© 2013 Embarcadero Technologies, Inc. Embarcadero, the Embarcadero Technologies logos, and all other Embarcadero Technologies product or service names are trademarks or registered trademarks of Embarcadero Technologies, Inc. All other trademarks are property of their respective owners.

This software/documentation contains proprietary information of Embarcadero Technologies, Inc.; it is provided under a license agreement containing restrictions on use and disclosure and is also protected by copyright law. Reverse engineering of the software is prohibited.

Embarcadero Technologies, Inc. is a leading provider of award-winning tools for application developers and database professionals so they can design systems right, build them faster and run them better, regardless of their platform or programming language. Ninety of the Fortune 100 and an active community of more than three million users worldwide rely on Embarcadero products to increase productivity, reduce costs, simplify change management and compliance and accelerate innovation. The company’s flagship tools include: Embarcadero® Change Manager™, CodeGear™ RAD Studio, DBArtisan®, Delphi®, ER/Studio®, JBuilder® and Rapid SQL®. Founded in 1993, Embarcadero is headquartered in San Francisco, with offices located around the world. Embarcadero is online at www.embarcadero.com.
Contents

Welcome to Rapid SQL ................................................................. 11

Additional Product Information ............................................. 11

Prerequisites and Preliminary Tasks ........................................ 12

Technical Requirements ......................................................... 12

Database Support and Connectivity Options ......................... 14

Licensing ................................................................................. 16

More Information on Using this Document ............................. 21

Getting Started ................................................................. 25

Application Basics ............................................................... 27

Starting Rapid SQL ............................................................... 27

Product Design ....................................................................... 30

Tutorial exercises ..................................................................... 55

Session 1: Getting Started .................................................... 55

Session 2: Productivity Enhancers ........................................ 58

Session 3: Scripting ............................................................... 68

Session 4: Working with Code Workbench .............................. 74

Session 5: Building a Database Project ................................. 76

Session 6: Visual Query Builder ........................................... 77

Session 7: Live Data Editor ................................................... 79

Session 8: Code Analyst ........................................................ 80

Session 9: SQL Debugging and Profiling ............................... 81

Specifying Rapid SQL application and feature options .......... 87

Configuring Feature Options ................................................ 87

Explorer Options .................................................................... 101

Locking Down Rapid SQL Features Using the Registry .......... 127

Datasource and Server Management ..................................... 129

Registering Datasources ......................................................... 129

Specifying a Datasource Catalog Storage Option ................ 130

Manually Registering or Editing Datasources ....................... 131

Automatically Discovering Datasources ............................... 144

Importing and Exporting Datasource Definitions .................. 146

Working With Datasources from a Connect Repository .......... 148

Viewing Datasource Properties ............................................. 152

Unregistering Datasource ...................................................... 153
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>External Functions</td>
<td>194</td>
</tr>
<tr>
<td>Foreign Keys</td>
<td>195</td>
</tr>
<tr>
<td>Full-text Catalogs</td>
<td>196</td>
</tr>
<tr>
<td>Full-text Indexes</td>
<td>197</td>
</tr>
<tr>
<td>Functions</td>
<td>197</td>
</tr>
<tr>
<td>Generators</td>
<td>199</td>
</tr>
<tr>
<td>Groups</td>
<td>200</td>
</tr>
<tr>
<td>Indexes</td>
<td>200</td>
</tr>
<tr>
<td>Instance</td>
<td>205</td>
</tr>
<tr>
<td>Java Classes</td>
<td>206</td>
</tr>
<tr>
<td>Java Resources</td>
<td>206</td>
</tr>
<tr>
<td>Java Sources</td>
<td>206</td>
</tr>
<tr>
<td>Jobs (Oracle)</td>
<td>207</td>
</tr>
<tr>
<td>Job Queues</td>
<td>208</td>
</tr>
<tr>
<td>Join Indexes</td>
<td>208</td>
</tr>
<tr>
<td>Libraries</td>
<td>209</td>
</tr>
<tr>
<td>Logins</td>
<td>209</td>
</tr>
<tr>
<td>Materialized Query Tables</td>
<td>211</td>
</tr>
<tr>
<td>Materialized Views</td>
<td>211</td>
</tr>
<tr>
<td>Materialized View Logs</td>
<td>212</td>
</tr>
<tr>
<td>Outlines</td>
<td>213</td>
</tr>
<tr>
<td>Packages</td>
<td>213</td>
</tr>
<tr>
<td>Package Bodies</td>
<td>215</td>
</tr>
<tr>
<td>Partition Functions</td>
<td>215</td>
</tr>
<tr>
<td>Partition Schemes</td>
<td>216</td>
</tr>
<tr>
<td>Plans</td>
<td>217</td>
</tr>
<tr>
<td>Primary Keys</td>
<td>217</td>
</tr>
<tr>
<td>Procedures</td>
<td>219</td>
</tr>
<tr>
<td>Profiles</td>
<td>221</td>
</tr>
<tr>
<td>Programs</td>
<td>222</td>
</tr>
<tr>
<td>Recycle Bin</td>
<td>222</td>
</tr>
<tr>
<td>Roles</td>
<td>223</td>
</tr>
<tr>
<td>Rules</td>
<td>224</td>
</tr>
<tr>
<td>Schedules</td>
<td>225</td>
</tr>
<tr>
<td>Schema</td>
<td>226</td>
</tr>
<tr>
<td>Segments</td>
<td>226</td>
</tr>
<tr>
<td>Sequences</td>
<td>227</td>
</tr>
<tr>
<td>Shadows</td>
<td>228</td>
</tr>
<tr>
<td>CONTENTS</td>
<td>Page</td>
</tr>
<tr>
<td>-------------------------------------------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>Structured Types</td>
<td>228</td>
</tr>
<tr>
<td>Symmetric Keys</td>
<td>229</td>
</tr>
<tr>
<td>Synonyms</td>
<td>229</td>
</tr>
<tr>
<td>System Indexes</td>
<td>230</td>
</tr>
<tr>
<td>System Tables</td>
<td>231</td>
</tr>
<tr>
<td>System Triggers</td>
<td>231</td>
</tr>
<tr>
<td>Tables</td>
<td>232</td>
</tr>
<tr>
<td>Tablespaces</td>
<td>235</td>
</tr>
<tr>
<td>Triggers</td>
<td>236</td>
</tr>
<tr>
<td>Types</td>
<td>238</td>
</tr>
<tr>
<td>Type Bodies</td>
<td>238</td>
</tr>
<tr>
<td>Unique Keys</td>
<td>239</td>
</tr>
<tr>
<td>User Datatypes</td>
<td>240</td>
</tr>
<tr>
<td>User Messages</td>
<td>241</td>
</tr>
<tr>
<td>Users</td>
<td>242</td>
</tr>
<tr>
<td>Views</td>
<td>244</td>
</tr>
<tr>
<td>Creating objects</td>
<td>247</td>
</tr>
<tr>
<td>Overview and Common Usage of Object Wizards</td>
<td>247</td>
</tr>
<tr>
<td>IBM DB2 for Linux, Unix, and Windows Object Wizards</td>
<td>251</td>
</tr>
<tr>
<td>IBM DB2 for z/OS Object Wizards</td>
<td>278</td>
</tr>
<tr>
<td>InterBase/Firebird Object Wizards</td>
<td>305</td>
</tr>
<tr>
<td>Microsoft SQL Server Object Wizards</td>
<td>324</td>
</tr>
<tr>
<td>MySQL object wizards</td>
<td>359</td>
</tr>
<tr>
<td>Oracle Object Wizards</td>
<td>367</td>
</tr>
<tr>
<td>Sybase ASE Object Wizards</td>
<td>419</td>
</tr>
<tr>
<td>Modifying objects using editors</td>
<td>443</td>
</tr>
<tr>
<td>Overview and common usage of object editors</td>
<td>443</td>
</tr>
<tr>
<td>IBM DB2 for Linux, Unix, and Windows Object Editors</td>
<td>451</td>
</tr>
<tr>
<td>IBM DB2 for z/OS Object Editors</td>
<td>470</td>
</tr>
<tr>
<td>InterBase/Firebird Object Editors</td>
<td>488</td>
</tr>
<tr>
<td>Microsoft SQL Server Object Editors</td>
<td>500</td>
</tr>
<tr>
<td>MySQL editors</td>
<td>521</td>
</tr>
<tr>
<td>Oracle Object Editors</td>
<td>525</td>
</tr>
<tr>
<td>Sybase ASE Object Editors</td>
<td>555</td>
</tr>
<tr>
<td>Object actions</td>
<td>573</td>
</tr>
<tr>
<td>Overview of object actions/operations execution</td>
<td>573</td>
</tr>
<tr>
<td>Available object actions by DBMS</td>
<td>577</td>
</tr>
</tbody>
</table>
# Contents

SQL Scripting ........................................................................................................ 703

ISQL Editor ............................................................................................................. 703
  Preprocessing #define and #include Directives ............................................ 705
  Toolbar Options ................................................................................................. 709
  ISQL Windows ...................................................................................................... 710

DDL Editors ........................................................................................................... 722
  Open Files ........................................................................................................... 723
  What Type of File ............................................................................................... 724
  Insert File into Current File .............................................................................. 725
  Splitting Windows ............................................................................................... 726
  Find ...................................................................................................................... 727
  Replace ............................................................................................................... 728
  Regular Expressions Support in Rapid SQL ..................................................... 729

Goto ......................................................................................................................... 730

Sending SQL Scripts .............................................................................................. 731

Renaming and Closing Query Window Tabs ....................................................... 731

Print ......................................................................................................................... 732

Saving and Closing Scripts .................................................................................. 734

Editing Scripts ....................................................................................................... 736

Executing Scripts ................................................................................................... 746

Results Editor ......................................................................................................... 767

Configuring Result Set Windows .......................................................................... 767

Exporting Data to Other Products ....................................................................... 770

Setting Result Windows to Read Only Mode ....................................................... 770

Result Window Status Bar .................................................................................... 770

Mailing Result Sets ............................................................................................... 770

Closing and Renaming Result Window Tabs ....................................................... 771

Saving and Closing Result Sets .......................................................................... 772

Editing Result Sets ............................................................................................... 773

Formatting Result Sets ........................................................................................ 779

Notes on XML Types and Unicode Display in the Results Editor ................... 784

Permissions Management ....................................................................................... 785

Explicit Permissions ............................................................................................. 785

Cascading Permissions ......................................................................................... 785

Using Roles to Grant Permissions and Privileges .............................................. 786

Using Roles to Revoke Permissions and Privileges ........................................... 786

Grant Privilege(s) To ............................................................................................. 786

Revoke Privilege(s) From ..................................................................................... 787
CONTENTS

Deny Privileges From .......................................................... 788

Project Management .......................................................... 789

Project support ................................................................. 789

Create a New Project ......................................................... 790

Working with Projects ....................................................... 797

Version Control ............................................................... 813

Version Control Integration ................................................. 813

Version Control Configuration .............................................. 815

Using Version Control ....................................................... 818

Tools .................................................................................... 835

Find in Files ...................................................................... 836

Database Search ............................................................... 837

Database Search Wizard - Panel 1 ........................................ 837

Database Search Wizard - Panel 2 ........................................ 838

Database Search Results .................................................... 838

Script Execution Facility ...................................................... 839

File Execution Facility ......................................................... 839

Completing the Script/File Execution Facility ....................... 840

Script Execution Facility - Script Tab .................................... 840

File Execution Facility - Files Tab ........................................ 841

File/Script Execution Facility - Target Tab ............................ 841

File/Script Execution Facility - Output Tab ............................ 842

File/Script Execution Facility - Notify Tab ............................. 842

Scheduling ......................................................................... 843

Microsoft Task Scheduler ................................................... 843

ETSQLX Command Line Utility ............................................. 843

Visual Difference ............................................................... 844

Comparing Files .................................................................. 844

Comparing Database Objects ............................................... 845

Navigating in the Visual Difference Dialog Box ..................... 846

Printing a Pane of the Visual Difference Dialog Box ................. 846

Searching in the Visual Difference Dialog Box ....................... 846

Setting Options in the Visual Difference Dialog Box ................. 847

Query Builder ..................................................................... 848

Query Builder Design .......................................................... 849

Using Query Builder ........................................................... 858
Data Editor ................................................................. 889
  Data Editor Design .................................................. 889
Code Generation Facility .............................................. 898
Import Data ............................................................. 899
  Import Data Wizard - Panel 1 ......................................... 900
  Import Data Wizard - Panel 2 for Text Files ....................... 901
  Import Data Wizard - Panel 3 for Text Files ....................... 901
  Import Data Wizard - Panel 2 for Excel Files ...................... 901
Embarcadero Products ................................................ 902
Code Workbench ....................................................... 902
  Enabling the Code Templates and Auto Replace Features .......... 902
  Maintaining Code Template Definitions ............................ 903
  Maintaining Auto Replace Expressions ............................. 904
  Loading and Saving Custom Code Workbench Settings .............. 905
Code Analyst .......................................................... 906
  Code Analyst DBMS Notes ............................................ 907
  Code Analyst Requirements .......................................... 911
  Installing Code Analyst ............................................... 911
  Uninstalling Code Analyst ........................................... 912
  Code Analyst Product Design ......................................... 913
  Code Analyst Tutorial ................................................ 915
  Using the Code Analyst ............................................... 920
Rapid SQL Add-On Tools .............................................. 929
  Embarcadero SQL Debugger for IBM DB2 LUW for Linux, Unix, and Windows .... 929
    Embarcadero SQL Debugger for IBM DB2 LUW for Linux, Unix, and Windows Features .... 930
    Embarcadero SQL Debugger for IBM DB2 LUW for Linux, Unix, and Windows Interface .......... 933
    Embarcadero SQL Debugger for IBM DB2 LUW for Linux, Unix, and Windows Functionality .... 937
    Using the Embarcadero SQL Debugger for IBM DB2 LUW for Linux, Unix, and Windows .......... 946
  Embarcadero SQL Debugger for Microsoft SQL Server ............... 948
    Embarcadero SQL Debugger for Microsoft Features ................ 949
    Embarcadero SQL Debugger for Microsoft Interface ................ 956
    Embarcadero SQL Debugger for Microsoft Functionality ........... 959
    Using the Embarcadero SQL Debugger for Microsoft ............... 967
    Debugging a Sample Script ........................................ 969
  Embarcadero SQL Debugger for Oracle ................................ 979
    Debugging Features ................................................ 980
    Embarcadero SQL Debugger for Oracle Interface .................. 982
Welcome to Rapid SQL

Rapid SQL is an integrated cross-platform database development environment that provides a highly-intuitive and well-integrated interface. Its graphical facilities simplify SQL scripting, object management, reverse-engineering, database project management, version control, and schema deployment. Additionally, it provides comprehensive tools for tuning and editing code to ensure high-performance and quality.

Rapid SQL offers support for all major databases including IBM DB2, InterBase/Firebird, Microsoft SQL Server, MySQL, Oracle, and Sybase.

The table below describes the major sections of Help.

<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Getting Started</td>
<td>Provides an introduction for new users and helps you set up Rapid SQL. Included is an investigation of the major user interface elements, detailed tutorial exercises, and instructions on configuring Rapid SQL features.</td>
</tr>
<tr>
<td>Datasource and Server Management</td>
<td>Shows you how to register the datasources that Rapid SQL will work against. This chapter also describes the extensive datasource management facilities.</td>
</tr>
<tr>
<td>Database Object Management</td>
<td>Describes how to create new database objects, edit existing objects, and provides details on the operations you can perform against database objects.</td>
</tr>
<tr>
<td>Coding Environments/Editors</td>
<td>Describes the development/execution/testing environments offered.</td>
</tr>
<tr>
<td>Tools</td>
<td>Tools provide search, script and file execution, scheduling, visual difference, a visual query builder, data import, a DML generation facility, a data editor, and an auto-replace tool for the scripting environment.</td>
</tr>
<tr>
<td>Project Management</td>
<td>Rapid SQL provides project support and version control system integration.</td>
</tr>
<tr>
<td>Rapid SQL Add-On Tools</td>
<td>License-dependent add-ons include:</td>
</tr>
<tr>
<td></td>
<td><strong>Debuggers</strong> - Rapid SQL provides debugging environments for DB2 LUW, SQL Server, Oracle, and Sybase ASE.</td>
</tr>
<tr>
<td></td>
<td><strong>Oracle PL/SQL Profiler</strong> - captures metrics of various PL/SQL programmable objects as they are executed</td>
</tr>
<tr>
<td></td>
<td><strong>Code Analyst</strong> - helps you identify time-consuming lines of code.</td>
</tr>
</tbody>
</table>

Additional Product Information

The Embarcadero Web site provides access to information and resources useful through the life of your product. This includes access to:

- Technical Support
- Case studies, video presentations, webinars and white papers
- Product communities through the Embarcadero Developer Network
- Free trials of related products
PREREQUISITES AND PRELIMINARY TASKS

The following topics provide information on requirements that must be satisfied and initial setup tasks that must be performed before using Rapid SQL:

- Technical Requirements
- Database Support and Connectivity Options
- Licensing

TECHNICAL REQUIREMENTS

Rapid SQL is a 32-bit application that runs in a Microsoft Windows environment. Before using Rapid SQL, please verify that your environment meets the following requirements:

- Hardware Requirements
- Operating System Requirements

**NOTE:** Users need full registry privileges during the installation and access to the keys under HKEY_CURRENT_USER in the registry after installation.

HARDWARE REQUIREMENTS

Embarcadero Technologies recommends the following minimum hardware requirements:

- Pentium 4-level processor
- 1 GB of memory
- 1 GB of disk space
- 1024 x 768 display

OPERATING SYSTEM REQUIREMENTS

Rapid SQL supports the following operating systems:

- Windows XP SP2 (32-bit and 64-bit)
- Windows Vista (32-bit and 64-bit)
- Windows 7 (32-bit and 64-bit)
For more detailed information, see the following topics:

- **XP Support**
- **Vista and Windows 7 Support**
- **32-bit Versus 64-bit Operating System Support and Restrictions**

**XP SUPPORT**

Windows XP has two user security groups:

- **Users**
- **Power Users**

Microsoft intentionally does not grant members of the Users Group the authority to install applications or make global changes to the system. Restricted Users are members of the Users Group. Standard users belong to the Power Users Group. Microsoft grants members of the Power Users Group the authority to install programs. You must be a member of the Administrators Group in order to install and use Embarcadero Technologies applications.

Because Restricted Users are members of the Users Group, they cannot install and run Embarcadero Technologies applications.

**CAUTION:** You must be a member of the Administrators Group in order to install and use Embarcadero Technologies applications.

To open the Group Membership tab where you can determine your group and review the Microsoft security guidelines:

1. On the **Control Panel**, open **User Accounts**.
2. On the **Users** tab, select a user and then click the **Properties** button.
3. Click the **Group Membership** tab.

**VISTA AND WINDOWS 7 SUPPORT**

Windows Vista UAC and Windows 7 provide two user types:

- **Standard user**
- **Administrator**

Rapid SQL can be installed or uninstalled by an administrator or by a standard user using an administrator token. Standard users can run Rapid SQL.

**CAUTION:** For the purposes of running Rapid SQL, default standard user token privileges should not be modified. Modifying standard user token privileges can result in licensing issues which will prevent Rapid SQL from operating properly.
32-bit Versus 64-bit Operating System Support and Restrictions
Rapid SQL is a 32-bit application that runs emulated on 64-bit versions of Windows. The only requirement is that Rapid SQL supports only 32-bit versions of the client software that must be installed for connectivity to each DBMS that Rapid SQL will work against.

Database Support and Connectivity Options
Rapid SQL provides dedicated DBMS platform support with the following connectivity options:

- For use with IBM DB2, SQL Server, MySQL, Oracle, and Sybase ASE datasources, Rapid SQL is packaged with a set of proprietary drivers that work in conjunction with a supported set of clients that must be installed.
  
  InterBase requires both client and driver software to be installed. Firebird requires driver software.
  
  For information on the DBMS clients or client/driver combinations that must be installed, see "Packaged Embarcadero Drivers with Native Client Support" on page 15.

- Alternatively, you can connect to a supported DBMS using a Type 4 JDBC driver packaged with Rapid SQL. For a listing of the third-party JDBC drivers, see "Third-party JDBC drivers" on page 15.

  The following table lists the DBMS platform versions for which dedicated support is provided, and the connectivity options supported:

<table>
<thead>
<tr>
<th>DBMS Version</th>
<th>Native Embarcadero Driver Support</th>
<th>Packaged Third-party JDBC Client Support</th>
</tr>
</thead>
<tbody>
<tr>
<td>Firebird 2.0</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>IBM DB2 for z/OS 8 and 9</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>IBM DB2 LUW 9.0 - 9.7</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>InterBase 2007 and InterBase 2009</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>For SQL Server 2005 and 2008, only object types like users, logins, roles, config parameters, etc., are supported. We do NOT support Microsoft .NET extensions at this time.</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>MySQL 4.x. (Rapid SQL is tolerant of 5.x but does not support Stored Procedures, Triggers, or Views)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Oracle 9i, 10g, and 11g</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Sybase ASE 12.5 - 15.5</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Sybase IQ 12.7 - 15.4</td>
<td>✓</td>
<td>✓</td>
</tr>
</tbody>
</table>

Lastly, generic JDBC and ODBC is provided for non-dedicated DBMS platforms and other datasources. For details, see "Generic JDBC and ODBC Support" on page 16.
PACKAGED EMBARCADERO DRIVERS WITH NATIVE CLIENT SUPPORT
If you are using a native Embarcadero connectivity option to connect to supported DBMS platforms, ensure that the relevant client or driver/client combination is installed and configured:

<table>
<thead>
<tr>
<th>DBMS</th>
<th>Client</th>
</tr>
</thead>
<tbody>
<tr>
<td>Firebird</td>
<td>Firebird ODBC driver</td>
</tr>
<tr>
<td>IBM DB2 for z/OS</td>
<td>DB2 UDB Client for Windows 8 or later</td>
</tr>
<tr>
<td>IBM DB2 for Linux, Unix, and Windows</td>
<td>IBM DB2 LUW Client for Windows 8 or later</td>
</tr>
<tr>
<td>Microsoft SQL Server</td>
<td>Microsoft SQL Server Client Library</td>
</tr>
<tr>
<td>MySQL</td>
<td>MySQL Connector/ODBC Driver 5.2.x Driver - MySQL Connector/ODBC driver 3.51.x Driver</td>
</tr>
<tr>
<td>Oracle</td>
<td>Oracle SQL*Net Client</td>
</tr>
<tr>
<td>Sybase ASE</td>
<td>Sybase Open Client</td>
</tr>
<tr>
<td>InterBase</td>
<td>DataDirect ODBC driver for InterBase and the InterBase Client</td>
</tr>
<tr>
<td>Sybase IQ</td>
<td>SQL Anywhere ODBC drivers for Sybase IQ 12.7</td>
</tr>
<tr>
<td></td>
<td>Sybase IQ 32-bit ODBC drivers</td>
</tr>
</tbody>
</table>

**NOTE:** Since Rapid SQL is a 32-bit application that runs emulated on 64-bit versions of Windows, only 32-bit versions of the DBMS client software are supported.

THIRD-PARTY JDBC DRIVERS
If policy or preference dictates use of Type 4 JDBC drivers, the following table includes the drivers supplied for each supported DBMS platform:

<table>
<thead>
<tr>
<th>Platform</th>
<th>JDBC Driver</th>
</tr>
</thead>
<tbody>
<tr>
<td>Firebird</td>
<td>Jaybird JDBC Driver</td>
</tr>
<tr>
<td>IBM DB2 for Linux, Unix and Windows</td>
<td>IBM Data Server Driver for JDBC</td>
</tr>
<tr>
<td>IBM DB2 for z/OS</td>
<td>InterBase JDBC driver</td>
</tr>
<tr>
<td>InterBase</td>
<td>jTDS Type 4 JDBC Driver for Microsoft SQL Server</td>
</tr>
<tr>
<td>Microsoft SQL Server</td>
<td>Microsoft SQL Server JDBC Driver</td>
</tr>
<tr>
<td>MySQL</td>
<td>MySQL Connector/J JDBC Driver</td>
</tr>
<tr>
<td>Oracle</td>
<td>Oracle JDBC Thin Driver</td>
</tr>
<tr>
<td>Sybase ASE</td>
<td>jTDS Type 4 JDBC Driver for Microsoft SQL Server</td>
</tr>
<tr>
<td>Sybase jConnect JDBC Driver</td>
<td>Sybase jConnect JDBC Driver</td>
</tr>
<tr>
<td>Sybase IQ</td>
<td>Sybase jConnect JDBC Driver for Sybase IQ</td>
</tr>
</tbody>
</table>
EMBARCADERO CONNECT SUPPORT
Rapid SQL can make use of datasource definitions stored on an Embarcadero Connect server. For details, see "Working With Datasources from a Connect Repository" on page 148.

GENERIC JDBC AND ODBC SUPPORT
Generic JDBC/ODBC connectivity to non-dedicated DBMS systems or non-database datasources is also provided. Rapid SQL can connect to a datasource using a customer-provided, third-party JDBC version 3.0 or ODBC version 3.0 driver. Minimal Rapid SQL functionality is provided, including a basic Explorer tree and SQL querying.

IBM DB2 FOR Z/OS STORED PROCEDURE REQUIREMENTS
When working against an IBM DB2 for z/OS data source, Rapid SQL relies on the following stored procedures, provided as an optional installation step in setting up the DB2 subsystem:

- DSNWZP
- DSNUILS
- ADMIN_COMMAND_DSN
- ADMIN_COMMAND_DB2

Prior to using Rapid SQL against an IBM DB2 for z/OS data source, ensure that these components are installed on the server. See http://publib.boulder.ibm.com/infocenter/dzichelp/v2r2/topic/com.ibm.db2.doc.inst/stpadd.htm#stpadd for more information.

LICENSING
Each Embarcadero client application requires one or more licenses in order to run. An Embarcadero product, such as Rapid SQL or ER/Studio, has a baseline license which provides basic feature support for that product. In addition, incremental licenses may be required to support specific DBMS platforms, product add-ons, or other functions.

For more information, see the following topics:
- Licensing Overview
- Licensing Your Application
- Selecting a License Category During Startup
- Online/Offline Mode and Concurrent License Checkout
Licensing Overview
The following topics provide a high-level discussion of key licensing topics and directs you to sources of more detailed information.

- Viewing Your License Type and Modules
- Understanding Trial, Workstation, and Networked Licenses
- Rapid SQL License Modules, DBMS Support, and Feature Availability
- Rapid SQL XE License Modules, DBMS Support, and Feature Availability
- Directing Queries Regarding Licenses

Viewing Your License Type and Modules
The About... dialog, available from the Help menu, displays your license type and each individual license module currently registered.

Understanding Trial, Workstation, and Networked Licenses
Three kinds of licenses are available: Trial, Workstation, and Networked.

- **Trial licenses**: A license for a 14-day, full-featured trial version of the product. The trial license must be registered before you can use the product.

- **Workstation licensing**: A license or set of licenses is tied to a particular workstation. The product can only be used on that workstation.

- **Networked licensing**: Networked licenses are administered and distributed by a central License Server (Embarcadero License Center or Acresto FLEXnet Publisher). There are two types of networked licenses: Concurrent and Networked Named User. With Concurrent licensing, users on different machines take turns using licenses from a shared pool. With Networked Named User licensing, licenses are pre-assigned to specific users setup on the license server’s user list. Those users are guaranteed to have licenses available any time.

  NOTE: Concurrent licenses can be borrowed for use without a network connection. For details, see “Online/Offline Mode and Concurrent License Checkout” on page 20.

For a detailed description of licensing options, see http://www.embarcadero.com/software-licensing-solutions.

Rapid SQL License Modules, DBMS Support, and Feature Availability
Individual license modules correspond to the DBMS platforms you are licensed to use. In addition, each DBMS license module corresponds to a product edition. Feature availability for each license module edition is as follows:

- **Standard**: Provides baseline support including datasource management, object management, SQL editing and execution, and standard tools and utilities.

- **Professional**: Standard edition features plus SQL Debugger, SQL Profiler, and Code Analyst.
RAPID SQL XE LICENSE MODULES, DBMS SUPPORT, AND FEATURE AVAILABILITY
An XE license provides access to all supported DBMS platforms. XE module and feature availability is as follows:

- **XE Pro** - Provides baseline support including datasource management, object management, SQL editing and execution, and standard tools and utilities, SQL Debugger, SQL Profiler, and Code Analyst.

DIRECTING QUERIES REGARDING LICENSES
Questions regarding license availability, feature availability, and client or server licensing, should be directed as follows:

- If you work in an organization that uses networked licensing, direct any questions to your site’s Rapid SQL administrator.
- If you are using workstation licensing, direct licensing questions to your Embarcadero Technologies representative.

LICENSING YOUR APPLICATION
See the following topics for details on registering your product:

- Registering a Trial or Workstation License during Installation
- Registering a Workstation License After Application Startup
- Registering By Phone
- Registering a Networked License

REGISTERING A TRIAL OR WORKSTATION LICENSE DURING INSTALLATION
Shortly after initiating download of a trial version of an Embarcadero product, you should receive an email with a serial number you must register during installation. Similarly, if you purchase an Embarcadero product while no trial version is active, you will receive a serial number that must be registered during installation.

1. Start the installation. An Embarcadero License Registration dialog appears.
2. Copy the serial number from the email and paste it in the Serial Number field.
3. Enter your Embarcadero Developer Network account credentials in the Login or Email and Password fields. If you have not previously created an EDN account, or have forgotten your password, click I need to create ... or I’ve lost my password.
4. Click Register.

Your activation file should be downloaded and installed automatically. If this does not happen, click the Trouble Connecting? Try Web Registration link and follow the prompts. If you still have problems, see “Registering By Phone” on page 19.
REGISTERING A WORKSTATION LICENSE AFTER APPLICATION STARTUP

The following instructions assume that you have received a workstation license by email and that you currently have a valid trial license. If you did not install a trial version or the trial period has expired, follow the instructions in "Registering a Trial or Workstation License during Installation" on page 18 instead.

1. On the Help menu select About and then on the dialog that opens, click Manage to open a license manager dialog.

2. On the Serial menu, select Add.

3. Copy the serial number from the email and paste it in the Add Serial Number dialog, then click OK.

4. Right-click on the serial number you added, and then select Register from the context menu. A registration dialog opens.

   **NOTE:** The Registration Code box shows a machine-specific identifier required with other registration methods.

5. Ensure that the Register using Online Registration radio box is selected.

6. Provide Developer Network credentials in the DN Login name or Email and DN Password boxes. If you have not previously created an EDN account, or have forgotten your password, click I need to create ... or I've lost my password.

7. Click Register.

8. If prompted to restart the application, click Yes.

Your activation file should be downloaded and installed automatically. If this does not happen, click the Trouble Connecting? Try Web Registration link and follow the prompts. If you still have problems, see "Registering By Phone" on page 19.

REGISTERING BY PHONE

If you have problems with either of the above procedures, you can register licenses by phone. You will have to provide:

- Developer Network credentials
- The registration code displayed in the Embarcadero License Registration dialog that appears when you start an unlicensed application
- The product base license serial number
- The license serial numbers for any additional features you have purchased.

For North America, Latin America and Asia Pacific, call (415) 834-3131 option 2 and then follow the prompts. The hours are Monday to Friday, 6:00 A.M. to 6:00 P.M. Pacific time.

For Europe, Africa and the Middle East, call +44 (0)1628-684 494. The hours are Monday to Friday, 9 A.M. to 5:30 P.M. U.K. time.
Shortly after phoning in, you will receive an email containing an activation file. Then do the following:

1. Save the file to the desktop or a scratch directory such as \(c:\temp\).
2. On the Help menu select About and then on the dialog that opens, click Register. A registration dialog opens.
3. Select the I have received an activation file (*.slip or reg*.txt) radio box.
4. Click the Browse button and use the Select License Activation File dialog to locate and select the activation file you installed.
5. Click the Import button to import the activation file and when complete, click the Finish button.
6. If prompted to restart the application, click Yes.

**Registering a Networked License**

If you work in an organization using Networked licensing, an administrator, department head, or someone performing a similar function will provide you with an activation file.

Once you receive the file, save it to the license subfolder of your product's main installation folder (typically \(C:\Program Files\Embarcadero\<product><version>\license\)), then restart the application.

No additional steps are necessary.

**Selecting a License Category During Startup**

During Rapid SQL startup, if multiple concurrent license categories are available, you are prompted to select a category to use for this Rapid SQL session. Multiple license categories can be set up to provide differing feature access or access to different DBMS versions. Feature and DBMS version access are typically distributed across multiple license categories to optimize use of a site's purchased licenses.

 NOTE: This dialog also includes the option to remember your selection on subsequent startups. If you select that option, you can subsequently use the Select Licenses button on the About... dialog (Help > About) to select a different license.

Contact your License Administrator for details on individual license categories or requests for additional feature or DBMS support.

**Online/Offline Mode and Concurrent License Checkout**

Concurrent licenses can be used in both online and offline modes. In online mode, you must have a continuous network connection to your License Center. Licenses are checked out when you start Rapid SQL and checked back in when you shut Rapid SQL down.
You can also use a license in offline mode. When you explicitly check out a license for offline use, you can use Rapid SQL without a connection to your License Center for a specified duration. This lets you work while travelling or commuting, work away from your primary work area, or use Rapid SQL when a network connection is unavailable or not required.

**NOTE:** Contact your site administrator for information on offline license availability, the maximum duration, offline license policy at your site, or any other issues arising from online license usage.

**To check out a license for offline use:**

1. On the **Help** menu, select **Checkout License**. The **Check Out Licenses For Offline Use** dialog opens.
2. Select the check box associated with each individual license you want to check out.
3. In the **Checkout Duration** box, type the number of hours that you can use the offline license without a network connection to the License Center.
4. Click **OK**.

You can work offline for the specified duration. The duration period begins immediately.

If you subsequently establish a network connection to the License Center before the license duration expires, you can indicate to the License Center that the offline license is no longer required.

**To indicate that an offline license is no longer required:**

1. On the **Help** menu, select **Checkin License**.

There is no interruption in Rapid SQL usage. The license is not actually checked in until you shut down Rapid SQL.

**MORE INFORMATION ON USING THIS DOCUMENT**

The following topics provide additional information that is useful when working with product documentation:

- [Accessing Third Party Documentation](#)
- [Shorthand for Third Party Product References](#)

**ACCESSING THIRD PARTY DOCUMENTATION**

Many Rapid SQL features provide support for functionality available in the supported third party DBMS platforms. In object management for example, properties available when creating or editing objects and actions available against object types, are direct equivalents of clauses, options, or keywords available for use with the third party equivalent.
In such cases, no attempt is made to duplicate detailed documentation by third parties. Casual descriptions are provided, noting the third party equivalent. You can consult the third party documentation for details or clarifications. The following links provide access to online documentation for DBMS platforms supported by Rapid SQL:

- IBM DB2 for Linux, Unix, and Windows documentation
- IBM DB2 for z/OS documentation
- InterBase/Firebird documentation
- Microsoft SQL Server documentation
- MySQL documentation
- Oracle documentation
- Sybase ASE and Sybase IQ documentation

**SHORTHAND FOR THIRD PARTY PRODUCT REFERENCES**

To save space in headings and table columns, shorthand is used to represent versions and variations of the DBMS platforms supported by Rapid SQL.

- **DB2 LUW**
- **DB2 z/OS**
- **ITB/FBD**
- **MySQL**
- **ORCL**
- **SQL SVR**
- **SYB ASE**
- **SYB IQ**

**DB2 LUW**
DB2 LUW is used as shorthand for IBM DB2 for Linux, Unix, and Windows.

**DB2 z/OS**
DB2 z/OS is used as shorthand for IBM DB2 for z/OS.

**ITB/FBD**
ITB/FBD is used as shorthand for InterBase/Firebird.
MySQL
MySQL is used as shorthand for the MySQL RDBMS.

ORCL
ORCL is used as shorthand for Oracle.

SQL SVR
SQL SVR is used as shorthand for Microsoft SQL Server.

SYB ASE
SYB ASE is used as shorthand for Sybase Adaptive Server.

SYB IQ
SYB IQ is used as shorthand for Sybase IQ.
GETTING STARTED

The following sets of topics are intended for new users. They provide learning curve material and tell you how to configure Rapid SQL:

- **Application Basics**
  - Introduces the major user interface elements.

- **Rapid SQL Tutorial**
  - Provides detailed tutorial exercises that introduce the basic areas of Rapid SQL functionality.

- **Specifying Rapid SQL application and feature options**
  - Tells you how to configure Rapid SQL.
APPLICATION BASICS

Application Basics is designed to situate you within the application and to provide information about what Rapid SQL offers in the way of design, navigation, and application features. The information presented here is high-level and conceptual.

Application Basics is divided into two sections, the table below describes each section:

<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Starting Rapid SQL</td>
<td>Describes the various ways to start the application.</td>
</tr>
<tr>
<td>Product Design</td>
<td>This section describes the Rapid SQL user interface.</td>
</tr>
<tr>
<td>Specifying Rapid SQL application and feature options</td>
<td>This section describes how to customize Rapid SQL's configuration to suit your specific needs.</td>
</tr>
</tbody>
</table>

STARTING RAPID SQL

There are three ways to start the Rapid SQL application:

- Starting an Installed version of Rapid SQL from the Start Menu
- Starting an Installed version of Rapid SQL from the Command Line
- Starting a .ion version of Rapid SQL

STARTING AN INSTALLED VERSION OF RAPID SQL FROM THE START MENU

The Start menu sequence for DBArtisan is always in the form Programs > Embarcadero DBArtisan version identifier > Embarcadero DBArtisan version identifier, where version identifier reflects the version you are running.

STARTING AN INSTALLED VERSION OF RAPID SQL FROM THE COMMAND LINE

Command line startup is primarily aimed at identity management systems working in conjunction with Rapid SQL. Such systems can be configured to start Rapid SQL and connect to a specific datasource using credentials that are invisible to the user. Other applications that hide credentials, force connection to a specific datasource, administer usage audits, or otherwise automate startup of Rapid SQL can make use of this feature.

Two forms of command line startup are available. Syntax and parameters are as follows:

```
rsqle.exe -D datasource -U username -P password
rsqle.exe -D datasource -U username -P password
```

For example:

- rsqle.exe -D torlabsy01 -U myusername -P mypassword
Keep the following points in mind when using command line startup:

- Credentials remain valid until the user disconnects from the datasource.
- When you try disconnect, a confirmation message box includes a warning message that the connection has external credentials that will be lost if you choose to proceed with disconnect.
- Once disconnected, a user must connect to the previously disconnected datasource using specified, valid credentials or rely on Auto-connect. For more information, see "Manually Registering or Editing Datasources" on page 131.
- Command line credentials override the default credentials provided if a datasource is registered using the Auto-connect setting.

Regarding the switch specifications:

- The password switch/value pair is optional and the P switch can be provided without a value.
- The switches are case-sensitive while the datasource is case-insensitive;
- The order of these switches doesn’t matter;
- Switches can be specified with the minus sign or with a slash and any combinations are allowed. For example, RSQL.-D ROMLABSQL08 /U sa /P.
- If you specify a switch multiple times, it’s last valid occurrence from left to right is used. We auto-connect a single datasource, no matter the number of times a -D switch is specified;
- The -p switch (with lower case) prints a file;
- If -R is specified then one of the following will occur:
  - If -D is also specified, it will check to see if that datasource already exists. If it does exist, it will check to see if its connection information matches the provided -R parameter. If it matches, startup behavior will be the same as if -R was not specified. If it doesn’t match, a modified form of the datasource name is generated using the -D-provided name to ensure uniqueness and give it the connection information specified by -R. If the datasource doesn’t exist, a new datasource is generated using the name provided by -D and the remaining connection information provided by -R.
  - If -D is not specified, the -R-provided datasource is checked for a match against existing datasources. If a match is found, that datasource is connected. If no match is found, a new datasource is generated using the name provided by -R and the remaining connection information provided by -R.

\[NOTE:\] If connecting to an existing datasource with auto-connect enabled, if -U and -P values were provided, then auto-connect will be disabled and the provided -U and -P values are used.
-R SWITCH VALUES BY PLATFORM

The following table lists the valid connection strings that can be used with the -R switch for a command line startup.

<table>
<thead>
<tr>
<th>Platform</th>
<th>Connect String</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>DB2 LUW and DB2 z/OS</td>
<td>db2://&lt;HOST&gt;/&lt;DB&gt;</td>
<td>If the DB2 ODBC/CLI driver is installed on the system, that driver will be used for DB2 connections. Otherwise the IBM Data Server Driver for JDBC will be used. Using “db2p” will make the datasource created permanent</td>
</tr>
<tr>
<td></td>
<td>db2://&lt;HOST&gt;:&lt;PORT&gt;/&lt;DB&gt;</td>
<td></td>
</tr>
<tr>
<td></td>
<td>db2:@&lt;ALIAS&gt; where ALIAS is the name from the DB2 client registration</td>
<td></td>
</tr>
<tr>
<td>MySQL</td>
<td>mysql://&lt;HOST&gt;</td>
<td>If the MySQL ODBC driver is installed on the system, that driver will be used to make the connection. Otherwise, the MySQL Connector/J JDBC driver will be used. Using “mysqlp” will make the datasource created permanent</td>
</tr>
<tr>
<td></td>
<td>mysql://&lt;HOST&gt;/&lt;DB&gt;</td>
<td></td>
</tr>
<tr>
<td></td>
<td>mysql://&lt;HOST&gt;:&lt;PORT&gt;</td>
<td></td>
</tr>
<tr>
<td></td>
<td>mysql://&lt;HOST&gt;:&lt;PORT&gt;/&lt;DB&gt;</td>
<td></td>
</tr>
<tr>
<td>ODBC</td>
<td>odbc://&lt;CONNECT_STRING&gt;</td>
<td>Using “odbcp” will make the datasource created permanent.</td>
</tr>
<tr>
<td></td>
<td>where connect string can be the a System DSN name on it’s own or the full ODBC connection string containing at least one of the following tags: DSN=, FILEDSN= or DRIVER=</td>
<td></td>
</tr>
<tr>
<td>SQL SVR</td>
<td>sqlserver://&lt;HOST&gt;</td>
<td>The latest Microsoft ODBC driver for SQL Server installed on the system is used to make the connection. Using “sqlsvrerp” will make the datasource created permanent</td>
</tr>
<tr>
<td></td>
<td>sqlserver://&lt;HOST&gt;/&lt;DB&gt;</td>
<td></td>
</tr>
<tr>
<td></td>
<td>sqlserver://&lt;HOST&gt;:&lt;PORT&gt;</td>
<td></td>
</tr>
<tr>
<td></td>
<td>sqlserver://&lt;HOST&gt;:&lt;PORT&gt;/&lt;DB&gt;</td>
<td></td>
</tr>
<tr>
<td></td>
<td>sqlserver://&lt;HOST&gt;:&lt;INSTANCE&gt;</td>
<td></td>
</tr>
<tr>
<td></td>
<td>sqlserver://&lt;HOST&gt;:&lt;INSTANCE&gt;/&lt;DB&gt;</td>
<td></td>
</tr>
<tr>
<td></td>
<td>sqlserver://&lt;HOST&gt;:&lt;INSTANCE&gt;:&lt;PORT&gt;</td>
<td></td>
</tr>
<tr>
<td></td>
<td>sqlserver://&lt;HOST&gt;:&lt;INSTANCE&gt;:&lt;PORT&gt;/&lt;DB&gt;</td>
<td></td>
</tr>
<tr>
<td></td>
<td>sqlserver:@&lt;ALIAS&gt;</td>
<td></td>
</tr>
<tr>
<td></td>
<td>sqlserver:@&lt;ALIAS&gt;/&lt;DB&gt;</td>
<td></td>
</tr>
<tr>
<td></td>
<td>where ALIAS is the name from the Network Library Configuration</td>
<td></td>
</tr>
<tr>
<td>SQL SVR Azure</td>
<td>sqlserverazure://&lt;HOST&gt;</td>
<td>The latest Microsoft ODBC driver for SQL Server installed on the system is used to make the connection. Using ”sqlserverazurep” will make the datasource created permanent</td>
</tr>
<tr>
<td></td>
<td>sqlserverazure://&lt;HOST&gt;/&lt;DB&gt;</td>
<td></td>
</tr>
<tr>
<td>SYB IQ</td>
<td>sybaseiq://&lt;HOST&gt;</td>
<td>If the Sybase IQ ODBC driver is installed on the system it will use that, otherwise it will use the Sybase jConnect JDBC driver. Using “sybaseiqp” will make the datasource created permanent</td>
</tr>
<tr>
<td></td>
<td>sybaseiq://&lt;HOST&gt;/&lt;DB&gt;</td>
<td></td>
</tr>
<tr>
<td></td>
<td>sybaseiq://&lt;HOST&gt;:&lt;PORT&gt;</td>
<td></td>
</tr>
<tr>
<td></td>
<td>sybaseiq://&lt;HOST&gt;:&lt;PORT&gt;/&lt;DB&gt;</td>
<td></td>
</tr>
</tbody>
</table>

For more general information, see "Starting an Installed version of Rapid SQL from the Command Line " on page 27.
STARTING A .ION VERSION OF RAPID SQL
Start the application by double-clicking the file you downloaded.

PRODUCT DESIGN
The Rapid SQL window opens with the Database Explorer on the left, the Workspace on the right, and all toolbars docked at the top of the application. The Output Window is not automatically displayed. Rapid SQL also offers you a number of desktops, or workspaces, that you can toggle among while you work.

DATABASE EXPLORER
Rapid SQL organizes the wealth of information pertaining to your servers through its Database Explorer. The Database Explorer provides a fast and efficient way to access your database objects and scripts. The Database Explorer is a separate window containing a tree object that you can select and expand. The tree object organizes and nests subjects as branches. By expanding or collapsing the tree, you can efficiently browse multiple datasources. The Database Explorer window is dockable so that you can maneuver through the application efficiently.

For details on the Explorer and datasource management, in general, see the following topics:

- "Datasource and Server Management" on page 129
- "Using the Datasource Navigator" on page 157

TIP: You can also set these options on the Explorer tab of the Options Editor. For details, see Explorer Options - Main Tab.

RAPID SQL WINDOWS
The Rapid SQL interface includes several windows to help you develop your program. The windows include:

Topics
- Describe Window
- Output Window
- Browsers
- Workspaces
- Preview Dialog Boxes
**DESCRIPT WINDOW**
Rapid SQL offers a floating Describe window for procedures, tables, views, and functions (Oracle and IBM DB2 LUW for Open Systems only). In the Describe window, you can view columnar information (for tables and views) or input parameter information (for procedures and functions).

**Opening the Describe Window**
Rapid SQL offers three ways to open the Describe window:

1. In an editor, right-click an object and then click Describe from Cursor.
2. On the Explorer Tab, select an object and then click Describe.
3. On the Explorer Tab or in an editor, select an object and then press CTRL+D.

**Using the Describe Window**
In the Describe window:

1. Click the Name list and then click a name to view a list of types of objects in the database.
2. Click the Owner list and then click an owner to view a list of all owners of objects in the database.
3. Click the Type list and then click a type to view columnar information (for tables and views) or input parameter information (for functions and procedures).

**OUTPUT WINDOW**
Rapid SQL incorporates a separate window to capture all messages returned by the server and to log entries about the progress of operations started by the application.

For more information, see [Configuring the Output Window](#).

**CONFIGURING THE OUTPUT WINDOW**
Rapid SQL lets you display, hide, or dock the [Output Window](#) anywhere in the application.

**Displaying the Output Window**

1. On the View menu, click Output.
   
   OR

   On the Main toolbar, click Output.

   Rapid SQL displays the Output Window.
Hiding the Output Window
1. On the View menu, click Output.
   OR
   On the Main toolbar, click Output.
   OR
   Right-click the Output Window and then click Hide.
   Rapid SQL hides the Output Window.

Docking the Output Window
Right-click the Output Window and then click Docking View.
Rapid SQL docks the Output Window to the bottom of the application frame.

Undocking the Output Window
Right-click the Output Window and then click Docking View.
Rapid SQL displays the Output Window as a floating window in the application.

MESSAGES IN THE OUTPUT WINDOW
The Output Window lets you save, print, copy, and clear server messages.

Saving Server Messages
1. Right-click the Output Window and then click Save.
   Rapid SQL opens the Save As dialog box.
2. Enter the location and name of the file in the File Name box.
   NOTE: Rapid SQL defaults the file extension to .msg.
3. To save the file, click OK.

Printing Server Messages
1. Right-click the Output Window and then click Print.
   Rapid SQL opens the Print dialog box.
   NOTE: Rapid SQL prompts you with information on the size of the print job before opening the Print dialog box.
2. Configure your print job.
3. Click OK to print the file.
Copying Server Messages
1. Right-click the target Server Messages and then click Copy.
   Rapid SQL copies the selected text to the Microsoft Windows Clipboard.
2. Paste the contents of the clipboard into target applications.

Clearing Server Messages
1. Right-click the Output Window and then click Clear.
   Rapid SQL clears your Server Messages.

BROWSERS
Browsers are a flexible environment where you can examine, extract, and execute database objects and their dependencies. Browsers provide the means to view objects types across multiple database platforms and connections. You can simultaneously view and work with objects from InterBase/Firebird, Oracle, Microsoft SQL Server, Sybase Adaptive Server, and IBM DB2 LUW for Open Systems.

The benefit of using Browsers is the ability to see detailed information about specific object types. You can also print, search, copy, and sort the contents of a Browser window.

Topics
- Browser Toolbar
- Opening Browsers
- Browser Object Types
- Column filtering in the Browser
- Extracting DDL from Browsers
- Displaying Dependencies from Browsers
- Refreshing Browsers

BROWSER TOOLBAR
You can place the floating Browser toolbar anywhere on the Rapid SQL workspace.

For more information, see Browsers.

OPENING BROWSERS
Browsers let you view all types of database objects, including the SQL procedures used to build them. Browsers let you:
- Copy database objects
- Modify database objects
• Test database objects

The ability to browse dependencies is especially useful, particularly when modifying SQL code in procedures and triggers. For example, in a situation where a trigger enforces a rule that does not let you update a particular box, you can use the Browser to do the following:

• Browse the triggers to find the offending trigger.
• Extract the DDL for that trigger into one window.
• In another window, drop the offending trigger, make your update to the box, then execute the corrected trigger DDL to replace the trigger in the database.

**Opening a Browser Window**

Rapid SQL offers two ways to open a Browser:

1. On the *Browse* menu, click the target object type.

   OR

2. In the workspace, right-click, click *Browser*, then click the target object.

   Rapid SQL opens a Browser.

For more information, see *Browsers*.

**Browser Object Types**

Rapid SQL’s Browsers read the appropriate object types for specific databases. A select statement is issued against the appropriate systems table based on the requested object to bring back a listing of the objects in the database. The table below contains a list of the Browsers available for each database platform:

<table>
<thead>
<tr>
<th>Object Type</th>
<th>DB2 LUW</th>
<th>DB2 z/OS</th>
<th>InterBase/Firebird</th>
<th>SQL Server</th>
<th>Oracle</th>
<th>Sybase</th>
</tr>
</thead>
<tbody>
<tr>
<td>Aliases</td>
<td>✔️</td>
<td>✔️</td>
<td></td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>Blob Filters</td>
<td></td>
<td>✔️</td>
<td></td>
<td>✔️</td>
<td>✔️</td>
<td></td>
</tr>
<tr>
<td>Check Constraints</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>Clusters</td>
<td></td>
<td></td>
<td></td>
<td>✔️</td>
<td>✔️</td>
<td></td>
</tr>
<tr>
<td>Databases</td>
<td>✔️</td>
<td>✔️</td>
<td></td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>Database Links</td>
<td></td>
<td></td>
<td></td>
<td>✔️</td>
<td>✔️</td>
<td></td>
</tr>
<tr>
<td>Object Type</td>
<td>DB2 LUW</td>
<td>DB2 z/OS</td>
<td>InterBase/Firebird</td>
<td>SQL Server</td>
<td>Oracle</td>
<td>Sybase</td>
</tr>
<tr>
<td>---------------------</td>
<td>---------</td>
<td>----------</td>
<td>--------------------</td>
<td>------------</td>
<td>--------</td>
<td>--------</td>
</tr>
<tr>
<td>Defaults</td>
<td></td>
<td></td>
<td></td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Directories</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Domains</td>
<td></td>
<td></td>
<td>✔</td>
<td></td>
<td></td>
<td>✔</td>
</tr>
<tr>
<td>Encrypted Keys</td>
<td></td>
<td></td>
<td>✔</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Event Monitors</td>
<td>✔</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Exceptions</td>
<td></td>
<td></td>
<td></td>
<td>✔</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Extended Procedures</td>
<td></td>
<td></td>
<td></td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>External Functions</td>
<td></td>
<td></td>
<td></td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Foreign Keys</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Functions</td>
<td>✔</td>
<td>✔</td>
<td></td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Generators</td>
<td></td>
<td></td>
<td>✔</td>
<td></td>
<td>✔</td>
<td></td>
</tr>
<tr>
<td>Groups</td>
<td></td>
<td></td>
<td></td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Indexes</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Libraries</td>
<td></td>
<td></td>
<td></td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Packages</td>
<td>✔</td>
<td>✔</td>
<td></td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Plans</td>
<td>✔</td>
<td>✔</td>
<td></td>
<td></td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>PL/SQL Code</td>
<td></td>
<td></td>
<td></td>
<td>✔</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Profiling</td>
<td></td>
<td></td>
<td></td>
<td>✔</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Primary Keys</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Object Type</td>
<td>DB2 LUW</td>
<td>DB2 z/OS</td>
<td>InterBase/Firebird</td>
<td>SQL Server</td>
<td>Oracle</td>
<td>Sybase</td>
</tr>
<tr>
<td>--------------------</td>
<td>---------</td>
<td>----------</td>
<td>--------------------</td>
<td>------------</td>
<td>--------</td>
<td>--------</td>
</tr>
<tr>
<td>Procedures</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Profiles</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Roles</td>
<td></td>
<td></td>
<td>✓</td>
<td></td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Rules</td>
<td></td>
<td></td>
<td></td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Rollback Segments</td>
<td></td>
<td></td>
<td></td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Segments</td>
<td></td>
<td></td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Sequences</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>Shadows</td>
<td></td>
<td></td>
<td></td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Snapshots</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Snapshot Logs</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>Materialized Views</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>Materialized View Logs</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>Synonyms</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>Tables</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Tablespaces</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>Triggers</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Types</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>Type Bodies</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✓</td>
</tr>
</tbody>
</table>
WORKING WITH BROWSERS
Browsers offer a versatile method of browsing and managing the contents of your databases. To help you maintain and organize your databases, you can:

- Print the contents of a Browser
- Search the contents of a Browser
- Copy the contents of a Browser
- Sort the contents of a Browser

### Printing Browsers

1. Open a Browser for the desired object type.
2. On the File menu, click Print to open the Print dialog box.
3. In the Name box, click the list, which contains a list of local and network printers that you can access (if you do not see any listed, then your computer is not configured for any printers).
4. Click the target printer.
5. In the Print Range box, click the appropriate option button to indicate print range.
6. In the Number of copies text box of the Copies box, click the Up or Down arrow or enter the number of copies.
7. Click OK.
   
   Rapid SQL prints the selection.
Searching Browsers
1. Open a Browser for the desired object type.
2. On the Edit menu, click Find.
   Rapid SQL opens the Find box.
3. In the Find What text box, enter the search string.
4. To make the search case sensitive, select the Match Case check box.
5. To specify the direction to search, in the Direction box, click the Up or Down option button.
6. Click Find Next.
   Rapid SQL finds the next occurrence of your search string.

Copying Browsers
1. Open a Browser for the desired object type.
2. Select the objects to copy.
3. On the Edit menu, click Copy.
4. Place the pointer at the position where you want to paste the objects, and then on the Edit menu, click Paste.

Sorting Browsers
1. Open or Create a Browser for the desired object type.
2. Double-click the column header for the column of data to sort and Rapid SQL lists the contents of the column in ascending order.
3. Double-click the column header again and Rapid SQL lists the contents of the column in descending order.

For more information, see Browsers.

COLUMN FILTERING IN THE BROWSER
Two methods of filtering are available when database objects are displayed in the Browser. Both make use of the text boxes appearing below column names in the display.
To show only rows for which a given column value contains one or more contiguous characters

1. Type those characters into the text box below that column name.

To make use of regular expressions in column filtering

1. Ensure that regular expression usage is enabled. For details, see "Explorer Options - Main Tab" on page 101.

2. Type a valid regular expression search criteria into the text box below that column name. For more information, see "Regular Expressions Support in Rapid SQL" on page 729.

**NOTE:** The RegEx ON/RegEx OFF button lets you enable or disable regular expression usage on-the-fly for a given Explorer window.

**Extracting DDL from Browsers**

For each database type, Rapid SQL provides an appropriate Browser. The Browsers are mutually exclusive object windows, showing only objects of a given type. If you connect to multiple datasources, you have access to a number of objects that are not available based on the database platform. Rapid SQL includes intelligence to determine the valid object types in the underlying datasource.

**Using the Main Menu**

1. On the Browse menu, click the target object type.

   Rapid SQL opens the appropriate Browser:

2. In the Browser, double-click the target object type to extract the object type DDL into a DDL Editor.

**Using the Browser Toolbar**

1. On the Browser toolbar, click Tables.

   Rapid SQL opens the Table Browser:

2. Click the scroll bar arrow to locate the target table.

3. Double-click the target table.

   Rapid SQL extracts the schema DDL into a DDL Editor.

**Using the Shortcut Menu**

1. Right-click an open area of the workspace, click Browsers, and then click the target object type.

2. In the Browser, double-click the target object type.

   Rapid SQL extracts the schema DDL into a DDL Editor.
For more information, see Browsers.

DISPLAYING DEPENDENCIES FROM BROWSERS
You can display object dependencies for an object from its corresponding object Browser. Rapid SQL displays the dependencies in a separate result set window.

Displaying Dependencies
Rapid SQL offers three ways to display dependencies from Browsers:

1. Open a Browser for an object type.
2. In the Browser, click the target object.
3. On the Object menu, click Dependencies.
   OR
   On the Browser toolbar, click Dependencies.
   OR
   Right-click the target object and then click Dependencies.

Rapid SQL displays dependencies in a separate window.

For more information, see Browsers.

REFRESHING BROWSERS
Rapid SQL lets you refresh and display the results of a Browser operation.

Refreshing the Browser
1. On the Object menu, click Refresh.
   OR
   On the Browser toolbar, click Refresh.
   OR
   Right-click the Browser workspace and then click Refresh.

Rapid SQL refreshes the results of the browser operation.

For more information, see Browsers.

WORKSPACES
Workspaces are a convenient way to maximize your desktop. You can use workspaces to multiply the amount of scripting, script execution, and development resources you have available at any one time. Rapid SQL lets you open and use several workspaces at one time. Using more than one workspace lets you:
• Execute long running scripts in one workspace while working in other workspaces.
• Develop strategies for working on scripts and result sets in one workspace while other scripts reside in one or more of the other workspaces.

**Toggling Between Workspaces**
Rapid SQL offers two ways to toggle between workspaces:

1. On the **Main** toolbar, click **Workspace**.

OR

2. Right-click the current workspace and then click the target workspace.

Rapid SQL brings the target workspace forward.

For more information, see:

*Managing Workspaces*

**MANAGING WORKSPACES**
Rapid SQL provides you with three default workspaces. You manage the workspaces in the **Workspace** dialog box. Using the **Workspace** dialog box you can:

• Differentiate between workspaces by changing the background color or wallpaper.
• Toggle among workspaces.
• Create, delete, rename, and specify the order of workspaces.

**Managing Workspaces**
The **Workspace** dialog box lets you manage all open windows in your workspace.

1. On the **Windows** menu, click **Windows**.

Rapid SQL displays the **Workspace** dialog box. Any open windows in the current workspace display in the list.

The table below describes the options and functionality on the **Workspace** dialog box:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Activate</td>
<td>Sets the focus onto the window you have selected in the list and closes the <strong>Workspace</strong> dialog box.</td>
</tr>
<tr>
<td>OK</td>
<td>Closes the <strong>Workspace</strong> dialog box and accepts any changes you have made to the windows in the current workspace.</td>
</tr>
<tr>
<td>Save</td>
<td>Saves the contents of the window you have selected in the list. You are prompted to provide a name and location for the file you are saving if you have not done so already.</td>
</tr>
<tr>
<td>Close Window</td>
<td>Closes the window you have selected from the list. If you have not saved the contents of the window, you are prompted with a save file alert.</td>
</tr>
</tbody>
</table>
The Set Sort Columns dialog box lets you sort multiple columns, and sort column identification, in the Right Pane of the application.

For more information, see [Completing the Set Columns Dialog Box](#).

### Completing the Set Columns Dialog Box
To complete the Set Columns dialog box, do the following:

1. In the right pane of the application, right-click a column heading and select Sort Multiple Columns.
   
   Rapid SQL opens the Set Sort Columns dialog box.
2. In Column Name select the column(s) to use to sort the information in the right pane of the application.
3. Click the right arrow to move the column(s) to the Column Name box.
4. Click the up and down arrows to change the order of the sort columns.

For more information, see [Set Sort Column Dialog Box](#).

### Preview Dialog Boxes
Before executing any code, Rapid SQL offers Preview dialog boxes to let you confirm actions before execution. In the Preview dialog boxes, you can:

- Preview the code to execute.
- View the SQL of the code on your database.
- Create a report detailing the affect of executing code on your database.
- Schedule execution of the code.
- Save the code to execute.
- Open your e-mail program with the code to execute as an attachment.
- Print the code to execute.
MENUS
Rapid SQL offers two context-sensitive menus to let you access all the application’s features. The Main Menu is always on the top of the application window. The shortcut menu is accessible from almost anywhere in the application. Right-click to view the available shortcut menu. Rapid SQL lets you customize the Tools menu to help you tailor the application to your needs.

Topics
- Main Menu
- Shortcut menus
- Customizing General User Interface Appearance

MAIN MENU
Rapid SQL’s features can all be accessed from the Main Menu by clicking the menu name and selecting from the submenu. The menus are context sensitive and change based on the tasks you want to perform. The table below describes the Rapid SQL menus:

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>File</td>
<td>Create, open, close, print, send, and save script files and result sets. Set application options and defaults.</td>
</tr>
<tr>
<td>Datasource</td>
<td>Create, modify, select, connect to, and disconnect from datasources. Access the database search facility.</td>
</tr>
<tr>
<td>Project</td>
<td>Available only when a project is open. Configure project management, build projects, and use version control functions.</td>
</tr>
<tr>
<td>Browse</td>
<td>Browse any object type a datasource connection.</td>
</tr>
<tr>
<td>Logfile</td>
<td>Activate/deactivate, open, set options, and flush the Rapid SQL application log.</td>
</tr>
<tr>
<td>View</td>
<td>Arrange the Rapid SQL environment. Display or hide the Database Explorer, toolbars, Output Window, Describe window, activate full-screen mode.</td>
</tr>
<tr>
<td>Tools</td>
<td>Choose any of Rapid SQL’s tools, such as Database Search and the Visual Diff Utility. Customize and add tools of your own.</td>
</tr>
<tr>
<td>Bookmarks</td>
<td>Access and manage bookmarks.</td>
</tr>
<tr>
<td>Help</td>
<td>Access HTML Help.</td>
</tr>
<tr>
<td>Query</td>
<td>Available only when an Editor is open. Execute and set options for your SQL scripts.</td>
</tr>
<tr>
<td>Object</td>
<td>Available only when a browser is open. Execute, view dependencies, extract, and refresh objects in a database.</td>
</tr>
<tr>
<td>Edit</td>
<td>Available only when an Editor is open. Edit and manipulate the text in your scripts.</td>
</tr>
<tr>
<td>Format</td>
<td>Available only when a Result Window is active. Format the contents of result sets.</td>
</tr>
<tr>
<td>Window</td>
<td>Cascade and tile open windows. Toggle among open windows.</td>
</tr>
</tbody>
</table>
APPLICATION BASICS

For more information, see Menus.

EXPLORER BOOKMARKS
The Bookmarks menu lets you access and manage explorer bookmarks. Explorer bookmarks let you quickly access nodes in the Database Explorer.

Creating Explorer Bookmarks
1. On the Database Explorer, right-click the target node, and then select Add Bookmark.
   Rapid SQL opens the Add Friendly Bookmark Name dialog box.
2. Type the explorer bookmark name.
3. Click OK.
   Rapid SQL displays the explorer bookmark under the Bookmarks menu. Explorer bookmarks are organized by platform.

Editing Explorer Bookmarks
1. On the Main Menu, select Bookmarks.
2. Select Bookmark Manager.
   Rapid SQL opens Bookmark Manager.
3. To rename the explorer bookmark, select the target explorer bookmark, and then click Rename.
   Rapid SQL opens the Edit Bookmark Name dialog box.
4. Type the new explorer bookmark name.
5. Click OK.
6. To delete an explorer bookmark, select the target explorer bookmark, and then click Delete.
   **TIP:** To add explorer bookmarks without using the Add Friendly Bookmark Name dialog box, select Do not show ‘Add Friendly Bookmark Name’ dialog option.

SHORTCUT MENUS
Rapid SQL incorporates context-sensitive menus to give you another way to access object functionality. These menus mirror the functionality that you can access from application toolbars or the main menu.

Opening Shortcut Menus
1. Right-click anywhere on the Rapid SQL desktop to open the appropriate shortcut menu.

For more information, see Menus.
TOOLBARS
Rapid SQL toolbars change to reflect the element of the application you are using. The toolbars contain icons that are the fastest way to access commonly used features of Rapid SQL. You can move the toolbars to horizontal or vertical positions anywhere on the screen, and you can toggle them off and on by using the shortcut menu when the pointer is positioned over one of Rapid SQL's toolbars. For more information, see the following topics:

- [Available Toolbars](#)
- [Using Toolbar Viewing Options](#)
- [Moving Toolbars](#)

**NOTE:** For related information, see [Customizing General User Interface Appearance](#).

AVAILABLE TOOLBARS
The following list represents Rapid SQL's toolbars:

Datasource Toolbar

![Datasource Toolbar](image)

Registration Toolbar

![Registration Toolbar](image)

Main Toolbar

![Main Toolbar](image)

Windows Toolbar

![Windows Toolbar](image)

Tools Toolbar

![Tools Toolbar](image)
APPLICATION BASICS

Project Toolbar

SQL Edit Toolbar

Browsers Toolbar

USING TOOLBAR VIEWING OPTIONS
Rapid SQL offers standard Windows toolbar options such as docking, floating, and positioning toolbars. The only application-specific viewing option is the hiding or display of the individual toolbars.

To hide or display a toolbar
1. On the View menu, select Toolbars and then select the specific toolbar you want to display or hide.

For information on the toolbars available, see Available Toolbars.

MOVING TOOLBARS
1. Click the pointer at the right edge of any toolbar.
2. Drag the toolbar to the new position.

For more information, see Toolbars.

CUSTOMIZING GENERAL USER INTERFACE APPEARANCE
Rapid SQL lets you choose from a set of general visual application styles, dictate hiding or display of particular items, and select preferences for specific user interface elements.
To customize the general look and feel of Rapid SQL

1. On the **View** menu, select **Toolbars** and then select **Customize**. The **Customize** dialog opens.

2. Use the following table as a guide to understanding and setting options on tabs of the **Customize** dialog:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Toolbars</td>
<td>Select the toolbars you want to display in the application. For information on the toolbars available, see Available Toolbars.</td>
</tr>
<tr>
<td>Application Visual Style</td>
<td>Select a visual style such as Microsoft Windows XP or one of the .NET options from the dropdown. Depending on your selection, the following options may or may not be enabled: <strong>Use default Windows XP colors, OneNote style tabs, Docking Tab Colors, Allow MDI Tab Swapping, Enable Smart Docking, Enable Tab Menu, and 3D Rounded Docking Tabs.</strong></td>
</tr>
<tr>
<td>Menu animations</td>
<td>Lets you specify a menu animation style of UNFOLD, SLIDE, or FADE.</td>
</tr>
<tr>
<td>Menu Shadows</td>
<td>Displays shadowed 3D effects.</td>
</tr>
<tr>
<td>Tools</td>
<td>Lets you define external applications to run from the <strong>Tools</strong> menu of Rapid SQL: the text displayed on the Tools menu command (<strong>Menu contents</strong>), the path and file name of the executable (<strong>Command</strong>), optional <strong>Arguments</strong>, and an optional <strong>Initial Directory</strong>. For detailed information on providing arguments, see Specifying an Argument for a Tools Menu Command.</td>
</tr>
<tr>
<td>Keyboard</td>
<td>Select a general category for a hot key for the command.</td>
</tr>
<tr>
<td>Commands</td>
<td>Select a hot key command, based on the general category.</td>
</tr>
<tr>
<td>Description</td>
<td>Displays the command description.</td>
</tr>
<tr>
<td>Set Accelerator for</td>
<td>Select application area where you want new hot key to be active.</td>
</tr>
<tr>
<td>Current Keys</td>
<td>Displays current hot key.</td>
</tr>
<tr>
<td>Press New Shortcut Key</td>
<td>Press keyboard key or an unassigned F key.</td>
</tr>
<tr>
<td>Options</td>
<td><strong>Show ScreenTips on toolbars</strong> Select to display a ScreenTip when you hover your mouse over a button. For example, when you hover your mouse over the New button, Rapid SQL displays the ScreenTip “New.”</td>
</tr>
<tr>
<td></td>
<td><strong>Show shortcut keys in ScreenTips</strong> Select to display a shortcut key in the ScreenTip when you hover your mouse over a button. For example, when you hover your mouse over the New button, Rapid SQL displays the ScreenTip “New (CTRL+N).”</td>
</tr>
</tbody>
</table>

3. Click **Apply** at any time to implement any changes you have made and when finished, click **Close**.

**Specifying an Argument for a Tools Menu Command**

You can specify an argument to be passed to a program for newly added commands by choosing one of Rapid SQL’s predefined arguments or entering a command-line argument.
The table below provides scenarios of how to use command-line arguments:

<table>
<thead>
<tr>
<th>Command</th>
<th>Argument</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>NOTEPAD.EXE</td>
<td>$$FilePath$$</td>
<td>Starts Microsoft Notepad displaying the contents of the $$FilePath$$ argument.</td>
</tr>
<tr>
<td>ISQL.EXE</td>
<td>-U$$CurUserID$$  -P$$CurPwd$$ -S$$CurConString$$ -i$$FilePath$$</td>
<td>Starts ISQL, automatically connects to the current datasource using the current user name and password, and executes the contents of $$FilePath$$.</td>
</tr>
</tbody>
</table>
| SQLPLUS.EXE | $$CurUserID$$/ $$CurPwd$$@$$CurConString$$ @$FilePath$$ | Starts SQL*Plus, connects to the current datasource using the current user name and password, and executes the contents of $$FilePath$$.

The table below provides scenarios of how to use Rapid SQL's predefined arguments:

<table>
<thead>
<tr>
<th>Argument</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>$$FilePath$$</td>
<td>The complete filename of the current source (defined as drive+path+filename); blank if a non-source window is active.</td>
</tr>
<tr>
<td>$$FileDir$$</td>
<td>The directory of the current source (defined as drive+path); blank if a non-source window is active.</td>
</tr>
<tr>
<td>$$FileName$$</td>
<td>The filename of the current source (defined as filename); blank if the non-source window is active.</td>
</tr>
<tr>
<td>$$FileExt$$</td>
<td>The filename extension of the current source; blank if a non-source window is active.</td>
</tr>
<tr>
<td>$$CurLine$$</td>
<td>The current cursor line position within the active window.</td>
</tr>
<tr>
<td>$$CurCol$$</td>
<td>The current cursor column position within the active window.</td>
</tr>
<tr>
<td>$$CurText$$</td>
<td>The current text (the word under the current cursor position, or the currently selected text, if there is one).</td>
</tr>
<tr>
<td>$$CurDir$$</td>
<td>The current working directory (defined as drive+path).</td>
</tr>
<tr>
<td>$$CurDatasource$$</td>
<td>The name of the current datasource as defined in Rapid SQL.</td>
</tr>
<tr>
<td>$$CurUserID$$</td>
<td>The name of the current datasource user.</td>
</tr>
<tr>
<td>$$CurPwd$$</td>
<td>The current datasource password.</td>
</tr>
<tr>
<td>$$CurConString$$</td>
<td>The current connection string or server name.</td>
</tr>
</tbody>
</table>
PREDEFINED ARGUMENTS
Rapid SQL provides a number of predefined arguments that you can pass to programs that you have added to the Tools menu. The table below lists the available predefined arguments:

<table>
<thead>
<tr>
<th>Argument</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>$$FilePath$$</td>
<td>The complete filename of the current source (defined as drive+path+filename); blank if a non-source window is active.</td>
</tr>
<tr>
<td>$$FileDir$$</td>
<td>The directory of the current source (defined as drive+path); blank if a non-source window is active.</td>
</tr>
<tr>
<td>$$FileName$$</td>
<td>The filename of the current source (defined as filename); blank if the non-source window is active.</td>
</tr>
<tr>
<td>$$FileExt$$</td>
<td>The filename extension of the current source; blank if a non-source window is active.</td>
</tr>
<tr>
<td>$$CurLine$$</td>
<td>The current cursor line position within the active window.</td>
</tr>
<tr>
<td>$$CurCol$$</td>
<td>The current cursor column position within the active window.</td>
</tr>
<tr>
<td>$$CurText$$</td>
<td>The current text (the word under the current cursor position, or the currently selected text, if there is one).</td>
</tr>
<tr>
<td>$$CurDir$$</td>
<td>The current working directory (defined as drive+path).</td>
</tr>
<tr>
<td>$$CurDatasource$$</td>
<td>The name of the current datasource as defined in Rapid SQL.</td>
</tr>
<tr>
<td>$$CurUserID$$</td>
<td>The name of the current datasource user.</td>
</tr>
<tr>
<td>$$CurPwd$$</td>
<td>The current datasource password.</td>
</tr>
<tr>
<td>$$CurConString$$</td>
<td>The current connection string or server name.</td>
</tr>
</tbody>
</table>

NOTE: Arguments are case-sensitive.

KEYBOARD SHORTCUTS
Rapid SQL provides a number of keyboard shortcuts to help you expedite your tasks. The table below lists the taxes and related shortcuts:

<table>
<thead>
<tr>
<th>General Editing</th>
<th>Keyboard Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delete one character to the left</td>
<td>BACKSPACE</td>
</tr>
<tr>
<td>Delete one character to the right</td>
<td>DELETE</td>
</tr>
<tr>
<td>Cut selected text to the Clipboard</td>
<td>CTRL+X</td>
</tr>
<tr>
<td>Undo the last action</td>
<td>CTRL+Z</td>
</tr>
<tr>
<td>Redo the last undo operation</td>
<td>CTRL+Y</td>
</tr>
<tr>
<td>Copy text</td>
<td>CTRL+C</td>
</tr>
<tr>
<td>Paste the Clipboard contents</td>
<td>CTRL+V</td>
</tr>
</tbody>
</table>
### To Extend a Selection

<table>
<thead>
<tr>
<th>Description</th>
<th>Keyboard Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>One character to the right</td>
<td>SHIFT+RIGHT ARROW</td>
</tr>
<tr>
<td>One character to the left</td>
<td>SHIFT+LEFT ARROW</td>
</tr>
<tr>
<td>To the end of a word</td>
<td>CTRL+SHIFT+RIGHT ARROW</td>
</tr>
<tr>
<td>To the beginning of a word</td>
<td>CTRL+SHIFT+LEFT ARROW</td>
</tr>
<tr>
<td>To the end of a line</td>
<td>SHIFT+END</td>
</tr>
<tr>
<td>To the beginning of a line</td>
<td>SHIFT+HOME</td>
</tr>
<tr>
<td>One line down</td>
<td>SHIFT+DOWN ARROW</td>
</tr>
<tr>
<td>One screen up</td>
<td>SHIFT+PAGE UP</td>
</tr>
<tr>
<td>To the beginning of a document</td>
<td>CTRL+SHIFT+HOME</td>
</tr>
<tr>
<td>To the end of a document</td>
<td>CTRL+SHIFT+END</td>
</tr>
<tr>
<td>To include the entire document</td>
<td>CTRL+A</td>
</tr>
</tbody>
</table>

### To Move the Insertion Point

<table>
<thead>
<tr>
<th>Description</th>
<th>Keyboard Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>One character to the left</td>
<td>LEFT ARROW</td>
</tr>
<tr>
<td>One character to the right</td>
<td>RIGHT ARROW</td>
</tr>
<tr>
<td>One word to the left</td>
<td>CTRL+LEFT ARROW</td>
</tr>
<tr>
<td>One word to the right</td>
<td>CTRL+RIGHT ARROW</td>
</tr>
<tr>
<td>One line up</td>
<td>UP ARROW</td>
</tr>
<tr>
<td>One line down</td>
<td>DOWN ARROW</td>
</tr>
<tr>
<td>To the end of a line</td>
<td>END</td>
</tr>
<tr>
<td>To the beginning of a line</td>
<td>HOME</td>
</tr>
<tr>
<td>One screen up (scrolling)</td>
<td>PAGE UP</td>
</tr>
<tr>
<td>One screen down (scrolling)</td>
<td>PAGE DOWN</td>
</tr>
<tr>
<td>To the end of a document</td>
<td>CTRL+END</td>
</tr>
<tr>
<td>To the beginning of a document</td>
<td>CTRL+HOME</td>
</tr>
</tbody>
</table>

### Bookmarks

<table>
<thead>
<tr>
<th>Description</th>
<th>Keyboard Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Toggle bookmark on/off</td>
<td>CTRL+F2</td>
</tr>
<tr>
<td>Go to next bookmark</td>
<td>F2</td>
</tr>
<tr>
<td>Go to previous bookmark</td>
<td>SHIFT+F2</td>
</tr>
</tbody>
</table>
### Splitter Windows

<table>
<thead>
<tr>
<th>Action</th>
<th>Keyboard Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Go to next pane</td>
<td>F6</td>
</tr>
<tr>
<td>Go to previous pane</td>
<td>SHIFT+F6</td>
</tr>
</tbody>
</table>

### Debugger Operations

<table>
<thead>
<tr>
<th>Operation</th>
<th>Keyboard Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start Debugging</td>
<td>CTRL+F5</td>
</tr>
<tr>
<td>Stop Debugging</td>
<td>SHIFT+F5</td>
</tr>
<tr>
<td>Step Over</td>
<td>F10</td>
</tr>
<tr>
<td>Step Into</td>
<td>F11</td>
</tr>
<tr>
<td>Run to Cursor</td>
<td>CTRL+F10</td>
</tr>
<tr>
<td>Step Out</td>
<td>SHIFT+F11</td>
</tr>
<tr>
<td>Describe from Cursor</td>
<td>CTRL+D</td>
</tr>
<tr>
<td>Insert or Remove Breakpoint</td>
<td>F9</td>
</tr>
<tr>
<td>Toggle (Enable or Disable) Breakpoint</td>
<td>CTRL+F9</td>
</tr>
<tr>
<td>Edit Breakpoint</td>
<td>ALT+F9</td>
</tr>
<tr>
<td>Go</td>
<td>F5</td>
</tr>
<tr>
<td>Restart</td>
<td>CTRL+SHIFT+F5</td>
</tr>
</tbody>
</table>

### Debugger Windows

<table>
<thead>
<tr>
<th>Window</th>
<th>Keyboard Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open or Close Watch Window</td>
<td>ALT+3</td>
</tr>
<tr>
<td>Open or Close Variables Window</td>
<td>ALT+4</td>
</tr>
<tr>
<td>Open or Close Call Stack Window</td>
<td>ALT+5</td>
</tr>
<tr>
<td>Open or Close Dependency Tree Window</td>
<td>ALT+6</td>
</tr>
</tbody>
</table>

### Other Windows

<table>
<thead>
<tr>
<th>Window</th>
<th>Keyboard Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Go to the Result Tab</td>
<td>CTRL+ALT+R</td>
</tr>
<tr>
<td>Go to the Query Tab</td>
<td>CTRL+ALT+Q</td>
</tr>
<tr>
<td>Open the Describe window (for highlighted object)</td>
<td>CTRL+D</td>
</tr>
<tr>
<td>Toggle between Workspaces</td>
<td>CTRL+W</td>
</tr>
<tr>
<td>Toggle between Datasource Explorer and ISQL Window.</td>
<td>CTRL+ALT+E</td>
</tr>
</tbody>
</table>
**FULL SCREEN MODE**
Rapid SQL has full screen mode capabilities so you can conceal the application framework and use the entire monitor area. Full screen mode hides any other applications running on the computer and uses every available pixel for the application. Main menu functionality is accessible through keyboard commands when you use full screen mode.

**Activating Full Screen Mode**
Rapid SQL offers two ways to activate full screen mode:

1. On the **View** menu, click **Full Screen**.

   OR

2. On the **Main** toolbar, click **Full Screen**.

   Rapid SQL expands the application to fit the entire monitor area.

   **NOTE:** The Full Screen mode icon is a stand-alone floating toolbar.

**Dismissing Full Screen Mode**

1. Click **Full Screen** to expand the application to fit the entire monitor area.

   **TIP:** If you closed the Full Screen mode toolbar, right-click the top of the Rapid SQL desktop to bring the toolbar back.

2. Click **Full Screen** to restore the application to the default size.
**TUTORIAL EXERCISES**

The exercises that follow walk you through the Rapid SQL's major functional areas. After completing these exercises, you will have the foundation you need to explore the many features and benefits of Rapid SQL. You’ll have learned how to competently manage the major database administration and development tools provided.

This guide is divided into a set of sessions:

- **Session 1: Getting Started**
- **Session 2: Productivity Enhancers**
- **Session 3: Scripting**
- **Session 4: Working with Code Workbench**
- **Session 5: Building a Database Project**
- **Session 6: Visual Query Builder**
- **Session 7: Live Data Editor**
- **Session 8: Code Analyst**
- **Session 9: SQL Debugging and Profiling**

You can use this basic tutorial as a roadmap of product highlights, but also to help you find your own path to explore Rapid SQL.

Once you’ve started, you can select Help Topics from the Help menu to find many additional resources that complement and build on many of the activities shown in this tutorial.

**NOTE:** The tutorial exercises make use of the sample SQL Server database, **AdventureWorks**. Since this is not part of a typical install, you can obtain the files from installation CDs or online sources to install and attach that database. Alternatively, you can perform the tasks targeted for the **AdventureWorks** database against another available database. No destructive actions are initiated in the exercises.

**SESSION 1: GETTING STARTED**

Before anything else, you must perform the following tasks:

- **Starting Rapid SQL**
- **Registering Cross-Platform Datasources**

**STARTING RAPID SQL**

How you start Rapid SQL depends on the type of application you are evaluating:

- **InstantOn version** - start the application by double-clicking the file you downloaded.
• **Fully-installed version** - The Start menu sequence for Rapid SQL is always in the form Programs > Embarcadero Rapid SQL version identifier > Embarcadero Rapid SQL version identifier, where version identifier reflects the version you are running.

**To get started**

1. Run Rapid SQL.

   The first time Rapid SQL starts, a dialog opens, prompting you to set up datasources. In addition to letting you manually set up individual datasources, a number of more automated methods are available. If you have installed and used other Embarcadero tools, Rapid SQL can find any active datasources being used by those tools. In addition, Rapid SQL provides a Discover Datasources feature that automatically searches the DBMS configuration files on your system for datasources that are not currently registered. Since other Embarcadero tools let you export datasource definitions to file, you also have the option of importing these definitions.

2. For the purpose of this tutorial, click **Cancel**. You will be registering a datasource manually.

   The main Rapid SQL window opens.
REGISTERING CROSS-PLATFORM DATASOURCES

For now, you will register a datasource manually.

1. On the **Datasource** menu, select **Register Datasource**. A **Datasource Registration** Wizard opens.

2. Choose **Microsoft SQL Server** as the DBMS type and then click **Next**. The next panel opens.

3. Ensure that a **Registration type** of **User defined** is selected, specify the **Host** name of an SQL Server datasource on your network, override the **Datasource Name** with **SAMPLE_DATASOURCE** and then click **Next**.

4. Provide valid credentials in the **User ID** and **Password** boxes, and then select the **Auto-Connect?** checkbox to eliminate having to provide credentials each time you connect to this datasource.

5. In the left-hand pane, select **Datasource Group**, select the **MS SQL Server** folder, and then click **Finish**.

   **NOTE:** The **Datasource Group** panel also lets you assign a category to a datasource. This provides a means to visually distinguish between different server purposes, development vs. production, for example, in your enterprise. Categorization is a customizable feature.

6. Select **Yes** when prompted to connect to the new datasource.
Rapid SQL offers the same easy-to-use Datasource Registration Wizard for all supported DBMS platform connections. The connection information only needs to be set up one time for each platform and can be saved locally or in a common datasource catalog for use by other Embarcadero products.

By default, Rapid SQL stores datasource definitions in the Windows Registry. There is also a local, file-based option. Embarcadero products supporting these methods can share datasource catalogs on the same machine.

There is also a network-shared storage option. Lastly, datasource definitions can be stored centrally on an Embarcadero Connect server for use by Rapid SQL users.

Rapid SQL also offers the ability to import and export datasource definitions. This lets you share definitions among users and across datasource storage methods.

**SESSION 2: PRODUCTIVITY ENHANCERS**

This session focuses on some commonly used time-saving features:

- The Datasource Navigator Tree
- Creating an Object Using the Object Creation Wizard
- Working With an Existing Object Using the Object Editor
- Object Documentation and Reporting
- Working With Code, Files and Data
- Setting Environment Options
- Favorites Tab
- Working with Scripts and Files
- Viewing Data
- Retaining Datasource Navigator View Settings
- Datasource Navigator Bookmarks
- Setting Keyboard Shortcuts and Hotkeys
- Referencing Most Recently Used Datasources
THE DATASOURCE NAVIGATOR TREE
Rapid SQL makes it easy and intuitive to navigate between datasources and to drill-down into atomic database objects within the Datasource Navigator tree. The Datasource Navigator displays all registered datasources and serves as the entry-point for much of Rapid SQL's advanced functionality.

1. Click on the Navigator's dropdown and ensure that Organize By Object Type is selected.

2. Select and expand the SAMPLE_DATASOURCE > Databases > AdventureWorks node to display the database object sub-nodes.
CREATING AN OBJECT USING THE OBJECT CREATION WIZARD

From within the Navigator tree you can create any database object using simple Object Creation Wizards. The following is an example of how to use the Table Object Creation Wizard. It is similar to the Object Creation Wizards available within Rapid SQL for all database objects and other supported elements.

1. Right-click on the Tables node and select Create. A Create Table Wizard opens.

2. Select a Schema and provide a Name of SAMPLE_TABLE. Leave the remaining default settings and click Next.

3. Add a column, using a Name of Sample_Column1 and select a Type of char. Experiment with the Add Column and Delete buttons, and with selecting a column and modifying its attributes.

4. Click Finish. The DDL View panel opens showing the DDL that will be used to create the new table.

5. Deselect the Launch Object Editor After Execute and then click Execute.

Rapid SQL builds the platform-specific SQL code, syntactically-correct and ready to run the first time. There is no SQL coding required in any of the Rapid SQL Object Creation Wizards.
WORKING WITH AN EXISTING OBJECT USING THE OBJECT EDITOR

While the wizard offered you the option to automatically open an editor on creating the table, you can also manually open an editor.

1. In the Navigator, ensure that the Tables node is expanded and then right-click on your new table and select Open.

Object Editor features are as follows:

- All Object Editors provide standardized, multi-tabbed windows for each database object type.
- All Object Editors provide fully-functional toolbars for easy object management.
- Rapid SQL has full knowledge of the underlying DBMS system catalog, syntax and alteration rules, so the user can concentrate on what needs to be done, not on how to do it.
- Drop-down boxes allow you to easily move between owners and objects.
- The Rapid SQL Object Editors easily perform operations that would normally require painstaking and error-prone scripting, such as deleting or inserting columns in a table while preserving data, dependencies and permissions. Rapid SQL analyzes the database catalog to determine its structure, and then automatically generates the SQL script required for the extended alteration. For instance, when a full table alteration is required, Rapid SQL automatically unloads and reloads the data, eliminating tedious work.

2. Close the Object Editor window.
OBJECT DOCUMENTATION AND REPORTING

Rapid SQL provides rich, detailed HTML Reporting for all database objects. Building a browser-ready report for any object is only a few mouse-clicks away.

1. Expand the Tables node, right-click on any table and select Report from the menu. A Report dialog opens.

2. Enter a destination Report Home Page File Name. This can be a network web server directory.

3. Enter a Report Title and click Execute.

The HTML report will automatically be displayed in the Rapid SQL application workspace. For example:

```
dbo.SAMPLE_TABLE

<table>
<thead>
<tr>
<th>Object Type</th>
<th>Table</th>
</tr>
</thead>
<tbody>
<tr>
<td>Datasource</td>
<td>ROMLAESQL05_1 (SQL Server 09.00.3073)</td>
</tr>
<tr>
<td>Login</td>
<td>sa</td>
</tr>
<tr>
<td>Database</td>
<td>AdventureWorks</td>
</tr>
<tr>
<td>Report Date</td>
<td>7/23/2012 17:28:27.894</td>
</tr>
</tbody>
</table>

Columns

<table>
<thead>
<tr>
<th>Name</th>
<th>Datatype</th>
<th>Null</th>
<th>Default</th>
<th>Default Binding</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sample_Column1</td>
<td>char(1)</td>
<td>Yes</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
```

The HTML report can be saved to a new file or referenced in the file named above.

**NOTE:** All HTML reports are browser-ready and suitable for posting directly to the web.

WORKING WITH CODE, FILES AND DATA

Rapid SQL provides many features and powerful development tools for creating and executing SQL code and working with data.

**NOTE:** For purposes of this exercise, we are only covering high-level functionality of the major features and tools within Rapid SQL.
SETTING ENVIRONMENT OPTIONs

The **Options** dialog allows you to set the Rapid SQL development environment to meet your needs.

1. Select **File > Options** from the menu. The **Options** dialog opens.

The **Options** dialog has one page per option category. Select an option category in the left-hand pane and you can subsequently set options on that page. Options are applied when you click **OK**.

2. Close the **Options** dialog.

FAVORITES TAB

The **Favorites** Explorer provides a drag-and-drop library interface of all supported DBMS syntax, SQL syntax, built-in functions, optimizer hints, and SQL-conditional syntax. Additionally, it provides the ability to create custom folders to store commonly-used code for quick and efficient access, as needed.

To open the Favorites Explorer:

1. Select **View > Favorites**. The Favorites window opens.

2. Expand the **Microsoft** node and then expand the **Schema** sub-node.
3. Right-click the **Procedures** node and select **Open**. The selected code opens in the SQL Editor window and is ready for execution.

4. Right-click in the editor window and select **Close** from the context menu.

**To add a custom folder to the Favorites Explorer**

1. Right-click the **Favorites > Schema** folder.

2. Select **New Folder** from the menu. A new folder is added to the bottom of the **Schema** folder.

**To close the Favorites Explorer:**

1. Select **View > Favorites**.

**WORKING WITH SCRIPTS AND FILES**

Rapid SQL extends the auto-generation of SQL code by allowing you to run your scripts across multiple databases at the same time.

**FILE EXECUTION FACILITY**

Files containing SQL scripts can be added to the File Execution Facility and executed immediately or scheduled to run later.

1. On the **Tools** menu, select **File Execution Facility**. Rapid SQL opens the **File Execution Facility** dialog box.

2. To locate the file you want to execute, click **Add**. Use the **Add Files** dialog box to locate and select a file.

3. On the **Target** tab, select the datasources to run the script against.

4. On the **Output** tab, select the desired output option. For the purposes of this example, select **Graphical Output**.

   **NOTE:** To enable the scheduling function for the script, you must select the **File Output** option.

5. If you want to send notification that the script has executed, on the **Notify** tab, complete the target information.

6. Click **Execute** if you want Rapid SQL to run the script against the target datasources. Otherwise, close the dialog without executing.

   **NOTE:** Separate script output windows are created for each selected datasource.
SCRIPT EXECUTION FACILITY
The Tools menu also offers a Script Execution Facility. Similar to the File Execution facility, it lets you type or paste the script to be executed.

VIEWING DATA
Rapid SQL provides several options for browsing data. In addition, it gives you the ability to construct even the most complex SQL statements with point-and-click ease.

SELECT * BROWSING
1. On the Datasource Navigator, expand the **MS SQL Servers** node.
2. Expand any database you know has table data, expand the **Tables** node, right-click a table, and then click **SELECT * FROM**.
   All columns and rows from the table are displayed in the active workspace.
3. Close the workspace window.

RETAINING DATASOURCE NAVIGATOR VIEW SETTINGS
1. Click on the dropdown at the top of the Datasource Navigator.
2. Select **Retain View Settings**.
The Navigator will open the next time just as you left it. All connections that were present when you closed Rapid SQL will be re-established.
DATASOURCE NAVIGATOR BOOKMARKS

Rapid SQL allows you to set bookmarks for frequently visited database objects.

1. Right-click on any node in the Datasource Navigator.

2. Select Add Bookmark and use the Add Friendly Bookmark Name dialog to optionally provide a new name, and create the bookmark.

After Bookmarks are defined you can use them to easily navigate to commonly used datasource resources. In this case, you would select the dropdown at the top of the Datasource Navigator, selecting Bookmarks > SQLServer and then selecting the bookmark you just created.

The Bookmark Manager handles maintenance of Bookmarks.
3 Select the dropdown at the top of the Datasource Navigator and then select **Bookmarks > Bookmark Manager**.

![Bookmark Manager](image)

4 Close the **Bookmark Manager** dialog.

**SETTING KEYBOARD SHORTCUTS AND HOTKEYS**

1 On the **Tools** menu, select **Customize**.

2 In the **Customize** dialog, go to the **Keyboard** tab.

![Customize Keyboard Tab](image)

The **Keyboard** tab can be used to set keyboard shortcut hotkeys for all areas of Rapid SQL functionality.

3 Close the **Customize** dialog.
REFERRING MOST RECENTLY USED DATASOURCES

1 Select **File > Recent Datasources** and then select a datasource.

```
Recent Datasources
  1 TORLABSQL05_1
  2 TORLABSQL05_2
  3 SAMPLE_DATASOURCE1
  4 TORLABSQL05_9
  5 TORLABSQL08_1
  6 TORLABSY15_2
  7 DALLAS9
  8 ROMLABSQL05_1
```

This will automatically place you on the datasource within the Navigator, ready to work with active connection.

SESSION 3: SCRIPTING

This session looks at Rapid SQL's development environment:

- **Generating Code**
- **Right-click feature**
- **Automated error detection and coding assistance**
- **Other coding aids**

GENERATING CODE

By providing several code generation and assistance options, Rapid SQL makes cross-platform development easy for developers of all experience levels.

**NOTE:** The following examples build on the SAMPLE_DATASOURCE registered earlier in this Evaluation Guide. These examples can be applied to any registered datasource for any of the supported platforms.

CODE GENERATION FACILITY

The Code Generation Facility can be used to create complete procedures, functions or packages revolving around views or tables.

1 From the menu, open **Tools > Code Generation Facility**.

2 Select the **SAMPLE_DATASOURCE** datasource, the **AdventureWorks** database, and the **Purchasing** schema from the dropdown list boxes.
3 Select the **Vendor** table, **Name** as the input column and all columns for output.

![Vendor Table Selection](image)

4 Select **Select** as the code option.

![Select Code Option](image)

5 Select a file to save the generated script and check **Open**.

![Select Output File](image)

6 Click **OK** and the DDL to create the procedure will be generated and displayed in an editable window, called the DDL Editor. You can edit the name of the new procedure and any of the generated code at this time. Name the new procedure **sample_select_vendors**.
7. Click on the Execute button to submit the DDL and create the procedure.

The indicated file will be saved on the selected directory.

**NOTE:** No SQL statement coding is required to generate complete stored procedures and packages. If applicable, Rapid SQL allows all generated code to be previewed and edited to fit any development need.

**RIGHT-CLICK FEATURE**

Similar to the Code Generation Facility, the "right-click" code generation feature can be used to create complete procedures, functions or packages revolving around views or tables.

1. From the Datasource Navigator tree, expand the **SAMPLE_DATASOURCE > AdventureWorks > Tables** sub-node.

2. Right-click on the **Vendors** table.

3. Select **Generate > Procedure > Select**.

4. Select **Name** as the input column, and leave all output columns selected.

5. Click **OK** and the DDL to create the procedure will be generated and displayed in the DDL Editor. You can edit the name of the new procedure and any of the generated code. Name the new procedure **sample_select_vendors2**.

6. Click on the **Execute** or **Step Execute** button to submit the DDL and create the procedure.

**AUTOMATED ERROR DETECTION AND CODING ASSISTANCE**

Rapid SQL provides a range of features that detect or help you avoid errors and save keystrokes in developing your scripts.
To enable these features:
1. On the File menu, select Options. The Options dialog opens.
2. In the left-hand pane, expand the ISQL node and then select Code Assist.
3. On the Code Assist panel:
   - Ensure that Enable Code Complete is selected.
   - Ensure that Severity levels for semantic validation problems has Warning selected.
   - Ensure that Enable Real-time syntax checking is selected.
4. Click OK.

To see these features in action:
1. On the File menu, click New, and then SQL.
   Rapid SQL opens the SQL Editor window. You can add SQL code via your method of choice (free-form typing, retrieve from a file, paste copied code, etc.).

2. Type `SELECT * FROM` and stop typing.
   Note the error condition.

   ![SQL Editor window with SELECT * FROM example]

3. This time type a fragment that includes the name of a nonexistent object, `SELECT * FROM NON.OBJECT`, for example. For now, ignore any popups. The warning condition is a result of on-the-fly semantic validation.

   ![SQL Editor window with SELECT * FROM NON.OBJECT example]

   Rapid SQL notifies you when a script contains a reference to an object that Rapid SQL cannot resolve.
4 Type `SELECT * FROM` followed by a space and then stop typing. If no popup appears, press CTRL+SPACE. The Code Complete suggestion box lets you select from objects or object name components such as databases or schema. This feature saves keystrokes and minimizes typing errors. See the online Help for full descriptions of these features.

5 Close the current SQL Editor window.

**To restore Rapid SQL settings:**
1 On the **File** menu, select **Options**. The **Options** dialog opens.
2 On the **Code Assist** panel, click the **Restore defaults** button.
3 Click **OK**.

**OTHER CODING AIDS**
Rapid SQL provides extensive, easy-to-use coding aids for all of the supported DBMS platforms, throughout the application. Aids are provided in the form of ready-to-use code templates and blocks of syntactically correct code.

**PASTE SQL**
1 From the Datasource Navigator tree, expand the **SAMPLE_DATASOURCE > AdventureWorks** sub-node.
2 Select **File > New > SQL** to open an SQL Editor window.
3 Select **Edit > Paste SQL Statement** to open the **Paste SQL** window.
4 On the **Paste SQL** dialog, select **Sample_Datasource** from the **Datasource** dropdown, **AdventureWorks** from **Database**, **All Owners** from **Owner**, and an **Object Type** of **Tables**.
5  In the **Tables** list, select **Purchasing.Vendor**.

6  Under the **Columns** list, click **ALL**.

7  Click the **Select** radio button.

8  Click **Paste Statement** to copy the generated code to the SQL Editor window. 

You can use the statement as is, or modify the code as needed.

**PASTE SQL SYNTAX**

1  Select **File > New > SQL** to open a fresh SQL Editor window.

2  Select **Edit > Paste SQL Syntax** to open the **SQL Syntax for SQL Server** window.
3 Select a template and click **Paste** to copy the code template into the SQL Editor window.

4 Add your own code to complete the needed operation.

**SESSION 4: WORKING WITH CODE WORKBENCH**

The Code Workbench lets you configure resources for two SQL Editor features:

- Code Templates
- Auto Replace

Code templates are complete code blocks that can be easily added to open windows or scripts with a few keystrokes. When you type CTRL+SPACE, the Code Assist menu opens, letting you select a code template for insertion in the editor window.
Auto Replace lets you define shortcuts consisting of a few characters that represent longer character strings. Instances of these Auto Replace expressions are automatically replaced by the replacement string on activation events such as typing SPACE, TAB, or RETURN. This feature is useful for creating shortcuts for one-line commands or SQL statement subsets, or even to detect and fix common typographical errors such as teh for the.

For example, consider an Auto Replace definition with an expression of sel to represent Select * From:

```
 sel
```

If the associated activation event includes a SPACE, then on typing sel followed by pressing SPACE, the following replacement occurs.

```
 select * from
```

Rapid SQL loads a default set of Auto Replace and Code template definitions at startup, but you can also add, edit, and delete definitions. In addition, you can save sets of definitions to file and subsequently load specific sets of definitions, allowing you to customize your templates to different platforms or development projects.

**To invoke Code Workbench settings:**

1. Select **Tools > Code Workbench**.

   ![Code Workbench settings](image)

   The **Settings** tab lets you enable the Auto Replace and Code Template features.

2. Inspect the **Code Templates** and **Auto Replace** tabs.

3. Click **OK**.
SESSION 5: BUILDING A DATABASE PROJECT

CREATING A NEW RAPID SQL PROJECT
Rapid SQL provides an excellent team development environment by allowing you to reverse engineer live database objects into off-line SQL source code files. You can subsequently perform tasks such as distribute the files or add them to a Version Control System (VCS). This example will reverse engineer the table objects from the Microsoft SQL Server AdventureWorks database into a Rapid SQL project.

1. Select File > New > Project to open the wizard.
2. Enter sample_project as the name, and accept the default target directory. Select From Database and click OK.
3. On the Connection page, select SAMPLE_DATASOURCE and click Next.
4. On the Catalogs page, select AdventureWorks and click Next.
5. Click Schemas to open the Schema Selection dialog. Select Human Resources, Purchasing, and Sales, and then click OK. The Object Selection page opens.
6. Under Object Types, select Tables. Then, under Objects, expand the Tables node and select the Purchasing.Vendor, Sales.SpecialOffer, and HumanResources.Employee tables. Click Next.
7. On the Options page, leave the default selections and click Finish.
8. When the Execute page shows that reverse engineering is complete, click Continue.

The Project tab displays the results of the reverse engineering.
Before closing the Project tab, investigate the individual project elements. In addition, check the File and Project menus for project and version control options.

SESSION 6: VISUAL QUERY BUILDER

Rapid SQL gives you the ability to construct complex SQL statements with point-and-click ease using the Visual Query Builder.

1. From the Navigator tree, right-click on the HumanResources.Employee table and select Build Query.

   The table is automatically added to the Query Builder workspace.

2. On the Tables/Views tab, right-click on the Department table and select Add.

3. Similarly, on the Tables/Views tab, right-click on the EmployeeDepartmentHistory table and select Add.

4. Rearrange the contents of the window to look like the following graphic.

5. Select the columns indicated in the graphic.
Note that the tables are automatically identified as being joined by any columns with the same name and datatype. Also, note that the query is being built in the lower pane.

6 Click on the DML tab to expose the visual query building clauses and options. You can right-click on any clause to easily add the code to the query.

7 Experiment with adding, deleting, and modifying clauses.

8 Click the **Execute** button to execute the query.

The results will display in the lower window.
Before closing the Query Builder, experiment with additional options. Try selecting a different statement type, such as **Insert** or **Update**, from the dropdown at the top of the Query Builder window. Use the different clauses on the DML tab.

**NOTE:** Any visual query builder session can easily be saved to a file for later use.

**SESSION 7: LIVE DATA EDITOR**

1. From the Navigator, right-click on the **Purchasing.Vendor** table and select **Edit Data**.

2. In the **Data Editor Filter** dialog, click **Add All** to add all columns to the editing session.

   At this point, you can add a WHERE clause that will filter for only the desired data. Note that Rapid SQL builds the SQL to retrieve the data to be edited in the **Select Statement** area.

3. Click **OK**. A Data Editor opens.

![Data Editor](image)

Note the dropdown at the left of the toolbar. The editing window has **LIVE** and **BATCH** modes:

- **LIVE** mode commits your changes each time you move to a new row.

- **BATCH** mode will allow you to move within the window and commit your changes when ready. Changes made in **BATCH** mode can be cancelled by selecting the **Reload Data** icon.

At any time during the session, you can change the filter parameters by selecting the **Filter Data** icon.
SESSION 8: CODE ANALYST

The Code Analyst allows you to capture run-time statistics on executable database objects, including stored procedures and functions. Not only can you capture statistics for single objects, but you can group more than one object.

To get started

   
   **NOTE:** In order for Code Analyst to run, 5 repository tables will be created on the database. Select the database you would like the tables to be installed on and press OK. Once the tables are installed, you’re ready to start defining a session.

2. On the Code Analyst toolbar, click the Create New Collection button.

3. On the Code Analyst Object Selection dialog, provide a Session Name, locate and select the objects to be executed, and click Next.

4. Use the Code Analyst Object Initialization dialog to initiate providing input parameters as required, change the order of execution, and when ready, click Finish.

Once the session has been run, the total time for the execution is displayed in the Run Summary tab.
5 Select the other tabs to view the tabular and graphical representation of the execution details on your selected objects. For example:
   • The Run Detail tab shows a breakdown of the different objects that make up the session.
   • The Unit Detail tab contains the specific time measurements for individual SQL statements.

6 Close the Code Analyst window.

SESSION 9: SQL DEBUGGING AND PROFILING
Rapid SQL offers the following facilities that help you test and optimize code:
   • SQL Debugging
   • SQL Profiling- Oracle Only

SQL DEBUGGING
The SQL Debugger is another database productivity tool that lets you debug SQL Server, Oracle, Sybase ASE or DB2 stored procedures, as well as Oracle functions. SQL Debugger simplifies the task of finding coding errors.

1 In the Navigator, expand the Procedure or Function node.

2 Right-click the object and select Debug from the context menu.

3 If the procedure or function takes input parameters, the Procedure Execution window prompts you to enter values.
4 Enter input values and press **Continue**.

**TIP:** Rapid SQL allows the user to save the input variable values to a file for later use. This is very helpful for procedures/functions with many input variables that need to be run repeatedly.

The application opens the SQL Debugger Interface.
The Debugger features basic execution, line-by-line execution, breakpoint support, and other common debugging features. For details, refer to the relevant online Help topics.

**SQL PROFILING- ORACLE ONLY**

The SQL Profiler within Rapid SQL provides the ability to capture the metrics of various PL/SQL programmable objects as they are executed in the database. It quickly identifies performance bottlenecks by first calculating the overall runtimes of objects like Oracle packages, and then computing the amount of time each line of PL/SQL code spends executing. Information is presented in an easily viewed, drill-down format.

1. To start a profiling session, use the **Tools** menu option and select **SQL Profiler > Start**.
2. Enter a name for the profiling session or select an existing name from the dropdown. Press **OK**. The Profile session is now active.
3 Execute the programmable object (i.e. Stored Procedure) you wish to capture metrics on.

4 When finished, select **Tools > SQL Profiler > Stop**. The **SQL Profiler – Stop** dialog window prompts you to select an option.

5 Press **Stop**.

6 On the Navigator, expand the **PL/SQL Code Profiling** node.
7 Right-click on the profile session and select **Run Summary**. The **Run Summary** window opens.

<table>
<thead>
<tr>
<th>Comment</th>
<th>Run ID</th>
<th>Run Date</th>
<th>Total Time (ms)</th>
</tr>
</thead>
<tbody>
<tr>
<td>My_Profile</td>
<td>60</td>
<td>01/09/2009 12:00:43 PM</td>
<td>47261</td>
</tr>
<tr>
<td>My_Profile</td>
<td>61</td>
<td>01/09/2009 12:01:52 PM</td>
<td>5484</td>
</tr>
</tbody>
</table>

8 Select a session and select **Run Detail** from the right-click menu. The **Run Detail** screen appears allowing you to view the metrics for this execution in both a graphical and text format.

9 To drill down further into the data, highlight a unit and select **Unit Detail** from the right-click menu. Scroll through the Source window to view the times for each statement.

10 To compare 2 cases, select the 2 cases you wish to compare (shift-click to select the second case) from the **Run Summary** screen and select **Compare** from the right-click menu. The **SQL Profiler Run Comparison** screen appears.

See the relevant online Help topics for more information on profiling.
SPECIFYING RAPID SQL APPLICATION AND FEATURE OPTIONS

The following topics show you how Rapid SQL lets you customize the application configuration for your specific needs:

- Configuring Feature Options
- Locking Down Rapid SQL Features Using the Registry

CONFIGURING FEATURE OPTIONS

All Rapid SQL application settings are available in the Options Editor, which is organized in a tabular format based on feature sets.

To specify options for the Rapid SQL application or a particular feature

1. On the File menu, select Options.
   
   Rapid SQL opens the Options Editor.

2. Click the tab corresponding to the feature you want to customize:

   - **Connect Options**: Lets you integrate with the Embarcadero Connect data governance metadata repository.
   - **Browsers Options**: Lets you specify appearance of browser windows.
   - **Code Analyst Options**: Lets you set dependency profiling level, alarm and threshold, and oracle options for Code Analyst.
   - **Data Editor Options**: Specifies the timeout parameters, packet size for a connection, and ANSI to OEM settings.
   - **Data Editor Options**: Specifies settings for Data Editor.
   - **Data Transfer Options**: Sets default directories when performing data unload and load and data export and import operations.
   - **Explorer Options - Main Tab**: Sets defaults for the organization of objects in the Datasource Navigator.
   - **Datasource Options**: Specifies general datasource management options and Datasource Navigator preferences.
   - **DBMS_Java Options**: Specifies load Java files and drop Java files.
   - **DB2 Utilities Options**: Sets default directories for executables used by DB2 LUW.
   - **DDL Extract Options**: Specifies whether or not Rapid SQL should include DROP statements when extracting the schema of different database object types.
   - **Debug Options**: Sets the duration of your debug initialization and debug session, enable or disable DBMS_OUTPUT, and enable the refresh option.
   - **Directories Options**: Sets the default directories for placing the output of different operations such as HTML reports or schema extractions.
   - **General Options**: Sets defaults for automatic login, restoring the last session, and other general application options.
Set feature options on the tab and then click **OK**.

**NOTE:** If there is an open document, Rapid SQL opens the **Update Document Statement Properties** dialog. The **Update Document Statement Properties** dialog lets you override changes you made to a current document or documents with new setting you made in the Options Editor.

### Connect Options

The **Connect** tab of the Options Editor integrates Rapid SQL with Embarcadero Connect, a data governance metadata repository.

**NOTE:** For information on opening the Options Editor, see "**Specifying Rapid SQL application and feature options**" on page 87.

The table below describes the options and functionality on the **Connect** tab:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use Connect</td>
<td>Enables use of the Embarcadero Connect repository to manage datasources.</td>
</tr>
<tr>
<td>Connect URL</td>
<td>The login URL of the Connect repository.</td>
</tr>
</tbody>
</table>

**NOTE:** These controls can be set or disabled using registry entries. For details, see "**Locking Down Rapid SQL Features Using the Registry**" on page 127.

For more information on repository-based datasources, see "**Working With Datasources from a Connect Repository**" on page 148.
CONNECTION OPTIONS
The Connection tab of the Options Editor lets you specify common connectivity options and provides access to DBMS-specific options.

NOTE: For general information on DBMS version support and client options, see "Database Support and Connectivity Options" on page 14.

NOTE: For information on opening the Options Editor, see "Specifying Rapid SQL application and feature options" on page 87.

The table below describes the options and functionality on the Connection tab:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Login Timeout</td>
<td>Specifies the number of seconds that the application should wait for a response to a connection request from server. If server does not respond within the specified period, the application aborts the connection and returns an error message.</td>
<td>30</td>
</tr>
<tr>
<td>Query Timeout</td>
<td>Specifies the number of seconds that the application should wait for a response to a query from the server. If the server does not respond within the specified period, the application terminates its query process and returns an error.</td>
<td>0</td>
</tr>
<tr>
<td>Host Name</td>
<td>Name of the client computer.</td>
<td>Local name</td>
</tr>
</tbody>
</table>

See the following topics for DBMS platform-specific options:

- Connection Options - Sybase
- Connections Options - Sybase IQ
- Connections Options - SQL Server
- Connections Options - Oracle

CONNECTION OPTIONS - SYBASE
The Connection > Sybase tab of the Options Editor lets you select an installed client other than the active/default client version for Embarcadero driver connections. It also lets you override default client/server settings.

NOTE: For information on opening the Options Editor, see "Specifying Rapid SQL application and feature options" on page 87.

NOTE: For more general connectivity options, see "Connection Options" on page 89.

<table>
<thead>
<tr>
<th>Group</th>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Use Quoted Identifiers</td>
<td>If you plan to use delimited identifiers, select this option.</td>
</tr>
</tbody>
</table>
CONNECTIONS OPTIONS - SYBASE IQ
The Connection > Sybase IQ tab of the Options Editor lets you specify DBMS-specific connection options.

**NOTE:** For information on opening the Options Editor, see "Specifying Rapid SQL application and feature options" on page 87.

**NOTE:** For more general connectivity options, see "Connection Options" on page 89.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use Quoted Identifiers</td>
<td>If you plan to use delimited identifiers, select this option.</td>
</tr>
</tbody>
</table>

CONNECTIONS OPTIONS - SQL SERVER
The Connection > SQL Server tab of the Options Editor lets you specify DBMS-specific connection options.

**NOTE:** For information on opening the Options Editor, see "Specifying Rapid SQL application and feature options" on page 87.

**NOTE:** For more general connectivity options, see "Connection Options" on page 89.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use Quoted Identifiers</td>
<td>If you plan to use delimited identifiers, select this option.</td>
</tr>
</tbody>
</table>
CONNECTIONS OPTIONS - ORACLE

The **Connection > Oracle** tab of the Options Editor lets you select an installed client other than the active/default client version for Embarcadero driver connections. It also lets you override default client/server settings.

**NOTE:** For information on opening the Options Editor, see "**Specifying Rapid SQL application and feature options**" on page 87.

**NOTE:** For more general connectivity options, see "**Connection Options**" on page 89.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Packet Size</strong></td>
<td>This control lets you specify a default packet size parameter used with SQL Server connections. This setting can be overridden when registering a SQL Server datasource. For details, see &quot;<strong>Providing SQL Server Connection Information When Registering Datasources</strong>&quot; on page 137.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Group</th>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Hide time portion of DATE datatype if zero</strong></td>
<td>If selected, the time portion (HH:MM:SS) of DATE datatype results are suppressed in the ISQL Editor’s Results window, if the time portion is all zeroes.</td>
<td></td>
</tr>
<tr>
<td><strong>Client Selection</strong></td>
<td>This group of controls apply only to use of the Embarcadero drivers with native Oracle clients. If no client is specified using these controls, Rapid SQL will use the following sequence in determining the client to use for Oracle connections.</td>
<td>- The driver specified in the ORACLE_HOME environment variable&lt;br&gt;- The first driver found in the PATH environment variable&lt;br&gt;- The Oracle Instant Client driver (v. 11) bundled with DBArtisan</td>
</tr>
<tr>
<td><strong>Enable Client Selection</strong></td>
<td>Selecting this check box lets you override the default/active client specified by Oracle environment variables. This control enables and disables the <strong>Oracle Home</strong> control.</td>
<td></td>
</tr>
<tr>
<td><strong>Oracle Home</strong></td>
<td>Select the directory of the Oracle client you wish to use.</td>
<td></td>
</tr>
</tbody>
</table>
The Browsers tab of the Options Editor lets you set a number of options for your browser windows, including browser appearance, mail file type options, and default object owner.

**NOTE:** For information on opening the Options Editor, see "Specifying Rapid SQL application and feature options" on page 87.

**NOTE:** For information on Browser features, see "Browsers" on page 33.

The table below describes Browser options:

<table>
<thead>
<tr>
<th>Interface Element</th>
<th>Option</th>
<th>Description</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Window</td>
<td>Show Toolbar</td>
<td>Toggles the Browser window toolbar. Commands can also be activated from the shortcut menu that displays when you right-click in an open Browser window.</td>
<td>Selected</td>
</tr>
<tr>
<td></td>
<td>Show Status Bar</td>
<td>Toggles the status bar at the bottom of the Browser window. The status bar displays the cell location of the current focus and the number of rows in the Browser window itself.</td>
<td>Selected</td>
</tr>
<tr>
<td></td>
<td>Detailed Listing</td>
<td>Toggles detail columns for a given object type. Each object contains object specific details, such as creation date, segment, and so on. When Detailed Listing is turned off, only the names of objects and the numbers of rows of data for a table are displayed.</td>
<td>Not selected</td>
</tr>
</tbody>
</table>
### Code Analyst Options

Code Analyst is a utility that helps you identify time-consuming lines of code. The **Code Analyst** tab of the Options Editor lets you specify Code Analyst operational parameters.

**NOTE:** For information on opening the Options Editor, see "Specifying Rapid SQL application and feature options" on page 87.

**NOTE:** For information on using Code Analyst, see "Code Analyst" on page 1039.

The table below describes Code Analyst options:

<table>
<thead>
<tr>
<th>Group</th>
<th>Options and descriptions</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Dependency profiling level</strong></td>
<td>Code Analyst will use all levels of dependencies when profiling the session.</td>
</tr>
<tr>
<td></td>
<td>Lets you specify how many levels of dependencies the Code Analyst will use when profiling the session.</td>
</tr>
<tr>
<td><strong>Oracle</strong></td>
<td>Code Analyst lists the procedures within a package and functions that are found in the Oracle database.</td>
</tr>
<tr>
<td></td>
<td>Code Analyst uses Oracle's DBMS_Profiler package to collect time metrics.</td>
</tr>
<tr>
<td></td>
<td>Code Analyst displays the actual run time on the database, and does not include the time it takes to get to the server.</td>
</tr>
</tbody>
</table>
The Data Editor tab of the Options Editor lets you provide preferences that dictate behavior of Rapid SQL’s table data editor.

**DATA EDITOR OPTIONS**

The Data Editor tab of the Options Editor lets you provide preferences that dictate behavior of Rapid SQL’s table data editor.

**NOTE:** Option parameters set in the Options Editor override options set within Query Builder and Data Editor.

**NOTE:** For information on opening the Options Editor, see "Specifying Rapid SQL application and feature options" on page 87.

**NOTE:** For information on using the Data Editor, see "Data Editor" on page 889.

The table below describes the options and functionality on the Data Editor tab:

<table>
<thead>
<tr>
<th>Interface Element</th>
<th>Option</th>
<th>Description</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default Execution Mode</td>
<td>Live Mode</td>
<td>lets you execute changes one row at a time. Batch Mode lets you make unlimited changes prior to execution. Batch Mode offers three sub-options: Ignore errors-continue processing, Prompt on Error, and Stop after error(s) (number of errors allowed before stopping execution)</td>
<td>Live Mode</td>
</tr>
<tr>
<td>Data Editor File</td>
<td>Mail File Type</td>
<td>Sets the default mail output style as Results, Tab Delimited, Comma Separated, or HTML.</td>
<td>Results</td>
</tr>
<tr>
<td></td>
<td>Include column titles</td>
<td>includes column titles when saving.</td>
<td>Not selected</td>
</tr>
<tr>
<td></td>
<td>when saving</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Grid Font</td>
<td></td>
<td>Customizes font style, and size for the Data Editor and the Results Grid.</td>
<td>Available</td>
</tr>
<tr>
<td>Printer Font</td>
<td></td>
<td>Sets font style, and size for printing output.</td>
<td>Available</td>
</tr>
<tr>
<td>Auto Format (Best Fit)</td>
<td></td>
<td>Fits formatting to match your desktop.</td>
<td>Selected</td>
</tr>
<tr>
<td>Begin and End Transaction</td>
<td></td>
<td>Adds a beginning and ending transaction on each statement.</td>
<td>Selected</td>
</tr>
<tr>
<td>Statements</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Default Date/Time Format</td>
<td></td>
<td>Displays the current date/time format and lets you customize the date/time display.</td>
<td>Results</td>
</tr>
</tbody>
</table>
DATA TRANSFER OPTIONS  
After opening the Options editor (see Specifying Rapid SQL application and feature options), you can make changes to the Data Transfer tab.

You can configure Rapid SQL to use default directories when performing data unload and load and data export and import operations. Setting a default directory saves time because it describes a single reference point for loading or unloading, exporting and importing table or view data files.

The table below describes the options and functionality on the Data Transfer tab:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Unload</td>
<td>Specifies the name and location of the default directory in the Data Unload box.</td>
</tr>
<tr>
<td>Data Load</td>
<td>Specifies the name and location of the default directory in the Data Load box.</td>
</tr>
<tr>
<td>Oracle Export (for Oracle)</td>
<td>Specifies the name and location of the default directory in the Oracle Export box.</td>
</tr>
<tr>
<td>Oracle Import (for Oracle)</td>
<td>Specifies the name and location of the default directory in the Oracle Import box.</td>
</tr>
</tbody>
</table>
**DATASOURCE OPTIONS**

The **Datasource** tab of the Options Editor lets you provide datasource categorization and storage preferences.

**NOTE:** For information on opening the Options Editor, see "Specifying Rapid SQL application and feature options" on page 87.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
<th>Default</th>
</tr>
</thead>
</table>
| Datasource Storage Management | Rapid SQL offers both registry-based and file-based datasource catalog management. Prior to changing methods, see Understanding the Datasource Catalog. The following options are offered:  
  **Windows Registry datasource catalog** - The datasource catalog is stored and managed locally, in the Windows registry. This user can add and delete datasources and edit the registration details of existing resources. Any changes are retained across startups of Rapid SQL.  
  **File based datasource catalog** - The datasource catalog is stored locally and is file-based (%APPDATA%\Embarcadero\Data Sources\ in a default installation). This user can add and delete datasources and edit the registration details of existing resources. Any changes are retained across startups of Rapid SQL.  
  **Network shared datasource catalog** - The datasource catalog is file-based, and obtained from the location specified in the Location of shared datasources file control. Changes such as new datasources, deleted datasources or edited datasource registrations are lost as soon as this user shuts down Rapid SQL. Changing methods does not delete datasource definitions stored using the current method. When you change methods, Rapid SQL does not automatically convert existing catalog definitions to the new method. | Windows Registry |
| Recent Datasource List Contains | Lets you specify number of datasources to display when you select Recent Datasources from the File menu.                                                                                                          | 8             |
| Default to Alias Usage When Defining New Datasources | For DBMS that support alias usage, defaults the Connection Information tab to alias usage selection.                                                                                                         | Unselected    |
| Datasource Category Settings | Lets you select the optional user interface elements that are to be color-coded or labelled for datasources that have been assigned a category:  
  **Color the status bar using the datasource’s category color**  
  **Color the tabs using the datasource’s category color**  
  **Include category short name in the datasource toolbar combo**  
  For an introduction to datasource categorization and related tasks, see Categorizing datasources using color-coding and labelling. | N/A           |

**NOTE:** For information on using Embarcadero Connect repository-based datasource usage, see "Connect Options" on page 88.
DBMS_JAVA OPTIONS

The DBMS_JAVA tab of the Options Editor lets you choose between use of the DBMS_JAVA package and the loadJava.bat batch file when loading or dropping Java classes.

**NOTE:** For information on opening the Options Editor, see "Specifying Rapid SQL application and feature options" on page 87.

The table below describes the options and functionality on the DBMS_Java tab:

<table>
<thead>
<tr>
<th>Interface Element</th>
<th>Option</th>
<th>Description</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Load Java files</td>
<td>Use the DBMS_JAVA package</td>
<td>Lets you schedule your SQL.</td>
<td>Selected</td>
</tr>
<tr>
<td></td>
<td>Use batch file (oracle_home/bin/loadJava.bat)</td>
<td>Uses batch file (oracle_home/bin/loadJava.bat)</td>
<td>Not selected</td>
</tr>
<tr>
<td></td>
<td>Default Encoding option</td>
<td>Leave blank to use the default.</td>
<td>Default</td>
</tr>
<tr>
<td>Drop Java files</td>
<td>Use the DBMS_JAVA package</td>
<td>Lets you schedule your SQL.</td>
<td>Selected</td>
</tr>
<tr>
<td></td>
<td>Use batch file (oracle_home/bin/dropJava.bat)</td>
<td>Uses batch file (oracle_home/bin/dropJava.bat)</td>
<td>Not selected</td>
</tr>
</tbody>
</table>

For related information, see the following object actions:

- "Drop Java" on page 623
- "Load Java" on page 642

DB2 UTILITIES OPTIONS

Some Rapid SQL functionality against DB2 LUW datasources makes use of native DB2 utilities.

**NOTE:** For information on opening the Options Editor, see "Specifying Rapid SQL application and feature options" on page 87.

The table below describes the options and functionality of the DB2 Utilities tab:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>db2cmd.exe</td>
<td>Use this control to specify the location of the directory containing the db2cmd.exe utility.</td>
</tr>
<tr>
<td>db2.exe</td>
<td>Use this control to specify the location of the directory containing the db2.exe utility.</td>
</tr>
</tbody>
</table>
### DDL EXTRACT OPTIONS

The DDL Extract tab of the Options Editor lets you specify results-handling preferences for use of the Extract object action.

**NOTE:** For information on opening the Options Editor, see "Specifying Rapid SQL application and feature options" on page 87.

**NOTE:** For information on using the Extract object action, see "Extract" on page 633.

### Common options

The table below describes the options and functionality on the DDL Extract tab, main view, of the Options Editor:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Extract to multiple windows</td>
<td>Select to extract the schema for each object into separate DDL windows.</td>
</tr>
<tr>
<td></td>
<td>NOTE: This option only works when you extract DDL for multiple objects.</td>
</tr>
<tr>
<td>Extract in dependency order</td>
<td>This is the default.</td>
</tr>
<tr>
<td></td>
<td>When you select a number of objects as part of an extraction job, this option ensures</td>
</tr>
<tr>
<td></td>
<td>objects will be extracted in the proper dependency order.</td>
</tr>
<tr>
<td></td>
<td>If the option is not selected, errors may result when you execute the script.</td>
</tr>
<tr>
<td></td>
<td>It's also true, however, that loading the dependencies can add significant overhead when</td>
</tr>
<tr>
<td></td>
<td>you are extracting numerous objects.</td>
</tr>
<tr>
<td>Script Use Statement</td>
<td>This option is for Sybase. Optimizes extraction through generating Use statements in the generated script.</td>
</tr>
<tr>
<td>Grouping Extracted DDL</td>
<td>There are two option as to how the DDL is generated for an extract operation:</td>
</tr>
<tr>
<td></td>
<td><strong>Group the Drop and Create DDL for each object together</strong> - Objects are extracted one at a time. In</td>
</tr>
<tr>
<td></td>
<td>the DDL generated by the extract, the Drop statement for a selected or referenced object is followed by</td>
</tr>
<tr>
<td></td>
<td>the Create statement for that object.</td>
</tr>
<tr>
<td></td>
<td><strong>Group DDL statements by type - all Drop statements, then all Create statements</strong> - In the DDL</td>
</tr>
<tr>
<td></td>
<td>generated by the extract, Drop statements for all selected or referenced objects are grouped to precede</td>
</tr>
<tr>
<td></td>
<td>Create statements for those objects. This method ensures that all dependencies are respected.</td>
</tr>
<tr>
<td></td>
<td>For more information on DROP options and dependencies, see DBMS-specific DDL Extract Options.</td>
</tr>
</tbody>
</table>

### DBMS-specific DDL Extract Options

The DBMS-specific views of the DDL Extract tab let you specify:

- The object types to include DROP statements for
- The default dependent object types for each object type included in extraction/migration operations
You can choose to include DROP statements before you perform ad hoc DDL extractions. You can use this feature to modify and to re-compile database objects. To recompile a database object, drop it before recreating it. This option drops any existing objects of the same name before recreating the object. The data in the existing table is not saved when you specify a DROP statement for extracted DDL.

**CAUTION:** Because dropping an object is a destructive action, you should carefully consider including drop statements before activating this option.

You can also specify dependent object types included in extraction/migration operations. Each DBMS-specific view of the DDL Extract tab lets you specify the object dependencies for each object type. Dependent object types selected on that view are by default selected when you run an extraction/migration operation and can be overridden using those wizards. For more information see Extract.

### Debug Options

The **Debug tab** of the Options Editor lets you specify operational preferences for the Rapid SQL Debugger.

**NOTE:** For information on opening the Options Editor, see "Specifying Rapid SQL application and feature options" on page 87.

**NOTE:** For information on using the Rapid SQL Debugger, see "Rapid SQL Add-On Tools" on page 929.

The table below describes the options and functionality on the **Debug tab**:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Option</th>
<th>Description</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>General</td>
<td>Dependency Tree Option</td>
<td>Lets you specify pre-fetch levels.</td>
<td>Pre-Fetch All Dependencies</td>
</tr>
<tr>
<td>Profiler</td>
<td>Profiler Time Unit</td>
<td>Lets you select a unit of milliseconds, seconds or minutes.</td>
<td>Milliseconds</td>
</tr>
<tr>
<td></td>
<td>Save Profiler Reports</td>
<td>Lets you save profiler reports and type or browse for the report path.</td>
<td>Not Selected</td>
</tr>
<tr>
<td>Oracle</td>
<td>Initialization Timeout (seconds)</td>
<td>Specifies the point at which the application stops trying to initialize the debugger. If it cannot initialize the debugger in the specified time, it displays message in the Debug Output window.</td>
<td>60</td>
</tr>
<tr>
<td></td>
<td>Debug Session Timeout (seconds)</td>
<td>Specifies the point at which the application terminates your debug session due to idle time.</td>
<td>7200</td>
</tr>
<tr>
<td></td>
<td>Enable DBMS Output</td>
<td>Enables the Oracle built-in package, DBMS_OUTPUT, letting you send messages from stored procedures, packages, and triggers.</td>
<td>Selected</td>
</tr>
<tr>
<td></td>
<td>Refresh Dependencies for each run</td>
<td>Refreshes the dependencies each time you run the debugger.</td>
<td>Not selected</td>
</tr>
</tbody>
</table>
DIRECTORIES OPTIONS

The **Debug tab** of the Options Editor lets you configure default directories when performing certain operations. You can set the default directories for:

- Wizard operations
- Report generation
- Schema extraction
- HTML templates for customizing reports

**NOTE:** For information on opening the Options Editor, see "Specifying Rapid SQL application and feature options" on page 87.

The table below describes the options and functionality on the **Directories** tab:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Option</th>
<th>Description</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Compile with Debug Option</td>
<td></td>
<td>When debugging a procedure against an Oracle datasource, Rapid SQL performs a compilation before debugging. During a compilation, Oracle invalidates referencing objects. For example, if procedures A2 and A3 both reference procedure A1, debugging procedure A1 in Rapid SQL, will result in procedures A2 and A3 being marked as invalidated. <strong>The Compile with Debug Options settings let you control compilation of dependent objects while debugging.</strong></td>
<td>Compile dependent options</td>
</tr>
<tr>
<td>DB2</td>
<td>Debug Session Timeout</td>
<td>Specifies the point at which the application terminates your debug session due to idle time.</td>
<td>300</td>
</tr>
<tr>
<td></td>
<td>Compile with Debug Option</td>
<td>Lets you specify options.</td>
<td>Prompt Always</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Wizard Definitions</td>
<td>Specifies the name and location of the default directory for saving wizard operations. This option applies to wizard operations in which you have the option to save the definition file, such as data unload/load or schema migration operations.</td>
<td>C:\Documents and Settings\username\Application Data\Embarcadero\RapidSQL\DefFiles</td>
</tr>
<tr>
<td>HTML Reports</td>
<td>Specifies the name and location of the default directory for the output from generated HTML reports. For information on generating reports, see &quot;Report&quot; on page 680.</td>
<td>C:\Documents and Settings\username\Application Data\Embarcadero\RapidSQL\Report</td>
</tr>
<tr>
<td>Schema Extraction</td>
<td>Specifies the name and location of the default directory for placing the output from schema extraction operations.</td>
<td>C:\Documents and Settings\username\Application Data\Embarcadero\RapidSQL\Extract</td>
</tr>
</tbody>
</table>
**EXPLORER OPTIONS**

The Explorer options are available on the following Options Editor tabs:

- [Explorer Options - Main Tab](#)
- [Explorer Options - Organization Tab](#)
- [Explorer Options - Limits Tab](#)
- [Explorer Options - Browsers Tab](#)

**EXPLORER OPTIONS - MAIN TAB**

The Options Editor’s **Explorer** tab controls the appearance and behavior of the Rapid SQL Datasource Navigator.

**NOTE:** For information on opening the Options Editor, see “Specifying Rapid SQL application and feature options” on page 87.

**NOTE:** For related information, see "Using the Datasource Navigator" on page 157.

### HtmlTemplate

**Description:** Specifies the name and location of the default directory where Rapid SQL can find the HTML template on which to base HTML reports. This feature lets you customize your HTML reports.

**Default:** C:\Program Files\Embarcadero\RSQL<version identifier>\HtmlTpl

### UserSQLScripts

**Description:** Specifies the name and location of the default directory for SQL Scripts.

**Default:** C:\Documents and Settings\userName\Application Data\Embarcadero\RapidSQL\UserSQLScripts

### JobConfigFiles

**Description:** Specifies the location of any ETSQLX job configuration files you have set on your local machine. For more information, see ETSQLX Command Line Utility.

**Default:** C:\Documents and Settings\davidt\My Documents\Embarcadero\RapidSQL\Directories\ETSQLXJobCfg

### #includeFiles

**Description:** Specifies the name and location of the directory searched for files specified by a #include directive in the ISQL editor, Procedure Object Editor, or Package Body Object Editor if there are no paths specified on the Datasource Properties tab of the Datasource Registration Editor. For more information, see Registering or editing datasources. For information on using compiler directives, see "SQL Preprocessing: #define and #include" on page 795.

**Default:** C:\Documents and Settings\davidt\My Documents\Embarcadero\RapidSQL\Directories\IncludeFiles
Use the following table as a guide to modifying settings on this tab

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Refresh after Object Commands</td>
<td>Refreshes the Explorer automatically after an object has been modified or created.</td>
</tr>
<tr>
<td>Retain View Setting on Close</td>
<td>Select to retain the current state of the Datasource Explorer so that it opens the same way the next time you start Rapid SQL.</td>
</tr>
<tr>
<td>Column filters use regular expressions by default</td>
<td>Column filters use regular expressions by default - Lets you use regular expressions when defining criteria for display of database objects in the Browser. For more information, see &quot;Working with Browsers&quot; on page 37.</td>
</tr>
</tbody>
</table>

EXPLORER OPTIONS - ORGANIZATION TAB
The Options Editor's Explorer > Organization tab controls the appearance and behavior of the Rapid SQL Datasource Navigator.

**NOTE:** For information on opening the Options Editor, see "Specifying Rapid SQL application and feature options" on page 87.

**NOTE:** For related information, see "Using the Datasource Navigator" on page 157.

Use the following table as a guide to modifying settings on this tab

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Explorer organization</td>
<td>Lets you select a default grouping option of Organize by Object Owner (groups objects, by object type, for each user) or Organize by Object Type (groups objects by object type for all users in the same list). Grouping by object owner is most efficient if you are working with databases containing a high number of objects. You can change the organization manually during a Rapid SQL session. For details, see &quot;Basic Viewing Options in the Navigator&quot; on page 163.</td>
</tr>
<tr>
<td>Show System Objects and Show Only My Objects (available if you are organizing the Datasource Explorer by object type)</td>
<td>Lets you select a default Datasource Explorer tree display options for system objects and objects that you own. Available options in the two groups are: Never - the relevant objects are not displayed by default. Always - the relevant objects are always displayed by default. Use datasource filter - The relevant default datasource filter is enabled. For more information, see &quot;Filtering in the Navigator&quot; on page 170. You can change the Show System Objects and Show Only My Objects settings manually during a Rapid SQL session. For details, see &quot;Using the Default Filters&quot; on page 174.</td>
</tr>
</tbody>
</table>
**EXPLORER OPTIONS - LIMITS TAB**

The Options Editor’s **Explorer > Limits** tab controls the appearance and behavior of the Rapid SQL Datasource Navigator.

*NOTE:* For information on opening the Options Editor, see "Specifying Rapid SQL application and feature options" on page 87.

*NOTE:* For related information, see "Using the Datasource Navigator" on page 157.

While Rapid SQL queries the DBMS as necessary when you navigate the node hierarchy, it also caches nodes for the purpose of quickly repopulating if you move away from and then back to a node. For example if you open a **Tables** node and then an **Indexes** node and then again select the **Tables** node, the cached **Tables** sub-nodes are displayed.

Use the following table as a guide to controlling caching details:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cache Expiration Time</td>
<td>The duration node is cached. Selecting a node after this expiration interval results in a fresh population.</td>
</tr>
<tr>
<td>Maximum number of children to display per tree node</td>
<td>Lets you place an upper limit of the number of nodes to display per node.</td>
</tr>
</tbody>
</table>

**EXPLORER OPTIONS - BROWSERS TAB**

The Options Editor’s **Explorer > Browsers** tab controls the appearance and behavior of the Rapid SQL Database Navigator

*NOTE:* For information on opening the Options Editor, see "Specifying Rapid SQL application and feature options" on page 87.

Use the following table as a guide to modifying settings on this tab

<table>
<thead>
<tr>
<th>Interface Element</th>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default Owner</td>
<td>All Owners</td>
<td>Indicates that the Browser Window should default to displaying database objects in the browsers for all owners in the database.</td>
</tr>
<tr>
<td></td>
<td>Current User</td>
<td>Indicates that the Browser Window should default to displaying database objects owned exclusively by the current user.</td>
</tr>
<tr>
<td></td>
<td>Specific Owner</td>
<td>Indicates that the Browser Window should default to displaying only the database objects owned by a specific owner. If you select this option, you must provide an owner name in the box.</td>
</tr>
<tr>
<td>Mail File Type</td>
<td>Specifies what file type you want the browser file saved as when sent as e-mail to another user on a MAPI compliant mail system. The valid types are the proprietary Rapid SQL Results type, Tab delimited, Comma separated, and HTML, which formats the results in a simple HTML table.</td>
<td></td>
</tr>
<tr>
<td>Browser colors</td>
<td>Lets you specify foreground and background colors for object types displayed in the Browser</td>
<td></td>
</tr>
</tbody>
</table>
**GENERAL OPTIONS**

The **General** tab of the Options Editor lets you specify general application options.

**NOTE:** For information on opening the Options Editor, see "Specifying Rapid SQL application and feature options" on page 87.

The table below describes the options and functionality on the **General tab**:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Option</th>
<th>Description</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Main tab</td>
<td>Confirm on Exit</td>
<td>Instructs Rapid SQL to issue a message confirming the operation before exiting the application.</td>
<td>Selected</td>
</tr>
<tr>
<td></td>
<td>Max Editors in a Single Open Operation</td>
<td>Specifies the maximum number of editors allowable from a single Open operation.</td>
<td>5</td>
</tr>
<tr>
<td></td>
<td>Max Entries in Output Window</td>
<td>Specifies the maximum number of messages that can appear in the Output Window before the contents are flushed. This option conserves memory resources. You can clear the Output window or raise the maximum number allowed at any time.</td>
<td>1500</td>
</tr>
</tbody>
</table>

The **General** tab also offers the following DBMS-specific sub-tabs:
Oracle sub-tab

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Dictionary View Usage</td>
<td>Lets you synchronize Rapid SQL use of the Oracle Data Dictionary DBA and ALL/USER views with the privileges associated with the role used in creating and using the datasource.</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Role-based Views</strong> - Rapid SQL will use views based on the user’s role. That is, users with DBA privileges will use DBA views.</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>DBA Views</strong> - Rapid SQL always uses DBA views.</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>All Views</strong> - Rapid SQL always uses ALL views.</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Use Datasource Configuration for Views</strong> - lets you set up Data Dictionary usage on a view-by-view basis when editing or registering a datasource. For more information, see “Registering Datasources” on page 129.</td>
<td></td>
</tr>
<tr>
<td>Preserve Case in Object Identifiers</td>
<td>Preserves case of the database object.</td>
<td>Not selected</td>
</tr>
</tbody>
</table>

Sybase and SQL Server sub-tabs

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rename action style</td>
<td>Lets you specify whether user-defined objects or datatypes are renamed using an extended ALTER or using the <code>sp_rename</code> procedure.</td>
<td>extended alter</td>
</tr>
</tbody>
</table>

InterBase/Firebird sub-tab

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Preserve Case in Object Identifiers</td>
<td>Preserves case of the database object.</td>
<td>Not selected</td>
</tr>
</tbody>
</table>

GRID PROPERTIES (RESULTS WINDOW) OPTIONS

The Grid Properties tab of the Option editor lets you set preferences for the layout and appearance of the grid in an Results window.

**NOTE:** For information on opening the Options Editor, see "Specifying Rapid SQL application and feature options" on page 87.

The table below describes the options and functionality on the Grid Properties tab:

<table>
<thead>
<tr>
<th>Interface Element</th>
<th>Options and descriptions</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Titles and Gridlines</td>
<td>3D-Buttons - Enables or disables a 3-D appearance on row and column headings in the grid.</td>
<td>Set</td>
</tr>
<tr>
<td></td>
<td>Horizontal Gridlines - Enables or disables ruling between rows of the grid.</td>
<td>Set</td>
</tr>
<tr>
<td></td>
<td>Vertical Gridlines - Enables or disables ruling between columns of the grid.</td>
<td>Set</td>
</tr>
</tbody>
</table>
ISQL OPTIONS
The ISQL options are available on the following Options Editor tabs:

- ISQL Options - Main Tab
- ISQL Options - Oracle Tab
- ISQL Options - DB2 Tab
- ISQL Options - Sybase Tab
- ISQL Options - Sybase IQ Tab
- ISQL Options - Sybase IQ Tab
- ISQL Options - MySQL Tab
- ISQL Options - DB2 OS390 Tab
- ISQL Options - InterBase Tab
- ISQL Options - Editor Tab
- ISQL Options - Auto format Tab
- ISQL Options - Code Assist Tab

ISQL OPTIONS - MAIN TAB
The Options Editor’s ISQL tab and its sub-tabs control the appearance and behavior of the Rapid SQL SQL Editor.

**NOTE:** For information on opening the Options Editor, see “Specifying Rapid SQL application and feature options” on page 87.

**NOTE:** For information on using the SQL Editor, see “Coding Environments/Editors” on page 783.

Use the following table as a guide to modifying settings on this tab:

<table>
<thead>
<tr>
<th>Interface Element</th>
<th>Options and descriptions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mark Headings</td>
<td>Enables or disables highlighted row and column headings.</td>
</tr>
<tr>
<td>Preview</td>
<td>Displays a preview of the settings currently selected in the Titles and Gridlines group.</td>
</tr>
</tbody>
</table>

- **Max Errors Before Aborting Execution**
  - Sets the maximum number of errors allowed before aborting the execution of a script. A zero indicates that the option is inactive and that you recognize no limit to the number of errors allowed. Rapid SQL refers to this value when step executing SQL scripts.
- **Execute Selected Text**
  - Executes a portion of a selected SQL script.
## ISQL Options - Oracle Tab

The Options Editor’s **ISQL > Oracle** tab controls the appearance and behavior of the Rapid SQL SQL Editor when executing against an Oracle environment.

**NOTE:** For information on opening the Options Editor, see "Specifying Rapid SQL application and feature options" on page 87.

**NOTE:** For information on using the SQL Editor, see "Coding Environments/Editors" on page 783.

Use the following table as a guide to modifying settings on this tab:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Check Syntax When Executing</strong></td>
<td>For DB2, required to execute DB2 call statements in the ISQL Window.</td>
</tr>
<tr>
<td><strong>Automatically lock connection</strong></td>
<td>When disabled, a prompt to commit or rollback the transaction is displayed when you close the ISQL editor window. Enabling this options disables the prompts and locks the connection automatically.</td>
</tr>
<tr>
<td><strong>Prompt to lock database connection</strong></td>
<td>Locks the database connection on execution.</td>
</tr>
<tr>
<td><strong>Tabs</strong></td>
<td>Sets the appearance of the ISQL Window tabs to either the top or bottom of the ISQL Window.</td>
</tr>
<tr>
<td><strong>File Association</strong></td>
<td>Specifies whether the application should open an unknown file type automatically into an ISQL Window or prompt you with a message that Rapid SQL does not recognize the file type.</td>
</tr>
<tr>
<td><strong>Query Plan Layout</strong></td>
<td>Sets the default orientation of a graphical query plan. For more information, see &quot;Setting up the Execution Environment with Query options&quot; on page 815.</td>
</tr>
</tbody>
</table>

**ISQL OPTIONS - ORACLE TAB**

The Options Editor’s **ISQL > Oracle** tab controls the appearance and behavior of the Rapid SQL SQL Editor when executing against an Oracle environment.

**NOTE:** For information on opening the Options Editor, see "Specifying Rapid SQL application and feature options" on page 87.

**NOTE:** For information on using the SQL Editor, see "Coding Environments/Editors" on page 783.

Use the following table as a guide to modifying settings on this tab:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Check Syntax When Executing</strong></td>
<td>For DB2, required to execute DB2 call statements in the ISQL Window.</td>
</tr>
<tr>
<td><strong>Automatically lock connection</strong></td>
<td>When disabled, a prompt to commit or rollback the transaction is displayed when you close the ISQL editor window. Enabling this options disables the prompts and locks the connection automatically.</td>
</tr>
<tr>
<td><strong>Prompt to lock database connection</strong></td>
<td>Locks the database connection on execution.</td>
</tr>
<tr>
<td><strong>Tabs</strong></td>
<td>Sets the appearance of the ISQL Window tabs to either the top or bottom of the ISQL Window.</td>
</tr>
<tr>
<td><strong>File Association</strong></td>
<td>Specifies whether the application should open an unknown file type automatically into an ISQL Window or prompt you with a message that Rapid SQL does not recognize the file type.</td>
</tr>
<tr>
<td><strong>Query Plan Layout</strong></td>
<td>Sets the default orientation of a graphical query plan. For more information, see &quot;Setting up the Execution Environment with Query options&quot; on page 815.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Enable DBMS Output</strong></td>
<td>Lets you specify Buffer size. 0 is the default.</td>
</tr>
<tr>
<td><strong>Auto-Commit changes</strong></td>
<td>Applies auto commit status changes to all open windows.</td>
</tr>
<tr>
<td><strong>View xmltype as clob</strong></td>
<td>When enabled, xmltype columns are displayed as CLOBs in the Results grid and the Data editor. Without this option selected, SELECT statements that qualify xmltype columns produce an OciTypeBinder conversion error. With the option selected, the SELECT submitted by Rapid SQL is modified to include a getclobval() method call.</td>
</tr>
<tr>
<td><strong>Retain connection in pool after use</strong></td>
<td>This option determines what happens to a connection after it is unlocked by the ISQL window. If selected, the connection will be returned to the application connection pool. If unselected, the unlocked connection will be disconnected.</td>
</tr>
<tr>
<td><strong>Default Query Plan</strong></td>
<td>Lets you select the default display, tree-based or graphical, when you generate a query plan. For more information, see &quot;Using the Query Plan Facility&quot; on page 830.</td>
</tr>
</tbody>
</table>
ISQL OPTIONS - DB2 TAB
The Options Editor’s ISQL > DB2 tab controls the appearance and behavior of the Rapid SQL SQL Editor when executing against a DB2 LUW environment.

**NOTE:** For information on opening the Options Editor, see "Specifying Rapid SQL application and feature options" on page 87.

**NOTE:** For information on using the SQL Editor, see "Coding Environments/Editors" on page 783.

Use the following table as a guide to modifying settings on this tab:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Load Query Options</strong></td>
<td>If this option is not enabled, Rapid SQL loads a set of default query options that customize your execution environment, and periodically sends those settings to the server. Enabling this option and specifying an XML file, forces Rapid SQL to load a previously saved query options file each time an ISQL window opens against this DBMS platform. This lets you override Rapid SQL’s default query options. You can also enable this option when saving a query options file. For information on other load and save options, specific query options offered, manually updating query options, and conditions for which query options are sent to the server, see &quot;Setting up the Execution Environment with Query options&quot; on page 815.</td>
</tr>
</tbody>
</table>

| **Set Isolation Level** | Sets the default for the value of the Isolation Level option on the Query Options dialog. For details, see "Setting up the Execution Environment with Query options" on page 815. |
| **Auto-Commit changes** | Applies auto commit status changes to all open windows. |
| **Create Explain plan tables if required** | If set to TRUE, Explain Plan tables are created, as necessary. If set to FALSE and you don’t manually create tables, Explain Plan operations will fail. |
| **Create explain plan tables on the SYSTOOLS schema** | If set to TRUE, Explain Plan tables are created on the SYSTOOLS schema. If the tables already exist in the user’s default schema, Rapid SQL continues to use those tables. Refer to DB2 documentation for a listing of Explain Plan tables that must be deleted in order to use the SYSTOOLS option. If set to FALSE, Explain Plan tables are created under the user’s default schema. |
| **Retain connection in pool after use** | This option determines what happens to a connection after it is unlocked by the ISQL window. If selected, the connection will be returned to the application connection pool. If unselected, the unlocked connection will be disconnected. |
| **Load Query Options** | If this option is not enabled, Rapid SQL loads a set of default query options that customize your execution environment, and periodically sends those settings to the server. Enabling this option and specifying an XML file, forces Rapid SQL to load a previously saved query options file each time an ISQL window opens against this DBMS platform. This lets you override Rapid SQL’s default query options. You can also enable this option when saving a query options file. For information on other load and save options, specific query options offered, manually updating query options, and conditions for which query options are sent to the server, see "Setting up the Execution Environment with Query options" on page 815. |
ISQL OPTIONS - SYBASE TAB
The Options Editor’s ISQL > Sybase tab controls the appearance and behavior of the Rapid SQL SQL Editor when executing against a Sybase ASE environment.

NOTE: For information on opening the Options Editor, see “Specifying Rapid SQL application and feature options” on page 87.

NOTE: For information on using the SQL Editor, see “Coding Environments/Editors” on page 783.

Use the following table as a guide to modifying settings on this tab:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto-Commit changes</td>
<td>Applies auto commit status changes to all open windows.</td>
</tr>
<tr>
<td>Retain connection in pool after use</td>
<td>This option determines what happens to a connection after it is unlocked by the ISQL window. If selected, the connection will be returned to the application connection pool. If unselected, the unlocked connection will be disconnected.</td>
</tr>
<tr>
<td>Load Query Options</td>
<td>If this option is not enabled, Rapid SQL loads a set of default query options that customize your execution environment, and periodically sends those settings to the server. Enabling this option and specifying an XML file, forces Rapid SQL to load a previously saved query options file each time an ISQL windows opens against this DBMS platform. This lets you override Rapid SQL’s default query options. You can also enable this option when saving a query options file. For information on other load and save options, specific query options offered, manually updating query options, and conditions for which query options are sent to the server, see “Setting up the Execution Environment with Query options” on page 815.</td>
</tr>
</tbody>
</table>

ISQL OPTIONS - SYBASE IQ TAB
The Options Editor’s ISQL > Sybase IQ tab controls the appearance and behavior of the Rapid SQL SQL Editor when executing against aSybase IQr environment.

NOTE: For information on opening the Options Editor, see “Specifying Rapid SQL application and feature options” on page 87.

NOTE: For information on using the SQL Editor, see “Coding Environments/Editors” on page 783.

Use the following table as a guide to modifying settings on this tab:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable Set Query Options</td>
<td>Sets the default value of the Send Set Options setting on the Query Options dialog. For details, see “Setting up the Execution Environment with Query options” on page 815. Changing this value does not affect ISQL sessions currently open.</td>
</tr>
<tr>
<td>Auto-Commit changes</td>
<td>Applies auto commit status changes to all open windows.</td>
</tr>
<tr>
<td>Retain connection in pool after use</td>
<td>This option determines what happens to a connection after it is unlocked by the ISQL window. If selected, the connection will be returned to the application connection pool. If unselected, the unlocked connection will be disconnected.</td>
</tr>
</tbody>
</table>
ISQL OPTIONS - SQL SERVER TAB

The Options Editor's **ISQL > SQL Server** tab controls the appearance and behavior of the Rapid SQL SQL Editor when executing against a SQL Server environment.

**NOTE:** For information on opening the Options Editor, see "Specifying Rapid SQL application and feature options" on page 87.

**NOTE:** For information on using the SQL Editor, see "Coding Environments/Editors" on page 783.

Use the following table as a guide to modifying settings on this tab:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Load Query Options</strong></td>
<td>If this option is not enabled, Rapid SQL loads a set of default query options that customize your execution environment, and periodically sends those settings to the server. Enabling this option and specifying an XML file, forces Rapid SQL to load a previously saved query options file each time an ISQL windows opens against this DBMS platform. This lets you override Rapid SQL's default query options. You can also enable this option when saving a query options file. For information on other load and save options, specific query options offered, manually updating query options, and conditions for which query options are sent to the server, see &quot;Setting up the Execution Environment with Query options&quot; on page 815.</td>
</tr>
</tbody>
</table>

**Option** | **Description**  |
--- | --- |
Enable Set Query Options | Sets the default value of the **Send Set Options** setting on the Query Options dialog. For details, see "Setting up the Execution Environment with Query options" on page 815. Changing this value does not affect ISQL sessions currently open. |
Auto-Commit changes | Applies auto commit status changes to all open windows. |
Retain connection in pool after use | This option determines what happens to a connection after it is unlocked by the ISQL window. If selected, the connection will be returned to the application connection pool. If unselected, the unlocked connection will be disconnected. |
Load Query Options | If this option is not enabled, Rapid SQL loads a set of default query options that customize your execution environment, and periodically sends those settings to the server. Enabling this option and specifying an XML file, forces Rapid SQL to load a previously saved query options file each time an ISQL windows opens against this DBMS platform. This lets you override Rapid SQL's default query options. You can also enable this option when saving a query options file. For information on other load and save options, specific query options offered, manually updating query options, and conditions for which query options are sent to the server, see "Setting up the Execution Environment with Query options" on page 815. |
ISQL OPTIONS - MYSQL Tab
The Options Editor’s ISQL > MySQL tab controls the appearance and behavior of the Rapid SQL SQL Editor when executing against a MySQL environment.

**NOTE:** For information on opening the Options Editor, see “Specifying Rapid SQL application and feature options” on page 87.

**NOTE:** For information on using the SQL Editor, see “Coding Environments/Editors” on page 783.

Use the following table as a guide to modifying settings on this tab:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Retain connection in pool after use</td>
<td>This option determines what happens to a connection after it is unlocked by the ISQL window. If selected, the connection will be returned to the application connection pool. If unselected, the unlocked connection will be disconnected.</td>
</tr>
<tr>
<td>Load Query Options</td>
<td>If this option is not enabled, Rapid SQL loads a set of default query options that customize your execution environment, and periodically sends those settings to the server. Enabling this option and specifying an XML file, forces Rapid SQL to load a previously saved query options file each time an ISQL windows opens against this DBMS platform. This lets you override Rapid SQL's default query options. You can also enable this option when saving a query options file. For information on other load and save options, specific query options offered, manually updating query options, and conditions for which query options are sent to the server, see “Setting up the Execution Environment with Query options” on page 815.</td>
</tr>
</tbody>
</table>

ISQL OPTIONS - DB2 OS390 Tab
The Options Editor’s ISQL > DB2 OS390 tab controls the appearance and behavior of the Rapid SQL SQL Editor when executing against a DB2 z/OS environment.

**NOTE:** For information on opening the Options Editor, see “Specifying Rapid SQL application and feature options” on page 87.

**NOTE:** For information on using the SQL Editor, see “Coding Environments/Editors” on page 783.

Use the following table as a guide to modifying settings on this tab:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Retain connection in pool after use</td>
<td>This option determines what happens to a connection after it is unlocked by the ISQL window. If selected, the connection will be returned to the application connection pool. If unselected, the unlocked connection will be disconnected.</td>
</tr>
</tbody>
</table>
ISQL OPTIONS - INTERBASE TAB
The Options Editor’s ISQL > InterBase tab controls the appearance and behavior of the Rapid SQL SQL Editor when executing against an InterBase/Firebird environment.

**NOTE:** For information on opening the Options Editor, see "Specifying Rapid SQL application and feature options" on page 87.

**NOTE:** For information on using the SQL Editor, see "Coding Environments/Editors" on page 783.

Use the following table as a guide to modifying settings on this tab:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Load Query Options</strong></td>
<td>If this option is not enabled, Rapid SQL loads a set of default query options that customize your execution environment, and periodically sends those settings to the server. Enabling this option and specifying an XML file, forces Rapid SQL to load a previously saved query options file each time an ISQL window opens against this DBMS platform. This lets you override Rapid SQL’s default query options. You can also enable this option when saving a query options file. For information on other load and save options, specific query options offered, manually updating query options, and conditions for which query options are sent to the server, see &quot;Setting up the Execution Environment with Query options&quot; on page 815.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Retain connection in pool after use</strong></td>
<td>This option determines what happens to a connection after it is unlocked by the ISQL window. If selected, the connection will be returned to the application connection pool. If unselected, the unlocked connection will be disconnected.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Load Query Options</strong></td>
<td>If this option is not enabled, Rapid SQL loads a set of default query options that customize your execution environment, and periodically sends those settings to the server. Enabling this option and specifying an XML file, forces Rapid SQL to load a previously saved query options file each time an ISQL window opens against this DBMS platform. This lets you override Rapid SQL’s default query options. You can also enable this option when saving a query options file. For information on other load and save options, specific query options offered, manually updating query options, and conditions for which query options are sent to the server, see &quot;Setting up the Execution Environment with Query options&quot; on page 815.</td>
</tr>
</tbody>
</table>

ISQL OPTIONS - EDITOR TAB
The Options Editor’s ISQL > Editor tab controls the appearance and behavior of the Rapid SQL SQL Editor window.

**NOTE:** For information on opening the Options Editor, see "Specifying Rapid SQL application and feature options" on page 87.

**NOTE:** For information on using the SQL Editor, see "Coding Environments/Editors" on page 783.
The table below describes the options and functionality on the **Editor** tab:

<table>
<thead>
<tr>
<th>Group</th>
<th>Option</th>
<th>Description</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Window</td>
<td>Show Toolbar and Show Status Bar</td>
<td>Enables/disables these ISQL Window user interface elements.</td>
<td>Selected</td>
</tr>
<tr>
<td></td>
<td>Maximize on new or open</td>
<td>Indicates that Rapid SQL should maximize the ISQL Editor. If you already have an active MDI Window that is maximized, the default behavior is to maximize a new child window. To deactivate this option, ensure you do not have any active MDI Windows, such as the Explorer.</td>
<td>Selected</td>
</tr>
<tr>
<td>File Tracking</td>
<td></td>
<td>Indicates that the ISQL Editor should use the File Tracking Facility to monitor the status of a file. If a file has been modified and saved outside the application, the application loads the most current version of the file into the ISQL Editor based on the options set for Auto-Reload File (see above.)</td>
<td>Selected</td>
</tr>
<tr>
<td></td>
<td>Auto-Reload File</td>
<td>If File Tracking is enabled, indicates that the application should automatically reload a file that has been externally modified without prompting you. If you turn this option off, Rapid SQL prompts you before reloading your file if external changes have been saved.</td>
<td>Not selected</td>
</tr>
<tr>
<td>Auto-Save File</td>
<td></td>
<td>Indicates that files in the ISQL Editor should automatically be saved at the indicated time interval. Backup files are saved to C:\Documents and Settings\username\Application Data\Embarcadero\RapidSQL\Backup\Backup files use a naming convention of the form ~ETxxxx.tmp., See the registry under HKEY_CURRENT_USER\Software\Embarcadero\RapidSQL\version\Backup for a listing of backup file names and the path of the file to which they correspond.</td>
<td>Selected(5 minutes)</td>
</tr>
<tr>
<td>Command History</td>
<td>Save File Before Overwriting</td>
<td>Specifies the action you want the application to take when selecting a command from the Command History box. You have the option to be reminded to save a file before overwriting (Ask First), to automatically save a file before overwriting (Always), or to automatically overwrite the file with the command (Never).</td>
<td>Ask First</td>
</tr>
<tr>
<td></td>
<td>Save Most Recent</td>
<td>Specifies the number of commands you want to save in the Command History list in the top of the ISQL Window toolbar. The maximum value is 99.</td>
<td>15</td>
</tr>
<tr>
<td>Printing</td>
<td></td>
<td>Lets you select common printer options.</td>
<td></td>
</tr>
<tr>
<td>Appearance</td>
<td>Enable Syntax Highlighting</td>
<td>Sets syntax highlighting on so that all keywords and comments are colored for easier reading and debugging.</td>
<td>Selected</td>
</tr>
<tr>
<td></td>
<td>Show Line Numbers</td>
<td>Places line numbers in the left column of an ISQL Window.</td>
<td>Selected</td>
</tr>
<tr>
<td></td>
<td>Enable Outlining</td>
<td>Enables and disables outlining.</td>
<td>Selected</td>
</tr>
<tr>
<td></td>
<td>Enable Text Wrapping</td>
<td>Enables and disables a typical text wrap feature.</td>
<td>Selected</td>
</tr>
<tr>
<td></td>
<td>Editor Font</td>
<td>Sets the font face, style, and size displayed in the editor.</td>
<td>Available</td>
</tr>
<tr>
<td></td>
<td>Syntax Colors</td>
<td>Sets syntax coloring for keywords, comments, quotes, and default text for various file types and scripts from the <strong>Syntax Coloring</strong> dialog.</td>
<td>Available</td>
</tr>
</tbody>
</table>
ISQL OPTIONS - AUTO FORMAT TAB

After opening the Options editor (see Specifying Rapid SQL application and feature options), you can make changes to the Auto Format tab of the ISQL pane.

The Options Editor’s ISQL > Auto Format tab lets you specify the style and spacing of SQL statements in an ISQL window when you choose to auto format SQL in the ISQL editor.

**NOTE:** For information on opening the Options Editor, see "Specifying Rapid SQL application and feature options" on page 87.

**NOTE:** For information on using the SQL Editor, see "Coding Environments/Editors" on page 783.

On opening, the Preview area shows an SQL statement formatted according to the current Auto Format settings. Click Edit to open the Auto Format Options dialog. Use the following table as a guide to understanding and modifying the settings in this dialog:

<table>
<thead>
<tr>
<th>Group</th>
<th>Option</th>
<th>Description</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Formatting</td>
<td>Auto Indent</td>
<td>Sets automatic indentation for each carriage return, new line in your SQL script.</td>
<td>Selected</td>
</tr>
<tr>
<td></td>
<td>Expand Tabs and Tab Size</td>
<td>Sets tabs as the specified number of spaces in result sets.</td>
<td>Selected</td>
</tr>
<tr>
<td>Clipboard Line Endings</td>
<td>None</td>
<td>When copying text from the editor, no substitution is made for end-of-line characters. This provides the fastest cut and paste operation.</td>
<td>Selected</td>
</tr>
<tr>
<td>Line Endings</td>
<td></td>
<td>When copying text from the editor, end-of-line characters are replaced with platform-specific equivalents (Windows - CR LF, UNIX - LF, Macintosh - CR). This lets you copy text into environments such as Notepad, that require platform-specific end-of-line characters. This option avoids unnecessary characters and incorrect display, but cut-and-paste operations take more time to complete.</td>
<td></td>
</tr>
</tbody>
</table>
ISQL OPTIONS - CODE ASSIST TAB
Code assist options are available on the following tabs:

- ISQL Options - Code Assist - Main Tab
- ISQL Options - Code Assist - Advanced Tab

ISQL OPTIONS - CODE ASSIST - MAIN TAB
The Options Editor’s ISQL > Code Assist tab lets you activate and select options for coding assistance and error-detection features available from the ISQL editor:

- **Code Complete** - lets you insert or replace object names, selected from suggestion lists, as you edit a script. For more information, see "Code Complete" on page 803.

- **Semantic validation** - detects object name references to objects not present in the datasource index. For more information, see "Semantic Validation" on page 802.

- **Real-time syntax checking** - on-the-fly syntax checking is performed as you type. For more information, see "Syntax Checking" on page 801.

- **Hyperlinks** - lets you invoke object actions against objects referenced in a script. For more information, see Hyperlink Object Actions.

- **Object metadata display** - lets you view Connect server metadata for referenced objects. For details, see "Viewing Embarcadero Connect Model Metadata in the SQL Editor" on page 812.

---

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Conditions format style** | Specifies how conditions in clauses are formatted:  
CONDITIONS_WRAPPED - lines are not forced before conditions.  
CONDITIONS_STACKED_WITH_LEADING_OPERATORS - a new line is forced for each condition in a clause, with logical operators, if present for a line, displayed at the start of the line.  
CONDITIONS_STACKED_WITH_TRAILING_OPERATORS - a new line is forced for each condition in a clause, with logical operators, if present for a line, displayed at the end of the line. |
| **Conditions stack threshold** | For Conditions format style selections that specify stacking, this value specifies the minimum number of conditions that must appear in a clause before conditions are stacked. |
| **THEN statements** | If enabled, simple THEN clauses are kept to a single line.                                                                                                                                                  |
The **ISQL - Code Assist** tab has the following settings:

<table>
<thead>
<tr>
<th>Group/Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Code Complete</strong></td>
<td><strong>Enable Code Complete</strong> Lets you enable or disable the Code Complete feature. When disabled, Code Complete cannot be invoked automatically or manually. Because of the overhead in maintaining internal resources used in implementing this feature, a slight performance increase can result from disabling the feature.</td>
</tr>
<tr>
<td><strong>Enable auto-activation</strong></td>
<td><strong>Auto-activation delay</strong> When auto-activation is disabled, the Code Complete feature must be invoked manually. When auto-activation is enabled, the Code Complete feature is invoked automatically each time the interval between keystrokes exceeds the specified <strong>Auto-activation delay</strong>.</td>
</tr>
<tr>
<td><strong>Insert single proposals</strong></td>
<td>Automatically Specifies that if a Code Complete suggestion list would contain only a single suggestion, that suggestion is inserted automatically.</td>
</tr>
<tr>
<td><strong>Fully qualify completions</strong></td>
<td>Automatically Specifies that Code Complete results are returned fully qualified, rather than the minimum required to identify the object.</td>
</tr>
<tr>
<td><strong>Code Validation</strong></td>
<td><strong>Enable Real-time syntax checking</strong> If enabled, syntax-checking is performed as you type. If disabled, syntax checks must be initiated manually.</td>
</tr>
<tr>
<td></td>
<td><strong>Severity levels for semantic validation problems</strong> Lets you select the severity level (ERROR, WARNING, or IGNORE) associated with detected semantic errors. The WARNING option provides a contrast to syntax errors, which are always flagged with a severity level of ERROR. The IGNORE setting disables the feature. For more information, see &quot;Semantic Validation&quot; on page 802.</td>
</tr>
<tr>
<td></td>
<td><strong>Perform syntax and semantic validation on files smaller than</strong> Places an upper limit on the size of files for which automatic syntax checking and semantic validation are active.</td>
</tr>
<tr>
<td><strong>DB Action Menu</strong></td>
<td><strong>Enable DBAction menu in the editor</strong> Enables the Hyperlinks feature.</td>
</tr>
<tr>
<td></td>
<td><strong>Show DB Actions in submenu</strong> If unselected, Hyperlink menu actions are available as first level options in the context menu. If selected, Hyperlink menu actions are available as a <strong>DB Actions</strong> submenu.</td>
</tr>
<tr>
<td></td>
<td><strong>Key used in conjunction with right-mouse</strong> Lets you select the key (CTRL, SHIFT, or CTRL+SHIFT) used in conjunction with right-clicking, that activates the object action menu against a supported object type reference in a script. The default keystroke combination is CTRL+right-click.</td>
</tr>
<tr>
<td><strong>Restore defaults</strong></td>
<td>Restores all settings on the tab to the original defaults.</td>
</tr>
<tr>
<td><strong>Metadata</strong></td>
<td>Enables display/use of metadata for referenced objects, obtained from a Connect server repository, in the following user interface elements: tooltips, window gutter, code and complete proposals. You can also have metadata added as comments when formatting code. For detailed information on setting up and using this feature, see &quot;Viewing Embarcadero Connect Model Metadata in the SQL Editor&quot; on page 812.</td>
</tr>
</tbody>
</table>

**NOTE:** For information on opening the Options Editor, see "Specifying Rapid SQL"
NOTE: For information on using the SQL Editor, see “Coding Environments/Editors” on page 783.

**ISQL OPTIONS - CODE ASSIST - ADVANCED TAB**

Coding assistance and error detection features such as Hyperlink object actions, Code Complete, and Semantic Validation rely on:

- Parsing of SQL entered in the SQL Editor into keywords, object name references, data, and so on
- A database object index that Rapid SQL generates for a connected datasource. On the first connection to a datasource, Rapid SQL generates an index of specified object types, with an imposed, configurable, upper limit on the number of objects contained in the index. On each subsequent connection, Rapid SQL updates the index to reflect any additions or changes on the datasource.

NOTE: The object index is stored in a persistent database with a database path of %TEMP%. With that in mind, the index may be deleted by the system administrator or automated administration-related processes.

When coding assistance and error detection features are enabled, Rapid SQL queries the index for the names of objects referenced in your scripts queries. This information is then used for tasks such as recognizing object types, detecting misspelled object names, and populating suggestion lists.

The Options Editor’s ISQL > Code Assist > Advanced tab lets you force parsing, if required, and customize how the index is generated. Since there is performance overhead associated with generation and usage of the index, you can control the properties and usage of the index.

NOTE: For information on opening the Options Editor, see “Specifying Rapid SQL application and feature options” on page 87.

The table below describes the options and functionality on the ISQL > Code Assist > Advanced Tab of the Options Editor:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scan entire file for context</td>
<td>This control is enabled only if the ISQL &gt; Code Assist tab’s Enable Real-time syntax checking check box is deselected and the Severity levels for semantic validation problems is set to IGNORE. When this control is enabled, Rapid SQL will continue to parse SQL Editor content. That is, if you have disabled real-time syntax checking and effectively disabled semantic validation, you can still use the Hyperlinks feature.</td>
</tr>
<tr>
<td>Limit scanning to files smaller than</td>
<td>Lets you place an upper limit on the size of files parsed for Code Assist features.</td>
</tr>
</tbody>
</table>
Object types to be indexed

Lets you select specific object types (aliases, synonyms, functions, packages, procedures, tables, or views) that will be included in the object index. While this can be used to reduce the index size and therefore improve performance, Hyperlinks, Semantic Validation, and Code Complete functionality associated with object types not included in the index will not be available.

Recycle cache space when index size exceeds

This imposes a soft ceiling on the number of objects stored in the index. After updating the index on connection to a datasource, the total number of objects in the index is compared to this value. If the value is exceeded, Rapid SQL deletes the oldest definitions.

The maximum number of results to return when querying the object index

Specifies the number of results when querying against the cache databases, to improve performance when working with large databases. This limit is applied per object type.

Refresh

Each time you open an ISQL editor window, Rapid SQL obtains schema information for the object types supported for the Code Complete and Semantic Validation features. That information is updated with any modifications that you make and persists until the window is closed. The Refresh button ensures that the information is current in case other users or applications are modifying the schema while the current SQL editor session window is open.

JAVA OPTIONS

Rapid SQL requires a JDBC connection. The Options Editor’s Java tab lets you set or change options that apply to the Java virtual machine (JVM) that is running on the client.

**NOTE:** For information on opening the Options Editor, see "Specifying Rapid SQL application and feature options" on page 87.

The table below describes the options and functionality of the Java tab:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>JVM Options:</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Initial Heap Size</td>
<td>Set the size, in MB, for the repository where live and dead objects come</td>
<td>64 MB</td>
</tr>
<tr>
<td></td>
<td>mingle with free memory. If memory runs out, JVM executions stop so the</td>
<td></td>
</tr>
<tr>
<td></td>
<td>garbage can be collected and expunged. Each platform responds differently,</td>
<td></td>
</tr>
<tr>
<td></td>
<td>so trial and error can help you maximize performance.</td>
<td></td>
</tr>
<tr>
<td>Maximum Heap Size</td>
<td>Set the upper limit for your heap size.</td>
<td>64 MB</td>
</tr>
<tr>
<td>Maximum Perm Gen</td>
<td>Set the upper limit for the permanent generation size.</td>
<td>Version-specific</td>
</tr>
<tr>
<td>Additional Options</td>
<td>Add options here ONLY in consultation with Embarcadero Technical Support.</td>
<td>N/A</td>
</tr>
</tbody>
</table>
LDAP CONFIGURATION OPTIONS
When using the Discover Datasources feature, Rapid SQL can search an LDAP Server for datasources. Similarly, when manually registering a datasource, you can select from server names obtained from an LDAP Server. The LDAP Configuration tab of the Options Editor lets you provide the information required to establish a session with the LDAP Server and obtain the required datasource information.

NOTE: For information on opening the Options Editor, see "Specifying Rapid SQL application and feature options" on page 87.

The table below describes the options and functionality on the LDAP Configuration tab:

<table>
<thead>
<tr>
<th>Group</th>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable LDAP</td>
<td></td>
<td>Enables LDAP lookup. This check box must be selected in order for the Discover Datasources feature to search an LDAP Servers or for server names obtained from an LDAP server to be available when manually registering datasources.</td>
</tr>
<tr>
<td>Server</td>
<td>Host Port</td>
<td>The FQDN or IP address of the LDAP server.</td>
</tr>
<tr>
<td></td>
<td>Search Base DN and Suggest</td>
<td>Lets you provide the distinguished name to be used as the search base. The Suggest button is only enabled after you select an authentication type and provide details, as required. It queries the server for possible DNs and populates the combo box with the results.</td>
</tr>
<tr>
<td>Authentication</td>
<td>Anonymous Login</td>
<td>Selecting this check box directs Rapid SQL to send LDAP requests without performing a bind. This also disables the other Authentication controls.</td>
</tr>
<tr>
<td></td>
<td>User, Password , and Remember</td>
<td>Let you provide the credentials used when sending LDAP requests.</td>
</tr>
<tr>
<td>Options</td>
<td>Size Limit and Time Limit</td>
<td>Lets you specify the maximum number of entries returnable and the maximum time, in seconds, to wait for the search to complete.</td>
</tr>
</tbody>
</table>

For more information, see:
- Manually Registering or Editing Datasources on page 131
- Automatically Discovering Datasources on page 144

LOGGING OPTIONS
After opening the Options editor (see Specifying Rapid SQL application and feature options), you can make changes to the Logging tab. The Logging tab lets you set defaults that specify the behavior and placement of SQL Logging and Output Logging.
The table below describes the options and functionality on the **Logging** tab:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Log all SQL Statements to a File</td>
<td>Indicates that the application should log all of the SQL that it executes to a file. SQL logging provides an audit trail for Rapid SQL. You can examine this log to determine the SQL executed to complete a task.</td>
<td>Not selected</td>
</tr>
<tr>
<td>Logfile Path</td>
<td>If you choose to log the SQL generated by the application, specify the drive, directory, and file name.</td>
<td>None</td>
</tr>
<tr>
<td>Max File Size</td>
<td>Specifies the maximum size for the logfile. When the logfile reaches this threshold, it automatically starts deleting lines in the logfile (starting with the oldest statements) to remain within the specified size limit.</td>
<td>1024 KB</td>
</tr>
<tr>
<td>Truncate</td>
<td>Empties the entire contents of the logfile.</td>
<td>Not available</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Log all Output Messages to a File</td>
<td>Indicates that the application should log all server messages sent to the Output window. This type of logging lets you monitor only messages issued by the server versus all SQL logged by the application. You can examine this log to determine all messages the server issued.</td>
<td>Not selected</td>
</tr>
<tr>
<td>Logfile Path</td>
<td>If you choose to log the server messages generated in the Output window, specify the drive, directory, and file name.</td>
<td>None</td>
</tr>
<tr>
<td>Max File Size</td>
<td>Specifies the maximum size for the output logfile. When the output logfile reaches this threshold, it automatically starts deleting lines in the file (starting with the oldest statements) to remain within the specified size limit.</td>
<td>1024 KB</td>
</tr>
<tr>
<td>Truncate</td>
<td>Empties the entire contents of the output logfile.</td>
<td>Not available</td>
</tr>
</tbody>
</table>

### MySQL Utilities Options

Rapid SQL integrates with MySQL utilities. For Rapid SQL to access these utilities, you need to specify their location in the **MySQL Utilities** tab of the Options Editor. You can use the MySQL Dump and Import Utilities.

**NOTE:** For information on opening the Options Editor, see "[Specifying Rapid SQL application and feature options](#)" on page 87.

The table below describes the options and functionality on the **MySQL Utilities** tab:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>mysqldump</td>
<td>Specifies a path for the MySQL dump utility, mysqldump.exe. By default, MySQL installs this utility in the C:\mysql\bin directory.</td>
</tr>
<tr>
<td>mysqlimport</td>
<td>Specifies a path for the MySQL import utility, mysqlimport.exe. By default, MySQL installs this utility in the C:\mysql\bin directory.</td>
</tr>
</tbody>
</table>
ORACLE UTILITIES OPTIONS

Rapid SQL integrates with multiple Oracle utilities. For Rapid SQL to access these utilities, you need to specify their location on the Oracle Utilities tab of the Options Editor. You can use the Oracle Export, Import Utilities, and SQL * Loader.

**NOTE:** For information on opening the Options Editor, see "Specifying Rapid SQL application and feature options" on page 87.

The table below describes the options and functionality on the Oracle Utilities tab:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Pump Export</td>
<td>Specifies a path for the Oracle expdp.exe utility.</td>
</tr>
<tr>
<td>Data Pump Import</td>
<td>Specifies a path for the Oracle impdp.exe utility.</td>
</tr>
<tr>
<td>Export</td>
<td>Specifies a path for the Oracle Export utility. By default, Oracle installs to C:\Orant\Bin directory.</td>
</tr>
<tr>
<td>Import</td>
<td>Specifies a path for the Oracle Import utility. By default, Oracle installs to C:\Orant\Bin directory.</td>
</tr>
<tr>
<td>SQL*Loader</td>
<td>Specifies a path for the SQL * Loader utility. By default, Oracle installs to C:\Orant\Bin directory.</td>
</tr>
<tr>
<td>Default Bind Size</td>
<td>Specifies the bind size. Default is set to 70KB.</td>
</tr>
</tbody>
</table>

PERF CENTER OPTIONS

Rapid SQL lets you customize Performance Center’s integration with Rapid SQL. The Options Editor’s Performance Center tab lets you provide connection details.

**NOTE:** For information on opening the Options Editor, see "Specifying Rapid SQL application and feature options" on page 87.

The table below describes the options and functionality on the Perf Center tab:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Computer Name or IP Address</td>
<td>Specify where the Performance Center Server is installed.</td>
<td>localhost</td>
</tr>
<tr>
<td>Port Number</td>
<td>Specify the port for the Apache server or IIS web server.</td>
<td>80</td>
</tr>
<tr>
<td>Test</td>
<td>Verifies the settings.</td>
<td></td>
</tr>
<tr>
<td>Connect to the server using</td>
<td>Specify if you want Rapid SQL to open the Web Client or the Performance Center file (PerfCntr.exe) within Rapid SQL</td>
<td>Web Client</td>
</tr>
</tbody>
</table>
QUERY BUILDER OPTIONS

The Options Editor’s **Query Builder Options** tab lets you specify operational and execution preferences for the Query Builder. Option parameters set on the Options Editor elicit a prompt if there are different options set on an open individual session. Global options override properties set within individual Query Builder sessions.

**NOTE:** For information on opening the Options Editor, see “Specifying Rapid SQL application and feature options” on page 87.

**NOTE:** For information on using the Query Builder, see “Query Builder” on page 848.

The table below describes the options and functionality on the **Query Builder tab**:

<table>
<thead>
<tr>
<th>Interface Element</th>
<th>Option</th>
<th>Description</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Code Generation</td>
<td>Generate Use Database statement</td>
<td>Adds a line of SQL code indicating which database or instance is used in the statement.</td>
<td>Selected</td>
</tr>
<tr>
<td></td>
<td>Generate owner names</td>
<td>Adds a line of SQL code showing the table owner name as part of the query.</td>
<td>Selected</td>
</tr>
<tr>
<td></td>
<td>Include Row Count limits</td>
<td>Includes the output row limit set in the Execution settings.</td>
<td>Not selected</td>
</tr>
<tr>
<td></td>
<td>Generate SQL/92 if supported by DBMS</td>
<td>SQL/92 is a standard for relational database management systems.</td>
<td>Not selected</td>
</tr>
<tr>
<td>Execution</td>
<td>To set the maximum number of rows in your result set, type the number in the dialog. This lessens congestion of server processes when queries execute by setting row count limits.</td>
<td>1000 rows</td>
<td></td>
</tr>
<tr>
<td>General</td>
<td>Show Column Data types in Query Diagram</td>
<td>Reveals the data type in each column for tables in the SQL Diagram pane.</td>
<td>Not selected</td>
</tr>
<tr>
<td></td>
<td>Confirm on Item delete</td>
<td>Opens a <strong>Confirm Delete</strong> dialog when an item is deleted.</td>
<td>Selected</td>
</tr>
<tr>
<td></td>
<td>Auto Populate Views</td>
<td>Checks syntax every time an execute statement, refresh or copy statement begins.</td>
<td>Not Selected</td>
</tr>
<tr>
<td></td>
<td>Auto Format</td>
<td>Automatically sets style and spacing of display.</td>
<td>Selected</td>
</tr>
<tr>
<td>Auto Join</td>
<td>Run Automatically</td>
<td>Automatically detects names and data types, and create joins for multiple tables.</td>
<td>Selected</td>
</tr>
<tr>
<td></td>
<td>Require Indexes</td>
<td>Joins only indexed columns. Requires an indexed column for joins.</td>
<td>Selected</td>
</tr>
<tr>
<td></td>
<td>Require same data type</td>
<td>Automatically joins columns with the same data type.</td>
<td>Selected</td>
</tr>
<tr>
<td>Syntax Checker</td>
<td>Automatic Syntax Check</td>
<td>Automatically checks SELECT and CREATE VIEW statements for errors.</td>
<td>Selected</td>
</tr>
<tr>
<td></td>
<td>Warn on non index join</td>
<td>Returns a warning when it detects a join against a non-indexed column, or a column not participating in a primary key</td>
<td>Not selected</td>
</tr>
<tr>
<td>Display</td>
<td>Lets you sets the style, size, and color of Column Font and Title Font. Also lets you set the background Table Color for the SQL Diagram Pane.</td>
<td>Available</td>
<td></td>
</tr>
</tbody>
</table>
REPORTS OPTIONS
The Options Editor's Reports tab lets you:

• Append a date and timestamp to report file names. This prevents existing reports from being overwritten.

• Save reports in date-specific folders.

• Save reports in PDF format as opposed to HTML.

• Let you include a provided image and title to reports.

  NOTE: For information on opening the Options Editor, see "Specifying Rapid SQL application and feature options" on page 87.

  NOTE: For information on generating reports, see "Report" on page 680.

RESULTS (ISQL) OPTIONS
The Options Editor's Results tab lets you specify operational and appearance details for Rapid SQL's SQL Editor.

  NOTE: For information on opening the Options Editor, see "Specifying Rapid SQL application and feature options" on page 87.

  NOTE: For information on using the SQL Editor, see "Coding Environments/Editors" on page 783.

The table below describes the options and functionality on the Results tab:

<table>
<thead>
<tr>
<th>Interface Element</th>
<th>Options and descriptions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Results Option pane</td>
<td>Result Window</td>
</tr>
<tr>
<td>Single Window</td>
<td>- Displays all results in one tabbed result window. Multiple result sets together in the window. Single Window and Multiple Windows options are mutually exclusive.</td>
</tr>
<tr>
<td>Multiple Windows</td>
<td>- Displays multiple result sets one result set per window.</td>
</tr>
<tr>
<td>Attached to Editor</td>
<td>- Sets results as tabbed windows attached to the ISQL window. Used in conjunction with Single Window option or Multiple Window option. Attached and Unattached options are mutually exclusive.</td>
</tr>
<tr>
<td>Unattached</td>
<td>- Sets results appear separate from the ISQL Window. Used in conjunction with Single Window option or Multiple Windows option.</td>
</tr>
<tr>
<td>Reuse Window</td>
<td>- Sets new result sets to overwrite any current result sets in an open Result Window. Only valid for Single and Attached to Editor combination.</td>
</tr>
<tr>
<td>Interface Element</td>
<td>Options and descriptions</td>
</tr>
<tr>
<td>-------------------</td>
<td>--------------------------</td>
</tr>
</tbody>
</table>
| Results File      | **Mail File Type** - Selects the file type to use when sending result sets via a MAPI-compliant mail package. Valid formats include the proprietary Results type, Tab delimited, Comma separated, and HTML.  
**Schedule File Type** - Selects the schedule file type. Valid formats include Tab delimited, Comma separated, and HTML.  
**Include column titles when saving** - Includes column titles when saving a result set. If this option is turned off, column titles Rapid SQL does not save result sets. |
| Result Set Options| **Default Rowcount** - Lets you limit the number of rows returned to the result window of the ISQL window (default 0).  
**Sybase ASE and SQL Server: Text Size (bytes)** - Lets you specify the text size (default 8192).  
**Oracle:LONG Size (bytes)** - Lets you specify the LONG size (default 8192).  
**LOB Preview: Text Size (bytes)** - Specifies the length of the preview of LOB column data (default 4096). |
| Sort Type         | Lets you select a result sorting: Alphameric or Lexicographic. |
| Format pane       | **Column Formatting**  
**Auto Format (Best Fit)** - Sets column widths automatically to accommodate the longest piece of data in a column. Large queries depend on the longest row formatting, so activating this option can affect performance.  
**Use pre-defined column** - Lets you select column type and character length |
| Enable Date/Time Format | Lets you select the date/time format. |
| Format            | **Standard Grid** - Displays all result sets in a standard grid format. Rapid SQL displays result sets in grid format in ISQL Editors that are opened after you have selected this option. Rapid SQL does not display ISQL Editors that are already open.  
**HTML** - Displays all result sets as HTML tables. Rapid SQL displays result sets in HTML format in ISQL Editors that are opened after you have selected this option. Rapid SQL does not display ISQL Editors that are already open.  
**ASCII Text** - Displays all result sets as ASCII Text. Rapid SQL displays result sets in ASCII Text format in ISQL Editors that are opened after you have selected this option. Rapid SQL does not display ISQL Editors that are already open.  
**Grid Font** and **Printer Font** buttons - Open a Font dialog, letting you select the font, style, and size for the result sets grid or printed result sets.  
**Enable Locale** - If selected, numbers are formatted (thousands separator, decimal separator) as locale-specific strings. If unselected, numbers are formatted according to the C locale. |
SMTP Mail Options
The Options Editor's **SMTP Mail Options** tab lets you specify outgoing notification e-mail message options.

**NOTE:** For information on opening the Options Editor, see "Specifying Rapid SQL application and feature options" on page 87.

The table below describes the options and functionality on the **SMTP Mail** tab:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Send messages through SMTP</td>
<td>Enables SMTP messaging and makes the other controls on this tab available.</td>
<td>Unselected</td>
</tr>
<tr>
<td>Name</td>
<td>Name that appear as the e-mail sender.</td>
<td>Name you specified during installation.</td>
</tr>
<tr>
<td>E-mail Address</td>
<td>Address to send e-mails from Rapid SQL.</td>
<td>E-mail address you specified during installation.</td>
</tr>
<tr>
<td>Authentication</td>
<td>Lets you specify authentication options.</td>
<td>None</td>
</tr>
<tr>
<td>User Name</td>
<td>User name for authentication.</td>
<td>Not available</td>
</tr>
<tr>
<td>Password</td>
<td>Password for authentication.</td>
<td>Not available</td>
</tr>
<tr>
<td>Host Name</td>
<td>SMTP server for outgoing messages. For Microsoft Outlook, select Tools, and then Accounts. On the Mail tab, select target account, and then click Properties. On Servers tab, copy the Outgoing Mail(SMPT) and paste.</td>
<td>Host Name you specified during installation.</td>
</tr>
<tr>
<td>Port Number</td>
<td>Port number you connect to on your outgoing SMTP server.</td>
<td>25</td>
</tr>
<tr>
<td>Test</td>
<td>Opens an SMTP Configuration Test e-mail addressed to your e-mail address. Click Send Mail to send the e-mail.</td>
<td>Available</td>
</tr>
<tr>
<td>Bind to</td>
<td>Your IP address the message is bound to.</td>
<td>ANY_IP_ADDRESS</td>
</tr>
<tr>
<td>Encoding</td>
<td>E-mail encoding.</td>
<td>Western Europe (ISO)</td>
</tr>
<tr>
<td>Send messages Mime encoded</td>
<td>Messages encoded using Multipurpose Internet Mail Extensions (MIME) support enriched content and attachments.</td>
<td>Selected</td>
</tr>
<tr>
<td>Send all messages as HTML</td>
<td>Messages include text formatting.</td>
<td>Selected</td>
</tr>
<tr>
<td>Auto Connect to the Internet</td>
<td>Rapid SQL connects to internet at launch.</td>
<td>Selected</td>
</tr>
</tbody>
</table>

Version Control Options
The Options Editor's **Version Control tab** lets you select which version control system you want Rapid SQL to use as the underlying version control system.

**NOTE:** For information on opening the Options Editor, see "Specifying Rapid SQL application and feature options" on page 87.

**NOTE:** For information on version control in Rapid SQL, see "Version Control" on page 813.
The table below describes Version Control options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Specify Version Control System</td>
<td>Lists the Version Control systems that integrate with Rapid SQL. Select the option button for the product you want Rapid SQL to use.</td>
<td>None</td>
</tr>
<tr>
<td>Optional Fields</td>
<td>If you select Microsoft Visual SourceSafe, Rapid SQL uses your default SourceSafe database unless you override this setting by entering the path for the SourceSafe file associated with the desired database. To use a SourceSafe database other than the default, provide a user name, password, and the location of a scrsafe.ini file.</td>
<td>Optional</td>
</tr>
</tbody>
</table>

**Warnings Options**

Rapid SQL lets you issue warning messages to users whenever improper operations are attempted in a database. Warning messages differ by platform. The Options Editor’s **Warnings** tab lets you select the DBMS-specific events that generate warnings.

**NOTE:** For information on opening the Options Editor, see "Specifying Rapid SQL application and feature options" on page 87.

The tables below describes the options of the **Warnings** tab:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
<th>Platform</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create an index on the same tablespace as the associated table</td>
<td>Issues a warning message whenever a user does not create an index on a different tablespace than the table. This makes it possible for the server to read the index and table data in parallel.</td>
<td>DB2</td>
</tr>
<tr>
<td>Create an index on the same tablespace as the associated table</td>
<td>Issues a warning message whenever a user does not create an index on a different tablespace than the table. This makes it possible for the server to read the index and table data in parallel.</td>
<td>Oracle</td>
</tr>
<tr>
<td>Create an object in the SYSTEM tablespace</td>
<td>Issues a warning message whenever a user tries to create or place an object on the SYSTEM tablespace.</td>
<td>Oracle</td>
</tr>
<tr>
<td>Create a user with default or temp tablespace as the SYSTEM tablespace</td>
<td>Issues a warning message when a user is created with a default or temp tablespace on the SYSTEM tablespace.</td>
<td>Oracle</td>
</tr>
<tr>
<td>Create an object in the master database</td>
<td>Issues a warning message when an object is created in the master database.</td>
<td>Microsoft SQL Server and Sybase ASE</td>
</tr>
<tr>
<td>Create a table or index on the default segment</td>
<td>Issues a warning message when a table or index is created on the default segment.</td>
<td>Microsoft SQL Server and Sybase ASE</td>
</tr>
<tr>
<td>Create a non-clustered index on same segment as the associated table</td>
<td>Issues a warning message when a non-clustered index is created on the same segment as the associated table.</td>
<td>Microsoft SQL Server and Sybase ASE</td>
</tr>
</tbody>
</table>
LOCKING DOWN RAPID SQL FEATURES USING THE REGISTRY

Administrators can restrict certain Rapid SQL features on individual machines through registry settings. Those settings are stored in the following location:

- HKLM\Software\Embarcadero\Rapid SQL optional version identifier\Admin

The following general datasource and connection settings are available:

<table>
<thead>
<tr>
<th>Name (and Type)</th>
<th>Description and Supported Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>RestrictedPlatforms (REG_SZ)</td>
<td>A comma-separated list (db2=0,mssqlserver=1, for example) dictating DBMS platform support on the machine. Valid names for the name=value pairs are db2, os390, mssqlserver, mysql, oracle, sybase, interbase, mssqlazure, odbc, jdbc, and sybaseiq. Any non-zero value for a name=value pair results in that platform not being unavailable to Rapid SQL on that machine. A zero value (the default) results in the platform being available on that machine.</td>
</tr>
<tr>
<td>DisableAutoConnect (REG_DWORD)</td>
<td>When set to any non-zero value, users cannot use the auto-connect feature when registering or logging in to a datasource.</td>
</tr>
<tr>
<td>SharedDatasourceCatalogPath (REG_SZ)</td>
<td>Providing a path to the network shared datasource catalog forces Rapid SQL to use that datasource catalog storage option. Registry-based and file-based catalog storage will be unavailable on this machine.</td>
</tr>
</tbody>
</table>

The following settings control configuration options on the Connect page of the Options Editor and the Connect login dialog. For details, see "Connect Options" on page 88 and "Logging in to an Embarcadero Connect Server" on page 149.

<table>
<thead>
<tr>
<th>Name (and Type)</th>
<th>Description and Supported Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>ConnectURL (REG_SZ)</td>
<td>The full Embarcadero Connect server URL that the user must use if use of Embarcadero Connect is enabled. If a value is specified, the Connect URL control on the Connect page of the Options Editor is set to read-only.</td>
</tr>
<tr>
<td>UseConnect (REG_DWORD)</td>
<td>If a value of 1 (TRUE) is specified, use of Embarcadero Connect is enabled. If a value of 0 (FALSE) is specified, use of Embarcadero Connect is disabled. If either value is specified, the Use Connect control on the Connect page of the Options Editor is disabled.</td>
</tr>
<tr>
<td>AllowKeepMeSignedIn (REG_DWORD)</td>
<td>If a value of 1 (TRUE) is specified, the Keep me signed in control on the Embarcadero Connect - Log In dialog is set to an unchecked state and the control is disabled.</td>
</tr>
</tbody>
</table>

UseConnect and AllowKeepMeSignedIn is type REG_DWORD (legal values for both are 0 for FALSE and 1 for TRUE).

Administrators not wanting to use these settings from the HKLM root key, can use the same options in HKCU root key:

- HKCU\Software\Embarcadero\Rapid SQL optional version identifier\Admin

If the option is specified in both locations, HKLM takes precedence over HKCU.
After installing Rapid SQL, you must set up datasource definitions to establish reusable connections to your database servers. The following topics describe the function of datasources, the process of establishing datasource connections, and the related options provided by Rapid SQL:

**Registering Datasources**

Provides instructions on how to set up datasource definitions, manually and automatically.

**Connecting to Datasources**

Provides instructions on how to connect to datasources, manually and automatically.

**Trouble-shooting Client Setup**

Provides advice on solving common connectivity problems.

**Using the Datasource Navigator**

Describes the user interface mechanism that lets you browse among datasources, drill down to the database object level, and initiate datasource or object actions.

**Using the Manage Datasources Utility**

Describes a utility offering shortcuts to Rapid SQL datasource options.

**Registering Datasources**

A datasource is the connection profile that lets you have access to a database, and, therefore, to your data. So, when you register a datasource, you’re telling Rapid SQL how to get at the database(s) you want to operate on. In fact, all database activities are performed through datasources, so you need a datasource profile for each database instance (or database server) in your enterprise. Each connection profile consists of basics such as unique name, DBMS-specific connection parameters, and user credentials.

Collectively, datasource definitions are stored in a datasource catalog. The catalog can be registry-based, local file-based, or network shared file-based, with each method addressing particular advantages. For details, see "Specifying a Datasource Catalog Storage Option" on page 130.

Rapid SQL offers the following options for registering datasources:

**Manual registration**

You can register datasources individually. For details, see "Manually Registering or Editing Datasources" on page 131.

**Automatic discovery**

You can have Rapid SQL search computers or your network for datasources. For details, see "Automatically Discovering Datasources" on page 144.

**Import/Export**

Rapid SQL lets you export and import sets of datasource registrations. For details, see "Importing and Exporting Datasource Definitions" on page 146.

**Embarcadero Connect**

Integrating with Embarcadero Connect lets you work with datasource definitions on a data governance metadata repository. For details, see "Working With Datasources from a Connect Repository" on page 148.

As an aid in maintaining your datasource registrations, Rapid SQL lets you quickly view basic registration details of a datasource. For details, see "Viewing Datasource Properties" on page 152.
Lastly, when a datasource registration becomes obsolete, you can remove the registration from Rapid SQL. For details, see "Unregistering Datasource" on page 153.

**SPECIFYING A Datasource Catalog STORAGE OPTION**

A Datasource Catalog is a collection of defined datasources. On startup, Rapid SQL loads a Datasource Catalog using one of three methods, specified using the Options editor:

- **Windows Registry datasource catalog** - The datasource catalog is stored and managed locally, in the Windows registry. This user can add and delete datasources and edit the registration details of existing resources. Any changes are retained across startups of Rapid SQL.

  This method is compatible with other Embarcadero products using registry-based datasource definition storage. If more than one of those products is installed on the same machine, they can share the same Datasource Catalog.

- **File based datasource catalog** - The datasource catalog is stored locally and is file-based. Each datasource definition included in the catalog is stored in a single file (.dsd file suffix) in the `%APPDATA%\Embarcadero\Data Sources\` folder, in a default installation. This user can add and delete datasources and edit the registration details of existing resources. Any changes are retained across startups of Rapid SQL.

  This method is compatible with other Embarcadero products using file-based datasource definition storage. If more than one of those products is installed on the same machine with Rapid SQL, all can share the same Datasource Catalog.

- **Network shared datasource catalog** - The datasource catalog is file-based, and obtained from a user-specified location such as a network share. At each startup, Rapid SQL imports definitions from the network shared file (.etsds file suffix).

  Changes such as new datasources, deleted datasources or edited datasource registrations are lost as soon as this user shuts down Rapid SQL. This method allows centralized maintenance of the Datasource Catalog and sharing of a single catalog among multiple users across a network.

  **NOTE:** The definition files used in both the File based datasource catalog and Network shared datasource catalog methods do not store user ID and password credentials. Credentials, links to definition files in the current user’s catalog, and folder structure are stored in the `%APPDATA%\Embarcadero\Data Sources\metadata\dsuri.xml` file.

  **NOTE:** On individual computers, administrators can force use of the network shared option. For details, see "Locking Down Rapid SQL Features Using the Registry" on page 127.

For information on choosing a method and specifying the network location of a Shared Datasource Management definition file, see “Datasource Options” on page 96.

Regardless of the catalog storage method, the Datasource Catalog can be built manually by explicitly registering datasources or using automated methods such as the Discover Datasources feature. For details, see “Registering Datasources” on page 129.
Keep in mind that changes made with Network shared datasource catalog in effect, are lost on shutdown of Rapid SQL.

In order to set up a Network shared datasource catalog scheme, you can build a catalog first using the File based datasource catalog or Windows Registry datasource catalog method. You can subsequently use the Manage Datasources facility to export your Network shared datasource catalog file to the location that others will use to load the file. For details, see "Importing and Exporting Datasource Definitions" on page 146.

More generally, the Manage Datasources facility’s import/export functions can be used to exchange datasource definitions between users employing the different storage methods. Even more simply, these functions save time in allowing datasource definitions to be defined once and then shared with multiple users.

**MANUALLY REGISTERING OR EDITING DATASOURCES**

Each database instance must be registered. Whether you are registering a new datasource, registering a new datasource based on an existing datasource definition, or editing preexisting connection information, you use the Datasource Registration dialog box.

**To register a new datasource or edit an existing datasource**

1. Use one of the following actions:
   
   - To register a new datasource, from the **Datasource** menu, select **Register Datasource**.
   
   - To register a new datasource based on an existing definition, select the existing datasource in the Navigator and then from the **Datasource** menu, select **Register Like**.
   
   - To edit registration information, on the Navigator, right-click a datasource and select **Edit**.

2. Use the following topics as a guide to providing the information required to register or edit the datasource:
   
   - **Selecting Database Type/Connectivity Options When Registering Datasources**
   
   - **Providing Connection Information When Registering Datasources**
   
   - **Providing Security Parameters When Registering Datasources**
   
   - **Providing Custom Driver Properties When Registering Datasources**
   
   - **Specifying Datasource Properties When Registering Datasources**
   
   - **Specifying Oracle Views Configuration When Registering Datasources**
   
   - **Specifying Group and Category Details When Registering Datasources**

3. When ready, click **Finish** and respond to the prompt to connect immediately.

**NOTE:** The **Test Connection** button can be used when creating or editing a datasource to verify that a connection can be established. Keep in mind that the information currently provided in the wizard is used to test the connection and therefore connection information, credentials, and custom JDBC driver properties if appropriate, must be valid.
SELECTING DATABASE TYPE/CONNECTIVITY OPTIONS WHEN REGISTERING DATASOURCES

The **Datasource Registration Wizard**’s **Database Type** panel lets you specify the basic connectivity method for the datasource you are creating.

**NOTE:** Prior to registering datasources, you should be familiar with the connectivity options available for each DBMS platform. For details, see "Database Support and Connectivity Options" on page 14.

**NOTE:** The Options Editor lets you indicate preferences, select options, and provide details not available with the Datasource Registration Wizard. For details, see "Connection Options" on page 89.

**NOTE:** On individual computers, administrators can restrict the available DBMS platforms available to Rapid SQL using registry settings. For details, see "Locking Down Rapid SQL Features Using the Registry" on page 127.

To use Embarcadero’s default drivers requiring dedicated client software installed on the client machine

1. From the **Available database types** list, select one of the following:
   - IBM DB2 Universal Database
   - Microsoft SQL Server
   - MySQL
   - Oracle
   - Sybase Adaptive Server
   - Sybase IQ
   - InterBase/Firebird

   If there is currently a DBMS node selected in the Navigator, that database type is automatically selected.

   **NOTE:** Selecting an entry of the selected database type from the **Attached to Connect datasource** list, prepopulates the wizard with definitions/settings from the Connect server for that datasource. For more information on Connect datasources, see "Working With Datasources from a Connect Repository" on page 148.

2. Click **Next**.

To specify a custom JDBC driver

1. From the **Available database types** list, select **Generic JDBC**.

2. Click **Next**.
To specify a generic ODBC driver or to use an ODBC connection
1. From the **Available database types** list, select **Generic JDBC**.
2. Click **Next**.

**Providing Connection Information When Registering Datasources**
Connection information is provided on a DBMS platform basis. The following topics describe platform-by-platform descriptions of the required and optional connection information:

- Providing DB2 Connection Information When Registering Datasources
- Providing InterBase/Firebird Connection Information When Registering Datasources
- Providing MySQL Connection Information When Registering Datasources
- Providing Oracle Connection Information When Registering Datasources
- Providing SQL Server Connection Information When Registering Datasources
- Providing Sybase ASE Connection Information When Registering Datasources
- Providing Connection Information When Registering a Generic JDBC Datasource
- Providing Connection Information When Registering a Generic ODBC Datasource

**Providing DB2 Connection Information When Registering Datasources**
The **Datasource Registration** Wizard's **Connection Information** panel lets you provide details required to establish a connection to a DB2 datasource. Available options depend on the **Registration Type** value selected.

The following table describes these settings:

<table>
<thead>
<tr>
<th>Registration Type</th>
<th>Option/Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Simple</td>
<td><strong>Host/Instance</strong> - The network name of the machine hosting the datasource.</td>
</tr>
<tr>
<td></td>
<td><strong>Port</strong> - This defaults to 50000 but can be overwritten.</td>
</tr>
<tr>
<td></td>
<td><strong>Database</strong> - The name of the database this user should connect to.</td>
</tr>
<tr>
<td></td>
<td><strong>Datasource Name</strong> - This is the name of the datasource as it will appear in the Navigator or Explorer.</td>
</tr>
<tr>
<td>Use alias from IBM client</td>
<td><strong>Server</strong> - Select from the names of servers defined in the IBM client.</td>
</tr>
<tr>
<td></td>
<td><strong>Datasource Name</strong> - This is the name of the datasource as it will appear in the Navigator or Explorer.</td>
</tr>
</tbody>
</table>
Keep the following in mind when registering a DB2 datasource:

- The Options Editor lets you indicate preferences, select options, and provide details not available with the Datasource Registration Wizard. For details, see "Connection Options" on page 89.
- Consult DB2 documentation for detailed information on general LDAP support, supported LDAP servers, and client configuration before trying to use Rapid SQL to register LDAP-specified datasources. For assistance, see Accessing Third Party Documentation.
- For more general information on registering datasources, see "Manually Registering or Editing Datasources" on page 131.

Providing InterBase/Firebird Connection Information When Registering Datasources

The Datasource Registration Wizard’s Connection Information lets you provide details required to establish a connection to an InterBase or Firebird datasource. The following table describes these setting:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Host name</td>
<td>The name of the machine where the database resides.</td>
</tr>
<tr>
<td>Port</td>
<td>Optionally, provide a port number.</td>
</tr>
<tr>
<td>Character Set</td>
<td>The default character set used for this connection.</td>
</tr>
<tr>
<td>Database file path</td>
<td>The full path to the database file, a .gdb file for Interbase or a .fdb file for Firebird.</td>
</tr>
<tr>
<td>Datasource Name</td>
<td>Optionally, override any value in this field with a value to be displayed in the Rapid SQL Datasource Navigator tree.</td>
</tr>
</tbody>
</table>

For more general information on registering datasources, see "Manually Registering or Editing Datasources" on page 131.
PROVIDING MySQL Connection Information When Registering Datasources

The Datasource Registration Wizard’s Connection Information lets you provide details required to establish a connection to a MySQL datasource. The following table describes these setting:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Server</td>
<td>Enter the name of the host, for example doctest01.</td>
</tr>
<tr>
<td>Port (optional)</td>
<td>The default port is 3306. You do not need to enter this information.</td>
</tr>
<tr>
<td>Default Database</td>
<td>You must enter the name of the default database.</td>
</tr>
<tr>
<td>Datasource Name</td>
<td>This field is automatically populated with the server name, but you can rename it to whatever you want.</td>
</tr>
</tbody>
</table>

**NOTE:** The Options Editor lets you indicate preferences, select options, and provide details not available with the Datasource Registration Wizard. For details, see "Connection Options" on page 89.

For more general information on registering datasources, see "Manually Registering or Editing Datasources" on page 131.

Providing Oracle Connection Information When Registering Datasources

The Datasource Registration Wizard’s Connection Information lets you provide details required to establish a connection to an Oracle datasource. Available options depend on the Registration Type value selected.

The following table describes these setting:

<table>
<thead>
<tr>
<th>Registration Type</th>
<th>Options/Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Simple</td>
<td>Host - Manually enter the name of the host machine.</td>
</tr>
<tr>
<td></td>
<td>Port - The default is 1521, but you can change it to wherever the Oracle listener is set up.</td>
</tr>
<tr>
<td></td>
<td>SID/Service Name - Enter the SID or Service Name to correspond with the option you select.</td>
</tr>
<tr>
<td></td>
<td>Instance Name - The specific name used to identify the Oracle instance (the SGA and the Oracle processes).</td>
</tr>
<tr>
<td></td>
<td>Datasource Name - The field is automatically populated with the host name, but you can change it.</td>
</tr>
<tr>
<td>Use Connection Descriptor</td>
<td>Connect Descriptor - provide a TNS Connect String, a connect identifier that defines the parameters that need the Oracle Net Service to connect to a database service.</td>
</tr>
<tr>
<td></td>
<td>Datasource Name - The field is automatically populated with the host name, but you can change it.</td>
</tr>
</tbody>
</table>
Keep the following in mind when registering an Oracle datasource:

- You can register an Oracle ASM instance directly using the Datasource Registration Wizard. No Datasource Navigator tree is available when connecting to the ASM instance. The ISQL Editor is available with this type of connection.

- Consult Oracle documentation for detailed information on general LDAP support, supported LDAP servers, and client configuration before trying to use Rapid SQL to register LDAP-specified datasources. For assistance, see Accessing Third Party Documentation.

- For more general information on registering datasources, see "Manually Registering or Editing Datasources" on page 131.
Providing SQL Server Connection Information When Registering Datasources

The Datasource Registration Wizard’s Connection Information lets you provide details required to establish a connection to a SQL Server datasource. The following table describes these setting:

**NOTE:** If you are registering a named instance on a server, you are restricted to use of the Use Network Library Configuration/Alias method below. Prior to registering the datasource in Rapid SQL, use the SQL Server Configuration Manager to create an alias to the instance, making it available as an Alias selection on the Connection Information panel.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Simple</strong></td>
<td>Protocol (TCP/IP or Named Pipes) - You need to select one or the other to register a SQL Server database. Host - the host name. Port - Depending on your section, you can optionally indicate the port for TCP/IP or the pipe name depending on your means of connection. Default DB - Optionally give the default name for the database. Datasource Name - The field is automatically populated with the host name, but you can rename to whatever you want.</td>
</tr>
<tr>
<td><strong>Use Network Library Configuration</strong></td>
<td>Use Encryption - enables multiprotocol encryption. Alias - Select an alias Protocol (TCP/IP or Named Pipes) - You need to select one or the other to register a SQL Server database. Host - Displays the host name. Port - Depending on your section, you can optionally indicate the port for TCP/IP or the pipe name depending on your means of connection. Default DB - Optionally give the default name for the database. Datasource Name - The field is automatically populated with the host name, but you can rename to whatever you want.</td>
</tr>
</tbody>
</table>

**NOTE:** The Options Editor lets you indicate preferences, select options, and provide details not available with the Datasource Registration Wizard. For details, see "Connection Options" on page 89.

For more general information on registering datasources, see "Manually Registering or Editing Datasources" on page 131.
Providing Sybase ASE Connection Information When Registering Datasources

The Datasource Registration Wizard’s Connection Information lets you provide details required to establish a connection to a Sybase ASE datasource. The following table describes these settings:

<table>
<thead>
<tr>
<th>Registration Type</th>
<th>Option/Description</th>
</tr>
</thead>
</table>
| Simple                                  | **Use SSL Encryption** - If this option is selected, the JDBC connection will be established using SSL encryption  
**Host** - Manually enter the name of the host.  
**Port** - There is no default for this optional field.  
**Default DB** - Optionally give the default name for the database.  
**Datasource Name** - This field automatically populates with the server name. You can change it to whatever you want. |
| Use alias information from the SQL.INI FILE | **Sybase Server** - Select a server from the dropdown  
**Host** - Automatically populated when you select an alias.  
**Port** - There is no default for this optional field.  
**Default DB** - Optionally give the default name for the database.  
**Datasource Name** - This field automatically populates with the server name. You can change it to whatever you want. |
| Use data from the LDAP server           | **Use SSL Encryption** - The connection will be established using SSL encryption.  
**Sybase Server** - Select a server from the dropdown  
**Host** - Automatically populated when you select an alias.  
**Port** - There is no default for this optional field.  
**Default DB** - Optionally give the default name for the database.  
**Datasource Name** - This field automatically populates with the server name. You can change it to whatever you want. |

**NOTE:** The Options Editor lets you indicate preferences, select options, and provide details not available with the Datasource Registration Wizard. For details, see "Connection Options" on page 89.

For more general information on registering datasources, see "Manually Registering or Editing Datasources" on page 131.
PROVIDING SYBASE IQ CONNECTION INFORMATION WHEN REGISTERING DATASOURCES

The **Datasource Registration** Wizard’s **Connection Information** lets you provide details required to establish a connection to a Sybase IQ datasource. The following table describes these settings:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Host</td>
<td>The host name for the Sybase IQ Server.</td>
</tr>
<tr>
<td>Port</td>
<td>The port that Sybase IQ is listening on.</td>
</tr>
<tr>
<td>Database</td>
<td>The name for the database to connect to.</td>
</tr>
<tr>
<td>Datasource Name</td>
<td>This field automatically populates with the host name. You can change it to whatever you want.</td>
</tr>
</tbody>
</table>

**NOTE:** The Options Editor lets you indicate preferences, select options, and provide details not available with the Datasource Registration Wizard. For details, see "Connection Options" on page 89.

For more general information on registering datasources, see "Manually Registering or Editing Datasources" on page 131.

PROVIDING CONNECTION INFORMATION WHEN REGISTERING A GENERIC JDBC DATASOURCE

The **Datasource Registration** Wizard’s **Connection Information** lets you provide basic information details required to establish a connection to a generic JDBC datasource.

**NOTE:** For requirements and Rapid SQL functionality restrictions for generic JDBC connections, see "Generic JDBC and ODBC Support" on page 16.

The following table describes the settings on this panel:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>JDBC driver to use</td>
<td></td>
</tr>
<tr>
<td>Connection URL</td>
<td>If you are defining a datasource using a custom JDBC driver, this field is automatically populated with the value you entered in the Template Connect URL for new datasource field. For more information, see &quot;Providing details for a new custom JDBC driver&quot; on page 140. Type a valid connection URL or edit the URL template to provide a valid connection URL.</td>
</tr>
<tr>
<td>Datasource Name</td>
<td>This is the name that will appear in Rapid SQL's Navigator.</td>
</tr>
</tbody>
</table>

**NOTE:** In addition to basic connection properties, you can also specify provider-specific JDBC properties. For details, see "Providing Custom Driver Properties When Registering Datasources" on page 142.
3 Take one of the following actions:

a To specify a JDBC driver that you have not used with Rapid SQL before, click Manage to register a new driver with Rapid SQL. For more information, see "Providing details for a new custom JDBC driver" on page 140.

b To use a custom JDBC driver you have already registered with Rapid SQL, select that driver from the JDBC driver to use dropdown.

**Providing details for a new custom JDBC driver**

When registering a datasource, if you select a generic JDBC connection, you must specify the installed JDBC driver to be used. If you have not used that driver with Rapid SQL, you can register that driver with Rapid SQL while defining a datasource.

**NOTE:** Before setting up a custom driver, consult the documentation for that driver to obtain details such as the driver class and connection URL for that driver type.

**To specify a new custom JDBC driver**

1 Open a datasource registration dialog. For details, see "Manually Registering or Editing Datasources" on page 131.

1 From the Available database types list, select Generic JDBC.

2 On the Connection Information page, click Manage. The JDBC Driver Editor opens.

3 In the Name field, type a name or description for the new driver.

4 Click the Add button associated with the Driver Archives list and use the Open dialog to locate and select the library or archive for the driver.

5 In the Class field, type the driver class.

6 In the Template Connect URL for new data source field, provide a connection URL template. There are no constraints on the value that you enter. When providing details on the Datasource Registration Wizard's Connection Information panel, the template will automatically be entered in the Connection URL field, letting you provide actual values for any placeholders you provide in the URL template entered here.

**Providing connection information when registering a generic ODBC datasource**

The Datasource Registration Wizard’s Connection Information lets you provide details required to establish a connection to a generic ODBC datasource.

**NOTE:** For requirements and Rapid SQL functionality restrictions for generic ODBC connections, see "Generic JDBC and ODBC Support" on page 16.
The following table describes the settings on this panel:

<table>
<thead>
<tr>
<th>Use Connect String</th>
<th>Option/Description</th>
</tr>
</thead>
</table>
| Unselected         | **Datasource Name** - Provide the name that will appear in the Rapid SQL Navigator for this datasource.  
                      **DSN** - Provide the DSN for the datasource. |
| Selected           | **Datasource Name** - Provide the name that will appear in the Rapid SQL Navigator for this datasource.  
                      **Connect String** - Provide the full connection string for the datasource. |

**NOTE:** Consult the documentation for the ODBC driver and the datasource you are connecting to for details on DSN and connect string requirements.

**Provisioning Security Parameters When Registering Datasources**

The **Datasource Registration** Wizard's **Security Parameters** panel lets you provide user credentials and specify other DBMS-specific security settings. The following table describes these settings and their DBMS availability:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>User ID</td>
<td>The User ID that DBArtisan will use to connect to the datasource.</td>
</tr>
<tr>
<td>Password</td>
<td>The password associated with the User ID.</td>
</tr>
<tr>
<td>Connect As (Oracle)</td>
<td>When relevant, choose the appropriate user/administrator level (NORMAL, SYSDBA, or SYSOPER).</td>
</tr>
<tr>
<td>Domain (SQL Server)</td>
<td>For MS SQL only. Identify the domain if the user has restricted access.</td>
</tr>
<tr>
<td>Auto connect?</td>
<td>Spares the user from reentering the password every time you connect.</td>
</tr>
<tr>
<td></td>
<td>On individual computers, auto connect can be disabled by administrators.</td>
</tr>
<tr>
<td></td>
<td>For details, see &quot;Locking Down Rapid SQL Features Using the Registry&quot; on page 127.</td>
</tr>
<tr>
<td>Omit User ID and Password (Generic JDBC and Generic ODBC only)</td>
<td>Selected, no user ID or password are passed when connecting to the datasource.</td>
</tr>
<tr>
<td>Connect using Windows Authentication or Connect using OS Authentication (IBM DB2 for Windows, Unix, and Linux, MySQL, Oracle, SQL Server)</td>
<td>Login to the server is verified using Windows/OS authentication</td>
</tr>
<tr>
<td>Connect using Kerberos Authentication (Sybase ASE)</td>
<td>If this option is selected, login to the server is verified using Kerberos authentication.</td>
</tr>
<tr>
<td></td>
<td>NOTE: This is only available of the Use alias information in the SQL.INI file/Sybase Server option on the Connection Information tab is selected. For details, see Data Editor Options.</td>
</tr>
</tbody>
</table>

For more general information on registering datasources, see "Manually Registering or Editing Datasources" on page 131.
Providing Custom Driver Properties When Registering Datasources

The Datasource Registration Wizard’s Custom Driver Properties panel lets you specify optional, provider-specific connection string keywords or properties beyond those offered on other panels of the wizard.

NOTE: Consult driver/client documentation for details on supported driver properties. For a listing of supported DBMS drivers and clients, see the ReadMe.htm file for this release (View > Release Notes).

To add a driver property for this datasource connection


2. Select a property name from the Name dropdown or type the name of the property. The dropdown is automatically populated with the most commonly-used properties for a platform driver. However, all properties (name/value pairs) supported for that driver can be specified.

3. Type the property value in the Value field.

4. Optionally, provide a Description.

5. Click OK.

The dialog closes and the new property’s name and value are displayed in the Property Name/Property Value list.

Use the Edit button to initiate editing of a selected property name/value pair. Similarly, use the Delete button to remove a selected property name/value pair from the list.

Specifying Datasource Properties When Registering Datasources

The Datasource Registration Wizard’s Datasource Properties panel lets you specify properties used in conjunction with Rapid SQL features. The following table describes these settings and their DBMS availability:

| #Include Search Directories | Enter one or more paths on this datasource, which will be searched for files in conjunction with use of the #include directive in the ISQL editor, Procedure Object Editor, or Package Body Object Editor. Separate multiple paths using semicolons. For example:
c:\myscripts;c:\Program Files\Scripts
For more information on use of the #include directive, see SQL Preprocessing: #define and #include.
Note that if there are no entries specified here, the directory specified on the Directories tab of the Options editor will be searched. For more information, see Directories Options. |
| Database device default path (Sybase ASE) | The database device default path is used when creating a new database device. |
For more general information on registering datasources, see "Manually Registering or Editing Datasources" on page 131.

**SPECIFYING ORACLE VIEWS CONFIGURATION WHEN REGISTERING DATASOURCES**

The Datasource Registration Wizard's Oracle View Config panel lets you manually configure Rapid SQL access to Oracle Data Dictionary DBA or ALL/USER views to conform to the view privileges associated with a specific role.

**NOTE:** In order to enable manual configuration of Oracle Data Dictionary views for Oracle datasources and make this panel available, you must select Use Datasource Configuration for Views in the Options Editor (File > Options > General > Oracle). For more information, see General Options.

Only DBA views with an ALL/USER equivalent are offered on this panel. You can use the following methods to select DBA or ALL/USER type views on a view-by-view basis:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Manual selection using the Use DBA View check boxes</td>
<td>Selecting the Use DBA View check box associated with an individual view makes the DBA group version of that view available to Rapid SQL. Deselecting the Use DBA View check box associated with an individual view makes the ALL/USER group version of that view available to Rapid SQL.</td>
</tr>
<tr>
<td>Reset to All</td>
<td>Deselects all Use DBA View check boxes, making only ALL views accessible to Rapid SQL.</td>
</tr>
<tr>
<td>Reset to DBA</td>
<td>Selects all Use DBA View check boxes, making DBA views accessible to Rapid SQL.</td>
</tr>
<tr>
<td>Resolve Automatically (only available when editing a connected datasource)</td>
<td>Queries the datasource and selects the Use DBA View check box for each DBA view to which the current user has access.</td>
</tr>
</tbody>
</table>

Changes take effect as soon as you click the Finish button.

For more general information on registering datasources, see "Manually Registering or Editing Datasources" on page 131.

**SPECIFYING GROUP AND CATEGORY DETAILS WHEN REGISTERING DATASOURCES**

The Datasource Registration Wizard's Datasource Group panel lets you specify properties that help you organize your datasources. The following table describes these settings and their DBMS availability:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select the datasource group folder</td>
<td>Select the folder that is to contain this datasource.</td>
</tr>
</tbody>
</table>
AUTOMATICALLY DISCOVERING DATASOURCES

Rapid SQL lets you automate registration of datasources by importing datasource definitions from the following locations:

- DBMS configuration files/registry entries
- LDAP Servers
- TOAD product datasource definitions (specifically from TOAD for Oracle, TOAD for Microsoft SQL Server, TOAD for MySQL, TOAD for Sybase (both ASE and IQ))
- An Embarcadero Connect repository. For detailed information, see "Working With Datasources from a Connect Repository" on page 148

For example, if you have a multiple DBMS platform license, the Discover Datasources feature finds all unregistered datasources that Rapid SQL is licensed for. If you have an Oracle only license, Discover Datasources finds all unregistered Oracle datasources.

Use the information in "Setting up to Automatically Discover Datasources" on page 144 to ensure that you are ready to use the Discover Datasources feature.

There are two relevant scenarios for this feature. For details, see the following topics:

- Discovering Datasources on First Application Startup
- Manually Discovering Datasources

In addition to Auto-Discovering your database servers, Rapid SQL automatically places the datasource within a DBMS-specific database group folder in the Navigator. For more information, see "Categorizing Datasources using Color-coding and Labeling" on page 168.

For related information, see "Connecting to Datasources" on page 153.

SETTING UP TO AUTOMATICALLY DISCOVER DATASOURCES

Some search targets used by the Discover Datasources feature rely on customer-provided information. The Options Editor lets you provide the following:
• The names and locations of configuration files such as the Oracle TNSNAMES.ORA file and the Sybase ASE SQL.INI file. For details, see "Connection Options" on page 89.

• Identification and authentication details of an LDAP Server that can publish datasources. For details, see "LDAP Configuration Options" on page 119.

• Enabling and configuration of an Embarcadero Connect server connection. For details, see "Connect Options" on page 88. In addition, you must be logged in to the Embarcadero Connect Server. For details, see "Logging in to an Embarcadero Connect Server" on page 149.

In addition, there are environment details that can impact this feature. For details, see "Troubleshooting Client Setup" on page 155.

**Discovering Datasources on First Application Startup**

The first time you run Rapid SQL a dialog box displays, giving you the option to Auto-Discover all configured datasources. If you click Yes, the Rapid SQL Auto-Discover feature searches the DBMS configuration files on your computer and automatically discovers all the datasources that you are licensed for.

**NOTE:** Microsoft SQL Server datasources are registered through a Windows system call to your network. Provide login information (user name and password) the first time you connect to a datasource. For more information, see "Disconnecting from a Datasource" on page 155.

**NOTE:** IBM DB2 for Linux, Unix, and Windows databases use ODBC/CLI or DB2 (attach) to connect. Therefore, you need the proper ODBC/CLI Connection established in order for the auto-discover feature to find your IBM DB2 for Linux, Unix, and Windows databases, including registering the DB2 datasource to ODBC as a system datasource. Although your datasources are auto-discovered, provide login information (user name and password) the first time you connect to a datasource.

**Manually Discovering Datasources**

Rapid SQL discovers datasources residing on your system that are not currently registered datasources. Rapid SQL can retrieve a list of discovered datasources, which includes the name of the server or instance, the type of DBMS, and source (DBMS configuration files/registry entries, LDAP Servers, TOAD datasource definitions, Embarcadero Connect) of all unregistered datasources found on your network or local machine. Once discovered, you have the option to register datasources.

**Completing the Discover Datasources Dialog Box**

1. On the **Datasource** menu, click **Discover Datasources**.

   Rapid SQL opens the **Discover Datasources** dialog box and when the search is complete, displays all discovered datasources. The source (Local alias, Network, LDAP, or Toad) and status of each is displayed.
2. Select the check box next to any datasources you want to register.

3. Click **Register**.

   Rapid SQL registers the datasource or datasources selected.

**IMPORTING AND EXPORTING DATASOURCE DEFINITIONS**

On startup, Rapid SQL loads a datasource catalog, a collection of datasource definitions that the user can work against. How the catalog is stored and whether changes to the catalog are temporary or permanent, depends on the datasource storage method used. For an introduction, see "Specifying a Datasource Catalog Storage Option" on page 130.

**NOTE:** On individual computers, administrators can restrict the available DBMS platforms available to Rapid SQL using registry settings. For details, see “Locking Down Rapid SQL Features Using the Registry” on page 127.

Regardless of the storage method used, Rapid SQL lets you add datasources to the currently loaded catalog by importing datasource definitions from the following sources:

- Windows Registry - if you previously used the Windows Registry datasource catalog storage method but are now using one of the file-based methods
- File-based datasource catalog storage method files (**.dsd** file suffix)
- Network-shared datasource catalog storage method files (**.etsds** file suffix)

Similarly, you can export the currently loaded datasource catalog definitions to a file-based datasource catalog or network-shared datasource catalog storage method files.

The ability to export and import datasource definitions provides a number of practical advantages. For example:

- Simple sharing among users - if you have a large number of datasources to register, you can have one user walk through the process of registering each datasource and then export those definitions. Other users can then import the resulting datasource definition files.
- Sharing definitions among users employing different datasource storage methods - datasource definitions or entire catalogs created using the Windows Registry datasource catalog or File based datasource catalog methods can be exported for use by users employing any of the three methods.

**To export one or more datasource definitions**

1. On the **Datasource** menu, select **Manage Datasources**.

   Rapid SQL opens the **Manage Datasources** dialog box.
2 Select a single datasource, multiple datasources, or a default or custom datasource group folder.

**NOTE:** Datasource group folder information is not exported. Datasources are exported as individual files with no higher level grouping.

3 Click Export. An Export Data Sources Folder dialog opens.

4 Take one of the following actions:

- To export datasource definitions to individual files that can be imported on a datasource-by-datasource basis, select **Export Data Sources to Individual Data Source Files** and use the associated control to locate and select a target folder.

- To export datasource definitions to a single file for use by installations employing the Shared Datasource Managed catalog storage method, select **Export Data Sources To a Shared Data Source Management File** and use the associated control to locate and select a target folder and provide a file name. For information on how to designate a user as a shared datasource managed catalog storage method, see "Datasource Options" on page 96.

5 Click OK.

**NOTE:** User ID and password credentials are not exported to the datasource definition file.

After export, other users can then import the datasource definitions.

**To add one or more datasource definitions to a catalog**

1 On the Datasource menu, click Manage Datasources.

Rapid SQL opens the Manage Datasources dialog box.

2 Select the datasource group folder where the files or files are to be imported.

3 Click Import. An Import Data Sources dialog opens.

4 Take one of the following actions:

- If you previously used the Windows Registry catalog storage method but are currently using the Locally Managed or Shared Datasource Managed method, select **Import Previously Registered Embarcadero Data Sources From Registry** to load any datasources registered when you were using the Windows Registry catalog method.

- To import datasource definitions from individual datasource definition files (\.dsd file suffix), select **Import Previously Registered Embarcadero Data Sources From File(s)**, click Add, and use the **Select datasource definitions to import** dialog to locate and select the files to be added.

- To import datasource definitions from a single Shared Datasource Managed storage method file (\.etsds file suffix) file, select **Import Data Sources From a Shared Datasource Management File** and use the associated control to locate and select the target file.
5  Click OK.

After importing a datasource definition file, you can either edit the datasource registration to provide security parameters or provide credentials when connecting to the datasource.

WORKING WITH DATASOURCES FROM A CONNECT REPOSITORY

Rapid SQL integrates with Embarcadero Connect, a product that allows easy distribution of data governance repository metadata to the enterprise. Specifically, the Connect repository provides dedicated support for datasource definitions.

With Rapid SQL properly configured, and subsequent login to the Connect server, a dedicated Connect Navigator shows the available datasource definitions on the Connect server. A datasource definition on the Connect server can be registered as a local datasource.

NOTE:  For access to Connect documentation, see docs.embarcadero.com.

Registering a Connect server datasource as a local datasource creates a local copy of the datasource definition, accessible in the existing Navigator. Key connectivity information, the Connection Information tab settings (excluding Datasource Name) and a custom JDBC driver if supplied, is not editable in the resulting local datasource definition. Security Parameters tab information, such as User ID and Password) is not copied to the local datasource definition.

By default, when you register a Connect server datasource as a local datasource, the local definition is “attached” to the Connect version. The local definition’s key connectivity information is synchronized with the Connect server definition on each attempt to connect to the datasource.

An attached datasource has a distinctive icon:
You can subsequently detach a local datasource definition from a Connect server definition. Settings for the detached, local datasource definition are those that were active on the Connect server definition when the datasource was detached. When no longer attached to a Connect server datasource definition, a detached datasource is functionally no different than any locally registered (manually registered or automatically discovered) datasource.

The Connect Navigator lets you perform tasks such as attaching local datasources and managing datasource definitions residing on the Connect server.

Basic steps in getting started with Connect datasources are as follows:

1. **Enable and configure Connect server usage** - For details, see “Connect Options” on page 88 shows you how to enable and configure Connect.

2. **Log in to the Connect server from Rapid SQL** - For details, on how to establish a session with Connect, see “Logging in to an Embarcadero Connect Server” on page 149.

3. **Register Connect server datasources definitions as local datasources** - See “Using the Connect Navigator” on page 150 for information on how to use a simple Explorer interface to manage your local/Connect datasources.

4. **Connect to a Connect datasource that you have registered locally** - See “Connecting to Datasources” on page 153.

For related information, see “Viewing Embarcadero Connect Model Metadata in the SQL Editor” on page 812.

**LOGGING IN TO AN EMBARCADERO CONNECT SERVER**

Before you can work with datasource definitions on a Connect repository, you must login to the repository.

1. Ensure that Connect repository usage is enabled. For details, see “Connect Options” on page 88.

2. Select Tools > Connect > Login and then use the Embarcadero Connect - Log In dialog to provide credentials and complete the login.

   **NOTE:** Use the Keep me signed in check box to have logins persist across startups and shutdowns of Rapid SQL.

   **NOTE:** The Keep me signed control can be set and disabled using a registry entry. For details, see “Locking Down Rapid SQL Features Using the Registry” on page 127.

After logging in, you can manage the definitions on the repository and register local datasources from those definitions. For details, see Using the Connect Navigator.
USING THE CONNECT NAVIGATOR
The Connect Navigator displays datasources on an Embarcadero Connect server and lets you work with relationships to local datasources.

Before working with the Connect Navigator:

- Familiarize yourself with the Datasource Navigator. It offers comparable functionality. For details, see "Using the Datasource Navigator" on page 157.
- Understand the basics of Connect server datasource support. For details, see "Working With Datasources from a Connect Repository" on page 148.

To display the Connect Navigator
1. Ensure that Connect repository usage is enabled and that you are logged in to the Connect Server. For details, see "Connect Options" on page 88 and "Logging in to an Embarcadero Connect Server" on page 149.
2. Use View > Connect Navigator to toggle display of the Connect Datasources Explorer.

The first three levels in the expandable tree are:
- Datasource groups
- Datasource definitions in the ER/Studio Portal repository
- Local datasources that were registered using definitions in the ER/Studio Portal repository

With the Connect Datasources Explorer displayed, you can then:
• Create a local datasource from a definition on the repository - Expand a datasource group folder, right-click a repository datasource definition, and select Register Local Datasource. This opens a Register Datasource wizard, partially completed using information from the repository definition. For more information, see "Manually Registering or Editing Datasources" on page 131.

The icon for a datasource that is attached to a Connect repository shows a green arrow in the upper left.

• Detach a currently attached local datasource definition so that it is no longer synchronized with the Connect server definition - right-click the attached datasource and select Detach Connect Data Source and select Yes when prompted to verify.

• Create a new definition on the repository - Right-click a datasource group and select Create. This opens a Create Connect Datasource wizard. For more information, see "Manually Registering or Editing Datasources" on page 131.

• Edit a definition on the repository - Expand a datasource group folder, right-click a repository datasource definition, and select Edit. This opens an Edit Connect Datasource wizard. For more information, see "Manually Registering or Editing Datasources" on page 131.

• Delete a definition on the repository - Expand a datasource group folder, right-click a repository datasource definition, select Delete and confirm when prompted.

• View the datasource details in Embarcadero Connect - Expand a datasource group folder, right-click a repository datasource definition, and select View in Connect.

• Filter displayed nodes by name - Type one or more characters in the filter box at the top of the Explorer to show only nodes whose name contains the typed character string and their parent nodes.

• Display nodes by attached/unattached status - Use the Filter Options menu to display all datasource definitions, only definitions from which a local datasource has been registered, or only definitions from which no local datasource has been registered.

• Work with multiple local and Connect datasources. For details, see "Reconciling Local and Connect Datasources" on page 151.

Reconciling Local and Connect Datasources
While the Connect Navigator provides separate, individual operations for working with the relationships between local and Connect server datasource definitions, the Reconcile Connect Data Sources dialog lets you work simultaneously with multiple datasource definitions.
To reconcile multiple datasource definitions
1. Ensure that Connect repository usage is enabled and that you are logged in to the Connect Server. For details, see "Logging in to an Embarcadero Connect Server" on page 149 and "Logging in to an Embarcadero Connect Server" on page 149.
2. On the Connect Navigator dropdown, select Reconcile Data Sources. The Reconcile Connect Data Sources dialog opens.
3. Reconcile your Connect and local datasources using the three list boxes as follows:
   - **Matching data sources** - lists Embarcadero Connect server datasource definitions and local datasource definitions with identical connection information details but that are currently not attached. Selecting an entry from this list attaches the local datasource to the Connect datasource, ensuring that any changes to the Connect server definition will be copied to the local datasource definition on the next attempt to connect to the datasource.
   - **Unmatched Connect data sources** - lists Embarcadero Connect server datasource definitions for which there are no local datasource definitions with matching connection information. Selecting an entry from this list creates a matching local datasource definition and attaches the local definition to the matching Connect server datasource definition.
   - **Unmatched local data sources** - lists local datasource definitions for which there are no Embarcadero Connect server datasource definitions with matching connection information. Selecting an entry from this list creates a matching Connect server datasource definition and attaches the local definition to the Connect server datasource definition.
4. Click Reconcile.

**VIEWING DATASOURCE PROPERTIES**
Rapid SQL lets you view the name, type, version, status and mode of a connected datasource. The Datasource Properties dialog also lets you view the middleware or connectivity software that is being used to establish a particular datasource connection. You can use this information to troubleshoot connectivity problems, determining vital information such as the server version, connectivity library used, and library version and date.

**NOTE:** For information on establishing a datasource connection, see “Connecting to Datasources” on page 153.
To view key properties of a connected datasource

1. On the Datasource Navigator, select a datasource with an established connection. For more information, see "Using the Datasource Navigator" on page 157.


   Rapid SQL opens the Datasource Properties dialog box.

UNREGISTERING DATASOURCE

Rapid SQL lets you unregister datasources when you no longer need them.

NOTE: Removing a datasource from Rapid SQL does not delete the physical database. It simply removes the datasource definition, and connection information, from the Rapid SQL catalog.

1. In the Datasource Navigator, right-click the target datasource and select Unregister. For more information, see "Using the Datasource Navigator" on page 157.

2. When prompted to confirm, click Yes.

   NOTE: The datasource manager is shared across Embarcadero's database management products. When you remove a datasource in any of Embarcadero's database management tools the datasource is removed across all relevant products.

For related information, see "Registering Datasources" on page 129.

CONNECTING TO DATASOURCES

Rapid SQL provides two general categories of methods for connecting to a datasource.

**Automatic**

You can set datasources to automatically connect each time you open the application. You can do this when registering a datasource or as an option when explicitly connecting to a datasource. For details, see "Registering Datasources" on page 129 and "Manually Registering or Editing Datasources" on page 131.

**Explicit**

If you do not use the automatic connection option for a datasource, you must explicitly connect to a datasource before you can use Rapid SQL against that datasource.

The following topics provide instruction on explicit connection and disconnection options:

- [Disconnecting from a Datasource](#)
- [Connecting to Datasources from an Alphabetical Listing](#)
- [Disconnecting from a Datasource](#)

For related information, see "Registering Datasources" on page 129.
CONNECTING TO DATASOURCES FROM THE NAVIGATOR

The first time you start the application, Rapid SQL prompts you to register your datasources. During this process, you can select the Auto Connect check box, which automatically connects all registered datasource each subsequent time you open the application. For details, see "Moving Datasources Between Groups" on page 165.

If you did not check the Auto Connect box, or if you clicked No when prompted to connect to a database after registering, you must connect manually, each time you want to access that datasource.

If you later want to automatically connect your datasources, you can edit the datasource to make that change.

TIP: To configure your datasource to login automatically, refer to "Registering Datasources" on page 129.

To manually connect to a datasource
1 In the Datasource Navigator, right-click a datasource and select Connect from the context menu. For details on the Explorer or Navigator, see "Using the Datasource Navigator" on page 157.

   Rapid SQL opens a Login to... dialog box.

2 Type a Login ID and Password.

3 Optionally, and only if available, provide Login As, Default Schema ID, and Default Function Path values.

4 Select Auto Connect to automatically connect to the datasource in the future.

5 Click OK.

Rapid SQL connects to the datasource and expands the datasource display to show the top level of nodes available on that datasource. For more information, see "Working with Bookmarks" on page 160.

CONNECTING TO DATASOURCES FROM AN ALPHABETICAL LISTING

The Select Datasource dialog lets you sequentially connect to a set of datasources chosen from a list.

To connect to one or more datasources
1 On the Datasource menu, select Select. Rapid SQL opens the Select Datasource dialog.

2 For each datasource that you want to connect to, select a datasource from the Datasource list, and then click Connect to connect to the selected datasource.

3 If the last datasource you connect to supports multiple databases, you can optionally select a database from the Database list, and then click OK to have that database selected.
Rapid SQL expands the datasource display to show the top level of nodes available on the datasources you connected to. For more information, see "Working with Bookmarks" on page 160.

**DISCONNECTING FROM A DATASOURCE**

When you disconnect from a server, the application immediately breaks the connection between any open ISQL Windows, the servers, and databases. Although your ISQL Windows are still visible, the connections are no longer valid. If you attempt to execute a script, Rapid SQL attempts to reconnect to a registered datasource, if available.

To disconnect from a datasource

1. In the Datasource Navigator, right-click a datasource and select **Disconnect**. For information on the Explorer and Navigator, see "Using the Datasource Navigator" on page 157.

   **NOTE:** If necessary, Rapid SQL opens a dialog box asking if you want to commit all pending transactions for that connection or to rollback all before disconnecting. You cannot disconnect if there is an uncommitted transaction.

**TROUBLE-SHOOTING CLIENT SETUP**

If you are using native Embarcadero drivers to connect to a datasource, improperly configured client software can lead to the following symptoms:

- Failure to Auto-Discover accessible datasources.
- Inability to properly register a datasource
- Failure to manually connect to a registered datasource
- Error messages indicating missing client software files

   **NOTE:** For details on the various ways to register and connect to datasources, see "Datasource and Server Management" on page 129.

Regardless of the DBMS platform, your first step in trouble-shooting client connectivity is to ensure that your client is specified in the **PATH** environment variable.

For DBMS-specific help, see the following topics:

- [Trouble-shooting Sybase Connectivity](#)
- [Trouble-shooting Oracle Connectivity](#)
- [Trouble-shooting DB2 LUW and DB2 z/OS Connectivity](#)
- [Trouble-shooting SQL Server Connectivity](#)
TROUBLE-SHOOTING SYBASE CONNECTIVITY

A common cause of client connectivity issues against a Sybase DBMS is the client on the workstation not being compatible with Rapid SQL or the Sybase environment on your workstation not being configured properly.

Verify that your Sybase environment variables have been set properly on your workstation. If you make any changes, restart DBArtisan

Ensure you at least have the following variables (Environment Variables accessible through the Control Panel):

- SCROOT
- SYBASE
- SYBASE_OCS
- SYBROOT
- LIB - ensure that the Sybase LIB directory is listed here
- INCLUDE - ensure that the Sybase INCLUDE directory is listed here

Verify that the PATH value has only ONE SET of Sybase directories listed. You can modify this from the same Environment Variable window above in the PATH value:

%SystemRoot\%system32;%SystemRoot%;%SystemRoot%\system32\WBEM;C:\PROGRA~1\Serena\vm\win32\bin;C:\PROGRA~1\Serena\vm\common\bin\win32;C:\oracle\ora92\bin;C:\oracle\ora92\jre\1.4.2\bin\client;c:\sybase\OCS-15_0\lib3p;c:\sybase\OCS-15_0\dll;c:\sybase\OCS-15_0\bin;c:\sybase\DataAccess\ADONET\dll;c:\sybase\DataAccess\OLEDB\dll;c:\sybase\Data Access\ODBC\dll;c:\sybase\Shared\Sybase Central 4.3;c:\sybase\ua\bin;C:\Program Files\Internet Explorer;C:\WINDOWS\system32;C:\WINDOWS;C:\WINDOWS\System32\Wbem;C:\Program

In order to use the Auto-Discover feature, a valid SQL.ini file must be located in the following location:

C:\sybase\version_identifier_directory\ini

Where the version_identifier_directory is the name of the release-specific directory associated with this purpose, such as OCS-15_0 or OCS-12_5.

TROUBLE-SHOOTING ORACLE CONNECTIVITY

An Oracle client must be installed on the workstation. It must be defined/specifed in the following locations:

- The ORACLE_HOME in the Windows Registry
- The Environment PATH value

In addition, in order for the Auto-Discover feature to work, there must be a valid Oracle tnsnames.ora and sqlnet.ora file in the Oracle client installed. They must be installed in the %Oracle_home\Network\Admin directory. As well, the sqlnet.ora file must have the NAMES.DIRECTORY_PATH value of TNSNAMES.
A typical sqlnet.ora file:

```sql
# sqlnet.ora Network Configuration File:
C:\oracle\product\10.2.0\client_2\network\admin\sqlnet.ora
# Generated by Oracle configuration tools.

# This file is actually generated by netca. But if customers choose to
# install "Software Only", this file won't exist and without the native
# authentication, they will not be able to connect to the database on NT.
SQLNET.AUTHENTICATION_SERVICES= (NTS)
SQLNET.INBOUND_CONNECT_TIMEOUT = 30
SQLNET.SEND_TIMEOUT = 30
SQLNET.RECV_TIMEOUT = 30
TRACE_FILENO_SERVER=3
LOG_FILE_SERVER=svr.log
TRACE_FILE_CLIENT=clientsqlnet.trc
NAMES.DIRECTORY_PATH= (TNSNAMES)
```

**TROUBLE-SHOOTING DB2 LUW AND DB2 z/OS CONNECTIVITY**

The client must be defined in the workstation PATH value.

In order to Auto-Discover or manually register DB2 datasources, they must be configured in the DB2 Configuration Assistant. If Rapid SQL is not detecting DB2 datasources, have your DBA provide a Configuration Assistant profile.

**TROUBLE-SHOOTING SQL SERVER CONNECTIVITY**

In general, SQL Server datasources rarely go undetected by Rapid SQL. Each database server sends out a ping (via a service) to the network and Rapid SQL is usually able to find this. The SQL Server client must be defined in the workstation PATH value.

**USING THE DATASOURCE NAVIGATOR**

The Datasource Navigator provides a visual method for browsing, accessing, and manipulating objects. The Datasource Explorer contains a hierarchy consisting of groups, datasources, object type, and object nodes:

- Groups organize the datasources available to Rapid SQL. A default set of groups correspond to the DBMS platforms supported by Rapid SQL. You can also create custom groups to organize your datasources. For more information, see “Categorizing Datasources using Color-coding and Labeling” on page 168.
• Within groups are the datasources on your network that you have registered. You must register datasources with Rapid SQL in order to work against them. For more information, see "Registering Datasources" on page 129 and "Connecting to Datasources" on page 153.

• With the exceptions of the Filters node, nodes immediately below the datasource level correspond to the object types supported on the DBMS platform. At the lowest level, are the individual database objects on the datasource. For a listing of object types by DBMS platform and detailed support summaries for each type, see "Supported Objects" on page 179.

NOTE: For more information on the Filters node, see "Filtering in the Navigator" on page 170.

Higher level nodes in the hierarchy have an associated Expand/Collapse icon, letting you drill down through the hierarchy to expose lower level nodes and objects.

Bookmarks provide another means to quickly navigate to specific Explorer object nodes. For details, see "Working with Bookmarks" on page 160.

You can also initiate object type-specific actions and open object editors from the Explorer. For details, see "Initiating Object Actions in the Navigator" on page 161.

Rapid SQL offers a number of viewing and organization options that let you optimize the Explorer for your own purposes. These include:
• Basic viewing options that let you toggle between type-based or owner-based display, one-step expansion and collapse of hierarchy elements, hiding or display of system objects, saving of view option settings.

• Creating custom datasource groups to provide a deeper level of organization.

• Categorizing datasources using color-coding and labeling to quickly distinguish between datasources used for different purposes in your organization.

• Filtering the Explorer tree to display only selected nodes and objects. Rapid SQL offers the following filtering options. You can filter by name, schema or object type.

For detailed information on customizing the Explorer view, see “Customizing the Navigator Display” on page 163.

HIDING AND DISPLAYING THE DATASOURCE NAVIGATOR
Display of the Datasource Navigator can be toggled on and off.

To Toggle Display of the Navigator On and Off
• Select View > Datasource Navigator.

CONNECTED/SELECTED DATASOURCE OPTIONS
While you can connect to multiple datasources, at any one time only one connected datasource is the currently selected datasource. The currently selected datasource is displayed in the Datasource toolbar. For multiple-database datasources such as SQL Server and Sybase, a currently selected database is also displayed.

Certain features, to varying degrees, depend on the currently selected datasource or selected datasource/database combination. On a fairly trivial level, availability of some features or the initial state of a feature on being invoked is dependent on the selected datasource:

• Browse menu object type availability is dependent on DBMS platform of the currently selected datasource.

• Some features, Query Builder for example, have user interface controls for selecting a datasource. On opening, these user interface items default to the currently selected datasource.
More strongly dependent on the selected datasource is the SQL Editor. A SQL Editor window not locked to a datasource, will direct all transactions to the currently selected datasource.

**NOTE:** For information on how to lock and unlock a SQL Editor window, see "Locking a SQL Editor Window to a Datasource" on page 814

With a Datasource Navigator active, while an unlocked SQL Editor window is open, the selected datasource can be changed explicitly or automatically in response to Explorer navigation or related user interface actions.

This can result in the following issues:

- Active session-specific features such as execution directives and query options being sent to the wrong datasource
- Features such as Semantic Validation returning false errors

How the selected datasource changes depends on the state of the Link button appearing at the top of the Explorer pane:

<table>
<thead>
<tr>
<th>Link Button State</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="link1.png" alt="Link" /></td>
<td>The Explorer is linked to the Select Datasource combo. You can explicitly change the active datasource by selecting a datasource from the Select Datasource dropdown. The active datasource changes automatically as datasource-associated windows such as object editors become active in the Workspace or as you select nodes in the Explorer. As a side effect, the associated datasource node in the Explorer tree is selected.</td>
</tr>
<tr>
<td><img src="link2.png" alt="Link" /></td>
<td>The Explorer is NOT linked to the Select Datasource combo. When linking is inactive, you can only explicitly change the active datasource when an SQL Editor window is open. The active datasource still changes automatically as datasource-associated windows such as object editors become active in the Workspace. And when linking is inactive, the change in the selected datasource has no effect on the selected node in the Explorer tree.</td>
</tr>
</tbody>
</table>

**WORKING WITH BOOKMARKS**

Rapid SQL supports easy datasource navigation with the Bookmarks. You can right-click any node of the Explorer tree and add a bookmark. After a bookmark is created, you can simply select it from the Bookmarks menu, and be instantly positioned and connected to the resource in the Datasource Explorer tree.

Up to 256 bookmarks can be created.
To create a bookmark
1. On the Navigator, right-click the target node, and then select Add Bookmark. Rapid SQL opens the Add Friendly Bookmark Name dialog.
2. Type the Explorer bookmark name.
3. Click OK.
   
   **NOTE:** Rapid SQL will not let you create multiple bookmarks referencing the same node.

To navigate to a bookmarked node
1. Select the Options menu (designated with a down arrow, above the Navigator tree), select Bookmarks, select a DBMS platform, and then select the bookmarked node.

Editing Explorer Bookmarks
1. Select the Options menu (designated with a down arrow, above the Navigator tree), and then select Bookmarks > Bookmark Manager. Rapid SQL opens Bookmark Manager dialog.
   
   • Rename a bookmark by selecting it and then clicking Rename. Then use the Edit Bookmark Name dialog to provide a new name.
   
   • Delete a bookmark by selecting it and then clicking Delete.

**INITIATING OBJECT ACTIONS IN THE NAVIGATOR**
In the Datasource Navigator, right-click options let you initiate object actions against object types or against specific objects.
WORKING WITH SUPPLEMENTARY ORGANIZER TABS

In addition to the commonly used Explorer tab, the Organizer window offers the following tabs:

- **Project** - when working with Rapid SQL’s Project Management feature, this tab provides a visual method for browsing, accessing, and manipulating your projects. For more information on working with projects, see "Project Management" on page 789.
• **VC Files** - when working with Rapid SQL's Version Control feature, this tab provides access to version control files. For more information on working with projects, see "**Version Control**" on page 813.

• **Favorites** - lets you designate and access favorite scripts. This tab lets you view, navigate, save, recall, and execute scripts. Sample Favorite Scripts are installed for Microsoft SQL Server, Oracle, and Sybase Adaptive Server. For more information, see **Favorite Properties Dialog Box**.

**FAVORITE PROPERTIES DIALOG BOX**
The table below describes the options and functionality on the Favorite Properties dialog box:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>Lets you enter a description.</td>
</tr>
<tr>
<td>File Name</td>
<td>Lets you type or browse and locate a file.</td>
</tr>
<tr>
<td>Hot Key</td>
<td>Lets you enter a Hot Key. Hot Keys must begin with CTRL or be stand-alone function keys. Rapid SQL automatically places the CTRL command in front of any character.</td>
</tr>
<tr>
<td>File Type</td>
<td>Lets you select a file type.</td>
</tr>
</tbody>
</table>

**CUSTOMIZING THE NAVIGATOR DISPLAY**
Rapid SQL offers flexibility in the elements displayed and in how elements are displayed in the Datasource Explorer and Datasource Navigator.

• **Basic Viewing Options in the Navigator**
• **Categorizing Datasources using Color-coding and Labeling**
• **Categorizing Datasources using Color-coding and Labeling**
• **Filtering in the Navigator**

**BASIC VIEWING OPTIONS IN THE NAVIGATOR**
The dropdown menu, available above the Datasource Navigator tree, provides basic organization and display options.
To change basic organization and viewing options

1. From the Options dropdown menu, select an option. Use the following table as a guide to your selection.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Organize by Object Owner** or **Organize by Object Type** | Toggling these options has the following effect:  
**Owner** - the Navigator displays objects for each user, categorized by object type. This display mode is most efficient if you are working with databases containing a high number of objects.  
**Type** - the Navigator displays all objects, categorized by object type, for all users in the same list. This display mode speeds or slows performance in databases that contain many objects. |
| **Show System Objects** and **Show Only My Objects** | Lets you control display of system objects and objects that you own: NEVER, ALWAYS, or USE DATASOURCE FILTER. For information on filter options, see Simple, on-the-fly, Character-based Tree Filtering. |
| **Full Refresh**                            | Select to refresh.                                                                                                                             |
| **Expand All Groups**                       | Select to expand all groups.                                                                                                                  |
| **Collapse All Groups**                     | Select to collapse all groups.                                                                                                                 |
| **Collapse All Datasources**                | Select to collapse all datasources.                                                                                                            |
| **Retain View Settings**                    | Select to retain the current state of the Explorer so that it opens the same way the next time you start Rapid SQL.                           |
| **Bookmarks**                               | Provides access to bookmark resources. For more information, see "Working with Supplementary Organizer Tabs" on page 162.                      |

**TIP:** You can also set these options on the Explorer Options tab of the Options editor.

**WORKING WITH DATASOURCE GROUPS**

Rapid SQL lets you define datasource groups to organize the datasources in your enterprise. Datasource Groups behave as folders in the Windows Explorer, allowing you to group related datasources together. Anywhere that datasources are presented in a hierarchical tree format, datasource group folders expand to display one or more contained datasources.
By default, the Datasource Navigator has one group per supported DBMS platform.

Rapid SQL lets you create custom groups or subgroups. This level of organization is useful if you want to group large numbers of registered datasources or have another need to organize datasources. For basic database group maintenance tasks, see the following topics:

- "Removing, Adding, andRenaming Datasource Groups" on page 166.
- "Changing the Level of a Datasource Group in the Hierarchy" on page 167.

When you manually register a datasource, you have the option of changing the default group to which Rapid SQL will automatically assign the datasource. Subsequently, you can move a datasource from one folder to another. For details, see "Moving Datasources Between Groups" on page 165.

MOVING DATASOURCES BETWEEN GROUPS
Rapid SQL offers two ways change datasource groups:

- Dragging the datasource between groups
- Invoking the **Change Group** dialog box.

**NOTE:** You should always disconnect from a datasource before changing datasource groups.

**To move a datasource between groups by dragging and dropping**

1. If necessary, expand groups until both the datasource and the target datasource group are visible.
2. Drag the datasource over the target folder and drop it there.
To move a datasource using the Change Datasource Group dialog box

1. If necessary, expand groups until the datasource you want to move is visible.

2. Right-click the datasource you want to move, and select Change Group.

   Rapid SQL opens the Change Datasource Group dialog box.

3. Use the select... tree to locate and select the target group.

4. Click OK.

For more general information on datasource groups and associated tasks, see "Categorizing Datasources using Color-coding and Labeling" on page 168.

Removing, Adding, and Renaming Datasource Groups

Rapid SQL offers a set of datasource group maintenance tasks. You can remove database groups that you no longer need to access, or that have otherwise become obsolete. Keep the following in mind when removing datasource groups:

- If a datasource group contains datasources or other datasource groups, those items are deleted when you delete the containing group. You should move any contained datasources or groups before preceding. For details on moving datasources, see "Moving Datasources Between Groups" on page 165.

- The default datasource groups correspond to the DBMS platforms supported by Rapid SQL. If you delete a default group, it will be recreated if you subsequently register a datasource for the associated platform.

To remove a datasource group

1. If necessary, expand datasource groups in the Explorer until the datasource you want to remove is visible.

2. Right-click the datasource group, and select Remove. Rapid SQL prompts you to verify.

3. Click Yes.

Similarly, Rapid SQL lets you define datasource groups to organize the datasources in your enterprise.
To create a new datasource group
1 If creating a folder within an existing folder, expand datasource groups in the Explorer until the target group is visible.
2 On the Explorer tree take one of the following actions:
   • To create a new folder at the top level, right-click in empty space and select New from the context menu.
   • To create a folder within an existing folder, right-click the target folder and select New from the context menu.
   Rapid SQL opens the New Datasource Group dialog.
3 In the Datasource Group Name box, type the name of the new datasource group.
4 Click OK.

Lastly, Rapid SQL lets you change the name of an existing datasource group.

To rename a datasource group
1 If necessary, expand datasource groups in the Explorer until the datasource you want to rename is visible.
2 On the Explorer, right-click the datasource group folder, and select Rename. Rapid SQL opens the Rename Datasource Group dialog.
3 In the Datasource Group Name box, type the new name of the datasource group.
4 Click OK.

For related information, see the following topics:
   • See "Changing the Level of a Datasource Group in the Hierarchy" on page 167 for information on changing hierarchy levels.
   • See "Categorizing Datasources using Color-coding and Labeling" on page 168 for more general information on working with datasource groups.

CHANGING THE LEVEL OF A DATASOURCE GROUP IN THE HIERARCHY
Rapid SQL lets you reorganize the datasource group tree by moving individual groups up and down the hierarchy.

To move a datasource group to the top level of the hierarchy
1 If necessary, expand groups until the datasource group you want to move is visible.
2 Drag the target group to open space in the Explorer pane.
To make a datasource group a subgroup within another group

1. If necessary, expand groups until the datasource group you want to move and the target group are visible.

2. Drag the target group and drop it on the datasource group that is to be the new parent.

For related information, see the following topics:

- See "Removing, Adding, and Renaming Datasource Groups" on page 166 for information on basic datasource tree tasks.
- See "Categorizing Datasources using Color-coding and Labeling" on page 168 for more general information on working with datasource groups.

CATEGORIZING DATASOURCES USING COLOR-CODING AND LABELING

Rapid SQL provides a means to visually distinguish between datasources used for different purposes in your organization. You can assign a category, such as development or production, when creating or editing a datasource. This color-codes or labels particular user interface elements associated with that datasource.

When you assign a category to a datasource, the Navigator icons for the datasource show a distinctive color-coded category indicator. Optionally, you can customize your categorization scheme to include the following user interface elements:

- A short name label included in the Datasource toolbar combo/dropdown when a categorized datasource is selected
- Color-coded tabs on windows associated with actions against a categorized datasource, editor or ISQL windows for example
• Color-coding of the status bar at the bottom of the Rapid SQL window

The default categories [and short name labels] and the associated colors are as follows:

<table>
<thead>
<tr>
<th>Default Category</th>
<th>Short Name Label</th>
<th>Color</th>
</tr>
</thead>
<tbody>
<tr>
<td>Production</td>
<td>PROD</td>
<td></td>
</tr>
<tr>
<td>Development</td>
<td>DEV</td>
<td></td>
</tr>
<tr>
<td>QA</td>
<td>QA</td>
<td></td>
</tr>
<tr>
<td>Test</td>
<td>TEST</td>
<td></td>
</tr>
</tbody>
</table>

In addition to the defaults, you can create custom category/color code/label category combinations.

To work with color-coded datasource resources, you must be familiar with the following tasks:

• Enabling the specific user interface items that can be color-coded or labelled. For details, see "Datasource Options" on page 96.
Customizing your category scheme. For details, see Customizing Datasource Categories.

Assigning a category to a datasource when creating or editing it. For details, see "Manually Registering or Editing Datasources" on page 131.

Customizing Datasource Categories

Rapid SQL lets you customize your datasource category scheme. A datasource category has the following configurable components:

- Category name - The name displayed as a selection in the Select a category dropdown
- Short Name - The abbreviation shown in the Datasource toolbar dropdown when a categorized datasource is selected.
- Color - The color used to denote a categorized datasource in the Navigator tree icons and window tabs.

*Note:* Display of specific user items used to denote categories is configurable. For more information, see "Datasource Options" on page 96.

To customize your datasource categories

1. On the **Datasource** menu select **Register Datasource** and then select the **Datasource Group** panel.

2. From the **Select a category** dropdown select **Customize**. The **Manage Datasource Categories** dialogs opens.

3. Take one of the following actions:

   - Create a new category by clicking **New** and selecting or providing a **Full name**, **Short name**, and **Color** combination.
   - Edit an existing category by selecting the category, clicking **Edit** and modifying the name and color combination.
     
     *Note:* The short name for a category cannot be edited.

   - Delete an existing category by selecting the category, clicking **Delete** and verifying the deletion at the prompt.

Filtering in the Navigator

For ease of navigation, Rapid SQL lets you filter the Navigator tree to display only selected nodes and objects. Rapid SQL offers the following filtering options:

- Real-time modification of the tree to show only nodes with names matching a typed character string. For details, see Simple, on-the-fly, Character-based Tree Filtering.
• Permanent object filters, enabled and disabled for individual datasources, that restrict display based on object name and owning schema (and optionally, object type). For details, see Object Name/schema Filtering.

• The ability to restrict object types displayed for each DBMS platform. For details, see Node, or Object Type, Filtering.

Two default filters applying to owned and system objects are available. For details, see Using the Default Filters.

SIMPLE, ON-THE-FLY, CHARACTER-BASED TREE FILTERING

The Filter box at the top of the Navigator provides a quick, ad hoc way to restrict the nodes displayed.

To restrict the Explorer tree display to only user-defined nodes whose name contains a particular character string

• Type one or more characters in the Filter box.

The display is updated to show only nodes whose name contains the typed character string and their parent nodes.

NOTE: The Clear button in the Filter box (X) deletes the contents of the Filter box and restores the unfiltered tree display.

OBJECT NAME/SHEMA FILTERING

Object filters let you restrict the Navigator tree display for a datasource by name, owning schema, or name/schema combinations. These filters are defined at the DBMS platform level and are enabled or disabled on a datasource by datasource level. Multiple object filters can be created for a DBMS platform, letting you enable combinations of filters for a single datasource, ad hoc enabling and disabling of individual filters depending on your requirements, and so on.

Each filter consists of one or more ANDed conditions based on name or schema. For example, you could create a two-condition filter that restricts the Navigator tree for a datasource to display only objects belonging to the Schema QA and whose name starts with the string Test.
Each filter condition is a simple expression that tests object names for equality (*Equals*, *Not Equals*), inclusion in a specified list (*In*, *Not In*), or using pattern matching (*Like*, *Not Like*). Optionally, an object filter can also be used to restrict display of specified object types on a datasource.

**To create an object filter that can be enabled for all datasources for a DBMS platform**

1. Right-click in the Navigator tree and select **Filter** from the context menu.

   The *Filters* dialog opens. The *Object Filters* tab opens by default, letting you create an object filter definition. The *Node Filters* tab, on the other hand, lets you perform real-time filtering of object types for all datasources on a DBMS platform. For details, see *Node, or Object Type, Filtering*.

2. In the *View* area, select **By Filter**.

   **NOTE:** The current instructions create a filter at the DBMS level. To create a filter for a single datasource, select the *By Datasource* view, select a specific datasource, and then proceed to *step 4*.

3. Expand the icon corresponding to the DBMS for which you want to create a filter and ensure that the icon is selected.

4. Click **New** and type a name for the new filter.
5 On the Predicates tab, create one or more name-based or schema-based conditions, all of which must be satisfied when this filter is enabled. Objects that do not satisfy the conditions will be filtered from view. Use the following guidelines in constructing conditions:

- The Like and Not Like operators take pattern-matching Values. Rapid SQL supports the wildcard characters and conventions supported on the target DBMS.
- The In and Not In operators take a comma-delimited list such as CO,CA,CU, as a Value.
- Click the associated New button to add new predicates.

6 Optionally, on the Database Elements tab, select the check boxes for all object types to which this filter is to be applied. The filter does not affect the display of any deselected object types.

7 Click OK.

By default, when you create an object filter for a DBMS platform, it is enabled for each registered datasource of that DBMS type.

To disable or enable an object filter for a datasource

1 Right-click in the Navigator tree and select Filter from the context menu. The Filters dialog opens.

2 In the View area, select By Datasource.

3 Expand the icon corresponding to the target DBMS and then expand the icon corresponding to the specific datasource for which you want to for enable or disable a filter.

4 Enable an object filter by selecting the associated check box or disable the object filter by deselecting the check box.

5 Click OK.

NOTE: You can also enable and disable filters using controls found under the Filters node for each datasource in the Navigator tree.

You can also use the Filters dialog to select and edit an object filter, rename or create a clone of an existing object filter, and delete filters.

Node, or Object Type, Filtering

Node filtering lets you hide specified Navigator tree nodes for a DBMS platform. For example, if you do not typically work with credential-related objects such as users, groups, profiles or logins, you may wish to filter those out of the Navigator tree. You could either disable display of the individual object types or if practical, disable display of the Security node for the DBMS.
To change the hidden/displayed status of object types for a DBMS platform

1. Right-click in empty space in the Navigator tree and select Filter from the context menu. The Filters dialog opens.

   The NodeFilters tab opens by default, letting perform real-time filtering of object types for all datasources on a DBMS platform. The Object Filters tab, on the other hand, lets you create permanent, name-based or schema-based filters. For details, see "Object Name/schema Filtering" on page 171.

2. Click the Node Filters tab.

3. Expand the icon corresponding to the DBMS for which you want to create a node filter, and continue to expand nodes until all nodes for which you want to change the hidden/displayed status, are visible.

4. Ensure that all nodes corresponding to objects types that are to be displayed, are selected. Similarly, ensure that all nodes corresponding to objects types that are to be hidden, are deselected.

5. Click OK.

Hidden/displayed status is retained for the DBMS until you explicitly open the Filters dialog and change the current settings.

Using the Default Filters

The Filters node for each registered datasource includes two default Navigator tree filters, Ignore System Objects and Show Only My Objects. These filters can be enabled and disabled for each datasource but cannot be edited or deleted.

Using the Manage Datasources Utility

The Manage Datasources dialog box lets you manage datasources throughout your enterprise from a single vantage point. It provides concise, relevant information on your datasources in a simple grid format. It provides centralized access to common datasource operations such as adding, modifying, deleting, discovering, importing, and exporting datasources.

To open the Manage Datasources dialog box:

1. On the Datasource menu, click Manage Datasources.

   Rapid SQL opens the Manage Datasources dialog box.
The grid format lets you access and view datasource specifications. Datasources are grouped according to the default, DBMS-based folder structure and then within any custom datasource groups you have set up. The table below describes information available for each datasource entry:

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Datasource Name</td>
<td>Uses an explorer-like interface to display all registered datasources and their groups. You can navigate this column in the same manner as the datasource explorer, by clicking on nodes to expand or collapse your view of the datasources.</td>
</tr>
<tr>
<td>Connect String</td>
<td>Displays the full connection string for the datasource.</td>
</tr>
<tr>
<td>Default User Id</td>
<td>Displays the Default User ID for the datasource.</td>
</tr>
<tr>
<td>Auto-Connect?</td>
<td>Indicates whether the Auto Connect feature is turned on or off.</td>
</tr>
<tr>
<td>Host Computer</td>
<td>Displays the name of the Host Computer if one has been configured.</td>
</tr>
<tr>
<td>Default Schema</td>
<td>Displays view default schemas for your DB2 datasources.</td>
</tr>
</tbody>
</table>

In addition, you can take the following actions:

- Click the New Datasource button to register a datasource. For more information, see "Registering Datasources" on page 129.

- Select a datasource and click the Edit Datasource button to edit that datasource definition.

- Select a datasource and click the Remove Datasource button to unregister that datasource definition. For more information, see "Categorizing Datasources using Color-coding and Labeling" on page 168.
• Click the Discover button to locate all configured datasources on your network and automate the process of registering them. For more information, see "Moving Datasources Between Groups" on page 165.

• Import or export datasource definitions. For details, see "Importing and Exporting Datasync Definitions" on page 146.
DATABASE OBJECT MANAGEMENT

For each supported DBMS, Rapid SQL provides extensive object management facilities. Aimed at both Database Administrators and Developers, Rapid SQL provides support for the most commonly used object types. The following sets of topics describe the major areas of support:

- **Supported Objects**
  Describes the database objects and related elements supported by Rapid SQL. In addition to a listing of all supported objects by DBMS platform, a support summary is provided for each object type.

- **Creating objects**
  Tells you how to create new objects using graphical wizards.

- **Modifying objects using editors**
  Tells you how to edit existing objects.

- **Object actions**
  Provides details on the actions and operations that Rapid SQL lets you perform against database objects.
**SUPPORTED OBJECTS**

Rapid SQL lets you manage database objects across different database platforms. The table below indicates the objects that Rapid SQL supports by platform:

<table>
<thead>
<tr>
<th>Objects</th>
<th>DB2 LUW</th>
<th>DB2 z/OS</th>
<th>ITB/FBD</th>
<th>MySQL</th>
<th>ORCL</th>
<th>SQL SVR</th>
<th>SYB ASE</th>
<th>SYB IO</th>
</tr>
</thead>
<tbody>
<tr>
<td>Aliases</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Asymmetric Keys</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>Blob Filters</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✔</td>
</tr>
<tr>
<td>Certificates</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✔</td>
</tr>
<tr>
<td>Chains</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>Check Constraints</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✔</td>
</tr>
<tr>
<td>Clusters</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✔</td>
</tr>
<tr>
<td>Database Links</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✔</td>
</tr>
<tr>
<td>Database Triggers</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✔</td>
</tr>
<tr>
<td>Databases</td>
<td>✓</td>
<td></td>
<td>✓</td>
<td></td>
<td></td>
<td>✓</td>
<td></td>
<td>✔</td>
</tr>
<tr>
<td>DBSpaces</td>
<td></td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>DBSpaces</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✔</td>
</tr>
<tr>
<td>Defaults</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✔</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Directories</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✔</td>
<td></td>
</tr>
<tr>
<td>Domains</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✔</td>
</tr>
<tr>
<td>Encryption Keys</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✔</td>
</tr>
<tr>
<td>Domains</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✔</td>
</tr>
<tr>
<td>Exceptions</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✔</td>
</tr>
<tr>
<td>Extended Procedures</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✔</td>
</tr>
<tr>
<td>External Functions</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✔</td>
</tr>
<tr>
<td>Foreign Keys</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td></td>
<td>✓</td>
<td></td>
<td>✔</td>
</tr>
<tr>
<td>Full-text Catalogs</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✔</td>
</tr>
<tr>
<td>Full-text Indexes</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✔</td>
</tr>
<tr>
<td>Functions</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td></td>
<td>✓</td>
<td></td>
<td>✔</td>
</tr>
<tr>
<td>Generators</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✔</td>
</tr>
<tr>
<td>Groups</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✔</td>
</tr>
<tr>
<td>Indexes</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td></td>
<td>✓</td>
<td></td>
<td>✔</td>
</tr>
<tr>
<td>Instance</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✔</td>
</tr>
<tr>
<td>Java Classes</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✔</td>
</tr>
<tr>
<td>Java Resources</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✔</td>
</tr>
<tr>
<td>Java Sources</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✔</td>
</tr>
<tr>
<td>Job Queues</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✔</td>
<td></td>
</tr>
<tr>
<td>Objects</td>
<td>DB2 LUW</td>
<td>DB2 z/OS</td>
<td>ITB/FBD</td>
<td>MySQL</td>
<td>ORCL</td>
<td>SQL SVR</td>
<td>SYB ASE</td>
<td>SYB IQ</td>
</tr>
<tr>
<td>--------------------------</td>
<td>---------</td>
<td>----------</td>
<td>---------</td>
<td>-------</td>
<td>------</td>
<td>---------</td>
<td>---------</td>
<td>--------</td>
</tr>
<tr>
<td>Jobs (Oracle)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Join Indexes</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✓</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Libraries</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Logins</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✓</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Materialized Query Tables</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Materialized Views</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Materialized View Logs</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Outlines</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Package Bodies</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Packages</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Partition Functions</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Partition Schemes</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Plans</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Primary Keys</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td></td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Procedures</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td></td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Profiles</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Programs</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Recycle Bin</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Roles</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Rules</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Schedules</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Segments</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Sequences</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Shadows</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Structured Types</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Symmetric Keys</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Synonymys</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✓</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>System Indexes</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✓</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>System Tables</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✓</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>System Triggers</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Tables</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td></td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Tablespaces</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td></td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Triggers</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td></td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Type Bodies</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Types</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Aliases let you assume the permissions of another database user without creating a separate user identity. You can use an alias when a user requires only temporary access to a database. You can also use an alias to mask a user’s identity.

Platform availability

Creating and editing
See the following topics:

- "Aliases Wizard (DB2 LUW)" on page 252 and "Aliases Editor (IBM DB2 LUW)" on page 452
- "Aliases Wizard (DB2 Z/OS)" on page 279 and "Aliases Editor (IBM DB2 Z/OS)" on page 471
- "Aliases Wizard (Sybase ASE)" on page 420 and "Aliases Editor (Sybase ASE)" on page 556

Object actions/operations supported
The following table lists object actions available for this object type. For an introduction to object actions and details on usage of specific actions, see "Object actions" on page 573.
ASYMMETRIC KEYS
Asymmetric keys, in addition to symmetric keys and certificates, provide Rapid SQL support for Public Key Encryption. Asymmetric keys consist of a private key and corresponding public key and are used to secure symmetric keys.

Platform availability

<table>
<thead>
<tr>
<th>DB2 LUW</th>
<th>DB2 z/OS</th>
<th>ITB/FBD</th>
<th>MySQL</th>
<th>ORCL</th>
<th>SQL SVR</th>
<th>SYB ASE</th>
<th>SYB IQ</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✔</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Creating and editing
- "Asymmetric Keys Wizard (SQL Server)" on page 325 and "Asymmetric Keys Editor (SQL Server)" on page 501

Object actions/operations supported
The following object actions are available for this object type. For an introduction to object actions and details on usage of specific actions, see "Object actions" on page 573.

<table>
<thead>
<tr>
<th>Drop</th>
<th>Extract</th>
<th>Report</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Related information
- "Certificates" on page 183
- "Symmetric Keys" on page 229

BLOB FILTERS
Rapid SQL provides support for blob filters, user-written programs that convert data stored in Blob columns from one subtype to another.

Platform availability

<table>
<thead>
<tr>
<th>DB2 LUW</th>
<th>DB2 z/OS</th>
<th>ITB/FBD</th>
<th>MySQL</th>
<th>ORCL</th>
<th>SQL SVR</th>
<th>SYB ASE</th>
<th>SYB IQ</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>✔</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Creating and editing
See "Blob Filters Wizard (ITB/FBD)" on page 306 and "Blob Filters Editor (InterBase/Firebird)" on page 488.
Object actions/operations supported
The following object actions are available for this object type. For an introduction to object actions and details on usage of specific actions, see "Object actions" on page 573.

- Drop
- Extract
- Rename
- Report

CERTIFICATES
Certificates, in addition to symmetric and asymmetric keys, provide Rapid SQL support for Public Key Encryption. Certificates are digitally signed security objects containing a public key and optionally, a private key.

Platform availability

<table>
<thead>
<tr>
<th></th>
<th>DB2 LUW</th>
<th>DB2 z/OS</th>
<th>ITB/FBD</th>
<th>MySQL</th>
<th>ORCL</th>
<th>SQL SVR</th>
<th>SYB ASE</th>
<th>SYB IQ</th>
</tr>
</thead>
<tbody>
<tr>
<td>Drop</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Extract</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Rename</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Report</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Creating and editing
- "Certificate Wizard (SQL Server)" on page 327 and "Certificates Editor (SQL Server)" on page 501

Object actions/operations supported
The following object actions are available for this object type. For an introduction to object actions and details on usage of specific actions, see "Object actions" on page 573.

- Add Private Key
- Backup Certificate
- Drop
- Extract
- Report

Related information
- "Asymmetric Keys" on page 182
- "Symmetric Keys" on page 229

CHAINS
The following summarizes support for named series of tasks
CHECK CONSTRAINTS
Check constraints are data values that are acceptable in a column. They are logical expressions that verify column values meet defined acceptance criteria.

Platform availability

<table>
<thead>
<tr>
<th></th>
<th>DB2 LUW</th>
<th>DB2 z/OS</th>
<th>ITB/FBD</th>
<th>MySQL</th>
<th>ORCL</th>
<th>SQL SR</th>
<th>SYB ASE</th>
<th>SYB IQ</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
</tbody>
</table>

Creating and editing
See "Add or Modify Check Constraint" on page 580.

Object actions/operations supported
The following table lists object actions available for this object type. For an introduction to object actions and details on usage of specific actions, see "Object actions" on page 573.

<table>
<thead>
<tr>
<th></th>
<th>DB2 LUW</th>
<th>DB2 z/OS</th>
<th>ITB/FBD</th>
<th>ORCL</th>
<th>SQL SR</th>
<th>SYB ASE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change Status (check constraints)</td>
<td>✓</td>
<td></td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Drop</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
</tbody>
</table>
Clusters provide an optional method of storing table data. A cluster comprises of a group of tables that share the same data blocks, and which are grouped together because they share common columns and are often used together. The related columns of tables stored in a cluster are known as the cluster key.

There are two types of clusters:

- Index
- Hash

Index clusters store the cluster data together and index the cluster key, which should make them faster at retrieving a range of data rows.

Hash clusters apply hashing functions to the cluster key to determine the physical location of a data row, which should make them faster at retrieving specific data rows.

NOTE: To place a table on a cluster, include the ON CLUSTER syntax within the CREATE TABLE statement. Placing a table on a cluster precludes you from placing it on a tablespace or defining the associated storage parameters.

Platform availability

<table>
<thead>
<tr>
<th>Extract</th>
<th>Hide Text</th>
<th>Rename</th>
<th>Report</th>
<th>Transfer Ownership</th>
</tr>
</thead>
<tbody>
<tr>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
</tbody>
</table>

Creating and editing

- "Clusters Wizard (Oracle)" on page 368 and "Clusters Editor (Oracle)" on page 526.

Object actions/operations supported

The following object actions are available for this object type. For an introduction to object actions and details on usage of specific actions, see "Object actions" on page 573.
DATABASE LINKS

Database links are named schema objects that describe a path from one database to another. Database links are implicitly used when a reference is made to a global object name in a distributed database. To use a database link, either it is public or you own it.

**NOTE:** Oracle syntax does not let you alter an existing database link. To change its definition, drop and re-create it.

Platform availability

<table>
<thead>
<tr>
<th></th>
<th>DB2 LUW</th>
<th>DB2 z/OS</th>
<th>ITB/FBD</th>
<th>MySQL</th>
<th>ORCL</th>
<th>SQL SVR</th>
<th>SYB ASE</th>
<th>SYB IQ</th>
</tr>
</thead>
<tbody>
<tr>
<td>Creating</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Editing</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Creating and editing

- "Database Links Wizard (Oracle)" on page 371 and "Database Links Editor (Oracle)" on page 528

Object actions/operations supported

The following object actions are available for this object type. For an introduction to object actions and details on usage of specific actions, see "Object actions" on page 573.

Drop          Extract          Rename          Report

DATABASE TRIGGERS

A database trigger implements a database-scope DDL trigger. These triggers fire in response to events associated with DDL statements.

**NOTE:** Before working with database triggers, consult Microsoft SQL Server documentation for a general understanding of DDL triggers. For more information, see Accessing Third Party Documentation.

Platform availability

<table>
<thead>
<tr>
<th></th>
<th>DB2 LUW</th>
<th>DB2 z/OS</th>
<th>ITB/FBD</th>
<th>MySQL</th>
<th>ORCL</th>
<th>SQL SVR</th>
<th>SYB ASE</th>
<th>SYB IQ</th>
</tr>
</thead>
<tbody>
<tr>
<td>Creating</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Editing</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Creating and editing

- "Database Triggers Wizard (SQL Server)" on page 329 and "Database Triggers Editor (SQL Server)" on page 504
**Object actions/operations supported**

The following object actions are available for this object type. For an introduction to object actions and details on usage of specific actions, see "Object actions" on page 573.

<table>
<thead>
<tr>
<th>Action</th>
<th>DB2 LUW</th>
<th>DB2 z/OS</th>
<th>ITB/FBD</th>
<th>MySQL</th>
<th>ORCL</th>
<th>SQL SVR</th>
<th>SYB ASE</th>
<th>SYB IQ</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change Status</td>
<td>✔</td>
<td>✔</td>
<td></td>
<td>✔</td>
<td></td>
<td>✔</td>
<td>✔</td>
<td></td>
</tr>
<tr>
<td>Drop</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Extract</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Report</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**DATABASES**

Databases are a collection of tables, or a collection of index spaces and tablespaces. The goals of a database system are straightforward but challenging. In general, a database aims to manage large amounts of data in a multi-user environment. It should achieve high performance while letting many users access the same information concurrently without compromising data integrity. A database also must protect against unauthorized access and provide reliable solutions for failure recovery.

**Platform availability**

<table>
<thead>
<tr>
<th></th>
<th>DB2 LUW</th>
<th>DB2 z/OS</th>
<th>ITB/FBD</th>
<th>MySQL</th>
<th>ORCL</th>
<th>SQL SVR</th>
<th>SYB ASE</th>
<th>SYB IQ</th>
</tr>
</thead>
<tbody>
<tr>
<td>Attach Database</td>
<td>✔</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Checkpoint</td>
<td></td>
<td>✔</td>
<td>✔</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Copy Schema</td>
<td>✔</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>DBCC</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Detach Database</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✔</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>


<table>
<thead>
<tr>
<th>DBMS-specific information</th>
</tr>
</thead>
<tbody>
<tr>
<td>• IBM DB2 for Linux, Unix, and Windows Instances</td>
</tr>
<tr>
<td>• Microsoft SQL Server Databases</td>
</tr>
<tr>
<td>• IBM DB2 for OS/390 and z/OS Instances</td>
</tr>
<tr>
<td>• Sybase ASE Databases</td>
</tr>
</tbody>
</table>

IBM DB2 for Linux, Unix, and Windows Instances

Databases are a collection of tables, or a collection of index spaces and table spaces. The goals of a database system are straightforward but challenging. In general, a database aims to manage large amounts of data in a multi-user environment. It should achieve high performance while letting many users access the same information concurrently without compromising data integrity. A database also must protect against unauthorized access and provide reliable solutions for failure recovery.
MICROSOFT SQL SERVER DATABASES
Databases are a collection of tables, or a collection of index spaces and tablespaces. The goals of a database system are straightforward but challenging. In general, a database aims to manage large amounts of data in a multi-user environment. It should achieve high performance while letting many users access the same information concurrently without compromising data integrity. A database also must protect against unauthorized access and provide reliable solutions for failure recovery.

NOTE: Microsoft SQL Server recommends that you do not create any user objects, such as tables, views, stored procedures, or triggers, in the master database. The master database includes the system tables that store the system information used by SQL Server, such as configuration option settings.

IBM DB2 FOR OS/390 AND Z/OS INSTANCES
Databases are a collection of tables, or a collection of index spaces and tablespaces. The goals of a database system are straightforward but challenging. In general, a database aims to manage large amounts of data in a multi-user environment. It should achieve high performance while letting many users access the same information concurrently without compromising data integrity. A database also must protect against unauthorized access and provide reliable solutions for failure recovery.

SYBASE ASE DATABASES
Databases are a collection of tables, or a collection of index spaces and tablespaces. The goals of a database system are straightforward but challenging. In general, a database aims to manage large amounts of data in a multi-user environment. It should achieve high performance while letting many users access the same information concurrently without compromising data integrity. A database also must protect against unauthorized access and provide reliable solutions for failure recovery.

DBSPACES
Rapid SQL offers support for these tablespaces made up of one or more operating system files.

Platform availability

<table>
<thead>
<tr>
<th>DB2 LUW</th>
<th>DB2 z/OS</th>
<th>ITB/FBD</th>
<th>MySQL</th>
<th>ORCL</th>
<th>SQL SVR</th>
<th>SYB ASE</th>
<th>SYB IQ</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✓</td>
</tr>
</tbody>
</table>

Creating, and editing
Rapid SQL does not offer support for creating or editing objects of this type.
Object actions/operations supported
The following object actions are available for this object type. For an introduction to object actions and details on usage of specific actions, see "Object actions" on page 573.

<table>
<thead>
<tr>
<th>Drop</th>
<th>Extract</th>
</tr>
</thead>
</table>

DEFAULTS
Defaults promote data integrity by supplying a default value to a table column if the user does not explicitly provide one. They are reusable objects that you can bind to table columns or user datatypes.

Platform availability

<table>
<thead>
<tr>
<th>DB2 LUW</th>
<th>DB2 z/OS</th>
<th>ITB/FBD</th>
<th>MySQL</th>
<th>ORCL</th>
<th>SQL SVR</th>
<th>SYB ASE</th>
<th>SYB IQ</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✓</td>
<td>✓</td>
<td></td>
</tr>
</tbody>
</table>

Creating and editing
- "Defaults Wizard (SQL Server)" on page 330 and "Defaults Editor (SQL Server)" on page 504
- "Defaults Wizard (Sybase ASE)" on page 422 and "Defaults Editor (Sybase ASE)" on page 558

Object actions/operations supported
The following table lists object actions available for this object type. For an introduction to object actions and details on usage of specific actions, see "Object actions" on page 573.

<table>
<thead>
<tr>
<th>SQL SVR</th>
<th>SYB ASE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Drop</td>
<td>✓</td>
</tr>
<tr>
<td>Extract</td>
<td>✓</td>
</tr>
<tr>
<td>Hide Text</td>
<td>✓</td>
</tr>
<tr>
<td>Rename</td>
<td>✓</td>
</tr>
<tr>
<td>Report</td>
<td>✓</td>
</tr>
</tbody>
</table>
DIRECTORIES
Directories create an alias to an external operating system directory to your database files, which can be used for storing large binary object files. When you create a directory, provide the full path name to the outside operating system where the BFILE’s are stored. This object lets you store large files, such as video, outside of the database. The directory object lets you provide a simple alias to the full path name of an outside server’s file system, which you can then use to point to the files when creating procedural logic objects. This saves the developer from having to type the full path name when coding.

To create a Directory object, you need CREATE ANY DIRECTORY system privileges. You also create or have in place a corresponding operating system directory to store the file. This directory must have the correct read permissions for Oracle processes.

Platform availability

<table>
<thead>
<tr>
<th>DB2 LUW</th>
<th>DB2 z/OS</th>
<th>ITB/FBD</th>
<th>MySQL</th>
<th>ORCL</th>
<th>SQL SVR</th>
<th>SYB ASE</th>
<th>SYB IQ</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✔</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Creating and editing
- "Directories Wizard (Oracle)" on page 372 and "Directories Editor (Oracle)" on page 528

Object actions/operations supported

The following object actions are available for this object type. For an introduction to object actions and details on usage of specific actions, see "Object actions" on page 573.

- Drop
- Extract
- Report

DOMAINS
Rapid SQL provides support for domains, letting you work with these type definitions.

Platform availability

<table>
<thead>
<tr>
<th>DB2 LUW</th>
<th>DB2 z/OS</th>
<th>ITB/FBD</th>
<th>MySQL</th>
<th>ORCL</th>
<th>SQL SVR</th>
<th>SYB ASE</th>
<th>SYB IQ</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>✔</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Creating and editing

- "Domains Wizard (ITB/FBD)" on page 307 and "Domains Editor (InterBase/Firebird)" on page 489.

**NOTE:** Rapid SQL does not support creation or editing of this object type against a Sybase IQ datasource.
Object actions/operations supported
The following object actions are available for this object type. For an introduction to object actions and details on usage of specific actions, see "Object actions" on page 573.

The following object actions are available for this object type. For an introduction to object actions and details on usage of specific actions, see "Object actions" on page 573.

Drop  Extract  Rename  Report

Encryption Keys
Rapid SQL provides support for encryption keys, used in encrypting and decrypting tables and columns.

Platform availability

<table>
<thead>
<tr>
<th>DB2 LUW</th>
<th>DB2 z/OS</th>
<th>ITB/FBD</th>
<th>MySQL</th>
<th>ORCL</th>
<th>SQL SVR</th>
<th>SYB ASE</th>
<th>SYB IQ</th>
</tr>
</thead>
<tbody>
<tr>
<td>✔</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Creating and editing
See "Encryption Keys wizard (ITB/FBD)" on page 308 and "Encryption Keys editor (InterBase/Firebird)" on page 489.

Object actions/operations supported
The following object actions are available for this object type. For an introduction to object actions and details on usage of specific actions, see "Object actions" on page 573.

Drop  Extract  Rename  Report

Events
Rapid SQL provides support for events, letting you work with these state changes that can be monitored or used as trigger conditions.
Platform availability

<table>
<thead>
<tr>
<th>Platform</th>
<th>DB2 LUW</th>
<th>DB2 z/OS</th>
<th>ITB/FBD</th>
<th>MySQL</th>
<th>ORCL</th>
<th>SQL SVR</th>
<th>SYB ASE</th>
<th>SYB IQ</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td>✔</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Creating and editing
Rapid SQL does not support creation or editing of this object type against a Sybase IQ datasource.

Object actions/operations supported
The following object actions are available for this object type. For an introduction to object actions and details on usage of specific actions, see “Object actions” on page 573.

- Drop
- Extract
- Object Properties

EXCEPTIONS
Rapid SQL provides support for exceptions, letting you work with these named error messages.

Platform availability

<table>
<thead>
<tr>
<th>Platform</th>
<th>DB2 LUW</th>
<th>DB2 z/OS</th>
<th>ITB/FBD</th>
<th>MySQL</th>
<th>ORCL</th>
<th>SQL SVR</th>
<th>SYB ASE</th>
<th>SYB IQ</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td>✔</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Creating and editing
See "Exceptions Wizard (ITB/FBD)" on page 309 and "Exceptions Editor (InterBase/Firebird)" on page 490.

Object actions/operations supported
The following object actions are available for this object type. For an introduction to object actions and details on usage of specific actions, see “Object actions” on page 573.

- Drop
- Extract
- Rename
- Report
EXTENDED PROCEDURES

Extended Procedures are dynamic link libraries that can be used to load and execute application routines written in other programming languages, such as C or Visual Basic. Extended Procedures function and appear in the same manner as normal stored procedures in that you can pass parameters to them and obtain results.

NOTE: Extended Procedures can only be accessed on the Master database.

Platform availability

<table>
<thead>
<tr>
<th>DB2 LUW</th>
<th>DB2 z/OS</th>
<th>ITB/FBD</th>
<th>MySQL</th>
<th>ORCL</th>
<th>SQL SVR</th>
<th>SYB ASE</th>
<th>SYB IQ</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✔</td>
<td></td>
</tr>
</tbody>
</table>

Creating and editing

- "Extended Procedures Wizard (Sybase ASE)" on page 423 and "Extended Procedures Editor (Sybase ASE)" on page 558

Object actions/operations supported

- Drop
- Describe
- Execute
- Extract
- Hide Text
- Rename
- Report

EXTERNAL FUNCTIONS

Rapid SQL provides support for external functions, letting you work with declarations for existing functions.

Platform availability

<table>
<thead>
<tr>
<th>DB2 LUW</th>
<th>DB2 z/OS</th>
<th>ITB/FBD</th>
<th>MySQL</th>
<th>ORCL</th>
<th>SQL SVR</th>
<th>SYB ASE</th>
<th>SYB IQ</th>
</tr>
</thead>
<tbody>
<tr>
<td>✔</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Creating and editing

See "External Functions Wizard (ITB/FBD)" on page 310 and "External Functions editor (InterBase/Firebird)" on page 491.

Object actions/operations supported

The following object actions are available for this object type. For an introduction to object actions and details on usage of specific actions, see "Object actions" on page 573.

- Rename
FOREIGN KEYS

Foreign keys enforce referential integrity between tables by verifying the existence of foreign key values in the parent table before letting you insert or update foreign key values in the child table.

Platform availability

<table>
<thead>
<tr>
<th></th>
<th>DB2 LUW</th>
<th>DB2 z/OS</th>
<th>ITB/FBD</th>
<th>MySQL</th>
<th>ORCL</th>
<th>SQL SVR</th>
<th>SYB ASE</th>
<th>SYB IQ</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
</tbody>
</table>

Creating and editing

- "Foreign Keys Wizard (DB2 LUW)" on page 254 and "Foreign Keys Editor (IBM DB2 LUW)" on page 454
- "Foreign Keys Wizard (DB2 Z/OS)" on page 281 and "Foreign Keys Editor (IBM DB2 Z/OS)" on page 472
- "Foreign Keys Wizard (ITB/FBD)" on page 311 and "Foreign Keys editor (InterBase/Firebird)" on page 491
- "Foreign Keys wizard (MySQL)" on page 360 and "Foreign Keys editor (MySQL)" on page 522
- "Foreign Keys Wizard (Oracle)" on page 373 and "Foreign Keys Editor (Oracle)" on page 529
- "Foreign Keys Wizard (SQL Server)" on page 332 and "Foreign Keys Editor (SQL Server)" on page 505
- "Foreign Keys Wizard (Sybase ASE)" on page 424 and "Foreign Keys Editor (Sybase ASE)" on page 559

**NOTE:** Creation and editing of objects of this type is not supported against Sybase IQ datasources.

Object actions/operations supported

The following table lists object actions available for this object type. For an introduction to object actions and details on usage of specific actions, see "Object actions" on page 573.

<table>
<thead>
<tr>
<th>Change Status (check constraints)</th>
<th>DB2 LUW</th>
<th>DB2 z/OS</th>
<th>ITB/FBD</th>
<th>MySQL</th>
<th>ORCL</th>
<th>SQL SVR</th>
<th>SYB ASE</th>
<th>SYB IQ</th>
</tr>
</thead>
<tbody>
<tr>
<td>Drop</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Extract</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Rename</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Report</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
</tbody>
</table>

RAPID SQL XE4/8.5 USER GUIDE
DBMS platform-specific notes

| MySQL | MySQL recognizes two types of tables, MyISAM and InnoDB. MyISAM tables access data records using an index, where InnoDB tables allow transactions and foreign keys. Therefore, the discussion of foreign keys is limited to your InnoDB tables. |

FULL-TEXT CATALOGS

A full-text catalog is a set of operating system files that store full-text indexes. Full-text catalogs, along with full-text indexes and the object actions supported for these object types, provide full text search support in Rapid SQL.

NOTE: Before working with full-text catalogs, consult Microsoft SQL Server documentation for a general understanding of full-text searching. For more information, see "Accessing Third Party Documentation" on page 21.

Platform availability

Creating and editing

- "Full-text Catalogs Wizard (SQL Server)" on page 333 and "Full-text Catalogs Editor (SQL Server)" on page 506

Object actions/operations supported

The following object actions are available for this object type. For an introduction to object actions and details on usage of specific actions, see "Object actions" on page 573.

Drop  Extract  Rebuild (Full-text Catalogs)  Reorganize (SQL Server Full-text)  Report Catalogs

Related information

- "Full-text Indexes" on page 197
FULL-TEXT INDEXES

A full-text index stores information used by the Full-Text Engine to compile full-text queries that can quickly search a table for particular words or word combinations. A full-text index stores information about key words and their location within one or more columns of a table.

Full-text indexes, along with full-text catalogs and the object actions supported for these object types, provide full text search support in Rapid SQL.

NOTE: Before working with full-text indexes, consult Microsoft SQL Server documentation for a general understanding of full-text searching. For more information, see "Accessing Third Party Documentation" on page 21.

Platform availability

<table>
<thead>
<tr>
<th>Platform</th>
<th>DB2 LUW</th>
<th>DB2 z/OS</th>
<th>ITB/FBD</th>
<th>MySQL</th>
<th>ORCL</th>
<th>SQL SVR</th>
<th>SYB ASE</th>
<th>SYB IQ</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>❑</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Creating and editing

- "Full-text Indexes Wizard (SQL Server)" on page 334 and "Full-text Indexes Editor (SQL Server)" on page 506

Object actions/operations supported

The following object actions are available for this object type. For an introduction to object actions and details on usage of specific actions, see "Object actions" on page 573.

- Change Status (Full-text Indexes)
- Drop
- Extract
- Population status
- Report

Related information

- "Full-text Catalogs" on page 196

FUNCTIONS

Functions are subroutines that you define. Functions are useful for reusable application logic. You can use functions to determine the best methods for controlling access and manipulation of the underlying data contained in an object.

The table below describes the types of user-defined functions that Rapid SQL lets you create:

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Column or External Table Function</td>
<td>You can write in a host programming language, such as C. This function can act on a table and returns a table value rather than a scalar value.</td>
</tr>
</tbody>
</table>
Platform availability

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>External Scalar Function</td>
<td>You can write in a language other than SQL, such as C++ or Java and returns a scalar value to the program. This type of function is referenced by the CREATE FUNCTION statement and can be used to perform computations on data contained in the database but cannot directly reference the data.</td>
</tr>
<tr>
<td>OLEDB Function</td>
<td>Accesses OLE DB data in user-defined OLE DB external tables.</td>
</tr>
<tr>
<td>Sourced Function</td>
<td>Inherits the semantics of another function and can be an operator.</td>
</tr>
<tr>
<td>Template Function</td>
<td>Partial functions that do not contain any executable code. Mainly used in a federated database to map the template function to a data source function -Oracle, SQL Server, Sybase ASE, etc. A function mapping needs to be created in conjunction with the template function.</td>
</tr>
</tbody>
</table>

Creating and editing

- "Functions Wizard (DB2 LUW)" on page 256 and "Functions Editor (IBM DB2 LUW)" on page 454
- "Functions Wizard (DB2 Z/OS)" on page 282 and "Functions Editor (IBM DB2 Z/OS)" on page 473
- "Functions wizard (MySQL)" on page 361 and "Functions editor (MySQL)" on page 522
- "Functions Wizard (Oracle)" on page 374 and "Functions Editor (Oracle)" on page 529
- "Functions Wizard (SQL Server)" on page 335 and "Functions Editor (SQL Server)" on page 507
- "Functions Wizard (Sybase ASE)" on page 425 and "Functions Editor (Sybase ASE)" on page 560

**NOTE:** Creation and editing of objects of this type is not supported against Sybase IQ datasources.

Object actions/operations supported

The following table lists object actions available for this object type. For an introduction to object actions and details on usage of specific actions, see "Object actions" on page 573.
Important Notes
With respect to functions and stored procedures, it can be necessary to have statements executed before and after creation of the procedure or function. This can be useful for example, if you need to create or drop temporary tables used by the function or procedure. Rapid SQL supports the use of two tag pairs, ETStart and ETEnd, that let you embed statements in the first comment block of a stored procedure or function. The following shows the expected syntax:

```sql
create procedure dbo.procname(@a numeric) as
/
<ETStart>SQL Statement</ETStart>
<ETEnd>SQL Statement</ETEnd>
*/
begin
...
```

GENERATORS
Rapid SQL provides support for generators, letting you work with these objects used to generate sequential numbers in a column.

Platform availability

<table>
<thead>
<tr>
<th>DB2 LUW</th>
<th>DB2 z/OS</th>
<th>ITB/FBD</th>
<th>MySQL</th>
<th>ORCL</th>
<th>SQL SVR</th>
<th>SYB ASE</th>
<th>SYB IQ</th>
</tr>
</thead>
<tbody>
<tr>
<td>✓</td>
<td>✓</td>
<td></td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
</tbody>
</table>

Creating and editing
See "Generators Wizard (ITB/FBD)" on page 312 and "Generators editor (InterBase/Firebird)" on page 492.

Object actions/operations supported
The following object actions are available for this object type. For an introduction to object actions and details on usage of specific actions, see "Object actions" on page 573.

<table>
<thead>
<tr>
<th>Drop</th>
<th>Extract</th>
<th>Rename</th>
<th>Report</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
GROUPS

Groups are a defined collection of database users. The primary use of groups is to consolidate the management of permissions. By matching together similar users into groups, you can greatly reduce the number of commands required to set permissions.

Every user automatically belongs to the public group. To assign a user to another group, add the user to that group. Then the user belongs to that group and public.

NOTE: A user can only belong to one group at a time other than public.

Platform availability

<table>
<thead>
<tr>
<th>DB2 LUW</th>
<th>DB2 z/OS</th>
<th>ITB/FBD</th>
<th>MySQL</th>
<th>ORCL</th>
<th>SQL SVR</th>
<th>SYB ASE</th>
<th>SYB IQ</th>
</tr>
</thead>
</table>

Creating and editing

- "Groups Wizard (Sybase ASE)" on page 425 and "Groups Editor (Sybase ASE)" on page 560

NOTE: Creation and editing of objects of this type is not supported against Sybase IQ datasources.

Object actions/operations supported

The following object actions are available for this object type. For an introduction to object actions and details on usage of specific actions, see "Object actions" on page 573.

<table>
<thead>
<tr>
<th>SYB ASE</th>
<th>SYB IQ</th>
</tr>
</thead>
<tbody>
<tr>
<td>Drop</td>
<td>✓</td>
</tr>
<tr>
<td>Extract</td>
<td>✓</td>
</tr>
<tr>
<td>Report</td>
<td>✓</td>
</tr>
</tbody>
</table>

INDEXES

Indexes are optional structures associated with tables. You can create indexes specifically to speed SQL statement execution on a table. When properly used, Indexes are the primary means of reducing disk I/O. Indexes are logically and physically independent of the data in the associated table. Unique Indexes guarantee that no two rows of a table have duplicate values in the columns that define the index.
Platform availability

<table>
<thead>
<tr>
<th>DB2 LUW</th>
<th>DB2 z/OS</th>
<th>ITB/FBD</th>
<th>MySQL</th>
<th>ORCL</th>
<th>SQL SVR</th>
<th>SYB ASE</th>
<th>SYB IQ</th>
</tr>
</thead>
<tbody>
<tr>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
</tbody>
</table>

Creating and editing

- "Indexes Wizard (DB2 LUW)" on page 259 and "Indexes Editor (IBM DB2 LUW)" on page 455
- "Indexes Wizard (DB2 Z/OS)" on page 284 and "Indexes Editor (IBM DB2 Z/OS)" on page 474
- "Indexes Wizard (ITB/FBD)" on page 312 and "Indexes Editor (InterBase/Firebird)" on page 493
- "Indexes, Primary Keys, or Unique Keys wizard (MySQL)" on page 362 and "Indexes, Primary Keys, and Unique Keys editors (MySQL)" on page 523
- "Indexes Wizard (Oracle)" on page 375 and "Indexes Editor (Oracle)" on page 530
- "Indexes Wizard (SQL Server)" on page 336 and "Indexes Editor (SQL Server)" on page 507
- "Indexes Wizard (Sybase ASE)" on page 426 and "Indexes Editor (Sybase ASE)" on page 561

**NOTE:** Creation and editing of objects of this type is not supported against Sybase IQ datasources.

Object actions/operations supported

The following table lists object actions available for this object type. For an introduction to object actions and details on usage of specific actions, see "Object actions" on page 573.

<table>
<thead>
<tr>
<th>DB2 LUW</th>
<th>DB2 z/OS</th>
<th>ITB/FBD</th>
<th>MySQL</th>
<th>ORCL</th>
<th>SQL SVR</th>
<th>SYB ASE</th>
<th>SYB IQ</th>
</tr>
</thead>
<tbody>
<tr>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
</tbody>
</table>

- Allocate Extent
- Analyze
- Check Index
- Create Alias
- Deallocation Unused Space
- Disable Index
- Drop
- DBCC
- Estimate Size
- Extract
**DBMS-specific information**

- [IBM DB2 for Linux, Unix, and Windows Indexes](#)
- [IBM DB2 for OS/390 and z/OS Indexes](#)
- [Microsoft SQL Server Indexes](#)
- [Oracle Indexes](#)
- [Sybase ASE Indexes](#)

**IBM DB2 FOR LINUX, UNIX, AND WINDOWS INDEXES**

IBM DB2 for Linux, Unix, and Windows offers two types of indexes:

- Unique
- Non-Unique

Unique Indexes guarantee that no two rows of a table have duplicate values in the columns that define the index.

**MICROSOFT SQL SERVER INDEXES**

Microsoft SQL Server offers two types of indexes: clustered and non-clustered. Clustered indexes physically sort table data to match their logical order. Non-clustered indexes only order the table data logically. In a database, an index lets you speed queries by setting pointers that allow you to retrieve table data without scanning the entire table. An index can be unique or non-unique.

<table>
<thead>
<tr>
<th>Place</th>
<th>DB2 LUW</th>
<th>DB2 z/OS</th>
<th>ITB/FBD</th>
<th>MySQL</th>
<th>ORCL</th>
<th>SQL SVR</th>
<th>SYB ASE</th>
<th>SYB IQ</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rebuild Index</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Rename</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Reorganize / Reorg</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Report</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Set Statistics</td>
<td></td>
<td></td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Shrink</td>
<td></td>
<td></td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Transfer Ownership</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Update Statistics</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✓</td>
<td>✓</td>
<td></td>
</tr>
</tbody>
</table>

*Place is supported on IBM DB2 and IBM DB2 for OS/390 and z/OS. Rebuild Index is supported on IBM DB2, IBM DB2 for OS/390 and z/OS, and Microsoft SQL Server. Rename is supported on IBM DB2. Reorganize / Reorg is supported on IBM DB2. Report is supported on IBM DB2, IBM DB2 for OS/390 and z/OS, Microsoft SQL Server, and Oracle. Set Statistics is supported on IBM DB2. Shrink is supported on IBM DB2. Transfer Ownership is supported on IBM DB2. Update Statistics is supported on IBM DB2, IBM DB2 for OS/390 and z/OS, Microsoft SQL Server, and Oracle.*
Microsoft SQL Server creates indexes as B-Trees, which are a series of pointers mapping index pages to their underlying data pages. As tables and, therefore, indexes grow, the number of levels in the B-Tree increases. The B-Tree of a clustered index is shorter than that of a non-clustered index because the leaf level of a clustered index is the data page.

A sound indexing strategy is critical to overall system performance. One pitfall to avoid is placing many indexes on a table without regard for their cumulative cost. Remember that indexes improve read but slow write performance because Microsoft SQL Server must update more information in the system catalog. Consequently, extra indexes can actually slow overall performance if data modification occurs frequently on the table. To determine the efficacy of indexes, you should tune your queries using SHOWPLAN and IO STATISTICS and analyze the selectivity of indexes using DBCC SHOW_STATISTICS.

Rapid SQL separates system indexes from user-defined indexes in the Datasource Navigator to ensure that system indexes are not accidentally altered or dropped.

**ORACLE INDEXES**

Oracle offers two types of indexes. The table below describes these indexes:

<table>
<thead>
<tr>
<th>Index</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table</td>
<td>A table index is defined on an individual table.</td>
</tr>
<tr>
<td>Cluster</td>
<td>A cluster index is defined on a set of tables physically stored together in a cluster. In an Oracle database, both table and cluster indexes use a B-tree structure.</td>
</tr>
</tbody>
</table>

The indexing strategy, particularly with large, active tables, is critical to overall system performance. The optimal definition and number of indexes for a given table is determined by the mix of access paths to that table performing insert, update, delete and select operations. For example, adding or changing an index can speed up your selects but slow your inserts, updates and deletes. Careful tuning and testing helps you achieve the best overall performance.

**TIP:** Indexes generally improve read operations in a database, but you should not place too many indexes on some tables. Since Oracle must maintain each index along with its referenced table, placing too many indexes on a table that is the object of much insert, update, and delete activity, can actually degrade performance.

Even when an index exists on a table, the way a SQL statement is coded can actually disallow the use of the index. To prevent this from happening, follow these rules of thumb:

- Try not to use SQL statements that include the NOT IN, NOT LIKE, $\neq$, IS NULL operators because they typically suppress the use of indexes.
- When referencing concatenated indexes with queries, be sure the leading column in the index is used. If it isn’t, the index won’t be used at all.
- Avoid using functions in WHERE predicates.

If you must use functions, investigate the use of function-based indexes.
INDEX PARTITIONS
Index partitions are similar to table partitions. There are three types of partitioned indexes that Oracle supports:

1. Local prefixed
2. Local nonprefixed
3. Global prefixed

**NOTE:** An index cannot be partitioned if it is a cluster index or if the index is defined on a clustered table.

Local prefixed and nonprefixed indexes
A local partitioned index has keys that refer to rows in a single table partition. A local partitioned index is automatically partitioned to mirror the underlying table. The number of partitions or subpartitions and the partition bounds for the partitioned index correspond with the partitions on the table. Oracle maintains this correspondence. If the table partitions are altered, the index partitions are altered accordingly.

A local partitioned index is prefixed if it is partitioned on the same column as the underlying table. The local partitioned index is nonprefixed if it is partitioned on a different column.

Global prefixed indexes
A global partitioned index can refer to rows in more than one table partition or subpartition. Global partitioned indexes are more difficult to manage than local partitioned indexes because any change in the underlying table partition affects all partitions in a global index. As a result, there is increased partition maintenance.

**NOTE:** A global index can only be range partitioned but it can be defined on any kind of partitioned table.

IBM DB2 FOR OS/390 AND Z/OS INDEXES
IBM DB2 for OS/390 and z/OS offers two types of indexes:

- Unique
- Non-Unique

Unique Indexes guarantee that no two rows of a table have duplicate values in the columns that define the index.

Non-Unique indexes let table rows have duplicate values in the columns that define the indexes.
SYBASE ASE INDEXES
Sybase ASE offers two types of indexes: clustered and non-clustered. Clustered indexes physically sort table data to match their logical order. Non-clustered indexes only order the table data logically. In a database, an index lets you speed queries by setting pointers that let you retrieve table data without scanning the entire table. An index can be unique or non-unique.

Sybase ASE creates indexes as B-Trees, which are a series of pointers mapping index pages to their underlying data pages. As tables and, therefore, indexes grow, the number of levels in the B-Tree increases. The B-Tree of a clustered index is shorter than that of a non-clustered index because the leaf level of a clustered index is the data page.

A sound indexing strategy is critical to overall system performance. One pitfall to avoid is placing many indexes on a table without regard for their cumulative cost. Remember that indexes improve read but slow write performance because Sybase ASE must update more information in the system catalog. Consequently, extra indexes can actually slow overall performance if data modification occurs frequently on the table. To determine the efficacy of indexes, you should tune your queries using SHOWPLAN and IO STATISTICS and analyze the selectivity of indexes using DBCC SHOW_STATISTICS.

Rapid SQL separates system indexes from user-defined indexes in the Datasource Navigator to ensure that system indexes are not accidentally altered or dropped.

INSTANCE
NOTE: This object is support for IBM DB2 and Oracle.

Rapid SQL places Instance as the first level of information under the Datasource node in the Datasource Navigator. Instance includes:

- DB Manager Configuration
- Data sources

Available Functionality
Rapid SQL offers the following functionality for this object:
JAVA CLASSES
The Java Classes contain compiled Java code. Java Classes are made up of a group of data items, with associated functions that perform operations. The data items are called fields or variables; the functions are referred to as methods.

**TIP:** Oracle is shipped with a JVM (Java Virtual Machine). The JVM provided by Oracle sits atop the Oracle RDBMS and interacts directly with the RDBMS instead of the operating system.

Platform availability

<table>
<thead>
<tr>
<th>DB2 LUW</th>
<th>DB2 z/OS</th>
<th>ITB/FBD</th>
<th>MySQL</th>
<th>ORCL</th>
<th>SQL SVR</th>
<th>SYB ASE</th>
<th>SYB IQ</th>
</tr>
</thead>
</table>

Object actions/operations supported
The following object actions are available for this object type. For an introduction to object actions and details on usage of specific actions, see "Object actions" on page 573.

<table>
<thead>
<tr>
<th>Compile</th>
<th>Create Synonym</th>
<th>Drop Java</th>
<th>Load Java</th>
<th>Report</th>
</tr>
</thead>
</table>

JAVA RESOURCES

**NOTE:** This object is supported by Oracle only.

The Java Resources node offers support for browsing Java resources.

Platform availability

<table>
<thead>
<tr>
<th>DB2 LUW</th>
<th>DB2 z/OS</th>
<th>ITB/FBD</th>
<th>MySQL</th>
<th>ORCL</th>
<th>SQL SVR</th>
<th>SYB ASE</th>
<th>SYB IQ</th>
</tr>
</thead>
</table>

Available Functionality

- Drop

JAVA SOURCES
Java Sources contain the uncompiled Java source code.

**TIP:** Oracle is shipped with a JVM (Java Virtual Machine). The JVM provided by Oracle sits atop the Oracle RDBMS and interacts directly with the RDBMS instead of the operating system.
Platform availability

<table>
<thead>
<tr>
<th>DB2 LUW</th>
<th>DB2 z/OS</th>
<th>ITB/FBD</th>
<th>MySQL</th>
<th>ORCL</th>
<th>SQL SVR</th>
<th>SYB ASE</th>
<th>SYB IQ</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Object actions/operations supported

The following object actions are available for this object type. For an introduction to object actions and details on usage of specific actions, see “Object actions” on page 573.

<table>
<thead>
<tr>
<th>Compile</th>
<th>Drop</th>
<th>Extract</th>
<th>Load Java</th>
<th>Rename</th>
<th>Report</th>
</tr>
</thead>
</table>

JOBS (ORACLE)

The following summarizes support for this object type, making up a combination of a schedule a program, and arguments required by the program.

Platform availability

<table>
<thead>
<tr>
<th>DB2 LUW</th>
<th>DB2 z/OS</th>
<th>ITB/FBD</th>
<th>MySQL</th>
<th>ORCL</th>
<th>SQL SVR</th>
<th>SYB ASE</th>
<th>SYB IQ</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Creating and editing

- "Jobs wizard (Oracle)" on page 379 and "Jobs Editor (Oracle)" on page 532

Object actions/operations supported

The following object actions are available for this object type. For an introduction to object actions and details on usage of specific actions, see “Object actions” on page 573.

<table>
<thead>
<tr>
<th>Drop</th>
<th>Enable/Disable (Oracle Jobs)</th>
<th>Extract</th>
<th>Run Job (Oracle Jobs)</th>
<th>Stop Job</th>
</tr>
</thead>
</table>

Related Information

See details for the following object types

- "Chains" on page 183
- "Programs" on page 222
- "Schedules" on page 225
**JOB QUEUES**

Job Queues are built-in mechanisms that let you schedule a variety of SQL-based or command-line driven tasks.

**Platform availability**

<table>
<thead>
<tr>
<th>DB2 LUW</th>
<th>DB2 z/OS</th>
<th>ITB/FBD</th>
<th>MySQL</th>
<th>ORCL</th>
<th>SQL SVR</th>
<th>SYB ASE</th>
<th>SYB IQ</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Creating and editing**

- "Oracle Job Queue Wizard (Oracle)" on page 378 and "Job Queue Editor (Oracle)" on page 532

**Object actions/operations supported**

The following object actions are available for this object type. For an introduction to object actions and details on usage of specific actions, see "Object actions" on page 573.

- Disable Job
- Drop
- Enable Job (Job Queue)
- Extract
- Report
- Run Job (job queues)

**JOIN INDEXES**

Rapid SQL offers limited support for these two or more table outer join indexes.

**Platform availability**

<table>
<thead>
<tr>
<th>DB2 LUW</th>
<th>DB2 z/OS</th>
<th>ITB/FBD</th>
<th>MySQL</th>
<th>ORCL</th>
<th>SQL SVR</th>
<th>SYB ASE</th>
<th>SYB IQ</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✓</td>
</tr>
</tbody>
</table>

**Creating and editing**

Rapid SQL does not offer support for creation or editing of objects this type.

**Object actions/operations supported**

The following object actions are available for this object type. For an introduction to object actions and details on usage of specific actions, see "Object actions" on page 573.

- Drop
- Extract
LIBRARIES
Libraries are an object type that represent a call to an operating system shared library. After the call is made, libraries can be used by SQL or PL/SQL to link to external procedures or functions. Libraries are only to be used on operating systems that support shared libraries and dynamic linking. Libraries serve as pointers or aliases to physical operating system shared library files and do not have existence as a physical object on their own, rather they rely on the physical existence of the files in the external operating system library to which they refer. To access the function or procedures stored in the library, you need execute privileges at the operating system level where the shared library resides.

Platform availability

<table>
<thead>
<tr>
<th>DB2 LUW</th>
<th>DB2 z/OS</th>
<th>ITB/FBD</th>
<th>MySQL</th>
<th>ORCL</th>
<th>SQL SVR</th>
<th>SYB ASE</th>
<th>SYB IQ</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✔️</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Creating and editing
- "Libraries Wizard (Oracle)" on page 380 and "Libraries Editor (Oracle)" on page 533

Object actions/operations supported
The following object actions are available for this object type. For an introduction to object actions and details on usage of specific actions, see "Object actions" on page 573.

Drop ✔️ Extract Rename ✔️ Report ✔️

LOGINS
Logins let you access your account. Your login account controls access to the server and all of the databases within it. Only the System Administrator or System Security Officer can create logins. Once you can log into a server, you need additional privileges to access user databases. Specifically, each database owner adds the login as a user or alias to the database.

Platform availability

<table>
<thead>
<tr>
<th>DB2 LUW</th>
<th>DB2 z/OS</th>
<th>ITB/FBD</th>
<th>MySQL</th>
<th>ORCL</th>
<th>SQL SVR</th>
<th>SYB ASE</th>
<th>SYB IQ</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✔️</td>
<td>✔️</td>
<td></td>
</tr>
</tbody>
</table>

Creating and editing
- "Logins Wizard (SQL Server)" on page 338 and "Logins Editor (SQL Server)" on page 508
- "Logins Wizard (Sybase ASE)" on page 427 and "Logins Editor (Sybase ASE)" on page 562
Object actions/operations supported

The following table lists object actions available for this object type. For an introduction to object actions and details on usage of specific actions, see "Object actions" on page 573.

<table>
<thead>
<tr>
<th>SQL SVR</th>
<th>SYB ASE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add/Modify Login Trigger</td>
<td>✓</td>
</tr>
<tr>
<td>Bind To Temporary Database</td>
<td>✓</td>
</tr>
<tr>
<td>Change Password</td>
<td>✓</td>
</tr>
<tr>
<td>Create Like</td>
<td>✓</td>
</tr>
<tr>
<td>Drop</td>
<td>✓</td>
</tr>
<tr>
<td>Drop Login Trigger</td>
<td>✓</td>
</tr>
<tr>
<td>Extract</td>
<td>✓</td>
</tr>
<tr>
<td>Report</td>
<td>✓</td>
</tr>
<tr>
<td>Unbind From Temporary Database</td>
<td>✓</td>
</tr>
</tbody>
</table>

Explorer Details

Depending on the DBMS platform, the icon associated with a login differs according to the login’s locked or unlocked state, when viewed in the Explorer.

<table>
<thead>
<tr>
<th>DBMS Platform</th>
<th>Icon</th>
<th>Login Account State</th>
</tr>
</thead>
<tbody>
<tr>
<td>SQL SVR or SYB ASE</td>
<td>[Icon]</td>
<td>Locked</td>
</tr>
<tr>
<td></td>
<td>[Icon]</td>
<td>Unlocked</td>
</tr>
</tbody>
</table>

DBMS-specific notes

- Microsoft SQL Server Logins
- Sybase ASE Logins

MICROSOFT SQL SERVER LOGINS

Logins let you access your account. Your login account controls access to the server and all of the databases within it. Only the System Administrator or System Security Officer can create logins. Once you can log into a server, you need additional privileges to access user databases. Specifically, each database owner adds the login as a user or alias to the database.
SYBASE ASE LOGINS
Logins let you access your account. Your login account controls access to the server and all of the databases within it. Only the System Administrator or System Security Officer can create logins. Once you can log into a server, you need additional privileges to access user databases. Specifically, each database owner adds the login as a user or alias to the database.

MATERIALIZED QUERY TABLES
A materialized query table is a table whose definition is based on the result of a query. The materialized query table typically contains pre-computed results based on the data existing in the table or tables that its definition is based on. If the SQL compiler determines that a query will run more efficiently against a materialized query table than the base table or tables, the query quickly executes against the materialized query table.

Platform availability

<table>
<thead>
<tr>
<th>Platform</th>
<th>DB2 LUW</th>
<th>DB2 z/OS</th>
<th>ITB/FBD</th>
<th>MySQL</th>
<th>ORCL</th>
<th>SQL SRV</th>
<th>SYB ASE</th>
<th>SYB IQ</th>
</tr>
</thead>
<tbody>
<tr>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Creating and editing
- "Materialized Query Tables Wizard (DB2 LUW)" on page 260 and "Materialized Query Tables Editor (IBM DB2 LUW)" on page 457

Object actions/operations supported
The following object actions are available for this object type. For an introduction to object actions and details on usage of specific actions, see "Object actions" on page 573.

<table>
<thead>
<tr>
<th>Action</th>
<th>Action</th>
<th>Action</th>
<th>Action</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Build Query</td>
<td>Create Alias</td>
<td>Create Like</td>
<td>Create View</td>
<td>Describe</td>
</tr>
<tr>
<td>Drop</td>
<td>Drop Materialized Query Table</td>
<td>Extract</td>
<td>Lock</td>
<td>Refresh Table</td>
</tr>
<tr>
<td>Reorganize/Reorg</td>
<td>Report</td>
<td>Schema</td>
<td>Select * From</td>
<td>Set Integrity</td>
</tr>
<tr>
<td>Transfer Ownership</td>
<td>Update Statistics</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

MATERIALIZED VIEWS

**NOTE:** This object is supported by Oracle only.

Materialized views are used to dynamically copy data between distributed databases. There are two types of materialized views:
- Complex
• Simple

Complex materialized views copy part of a master table or data from more than one master table. Simple materialized views directly copy a single table. You cannot directly update the underlying data contained in materialized views.

Platform availability

<table>
<thead>
<tr>
<th>DB2 LUW</th>
<th>DB2 z/OS</th>
<th>ITB/FBD</th>
<th>MySQL</th>
<th>ORCL</th>
<th>SQL SVR</th>
<th>SYB ASE</th>
<th>SYB IQ</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>8.1</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Creating and editing

• "Materialized Views Wizard (Oracle)" on page 381 and "Materialized Views Editor (Oracle)" on page 533

Object actions/operations supported

The following object actions are available for this object type. For an introduction to object actions and details on usage of specific actions, see "Object actions" on page 573.

- Compile
- Create Synonym
- Drop
- Extract
- Rename
- Report
- Shrink

MATERIALIZED VIEW LOGS

Materialized View logs are tables that maintain a history of modifications to the master table, and they are used to refresh simple materialized views. When you create a materialized view log, Oracle automatically creates a log table to track data changes in the master table and a log trigger to maintain the data in the log table.

Platform availability

<table>
<thead>
<tr>
<th>DB2 LUW</th>
<th>DB2 z/OS</th>
<th>ITB/FBD</th>
<th>MySQL</th>
<th>ORCL</th>
<th>SQL SVR</th>
<th>SYB ASE</th>
<th>SYB IQ</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>8.1</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Creating and editing

• "Materialized View Logs Wizard (Oracle)" on page 386 and "Materialized View Logs Editor (Oracle)" on page 535
Object actions/operations supported
The following object actions are available for this object type. For an introduction to object actions and details on usage of specific actions, see "Object actions" on page 573.

OUTLINES
Outlines are a set of results for the execution plan generation of a particular SQL statement. When you create an outline, plan stability examines the optimization results using the same data used to generate the execution plan. That is, Oracle uses the input to the execution plan to generate an outline, and not the execution plan itself.

Platform availability

<table>
<thead>
<tr>
<th>DB2 LUW</th>
<th>DB2 z/OS</th>
<th>ITB/FBD</th>
<th>MySQL</th>
<th>ORCL</th>
<th>SQL SVR</th>
<th>SYB ASE</th>
<th>SYB IQ</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Creating and editing
- "Outlines Wizard (Oracle)" on page 388 and "Outlines Editor (Oracle)" on page 536

Object actions/operations supported
The following object actions are available for this object type. For an introduction to object actions and details on usage of specific actions, see "Object actions" on page 573.

PACKAGES

NOTE: This object is supported by IBM DB2 for Linux, Unix, and Windows, IBM DB2 for OS/390 and z/OS, and Oracle only.

Packages contain all the information needed to process SQL statements from a single source file. You can use packages to process and call batches of SQL. Depending on the platform, packages can include:

- Procedures
- Functions
- Types
• Variables
• Constants
• Exceptions
• Cursors
• Subprograms

Packages offer a number of important advantages over using standalone procedures and functions, including the ability to:

• Modify package objects without recompiling dependent database objects.
• Declare global variables and cursors that can be shared within the package.
• Grant privileges more efficiently.
• Load multiple package objects into memory at once.

Packages usually have two parts: a header or specification and a body, although sometimes the body is unnecessary. The package header declares the members of the package while the body details the logic underlying each of the package components.

**NOTE:** Rapid SQL splits out package headers and package bodies in the Datasource Navigator; however, you create both a package header and body from the packages node.

### Platform availability

<table>
<thead>
<tr>
<th>DB2 LUW</th>
<th>DB2 z/OS</th>
<th>ITB/FBD</th>
<th>MySQL</th>
<th>ORCL</th>
<th>SQL SVR</th>
<th>SYB ASE</th>
<th>SYB IQ</th>
</tr>
</thead>
<tbody>
<tr>
<td>✔️</td>
<td>✔️</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Creating and editing

- "Packages Editor (IBM DB2 LUW)" on page 458
- "Packages Editor (IBM DB2 Z/OS)" on page 476
- "Packages Wizard (Oracle)" on page 388 and "Packages Editor (Oracle)" on page 536

### Object actions/operations supported

The following table lists object actions available for this object type. For an introduction to object actions and details on usage of specific actions, see "Object actions" on page 573.

<table>
<thead>
<tr>
<th>DB2 LUW</th>
<th>DB2 z/OS</th>
<th>ORCL</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>✔️</td>
<td></td>
</tr>
<tr>
<td>Compile</td>
<td>✔️</td>
<td></td>
</tr>
<tr>
<td>Create Synonym</td>
<td>✔️</td>
<td></td>
</tr>
</tbody>
</table>
PACKAGE BODIES

Package Bodies implement the package specification in that the package body includes the definition of every cursor and subprogram declared in the package specification.

Platform availability

<table>
<thead>
<tr>
<th>DB2 LUN</th>
<th>DB2 z/OS</th>
<th>ORCL</th>
</tr>
</thead>
<tbody>
<tr>
<td>Drop</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Extract</td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>Flush Cache</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Free (Packages)</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Rebind Packages</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Report</td>
<td>✓</td>
<td>✓</td>
</tr>
</tbody>
</table>

Creating and editing

While Package Bodies are listed as a separate object in the Datasource Navigator, they are created on the Packages Editor in conjunction with Packages. For more information, see "Package Bodies Editor (Oracle)" on page 536.

Object actions/operations supported

The following object actions are available for this object type. For an introduction to object actions and details on usage of specific actions, see "Object actions" on page 573.

<table>
<thead>
<tr>
<th>Compile</th>
<th>Create Synonym</th>
<th>Drop</th>
<th>Extract</th>
<th>Report</th>
</tr>
</thead>
</table>

PARTITION FUNCTIONS

Partition functions are functions that maps the rows of a table or index into partitions based on the values of a specified column. Partition functions are referenced in partition scheme definitions in partitioning indexes or tables.
Platform availability

<table>
<thead>
<tr>
<th></th>
<th>DB2 LUW</th>
<th>DB2 z/OS</th>
<th>ITB/FBD</th>
<th>MySQL</th>
<th>ORCL</th>
<th>SQL SVR</th>
<th>SYB ASE</th>
<th>SYB IQ</th>
</tr>
</thead>
</table>

Creating and editing
See the following topics:

- "Partition Functions Wizard (SQL Server)" on page 340 and "Partition Functions Editor (SQL Server)" on page 509

Available Functionality
Rapid SQL offers the following functionality for this object type:

<table>
<thead>
<tr>
<th>Drop</th>
<th>Extract</th>
<th>Report</th>
</tr>
</thead>
</table>

For related information, see the following topics:

- "Partition Schemes" on page 216 and "Partition Schemes Wizard (SQL Server)" on page 341
- "Indexes Wizard (SQL Server)" on page 336
- "Tables Wizard (SQL Server)" on page 351

PARTITION SCHEMES
Partition schemes map the partitions of a partitioned table or index to filegroups. The number and domain of the partitions for a partitioned table or index are specified in a partition function definition. Partition scheme definitions are referenced when partitioning indexes or tables.

Platform availability

<table>
<thead>
<tr>
<th></th>
<th>DB2 LUW</th>
<th>DB2 z/OS</th>
<th>ITB/FBD</th>
<th>MySQL</th>
<th>ORCL</th>
<th>SQL SVR</th>
<th>SYB ASE</th>
<th>SYB IQ</th>
</tr>
</thead>
</table>

Creating and editing
See the following topics:

- "Partition Schemes Wizard (SQL Server)" on page 341 and "Partition Schemes Editor (SQL Server)" on page 510
Available Functionality
Rapid SQL offers the following functionality for this object type:

<table>
<thead>
<tr>
<th>Drop</th>
<th>Extract</th>
<th>Next Used Filegroup</th>
<th>Report</th>
</tr>
</thead>
</table>

For related information, see the following topics:

- "Partition Functions" on page 215 and "Partition Functions (SQL Server) - Properties" on page 341
- "Indexes Wizard (SQL Server)" on page 336
- "Tables Wizard (SQL Server)" on page 351

PLANS
A Plan is an executable application created in the bind process. It can include one or more packages or debris.

Platform availability

<table>
<thead>
<tr>
<th>DB2 LUW</th>
<th>DB2 z/OS</th>
<th>ITB/FBD</th>
<th>MySQL</th>
<th>ORCL</th>
<th>SQL SVR</th>
<th>SYB ASE</th>
<th>SYB IQ</th>
</tr>
</thead>
<tbody>
<tr>
<td>✔️</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Creating and editing

- "Plans Wizard (DB2 Z/OS)" on page 287 and "Plans Editor (IBM DB2 Z/OS)" on page 477

Object actions/operations supported
The following object actions are available for this object type. For an introduction to object actions and details on usage of specific actions, see "Object actions" on page 573.

<table>
<thead>
<tr>
<th>Drop</th>
<th>Free Plan</th>
<th>Rebind Plans</th>
<th>Report</th>
</tr>
</thead>
</table>

PRIMARY KEYS

NOTE: This object is supported by all platforms.

Primary Keys are a set of table columns that can uniquely identify every row of a table.
Platform availability

<table>
<thead>
<tr>
<th>DB2 LUW</th>
<th>DB2 z/OS</th>
<th>ITB/FBD</th>
<th>MySQL</th>
<th>ORCL</th>
<th>SQL SVR</th>
<th>SYB ASE</th>
<th>SYB IQ</th>
</tr>
</thead>
<tbody>
<tr>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
</tbody>
</table>

Creating and editing

- "Primary Keys Wizard (DB2 LUW)" on page 263 and "Primary Keys Editor (IBM DB2 LUW)" on page 458
- "Primary Keys Wizard (DB2 Z/OS)" on page 289 and "Primary Keys Editor (IBM DB2 Z/OS)" on page 478
- "Primary Keys Wizard (ITB/FBD)" on page 314 and "Primary Keys editor (InterBase/Firebird)" on page 493
- "Indexes, Primary Keys, or Unique Keys wizard (MySQL)" on page 362 and "Indexes, Primary Keys, and Unique Keys editors (MySQL)" on page 523
- "Primary Keys Wizard (Oracle)" on page 389 and "Primary Keys Editor (Oracle)" on page 537
- "Primary Keys Wizard (SQL Server)" on page 342 and "Primary Keys Editor (SQL Server)" on page 510
- "Primary Keys Wizard (Sybase ASE)" on page 429 and "Primary Keys Editor (Sybase ASE)" on page 562

**NOTE:** Creation and editing of objects of this type is not supported against Sybase IQ datasources.

Object actions/operations supported

The following table lists object actions available for this object type. For an introduction to object actions and details on usage of specific actions, see "Object actions" on page 573.

<table>
<thead>
<tr>
<th>DB2 LUW</th>
<th>DB2 z/OS</th>
<th>ITB/FBD</th>
<th>MySQL</th>
<th>ORCL</th>
<th>SQL SVR</th>
<th>SYB ASE</th>
<th>SYB IQ</th>
</tr>
</thead>
<tbody>
<tr>
<td>Allocate Extent</td>
<td>✓</td>
<td></td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Analyze</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Change Status (check constraints)</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Deallocate Unused Space</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Disable Index</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Drop</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Extract</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Rebuild Index</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
PROCEDURES

Procedures are a reusable block of PL/SQL, stored in the database, that applications can call. Procedures streamline code development, debugging, and maintenance by being reusable. Procedures enhance database security by letting you write procedures granting users execution privileges to tables rather than letting them access tables directly.

Platform availability

<table>
<thead>
<tr>
<th>DB2 LUW</th>
<th>DB2 z/OS</th>
<th>ITB/FBD</th>
<th>MySQL</th>
<th>ORCL</th>
<th>SQL SVR</th>
<th>SYB ASE</th>
<th>SYB IQ</th>
</tr>
</thead>
<tbody>
<tr>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
</tbody>
</table>

Creating and editing

- "Procedures Wizard (DB2 LUW)" on page 264 and "Procedures Editor (IBM DB2 LUW)" on page 459
- "Procedures Wizard (DB2 Z/OS)" on page 291 and "Procedures Editor (IBM DB2 Z/OS)" on page 479
- "Procedures Wizard (ITB/FBD)" on page 315 and "Procedures editor (InterBase/Firebird)" on page 494
- "Procedures Wizard (Oracle)" on page 391 and "Procedures Editor (Oracle)" on page 539
- "Procedures Wizard (SQL Server)" on page 343 and "Procedures Editor (SQL Server)" on page 512
- "Procedures Wizard (Sybase ASE)" on page 430 and "Procedures Editor (Sybase ASE)" on page 563

**NOTE:** Creation and editing of objects of this type is not supported against Sybase IQ datasources.

Object actions/operations supported

The following table lists object actions available for this object type. For an introduction to object actions and details on usage of specific actions, see "Object actions" on page 573.

<table>
<thead>
<tr>
<th>DB2 LUW</th>
<th>DB2 z/OS</th>
<th>ITB/FBD</th>
<th>ORCL</th>
<th>SQL SVR</th>
<th>SYB ASE</th>
<th>SYB IQ</th>
</tr>
</thead>
<tbody>
<tr>
<td>✓</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
For more specific information, see the following topics:

- DB2 z/OS Procedures
- Sybase ASE Procedures
- Executing Statements Before and After Procedure or Function Creation

### DB2 z/OS Procedures

Only IBM DB2 for OS/390 and z/OS SQL stored procedures created by Rapid SQL, or IBM’s Stored Procedure Builder can be retrieved by Rapid SQL.

### Sybase ASE Procedures

Procedures perform procedural logic in your Sybase ASE applications. They are batches of SQL statements that are compiled and stored in the system catalog. Procedures execute faster than embedded SQL statements because they are pre-compiled and have execution plans for use by the optimizer. When you create a procedure, Sybase ASE builds a query tree, which it stores in a system table. When you execute a procedure for the first time, Sybase ASE loads it from the system table, compiles, and optimizes it. Sybase ASE places the resulting query plan in the procedure cache where it remains on a most recently used basis. In addition to better performance, procedures yield other benefits, including easier code maintenance, additional security and reduced network traffic.

**NOTE:** Rapid SQL also supports extended procedures. For details, see Extended Procedures.
EXECUTING STATEMENTS BEFORE AND AFTER PROCEDURE OR FUNCTION CREATION

With respect to functions and stored procedures, it can be necessary to have statements executed before and after creation of the procedure or function. This can be useful for example, if you need to create or drop temporary tables used by the function or procedure. Rapid SQL supports the use of two tag pairs, ETStart and ETEnd, that let you embed statements in the first comment block of a stored procedure or function. The following shows the expected syntax:

```sql
create procedure dbo.procname(@a numeric) as
/*
<ETStart>SQL Statement</ETStart>
<ETEnd>SQL Statement</ETEnd>
*/
begin
...
```

PROFILES

Profiles are a mechanism for allocating system and database resources to users. Profiles let you specify limits on:

- Number of sessions
- CPU time
- Connect time
- Idle time
- Logical reads and space in the SGA's shared pool

You can assign profiles to one or more users. The database's default profile and all of its resource limits are assigned to users without a specific profile assignment.

Platform availability

<table>
<thead>
<tr>
<th>DB2 LUW</th>
<th>DB2 z/OS</th>
<th>ITB/FBD</th>
<th>MySQL</th>
<th>ORCL</th>
<th>SQL SVR</th>
<th>SYB ASE</th>
<th>SYB IQ</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Creating and editing

- "Profiles Wizard (Oracle)" on page 392 and "Profiles Editor (Oracle)" on page 539

Object actions/operations supported

The following object actions are available for this object type. For an introduction to object actions and details on usage of specific actions, see "Object actions" on page 573.
PROGRAMS
The following summarizes support for this object type, making up a collection of metadata about a particular task.

Platform availability

<table>
<thead>
<tr>
<th>Platform</th>
<th>DB2 LUW</th>
<th>DB2 z/OS</th>
<th>ITB/FBD</th>
<th>MySQL</th>
<th>ORCL</th>
<th>SQL SVR</th>
<th>SYB ASE</th>
<th>SYB IQ</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Creating and editing
- "Programs wizard (Oracle)" on page 394 and "Programs Editor (Oracle)" on page 540

Object actions/operations supported
The following object actions are available for this object type. For an introduction to object actions and details on usage of specific actions, see "Object actions" on page 573.

<table>
<thead>
<tr>
<th>Action</th>
<th>DB2 LUW</th>
<th>DB2 z/OS</th>
<th>ITB/FBD</th>
<th>MySQL</th>
<th>ORCL</th>
<th>SQL SVR</th>
<th>SYB ASE</th>
<th>SYB IQ</th>
</tr>
</thead>
<tbody>
<tr>
<td>Drop</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Enable/Disable (Oracle Jobs)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Extract</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Related Information
See details for the following object types
- "Chains" on page 183
- "Jobs (Oracle)" on page 207
- "Schedules" on page 225

RECYCLE BIN
Rapid SQL provides basic support for Oracle’s Recycle Bin feature. When enabled, dropped tables, indexes, and associated objects are stored in the Recycle Bin until explicitly purged.

Platform availability

<table>
<thead>
<tr>
<th>Platform</th>
<th>DB2 LUW</th>
<th>DB2 z/OS</th>
<th>ITB/FBD</th>
<th>MySQL</th>
<th>ORCL</th>
<th>SQL SVR</th>
<th>SYB ASE</th>
<th>SYB IQ</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Creating and editing
The Recycle Bin cannot be created or edited.
Object actions/operations supported
On the Database Navigator, expanding the Recycle Bin node has the same effect as issuing a SHOW RECYCLEBIN statement. The contents of the Recycle Bin are displayed.

Related actions include:

<table>
<thead>
<tr>
<th>Function</th>
<th>ITB/FBD</th>
<th>ORCL</th>
<th>SQL SVR</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable Recycle Bin</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Flashback Recycle Bin Entry</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Purge Recycle Bin</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Purge Recycle Bin Entry</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**NOTE:** Select * From functionality is supported as a right-click option for individual tables in the Recycle Bin. For details on this feature, see “Select * From” on page 683.

**ROLES**
Roles are sets of user privileges you associate with access to objects within a database. Roles streamline the process of granting permissions. You can use roles to grant sets of permissions and privileges to users and groups.

**Platform availability**

<table>
<thead>
<tr>
<th>Platform</th>
<th>DB2 LUW</th>
<th>DB2 z/OS</th>
<th>ITB/FBD</th>
<th>MySQL</th>
<th>ORCL</th>
<th>SQL SVR</th>
<th>SYB ASE</th>
<th>SYB IQ</th>
</tr>
</thead>
<tbody>
<tr>
<td>DB2 LUW</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>DB2 z/OS</td>
<td></td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ITB/FBD</td>
<td></td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>MySQL</td>
<td></td>
<td></td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ORCL</td>
<td></td>
<td></td>
<td></td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SQL SVR</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SYB ASE</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>SYB IQ</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✓</td>
<td>✓</td>
</tr>
</tbody>
</table>

**Creating and editing**
- "Roles Wizard (ITB/FBD)" on page 316 and "Roles editor (InterBase/Firebird)" on page 495
- "Roles Wizard (SQL Server)" on page 345 and "Roles Editor (SQL Server)" on page 512
- "Roles Wizard (Oracle)" on page 395 and "Roles Editor (Oracle)" on page 541

**Object actions/operations supported**
The following table lists object actions available for this object type. For an introduction to object actions and details on usage of specific actions, see “Object actions” on page 573.

<table>
<thead>
<tr>
<th>Action</th>
<th>ITB/FBD</th>
<th>ORCL</th>
<th>SQL SVR</th>
</tr>
</thead>
<tbody>
<tr>
<td>Drop</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Extract</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Report</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Role Activation</td>
<td></td>
<td>✓</td>
<td>✓</td>
</tr>
</tbody>
</table>

**For related information**
- Microsoft SQL Server Roles
- Oracle Roles
MICROSOFT SQL SERVER ROLES
Roles let you manage permissions for users to perform a set of activities based on job functions. Roles are a mechanism for streamlining the assignment of object and system privileges to multiple users. Instead of granting sets of privileges to individual users, you can create a role, grant system and object privileges to that role, and then grant that role to all the users who should share the same privileges. You can grant one or more roles to the same user. Therefore, if you need to change the permissions for a certain role you can do so, and not have to grant or revoke the permissions for each individual user.

ORACLE ROLES
Roles are a mechanism for streamlining the assignment of object and system privileges to multiple users. Instead of granting sets of privileges to individual users, you can create a role, grant system and object privileges to that role, then simply grant that role to all the users who should share the same privileges. You can grant one or more roles to the same user.

DBMS-specific functionality
- For information on activating and deactivating roles for the current login in the current session, see "Role Activation" on page 681.

RULES
Rules promote data integrity by allowing you to validate the values supplied to a table column. They are reusable objects that you can bind to table columns or user datatypes. For example, you can create a rule, bind it to a column in a table and have it specify acceptable values that can be inserted into that column.

Platform availability

<table>
<thead>
<tr>
<th>DB2 LUW</th>
<th>DB2 z/OS</th>
<th>ITB/FBD</th>
<th>MySQL</th>
<th>ORCL</th>
<th>SQL SVR</th>
<th>SYB ASE</th>
<th>SYB IQ</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✓</td>
<td>✓</td>
<td></td>
</tr>
</tbody>
</table>

Creating and editing
- "Rules Wizard (SQL Server)" on page 345 and "Rules Editor (SQL Server)" on page 513
- "Rules Wizard (Sybase ASE)" on page 431 and "Rules Editor (Sybase ASE)" on page 564
Object actions/operations supported
The following table lists object actions available for this object type. For an introduction to object actions and details on usage of specific actions, see "Object actions" on page 573.

<table>
<thead>
<tr>
<th></th>
<th>SQL SVR</th>
<th>SYB ASE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Drop</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Extract</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Hide Text</td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>Rename</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Report</td>
<td>✓</td>
<td>✓</td>
</tr>
</tbody>
</table>

SCHEDULES
The following summarizes support for the object type that implements a schedule defining when a job should be run or when a window should open.

Platform availability

<table>
<thead>
<tr>
<th>DB2 LUW</th>
<th>DB2 z/OS</th>
<th>ITB/FBD</th>
<th>MySQL</th>
<th>ORCL</th>
<th>SQL SVR</th>
<th>SYB ASE</th>
<th>SYB IQ</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✓</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Creating and editing
- "Schedules Wizard (Oracle)" on page 397 and "Schedules Editor (Oracle)" on page 543

Object actions/operations supported
The following object actions are available for this object type. For an introduction to object actions and details on usage of specific actions, see "Object actions" on page 573.

- Drop
- Extract

Related Information
See details for the following object types
- "Chains" on page 183
- "Jobs (Oracle)" on page 207
- "Programs" on page 222
SCHEMA
A Schema is a container of objects that can be owned by any user.

**NOTE:** The Schema nodes available under DB2 LUW, DB2 z/OS, and Oracle datasources do not own a specific set of objects. They are simply an organizational container for all database objects for a datasource or database.

Platform availability

<table>
<thead>
<tr>
<th>Platform</th>
<th>DB2 LUW</th>
<th>DB2 z/OS</th>
<th>ITB/FBD</th>
<th>MySQL</th>
<th>ORCL</th>
<th>SQL SVR</th>
<th>SYB ASE</th>
<th>SYB IQ</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Creating and editing

- "Schema Wizard (SQL Server)" on page 346 and "Schemas Editor (SQL Server)" on page 513

Object actions/operations supported

The following object actions are available for this object type. For an introduction to object actions and details on usage of specific actions, see "Object actions" on page 573.

- Drop
- Extract
- Report

SEGMENTS

**NOTE:** This object is supported by Sybase ASE only.

Segments are a mechanism for placing tables and indexes on specific logical partitions. You create segments on one or more fragments of a database. You can map segments to specific database fragments, which in turn reside on specific hard disks; and, mapping segments lets you increase i/o throughput by placing intensively used tables and indexes on different physical devices. You can allocate tables and indexes to segments by including placement statements at the end of CREATE TABLE or CREATE INDEX statements.

Platform availability

<table>
<thead>
<tr>
<th>Platform</th>
<th>DB2 LUW</th>
<th>DB2 z/OS</th>
<th>ITB/FBD</th>
<th>MySQL</th>
<th>ORCL</th>
<th>SQL SVR</th>
<th>SYB ASE</th>
<th>SYB IQ</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Creating and editing

- "Segment Wizard (Sybase ASE)" on page 432 and "Segments Editor (Sybase ASE)" on page 564
Object actions/operations supported
The following object actions are available for this object type. For an introduction to object actions and details on usage of specific actions, see "Object actions" on page 573.

Drop Extract Report

SEQUENCES
Sequences are programmable database objects that generate a definable sequence of values. Once defined, a sequence can be made available to many users. A sequence can be accessed and incremented by multiple users with no waiting. A sequence can be used to automatically generate primary key values for tables. When you create a sequence, you can define its initial value, increment interval and maximum value.

Platform availability

<table>
<thead>
<tr>
<th>DB2 LUW</th>
<th>DB2 z/OS</th>
<th>ITB/FBD</th>
<th>MySQL</th>
<th>ORCL</th>
<th>SQL SVR</th>
<th>SYB ASE</th>
<th>SYB IQ</th>
</tr>
</thead>
<tbody>
<tr>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Creating and editing
- "Sequences Wizard (DB2 LUW)" on page 266 and "Sequences Editor (IBM DB2 LUW)" on page 460
- "Sequences Wizard (Oracle)" on page 398 and "Sequences Editor (Oracle)" on page 543

Object actions/operations supported
The following table lists object actions available for this object type. For an introduction to object actions and details on usage of specific actions, see "Object actions" on page 573.

<table>
<thead>
<tr>
<th>DB2 LUW</th>
<th>ORCL</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create Alias</td>
<td>✓</td>
</tr>
<tr>
<td>Create Synonym</td>
<td>✓</td>
</tr>
<tr>
<td>Drop</td>
<td>✓</td>
</tr>
<tr>
<td>Extract</td>
<td>✓</td>
</tr>
<tr>
<td>Rename</td>
<td>✓</td>
</tr>
<tr>
<td>Report</td>
<td>✓</td>
</tr>
<tr>
<td>Run Job (job queues)</td>
<td>✓</td>
</tr>
<tr>
<td>Transfer Ownership</td>
<td>✓</td>
</tr>
</tbody>
</table>
SHADOWS
Rapid SQL provides support for shadows, letting you create one or more in-sync copies of the database stored on secondary storage devices.

Platform availability

<table>
<thead>
<tr>
<th>DB2 LUW</th>
<th>DB2 z/OS</th>
<th>ITB/FBD</th>
<th>MySQL</th>
<th>ORCL</th>
<th>SQL SVR</th>
<th>SYB ASE</th>
<th>SYB IQ</th>
</tr>
</thead>
<tbody>
<tr>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Creating and editing
See "Shadows wizard (ITB/FBD)" on page 316 and "Shadows editor (InterBase/Firebird)" on page 496.

Object actions/operations supported
The following object actions are available for this object type. For an introduction to object actions and details on usage of specific actions, see "Object actions" on page 573.

- Drop
- Extract
- Rename
- Report

STRUCTURED TYPES
Structured types define an abstract data type or object composed of a collection of similar types of data. For example, create an structured type that defines a full address rather than the pieces of an address, such as city, state and postal code. An structured type stores the pieces of an address in a single type, storing them in the same location and allowing the full address to be accessed and manipulated as single unit rather than multiple units.

Structured types are useful for ensuring uniformity and consistency as they are defined as single encapsulated entity that can be reused in other structured types and objects. They also offer flexibility by allowing for the creation of objects that represent real-world situations which is limited in relational objects.

Platform availability

<table>
<thead>
<tr>
<th>DB2 LUW</th>
<th>DB2 z/OS</th>
<th>ITB/FBD</th>
<th>MySQL</th>
<th>ORCL</th>
<th>SQL SVR</th>
<th>SYB ASE</th>
<th>SYB IQ</th>
</tr>
</thead>
<tbody>
<tr>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Creating and editing
- "Structured Types Wizard (DB2 LUW)" on page 267 and "Structured Types Editor (IBM DB2 LUW)" on page 461
**Object actions/operations supported**
The following object actions are available for this object type. For an introduction to object actions and details on usage of specific actions, see "Object actions" on page 573.

<table>
<thead>
<tr>
<th>Drop</th>
<th>Extract</th>
<th>Report</th>
<th>Transfer Ownership</th>
</tr>
</thead>
</table>

**SYMMETRIC KEYS**
Symmetric keys, in addition to asymmetric keys and certificates, provide Rapid SQL support for Public Key Encryption. Symmetric keys consist of a private key and corresponding public key and are used to secure symmetric keys.

**Platform availability**

<table>
<thead>
<tr>
<th>DB2 LUW</th>
<th>DB2 z/OS</th>
<th>ITB/FBD</th>
<th>MySQL</th>
<th>ORCL</th>
<th>SQL SVR</th>
<th>SYB ASE</th>
<th>SYB IQ</th>
</tr>
</thead>
</table>

**Creating and editing**
- "Symmetric Keys Wizard (SQL Server)" on page 347 and "Symmetric Key Editor (SQL Server)" on page 514

**Object actions/operations supported**
The following object actions are available for this object type. For an introduction to object actions and details on usage of specific actions, see "Object actions" on page 573.

<table>
<thead>
<tr>
<th>Drop</th>
<th>Extract</th>
<th>Report</th>
</tr>
</thead>
</table>

**Related information**
- "Certificates" on page 183
- "Asymmetric Keys" on page 182

**SYNONYMS**
The function and usage of synonyms differs by DBMS platform

- **DB2 z/OS**
  An alternate name for an existing table, view, or alias.

- **Oracle**
  An alternative name for a table, view, sequence, procedure, function, package, materialized view, java class, type, or another synonym.
Platform availability

<table>
<thead>
<tr>
<th>Platform</th>
<th>DB2 LUW</th>
<th>DB2 z/OS</th>
<th>ITB/FBD</th>
<th>MySQL</th>
<th>ORCL</th>
<th>SQL SVR</th>
<th>SYB ASE</th>
<th>SYB IQ</th>
</tr>
</thead>
<tbody>
<tr>
<td>DB2 z/OS</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ORCL</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SQL SVR</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SYB ASE</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SYB IQ</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Creating and editing

- "Synonyms Wizard (DB2 Z/OS)" on page 294 and "Synonyms Editor (IBM DB2 Z/OS)" on page 481
- "Synonyms Wizard (Oracle)" on page 400 and "Synonyms Editor (Oracle)" on page 544
- "Synonyms Wizard (SQL Server)" on page 350 and "Synonyms Editor (SQL Server)" on page 514

Object actions/operations supported

The following table lists object actions available for this object type. For an introduction to object actions and details on usage of specific actions, see “Object actions” on page 573.

<table>
<thead>
<tr>
<th>Action</th>
<th>DB2 z/OS</th>
<th>ORCL</th>
<th>SQL SVR</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create Synonym</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Describe</td>
<td></td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Drop</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Extract</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Rename</td>
<td>✓</td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>Report</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
</tbody>
</table>

SYSTEM INDEXES

On some DBMS platforms, Rapid SQL offers system indexes as listed separately from standard indexes.
Platform availability

<table>
<thead>
<tr>
<th>DB2 LUW</th>
<th>DB2 z/OS</th>
<th>ITB/FBD</th>
<th>MySQL</th>
<th>ORCL</th>
<th>SQL SRV</th>
<th>SYB ASE</th>
<th>SYB IQ</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
</tbody>
</table>

Creating, Editing, and Object Actions Supported

Against SQL Server and Sybase ASE datasources, functionality offered for system indexes is identical to that offered for standard indexes. For details, see “Indexes” on page 200.

Against Sybase IQ datasources, Rapid SQL does not offer support for creation or editing against this object type. The following object actions are available:

- Drop
- Extract

SYSTEM TABLES

On some DBMS platforms, Rapid SQL offers system tables as listed separately from standard tables.

Platform availability

<table>
<thead>
<tr>
<th>DB2 LUW</th>
<th>DB2 z/OS</th>
<th>ITB/FBD</th>
<th>MySQL</th>
<th>ORCL</th>
<th>SQL SRV</th>
<th>SYB ASE</th>
<th>SYB IQ</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
</tbody>
</table>

Creating, Editing, and Object Actions Supported

Against SQL Server and Sybase ASE datasources, functionality offered for system indexes is identical to that offered for standard indexes. For details, see "Indexes" on page 200.

Against Sybase IQ datasources, Rapid SQL does not offer support for creation or editing against this object type. The following object actions are available:

- Drop
- Extract
- Object Properties
- Select * From

SYSTEM TRIGGERS

Against Sybase IQ datasources, Rapid SQL offers system triggers as listed separately from standard triggers.
Platform availability

<table>
<thead>
<tr>
<th>DB2 LUW</th>
<th>DB2 z/OS</th>
<th>ITB/FBD</th>
<th>MySQL</th>
<th>ORCL</th>
<th>SQL SVR</th>
<th>SYB ASE</th>
<th>SYB IQ</th>
</tr>
</thead>
<tbody>
<tr>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
</tbody>
</table>

Creating, Editing, and Object Actions Supported
Rapid SQL does not offer support for creation, editing, and object actions against this object type.

**TABLES**

Tables are the basic unit of data storage. Tables store all the data accessible to users in rows and columns. Each column has a name, datatype and other associated properties. After you define a table, users can insert valid data into the table, which you can later query, update and delete.

**NOTE:** Rapid SQL separates system tables from user-defined tables in the Navigator to ensure that system tables are not accidentally altered or dropped.

Platform availability

<table>
<thead>
<tr>
<th>DB2 LUW</th>
<th>DB2 z/OS</th>
<th>ITB/FBD</th>
<th>MySQL</th>
<th>ORCL</th>
<th>SQL SVR</th>
<th>SYB ASE</th>
<th>SYB IQ</th>
</tr>
</thead>
<tbody>
<tr>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
</tbody>
</table>

Creating and editing

- "Tables Wizard (DB2 LUW)" on page 269 and "Tables Editor (IBM DB2 LUW)" on page 463
- "Tables Wizard (DB2 Z/OS)" on page 294 and "Tables Editor (IBM DB2 Z/OS)" on page 481
- "Tables Wizard (ITB/FBD)" on page 318 and "Tables editor (InterBase/Firebird)" on page 496
- "Tables wizard (MySQL)" on page 363 and "Tables editor (MySQL)" on page 523
- "Tables Wizard (Oracle)" on page 401 and "Tables Editor (Oracle)" on page 544
- "Tables Wizard (SQL Server)" on page 351 and "Tables Editor (SQL Server)" on page 515
- "Tables Wizard (Sybase ASE)" on page 434 and "Tables Editor (Sybase ASE)" on page 565

**NOTE:** Creation and editing of objects of this type is not supported against Sybase IQ datasources.
Object actions/operations supported

The following table lists object actions available for this object type. For an introduction to object actions and details on usage of specific actions, see "Object actions" on page 573.

<table>
<thead>
<tr>
<th>Object Action</th>
<th>DB2 LUW</th>
<th>DB2 z/OS</th>
<th>ITB/FBD</th>
<th>MySQL</th>
<th>ORCL</th>
<th>SQL SVR</th>
<th>SYB ASE</th>
<th>SYB IQ</th>
</tr>
</thead>
<tbody>
<tr>
<td>Allocate Extent</td>
<td>✔️</td>
<td></td>
<td></td>
<td>✔️</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Analyze</td>
<td>✔️</td>
<td></td>
<td></td>
<td>✔️</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Analyze Tables</td>
<td>✔️</td>
<td></td>
<td></td>
<td>✔️</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Build Query</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>Change Access Status</td>
<td>✔️</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Check Tables</td>
<td>✔️</td>
<td></td>
<td></td>
<td>✔️</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Checksum Tables</td>
<td>✔️</td>
<td></td>
<td></td>
<td>✔️</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Convert Tables</td>
<td>✔️</td>
<td></td>
<td></td>
<td>✔️</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Create Alias</td>
<td>✔️</td>
<td>✔️</td>
<td></td>
<td>✔️</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Create Clone</td>
<td>✔️</td>
<td></td>
<td></td>
<td>✔️</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Create Insert Statements</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>Create Like</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>Create Synonym</td>
<td>✔️</td>
<td></td>
<td></td>
<td>✔️</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Create View</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>DBCC</td>
<td>✔️</td>
<td></td>
<td></td>
<td>✔️</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Deallocate Unused Space</td>
<td>✔️</td>
<td></td>
<td></td>
<td>✔️</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Delete Statistics</td>
<td>✔️</td>
<td></td>
<td></td>
<td>✔️</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Describe</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>Disable Keys</td>
<td>✔️</td>
<td></td>
<td></td>
<td>✔️</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Disable/Enable Triggers</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>Drop</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>Drop Clone</td>
<td>✔️</td>
<td></td>
<td></td>
<td>✔️</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Drop Unused Columns</td>
<td>✔️</td>
<td></td>
<td></td>
<td>✔️</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Edit Data</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>Enable Keys</td>
<td>✔️</td>
<td></td>
<td></td>
<td>✔️</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Estimate Size</td>
<td>✔️</td>
<td></td>
<td></td>
<td>✔️</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Exchange Data With Clone</td>
<td>✔️</td>
<td></td>
<td></td>
<td>✔️</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Extract</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>Extract Data as XML</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>Supported Objects</td>
<td>DB2 LUW</td>
<td>DB2 z/OS</td>
<td>ITB/FBD</td>
<td>MySQL</td>
<td>ORCL</td>
<td>SQL SVR</td>
<td>SYB ASE</td>
<td>SYB IQ</td>
</tr>
<tr>
<td>-------------------</td>
<td>---------</td>
<td>----------</td>
<td>---------</td>
<td>-------</td>
<td>------</td>
<td>---------</td>
<td>--------</td>
<td>-------</td>
</tr>
<tr>
<td>Flashback Table</td>
<td></td>
<td></td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Flush Tables</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Hide Text</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Import Data From File</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Lock</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Move Table</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Object Properties</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Optimize Tables</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Place</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Rebuild Table</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Recompile</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td></td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Rename</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Reorganize/Reorg</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Repair Tables</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Report</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Schema</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Select * From</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Set Integrity</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Shrink</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Transfer Ownership</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Truncate</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Update Statistics</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✓</td>
<td>✓</td>
</tr>
</tbody>
</table>
DBMS platform-specific notes

| MySQL | MySQL servers can store tables in multiple formats, including MyISAM and InnoDB. MyISAM tables (ISAM is the acronym for indexed sequential access method) are used most often for read operations. The read operation is very fast, but you cannot include any referential integrity, such as a foreign key. Also, MyISAM tables only issue table-level locks. InnoDB tables, on the other hand, do permit transactions and foreign key constraints. InnoDB tables also lock data at the row level, which is appropriate for high transaction tables. Additional table types available are MERGE, MEMORY, FEDERATED, and ARCHIVE among others. For a complete discussion of table types, go to the MySQL documentation of table and engine types. For more information, see Accessing Third Party Documentation. |

TABLESPACES

Tablespaces are storage structures that act as partitions for the database. You can create a tablespace to store table data and other objects related to table performance such as indexes or large object data. Tablespaces are used to manage large complex databases. Once you have created a tablespace, you can place objects on it.

TIP: Create separate tablespaces for your tables and indexes and put each tablespace on a different drive or file system. Segmenting tables and their corresponding indexes in this manner helps eliminate I/O contention at the server level.

NOTE: IBM DB2 for Linux, Unix, and Windows lets you assign a location for table or index data directly to physical storage devices. Each tablespace can also be broken down into a collection of containers which are the actual physical storage files or devices. You can then spread the data or database objects across multiple file systems, thereby giving you the necessary space for objects that require it.

Once you have created a tablespace, you can place individual tables and indexes on it. Because tablespaces map to physical drives, you can improve i/o performance by placing tables and their indexes on physically separated table spaces.

Platform availability

<table>
<thead>
<tr>
<th>DB2 LUW</th>
<th>DB2 z/OS</th>
<th>ITB/FBD</th>
<th>MySQL</th>
<th>ORCL</th>
<th>SQL SRV</th>
<th>SYB ASE</th>
<th>SYB IQ</th>
</tr>
</thead>
<tbody>
<tr>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Creating and editing

- "Tablespaces Wizard (DB2 LUW)" on page 273 and "Tablespaces Editor (IBM DB2 LUW)" on page 466
- "Tablespaces Wizard (Oracle)" on page 408 and "Tablespaces Editor (Oracle)" on page 547
Object actions/operations supported
The following table lists object actions available for this object type. For an introduction to object actions and details on usage of specific actions, see "Object actions" on page 573.

<table>
<thead>
<tr>
<th>Object</th>
<th>DB2 LUW</th>
<th>DB2 z/OS</th>
<th>ORCL</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change Status</td>
<td></td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>Coalesce</td>
<td></td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>Create Alias</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Drop</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Extract</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Lower High Water Mark</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Rebalance</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Rename</td>
<td>✓</td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>Reorganize/Reorg</td>
<td></td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Report</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Set Default</td>
<td></td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>Set UNDO</td>
<td></td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>Switch Online</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Transfer Ownership</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

TRIGGERS
Triggers are a special type of procedure that automatically fire when defined data modification operations (insert, update, or delete) occur on a target table or view. Trigger support in Rapid SQL differs by DBMS type, but in general offers options such as:

- Standard INSERT/DELETE/UPDATE event support
- BEFORE/AFTER timing control
- Row/statement trigger type control
- INSTEAD OF triggers
- Compound triggers
- Enabled/disabled status options
Platform availability

<table>
<thead>
<tr>
<th></th>
<th>DB2 LUW</th>
<th>DB2 z/OS</th>
<th>ITB/FBD</th>
<th>MySQL</th>
<th>ORCL</th>
<th>SQL SVR</th>
<th>SYB ASE</th>
<th>SYB IQ</th>
</tr>
</thead>
<tbody>
<tr>
<td>✔</td>
<td>✔</td>
<td></td>
<td></td>
<td>✔</td>
<td></td>
<td></td>
<td></td>
<td>✔</td>
</tr>
</tbody>
</table>

Creating and editing

- "Triggers Wizard (DB2 LUW)" on page 274 and "Triggers Editor (IBM DB2 LUW)" on page 467
- "Triggers Wizard (DB2 Z/OS)" on page 299 and "Triggers Editor (IBM DB2 Z/OS)" on page 484
- "Triggers Wizard (ITB/FBD)" on page 320 and "Triggers Editor (InterBase/Firebird)" on page 497
- "Triggers Wizard (Oracle)" on page 412 and "Triggers Editor (Oracle)" on page 549
- "Triggers Wizard (SQL Server)" on page 353 and "Triggers Editor (SQL Server)" on page 516
- "Triggers Wizard (Sybase ASE)" on page 436 and "Triggers Editor (Sybase ASE)" on page 568

**NOTE:** Creation and editing of objects of this type is not supported against Sybase IQ datasources.

Object actions/operations supported

The following table lists object actions available for this object type. For an introduction to object actions and details on usage of specific actions, see "Object actions" on page 573.

<table>
<thead>
<tr>
<th>Action</th>
<th>DB2 LUW</th>
<th>DB2 z/OS</th>
<th>ITB/FBD</th>
<th>ORCL</th>
<th>SQL SVR</th>
<th>SYB ASE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change Status</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td></td>
</tr>
<tr>
<td>Compile</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Drop</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Extract</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Hide Text</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Report</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Transfer Ownership</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
</tbody>
</table>
TYPES

Types define an abstract data type or object composed of a collection of similar types of data. For example, create an object type that defines a full address rather than the pieces of an address, such as city, state and postal code. An object type stores the pieces of an address in a single type, storing them in the same location and allowing the full address to be accessed and manipulated as a single unit rather than multiple units.

Object types are useful for ensuring uniformity and consistency as they are defined as single encapsulated entity that can be reused in other object types and objects. They also offer flexibility by allowing for the creation of objects that represent real-world situations which is limited in relational objects.

You can choose to create a type that is incomplete, complete, a VARRAY, or a nested table or any combination of the above. An incomplete type specifies no attributes and can be used for circular references such as person - female. It lets the type be referenced before it is complete. The VARRAY type can be used to store small sets of related data. For example, if you have ten offices (each one with a different description) at a particular division in your company, you could create a VARRAY of 10 to hold the details of these offices. The values for a VARRAY type must be fixed and known and small values as they are stored in RAW format. A nested table type can be used when data is repeated for the same entity an unknown number of times and storage is a concern.

Platform availability

<table>
<thead>
<tr>
<th>DB2 LUW</th>
<th>DB2 z/OS</th>
<th>ITB/FBD</th>
<th>MySQL</th>
<th>ORCL</th>
<th>SQL SVR</th>
<th>SYB ASE</th>
<th>SYB IQ</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Creating and editing

- "Object Types Wizard (Oracle)" on page 414 and "Types Editor (Oracle)" on page 551

Object actions/operations supported

The following object actions are available for this object type. For an introduction to object actions and details on usage of specific actions, see "Object actions" on page 573.

Compile  Drop  Extract  Report

TYPE BODIES

Type Bodies implement object type specification by containing the definition of every cursor and subprogram declared in the object type specification. While Type Bodies are listed as a separate object in the Datasource Navigator, they are created on the Types editor in conjunction with Types.
Platform availability

<table>
<thead>
<tr>
<th>DB2 LUW</th>
<th>DB2 z/OS</th>
<th>ITB/FBD</th>
<th>MySQL</th>
<th>ORCL</th>
<th>SQL SVR</th>
<th>SYB ASE</th>
<th>SYB IQ</th>
</tr>
</thead>
<tbody>
<tr>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
</tbody>
</table>

Creating and editing

While listed as separate objects in the Datasource Navigator, type bodies are created and edited on the **Body** tab of the Types Editor. For details, see "Types Editor (Oracle)" on page 551.

Object actions/operations supported

The following object actions are available for this object type. For an introduction to object actions and details on usage of specific actions, see "Object actions" on page 573.

- **Compile**
- **Drop**
- **Extract**
- **Report**

**UNIQUE KEYS**

Unique keys can enforce logical keys that are not chosen as the primary key. They enforce uniqueness for specified columns in a table.

Platform availability

<table>
<thead>
<tr>
<th>DB2 LUW</th>
<th>DB2 z/OS</th>
<th>ITB/FBD</th>
<th>MySQL</th>
<th>ORCL</th>
<th>SQL SVR</th>
<th>SYB ASE</th>
<th>SYB IQ</th>
</tr>
</thead>
<tbody>
<tr>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
</tbody>
</table>

Creating and editing

- "**Unique Keys Wizard (DB2 LUW)**" on page 275 and "**Unique Keys Editor (IBM DB2 LUW)**" on page 467
- "**Unique Keys Wizard (DB2 Z/OS)**" on page 300 and "**Unique Keys Editor (IBM DB2 Z/OS)**" on page 485
- "**Unique Keys Wizard (ITB/FBD)**" on page 321 and "**Unique Keys editor (InterBase/Firebird)**" on page 498
- "**Indexes, Primary Keys, or Unique Keys wizard (MySQL)**" on page 362 and "**Indexes, Primary Keys, and Unique Keys editors (MySQL)**" on page 523
- "**Unique Keys Wizard (Oracle)**" on page 414 and "**Unique Keys Editor (Oracle)**" on page 551
- "**Unique Keys Wizard (SQL Server)**" on page 355 and "**Unique Keys Editor (SQL Server)**" on page 517
• "Unique Keys Wizard (Sybase ASE)" on page 437 and "Unique Keys Editor (Sybase ASE)" on page 568

**NOTE:** Creation and editing of objects of this type is not supported against Sybase IQ datasources.

**Object actions/operations supported**

The following table lists object actions available for this object type. For an introduction to object actions and details on usage of specific actions, see "Object actions" on page 573.

<table>
<thead>
<tr>
<th>DB2 LUW</th>
<th>DB2 z/OS</th>
<th>ITB/FBD</th>
<th>MySQL</th>
<th>ORCL</th>
<th>SQL SVR</th>
<th>SYB ASE</th>
<th>SYB IQ</th>
</tr>
</thead>
<tbody>
<tr>
<td>Allocate Extent</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Analyze</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Change Status</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Deallocate Unused Space</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Disable Index</td>
<td></td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Drop</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Extract</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Rebuild Index</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Rename</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Reorganize /Reorg</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Report</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Transfer Ownership</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**User Datatypes**

User-defined datatypes promote domain consistency by streamlining the definition of commonly used table columns in a database. You can build a customized datatype from system datatypes and bind defaults and rules to it to enhance integrity. When you reference the user datatype in a column, the column assumes all of the properties of the user datatype.

**Platform availability**

<table>
<thead>
<tr>
<th>DB2 LUW</th>
<th>DB2 z/OS</th>
<th>ITB/FBD</th>
<th>MySQL</th>
<th>ORCL</th>
<th>SQL SVR</th>
<th>SYB ASE</th>
<th>SYB IQ</th>
</tr>
</thead>
<tbody>
<tr>
<td>✓</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✓</td>
<td>✓</td>
</tr>
</tbody>
</table>

**Creating and editing**

• "User Datatypes (DB2 LUW)" on page 276 and "User Datatypes Editor (IBM DB2 LUW)" on page 468
Object actions/operations supported
The following table lists object actions available for this object type. For an introduction to object actions and details on usage of specific actions, see "Object actions" on page 573.

<table>
<thead>
<tr>
<th></th>
<th>DB2 LUW</th>
<th>DB2 z/OS</th>
<th>SQL SVR</th>
<th>SYB ASE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Drop</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Extract</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Rename</td>
<td></td>
<td></td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Report</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Transfer Ownership</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

USER MESSAGES
User Messages lets you catalog error messages that your database applications can re-use. Microsoft SQL Server stores your error messages in a system table, sysmessages. To return error messages from stored procedures and triggers, you need to call a system stored procedure and pass an error number as a parameter.

Platform availability

<table>
<thead>
<tr>
<th>DB2 LUW</th>
<th>DB2 z/OS</th>
<th>ITB/FBD</th>
<th>MySQL</th>
<th>ORCL</th>
<th>SQL SVR</th>
<th>SYB ASE</th>
<th>SYB IQ</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✓</td>
<td>✓</td>
<td></td>
</tr>
</tbody>
</table>

**NOTE:** On SQL Server, User Messages can only be accessed from the master database for a specific server.

Creating and editing
- "User Messages Wizard (SQL Server)" on page 356 and "User Messages Editor (SQL Server)" on page 519
- "User Messages Wizard (Sybase ASE)" on page 439 and "User Messages Editor (Sybase ASE)" on page 570
Object actions/operations supported
The following table lists object actions available for this object type. For an introduction to object actions and details on usage of specific actions, see "Object actions" on page 573.

<table>
<thead>
<tr>
<th></th>
<th>SQL SVR</th>
<th>SYB ASE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Drop</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>Extract</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>Report</td>
<td>✔️</td>
<td>✔️</td>
</tr>
</tbody>
</table>

**USERS**
A user is an individual with access to the DBMS.

Platform availability

<table>
<thead>
<tr>
<th>Platform</th>
<th>SQL SVR</th>
<th>DB2 LUW</th>
<th>DB2 z/OS</th>
<th>ITB/FBD</th>
<th>MySQL</th>
<th>ORCL</th>
<th>SQL SVR</th>
<th>SYB ASE</th>
<th>SYB IQ</th>
</tr>
</thead>
<tbody>
<tr>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
</tr>
</tbody>
</table>

Creating and editing
- "Users Wizard (DB2 LUW)" on page 277 and "Users Editor (IBM DB2 LUW)" on page 469
- "Users Wizard (DB2 Z/OS)" on page 304 and "Users Editor (IBM DB2 Z/OS)" on page 486
- "Users wizard (InterBase/Firebird)" on page 322 and "Users editor (InterBase/Firebird)" on page 498
- "Users wizard (MySQL)" on page 366 and "Users editor (MySQL)" on page 524
- "Users Wizard (Oracle)" on page 417 and "Users Editor (Oracle)" on page 553
- "Users Wizard (SQL Server)" on page 357 and "Users Editor (SQL Server)" on page 518
- "Users Wizard (Sybase ASE)" on page 441 and "Users Editor (Sybase ASE)" on page 571

**NOTE:** Creation and editing of objects of this type is not supported against Sybase IQ datasources.

Object actions/operations supported
The following table lists object actions available for this object type. For an introduction to object actions and details on usage of specific actions, see "Object actions" on page 573.

<table>
<thead>
<tr>
<th></th>
<th>DB2 LUW</th>
<th>DB2 z/OS</th>
<th>ITB/FBD</th>
<th>MySQL</th>
<th>ORCL</th>
<th>SQL SVR</th>
<th>SYB ASE</th>
<th>SYB ASE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Analyze</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Change Password</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td></td>
<td>✔️</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Explorer Details
Depending on the DBMS platform, the icon associated with a user differs according to the account’s locked or unlocked state, when viewed in the Explorer.

<table>
<thead>
<tr>
<th>DBMS Platform</th>
<th>Icon</th>
<th>User Account State</th>
</tr>
</thead>
<tbody>
<tr>
<td>ORCL or SYB ASE</td>
<td>![Icon]</td>
<td>Locked</td>
</tr>
<tr>
<td></td>
<td>![Icon]</td>
<td>Unlocked</td>
</tr>
</tbody>
</table>

Related information
- [**Microsoft SQL Server Users**](#)
- [**MySQL Users**](#)
- [**Oracle Users**](#)
- [**Sybase ASE Users**](#)

**Microsoft SQL Server Users**
Microsoft SQL Server controls access at the database level by requiring the System Administrator or Database Owner to add a login as a database user or alias. After you create a database user, you can implement further security by the granting or revoking the privileges for that user on specific database objects. To consolidate the process of granting or revoking permissions to many users, the database owner can assign users to groups.

**MySQL Users**
Unlike adding new users to other platforms, MySQL doesn’t rely solely on a userid/password combination. The MySQL server must not only validate the user and password, but also the host from which the connection is being requested before the new user is admitted to the server’s inner sanctum. The Rapid SQL User Wizard and User Editor enable these validations.
**ORACLE USERS**
To access an Oracle database, you need a user account authenticated with a password. A user account is what Oracle uses to permit access by the user. You can assign the following optional properties to the user:

- Default tablespace
- Temporary tablespace
- Quotas for allocating space in tablespaces
- Profile containing resource limits

**SYBASE ASE USERS**
Sybase ASE controls access at the database level by requiring the System Administrator or Database Owner to add a login as a database user or alias. After you create a database user, you can implement further security by granting or revoking the privileges for that user on specific database objects. To consolidate the process of granting or revoking permissions to many users, the database owner can assign users to groups.

**VIEWS**
Views are SQL queries stored in the system catalog that customize the display of data contained in one or more tables. Views behave like tables because you can query views and perform data manipulation operations on them. However, views do not actually store any data. Instead, they depend on data contained in their base tables. Views let you:

- View a customized selection of data from one or more tables. As a result, you can display data more cogently to different sets of users, even though the underlying data is the same.
- Restricting access to a defined set of rows and columns.

**Platform availability**

<table>
<thead>
<tr>
<th>DB2 LUW</th>
<th>DB2 z/OS</th>
<th>ITB/FBD</th>
<th>MySQL</th>
<th>ORCL</th>
<th>SQL SVR</th>
<th>SYB ASE</th>
<th>SYB IQ</th>
</tr>
</thead>
<tbody>
<tr>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
</tbody>
</table>

**Creating and editing**

- "[Views Wizard (DB2 LUW)](page277)" on page 277 and "[Views Editor (IBM DB2 LUW)](page469)" on page 469
- "[Views Wizard (DB2 Z/OS)](page304)" on page 304 and "[Views Editor (IBM DB2 Z/OS)](page487)" on page 487
- "[Views Wizard (ITB/FBD)](page323)" on page 323 and "[Views editor (InterBase/Firebird)](page499)" on page 499
- "[Views Wizard (Oracle)](page418)" on page 418 and "[Views Editor (Oracle)](page554)" on page 554
• "Views Wizard (SQL Server)" on page 358 and "Views Editor (SQL Server)" on page 520

• "Views Wizard (Sybase ASE)" on page 442 and "Views Editor (Sybase ASE)" on page 571

**NOTE:** Creation and editing of objects of this type is not supported against Sybase IQ datasources.

**Object actions/operations supported**

The following table lists object actions available for this object type. For an introduction to object actions and details on usage of specific actions, see "Object actions" on page 573.

<table>
<thead>
<tr>
<th></th>
<th>DB2 LUW</th>
<th>DB2 z/OS</th>
<th>ITB/FBD</th>
<th>ORCL</th>
<th>SQL SVR</th>
<th>SYB ASE</th>
<th>SYB IQ</th>
</tr>
</thead>
<tbody>
<tr>
<td>Build Query</td>
<td>✓</td>
<td>✗</td>
<td>✗</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Compile</td>
<td></td>
<td></td>
<td></td>
<td>✓</td>
<td></td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>Create Alias</td>
<td>✓</td>
<td></td>
<td></td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Create Synonym</td>
<td>✓</td>
<td></td>
<td></td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Describe</td>
<td>✓</td>
<td></td>
<td></td>
<td>✓</td>
<td></td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Drop</td>
<td>✓</td>
<td></td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Extract</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Generate Package/Procedure/Statement</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Hide Text</td>
<td></td>
<td></td>
<td></td>
<td>✓</td>
<td></td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>Object Properties</td>
<td></td>
<td></td>
<td></td>
<td>✓</td>
<td></td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>Rename</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Report</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Schema</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Select * From</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Transfer Ownership</td>
<td></td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Update Statistics</td>
<td>✓</td>
<td></td>
<td></td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
CREATING OBJECTS

Rapid SQL offers easy-to-use wizards and dialog boxes for creating objects. For an introduction to object creation wizards, see "Overview and Common Usage of Object Wizards" on page 247.

Platform-by-platform discussions of wizards are discussed as follows:

- "IBM DB2 for Linux, Unix, and Windows Object Wizards" on page 251
- "IBM DB2 for z/OS Object Wizards" on page 278
- "InterBase/Firebird Object Wizards" on page 305
- "Microsoft SQL Server Object Wizards" on page 324
- "MySQL object wizards" on page 359
- "Oracle Object Wizards" on page 367
- "Sybase ASE Object Wizards" on page 419

OVERVIEW AND COMMON USAGE OF OBJECT WIZARDS

An object wizard lets you create new database and server objects on a datasource. For example, a Tables wizard lets you create columns, set up permissions to work with that table, provide details on physical storage for the table, and so on. Each pane on an object wizard lets you perform a logical task or collection of logical tasks for that object type. For example:
In order to work with object wizards, you must be familiar with the following:

- Opening an Object Wizard
- Navigating and Setting Properties in an Object Wizard
- Previewing the DDL Generated to Create the New Object.

OPENING AN OBJECT WIZARD
Object wizards are accessed from the Datasource Navigator pane of the Rapid SQL main window.

To open an Object wizard for a server or database object
1. Connect to the datasource where you want to create a new resource. For more information, see "Datasource Management" on page 131.
2. On the Datasource Explorer, expand the target datasource.
3. Continue to expand folders under the datasource until the type of object you want to create is visible.
4 On the Datasource Navigator, right-click on the specific type of object that you want to create and select Create from the context menu.

Rapid SQL opens the object wizard for that object type.

**Navigating and Setting Properties in an Object Wizard**

When you invoke an object wizard, it opens on the first pane of the wizard, typically a Properties pane. As you select options or provide details, you use the navigation buttons at the bottom of the window and the pane controls at the left of the window to navigate through the wizard.

- Use the Next button to move to the next pane of the wizard.

  **NOTE:** In some cases, the Next button is not activated until required information is provided. Similarly, some panes of a wizard do not become accessible until activated by choice of an option or property on a previous pane. For example, a Partitions tab in a table wizard may only become available if the Clustered and Number of Partitions options on a prior tab are set accordingly.

- Use the Back button to move to the previous pane of the wizard.

- Use the pane controls at the left of the window to move to a specific pane of the wizard.

**Adding a Comment to an Object**

The object wizards for certain object types feature a Comment tab that lets you add an explanatory note to specific object definitions. Comments are stored in the REMARKS column of the object’s system-catalog.
To add a comment to an object:
1. Open an object wizard on an object type that permits comments. For details, see "Opening an Object Wizard" on page 248.

See the topics for specific Object editors later in this chapter for information on whether that object type supports comments.

2. Click the Comment panel when enabled.

3. In the Comment area, type an explanatory note of up to 254 characters long.

Setting Permissions or Privileges for an Object
When you open an Object wizard to create an object with associated privileges, the Permissions (or Privileges or Object Permissions or System Permissions) panel for that editor displays the relevant privileges and lets you make changes accordingly:

To set permissions for an object:
1. Open an object wizard on an object type with associated permissions or privileges. For details, see "Opening an Object Wizard" on page 248.

2. Click the Permissions (Privileges, Object Permissions or System Permissions) panel when enabled.

3. For each specific permission to be granted to an entity such as a user, login, or group, select the cell corresponding to the entity and specific permission, and click the Grant button. To revoke a privilege, select a cell showing a Granted permission and click Revoke.

Previewing the DDL Generated to Create the New Object
The final pane or tab of a wizard or editor is most commonly designated DDL View or Definition.

- A DDL View tab/panel lets you view the DDL generated by your selections on the other tabs/panels of the wizard or editor.
• A **Definition** tab/panel is only available for objects such as triggers and procedures, for which you must provide the additional SQL statements that provide the actions taken for that object.

In most cases you arrive at **DDL View** or **Definition** by navigating through panes or tabs, choosing options as you proceed. Alternatively, if you have provided all required information for that object type, you can click **Finish** or **Execute** to create the object.

---

**IBM DB2 for Linux, UNIX, and Windows Object Wizards**

Rapid SQL lets you create DB2 LUW objects using the following wizards:

- Aliases Wizard (DB2 LUW)
- Databases Wizard (DB2 LUW)
- Foreign Keys Wizard (DB2 LUW)
- Functions Wizard (DB2 LUW)
- Indexes Wizard (DB2 LUW)
- Materialized Query Tables Wizard (DB2 LUW)
- Nodegroups Wizard (DB2 LUW)
- Primary Keys Wizard (DB2 LUW)
- Procedures Wizard (DB2 LUW)
- Schemas Wizard (DB2 LUW)
- Sequences Wizard (DB2 LUW)
- Structured Types Wizard (DB2 LUW)
- Tables Wizard (DB2 LUW)
- Tablespaces Wizard (DB2 LUW)
- Triggers Wizard (DB2 LUW)
- Unique Keys Wizard (DB2 LUW)
- User Datatypes (DB2 LUW)
- Users Wizard (DB2 LUW)
- Views Wizard (DB2 LUW)

In addition, see [Create Synonym](#).
CREATING OBJECTS

**ALESIASES WIZARD (DB2 LUW)**
An alias offers you security and convenience so that you can refer to an object without revealing who owns it or what database it belongs to. You can create aliases for tables, views, and even other aliases. The Alias Wizard lets you create an alias without knowing the underlying commands. As you complete the Alias Wizard process, Rapid SQL constructs the necessary CREATE ALIAS statement based on the information that you supply.

**To create a new alias using a wizard:**
1. Open a creation wizard for an alias. For details, see "Opening an Object Wizard" on page 248.
2. Use the following topics as a guide to setting properties and performing tasks as you pass through the wizard panels:
   - **Properties** panel - for details see Aliases (DB2 LUW) - Properties.
   - **Comment** panel - for details, see "Adding a Comment to an Object" on page 249.
   - **DDL View** panel - for details, see "Previewing the DDL Generated to Create the New Object" on page 250.
3. Finally, use the **Execute** button to create the object.

**ALESIES (DB2 LUW) - PROPERTIES**
When creating or editing an alias, this tab/panel lets you work with the following settings:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Schema</td>
<td>Select the schema that is to own the alias.</td>
</tr>
<tr>
<td>Name</td>
<td>Provide a name for the alias.</td>
</tr>
<tr>
<td>Target Owner</td>
<td>Select the owner of the object to which you are creating an alias.</td>
</tr>
<tr>
<td>Target Type</td>
<td>Select the type of object to which you want to create an alias.</td>
</tr>
<tr>
<td>Target Name</td>
<td>Select the specific object to which you are creating an alias.</td>
</tr>
</tbody>
</table>

For context information on the wizard and editor that include this tab/panel, see "Aliases Wizard (DB2 LUW)" on page 252 and "Aliases Editor (IBM DB2 LUW)" on page 452.

**DATABASES WIZARD (DB2 LUW)**
The Database Wizard lets you create a database (a structured collection of data that can be updated or queried) without knowing the underlying commands. Databases can be simple, that is one file with many records and the same fields, or much more complicated with multiple files with different fields.
To open the IBM DB2 for Linux, Unix, and Windows Database Wizard

On the Registration tool bar, click New UDB Database.

OR

On the Navigator right-click an instance node or the Datasources node, and then click New UDB Database.

The tables below describe the fields you may encounter as you complete the wizard.

### Naming the New Database

<table>
<thead>
<tr>
<th>Required Information</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>What is the name of the database?</td>
<td>Each database requires a unique name. The database name should be between 1 - 8 characters and must begin with a letter A-Z. It’s wise to avoid the symbols @, #, and $ if the database will exist in a communications environment or be summoned from an area where those characters do not exist in the language (and hence, on a keyboard).</td>
</tr>
<tr>
<td>What is the datasource name for the new database?</td>
<td>Each datasource should have a unique name. This is the name that will appear on the Navigator.</td>
</tr>
<tr>
<td>What is the alias name of the database.</td>
<td>OPTIONAL: A database alias is the local synonym given to the database you are creating, and must be unique. If you don’t assign an alias, the database name becomes the default alias. Note that a DB2 client can have connections to two different databases with the same name if those databases live on different servers and each database has its own alias.</td>
</tr>
<tr>
<td>What is the comment used for the database?</td>
<td>OPTIONAL: Lets you type a comment up to 30 characters. Any comment you enter can be changed later.</td>
</tr>
</tbody>
</table>

### Drive Path and Parameters

<table>
<thead>
<tr>
<th>Required Information</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>On what drive/path will the database reside?</td>
<td>OPTIONAL: Leave blank if you want Rapid SQL to create the database using the DFTBPATH (default database path configuration) parameter.</td>
</tr>
</tbody>
</table>
| What default tablespace parameters should be used? | OPTIONAL
Extent size: This is the number of pages of table data that will be written before data is written to the next container.
Number of segments: The default is 0. The number you designate specifies the number of extended memory segments available for the database to use. You should only set this number if you have a large amount of real memory. |
| What global default parameters should the database use? | Territory: The territory where the database was created. This is purely informational, for example, en_US and is related to region-specific support.
Codeset: IBM-1252 or UTF-8 are the options for language support.
Collating Sequence: Compatibility, Identity, System are your choices for comparing character data. Note: The collation sequence can’t be changed after the database has been created. |
CREATING OBJECTS

There are three distinct wizard panels, one for each container type, that enable you to customize your database. Click Next or Finish depending on how you want to proceed.

<table>
<thead>
<tr>
<th>Required Information</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>What container(s) will be used to store the catalog/temporary tables?</td>
<td>Use System Managed Space: If you select this option, the operating system's file system manager allocates and manages the space where the catalog tables are stored. This is the default. Use Database Managed Space: If you select this option, the database manager controls the storage space for catalog tables. Add or Edit - For details, see Add/Edit Container for Tablespace.</td>
</tr>
<tr>
<td>What optional default storage parameters should be used.</td>
<td>Optionally identify values for extent size, pre-fetch size, transfer rate, and overhead.</td>
</tr>
<tr>
<td>Finish</td>
<td>Opens the Preview SQL dialog.</td>
</tr>
</tbody>
</table>

ADD/EIDT CONTAINER FOR TABLESPACE

The table below describes the options and functionality on this dialog:

<table>
<thead>
<tr>
<th>Required Information</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Container Parameters</td>
<td>These parameters are enabled for modification only if you have opted to use database managed space. When enabled, you can either indicate file size parameters or specify device information.</td>
</tr>
<tr>
<td>Directory</td>
<td>Identify the directory where the catalog table container will be stored.</td>
</tr>
<tr>
<td>File Name</td>
<td>Identify a name for the file where the catalog table container will be stored.</td>
</tr>
<tr>
<td>Device Information</td>
<td>Enable either raw partition and type a value, or raw drive, and select a value.</td>
</tr>
</tbody>
</table>

FOREIGN KEYS WIZARD (DB2 LUW)

Foreign keys are unique values that refer to specific columns of other tables. Thus, a foreign key links two tables together. Embarcadero Rapid SQL's Foreign Key Wizard makes it easy for you to create a relational link between two tables, thereby speeding queries and giving you faster access to data. The Foreign Key Wizard lets you create a foreign key without knowing the underlying commands.
To create a new foreign key using a wizard:
1. Open a creation wizard for a foreign key. For details, see "Opening an Object Wizard" on page 248.
2. Use the following topics as a guide to setting properties and performing tasks as you pass through the wizard panels:
   - **Properties** panel - for details, see Foreign Keys (DB2 LUW) - Properties
   - **Column Mapping** panel - for details, see Foreign Keys (DB2 LUW) - Column Mapping
   - **Comment** panel - for details, see "Adding a Comment to an Object" on page 249.
   - **DDL View** panel - for details, see "Previewing the DDL Generated to Create the New Object" on page 250.
3. Finally, use the **Execute** button to create the object.

### FOREIGN KEYS (DB2 LUW) - PROPERTIES
When creating or editing a foreign key, this tab/panel lets you work with the following settings:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Table Schema</strong></td>
<td>The schema owning the table where the foreign key is being created.</td>
</tr>
<tr>
<td><strong>Table Name</strong></td>
<td>This is the table where the foreign key link originates--the child table.</td>
</tr>
<tr>
<td><strong>Name</strong></td>
<td>Lets you select a constraint name.</td>
</tr>
<tr>
<td></td>
<td>System Generated Name - DB2 automatically generates a name.</td>
</tr>
<tr>
<td></td>
<td>User Specified Constraint Name - You type the name.</td>
</tr>
<tr>
<td><strong>Enabled</strong></td>
<td>TRUE enables the Foreign Key while FALSE disables the Foreign Key.</td>
</tr>
<tr>
<td><strong>Delete Rule</strong></td>
<td>Select an action:</td>
</tr>
<tr>
<td></td>
<td><strong>NO ACTION</strong> - ensures that referenced values cannot be updated or deleted if to do so would violate referential integrity.</td>
</tr>
<tr>
<td></td>
<td><strong>CASCADE</strong> - permits a referenced row in a child table to be deleted/updated if it is deleted/updated in the parent table. A row in the child table is SET NULL when rows in the parent table are deleted/updated.</td>
</tr>
<tr>
<td></td>
<td><strong>RESTRICT</strong> - prevents a command from executing if changes to referential data prompts an error.</td>
</tr>
<tr>
<td><strong>Update Rule</strong></td>
<td>Select an action:</td>
</tr>
<tr>
<td></td>
<td><strong>NO ACTION</strong> - ensures that referenced values cannot be updated or deleted if to do so would violate referential integrity.</td>
</tr>
<tr>
<td></td>
<td><strong>RESTRICT</strong> - prevents a command from executing if changes to referential data prompts an error</td>
</tr>
</tbody>
</table>
FOREIGN KEYS (DB2 LUW) - COLUMN MAPPING

1. Under **Referenced Table**, choose the **Owner** and then the **Name** of the referenced, or parent, table.

2. Under the **Main Table**, select check boxes corresponding to the columns that are to reference columns in the referenced table.

FUNCTIONS WIZARD (DB2 LUW)

To create a relationship between one set of values and another, Rapid SQL offers the Function Wizard. You can develop reusable subroutines so you can control, access, and manipulate the data that underlies an object. As you complete the Function Wizard process, Rapid SQL constructs the necessary CREATE FUNCTION statement based on the information that you supply. The Function Wizard lets you create a function without knowing the underlying commands.

**NOTE:** To create a user-defined function, you need CREATE ANY privileges or IMPLICIT_SCHEMA authority on the database if the schema does not already exist.

To create a new function using a wizard:

1. Open a creation wizard for a function. For details, see "Opening an Object Wizard" on page 248.

2. Use the following topics as a guide to setting properties and performing tasks as you pass through the wizard panels:

   - **Properties** panel - for details, see Functions (DB2 LUW) - Properties.
   - **Advanced** panel - for details, see Functions (DB2 LUW) - Advanced.
   - **Source** panel (only available for a **Function Type** of SOURCED) - for details, see Functions (DB2 LUW) - Source.
   - **Parameters** panel (only available for a **Function Type** of SQL, SOURCED, or TEMPLATE) - for details, see Functions (DB2 LUW) - Parameters.
   - **Return Scalar** panel - for details, see Functions (DB2 LUW) - Return Scalar.
   - **Return Columns** panel (only available when you choose a **Function Type** of EXTERNAL TABLE) - for details, see Functions (DB2 LUW) - Return Columns.
   - **Body** panel - for details, see Functions (DB2 LUW) - Body.
   - **DDL View** panel - for details, see "Previewing the DDL Generated to Create the New Object" on page 250.

3. Finally, use the **Execute** button to create the object.
FUNCTIONS (DB2 LUW) - PROPERTIES
When creating or editing a foreign key, this tab/panel lets you work with the following settings:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Schema, Name, and Specific Name</td>
<td>Let you select the owner of the function, provide a name for the function, and provide the Specific name to be used by some SQL statements and DB2 commands for this function.</td>
</tr>
<tr>
<td>Function Type</td>
<td>Select the type of function:</td>
</tr>
<tr>
<td></td>
<td>External Scalar - written in a programming language and returns a scalar value.</td>
</tr>
<tr>
<td></td>
<td>External Table - written in a programming language and returns a complete table.</td>
</tr>
<tr>
<td></td>
<td>OLEDB - accesses OLE DB data in user-defined OLE DB external tables.</td>
</tr>
<tr>
<td></td>
<td>Sourced - another function is invoked to implement the function you are creating.</td>
</tr>
<tr>
<td></td>
<td>SQL Language - written in SQL and returns a table, scalar value, or single row.</td>
</tr>
<tr>
<td></td>
<td>Template: - this is a partial function and can only be invoked from a federated datasource.</td>
</tr>
<tr>
<td></td>
<td>For more information, see &quot;About function types&quot; on page 258.</td>
</tr>
<tr>
<td>Language</td>
<td>If you chose a Function Type of EXTERNAL SCALAR or EXTERNAL TABLE, specify a language of C, JAVA, or OLE. For more information, see &quot;About function types&quot; on page 258.</td>
</tr>
<tr>
<td>Return Type</td>
<td>For a Function Type of SQL, select ROW, TABLE, or SCALAR. For other Function Type choices, this indicates the default return type for that choice.</td>
</tr>
<tr>
<td>External Name</td>
<td>Provide the External Name of the function.</td>
</tr>
<tr>
<td>SQL Access Level</td>
<td>Indicates whether the function can execute SQL statements.</td>
</tr>
<tr>
<td></td>
<td>CONTAINS SQL: Statements that don’t read or modify SQL can be executed.</td>
</tr>
<tr>
<td></td>
<td>NO SQL: No SQL statements can be executed.</td>
</tr>
<tr>
<td></td>
<td>READS SQL: Statements that cannot modify SQL can be executed.</td>
</tr>
</tbody>
</table>

FUNCTIONS (DB2 LUW) - ADVANCED
This tab is only available after clicking the Advanced button on the Function wizard's Properties panel. It lets you work with the Threading, Fenced, Scratchpad, Scratchpad Length, Allow Parallel, Final Call, Parameter Style, Inherit Special Registers, DBINFO, Deterministic, External Action, Called on Null Input, and Parameter CCSID properties.

FUNCTIONS (DB2 LUW) - SOURCE
NOTE: This panel is only available for a Function Type of SOURCED.

Select the Schema, Name, and Specific Name of the source function. Function Parameters and Return Type for the selected function are displayed. For more information, see "About function types" on page 258.

FUNCTIONS (DB2 LUW) - PARAMETERS
NOTE: This panel is only available for a Function Type of SQL, SOURCED, or TEMPLATE.
For each parameter for this function, use the New button to add a new parameter, provide a name for the parameter, and in the **Attributes** area, select a **Type**, and if appropriate, the **Precision**, **Scale**, and **Size** options.

**FUNCTIONS (DB2 LUW) - RETURN SCALAR**

Under **Return Datatype**, select a Type and depending on your choice, provide or select **Precision**, **Scale**, **Size**, and **As Locator** options.

To make use of a CAST FROM clause, under **Cast Datatype** set **Enabled** to True, select a **Type**, and if appropriate, the **Scale**, **Size**, and **As Locator** options.

**FUNCTIONS (DB2 LUW) - RETURN COLUMNS**

**NOTE:** This panel is only available when you choose a **Function Type** of EXTERNAL TABLE.

For each column returned by this function, use the New button to add a new parameter, provide a name for the parameter, and in the **Attributes** area, select a **Type**, and if appropriate, the **Precision**, **Scale**, **Size**, and **As Locator** options.

**FUNCTIONS (DB2 LUW) - BODY**

Enter the return statement for the function.

**ABOUT FUNCTION TYPES**

**External Scalar/Table/OLE DB Function**

External scalar user-defined functions are implemented in an external programming language. The functions are executed on the server and can read SQL data but cannot make changes to the data. These functions are often used to extend the set of built-in functions for DB2, perform logic inside a SQL query that SQL can’t perform on its own, and encapsulate a scalar query that is often used as a subquery in SQL statements, for example, if given an ingredient, search a table for a recipe that uses that ingredient.

When specifying the **Specific Name** for one of these function types:

- If you are using C language, specify the full library path and the function name, otherwise IBM DB2 Database Manager assumes the function is under the IBM DB2 library.

- If you are using Java script, specify the Class ID and the function name, otherwise IBM DB2 Database Manager assumes the function is under the IBM DB2 library.

- If you are using OLE language, specify the full library path and the function name, otherwise IBM DB2 Database Manager assumes the function is under the IBM DB2 library.
Sourced Functions
When you create a sourced function, the new function you are creating will be implemented by a preexisting (source) function that's known to the database manager. The source function can be a built-in function or a previously created user-defined scalar function.

When you select the appropriate schema, you are really specifying an implicit schema privilege. In other words, you’re selecting a schema/function that belongs to a user with DBAdmin privileges. If you want to use a built-in function, you must specify the function’s specific name.

SQL Language Function
The function you are creating is written in SQL. A table, scalar value, or single row is returned.

Template Function
A template function is better thought of as a template for a function. It’s a partial function that has no executable code. You create a function template for mapping it to a datasource function. When the mapping is created, you can specify the function template be used in queries submitted to the federated server. When the query is processed, the federated server invokes datasource function where the template is mapped and returns the appropriate values.

INDEXES WIZARD (DB2 LUW)
Comparable to an index in a book, an index gives you speedy access to particular records in a table. The Index Wizard lets you create an index without knowing the underlying commands.

To create a new index using a wizard:
1 Open a creation wizard for an index. For details, see “Opening an Object Wizard” on page 248.
2 Use the following topics as a guide to setting properties and performing tasks as you pass through the wizard panels:
   • Properties panel - for details, see Indexes (DB2 LUW) - Properties.
   • Columns and Include Columns panels - for details, see Indexes (DB2 LUW) - Columns and Include Columns.
   • Comment panel - for details, see “Adding a Comment to an Object” on page 249.
   • DDL View panel - for details, see “Previewing the DDL Generated to Create the New Object” on page 250.
3 Finally, use the Execute button to create the object.
INDEXES (DB2 LUW) - PROPERTIES
When creating or editing an index, this tab/panel lets you work with the following settings:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Parent Type, Parent Schema and Parent Name</td>
<td>Choose the type (TABLE or MATERIALIZED QUERY TABLE) owning schema, and name of the parent object in which the index is being created.</td>
</tr>
<tr>
<td>Schema and Name</td>
<td>Choose the owner and name of the index being created.</td>
</tr>
<tr>
<td>Index Type</td>
<td>Index enforces uniqueness on the values of the table's index key.</td>
</tr>
<tr>
<td>Clustered</td>
<td>Specifies that the index is the clustering index of the table. The cluster factor of a clustering index is maintained or improved dynamically as data is inserted into the associated table, by attempting to insert new rows physically close to the rows for which the key values of this index are in the same range.</td>
</tr>
<tr>
<td>Allow Reverse Scans</td>
<td>If selected, a ALLOW REVERSE SCAN clause is included with the CREATE/ALTER INDEX statement, specifying that the index supports both forward and reverse scans.</td>
</tr>
<tr>
<td>Compress (9.7^)</td>
<td>YES - Selecting this option adds a COMPRESS YES clause, enabling index compression. NO - Selecting this option adds a COMPRESS NO clause, disabling index compression. DEFAULT - Selecting this option specifies default compression handling to that of the parent object.</td>
</tr>
<tr>
<td>Percent Free</td>
<td>Lets you provide a PCTFREE value, specifying the percentage of each index page to leave as free space when building the index, from 0 to 99.</td>
</tr>
<tr>
<td>Minimum Percent Used</td>
<td>Lets you provide a MINPCTUSED value, specifying whether index leaf pages are merged online, and the minimum percentage threshold of space used on index leaf pages.</td>
</tr>
</tbody>
</table>

INDEXES (DB2 LUW) - COLUMNS AND INCLUDE COLUMNS
Index columns can be segregated into unique key columns (Columns pane) and Include columns that are to be part of the index but do not form part of the unique key.

The steps in completing the panes for the two column types are identical.

- From the Column dropdown, select a column for the index and specify a Sort option. To add more columns, click the New button and then follow the steps in the last instruction. Use the Delete button to drop columns.

MATERIALIZED QUERY TABLES WIZARD (DB2 LUW)
A materialized query table (MQT) is a table based on the result of a query. An MQT contains information that is summarized from other tables and can save time when processing dynamic SQL queries. The Materialized Query Table Wizard lets you create a table without knowing the underlying commands.
**To Open the Materialized Query Wizard**

1. On the Navigator, find the datasource where you want to add the new materialized query table.

2. Expand the **Schema** branch, right-click **Materialized Query Tables**, and select **New**.

The table that follows describes the fields you may encounter as you complete the Materialized Query Table Wizard.

**NOTE:** These options are only available if the tablespace you selected is a database managed tablespace.

<table>
<thead>
<tr>
<th>Required Information</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Who owns the table?</td>
<td>Choose the owner of the table you’re creating from the drop-down list.</td>
</tr>
<tr>
<td>What is the name of the table?</td>
<td>Type the name of the materialized query table you are creating.</td>
</tr>
<tr>
<td>Select a tablespace on which to place the table:</td>
<td>OPTIONAL: No selection is the default. But you can select a tablespace that belongs to the new table’s owner if you want.</td>
</tr>
<tr>
<td>Specify separate tablespaces for index and long data</td>
<td>OPTIONAL: Lets you separate indexes or long data from the table.</td>
</tr>
<tr>
<td>Specify the query on which this table is based</td>
<td>Write the query you want to use to create the table. Note: Every select list element must have a name (use the AS clause for expressions)</td>
</tr>
<tr>
<td>Add the columns belonging to this table</td>
<td>Click <strong>Add</strong>, <strong>Insert</strong> or <strong>Edit</strong> to add or modify table columns. Click <strong>Drop</strong> to delete a selected column.</td>
</tr>
<tr>
<td>Add the columns belonging to the partition key</td>
<td></td>
</tr>
<tr>
<td>Do you want the table replicated across database partitions?</td>
<td>The default is no, but check the box if you do want to replicate the table. Replicated materialized query tables can help you improve query performance by enabling collocation between tables. Replication is especially helpful when you have joins between large fact tables and small dimension tables. It’s best if tables that are to be replicated are infrequently updated.</td>
</tr>
<tr>
<td>Definition Only</td>
<td>Lets you select definition options, Include Column Defaults and Include Identity Column Attributes. When you select the Definition Only option, the new table is treated as if it was a base table rather than a MQT. After you complete the wizard, Rapid SQL opens the Tables Editor.</td>
</tr>
</tbody>
</table>
### Required Information

<table>
<thead>
<tr>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Refreshable</td>
</tr>
</tbody>
</table>

**Lets you select refresh options:**

- **Immediate:** The table you are creating will be refreshed automatically when changes are made to the base table(s).
- **Deferred:** Static SQL will not be optimized. Changes to the base table(s) will not be reflected.

**Query Optimization:**

- **Enabled:** Queries will be routed to the MQT.
- **Disabled:** This is the default.

**Maintained by:**

- **System:** This is the default
- **User**

After you complete the wizard, Rapid SQL opens the Material Query Tables Editor.

---

<table>
<thead>
<tr>
<th>Would you like extra information regarding SQL changes to this table to be written to the log?</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Yes</strong> means you want to receive error messages issued by the DB2 replication programs.</td>
</tr>
<tr>
<td><strong>Include Longvar Columns</strong> means you want to receive error messages for these columns if long varchar data is a part of the table you’re replicating.</td>
</tr>
<tr>
<td><strong>No</strong></td>
</tr>
</tbody>
</table>

---

<table>
<thead>
<tr>
<th>Would you like to skip logging changes made to this table by Insert… and Alter Table operations in the same unit of work in which this table is created?</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Initially Not Logged:</strong> This is an option that can reduce logging and increase performance, but also means that you cannot recover the table when rolling forward.</td>
</tr>
<tr>
<td><strong>Logged Initially.</strong> This is the default.</td>
</tr>
</tbody>
</table>

---

<table>
<thead>
<tr>
<th>What type of table lock would you like when it is being accessed?</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Row:</strong> This is the default. During a table or index scan, DB2 locks each row that is scanned before determining whether that row is relevant to the query.</td>
</tr>
<tr>
<td><strong>Table:</strong> During a table scan, DB2 locks the table so no data can be added or altered while the query is executed.</td>
</tr>
</tbody>
</table>

---

<table>
<thead>
<tr>
<th>What percent of free space to leave for load and reorganization?</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>-1</strong> is the default.</td>
</tr>
</tbody>
</table>

---

<table>
<thead>
<tr>
<th>Do you want data to append to the end of the table?</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Yes</strong></td>
</tr>
<tr>
<td><strong>No:</strong> This is the default</td>
</tr>
</tbody>
</table>

---

<table>
<thead>
<tr>
<th>Do you want the access plan to this table to be based on existing statistics and optimization level?</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Volatile:</strong> A volatile table’s contents can vary from empty to huge at run time and can render collected statistics inaccurate.</td>
</tr>
<tr>
<td><strong>Not Volatile:</strong> This is the default.</td>
</tr>
</tbody>
</table>

---

<table>
<thead>
<tr>
<th>Enter a comment</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Optional</strong></td>
</tr>
</tbody>
</table>
**NODEGROUPS WIZARD (DB2 LUW)**

A nodegroup is a named subset of one or more database partitions. The Node Group Wizard lets you create a node group without knowing the underlying commands. When you create a nodegroup, the wizard simply asks you to name the nodegroup and select the partitions to include in the nodegroup.

**To Open the Nodegroup Wizard**

1. On the Navigator, find the datasource where you want to add the new Nodegroup.
2. Expand the **Storage** branch, right-click **Nodegroups**, and select **New**.

**PRIMARY KEYS WIZARD (DB2 LUW)**

A primary key is a column or group of columns that you can use to identify or access one or more specific rows in a table. A primary key is ‘constrained’ in that no values can be null and no two values are equal. You can only create one primary key for any table. The Create Primary Key Constraint dialog lets you create a primary key without knowing the underlying commands.

When you create a primary key, specify the table owner and the table on which you want to place the primary key constraint. You name the constraint and select the column(s) you want to include.

**To create a new primary key using a wizard:**

1. Open a creation wizard for a primary key. For details, see "Opening an Object Wizard" on page 248.
2. Use the following topics as a guide to setting properties and performing tasks as you pass through the wizard panels:
   - **Properties** panel - for details, see Primary Keys (DB2 LUW) - Properties.
   - **Columns** panel - for details, see Primary Keys (DB2 LUW) - Columns.
   - **Comment** panel - for details, see "Adding a Comment to an Object" on page 249.
   - **DDL View** panel - for details, see "Previewing the DDL Generated to Create the New Object" on page 250.
3. Finally, use the **Execute** button to create the object. For more information, see Previewing the DDL Generated to Create the New Object.

**PRIMARY KEYS (DB2 LUW) - PROPERTIES**

When creating or editing a primary key, this tab/panel lets you work with the following settings:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Table Schema</strong> and</td>
<td>Choose the owner and name of the table in which the primary key is being</td>
</tr>
<tr>
<td><strong>Table Name</strong></td>
<td>created.</td>
</tr>
</tbody>
</table>
CREATING OBJECTS

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Choose the owner and name of the primary key being created.</td>
</tr>
<tr>
<td>Time period policy</td>
<td>This setting is for use with tables set up as business-time tables. For more information, see &quot;Tables (DB2 LUW v10) - Temporal Properties&quot; on page 272. When selected, a BUSINESS_TIME WITHOUT OVERLAPS option is specified against the column or columns defining the constraint, in the generated DDL. This ensures that values for the constraint columns are unique with respect to the time for the BUSINESS_TIME period. When you select this option, columns specified as business-time begin period and end period are not available as candidates on the Columns tab/panel.</td>
</tr>
</tbody>
</table>

**PRIMARY KEYS (DB2 LUW) - COLUMNS**

From the Column dropdown, select a column for the primary key and specify a Sort option. To add more columns, click the New button and then follow the steps in the last instruction. Use the Delete button to drop columns.

**PROCEDURES WIZARD (DB2 LUW)**

Procedures are a reusable block of PL/SQL, stored in the database, that applications can call. Procedures streamline code development, debugging, and maintenance by being reusable. Procedures enhance database security by letting you write procedures granting users execution privileges to tables rather than letting them access tables directly.

**To create a new procedure using a wizard:**

1. Open a creation wizard for a procedure. For details, see "Opening an Object Wizard" on page 248.
2. Use the following topics as a guide to setting properties and performing tasks as you pass through the wizard panels:
   - Properties panel - for details, see Procedures (DB2 LUW) - Properties.
   - Advanced panel - for details, see Procedures (DB2 LUW) - Advanced.
   - Parameters panel - for details, see Procedures (DB2 LUW) - Parameters.
   - DDL View panel - for details, see "Previewing the DDL Generated to Create the New Object" on page 250.
3. Finally, use the Execute button to create the object.

**PROCEDURES (DB2 LUW) - PROPERTIES**

When creating or editing a procedure, this tab/panel lets you work with the following settings:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Schema</td>
<td>Select the owner for the procedure.</td>
</tr>
</tbody>
</table>
CREATING OBJECTS

PROCEDURES (DB2 LUW) - ADVANCED
When creating or editing a procedure, this tab/panel lets you work with the following settings:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Provide the name of the function.</td>
</tr>
<tr>
<td>Specific Name</td>
<td>Optionally, provide the unique name of the procedure.</td>
</tr>
<tr>
<td>Language</td>
<td>Select among C, JAVA, COBOL, OLE, or SQL. The database manager will call the procedure accordingly.</td>
</tr>
<tr>
<td>External Name</td>
<td>Provide the external name of the procedure.</td>
</tr>
<tr>
<td>SQL Access Level</td>
<td>Select an option: MODIFIES SQL DATA - the procedure can support any SQL statement except those that cannot be supported in procedures. CONTAINS SQL DATA - only SQL statements that neither modify nor read SQL data can be executed in the procedure. READS SQL DATA - some SQL statements that don’t modify SQL data can be included in the procedure.</td>
</tr>
<tr>
<td>Results Sets</td>
<td>Indicate the estimated upper bound of returned result sets. 0 is the default.</td>
</tr>
<tr>
<td>External Action</td>
<td>Select the External Action option.</td>
</tr>
<tr>
<td>New Save Point</td>
<td>Lets you specify a NEW SAVEPOINT LEVEL clause for the procedure.</td>
</tr>
<tr>
<td>Threadsafe</td>
<td>Specify whether the procedure is safe to run within the same process as other routines.</td>
</tr>
<tr>
<td>Fenced</td>
<td>If you select yes, you are saying you do not want the procedure to run in the manager operating system environment. This means the database management system will protect its internal resources from the procedure. This option can affect the procedure's operation. To run a procedure as not fenced, or a No selection, you must have SYSADMIN or DBADMIN privileges because of the potential to compromise data if the procedure has not been adequately tested.</td>
</tr>
<tr>
<td>Parameter Style</td>
<td>Lets you select an option: DB2DARI, DB2GENERAL, DB2SQL, GENERAL, GENERAL WITH NULLS, JAVA, and SQL. DB2GENERAL is for Java Language only. DB2SQL is for C, COBOL, or OLE Language only. GENERAL is for C Language only. GENERAL WITH NULLS is for C or COBOL Language only. JAVA is for Java Language only. SQL is for C, COBOL, or OLE Language only.</td>
</tr>
<tr>
<td>Program Type</td>
<td>MAIN: valid for C or COBOL Language and Parameter Style GENERAL, GENERAL WITH NULLS, SQL, or DB2SQL only. In this case, parameters will be passed as an argument counter or argument vector. SUBROUTINE: the procedure expects the parameters to be passed as separate arguments.</td>
</tr>
<tr>
<td>Inherit Special Registers</td>
<td>Lets you specify this optional clause dictating that the procedure will inherit initial values from the environment of the invoking statement.</td>
</tr>
</tbody>
</table>
Creating Objects

Procedures (DB2 LUW) - Parameters
For each parameter for this function, use the New button to add a new parameter, provide a name for the parameter, and in the Attributes area, select a Type, specify a Parameter Mode of INPUT, OUTPUT, or INPUT_OUTPUT, and if appropriate, the Precision, Scale, and Size options.

Sequences Wizard (DB2 LUW)
A sequence allows the automatic generation of values, something well-suited to the generation of unique key values. Sequences are not tied to particular table columns. The Sequence Wizard lets you create a sequence without knowing the underlying commands. As you complete the Sequence Wizard, Rapid SQL constructs the necessary CREATE SEQUENCE statement from the information that you have supplied. When finished, you can instruct Rapid SQL to compile the sequence on the target Rapid SQL database or to write a script file containing the CREATE SEQUENCE statement.

The Sequence Wizard lets you:
- Specify the name and owner of the sequence.
- Set both the value of the sequence, and an interval and ranges for incrementing it.
- Cache the sequence, cycle the sequence when it reaches its minimum or maximum values, and guarantee that Rapid SQL generates sequence numbers in the order of request.

**NOTE:** To create a sequence, it must belong to your schema or you need CREATE SEQUENCE privileges.

To Open the Sequence Wizard
1. On the Navigator, find the datasource where you want to add the new Sequence.
2. Expand the Schema branch, right-click Sequences, and select New.

The table that follows describes what you may encounter as you complete the Sequence Wizard:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DBINFO</td>
<td>Specific information contains such information as the database name, application ID, database code page, and so on.</td>
</tr>
<tr>
<td>Deterministic</td>
<td>Enabling this feature specifies the procedure will always return the same result for given argument values. Disabling it means there are state values that affect the results and so the same result will not always be returned when you use identical inputs to invoke the procedure.</td>
</tr>
<tr>
<td>Parameter CCSID</td>
<td>Select an encoding scheme of ASCII, UNICODE, or NONE for character or graphic string parameters.</td>
</tr>
</tbody>
</table>
CREATING OBJECTS

**SCHEMAS WIZARD (DB2 LUW)**
The Schema Wizard lets you create the structure of a database system including database objects.

**To Open the Schema Wizard**
1. On the Navigator, find the datasource where you want to add the new Schema.
2. Right-click **Schema** and select **New**.

All you need to do when the single-panel wizard opens is to give a unique name to the schema you’re creating.

**STRUCTURED TYPES WIZARD (DB2 LUW)**
The Structured Type wizard lets you create the object type specification and define attributes for a structured type. You then use the Structured Type editor to define the methods and body for the type.
To Open the Type Wizard

1. On the Navigator, find the datasource where you want to add the new Structured Type.
2. Expand the Schema branch, right-click Structured Type, and select Create.
3. Use the following topics as a guide to setting properties and performing tasks as you pass through the wizard panels:
   - Properties panel - for details, see Structured Types (DB2 LUW) - Properties.
   - Attributes panel - for details, see Structured Types (DB2 LUW) - Attributes.
   - DDL View panel - for details, see "Previewing the DDL Generated to Create the New Object" on page 250.
4. Finally, use the Execute button to create the object.

On completion, the Structured Type editor opens, letting you provide method and body specifications for the structured type. For details, see "Structured Types Editor (IBM DB2 LUW)" on page 461.

Structured Types (DB2 LUW) - Properties
When creating or editing a structured type, this tab/panel lets you work with the following settings:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Attributes</td>
<td>Instantiable - if disabled, no constructor function can be generated, nor can a non-instantiable type be used as the type of a table or view. Final Type - enabled, indicates that the structured type cannot be used as a supertype. With Function Access - If enabled, all methods of the type you are creating, and those you will create, can be accessed using functional notation. Some applications prefer functional notation over method invocation. Without Comparisons - If enabled, indicates that there are no comparison functions supported for instances of the structured type. Inline Length - Specifies the maximum size of an instance of a structured type in a column. If the size of a structured type instance is less than the defined maximum, the data is stored inline with the other values in the row. If the size of the structured type is larger than the defined maximum, the structured type data is stored outside of the table (like LOBs).</td>
</tr>
<tr>
<td>Supertype</td>
<td>Supertype Schema and Supertype Name - let you designate this structured type as a subtype by providing details of the owning supertype.</td>
</tr>
<tr>
<td>Reference</td>
<td>Cast (Source as Ref) With and Cast (Ref as Source) With - Lets you name the cast function, although one will be created with the default name of the structured type you are creating. The cast function “casts” a value between the reference type and the representation type in both directions. Reference Using, Size, Precision, and Scale - Define the built-in data type used as the underlying data type for the structured type you are creating and all its subtypes.</td>
</tr>
</tbody>
</table>
STRUCTURED TYPES (DB2 LUW) - ATTRIBUTES
For each attribute to be added to the structured type, click the New button, and provide a name for the attribute.

With an attribute selected, you can modify the Datatype. Depending on the datatype you choose you can provide the following datatype qualifiers:

- **Width** (decimal only)
- **Scale** (decimal only)
- **Size** (blob, character, clob, dbclob, graphic, varchar, vargraphic only)
- **Allow log** (blob, clob, dbclob only)
- **Allow compact** (blob, clob, dbclob only)
- **For bit data** (character, long varchar, varchar, only)

TABLES WIZARD (DB2 LUW)
The Table Wizard lets you create a table without knowing the underlying commands.

To create a new table using a wizard:
1. Open a creation wizard for a table. For details, see “Opening an Object Wizard” on page 248.
2. Use the following topics as a guide to setting properties and performing tasks as you pass through the wizard panels:
   - **Properties** panel - for details, see Tables (DB2 LUW) - Properties.
   - **Columns** panel - for details, see Tables (DB2 LUW) - Columns.
   - **Partition** panel - for details, see Tables (DB2 LUW) - Partition.
   - **Tablespaces** panel - for details, see Tables (DB2 LUW) - Tablespaces.
   - **Dimension** panel - for details, see Tables (DB2 LUW) - Dimensions.
   - **Distribution Key Columns** panel - for details, see Tables (DB2 LUW) - Distribution Key Columns.
   - **Indexes** panel - for details, see Tables (DB2 LUW) - Indexes.
   - **Temporal Properties** panel - for details, see Tables (DB2 LUW v10) - Temporal Properties.
   - **Constraints** panel - for details, see Tables (DB2 LUW) - Constraints.
   - **Comment** panel - for details, see “Adding a Comment to an Object” on page 249.
   - **Permissions** panel - “Setting Permissions or Privileges for an Object” on page 250.
   - **DDL View** panel - for details, see “Previewing the DDL Generated to Create the New Object” on page 250.
CREATING OBJECTS

3  Finally, use the **Execute** button to create the object.

**TABLES (DB2 LUW) - PROPERTIES**
When creating or editing a table, this tab/panel lets you work with the following settings:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Schema</strong></td>
<td>Select the schema that is to own the table.</td>
</tr>
<tr>
<td><strong>Name</strong></td>
<td>Provide a name for the table.</td>
</tr>
<tr>
<td><strong>Percent Free</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Lock Size</strong></td>
<td>The table-level lock prevents concurrently operating applications from using or changing a table. When scanning a table for a query, a row-level lock locks the row when it is being assessed.</td>
</tr>
<tr>
<td><strong>Append Data</strong></td>
<td>Enable or Disable appending data to the end of the table.</td>
</tr>
<tr>
<td><strong>Volatile</strong></td>
<td>Enable this feature if a table contents may fluctuate from empty to very large. The access plan will not depend on the existing statistics for that table.</td>
</tr>
<tr>
<td><strong>Compress</strong></td>
<td>Enable or disable value compression</td>
</tr>
<tr>
<td><strong>Row Compression</strong></td>
<td>Enable or disable row compression.</td>
</tr>
<tr>
<td><strong>Security Policy</strong></td>
<td>Lets you add a security policy to a table.</td>
</tr>
<tr>
<td><strong>RestrictDrop</strong></td>
<td>Corresponds to the DB2 Restrict on Drop attribute.</td>
</tr>
<tr>
<td><strong>Log Index Build</strong></td>
<td>Enables this level of logging when creating, recreating, or reorganizing an index.</td>
</tr>
<tr>
<td><strong>CCSID</strong></td>
<td>Specify ASCII or UNICODE or leave unspecified. If specified, this is the encoding scheme for string data. If unspecified, CCSID default encoding is used.</td>
</tr>
<tr>
<td><strong>Tablespace, Index Tablespace, and Long Data Tablespace</strong></td>
<td>Select a tablespace, an index tablespace, and a tablespace for Long or LOB table columns.</td>
</tr>
<tr>
<td><strong>Do not initially log</strong></td>
<td>If enabled, all changes to the table will be flushed out at commit time. This also means that if a statement fails, the unit of work will rollback. If you are concerned about recoverability, disable this feature.</td>
</tr>
<tr>
<td><strong>Data Capture</strong></td>
<td>Specify additional information logged by selecting DATACAPTURE NONE, DATA CAPTURE CHANGES, or DATA CAPTURE CHANGES INCLUDE LONGVAR.</td>
</tr>
</tbody>
</table>

**TABLES (DB2 LUW) - COLUMNS**
For each column in the table, click the **New** button to create a column and provide a name for the column. Then, in the **Column Attributes** area, provide details for the column.

Use the **Delete** button to drop a selected column.

**Row Properties** (V10) settings are available when you select a **Type** of TIMESTAMP. These settings are used in conjunction with settings on the **Temporal Properties** tab in setting up system and application temporal tables. For more information, see "**Tables (DB2 LUW v10) - Temporal Properties**" on page 272.
Specific settings are:

- **As Row Begin** - adds a GENERATED ALWAYS AS ROW BEGIN option to the column specification, used to track when a row is current.

- **As Row End** - adds a GENERATED ALWAYS AS ROW END option to the column specification.

- **Transaction Start ID** - adds a GENERATED ALWAYS AS TRANSACTION START ID option to the column specification indicating that this column captures the start times for transactions that affect rows.

A column can have only one of the three settings selected.

When you select a **Row Properties** setting, the **Scale** value and if appropriate, the **Allow Nulls**, **Default Value**, and **Expression** settings are automatically adjusted for compatibility with row generation. Similarly, if one of the three **Row Properties** settings is selected for a column, and any of the **Scale**, **Allow Nulls**, **Default Value**, or **Expression** settings are modified, then the selected **Row Properties** setting is cleared.

**TABLES (DB2 LUW) - PARTITION**
Under **Partition Columns**, for each partition column, click the **New** button and then choose a column name from the dropdown. To add a **Data Partition**, click the **New** button to open a dialog that lets you add a partition.

**TABLES (DB2 LUW) - TABLESPACES**
For each Data Tablespace or Long Tablespace, click the **New** button and then choose a tablespace from the dropdown. To specify an Index Tablespace, select a tablespace from the dropdown.

**TABLES (DB2 LUW) - DIMENSIONS**
For each column that is to make up a dimension, click the **New** button to open a dialog that lets you add a column.

**TABLES (DB2 LUW) - DISTRIBUTION KEY COLUMNS**
For each column that is to make up the distribution key, click the **New** button and then select a column from the dropdown.

**TABLES (DB2 LUW) - INDEXES**
Click **Add** to open the Index wizard. For more information, see "**Indexes Wizard (DB2 LUW)**" on page 259.
TABLES (DB2 LUW v10) - TEMPORAL PROPERTIES

This tab/panel lets you specify temporal properties to a table, designating it as a table that records the period of time when a row is valid.

**NOTE:** Before using this object action, consult DB2 LUW documentation for details on setup and use of the temporal tables feature. For more information, see "Accessing Third Party Documentation" on page 21.

This tab/panel has the following controls:

- **System-time table** - selecting this option creates a table with the PERIOD SYSTEM_TIME clause, designating it as a system-period temporal table. This option is available if the table has three columns of type TIMESTAMP, and the following prerequisites have been met:
  - At least one TIMESTAMP-typed column has the As Row Begin property selected
  - At least one TIMESTAMP-typed column has the As Row End property selected
  - At least one TIMESTAMP-typed column has the Transaction Start ID property selected

  For details on column definitions, see "Tables (DB2 LUW) - Columns" on page 270.

  The Row-begin column, Row-end column, and Transaction Start ID column controls are automatically populated with the columns having the corresponding property.

  When you select this option, in the generated DDL, the Row-begin column and Row-end column values are used as the PERIOD SYSTEM_TIME column parameters, defining the system period.

- **Business-time table** - selecting this option creates a table with the PERIOD BUSINESS_TIME clause, designating it as an application-period temporal table. This option is available if the table has two columns of type DATE or TIMESTAMP, for which no Row Properties have been assigned.

  The Begin column and End Column controls are automatically populated with the valid candidate columns from the table’s column list and the first distinct column pair is automatically chosen for convenience.

- **Use history table** - this set of controls is only active when Business-time table is selected. It lets you associate a history table. When you select Use history table, the Owner and Name controls are activated, letting you identify the history table to associate with this table.

  Note that a constraint created on a business-time table can enforce the uniqueness of the data for any point in business time via the Time period policy property that has been added in the constraint wizards. For details, see the following topics:

  - "Primary Keys (DB2 LUW) - Properties" on page 263
  - "Unique Keys (DB2 LUW) - Properties" on page 276

TABLES (DB2 LUW) - CONSTRAINTS

Selecting a constraint type and clicking Add opens the object wizard for that object type. For details see:
TABLESPACES WIZARD (DB2 LUW)
Tablespaces establish connections between the physical storage devices of your database system and the logical containers or tables being used to store data. In essence, a tablespace is a storage structure that can hold tables, indexes, large objects, and long data. The Tablespace Wizard lets you create a tablespace without knowing the underlying commands.

To create a new tablespace using a wizard:
1. Open a creation wizard for a tablespace. For details, see "Opening an Object Wizard" on page 248.
2. Use the following topics as a guide to setting properties and performing tasks as you pass through the wizard panels:
   - Properties panel - for details, see Tablespace (DB2 LUW) - Properties.
   - Container panel - for details, see Tablespace (DB2 LUW) - Container.
   - Comment panel - for details, see "Adding a Comment to an Object" on page 249.
   - Permissions panel - "Setting Permissions or Privileges for an Object" on page 250.
   - DDL View panel - for details, see "Previewing the DDL Generated to Create the New Object" on page 250.
3. Finally, use the Execute button to create the object.

TABLESPACES (DB2 LUW) - PROPERTIES
When creating or editing a tablespace, this tab/panel lets you work with the following settings:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tablespace properties</td>
<td>Type - Select REGULAR, LARGE, TEMPORARY, or USER TEMPORARY. Use Automatic Storage and Managed By let you specify whether storage is managed automatically, by the database, or by the system. Database Partition Group - lets you select a database partition group. Buffer Pool - lets you select a buffer pool. Drop Recovery - For REGULAR type tablespaces, lets you enable/disable drop recovery.</td>
</tr>
<tr>
<td>Performance properties</td>
<td>This group lets you specify or select the Page Size, Extent Size, Prefetch Automatic, Prefetch Size, Overhead, Transfer Rate, and File System Caching properties.</td>
</tr>
<tr>
<td>Automatic Storage properties</td>
<td>This group lets you specify or select the AutoResize, Initial Size, Increase Size, Max Size Unlimited, and Max Size attributes.</td>
</tr>
</tbody>
</table>
TABLESPACES (DB2 LUW) - CONTAINER
For each container in the tablespace, in the Container Properties area, provide the following container properties: Database Partitions, Type (FILE or DEVICE), Name, and Size, and then click the New button.

Use the Delete button to drop a selected container.

TRIGGERS WIZARD (DB2 LUW)
A trigger defines a set of actions that take place in conjunction with, or are triggered, for a particular base table, with an insert, update, or delete statement. Triggers are dandy ways to validate input data, read from other tables for cross-referencing purposes, and other similar purposes. The Trigger Wizard lets you create a trigger without requiring you to know any of the underlying commands.

To create a new trigger using a wizard:
1. Open a creation wizard for a trigger. For details, see "Opening an Object Wizard" on page 248.
2. Use the following topics as a guide to setting properties and performing tasks as you pass through the wizard panels:
   - Properties panel - for details, see Triggers (DB2 LUW) - Properties.
   - Column Selection panel - for details, see Triggers (DB2 LUW) - Column Selection.
   - Definition panel - for details, see Triggers (DB2 LUW) - Definition.
3. Finally, use the Execute button to create the object.

TRIGGERS (DB2 LUW) - PROPERTIES
When creating or editing a trigger, this tab/panel lets you work with the following settings:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table Schema and Table Name</td>
<td>Choose the owner and name of the table for which the trigger is being created.</td>
</tr>
<tr>
<td>Schema and Name</td>
<td>Choose the owner and name of the trigger being created.</td>
</tr>
</tbody>
</table>
| Trigger Timing       | BEFORE: These triggers serve as extensions to the constraint subsystem and are most often used to validate input data, generate values for newly inserted rows, and read from other tables for cross-reference purposes. Note: Before triggers must be created as a For Each Row.  
AFTER: Such a trigger is run after the integrity constraint validations; they can be used to modify operations in the database or be used for activities beyond the database, like supporting an alert notification. |
| Trigger Events       | An INSERT trigger must be associated with an INSERT statement. For example, if a data load operation doesn’t include an INSERT statement, the trigger will not be invoked.  
An UPDATE trigger can be associated with specific columns of the base table and will only be activated if those columns are updated. |
CREATING OBJECTS

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Trigger Type</td>
<td><strong>STATEMENT</strong>: (only fires once).</td>
</tr>
<tr>
<td></td>
<td><strong>ROW</strong> (fires for each affected row): The trigger runs as many times as</td>
</tr>
<tr>
<td></td>
<td>there are rows in the affected section. If the set of affected rows is</td>
</tr>
<tr>
<td></td>
<td>empty, the trigger doesn’t run.</td>
</tr>
<tr>
<td>Old Table Alias</td>
<td>Type the name of a temporary table of rows as they exist before they’re</td>
</tr>
<tr>
<td></td>
<td>updated or deleted.</td>
</tr>
<tr>
<td>New Table Alias</td>
<td>Type a name for a temporary table of rows as they exist after they’re</td>
</tr>
<tr>
<td></td>
<td>inserted or updated.</td>
</tr>
<tr>
<td>Old Row Alias</td>
<td>Type a name for the rows as they are before they’ve been deleted or</td>
</tr>
<tr>
<td></td>
<td>updated.</td>
</tr>
<tr>
<td>New Row Alias</td>
<td>Type a name for the rows as they are after they’ve been inserted or</td>
</tr>
<tr>
<td></td>
<td>updated.</td>
</tr>
</tbody>
</table>

**TRIGGERS (DB2 LUW) - COLUMN SELECTION**
If you chose UPDATE as the **Trigger Event**, select the columns, select the check box beside each column that is to fire the trigger.

**TRIGGERS (DB2 LUW) - DEFINITION**
Complete the CREATE TRIGGER outline provided by typing or pasting the body of the trigger.

**UNIQUE KEYS WIZARD (DB2 LUW)**
A unique key constraint is a key for which no two of its values can be equal and no values can be null. A table can have a number of unique constraints, but it cannot have more than one unique constraint on the same set of columns. If you are creating a unique key constraint on a table that already exists (as opposed to creating a unique key at the time the table is first generated), a unique index must already exist on the columns of the unique key you want to constrain. If no unique index exists, the Index Wizard will open as you complete the **Create Unique Key Constraint** dialog.

**To create a new unique key using a wizard:**
1. Open a creation wizard for a unique key. For details, see "Opening an Object Wizard" on page 248.
2. Use the following topics as a guide to setting properties and performing tasks as you pass through the wizard panels:
   - Properties panel - for details, see **Unique Keys (DB2 LUW) - Properties**.
   - Columns panel - for details, see **Unique Keys (DB2 LUW) - Columns**.
   - Comment panel - for details, see "Adding a Comment to an Object" on page 249.
   - DDL View panel - for details, see "Previewing the DDL Generated to Create the New Object" on page 250.
3. Finally, use the **Execute** button to create the object.
UNIQUE KEYS (DB2 LUW) - PROPERTIES
When creating or editing a unique key, this tab/panel lets you work with the following settings:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table Schema and Table Name</td>
<td>Choose the owner and name of the table in which the unique key is being created.</td>
</tr>
<tr>
<td>Name</td>
<td>Provide a name for the unique key being created.</td>
</tr>
<tr>
<td>Time period policy</td>
<td>This setting is for use with tables set up as business-time tables. For more information, see &quot;Tables (DB2 LUW v10) - Temporal Properties&quot; on page 272. When selected, a BUSINESS_TIME WITHOUT OVERLAPS option is specified against the column or columns defining the constraint, in the generated DDL. This ensures that values for the constraint columns are unique with respect to the time for the BUSINESS_TIME period. When you select this option, columns specified as business-time begin period and end period are not available as candidates on the Columns tab/panel.</td>
</tr>
</tbody>
</table>

UNIQUE KEYS (DB2 LUW) - COLUMNS
From the Column dropdown, select a column for the primary key and specify a Sort option. To add more columns, click the New button and then follow the steps in the last instruction. Use the Delete button to drop columns.

USER DATATYPES (DB2 LUW)
User defined datatypes allow column definitions to be consistent across a database. They let you associate frequently used datatype information to be associated with a specified function and take advantage of performance features available to built-in datatypes including indexing and parallel database queries.

To create a new user datatype using a wizard:
1. Open a creation wizard for a user datatype. For details, see "Opening an Object Wizard" on page 248.
2. Use the following topics as a guide to setting properties and performing tasks as you pass through the wizard panels:
   - Properties panel - for details, see User Datatypes (DB2 LUW) - Properties.
   - Comment panel - for details, see "Adding a Comment to an Object" on page 249.
   - DDL View panel - for details, see "Previewing the DDL Generated to Create the New Object" on page 250.
3. Finally, use the Execute button to create the object.
USER DATATYPES (DB2 LUW) - PROPERTIES
When creating or editing a user datatype, this tab/panel lets you work with the following settings:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Owner</td>
<td>Select the owner of the user datatype.</td>
</tr>
<tr>
<td>Datatype</td>
<td>Provide a name for the datatype.</td>
</tr>
<tr>
<td>Type</td>
<td>Select the base datatype.</td>
</tr>
<tr>
<td>Size</td>
<td>Provide the size of the datatype.</td>
</tr>
<tr>
<td>Allow Bit Data</td>
<td>The option is only available for certain datatypes. A check means you want to store the data in a bit format.</td>
</tr>
</tbody>
</table>

USERS WIZARD (DB2 LUW)
Users have authorization to use a database and its objects, and the User Wizard gives you an easy way to add new ones.

To create a new user using a wizard:
1. Open a creation wizard for a user. For details, see "Opening an Object Wizard" on page 248.
2. Use the following topics as a guide to setting properties and performing tasks as you pass through the wizard panels:
   - **Properties** panel - for details, see Users (DB2 LUW) - Properties.
   - **Object Permissions** and **System Permissions** panels - "Setting Permissions or Privileges for an Object" on page 250
   - **DDL View** panel - for details, see "Previewing the DDL Generated to Create the New Object" on page 250.
3. Finally, use the **Execute** button to create the object.

USERS (DB2 LUW) - PROPERTIES
When creating or editing a user datatype, this tab/panel lets you provide the user **Name**.

VIEWS WIZARD (DB2 LUW)
A view gives you an alternative way to look at data in one or more tables. You can customize how you see a table’s contents.
To create a new view using a wizard:

1. Open a creation wizard for a view. For details, see "Opening an Object Wizard" on page 248.

2. Use the following topics as a guide to setting properties and performing tasks as you pass through the wizard panels:
   - **Properties** panel - for details, see Views (DB2 LUW) - Properties.
   - **Definition** panel - for details, see Views (DB2 LUW) - Definition.

3. Finally, use the Execute button to create the object.

### Views (DB2 LUW) - Properties
When creating or editing a view, this tab/panel lets you work with the following settings:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Schema</td>
<td>Select the owner of the view. The owner of the view must have SELECT privileges for the tables in the CREATE view statement or DBADM authority on the database that contains the table.</td>
</tr>
<tr>
<td>Name</td>
<td>Provide a name for the view.</td>
</tr>
<tr>
<td>Check Type</td>
<td><strong>CHECK_NONE</strong> - No search conditions must be satisfied for insert or update operations. <strong>CHECK_LOCAL</strong> - Update and insert operations on view must satisfy the search conditions of the view and underlying views that are defined with a check option. Furthermore, every updatable view that is directly or indirectly defined on view inherits those search conditions (the search conditions of view and all underlying views of that are defined with a check option) as a constraint on insert or update operations. <strong>CHECK_CASCADED</strong> - Update and insert operations on the view must satisfy the search conditions of view and all underlying views, regardless of whether the underlying views were defined with a check option. Furthermore, every updatable view that is directly or indirectly defined on view inherits those search conditions (the search conditions of view and all underlying views) as a constraint on insert or update operations.</td>
</tr>
</tbody>
</table>

### Views (DB2 LUW) - Definition
Complete the CREATE VIEW statement by typing or pasting in the relevant query.

### IBM DB2 for z/OS Object Wizards
Rapid SQL lets you create DB2 OS390 objects using the following wizards:

- Aliases Wizard (DB2 Z/OS)
- Databases Wizard (DB2 Z/OS)
- Foreign Keys Wizard (DB2 Z/OS)
- Functions Wizard (DB2 Z/OS)
CREATE SYNONYM

ALIASES WIZARD (DB2 Z/OS)

An alias offers you security and convenience so that you can refer to an object without revealing who owns it or what database it belongs to. You can create aliases for tables or views. The Alias Wizard lets you create an alias without knowing the underlying commands. As you complete the Alias Wizard process, Rapid SQL constructs the necessary CREATE ALIAS statement based on the information that you supply. To create an alias, you must have CREATE ALIAS privileges or sysadmin or sysctrl authority.

To create a new alias using a wizard:
1. Open a creation wizard for an alias. For details, see "Opening an Object Wizard" on page 248.
2. Use the following topics as a guide to setting properties and performing tasks as you pass through the wizard panels:
   - Properties panel - for details, see Aliases (DB2 z/OS) - Properties.
   - DDL View panel - for details, see "Previewing the DDL Generated to Create the New Object" on page 250.
3. Finally, use the Execute button to create the object.
CREATING OBJECTS

ALIASES (DB2 Z/OS) - PROPERTIES
When creating or editing a view, this tab/panel lets you work with the following settings:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Schema</td>
<td>Select the schema that is to own the alias.</td>
</tr>
<tr>
<td>Name</td>
<td>Provide a name for the alias.</td>
</tr>
<tr>
<td>Target Owner</td>
<td>Select the owner of the object to which you are creating an alias.</td>
</tr>
<tr>
<td>Target Type</td>
<td>Select the type of object (TABLE, VIEW) to which you are creating an alias.</td>
</tr>
<tr>
<td>Target Name</td>
<td>Select the specific object to which you are creating an alias.</td>
</tr>
</tbody>
</table>

DATABASES WIZARD (DB2 Z/OS)
The Database Wizard lets you create a database (a structured collection of data that can be updated or queried) without knowing the underlying commands. Databases can be simple, that is one file with many records and the same fields, or much more complicated with multiple files with different fields.

To create a new database using a wizard:
1. Open a creation wizard for a database. For details, see "Opening an Object Wizard" on page 248.
2. Use the following topics as a guide to setting properties and performing tasks as you pass through the wizard panels:
   - Properties panel - for details, see Databases (DB2 z/OS) - Properties.
   - Permissions panel - for details, see "Setting Permissions or Privileges for an Object" on page 250.
   - DDL View panel - for details, see "Previewing the DDL Generated to Create the New Object" on page 250.
3. Finally, use the Execute button to create the object.

DATABASES (DB2 Z/OS) - PROPERTIES
When creating or editing a database, this tab/panel lets you work with the following settings:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Provide a unique name for the database.</td>
</tr>
<tr>
<td>Type</td>
<td>Workfile: This option in only available if the server is configured in IBM DB2 for OS/390 and z/OS to allow sharing. For more information, contact your System administrator. Temp: This option indicates the database is only for declared temporary tables. A temp database cannot be shared.</td>
</tr>
<tr>
<td>Group Member</td>
<td>Specifies the member for which this database is being created. Use this only in a shared environment.</td>
</tr>
</tbody>
</table>
Creating Objects

Foreign Keys Wizard (DB2 Z/OS)

Foreign keys are unique values that refer to specific columns of other tables. Thus, a foreign key links two tables together. Embarcadero Rapid SQL’s Foreign Key Wizard makes it easy for you to create a relational link between two tables, thereby speeding queries and giving you faster access to data. The Foreign Key Wizard lets you create a foreign key without knowing the underlying commands.

**To create a new foreign key using a wizard:**

1. Open a creation wizard for a foreign key. For details, see "Opening an Object Wizard" on page 248.

2. Use the following topics as a guide to setting properties and performing tasks as you pass through the wizard panels:
   - **Properties** panel - for details, see Foreign Keys (DB2 z/OS) - Properties.
   - **Column Mapping** panel - for details, see Foreign Keys (DB2 z/OS) - Column Mapping.
   - **DDL View** panel - for details, see "Previewing the DDL Generated to Create the New Object" on page 250.

3. Finally, use the Execute button to create the object.

Foreign Keys (DB2 Z/OS) - Properties

When creating or editing a foreign key, this tab/panel lets you work with the following settings:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table Schema</td>
<td>Select the owner of the referencing, or child, table.</td>
</tr>
<tr>
<td>Table Name</td>
<td>Select the name of the referencing, or child, table.</td>
</tr>
<tr>
<td>Name</td>
<td>If you do not want to use the system-generated name, provide a new one.</td>
</tr>
<tr>
<td>Delete Rule</td>
<td>Select the action to be taken (NO ACTION, RESTRICT, CASCADE, or SET NULL) when a row of the referenced, or parent, table is deleted.</td>
</tr>
</tbody>
</table>
FOREIGN KEYS (DB2 z/OS) - COLUMN MAPPING

Under **Referenced Table**, choose the **Owner** and then the **Name** of the referenced, or parent, table.

Under the **Main Table**, select check boxes corresponding to the columns that are to reference columns in the referenced table. Then, under **Referenced Table**, select the corresponding column check boxes.

FUNCTIONS WIZARD (DB2 Z/OS)

To create a relationship between one set of values and another, Rapid SQL offers the Function Wizard. You can develop reusable subroutines so you can control, access, and manipulate the data that underlies an object. As you complete the Function Wizard process, Rapid SQL constructs the necessary CREATE FUNCTION statement based on the information that you supply.

**NOTE:** To create a user-defined function, you need CREATE ANY privileges or IMPLICIT_SCHEMA authority on the database if the schema does not already exist.

To create a new function using a wizard:

1. Open a creation wizard for a function. For details, see "Opening an Object Wizard" on page 248.

2. Use the following topics as a guide to setting properties and performing tasks as you pass through the wizard panels:
   - **Properties** panel - for details, see Functions (DB2 z/OS) - Properties.
   - **Source** panel - (Only available for a Function Type of SOURCED) for details, see Functions (DB2 z/OS) - Source.
   - **Parameters** panel - for details, see Functions (DB2 z/OS) - Parameters.
   - **Return Scalar** panel - for details, see Functions (DB2 z/OS) - Return Scalar.
   - **Return Columns** panel - (Only available when you choose a Function Type of EXTERNAL TABLE) for details, see Functions (DB2 z/OS) - Return Columns.
   - **Body** panel - for details, see Functions (DB2 z/OS) - Body.
   - **DDL View** panel - for details, see "Previewing the DDL Generated to Create the New Object" on page 250.

3. Finally, use the **Execute** button to create the object.
FUNCTIONS (DB2 z/OS) - PROPERTIES

When creating or editing a function, this tab/panel lets you work with the following settings:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Schema, Name, and Specific Name</strong></td>
<td>Select the owner of the function, provide a name for the function, and provide the Specific name to be used by some SQL statements and DB2 commands for this function.</td>
</tr>
</tbody>
</table>
| **Function Type**            | External Scalar: This allows you to extend the function by adding your own or another party’s definition for the function.  
                                | External Table: Use this to create a function that is written in ASSEMBLE, C, COBOL, or PLI to return a table after it is deployed.  
                                | Sourced: Here you are creating a function that is based on an existing scalar or table function with an application server.  
                                | SQL: This type of function returns a single value when the function is invoked if the SQL statement that defines it is valid. |
| **Language**                 | If you chose a Function Type of EXTERNAL SCALAR or EXTERNAL TABLE, specify a language of ASSEMBLE, C, COBOL, or PLI. |
| **Return Type**              | Identifies the return type of the function.                                                                                                                                               |
| **External Name**            | Provide the External Name of the function.                                                                                                                                                 |
| **SQL Access Level**         | Indicates whether the function can execute SQL statements.  
                                | CONTAINS SQL: Statements that don’t read or modify SQL can be executed.  
                                | NO SQL: No SQL statements can be executed.  
                                | READS SQL: Statements that cannot modify SQL can be executed. |
| **WLM Environment**          | Specify a Workload Management Environment (Required if Language is JAVA/COMPJAVA/REXX, the Procedure contains a LOB parameter, Security is set to ‘USER’ or ‘DEFINER’, or program type is ‘SUB’). |
| **WLM For Nested**           | Self-explanatory                                                                                                                                                                             |

FUNCTIONS (DB2 z/OS) - SOURCE

**NOTE:** Only available for a Function Type of SOURCED.

Select the Schema, Name, and Specific Name of the source function.

FUNCTIONS (DB2 z/OS) - PARAMETERS

For each parameter for this function, use the New button to add a new parameter, provide a name for the parameter, and in the Attributes area, select a Type, and if appropriate, the Precision, Scale, Size, and As Locator options.

FUNCTIONS (DB2 z/OS) - RETURN SCALAR

Under Return Datatype, select a Type and depending on your choice, provide or select Precision, Scale, Size, and As Locator options.

To make use of a CAST FROM clause, under Cast Datatype set Enabled to True, select a Type, and if appropriate, the Scale, Size, and As Locator options.
FUNCTIONS (DB2 z/OS) - RETURN COLUMNS

**NOTE:** Only available when you choose a Function Type of EXTERNAL TABLE.

For each column returned by this function, use the New button to add a new parameter, provide a name for the parameter, and in the Attributes area, select a Type, and if appropriate, the Precision, Scale, Size, and As Locator options.

FUNCTIONS (DB2 z/OS) - BODY
Enter the return statement for the function.

INDEXES WIZARD (DB2 Z/OS)
Like the index in a book, a database index makes it easier for you to access information quickly. An index lists the location of rows, sorted by the contents of one or more columns.

To create a new index using a wizard:
1. Open a creation wizard for an index. For details, see “Opening an Object Wizard” on page 248.
2. Use the following topics as a guide to setting properties and performing tasks as you pass through the wizard panels:
   - Properties panel - for details, see Indexes (DB2 z/OS) - Properties
   - Columns panel - for details, see Indexes (DB2 z/OS) - Columns
   - Indexes panel - for details, see Indexes (DB2 z/OS) - Storage
   - Partitions panel - for details, see Indexes (DB2 z/OS) - Partitions
   - Comment panel - for details, see “Adding a Comment to an Object” on page 249.
   - DDL View panel - for details, see “Previewing the DDL Generated to Create the New Object” on page 250.
3. Finally, use the Execute button to create the object.

INDEXES (DB2 z/OS) - PROPERTIES
When creating or editing an index, this tab/panel lets you work with the following settings:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table Schema and</td>
<td>Choose the owner and name of the table in which the index is being created.</td>
</tr>
<tr>
<td>Table Name</td>
<td></td>
</tr>
<tr>
<td>Schema and Name</td>
<td>Choose the owner and name of the index being created.</td>
</tr>
</tbody>
</table>
The actions you take on this tab/panel depend on whether you set the Index on Expression check box on the Properties panel. For more information, see "Indexes (DB2 z/OS) - Properties" on page 284.

- If Index on Expression is disabled:

  From the Column dropdown, select a column for the index and specify a Sort option.

  **NOTE:** If you want to use the RANDOM sort option, you must first set the Padded check box on the Properties tab/panel.

- If Index on Expression is enabled:

  Enter a valid key-expression in the Expression field and choose a Sort order.

To add more columns/key-expressions, click the New button and then follow the steps in the last instruction. Use the Delete button to drop columns.
INDEXES (DB2 Z/OS) - STORAGE
This tab/panel lets you perform the following tasks:

- Select a dataset management scheme
- Provide associated attribute values

To select a data set management scheme:

1. Click the Edit button. The Data Set Management dialog opens.
2. Set one of the following data set management options:
   - DB2 will define and manage the data sets on a volume of the default storage group of the database
   - DB2 will define and manage the data sets on a volume of the specified storage group - Select a storage group (a storage group is made up of disk device volumes): Each data set will be defined on a volume listed in the storage group you select.

Minimum primary space allocation: 12 kilobytes is the default.
Minimum secondary space allocation: 12 kilobytes is the default.

NOTE: If the primary and (118 x) secondary space allocations combine to be greater than 2 gigabytes, more than one data set may eventually be used.

Erase data sets when index dropped? If choose this option, DB2 will overwrite all data with zeros before they are deleted as a security measure.

- User will manage the data sets on a specified VCAT catalog-name - Enter or select the VCAT. Do not select this option for an index on a declared temporary table.
3. Click OK.

In addition to the attributes specific to your data set management choice, this tab/panel also offers the following settings:

| Free Page | One free page exists for every x pages. The x specifies how often to leave a page of free space when index entries are created from executing a DB2 utility or creating an index for a table with pre-existing rows. (0-255) |
| Percent Free | The percentage of free space you want to leave in every page when entries are added to an existing index. The default is 10%. |
| GBP Cache | This option is available only in a data-sharing environment. | ALL: As pages are read, all of them will be cached in the group buffer pool. | CHANGED: Updated pages are cached to the group buffer pool. | NONE: No pages will be cached. |

INDEXES (DB2 Z/OS) - PARTITIONS
Displays the default settings for the number of partitions you specified on the Properties pane. Select a partition and click the Edit button to modify details for that partition.
PLANS WIZARD (DB2 Z/OS)

A plan, also known as the application plan, is a control structure that is used to process the SQL statements DB2 encounters when it is executing those SQL statements. The Plan Wizard, really, the Bind Plan Wizard, creates the structure that is used in the bind process—the process by which the output from the SQL precompiler is converted into usable form. Some authorization checking is necessary.

To Open the Bind Plan Wizard

1. On the Navigator, find the database where you want to add the new bind plan.
2. On the Plan branch, right-click and select Create.

The Bind Plan Wizard lets you set plan parameters, add packages, and set bind properties. The table below describes the options and functionality on the Bind Plan wizard:

<table>
<thead>
<tr>
<th>Panel</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Plan Name: Lets you select the plan name.</td>
</tr>
<tr>
<td></td>
<td>Qualifier: OPTIONAL: Lets you select a qualifier, the plan creator.</td>
</tr>
<tr>
<td></td>
<td>Action: OPTIONAL: Lets you select an action.</td>
</tr>
<tr>
<td></td>
<td>Sql Rules: OPTIONAL: Determines whether you can execute a type 2 CONNECT statement to an existing SQL connection, according to DB2 rules. Lets you select DB2 or STD.</td>
</tr>
<tr>
<td></td>
<td>Cache Size: OPTIONAL: Lets you select or type the cachesize in bytes, the authorization cache acquired in the EDM pool for the plan. At run time, the authorization cache stores user IDs authorized to run. Consulting the cache can avoid a catalog lookup for checking authorization to run the plan.</td>
</tr>
<tr>
<td></td>
<td>Plan Owner: OPTIONAL: Determines the authorization ID of the owner of the plan.</td>
</tr>
<tr>
<td></td>
<td>Current Server: OPTIONAL: Determines the location to connect to before running the plan.</td>
</tr>
<tr>
<td></td>
<td>Resource Acquire: OPTIONAL: Use - Acquires table space locks only when first used by a bound application program. Allocate - Acquires all table space locks when the plan is allocated. The value has no effect on dynamic SQL statements, which always use ACQUIRE(USE).</td>
</tr>
<tr>
<td></td>
<td>Disconnect: OPTIONAL: Determines which remote connections to destroy during commit operations. The option applies to any application process that uses the plan and has remote connections of any type. Regardless of the value of this option, a commit operation destroys all connections in the release pending state. Explicit - Destroy only connections in the release pending state. This value allows you maximum flexibility for controlling remote connections. Automatic - Destroy all remote connections. Conditional - Destroy all remote connections unless an open cursor defined as WITH HOLD is associated with the connection.</td>
</tr>
<tr>
<td>2</td>
<td>Lets you select the Member Name, PDS Name (partitioned data set) and click Add to enter each member and PDS name.</td>
</tr>
<tr>
<td>3</td>
<td>Lets you select the Location to connect to, the Collection (location of the DBMS where the plan binds and where the description of the plan resides.) and a Package.</td>
</tr>
<tr>
<td>Panel</td>
<td>Settings and tasks</td>
</tr>
<tr>
<td>-------</td>
<td>-------------------</td>
</tr>
<tr>
<td>4</td>
<td>Isolation</td>
</tr>
<tr>
<td></td>
<td>Keep Dynamic</td>
</tr>
<tr>
<td></td>
<td>Current Data</td>
</tr>
<tr>
<td></td>
<td>Degree</td>
</tr>
<tr>
<td></td>
<td>Dynamic Rules</td>
</tr>
<tr>
<td></td>
<td>Release</td>
</tr>
<tr>
<td></td>
<td>Validate</td>
</tr>
<tr>
<td>5</td>
<td>Explain</td>
</tr>
<tr>
<td></td>
<td>Reopt(VARS)</td>
</tr>
<tr>
<td></td>
<td>Prepare</td>
</tr>
<tr>
<td></td>
<td>ImmedWrite</td>
</tr>
<tr>
<td></td>
<td>Opthint</td>
</tr>
<tr>
<td></td>
<td>Encoding</td>
</tr>
<tr>
<td></td>
<td>Path</td>
</tr>
<tr>
<td></td>
<td>Flag</td>
</tr>
</tbody>
</table>
Creating Objects

Primary Keys Wizard (DB2 Z/OS)

A primary key is a unique key that is part of a table's definition. There can be only one primary key for each table, and the columns contained in a primary key cannot have null values. A primary key constraint forbids duplicate values in one or more columns. A table with a primary key will be considered the parent table to a table with a foreign key, which becomes the dependent table.

**NOTE:** A nullable column cannot be a part of a primary key.

To create a new primary key using a wizard:

1. Open a creation wizard for a primary key. For details, see "Opening an Object Wizard" on page 248.

2. Use the following topics as a guide to setting properties and performing tasks as you pass through the wizard panels:

   • **Properties** panel - for details, see Primary Keys (DB2 z/OS) - Properties.
   
   • **Columns** panel - for details, see Primary Keys (DB2 z/OS) - Columns.
   
   • **Storage** panel - for details, see Primary Keys - Storage - Edit button (manage datasets) and Primary Keys (DB2 z/OS) - Storage - Attributes.
   
   • **Partitions** panel - for details, see Primary Keys (DB2 z/OS) - Partitions.
   
   • **Comment** panel - for details, see "Adding a Comment to an Object" on page 249.
   
   • **DDL View** panel - for details, see "Previewing the DDL Generated to Create the New Object" on page 250.

3. Finally, use the **Execute** button to create the object.

Primary Keys (DB2 Z/OS) - Properties

When creating or editing a primary key, this tab/panel lets you work with the following settings:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table Schema and Table Name</td>
<td>Choose the owner and name of the table in which the index is being created.</td>
</tr>
<tr>
<td>Schema and Name</td>
<td>Choose the owner and name of the index being created.</td>
</tr>
<tr>
<td>Clustered</td>
<td>Enable or disable clustering.</td>
</tr>
<tr>
<td>Number of Partitions</td>
<td>If you enabled Clustering, specify the number of partitions.</td>
</tr>
<tr>
<td>Buffer Pool</td>
<td>Provide the buffer pool in which this index should reside</td>
</tr>
</tbody>
</table>
### Creating Objects

**Creating Objects**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Defer, Close, Copy, and Define</td>
<td>Enable or disable these DB2 options as required.</td>
</tr>
<tr>
<td><strong>Piece Size</strong></td>
<td>The maximum addressability of the dataset for a non-partitioned index.</td>
</tr>
</tbody>
</table>
| **Time period policy**  | This setting is for use with tables set up as business-time tables. For more information, see "Tables (DB2 z/OS v10) - Temporal Properties" on page 296.  
When selected, a BUSINESS_TIME WITHOUT OVERLAPS option is specified against the column or columns defining the constraint, in the generated DDL. This ensures that values for the constraint columns are unique with respect to the time for the BUSINESS_TIME period. 
When you select this option, columns specified as business-time begin period and end period are not available as candidates on the Columns tab/panel. |

### Primary Keys (DB2 z/OS) - Columns

From the Column dropdown, select a column for the primary key and specify a Sort option. To add more columns, click the New button and then follow the steps in the last instruction. Use the Delete button to drop columns.

### Primary Keys - Storage - Edit Button (Manage Datasets)

**NOTE:** Availability differs according to the dataset management options you chose

Choose a data set management option:

**DB2 will define and manage the data sets on a volume of the default storage group of the database**

**DB2 will define and manage the data sets on a volume of the specified storage group**

Select a storage group (a storage group is made up of disk device volumes): Each data set will be defined on a volume listed in the storage group you select.

**Minimum primary space allocation:** 12 kilobytes is the default.

**Minimum secondary space allocation:** 12 kilobytes is the default.

**NOTE:** If the primary and (118 x) secondary space allocations combine to be greater than 2 gigabytes, more than one data set may eventually be used.

**Erase data sets when index dropped?** If you choose this option, DB2 will overwrite all data with zeros before they are deleted as a security measure.

**User will manage the data sets on a specified VCAT catalog-name** Enter or select the VCAT. Do not select this option for an index on a declared temporary table.
**PRIMARY KEYS (DB2 z/OS) - STORAGE - ATTRIBUTES**

When creating or editing a primary key, this tab/panel lets you work with the following settings:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Storage Group, Primary Space Allocation, Secondary Space Allocation, Erase, and VCAT catalog</td>
<td>The ability to set these options depends on the dataset management options you chose.</td>
</tr>
<tr>
<td>Free Page</td>
<td>One free page exists for every x pages. The x specifies how often to leave a page of free space when index entries are created from executing a DB2 utility or creating an index for a table with pre-existing rows. (0-255)</td>
</tr>
<tr>
<td>Percent Free</td>
<td>The percentage of free space you want to leave in every page when entries are added to an existing index. The default is 10%.</td>
</tr>
<tr>
<td>GBP Cache</td>
<td>This option is available only in a data-sharing environment. ALL: As pages are read, all of them will be cached in the group buffer pool. CHANGED: Updated pages are cached to the group buffer pool. NONE: No pages will be cached.</td>
</tr>
</tbody>
</table>

**PRIMARY KEYS (DB2 z/OS) - PARTITIONS**

Displays the default settings for the number of partitions you specified on the Properties pane. Select a partition and click the Edit button to modify details for that partition.

**PROCEDURES WIZARD (DB2 Z/OS)**

Procedures are a reusable block of PL/SQL, stored in the database, that applications can call. Procedures streamline code development, debugging, and maintenance by being reusable. Procedures enhance database security by letting you write procedures granting users execution privileges to tables rather than letting them access tables directly.

**To create a new procedure using a wizard:**

1. Open a creation wizard for a procedure. For details, see "Opening an Object Wizard" on page 248.

2. Use the following topics as a guide to setting properties and performing tasks as you pass through the wizard panels:
   - **Properties** panel - for details, see Procedures (DB2 z/OS) - Properties.
   - **Parameters** panel - for details, see Procedures (DB2 z/OS) - Parameters.
   - **DDL View** panel - for details, see "Previewing the DDL Generated to Create the New Object" on page 250.

3. Finally, use the Execute button to create the object.
Important Notes

- If you are creating a SQL routine procedure, you must have the latest DB2 fixpack installed on your OS/390 Client. If you do not have the latest fixpack installed, the SQL routine procedure creation will fail.

PROCEDURES (DB2 z/OS) - PROPERTIES

When creating or editing a procedure, this tab/panel lets you work with the following settings:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Schema, Name, and Specific Name</td>
<td>Select the schema that is to own the procedure, provide a name for the procedure, and provide the Specific Name for the procedure.</td>
</tr>
</tbody>
</table>
| Language                         | The database manager will call the procedure accordingly assuming the program is designed to run in the server's environment.  
C: a stored procedure written in C or C++  
COBOL: a stored procedure written in COBOL  
CompJAVA: CompJAVA is no longer supported. Stored procedures should alternatively be written in JAVA.  
JAVA  
PLI: A stored procedure written in PL/I.  
REXX (Restructured Extended Executor Language) - Don’t use this language when SQL parameter style is in effect. To specify REXX, the general parameter style or general with nulls. SQL |
| SQL Access Level                 | MODIFIES SQL DATA (Default): The procedure can support any SQL statement except those that cannot be supported in procedures.  
CONTAINS SQL DATA: Only SQL statements that neither modify nor read SQL data can be executed in the procedure.  
READS SQL DATA Some SQL statements that don’t modify SQL data can be included in the procedure  
NO SQL: Only SQL statements with a data access classification of NO SQL can be executed. Don’t select this option for a JAVA procedure that uses a .jar. |
| WLM Environment                  | Specify a Workload Management Environment (Required if Language is JAVA/COMPJAVA/REXX, the Procedure contains a LOB parameter, or Security is set to 'USER' or 'DEFINER'). |
| WLM For Nested                   | Self-explanatory                                                                                                                                                                                           |

PROCEDURES (DB2 z/OS) - PARAMETERS

For each parameter for this function, use the New button to add a new parameter, provide a name for the parameter, and in the Attributes area, select a Type, specify a Parameter Mode of INPUT, OUTPUT, or INPUT_OUTPUT, and if appropriate, the Precision, Scale, and Size options.
**Stogroups Wizard (DB2 Z/OS)**

Stogroups are storage groups. You create them on the current server. Storage from the named sets of volumes you create can be allocated at a later date for tablespaces or index spaces.

**To Open the Stogroup Wizard**

1. On the Navigator, find the datasource where you want to add the new Storage Group.
2. Expand the Storage branch, right-click Stogroup, and select New.

The table below describes the fields you will encounter as you complete the Stogroup Wizard.

<table>
<thead>
<tr>
<th>Required Information</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>What is the name of the Stogroup?</td>
<td>Enter a name for the storage group.</td>
</tr>
<tr>
<td>VCAT</td>
<td>This is the integrated catalog facility catalog, or volume catalog. Name the catalog or choose one from the drop-down list if it is available.</td>
</tr>
<tr>
<td>Select the volumes in the Stogroup</td>
<td>Specify a set of volumes that may exist on the system but may not be in use by other storage groups.</td>
</tr>
<tr>
<td>Select All</td>
<td>Selects all listed volumes.</td>
</tr>
<tr>
<td>Unselect All</td>
<td>Unselects all listed volumes.</td>
</tr>
<tr>
<td>Add</td>
<td>Opens the Add Volume Dialog Box.</td>
</tr>
<tr>
<td>Remove</td>
<td>Deletes all selected volumes from the list.</td>
</tr>
</tbody>
</table>

**Add Volume Dialog Box**

The table below describes the options and functionality on the Add Volume dialog:

<table>
<thead>
<tr>
<th>Required Information</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enter one or more volumes to add to the stogroup</td>
<td>Type the names of the volumes (separated by spaces) to add to the stogroup.</td>
</tr>
<tr>
<td>Check</td>
<td>Click to see if any additional information is available about the volumes you typed. Opens the Volumes Info Dialog Box.</td>
</tr>
<tr>
<td>Or select volumes for the list</td>
<td>Lets you select volumes.</td>
</tr>
</tbody>
</table>

**Volumes Info Dialog Box**

The table below describes the options and functionality on the Volume Info dialog:

<table>
<thead>
<tr>
<th>Required Information</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Volumes</td>
<td>Lets you select volumes.</td>
</tr>
<tr>
<td>OK</td>
<td>Click to add volumes to Stogroup Wizard.</td>
</tr>
</tbody>
</table>
SYNONYMS WIZARD (DB2 Z/OS)
A synonym is an alternative name you can create for a table or view. Using a synonym can make it easier for you to remember that table or view instead of having to think about the possibly cumbersome formal name (for example, a show dog may have a formal name that incorporates all his ancestors, but will answer to the name Spot around the house).

To create a new synonym using a wizard:
1. Open a creation wizard for a synonym. For details, see "Opening an Object Wizard" on page 248.
2. Use the following topics as a guide to setting properties and performing tasks as you pass through the wizard panels:
   - Properties panel - for details, see Synonyms (DB2 z/OS) - Properties.
   - DDL View panel - for details, see "Previewing the DDL Generated to Create the New Object" on page 250.
3. Finally, use the **Execute** button to create the object.

SYNONYMS (DB2 Z/OS) - PROPERTIES
When creating or editing a synonym, this tab/panel lets you work with the following settings:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Schema</strong></td>
<td>Select the schema that is to own the synonym.</td>
</tr>
<tr>
<td><strong>Name</strong></td>
<td>Provide a name for the synonym.</td>
</tr>
<tr>
<td><strong>Referenced Object Owner</strong></td>
<td>Select the owner of the object to which you are creating a synonym.</td>
</tr>
<tr>
<td><strong>Referenced Object Type</strong></td>
<td>Select the type of object (TABLE, VIEW) to which you are creating a synonym.</td>
</tr>
<tr>
<td><strong>Referenced Object Name</strong></td>
<td>Select the specific object to which you are creating a synonym.</td>
</tr>
</tbody>
</table>

TABLES WIZARD (DB2 Z/OS)
All data in a database is stored in a tabular format, that is a collection of rows and columns. Tables, therefore are fundamental to whatever database you are administering.
To create a new table using a wizard:

1. Open a creation wizard for a table. For details, see "Opening an Object Wizard" on page 248.

2. Use the following topics as a guide to setting properties and performing tasks as you pass through the wizard panels:

   - **Properties** panel - for details, see Tables (DB2 z/OS) - Properties.
   - **Columns** panel - for details, see Tables (DB2 z/OS) - Columns.
   - **Indexes** panel - for details, see Tables (DB2 z/OS) - Indexes.
   - **Temporal Properties** panel - for details, see Tables (DB2 z/OS v10) - Temporal Properties.
   - **Constraints** panel - for details, see Tables (DB2 z/OS) - Constraints.
   - **Comment** panel - for details, see "Adding a Comment to an Object" on page 249.
   - **Permissions** panel - "Setting Permissions or Privileges for an Object" on page 250.
   - **DDL View** panel - for details, see "Previewing the DDL Generated to Create the New Object" on page 250.

The table that follows describes the fields you may encounter as you complete the Table Wizard.

### Tables (DB2 z/OS) - Properties
Select the **Schema**, provide a **Name**, and provide or select other table properties.

### Tables (DB2 z/OS) - Columns
For each column in the table, click the **Add Column** button to create a column, provide a **Name** for the column and provide or select the remaining column attributes.

Use the **Delete** button to drop a selected column.

Use the arrow buttons to reposition the columns.

**Row Properties** (V10) settings are available when you select a **Type** of TIMESTAMP. These settings are used in conjunction with settings on the **Temporal Properties** tab in setting up system and application temporal tables. For more information, see "Tables (DB2 z/OS v10) - Temporal Properties" on page 296.

Specific settings are:

- **As Row Begin** - adds a GENERATED ALWAYS AS ROW BEGIN option to the column specification, used to track when a row is current.
- **As Row End** - adds a GENERATED ALWAYS AS ROW END option to the column specification.
- **Transaction Start ID** - adds a GENERATED ALWAYS AS TRANSACTION START ID option to the column specification indicating that this column captures the start times for transactions that affect rows.
CREATING OBJECTS

A column can have only one of the three settings selected.

When you select a Row Properties setting, the Scale value and if appropriate, the Allow Nulls, Default Value, and Expression settings are automatically adjusted for compatibility with row generation. Similarly, if one of the three Row Properties settings is selected for a column, and any of the Scale, Allow Nulls, Default Value, or Expression settings are modified, then the selected Row Properties setting is cleared.

TABLES (DB2 z/OS) - INDEXES

Click Add to open the Indexes Wizard (DB2 z/OS).

TABLES (DB2 z/OS v10) - TEMPORAL PROPERTIES

This tab/panel lets you specify temporal properties to a table, designating it as a table that records the period of time when a row is valid.

NOTE: Before using this object action, consult DB2 LUW documentation for details on setup and use of the temporal tables feature. For more information, see "Accessing Third-Party Documentation" on page 21.

This tab/panel has the following controls:

- **System-time table** - selecting this option creates a table with the PERIOD SYSTEM_TIME clause, designating it as a system-period temporal table. This option is available if the table has three columns of type TIMESTAMP, and the following prerequisites have been met:
  - At least one TIMESTAMP-typed column has the As Row Begin property selected
  - At least one TIMESTAMP-typed column has the As Row End property selected
  - At least one TIMESTAMP-typed column has the Transaction Start ID property selected

For details on column definitions, see "Tables (DB2 z/OS) - Columns" on page 295.

The Row-begin column, Row-end column, and Transaction Start ID column controls are automatically populated with the columns having the corresponding property.

When you select this option, in the generated DDL, the Row-begin column and Row-end column values are used as the PERIOD SYSTEM_TIME column parameters, defining the system period.

- **Business-time table** - selecting this option creates a table with the PERIOD BUSINESS_TIME clause, designating it as an application-period temporal table. This option is available if the table has two columns of type DATE or TIMESTAMP, for which no Row Properties have been assigned.

The Begin column and End Column controls are automatically populated with the valid candidate columns from the table’s column list and the first distinct column pair is automatically chosen for convenience.
• **Use history table** - this set of controls is only active when **Business-time table** is selected. It lets you associate a history table. When you select **Use history table**, the Owner and Name controls are activated, letting you identify the history table to associate with this table.

Note that a constraint created on a business-time table can enforce the uniqueness of the data for any point in business time via the **Time period policy** property that has been added in the constraint wizards. For details, see the following topics:

- "Primary Keys (DB2 z/OS) - Properties" on page 289
- "Unique Keys (DB2 z/OS) - Properties" on page 301

**TABLES (DB2 z/OS) - CONSTRAINTS**

Selecting a constraint type and clicking **Add** opens the object wizard for that object type. For details see:

- [Foreign Keys Wizard (DB2 Z/OS)]
- [Primary Keys Wizard (DB2 Z/OS)]
- [Unique Keys Wizard (DB2 Z/OS)]
- [Create Synonym]

**TABLESPACES WIZARD (DB2 Z/OS)**

Tablespaces establish connections between the physical storage devices of your database system and the logical containers or tables being used to store data. In essence, a tablespace is a storage structure that can hold tables, indexes, large objects, and long data.

**NOTE:** To change the encoding scheme for a database after it is created to utilize a different coded character set identifier (CCSID) that supports the Euro symbol, all data must be unloaded and reloaded. For more information regarding the encoding scheme, contact your System administrator.

**To Open the Tablespace Wizard**

1. On the Navigator, find the datasource where you want to add the new Tablespace.
2. Expand the Storage branch, right-click **Tablespaces**, and select **New**.
3. Use the following table as a guide to setting properties and performing tasks as you pass through the wizard panels:
   - **Properties** panel - for details, see [Tablespaces (DB2 z/OS) - Properties]
   - **Permissions** panel - "Setting Permissions or Privileges for an Object" on page 250
   - **DDL View** panel - for details, see "Previewing the DDL Generated to Create the New Object" on page 250.
4. Finally, use the **Execute** button to create the object.
### TABLESPACES (DB2 z/OS) - PROPERTIES

When creating or editing a tablespace, this tab/panel lets you work with the following settings:

<table>
<thead>
<tr>
<th>Group</th>
<th>Settings</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Creation</strong></td>
<td><strong>Name and Database</strong></td>
<td>Provide a name and select an associated database.</td>
</tr>
<tr>
<td></td>
<td><strong>Database</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Database type</strong></td>
<td>Lets you select a REGULAR or WORKFILE database type.</td>
</tr>
<tr>
<td></td>
<td><strong>Creation type</strong></td>
<td>Lets you select among PARTITIONED, SEGMENTED, RANGE-PARTITIONED UNIVERSAL, PARTITION-BY-GROWTH UNIVERSAL, and LOB options. Refer to DB2 z/OS product documentation for detailed information on these types and other required settings. For more information, see &quot;Accessing Third Party Documentation&quot; on page 21.</td>
</tr>
<tr>
<td><strong>Tablespace management</strong></td>
<td><strong>Management type</strong></td>
<td>Lets you select how you want the tablespace managed: DEFAULT STORAGE GROUP, STORAGE GROUP, or VCAT CATALOG-NAME.</td>
</tr>
<tr>
<td></td>
<td><strong>Storage group</strong></td>
<td>If you selected a <strong>Management type</strong> of STORAGE GROUP, select a storage group, specify minimum space allocations, and specify whether data sets are to be erased when the tablespace is dropped.</td>
</tr>
<tr>
<td></td>
<td><strong>Minimum primary space allocation</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Minimum secondary space allocation</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Erase rule</strong></td>
<td>If you selected a <strong>Management type</strong> of STORAGE GROUP, select a storage group, specify minimum space allocations, and specify whether data sets are to be erased when the tablespace is dropped.</td>
</tr>
<tr>
<td></td>
<td><strong>VCatName</strong></td>
<td>If you selected a <strong>Management type</strong> of VCAT catalog-name, select a catalog name.</td>
</tr>
<tr>
<td><strong>Bufferpool</strong></td>
<td><strong>Buffer Pool</strong></td>
<td>Select the buffer pool where the tablespace is to reside.</td>
</tr>
<tr>
<td><strong>Partitions and size</strong></td>
<td><strong>Number of partitions</strong></td>
<td>If you selected a <strong>Creation Type</strong> of PARTITIONED or RANGE-PARTITIONED UNIVERSAL, specify the number of partitions.</td>
</tr>
<tr>
<td></td>
<td><strong>Partition size (DSSIZE)</strong></td>
<td>If you did not select a <strong>Creation Type</strong> of SEGMENTED, select a partition size.</td>
</tr>
<tr>
<td></td>
<td><strong>Segment size</strong></td>
<td>If you selected a <strong>Creation Type</strong> of SEGMENTED, PARTITION-BY-GROWTH, or RANGE-PARTITIONED UNIVERSAL, select the number of pages that are to be assigned to each segment of the tablespace.</td>
</tr>
<tr>
<td></td>
<td><strong>Max rows per page</strong></td>
<td>Specify the number of rows (1-255) that can be placed on each data page.</td>
</tr>
<tr>
<td><strong>Space Management</strong></td>
<td><strong>Free space portion of each page (%)</strong></td>
<td>If you did not select a <strong>Creation Type</strong> of LOB, specify the percentage of each page to be left as free space when a tablespace is reloaded or reorganized.</td>
</tr>
<tr>
<td></td>
<td><strong>Free page frequency</strong></td>
<td>If you did not select a <strong>Creation Type</strong> of LOB, specify how often to leave a free page when a tablespace is reloaded or reorganized.</td>
</tr>
</tbody>
</table>
To create a new trigger using a wizard:

1. Open a creation wizard for a trigger. For details, see "Opening an Object Wizard" on page 248.

2. Use the following topics as a guide to setting properties and performing tasks as you pass through the wizard panels:
   - Properties panel - for details, see Triggers (DB2 z/OS) - Properties.
   - Column Selection panel - for details, see Triggers (DB2 z/OS) - Column Selection.
   - Definition panel - for details, see Triggers (DB2 z/OS) - Definition.

3. Finally, use the Execute button to create the object.

Triggers (DB2 z/OS) - Properties
When creating or editing a trigger, this tab/panel lets you work with the following settings:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table Schema and Table Name</td>
<td>Choose the owner and name of the table for which the trigger is being created.</td>
</tr>
</tbody>
</table>
If you chose UPDATE as the **Trigger Event**, select the columns, select the check box beside each column that is to fire the trigger.

**TRIGGERS (DB2 z/OS) - DEFINITION**

Complete the CREATE TRIGGER outline provided by typing or pasting the body of the trigger.

**UNIQUE KEYS WIZARD (DB2 z/OS)**

A unique key constraint is a key for which no two of its values can be equal and no values can be null. A table can have a number of unique constraints, but it cannot have more than one unique constraint on the same set of columns. If you are creating a unique key constraint on a table that already exists (as opposed to creating a unique key at the time the table is first generated), a unique index must already exist on the columns of the unique key you want to constrain. If no unique index exists, the Index Wizard will open as you complete the **Create Unique Key Constraint** dialog.
CREATING OBJECTS

To create a new unique key using a wizard:

1. Open a creation wizard for a unique key. For details, see “Opening an Object Wizard” on page 248.

2. Use the following topics as a guide to setting properties and performing tasks as you pass through the wizard panels:

   - **Properties** panel - for details, see Unique Keys (DB2 z/OS) - Properties.
   - **Columns** panel - for details, see Unique Keys (DB2 z/OS) - Columns.
   - **Storage** panel - for details, see Unique Keys (DB2 z/OS) - Storage - Edit button (manage datasets) and Unique Keys (DB2 z/OS) - Storage - Attributes.
   - **Partitions** panel - for details, see Unique Keys (DB2 z/OS) - Partitions.
   - **Comment** panel - for details, see "Adding a Comment to an Object" on page 249.
   - **DDL View** panel - for details, see "Previewing the DDL Generated to Create the New Object" on page 250.

3. Finally, use the **Execute** button to create the object.

**Unique Keys (DB2 z/OS) - Properties**

When creating or editing a primary key, this tab/panel lets you work with the following settings:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Table Schema</strong> and <strong>Table Name</strong></td>
<td>Choose the owner and name of the table in which the unique key is being created.</td>
</tr>
<tr>
<td><strong>Schema and Name</strong></td>
<td>Choose the owner and name of the index being created.</td>
</tr>
<tr>
<td><strong>Clustered</strong></td>
<td>Enable or disable clustering.</td>
</tr>
<tr>
<td><strong>Number of Partitions</strong></td>
<td>If you enabled Clustering, specify the number of partitions.</td>
</tr>
<tr>
<td><strong>Buffer Pool</strong></td>
<td>Provide the buffer pool in which this unique key should reside</td>
</tr>
<tr>
<td><strong>Defer, Close, Copy, and Define</strong></td>
<td>Enable or disable these DB2 options as required.</td>
</tr>
<tr>
<td><strong>Piece Size</strong></td>
<td>The maximum addressability of the dataset for a non-partitioned index.</td>
</tr>
<tr>
<td><strong>Time period policy</strong></td>
<td>This setting is for use with tables set up as business-time tables. For more information, see “Tables (DB2 z/OS v10) - Temporal Properties” on page 296. When selected, a BUSINESS_TIME WITHOUT OVERLAPS option is specified against the column or columns defining the constraint, in the generated DDL. This ensures that values for the constraint columns are unique with respect to the time for the BUSINESS_TIME period. When you select this option, columns specified as business-time begin period and end period are not available as candidates on the <strong>Columns</strong> tab/panel.</td>
</tr>
</tbody>
</table>
**Creating Objects**

**Unique Keys (DB2 z/OS) - Columns**

From the **Column** dropdown, select a column for the unique key and specify a **Sort** option. To add more columns, click the **New** button and then follow the steps in the last instruction. Use the **Delete** button to drop columns.

**Unique Keys (DB2 z/OS) - Storage - Edit button (manage datasets)**

**NOTE:** Availability differs according to the dataset management options you chose

Choose a data set management option:

**DB2 will define and manage the data sets on a volume of the default storage group of the database**

**DB2 will define and manage the data sets on a volume of the specified storage group**

Select a storage group (a storage group is made up of disk device volumes): Each data set will be defined on a volume listed in the storage group you select.

**Minimum primary space allocation:** 12 kilobytes is the default.

**Minimum secondary space allocation:** 12 kilobytes is the default.

**NOTE:** If the primary and (118 x) secondary space allocations combine to be greater than 2 gigabytes, more than one data set may eventually be used.

**Erase data sets when index dropped?** If you choose this option, DB2 will overwrite all data with zeros before they are deleted as a security measure.

**User will manage the data sets on a specified VCAT catalog-name** Enter or select the VCAT. Do not select this option for an index on a declared temporary table.

**Unique Keys (DB2 z/OS) - Storage - Attributes**

**NOTE:** Availability differs according to the dataset management options you chose

When creating or editing a unique key, this tab/panel lets you work with the following settings:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Storage Group, Primary Space Allocation, Secondary Space Allocation, Erase, and VCAT catalog</strong></td>
<td>The ability to set these options depends on the dataset management options you chose.</td>
</tr>
<tr>
<td><strong>Free Page</strong></td>
<td>One free page exists for every x pages. The x specifies how often to leave a page of free space when index entries are created from executing a DB2 utility or creating an index for a table with pre-existing rows. (0-255)</td>
</tr>
<tr>
<td><strong>Percent Free</strong></td>
<td>The percentage of free space you want to leave in every page when entries are added to an existing index. The default is 10%.</td>
</tr>
</tbody>
</table>
CREATING OBJECTS

\[\text{RAPID SQL XE4/8.5 USER GUIDE}\]

\[\text{303}\]

\section*{UNIQUE KEYS (DB2 Z/OS) - PARTITIONS}
Displays the default settings for the number of partitions you specified on the \textbf{Properties} pane. Select a partition and click the \textbf{Edit} button to modify details for that partition.

\section*{USER DATATYPES WIZARD (DB2 Z/OS)}
A datatype is a named set of valid values that can be manipulated by a set of operations. There are intrinsic datatypes, which are predefined and always available, and derived datatypes. A derived datatype is a user-defined datatype, which can include both intrinsic and previously derived datatypes. The User Datatype Wizard lets you create a derived datatype without knowing the underlying commands.

\textbf{To create a new user datatype using a wizard:}

1. Open a creation wizard for a user datatype. For details, see "Opening an Object Wizard" on page 248.

2. Use the following topics as a guide to setting properties and performing tasks as you pass through the wizard panels:
   - \textbf{Properties} panel - for details, see User Datatypes (DB2 z/OS) - Properties.
   - \textbf{Comment} panel - for details, see "Adding a Comment to an Object" on page 249.
   - \textbf{DDL View} panel - for details, see "Previewing the DDL Generated to Create the New Object" on page 250.

3. Finally, use the \textbf{Execute} button to create the object.

\section*{USER DATATYPES (DB2 Z/OS) - PROPERTIES}
When creating or editing a user datatype, this tab/panel lets you work with the following settings:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Owner</td>
<td>Select the owner of the user datatype.</td>
</tr>
<tr>
<td>Datatype</td>
<td>Provide a name for the datatype.</td>
</tr>
<tr>
<td>Type</td>
<td>Select the base datatype.</td>
</tr>
<tr>
<td>Size</td>
<td>Provide the size of the datatype.</td>
</tr>
<tr>
<td>For Data</td>
<td>Select the MIXED, SBCS, or BIT option for the datatype.</td>
</tr>
</tbody>
</table>

\begin{tabular}{|l|l|}
\hline
GBP Cache & This option is available only in a data-sharing environment.  

ALL: As pages are read, all of them will be cached in the group buffer pool.  

CHANGED: Updated pages are cached to the group buffer pool.  

NONE: No pages will be cached.  
\hline
\end{tabular}
Creating Objects

Users have authorization to use a database and its objects, and the User Wizard gives you an easy way to add new ones.

To create a new user using a wizard:

1. Open a creation wizard for a user. For details, see "Opening an Object Wizard" on page 248.

2. Use the following topics as a guide to setting properties and performing tasks as you pass through the wizard panels:
   - Properties panel - for details, see Users (DB2 Z/OS) - Properties.
   - Object Permissions and System Permissions panels - "Setting Permissions or Privileges for an Object" on page 250
   - DDL View panel - for details, see "Previewing the DDL Generated to Create the New Object" on page 250.

3. Finally, use the Execute button to create the object.

Users (DB2 Z/OS) - Properties

When creating or editing a user datatype, this tab/panel lets you provide the user Name.

Views Wizard (DB2 Z/OS)

A view gives you a new way of looking at data in a results table. Views behave like tables because you can query views and perform data manipulation operations on them. However, views do not actually store any data. Instead, they depend on data contained in their base tables. Columns added to the base table(s) after the view is created are not included in the result set. Views are thus handy tools for controlling access to a table. You can allow someone to see portions of data without allowing that user to see the table in its entirety. For example, you can create a view that will permit a user to see employee names in a table without allowing access to the Social Security numbers of that same table.

The wizard itself is a single panel. After you complete the wizard, the View Editor opens so you can complete the definition of the view, choose the columns to show in the view, the dependencies, and access privileges to the view.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CCSID</td>
<td>Select the NONE, ASCII, EBCDIC, or UNICODE option for the datatype.</td>
</tr>
</tbody>
</table>
To create a new view using a wizard:

1. Open a creation wizard for a view. For details, see "Opening an Object Wizard" on page 248.

2. Use the following topics as a guide to setting properties and performing tasks as you pass through the wizard panels:
   - Properties panel - for details, see Views (DB2 z/OS) - Properties.
   - Definition panel - for details, see Views (DB2 z/OS) - Definition.

3. Finally, use the Execute button to create the object.

**VIEWS (DB2 z/OS) - PROPERTIES**

When creating or editing a view, this tab/panel lets you work with the following settings:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Owner</td>
<td>Select the owner of the view. The owner of the view must have SELECT privileges for the tables in the CREATE view statement or DBADM authority on the database that contains the table.</td>
</tr>
<tr>
<td>Name</td>
<td>Provide a name for the view.</td>
</tr>
</tbody>
</table>
| Check Type   | **CHECK_NONE** - No search conditions must be satisfied for insert or update operations.  
CHECK_LOCAL - Update and insert operations on view must satisfy the search conditions of the view and underlying views that are defined with a check option. Furthermore, every updatable view that is directly or indirectly defined on view inherits those search conditions (the search conditions of view and all underlying views of that are defined with a check option) as a constraint on insert or update operations.  
CHECK CASCADED - Update and insert operations on the view must satisfy the search conditions of view and all underlying views, regardless of whether the underlying views were defined with a check option. Furthermore, every updatable view that is directly or indirectly defined on view inherits those search conditions (the search conditions of view and all underlying views) as a constraint on insert or update operations. |

**Views (DB2 z/OS) - Definition**

Complete the CREATE VIEW statement by typing or pasting in the relevant query.

**INTERBASE/FIREBIRD OBJECT WIZARDS**

Rapid SQL provides wizards that let you create all supported InterBase/Firebird objects. For details, see the following topics:

- Blob Filters Wizard (ITB/FBD)
- Domains Wizard (ITB/FBD)
- Encryption Keys wizard (ITB/FBD)
- Exceptions Wizard (ITB/FBD)
• **External Functions Wizard (ITB/FBD)**
• **Foreign Keys Wizard (DB2 LUW)**
• **Generators Wizard (ITB/FBD)**
• **Indexes Wizard (ITB/FBD)**
• **Primary Keys Wizard (ITB/FBD)**
• **Procedures Wizard (ITB/FBD)**
• **Roles Wizard (ITB/FBD)**
• **Shadows wizard (ITB/FBD)**
• **Tables Wizard (ITB/FBD)**
• **Triggers Wizard (ITB/FBD)**
• **Unique Keys Wizard (ITB/FBD)**
• **Users wizard (InterBase/Firebird)**
• **Views Wizard (ITB/FBD)**

**Blob Filters Wizard (ITB/FBD)**

The Blob Filter wizard lets you create and submit a DECLARE FILTER statement. Properties let you provide input and output subtypes, an entry point, and the module name.

**To create a new blob filter using a wizard:**

1. Open an object creation wizard for a blob filter. For details, see [Opening an Object Wizard](#) on page 248.

2. Use the following topics as a guide to setting properties and performing tasks as you pass through the wizard panels:

   • **Properties** panel - for details, see [Blob Filters (ITB/FBD) - Properties](#).
   • **Comment** panel - for details, see "[Adding a Comment to an Object](#)" on page 249.
   • **DDL View** panel - for details, see "[Previewing the DDL Generated to Create the New Object](#)" on page 250.

3. Finally, use the **Execute** button to create the object.
**CREATING OBJECTS**

**BLOB FILTERS (ITB/FBD) - PROPERTIES**

When creating or editing a Blob Filter, this tab/panel lets you work with the following settings:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>A name that must be unique among filters on the database.</td>
</tr>
<tr>
<td>Input subtype</td>
<td>Lets you provide an INPUT_TYPE argument that specifies the Blob subtype from which data is to be converted.</td>
</tr>
<tr>
<td>Output subtype</td>
<td>Lets you provide an OUTPUT_TYPE argument that specifies the Blob subtype into which data is to be converted.</td>
</tr>
<tr>
<td>Entrypoint</td>
<td>Lets you provide an ENTRY_POINT argument. Provide a quoted string specifying the name of the Blob filter as stored in a linked library.</td>
</tr>
<tr>
<td>Module name</td>
<td>Lets you provide a MODULE_NAME argument. Provide a quoted file specification identifying the object module in which the filter is stored.</td>
</tr>
</tbody>
</table>

**DOMAINS WIZARD (ITB/FBD)**

The Domain wizard lets you provide datatype details and other basic clause/option values, in creating a domain.

**To create a new domain using a wizard:**

1. Open an object creation wizard for a domain. For details, see Opening an Object Wizard on page 248.

2. Use the following topics as a guide to setting properties and performing tasks as you pass through the wizard panels:
   - **Properties** panel - for details, see Domains (ITB/FBD) - Properties.
   - **Comment** panel - for details, see "Adding a Comment to an Object" on page 249.
   - **DDL View** panel - for details, see "Previewing the DDL Generated to Create the New Object" on page 250.

3. Finally, use the **Execute** button to create the object.

**DOMAINS (ITB/FBD) - PROPERTIES**

When creating or editing a domain, this tab/panel lets you work with the following settings:

<table>
<thead>
<tr>
<th>Group</th>
<th>Settings and descriptions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Creation</td>
<td>Lets you provide a Datatype name.</td>
</tr>
</tbody>
</table>
The Encryption Key wizard lets you create keys used to encrypt and decrypt databases or table columns. It lets you specify the credentials, basic algorithm details, and other encryption options.

**NOTE:** Before working with encryption keys, you should be familiar with InterBase/Firebird requirements regarding passwords and user permissions. See the InterBase documentation at [http://docs.embarcadero.com/products/interbase/](http://docs.embarcadero.com/products/interbase/).

### To create a new encryption key using a wizard:

1. Open an object creation wizard for an encryption key. For details, see Opening an Object Wizard on page 248.
2. Use the following topics as a guide to setting properties and performing tasks as you pass through the wizard panels:
   - **Properties** panel - for details, see Encryption Keys (ITB/FBD) - Properties.
   - **DDL View** panel - for details, see Previewing the DDL Generated to Create the New Object on page 250.
3. Finally, use the **Execute** button to create the object.

### Encryption Keys Wizard (ITB/FBD)

When creating or editing an encryption key, this tab/panel lets you work with the following settings:

<table>
<thead>
<tr>
<th>Property</th>
<th>Descriptions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>When creating an encryption key, provide a unique name. After creating the encryption key, the name cannot be edited.</td>
</tr>
</tbody>
</table>
The Exception wizard lets you provide the text of an exception and the name by which it is raised from a stored procedure.

To create a new exception using a wizard:
1. Open an object creation wizard for an exception. For details, see Opening an Object Wizard on page 248.
2. Use the following topics as a guide to setting properties and performing tasks as you pass through the wizard panels:
   - **Properties** panel - for details, see Exceptions (ITB/FBD) - Properties.
   - **Comment** panel - for details, see "Adding a Comment to an Object" on page 249.
   - **DDL View** panel - for details, see "Previewing the DDL Generated to Create the New Object" on page 250.
3. Finally, use the Execute button to create the object.

### Exceptions (ITB/FBD) - Properties
When creating or editing an exception, this tab/panel lets you work with the following settings:

<table>
<thead>
<tr>
<th>Property</th>
<th>Descriptions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Algorithm</td>
<td>Options represent choices of the Advanced Encryption Standard or Data Encryption Standard algorithm and a key length.</td>
</tr>
<tr>
<td>Pad random</td>
<td>Enabled, the encryption key is created with a PAD RANDOM option, causing equal values to have different ciphertext. Disabled, the encryption key is created with a PAD NULL option, specifying that random padding should not be performed.</td>
</tr>
<tr>
<td>Init Vector random</td>
<td>Enabled, the encryption key is created with an INIT_VECTOR RANDOM option, enabling Cipher Block Chaining (CBC) encryption, forcing equal values to take different ciphertext. Disabled, the encryption key is created with a INIT_VECTOR NULL option, enabling Electronic Cookbook (ECB).</td>
</tr>
<tr>
<td>Password</td>
<td>Optionally, provide a user password.</td>
</tr>
<tr>
<td>Is Default</td>
<td>When enabled, the encryption key is created with an AS DEFAULT option, making this key the database default when no explicit key is specified for database or column encryption.</td>
</tr>
</tbody>
</table>
EXTERNAL FUNCTIONS WIZARD (ITB/FBD)
The External Functions wizard lets you DECLARE an existing, user-defined function.

To create a new external function using a wizard:
1. Open an object creation wizard for an external function. For details, see Opening an Object Wizard on page 248.
2. Use the following topics as a guide to setting properties and performing tasks as you pass through the wizard panels:
   - Properties panel - for details, see External Functions (ITB/FBD) - Properties.
   - Parameters panel - for details, see External Functions (ITB/FBD) - Parameters.
   - Return Type panel - for details, see External Functions (ITB/FBD) - Return Type.
   - Comment panel - for details, see "Adding a Comment to an Object" on page 249.
   - DDL View panel - for details, see "Previewing the DDL Generated to Create the New Object" on page 250.
3. Finally, use the Execute button to create the object.

EXTERNAL FUNCTIONS (ITB/FBD) - PROPERTIES
When creating or editing a generator, this tab/panel lets you work with the following settings:

<table>
<thead>
<tr>
<th>Group</th>
<th>Settings and descriptions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Creation</td>
<td>Lets you specify the Name of the function.</td>
</tr>
<tr>
<td>General</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>EntryPoint</strong> Type a quoted identifier as the ENTRY_POINT clause value for the declaration.</td>
</tr>
<tr>
<td></td>
<td><strong>ModuleName</strong> Type a quoted identifier as the MODULE_NAME clause value for the declaration.</td>
</tr>
</tbody>
</table>

EXTERNAL FUNCTIONS (ITB/FBD) - PARAMETERS

For each parameter to be added to this function:
1. Use the New button to add a new parameter and type a name for the parameter in the space provided.
2. With the parameter selected, in the Attributes area select a Type, and if appropriate, provide or select Precision, Scale, and Size options.

Use the Delete button to drop a selected parameter and use the arrow keys to reorder the parameter list.
EXTERNAL FUNCTIONS (ITB/FBD) - RETURN TYPE
When creating an external function, this tab/panel lets you specify the datatype of the value returned by the external function. Select a **Type**, and if appropriate, provide or select **Precision**, **Scale**, and **Size** options.

You cannot modify the return type when editing an external function.

**For each parameter to be added to this function:**
1. Use the New button to add a new parameter and type a name for the parameter in the space provided.
2. With the parameter selected, in the **Attributes** area select a **Type**, and if appropriate, provide or select **Precision**, **Scale**, and **Size** options.

Use the Delete button to drop a selected parameter and use the arrow keys to reorder the parameter list.

FOREIGN KEYS WIZARD (ITB/FBD)
The Foreign Key Wizard lets you create a foreign key constraint, mapping the relevant columns and specifying delete and update integrity checks.

**To create a new foreign key using a wizard:**
1. Open an object creation wizard for a foreign key. For details, see [Opening an Object Wizard](#) on page 248.
2. Use the following topics as a guide to setting properties and performing tasks as you pass through the wizard panels:
   - **Properties** panel - for details, see [Foreign keys (ITB/FBD) - Properties](#)
   - **Column Mapping** panel - for details, see [Foreign Keys (ITB/FBD) - Column Mapping](#)
   - **DDL View** panel - for details, see [Previewing the DDL Generated to Create the New Object](#) on page 250.
3. Finally, use the **Execute** button to create the object.

FOREIGN KEYS (ITB/FBD) - PROPERTIES
When creating or editing a foreign key, this tab/panel lets you work with the following settings:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table Owner</td>
<td>The owner of the table where the foreign key is being created.</td>
</tr>
<tr>
<td>Table Name</td>
<td>The table where the foreign key link originates—the child table.</td>
</tr>
<tr>
<td>Name</td>
<td>Lets you provide a constraint name.</td>
</tr>
</tbody>
</table>
FOREIGN KEYS (ITB/FBD) - COLUMN MAPPING

1. Under **Referenced Table**, choose the **Owner** and then the **Name** of the referenced, or parent, table.

2. Under the **Main Table**, select check boxes corresponding to the columns that are to reference columns in the referenced table. Then, under **Referenced Table**, select the corresponding column check boxes.

GENERATORS WIZARD (ITB/FBD)

The Generator wizard lets you create a simple, named generator and set its initial value.

**To create a new generator using a wizard:**

1. Open an object creation wizard for a generator. For details, see [Opening an Object Wizard](#) on page 248.

2. Use the following topics as a guide to setting properties and performing tasks as you pass through the wizard panels:

   - **Properties** panel - for details, see [Generators (ITB/FBD) - Properties](#).
   - **DDL View** panel - for details, see "[Previewing the DDL Generated to Create the New Object](#)" on page 250.

3. Finally, use the **Execute** button to create the object.

GENERATORS (ITB/FBD) - PROPERTIES

When creating or editing a generator, this tab/panel lets you work with the following settings:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delete Rule and Update Rule</td>
<td>Let you select ON UPDATE and ON DELETE argument values of NONE, CASCADE, SET DEFAULT, SET NULL, NO ACTION, or RESTRICT.</td>
</tr>
</tbody>
</table>

INDEXES WIZARD (ITB/FBD)

The Index Wizard lets you create a basic InterBase/Firebird index, specifying the sort order and ACTIVE/INACTIVE status for the index, and indicating whether duplicate values are allowed.
To create a new index using a wizard:

1. Open an object creation wizard for an index. For details, see Opening an Object Wizard on page 248.

2. Use the following topics as a guide to setting properties and performing tasks as you pass through the wizard panels:
   - **Properties** panel - for details, see Indexes (ITB/FBD) - Properties.
   - **Columns** panel - for details, see Indexes (ITB/FBD) - Columns.
   - **DDL View** panel - for details, see “Previewing the DDL Generated to Create the New Object” on page 250.

3. Finally, use the **Execute** button to create the object.

### Indexes (ITB/FBD) - Properties
When creating or editing an index, this tab/panel lets you work with the following settings:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the index.</td>
</tr>
<tr>
<td>Table Name</td>
<td>The owning table.</td>
</tr>
<tr>
<td>Unique</td>
<td>When enabled, the index is created with the UNIQUE keyword, disallowing duplicate values.</td>
</tr>
<tr>
<td>Enabled</td>
<td>When enabled, the index is created or altered with an ACTIVE status. When disabled, the index is created or altered with an INACTIVE status.</td>
</tr>
<tr>
<td>Descending</td>
<td>Specifies the sort order. When enabled, the index is created with the DESCENDING keyword. When disabled, the index is created with the ASCENDING keyword.</td>
</tr>
</tbody>
</table>

### Indexes (ITB/FBD) - Columns
When adding or editing an index, this tab/panel lets you manage the columns that make up the index.

**To add a column to the index:**
Click the **New** button and select a column from the **Column** dropdown.

**To delete a column from the index:**
Select the column and click the **Remove** button.

**To change the position of a column in the list:**
Select the column and use the arrow keys to reorder the column list.
**PRIMARY KEYS WIZARD (ITB/FBD)**
The Primary Key Wizard lets you add a basic InterBase/Firebird primary key to a table.

**To create a new primary key using a wizard:**
1. Open an object creation wizard for a primary key. For details, see Opening an Object Wizard on page 248.
2. Use the following topics as a guide to setting properties and performing tasks as you pass through the wizard panels:
   - **Properties** panel - Primary Keys (ITB/FBD) - Properties.
   - **Columns** panel - Primary Keys (ITB/FBD) - Columns.
   - **DDL View** panel - for details, see "Previewing the DDL Generated to Create the New Object" on page 250.
3. Finally, use the **Execute** button to create the object.

**PRIMARY KEYS (ITB/FBD) - PROPERTIES**
When creating or editing an index, this tab/panel lets you work with the following settings:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the primary key.</td>
</tr>
<tr>
<td>Table Name</td>
<td>The owning table.</td>
</tr>
</tbody>
</table>

**PRIMARY KEYS (ITB/FBD) - COLUMNS**
When adding or editing a primary key, this tab/panel lets you manage the columns that make up the primary key.

**NOTE:** Only columns defined with the **Allow Nulls** property disabled can be added to a primary key.

**To add a column to the primary key:**
Click the **New** button and select a column from the **Column** dropdown.

**To delete a column from the primary key:**
Select the column and click the **Remove** button.

**To change the position of a column in the list:**
Select the column and use the arrow keys to reorder the column list.
PROCEDURES WIZARD (ITB/FBD)

The Procedures Wizard lets you create a procedure definition that includes parameter specifications, the body of the procedure, and execution permissions.

To create a new procedure using a wizard:

1. Open an object creation wizard for a procedure. For details, see Opening an Object Wizard on page 248.

2. Use the following topics as a guide to setting properties and performing tasks as you pass through the wizard panels:
   - **Properties** panel - Procedures (ITB/FBD) - Properties.
   - **Parameters** panel - Procedures (ITB/FBD) - Parameters.
   - **Body** panel - Procedures (ITB/FBD) - Body.
   - **Permissions** panel - Setting Permissions or Privileges for an Object
   - **DDL View** panel - for details, see “Previewing the DDL Generated to Create the New Object” on page 250.

3. Finally, use the **Execute** button to create the object.

PROCEDURES (ITB/FBD) - PROPERTIES

When creating a procedure, this panel/tab lets you provide a **Name** for the procedure. After creation, you cannot change its name.

PROCEDURES (ITB/FBD) - PARAMETERS

This tab lets you add and modify the parameters for a procedure.

To add a parameter:

1. Click the **New** button and type a name for the parameter in the space provided.

2. In the **Attributes** area, select a **Type** and if appropriate, provide **Precision, Scale**, and **Size** values.

3. Select a **Parameter Mode** of **INPUT** or **OUTPUT**.

To edit a parameter:

- Select the parameter and modify the values in the **Attributes** area.

To delete a parameter:

- Select the parameter and click the **Delete** button.
To change the ordering position of a parameter:
- Select the parameter and use the arrow buttons to move the parameter up or down in the list.

PROCEDURES (ITB/FBD) - BODY
This tab provides a simple editor that lets you add or modify the body of the procedure.

ROLES WIZARD (ITB/FBD)
The Roles Wizard lets you create a basic InterBase/Firebird role.

To create a new role using a wizard:
1. Open an object creation wizard for a role. For details, see Opening an Object Wizard on page 248.
2. Use the following topics as a guide to setting properties and performing tasks as you pass through the wizard panels:
   - Properties panel - Roles (ITB/FBD) - Properties.
   - DDL View panel - for details, see “Previewing the DDL Generated to Create the New Object” on page 250.
3. Finally, use the Execute button to create the object. For more information, see Previewing the DDL Generated to Create the New Object.

The Roles editor opens, letting you immediately assign users to the new roles and set up a set of permissions for the role. For more information, see "Roles editor (InterBase/Firebird)” on page 495.

ROLES (ITB/FBD) - PROPERTIES
When creating a role, this tab/panel lets you provide a Name for the role. When editing a role, this tab/panel displays the Name and Authorization Owner for the role.

SHADOWS WIZARD (ITB/FBD)
The Shadows Wizard lets you create a shadow, consisting of one or more in-sync copies of the database stored on secondary storage devices.
To create a new shadow using a wizard:

1. Open an object creation wizard for a shadow. For details, see "Opening an Object Wizard" on page 248.

2. Use the following topics as a guide to setting properties and performing tasks as you pass through the wizard panels:
   - **Properties** panel - [Shadows (ITB/FBD) - Properties](#).
   - **Storage** panel - [Shadows (ITB/FBD) - Storage](#).
   - **DDL View** panel - for details, see "Previewing the DDL Generated to Create the New Object" on page 250.

3. Finally, use the **Execute** button to create the object.

**SHADOWS (ITB/FBD) - PROPERTIES**

When creating or editing a shadow, this tab/panel lets you work with the following settings:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shadow Set</td>
<td>Lets you specify a set number, designating a shadow set to which files specified on the Storage panel belong. Once the shadow set is created, this value cannot be edited.</td>
</tr>
<tr>
<td>Conditional</td>
<td>Lets you include the CONDITIONAL argument with the CREATE SHADOW statement, when creating a new shadow. This allows shadowing to continue if the primary shadow becomes unavailable or if the shadow replaces the database due to disk failure.</td>
</tr>
<tr>
<td>Behavior</td>
<td>Lets you include AUTO or MANUAL arguments with the CREATE SHADOW statement, specifying default access behavior when no shadow is available. AUTO specifies that all attachments and accesses succeed, all references to the shadow are deleted, and the shadow file is detached. MANUAL specifies that database attachments and accesses fail until a shadow becomes available or until all shadow references are removed from the database.</td>
</tr>
</tbody>
</table>

**SHADOWS (ITB/FBD) - STORAGE**

When creating or editing a shadow, this tab/panel lets you manage a primary and one or more secondary files making up the shadow set. Note the following when managing shadow files:

- When creating a shadow, a primary file entry is automatically created when you select this tab. You must provide primary file property values before proceeding.

- A secondary file cannot be created if there is no primary file entry.

To add a primary or secondary file to the shadow:

1. Click the **New** button.

2. Use the following table as a guide to providing values in the **Property/Value** list for the file entry:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Physical File Name</td>
<td>Provide the path and file name for the shadow file, which must reside on the local file system.</td>
</tr>
</tbody>
</table>
To delete a primary or secondary file entry:
Select the file entry in the primary and secondary file list and click the **Delete** button.

### TABLES WIZARD (ITB/FBD)
The Tables wizard lets you create a table definition, providing column descriptions, indexes, permissions, and constraints for the table.

#### To create a new table using a wizard:
1. Open an object creation wizard for a table. For details, see [Opening an Object Wizard](#) on page 248.
2. Use the following topics as a guide to setting properties and performing tasks as you pass through the wizard panels:
   - **Properties** panel - for details, see [Tables (ITB/FBD) - Properties](#).
   - **Columns** panel - for details, see [Tables (ITB/FBD) - Columns](#).
   - **Indexes** panel - for details, see [Tables (ITB/FBD) - Indexes](#).
   - **Constraints** panel - for details, see [Tables (ITB/FBD) - Constraints](#).
   - **Comment** panel - for details, see "[Adding a Comment to an Object](#)" on page 249.
   - **Permissions** panel - "[Setting Permissions or Privileges for an Object](#)" on page 250
   - **DDL View** panel - for details, see "[Previewing the DDL Generated to Create the New Object](#)" on page 250.
3. Finally, use the **Execute** button to create the object.

### TABLES (ITB/FBD) - PROPERTIES
When creating a table, this tab/panel lets you provide a **Name** for the table. When editing a table, the **Name** is for display only.

### TABLES (ITB/FBD) - COLUMNS
When creating or editing a table, this tab/panel lets you manage the columns for the table:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Starting Page</td>
<td>Starting page number of a secondary shadow file.</td>
</tr>
<tr>
<td>Size</td>
<td>The size, in pages.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Starting Page</td>
<td>Starting page number of a secondary shadow file.</td>
</tr>
<tr>
<td>Size</td>
<td>The size, in pages.</td>
</tr>
</tbody>
</table>
To add a column to the table:

1. Use the Add Column dropdown to add a new column to the bottom of the column list or to insert a new column above the currently selected column in the column list.

2. Provide a Name for the column.

3. Either select a Type for the column or select Computed and provide a valid InterBase/Firebird Computed Expression.

4. Use the following table as a guide to providing additional property values, noting that availability of a property differs by data type and other property selections.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Array Dimensions</td>
<td>Lets you type a valid InterBase/Firebird array_dim specifier or use the ... button to open a dialog that lets you build the specifier.</td>
</tr>
<tr>
<td>Size</td>
<td>Lets you provide a size for character datatypes.</td>
</tr>
<tr>
<td>Allow Nulls</td>
<td>Disabled, submits a NOT NULL argument.</td>
</tr>
<tr>
<td>Default Character Set</td>
<td>Submits a CHARACTER SET argument value.</td>
</tr>
<tr>
<td>Default Collation</td>
<td>Submits a COLLATE argument value.</td>
</tr>
<tr>
<td>Default Value</td>
<td>Submits a literal COLLATE argument value.</td>
</tr>
</tbody>
</table>

To edit a column:

- Select the column from the list and edit property values as per the descriptions above.

To drop a column:

- Select the column from the list and click the Delete button.

To change the position of a column in the list:

- Select the column from the list and use the arrow buttons to change its position.

TABLES (ITB/FBD) - INDEXES

When creating or editing tables, this tab/panel lets you manage indexes for the table:

- Click Add to open a wizard that lets you add a new index to the table. For information on using the wizard, see "Indexes Wizard (ITB/FBD)" on page 312.

- Select an index and click Edit to open an editor on the index. For information on using the editor, see "Indexes editor (InterBase/Firebird)" on page 493.

- Select an index and click Drop to drop an index from the table.

TABLES (ITB/FBD) - CONSTRAINTS

When creating or editing tables, this tab/panel lets you manage foreign key, primary key, unique key and check constraints for the table:
• Select a constraint type and click Add to open a wizard that lets you add a new constraint of that type to the table.

• Select an existing constraint and click Edit to open a wizard that lets you add modify that constraint.

The wizards used to add and modify constraints offer functionality identical to the editors and wizards used when creating those object types. For details, see the following topics:

• "Foreign Keys Wizard (DB2 LUW)" on page 254 and "Foreign Keys editor (InterBase/Firebird)" on page 491
• "Primary Keys Wizard (ITB/FBD)" on page 314 and "Primary Keys editor (InterBase/Firebird)" on page 493
• "Unique Keys Wizard (ITB/FBD)" on page 321 and "Unique Keys editor (InterBase/Firebird)" on page 498
• "Add or Modify Check Constraint" on page 580
• Select a constraint and click Drop to drop a constraint from the table.

TRIGGERS WIZARD (ITB/FBD)

The Triggers wizard lets you create a basic InterBase trigger, providing a trigger body and specifying key properties such as the associated event type and the trigger timing.

To create a new trigger using a wizard:

1. Open an object creation wizard for a trigger. For details, see Opening an Object Wizard on page 248.

2. Use the following topics as a guide to setting properties and performing tasks as you pass through the wizard panels:

   • Properties panel - for details, see Triggers (ITB/FBD) - Properties.
   • Body panel - for details, see Triggers (ITB/FBD) - Body.
   • Comment panel - for details, see "Adding a Comment to an Object" on page 249.
   • DDL View panel - for details, see "Previewing the DDL Generated to Create the New Object" on page 250.

3. Finally, use the Execute button to create the object.

TRIGGERS (ITB/FBD) - PROPERTIES

When creating a trigger, this tab/panel lets you provide values for the following trigger properties:

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Parent Type</td>
<td>Select TABLE or VIEW as the Parent type.</td>
</tr>
</tbody>
</table>
UNIQUE KEYS WIZARD (ITB/FBD)
The Unique Key Wizard lets you add a basic InterBase/Firebird unique key to a table.

To create a new unique key using a wizard:
1. Open an object creation wizard for a unique key. For details, see Opening an Object Wizard on page 248.
2. Use the following topics as a guide to setting properties and performing tasks as you pass through the wizard panels:
   - Properties panel - Unique Keys (ITB/FBD) - Properties.
   - Columns panel - Unique Keys (ITB/FBD) - Columns.
   - DDL View panel - for details, see "Previewing the DDL Generated to Create the New Object" on page 250.
3. Finally, use the Execute button to create the object.

UNIQUE KEYS (ITB/FBD) - PROPERTIES
When creating a unique key, this tab/panel lets you provide a Name for the unique key and select the owning Table Name. These values cannot be changed when editing the unique key.
UNIQUE KEYS (ITB/FBD) - COLUMNS
When adding or editing a unique key, this tab/panel lets you manage the columns that make up the unique key.

**NOTE:** Only columns defined with the **Allow Nulls** property disabled can be added to a unique key.

To add a column to the unique key:
Click the **New** button and select a column from the **Column** dropdown.

To delete a column from the unique key:
Select the column and click the **Remove** button.

To change the position of a column in the list:
Select the column and use the arrow keys to reorder the column list.

USERS WIZARD (INTERBASE/FIREBIRD)
The Users wizard lets you create a basic InterBase/Firebird user, providing basic properties, assigning roles, and granting relevant permissions.

**NOTE:** The Users node is only available for databases with the Embedded User Authentication option enabled. Before using Rapid SQL against InterBase/Firebird users, you should be familiar with this feature and with InterBase/Firebird permissions with regard to this object type. For access to InterBase documentation, see [http://docs.embarcadero.com/products/interbase/](http://docs.embarcadero.com/products/interbase/).

To create a new user:
1. Open an object creation wizard for a user. For details, see Opening an Object Wizard on page 248.
2. Use the following topics as a guide to setting properties and performing tasks as you pass through the wizard panels:
   - **Properties** panel - for details, see Users (ITB/FBD) - Properties.
   - **Comment** panel - for details, see "Adding a Comment to an Object" on page 249.
   - **Roles** panel - for details, see Users (ITB/FBD) - Roles.
   - **Object Permissions** panel - Setting Permissions or Privileges for an Object
   - **DDL View** panel - for details, see "Previewing the DDL Generated to Create the New Object" on page 250.
3. Finally, use the **Execute** button to create the object.

The User editor opens. For more information, see "Users editor (InterBase/Firebird)" on page 498.
Creating Objects

Users (ITB/FBD) - Properties
When creating or editing a user, this tab/panel lets you provide values for the following properties:

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The login name for this user.</td>
</tr>
<tr>
<td>Password</td>
<td>The password for this user.</td>
</tr>
<tr>
<td>Group</td>
<td>Lets you specify a group name for the user. If unspecified, the user is created with the NO GROUP NAME option.</td>
</tr>
<tr>
<td>Default Role</td>
<td>Lets you select a default role for the user. If unspecified, the user is created with the NO DEFAULT ROLE option. Additional roles can be assigned for this user on the Roles tab/panel. For details, see Users (ITB/FBD) - Roles.</td>
</tr>
<tr>
<td>First Name, Middle Name, and Last Name</td>
<td>Let you provide the user's name, as opposed to the login name.</td>
</tr>
<tr>
<td>Active</td>
<td>This control is not enabled when creating a user and by default the user is created with the ACTIVE option. When editing a user, selecting this check box allows the user to log into the database. When unselected, the user is prevented from logging in to the database.</td>
</tr>
<tr>
<td>System User Name</td>
<td>Lets you specify a systemuser name for the user. If unspecified, the user is created with the NO SYSTEM USER NAME option.</td>
</tr>
<tr>
<td>Description</td>
<td>Lets you provide a short description for this user</td>
</tr>
<tr>
<td>GID</td>
<td>Lets you specify a numeric group ID for this user.</td>
</tr>
<tr>
<td>UID</td>
<td>Lets you specify a numeric user ID for this user.</td>
</tr>
</tbody>
</table>

Users (ITB/FBD) - Roles
When creating or editing a user, this tab/panel lets you assign the valid, non-default roles that a user can specify when logging in to the database.

NOTE: A default login role can be assigned for this user on the Properties tab/panel. For details, see "Users (ITB/FBD) - Roles" on page 323.

To assign roles to the user:
- Select the associated check box.

Views Wizard (ITB/FBD)
The Views wizard lets you create a basic InterBase/Firebird view
To create a new view using a wizard:

1. Open an object creation wizard for a view. For details, see Opening an Object Wizard on page 248.

2. Use the following topics as a guide to setting properties and performing tasks as you pass through the wizard panels:
   - Properties panel - for details, see Views (ITB/FBD) - Properties.
   - Comment panel - for details, see "Adding a Comment to an Object" on page 249.
   - Definition panel - for details, see Views (ITB/FBD) - Definition.

3. Finally, use the Execute button to create the object.

**VIEWS (ITB/FBD) - PROPERTIES**

When creating or editing a view, this tab/panel lets you provide values for the following properties:

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Provide a name for the view.</td>
</tr>
<tr>
<td>Check Option</td>
<td>When enabled, a WITH CHECK OPTION argument is included with the DDL generated to create the view. This prevents INSERT or UPDATE operations on an updatable view if that operation violates the search condition specified in the associated WHERE clause.</td>
</tr>
</tbody>
</table>

When editing a view, these values cannot be modified.

**VIEWS (ITB/FBD) - DEFINITION**

When creating or editing a view, this tab/panel previews the DDL reflecting your property values and lets you provide or edit the relevant query.

**MICROSOFT SQL SERVER OBJECT WIZARDS**

Rapid SQL lets you create SQL Server objects using the following wizards:

- Asymmetric Keys Wizard (SQL Server)
- Certificate Wizard (SQL Server)
- Databases Wizard (SQL Server)
- Database Triggers Wizard (SQL Server)
- Defaults Wizard (SQL Server)
- Extended Procedures Wizard (SQL Server)
- Foreign Keys Wizard (SQL Server)
• Full-text Catalogs Wizard (SQL Server)
• Full-text Indexes Wizard (SQL Server)
• Functions Wizard (SQL Server)
• Indexes Wizard (SQL Server)
• Logins Wizard (SQL Server)
• Partition Functions Wizard (SQL Server)
• Partition Schemes Wizard (SQL Server)
• Primary Keys Wizard (SQL Server)
• Procedures Wizard (SQL Server)
• Roles Wizard (SQL Server)
• Rules Wizard (SQL Server)
• Schema Wizard (SQL Server)
• Symmetric Keys Wizard (SQL Server)
• Synonyms Wizard (SQL Server)
• Tables Wizard (SQL Server)
• Triggers Wizard (SQL Server)
• Unique Keys Wizard (SQL Server)
• User Messages Wizard (SQL Server)
• Users Wizard (SQL Server)
• User Datatypes Wizard (SQL Server)
• Views Wizard (SQL Server)

ASYMMETRIC KEYS WIZARD (SQL SERVER)
This wizard lets you build and submit a CREATE ASYMMETRIC KEY statement with options corresponding to the contained private and public keys.
To create a new asymmetric key using a wizard:

1. Open a creation wizard for an asymmetric key. For details, see "Opening an Object Wizard" on page 248.

2. Use the following topics as a guide to setting properties and performing tasks as you pass through the wizard panels:
   - **Properties** panel - Asymmetric Keys (SQL Server) - Properties.
   - **DDL View** panel - for details, see "Previewing the DDL Generated to Create the New Object" on page 250.

3. Finally, use the **Execute** button to create the object.

**Asymmetric Keys (SQL Server) - Properties**

When creating or editing an asymmetric key, this tab/panel lets you work with the following settings:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Availability and description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Authorization Owner</td>
<td>The name of the user that will own the certificate.</td>
</tr>
<tr>
<td>Name</td>
<td>The name for the certificate.</td>
</tr>
<tr>
<td>Use Existing Keys</td>
<td>Selected, a WITH ALGORITHM option variation of the CREATE ASYMMETRIC KEY statement is generated. Deselected, a FROM FILE, FROM EXECUTABLE FILE, FROM ASSEMBLY, or FROM PROVIDER option variation of the CREATE ASYMMETRIC KEY statement is generated.</td>
</tr>
<tr>
<td>Provider Name</td>
<td>Available if Use Existing Keys is not selected. Lets you provide a FROM PROVIDER argument value, specifying an Extensible Key Management provider and name.</td>
</tr>
<tr>
<td>Key Algorithm</td>
<td>Available if Use Existing Keys is not selected. Lets you select a WITH ALGORITHM value of RSA_512, RSA_1024, or RSA_2048, specifying the key length.</td>
</tr>
<tr>
<td>Key Name In Provider</td>
<td>Available if Use Existing Keys is not selected, after Provider Name is entered. Lets you provide a PROVIDER_KEY_NAME value, specifying the key name from the external provider.</td>
</tr>
<tr>
<td>Creation Disposition</td>
<td>Lets you select a CREATION_DISPOSITION value of OPEN_EXISTING or CREATE_NEW, specifying whether the asymmetric key is mapped to an existing EKM key or a new key is created on the EKM device.</td>
</tr>
<tr>
<td>File</td>
<td>Available if Use Existing Keys is selected. Let you provide FROM FILE, FROM EXECUTABLE FILE, FROM ASSEMBLY, or FROM PROVIDER option values, respectively.</td>
</tr>
<tr>
<td>Executable File</td>
<td>Assembly</td>
</tr>
<tr>
<td>Assembly</td>
<td>Provider Name</td>
</tr>
<tr>
<td>Encryption Password</td>
<td>Available if Use Existing Keys is not selected and after Subject is provided. Lets you provide an ENCRYPTION BY PASSWORD = clause value, specifying the password used to encrypt the private key.</td>
</tr>
</tbody>
</table>
CERTIFICATE WIZARD (SQL SERVER)
This wizard lets you build and submit a CREATE CERTIFICATE statement, adding a certificate to a database.

To create a new certificate using a wizard:
1. Open a creation wizard for a certificate. For details, see "Opening an Object Wizard" on page 248.
2. Use the following topics as a guide to setting properties and performing tasks as you pass through the wizard panels:
   - Properties panel - Certificates (SQL Server) - Properties.
   - DDL View panel - for details, see "Previewing the DDL Generated to Create the New Object" on page 250.
3. Finally, use the Execute button to create the object.

CERTIFICATES (SQL SERVER) - PROPERTIES
When creating or editing a certificate, this tab/panel lets you work with the following settings:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Availability and description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Owner</td>
<td>The name of the user that will own the certificate.</td>
</tr>
<tr>
<td>Name</td>
<td>The name for the certificate.</td>
</tr>
<tr>
<td>Use Existing Keys</td>
<td>Lets you choose between EXISTING KEYS and GENERATE NEW KEYS options.</td>
</tr>
<tr>
<td>Active For Begin Dialog</td>
<td>Lets you select ON/OFF values for a ACTIVE FOR BEGIN_DIALOG = option.</td>
</tr>
<tr>
<td>Subject</td>
<td>Available if Use Existing Keys is not selected.</td>
</tr>
<tr>
<td>StartDate and ExpiryDate</td>
<td>Available if Use Existing Keys is not selected and after Subject is provided.</td>
</tr>
<tr>
<td>Assembly</td>
<td>Available if Use Existing Keys is selected.</td>
</tr>
<tr>
<td>ExecutableFile</td>
<td>Lets you provide a WITH PRIVATE KEY (FILE =... clause value, specifying that the certificate's private key is loaded.</td>
</tr>
<tr>
<td>PrivateKeyFile</td>
<td>Available if Use Existing Keys is selected.</td>
</tr>
<tr>
<td>Encryption Password</td>
<td>Available if Use Existing Keys is not selected and after Subject is provided.</td>
</tr>
<tr>
<td>DecryptionPassword</td>
<td>Available if Use Existing Keys is not selected. Also available if Use Existing Keys is selected and after an Assembly or PrivateKeyFile value is provided.</td>
</tr>
</tbody>
</table>
DATABASES WIZARD (SQL SERVER)

The Database Wizard presents you with a different set of options based on your server version to create the database accurately on each platform.

**TIP:** Microsoft SQL Server recommends that you do not create any user objects, such as tables, views, stored procedures, or triggers, in the master database. The master database includes the system tables that store the system information used by SQL Server, such as configuration option settings.

To create a new database using a wizard:

1. Open a creation wizard for a database. For details, see "Opening an Object Wizard" on page 248.

2. Use the following topics as a guide to setting properties and performing tasks as you pass through the wizard panels:
   - **Options panel** - for details, see Databases (SQL Server) - Options.
   - **Placement panel** - for details, see Databases (SQL Server) - Placement.
   - **Transaction Log panel** - for details, see Databases (SQL Server) - Transaction Log.
   - **DDL View panel** - for details, see "Previewing the DDL Generated to Create the New Object" on page 250.

3. Finally, use the **Execute** button to create the object.

**DATABASES (SQL Server) - OPTIONS**

When creating or editing a database, this tab/panel lets you work with the following settings:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Provide a name for the database.</td>
</tr>
<tr>
<td>Attach existing OS files</td>
<td>To create a database from an existing set of operating system files, there must be a <code>&lt;filespec&gt;</code> entry for the first PRIMARY file. The PRIMARY filegroup contains all the database system tables. Primary files have a .mdf extension.</td>
</tr>
<tr>
<td>Compatible Level</td>
<td>Select a version compatibility level.</td>
</tr>
<tr>
<td>Properties group</td>
<td>Select the following settings: ANSI null default, ANSI nulls, ANSI padding, ANSI warnings, auto create statistics, auto update statistics, autoclose, autoshrink, concat null yields null, cursor close on commit, arithabort, db chaining, dbo use only, default to local cursor, merge publish, numeric roundabout, offline, published, quoted identifier, read only, recursive triggers, select into/bulkcopy/pilsort, single user, subscribed, torn page detection, and trunc log on chkpt.</td>
</tr>
</tbody>
</table>
By default, when you open the Wizard and click the **Placement** tab, a filegroup definition, using the name you provided for the database and default settings, is displayed. For each filegroup to be added, click the **New** button, provide a **Device File Name** for the filegroup, and use the **File Group Properties** and **Device File Properties** groups to provide the attributes of the filegroup.

Use the Delete button to delete a selected filegroup.

**DATABASES (SQL SERVER) - TRANSACTION LOG**

The transaction log file is a required file for each database. This file holds the log information to recover the database. There can be multiple log files for a database, but there has to be at least one. Traditionally the logfile extension has been .ldf.

By default, when you open the Wizard and click the **Transaction Log** tab, a transaction log file definition, using the name derived from the name you provided for the database and with default settings, is displayed. For each file to be added, click the **New** button, provide a **Device File Name**, and use the **Log Device Properties** group to provide the attributes of the file.

Use the Delete button to delete a selected file.

**NOTE:** As you complete the wizard, be aware that the Primary file contains startup information for the database and is also used to store data. The transaction log files hold the information used to recover the database.

**DATABASE TRIGGERS WIZARD (SQL SERVER)**

This wizard builds and submits a CREATE TRIGGER... ON DATABASE statement, letting you create a DDL trigger with database scope, that fires in response to selected DDL events. The wizard builds basic syntax only, letting you provide the actions and conditions SQL making up the main body of the trigger.

**NOTE:** Before working with database triggers, consult Microsoft SQL Server documentation for general information on DDL triggers as well as specifics such as FOR/AFTER argument details, valid actions and conditions, and supported events. For more information, see “Accessing Third Party Documentation” on page 21.

**To create a new database trigger using a wizard:**

1. Open a creation wizard for a database trigger. For details, see “Opening an Object Wizard” on page 248.

2. Use the following topics as a guide to setting properties and performing tasks as you pass through the wizard panels:

   - **Properties** panel - for details, see Database Triggers (SQL Server) - Properties.
   - **Trigger Events** panel - for details, see Database Triggers (SQL Server) - Trigger Events.
   - **Definition** panel - for details, see “Previewing the DDL Generated to Create the New Object” on page 250.
3 Finally, use the **Execute** button to create the object.

**NOTE:** In order to fire in response to specified events, a database trigger must be enabled. For information on enabling and disabling a database trigger, see "Database Triggers Editor (SQL Server)" on page 504 and "Change Status (SQL Server DDL triggers)" on page 593.

### DATABASE TRIGGERS (SQL SERVER) - PROPERTIES

When creating or editing a database trigger, this tab/panel lets you work with the following settings:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Provide a name for the DDL trigger.</td>
</tr>
<tr>
<td>Trigger Timing</td>
<td>Use this control to specify a FOR/AFTER argument option. The specific events for the argument are provided on the Trigger Events tab/panel.</td>
</tr>
<tr>
<td>Encrypted</td>
<td>Select this check box to add a WITH ENCRYPTION argument to the generated DDL. This prevents the trigger from being published as part of a SQL Server replication.</td>
</tr>
</tbody>
</table>

### DATABASE TRIGGERS (SQL SERVER) - TRIGGER EVENTS

When creating or editing a database trigger, this tab/panel lets you specify the FOR/AFTER argument appearing in the generated CREATE TRIGGER... ON DATABASE syntax. For each event that is to fire this trigger, select the associated check box.

### DEFAULTS WIZARD (SQL SERVER)

When bound to a column or user-defined object, a default ensures that a specific value will be inserted into the column where the object will be bound if no explicit value is given.

The Default Wizard lets you name the default and specify its value.

**To create a new default using a wizard:**

1 Open a creation wizard for a default. For details, see "Opening an Object Wizard" on page 248.

2 Use the following topics as a guide to setting properties and performing tasks as you pass through the wizard panels:

   * **Properties** panel - [Defaults (SQL Server) - Properties](#).
   * **Dependencies** panel - [Defaults (SQL Server) - Dependencies](#).
   * **DDL View** panel - for details, see "[Previewing the DDL Generated to Create the New Object](#)" on page 250.

3 Finally, use the **Execute** button to create the object.
DEFAULTS (SQL SERVER) - PROPERTIES
When creating or editing a default, this tab/panel lets you work with the following settings:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Owner</td>
<td>Select the schema that is to own the default.</td>
</tr>
<tr>
<td>Name</td>
<td>Provide a name for the default.</td>
</tr>
<tr>
<td>Value</td>
<td>Provide the value of the default.</td>
</tr>
</tbody>
</table>

DEFAULTS (SQL SERVER) - DEPENDENCIES
From the Type dropdown, choose Column or Datatype, and if you chose Column, choose a Table from the Table dropdown. The list on the left is populated with candidate columns or datatypes. To move a candidate from the list on the left to the dependencies column on the right, select the candidate and click Add. Remove columns or datatypes from the dependencies list on the right by selecting the column or datatype and clicking Remove.

EXTENDED PROCEDURES WIZARD (SQL SERVER)
Extended Procedures are dynamic link libraries that can be used to load and execute application routines written in other programming languages, such as C or Visual Basic. Extended Procedures function and appear in the same manner as SQL Server stored procedures in that you can pass parameters to them and obtain results.

Extended stored procedures provide a method for calling procedural language functions from within the Adaptive Server.

**NOTE:** Extended procedures can only be created in the Master database.

To create a new Extended procedure using a wizard:
1. Open a creation wizard for an extended procedure. For details, see "Opening an Object Wizard" on page 248.
2. Use the following topics as a guide to setting properties and performing tasks as you pass through the wizard panels:
   - Properties panel - Extended Procedures (SQL Server) - Properties.
   - DDL View panel - for details, see "Previewing the DDL Generated to Create the New Object" on page 250.
3. Finally, use the Execute button to create the object.
EXTENDED PROCEDURES (SQL SERVER) - PROPERTIES
When creating or editing an extended procedure, this tab/panel lets you work with the following settings:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Owner</td>
<td>Select the owner of the extended procedure.</td>
</tr>
<tr>
<td>Name</td>
<td>Provide a name for the extended procedure.</td>
</tr>
<tr>
<td>Library</td>
<td>Provide the name of the DLL containing the extended procedure.</td>
</tr>
</tbody>
</table>

FOREIGN KEYS WIZARD (SQL SERVER)
Foreign keys are unique values that refer to specific columns of other tables. Thus, a foreign key links two tables together. Embarcadero Rapid SQL’s Foreign Key Wizard makes it easy for you to create a relational link between two tables, thereby speeding queries and giving you faster access to data. The column in the initial table, the parent table, is called the primary key. The corresponding column in the (child) table that references the primary key, is the foreign key. Foreign keys can also refer to columns within the same table.

To create a new Foreign Key using a wizard:
1. Open a creation wizard for a foreign key. For details, see "Opening an Object Wizard" on page 248.
2. Use the following topics as a guide to setting properties and performing tasks as you pass through the wizard panels:
   - Properties panel - Foreign Keys (SQL Server) - Properties.
   - Column Mapping panel - Foreign Keys (SQL Server) - Column Mapping.
   - DDL View panel - for details, see "Previewing the DDL Generated to Create the New Object" on page 250.
3. Finally, use the Execute button to create the object.

FOREIGN KEYS (SQL SERVER) - PROPERTIES
When creating or editing a foreign key, this tab/panel lets you work with the following settings:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table Owner and Table Name</td>
<td>Select the owner and name of the table for which the foreign key is being created.</td>
</tr>
<tr>
<td>Name</td>
<td>Provide a name for the foreign key.</td>
</tr>
<tr>
<td>Enabled</td>
<td>Enables or disables the foreign key.</td>
</tr>
<tr>
<td>Not For Replication</td>
<td>Replication copies and distributes data and database objects from one database to another and then synchronizes information between databases for consistency.</td>
</tr>
<tr>
<td>Delete Rule</td>
<td>If you choose the CASCADE option, all rows containing data involved with the foreign key will be deleted after a delete operation.</td>
</tr>
</tbody>
</table>
FOREIGN KEYS (SQL SERVER) - COLUMN MAPPING
Under Referenced Table, choose the Owner and then the Name of the referenced, or parent, table.

Under the Main Table, select check boxes corresponding to the columns that are to reference columns in the referenced table. Then, under Referenced Table, select the corresponding column check boxes.

FULL-TEXT CATALOGS WIZARD (SQL SERVER)
This wizard builds and submits a CREATE FULLTEXT CATALOG statement. This lets you add a full-text catalog to a database, specifying accent sensitivity and an owner, and letting you define the catalog as the default full-text catalog. You can also provide filegroup and root directory details.

Along with full-text indexes, full-text catalogs facilitate full-text searching. For related information, see "Full-text Indexes Wizard (SQL Server)" on page 334.

NOTE: Full-text catalogs cannot be created in the master catalog.

NOTE: Before working with full-text catalogs, consult Microsoft SQL Server documentation for general information on full-text searching and detailed information on topics such as restrictions on where these objects can be created, required permissions, virtual object and filegroup considerations, and the relationship with full-text indexes and the default collation. For more information, see "Accessing Third Party Documentation" on page 21.

To create a new full-text catalog using a wizard:
1. Open a creation wizard for a full-text catalog. For details, see "Opening an Object Wizard" on page 248.
2. Use the following topics as a guide to setting properties and performing tasks as you pass through the wizard panels:
   - Properties panel - for details, see Full-text Catalogs (SQL Server) - Properties.
   - DDL View panel - for details, see "Previewing the DDL Generated to Create the New Object" on page 250.
3. Finally, use the Execute button to create the object.
FULL-TEXT CATALOGS (SQL SERVER) - PROPERTIES
When creating or editing a full-text catalog, this tab/panel lets you work with the following settings:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Provide a name for the catalog.</td>
</tr>
<tr>
<td>Filegroup</td>
<td>Selecting a filegroup adds an explicit ON FILEGROUP clause, specifying the selected filegroup to which the catalog will belong. If not specified, the new catalog will be part of the default filegroup used for all full-text catalogs.</td>
</tr>
<tr>
<td>Path</td>
<td>Specifying a path adds an explicit IN PATH clause, specifying the root directory for the catalog. If no path is specified, the new catalog will be located in the default directory specified during setup.</td>
</tr>
<tr>
<td>Accent Sensitive</td>
<td>Lets you specify a WITH ACCENT_SENSITIVITY = ON/OFF clause, reflecting the selected/deselected status of the check box.</td>
</tr>
<tr>
<td>Default</td>
<td>Select this check box to add an AS DEFAULT argument, specifying that this catalog is the default full-text catalog. If an existing full-text catalog is currently specified as the default, this catalog becomes the new default.</td>
</tr>
<tr>
<td>Authorization Owner</td>
<td>Select a user or role to add an AUTHORIZATION argument that sets the owner of the full-text catalog.</td>
</tr>
</tbody>
</table>

FULL-TEXT INDEXES WIZARD (SQL SERVER)
This wizard lets you build and submit a CREATE FULLTEXT INDEX statement, adding a full-text index for a table or indexed view. Along with full-text catalogs, full-text indexes facilitate full-text searching.

**NOTE:** Full-text indexes cannot be created in the master catalog.

**NOTE:** Before working with full-text indexes, consult Microsoft SQL Server documentation for general information on full-text searching and detailed information on topics such as required permissions, column specification details, recommended datatype, and XML considerations. For more information, see "Accessing Third Party Documentation" on page 21.

To create a new full-text index using a wizard:
1. Open a creation wizard for a full-text index. For details, see "Opening an Object Wizard" on page 248.
2. Use the following topics as a guide to setting properties and performing tasks as you pass through the wizard panels:
   - **Properties** panel - for details, see Full-text Indexes (SQL Server) - Properties.
   - **Columns** panel - for details, see Full-text Indexes (SQL Server) - Columns.
   - **DDL View** panel - for details, see "Previewing the DDL Generated to Create the New Object" on page 250.
3. Finally, use the **Execute** button to create the object.
For related information, see "Full-text Catalogs Wizard (SQL Server)" on page 333.

**FULL-TEXT INDEXES (SQL Server) - PROPERTIES**

When creating or editing a full-text index, this tab/panel lets you work with the following settings:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Parent Type</td>
<td>Select table or indexed view.</td>
</tr>
<tr>
<td>Parent Schema</td>
<td>The parent's owning schema.</td>
</tr>
<tr>
<td>Parent Name</td>
<td>Select the name of the table or indexed view on which the index is to be created.</td>
</tr>
<tr>
<td>Key Index</td>
<td>Select the unique key index on the table or view that will be used as the value for the KEY INDEX argument.</td>
</tr>
<tr>
<td>Full-text Catalog Name</td>
<td>Select an existing full-text catalog. For information on creating full-text catalogs, see &quot;Full-text Catalogs Wizard (SQL Server)&quot; on page 333. If you do not select a catalog, SQL Server will assign the index to the default full-text catalog, generating an error if no default exists.</td>
</tr>
<tr>
<td>Filegroup Name (SQL Server 2008 ^)</td>
<td>Select the filegroup that the index is to be created on. Specifying no filegroup results in SQL Server default behavior, placing the index in the same filegroup as the base table or view for a non-partitioned table or in the PRIMARY filegroup for a partitioned table.</td>
</tr>
<tr>
<td>Change Tracking</td>
<td>Select a CHANGE_TRACKING argument value of MANUAL, AUTO, OFF, or OFF, NO POPULATION to specify whether changes to columns covered by the full-text index will be propagated to the full-text index.</td>
</tr>
<tr>
<td>Stoplist (SQL Server 2008 ^)</td>
<td>Select a STOPLIST argument value of OFF to specify that no stoplist be associated with the index or SYSTEM to specify that the default full-text system STOPLIST be used for this index.</td>
</tr>
</tbody>
</table>

**FULL-TEXT INDEXES (SQL Server) - COLUMNS**

When creating or editing a full-text index, this tab/panel lets you specify the columns that make up the index:

- For each column to include in the full-text index, select the associated Indexed check box.
- Optionally, select a language from the associated Language column.
- For varbinary(max) and image columns, provide a TYPE COLUMN argument filename extension.

**FUNCTIONS WIZARD (SQL Server)**

Functions are subroutines that you define so you can reuse code without having to reinvent the wheel each time. You can use functions to determine the best methods for controlling access and manipulation of the underlying data contained in an object. A function returns a value, unlike a stored procedure, which does not.

- To create a user-defined function, you need CREATE ANY privileges or IMPLICIT_SCHEMA authority on the database if the schema does not already exist.
To create a new function using a wizard:

1. Open a creation wizard for a function. For details, see "Opening an Object Wizard" on page 248.

2. Use the following topics as a guide to setting properties and performing tasks as you pass through the wizard panels:
   - Properties panel - for details, see Functions (SQL Server) - Properties.
   - Definition panel - for details, see Functions (SQL Server) - Definition.

3. Finally, use the Execute button to create the object.

FUNCTIONS (SQL Server) - PROPERTIES

When creating or editing a function, this tab/panel lets you work with the following settings:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Owner</td>
<td>Select the owner of the function.</td>
</tr>
<tr>
<td>Name</td>
<td>Provide a name for the function.</td>
</tr>
<tr>
<td>Schema Binding</td>
<td>Choose whether the function is bound to database objects that it references.</td>
</tr>
<tr>
<td>Encryption</td>
<td>Choose whether SQL Server encrypts table columns that contain the text of the CREATE FUNCTION statement.</td>
</tr>
</tbody>
</table>

FUNCTIONS (SQL Server) - DEFINITION

Complete the CREATE FUNCTION outline provided by typing or pasting the body of the function.

INDEXES WIZARD (SQL Server)

Like an index in a book, a table index helps you get at the data you want without having to read through the whole table. Indexes can exist on single column or on multiple columns. Indexes appear in the form of B-trees. And, as for books, you can have multiple indexes for a single table. You can also create indexes for a view.
To create a new index using a wizard:

1. Open a creation wizard for an index. For details, see “Opening an Object Wizard” on page 248.

2. Use the following topics as a guide to setting properties and performing tasks as you pass through the wizard panels:

   - **Properties** panel - Indexes (SQL Server) - Properties.
   - **Columns** panel - Indexes (SQL Server) - Columns.
   - **DDL View** panel - for details, see “Previewing the DDL Generated to Create the New Object” on page 250.

3. Finally, use the **Execute** button to create the object.

**INDEXES (SQL SERVER) - PROPERTIES**

When creating or editing an index, this tab/panel lets you work with the following settings:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Parent Type</strong></td>
<td>Select TABLE or VIEW.</td>
</tr>
<tr>
<td><strong>Parent Owner</strong></td>
<td>Select the owner of the table or view.</td>
</tr>
<tr>
<td><strong>Parent Name</strong></td>
<td>Select the specific table or view containing the columns you want to index.</td>
</tr>
<tr>
<td><strong>Name</strong></td>
<td>Provide a name for the index.</td>
</tr>
<tr>
<td><strong>Build Online</strong></td>
<td>Enabling this feature specifies that the ONLINE=ON clause is used when creating this object and can subsequently be used when rebuilding or dropping this object.</td>
</tr>
<tr>
<td><strong>Max degree of parallelism</strong></td>
<td>Lets you specify a MAXDOP index operation value, limiting the number of processors used in parallel plan execution.</td>
</tr>
<tr>
<td><strong>Index Type</strong></td>
<td>Select UNIQUE or NONUNIQUE. An index is unique when no two rows are permitted to have the same index value. (Note: A clustered index on a view must be unique.) If an INSERT or UPDATE statement creates a duplicate value, the operation may fail.</td>
</tr>
<tr>
<td><strong>Clustered</strong></td>
<td>A clustered index is one in which the physical order of rows matches the order of indexed rows. A table or view can only have one clustered index at a time. In a nonclustered index, the physical order of rows is independent of the indexed order of rows. For an indexed view, you can only create a nonclustered index if there is already a clustered index extant. With this check box enabled, subsequent rebuild and drop operations offer an online option.</td>
</tr>
<tr>
<td><strong>Ignore Duplicate Key</strong></td>
<td>This option controls what happens when an attempt is made to insert a duplicate key value into a column that is part of a unique clustered index. If the option is selected and an INSERT statement that creates a duplicate key is executed, SQL Server issues a warning and ignores the duplicate row. If not selected, SQL Server issues an error message and rolls back the entire INSERT statement.</td>
</tr>
<tr>
<td><strong>Statistics Recompute</strong></td>
<td>Enabling this feature means queries involving the table run at the optimal level as distribution statistics are updated automatically when the index is created. If you disable this option, you can compromise query performance.</td>
</tr>
</tbody>
</table>
CREATING OBJECTS

INDEXES (SQL SERVER) - COLUMNS
From the Column dropdown, select a column for the index and specify a Sort option. To add more columns, click the New button and then follow the steps in the last instruction. Use the Delete button to drop columns.

LOGINS WIZARD (SQL SERVER)
The Login wizard lets you build and submit a CREATE LOGIN statement, adding a new SQL Server, Windows, certificate-based, or asymmetric key-based login. The Login wizard also lets you:

- Add the login to fixed server roles
- Create user accounts for the login on selected databases
To create a new login using a wizard:

1. Open a creation wizard for a login. For details, see "Opening an Object Wizard" on page 248.

2. Use the following topics as a guide to setting properties and performing tasks as you pass through the wizard panels:

   - **Properties** panel - for details, see Logins (SQL Server) - Properties.
   - **Server Roles** panel - for details, see Logins (SQL Server) - Server Roles.
   - **Users** panel - for details, see Logins (SQL Server) - Users.
   - **DDL View** panel - for details, see "Previewing the DDL Generated to Create the New Object" on page 250.

3. Finally, use the **Execute** button to create the object.

**LOGINS (SQL SERVER) - PROPERTIES**

When creating or editing a login, this tab/panel lets you work with the following properties:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Specifies a name for this login.</td>
</tr>
<tr>
<td>Default Database</td>
<td>Lets you specify a DEFAULT_DATABASE argument, specifying a default database for this login.</td>
</tr>
<tr>
<td>Default Language</td>
<td>Lets you specify a DEFAULT_LANGUAGE argument, specifying a default language for this login.</td>
</tr>
</tbody>
</table>
| Account Type   | Lets you select one of the following login types:
|                | STANDARD - (SQL Server logins) if you select this type, you must also provide Password and Check Policy values.
|                | NTGROUP or NTUSER - (Windows logins) if you select one of these types, you must also provide a Domain value.
|                | CERTIFICATE - (certificate-mapped logins) if you select this type, you must also provide a Certificate value.
|                | ASYMMETRIC KEY - (asymmetric key-mapped logins) if you select this type, you must also provide an Asymmetric Key value.                  |
| Password       | This is only available for an Account Type of STANDARD. It lets you provide a password for the login.                                     |
| Check Policy   | This is only available for an Account Type of STANDARD. If selected, login policies defined on the server apply to this login.          |
| Check Expiration | This is only available if Check Policy is selected. If selected, password expiration policies are applied to this login.             |
| Must Change    | This is only available if Check Expiration is selected. If selected, the user will be prompted to change the password on the first login. |
| Domain         | This is only available for an Account Type of NTUSER or NTGROUP. Lets you specify the domain name value that will be specified with the loginName argument ([<domainName>\<loginName>]). |
LOGINS (SQL SERVER) - SERVER ROLES
When creating or editing a login, this tab/panel builds sp_addsrvrolemember procedure calls that will be submitted along with the CREATE LOGIN statement issued by this wizard/editor. This lets you add the login as a member of one or more fixed server roles (or common user-defined roles when selecting multiple databases) by selecting the check boxes associated with those roles.

For information on editing fixed server roles, see "Roles Editor (SQL Server)" on page 512.

LOGINS (SQL SERVER) - USERS
When creating or editing a role, this tab/panel lets you build CREATE USER... FOR LOGIN statements that will be submitted with the CREATE LOGIN statement issued with this wizard/editor. Maintain database user accounts for a login as follows:

• Add a user account for this login to a database by selecting a database from the Databases where the Login does NOT have a User Account and clicking the Add button. This opens the SQL Server User wizard, letting you define a new user on that database. For more information, see "Users Wizard (SQL Server)" on page 357.

• Remove a user account for this login from a database by selecting a database from the Databases where the Login HAS a User Account and clicking the Remove button.

PARTITION FUNCTIONS WIZARD (SQL SERVER)
The Partition Functions Wizard lets you build and submit a CREATE PARTITION FUNCTION statement, specifying a range, input parameter type, and boundary values. Once created, the partition function can be referenced by the partition scheme used to create a partitioned table or index.

NOTE: Before creating a partition function, consult Microsoft SQL Server documentation for detailed information on topics such as type restrictions and boundary value usage. For more information, see "Accessing Third Party Documentation" on page 21.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Certificate</td>
<td>This is only available for an Account Type of CERTIFICATE. It lets you specify the name of a certificate that is to be associated with this login. It lets you specify the name of a certificate that is to be associated with this login.</td>
</tr>
<tr>
<td>Asymmetric Key</td>
<td>This is only available for an Account Type of ASYMMETRIC KEY. It lets you specify the name of an asymmetric key that is to be associated with this login.</td>
</tr>
</tbody>
</table>
To create a new partition function using a wizard:

1. Open a creation wizard for a partition function. For details, see "Opening an Object Wizard" on page 248.

2. Use the following topics as a guide to setting properties and performing tasks as you pass through the wizard panels:
   - **Properties panel** - for details, see Partition Functions (SQL Server) - Properties.
   - **DDL View panel** - for details, see “Previewing the DDL Generated to Create the New Object” on page 250.

3. Finally, use the **Execute** button to create the object.

For related information, see the following topics:

- "Partition Schemes Wizard (SQL Server)" on page 341
- "Indexes Wizard (SQL Server)" on page 336
- "Tables Wizard (SQL Server)" on page 351

### PARTITION FUNCTIONS (SQL SERVER) - PROPERTIES

When creating or editing a partition function, this tab/panel lets you work with the following settings:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Name</strong></td>
<td>Provide a name for the partition function.</td>
</tr>
<tr>
<td><strong>Input Parameter Type</strong></td>
<td>Select the data type of the column used for partitioning.</td>
</tr>
<tr>
<td><strong>Range</strong></td>
<td>Select to which side of each functional value interval (LEFT, RIGHT) the functional value belongs, when interval values are sorted in ascending order from left to right.</td>
</tr>
<tr>
<td><strong>Function Values</strong></td>
<td>Lets you specify the boundary values to include as FOR VALUES arguments to the CREATE PARTITION FUNCTION statement. Each boundary value is a constant expression that can reference variables. The set of values provided define the partition points for an index or table partitioned using this function. Use the New, Delete, Up, and Down buttons to create and maintain the value list.</td>
</tr>
</tbody>
</table>

### PARTITION SCHEMES WIZARD (SQL SERVER)

The Partition Scheme Wizard builds and submits a CREATE PARTITION SCHEME statement, letting you specify a partition function and a file group mapping. Once created, the partition scheme can be referenced when creating a partitioned table or index.

**NOTE:** Before creating a partition scheme, consult Microsoft SQL Server documentation for detailed information on topics such as the relationship between the partition function and filegroups specified. For more information, see "Accessing Third Party Documentation" on page 21.
To create a new partition wizard using a wizard:
1. Open a creation wizard for a partition scheme. For details, see "Opening an Object Wizard" on page 248.
2. Use the following topics as a guide to setting properties and performing tasks as you pass through the wizard panels:
   - Properties panel - for details, see Partition Schemes (SQL Server) - Properties.
   - DDL View panel - for details, see “Previewing the DDL Generated to Create the New Object” on page 250.
3. Finally, use the Execute button to create the object.

For related information, see the following topics:
- "Partition Functions Wizard (SQL Server)" on page 340
- "Indexes Wizard (SQL Server)" on page 336
- "Tables Wizard (SQL Server)" on page 351

**PARTITION SCHEMES (SQL SERVER) - PROPERTIES**
When creating or editing a partition scheme, this tab/panel lets you work with the following settings:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Provide a name for the partition scheme.</td>
</tr>
<tr>
<td>Partition Function</td>
<td>Select the partition function that specifies the range, input parameter type, and boundary values for this partition scheme.</td>
</tr>
<tr>
<td>Filegroup Name</td>
<td>Lets you specify the names of the filegroups to store the partitions specified by the selected Partition Function. Consult Microsoft SQL Server documentation for details on the relation ship between filegroups and partitions. For more information, see &quot;Accessing Third Party Documentation&quot; on page 21. Use the New, Delete, Up, and Down buttons to create and maintain the value list.</td>
</tr>
</tbody>
</table>

**PRIMARY KEYS WIZARD (SQL SERVER)**
Primary key constraints make sure that no duplicate values or NULLS are entered in the columns you specify. You can use primary key constraints to enforce uniqueness and referential integrity. A table can only have a single primary key constraint.

The dialog box lets you specify the owner and table on which you want to place the primary key constraint.
To create a new primary key using a wizard:

1. Open a creation wizard for a primary key. For details, see "Opening an Object Wizard" on page 248.

2. Use the following topics as a guide to setting properties and performing tasks as you pass through the wizard panels:
   
   - **Properties** panel - Primary Keys (SQL Server) - Properties.
   - **Columns** panel - Primary Keys (SQL Server) - Properties.
   - **DDL View** panel - for details, see "Previewing the DDL Generated to Create the New Object" on page 250.

3. Finally, use the **Execute** button to create the object.

### PRIMARY KEYS (SQL Server) - PROPERTIES

When creating or editing a primary key, this tab/panel lets you work with the following settings:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Table Owner</strong> and <strong>Table Name</strong></td>
<td>Choose the owner and name of the table in which the primary key is being created.</td>
</tr>
<tr>
<td><strong>Name</strong></td>
<td>Provide a name of the primary key being created.</td>
</tr>
<tr>
<td><strong>Build Online</strong></td>
<td>Enabling this feature specifies that the ONLINE=ON clause is used when creating this object and can subsequently be used when rebuilding or dropping this object.</td>
</tr>
<tr>
<td><strong>Max degree of parallelism</strong></td>
<td>Lets you specify a MAXDOP index operation value, limiting the number of processors used in parallel plan execution.</td>
</tr>
<tr>
<td><strong>Clustered</strong></td>
<td>Enable or disable clustering. With this check box enabled, subsequent rebuild and drop operations offer an online option.</td>
</tr>
<tr>
<td><strong>File Group</strong></td>
<td>If you do not specify a filegroup, Microsoft SQL Server creates the index in the default filegroup.</td>
</tr>
<tr>
<td><strong>Fill Factor</strong></td>
<td>This specifies how full each index page that's storing data should be. The fill factor is a percentage value between 0 and 100.</td>
</tr>
</tbody>
</table>

### PRIMARY KEYS (SQL Server) - COLUMNS

From the **Column** dropdown, select a column for the primary key and specify a **Sort** option. To add more columns, click the **New** button and then follow the steps in the last instruction. Use the **Delete** button to drop columns.

### PROCEDURES WIZARD (SQL Server)

Procedures are a reusable block of PL/SQL, stored in the database, that applications can call. Procedures streamline code development, debugging, and maintenance by being reusable. Procedures enhance database security by letting you write procedures granting users execution privileges to tables rather than letting them access tables directly.
The Procedure Wizard lets you:

- Name the procedure and specify its body.
- Specify any execution options and you can encrypt the stored procedure text in syscomments.

**To create a new procedure using a wizard:**

1. Open a creation wizard for a procedure. For details, see "Opening an Object Wizard" on page 248.
2. Use the following topics as a guide to setting properties and performing tasks as you pass through the wizard panels:
   - **Properties** panel - for details, see Procedures (SQL Server) - Properties.
   - **Definition** panel - for details, see Procedures (SQL Server) - Definition.
3. Finally, use the Execute button to create the object.

**Procedures (SQL Server) - Properties**

When creating or editing a procedure, this tab/panel lets you work with the following settings:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Owner</td>
<td>Select the owner of the procedure.</td>
</tr>
<tr>
<td>Name</td>
<td>Provide a name for the procedure.</td>
</tr>
<tr>
<td>Procedure Number</td>
<td>Optionally, provide a procedure number. By using a number, you can group procedures of the same name together. This also enables you to drop them using only one DROP PROCEDURE statement. So, the procedures bill;1, bill;2, bill;3, etc. will be dropped simultaneously when the time comes.</td>
</tr>
<tr>
<td>Replication</td>
<td>This option creates a procedure that is used as a stored procedure filter and is executed only during replication.</td>
</tr>
<tr>
<td>Recompile</td>
<td>The plan for this procedure will not be cached and the procedure is recompiled when it is run. This option is appropriate when you’re using atypical or temporary values and you don’t want to override the execution plan cached in memory.</td>
</tr>
<tr>
<td>Encryption</td>
<td>If you select this option, SQL Server will encrypt the syscomments table entry containing the text of the CREATE PROCEDURE statement. It keeps the procedure from being published as part of replication.</td>
</tr>
</tbody>
</table>

**Procedures (SQL Server) - Definition**

Complete the CREATE PROCEDURE outline provided by typing or pasting the body of the procedure.
Creating Objects

Roles Wizard (SQL Server)
Roles are sets of user privileges you associate with access to objects within a database. Roles streamline the process of granting permissions. You can use roles to grant sets of permissions and privileges to users and groups. Roles can help you comply with Sarbanes Oxley regulations by limiting which users can have access to what privileges, for example a Human Resources Role versus an Accounting Role.

To create a new role using a wizard:
1. Open a creation wizard for a role. For details, see “Opening an Object Wizard” on page 248.
2. Use the following topics as a guide to setting properties and performing tasks as you pass through the wizard panels:
   - Properties panel - for details, see Roles (SQL Server) - Properties.
   - DDL View panel - for details, see “Previewing the DDL Generated to Create the New Object” on page 250.
3. Finally, use the Execute button to create the object.

After you click Finish and the role has been created, the Roles Editor open. You can then assign object and system privileges to the role and determine which users can take part in the role. For more information, see “Roles Editor (SQL Server)” on page 512.

Roles (SQL Server) - Properties
When creating or editing a role, this tab/panel lets you work with the following settings:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name used to reference the role.</td>
</tr>
<tr>
<td>RoleType</td>
<td>The value can be NONE, APPLICATION, or STANDARD.</td>
</tr>
<tr>
<td>Authorization Owner</td>
<td>Only required with a Role Type of STANDARD.</td>
</tr>
<tr>
<td>Password</td>
<td>Only required with a Role Type of APPLICATION.</td>
</tr>
</tbody>
</table>

Rules Wizard (SQL Server)
Rules promote data integrity by allowing you to validate the values supplied to a table column. They are reusable objects that you can bind to table columns or user datatypes. Check constraints are similar to rules, and are in fact the preferred way of restricting data. A column or user-defined data type can have only one rule bound to it, but a column can have both a rule and one or more check constraints associated with it. Not that a rule cannot apply to data already existing in the database at the time you’re creating the rule and can’t be bound to a system-created data type. If you create a new rule when one already exists, the new rule will override the previous one.
**To create a new rule using a wizard:**

1. Open a creation wizard for a rule. For details, see "Opening an Object Wizard" on page 248.
2. Use the following topics as a guide to setting properties and performing tasks as you pass through the wizard panels:
   - **Properties panel** - Rules (SQL Server) - Properties.
   - **Dependencies panel** - Rules (SQL Server) - Dependencies.
   - **DDL View** panel - for details, see "Previewing the DDL Generated to Create the New Object" on page 250.
3. Finally, use the **Execute** button to create the object.

**Rules (SQL Server) - Properties**

When creating or editing a rule, this tab/panel lets you work with the following settings:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Owner</td>
<td>Select the Owner of the rule.</td>
</tr>
<tr>
<td>Name</td>
<td>Provide a name for the rule.</td>
</tr>
<tr>
<td>Restriction</td>
<td>Type the condition. The rule restriction is the condition that defines the rule and can be any expression valid in a WHERE clause and can include such elements as arithmetic operators, relational operators, and predicates (for example, IN, LIKE, BETWEEN).</td>
</tr>
</tbody>
</table>

**Rules (SQL Server) - Dependencies**

From the **Type** dropdown, choose Column or Datatype, and if you chose **Column**, choose a Table from the **Table** dropdown. The list on the left is populated with candidate columns or datatypes. To move a candidate from the list on the left to the dependencies column on the right, select the candidate and click **Add**. Remove columns or datatypes from the dependencies list on the right by selecting the column or datatype and clicking **Remove**.

**Schema Wizard (SQL Server)**

Rapid SQL lets you create a schema on Microsoft SQL Server.
To create a new schema using a wizard:

1. Open a creation wizard for a schema. For details, see "Opening an Object Wizard" on page 248.
2. Use the following topics as a guide to setting properties and performing tasks as you pass through the wizard panels:
   - **Properties** panel - Schema (SQL Server) - Properties.
   - **Permissions** panel - "Setting Permissions or Privileges for an Object" on page 250.
   - **DDL View** panel - for details, see "Previewing the DDL Generated to Create the New Object" on page 250.
3. Finally, use the **Execute** button to create the object.

**Schema (SQL Server) - Properties**
When creating or editing a schema, this tab/panel lets you provide a **Name** and select the **Owner** of the schema.

**Schema (SQL Server) - Permissions**
For each specific permission to be granted, select the cell corresponding to the name and specific permission, and click the **Grant** button. To revoke a privilege, select a cell showing a Granted permission and click **Revoke**.

**Symmetric Keys Wizard (SQL Server)**
This wizard lets you build and submit a CREATE SYMMETRIC KEY statement.

To create a new symmetric key using a wizard

1. Open a creation wizard for a symmetric key. For details, see “Opening an Object Wizard” on page 248.
2. Use the following topics as a guide to setting properties and performing tasks as you pass through the wizard panels:
   - **Properties** panel - Symmetric Keys (SQL Server) - Properties.
   - **Encryption Mechanisms** panel - Symmetric Keys (SQL Server) - Encryption Mechanisms.
   - **DDL View** panel - for details, see "Previewing the DDL Generated to Create the New Object" on page 250.
3. Finally, use the **Execute** button to create the object.
### Symmetric Keys (SQL Server) - Properties

When creating or editing an asymmetric key, this tab/panel lets you work with the following settings:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Authorization Owner</td>
<td>The name of the user that will own the symmetric key.</td>
</tr>
<tr>
<td>Name</td>
<td>The name for the symmetric key</td>
</tr>
<tr>
<td>Provider Name</td>
<td>Lets you provide a FROM PROVIDER argument value, specifying an Extensible Key Management provider and name.</td>
</tr>
<tr>
<td>Key Algorithm</td>
<td>Lets you select a WITH ALGORITHM value of DES, AES_192, RC2, RC4_128, DESX, AES_128, TRIPLE_DES, or TRIPLE_DES_3KEY, specifying the encryption algorithm.</td>
</tr>
<tr>
<td>Pass Phrase</td>
<td>Lets you provide a KEY_SOURCE argument value, specifying a pass phrase from which to derive the key.</td>
</tr>
<tr>
<td>Identity Phrase</td>
<td>Lets you provide an IDENTITY_VALUE argument value, specifying an identity phrase from which to generate a GUID that tags data encrypted with a temporary key.</td>
</tr>
<tr>
<td>Key Name In Provider</td>
<td>Lets you provide a PROVIDER_KEY_NAME value, specifying the key name from the external provider.</td>
</tr>
<tr>
<td>Creation Disposition</td>
<td>Lets you select a CREATION_DISPOSITION value of OPEN_EXISTING or CREATE_NEW, specifying whether the symmetric key is mapped to an existing EKM key or a new key is created on the EKM device.</td>
</tr>
</tbody>
</table>

For context information such as opening the wizard or editor for this object type, see "Symmetric Keys Wizard (SQL Server)" on page 347 and "Synonyms Wizard (SQL Server)" on page 350.

### Symmetric Keys (SQL Server) - Encryption Mechanisms

When creating or editing a symmetric key, this tab/panels lets you provide an ENCRYPTION BY... argument, and indicate the specific asymmetric key, symmetric keys, or certificate used to encrypt the key being created or the password from which to derive a TRIPLE_DES key.

The **Used Encryption Mechanisms** lists the symmetric key, asymmetric key, certificate, or password options currently included in the ENCRYPTION BY argument. Selecting ASYMMETRIC KEYS, CERTIFICATES, PASSWORD, or SYMMETRIC KEYS from the **Encryption Type** dropdown displays the list of available elements of that type in the **Existing Encryption Mechanisms** list.
To specify encrypting mechanisms for a symmetric key
1. From the **Encryption Type** dropdown, select an option among ASYMMETRIC KEYS, CERTIFICATES, PASSWORD, or SYMMETRIC KEYS.
2. Take one of the following actions:
   - Select CERTIFICATE or ASYMMETRIC KEY from the **Encryption Type** dropdown to display elements of that type in the **Existing Encryption Mechanisms** list. Select a specific certificate or asymmetric key and click **Add** to move that element to the **Used Encryption Mechanisms** list.
   - Select SYMMETRIC KEY from the **Encryption Type** dropdown to display elements of that type in the **Existing Encryption Mechanisms** list. Select a specific symmetric key and click **Add** to open the **Open Key** dialog. For more information on opening and decrypting the key, see "Opening a Symmetric Key" on page 349.
   - Select PASSWORD from the **Encryption Type** dropdown and click **Add** to open the **Add Password** dialog. That dialog lets you add an ENCRYPTION BY PASSWORD argument. Use the **Password** control to provide the ENCRYPTION BY PASSWORD value. Click **OK** to add the password to the **Used Encryption Mechanisms** list.
3. Repeat step 1 and step 2 to add more encrypting mechanisms for this symmetric key.

To remove an encryption mechanism from an asymmetric key
1. Select an item from the **Used Encryption Mechanisms** list.
2. Click **Remove**.

For context information such as opening the wizard or editor for this object type, see "Symmetric Keys Wizard (SQL Server)" on page 347 and "Synonyms Wizard (SQL Server)" on page 350.

For information on creating asymmetric keys or certificates to be used with the encryption method for this key, see "Asymmetric Keys Wizard (SQL Server)" on page 325 and "Certificate Wizard (SQL Server)" on page 327.

**OPENING A SYMMETRIC KEY**
When specifying a symmetric keys as the encryption mechanism, you must decrypt the symmetric key and make it available for use. The **Open Key** dialog lets you build an OPEN SYMMETRIC KEY that will precede the CREATE SYMMETRIC KEY statement submitted to create or edit a symmetric key.

Use the **Certificate** control to provide a DECRYPTION BY CERTIFICATE value and the **Password** control to provide a WITH PASSWORD value. Click **Open Key** to add the symmetric key to the **Used Encryption Mechanisms** list.

**NOTE:** This functionality is available for Microsoft SQL Server only.
CREATING OBJECTS

To open a symmetric key
1. Open a creation wizard or editor for a symmetric key. For details, see "Opening an Object Wizard" on page 248 and "Opening an Object Editor" on page 444.
2. Select the Encryption Mechanisms tab.
3. Select Symmetric Keys from the Encryption Type dropdown, select a symmetric key from the Existing Encryptions Mechanisms list, and then click Add.
   Rapid SQL opens the Open Key dialog.
4. Use the following table as a guide to understanding and modifying settings in the dialog:

<table>
<thead>
<tr>
<th>Step</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action options</td>
<td>Lets you work with the following settings:</td>
</tr>
<tr>
<td></td>
<td>Decryption Mechanism and Certificate/ Symmetric Key/ Asymmetric Key/Password</td>
</tr>
<tr>
<td></td>
<td>Password</td>
</tr>
<tr>
<td>Preview</td>
<td>Displays the DDL that will execute the object action. For details, see &quot;Preview&quot; on page 576.</td>
</tr>
</tbody>
</table>

5. Click Open Key to dismiss the dialog and return to the Symmetric Key wizard or editor.

SYNONYMS WIZARD (SQL SERVER)
This wizard builds and submits a CREATE SYNONYM statement, letting you build a one-part name that can be used in SQL statements instead of a fully-qualified, multi-part name.

To create a new synonym using a wizard:
1. Open a creation wizard for a synonym. For details, see "Opening an Object Wizard" on page 248.
2. Use the following topics as a guide to setting properties and performing tasks as you pass through the wizard panels:
   • Properties panel - for details, see Synonyms (SQL Server) - Properties.
   • Permissions panel - "Setting Permissions or Privileges for an Object" on page 250
   • DDL View panel - for details, see "Previewing the DDL Generated to Create the New Object" on page 250.
3. Finally, use the Execute button to create the object.
SYNONYMS (SQL Server) - Properties

When creating a synonym, this tab/panel lets you provide a synonym name and fully qualify the object name that it references. When editing a synonym, this tab/panel lets you view the synonym definition.

NOTE: Before creating or editing a synonym, consult Microsoft SQL Server documentation for information on topics such as support for specific function and procedure types, and three-part and four-part name restrictions. For assistance, see "Accessing Third Party Documentation" on page 21.

The following table describes the available settings:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Schema and Name</td>
<td>Use these settings to select an owner and type the one-part name that will be used to reference the object. Optionally, you can use the server, database, and owner settings to construct a partially-qualified to fully-qualified name for the object. The user interface will allow you to construct all valid, multi-part name variations (for example: server.database.owner.object, database.owner.object, owner.object, server...object).</td>
</tr>
</tbody>
</table>

TABLES WIZARD (SQL Server)

A table is a column-based arrangement of data in which the content of one column has a bearing on the other column(s). So, for example, a table might have a column for authors, another column for the books each author has written, and a third for the number of copies each title by a given author has sold. The data moves across the columns in rows.

You must have CREATE TABLE permissions to generate a new table.

To create a new table using a wizard:

1. Open a creation wizard for a table. For details, see "Opening an Object Wizard" on page 248.

2. Use the following topics as a guide to setting properties and performing tasks as you pass through the wizard panels:
   - Dependencies panel - Tables (SQL Server) - Properties.
   - Columns panel - Tables (SQL Server) - Columns.
   - Indexes panel - Tables (SQL Server) - Indexes.
   - Constraints panel - Tables (SQL Server) - Constraints.
   - Permissions panel - "Setting Permissions or Privileges for an Object" on page 250.
   - DDL View panel - for details, see "Previewing the DDL Generated to Create the New Object" on page 250.
3 Finally, use the **Execute** button to create the object.

### TABLES (SQL Server) - PROPERTIES

When creating or editing a table, this tab/panel lets you work with the following settings:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Schema</strong></td>
<td>Select the owner of the table.</td>
</tr>
<tr>
<td><strong>Name</strong></td>
<td>Provide a name for the table.</td>
</tr>
<tr>
<td><strong>ANSI_NULLS option</strong></td>
<td>By setting this option, you are setting ANSI_NULLS, ANSI_PADDING, ANSI_WARNINGS, and QUOTED_IDENTIFIER to on so the table can be used in an Indexed View.</td>
</tr>
<tr>
<td><strong>Partitioned</strong></td>
<td>When selected, an ON clause is added to the CREATE TABLE statement, letting you specify a <strong>Partition Scheme</strong>, partitioning this index.</td>
</tr>
<tr>
<td><strong>Partition Scheme</strong></td>
<td>This property is only available if the <strong>Partitioned</strong> check box is selected.  &lt;br&gt; Select the partition scheme that specifies the filegroup mapping for this index. For information on creating partition schemes, see &quot;Partition Schemes Wizard (SQL Server)&quot; on page 341.</td>
</tr>
<tr>
<td><strong>Filegroup</strong></td>
<td>This property is only available if the <strong>Partitioned</strong> check box is not selected.  &lt;br&gt; Select an existing, named filegroup to have the table stored on the specified filegroup. Select PRIMARY to have the table stored on the default database filegroup.</td>
</tr>
<tr>
<td><strong>Text Image Filegroup</strong></td>
<td>Select an existing, named filegroup to have text, ntext, image, xml, varchar(max), nvarchar(max), varbinary(max), and CLR user-defined type columns stored on the specified filegroup. Select PRIMARY to have columns of those types stored on the default database filegroup.</td>
</tr>
</tbody>
</table>

### TABLES (SQL Server) - COLUMNS

Use the **Add Column** button to add the columns for the table. After providing a **Name** for a new column, you can modify column properties in the **Property/Value** list. Available properties depend on the datatype you choose as well as on the property values you select:

- **Computed** and **Computed Expression** - Let you define a column as a computed column and provide the computed column expression.
- **Type** - Lets you select a datatype (depending on the type, additional properties such as **Size**, **Width**, and **Scale** may be available).
- **Identity Column** - Select this check box to define the column as an identity column.
- **Allow Nulls** - Select this check box to allow nulls in this column.
- **Default Collation** - available for text/character datatypes, lets you specify a default collation.
- **Default Value** - Lets you type a constant value or select a function returning a constant value to serve as the default for the column
- **Default Binding** and **Rule Binding** - Let you bind a rule or default to a column.
**Is Sparse** - Available to columns that allow NULL values, optimizes storage of the column for null values. This property does apply to the following data types: text, ntext, image, timestamp, user-defined data type, geometry, or geography. Columns with default values, default or rule bindings, cannot be defined as sparse. Computed columns cannot be defined as Sparse, but the columns in the computed expression can be Sparse columns.

Optionally, you can select a column and modify its values or select a column and **Delete** it.

**NOTE:** If you create a table with a Column datatype = text., you can set the storage and image values on the Storage tab of the Tables Editor Storage tab. When you have a text datatype, the Storage tab displays a Text In Row box where you can specify the maximum size to be stored.

**NOTE:** Because the smalldatetime datatype stores dates and time with less precision than the datetime datatype, before outputting you use the CAST or CONVERT functions to convert any boxes with the smalldatetime datatype to either VARCHAR or datetime datatypes. For more information, see SQL Server Books Online, Transact-SQL Reference.

**TABLES (SQL SERVER) - INDEXES**
Click **Add** to open the Index Wizard. For details, see "Indexes Wizard (SQL Server)" on page 336.

**TABLES (SQL SERVER) - CONSTRAINTS**
Selecting a constraint type and clicking **Add** opens the object wizard for that object type. For details see:
- "Primary Keys Wizard (SQL Server)" on page 342
- "Unique Keys Wizard (SQL Server)" on page 355
- "Foreign Keys Wizard (SQL Server)" on page 332
- "Create Synonym" on page 609

**TRIGGERS WIZARD (SQL SERVER)**
Triggers are a special type of procedure that automatically fire when defined data modification operations (insert, update, or delete) occur on a target table or view. Triggers fire after an insert, update or delete, but belong to the same transaction as the data modification operation. Triggers can be implemented to enforce business rules or referential data integrity.

**Important Notes**
- For more information on the syntax for Trigger bodies, consult the Microsoft SQL Server Transact-SQL Documentation.
To create a new trigger using a wizard:

1. Open a creation wizard for a trigger. For details, see "Opening an Object Wizard" on page 248.

2. Use the following topics as a guide to setting properties and performing tasks as you pass through the wizard panels:
   - **Properties** panel - for details, see Triggers (SQL Server) - Properties.
   - **Definition** panel - for details, see Triggers (SQL Server) - Definition.

3. Finally, use the **Execute** button to create the object.

   **NOTE:** You can use the Trigger Editor opens to create dependencies or alter the trigger statement.

**Triggers (SQL Server) - Properties**

When creating or editing a trigger, this tab/panel lets you work with the following settings:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Parent Type</strong></td>
<td>Select the TABLE or VIEW on which the trigger is to be created.</td>
</tr>
<tr>
<td><strong>Parent Schema</strong></td>
<td>Select the owner of the table or view on which the trigger is to be created.</td>
</tr>
<tr>
<td><strong>Parent Name</strong></td>
<td>Select the specific table or view in which the trigger is to be created.</td>
</tr>
<tr>
<td><strong>Name</strong></td>
<td>Provide a name for the trigger.</td>
</tr>
<tr>
<td><strong>Trigger Timing</strong></td>
<td>INSTEAD OF: This is the only option for a View trigger. An INSTEAD OF trigger fires in place of the triggering statement and will not make changes to the data unless the conditions of the INSTEAD OF statement are met first. So, your UPDATE execution statement is replaced by an INSTEAD OF UPDATE statement as a way to enforce particular business rules you establish. AFTER: An AFTER trigger fires following the successful completion of the triggering action. So, for example, the trigger would fire after an UPDATE statement has executed and after constraints have been checked and verified.</td>
</tr>
<tr>
<td><strong>Fire On Insert</strong></td>
<td>An INSERT trigger must be associated with an INSERT statement. For example, if a data load operation doesn’t include an INSERT statement, the trigger won’t be invoked.</td>
</tr>
<tr>
<td><strong>Fire On Update</strong></td>
<td>An UPDATE trigger can be associated with specific columns of the base table and will only be activated if those columns are updated.</td>
</tr>
<tr>
<td><strong>Fire On Delete</strong></td>
<td>A DELETE trigger is associated with a DELETE operation.</td>
</tr>
<tr>
<td><strong>Encrypted</strong></td>
<td>If you choose to encrypt the trigger, the trigger can’t be published as part of SQL Server replication.</td>
</tr>
</tbody>
</table>

4. Finally, use the **Execute** button to create the object.

**Triggers (SQL Server) - Definition**

Complete the CREATE TRIGGER outline provided by typing or pasting the body of the trigger.
**Unique Keys Wizard (SQL Server)**

Unique keys can enforce logical keys that are not chosen as the primary key. In other words, you can use a unique key to ensure no duplicate values are entered in specific columns that are not a part of the primary key. Although you can only attach one primary key to a table, you can attach multiple unique keys. Also, you can use unique keys on columns that allow null values.

**To create a new unique key using a wizard:**

1. Open a creation wizard for a unique key. For details, see "Opening an Object Wizard" on page 248.

2. Use the following topics as a guide to setting properties and performing tasks as you pass through the wizard panels:
   - **Properties** panel - [Unique Keys (SQL Server) - Properties](#).
   - **Columns** panel - [Unique Keys (SQL Server) - Columns](#).
   - **DDL View** panel - for details, see "Previewing the DDL Generated to Create the New Object" on page 250.

3. Finally, use the **Execute** button to create the object.

**Unique Keys (SQL Server) - Properties**

When creating or editing a unique key, this tab/panel lets you work with the following settings:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Table Owner and Table Name</strong></td>
<td>Choose the owner and name of the table in which the unique key is being created.</td>
</tr>
<tr>
<td><strong>Name</strong></td>
<td>Provide a name of the unique key being created.</td>
</tr>
<tr>
<td><strong>Build Online</strong></td>
<td>Enabling this feature specifies that the ONLINE=ON clause is used when creating this object and can subsequently be used when rebuilding or dropping this object.</td>
</tr>
<tr>
<td><strong>Max degree of parallelism</strong></td>
<td>Lets you specify a MAXDOP index operation value, limiting the number of processors used in parallel plan execution.</td>
</tr>
<tr>
<td><strong>Clustered</strong></td>
<td>Enable or disable clustering. With this check box enabled, subsequent rebuild and drop operations offer an online option.</td>
</tr>
<tr>
<td><strong>File Group</strong></td>
<td>If you do not specify a filegroup, Microsoft SQL Server creates the unique key in the default filegroup.</td>
</tr>
<tr>
<td><strong>Fill Factor</strong></td>
<td>This specifies how full each index page that's storing data should be. The fill factor is a percentage value between 0 and 100.</td>
</tr>
</tbody>
</table>

**Unique Keys (SQL Server) - Columns**

From the **Column** dropdown, select a column for the primary key and specify a **Sort** option. To add more columns, click the **New** button and then follow the steps in the last instruction. Use the Delete button to drop columns.
USER MESSAGES WIZARD (SQL SERVER)

The User Message wizard lets you create multiple-language versions of user messages, such as errors and warnings, associated with a single message number. Key properties include the severity level and whether the message is automatically written to the NT Event Log.

NOTE: The user messages node only displays under the master database.

To create a new user message using a wizard:
1. Open a creation wizard for a user message. For details, see "Opening an Object Wizard" on page 248.
2. Use the following topics as a guide to setting properties and performing tasks as you pass through the wizard panels:
   - Properties panel - for details, see User Messages (SQL Server) - Properties.
   - Information panel - for details, see User Messages (SQL Server) - Information.
   - Object Permissions and System Permissions panels - "Setting Permissions or Privileges for an Object" on page 250
   - DDL View panel - for details, see "Previewing the DDL Generated to Create the New Object" on page 250.
3. Finally, use the Execute button to create the object.

USER MESSAGES (SQL SERVER) - PROPERTIES

When creating or editing a user message, this tab/panel lets you work with the following settings:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Message Number</td>
<td>Lets you specify a message number. The number must be greater than 50,000. The wizard automatically loads a value one higher than the currently highest used message number, but you can override the value.</td>
</tr>
<tr>
<td>Severity</td>
<td>Lets you select a predefined severity level between 001 and 025. The levels and their meanings are indicated in the User Message editor.</td>
</tr>
<tr>
<td>Write to NT Event Log</td>
<td>Lets you specify that the message is always written to the Windows NT Event Log.</td>
</tr>
</tbody>
</table>

USER MESSAGES (SQL SERVER) - INFORMATION

Let you create the different language versions of the text for the message. The first version must be created in us_english. Click the Add new text for the user message button, and in the dialog box that opens, select a Language of us_english and provide the Message Text.

You can subsequently use the same process to create each different language version of the us_english message.

NOTE: You cannot create two versions of a message for the same language.
This tab/panel also lets you edit and delete messages.

**USERS WIZARD (SQL SERVER)**

The User Wizard lets you create a user who will then have access to the database where you are registering him or her. You can also identify the appropriate user group and the system privileges you want to assign to the new user.

**To create a new user using a wizard:**

1. Open a creation wizard for a user. For details, see "Opening an Object Wizard" on page 248.
2. Use the following topics as a guide to setting properties and performing tasks as you pass through the wizard panels:
   - **Properties** panel - Users (SQL Server) - Properties.
   - **Roles** panel - Users (SQL Server) - Roles.
   - **DDL View** panel - for details, see "Previewing the DDL Generated to Create the New Object" on page 250.
3. Finally, use the **Execute** button to create the object.

**USERS (SQL SERVER) - PROPERTIES**

When creating or editing a user, this tab/panel lets you work with the following settings:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Login Name</td>
<td>Select the server login associated with this user.</td>
</tr>
<tr>
<td>Name</td>
<td>Provide the user name.</td>
</tr>
</tbody>
</table>

**USERS (SQL SERVER) - ROLES**

For each role to be assigned to the user, select the check box beside that role.

**USER DATATYPES WIZARD (SQL SERVER)**

User datatypes promote domain consistency by streamlining the definition of commonly used table columns in a database. You can build a customized datatype from system datatypes and bind defaults and rules to it to enhance integrity. When you reference the user datatype in a column, the column assumes all of the properties of the user datatype.
To create a new user datatype using a wizard:

1. Open a creation wizard for a user datatype. For details, see "Opening an Object Wizard" on page 248.

2. Use the following topics as a guide to setting properties and performing tasks as you pass through the wizard panels:
   - **Properties** panel - User Datatypes (SQL Server) - Properties.
   - **DDL View** panel - for details, see "Previewing the DDL Generated to Create the New Object" on page 250.

3. Finally, use the **Execute** button to create the object.

**User Datatypes (SQL Server) - Properties**

When creating or editing a user datatype, this tab/panel lets you work with the following settings:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Owner</td>
<td>Select the owner of the user datatype.</td>
</tr>
<tr>
<td>Datatype</td>
<td>Provide a name for the datatype.</td>
</tr>
<tr>
<td>Type</td>
<td>Select the base datatype.</td>
</tr>
<tr>
<td>Size</td>
<td>Provide the size of the datatype.</td>
</tr>
<tr>
<td>Allow Nulls</td>
<td>Null has no explicitly assigned value. Null is not equivalent to zero or blank. A value of null is not considered to be greater than, less than, or equivalent to any other value, including another value of null.</td>
</tr>
<tr>
<td>Default Binding</td>
<td>Defaults promote data integrity by supplying a default value to a column if the user does not explicitly provide one. They are reusable objects that you can bind to user datatypes.</td>
</tr>
<tr>
<td>Rule Binding</td>
<td>Rules promote data integrity by allowing you to validate the values supplied to a column. They are reusable objects that you can bind to user datatypes.</td>
</tr>
</tbody>
</table>

**Views Wizard (SQL Server)**

Views are SQL queries stored in the system catalog that customize the display of data contained in one or more tables. Views behave like tables because you can query views and perform data manipulation operations on them. However, views do not actually store any data. Instead, they depend on data contained in their base tables.

To create a new view using a wizard:

1. Open a creation wizard for a view. For details, see "Opening an Object Wizard" on page 248.

2. Use the following topics as a guide to setting properties and performing tasks as you pass through the wizard panels:
   - **Properties** panel - for details, see Views (SQL Server) - Properties.
   - **Definition** panel - for details, see Views (SQL Server) - Definition.
3  Finally, use the **Execute** button to create the object.

**VIEWS (SQL SERVER) - PROPERTIES**
When creating or editing a view, this tab/panel lets you work with the following settings:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Owner</td>
<td>Select the owner of the view. The owner of the view must have SELECT privileges for the tables in the CREATE view statement or DBADM authority on the database that contains the table.</td>
</tr>
<tr>
<td>Name</td>
<td>Provide a name for the view.</td>
</tr>
<tr>
<td>Encryption</td>
<td>If you select this option, the view will not be published with SQL Server replication.</td>
</tr>
<tr>
<td>Schema Binding</td>
<td>When you specify this option, the base table or tables cannot be modified in a way that would affect the view definition. The view definition itself must first be modified or dropped to remove dependencies on the table that is to be modified</td>
</tr>
<tr>
<td>Check Condition</td>
<td>When a row is modified through a view, this option makes sure the data remains visible through the view after the modification is committed.</td>
</tr>
<tr>
<td>Owner</td>
<td>Select the owner of the view. The owner of the view must have SELECT privileges for the tables in the CREATE view statement or DBADM authority on the database that contains the table.</td>
</tr>
</tbody>
</table>

**VIEWS (SQL SERVER) - DEFINITION**
Complete the CREATE VIEW statement by typing or pasting in the relevant query.

**MYSQL OBJECT WIZARDS**
Rapid SQL lets you create MySQL objects using the following wizards:

- Databases wizard (MySQL)
- Foreign Keys wizard (MySQL)
- Functions wizard (MySQL)
- Indexes, Primary Keys, or Unique Keys wizard (MySQL)
- Tables wizard (MySQL)
- Users wizard (MySQL)

**DATABASES WIZARD (MYSQL)**
The MySQL Database Wizard lets you build and execute a basic CREATE DATABASE statement and grant privileges on the database.
To create a new database using a wizard:
1. Open a creation wizard for a database. For details, see "Opening an Object Wizard" on page 248.
2. Use the following topics as a guide to setting properties and performing tasks as you pass through the wizard panels:
   - Properties panel - for details, see Databases - Properties
   - Privileges panel - "Setting Permissions or Privileges for an Object" on page 250
   - DDL View panel - for details, see "Previewing the DDL Generated to Create the New Object" on page 250.
3. Finally, use the Execute button to create the object.

DATABASES - PROPERTIES
When creating or editing database, this tab/panel lets you work with the following settings:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Database Name</td>
<td>The database name you choose can be up to 64 characters long. Feel free to use all alphabetic characters or mix in some special or numeric characters. But a name cannot be exclusively special or numeric characters.</td>
</tr>
<tr>
<td>Default Character Set</td>
<td>This is the character set for a language or alphabet. If you do not make a selection from the drop-down list (click the arrow to see the choices), the database will use the server's default character set.</td>
</tr>
<tr>
<td>Collation</td>
<td>The collation encodes the rules governing character used for a language (like Greek) or an alphabet. The database will use the server's default collation unless you specify otherwise.</td>
</tr>
</tbody>
</table>

**NOTE:** It’s possible to create databases with different character sets and collations on the same MySQL server.

FOREIGN KEYS WIZARD (MYSQL)
The MySQL Foreign Keys Wizard lets you build and execute an ALTER TABLE statement with an ADD CONSTRAINT option implementing a foreign key.

The wizard makes it easy for you to create a relational link between two tables, thereby speeding queries and giving you faster access to data. By using the Create Foreign Key Wizard you obviate the need for remembering the code underlying the creation process.
To create a new foreign key using a wizard:
1. Open a creation wizard for a foreign key. For details, see “Opening an Object Wizard” on page 248.
2. Use the following topics as a guide to setting properties and performing tasks as you pass through the wizard panels:
   - **Properties** panel - for details, see Foreign Keys - Properties
   - **Column Mapping** panel - for details, see Foreign Keys - Column Mapping
   - **DDL View** panel - for details, see “Previewing the DDL Generated to Create the New Object” on page 250.
3. Finally, use the **Execute** button to create the object.

**FOREIGN KEYS - PROPERTIES**
When creating or editing a foreign key, this tab/panel lets you work with the following settings:

<table>
<thead>
<tr>
<th>Group</th>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Constraint Name</td>
<td>System Generated and User Specified</td>
<td>The constraint name must be unique. You can either rely on MySQL to assign a unique name or you can specify one.</td>
</tr>
<tr>
<td>Constraint State</td>
<td>On Update and On Delete</td>
<td>Lets you specify ON UPDATE and ON DELETE values of NO ACTION, CASCADE, RESTRICT, or SET NULL.</td>
</tr>
</tbody>
</table>

**FOREIGN KEYS - COLUMN MAPPING**
1. Under **Referenced Table**, choose the **Database** and then the referenced, or parent, **Table**.
2. Under the **Main Table**, select the referencing **Table**.
3. Under the **Main Table**, select the check box corresponding to the referring column and then under **Referenced Table**, select the check box corresponding to the referenced column.

**FUNCTIONS WIZARD (MYSQL)**
The MySQL Functions Wizard lets you build and submit a CREATE FUNCTION declaration, specifying a return type and the owning library.

**NOTE:** Functions must be written in C or C++, your operating system must support dynamic loading, and you must have compiled mysqld dynamically (not statically).
CREATING OBJECTS

To create a new function using a wizard:
1. Open a creation wizard for a function. For details, see "Opening an Object Wizard" on page 248.
2. Use the following topics as a guide to setting properties and performing tasks as you pass through the wizard panels:
   • Properties panel - for details, see Functions - Properties.
   • DDL View panel - for details, see "Previewing the DDL Generated to Create the New Object" on page 250.
3. Finally, use the Execute button to create the object.

FUNCTIONS - PROPERTIES
When creating or editing a function, this tab/panel lets you work with the following settings:

<table>
<thead>
<tr>
<th>Required Information</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Function Name</td>
<td>In 64 characters or less, you can name your function.</td>
</tr>
<tr>
<td>Return Value</td>
<td>STRING, REAL (also known as Double), INTEGER</td>
</tr>
<tr>
<td>Shared Object Library</td>
<td>Identify the file that holds the library where your functions are stored.</td>
</tr>
<tr>
<td>Aggregate</td>
<td>Check the box if the function you are creating will collapse a large amount of data into a single output, or aggregate the data.</td>
</tr>
</tbody>
</table>

INDEXES, PRIMARY KEYS, OR UNIQUE KEYS WIZARD (MYSQL)
The Indexes Wizard, Primary Keys Wizard, and Unique Keys wizard offer the same steps in creating these MySQL objects.

To create a new index, primary key, or unique key using a wizard:
1. Open a creation wizard for an index, primary key, or unique key. For details, see "Opening an Object Wizard" on page 248.
2. Use the following topics as a guide to setting properties and performing tasks as you pass through the wizard panels:
   • Properties panel - for details, see Indexes, Primary Keys, or Unique Keys - Properties
   • DDL View panel - for details, see "Previewing the DDL Generated to Create the New Object" on page 250.
3. Finally, use the Execute button to create the object. For more information, see "Previewing the DDL Generated to Create the New Object" on page 250.
INDEXES, PRIMARY KEYS, OR UNIQUE KEYS - PROPERTIES
When creating or editing an index, primary key, or unique key, this tab/panel lets you work with the following settings:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table Name</td>
<td>Select the table on which you want to create the object.</td>
</tr>
<tr>
<td>Index Name</td>
<td>Provide a name of up to 64 alphanumeric characters.</td>
</tr>
<tr>
<td>Constraint Type</td>
<td>Primary: Each record of a table is identified as uniquely and relates to a foreign key in another table.</td>
</tr>
<tr>
<td></td>
<td>Unique: Ensures that there is no duplication between values in columns where you place this constraint.</td>
</tr>
<tr>
<td></td>
<td>Full Text: Enables the search for several words in arbitrary order in a table.</td>
</tr>
<tr>
<td></td>
<td>Spatial: Allows you to find records that are defined by location, or geometry types.</td>
</tr>
<tr>
<td>Index Storage Type</td>
<td>Hash: Used for equality comparisons. Only whole keys can be used to search for a row.</td>
</tr>
<tr>
<td></td>
<td>BTree: Tree data structure that keeps data sorted. BTrees grow from the bottom up as elements are inserted.</td>
</tr>
<tr>
<td></td>
<td>RTree: Tree data structure used for spatial indexes and access to multidimensional information.</td>
</tr>
<tr>
<td>Specify Columns in Index</td>
<td>Columns are listed by name and datatype and whether or not they are nullable. As you check selections, the sort order is identified.</td>
</tr>
</tbody>
</table>

TABLES WIZARD (MYSQL)
The MySQL Table Wizard lets you create a basic table definition.

To create a new table using a wizard:
1. Open a creation wizard for a table. For details, see "Opening an Object Wizard" on page 248.
2. Use the following topics as a guide to setting properties and performing tasks as you pass through the wizard panels:
   - Properties panel - for details, see Tables - Properties
   - Columns panel - for details, see Tables - Columns
   - Indexes panel - for details, see Tables - Indexes
   - Foreign Keys panel - for details, see Tables - Foreign Keys
   - MERGE tables panel - for details, see Tables - MERGE Tables
   - Privileges panel - for details, see "Setting Permissions or Privileges for an Object" on page 250
   - DDL View panel - for details, see "Previewing the DDL Generated to Create the New Object" on page 250
3. Finally, use the Execute button to create the object.
TABLES - PROPERTIES
When creating or editing a table, this tab/panel lets you work with the following properties:

**NOTE:** Prior to working with MySQL table properties, you should have a detailed understanding of MySQL table creation options. For access to MySQL documentation, see "Accessing Third Party Documentation" on page 21.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Table Name</strong></td>
<td>Provide a unique name of up to 64 characters.</td>
</tr>
<tr>
<td><strong>Storage Type</strong></td>
<td>Lets you select a storage engine value of MyISAM, InnoDB, BerkeleyDB, ISAM, MRG_MyISAM, HEAP, or MEMORY.</td>
</tr>
<tr>
<td><strong>Row Format</strong></td>
<td>Lets you select a row format of DEFAULT (returns the default value if there is one), FIXED (each row is stored with a fixed number of bytes), DYNAMIC (data records have variable length), or COMPRESSED (each record is compressed separately).</td>
</tr>
<tr>
<td><strong>Create via SELECT</strong></td>
<td>When you create a table using a SELECT command, the individual columns take their data types from the SELECT command, and don’t have to be declared explicitly. Attributes, however, are not carried over.</td>
</tr>
<tr>
<td><strong>Unique Key Violations</strong></td>
<td>When you try to insert or update a row that causes a violation, you can choose to IGNORE the violation and continue processing the next row. Or, you can choose REPLACE, which is equivalent to an insert statement if a violation occurs. The row will be replaced with the new data.</td>
</tr>
<tr>
<td><strong>Default Character Set</strong></td>
<td>This is the character set for a language or alphabet.</td>
</tr>
<tr>
<td><strong>Default Collation</strong></td>
<td>The collation encodes the rules governing character used for a language (like Greek) or an alphabet.</td>
</tr>
<tr>
<td><strong>Auto-increment</strong></td>
<td>You can specify the initial value used for the auto-increment sequence. This is possible only for MyISAM tables and for InnoDB tables built in MySQL versions 5.0.3 or greater. For InnoDB tables built in versions prior to 5.0.3, you can manually insert a dummy row with a value one less than the desired value after creating the dummy table; you then delete the dummy row.</td>
</tr>
<tr>
<td><strong>Comment</strong></td>
<td>Enter a descriptive comment.</td>
</tr>
<tr>
<td><strong>Min Rows</strong> and <strong>Max Rows</strong></td>
<td>Note that if you set the value for either parameter at 0, MySQL removes the setting. MySQL will take care of the row settings in this case.</td>
</tr>
<tr>
<td><strong>Average Row Length</strong></td>
<td>The average length (compressed or uncompressed) of table rows in the table space.</td>
</tr>
<tr>
<td><strong>Pack Keys</strong></td>
<td>This setting is only enabled for a Storage Type of MyISAM. It lets you specify a PACK KEYS option value of 0 (keys packing disabled), 1 (smaller indexes), or DEFAULT (pack long columns only).</td>
</tr>
<tr>
<td><strong>Check Sum</strong></td>
<td>This setting is only enabled for a Storage Type of MyISAM. When selected the CREATE TABLE statement is issued with a CHECKSUM = 1 option. When deselected, the CREATE TABLE statement is issued with a CHECKSUM = 0 option.</td>
</tr>
<tr>
<td><strong>Delay Key Write</strong></td>
<td>This setting is only enabled for a Storage Type of MyISAM. When selected, the CREATE TABLE statement is issued with a DELAY_KEY_WRITE = 1 option. When deselected, the CREATE TABLE statement is issued with a DELAY_KEY_WRITE = 0 option.</td>
</tr>
</tbody>
</table>

TABLES - COLUMNS
When creating or editing a table, this tab/panel lets you modify the table’s column setup, as follows:
• Use the Add Column button to add the columns to the table. After providing a Name for a new column, you can select a Type and modify other Datatype properties corresponding to the type you selected. When selected, the Allow Nulls property corresponds to a CREATE TABLE with a NULL attribute, while unselected it corresponds to a NOT NULL attribute. When available the Default Value property corresponds to a DEFAULT attribute.

• Modify a column definition by selecting the column from the column list and modifying values under Column Attributes.

• Delete a column definition by selecting the column from the column list and clicking Delete.

• Use the arrow buttons to change the position of a selected column.

TABLES - INDEXES
When creating or editing a table, this tab/panel lets you build an associated PRIMARY KEY, UNIQUE KEY, FULL TEXT, or SPATIAL clause that will be included with the CREATE TABLE statement.

• Use the Insert a New Index button to add an index. In the Index field, type a name for the index, select a Constraint Type of PRIMARY KEY, UNIQUE KEY, FULL TEXT, or SPATIAL, and select an Index Type of BTREE, HASH, or RTREE as appropriate to the constraint type. Under Specify Columns in Index, select the column or columns that are to make up the index.

• Modify an index definition by selecting the index from the list and modifying the Index name, Constraint Type, Index Type or the columns making up the index.

• Delete an index by selecting the index from the list and clicking the Remove button.

TABLES - FOREIGN KEYS
When creating or editing a table, this tab/panel lets you work with foreign keys for a table:

NOTE: This tab/panel is only available for a table with a Storage Type property value of INNODB.

• Use the Insert a New Foreign Key button to add a foreign key. Provide a Foreign Key Name, select the referenced database and table from the Ref. Database and Ref. Table dropdowns, and select On Delete and On Update actions of NONE, CASCADE, DEFAULT, SET NULL, NO ACTION, or RESTRICT. Under Main Table, select the foreign key column and then under Referenced Table, select the column that the foreign key is to reference.

• Modify a foreign key definition by selecting the foreign key from the list and changing the name, referenced database or table, delete or update actions, or the column specifications.

• Delete a foreign key by selecting the key from the list and clicking the Remove the selected foreign key button.
Creating Objects

Tables - Merge Tables
When creating or editing a table, this tab/panel lets you work with a collection of identical MyISAM tables that are to be used as a single table.

**NOTE:** This tab/panel is only available for a table with a Storage Type property value of MRG_MyISAM.

- Use the New button to add a MyISAM table to the collection, selecting a table from the associated dropdown.
- Use the Delete button to remove a selected MyISAM table from the collection.
- Use the arrow buttons to change the ordering position of a selected table.

Users Wizard (MySQL)
The MySQL Users Wizard lets you provide basic identification, grant privileges, and specify valid host information for a user definition.

To create a new user using a wizard:
1. Open a creation wizard for a user. For details, see "Opening an Object Wizard" on page 248.
2. Use the following topics as a guide to setting properties and performing tasks as you pass through the wizard panels:
   - User Information panel - for details, see Users - User Information
   - User Hosts panel - for details, see Users - User Hosts
   - System Privileges and Object Privileges panels - for details, see "Setting Permissions or Privileges for an Object" on page 250
   - DDL View panel - for details, see "Previewing the DDL Generated to Create the New Object" on page 250
3. Finally, use the Execute button to create the object.

Users - User Information
When creating or editing a user definition, this tab/panel lets you work with the following settings:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>User Name</td>
<td>The name of the new user. At this time, the name cannot exceed 16 characters, although the field accepts 34. Rapid SQL can’t enforce the discrepancy, so we urge you to show a little restraint. This is the name that is displayed in the User branch of the Navigator tree. If you leave this field blank and complete the process, you create an &lt;anonymous&gt; user. Only one anonymous user per datasource is allowed.</td>
</tr>
</tbody>
</table>
When creating or editing a user definition, this tab/panel lets you specify the valid hosts from which the user can connect to the server.

- Add a new host to the list by clicking the **New** button. Use the associated dropdown to select a valid host-name value (such as localhost or %), overwriting the text as necessary to provide a specific quoted identifier. Provide a password in the **Password** and **Confirm** fields and click **Apply**.

  **NOTE:** Click **Apply To All** to assign the current password for each host currently in the list.

- Remove a selected host from the list by clicking the **Delete** button.

### Oracle Object Wizards

Rapid SQL lets you create Oracle objects using the following wizards:

- [Clusters Wizard (Oracle)]
- [Database Links Wizard (Oracle)]
- [Directories Wizard (Oracle)]
- [Foreign Keys Wizard (Oracle)]
- [Functions Wizard (Oracle)]
- [Indexes Wizard (Oracle)]
- [Oracle Job Queue Wizard (Oracle)]
- [Jobs wizard (Oracle)]
- [Libraries Wizard (Oracle)]
• Materialized Views Wizard (Oracle)
• Materialized View Logs Wizard (Oracle)
• Outlines Wizard (Oracle)
• Packages Wizard (Oracle)
• Primary Keys Wizard (Oracle)
• Procedures Wizard (Oracle)
• Programs Wizard (Oracle)
• Profiles Wizard (Oracle)
• Roles Wizard (Oracle)
• Rollback Segments Wizard (Oracle)
• Schedules Wizard (Oracle)
• Sequences Wizard (Oracle)
• Synonyms Wizard (Oracle)
• Tables Wizard (Oracle)
• Tablespaces Wizard (Oracle)
• Triggers Wizard (Oracle)
• Object Types Wizard (Oracle)
• Unique Keys Wizard (Oracle)
• Users Wizard (Oracle)
• Views Wizard (Oracle)

CLUSTERS WIZARD (ORACLE)

The Cluster Wizard lets you create a cluster. A cluster is a schema object that has one or more tables that all have one or more common columns. Rows of one or more tables that share the same value in these common columns are stored together in the database. The related columns of tables stored in a cluster are known as the cluster key.

Important Notes
• To create a cluster, you need the CREATE CLUSTER or CREATE ANY CLUSTER system privilege.
To Open the Cluster Wizard

1. On the Navigator, find the schema where you want to add the new cluster.
2. On the Cluster branch, right-click and select New.

OR

1. On the main toolbar, click Datasource and scroll to Objects
2. Click Clusters and then click New from the toolbar.

The tables below describe the fields you may encounter as you complete the wizard.

<table>
<thead>
<tr>
<th>Required Information</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Who owns the cluster?</td>
<td>Pick an owner</td>
</tr>
<tr>
<td>What is the name of the cluster?</td>
<td>Type a unique name</td>
</tr>
<tr>
<td>On which tablespace do you want to create the cluster?</td>
<td>Self-explanatory</td>
</tr>
<tr>
<td>Add columns that are in this cluster</td>
<td>Add or Edit Button - For more information, see Adding or modifying a cluster column. Drop Button - Drops the column.</td>
</tr>
<tr>
<td>These are the columns that are common between the tables you are “clustering”</td>
<td></td>
</tr>
<tr>
<td>What is the size of this cluster?</td>
<td>This is the estimated number of bytes/KB/MB required by an average cluster key and its associated rows. Do not exceed the size of a data block.</td>
</tr>
<tr>
<td>What is the cluster type?</td>
<td>Index: Rows having the same cluster key value are stored together. Each separate cluster key is stored only once in each data block. An indexed cluster is helpful if your clustered tables might grow unpredictably. Hash: Rows with the same hash key value are stored together. This is helpful if the tables are static.</td>
</tr>
<tr>
<td>If this is a hash cluster, what is the number of hash keys?</td>
<td>Type the number of hash keys. Oracle will round the value up to the nearest prime number.</td>
</tr>
<tr>
<td>If this is a hash cluster, what is the hash function?</td>
<td>Oracle uses a hash function to generate a distribution of numeric values, called hash values, which are based on specific cluster key values. The key of a hash cluster, like the key of an index cluster, can be a single column or composite key (multiple column key). To find or store a row in a hash cluster, Oracle applies the hash function to the row's cluster key value. The resulting hash value corresponds to a data block in the cluster, which Oracle then reads or writes on behalf of the issued statement. Default is the Oracle internal hash function, otherwise specify the hash expression you want to use.</td>
</tr>
<tr>
<td>How many transaction entries are allowed for each data block in the cluster?</td>
<td>Each transaction that updates a data block requires a transaction entry. Initial (1-255): The initial parameter ensures that a minimum number of concurrent transactions can update a data block, avoiding the overhead of allocating a transaction entry dynamically. Maximum (1-255): The maximum parameter limits concurrency on a data block.</td>
</tr>
<tr>
<td>What is the percent of space reserved for future updates?</td>
<td>Percent Free (0-99): This sets the percentage of a data block to be reserved for possible row updates that are included in the block. The value you set is the percent kept free.</td>
</tr>
</tbody>
</table>
**CREATING OBJECTS**

**ADDING OR MODIFYING A CLUSTER COLUMN**

The **Add or Modify Cluster Column** dialog lets you manage cluster columns. You can open the dialog in the Oracle Cluster Wizard. For details, see "Clusters Wizard (Oracle)" on page 368.

The table below describes the options and functionality on the **Add or Modify Cluster Column** dialog:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Column Name</td>
<td>Lets you type the column name.</td>
</tr>
</tbody>
</table>
| Datatype                            | Lets you select the datatype for the cluster.  
  If you select CHAR, RAW or VARCHAR2, in the Width box, type the width value.  
  If you select NUMBER, in the Width box, type the width value and in the Scale box, type the scale value. |

---

**Required Information**

<table>
<thead>
<tr>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>What is the minimum percentage of used space that Oracle maintains for each data block?</td>
</tr>
<tr>
<td>The storage parameter lets you tune performance by minimizing the occurrence of row migration and chaining caused by update operations that extend the length of rows stored on the data block.</td>
</tr>
<tr>
<td>Percent Used (1-99)</td>
</tr>
<tr>
<td>How large are the cluster’s extents?</td>
</tr>
</tbody>
</table>
| The unit of space allocated to an object whenever the object needs more space.  
  Initial Extent - The initial space extent (in bytes) allocated to the object.  
  Next Extent - The next extent (in bytes) that the object will attempt to allocate when more space for the object is required. |
| Specify the number of free lists                                           |
| Free lists are lists of data blocks that have space available for inserting rows.  
  Identifying multiple free lists can reduce contention for free lists when concurrent inserts take place and potentially improve the performance of the cluster.  
  Free Lists: The default and minimum value is 1; this option should be set higher if multiple processes access the same data block. |
| Specify the number of free list groups (specify only if you are using the parallel server option) |
| This is the number of groups of free lists for the database objects being created. |
| Define a default buffer pool for this cluster                             |
| Default - Select to retain the default.  
  Keep - Select to retain the object in memory to avoid I/O conflicts. |
| Oracle's parallel query option                                             |
| The parallel server query option lets you process queries using many query server processes running against multiple CPUs, which provides substantial performance gains such as reducing the query completion time. |
| Choosing Cache                                                             |
| Cache: This keeps the data block in memory by placing it at the most recently used end. This option is useful for small lookup tables.  
  No Cache |
Completing the Add or Modify Cluster Column Dialog Box
To complete this dialog, do the following:

1. In the **Add Cluster Column** dialog, in the **Column Name** box, type the column name.
2. Click the **Datatype** list, click the datatype for the cluster.
   - If you clicked CHAR, RAW or VARCHAR2, in the **Width** box, type the width value.
   - If you clicked NUMBER, in the **Width** box, type the width value and in the **Scale** box, type the scale value.
3. Click the **Add** button.
4. To continue adding columns to the cluster, repeat steps 1-3.
5. When you finish adding columns, click **Close**.
   Rapid SQL closes the **Add Cluster Column** dialog.

For more information, see *Adding or modifying a cluster column*.

DATABASE LINKS WIZARD (ORACLE)
A database link specifies a communication path from one database to another. If you’re creating a link to a remote database, a database session is established in the remote database on behalf of the local application request. By creating either a public or private database link, you can determine which schema on the remote database the link will establish connections to by creating fixed, current, and connected database links. By creating a link you can reuse connectivity instructions each time you connect to the remote database.

To Open the Database Link Wizard

1. On the Navigator, find the schema where you want to add the new database link.
2. On the Database Links branch, right-click and select **New**.
   OR
1. On the main toolbar, click Datasource and scroll to Objects
2. Click **Database Links** and then click **New** from the toolbar.

The table that follows describes the fields you will encounter as you complete the wizard.

<table>
<thead>
<tr>
<th>REQUIRED INFORMATION</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>What is the name of the database link?</td>
<td>Create a unique name</td>
</tr>
</tbody>
</table>

**NOTE:** To create a public database link, you need CREATE PUBLIC DATABASE LINK privileges.
DIRECTORIES WIZARD (ORACLE)

A directory object specifies an alias for a directory on the server file system where external binary file LOBs and external table data are located. The wizard completes a CREATE DIRECTORY statement from the information you supply. The Directory Wizard prompts you to name the directory and provide the full-qualified directory path.

To Open the Directories Wizard

1. On the Navigator, find the Datasource where you want to create a directory and expand the Storage node.

2. Right-click Directories and select New.

The table that follows describes the fields you will encounter as you complete the wizard.

<table>
<thead>
<tr>
<th>Required Information</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Should the database link be made public?</td>
<td>A public link is a link on a local database that's accessible to all users on that database. If you keep the database link private by selecting No, a link is created in a specific schema of the local database and only the owner of the link can use it to access database objects in the corresponding remote database.</td>
</tr>
<tr>
<td>What is the name of the remote user?</td>
<td>Self-explanatory</td>
</tr>
<tr>
<td>What is the remote user’s password?</td>
<td>Create a password for the remote user.</td>
</tr>
<tr>
<td>What is the connection string?</td>
<td>Self-explanatory</td>
</tr>
</tbody>
</table>

After you have created the Directory, you can give other users Read or Write privileges by opening the new Directory on the Directories node, and making changes at the Privileges tab.
FOREIGN KEYS WIZARD (ORACLE)

A foreign key value in one table (child table) refers to a primary key value in another table (parent table). For example, the Author Name column in a publisher’s database may be the primary key for a table of addresses that includes the Author Name column. If an author isn’t included in the parent table, you can’t add the address to the dependent address table. So foreign keys enforce referential integrity between tables by verifying the existence of foreign key values in the parent table before letting you insert or update foreign key values in the child table. In other words, a foreign key is an integrity constraint that requires each value in one table’s column to match a value in a related table’s data.

To create a new foreign key using a wizard:

1. Open a creation wizard for a foreign key. For details, see "Opening an Object Wizard" on page 248.
2. Use the following topics as a guide to setting properties and performing tasks as you pass through the wizard panels:
   - Properties panel - Foreign Keys (Oracle) - Properties.
   - Column Mapping panel - Foreign Keys (Oracle) - Column Mapping.
   - DDL View panel - for details, see "Previewing the DDL Generated to Create the New Object" on page 250.
3. Finally, use the Execute button to create the object.

FOREIGN KEYS (ORACLE) - PROPERTIES

When creating or editing a foreign key, this tab/panel lets you work with the following settings:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table Owner</td>
<td>The owner of the table where the foreign key is being created.</td>
</tr>
<tr>
<td>Table Name</td>
<td>This is the table where the foreign key link originates—the child table.</td>
</tr>
<tr>
<td>Name</td>
<td>Let’s you select a constraint name.</td>
</tr>
<tr>
<td></td>
<td>System Generated Name - DB2 automatically generates a name.</td>
</tr>
<tr>
<td></td>
<td>User Specified Constraint Name - You type the name.</td>
</tr>
<tr>
<td>Enabled</td>
<td>Enable or disable the foreign key. Enabled ensures that all data modifications to a given table (or tables) satisfy the conditions of the constraints. When disabled, the constraint is temporarily not operational.</td>
</tr>
<tr>
<td>Delete Rule</td>
<td>Select an action:</td>
</tr>
<tr>
<td></td>
<td><strong>NO ACTION</strong> - ensures that referenced values cannot be updated or deleted if to do so would violate referential integrity.</td>
</tr>
<tr>
<td></td>
<td><strong>CASCADE</strong> permits a referenced row in a child table to be deleted/updated if it is deleted/updated in the parent table. A row in the child table is SET NULL when rows in the parent table are deleted/updated.</td>
</tr>
</tbody>
</table>
FOREIGN KEYS (ORACLE) - COLUMN MAPPING

Under **Referenced Table**, choose the **Owner** and then the **Name** of the referenced, or parent, table.

Under the **Main Table**, select check boxes corresponding to the columns that are to reference columns in the referenced table. Then, under **Referenced Table**, select the corresponding column check boxes.

FUNCTIONS WIZARD (ORACLE)

Functions are subroutines that you define and are useful for reusing application logic. You can use functions to determine the best methods for controlling access and manipulation of the underlying data contained in an object. A function returns a value, unlike a procedure, which does not.

**To create a new function using a wizard:**

1. Open a creation wizard for a function. For details, see "Opening an Object Wizard" on page 248.

2. Use the following topics as a guide to setting properties and performing tasks as you pass through the wizard panels:
   - **Properties** panel - Functions (Oracle) - Properties.
   - **Definition** panel - for details, see Previewing the DDL Generated to Create the New Object.

3. Finally, use the **Execute** button to create the object.

FUNCTIONS (ORACLE) - PROPERTIES

When creating or editing a function, this tab/panel lets you work with the following settings:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Owner</td>
<td>Select the owner of the function.</td>
</tr>
<tr>
<td>Name</td>
<td>Provide a name for the function.</td>
</tr>
</tbody>
</table>

FUNCTIONS (ORACLE) - DEFINITION

Complete the CREATE FUNCTION outline provided by typing or pasting the body of the function.
INDEXES WIZARD (ORACLE)

Indexes are optional structures associated with tables. You can create indexes specifically to speed SQL statement execution on a table. When properly used, indexes are the primary means of reducing disk I/O. Indexes are logically and physically independent of the data in the associated table. Unique Indexes guarantee that no two rows of a table have duplicate values in the columns that define the index.

**NOTE:** The Index Wizard varies slightly in content based on the version of Oracle to which you are connected.

**NOTE:** To create indexes in your own schema, you need INDEX privileges on the target table. To create indexes in other schema, you need CREATE ANY INDEX privileges.

**NOTE:** You can place a unique key constraint on an Index-Organized table.

**TIP:** Index-organized tables take up less storage space and quickly access table rows. Index-organized tables stores rows in primary key order reducing the amount of storage space needed.

**TIP:** An advantage of using index-organized tables is that the tables use less memory because key columns are not duplicated in the table and index. Rapid SQL stores the remaining non-key columns in the index structure.

To create a new index using a wizard:

1. Open a creation wizard for an index. For details, see "Opening an Object Wizard" on page 248.

2. Use the following topics as a guide to setting properties and performing tasks as you pass through the wizard panels:

   - **Properties** panel - Indexes (Oracle) - Properties.
   - **Columns** panel - Indexes (Oracle) - Columns.
   - **Storage** panel - Indexes (Oracle) - Storage.
   - **Partition** panel - Indexes (Oracle) - Partition.
   - **Definition** panel - for details, see "Previewing the DDL Generated to Create the New Object" on page 250.

3. Finally, use the **Execute** button to create the object.

INDEXES (ORACLE) - PROPERTIES

When creating or editing an index, this tab/panel lets you work with the following settings:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table Owner and</td>
<td>Choose the owner and name of the table in which the index is being created.</td>
</tr>
<tr>
<td>Table Name</td>
<td></td>
</tr>
</tbody>
</table>
**Index Type**

- **NONUNIQUE** - In a non-unique index, the ROWID is treated as part of the key. Oracle treats a constraint as deferrable.
- **UNIQUE** - Select if the index is a unique constraint. The values in the indexed columns must be distinct.
- **BITMAP** - Widely used in data warehousing environments. The environments typically have large amounts of data and ad hoc queries, but a low level of concurrent DML transactions.

**No Sort**

Enable this feature if the rows in the table already stored in ascending order. This increases the speed of the index creation process. Oracle does not sort the rows.

**Logging**

Enabling logs this operation to the redo file.

**Reverse**

Enabling this feature stores the bytes of the index block in reverse order and excludes the ROWID. The ROWID is a globally unique identifier for a row in a database. It is created at the time the row is inserted into a table, and destroyed when it is removed from a table.

**Function-Based**

Permits the results of known queries to be returned much more quickly. When you select this option, you are asked for the expression that governs the function-based index you are creating.

**Invisible (Oracle 11g)**

Adds an INVISIBLE keyword to the DDL generated to create or edit this index. The optimizer ignores an invisible index unless the OPTIMIZER_USE_INVISIBLE_INDEXES is set to TRUE at the session or system level.

**No Parallel Execution**

The parallel server query option lets you process queries, using many query server processes, running against multiple CPUs. This option provides substantial performance gains such as reduction of the query completion time.

After creation, **ALTER INDEX for NOPARALLEL execution** - when you use multiple query servers and you select this option, the parallel query option remains in place, but parallel processing will be removed. If, for example, multiple users on numerous nodes are modifying the same small set of data, the cost of synchronization from the parallel processing may have an unnecessarily large drag on throughput.

**Parallel Degree**

The value you select indicates the number of query server processes that should be used in the operation.

**Parallel Instances**

The value you select indicates how you want the parallel query partitioned between the Parallel Servers.

**INDEXES (ORACLE) - COLUMNS**

From the **Column** dropdown, select a column for the index and specify a **Sort** option. To add more columns, click the **New** button and then follow the steps in the last instruction. Use the Delete button to drop columns.
**INDEXES (ORACLE) - STORAGE**

When creating or editing an index, this tab/panel lets you work with the following settings:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Data Block Storage**   | Select the DEFAULT Tablespace only if you are creating a local partitioned index and want the partitions in the same tablespace as the partitions in the underlying table. (Each partition of a local index is associated with one partition of the table. Oracle can then keep the index partitions in sync with table partitions.)
|                          | A transaction entry is needed for each INSERT, UPDATE, DELETE, etc. statement that accesses one or more rows in the block. Transaction entries in many operating systems require approximately 23 bytes. |
|                          | **Percent Free** identifies how much space you want to allocate for new rows or updates to existing rows.                                                                                                      |
|                          | **Initial Transactions** ensures that a minimum number of concurrent transactions can update an index block, avoiding the overhead of allocating a transaction entry dynamically. |
|                          | **Maximum Transactions** limits concurrency on an index block.                                                                                                                                             |
| **Extents**              | An extent is the unit of space allocated to an object whenever the object needs more space.                                                                                                               |
|                          | **Initial Extent** - The initial space extent (in bytes) allocated to the object.                                                                                                                          |
|                          | **Next Extent** - The next extent (in bytes) that the object will attempt to allocate when more space for the object is required.                                                                           |
|                          | **Percentage Increase** - Lets you type the percentage.                                                                                                                                                      |
|                          | **NOTE**: You should be careful when setting Percent Increase because it magnifies how an object grows and, therefore, can materially affect available free space in a tablespace.                                |
|                          | **Minimum Extents** - For a dictionary managed tablespace, this is the total number of extents to be allocated when the index is first created. For a locally managed tablespace, this is simply the initial amount of space allocated. |
|                          | **Maximum Extents** - For a dictionary managed tablespace, this is the total number of extents that can ever be allocated to the index. In a locally managed tablespace, the database will automatically manage the extents. |
| **Freelists**            | Free lists let you manage the allocation of data blocks when concurrent processes are issued against the index. You can potentially improve the performance of the index by identifying multiple free lists, which can reduce contention for free lists when concurrent inserts take place. |
|                          | The default and minimum value is 1. You should increase this number if multiple processes access the same data block.                                                                                           |
|                          | **Free List Groups** is the number of groups of free lists.                                                                                                                                                   |
|                          | **NOTE**: This option is only applicable for the parallel server option.                                                                                                                                      |
| **Buffer Pool**          | DEFAULT - Choose this if you want to use the default bufferpool.                                                                                                                                              |
|                          | KEEP - Use this to retain the object in memory to avoid I/O conflicts. This type of bufferpool stores frequently referenced data blocks in a separate cache.                                                      |
|                          | RECYCLE - Select this option to save cache space by ridding data blocks from memory as soon as they are no longer in use.                                                                                  |

**INDEXES (ORACLE) - PARTITION**

Clicking **Create Partition** opens a wizard that lets you create a partition.
ORACLE JOB QUEUE WIZARD (ORACLE)

This wizard lets you build and submit a DBMS_JOB.SUBMIT call, creating a once-only or scheduled job, optionally submitted as broken.

To create a new job queue using a wizard:

1. Open a creation wizard for a job queue. For details, see "Opening an Object Wizard" on page 248.
2. Use the following topics as a guide to setting properties and performing tasks as you pass through the wizard panels:
   - **Properties** panel - for details, see Job Queues (Oracle) - Properties.
   - **Definition** panel - for details, see Job Queues (Oracle) - Definition.
   - **DDL View** panel - for details, see "Previewing the DDL Generated to Create the New Object" on page 250.
3. Finally, use the Execute button to create the object. For more information, see Previewing the DDL Generated to Create the New Object.

JOB QUEUES (ORACLE) - PROPERTIES

When creating or editing a job, this tab/panels lets you work with the following settings:

<table>
<thead>
<tr>
<th>Option</th>
<th>Availability and Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>No Parse</td>
<td>Specifies the value of the NO_PARSE flag. If deselected, the associated procedure is parsed on submission. If selected, the associated procedure is parsed the first time the job is executed.</td>
</tr>
<tr>
<td>Submit as disabled</td>
<td>If selected, the DBMS_JOB.SUBMIT call generated to create the job, is followed by a DBMS_JOB.BROKEN call. Marking the job as broken, this disables the job and in order to execute the job, you must use the Run Job object action. For details, see &quot;Run Job (job queues)&quot; on page 683.</td>
</tr>
<tr>
<td>Next Date</td>
<td>Use this control to open a calendar that lets you select a date for the job to run with a default time of midnight. You can then modify the time value.</td>
</tr>
<tr>
<td>Run Again</td>
<td></td>
</tr>
<tr>
<td>Every</td>
<td>Only available if Run Again is selected and Use Custom Expression is not selected.</td>
</tr>
<tr>
<td>Time Unit</td>
<td></td>
</tr>
<tr>
<td>Use Custom Expression</td>
<td>Only available if Run Again is selected. Custom Expression becomes available when Use Custom Expression is selected.</td>
</tr>
</tbody>
</table>

JOB QUEUES (ORACLE) - DEFINITION

When creating or editing a job, the tab/panel lets you provide the DBMS_JOB.SUBMIT call’s WHAT parameter, specifying the name of the PL/SQL procedure to run.
JOBS WIZARD (ORACLE)
This wizard builds and submits a call to DBMS_SCHEDULER.CREATE_JOB with optional DBMS_SCHEDULER.SET_JOB_ARGUMENT_VALUE, DBMS_SCHEDULER.SET_ATTRIBUTE, and DBMS_SCHEDULER ENABLE calls. This lets you create a fully-specified job.

NOTE: This functionality is available as of Oracle 10g.

NOTE: Before working with jobs, consult Oracle documentation for general information on DBMS_SCHEDULER. For more information, see "Accessing Third Party Documentation" on page 21.

To create a job using a wizard
1. On a connected Oracle datasource, expand the Scheduler node.
2. Right-click the Jobs node and select Create from the context menu.
3. Use the following topics as a guide to setting properties and performing tasks as you pass through the wizard panels:
   - Properties panel - for details, see Jobs (Oracle) - Properties.
   - Action panel - for details, see Jobs (Oracle) - Action.
   - Arguments panel - for details, see Jobs (Oracle) - Arguments.
   - DDL View panel - for details, see "Previewing the DDL Generated to Create the New Object" on page 250.
4. Finally, use the Finish button to create the object.

JOBS (ORACLE) - PROPERTIES
When creating or editing a job, this tab/panel lets you work with the following settings:

<table>
<thead>
<tr>
<th>Group</th>
<th>Settings and Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Creation</td>
<td>Lets you provide an Owner and Name for the job.</td>
</tr>
<tr>
<td>Attributes</td>
<td>Lets you provide Enabled, Description (COMMENTS), and Job Class (JOB_CLASS) attributes.</td>
</tr>
<tr>
<td>Schedule</td>
<td>Lets you select a Schedule Type of IMMEDIATE, ONCE, REPEATING, or specified SCHEDULE.</td>
</tr>
<tr>
<td></td>
<td>Depending on your selection, the following settings may be available:</td>
</tr>
<tr>
<td></td>
<td>Repeat Interval - corresponds to a REPEAT_INTERVAL attribute. Calendaring syntax, as</td>
</tr>
<tr>
<td></td>
<td>described in Oracle DBMS_SCHEDULER documentation, can be typed free-form, and will be</td>
</tr>
<tr>
<td></td>
<td>passed directly to the server. For information on third-party documentation access, see</td>
</tr>
<tr>
<td></td>
<td>Start Date and End Date - correspond to START_DATE and END_DATE, attributes.</td>
</tr>
<tr>
<td></td>
<td>Schedule Owner and Schedule Name - correspond to SCHEDULE_NAME attribute components.</td>
</tr>
</tbody>
</table>
CREATING OBJECTS

JOBS (ORACLE) - ACTION
When creating or editing a job, this tab/panel lets you specify a JOB_ACTION attribute for the DBMS_SCHEDULER.CREATE_JOB call, specifying the job action for the job.

To specify a job action
1. From Job Type, select one of PLSQL BLOCK, STORED PROCEDURE, EXECUTEABLE, or CHAIN.
2. Based on your Job Type selection, provide additional details as follows:
   - PLSQL BLOCK - Type or paste the SQL to be executed.
   - STORED PROCEDURE - Provide the Procedure Owner and Procedure Name.
   - EXECUTEABLE - Use the browse button to locate the executable.
   - PROGRAM - Provide the Program Owner and Program Name.
   - CHAIN - Provide the Chain Owner and Chain Name.

JOBS (ORACLE) - ARGUMENTS
When creating or editing a job, if you selected an Action tab choice of PROGRAM, EXECUTABLE, or STORED PROCEDURE, this tab/panel lets you manage parameters to be passed.

NOTE: If you provide arguments with an Action tab choice of PROGRAM, the provided arguments override those specified in the program definition. For details, see “Programs wizard (Oracle)” on page 394.

LIBRARIES WIZARD (ORACLE)
Libraries are an object type that represent a call to an operating system shared library cache. After the call is made, libraries can be used by SQL or PL/SQL to link to external procedures or functions. Libraries are only to be used on operating systems that support shared libraries and dynamic linking. Libraries serve as pointers or aliases to physical operating system shared library files and do not exist as a physical object; rather they rely on the physical existence of the files in the external operating system library to which they refer. To access the function or procedures stored in the library, you need execute privileges at the operating system level where the shared library resides.
To create a library in your own schema, you need CREATE ANY LIBRARY privileges. To use the functions or procedures stored in the library, you need object EXECUTE privileges on the library.

**To Open the Library Wizard**

1. On the Navigator, find the datasource where you want to create a Library and expand the Schema node.

2. Right-click the **Libraries** node, and select **New**.

The table that follows describes the fields you may encounter using this wizard:

<table>
<thead>
<tr>
<th>Required Information</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Who owns the library?</td>
<td>Self-explanatory.</td>
</tr>
<tr>
<td>What is the name of the library?</td>
<td>Self-explanatory.</td>
</tr>
<tr>
<td>What is the file specification?</td>
<td>Lets you type the file name and location. You must type the complete location (for example, D:\Embarcadero\ETLIB21D.DLL).</td>
</tr>
</tbody>
</table>

**MATERIALIZED VIEWS WIZARD (ORACLE)**

A materialized view gives you indirect access to table data by storing a query's results in a separate schema object. Essentially, a materialized view is a database object that contains the results of a query.

The Materialized View Wizard lets you:

- Specify the materialized view owner and to name the materialized view.
- Specify the materialized view's refresh configuration.
- Place the materialized view on a tablespace and specify the query that should be used to populate the materialized view.
- Specify how Oracle should allocate data blocks to store the materialized view.
- Specify how Oracle should manage the growth of the materialized view.
- Specify if Oracle updates the materialized view, register an existing table, and specify how to populate a materialized view.
- Specify if the data for the materialized view is cached, if you want the updates logged, and to specify a number of threads for a parallel operation.
- Specify rollback segments, and enable query rewrites.
To Open the Materialized View Wizard

1. On the Navigator, find the datasource where you want to create a Materialized View and expand the Schema node.

2. Right-click the Materialized Views node, and select New.

The table that follows describes the fields you may encounter as you complete the wizard:

<table>
<thead>
<tr>
<th>Required Information</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Who owns the materialized view?</td>
<td>Self-explanatory</td>
</tr>
<tr>
<td>What is the name of the materialized view?</td>
<td>Self-explanatory.</td>
</tr>
<tr>
<td>How should the materialized view be refreshed?</td>
<td>Fast - Using the information logged on the materialized view logs or a partition maintenance operation, the refresh applies incremental changes. See Fast Refresh Requirements for more information. Complete - This refresh recalculates the materialized view's defining query. Force - Applies fast refresh when feasible, otherwise uses a complete refresh. Never - Materialized view will not be refreshed with the optional refresh mechanisms.</td>
</tr>
<tr>
<td>Choose a refresh mechanism</td>
<td>On Demand - This option requires that all refreshes be manually executed. On Commit - Select to refresh the materialized view whenever Oracle processes a transaction. Only select this option for materialized views on single table aggregates and materialized views containing joins. Automatically - Select to refresh the materialized view automatically. In the On this date: boxes select a time and date, and then select a refresh amount and a unit of time.</td>
</tr>
<tr>
<td>Where do you want to place the materialized view?</td>
<td>Select the tablespace where you want the materialized view placed.</td>
</tr>
<tr>
<td>What is the materialized view query?</td>
<td>Type the SQL query to be used to populate and to refresh the materialized view.</td>
</tr>
<tr>
<td>Select a refresh method</td>
<td>Primary Key - A primary key’s values uniquely identify the rows in a table. Changes are propagated according to row changes as identified by the primary key value of the row. Only one primary key can be defined for each table. The primary key of the master table is the basis for this refresh option, which is the default option. ROWID - A globally unique identifier for a row in a database based on the physical row identifiers. A RowID is created at the time the row is inserted into a table, and destroyed when it is removed from a table. ROWID materialized views cannot contain distinct or aggregate functions or GROUP BY subqueries, joins and set operations.</td>
</tr>
<tr>
<td>How many transaction entries are allowed for each datablock in the materialized view?</td>
<td>A transaction is a logical unit of work that contains one or more SQL statements. Each transaction that updates a data block requires a transaction entry. Initial (1-255) - Ensures that a minimum number of concurrent transactions can update a data block, avoiding the overhead of allocating a transaction entry dynamically. Maximum (1-255) - Limits concurrency on a data block.</td>
</tr>
<tr>
<td>What is the percent of space reserved for future updates?</td>
<td>Percent Free (0-99) - This sets the percentage of a data block to be reserved for possible row updates that are included in the block. The value you set is the percent kept free.</td>
</tr>
<tr>
<td>Required Information</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>What is the minimum percentage of used space that Oracle maintains for each datablock?</td>
<td>Percent Used (0-99) - Set the amount of space to be used for each datablock. NOTE: The sum of percent free and the percent used cannot exceed 100.</td>
</tr>
<tr>
<td>How large are the materialized views extents?</td>
<td>The unit of space allocated to an object whenever the object needs more space. An extent is a specific number of contiguous data blocks set aside for storing a specific type of information. Initial Extent (KB) - The initial space extent (in bytes) allocated to the object. Next Extent - The next extent (in bytes) that the object will attempt to allocate when more space for the object is required.</td>
</tr>
<tr>
<td>How many extents should be allocated to the materialized view?</td>
<td>Minimum Extents - The appropriate minimum extents value for the object. Maximum Extents - The appropriate maximum extents value for the object.</td>
</tr>
<tr>
<td>What is the growth rate for sizing additional materialized views?</td>
<td>Percent Increase - Magnifies how an object grows and can materially affect available free space in a tablespace. Select a value in the corresponding box.</td>
</tr>
<tr>
<td>Can the materialized view be updated?</td>
<td>Yes/No</td>
</tr>
<tr>
<td>Do you want to register a prebuilt table to the view?</td>
<td>Yes/No. This option is particularly useful for registering large materialized views in a data warehousing environment.</td>
</tr>
<tr>
<td>Should the materialized view be immediately filled?</td>
<td>Yes/No: Select Yes if you want the materialized view populated immediately or during the next refresh operation.</td>
</tr>
<tr>
<td>Should data for the materialized view be cached?</td>
<td>Yes/No: Select if you want Oracle to put data you access frequently at the most recently used end of the list in the buffer cache when a full table scan is performed. This option is useful for small lookup tables.</td>
</tr>
<tr>
<td>Do you want updates to be logged?</td>
<td>Yes/No.</td>
</tr>
<tr>
<td>Do you want to specify the number of threads used in a parallel operation?</td>
<td>Parallel processes means that multiple processes work simultaneously to run a single statement. This can cut the amount of time it takes to get a response. Specify the degree of parallelism if you so desire. If you leave the default at 1, the operation will not be “parallelized.”</td>
</tr>
<tr>
<td>Would you like to specify rollback segments to be used for the materialized view refresh?</td>
<td>A rollback segment temporarily stores old data that has changed in a SQL statement transaction until it is committed. The “before” image of the database, as it were. Local Rollback Segment - Default indicates that Oracle will select the rollback segment to use on the local machine. Master Rollback Segment - Specify the remote rollback segment used at the remote master site for the individual materialized view.</td>
</tr>
<tr>
<td>Is the materialized view eligible for query rewrite?</td>
<td>Select to enable the materialized view for query rewrite. Only enable query rewrite if expressions in the statement are repeatable.</td>
</tr>
</tbody>
</table>
CREATING OBJECTS

**Fast Refresh Requirements**

<table>
<thead>
<tr>
<th>Required Information</th>
<th>Description</th>
</tr>
</thead>
</table>
| Do you want to partition this materialized view? | Yes/No | Partitioning methods available are:  
Range: Data is mapped to partitions based on ranges of column values. This is the default.  
Composite: Based on the range method of partitioning, you can create subpartitions within each partition.  
Hash: Data is distributed evenly over a specified number of partitions. Data need not fit into a logical range.  
List: You control explicitly how rows map to partitions. List partitions allow you to group and organize unrelated sets of data. |
| Do you want to enable Row Movement? | Yes/No | Enabling row movement allows you to specify whether Oracle can move a table row when you are compressing a table or performing an update on partitioned data. |

**Select the partitioning columns**  
Self-explanatory

**Select the subpartitioning method**  
Self-explanatory

**Select the subpartitioning columns**  
Self-explanatory

**Hash Partitioning methods**  
None  
Partition Definition:  
Specify number of partitions and (optionally) tablespaces  
Specify individual partitions by name and (optionally) tablespaces

**Create list/ordered list of partitions**  
Self-explanatory  
The Add Partition dialog may open.

**Specify number of subpartitions**  
Self-explanatory  
Click Add, Insert, or Edit to open a dialog that lets you work with subpartition properties.

**Select the default tablespaces to contain the subpartitions (optional)**  
Self-explanatory

---

**Fast Refresh Requirements**

<table>
<thead>
<tr>
<th>When the Materialized View has:</th>
<th>Only Joins</th>
<th>Joins and Aggregates</th>
<th>Aggregate on a Single Table</th>
</tr>
</thead>
<tbody>
<tr>
<td>Detail tables only</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Single table only</td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Table Appears only once in the FROM list</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>When the Materialized View has:</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>---------------------------------</td>
<td>--</td>
<td></td>
<td></td>
</tr>
<tr>
<td>No non-repeating expressions like SYSDATE and ROWNUM</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>No references to RAW or LONG RAW</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>No GROUP BY</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Rowids of all the detail tables must appear in the SELECT list of the query</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Expressions are allowed in the GROUP BY and SELECT clauses provided they are the same</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Aggregates allowed but cannot be nested</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>AVG with COUNT</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>SUM with COUNT</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Only Joins</td>
<td>Joins and Aggregates</td>
<td>Aggregate on a Single Table</td>
<td></td>
</tr>
<tr>
<td>VARIANCE with COUNT and SUM</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>STDDEV with COUNT and SUM</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>WHERE clause includes join predicates which can be ANDed but not ORed.</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>No WHERE clause</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>No HAVING or CONNECT BY</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>No subqueries, inline views, or set functions like UNION or MINUS</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>COUNT(*) must be present</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>No MIN and MAX allowed</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>If outer joins, then unique constraints must exist on the join columns of the inner join table</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Materialized View logs must exist and contain all columns referenced in the materialized view and have been created with the LOG NEW VALUES clause</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Materialized View Logs must exist with rowids of all the detail tables</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Non-aggregate expression in SELECT and GROUP BY must be straight columns</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>DML to detail table</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
</tbody>
</table>
Materialized view logs are tables that maintain a history of modifications to the master table, and they are used to refresh simple materialized views. When you create a materialized view log, Oracle automatically creates a log table to track data changes in the master table and a log trigger to maintain the data in the log table. A log can refresh the materialized view incrementally and is therefore often less time-consuming than a complete refresh.

The Materialized View Log Wizard lets you:

- Specify the materialized view log owner and master table.
- Select refresh types and select column filters.
- Specify how Oracle should allocate data blocks to store the materialized view log.
- Specify how Oracle should manage the growth of the materialized view.
- Specify if you want the data for the materialized view log cached, if you want updates logged, and to enable parallel query.
- Specify if you want the log to hold new values.

To Open the Materialized View Logs Wizard

1. On the Navigator, find the datasource where you want to create a Materialized View Log and expand the Schema node.

2. Right-click the Materialized View Log node, and select New.

The table that follows describes the fields you may encounter as you complete the wizard:

<table>
<thead>
<tr>
<th>Required Information</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Who owns the materialized view log's master table?</td>
<td>Self-explanatory</td>
</tr>
<tr>
<td>Which table will serve as the materialized view log's master table?</td>
<td>Self-explanatory</td>
</tr>
<tr>
<td>On which tablespace do you want to place the log?</td>
<td>Self-explanatory</td>
</tr>
<tr>
<td>Required Information</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Which refresh types would you like to use?</td>
<td>Primary Key - The log records changes to the master table based on the primary key of affected rows. A primary key’s values uniquely identify the rows in a table. Changes are propagated according to row changes as identified by the primary key value of the row. Only one primary key can be defined for each table. The primary key of the master table is the basis for this refresh option, which is the default option. ROWID - The log records changes to the master table based on the RowID of the affected rows. A ROWID is a globally unique identifier for a row in a database based on the physical row identifiers. A ROWID is created at the time the row is inserted into a table, and destroyed when it is removed from a table. ROWID materialized views cannot contain distinct or aggregate functions or GROUP BY subqueries, joins and set operations.</td>
</tr>
<tr>
<td>Optional: Select any filter column(s) to be recorded in the materialized view log.</td>
<td>A filter column is a column whose values you want to be recorded in the materialized view log for any rows that are changed. You can specify only one primary key, one ROWID, and one filter column list per materialized view log.</td>
</tr>
<tr>
<td>How many transaction entries are allowed for each data block in the materialized view log?</td>
<td>A transaction is a logical unit of work that contains one or more SQL statements. Each transaction that updates a data block requires a transaction entry. Initial (1-255) - Ensures that a minimum number of concurrent transactions can update a data block, avoiding the overhead of allocating a transaction entry dynamically. Maximum (1-255) - Limits concurrency on a data block.</td>
</tr>
<tr>
<td>What is the percent of space reserved for future updates?</td>
<td>Percent Free (0-99) - This sets the percentage of a data block to be reserved for possible row updates that are included in the block. The value you set is the percent kept free.</td>
</tr>
<tr>
<td>What is the minimum percentage of used space that Oracle maintains for each data block?</td>
<td>Percent Used (0-99) - Set the amount of space to be used for each datablock. NOTE: The sum of percent free and the percent used cannot exceed 100.</td>
</tr>
<tr>
<td>How large are the materialized view log’s extents?</td>
<td>Initial Extent (KB) - The default is the value specified for the tablespace where the materialized view log resides.</td>
</tr>
<tr>
<td>Should the data for a materialized view log be cached?</td>
<td>Yes/No - Select Yes if you want Oracle to put data you access frequently at the most recently used end of the least recently used list in the buffer cache when a full table scan is performed. This option is useful for small lookup tables. No indicates that your most frequently accessed data blocks are put at the least recently used end of the least recently used list of the buffer cache.</td>
</tr>
<tr>
<td>Do you want updates to be logged?</td>
<td>Yes/No</td>
</tr>
<tr>
<td>Do you want to enable parallel query for the log?</td>
<td>Degree. The integer is number of parallel threads used in the parallel operation. The Parallel server query option lets you process queries using many query server processes running against multiple CPUs. This option provides substantial performance gains such as reduction of the query completion time.</td>
</tr>
<tr>
<td>Should the log hold new values?</td>
<td>Yes/No - Yes indicates both old and new values should be saved in the materialized view log. No disables recording of new values in the log. This is the default.</td>
</tr>
</tbody>
</table>
OUTLINES WIZARD (ORACLE)

Outlines are a set of results for the execution plan generation of a particular SQL statement. When you create an outline, plan stability examines the optimization results using the same data used to generate the execution plan. That is, Oracle uses the input to the execution plan to generate an outline, and not the execution plan itself.

**NOTE:** To create an outline, you must have CREATE ANY OUTLINE system privileges.

To create a new outline using a wizard:

1. Open a creation wizard for an outline. For details, see "Opening an Object Wizard" on page 248.
2. Use the following topics as a guide to setting properties and performing tasks as you pass through the wizard panels:
   - Properties panel - Outlines (Oracle) - Properties.
   - Definition panel - Outlines (Oracle) - Definition.
   - DDL panel - for details, see "Previewing the DDL Generated to Create the New Object" on page 250.
3. Finally, use the Execute button to create the object.

OUTLINES (ORACLE) - PROPERTIES

When creating or editing an outline, this tab/panel lets you work with the following settings:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stored Outline Name</td>
<td>Provide a unique name for the outline.</td>
</tr>
<tr>
<td>Category</td>
<td>The category is a name you want to use to group stored outlines. (You can type over the word Default that appears automatically.)</td>
</tr>
</tbody>
</table>

OUTLINES (ORACLE) - DEFINITION

Type the SQL statement you want to store as an outline.

**NOTE:** The only SQL statements possible with stored outlines are SELECT, DELETE, UPDATE, INSERT…SELECT, and CREATE TABLE…AS SELECT.

PACKAGES WIZARD (ORACLE)

A package is a collection of related program objects stored together in the database. A package specification or package header, declares variables, constants, etc., that are visible outside the package's immediate scope. The package body defines objects declared by the specification but are not visible to applications outside the package. Packages contain all the information needed to process SQL statements from a single source file. You can use packages to process and call batches of SQL.
To Open the Package Wizard

1. On the Navigator, find the datasource where you want to create a package and expand the Schema node.
2. Right-click the Packages node, and select New.

You’re asked to name an owner for the package and give it a name. When you click Finish, the Packages editor opens to the header tab where you indicate any package specifications and create the package body. For more information, see “Package Bodies Editor (Oracle)” on page 536.

PRIMARY KEYS WIZARD (ORACLE)

Primary key (constraint)s are a set of table columns that can uniquely identify every row of a table. No fields that are a part of the primary key can have null values, and each table can have only one primary key.

To create a new primary key using a wizard:

1. Open a creation wizard for a primary key. For details, see “Opening an Object Wizard” on page 248.
2. Use the following topics as a guide to setting properties and performing tasks as you pass through the wizard panels:
   - Properties panel - Primary Keys (Oracle) - Properties.
   - Columns panel - Primary Keys (Oracle) - Columns.
   - Storage panel - Primary Keys (Oracle) - Storage.
   - Partition panel - Primary Keys (Oracle) - Partition.
   - DDL panel - for details, see “Previewing the DDL Generated to Create the New Object” on page 250.
3. Finally, use the Execute button to create the object.

PRIMARY KEYS (ORACLE) - PROPERTIES

When creating or editing a primary key, this tab/panel lets you work with the following settings:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table Owner and Table Name</td>
<td>Choose the owner and name of the table in which the primary key is being created.</td>
</tr>
<tr>
<td>Name</td>
<td>Provide a name for the primary key being created.</td>
</tr>
<tr>
<td>No Sort</td>
<td>Enable this feature if the rows in the table already stored in ascending order. This increases the speed of the index creation process. Oracle does not sort the rows.</td>
</tr>
<tr>
<td>Logging</td>
<td>Enabling logs this operation to the redo file.</td>
</tr>
</tbody>
</table>
**CREATING OBJECTS**

**PRIMARY KEYS (ORACLE) - COLUMNS**
From the Column dropdown, select a column for the index and specify a Sort option. To add more columns, click the New button and then follow the steps in the last instruction. Use the Delete button to drop columns.

**PRIMARY KEYS (ORACLE) - STORAGE**
When creating or editing a primary key, this tab/panel lets you work with the following settings:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reverse</td>
<td>Enabling this feature stores the bytes of the index block in reverse order and excludes the ROWID. The ROWID is a globally unique identifier for a row in a database. It is created at the time the row is inserted into a table, and destroyed when it is removed from a table.</td>
</tr>
<tr>
<td>Validate</td>
<td>Enabling this option indicates that existing data is checked against the constraint when the primary key is enabled. Leaving it disabled indicates that only new data is to be checked against the constraint.</td>
</tr>
<tr>
<td>Deferrable</td>
<td>Dictates whether constraint checking can be deferred until the end of a transaction.</td>
</tr>
<tr>
<td>Deferred</td>
<td>This option is enabled only if you enabled the Deferrable option. Select IMMEDIATE to have the constraint checked at the end of every DDL statement. Select DEFERRED to have the constraint checked only at the end of a transaction.</td>
</tr>
<tr>
<td>Enabled</td>
<td>Enables or disables the primary key.</td>
</tr>
</tbody>
</table>

**Setting**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Block Storage group</td>
<td>Select the DEFAULT Tablespace only if you are creating a local partitioned index and want the partitions in the same tablespace as the partitions in the underlying table. (Each partition of a local index is associated with one partition of the table. Oracle can then keep the index partitions in sync with table partitions.) A transaction entry is needed for each INSERT, UPDATE, DELETE, etc. statement that accesses one or more rows in the block. Transaction entries in many operating systems require approximately 23 bytes. <strong>Percent Free</strong> identifies how much space you want to allocate for new rows or updates to existing rows. <strong>Initial Transactions</strong> ensures that a minimum number of concurrent transactions can update an index block, avoiding the overhead of allocating a transaction entry dynamically. <strong>Maximum Transactions</strong> limits concurrency on an index block.</td>
</tr>
</tbody>
</table>
CREATING OBJECTS

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
</table>
| Extents group      | An extent is the unit of space allocated to an object whenever the object needs more space.  
|                    | **Initial Extent** - The initial space extent (in bytes) allocated to the object.  
|                    | **Next Extent** - The next extent (in bytes) that the object will attempt to allocate when more space for the object is required.  
|                    | **Percentage Increase** - Lets you type the percentage.  
|                    | NOTE: You should be careful when setting Percent Increase because it magnifies how an object grows and, therefore, can materially affect available free space in a tablespace.  
|                    | **Minimum Extents** - For a dictionary managed tablespace, this is the total number of extents to be allocated when the index is first created. For a locally managed tablespace, this is simply the initial amount of space allocated.  
|                    | **Maximum Extents** - For a dictionary managed tablespace, this is the total number of extents that can ever be allocated to the index. In a locally managed tablespace, the database will automatically manage the extents.  
| Freelists group    | **Free lists** let you manage the allocation of data blocks when concurrent processes are issued against the index. You can potentially improve the performance of the index by identifying multiple free lists, which can reduce contention for free lists when concurrent inserts take place.  
|                    | The default and minimum value is 1. You should increase this number if multiple processes access the same data block.  
|                    | **Free List Groups** is the number of groups of free lists.  
|                    | NOTE: This option is only applicable for the parallel server option.  
| Buffer Pool        | **DEFAULT** - Choose this if you want to use the default bufferpool.  
|                    | **KEEP** - Use this to retain the object in memory to avoid I/O conflicts. This type of bufferpool stores frequently referenced data blocks in a separate cache.  
|                    | **RECYCLE** - Select this option to save cache space by ridding data blocks from memory as soon as they are no longer in use.  

**PRIMARY KEYS (ORACLE) - PARTITION**

Clicking **Create Partition** opens a wizard that lets you create a partition.

**PROCEDURES WIZARD (ORACLE)**

Procedures are a reusable block of PL/SQL, stored in the database, that applications can call. Procedures streamline code development, debugging, and maintenance by being reusable. Procedures enhance database security by letting you write procedures granting users execution privileges to tables rather than letting them access tables directly. Procedures do not return values, unlike functions.

**NOTE:** To create a procedure in your own schema, you need CREATE PROCEDURE privileges. To create a procedure in someone else’s schema, you need CREATE ANY PROCEDURE privileges.
To create a new procedure using a wizard:

1. Open a creation wizard for a procedure. For details, see "Opening an Object Wizard" on page 248.

2. Use the following topics as a guide to setting properties and performing tasks as you pass through the wizard panels:
   - **Properties** panel - Procedures (Oracle) - Properties.
   - **Definition** panel - for details, see Procedures (Oracle) - Definition.

3. Finally, use the **Execute** button to create the object.

### Procedures (Oracle) - Properties
When creating or editing a procedure, this tab/panel lets you work with the following settings:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Owner</td>
<td>Select the owner of the procedure.</td>
</tr>
<tr>
<td>Name</td>
<td>Provide a name for the procedure.</td>
</tr>
</tbody>
</table>

### Procedures (Oracle) - Definition
Complete the CREATE PROCEDURE outline provided by typing or pasting the body of the procedure.

### Profiles Wizard (Oracle)
Profiles are a mechanism for allocating system and database resources to users. In essence, a profile is a set of limits with a name attached to them. If the profile is active, Oracle will limit use and resources to the limits defined by the profile.

The Profile Wizard lets you:

- Name the profile.
- Set composite limit.
- Set session limits for SGA shared pool.
- Set limits on total connection time per session and Idle time per session.
- Set limits on concurrent sessions per user, CPU time per session, and data blocks read per session.
- Set limits on CPU time per call, and number of data blocks read for a call to process an SQL statement.
- Set the number of failed login attempts, and the days an account locks.

**NOTE:** To create a profile, you need the CREATE PROFILE system privilege.
The Default option is subject to the limit specified for that particular resource. The default profile initially permits unlimited resources. Limits to the default profile can be made using an Alter statement.

The Unlimited option allows the user with that profile to take use unlimited amounts of that resource.

The Other options take on the resource limits that you indicate.

**To Open the Profile Wizard**

1. On the Navigator, find the datasource where you want to create a procedure and expand the Security node.
2. Right-click the Profile node, and select New.

The table that follows describes the fields you may encounter as you complete the wizard.

<table>
<thead>
<tr>
<th>Required Information</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>What is the name of the profile?</td>
<td>Write a name that’s 30 characters or less</td>
</tr>
<tr>
<td>What is the composite limit on resources per session?</td>
<td>You can set a single composite limit for all resource limits in a profile in addition to setting specific resource limits for a profile. Explicit and composite limits can peacefully coexist. The limit that is reached first stops the session’s activity. Service units are a weighted sum of CPU per session, connect time, logical reads per session, and private SGA. Default/Unlimited/Other (service units)</td>
</tr>
<tr>
<td>What is the limit on the amount of private space a session can allocate in the shared pool of the SGA?</td>
<td>This limit only applies if you are using Shared Server architecture. Default/Unlimited/Other (KB)</td>
</tr>
<tr>
<td>What is the limit on the total connection time per session?</td>
<td>The total elapsed time limit for a session Default/Unlimited/Other (Minutes)</td>
</tr>
<tr>
<td>What is the limit on idle time per session?</td>
<td>Permitted periods of continuous inactive time during a session, expressed in minutes. Long-running queries and other operations are not subject to this limit. Default/Unlimited/Other (Minutes)</td>
</tr>
<tr>
<td>What is the limit on concurrent sessions per user?</td>
<td>Default/Unlimited/Other</td>
</tr>
<tr>
<td>What is the limit on CPU time per session?</td>
<td>Default/Unlimited/Other (Hundredths of a Second)</td>
</tr>
<tr>
<td>What is the limit on data blocks read per session?</td>
<td>Default/Unlimited/Other</td>
</tr>
<tr>
<td>What is the limit on CPU time per call?</td>
<td>The limit on a parse, execute, or fetch. Default/Unlimited/Other (Hundredths of a Second)</td>
</tr>
<tr>
<td>What is the limit on the number of data blocks read for a call to process a SQL statement?</td>
<td>This is the number of logical reads per call. Default/Unlimited/Other</td>
</tr>
</tbody>
</table>
This wizard builds and submits a call to DBMS_SCHEDULER.CREATE_PROGRAM with optional DBMS_SCHEDULER.DEFINE_PROGRAM_ARGUMENT calls, letting you create a program.

NOTE: This functionality is available as of Oracle 10g.

NOTE: Before working with jobs, consult Oracle documentation for general information on DBMS_SCHEDULER. For more information, see "Accessing Third Party Documentation" on page 21.

To create a program using a wizard
1. On a connected Oracle datasource, expand the Scheduler node.
2. Right-click the Programs node and select Create from the context menu.
3. Use the following topics as a guide to setting properties and performing tasks as you pass through the wizard panels:
   - Action panel - for details, see Programs (Oracle) - Action.
   - Arguments panel - for details, see Programs (Oracle) - Arguments.
   - DDL View panel - for details, see "Previewing the DDL Generated to Create the New Object" on page 250.
4. Finally, use the Finish button to create the object.
**PROGRAMS (ORACLE) - ACTION**
When creating or editing a job, this tab/panel lets you work with the following settings:

<table>
<thead>
<tr>
<th>Group</th>
<th>Settings and Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Creation</td>
<td>Lets you provide an <strong>Owner</strong> and <strong>Name</strong> for the job as well as ENABLED and COMMENTS (Description) attribute values</td>
</tr>
<tr>
<td>Type of Program</td>
<td>The <strong>Type of Program</strong> setting lets you choose among EXECUTABLE, STORED PROCEDURE, or PLSQL Block. Depending on your choice, take one of the following actions:</td>
</tr>
<tr>
<td></td>
<td>PLSQL BLOCK - Type or paste the SQL to be executed.</td>
</tr>
<tr>
<td></td>
<td>STORED PROCEDURE - Provide the <strong>Procedure Owner</strong> and <strong>Procedure Name</strong>.</td>
</tr>
<tr>
<td></td>
<td>EXECUTEABLE - Use the browse button to locate the executable.</td>
</tr>
</tbody>
</table>

**PROGRAMS (ORACLE) - ARGUMENTS**
When creating or editing a program, if you selected an Action tab choice of EXECUTABLE or STORED PROCEDURE, this tab/panel lets you manage parameters to be passed.

**ROLES WIZARD (ORACLE)**
As you complete the Role Wizard, Rapid SQL constructs the necessary CREATE ROLE statement from the information that you have supplied. The Role Wizard lets you specify a name for the role and whether or not the role should be identified.

**NOTE:** To create a role, you need the CREATE ROLE system privilege.

**To Open the Role Wizard**
1. On the Navigator, find the datasource where you want to create a role and expand the Security node.
2. Right-click the **Roles** node, and select **New**.

The table that follows describes the fields you may encounter as you complete the wizard.

<table>
<thead>
<tr>
<th>Required Information</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>What is the name of</td>
<td>Self-explanatory.</td>
</tr>
<tr>
<td>the role?</td>
<td></td>
</tr>
</tbody>
</table>
For information on activating and deactivating roles for the current login in the current session, see "Role Activation" on page 681.

**ROLLBACK SEGMENTS WIZARD (ORACLE)**

Rollback segments manage all transactions in your Oracle databases. A transaction is a read, modify, and write cycle for an Oracle database. A rollback entry is made for all transactions unless a particular clause is specified. So, a rollback segment is a transaction log that consists of a pre-update image value and transaction status, among other things. The rollback segments maintain read consistency among concurrent users in a database and if the transaction fails for any reason, the old image is taken from the rollback segment. By maintaining a history of data changes, rollback segments can rollback uncommitted transactions so that data is rolled back to the prior state. SYS owns all rollback segments no matter who created them and are not accessible to users, just Oracle.

Oracle, it should be mentioned, strongly recommends that you use automatic undo management to simplify managing databases. Tuning rollback segments is a manual process that has largely been deprecated by Oracle, but it is supported for backward compatibility reasons.

The Rollback Segment Wizard lets you:

- Name the rollback segment and to place it online or off-line.

- Place the rollback segment on a tablespace.

- Specify the initial next and optimal extent size as well a the minimum and maximum number of extents that should be allocated to the rollback segment.

**NOTE:**  This wizard is not available if auto-UNDO management is enabled.

**TIP:**  Make sure enough rollback segments exist on a database to handle the imposed workload. One rule of thumb is to create one rollback segment for every four concurrent users.
**To Open the Rollback Segment Wizard**

1. On the Navigator, find the datasource where you want to create a rollback segment and expand the Storage node.

2. Right-click the **Rollback Segments** node, and select **New**.

The table that follows describes the fields you may encounter as you complete the wizard.

<table>
<thead>
<tr>
<th>Required Information</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>What is the name of the rollback segment?</td>
<td>Self-explanatory.</td>
</tr>
</tbody>
</table>
| Should this rollback segment be made public? | Yes - A public rollback segment can be brought online by any instance in a parallel server. Public rollback segments form a pool of rollback segments that can be used by any instance that needs one.  
No - This is the default. A private rollback segment can only be acquired by the instance specifying the segment in its initialization file. |
| Do you want to place the rollback segment to be online following its creation? | Online - To be useful, a rollback segment must be online.  
Offline - You may want to take rollback segments offline if you want to take a tablespace offline and it contains rollback segments that you want to keep from being used. |
| On which tablespace do you want to place this rollback segment? | Self-explanatory.  
Oracle suggests that you create one or more tablespaces specifically to hold all rollback segments. This way, the data contained in the rollback segments is held apart from other data types. |
| What extent sizes do you want to assign to this rollback segment? | Initial size (KB)  
Next size (KB)  
Optimal size (KB) Null/Default |
| What are the minimum and maximum number of extents to allocate to the rollback segment? | Minimum  
Maximum |

**SCHEDULES WIZARD (ORACLE)**

This wizard builds and submits a call to DBMS_SCHEDULER.CREATE_SCHEDULE call, letting you create a schedule.

**NOTE:** This functionality is available as of Oracle 10g.

**NOTE:** Before working with jobs, consult Oracle documentation for general information on DBMS_SCHEDULER. For more information, see "Accessing Third Party Documentation" on page 21.
To create a schedule using a wizard

1. On a connected Oracle datasource, expand the **Scheduler** node.
2. Right-click the **Schedules** node and select **Create** from the context menu.
3. Use the following topics as a guide to setting properties and performing tasks as you pass through the wizard panels:
   - **Properties** panel - for details, see **Schedules (Oracle) - Properties**.
   - **DDL View** panel - for details, see “**Previewing the DDL Generated to Create the New Object**” on page 250.
4. Finally, use the **Finish** button to create the object.

**Schedules (Oracle) - Properties**

When creating or editing a job, this tab/panel lets you work with the following settings:

<table>
<thead>
<tr>
<th>Group</th>
<th>Settings and Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Creation</td>
<td>Lets you provide an <strong>Owner</strong> and <strong>Name</strong> for the schedule.</td>
</tr>
<tr>
<td>Attributes</td>
<td><strong>Description</strong> - corresponds to a COMMENT attribute.</td>
</tr>
<tr>
<td></td>
<td><strong>Repeat Interval</strong> - corresponds to a REPEAT_INTERVAL attribute. Calendaring syntax, as</td>
</tr>
<tr>
<td></td>
<td>described in Oracle DBMS_SCHEDULER documentation, can be typed free-form, and will be</td>
</tr>
<tr>
<td></td>
<td>passed directly to the server. For information on third-party documentation access, see</td>
</tr>
<tr>
<td></td>
<td>&quot;<strong>Accessing Third Party Documentation</strong>&quot; on page 21.</td>
</tr>
<tr>
<td></td>
<td><strong>Start Date</strong> and <strong>End Date</strong> - correspond to START_DATE and END_DATE, attributes.</td>
</tr>
</tbody>
</table>

**Sequences Wizard (Oracle)**

Sequences are programmable database objects that provide numbers in sequence for input to a table. A sequence can be used to automatically generate primary key values for tables. Once defined, a sequence can be made available to many users. When you create a sequence, you can define its initial value, increment interval, and maximum value.

The Sequence Wizard lets you:

- Specify the name and owner of the sequence.
- Set both the value of the sequence, and an interval and ranges for incrementing it.
- Cache the sequence, cycle the sequence when it reaches its minimum or maximum values, and guarantee that Oracle generates sequence numbers in the order of request.

**NOTE:** To create a sequence, it must belong to your schema or you need CREATE SEQUENCE privilege.
To Open the Sequence Wizard

1. On the Navigator, find the datasource where you want to create a rollback segment and expand the Schema node.

2. Right-click the Sequences node, and select New.

The table that follows describes the fields you may encounter as you complete the wizard.

<table>
<thead>
<tr>
<th>Required Information</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Who owns the sequence?</td>
<td>Self-explanatory.</td>
</tr>
<tr>
<td>What is the sequence name?</td>
<td>Self-explanatory.</td>
</tr>
<tr>
<td>What is the first sequence number to be generated?</td>
<td>Start with: Pick an integer.</td>
</tr>
<tr>
<td>What is the interval between sequence numbers?</td>
<td>Increment by: Positive numbers will generate ascending values, and a negative number will generate descending numbers</td>
</tr>
<tr>
<td>What is the sequence's minimum value?</td>
<td>The default is 1 for ascending sequences; This integer value can have 28 or fewer digits. None Minimum value - Identify how low the sequence can go.</td>
</tr>
<tr>
<td>What is the sequence's maximum value?</td>
<td>For descending values, the default is 1. Lets you specify the maximum value the sequence can generate. This integer value can have 28 or fewer digits. None Maximum value - Indicate the highest sequence value that will be allowed.</td>
</tr>
<tr>
<td>Should Oracle preallocate sequence numbers and cache them for faster access?</td>
<td>This is the number of sequence values you want to specify in the SGA buffers. This speeds access, but cached numbers are erased when the database is shut down. The default value is 20. Yes Number of values No</td>
</tr>
<tr>
<td>Should the sequence continue to generate values after reaching either its maximum or minimum value?</td>
<td>If you say no, the sequences will automatically recycle to the minimum value when you’ve hit the maximum for ascending sequences and vice versa for descending sequence values. Yes No</td>
</tr>
<tr>
<td>Should the sequence numbers be generated in the order of request?</td>
<td>This may be required when sequences are required for timestamping. But generally, because sequences are naturally ordered, this is only necessary for if you use Oracle RAC clusters for parallel mode. Yes No</td>
</tr>
</tbody>
</table>
SNAPSHOTS AND SNAPSHOT LOGS WIZARDS (ORACLE)
Oracle has replaced the snapshot functionality with materialized views. Refer to the "Materialized Views Wizard (Oracle)" on page 381 and "Materialized View Logs Wizard (Oracle)" on page 386.

SYNONYMS WIZARD (ORACLE)
Synonyms are alternate names for database objects to be used as a reference by users or applications. A synonym offers you security and convenience so that you can refer to an object without revealing who owns it or what database it belongs to. Synonyms Depending on the platform, you can define synonyms on tables, views, sequences, procedures, functions, packages, and materialized views. If an underlying object needs to be renamed or moved, it’s easy enough to redefine the synonym without having to modify any applications based on the synonym.

NOTE: To create a private synonym, you need CREATE SYNONYM privileges. To create a public synonym, you need CREATE PUBLIC SYNONYM privileges.

To create a new synonym using a wizard:
1. Open a creation wizard for a synonym. For details, see "Opening an Object Wizard" on page 248.
2. Use the following topics as a guide to setting properties and performing tasks as you pass through the wizard panels:
   • Properties panel - Synonyms (Oracle) - Properties.
   • Definition panel - for details, see "Previewing the DDL Generated to Create the New Object" on page 250.
3. Finally, use the Execute button to create the object.

SYNONYMS (ORACLE) - PROPERTIES
When creating or editing a synonym, this tab/panel lets you work with the following settings:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Owner and Name</td>
<td>Choose the owner and provide a name for the synonym being created.</td>
</tr>
<tr>
<td>Referenced Object Owner</td>
<td>Select the owner of the object to which the synonym is to refer.</td>
</tr>
<tr>
<td>Referenced Object Type</td>
<td>Select the type of the object to which the synonym is to refer.</td>
</tr>
<tr>
<td>Referenced Object Name</td>
<td>Select the specific object to which the synonym is to refer.</td>
</tr>
<tr>
<td>Database Link</td>
<td>If the object resides on a remote database, select a database link.</td>
</tr>
</tbody>
</table>
TABLES WIZARD (ORACLE)

Tables are the most basic data storage units for Oracle. As you might expect, data is stored in rows and columns. By completing the Table Wizard, Rapid SQL constructs the necessary CREATE TABLE statement from the information that you supply. The Table Wizard varies slightly in content based on the version of Oracle on the target datasource. But in all cases, you name columns and determine column width or precision and scale depending on the column’s data type. A row collects the column information that corresponds to a single record.

You can set rules for the columns to live by, and these are called integrity constraints. For example, if you select NOT NULL, that column will have to have a value in each row.

Also, before beginning, consider what kind of table you want to create as the wizard will ask you to choose:

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Heap organized</td>
<td>This is a basic table where data is stored as an unordered collection, i.e., heap.</td>
</tr>
<tr>
<td>Index-organized</td>
<td>A B-tree index structure stores data, sorted by primary key. Nonkey column values are stored too.</td>
</tr>
<tr>
<td>Partitioned table</td>
<td>Data is broken down into smaller, more manageable pieces called partitions or subpartitions. Each partition can be managed individually and operate independent of the other partitions.</td>
</tr>
<tr>
<td>Clustered table</td>
<td>This is a table that, once created, is part of a cluster. A cluster is a group of tables that share some data blocks and columns and are often used together. To create a cluster, use the &quot;Clusters Wizard (Oracle)&quot; on page 368.</td>
</tr>
</tbody>
</table>

**NOTE:** The table wizard panels differ depending on what options you select.

**NOTE:** To simplify the process of creating a table, the Table Wizard focuses on creating the basic table definition with a primary key constraint. After you create the basic table definition you can add unique and foreign keys to the table on the Constraints tab of the Tables Editor.
To create a new table using a wizard:

1. Open a creation wizard for a table. For details, see "Opening an Object Wizard" on page 248.

2. Use the following topics as a guide to setting properties and performing tasks as you pass through the wizard panels:

   - **Properties** panel - for details, see Tables (Oracle) - Properties.
   - **Columns** panel - for details, see Tables (Oracle) - Columns.
   - **Indexes** panel (not available with a Row Organization of EXTERNAL) - for details, see Tables (Oracle) - Columns.
   - **Constraints** panel (not available with a Row Organization of EXTERNAL) - for details, see Tables (Oracle) - Constraints.
   - **Storage** panel (not available with a Row Organization of EXTERNAL) - for details, see Tables (Oracle) - Storage.
   - **IOT Properties** panel (not available with a Row Organization of EXTERNAL) - for details, see Tables (Oracle) - IOT Properties.
   - **Partition** (not available with a Row Organization of EXTERNAL) - for details, see Tables (Oracle) - Partition.
   - **Comment** panel - for details, see "Adding a Comment to an Object" on page 249.
   - **Permissions** panel - for details, see "Setting Permissions or Privileges for an Object" on page 250.
   - **DDL View** panel - for details, see "Previewing the DDL Generated to Create the New Object" on page 250.

3. Finally, use the **Execute** button to create the object.

### Tables (Oracle) - Properties

When creating or editing a table, this tab/panel lets you work with the following settings:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Owner</td>
<td>Select the owner of the table.</td>
</tr>
<tr>
<td>Name</td>
<td>Provide a name for the table</td>
</tr>
<tr>
<td>Cache</td>
<td>Enabling this feature keeps a block in memory by placing it at the most recently used end. This option is useful for small lookup tables.</td>
</tr>
<tr>
<td>Row Movement</td>
<td>Enabling this option permits the migration of a row to a new partition if its key is updated.</td>
</tr>
<tr>
<td>Parallel Degree</td>
<td>A value indicating the number of query server processes that should be used in the operation.</td>
</tr>
<tr>
<td>Parallel Instances</td>
<td>A value indicating how you want the parallel query partitioned between the Parallel Servers.</td>
</tr>
</tbody>
</table>
To add a column to the table

1. Click Add Column, provide a Name he column in the Property/Value list, and press TAB or ENTER.

   The column is added to the columns list on the left, with default attribute values.

2. Proceed to edit the column attributes.

To edit column attributes

3. Select the column in the columns list on the left. The controls in the Property/Values list are updated with values of the selected column.

4. Use the following table as a guide to providing additional property values, noting that availability of a property differs by data type and other property selections.

<table>
<thead>
<tr>
<th>Property or group</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Virtual</td>
<td>Selecting this check box defines the column as an Oracle virtual column, with a value calculated from a column expression. Virtual columns do not use any disk space as there is o data to store, and INSERT/UPDATE operations are not supported. Consult Oracle documentation before working with virtual columns to familiarize yourself with topics such as column expressions and virtual column-specific details such as automatic type conversion. For more information, see &quot;Accessing Third Party Documentation&quot; on page 21. After specifying a column as virtual, use the Default Value box to provide the calculation.</td>
</tr>
<tr>
<td>Datatype</td>
<td>This group lets you select a valid Type for the column. Depending on your selection, additional properties such as Scale, Size, Width, and Unused may be available.</td>
</tr>
<tr>
<td>Allow Nulls</td>
<td>Select this check box to allow nulls in this column.</td>
</tr>
</tbody>
</table>
To delete a column
1. Select a column from the column list on the left.
2. Click Delete to remove the column from the table.

To change a column’s ordering position
1. Select a column from the column list on the left.
2. Use the arrow buttons to move the column up or down.

TABLES (ORACLE) - INDEXES

NOTE: This tab/panel is not available with a Row Organization of EXTERNAL.

Click Add to open the Index Wizard. For details, see "Indexes Wizard (Oracle)" on page 375.

TABLES (ORACLE) - CONSTRAINTS

NOTE: This tab/panel is not available with a Row Organization of EXTERNAL.

Selecting a constraint type and clicking Add opens the object wizard for that object type. For details see:
- "Primary Keys Wizard (DB2 LUW)" on page 263
TABLES (ORACLE) - STORAGE

NOTE: This tab/panel is not available with a Row Organization of EXTERNAL.

When creating or editing a table, this tab/panel has the following settings:

<table>
<thead>
<tr>
<th>Settings</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Data Block Storage** group | Select the DEFAULT Tablespace only if you want the partitions in the same tablespace as the partitions in the underlying table.  
Percent Free identifies how much space you want to allocate for new rows or updates to existing rows.  
Initial Transactions ensures that a minimum number of concurrent transactions can update a primary key block, avoiding the overhead of allocating a transaction entry dynamically.  
Maximum Transactions limits concurrency on a primary key block. |
| **Extents** group | An extent is the unit of space allocated to an object whenever the object needs more space.  
Initial Extent - The initial space extent (in bytes) allocated to the object.  
Next Extent - The next extent (in bytes) that the object will attempt to allocate when more space for the object is required.  
Percentage Increase - Lets you type the percentage.  
NOTE: You should be careful when setting Percent Increase because it magnifies how an object grows and, therefore, can materially affect available free space in a tablespace.  
Minimum Extents - For a dictionary managed tablespace, this is the total number of extents to be allocated when the index is first created. For a locally managed tablespace, this is simply the initial amount of space allocated.  
Maximum Extents - For a dictionary managed tablespace, this is the total number of extents that can ever be allocated to the index. In a locally managed tablespace, the database will automatically manage the extents. |
| **Freelists** group | Free lists let you manage the allocation of data blocks when concurrent processes are issued against the primary key. You can potentially improve the performance of the primary key by identifying multiple free lists, which can reduce contention for free lists when concurrent inserts take place.  
The default and minimum value is 1. You should increase this number if multiple processes access the same data block.  
Free List Groups is the number of groups of free lists.  
NOTE: This option is only applicable for the parallel server option. |
| **Buffer Pool**       | DEFAULT - Choose this if you want to use the default bufferpool.  
KEEP - Use this to retain the object in memory to avoid I/O conflicts. This type of bufferpool stores frequently referenced data blocks in a separate cache.  
RECYCLE - Select this option to save cache space by ridding data blocks from memory as soon as they are no longer in use. |
TABLES (ORACLE) - IOT PROPERTIES

**NOTE:** This tab/panel is not available with a **Row Organization** of **EXTERNAL**.

Provide compression and space details for an index-organized table.

TABLES (ORACLE) - PARTITION

**NOTE:** This tab/panel is not available with a **Row Organization** of **EXTERNAL**.

Prior to working with partitions, you should be familiar with the material in **Rapid SQL and Oracle Partitioning**.

Click **Create Partition** to **Partition a table**.

**RAPID SQL AND ORACLE PARTITIONING**

Partitioning your tables lets you get around the problem of supporting large tables. Partitioning lets you break large tables into smaller pieces, which are called partitions. Partitions make the data in your table easier to manage and analyze. Your SQL statements can access the partitions rather than the entire table. Partitions are most useful in data warehouse applications, which store large amounts of data.

The table below describes the types of partitions in Oracle:

<table>
<thead>
<tr>
<th>Partition Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Range</strong></td>
<td>Use range partitioning to map rows to partitions based on ranges of column values. This type of partitioning is useful when dealing with data that has logical ranges into which it can be distributed; for example, months of the year. Performance is best when the data evenly distributes across the range. If partitioning by range causes partitions to vary dramatically in size because of unequal distribution, you may want to consider one of the other methods of partitioning.</td>
</tr>
<tr>
<td><strong>Hash</strong></td>
<td>Use hash partitioning if your data does not easily lend itself to range partitioning, but you would like to partition for performance and manageability reasons. Hash partitioning provides a method of evenly distributing data across a specified number of partitions. Rows are mapped into partitions based on a hash value of the partitioning key. Creating and using hash partitions gives you a highly tunable method of data placement, because you can influence availability and performance by spreading these evenly sized partitions across I/O devices (striping).</td>
</tr>
<tr>
<td><strong>Composite</strong></td>
<td>Hash partitions partition the table according to a hash function. Composite partitions use both range and hash types, first partitioning the data by a range of values, and then further dividing the partitions into subpartitions by way of a hash function. This option is not available for index-organized tables.</td>
</tr>
<tr>
<td><strong>List</strong></td>
<td>Use list partitioning when you require explicit control over how rows map to partitions. You can specify a list of discrete values for the partitioning column in the description for each partition. This is different from range partitioning, where a range of values is associated with a partition, and from hash partitioning, where the user has no control of the row to partition mapping.</td>
</tr>
</tbody>
</table>
PARTITION A TABLE
The Add partition wizard lets you set up partitions for a table. Use the following topics as a
guide to setting properties and performing tasks as you pass through the wizard panels:

<table>
<thead>
<tr>
<th>Step</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Properties</strong></td>
<td>Select a Partition Type and optionally, a Subpartition Type.</td>
</tr>
<tr>
<td><strong>Columns</strong></td>
<td>For each column, click the New button and select a name from the Column dropdown. Use the Delete button to drop a selected column.</td>
</tr>
<tr>
<td><strong>Subpartition Columns</strong> (only available with a Partition Type of RANGE and Subpartition Type of HASH or LIST)</td>
<td>For each column, click the New button and select a name from the Column dropdown. Use the Delete button to drop a selected column.</td>
</tr>
<tr>
<td><strong>Subpartitions</strong> (only available with a Subpartition Type of HASH)</td>
<td>Specify a Default number of partitions. For each partition, click the New button and then select a tablespace from the dropdown.</td>
</tr>
<tr>
<td><strong>Range Definitions</strong> (only available with a Partition Type of RANGE)</td>
<td>Click the New button to Add a partition definition.</td>
</tr>
<tr>
<td><strong>Partition Definition</strong> (only available with a Partition Type of HASH)</td>
<td>To specify a partition method other than None, take one of the following actions: (1) Select the Number Of Partitions radio box, specify the Number Of Partitions, and for each partition, click the New button and choose a tablespace from the dropdown, or (2) select the By Partition Name radio box and for each partition, click the New button provide a name and then choose a tablespace from the dropdown.</td>
</tr>
<tr>
<td><strong>List Definitions</strong> (only available with a Partition Type of List)</td>
<td>Click New to Add a partition definition.</td>
</tr>
</tbody>
</table>

ADD A PARTITION DEFINITION
Use the following topics as a guide in completing the settings in this wizard:

<table>
<thead>
<tr>
<th>Step</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Partition Definition</strong></td>
<td>Name Provide a name.</td>
</tr>
<tr>
<td></td>
<td>Tablespace Select a tablespace from the dropdown</td>
</tr>
<tr>
<td></td>
<td>Logging Enable or disable logging.</td>
</tr>
<tr>
<td><strong>Subpartitions</strong></td>
<td>To specify a partition method other than None, select the By Subpartition Name radio box and for each partition, click the New button to open a dialog that lets you provide subpartition values.</td>
</tr>
<tr>
<td></td>
<td>NOTE: When you split a range-list partition, you cannot specify the new partitions’ subpartition information.</td>
</tr>
<tr>
<td><strong>Storage</strong></td>
<td>Provide or select Data Block Storage, Extents, Freelists, and Buffer Pool values.</td>
</tr>
</tbody>
</table>
TABLESPACES WIZARD (ORACLE)
Tablespaces are logical storage structures that act as partitions for the database. Each tablespace consists of one or more datafiles which are the physical structures holding the data. You can create a tablespace to store table data and other objects related to table performance such as indexes or large object data. Tablespaces are used to manage large complex databases. Once you have created a tablespace, you can place objects on it.

The Tablespace Wizard lets you:

- Name the tablespace, and specify space management.
- Specify what types of objects are stored on the tablespace, and place the tablespace online or offline.
- Add the datafiles that comprise the tablespace and specify the parameters for the datafiles.
- Specify how Oracle should manage the growth of the tablespace.

Important Notes

- For auto-UNDO management to be in effect, set init.ora parameter to undo_management. When set to MANUAL (the default), it disables auto-UNDO management. When set to AUTO, auto-UNDO management is enabled.

- To determine if the undo_management parameter is set to AUTO, use the following query:

  ```sql
  SELECT VALUE
  FROM   SYS.V_$PARAMETER
  WHERE NAME = 'undo_management'
  ```

  **NOTE:** This parameter cannot be set dynamically via the ALTER SYSTEM or ALTER SESSION.

One of the best ways to avoid fragmentation in a tablespace is to pre-allocate the space that your objects will use. If possible, plan for one to two years’ growth for each object and allocate your space accordingly. Having initial empty objects will not affect table scan times as Oracle only scans up to the high-water mark (the last used block) in a table.

Of all your tablespaces, you want to avoid fragmentation problems in your SYSTEM tablespace the most as this is the major hotbed tablespace for Oracle activities. The easiest way to avoid this is to not allow any user (even the default DBA ID’s SYS and SYSTEM) to have access to it. There are three ways to do this:

- Ensure no user has a DEFAULT or TEMPORARY tablespace assignment of SYSTEM.
- Ensure no user has a quota set for SYSTEM.
- Ensure no user has been granted the UNLIMITED TABLESPACE privilege.
To create a new tablespace using a wizard:

1. Open a creation wizard for a tablespace. For details, see "Opening an Object Wizard" on page 248.

2. Use the following topics as a guide to setting properties and performing tasks as you pass through the wizard panels:
   - **Properties** panel - see Tables (Oracle) - Properties.
   - **Datafiles** panel - see Tables (Oracle) - Datafiles.
   - **DDL** panel - for details, see "Previewing the DDL Generated to Create the New Object" on page 250.

3. Finally, use the **Execute** button to create the object.

### Tables (Oracle) - Properties

When creating or editing a tablespace, this tab/panel lets you work with the following settings:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Name</strong></td>
<td>Provide a name for the tablespace.</td>
</tr>
<tr>
<td><strong>Big File</strong></td>
<td>Selecting this check box results in a CREATE BIGFILE TABLESPACE statement being generated. This results in a large, single file tablespace. Leaving this check box unselected results in a tablespace containing multiple smaller datafiles.</td>
</tr>
<tr>
<td><strong>Type</strong></td>
<td>Leaving the default PERMANENT selection creates a permanent tablespace, intended to contain schema objects you want to keep on an ongoing basis. The objects are stored in datafiles. The other two options let you generate a CREATE TABLESPACE statement that specifies TEMPORARY or UNDO keywords. An Undo tablespace is a kind of permanent tablespace that holds undo data if your database is operating in automatic undo mode. Oracle recommends the automatic undo mode as the wiser choice than using rollback segments to undo. In a Temporary tablespace, schema objects will last only as long as your session continues.</td>
</tr>
<tr>
<td><strong>Tablespace Group</strong></td>
<td>This option is only available with a <strong>Type</strong> value of TEMPORARY. If there are currently entries in the SYS.DBA_TABLESPACE_GROUPS table, you can either select an existing group or type the name for a new tablespace group. If there are currently no entries in the SYS.DBA_TABLESPACE_GROUPS table, you can type the name of a new tablespace group to be created. When editing a tablespace, clearing the entry from the <strong>Tablespace Group</strong> box deletes the &lt;tablespace_name, group_name&gt; entry from the SYS.DBA_TABLESPACE_GROUPS table.</td>
</tr>
<tr>
<td><strong>Retention Guarantee</strong></td>
<td>This option is only available with a <strong>Type</strong> value of UNDO. Selecting this check box specifies that unexpired data should be preserved for all Undo segments of the tablespace, regardless of whether this may force failure of ongoing operations that require space in those segments. Leaving this check box unselected specifies default RETENTION NOGUARANTEE behavior. Space currently being used by unexpired undo data in undo segments can be consumed as necessary by ongoing transactions.</td>
</tr>
<tr>
<td>Setting</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Status</td>
<td>This option is only available with a <strong>Type</strong> value of PERMANENT. Use this control to specify an ONLINE/OFFLINE clause in the generated DDL. The ONLINE selection makes the tablespace available immediately after creation. The OFFLINE selection results in a table is unavailable immediately after creation.</td>
</tr>
<tr>
<td>Logging</td>
<td>This option is only available with a <strong>Type</strong> value of PERMANENT. Use this control to specify a LOGGING/NOLOGGING clause in the generated DDL. This sets the default logging attributes of all tables, indexes, materialized views, materialized view logs, and partitions within this tablespace.</td>
</tr>
<tr>
<td>Force Logging</td>
<td>This option is only available with a <strong>Type</strong> value of PERMANENT. Selecting this check box specifies that a FORCE LOGGING clause be included in the generated DDL. Changes to all objects in the tablespace (temporary segments excepted) are logged, overriding any NOLOGGING setting for individual objects.</td>
</tr>
<tr>
<td>Compression Type</td>
<td>This option is only available with a <strong>Type</strong> value of PERMANENT. This lets you select default compression type of ALL OPERATIONS (corresponds to COMPRESS FOR ALL OPERATIONS in the DDL), COMPRESS DIRECT LOAD (corresponds to COMPRESS FOR DIRECT LOAD OPERATIONS in the DDL) or no compression.</td>
</tr>
<tr>
<td>Flashback</td>
<td>This option is only available with a <strong>Type</strong> value of PERMANENT. Use this control to specify a FLASHBACK ON/FLASHBACK OFF clause in the generated DDL. Select this check box to put the tablespace in FLASHBACK mode. In FLASHBACK mode, Oracle saves Flashback log data for the tablespace and the tablespace can participate in a FLASHBACK DATABASE operation. If you leave this check box unselected, Oracle does not save Flashback log data for the tablespace. Prior to FLASHBACK DATABASE operations, you must either take datafiles in the tablespace off line or drop them OR take the entire tablespace offline. The database does not drop existing Flashback logs.</td>
</tr>
<tr>
<td>Encrypted and Algorithm</td>
<td>This option is only available with a <strong>Type</strong> value of PERMANENT. Selecting the <strong>Encryption</strong> check box enables the <strong>Algorithm</strong> control. Together, they let you add an ENCRYPTION USING clause to the generated DDL. The <strong>Algorithm</strong> lets you select from AES 128, AES192, AES256, DES56, DES65, or NONE encryption algorithms.</td>
</tr>
<tr>
<td>Locally Managed, Uniform Allocation, Size, Automatic Segment Space Management, and Minimum Extent Size</td>
<td>These option are only available with a <strong>Type</strong> value of PERMANENT or UNDO. These controls let you work with the extent-related clauses that will be included in the generated DDL. Selecting the <strong>Locally Managed</strong> check box lets you generate an EXTENT MANAGEMENT LOCAL clause. Subsequently leaving the <strong>Uniform Allocation</strong> check box deselected adds an AUTOALLOCATE option. Alternatively, selecting the <strong>Uniform Allocation</strong> check box enables the <strong>Size</strong> check box, letting you add a UNIFORM SIZE option. Select the <strong>Automatic Segment Space Management</strong> check box to generate a SEGMENT SPACE MANAGEMENT AUTO or leave it deselected to generate a SEGMENT SPACE MANAGEMENT MANUAL clause. Leaving the <strong>Locally Managed</strong> check box deselected generates an EXTENT MANAGEMENT DICTIONARY clause. This also enables the <strong>Minimum Extent Size</strong> control, letting you select a MINIMUM EXTENT clause value.</td>
</tr>
<tr>
<td>Use Default Block Size and Block Size</td>
<td>Disabling the <strong>Use Default Block Size</strong> check box enables the <strong>Block Size</strong> control, generating a BLOCKSIZE clause to specify a nonstandard block size for the tablespace.</td>
</tr>
</tbody>
</table>
TABLESPACES (ORACLE) - DATAFILES
When creating or editing a tablespace, this tab/panel lets you build DATAFILE or TEMPFILE clauses that will be submitted with the CREATE TABLESPACE statement creating or editing this tablespace. This lets you manage the files that make up the tablespace.

To add a datafile
1. Click Add, either select an existing file name from File Name dropdown or type the name of a new file, and then press TAB or ENTER.

   The file is added to the datafiles list on the left, with default attribute values.
2. Proceed to edit the datafile attributes.

To edit datafile attributes
3. Select the file from the list on the left. The controls in the Property/Values list are updated with values of the selected file.
4. Use the following table as a guide to modifying property values.

<table>
<thead>
<tr>
<th>Properties</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Size</td>
<td>Lets you specify the SIZE option for the DATAFILE/TEMPFILE clause, to specify the size of the file.</td>
</tr>
<tr>
<td>Reuse Existing File</td>
<td>Lets you specify the REUSE option for the DATAFILE/TEMPFILE clause, to specify that an existing file can be reused.</td>
</tr>
<tr>
<td>Auto Extend and Growth Amount</td>
<td>Use these options to select an AUTOEXTEND option for the DATAFILE/TEMPFILE clause.</td>
</tr>
<tr>
<td></td>
<td>Leaving the Auto Extend check box unselected disables the Growth Amount disabled and specifies an AUTOEXTEND OFF option in the generated DDL.</td>
</tr>
<tr>
<td></td>
<td>Selecting the Auto Extend check box lets you specify an AUTOEXTEND ON NEXT clause. Selecting Auto Extend enables the Growth Amount control, letting you specify the size of the next increment of disk space automatically allocated when more extents are required.</td>
</tr>
<tr>
<td>Unlimited and Value</td>
<td>These options are only available with Auto Extend selected. They let you specify a MAXSIZE clause.</td>
</tr>
<tr>
<td></td>
<td>Selecting the Unlimited check box lets you specify a MAXSIZE UNLIMITED clause, placing no limit on the size of the file.</td>
</tr>
<tr>
<td></td>
<td>Leaving the Unlimited check box unselected enables the Value disabled. This specifies a MAXSIZE clause with a size provide by the Value control.</td>
</tr>
</tbody>
</table>

To delete a datafile
1. Select a datafile from the column list on the left.
2. Click Delete to remove the datafile from the tablespace.
TRIGGERS WIZARD (ORACLE)
This wizard lets you build and submit a CREATE OR REPLACE TRIGGER statement, creating a trigger to be associated with a table, view, schema, or database. BEFORE, AFTER, and COMPOUND triggers are supported for a variety of DDL, DML, and Database manipulation events.

Important Notes
• To create triggers in your own schema, you need CREATE TRIGGER privileges. To create triggers in other schemas, you need CREATE ANY TRIGGER privileges.

To create a new trigger using a wizard:
1. Open a creation wizard for a trigger. For details, see “Opening an Object Wizard” on page 248.
2. Use the following topics as a guide to setting properties and performing tasks as you pass through the wizard panels:
   - Properties panel - for details, see Triggers (Oracle) - Properties.
   - Events panel - for details, see Triggers (Oracle) - Events.
   - Column Selection panel - for details, see Triggers (Oracle) - Column Selection.
   - Action panel - for details, see Triggers (Oracle) - Action.
   - DDL View panel - for details, see “Previewing the DDL Generated to Create the New Object” on page 250.
3. Finally, use the Execute button to create the object.

TRIGGERS (ORACLE) - PROPERTIES
When creating or editing a trigger, this tab/panel lets you work with the following settings:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Availability and description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Parent Type</td>
<td>Select the type (TABLE, DATABASE, SCHEMA, or VIEW) of element that this trigger is to be associated with.</td>
</tr>
<tr>
<td>Parent Schema, and Name</td>
<td>If available and appropriate, select the specific object for which the trigger is being created.</td>
</tr>
<tr>
<td>Schema and Name</td>
<td>Select a schema and provide a name for the trigger being created.</td>
</tr>
<tr>
<td>Enabled</td>
<td>Deselecting this check box adds a DISABLE clause to the CREATE OR REPLACE TRIGGER statement, disabling the trigger.</td>
</tr>
<tr>
<td>Trigger Timing</td>
<td>BEFORE: These triggers serve as extensions to the constraint subsystem and are most often used to validate input data, generate values for newly inserted rows, and read from other tables for cross-reference purposes. Note: Before triggers must be created as a For Each Row. AFTER: Such a trigger is run after the integrity constraint validations; they can be used to modify operations in the database or be used for activities beyond the database, like supporting an alert notification. COMPOUND (11.1.0.7 ^): These triggers fire at more than one timing point.</td>
</tr>
</tbody>
</table>
CREATING OBJECTS

TRIGGERS (ORACLE) - EVENTS
When creating or editing a trigger, this tab/panel lets you provide BEFORE, AFTER, or FOR clause options.

If you selected a Parent Type of Table or View, select one or more of the INSERT, UPDATE, or DELETE check boxes to specify the events that are to fire the trigger.

If you selected a Parent Type of Database or Schema, select one or more of the ALTER, CREATE, ANALYZE, ASSOCIATE_STATISTICS, AUDIT, COMMENT, DISASSOCIATE_STATISTICS, DROP, GRANT, NOAUDIT, RENAME, REVOKE, TRUNCATE, LOGON, SERVERERROR, or SUSPEND check boxes to specify the events that are to fire the trigger.

TRIGGERS (ORACLE) - COLUMN SELECTION
If you chose UPDATE as the Trigger Event, this tab/panel lets you provide FOR UPDATE OF, BEFORE UPDATE OF, or AFTER UPDATE OF clause options. Select the check box beside each column that is to fire the trigger.

TRIGGERS (ORACLE) - ACTION
If you selected a Trigger Timing value of BEFORE or AFTER, provide the complete body of trigger. Keep the following in mind:

- If the SQL statement you have in mind for a trigger is longer than 60 lines of code, you would be better off creating a stored procedure.
- INSTEAD OF statements can only be used by view triggers.
- BEFORE and AFTER options cannot be used for view triggers.

If you selected a Trigger Timing value of COMPOUND, a compound trigger block template is generated. Customize the generated code provide a valid trigger body.
OBJECT TYPES WIZARD (ORACLE)
Types define an abstract data type or object composed of a collection of similar types of data. For example, you can create an object type that defines a full address rather than the pieces of an address, such as city, state and postal code. An object type stores the pieces of an address in a single type, storing them in the same location, and allowing the full address to be accessed and manipulated as single unit rather than multiple units.

To Open the Object Type Wizard
1. On the Navigator, find the datasource where you want to create a Type and expand the Schema node.
2. Right-click the Type node, and select New.

The single page wizard asks that you pick an owner for the type and name the type. The fun begins after you make your choices and click Finish. The Object Editor, where you can finalize the object type's creation, opens.

The Object Type Editor's tabs are:
- Header: Here you flesh out the specification for the type you’re creating including any methods (a subprogram), attributes, and any parameters or return types for a function.
- Body: For every specification, the object type body defines the code for the method. If the object type header declares only attributes, not a method, the body is unnecessary.
- You need to create the object type before you can see the following tabs. After you’ve added what you need to the Header and Body pages of the Editor, click Create on the toolbar.
- Information: Read-only page that indicates the vital statistics for the object type.
- Dependencies: A tree structure displays the objects that depend on the type you have created.
- Privileges: Displays individual, group, and role permissions associated with the object type.

UNIQUE KEYS WIZARD (ORACLE)
A unique key constraint requires that every value in a column or set of columns be unique. Thus, no two rows of a table have duplicate values in the column or set of columns you identified. So, for example, you can use a unique key constraint to make sure you haven’t duplicated a social security number in a list of employees.
To create a new unique key using a wizard:

1. Open a creation wizard for a unique key. For details, see “Opening an Object Wizard” on page 248.

2. Use the following topics as a guide to setting properties and performing tasks as you pass through the wizard panels:

   - **Properties** panel - for details, see Unique Keys (Oracle) - Properties.
   - **Columns** panel - for details, see Unique Keys (Oracle) - Columns.
   - **Storage** panel - for details, see Unique Keys (Oracle) - Storage.
   - **Partition** panel - for details, see Unique Keys (Oracle) - Partition.
   - **DDL** panel - for details, see “Previewing the DDL Generated to Create the New Object” on page 250.

3. Finally, use the **Execute** button to create the object.

**UNIQUE KEYS (ORACLE) - PROPERTIES**

When creating or editing a unique key, this tab/panel lets you work with the following settings:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Table Owner</strong></td>
<td>Choose the owner and name of the table in which the unique key is being created.</td>
</tr>
<tr>
<td><strong>Table Name</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Name</strong></td>
<td>Provide a name for the unique key being created.</td>
</tr>
<tr>
<td><strong>No Sort</strong></td>
<td>Enable this feature if the rows in the table already stored in ascending order. This increases the speed of the index creation process. Oracle does not sort the rows.</td>
</tr>
<tr>
<td><strong>Logging</strong></td>
<td>Enabling logs this operation to the redo file.</td>
</tr>
<tr>
<td><strong>Reverse</strong></td>
<td>Enabling this feature stores the bytes of the index block in reverse order and excludes the ROWID. The ROWID is a globally unique identifier for a row in a database. It is created at the time the row is inserted into a table, and destroyed when it is removed from a table.</td>
</tr>
<tr>
<td><strong>Validate</strong></td>
<td>Enabling this option indicates that existing data is checked against the constraint when the primary key is enabled. Leaving it disabled indicates that only new data is to be checked against the constraint.</td>
</tr>
<tr>
<td><strong>Deferrable</strong></td>
<td>Dictates whether constraint checking can be deferred until the end of a transaction.</td>
</tr>
<tr>
<td><strong>Deferred</strong></td>
<td>This option is enabled only if you enabled the <strong>Deferrable</strong> option. Select IMMEDIATE to have the constraint checked at the end of every DDL statement. Select DEFERRED to have the constraint checked only at the end of a transaction.</td>
</tr>
<tr>
<td><strong>Enabled</strong></td>
<td>Enables or disables the primary key.</td>
</tr>
</tbody>
</table>

**UNIQUE KEYS (ORACLE) - COLUMNS**

From the **Column** dropdown, select a column for the index and specify a **Sort** option. To add more columns, click the **New** button and then follow the steps in the last instruction. Use the Delete button to drop columns.
**UNIQUE KEYS (ORACLE) - STORAGE**

When creating or editing a primary key, this tab/panel lets you work with the following settings:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Data Block Storage group**| Select the **DEFAULT Tablespace** only if you are creating a local partitioned index and want the partitions in the same tablespace as the partitions in the underlying table. (Each partition of a local index is associated with one partition of the table. Oracle can then keep the index partitions in sync with table partitions.)
|                             | A transaction entry is needed for each INSERT, UPDATE, DELETE, etc. statement that accesses one or more rows in the block. Transaction entries in many operating systems require approximately 23 bytes.                               |
|                             | **Percent Free** identifies how much space you want to allocate for new rows or updates to existing rows.                                                                                            |
|                             | **Initial Transactions** ensures that a minimum number of concurrent transactions can update an index block, avoiding the overhead of allocating a transaction entry dynamically.                   |
|                             | **Maximum Transactions** limits concurrency on an index block.                                                                                                                                            |
|                             | **Data Block Storage** selects the DEFAULT Tablespace only if you are creating a local partitioned index and want the partitions in the same tablespace as the partitions in the underlying table. Each partition of a local index is associated with one partition of the table. Oracle can then keep the index partitions in sync with table partitions. A transaction entry is needed for each INSERT, UPDATE, DELETE, etc. statement that accesses one or more rows in the block. Transaction entries in many operating systems require approximately 23 bytes. **Percent Free** identifies how much space you want to allocate for new rows or updates to existing rows. **Initial Transactions** ensures that a minimum number of concurrent transactions can update an index block, avoiding the overhead of allocating a transaction entry dynamically. **Maximum Transactions** limits concurrency on an index block. |
| **Extents group**           | An extent is the unit of space allocated to an object whenever the object needs more space.                                                                                                                |
|                             | **Initial Extent** - The initial space extent (in bytes) allocated to the object.                                                                                                                        |
|                             | **Next Extent** - The next extent (in bytes) that the object will attempt to allocate when more space for the object is required.                                                                          |
|                             | **Percentage Increase** - Allows you to type the percentage.                                                                                                                                            |
|                             | **NOTE:** You should be careful when setting **Percent Increase** because it magnifies how an object grows and, therefore, can materially affect available free space in a tablespace.                        |
|                             | **Minimum Extents** - For a dictionary managed tablespace, this is the total number of extents to be allocated when the index is first created. For a locally managed tablespace, this is simply the initial amount of space allocated. |
|                             | **Maximum Extents** - For a dictionary managed tablespace, this is the total number of extents that can ever be allocated to the index. In a locally managed tablespace, the database will automatically manage the extents. |
| **Freelists group**         | **Free lists** let you manage the allocation of data blocks when concurrent processes are issued against the index. You can potentially improve the performance of the index by identifying multiple free lists, which can reduce contention for free lists when concurrent inserts take place. |
|                             | The default and minimum value is 1. You should increase this number if multiple processes access the same data block.                                                                                       |
|                             | **Free List Groups** is the number of groups of free lists.                                                                                                                                               |
|                             | **NOTE:** This option is only applicable for the parallel server option.                                                                                                                                  |
| **Buffer Pool**             | **DEFAULT** - Choose this if you want to use the default bufferpool.                                                                                                                                      |
|                             | **KEEP** - Use this to retain the object in memory to avoid I/O conflicts. This type of bufferpool stores frequently referenced data blocks in a separate cache.                                               |
|                             | **RECYCLE** - Select this option to save cache space by ridding data blocks from memory as soon as they are no longer in use.                                                                             |

**UNIQUE KEYS (ORACLE) - PARTITION**

Clicking **Create Partition** opens a wizard that lets you create a partition.
**CREATING OBJECTS**

**USERS WIZARD (ORACLE)**

Whoever you add as a user will have access to the Oracle database. You also can set up the means by which the database recognizes the user.

**Important Notes**

- To create a user, you need the CREATE USER system privilege.

**To create a new user using a wizard:**

1. Open a creation wizard for a user. For details, see "Opening an Object Wizard" on page 248.

2. Use the following topics as a guide to setting properties and performing tasks as you pass through the wizard panels:
   - **Properties** panel - for details, see Users (Oracle) - Properties.
   - **Roles** panel - for details, see Users (Oracle) - Roles.
   - **Quotas** panel - for details, see Users (Oracle) - Quotas.
   - **DDL** panel - for details, see "Previewing the DDL Generated to Create the New Object" on page 250.

3. Finally, use the **Execute** button to create the object.

**USERS (ORACLE) - PROPERTIES**

When creating or editing a user, this tab/panel lets you work with the following settings:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Provide a name for the user.</td>
</tr>
<tr>
<td>Default Tablespace and</td>
<td>Select the default tablespace for objects the user creates and the</td>
</tr>
<tr>
<td>Temporary Tablespace</td>
<td>tablespace to be used for the user's temporary segments.</td>
</tr>
<tr>
<td></td>
<td>If you do not specify a default tablespace when creating a user, the</td>
</tr>
<tr>
<td></td>
<td>assigned tablespace will be that set using the Set Default function. For</td>
</tr>
<tr>
<td></td>
<td>details, see Set Default.</td>
</tr>
<tr>
<td>Profile</td>
<td>The profile you choose affects the amount of database resources available</td>
</tr>
<tr>
<td></td>
<td>to the user.</td>
</tr>
<tr>
<td>Identified By</td>
<td>REQUIRED_YES - A user identified by password is a local user.</td>
</tr>
<tr>
<td></td>
<td>REQUIRED_EXTERNAL - This is a user who is validated by an external service</td>
</tr>
<tr>
<td></td>
<td>like an operating system or third-party service. The login authentication</td>
</tr>
<tr>
<td></td>
<td>is handled by that external entity.</td>
</tr>
<tr>
<td></td>
<td>REQUIRED_GLOBAL - The user you’re creating is a global user who is</td>
</tr>
<tr>
<td></td>
<td>authenticated by the enterprise directory service.</td>
</tr>
<tr>
<td>Password</td>
<td>If you specified an <strong>Identified By</strong> value of REQUIRED_YES, provide a</td>
</tr>
<tr>
<td></td>
<td>password for the user.</td>
</tr>
<tr>
<td>External Name</td>
<td>If you specified an <strong>Identified By</strong> value of REQUIRED_EXTERNAL, provide</td>
</tr>
<tr>
<td></td>
<td>an external name for the user.</td>
</tr>
<tr>
<td>Account Locked</td>
<td>When enabled, the account cannot be altered by anyone but the creator. It</td>
</tr>
<tr>
<td></td>
<td>also means that after a specified number of failed attempts to access the</td>
</tr>
<tr>
<td></td>
<td>database, the database will remain closed to the user for a period of time.</td>
</tr>
</tbody>
</table>
**USERS (ORACLE) - ROLES**

For each role to be assigned to the user, select the check box beside that role.

**USERS (ORACLE) - QUOTAS**

To assign a tablespace quota for a user, select a tablespace, select the **Other** radio button, and provide the value in the **Quota** box.

**VIEWS WIZARD (ORACLE)**

Views are SQL queries stored in the system catalog that customize the display of data contained in one or more tables. Views behave like tables because you can query views and perform data manipulation operations on them. However, views do not actually store any data. Instead, they depend on data contained in their base tables. You can use views to help enforce corporate security policies by creating a view that limits information a user can see.

**Important Notes**

- To create a view in your own schema, you need CREATE VIEW privileges. To create a view in someone else's schema, you need CREATE ANY VIEW privileges.

**To create a new view using a wizard:**

1. Open a creation wizard for a view. For details, see "Opening an Object Wizard" on page 248.

2. Use the following topics as a guide to setting properties and performing tasks as you pass through the wizard panels:
   - **Properties** panel - for details, see Views (Oracle) - Properties.
   - **Definition** panel - for details, see "Previewing the DDL Generated to Create the New Object" on page 250.

3. Finally, use the **Execute** button to create the object.

---

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Password Expired</strong></td>
<td>Marks the password as expired, forcing the user to change the password before being allowed to connect to the database.</td>
</tr>
</tbody>
</table>
When creating or editing a view, this tab/panel lets you work with the following settings:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Owner</td>
<td>Select the owner of the view. The owner of the view must have SELECT privileges for the tables in the CREATE view statement or DBADM authority on the database that contains the table.</td>
</tr>
<tr>
<td>Name</td>
<td>Provide a name for the view.</td>
</tr>
</tbody>
</table>

This is where you build the query that will display the data you’re interested in seeing. The template is `CREATE VIEW <name> AS`.

- **SELECT**: Identify the columns you want to show in the view.
- **FROM**: Identify the table(s) you want to draw the data from.
- **WHERE**: Write the equivalence you want to view.

You can use the Query Builder to help you write the appropriate SQL statement. For details, see "Query Builder" on page 848.

Rapid SQL lets you create Sybase ASE objects using the following wizards:

- Aliases Wizard (Sybase ASE)
- Databases Wizard (Sybase ASE)
- Defaults Wizard (Sybase ASE)
- Extended Procedures Wizard (Sybase ASE)
- Foreign Keys Wizard (Sybase ASE)
- Functions Wizard (Sybase ASE)
- Groups Wizard (Sybase ASE)
- Indexes Wizard (Sybase ASE)
- Logins Wizard (Sybase ASE)
- Primary Keys Wizard (Sybase ASE)
- Procedures Wizard (Sybase ASE)
- Rules Wizard (Sybase ASE)
- Segment Wizard (Sybase ASE)
- Tables Wizard (Sybase ASE)
CREATING OBJECTS

- Triggers Wizard (Sybase ASE)
- Unique Keys Wizard (Sybase ASE)
- User Datatypes Wizard (Sybase ASE)
- Users Wizard (Sybase ASE)
- Views Wizard (Sybase ASE)

ALIASES WIZARD (SYBASE ASE)
The Alias Wizard lets you map a login to an existing user in the database. You can set up aliases so that multiple users log in to the same account and therefore have the same privileges. You can also set up an alias based on individual log ins and give those users access to the same alias with the advantage that you can track their activity within the database.

To create a new alias using a wizard:
1. Open a creation wizard for an alias. For details, see "Opening an Object Wizard" on page 248.
2. Use the following topics as a guide to setting properties and performing tasks as you pass through the wizard panels:
   - Properties panel - for details, see Aliases (Sybase ASE) - Properties.
   - DDL View panel - for details, see "Previewing the DDL Generated to Create the New Object" on page 250.
3. Finally, use the Execute button to create the object.

ALIASES (SYBASE ASE) - PROPERTIES
When creating or editing an alias, this tab/panel lets you work with the following settings:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Provide a name for the alias being created.</td>
</tr>
<tr>
<td>User</td>
<td>Select the user to which the alias refers. The user has to have a valid account on SQL Server but cannot be a user in the current database.</td>
</tr>
</tbody>
</table>

DATABASES WIZARD (SYBASE ASE)
The Database Wizard lets you create a database (a structured collection of data that can be updated or queried) without knowing the underlying commands. Databases can be simple, that is one file with many records and the same fields, or much more complicated with multiple files with different fields.
To create a new database using a wizard:

1. Open a creation wizard for a database. For details, see "Opening an Object Wizard" on page 248.

2. Use the following topics as a guide to setting properties and performing tasks as you pass through the wizard panels:
   - Properties panel - for details, see Databases (Sybase ASE) - Properties.
   - Placement panel - for details, see Databases (Sybase ASE) - Placement.
   - DDL View panel - for details, see "Previewing the DDL Generated to Create the New Object" on page 250.

3. Finally, use the Execute button to create the object.

DATABASES (Sybase ASE) - PROPERTIES

When creating or editing a database, this tab/panel lets you work with the following settings:

<table>
<thead>
<tr>
<th>Category</th>
<th>Setting (and availability)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Creation Properties</td>
<td>Database Name</td>
<td>Provide a name for the database.</td>
</tr>
<tr>
<td></td>
<td>Type</td>
<td>Generate variations on the CREATE DATABASE DDL generated to create the database, as follows:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>DEFAULT - generates a generic CREATE DATABASE statement.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>TEMP - generates a CREATE TEMPORARY DATABASE variation.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>ARCHIVE - generates a CREATE ARCHIVE DATABASE variation.</td>
</tr>
<tr>
<td></td>
<td>In-memory (available with a Type of TEMP or DEFAULT)</td>
<td>Generates CREATE INMEMORY DATABASE DDL, indicating that this is an in-memory database.</td>
</tr>
<tr>
<td></td>
<td>Scratch Database (available with a Type of ARCHIVE)</td>
<td>Lets you provide a WITH SCRATCH_DATABASE parameter value, specifying the name of an existing database that stores information about the archive database.</td>
</tr>
<tr>
<td></td>
<td>For Proxy Update (available with a Type of DEFAULT and not available if For Load is selected)</td>
<td>Adds a FOR PROXY_UPDATE parameter to the generated DDL, forcing resynchronization of proxy tables with the proxy database. For information on how to resynchronize an existing database, see &quot;Resynchronize&quot; on page 681.</td>
</tr>
<tr>
<td></td>
<td>For Load (available with a Type of DEFAULT and not available if For Proxy Update is selected)</td>
<td>This option speeds loading by eliminating the step for pre-initializing panels. The for load option is appropriate when creating a database for recovering from media failure or moving a database from one machine to another.</td>
</tr>
<tr>
<td></td>
<td>With Override (available with a Type of TEMP or DEFAULT)</td>
<td>Enable this option to specify whether logs and data are to be kept on the same logical device.</td>
</tr>
<tr>
<td></td>
<td>With Default Location (available with a Type of DEFAULT)</td>
<td>Lets you add a WITH DEFAULT_LOCATION clause value, specifying a storage location for new tables. If you also select For Proxy Update, one proxy table will be automatically created for each remote table or view.</td>
</tr>
</tbody>
</table>
### DATABASES (SYBASE ASE) - PLACEMENT

In the **Fragment Properties** area provide or select values for the default fragment: **Device Name**, **Size** for the fragment, and a **Device Type** value of DATA ONLY, LOG ONLY, or DATA AND LOG. For databases with a **Properties** tab/panel **Type** selection of ARCHIVE, no LOG ONLY **Device Type** selection is available.

If necessary use the **New** button to add a new fragment and repeat the steps above to provide details for that fragment. Use the **Delete** button to drop a fragment.

### DEFAULTS WIZARD (SYBASE ASE)

Here you create a default for table column or user-defined datatype in the event that no value is available when the data is inserted. The default value you specify will be inserted only in the current database. You can then bind the default to a specific column or user-datatype.

**To create a new default using a wizard:**

1. Open a creation wizard for a default. For details, see "Opening an Object Wizard" on page 248.

2. Use the following topics as a guide to setting properties and performing tasks as you pass through the wizard panels:
   - **Properties** panel - for details, see Defaults (Sybase ASE) - Properties.
   - **Dependencies** panel - for details, see Defaults (Sybase ASE) - Dependencies.
   - **DDL View** panel - for details, see "Previewing the DDL Generated to Create the New Object" on page 250.

3. Finally, use the **Execute** button to create the object.

---

<table>
<thead>
<tr>
<th>Category</th>
<th>Setting (and availability)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Durability</td>
<td>(available with a Type of TEMP or DEFAULT)</td>
<td>Lets you select a WITH DURABILITY= parameter value of NO RECOVERY, FULL, or AT SHUTDOWN, specifying the durability level of the database. With In-memory selected, the only valid selection is NO RECOVERY.</td>
</tr>
<tr>
<td>Options</td>
<td>The GENERATE... DDL is followed by an sp_dboption call for each option selected in this group.</td>
<td></td>
</tr>
<tr>
<td>With a Type of</td>
<td>single user - generates an sp_dboption call specifying the SINGLE USER option, restricting database access to one user at a time.</td>
<td></td>
</tr>
<tr>
<td>TEMP or DEFAULT</td>
<td>In addition to the single user option, the following sp_dboption database options are available: abort tran on log full, allow nulls by default, auto identity, dbo use only, ddl in tran, identity in nonunique index, no chkpt on recovery, no free space acctg, read only, select into/bulkcopy/pllsort, single user, trunc log on chkpt, and unique auto_identity index. For Sybase ASE 15.0 databases, scratch database, async log service option, and delayed commit options are available.</td>
<td></td>
</tr>
</tbody>
</table>

**Category** | **Setting (and availability)** | **Description** |
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Durability</td>
<td>(available with a Type of TEMP or DEFAULT)</td>
<td>Lets you select a WITH DURABILITY= parameter value of NO RECOVERY, FULL, or AT SHUTDOWN, specifying the durability level of the database. With In-memory selected, the only valid selection is NO RECOVERY.</td>
</tr>
<tr>
<td>Options</td>
<td>The GENERATE... DDL is followed by an sp_dboption call for each option selected in this group.</td>
<td></td>
</tr>
<tr>
<td>With a Type of</td>
<td>single user - generates an sp_dboption call specifying the SINGLE USER option, restricting database access to one user at a time.</td>
<td></td>
</tr>
<tr>
<td>TEMP or DEFAULT</td>
<td>In addition to the single user option, the following sp_dboption database options are available: abort tran on log full, allow nulls by default, auto identity, dbo use only, ddl in tran, identity in nonunique index, no chkpt on recovery, no free space acctg, read only, select into/bulkcopy/pllsort, single user, trunc log on chkpt, and unique auto_identity index. For Sybase ASE 15.0 databases, scratch database, async log service option, and delayed commit options are available.</td>
<td></td>
</tr>
</tbody>
</table>
DEFaulTS (SYBASE ASE) - PROPERTIES
When creating or editing a default, this tab/panel lets you work with the following settings:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Owner</td>
<td>Select the schema that is to own the default.</td>
</tr>
<tr>
<td>Name</td>
<td>Provide a name for the default.</td>
</tr>
<tr>
<td>Value</td>
<td>Provide the value of the default.</td>
</tr>
</tbody>
</table>

DEFaulTS (SYBASE ASE) - DEPENDENCIES
From the Type dropdown, choose Column or Datatype, and if you chose Column, choose a Table from the Table dropdown. The list on the left is populated with candidate columns or datatypes. To move a candidate from the list on the left to the dependencies column on the right, select the candidate and click Add. Remove columns or datatypes from the dependencies list on the right by selecting the column or datatype and clicking Remove.

EXTENDED PROCEDURES WIZARD (SYBASE ASE)
Extended stored procedures provide a method for calling external procedural language functions from within the Adaptive Server. A procedural language is a language capable of calling a C language function or manipulating C language datatypes.

To create a new extended procedure using a wizard:
1. Open a creation wizard for an extended procedure. For details, see "Opening an Object Wizard" on page 248.
2. Use the following topics as a guide to setting properties and performing tasks as you pass through the wizard panels:
   • Properties panel - for details, see Extended Procedures (Sybase ASE) - Properties.
   • DDL View panel - for details, see "Previewing the DDL Generated to Create the New Object" on page 250.
3. Finally, use the Execute button to create the object.

EXTENDED PROCEDURES (SYBASE ASE) - PROPERTIES
When creating or editing an extended procedure, this tab/panel lets you work with the following settings:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Owner</td>
<td>Select the owner of the extended procedure.</td>
</tr>
<tr>
<td>Name</td>
<td>Provide the name of the procedure.</td>
</tr>
</tbody>
</table>
FOREIGN KEYS WIZARD (SYBASE ASE)

Foreign keys are used to relate information from one table to another. Foreign keys are unique values that refer to specific columns of other tables. Thus, a foreign key links two tables together. Embarcadero Rapid SQL’s Foreign Key Wizard makes it easy for you to create a relational link between two tables, thereby speeding queries and giving you faster access to data. The column in the initial table, the parent table, is called the primary key. The corresponding column in the (child) table that references the primary key, is the foreign key. Foreign keys can also refer to columns within the same table.

To create a new foreign key using a wizard:

1. Open a creation wizard for a foreign key. For details, see “Opening an Object Wizard” on page 248.

2. Use the following topics as a guide to setting properties and performing tasks as you pass through the wizard panels:
   - **Properties** panel - for details, see Foreign Keys (Sybase ASE) - Properties.
   - **Column Mapping** panel - for details, see Foreign Keys (Sybase ASE) - Column Mapping.
   - **DDL View** panel - for details, see “Previewing the DDL Generated to Create the New Object” on page 250.

3. Finally, use the **Execute** button to create the object.

**FOREIGN KEYS (SYBASE ASE) - PROPERTIES**

When creating or editing a foreign key, this tab/panel lets you work with the following settings:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Library Name</td>
<td>Provide the name of the library containing the procedure.</td>
</tr>
</tbody>
</table>

**FOREIGN KEYS (SYBASE ASE) - COLUMN MAPPING**

Under **Referenced Table**, choose the **Owner** and then the **Name** of the referenced, or parent, table.

Under the **Main Table**, select check boxes corresponding to the columns that are to reference columns in the referenced table. Then, under **Referenced Table**, select the corresponding column check boxes.
The Functions Wizard creates and submits a CREATE FUNCTION command. This lets you create a user-defined function, a saved Transact-SQL routine that returns a specified value. The wizard collects basic identifying information and generates basic CREATE FUNCTION statement syntax, letting you provide the body of the function.

**NOTE:** This functionality is supported for Sybase ASE 12.5.

To create a new function using a wizard:

1. Open a creation wizard for a function. For details, see "Opening an Object Wizard" on page 248.
2. Use the following topics as a guide to setting properties and performing tasks as you pass through the wizard panels:
   - **Properties panel** - for details, see Functions (SQL Server) - Properties.
   - **Definition panel** - for details, see Functions (SQL Server) - Definition.
3. Finally, use the Execute button to create the object.

### Functions (Sybase ASE) - Properties

When creating or editing a function, this tab/panel lets you work with the following settings:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Owner</td>
<td>Select the owner of the function.</td>
</tr>
<tr>
<td>Name</td>
<td>Provide a name for the function.</td>
</tr>
</tbody>
</table>

### Functions (Sybase ASE) - Definition

Complete the CREATE FUNCTION outline provided by typing or pasting the body of the function.

### GROUPS WIZARD (SYBASE ASE)

A group is a collection of privileges that the DBA assigns to designated users.
CREATING OBJECTS

To create a new group using a wizard:
1. Open a creation wizard for a group. For details, see “Opening an Object Wizard” on page 248.
2. Use the following topics as a guide to setting properties and performing tasks as you pass through the wizard panels:
   - **Properties** panel - for details, see Groups (Sybase ASE) - Properties.
   - **Object Permissions** and **System Permissions** panels - see “Setting Permissions or Privileges for an Object” on page 250.
   - **DDL View** panel - for details, see “Previewing the DDL Generated to Create the New Object” on page 250.
3. Finally, use the Execute button to create the object.

After you click Finish and Execute, use the Group Editor to assign users to the new group. For details, see Groups Editor (Sybase ASE).

GROUPS (SYBASE ASE) - PROPERTIES
When creating a group, this panel lets you provide a name for the group.

INDEXES WIZARD (SYBASE ASE)
Like an index in a book, a table index helps you get at the data you want without having to read through the whole table. Indexes can exist on single column or on multiple columns. Indexes appear in the form of B-trees. And, as for books, you can have multiple indexes for a single table.

To create a new index using a wizard:
1. Open a creation wizard for an index. For details, see “Opening an Object Wizard” on page 248.
2. Use the following topics as a guide to setting properties and performing tasks as you pass through the wizard panels:
   - **Properties** panel - for details, see Indexes (Sybase ASE) - Properties.
   - **Columns** panel - for details, see Indexes (Sybase ASE) - Columns.
   - **Partition** panel - for details, see Indexes (Sybase ASE) - Partition.
   - **DDL View** panel - for details, see “Previewing the DDL Generated to Create the New Object” on page 250.
3. Finally, use the Execute button to create the object.
INDEXES (SYBASE ASE) - PROPERTIES
When creating or editing an index, this tab/panel lets you work with the following settings:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table Owner, TableName, and Name</td>
<td>Select or provide identifying information.</td>
</tr>
<tr>
<td>Attributes</td>
<td>Provide or select values for the following Sybase options: Index Type,</td>
</tr>
<tr>
<td></td>
<td>Clustered, Ignore Duplicate Key, Ignore Duplicate Rows, and Maximum</td>
</tr>
<tr>
<td></td>
<td>Rows Per Page properties.</td>
</tr>
<tr>
<td>Storage</td>
<td>Provide or select values for the following Sybase options: Reserve Page</td>
</tr>
<tr>
<td></td>
<td>Gap, Segment Name, Fill Factor, Prefetch Strategy, and MRU Replacement</td>
</tr>
<tr>
<td></td>
<td>Strategy.</td>
</tr>
</tbody>
</table>

INDEXES (SYBASE ASE) - COLUMNS
Select a column from the Columns dropdown and specify a Sort option.

Use the New button to add more columns to the index. Use the Delete button to remove selected columns from the index.

INDEXES (SYBASE ASE) - PARTITION
Click Add to open the Index Partition wizard (Sybase ASE).

INDEX PARTITION WIZARD (SYBASE ASE)
The Sybase ASE Index Partition wizard can be opened from the following editors and wizards:

- Indexes Wizard (Sybase ASE)
- Indexes Editor (Sybase ASE)

Use the following topics as a guide to understanding and setting the options on this wizard:

<table>
<thead>
<tr>
<th>Step</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Properties</td>
<td>Select a Locality.</td>
</tr>
<tr>
<td>Partition Definitions</td>
<td>Click the Define a new partition button to open a dialog that lets you provide a name, select a segment, click the New button to add values, and then Add the partition definition.</td>
</tr>
</tbody>
</table>

When finished, click the Finish button.

LOGINS WIZARD (SYBASE ASE)
The Login wizard lets you build and submit an sp_addlogin call, adding a new login with a basic set of specified database, language, and password properties. An additional sp_locklogin call can be issued to lock the new login. The Login wizard also lets you:
• Grant roles to the login
• Create user accounts on databases for the role, optionally with an alias or by changing ownership

To create a new login using a wizard:

1. Open a creation wizard for a login. For details, see "Opening an Object Wizard" on page 248.

2. Use the following topics as a guide to setting properties and performing tasks as you pass through the wizard panels:
   • Properties panel - for details, see Logins (Sybase ASE) - Properties.
   • Roles panel - for details, see Logins (Sybase ASE) - Roles.
   • Users panel - for details, see Logins (Sybase ASE) - Users.
   • DDL View panel - for details, see "Previewing the DDL Generated to Create the New Object" on page 250.

3. Finally, use the Execute button to create the object.

   NOTE: Rapid SQL also provides support for login triggers, configured for individual logins. For details, "Logins Editor (Sybase ASE)" on page 562.

Logins (Sybase ASE) - Properties

When creating or editing a login, this tab/panel lets you work with the following settings:

<table>
<thead>
<tr>
<th>Group</th>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Creation</td>
<td>Name</td>
<td>The user login name.</td>
</tr>
<tr>
<td></td>
<td>Full Name</td>
<td>The full name of the user, an optional but useful identifier.</td>
</tr>
<tr>
<td>General</td>
<td>Default Database</td>
<td>The database where the user starts each session.</td>
</tr>
<tr>
<td></td>
<td>Default language</td>
<td>The language in which prompts and messages are displayed.</td>
</tr>
<tr>
<td></td>
<td>Locked</td>
<td>If selected, the sp_addlogin call is immediately followed by an</td>
</tr>
<tr>
<td></td>
<td></td>
<td>sp_locklogin call, locking the new login and effectively disabling it.</td>
</tr>
<tr>
<td></td>
<td>NOTE: After creating a login, this group also displays an assigned Login</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>trigger. For details, see &quot;Logins Editor (Sybase ASE)&quot; on page 562.</td>
</tr>
<tr>
<td>Authentication</td>
<td>Password</td>
<td>The initial password for the new user.</td>
</tr>
<tr>
<td></td>
<td>Password expiration</td>
<td>The duration, in days, before the password expires.</td>
</tr>
<tr>
<td></td>
<td>Minimum password</td>
<td>The minimum number of characters a password can contain.</td>
</tr>
<tr>
<td></td>
<td>length</td>
<td>The maximum number of login attempt failures before the login is suspended.</td>
</tr>
<tr>
<td></td>
<td>Authentication</td>
<td>Lets you select ASE, LDAP, PAM, or ANY authentication.</td>
</tr>
<tr>
<td></td>
<td>mechanism</td>
<td></td>
</tr>
</tbody>
</table>
LOGINS (SYBASE ASE) - ROLES
When creating or editing a login, this tab/panel lets you grant roles to the login by selecting the check boxes associated with those roles.

For information on activating and deactivating roles for the current login in the current session, see "Role Activation" on page 681.

LOGINS (SYBASE ASE) - USERS
When creating or editing a login, this tab/panel lets you maintain database user accounts for a login as follows:

- Add a user account for this login to a database by selecting a database from the Databases where the Login does NOT have a User Account and clicking the Add button. This opens the Add User dialog letting you provide additional details. For more information, see Adding a login account to a database.

- Remove a user account for this login from a database by selecting a database from the Databases where the Login HAS a User Account and clicking the Remove button.

ADDING A LOGIN ACCOUNT TO A DATABASE
When adding a user account for a login to a database, the Add user dialog lets you provide details on the method used (sp_adduser, sp_addalias, or sp_changedbowner). Use the following table as a guide to setting options in this dialog:

<table>
<thead>
<tr>
<th>Setting or Group</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>User Type</td>
<td>Lets you select the method by which the user account will be added to the database: USER (sp_adduser), ALIAS (sp_addalias) or DBO (sp_changedbowner).</td>
</tr>
<tr>
<td>Creation</td>
<td>Login Name - displays the user name from the Master database. If you selected a User Type of USER, the following settings are available: User Name - is a new name for the user in the target database. Group Name - lets you select a group in the target database to which the user will be added.</td>
</tr>
<tr>
<td>Alias</td>
<td>LoginUserName - If you selected a User Type of ALIAS, this control lets you select the database user name to alias the login name to.</td>
</tr>
<tr>
<td>dbo</td>
<td>TransferAliasesAndPermissions - If you selected a User Type of DBO, this control lets you transfer aliases and their permissions to the new database owner.</td>
</tr>
</tbody>
</table>

For more information, see Logins Wizard (Sybase ASE) and Logins Editor (Sybase ASE).

PRIMARY KEYS WIZARD (SYBASE ASE)
Primary key constraints make sure that no duplicate values or NULLS are entered in the columns you specify. You can use primary key constraints to enforce uniqueness and referential integrity. A table can only have a single primary key constraint.
To create a new primary key using a wizard:
1. Open a creation wizard for a primary key. For details, see "Opening an Object Wizard" on page 248.
2. Use the following topics as a guide to setting properties and performing tasks as you pass through the wizard panels:
   - **Properties** panel - for details, see Primary Keys (Sybase ASE) - Properties.
   - **Columns** panel - for details, see Primary Keys (Sybase ASE) - Columns.
   - **DDL View** panel - for details, see "Previewing the DDL Generated to Create the New Object" on page 250.
3. Finally, use the **Execute** button to create the object.

**Primary Keys (Sybase ASE) - Properties**
Provide or select the following:
- The **Table Owner** and **Table Name** of the table for which to create the index.
- A **Name** for the Index.
- Whether the index is **Clustered**.
- The **Maximum Rows Per Page**.
- A **Reserve Page Gap**.
- A **Segment Name**.
- A **Fill Factor** value.

**Primary Keys (Sybase ASE) - Columns**
Use the **Column** dropdown to choose a column name and choose a **Sort** option for that column. Use the New button to add an additional column to the index or use the Drop button to delete selected columns.

**Procedures Wizard (Sybase ASE)**
Procedures are a reusable block of PL/SQL, stored in the database, that applications can call. Procedures streamline code development, debugging, and maintenance by being reusable. Procedures enhance database security by letting you write procedures granting users execution privileges to tables rather than letting them access tables directly.
To create a new procedure using a wizard:

1. Open a creation wizard for a procedure. For details, see "Opening an Object Wizard" on page 248.

2. Use the following topics as a guide to setting properties and performing tasks as you pass through the wizard panels:
   - **Properties panel** - for details, see Procedures (Sybase ASE) - Properties.
   - **Definition panel** - for details, see Procedures (Sybase ASE) - Definition.

3. Finally, use the Execute button to create the object.

### Procedures (Sybase ASE) - Properties

When creating or editing a procedure, this tab/panel lets you work with the following settings:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Owner</td>
<td>Select the owner of the procedure.</td>
</tr>
<tr>
<td>Name</td>
<td>Provide the name of the procedure.</td>
</tr>
<tr>
<td>Procedure Number</td>
<td>Provide a procedure number if you want to group identically-named procedures.</td>
</tr>
<tr>
<td>Recompile</td>
<td>Optionally, enable this feature to prevent Sybase ASE from saving a plan for the procedure.</td>
</tr>
</tbody>
</table>

### Procedures (Sybase ASE) - Definition

Complete the provided CREATE PROCEDURE statement by typing or pasting the body of the procedure.

### Rules Wizard (Sybase ASE)

Rules promote data integrity by allowing you to validate the values supplied to a table column. They are reusable objects that you can bind to table columns or user datatypes. Check constraints are similar to rules, and are in fact the preferred way of restricting data. A column or user-defined data type can have only one rule bound to it, but a column can have both a rule and one or more check constraints associated with it. Not that a rule cannot apply to data already existing in the database at the time you’re creating the rule and can’t be bound to a system-created data type. If you create a new rule when one already exists, the new rule will override the previous one.
To create a new rule using a wizard:
1. Open a creation wizard for a rule. For details, see "Opening an Object Wizard" on page 248.
2. Use the following topics as a guide to setting properties and performing tasks as you pass through the wizard panels:
   - **Properties** panel - for details, see Rules (Sybase ASE) - Properties.
   - **Dependencies** panel - for details, see Rules (Sybase ASE) - Dependencies.
   - **DDL View** panel - for details, see "Previewing the DDL Generated to Create the New Object" on page 250.
3. Finally, use the **Execute** button to create the object.

### Rules (Sybase ASE) - Properties
When creating or editing a rule, this tab/panel lets you work with the following settings:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Owner and Name</td>
<td>Select an <strong>Owner</strong> and provide a <strong>Name</strong> for the rule.</td>
</tr>
<tr>
<td>Restriction</td>
<td>Type the condition. The rule restriction is the condition that defines the rule and can be any expression valid in a WHERE clause and can include such elements as arithmetic operators, relational operators, and predicates (for example, IN, LIKE, BETWEEN).</td>
</tr>
<tr>
<td>Type</td>
<td>Choose STANDARD_RULE, AND_ACCESS_RULE, or OR_ACCESS_RULE.</td>
</tr>
</tbody>
</table>

### Rules (Sybase ASE) - Dependencies
From the **Type** dropdown, choose Column or Datatype, and if you chose **Column**, choose a Table from the **Table** dropdown. The list on the left is populated with candidate columns or datatypes. To move a candidate from the list on the left to the dependencies column on the right, select the candidate and click **Add**. Remove columns or datatypes from the dependencies list on the right by selecting the column or datatype and clicking **Remove**.

### Segment Wizard (Sybase ASE)
This wizard lets you build and submit an `sp_addsegment` procedure call, optionally followed by `sp_dbextend 'set', 'database'... and sp_dbextend 'set', 'threshold'... calls. This defines a segment on a database device, and specifies the size by which to grow the database, its maximum size, and a free space level.
To create a new segment using a wizard:

1. Opening an Object Wizard for a segment.

2. Use the following topics as a guide to setting properties and performing tasks as you pass through the wizard panels:
   - **Properties** panel - for details, see Segments (Sybase ASE) - Properties.
   - **Location** panel - for details, see Segments (Sybase ASE) - Location.
   - **DDL View** panel - for details, see Previewing the DDL Generated to Create the New Object.

3. Finally, use the Execute button to create the object. For more information, see Previewing the DDL Generated to Create the New Object.

Rapid SQL opens the Segments Editor, where you can extend the segment and see the objects stored in the segment. For more information, see "Segments Editor (Sybase ASE)" on page 564.

### Segments (Sybase ASE) - Properties

When creating or editing a segment, this tab/panel lets you work with the following settings:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Provide a Name for the segment.</td>
</tr>
<tr>
<td>Grow By</td>
<td>Provide an sp_dbextend 'set', 'database'... growth rate parameter value,</td>
</tr>
<tr>
<td></td>
<td>specifying the rate at which the segment grows each time threshold procedures are run.</td>
</tr>
<tr>
<td>Threshold Free Space</td>
<td>Provide an sp_dbextend 'set', 'threshold'... free space parameter value,</td>
</tr>
<tr>
<td></td>
<td>specifying when the threshold procedure is installed on the segment.</td>
</tr>
<tr>
<td>Max Size</td>
<td>Provide an sp_dbextend 'set', 'database'... maximum segment size parameter</td>
</tr>
<tr>
<td></td>
<td>value.</td>
</tr>
</tbody>
</table>

### Segments (Sybase ASE) - Location

When creating a segment, this tab/panel lets you select the database device for the segment. Select a device from the Available Devices list and click Place to include the device in the Used Devices list.

Similarly, when editing a segment, this tab/panel lets you extend a segment by adding additional devices. Select a device from the Available Devices list and click Extend to include the device in the Used Devices list.
TABLES WIZARD (SYBASE ASE)
A table is a column-based arrangement of data in which the content of one column has a
bearing on the other column(s). So, for example, a table might have a column for authors,
another column for the books each author has written, and a third for the number of copies each
title by a given author has sold. The data moves across the columns in rows.

NOTE: You must have CREATE TABLE permissions to generate a new table.

To create a new table using a wizard:
1. Open a creation wizard for a table. For details, see "Opening an Object Wizard" on
   page 248.
2. Use the following topics as a guide to setting properties and performing tasks as you pass
   through the wizard panels:
   • Properties panel - for details, see Tables (Sybase ASE) - Properties.
   • Columns panel - for details, see Tables (Sybase ASE) - Columns.
   • Indexes panel - for details, see Tables (Sybase ASE) - Indexes.
   • Constraints panel - for details, see Tables (Sybase ASE) - Constraints.
   • Partitions panel - for details, see Tables (Sybase ASE) - Partition.
   • Permissions panel - for details, see Tables (Sybase ASE) - Permissions.
   • DDL View panel - for details, see “Previewing the DDL Generated to Create the New
     Object” on page 250.
3. Finally, use the Execute button to create the object.

TABLES (SYBASE ASE) - PROPERTIES
When creating or editing a table, this tab/panel lets you work with the following settings:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Owner</td>
<td>Select the owner of the table.</td>
</tr>
<tr>
<td>Name</td>
<td>Provide a name for the table</td>
</tr>
<tr>
<td>Segment Name</td>
<td>Specify the segment on which you want to place the table.</td>
</tr>
<tr>
<td>Maximum Rows Per Page</td>
<td>Specifying a number allows you to override the default. The default, 0, creates indexes with full pages and nonclustered indexes with full leaf pages. This number can be changed at any time.</td>
</tr>
<tr>
<td>Reserve Page Gap</td>
<td></td>
</tr>
<tr>
<td>Identity Gap</td>
<td>Specify the size of the identity gap for the table.</td>
</tr>
<tr>
<td>MRU Replacement Strategy</td>
<td>When enabled, new pages are read into the least recent end of the page chain. When pages reach the most recent end of the chain, the pages are flushed.</td>
</tr>
<tr>
<td>Prefetch Strategy</td>
<td>Enabling this feature allows you to fetch as many as eight 2K data pages simultaneously instead of one at a time (the default).</td>
</tr>
<tr>
<td>Lock Scheme</td>
<td>Select a locking scheme of ALLPAGES, DATAPAGES, or DATAROWS.</td>
</tr>
</tbody>
</table>
**TABLES (SYBASE ASE) - COLUMNS**

For each column in the table, click the **Add Column** button to create a column, provide a **Name** for the column and provide or select the remaining column attributes.

Use the **Delete** button to drop a selected column.

Use the arrow buttons to reposition the columns.

**NOTE:** Because the smalldatetime datatype stores dates and time with less precision than the datetime datatype, before outputting you use the CAST or CONVERT functions to convert any boxes with the smalldatetime datatype to either VARCHAR or datetime datatypes.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Expected Row Size</strong></td>
<td>If you specified a <strong>Lock Scheme</strong> of DATAROWS or DATAPAGES, provide an expected row size.</td>
</tr>
</tbody>
</table>

**TABLES (SYBASE ASE) - INDEXES**

Click **Add** to open the Index Wizard. For details, see "**Indexes Wizard (Sybase ASE)**" on page 426.

**TABLES (SYBASE ASE) - CONSTRAINTS**

Selecting a constraint type and clicking **Add** opens the object wizard for that object type. For details see:

- "**Primary Keys Wizard (Sybase ASE)**" on page 429
- "**Unique Keys Wizard (Sybase ASE)**" on page 437
- "**Foreign Keys Wizard (Sybase ASE)**" on page 424
- "**Create Synonym**" on page 609

**TABLES (SYBASE ASE) - PARTITION**

Click **Add** to open the Table Partition Wizard. For details, see "**Table Partition wizard for Sybase ASE**" on page 435.

**TABLES (SYBASE ASE) - PERMISSIONS**

Set up the user permissions for this table.

**TABLE PARTITION WIZARD FOR SYBASE ASE**

See the following topics for information on editors and wizards that let you open the Sybase ASE Table Partition Wizard:

- "**Tables Wizard (Sybase ASE)**" on page 434
CREATING OBJECTS

- "Tables Editor (Sybase ASE)" on page 565

Use the following topics as a guide to understanding and setting the options on this wizard:

<table>
<thead>
<tr>
<th>Step</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Properties</strong></td>
<td>Select a <strong>Partition Type</strong> of ROUNDROBIN, RANGE, HASH, or LIST</td>
</tr>
<tr>
<td><strong>Columns (not available with a Partition Type of ROUNDROBIN)</strong></td>
<td>For each column, click the <strong>Insert a new column</strong> button to create a column, provide a <strong>Name</strong> for the column and provide or select the remaining column attributes. Use the <strong>Delete</strong> button to drop a selected column. Use the arrow buttons to reposition the columns.</td>
</tr>
<tr>
<td><strong>Partition Definition (only available with a Partition Type of HASH or ROUNDROBIN)</strong></td>
<td>Take one of the following actions: (1) Select the <strong>Number Of Partitions</strong> radio box, specify the <strong>Number Of Partitions</strong>, and for each partition, click the <strong>New</strong> button and choose a tablespace from the dropdown, or (2) select the <strong>By Partition Name</strong> radio box and for each partition, click the <strong>New</strong> button provide a name and then choose a tablespace from the dropdown.</td>
</tr>
<tr>
<td><strong>Range Definitions (only available with a Partition Type of RANGE)</strong></td>
<td>Click the <strong>Define a new partition</strong> button to open a dialog that lets you provide a name, select a segment and <strong>Add</strong> the partition definition.</td>
</tr>
<tr>
<td><strong>List Definitions (only available with a Partition Type of LIST)</strong></td>
<td>Click the <strong>Define a new partition</strong> button to open a dialog that lets you provide a name, select a segment, click the <strong>New</strong> button to add values, and then <strong>Add</strong> the partition definition.</td>
</tr>
</tbody>
</table>

When finished, click the **Finish** button.

**TRIGGERS WIZARD (SYBASE ASE)**

The Triggers Wizard lets you build and submit a CREATE TRIGGER command, selecting a parent object type of table or view, and selecting the triggering events for the trigger. Depending on whether you are creating a trigger for a view or a table, the Wizard generates customizable CREATE TRIGGER syntax as follows:

- **Tables** - The wizard generates a FOR INSERT, UPDATE, DELETE trigger code template (all supported Sybase ASE versions)
- **Views** - The wizard generates an INSTEAD OF trigger code template (Sybase ASE 15.0.2)

In both cases, you provide the SQL statements that are to make up the body of the FOR or INSTEAD OF trigger.
To create a new trigger using a wizard:

1. Open a creation wizard for a trigger. For details, see “Opening an Object Wizard” on page 248.

2. Use the following topics as a guide to setting properties and performing tasks as you pass through the wizard panels:
   - Properties panel - for details, see Triggers (Sybase ASE) - Properties.
   - Definition panel - for details, see Triggers (Sybase ASE) - Definition.

3. Finally, use the Execute button to create the object.

**Triggers (Sybase ASE) - Properties**

When creating or editing a trigger, this tab/panel lets you work with the following settings:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Parent Type, Parent Owner, and Parent Name</td>
<td>Provide or select details on the target table or view.</td>
</tr>
<tr>
<td>Owner and Name</td>
<td>Select the owner and provide a name for the trigger being created.</td>
</tr>
</tbody>
</table>
| Fire On Insert, Fire On Update, and Fire On Delete | Enable the events that fire the trigger.  
An INSERT trigger must be associated with an INSERT statement. For example, if a data load operation doesn’t include an INSERT statement, the trigger won’t be invoked.  
An UPDATE trigger can be associated with specific columns of the base table and will only be activated if those columns are updated.  
A DELETE trigger fires automatically after items in the table are deleted. |

**NOTE:** For triggers with a table parent type, the editor lets you enable and disable the trigger, after creation. For details, see “Triggers Editor (Sybase ASE)” on page 568.

**Triggers (Sybase ASE) - Definition**

Complete the CREATE TRIGGER statement by typing or pasting in content.

- See the Microsoft SQL Server Transact-SQL documentation for information on the syntax for Trigger bodies. For more information, see ”Accessing Third Party Documentation” on page 21.

**Unique Keys Wizard (Sybase ASE)**

Unique keys can enforce logical keys that are not chosen as the primary key. In other words, you can use a unique key to ensure no duplicate values are entered in specific columns that are not a part of the primary key. Although you can only attach one primary key to a table, you can attach multiple unique keys. Also, you can use unique keys on columns that allow null values.
To create a new unique key using a wizard:
1. Open a creation wizard for a unique key. For details, see “Opening an Object Wizard” on page 248.
2. Use the following topics as a guide to setting properties and performing tasks as you pass through the wizard panels:
   - Properties panel - for details, see Unique Keys (Sybase ASE) - Properties.
   - Columns panel - for details, see Unique Keys (Sybase ASE) - Columns.
   - DDL View panel - for details, see “Previewing the DDL Generated to Create the New Object” on page 250.
3. Finally, use the Execute button to create the object.

Important Notes
- If you are creating a non-clustered index constraint, you should place it on a separate segment from the target table.

Unique Keys (Sybase ASE) - Properties
Provide or select the following:
- The Table Owner and Table Name of the table for which to create the index.
- A Name for the Index.
- Whether the index is Clustered.
- The Maximum Rows Per Page.
- A Reserve Page Gap.
- A Segment Name.
- A Fill Factor value.

Unique Keys (Sybase ASE) - Columns
Use the Column dropdown to choose a column name and choose a Sort option for that column. Use the New button to add an additional column to the index or use the Drop button to delete selected columns.

User Datatypes Wizard (Sybase ASE)
User datatypes promote domain consistency by streamlining the definition of commonly used table columns in a database. You can build a customized datatype from system datatypes and bind defaults and rules to it to enhance integrity. When you reference the user datatype in a column, the column assumes all of the properties of the user datatype.
To create a new user datatype using a wizard:

1. Open a creation wizard for a user datatype. For details, see "Opening an Object Wizard" on page 248.

2. Use the following topics as a guide to setting properties and performing tasks as you pass through the wizard panels:
   - Properties panel - for details, see User Datatypes (Sybase ASE) - Properties.
   - DDL View panel - for details, see "Previewing the DDL Generated to Create the New Object" on page 250.

3. Finally, use the Execute button to create the object.

User Datatypes (Sybase ASE) - Properties

When creating or editing a user datatype, this tab/panel lets you work with the following settings:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Datatype</td>
<td>Provide a name for the datatype.</td>
</tr>
<tr>
<td>Type</td>
<td>Select the base datatype.</td>
</tr>
<tr>
<td>Size</td>
<td>Provide the size of the datatype.</td>
</tr>
<tr>
<td>Allow Nulls</td>
<td>Null has no explicitly assigned value. Null is not equivalent to zero or blank. A value of null is not considered to be greater than, less than, or equivalent to any other value, including another value of null.</td>
</tr>
<tr>
<td>Identity</td>
<td>This allows you to specify whether or not you want to limit access to the new datatype based on the user's privileges.</td>
</tr>
<tr>
<td>Default Binding</td>
<td>Defaults promote data integrity by supplying a default value to a column if the user does not explicitly provide one. They are reusable objects that you can bind to user datatypes.</td>
</tr>
<tr>
<td>Rule Binding</td>
<td>Rules promote data integrity by allowing you to validate the values supplied to a column. They are reusable objects that you can bind to user datatypes.</td>
</tr>
</tbody>
</table>

User Messages Wizard (Sybase ASE)

A user message lets you write the error message users will see when a user-defined event transpires. The User Message Wizard lets you multiple language versions of a user message, specifying the message numbers, specifying the text for each language version, and binding the message to one or more integrity constraints.
CREATING OBJECTS

To create a new user message using a wizard:

1. Open a creation wizard for a user message. For details, see "Opening an Object Wizard" on page 248.

2. Use the following topics as a guide to setting properties and performing tasks as you pass through the wizard panels:
   - **Properties** panel - for details, see User Messages (Sybase ASE) - Properties.
   - **Information** panel - for details, see User Messages (Sybase ASE) - Information.
   - **Bindings** panel - for details, see User Messages (Sybase ASE) - Bindings.
   - **DDL View** panel - for details, see "Previewing the DDL Generated to Create the New Object" on page 250.

3. Finally, use the **Execute** button to create the object.

**USER MESSAGES (SYBASE ASE) - PROPERTIES**
When creating or editing a user message, this tab/panel lets you provide the message number parameter for the sp_addmessage system procedure calls that will create each language-based version of this user message.

**To specify the message number for this user message**
In the **Message Number** box, type a unique message number (20000 or greater).

**USER MESSAGES (SYBASE ASE) - INFORMATION**
For each language in which the user message is to be available, the User Message Wizard/Editor builds a sp_addmessage system procedure call. This tab/panel manages the language and message text parameters for each sp_addmessage call.

**To add a language version of the user message**
1. Click the **Add new text** for the user message button. The Create User Message Text dialog opens.
2. From the **Language** dropdown, select the language for the message.
3. In the **Message Text** box, type the text of the message.
4. Click **OK**.

**To edit an existing language version of the message**
1. Select the version from the **Language/Message** list.
2. Click the **Modify user message text** button. The Edit User Message Text dialog opens.
3. In the **Message Text** box, replace the text of the message.
4 Click **OK**.

**To delete an existing language version of the message**

1 Select the version from the **Language/Message** list.

2 Click the **Remove user message text** button and verify when prompted.

**USER MESSAGES (SYBASE ASE) - BINDINGS**

When creating or editing a user message, this tab/panel manages one or more sp_bindmsg system procedure calls that will be issued with the sp_addmessage calls that create or edit a user message. This lets you bind the user message to, or unbind the user message from foreign keys or check constraints.

**To bind a user message to an integrity constraint**

1 From the **Constraint Type** dropdown, select the type of integrity constraint (**Check Constraints** or **Foreign Keys**) to which you are binding the user message.

2 Select one or more check constraints or foreign keys from the list on the left and click **Bind**.

**To unbind a user message from a currently bound integrity constraint**

1 Select one or more check constraints or foreign keys from the list on the right and click **Unbind**.

**USERS WIZARD (SYBASE ASE)**

The User Wizard lets you create a user who will then have access to the database where you are registering him or her. You can also identify the appropriate user group and the system privileges you want to assign to the new user.

**To create a new user using a wizard:**

1 Open a creation wizard for a user. For details, see "[Opening an Object Wizard](#)" on page 248.

2 Use the following topics as a guide to setting properties and performing tasks as you pass through the wizard panels:

   - **Properties** panel - for details, see [Users (Sybase ASE) - Properties](#).
   - **DDL View** panel - for details, see [Previewing the DDL Generated to Create the New Object](#).

3 Finally, use the **Execute** button to create the object.

You can use the User Editor to assign System and Object privileges as well as create an alias.
CREATING OBJECTS

**Users (Sybase ASE) - Properties**
When creating or editing a user, this tab/panel lets you work with the following settings:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Login Name</td>
<td>Choose a login ID from the drop-down list.</td>
</tr>
<tr>
<td>Name</td>
<td>Provide the user name.</td>
</tr>
<tr>
<td>Group Name</td>
<td>Specify a group for the user.</td>
</tr>
</tbody>
</table>

**Views Wizard (Sybase ASE)**
Views are SQL queries stored in the system catalog that customize the display of data contained in one or more tables. Views behave like tables because you can query views and perform data manipulation operations on them. However, views do not actually store any data. Instead, they depend on data contained in their base tables. Views can only be

**To create a new view using a wizard:**

1. Open a creation wizard for a view. For details, see "Opening an Object Wizard" on page 248.

2. Use the following topics as a guide to setting properties and performing tasks as you pass through the wizard panels:
   - **Properties** panel - for details, see Views (Sybase ASE) - Properties.
   - **Definition** panel - for details, see Views (Sybase ASE) - Definition.

3. Finally, use the **Execute** button to create the object.

You can use the User Editor to assign System and Object privileges as well as create an alias.

**Views (Sybase ASE) - Properties**
When creating or editing a view, this tab/panel lets you work with the following settings:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Owner</td>
<td>Select the owner of the view.</td>
</tr>
<tr>
<td>Name</td>
<td>Provide a name for the view.</td>
</tr>
<tr>
<td>Check Type</td>
<td>When enabled, when a row is modified through a view, this option makes sure the data remains visible through the view after the modification is committed.</td>
</tr>
</tbody>
</table>

**Views (Sybase ASE) - Definition**
Complete the CREATE VIEW statement by typing or pasting in the relevant query.
MODIFYING OBJECTS USING EDITORS

An Object editor is a tabbed dialog box that stores information about existing server and database types and objects, and lets you modify those items. For an introduction to object editors, see "Overview and common usage of object editors" on page 443.

NOTE: Availability of editors for specific object type varies from DBMS to DBMS. Similarly, functionality offered for an editor for an object type common to two or more DBMS, will differ from DBMS to DBMS.

See the following topics for information the object editors available for each supported platform:

- IBM DB2 for Linux, Unix, and Windows Object Editors
- IBM DB2 for z/OS Object Editors
- InterBase/Firebird Object Editors
- Microsoft SQL Server Object Editors
- MySQL editors
- Oracle Object Editors
- Sybase ASE Object Editors

OVERVIEW AND COMMON USAGE OF OBJECT EDITORS

An Object editor lets you view and modify settings and properties of existing object types and servers on a datasource. It also lets you add new resources and provides access to related, datasource management facilities. For example, the Tables editor lets you add or insert, edit, or drop columns, work with permissions to work with that table, access information on physical storage and the distribution of data and indexes across table spaces, and so on.

Each tab on the Object editor lets you perform a logical task or collection of logical tasks for that object type. The Object editor toolbar has a set of commands common to all object types and also includes a Command menu with commands specific to the object type you are currently working with. For example:
In order to work with object editors, you must be familiar with the following tasks:

- Opening an Object Editor on a server or database object.
- Viewing and Modifying Object Properties using functionality common to all object editors as well as object-specific functionality available to specific object editors.
- Previewing and Submitting Object Editor Changes to effect your changes to the datasource.

**OPENING AN OBJECT EDITOR**
Object editors are accessed from the Datasource Navigator pane of the Rapid SQL main window.

**To open an Object editor on a specific database object**
1. Connect to the datasource that contains the object you want to modify. For more information, see "Datasource Management" on page 131.
2. On the Datasource Navigator, expand the target datasource.
3. Continue to expand folders until objects of the target object type are displayed.
4. Right-click the object to be edited and select Open from the context menu.
Rapid SQL opens an editor for that object type on the object you selected. For information on editing objects, see Viewing and Modifying Object Properties.

VIEWING AND MODIFYING OBJECT PROPERTIES
There are two categories of tasks you can perform using an Object editor:

- Work with Tasks and Settings of Specific Object Types
- Work with Tasks and Settings Common to Object Editors

WORK WITH TASKS AND SETTINGS OF SPECIFIC OBJECT TYPES
Many of the tasks you perform using an Object editor are specific to the object type you are working with. For example, the Triggers editor lets you work directly with SQL code for the trigger while the Tables editor lets you work with columns of the table. Object-specific tasks are documented in the topics for specific Object editors provided later in this chapter.

WORK WITH TASKS AND SETTINGS COMMON TO OBJECT EDITORS
The following tasks can be performed against many of the supported Object editors:
MODIFYING OBJECTS USING EDITORS

- **Using the object editor toolbar**
- **Opening Another Object in the Same Object Editor Explorer**
- **Viewing the SQL/DDL for an Object**
- **Working with Privileges and Permissions**
- **Working with Object Dependencies**
- **Adding a Comment to an object**

**USING THE OBJECT EDITOR TOOLBAR**
The Object editor toolbar appears above the tabs of the Object editor.

![Object Editor Toolbar]

It provides the following functions:

- **Create** - Launches a Rapid SQL object creation wizard. For more information, see "Creating objects" on page 247.

- **Alter** - Enabled when a property of the current database has been modified. Opens a dialog that lets you preview the SQL code that will effect the modification and then submit the change. For more information, see "Preview" on page 576.

- **Drop** - Lets you drop one or more database objects and remove their definition from the system catalog. For more information, see "Drop" on page 620.

- **Extract** - Rapid SQL lets you extract data from one database to another database and extract the statements required to create objects into an Interactive SQL window. For more information, see "Extract" on page 633.

- **Report** - Lets you generate detailed or summary reports on database objects. For details, see "Report" on page 680.

- **Command Menu** - Provides menu commands specific to the object being viewed or modified. For a listing of commands available, see the topic for the specific Object editor, later in this chapter.

- **Refresh** - Refreshes or clears Object editor contents.

- **Close** - Closes the Object editor and if appropriate, prompts you to verify any changes.

Commands on the Object editor toolbar are disabled if they do not apply to the object type being viewed or modified.

**OPENING ANOTHER OBJECT IN THE SAME OBJECT EDITOR EXPLORER**
When an object editor is open, the area between the object editor toolbar and the tabs has one or more dropdown lists. For example:
These lists allow you to qualify any object of the same type as the object currently displayed in the Object editor, and display information for that object in the current Object editor. The number of, and specific dropdown lists, differ according to the type of Object editor but there are always sufficient controls to uniquely identify another object of the same type.

**To display the information for another object of the same type**
- Use the dropdown lists to specify a different object.

**VIEWING THE SQL/DDL FOR AN OBJECT**
The object editors for most object types feature a DDL tab that lets you view an object’s underlying SQL code.

**To view the underlying DDL/SQL for a database object**
1. Open an editor on an object type for which DDL code can be displayed. For details, see "Opening an Object Editor" on page 444.

   See the topics for specific Object editors later in this chapter for information on whether that object type supports display of underlying SQL code.

2. Click the DDL tab.

**WORKING WITH PRIVILEGES AND PERMISSIONS**
When you open an Object editor on an object with associated privileges, the Permissions (or Object Permissions or System Permissions) tab for that editor displays the relevant privileges and lets you make changes accordingly:

For database objects such as tables or procedures, to which permissions or privileges are granted, a Permissions tab lets you manage permissions or privileges to that object from all grantees, such as users or groups, on that datasource. The tab has a navigation area, a command area, and a display area.
The Navigation area lets you change the content of the Display area to view more specific privilege details. For example, when viewing privileges for a database object such as a table, the dropdown lists in the navigation area, if present, let you drill down to populate the display area with privileges for a lower level component, such as a particular column. Similarly, when viewing privileges for a grantee such as a user, the **Object Permissions** tab’s Navigation area lets you populate the display area with that user’s permissions on specific object types, such as tables or procedures.

The Display area shows privilege details for an object or grantee. When viewing privileges for a grantee such as a user or role, the display area shows privileges for that recipient on objects currently qualified by the current selection in the Navigation area. When viewing privileges for an object such as a table, the display area shows the privileges for all grantees. Each cell in the Display area corresponds to a specific permissions and a cell representing a granted permission shows a distinctive icon.

The Command area lets you initiate granting or revocation of permissions.
To view or modify privileges using an Object editor
1. Open an editor on a database object with associated privileges or permissions. For details, see "Opening an Object Editor" on page 444.
2. Click the Permissions (or Privileges or Object Privileges or System Privileges) tab.
3. Use the dropdown lists in the navigation area, if present, to populate the Display area with details for more specific or different permissions.
4. In the Display area, select a cell corresponding to a specific permission.
5. Use the Command area controls to grant or revoke permissions.
6. Submit your changes. For details, see "Previewing and Submitting Object Editor Changes" on page 450.

WORKING WITH OBJECT DEPENDENCIES
For objects such as views and procedures, whose definition references other objects, such as tables, Rapid SQL lets you view all dependencies. The Object editors for referencing or referenced objects have a Dependencies tab that shows all dependencies for an object.

In addition to letting you view dependencies, Object editors let you drop a referencing or referenced object, or open an Object editor on that object.

To manage dependences for an object
1. Open an editor on a database object with referencing or referenced objects. For details, see "Opening an Object Editor" on page 444.
   
   See the object editor descriptions in subsequent topics to verify that an Object editor supports display of dependencies.
2 Click the **Dependencies** tab.

The **Dependency Name** area lists all referenced or referencing objects. Objects are grouped according to their object type.

3 Optionally, select a referenced or referencing object in the right pane and either:
   • Use the **Edit** button to open an Object editor on that object
   • Use the **Drop** button to initiate dropping that object.

**ADDING A COMMENT TO AN OBJECT**

The object editors for certain object types feature a **Comment** tab that lets you add an explanatory note to specific object definitions. Comments are stored in the REMARKS column of the object’s system-catalog.

**To add a comment to an object**

1 Open an editor on an object type that permits comments. For details, see "Opening an Object Editor" on page 444.

2 Click the **Comment** tab.

3 In the **Comment** area, type an explanatory note of up to 254 characters long.

   **NOTE:** Right-clicking in the **Comment** area opens a context menu that lets you perform edit text operations such as search, selection, copying and pasting, as well as coding-specific operations such as enabling/disabling line numbers and indenting lines.

4 Submit your changes. For details, see "Previewing and Submitting Object Editor Changes" on page 450.

**PREVIEWING AND SUBMITTING OBJECT EDITOR CHANGES**

After you use an Object editor to modify the settings or properties of a database object, you can preview the SQL that will be executed to effect those changes on the datasource. You can then submit the SQL for execution on the server.
To preview and submit object editor changes to a database object

1. Click the **Alter** button on the Object editor toolbar. For details, see "Overview and common usage of object editors" on page 443.

   A **Preview: Alter** dialog opens.

2. Use one of the following options to submit and execute your changes:
   - **Execute** button - executes the changes immediately.
   - **Schedule** button - opens a dialog that lets you schedule the change. For more information, see "Scheduling" on page 843.

IBM DB2 FOR LINUX, UNIX, AND WINDOWS OBJECT EDITORS

Rapid SQL includes an Object Editor for all supported IBM DB2 or Linux, Unix, and Windows objects. To see an Editor for a specific object, click the corresponding link below:

- **Aliases Editor (IBM DB2 LUW)**
- **Check Constraints Editor (IBM DB2 LUW)**
- **Databases Editor (IBM DB2 LUW)**
- **Foreign Keys Editor (IBM DB2 LUW)**
- **Functions Editor (IBM DB2 LUW)**
- **Indexes Editor (IBM DB2 LUW)**
- **Materialized Query Tables Editor (IBM DB2 LUW)**
- **Packages Editor (IBM DB2 LUW)**
• Primary Keys Editor (IBM DB2 LUW)
• Procedures Editor (IBM DB2 LUW)
• Sequences Editor (IBM DB2 LUW)
• Structured Types Editor (IBM DB2 LUW)
• Tables Editor (IBM DB2 LUW)
• Tables Spaces Editor (IBM DB2 LUW)
• Trigger Editor (IBM DB2 LUW)
• Unique Keys Editor (IBM DB2 LUW)
• User Datatypes Editor (IBM DB2 LUW)
• Users Editor (IBM DB2 LUW)
• Views Editor (IBM DB2 LUW)

For access to object editors for different supported DBMS platforms and an introduction to editor usage, see "Modifying objects using editors" on page 443.

ALIASES EDITOR (IBM DB2 LUW)
The Aliases Editor lets you view basic alias properties, change the comment associated with an alias, and view the DDL that will be issued to alter the alias definition.

To edit an alias
1. Open an editor on the alias. For details, see “Opening an Object Editor” on page 444.
2. Use the following table as a guide to understanding and modifying the settings on the tabs of this editor:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Properties</td>
<td>In addition to the owning Schema, this tab lets you view the Target Owner, Target Type, and Target Name, of the referenced object.</td>
</tr>
<tr>
<td>Comment</td>
<td>For details on using this tab, see &quot;Adding a Comment to an object&quot; on page 450.</td>
</tr>
<tr>
<td>DDL View</td>
<td>For details on using this tab, see &quot;Viewing the SQL/DDL for an Object&quot; on page 447.</td>
</tr>
</tbody>
</table>

3. When finished, you can submit your changes. For details, see “Previewing and Submitting Object Editor Changes” on page 450.

CHECK CONSTRAINTS EDITOR (IBM DB2 LUW)
The Check Constraints Editor lets you modify and enable/disable check constraints.
To edit a check constraint:
1. Open an editor on the check constraint. For details, see "Opening an Object Editor" on page 444.
2. Use the following table as a guide to understanding and modifying the settings on the tabs of this editor:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Definition</td>
<td>Use the Enabled control to enable/disable the check constraint. You can also edit the condition in the Check Condition box. The Table Column button opens a dialog that lets you select and paste column names into the check condition expression.</td>
</tr>
<tr>
<td>Comment</td>
<td>For details on using this tab, see &quot;Adding a Comment to an object&quot; on page 450.</td>
</tr>
<tr>
<td>DDL View</td>
<td>For details on using this tab, see &quot;Viewing the SQL/DDL for an Object&quot; on page 447.</td>
</tr>
</tbody>
</table>

3. When finished, you can submit your changes. For details, see "Previewing and Submitting Object Editor Changes" on page 450.

DATABASES EDITOR (IBM DB2 LUW)
The Databases Editor lets you manage database tablespace placement details and modify configuration parameters for the database.

To edit a database
1. Open an editor on the database. For details, see "Opening an Object Editor" on page 444.
2. Use the following table as a guide to understanding and modifying the settings on the tabs of this editor:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Placement</td>
<td>Select a tablespace and click the Edit button to open an object editor on that tablespace. For more information, see &quot;Tablespaces Editor (IBM DB2 LUW)&quot; on page 466.</td>
</tr>
<tr>
<td>Options</td>
<td>Lets you modify the DB2 Database Manager configuration file parameters for the database. Select a parameter and click the Edit button to open a dialog that lets you change the current value. <strong>NOTE:</strong> To set database options for all future databases, set the database options on the model database.</td>
</tr>
<tr>
<td>DDL</td>
<td>For details on using this tab, see &quot;Viewing the SQL/DDL for an Object&quot; on page 447.</td>
</tr>
</tbody>
</table>

3. When finished, you can submit your changes. For details, see "Previewing and Submitting Object Editor Changes" on page 450.
FOREIGN KEYS EDITOR (IBM DB2 LUW)
The Foreign Keys Editor lets you manage column mapping for a foreign key, modify update and delete rule actions, and specify a NOT ENFORCED value.

To edit a foreign key
1. Open an editor on the foreign key. For details, see "Opening an Object Editor" on page 444.
2. Use the following table as a guide to understanding and modifying the settings on the tabs of this editor:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Column Mapping</td>
<td>The existing column mapping for the foreign key is represented by selected columns in the Main Table and Referenced Table lists. Additional candidates in the Referenced Table list are indicated by enabled column check boxes. If necessary, use the Table dropdown in the Referenced Table group to choose a new table for this foreign key. Select or deselect columns in the Main Table list and Referenced Table list to form the referential constraint between the two tables.</td>
</tr>
<tr>
<td>Properties</td>
<td>Lets you modify the Delete Rule (NO ACTION, RESTRICT, CASCADE, SET NULL) and Update Rule (NO ACTION, RESTRICT) actions. This tab also lets you deselect the Enforced check box to specify a NOT ENFORCED option.</td>
</tr>
<tr>
<td>Comment</td>
<td>For details on using this tab, see &quot;Adding a Comment to an object&quot; on page 450.</td>
</tr>
<tr>
<td>DDL View</td>
<td>For details on using this tab, see &quot;Viewing the SQL/DDL for an Object&quot; on page 447.</td>
</tr>
</tbody>
</table>

3. When finished, you can submit your changes. For details, see "Previewing and Submitting Object Editor Changes" on page 450.

FUNCTIONS EDITOR (IBM DB2 LUW)
The Functions Editor lets you manage the body, inputs and outputs, and properties for a function.

To edit a function
1. Open an editor on the function. For details, see "Opening an Object Editor" on page 444.
2. Use the following table as a guide to understanding and modifying the settings on the tabs of this editor:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Properties</td>
<td>Displays the Language, Return Type, External Name, SQL Access Level, Origin, Threading, Fenced, Scratchpad, Scratchpad Length, Allow Parallel, Final Call, Parameter Style, Inherit Special Registers, DBInfo, Deterministic, External Action, Called on Null Input, and Parameter CCSID properties.</td>
</tr>
</tbody>
</table>
When finished, you can submit your changes. For details, see "Previewing and Submitting Object Editor Changes" on page 450.

INDEXES EDITOR (IBM DB2 LUW)
The Index Editor lets you manage columns and properties, and view space details for an index.

**NOTE:** IBM DB2 for Windows, Unix, and Linux, lets you segregate *include columns*; columns that are to be part of the index but not part of the unique key.

---

<table>
<thead>
<tr>
<th>Tab</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Parameters</td>
<td>Lets you manage function parameters. On opening, this tab shows the existing parameters. Optionally you can:</td>
</tr>
<tr>
<td></td>
<td>- Select a parameter from the list, modify the <strong>Type</strong> and if appropriate, the <strong>Precision</strong>, <strong>Size</strong>, and <strong>Scale</strong> of the parameter.</td>
</tr>
<tr>
<td></td>
<td>- Click the <strong>New</strong> button, provide a name for the new parameter and modify its attributes.</td>
</tr>
<tr>
<td></td>
<td>- Select a parameter and click the <strong>Drop</strong> button to delete the parameter.</td>
</tr>
<tr>
<td></td>
<td>- Select a parameter and use the arrow buttons to reorder the parameter list.</td>
</tr>
<tr>
<td>Return Scalar</td>
<td>Lets you change the <strong>Type</strong> of a return scalar and depending on the type specified, modify the <strong>Precision</strong>, <strong>Scale</strong>, and <strong>Size</strong> of the return scalar.</td>
</tr>
<tr>
<td>Return Columns</td>
<td>Lets you manage return columns for a function. On opening, this tab shows the existing columns. Optionally you can:</td>
</tr>
<tr>
<td></td>
<td>- Select a column from the list, modify the <strong>Type</strong> and if appropriate, the <strong>Precision</strong>, <strong>Size</strong>, and <strong>Scale</strong> of the parameter.</td>
</tr>
<tr>
<td></td>
<td>- Select a parameter and click the <strong>Drop</strong> button to delete the parameter.</td>
</tr>
<tr>
<td></td>
<td>- Select a parameter and use the arrow buttons to reorder the parameter list.</td>
</tr>
<tr>
<td>Body</td>
<td>Lets you edit the body of the function.</td>
</tr>
<tr>
<td>Comment</td>
<td>For details on using this tab, see &quot;Adding a Comment to an object&quot; on page 450.</td>
</tr>
<tr>
<td>Dependencies</td>
<td>For details on using this tab, see &quot;Working with Object Dependencies&quot; on page 449.</td>
</tr>
<tr>
<td>Permissions</td>
<td>For details on using this tab, see &quot;Working with Privileges and Permissions&quot; on page 447.</td>
</tr>
<tr>
<td>DDL View</td>
<td>For details on using this tab, see &quot;Viewing the SQL/DDL for an Object&quot; on page 447.</td>
</tr>
</tbody>
</table>
To edit an index

1. Open an editor on the index. For details, see "Opening an Object Editor" on page 444.

2. Use the following table as a guide to understanding and modifying the settings on the tabs of this editor:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Columns</strong></td>
<td>Lets you manage columns that make up the index. On opening, this tab shows the</td>
</tr>
<tr>
<td></td>
<td>existing columns. Optionally you can:</td>
</tr>
<tr>
<td></td>
<td>- Change the Sort order of a column.</td>
</tr>
<tr>
<td></td>
<td>- Click the New button and select a column name from the dropdown, to add a</td>
</tr>
<tr>
<td></td>
<td>column to the index.</td>
</tr>
<tr>
<td></td>
<td>- Select a column and click the Drop button to delete the column from the</td>
</tr>
<tr>
<td></td>
<td>index.</td>
</tr>
<tr>
<td></td>
<td>- Select a column and use the arrow buttons to reorder the columns in the</td>
</tr>
<tr>
<td></td>
<td>index.</td>
</tr>
<tr>
<td><strong>Properties</strong></td>
<td>Lets you work with properties in the following categories:</td>
</tr>
<tr>
<td></td>
<td>- <strong>Attributes</strong> Let you view the Defined By property. Let you set the Index</td>
</tr>
<tr>
<td></td>
<td>Type (UNIQUE or NONUNIQUE), specify the index as Clustered, Allow Reverse</td>
</tr>
<tr>
<td></td>
<td>Scans, and Compression.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Storage</strong> Let you set Percent Free and Minimum Percent Used settings.</td>
</tr>
<tr>
<td><strong>Include Columns</strong></td>
<td>Lets you Include columns that are to be part of the index but not part of the</td>
</tr>
<tr>
<td></td>
<td>unique key. On opening, the tab shows a listing of the Include columns currently</td>
</tr>
<tr>
<td></td>
<td>defined as part of this index.</td>
</tr>
<tr>
<td></td>
<td>- Optionally, take one of the following actions:</td>
</tr>
<tr>
<td></td>
<td>- Click the New button to add a new column to the index.</td>
</tr>
<tr>
<td></td>
<td>- Select an existing column and click the Delete button to delete that column.</td>
</tr>
<tr>
<td><strong>Space</strong></td>
<td>Lets you view the following property groups:</td>
</tr>
<tr>
<td></td>
<td>- <strong>Attributes</strong> Make Unique, System Required, Total Keys, Page Fetch Pairs,</td>
</tr>
<tr>
<td></td>
<td>and Distinct Keys</td>
</tr>
<tr>
<td></td>
<td>- <strong>Statistics</strong> Index Level, Cluster Ratio, Cluster Factor, Leaf Pages,</td>
</tr>
<tr>
<td></td>
<td>Sequential Pages, and Density</td>
</tr>
<tr>
<td></td>
<td>- <strong>Cards</strong> First Key, First 2 Keys, First3 Keys, First 4 Keys, and Full Keys</td>
</tr>
<tr>
<td><strong>Comment</strong></td>
<td>For details on using this tab, see &quot;Adding a Comment to an object&quot; on page 450.</td>
</tr>
<tr>
<td><strong>Permissions</strong></td>
<td>For details on using this tab, see &quot;Working with Privileges and Permissions&quot; on</td>
</tr>
<tr>
<td></td>
<td>page 447.</td>
</tr>
<tr>
<td><strong>DDL View</strong></td>
<td>For details on using this tab, see &quot;Viewing the SQL/DDL for an Object&quot; on page</td>
</tr>
<tr>
<td></td>
<td>447.</td>
</tr>
</tbody>
</table>

3. When finished, you can submit your changes. For details, see "Previewing and Submitting Object Editor Changes" on page 450.
MATERIALIZED QUERY TABLES EDITOR (IBM DB2 LUW)

The Materialized Query Tables Editor lets you manage the columns, base query and options for a materialized query table, and work with storage and performance settings.

To edit a materialized query table

1. Open an editor on the materialized query table. For details, see "Opening an Object Editor" on page 444.

2. Use the following table as a guide to understanding and modifying the settings on the tabs of this editor:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Columns</strong></td>
<td>Displays the currently defined columns for the materialized Query Table. Optionally, you can Add, Insert, or Edit columns for the materialized query table.</td>
</tr>
<tr>
<td><strong>Definition</strong></td>
<td><strong>Base Query</strong> Lets you view the query that this materialized query table is based on.</td>
</tr>
<tr>
<td><strong>Materialized Query Table Options</strong></td>
<td>Lets you specify an immediate or deferred Refresh, and explicitly set a Materialized Query Table as Enabled or Disabled or go with the Default. This tab also displays whether the Materialized Query Table is maintained by the system or by a user.</td>
</tr>
<tr>
<td><strong>Performance</strong></td>
<td><strong>Tablespace Placement</strong> Displays Table Tablespace, Index Tablespace, and Long Tablespace settings for the materialized query table.</td>
</tr>
<tr>
<td><strong>Log Options</strong></td>
<td>Lets you select logging options: Logged initially Data Capture - Lets you select none or change to Include Longvar Columns. NOTE: If you select the Data Capture option, the table name / column name cannot be longer than 18 bytes.</td>
</tr>
<tr>
<td><strong>Options</strong></td>
<td>Let you set the Percent Free, Locksize, Append, and Volatile settings for the materialized query table.</td>
</tr>
<tr>
<td><strong>Partition Columns</strong></td>
<td>Use the Add and Delete buttons to manage the partition columns for the materialized query table.</td>
</tr>
<tr>
<td><strong>Space</strong></td>
<td><strong>Page Information</strong> Lets you view Row Count and Num. of Overflow Rows values.</td>
</tr>
<tr>
<td><strong>Row Information</strong></td>
<td>Lets you view Num. of Pages with Rows, Num. of Pages, Percent Free values.</td>
</tr>
<tr>
<td><strong>Comment</strong></td>
<td>For details on using this tab, see &quot;Adding a Comment to an object&quot; on page 450.</td>
</tr>
<tr>
<td><strong>Permissions</strong></td>
<td>For details on using this tab, see &quot;Working with Privileges and Permissions&quot; on page 447.</td>
</tr>
<tr>
<td><strong>Dependencies</strong></td>
<td>For details on using this tab, see &quot;Working with Object Dependencies&quot; on page 449.</td>
</tr>
<tr>
<td><strong>DDL View</strong></td>
<td>For details on using this tab, see &quot;Viewing the SQL/DDL for an Object&quot; on page 447.</td>
</tr>
</tbody>
</table>

3. When finished, you can submit your changes. For details, see "Previewing and Submitting Object Editor Changes" on page 450.
MODIFYING OBJECTS USING EDITORS

PACKAGES EDITOR (IBM DB2 LUW)
The Packages Editor lets you view contents and settings for a package.

To edit a package
1. Open an editor on the package. For details, see "Opening an Object Editor" on page 444.
2. Use the following table as a guide to understanding and modifying the settings on the tabs of this editor:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Definition</td>
<td>Lets you view the following settings: Binder, Definer, Default Schema, Degree, Function Path, Language Level, SQL Math Warn, SQL Warn, Buffered Inset, Status, Code Page, Total Sections, Multi-node Bound, Intra-partition, Query Optimization, Cursor Blocking, Isolation Level, Date Time Format, Last Bind Time, Explicit Bind Time, Explain Level, Explain Snapshot, and Explain Mode.</td>
</tr>
<tr>
<td>Statements</td>
<td>Shows the contents of a package statement. Optionally, you can select a statement and click Explain to copy the statement to an ISQL Editor window. For more information, see &quot;Using the SQL Editor&quot; on page 791.</td>
</tr>
<tr>
<td>Comment</td>
<td>For details on using this tab, see &quot;Adding a Comment to an object&quot; on page 450.</td>
</tr>
<tr>
<td>Dependencies</td>
<td>For details on using this tab, see &quot;Working with Object Dependencies&quot; on page 449.</td>
</tr>
<tr>
<td>DDL View</td>
<td>For details on using this tab, see &quot;Viewing the SQL/DDL for an Object&quot; on page 447.</td>
</tr>
</tbody>
</table>

3. When finished, you can submit your changes. For details, see "Previewing and Submitting Object Editor Changes" on page 450.

PRIMARY KEYS EDITOR (IBM DB2 LUW)
The Primary Keys Editor lets you manage columns and properties for a primary key, and view space usage/allocation details.

To edit a primary key
1. Open an editor on the primary key. For details, see "Opening an Object Editor" on page 444.
2. Use the following table as a guide to understanding and modifying the settings on the tabs of this editor:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Settings and tasks</th>
</tr>
</thead>
</table>
| Columns    | Displays the columns that make up the primary key. Optionally, you can:  
Select a column and use the Delete key to remove the column from the primary key.  
Select a column and use the arrow keys to reorder the columns in the primary key. |
| Properties | Displays the owning Table Schema and Table Name, the Name of the primary key, a Defined By property, and Percent Free and Minimum Percent Used properties. |
MODIFYING OBJECTS USING EDITORS

When finished, you can submit your changes. For details, see "Previewing and Submitting Object Editor Changes" on page 450.

PROCEDURES EDITOR (IBM DB2 LUW)
The Procedures Editor lets you manage the body and parameters for a procedure.

To edit a procedure

1. Open an editor on the procedure. For details, see "Opening an Object Editor" on page 444.
2. Use the following table as a guide to understanding and modifying the settings on the tabs of this editor:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Space</td>
<td>Lets you view the following property groups:</td>
</tr>
<tr>
<td>Attributes</td>
<td>Make Unique, System Required, Total Keys, Page Fetch Pairs, and Distinct Keys</td>
</tr>
<tr>
<td>Statistics</td>
<td>Index Level, Cluster Ratio, Cluster Factor, Leaf Pages, Sequential Pages, and Density</td>
</tr>
<tr>
<td>Cards</td>
<td>First Key, First 2 Keys, First 3 Keys, First 4 Keys, and Full Keys</td>
</tr>
<tr>
<td>Comment</td>
<td>For details on using this tab, see &quot;Adding a Comment to an object&quot; on page 450.</td>
</tr>
<tr>
<td>DDL View</td>
<td>For details on using this tab, see &quot;Viewing the SQL/DDL for an Object&quot; on page 447.</td>
</tr>
</tbody>
</table>

3. When finished, you can submit your changes. For details, see "Previewing and Submitting Object Editor Changes" on page 450.

<table>
<thead>
<tr>
<th>Tab</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Properties</td>
<td>Lets you modify the following settings: SQL Access Level (MODIFIES SQL DATA, CONTAINS SQL, READS SQL DATA, NO SQL), number of Result Sets, External Action, New Save Point, Inherit Special Registers, Deterministic, and Parameter CCSID. Lets you view the following settings: Language (C, COBOL, JAVA, OLE, SQL CLR), External Name, Threadsafe, Fenced, Parameter Type (GENERAL, DB2, GENERAL WITH NULLS, SQL), Program Type (MAIN, SUB and not enabled for a Parameter Style of SQL), and DBInfo.</td>
</tr>
<tr>
<td>Parameters</td>
<td>Lets you manage procedure parameters. On opening, this tab shows the existing parameters. Optionally you can: Select a parameter from the list, modify the Type, and if appropriate, the Precision, Size, and Scale of the parameter. You can also set the Parameter Mode to INPUT, OUTPUT, or INPUT_OUTPUT. Click the New button, provide a name for the new parameter and modify its attributes. Select a parameter and click the Drop button to delete the parameter. Select a parameter and use the arrow buttons to reorder the parameter list. NOTE: You cannot use host variables in the CALL statement for the name of the procedure.</td>
</tr>
<tr>
<td>Comment</td>
<td>For details on using this tab, see &quot;Adding a Comment to an object&quot; on page 450.</td>
</tr>
<tr>
<td>Body</td>
<td>Lets you modify the body of the procedure.</td>
</tr>
<tr>
<td>Dependencies</td>
<td>For details on using this tab, see &quot;Working with Object Dependencies&quot; on page 449.</td>
</tr>
<tr>
<td>Permissions</td>
<td>For details on using this tab, see &quot;Working with Privileges and Permissions&quot; on page 447.</td>
</tr>
</tbody>
</table>
When finished, you can submit your changes. For details, see "Previewing and Submitting Object Editor Changes" on page 450.

SEQUENCES EDITOR (IBM DB2 LUW)

The Sequences Editor lets you manage cycle numbers, increments, the datatype, and other options for a sequence.

To edit a sequence

1. Open an editor on the sequence. For details, see "Opening an Object Editor" on page 444.

2. Use the following table as a guide to understanding and modifying the settings on the tabs of this editor:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>DDL View</td>
<td>For details on using this tab, see &quot;Viewing the SQL/DDL for an Object&quot; on page 447.</td>
</tr>
<tr>
<td>Definition</td>
<td>Lets you work with settings in the following categories:</td>
</tr>
<tr>
<td>Parameters</td>
<td>Increment By - Lets you specify the interval between sequence numbers. This integer value can be any positive or negative integer, but it cannot be 0. This value can have 28 or fewer digits. The absolute of this value must be less than the difference of MAXVALUE and MINVALUE. If this value is negative, then the sequence descends. If the increment is positive, then the sequence ascends. If you omit this clause, the interval defaults to 1. Minimum Value - Lets you specify the minimum value of the sequence. This integer value can have 28 or fewer digits. Maximum Value - Lets you specify the maximum value the sequence can generate. This integer value can have 28 or fewer digits.</td>
</tr>
<tr>
<td>Next Sequence Numbers</td>
<td>Lets you work with sequence cycle numbers.</td>
</tr>
<tr>
<td>Sequence Datatype</td>
<td>Lets you specify the datatype and width for the sequence.</td>
</tr>
<tr>
<td>Options</td>
<td>Lets you specify Cache Size, Cycle When Reach Max/Min, and Generate Numbers in Order (useful when you are using the sequence number as a timestamp) values.</td>
</tr>
<tr>
<td>Dependencies</td>
<td>For details on using this tab, see &quot;Working with Object Dependencies&quot; on page 449.</td>
</tr>
<tr>
<td>DDL View</td>
<td>For details on using this tab, see &quot;Viewing the SQL/DDL for an Object&quot; on page 447.</td>
</tr>
</tbody>
</table>

When finished, you can submit your changes. For details, see "Previewing and Submitting Object Editor Changes" on page 450.
STRUCTURED TYPES EDITOR (IBM DB2 LUW)
The Structured Types Editor lets you manage the attributes, methods and body for a structured type.

To edit a structured type
1. Open an editor on the structured type. For details, see "Opening an Object Editor" on page 444.
2. Use the following table as a guide to understanding and modifying the settings on the tabs of this editor:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Properties</td>
<td>Displays the initially-defined values for the following properties: Instantiable, Final Type,</td>
</tr>
<tr>
<td></td>
<td>With Function Access, Without Comparisons, Inline Length, Supertype Schema,</td>
</tr>
<tr>
<td></td>
<td>Supertype Name, Cast (Source as Ref) With, Cast (Ref as Source) With, Reference Using,</td>
</tr>
<tr>
<td></td>
<td>Size, Precision, and Scale.</td>
</tr>
<tr>
<td></td>
<td>For details on these properties, see &quot;Structured Types Wizard (DB2 LUW)&quot; on page 267.</td>
</tr>
<tr>
<td>Attributes</td>
<td>Displays the currently defined attributes for the structured type. Optionally, take one of the</td>
</tr>
<tr>
<td></td>
<td>following actions:</td>
</tr>
<tr>
<td></td>
<td>Select an attribute and change the Datatype in the Property/Value list. Depending on</td>
</tr>
<tr>
<td></td>
<td>the datatype you choose you can also provide additional datatype options. For details</td>
</tr>
<tr>
<td></td>
<td>on option availability, see &quot;Structured Types Wizard (DB2 LUW)&quot; on page 267.</td>
</tr>
<tr>
<td></td>
<td>Add an attribute by clicking the New button and typing a name for the attribute.</td>
</tr>
<tr>
<td></td>
<td>Select an attribute and click Drop to delete the attribute.</td>
</tr>
</tbody>
</table>
MODIFYING OBJECTS USING EDITORS

<table>
<thead>
<tr>
<th>Tab</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Methods</td>
<td>This tab lets you initiate creation of method specifications and prepopulate associated method bodies. On opening, this tab lists all method specifications associated with the structured type and for each method, includes name and language details. Optionally, take one of the following actions:</td>
</tr>
<tr>
<td></td>
<td>Click <strong>Add</strong> to begin the process of adding a new method specification. Similarly, select a method and click <strong>Edit</strong> to modify the method specification. For more information, see <strong>Adding or editing structured type methods</strong>.</td>
</tr>
<tr>
<td></td>
<td>Select a method specification and click <strong>Drop</strong> to delete that method specification from the structured type.</td>
</tr>
<tr>
<td>Methods</td>
<td>The <strong>Create Body</strong> and associated controls are available for selected methods for which no method body has yet been defined. They let you prepopulate the method body definition:</td>
</tr>
<tr>
<td></td>
<td><strong>External name</strong> - lets you provide a 'string” or SQL identifier for a method specified with a <strong>Language</strong> of C, JAVA, or OLE.</td>
</tr>
<tr>
<td></td>
<td><strong>Transform group</strong> - lets you specify the transform group used when invoking the method. This setting is available for methods specified with a <strong>Language</strong> of C, JAVA, or OLE.</td>
</tr>
<tr>
<td></td>
<td><strong>As identifier</strong> - This setting is available for methods specified with a <strong>Language</strong> of C. When this check box is checked, the method body is created with the external name as provided. Otherwise, the external name provided will appear within quotes in the CREATE METHOD statement on the <strong>Body</strong> tab.</td>
</tr>
<tr>
<td></td>
<td><strong>Inherit isolation level with lock request</strong> - specifies whether the INHERIT clause is specified as INHERIT ISOLATION LEVEL WITHOUT LOCK REQUEST or INHERIT ISOLATION LEVEL WITH LOCK REQUEST. This setting is available for methods specified with a Language of SQL.</td>
</tr>
<tr>
<td></td>
<td>After specifying options, click <strong>Create Body</strong> to work with the CREATE METHOD statement you generated on the editor’s <strong>Body</strong> tab.</td>
</tr>
<tr>
<td>Body</td>
<td>Lets you view and modify the CREATE METHOD statement generated with your choices on the <strong>Methods</strong> tab.</td>
</tr>
<tr>
<td>DDL View</td>
<td>For details on using this tab, see &quot;<strong>Viewing the SQL/DDL for an Object</strong>&quot; on page 447.</td>
</tr>
</tbody>
</table>

3 When finished, you can submit your changes. For details, see "**Previewing and Submitting Object Editor Changes**" on page 450.

ADDITION OR EDITING STRUCTURED TYPE METHODS

The **Add Method** and **Edit Method** wizards let you work with the methods of a structured type. They let you specify basic properties, parameter and return value details for methods.

**To add or edit a structured type method:**

1 Open an editor on a structured type. For details, see "**Opening an Object Editor**" on page 444.

2 Navigate to the **Methods** panel, and then open a wizard using one of the following techniques:

   • Click **Add** to create a new method
   • Select an existing method and click **Edit**.
3 Use the following table as a guide to understanding and modifying the settings on the tabs of this wizard:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Properties</td>
<td>When adding a method this pane lets you specify a Name, Specific Name, Language (OLE, SQL, JAVA, C), and SQL Access Level (CONTAINS SQL, READS SQL DATA, NO SQL). When editing a method, these properties are for display only.</td>
</tr>
<tr>
<td>Advanced (available after clicking the Advanced button on the Properties pane)</td>
<td>Lets you select or enable the following ADD METHOD options: Deterministic, External Action, Called on NULL Input, DBINFO, Fenced, Allow Parallel, Scratchpad, Scratchpad Length, Parameter Style (SQL, DB2GENERAL), and Final Call.</td>
</tr>
<tr>
<td>Parameters</td>
<td>Lets you work with input parameters:</td>
</tr>
<tr>
<td></td>
<td>Add a parameter by clicking the New button and typing a name for the parameter.</td>
</tr>
<tr>
<td></td>
<td>Select a parameter and change the Datatype in the Property/Value list. Depending on the datatype you choose you can also provide Precision, Size, and Scale options.</td>
</tr>
<tr>
<td></td>
<td>Delete a selected parameter by clicking the Delete button.</td>
</tr>
<tr>
<td></td>
<td>Order the parameters using the arrow buttons.</td>
</tr>
<tr>
<td>Return</td>
<td>Lets you provide details of the return value of the method:</td>
</tr>
<tr>
<td>Return Datatype</td>
<td>Lets you specify the base Type of the return value. Depending on the datatype you choose you can also provide Precision, Size, and Scale options.</td>
</tr>
<tr>
<td>Cast Datatype</td>
<td>This group lets you optionally use the CAST FROM form of the ADD METHOD RETURN clause. It lets you have the method return a different datatype, cast from the datatype specified in the Return Datatype group. This feature must be Enabled and provide the same type options as the Return Datatype group.</td>
</tr>
<tr>
<td>An As Locator option specifies that the method return a LOB locator instead of the actual value. The option is only available for LOB and LOB-based datatypes. As Locator applies to a LOB type in the Cast Datatype group, if specified. Otherwise it applies to a LOB type in the Return Datatype group</td>
<td></td>
</tr>
</tbody>
</table>

4 When ready click Finish.

**TABLES EDITOR (IBM DB2 LUW)**

The Tables Editor lets you manage basic properties, columns, dimension columns, distribution key columns, partitions, tablespaces, and constraints for a table.

**TIP:** Before modifying a table, familiarize yourself with the material in Altering Tables for IBM DB2 LUW for Linux, Unix, and Windows.
To edit a table

1. Open an editor on the table. For details, see "Opening an Object Editor" on page 444.

2. Use the following table as a guide to understanding and modifying the settings on the tabs of this editor:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Columns</td>
<td>Displays the currently defined columns in the table. Optionally, you can:</td>
</tr>
<tr>
<td></td>
<td>- Select a column, and in the <strong>Property/Value</strong> list modify property values for that column.</td>
</tr>
<tr>
<td></td>
<td>- Click <strong>Add Column</strong>, provide a name for the new column, and set property values for the column.</td>
</tr>
<tr>
<td></td>
<td>- Select a column and click <strong>Delete</strong> to remove the column from the table.</td>
</tr>
<tr>
<td>Status</td>
<td>Lets you view the following statistics: <strong>Total Number of Rows</strong>, <strong>Number of Overflow Rows</strong>, <strong>Number of Pages With Rows</strong>, <strong>Number of Pages</strong>, <strong>Table Status</strong>, <strong>Row Organization</strong>, <strong>RowTypeSchema</strong>, <strong>RowTypeName</strong>, <strong>AccessMode</strong>, <strong>ActiveBlocks</strong>, <strong>AvgCompressedRowSize</strong>, <strong>AvgRowCompressionRatio</strong>, <strong>CodePage</strong>, <strong>PercentOfPagesSaved</strong>, <strong>LastRegeneratedTime</strong>, and <strong>ProtectionGranularity</strong>.</td>
</tr>
<tr>
<td>Partition</td>
<td>This tab provides details on the partition columns and data partitions for the table. Optionally you can:</td>
</tr>
<tr>
<td></td>
<td>- Use the New or Delete buttons to create or drop a partition column or data partition.</td>
</tr>
<tr>
<td></td>
<td>- Use the Edit button to edit a data partition.</td>
</tr>
<tr>
<td></td>
<td>- Use the <strong>Commands</strong> menu to attach or detach a data partition.</td>
</tr>
<tr>
<td>Tablespace</td>
<td>Lets you view the <strong>Database partition Group</strong>, <strong>Managed By</strong>, <strong>Page Size</strong>, and <strong>Extent Size</strong> properties. Lets you choose the <strong>Name</strong> of a tablespace.</td>
</tr>
<tr>
<td>Dimensions</td>
<td>Lets you group columns to form a dimension:</td>
</tr>
<tr>
<td></td>
<td>- Click the <strong>New</strong> button to add a new column to the dimension for the table.</td>
</tr>
<tr>
<td></td>
<td>- Select a column and click the <strong>Edit</strong> button to modify the dimension column properties.</td>
</tr>
<tr>
<td></td>
<td>- Select a column and click the <strong>Delete</strong> button to drop a column from the dimension.</td>
</tr>
<tr>
<td>Distribution Key</td>
<td>Lets you group one or more columns to form a distribution key:</td>
</tr>
<tr>
<td>Columns</td>
<td>- Click the <strong>New</strong> button to add a new column to the dimension for the table.</td>
</tr>
<tr>
<td></td>
<td>- Select a column and click the <strong>Edit</strong> button to modify the dimension column properties.</td>
</tr>
<tr>
<td></td>
<td>- Select a column and click the <strong>Delete</strong> button to drop a column from the dimension.</td>
</tr>
<tr>
<td>Indexes</td>
<td>Lets you manage indexes for a table:</td>
</tr>
<tr>
<td></td>
<td>- Click <strong>Add</strong> to open a dialog that lets you add a new index to the table.</td>
</tr>
<tr>
<td></td>
<td>- Select an index and click <strong>Edit</strong> to open a dialog that lets you edit index properties.</td>
</tr>
<tr>
<td></td>
<td>- Select an index and click <strong>Drop</strong> to open a dialog that lets you remove the index from the table.</td>
</tr>
</tbody>
</table>
3 When finished, you can submit your changes. For details, see "Previewing and Submitting Object Editor Changes" on page 450.

ALTERING TABLES FOR IBM DB2 LUW FOR LINUX, UNIX, AND WINDOWS

The ALTER TABLE command of Transact-SQL is limited to adding NULL columns to the end of a table and to adding or dropping constraints. Unfortunately, this scenario does not address many requirements of administrators and developers who need to add, delete or modify columns more broadly:

- Add columns anywhere in a table, not just the end
- Add columns that do not permit a NULL value.
- Change the NULL/NOT NULL status of table columns
- Change column datatypes to other compatible types
- Change the length of datatypes
- Delete a column

Due to the limitations of the ALTER TABLE command, the only way to make broader modifications is to write SQL scripts that step through all desired changes. To perform an enhanced table alter, Rapid SQL constructs an SQL script that completes the following steps:

1. Renames the existing table so that the original and its data remain intact
2. Builds a CREATE TABLE statement with the new table definition, including declared defaults, primary key and check constraints
3. Builds an INSERT statement to copy data from the original, renamed table to the new one
4. Builds foreign keys on the new table
5. Reapplies any privileges granted on the table
6 Rebuilds all dependencies on the new table, including indexes, triggers, procedures, packages, functions and views. When rebuilding procedures, functions, packages and views, Rapid SQL also rebuilds any permissions on them.

**TABLESPACES EDITOR (IBM DB2 LUW)**

The Tablespaces Editor lets you manage containers, basic properties, performance, space usage, and associated objects for a tablespace.

**To edit a tablespace**

1. Open an editor on the tablespace. For details, see "Opening an Object Editor" on page 444.

2. Use the following table as a guide to understanding and modifying the settings on the tabs of this editor:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Properties</strong></td>
<td>Lets you work with settings in the following categories:</td>
</tr>
<tr>
<td><strong>Tablespace</strong></td>
<td>Lets you view the <strong>Type</strong> (REGULAR, LARGE, TEMPORARY, or USER TEMPORARY), <strong>Use Automatic Storage</strong>, <strong>Managed By</strong>, and <strong>Database Partition Group</strong> properties. Lets you modify the <strong>Buffer Pool</strong> and <strong>Drop Recovery</strong> properties.</td>
</tr>
<tr>
<td><strong>Performance</strong></td>
<td>Lets you view the <strong>Page Size</strong> and <strong>Extent Size</strong> properties.</td>
</tr>
<tr>
<td></td>
<td>Lets you specify or select the <strong>Prefetch Automatic</strong>, <strong>Overhead</strong>, <strong>Transfer Rate</strong>, and <strong>File System Caching</strong> properties.</td>
</tr>
<tr>
<td><strong>Automatic Storage</strong></td>
<td>Lets you work with the <strong>AutoResize</strong> (enables following size settings), <strong>Initial Size</strong>, <strong>Increase Size</strong>, <strong>Max Size Unlimited</strong>, and <strong>Max Size</strong> (enabled if <strong>Max Size Unlimited</strong> is not set) attributes. The <strong>Initial Size</strong> and <strong>Max Size</strong> values can be provided as kB, mB, or gB values.</td>
</tr>
<tr>
<td><strong>Container</strong></td>
<td>This option is only available for database managed tablespaces. This tab lets you add or delete containers of a tablespace.</td>
</tr>
<tr>
<td></td>
<td>Select an existing container and in the Property/Value list, use the <strong>Size</strong> controls to <strong>RESIZE</strong>, <strong>EXTEND</strong>, or <strong>REDUCE</strong> the container.</td>
</tr>
<tr>
<td></td>
<td>Add a container by clicking <strong>New</strong>, and then in the Property/Value list, provide <strong>Name</strong>, number of <strong>Database Partitions</strong>, <strong>Type</strong> (DEVICE, FILE) and original <strong>Size</strong>.</td>
</tr>
<tr>
<td></td>
<td>Click <strong>Delete</strong> to remove a container.</td>
</tr>
<tr>
<td><strong>Performance</strong></td>
<td>Lets you manage settings in the following categories:</td>
</tr>
<tr>
<td><strong>Page Setting</strong></td>
<td>Lets you view <strong>Page Size</strong> and <strong>Extent Size</strong> settings and modify the <strong>Prefetch Size</strong> setting.</td>
</tr>
<tr>
<td><strong>I/O Setting</strong></td>
<td>Let you modify the <strong>Overhead</strong> and <strong>Transfer Rate</strong> settings.</td>
</tr>
<tr>
<td><strong>Dropped Table Settings</strong></td>
<td>Lets you view the <strong>Recovery Status</strong>.</td>
</tr>
<tr>
<td><strong>Defaults</strong></td>
<td>Lets you view the <strong>Nodegroup</strong> and specify a <strong>Bufferpool</strong>.</td>
</tr>
<tr>
<td><strong>Comment</strong></td>
<td>For details on using this tab, see <em>Adding a Comment to an object</em> on page 450.</td>
</tr>
</tbody>
</table>
MODIFYING OBJECTS USING EDITORS

<table>
<thead>
<tr>
<th>Tab</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Space</td>
<td>Lets you view the table usage and the distribution of space for a tablespace. Specific statistics include <strong>Free Pages, Used Pages, Reserved Pages, and Total Pages</strong>.</td>
</tr>
<tr>
<td>Objects</td>
<td>Lets you manage database objects associated with the tablespace. Objects are organized in a tree structure with folders containing the objects. Optionally, take one of the following actions: Select an object and click <strong>Edit</strong> to open an object editor on the selected object. Select an object and click <strong>Drop</strong> to initiate dropping the selected object.</td>
</tr>
<tr>
<td>Privileges</td>
<td>For details on using this tab, see &quot;Working with Privileges and Permissions&quot; on page 447.</td>
</tr>
<tr>
<td>DDL View</td>
<td>For details on using this tab, see &quot;Viewing the SQL/DDL for an Object&quot; on page 447.</td>
</tr>
</tbody>
</table>

3. When finished, you can submit your changes. For details, see "Previewing and Submitting Object Editor Changes" on page 450.

**TRIGGERS EDITOR (IBM DB2 LUW)**
The Triggers Editor lets you view properties for a trigger.

**To edit a trigger**

1. Open an editor on the trigger. For details, see "Opening an Object Editor" on page 444.

2. Use the following table as a guide to understanding and modifying the settings on the tabs of this editor:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Properties</td>
<td>Lets you view the <strong>Trigger Timing</strong>, <strong>Trigger Events</strong>, <strong>Trigger Type</strong>, <strong>Object Status</strong>, <strong>Definer</strong>, and <strong>Function Path</strong> properties.</td>
</tr>
<tr>
<td>Comment</td>
<td>For details on using this tab, see &quot;Adding a Comment to an object&quot; on page 450.</td>
</tr>
<tr>
<td>Dependencies</td>
<td>For details on using this tab, see &quot;Working with Object Dependencies&quot; on page 449.</td>
</tr>
<tr>
<td>Definition</td>
<td>Lets you view and modify the CREATE TRIGGER DDL that will implement your changes. To modify a trigger, Rapid SQL must drop then create the trigger.</td>
</tr>
</tbody>
</table>

3. When finished, you can submit your changes. For details, see "Previewing and Submitting Object Editor Changes" on page 450.

**UNIQUE KEYS EDITOR (IBM DB2 LUW)**
The Unique Keys Editor lets you manage columns and basic properties for a unique key, as well as view space details.
MODIFYING OBJECTS USING EDITORS

To edit a unique key
1. Open an editor on the unique key. For details, see "Opening an Object Editor" on page 444.
2. Use the following table as a guide to understanding and modifying the settings on the tabs of this editor:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Columns</td>
<td>Lets you manage columns that make up the unique key. On opening, this tab shows the existing columns. For each column, the datatype (and if applicable the precision in brackets) and whether the table definition permits nulls in the target table column. Optionally you can:</td>
</tr>
<tr>
<td></td>
<td>Click the New button and select a column name from the dropdown, to add a column to the index.</td>
</tr>
<tr>
<td></td>
<td>Select a column and click the Drop button to delete the column from the index.</td>
</tr>
<tr>
<td>Properties</td>
<td>Displays the owning Table Schema and Table Name, the Name of the primary key, a Defined By property, and Percent Free and Minimum Percent Used properties.</td>
</tr>
<tr>
<td>Space</td>
<td>Lets you view settings in the following categories:</td>
</tr>
<tr>
<td>Attributes</td>
<td>Lets you view Make Unique, System Required, Total Keys, Distinct Keys, and Page Fetch Pairs settings.</td>
</tr>
<tr>
<td>Statistics</td>
<td>Lets you view Index Level, Cluster Ration, Cluster Factor, Leaf Pages, Sequential Pages, and Density settings.</td>
</tr>
<tr>
<td>Cards</td>
<td>Lets you view First Key, First 2 Keys, First 3 Keys, First 4 Keys and Full Keys settings.</td>
</tr>
<tr>
<td>Comment</td>
<td>For details on using this tab, see &quot;Adding a Comment to an object&quot; on page 450.</td>
</tr>
<tr>
<td>DDL View</td>
<td>For details on using this tab, see &quot;Viewing the SQL/DDL for an Object&quot; on page 447.</td>
</tr>
</tbody>
</table>

3. When finished, you can submit your changes. For details, see "Previewing and Submitting Object Editor Changes" on page 450.

USER DATATYPES EDITOR (IBM DB2 LUW)
The User Datatypes Editor lets you manage the basic properties of a user datatype.

To edit a user datatype
1. Open an editor on the user datatype. For details, see "Opening an Object Editor" on page 444.
2. Use the following table as a guide to understanding and modifying the settings on the tabs of this editor:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Properties</td>
<td>Displays the user Datatype name. Lets you select a new Owner or Type, and depending on the type specified, offers additional type-specific properties such as Size. Also lets you modify the Allow Bit Data property, if appropriate.</td>
</tr>
</tbody>
</table>
To edit a user

1. Open an editor on the user. For details, see "Opening an Object Editor" on page 444.

2. Use the following table as a guide to understanding and modifying the settings on the tabs of this editor:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Properties</strong></td>
<td>Displays the user <strong>Name</strong>.</td>
</tr>
<tr>
<td><strong>Objects</strong></td>
<td>Lets you manage database objects associated with the user. Objects are organized in a tree structure with folders containing the objects. Optionally, take one of the following actions:</td>
</tr>
<tr>
<td></td>
<td>Select an object and click <strong>Edit</strong> to open an object editor on the selected object.</td>
</tr>
<tr>
<td></td>
<td>Select an object and click <strong>Drop</strong> to initiate dropping the selected object.</td>
</tr>
<tr>
<td><strong>Object Permissions</strong></td>
<td>For details on using these tabs, see &quot;Working with Privileges and Permissions&quot; on page 447.</td>
</tr>
<tr>
<td><strong>System Permissions</strong></td>
<td>For details on using these tabs, see &quot;Working with Privileges and Permissions&quot; on page 447.</td>
</tr>
<tr>
<td><strong>DDL View</strong></td>
<td>For details on using this tab, see &quot;Viewing the SQL/DDL for an Object&quot; on page 447.</td>
</tr>
</tbody>
</table>

3. When finished, you can submit your changes. For details, see "Previewing and Submitting Object Editor Changes" on page 450.

**VIEWS EDITOR (IBM DB2 LUW)**

The Views Editor lets you manage the columns as well as view and modify properties for a view.
To edit a view
1. Open an editor on the view. For details, see "Opening an Object Editor" on page 444.
2. Use the following table as a guide to understanding and modifying the settings on the tabs of this editor:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Properties</td>
<td>Displays all columns for the view. Details for each column include the <strong>Column Name</strong>, the <strong>Datatype</strong> (and if applicable, with the precision in parentheses), and whether or not <strong>Nulls</strong> are allowed for that column.  You can also set the <strong>EnableQueryOptimization</strong> property for the view.</td>
</tr>
<tr>
<td>Definition</td>
<td>Lets you view and modify the CREATE VIEW DDL that will implement any changes you make in this editor. To modify a view, Rapid SQL must drop then create the view.</td>
</tr>
<tr>
<td>Comment</td>
<td>For details on using this tab, see &quot;Adding a Comment to an object&quot; on page 450.</td>
</tr>
<tr>
<td>Dependencies</td>
<td>For details on using this tab, see &quot;Working with Object Dependencies&quot; on page 449.</td>
</tr>
<tr>
<td>Permissions</td>
<td>For details on using this tab, see &quot;Working with Privileges and Permissions&quot; on page 447.</td>
</tr>
</tbody>
</table>

3. When finished, you can submit your changes. For details, see "Previewing and Submitting Object Editor Changes" on page 450.

**IBM DB2 FOR Z/OS OBJECT EDITORS**
Rapid SQL includes an Object Editor for all supported IBM DB2 for z/OS objects:

- **Aliases Editor (IBM DB2 Z/OS)**
- **Check Constraints Editor (IBM DB2 Z/OS)**
- **Databases Editor (IBM DB2 Z/OS)**
- **Foreign Keys Editor (IBM DB2 Z/OS)**
- **Functions Editor (IBM DB2 Z/OS)**
- **Indexes Editor (IBM DB2 Z/OS)**
- **Packages Editor (IBM DB2 Z/OS)**
- **Plans Editor (IBM DB2 Z/OS)**
- **Primary Keys Editor (IBM DB2 Z/OS)**
- **Procedures Editor (IBM DB2 Z/OS)**
- **Stogroups Editor (IBM DB2 Z/OS)**
- **Synonyms Editor (IBM DB2 Z/OS)**
- **Tables Editor (IBM DB2 Z/OS)**
- **Tablespaces Editor (IBM DB2 Z/OS)**
• Triggers Editor (IBM DB2 Z/OS)
• Unique Keys Editor (IBM DB2 Z/OS)
• User Datatypes Editor (IBM DB2 Z/OS)
• Users Editor (IBM DB2 Z/OS)
• Views Editor (IBM DB2 Z/OS)

For access to object editors for different supported DBMS platforms and an introduction to editor usage, see "Modifying objects using editors" on page 443.

ALIASES EDITOR (IBM DB2 Z/OS)
The Aliases Editor lets you view details of an alias definition.

To edit an alias
1. Open an editor on the alias. For details, see "Opening an Object Editor" on page 444.
2. Use the following table as a guide to understanding and modifying the settings on the tabs of this editor:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Properties</td>
<td>In addition to the owning Schema and Name of the alias, this tab lets you view the Target Owner, Target Type, and Target Name, of the referenced object.</td>
</tr>
<tr>
<td>Comment</td>
<td>For details on using this tab, see &quot;Adding a Comment to an object&quot; on page 450.</td>
</tr>
<tr>
<td>DDL View</td>
<td>For details on using this tab, see &quot;Viewing the SQL/DDL for an Object&quot; on page 447.</td>
</tr>
</tbody>
</table>

3. When finished, you can submit your changes. For details, see "Previewing and Submitting Object Editor Changes" on page 450.

CHECK CONSTRAINTS EDITOR (IBM DB2 Z/OS)
The Check Constraints Editor lets you view definition details and edit a check condition expression.
**MODIFYING OBJECTS USING EDITORS**

**To edit a check constraint**

1. Open an editor on the check constraint. For details, see "Opening an Object Editor" on page 444.

2. Use the following table as a guide to understanding and modifying the settings on the tabs of this editor:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Definition</strong></td>
<td>Lets you view basic identification information on the check constraint: Table Schema and Table Name, the Name of the constraint and the date it was Created. You can also edit the condition in the Check Condition box. The Table Columns button acts a time saver in editing the condition. It opens a dialog that lets you select and paste column names into the check condition expression.</td>
</tr>
<tr>
<td><strong>DDL View</strong></td>
<td>For details on using this tab, see &quot;Viewing the SQL/DDL for an Object&quot; on page 447.</td>
</tr>
</tbody>
</table>

3. When finished, you can submit your changes. For details, see "Previewing and Submitting Object Editor Changes" on page 450.

**DATABASES EDITOR (IBM DB2 Z/OS)**

The Databases Editor lets you manage basic properties, permissions, and object dependencies for a database.

**To edit a database**

1. Open an editor on the database. For details, see "Opening an Object Editor" on page 444.

2. Use the following table as a guide to understanding and modifying the settings on the tabs of this editor:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Properties</strong></td>
<td>The Database Creation group lets you view the Name and Group Member properties and set the Type property. The Database Attributes group lets you view the Encoding Scheme, Create Date, and Last Altered properties and lets you set the Tablespace Buffer Pool, Index Buffer Pool, Storage Group, and CCSID properties.</td>
</tr>
<tr>
<td><strong>Permissions</strong></td>
<td>For details on using this tab, see &quot;Working with Privileges and Permissions&quot; on page 447.</td>
</tr>
<tr>
<td><strong>Dependencies</strong></td>
<td>For details on using this tab, see &quot;Working with Object Dependencies&quot; on page 449.</td>
</tr>
<tr>
<td><strong>DDL View</strong></td>
<td>For details on using this tab, see &quot;Viewing the SQL/DDL for an Object&quot; on page 447.</td>
</tr>
</tbody>
</table>

3. When finished, you can submit your changes. For details, see "Previewing and Submitting Object Editor Changes" on page 450.

**FOREIGN KEYS EDITOR (IBM DB2 Z/OS)**

The Foreign Keys Editor lets you manage column mapping and specify a delete rule for a foreign key.
To edit a foreign key

1. Open an editor on the foreign key. For details, see "Opening an Object Editor" on page 444.

2. Use the following table as a guide to understanding and modifying the settings on the tabs of this editor:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Column Mapping</td>
<td>The existing column mapping for the foreign key is represented by selected columns in the Main Table and Referenced Table lists. Additional candidates in the Referenced Table list are indicated by enabled column check boxes. If necessary, use the Table dropdown in the Referenced Table group to choose a new table for this foreign key. Select or deselect columns in the Main Table list and Referenced Table list to form the referential constraint between the two tables.</td>
</tr>
<tr>
<td>Properties</td>
<td>Lets you specify a Delete Rule (CASCADE, NO ACTION, RESTRICT, SET NULL).</td>
</tr>
<tr>
<td>DDL View</td>
<td>For details on using this tab, see &quot;Viewing the SQL/DDL for an Object&quot; on page 447.</td>
</tr>
</tbody>
</table>

3. When finished, you can submit your changes. For details, see "Previewing and Submitting Object Editor Changes" on page 450.

FUNCTIONS EDITOR (IBM DB2 Z/OS)

The Functions Editor lets you view and modify properties for a function, manage its inputs and outputs, and modify the code in the body of the function.
To edit a function

1. Open an editor on the function. For details, see "Opening an Object Editor" on page 444.
2. Use the following table as a guide to understanding and modifying the settings on the tabs of this editor:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Properties</td>
<td>Lets you work with properties in the following categories:</td>
</tr>
<tr>
<td>Identification</td>
<td>Lets you view the Create Timestamp, Schema, Routine ID, and Origin properties. Lets you set the External Name and Collection ID properties.</td>
</tr>
<tr>
<td>Run Time</td>
<td>Lets you view the Result Sets property. Lets you set the WLM Environment, WLM For Nested, ASU Time, and Run Options properties.</td>
</tr>
<tr>
<td>Structure</td>
<td>Lets you view the Language, Parameter Style, Number of LOB Columns, Number of Parameters, and Allow Parallel properties. Lets you set the Program Type, Security Type, SQL Access Level, Inherit Special Registers, Fenced, DBINFO, Deterministic, Called On Null Input, External Action, Stay Resident, Final Call, Scratchpad, and Scratchpad Length properties.</td>
</tr>
<tr>
<td>Run Estimates</td>
<td>Lets you view the Initial I/Os, I/Os Per Invocation, Initial Instructions, and Instructions Per Invocation properties.</td>
</tr>
<tr>
<td>Java Structure</td>
<td>Lets you view the Java Class, Jar ID, Package ID, Method ID, Jar Schema, and Java Signature properties.</td>
</tr>
<tr>
<td>Parameters, Return Columns, and Return Scalar</td>
<td>On opening, these tabs displays the current function parameters, return columns or return scalar. Optionally, take one of the following actions:</td>
</tr>
<tr>
<td></td>
<td>Select a parameter, return column, or return scalar in the Attributes area, modify values, as permissible. Attributes differ by the tab you chose but typically include items such as Type, Precision, Scale, As Locator, and Size.</td>
</tr>
<tr>
<td></td>
<td>Click the New button to provide datatype and size details for a new parameter, return column, or return scalar.</td>
</tr>
<tr>
<td></td>
<td>Select a parameter, return column, or return scalar and click Drop to delete that parameter.</td>
</tr>
<tr>
<td>Body</td>
<td>Lets you modify the code in the text area of the tab.</td>
</tr>
<tr>
<td>Comment</td>
<td>For details on using this tab, see &quot;Adding a Comment to an object&quot; on page 450.</td>
</tr>
<tr>
<td>Permissions</td>
<td>For details on using this tab, see &quot;Working with Privileges and Permissions&quot; on page 447.</td>
</tr>
<tr>
<td>DDL View</td>
<td>For details on using this tab, see &quot;Viewing the SQL/DDL for an Object&quot; on page 447.</td>
</tr>
</tbody>
</table>

3. When finished, you can submit your changes. For details, see "Previewing and Submitting Object Editor Changes" on page 450.

INDEXES EDITOR (IBM DB2 Z/OS)

The Indexes Editor lets you manage basic, storage, and space properties for an index, as well as work with its columns and partitions.
To edit an index

1. Open an editor on the index. For details, see "Opening an Object Editor" on page 444.

2. Use the following table as a guide to understanding and modifying the settings on the tabs of this editor:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Columns</strong></td>
<td>Lets you manage the columns or key-expressions that make up the index. On opening, this tab shows the existing columns/key-expressions. <strong>NOTE:</strong> Key-expression functionality is only enabled if the Index on Expression setting is enabled on the Properties tab. Optionally you can:</td>
</tr>
<tr>
<td></td>
<td>Change the Sort order of a column or key-expression.</td>
</tr>
<tr>
<td></td>
<td>If Index on Expression is disabled, click the New button and select a column name from the dropdown to add a column to the index.</td>
</tr>
<tr>
<td></td>
<td>If Index on Expression is enabled, click the New button and type a valid key-expression in the Expression field, to add an expression to the index.</td>
</tr>
<tr>
<td></td>
<td>Select a column or key-expression and click the Drop button to delete the column from the index.</td>
</tr>
<tr>
<td><strong>Properties</strong></td>
<td>Lets you work with the Buffer Pool, Piece Size, Close, Copy, Compress, Index on Expression, and Padded properties. For more information on these properties, see &quot;Indexes (DB2 z/OS) - Properties&quot; on page 284.</td>
</tr>
<tr>
<td><strong>Storage</strong></td>
<td>Lets you select a dataset management scheme and provide associated attribute values. For details, see &quot;Indexes (DB2 z/OS) - Storage&quot; on page 286.</td>
</tr>
<tr>
<td><strong>Partitions</strong></td>
<td>Lets you work with partitions for the index. For each data partition, the listing shows the storage group, VCAT Catalog, primary and secondary space allocations, and if appropriate, the free space percentage, GBP Cache, limit key value, and erase on delete settings. Optionally, you can select a partition and click the Edit button to open an editor that lets you edit that partition.</td>
</tr>
<tr>
<td><strong>Space</strong></td>
<td>Lets you view the following property groups:</td>
</tr>
<tr>
<td>Attributes</td>
<td>Make Unique, System Required, Total Keys, Page Fetch Pairs, and Distinct Keys</td>
</tr>
<tr>
<td>Statistics</td>
<td>Index Level, Cluster Ratio, Cluster Factor, Leaf Pages, Sequential Pages, Density, DASD Storage, and Data Blocks/Key</td>
</tr>
<tr>
<td>Cards</td>
<td>First Key and Full Keys</td>
</tr>
<tr>
<td><strong>Comment</strong></td>
<td>For details on using this tab, see &quot;Adding a Comment to an object&quot; on page 450.</td>
</tr>
<tr>
<td><strong>DDL View</strong></td>
<td>For details on using this tab, see &quot;Viewing the SQL/DDL for an Object&quot; on page 447.</td>
</tr>
</tbody>
</table>

3. When finished, you can submit your changes. For details, see "Previewing and Submitting Object Editor Changes" on page 450.
PACKAGES EDITOR (IBM DB2 Z/OS)
The Packages Editor lets you manage properties and bind parameters for a package, as well as view environment information, package contents and associated plans.

To edit a package
1. Open an editor on the package. For details, see "Opening an Object Editor" on page 444.
2. Use the following table as a guide to understanding and modifying the settings on the tabs of this editor:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Properties</td>
<td>Lets you work with the following properties: Average Size, Bind Time, Consistency Token, Dec31, Decimal Point, Group Member, Katakana Charset, Language, Mixed Character Set, Operative, Package Size, Package Source, PDS Name, Precompile Timestamp, Release Bound, String Delimiter, SysEntries, Timestamp, and Valid.</td>
</tr>
<tr>
<td>Plan/Packlists</td>
<td>Displays the plans contained in the package if the package was bound individually, or as part of a complete collection ID. Optionally, you can:</td>
</tr>
<tr>
<td></td>
<td>- Select a plan and click Edit to open the Plans editor on the plan. For more information, see &quot;Plans Editor (IBM DB2 Z/OS)&quot; on page 477.</td>
</tr>
<tr>
<td></td>
<td>- Select a plan and click Rebind to initiate rebinding the plan. For more information, see &quot;Rebind Plans&quot; on page 656.</td>
</tr>
<tr>
<td></td>
<td>- Select a plan and click Free to initiate deleting the plan. For more information, see &quot;Drop&quot; on page 620.</td>
</tr>
<tr>
<td>Statements</td>
<td>Shows the contents of any package statement on the datasource. Optionally, select a statement and click Explain to copy the statement to an ISQL Editor window.</td>
</tr>
<tr>
<td></td>
<td>NOTE: For more information, see &quot;Using the SQL Editor&quot; on page 791.</td>
</tr>
<tr>
<td>Dependencies</td>
<td>For details on using this tab, see &quot;Working with Object Dependencies&quot; on page 449.</td>
</tr>
<tr>
<td>Privileges</td>
<td>For details on using this tab, see &quot;Working with Privileges and Permissions&quot; on page 447.</td>
</tr>
<tr>
<td>Environments</td>
<td>Displays run-time environments information for a package. Use the arrow buttons to move environments between the Enabled Environments and Disabled Environments lists.</td>
</tr>
<tr>
<td></td>
<td>To modify a connection, select the environment and click Edit Connections. For more information, see Connection Editor.</td>
</tr>
<tr>
<td>Command</td>
<td>Displays the command that originally built the package.</td>
</tr>
</tbody>
</table>

3. When finished, you can submit your changes. For details, see "Previewing and Submitting Object Editor Changes" on page 450.
CONNECTION EDITOR
The Connection Editor lets you modify plan and package connections. It is opened from the Packages editor. For more information, see Packages Editor (IBM DB2 Z/OS).

The table below describes the options and functionality of the Connection Editor:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connections</td>
<td>Displays the connections for the plan or package.</td>
</tr>
<tr>
<td>Add</td>
<td>Click to add the connection.</td>
</tr>
</tbody>
</table>

PLANS EDITOR (IBM DB2 Z/OS)
The Plans Editor lets you manage plan properties, view DBRM information, manage packages and contents, and manage run-time environments for a plan.

To edit a plan
1. Open an editor on the plan. For details, see "Opening an Object Editor" on page 444.
2. Use the following table as a guide to understanding and modifying the settings on the tabs of this editor:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Definition</td>
<td>Lets you work with the following attribute groups:</td>
</tr>
<tr>
<td>Properties</td>
<td>Lets you view the Timestamp, Group Member, Plan Size, Average Size, Valid, Operative, Pkg. List Entries, SysEntries, and Release Bound properties. Lets you set the Owner, Qualifier, and Current Server properties.</td>
</tr>
<tr>
<td>DBRMs</td>
<td>Lists details for each DBRM associated with a plan. Optionally, select a DBRM from the list and click Edit to open the DBRM editor on that DBRM.</td>
</tr>
<tr>
<td>Packages</td>
<td>Displays details for each package associated with a plan. Optionally, you can:</td>
</tr>
<tr>
<td></td>
<td>Select a package and click Edit to open the Package editor on that package. For details, see Packages Editor (IBM DB2 Z/OS) on page 476.</td>
</tr>
<tr>
<td></td>
<td>Select a package and click Rebind to open the Rebind Packages dialog.</td>
</tr>
<tr>
<td></td>
<td>Select a package and click Free to open the Free (Packages) dialog.</td>
</tr>
</tbody>
</table>
3 When finished, you can submit your changes. For details, see "Previewing and Submitting Object Editor Changes" on page 450.

**PRIMARY KEYS EDITOR (IBM DB2 Z/OS)**

The Primary Keys Editor lets you manage primary key columns as well as work with storage, space, and partitions for a primary key.

**TIP:** The refresh button lets you refresh or clear the editor’s contents, and log SQL.
To edit a primary key

1. Open an editor on the primary key. For details, see "Opening an Object Editor" on page 444.

2. Use the following table as a guide to understanding and modifying the settings on the tabs of this editor:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Column</td>
<td>Lets you manage columns that make up the primary key. On opening, this tab shows the existing columns. For each column, the listing shows the datatype (and if applicable the precision in brackets) and whether the table definition permits nulls in the target table column. Optionally you can:</td>
</tr>
<tr>
<td></td>
<td>- Change the Sort order of a column.</td>
</tr>
<tr>
<td></td>
<td>- Click the New button and select a column name from the dropdown, to add a column to the primary key.</td>
</tr>
<tr>
<td></td>
<td>- Select a column and click the Drop button to delete the column from the primary key.</td>
</tr>
<tr>
<td></td>
<td>- Select a column and use the arrow buttons to reorder the columns in the primary key.</td>
</tr>
<tr>
<td>Properties</td>
<td>Lets you set Buffer Pool, Close, Copy and Piece Size properties.</td>
</tr>
<tr>
<td>Partitions</td>
<td>Lets you work with partitions for the primary key.</td>
</tr>
<tr>
<td>Space</td>
<td>Lets you view values in the following property groups:</td>
</tr>
<tr>
<td></td>
<td>Attributes: Make Unique, System Required, Total Keys, Page Fetch Pairs, and Distinct Keys.</td>
</tr>
<tr>
<td></td>
<td>Statistics: Index Level, Cluster Ratio, Cluster Factor, Leaf Pages, Sequential Pages, and Density.</td>
</tr>
<tr>
<td></td>
<td>Cards: First Key and Full Keys.</td>
</tr>
<tr>
<td>Comment</td>
<td>For details on using this tab, see &quot;Adding a Comment to an object&quot; on page 450.</td>
</tr>
<tr>
<td>DDL View</td>
<td>For details on using this tab, see &quot;Viewing the SQL/DDL for an Object&quot; on page 447.</td>
</tr>
</tbody>
</table>

3. When finished, you can submit your changes. For details, see "Previewing and Submitting Object Editor Changes" on page 450.

PROCEDURES EDITOR (IBM DB2 Z/OS)
The Procedures Editor lets you manage the properties and input/output parameters of a procedure.
MODIFYING OBJECTS USING EDITORS

To edit a procedure

1. Open an editor on the procedure. For details, see "Opening an Object Editor" on page 444.

2. Use the following table as a guide to understanding and modifying the settings on the tabs of this editor:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Properties</strong></td>
<td>Lets you work with properties in the following categories:</td>
</tr>
<tr>
<td>Identification</td>
<td>Lets you view the Schema and Routine ID properties. Lets you set the External Name and Collection ID properties.</td>
</tr>
<tr>
<td>Run Time</td>
<td>Lets you set the Result Sets, WLM Environment, WLM For Nested, ASU Time, and Run Options properties.</td>
</tr>
<tr>
<td>Structure</td>
<td>Lets you view the Language, Number of LOB Columns, Number of Parameters, and DBINFO properties. Lets you set the Program Type, Security Type, SQL Access Level, Parameter Style, Inherit Special Registers, Fenced, Commit on Return, Deterministic, and Stay Resident properties.</td>
</tr>
<tr>
<td>Run Estimates</td>
<td>Lets you view the Initial I/Os, I/Os Per Invocation, Initial Instructions, and Instructions Per Invocation properties.</td>
</tr>
<tr>
<td>Java Structure</td>
<td>Lets you view the Java Class, Jar ID, Package ID, Method ID, Jar Schema, and Java Signature properties.</td>
</tr>
<tr>
<td><strong>Parameters</strong></td>
<td>Displays a listing of the existing input/output parameters for the procedure. For the selected parameter, the Datatype list shows details for that parameter, including the Type and Parameter Mode (INPUT, OUTPUT, INPUT_OUTPUT). Depending on the type other parameters such as Size, Precision, or Scale may be available for viewing or modification. Optionally you can:</td>
</tr>
<tr>
<td></td>
<td>Select a parameter and in the Datatype list, modify details for that parameter.</td>
</tr>
<tr>
<td></td>
<td>Click the Add button to add a new parameter, provide a name for the new parameter, and edit the parameter values in the Datatype list.</td>
</tr>
<tr>
<td></td>
<td>Click the Delete button to drop a selected parameter.</td>
</tr>
<tr>
<td></td>
<td>Use the arrow buttons to change the order location of a selected parameter.</td>
</tr>
<tr>
<td>Comment</td>
<td>For details on using this tab, see &quot;Adding a Comment to an object&quot; on page 450.</td>
</tr>
<tr>
<td>Body</td>
<td>Lets you modify the SQL code for procedures on the current datasource</td>
</tr>
<tr>
<td>Permissions</td>
<td>For details on using this tab, see &quot;Working with Privileges and Permissions&quot; on page 447.</td>
</tr>
<tr>
<td>DDL View</td>
<td>For details on using this tab, see &quot;Viewing the SQL/DDL for an Object&quot; on page 447.</td>
</tr>
</tbody>
</table>

3. When finished, you can submit your changes. For details, see "Previewing and Submitting Object Editor Changes" on page 450.

STOGROUPS EDITOR (IBM DB2 Z/OS)
The Stogroups Editor lets you view and modify volumes, manage function privileges, and view DDL for a stogroup.
To edit a stogroup
1. Open an editor on the stogroup. For details, see "Opening an Object Editor" on page 444.
2. Use the following table as a guide to understanding and modifying the settings on the tabs of this editor:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Volume Devices</td>
<td>Shows details on volumes associated with the stogroup. Optionally you can:</td>
</tr>
<tr>
<td></td>
<td>Click Add to open a dialog that lets you add volumes.</td>
</tr>
<tr>
<td></td>
<td>Select a volume and click Remove to delete the volume.</td>
</tr>
<tr>
<td>Privileges</td>
<td>For details on using this tab, see &quot;Working with Privileges and Permissions&quot; on page 447.</td>
</tr>
<tr>
<td>DDL View</td>
<td>For details on using this tab, see &quot;Viewing the SQL/DDL for an Object&quot; on page 447.</td>
</tr>
</tbody>
</table>

3. When finished, you can submit your changes. For details, see "Previewing and Submitting Object Editor Changes" on page 450.

SYNONYMS Editor (IBM DB2 Z/OS)
The Synonyms Editor lets you view base object information and manage database object dependencies for a synonym.

To edit a synonym
1. Open an editor on the synonym. For details, see Opening an Object Editor.
2. Use the following table as a guide to understanding and modifying the settings on the tabs of this editor:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Properties</td>
<td>Lets you view the owning Schema, the Name of the synonym, and the synonym’s</td>
</tr>
<tr>
<td></td>
<td>Referenced Object Owner, Referenced Object Type, and the Referenced Object</td>
</tr>
<tr>
<td></td>
<td>Name.</td>
</tr>
<tr>
<td>Dependencies</td>
<td>For details on using this tab, see &quot;Working with Object Dependencies&quot; on page 449.</td>
</tr>
<tr>
<td>DDL View</td>
<td>For details on using this tab, see &quot;Viewing the SQL/DDL for an Object&quot; on page 447.</td>
</tr>
</tbody>
</table>

3. When finished, you can submit your changes. For details, see "Previewing and Submitting Object Editor Changes" on page 450.

TABLES Editor (IBM DB2 Z/OS)
The Tables Editor lets you: manage columns, basic properties, partitions, indexes, and constraints for a table.

**NOTE:** Before editing tables, refer to the material in Altering Tables for IBM DB2 z/OS.
### To edit a table

1. Open an editor on the table. For details, see "Opening an Object Editor" on page 444.

2. Use the following table as a guide to understanding and modifying the settings on the tabs of this editor:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Columns</strong></td>
<td>Displays the currently defined columns in the table. For each column, the Property/Value list displays the <strong>Name</strong> and <strong>Type</strong> for the column. In addition, depending on the <strong>Type</strong> selected, the list also displays <strong>Size</strong>, <strong>Scale</strong>, <strong>Identity Column</strong>, <strong>Allow Nulls</strong>, <strong>Default Value</strong>, <strong>Comment</strong>, and <strong>For Data</strong> property values, as appropriate. The <strong>Statistics</strong> group displays a <strong>Number of Distinct Values in the Column</strong> value. Optionally, you can:</td>
</tr>
<tr>
<td></td>
<td>Select a column, and in the <strong>Property/Value</strong> list modify property values for that column.</td>
</tr>
<tr>
<td></td>
<td>Click <strong>Add Column</strong>, provide a name for the new column, and set property values for the column.</td>
</tr>
<tr>
<td></td>
<td>Select a column and click <strong>Delete</strong> to remove the column from the table.</td>
</tr>
<tr>
<td><strong>Properties</strong></td>
<td>Lets you work with settings in the following categories:</td>
</tr>
<tr>
<td></td>
<td><strong>Table</strong> Lets you view <strong>EditProcedure</strong>, <strong>Table Type</strong>, <strong>Table Status</strong>, <strong>Check Flag</strong>, <strong>DBID</strong>, and <strong>OBID</strong> properties. Lets you set <strong>Volatile</strong>, <strong>Audit</strong>, <strong>RestrictDrop</strong>, <strong>Label</strong>, and <strong>ValidProc</strong> properties.</td>
</tr>
<tr>
<td></td>
<td><strong>Tablespace Placement</strong> Lets you select a <strong>Tablespace</strong>.</td>
</tr>
<tr>
<td></td>
<td><strong>Log Options</strong> Lets you select a <strong>Data Capture</strong> option of <strong>DATA CAPTURE NONE</strong> or <strong>DATA CAPTURE CHANGES</strong>.</td>
</tr>
<tr>
<td></td>
<td><strong>Statistics</strong> Lets you view the following statistics: <strong>Last Runstats</strong>, <strong>Total number of rows</strong>, <strong>Average Row Length</strong>, <strong>Number of Pages</strong>, <strong>Percent Compressed Rows</strong>, <strong>Max Record Length</strong>, and <strong>DASD storage</strong>.</td>
</tr>
<tr>
<td><strong>Partitions</strong></td>
<td>Displays existing partition columns and data partitions. Optionally you can add, edit, or delete partition columns and data partitions.</td>
</tr>
<tr>
<td><strong>Indexes</strong></td>
<td>Displays the list of indexes for the table. Optionally, take one of the following actions:</td>
</tr>
<tr>
<td></td>
<td>Click <strong>Add</strong> to open a dialog that lets you add a new index to the table.</td>
</tr>
<tr>
<td></td>
<td>Select an index and click <strong>Edit</strong> to open a dialog that lets you edit index properties.</td>
</tr>
<tr>
<td></td>
<td>Select an index and click <strong>Drop</strong> to open a dialog that lets you remove the index from the table.</td>
</tr>
<tr>
<td><strong>Constraints</strong></td>
<td>Displays constraints in a tree structure. The tree contains folders which contain all constraints associated with the target table. The objects are organized in folders based on the type of constraint. Optionally take one of the following actions:</td>
</tr>
<tr>
<td></td>
<td>Select a constraint type folder and click <strong>Add</strong> to open a dialog that lets you add a constraint of that type.</td>
</tr>
<tr>
<td></td>
<td>Select a constraint and click <strong>Edit</strong> to open a dialog that lets you modify the constraint details.</td>
</tr>
<tr>
<td></td>
<td>Select a constraint and click <strong>Drop</strong> to remove the constraint.</td>
</tr>
<tr>
<td><strong>Comment</strong></td>
<td>For details on using this tab, see &quot;Adding a Comment to an object&quot; on page 450.</td>
</tr>
</tbody>
</table>
ALTERING TABLES FOR IBM DB2 Z/OS

The ALTER TABLE command of Transact-SQL is limited to adding NULL columns to the end of a table and to adding or dropping constraints. Unfortunately, this scenario does not address many requirements of administrators and developers who need to add, delete or modify columns more broadly:

- Add columns anywhere in a table, not just the end
- Add columns that do not permit a NULL value.
- Change the NULL/NOT NULL status of table columns
- Change column datatypes to other compatible types
- Change the length of datatypes
- Delete a column

Due to the limitations of the ALTER TABLE command, the only way to make broader modifications is to write SQL scripts that step through all desired changes. To perform an enhanced table alter, Rapid SQL constructs an SQL script that completes the following steps:

1. Renames the existing table so that the original and its data remain intact
2. Builds a CREATE TABLE statement with the new table definition, including declared defaults, primary key and check constraints
3. Builds an INSERT statement to copy data from the original, renamed table to the new one
4. Builds foreign keys on the new table
5. Reapplies any privileges granted on the table
6. Rebuilds all dependencies on the new table, including indexes, triggers, procedures, packages, functions and views. When rebuilding procedures, functions, packages and views, Rapid SQL also rebuilds any permissions on them

TABLESPACES EDITOR (IBM DB2 Z/OS)

The Tablespaces Editor lets you work with the basic properties and partitions for a tablespace as well as view space details, status, and objects stored on the tablespace.
MODIFYING OBJECTS USING EDITORS

To edit a tablespace

1. Open an editor on the tablespace. For details, see "Opening an Object Editor" on page 444.

2. Use the following table as a guide to understanding and modifying the settings on the tabs of this editor:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Properties</strong></td>
<td>Lets you work with properties in the following categories:</td>
</tr>
<tr>
<td></td>
<td>Buffer Pool</td>
</tr>
<tr>
<td></td>
<td>Number of partitions, Partition size (DSSIZE), Segment size, and Max rows per page</td>
</tr>
<tr>
<td></td>
<td>GBPCACHE, Compress, Track modified pages, Encoding scheme, Log, Define, Member Cluster, Close rule, Lock Size, and Maximum locks</td>
</tr>
<tr>
<td></td>
<td>For more information on these properties, see &quot;Tablespaces (DB2 z/OS) - Properties&quot; on page 298.</td>
</tr>
<tr>
<td><strong>Partitions</strong></td>
<td>Displays a list of partitions for the tablespace. Details for each partition include the storage group, VCAT, primary and secondary space allocations, the free space portion of each page and free page frequency, the group buffer cache scheme, and whether modifications are tracked.</td>
</tr>
<tr>
<td></td>
<td>Optionally, you can:</td>
</tr>
<tr>
<td></td>
<td>Select a partition and click <strong>Edit</strong> to open a dialog that lets you modify properties for that partition.</td>
</tr>
<tr>
<td></td>
<td>Select a partition and click <strong>Clone</strong> to open a dialog that lets you apply the attributes of the selected partition to another partition.</td>
</tr>
<tr>
<td><strong>Status</strong></td>
<td>Lets you display CLAIMERS, LOCKS, LPL, USE, or WEPR status details</td>
</tr>
<tr>
<td><strong>Space</strong></td>
<td>Lets you view space usage and allocation details for the tablespace.</td>
</tr>
<tr>
<td><strong>Objects</strong></td>
<td>Displays the objects stored on the tablespace. Objects are organized in a tree structure with folders containing the objects.</td>
</tr>
<tr>
<td></td>
<td>Optionally, you can:</td>
</tr>
<tr>
<td></td>
<td>Select an object and click <strong>Edit</strong> to open an object editor on that object.</td>
</tr>
<tr>
<td></td>
<td>Select an object and click <strong>Drop</strong> to initiate dropping that object.</td>
</tr>
<tr>
<td><strong>Permissions</strong></td>
<td>For details on using this tab, see &quot;Working with Privileges and Permissions&quot; on page 447.</td>
</tr>
<tr>
<td><strong>DDL</strong></td>
<td>For details on using this tab, see &quot;Viewing the SQL/DDL for an Object&quot; on page 447.</td>
</tr>
</tbody>
</table>

3. When finished, you can submit your changes. For details, see "Previewing and Submitting Object Editor Changes" on page 450.

TRIGGERS EDITOR (IBM DB2 Z/OS)

The Triggers Editor lets you modify the CREATE TRIGGER statement and manage properties for a trigger.
To edit a trigger
1. Open an editor on the trigger. For details, see "Opening an Object Editor" on page 444.
2. Use the following table as a guide to understanding and modifying the settings on the tabs of this editor:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Properties</td>
<td>Lets you view the Trigger Timing, Trigger Events, Trigger Type, Object Status, Definer, and Function Path properties.</td>
</tr>
<tr>
<td>Comment</td>
<td>For details on using this tab, see &quot;Adding a Comment to an object&quot; on page 450.</td>
</tr>
<tr>
<td>Dependencies</td>
<td>For details on using this tab, see &quot;Working with Object Dependencies&quot; on page 449.</td>
</tr>
<tr>
<td>Definition</td>
<td>Lets you modify the CREATE TRIGGER body for a trigger. To modify a trigger, Rapid SQL must drop then create the trigger.</td>
</tr>
</tbody>
</table>

3. When finished, you can submit your changes. For details, see "Previewing and Submitting Object Editor Changes" on page 450.

**UNIQUE KEYS EDITOR (IBM DB2 Z/OS)**
The Unique Keys Editor lets you manage columns, basic properties, and partitions for a unique key, as well as view storage details.

To edit a unique key
1. Open an editor on the unique key. For details, see "Opening an Object Editor" on page 444.
2. Use the following table as a guide to understanding and modifying the settings on the tabs of this editor:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Column</td>
<td>Lets you manage columns that make up the primary key. On opening, this tab shows the existing columns. For each column, the listing shows the datatype (and if applicable the precision in brackets) and whether the table definition permits nulls in the target table column. Optionally you can:</td>
</tr>
<tr>
<td></td>
<td>Change the Sort order of a column.</td>
</tr>
<tr>
<td></td>
<td>Click the New button and select a column name from the dropdown, to add a column to the primary key.</td>
</tr>
<tr>
<td></td>
<td>Select a column and click the Drop button to delete the column from the primary key.</td>
</tr>
<tr>
<td></td>
<td>Select a column and use the arrow buttons to reorder the columns in the primary key.</td>
</tr>
<tr>
<td>Properties</td>
<td>Lets you set the Buffer Pool, Piece Size, Close, and Copy properties.</td>
</tr>
</tbody>
</table>
### USER DATATYPES EDITOR (IBM DB2 Z/OS)
The User Datatypes Editor lets you manage basic properties of a user datatype.

**To edit a user datatype**

1. Open an editor on the user datatype. For details, see "Opening an Object Editor" on page 444.

2. Use the following table as a guide to understanding and modifying the settings on the tabs of this editor:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Properties</td>
<td>Lets you work with properties in the following categories:</td>
</tr>
<tr>
<td>Base Datatype</td>
<td>Lets you set <strong>Type</strong> and <strong>Size</strong> settings.</td>
</tr>
<tr>
<td>Character Options</td>
<td>Lets you set the <strong>For Data</strong> and <strong>CCSID</strong> properties.</td>
</tr>
<tr>
<td>Comment</td>
<td>For details on using this tab, see &quot;Adding a Comment to an object&quot; on page 450.</td>
</tr>
<tr>
<td>Permissions</td>
<td>For details on using this tab, see &quot;Working with Privileges and Permissions&quot; on page 447.</td>
</tr>
<tr>
<td>DDL View</td>
<td>For details on using this tab, see &quot;Viewing the SQL/DDL for an Object&quot; on page 447.</td>
</tr>
</tbody>
</table>

3. When finished, you can submit your changes. For details, see "Previewing and Submitting Object Editor Changes" on page 450.

### USERS EDITOR (IBM DB2 Z/OS)
The Users Editor lets you manage permissions for a user and the objects owned by that user.
MODIFYING OBJECTS USING EDITORS

To edit a user
1. Open an editor on the user. For details, see "Opening an Object Editor" on page 444.
2. Use the following table as a guide to understanding and modifying the settings on the tabs of this editor:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Properties</strong></td>
<td>Displays the user Name.</td>
</tr>
<tr>
<td><strong>Objects</strong></td>
<td>Lets you manage database objects associated with the user. Objects are organized in a tree structure with folders containing the objects. Optionally, take one of the following actions: Select an object and click <strong>Edit</strong> to open an object editor on the selected object. Select an object and click <strong>Drop</strong> to initiate dropping the selected object.</td>
</tr>
<tr>
<td><strong>Object Permissions</strong> and <strong>System Permissions</strong></td>
<td>For details on using these tabs, see &quot;Working with Privileges and Permissions&quot; on page 447.</td>
</tr>
<tr>
<td><strong>DDL View</strong></td>
<td>For details on using this tab, see &quot;Viewing the SQL/DDL for an Object&quot; on page 447.</td>
</tr>
</tbody>
</table>

3. When finished, you can submit your changes. For details, see "Previewing and Submitting Object Editor Changes" on page 450.

VIEWS EDITOR (IBM DB2 Z/OS)
The Views Editor lets you view columns for a view and work with the dependencies and permissions for the view.

To edit a view
1. Open an editor on the view. For details, see "Opening an Object Editor" on page 444.
2. Use the following table as a guide to understanding and modifying the settings on the tabs of this editor:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Properties</strong></td>
<td>Displays all columns for the view. Details for each column include the Column Name, the Datatype (and if applicable, with the precision in parentheses), and whether or not Nulls are allowed for that column.</td>
</tr>
<tr>
<td><strong>Definition</strong></td>
<td>Lets you view and modify the CREATE VIEW DDL that will implement any changes you make in this editor. To modify a view, Rapid SQL must drop then create the view.</td>
</tr>
<tr>
<td><strong>Comment</strong></td>
<td>For details on using this tab, see &quot;Adding a Comment to an object&quot; on page 450.</td>
</tr>
<tr>
<td><strong>Dependencies</strong></td>
<td>For details on using this tab, see &quot;Working with Object Dependencies&quot; on page 449.</td>
</tr>
<tr>
<td><strong>Permissions</strong></td>
<td>For details on using this tab, see &quot;Working with Privileges and Permissions&quot; on page 447.</td>
</tr>
</tbody>
</table>

3. When finished, you can submit your changes. For details, see "Previewing and Submitting Object Editor Changes" on page 450.
INTERBASE/FIREBIRD OBJECT EDITORS

Rapid SQL includes an Object Editor for all supported InterBase/Firebird objects. To see an Editor for a specific object, click the corresponding link below:

- Blob Filters Editor (InterBase/Firebird)
- Domains Editor (InterBase/Firebird)
- Encryption Keys editor (InterBase/Firebird)
- Exceptions Editor (InterBase/Firebird)
- External Functions editor (InterBase/Firebird)
- Foreign Keys editor (InterBase/Firebird)
- Generators editor (InterBase/Firebird)
- Indexes editor (InterBase/Firebird)
- Primary Keys editor (InterBase/Firebird)
- Procedures editor (InterBase/Firebird)
- Roles editor (InterBase/Firebird)
- Shadows editor (InterBase/Firebird)
- Tables editor (InterBase/Firebird)
- Triggers editor (InterBase/Firebird)
- Unique Keys editor (InterBase/Firebird)
- Users editor (InterBase/Firebird)
- Views editor (InterBase/Firebird)

For access to object editors for different supported DBMS platforms and an introduction to editor usage, see “Modifying objects using editors” on page 443.

BLOB FILTERS EDITOR (INTERBASE/FIREBIRD)

The Blob Filters editor lets you modify the input and output types, entry point, and the module name of a blob filter declaration.
**MODIFYING OBJECTS USING EDITORS**

**To edit a blob filter**

1. Open an editor on the blob filter. For details, see "Opening an Object Editor" on page 444.
2. Use the following table as a guide to understanding and modifying the settings on the tabs of this editor:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Properties</td>
<td>In addition to displaying the <strong>Name</strong> property, this tab also lets you modify the <strong>Input subtype</strong>, <strong>Output subtype</strong>, <strong>Entrypoint</strong>, and <strong>Module name</strong> properties. For details on these properties, see &quot;Blob Filters Editor (InterBase/Firebird)&quot; on page 488.</td>
</tr>
<tr>
<td>Comment</td>
<td>For details on using this tab, see &quot;Adding a Comment to an object&quot; on page 450.</td>
</tr>
<tr>
<td>Dependencies</td>
<td>For details on using this tab, see &quot;Working with Object Dependencies&quot; on page 449.</td>
</tr>
<tr>
<td>DDL View</td>
<td>For details on using this tab, see &quot;Viewing the SQL/DDL for an Object&quot; on page 447.</td>
</tr>
</tbody>
</table>

3. When finished, you can submit your changes. For details, see "Previewing and Submitting Object Editor Changes" on page 450.

**DOMAINS EDITOR (INTERBASE/FIREBIRD)**

The Domains editor lets you modify datatype details and other basic clause/option values of a domain.

**To edit a domain**

1. Open an editor on the domain. For details, see "Opening an Object Editor" on page 444.
2. Use the following table as a guide to understanding and modifying the settings on the tabs of this editor:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Properties</td>
<td>In addition to displaying the <strong>Datatype</strong> name, this tab lets you work with the <strong>Type</strong>, <strong>Allow Nulls</strong>, <strong>Size</strong>, <strong>Precision</strong>, <strong>Scale</strong>, <strong>Array</strong>, <strong>Character Set</strong>, <strong>Collation</strong>, <strong>LOB Segment Length</strong>, <strong>Default</strong>, and <strong>Check</strong> settings. For details on these settings and their availability, see &quot;Domains (ITB/FBD) - Properties&quot; on page 307.</td>
</tr>
<tr>
<td>Comment</td>
<td>For details on using this tab, see &quot;Adding a Comment to an object&quot; on page 450.</td>
</tr>
<tr>
<td>Dependencies</td>
<td>For details on using this tab, see &quot;Working with Object Dependencies&quot; on page 449.</td>
</tr>
<tr>
<td>DDL View</td>
<td>For details on using this tab, see &quot;Viewing the SQL/DDL for an Object&quot; on page 447.</td>
</tr>
</tbody>
</table>

3. When finished, you can submit your changes. For details, see "Previewing and Submitting Object Editor Changes" on page 450.

**ENCRYPTION KEYS EDITOR (INTERBASE/FIREBIRD)**

The Encryption Keys editor lets you modify the encryption algorithm and key length options for a key, as well as the padding and Cipher Block Chaining versus Electronic Cookbook details.
To edit an encryption key

1. Open an editor on the encryption key. For details, see "Opening an Object Editor" on page 444.

2. Use the following table as a guide to understanding and modifying the settings on the tabs of this editor:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Properties</td>
<td>In addition to displaying the Name of the encryption key, this tab lets you work with the Algorithm, Pad random, Init Vector random, and IsDefault settings. This tab also lets you modify the associated Password. For details on these settings, see &quot;Encryption Keys (ITB/FBD) - Properties&quot; on page 308.</td>
</tr>
<tr>
<td>Comment</td>
<td>For details on using this tab, see &quot;Adding a Comment to an object&quot; on page 450.</td>
</tr>
<tr>
<td>Dependencies</td>
<td>For details on using this tab, see &quot;Working with Object Dependencies&quot; on page 449.</td>
</tr>
<tr>
<td>Permissions</td>
<td>For details on using this tab, see &quot;Working with Privileges and Permissions&quot; on page 447.</td>
</tr>
<tr>
<td>DDL View</td>
<td>For details on using this tab, see &quot;Viewing the SQL/DDL for an Object&quot; on page 447.</td>
</tr>
</tbody>
</table>

3. When finished, you can submit your changes. For details, see "Previewing and Submitting Object Editor Changes" on page 450.

EXCEPTIONS EDITOR (INTERBASE/FIREBIRD)
The Exceptions Editor lets you modify the text of the message associated with an exception.

To edit an exception

1. Open an editor on the exception. For details, see "Opening an Object Editor" on page 444.

2. Use the following table as a guide to understanding and modifying the settings on the tabs of this editor:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Properties</td>
<td>In addition to displaying the Name of the exception, this tab lets you work with the Text setting. For details on these settings, see &quot;Exceptions (ITB/FBD) - Properties&quot; on page 309.</td>
</tr>
<tr>
<td>Comment</td>
<td>For details on using this tab, see &quot;Adding a Comment to an object&quot; on page 450.</td>
</tr>
<tr>
<td>Dependencies</td>
<td>For details on using this tab, see &quot;Working with Object Dependencies&quot; on page 449.</td>
</tr>
<tr>
<td>DDL View</td>
<td>For details on using this tab, see &quot;Viewing the SQL/DDL for an Object&quot; on page 447.</td>
</tr>
</tbody>
</table>

3. When finished, you can submit your changes. For details, see "Previewing and Submitting Object Editor Changes" on page 450.
EXTERNAL FUNCTIONS EDITOR (INTERBASE/FIREBIRD)
The External Functions editor lets you modify basic properties, input parameters, and return
datatype of an external function.

To edit an external function
1. Open an editor on the external function. For details, see "Opening an Object Editor" on
   page 444.
2. Use the following table as a guide to understanding and modifying the settings on the tabs
   of this editor:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Properties</td>
<td>In addition to displaying the Name of the external function, this tab lets you work with the EntryPoint and Module Name settings. For details on these settings, see &quot;External Functions (ITB/FBD) - Properties&quot; on page 310.</td>
</tr>
<tr>
<td>Parameters</td>
<td>Displays the input parameters to the external function. Optionally, you can:</td>
</tr>
<tr>
<td></td>
<td>Use the New button to add a new parameter and type a name for the parameter in the space provided. With the parameter selected, in the Attributes area select a Type, and if appropriate, provide or select Precision, Scale, and Size options.</td>
</tr>
<tr>
<td></td>
<td>Modify a parameter by selecting it, and in the Attributes area editing the Type, Precision, Scale, and Size options.</td>
</tr>
<tr>
<td></td>
<td>Use the Delete button to drop a selected parameter and use the arrow keys to reorder the parameter list.</td>
</tr>
<tr>
<td></td>
<td>Use the arrow keys to change the list ordering of a selected parameter.</td>
</tr>
<tr>
<td>Return Type</td>
<td>Displays datatype details of the value returned by the external function.</td>
</tr>
<tr>
<td>Dependencies</td>
<td>For details on using this tab, see &quot;Working with Object Dependencies&quot; on page 449.</td>
</tr>
<tr>
<td>Comment</td>
<td>For details on using this tab, see &quot;Adding a Comment to an object&quot; on page 450.</td>
</tr>
<tr>
<td>DDL View</td>
<td>For details on using this tab, see &quot;Viewing the SQL/DDL for an Object&quot; on page 447.</td>
</tr>
</tbody>
</table>

3. When finished, you can submit your changes. For details, see "Previewing and Submitting Object Editor Changes" on page 450.

FOREIGN KEYS EDITOR (INTERBASE/FIREBIRD)
The Foreign Keys Editor lets you manage column mapping for a foreign key as well as modify the update and delete rule actions.
**MODIFYING OBJECTS USING EDITORS**

**To edit a foreign key**

1. Open an editor on the foreign key. For details, see "Opening an Object Editor" on page 444.

2. Use the following table as a guide to understanding and modifying the settings on the tabs of this editor:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Column Mapping</td>
<td>The existing column mapping for the foreign key is represented by selected columns in the <strong>Main Table</strong> and <strong>Referenced Table</strong> lists. Additional candidates in the <strong>Referenced Table</strong> list are indicated by enabled column check boxes. If necessary, use the <strong>Table</strong> dropdown in the <strong>Referenced Table</strong> group to choose a new table for this foreign key. Select or deselect columns in the <strong>Main Table</strong> list and <strong>Referenced Table</strong> list to form the referential constraint between the two tables.</td>
</tr>
<tr>
<td>Properties</td>
<td>Lets you modify the <strong>Delete rule</strong> and <strong>Update Rule</strong> actions. For details on these properties, see &quot;Foreign keys (ITB/FBD) - Properties&quot; on page 311.</td>
</tr>
<tr>
<td>DDL View</td>
<td>For details on using this tab, see &quot;Viewing the SQL/DDL for an Object&quot; on page 447.</td>
</tr>
</tbody>
</table>

3. When finished, you can submit your changes. For details, see "Previewing and Submitting Object Editor Changes" on page 450.

**GENERATORS EDITOR (INTERBASE/FIREBIRD)**

The Generators Editor lets you view the name and work with the object dependencies for a generator.

**To edit a generator**

1. Open an editor on the generator. For details, see "Opening an Object Editor" on page 444.

2. Use the following table as a guide to understanding and modifying the settings on the tabs of this editor:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Properties</td>
<td>Lets you view the <strong>Name</strong> of the generator and modify the <strong>Current Value</strong>. For details on these properties, see &quot;Generators (ITB/FBD) - Properties&quot; on page 312.</td>
</tr>
<tr>
<td>Dependencies</td>
<td>For details on using this tab, see &quot;Working with Object Dependencies&quot; on page 449.</td>
</tr>
<tr>
<td>DDL View</td>
<td>For details on using this tab, see &quot;Viewing the SQL/DDL for an Object&quot; on page 447.</td>
</tr>
</tbody>
</table>

3. When finished, you can submit your changes. For details, see "Previewing and Submitting Object Editor Changes" on page 450.
INDEXES EDITOR (INTERBASE/FIREBIRD)
The Indexes Editor lets you modify the columns and basic properties for an index.

To edit an index
1. Open an editor on the index. For details, see "Opening an Object Editor" on page 444.
2. Use the following table as a guide to understanding and modifying the settings on the tabs of this editor:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Columns</td>
<td>Lets you manage columns that make up the index. On opening, this tab shows the existing columns. For each column, the listing displays the datatype and whether the table definition permits nulls. Optionally you can:</td>
</tr>
<tr>
<td></td>
<td>Click the New button and select a column name from the dropdown, to add a column to the index.</td>
</tr>
<tr>
<td></td>
<td>Select a column and click the Drop button to delete the column from the index.</td>
</tr>
<tr>
<td></td>
<td>Select a column and use the arrow buttons to reorder the columns in the index.</td>
</tr>
<tr>
<td>Properties</td>
<td>In addition to displaying the Name and associated Table Name for the index, this tab lets you modify the Unique, Enabled, and Descending properties. For details on these properties, see &quot;Indexes (ITB/FBD) - Properties&quot; on page 313.</td>
</tr>
<tr>
<td>DDL View</td>
<td>For details on using this tab, see &quot;Viewing the SQL/DDL for an Object&quot; on page 447.</td>
</tr>
</tbody>
</table>

3. When finished, you can submit your changes. For details, see "Previewing and Submitting Object Editor Changes" on page 450.

PRIMARY KEYS EDITOR (INTERBASE/FIREBIRD)
The Primary Keys Editor lets you modify the columns that make up a primary key.
To edit a primary key

1. Open an editor on the primary key. For details, see "Opening an Object Editor" on page 444.

2. Use the following table as a guide to understanding and modifying the settings on the tabs of this editor:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Columns</td>
<td>Lets you manage columns that make up the primary key. On opening, this tab shows the existing columns. For each column, the listing displays the datatype and whether the table definition permits nulls. Note that only columns defined with the Allow Nulls property disabled can be added to a primary key. Optionally you can: Click the New button and select a column name from the dropdown, to add a column to the index. Select a column and click the Drop button to delete the column from the index. Select a column and use the arrow buttons to reorder the columns in the index.</td>
</tr>
<tr>
<td>Properties</td>
<td>Displays the Name of the index and the associated Table Name.</td>
</tr>
<tr>
<td>DDL View</td>
<td>For details on using this tab, see &quot;Viewing the SQL/DDL for an Object&quot; on page 447.</td>
</tr>
</tbody>
</table>

3. When finished, you can submit your changes. For details, see "Previewing and Submitting Object Editor Changes" on page 450.

PROCEDURES EDITOR (INTERBase/FIREBIRD)
The Procedures Editor lets you modify the body and parameters for a procedure.

To edit a procedure

1. Open an editor on the procedure. For details, see "Opening an Object Editor" on page 444.

2. Use the following table as a guide to understanding and modifying the settings on the tabs of this editor:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Properties</td>
<td>Displays the Name of the procedure.</td>
</tr>
</tbody>
</table>
MODIFYING OBJECTS USING EDITORS

3 When finished, you can submit your changes. For details, see "Previewing and Submitting Object Editor Changes" on page 450.

ROLES EDITOR (INTERBASE/FIREBIRD)
The Roles Editor lets you manage the users assigned to a role and the permissions associated with the role.

To edit a role
1 Open an editor on the role. For details, see "Opening an Object Editor" on page 444.
2 Use the following table as a guide to understanding and modifying the settings on the tabs of this editor:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Properties</td>
<td>Displays the Name and Authorization Owner for the role.</td>
</tr>
<tr>
<td>Users</td>
<td>Let you manage users for the role. Use the Join Role and Leave Role buttons to move users between the Users In Role and Users Not In Role lists.</td>
</tr>
<tr>
<td>Object Permissions</td>
<td>For details on using these tabs, see &quot;Working with Privileges and Permissions&quot; on page 447.</td>
</tr>
<tr>
<td>DDL View</td>
<td>For details on using this tab, see &quot;Viewing the SQL/DDL for an Object&quot; on page 447.</td>
</tr>
</tbody>
</table>

3 When finished, you can submit your changes. For details, see "Previewing and Submitting Object Editor Changes" on page 450.
SHADOWS EDITOR (INTERBASE/FIREBIRD)
The Shadows Editor lets you modify CONDITIONAL, AUTO, and MANUAL argument usage and the file specification for a shadow.

To edit a shadow
1. Open an editor on the shadow. For details, see "Opening an Object Editor" on page 444.
2. Use the following table as a guide to understanding and modifying the settings on the tabs of this editor:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Properties</td>
<td>Displays the Shadow Set number and lets you modify the Conditional and Behavior properties. For details on these properties, see &quot;Shadows (ITB/FBD) - Properties&quot; on page 317.</td>
</tr>
<tr>
<td>Storage</td>
<td>Use the Delete button to drop a selected file. Modify an existing file by selecting the file in the primary and secondary files list, and modify the Physical File Name, Starting Page (for secondary files), and Size properties. Add a new file by clicking New, and providing file specification values in the Property/Value list.</td>
</tr>
<tr>
<td>DDL View</td>
<td>For details on using this tab, see &quot;Viewing the SQL/DDL for an Object&quot; on page 447.</td>
</tr>
</tbody>
</table>
3. When finished, you can submit your changes. For details, see "Previewing and Submitting Object Editor Changes" on page 450.

TABLES EDITOR (INTERBASE/FIREBIRD)
The Tables Editor lets you manage basic properties, columns, indexes, and constraints for a table.

To edit a table
1. Open an editor on the table. For details, see "Opening an Object Editor" on page 444.
2. Use the following table as a guide to understanding and modifying the settings on the tabs of this editor:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Columns</td>
<td>Displays the currently defined columns in the table. Optionally, you can:</td>
</tr>
<tr>
<td></td>
<td>Select a column, and in the Property/Value list modify property values for that column. For details on the properties, see &quot;Tables (ITB/FBD) - Columns&quot; on page 318.</td>
</tr>
<tr>
<td></td>
<td>Use the Add Column dropdown to add a new column to the bottom of the column list or to insert a new column above the currently selected column in the column list. Provide a Name for the column, and then set property values for the column.</td>
</tr>
<tr>
<td></td>
<td>Select a column and click Delete to remove the column from the table.</td>
</tr>
<tr>
<td>Properties</td>
<td>Displays the Name of the table and the date and time Created.</td>
</tr>
</tbody>
</table>
When finished, you can submit your changes. For details, see "Previewing and Submitting Object Editor Changes" on page 450.

**TRIGGERS EDITOR (INTERBASE/FIREBIRD)**

The Triggers Editor lets you modify the basic properties, trigger body, and dependencies for a trigger.

**To edit a trigger**

1. Open an editor on the trigger. For details, see "Opening an Object Editor" on page 444.

2. Use the following table as a guide to understanding and modifying the settings on the tabs of this editor:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Indexes</td>
<td>Lets you manage indexes for a table:</td>
</tr>
<tr>
<td></td>
<td>Click <strong>Add</strong> to open a dialog that lets you add a new index to the table. For more information, see &quot;Indexes Wizard (ITB/FBD)&quot; on page 312.</td>
</tr>
<tr>
<td></td>
<td>Select an index and click <strong>Edit</strong> to open a dialog that lets you edit index properties. For more information, see &quot;Indexes editor (InterBase/Firebird)&quot; on page 493.</td>
</tr>
<tr>
<td></td>
<td>Select an index and click <strong>Drop</strong> to open a dialog that lets you remove the index from the table.</td>
</tr>
<tr>
<td>Constraints</td>
<td>Lets you manage primary key, unique key, foreign key, and check constraints for a table. Constraints are grouped by type, under folders:</td>
</tr>
<tr>
<td></td>
<td>Select a constraint type folder and click <strong>Add</strong> to open a dialog that lets you add a constraint of that type.</td>
</tr>
<tr>
<td></td>
<td>Select a constraint and click <strong>Edit</strong> to open a dialog that lets you modify the constraint details.</td>
</tr>
<tr>
<td></td>
<td>Select a constraint and click <strong>Drop</strong> to remove the constraint.</td>
</tr>
<tr>
<td>Comment</td>
<td>For details on using this tab, see &quot;Adding a Comment to an object&quot; on page 450.</td>
</tr>
<tr>
<td>Permissions</td>
<td>For details on using this tab, see &quot;Working with Privileges and Permissions&quot; on page 447.</td>
</tr>
<tr>
<td>Dependencies</td>
<td>For details on using this tab, see &quot;Working with Object Dependencies&quot; on page 449.</td>
</tr>
<tr>
<td>DDL View</td>
<td>For details on using this tab, see &quot;Viewing the SQL/DDL for an Object&quot; on page 447.</td>
</tr>
</tbody>
</table>
3 When finished, you can submit your changes. For details, see "Previewing and Submitting Object Editor Changes" on page 450.

**UNIQUE KEYS EDITOR (INTERBASE/FIREBIRD)**

The Unique Keys editor lets you modify the columns that make up a unique key.

**To edit a unique key**

1. Open an editor on the unique key. For details, see "Opening an Object Editor" on page 444.

2. Use the following table as a guide to understanding and modifying the settings on the tabs of this editor:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Columns</td>
<td>Lets you manage columns that make up the unique key. On opening, this tab shows the existing columns. For each column, the listing includes the datatype and whether the table definition permits nulls. Note that only columns defined with the <strong>Allow Nulls</strong> property disabled can be added to a unique key. Optionally you can:</td>
</tr>
<tr>
<td></td>
<td>Click the <strong>New</strong> button and select a column name from the dropdown, to add a column to the unique key.</td>
</tr>
<tr>
<td></td>
<td>Select a column and click the <strong>Drop</strong> button to delete the column from the unique key.</td>
</tr>
<tr>
<td></td>
<td>Select a column and use the arrow buttons to reorder the columns in the unique key.</td>
</tr>
<tr>
<td>Properties</td>
<td>Displays the <strong>Name</strong> of the unique key and the associated <strong>Table Name</strong>.</td>
</tr>
<tr>
<td>DDL View</td>
<td>For details on using this tab, see &quot;Viewing the SQL/DDL for an Object&quot; on page 447.</td>
</tr>
</tbody>
</table>

3. When finished, you can submit your changes. For details, see "Previewing and Submitting Object Editor Changes" on page 450.

**USERS EDITOR (INTERBASE/FIREBIRD)**

The Users Editor lets you modify basic properties, assigned roles, and object permissions for a user.
To edit a user
1. Open an editor on the user. For details, see "Opening an Object Editor" on page 444.
2. Use the following table as a guide to understanding and modifying the settings on the tabs of this editor:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Properties</td>
<td>In addition to displaying the login Name for the user, this tab lets you work with the Password, Group, Default Role, First Name, Middle Name, Last Name, Active, System User Name, Description, GID, and UID properties. For details on these properties, see &quot;Users (ITB/FBD) - Properties&quot; on page 323.</td>
</tr>
<tr>
<td>Comment</td>
<td>For details on using this tab, see &quot;Adding a Comment to an object&quot; on page 450.</td>
</tr>
<tr>
<td>Roles</td>
<td>Lets you assign the valid, non-default roles that a user can specify when logging in to the database. A default login role can be assigned for this user on the Properties tab/panel. For details, see &quot;Users (ITB/FBD) - Roles&quot; on page 323. To assign roles to the user, select the associated check box.</td>
</tr>
<tr>
<td>Object Permissions</td>
<td>For details on using this tab, see &quot;Working with Privileges and Permissions&quot; on page 447.</td>
</tr>
<tr>
<td>DDL View</td>
<td>For details on using this tab, see &quot;Viewing the SQL/DDL for an Object&quot; on page 447.</td>
</tr>
</tbody>
</table>

3. When finished, you can submit your changes. For details, see "Previewing and Submitting Object Editor Changes" on page 450.

**VIEWS EDITOR (INTERBASE/FIREBIRD)**
The Views editor lets you work with the CREATE VIEW DDL for a view, grant and revoke associated permissions, and work with the view's dependencies.

To edit a view
1. Open an editor on the view. For details, see "Opening an Object Editor" on page 444.
2. Use the following table as a guide to understanding and modifying the settings on the tabs of this editor:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Properties</td>
<td>Displays the Name of the view and a listing of the associated columns. Details for each column include the column Name, the Datatype, whether or not Nulls are allowed for that column, and an associated Comment.</td>
</tr>
<tr>
<td>Comment</td>
<td>For details on using this tab, see &quot;Adding a Comment to an object&quot; on page 450.</td>
</tr>
<tr>
<td>Definition</td>
<td>Lets you view and modify the CREATE VIEW DDL for the view.</td>
</tr>
<tr>
<td>Dependencies</td>
<td>For details on using this tab, see &quot;Working with Object Dependencies&quot; on page 449.</td>
</tr>
<tr>
<td>Permissions</td>
<td>For details on using this tab, see &quot;Working with Privileges and Permissions&quot; on page 447.</td>
</tr>
</tbody>
</table>

3. When finished, you can submit your changes. For details, see "Previewing and Submitting Object Editor Changes" on page 450.
MODIFYING OBJECTS USING EDITORS

MICROSOFT SQL SERVER OBJECT EDITORS

Rapid SQL includes an Object Editor for all supported Microsoft SQL Server objects. To see an Editor for a specific object, click the corresponding link below:

- Asymmetric Keys Editor (SQL Server)
- Certificates Editor (SQL Server)
- Check Constraints Editor (SQL Server)
- Databases Editor (SQL Server)
- Database Triggers Editor (SQL Server)
- Defaults Editor (SQL Server)
- Extended Procedures Editor (SQL Server)
- Foreign Keys Editor (SQL Server)
- Full-text Catalogs Editor (SQL Server)
- Full-text Indexes Editor (SQL Server)
- Functions Editor (SQL Server)
- Indexes Editor (SQL Server)
- Logins Editor (SQL Server)
- Partition Functions Editor (SQL Server)
- Partition Schemes Editor (SQL Server)
- Primary Keys Editor (SQL Server)
- Procedures Editor (SQL Server)
- Rules Editor (SQL Server)
- Schemas Editor (SQL Server)
- Symmetric Key Editor (SQL Server)
- Synonyms Editor (SQL Server)
- Tables Editor (SQL Server)
- Triggers Editor (SQL Server)
- Unique Keys Editor (SQL Server)
- Users Editor (SQL Server)
- User Datatypes Editor (SQL Server)
- User Messages Editor (SQL Server)
MODIFYING OBJECTS USING EDITORS

- Views Editor (SQL Server)

For access to object editors for different supported DBMS platforms and an introduction to editor usage, see “Modifying objects using editors” on page 443.

ASYMMETRIC KEYS EDITOR (SQL SERVER)
The Asymmetric Keys Editor lets you view and modify asymmetric key properties.

To edit an asymmetric key
1. Open an editor on the asymmetric key. For details, see Opening an Object Editor.
2. Use the following table as a guide to understanding and modifying the settings on the tabs of this editor:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Properties</td>
<td>This tab lets you view all properties assigned when the asymmetric key was created. For more information, see “Asymmetric Keys (SQL Server) - Properties” on page 326. In addition, this tab lets you modify the following properties: Authorization Owner - the AUTHORIZATION argument. Change Encryption Mechanism - activates the Encryption Type control, letting you change the encryption method used for this certificate. Encryption Type - lets you select among encryption using the MASTER KEY, a USER_PASSWORD, or NONE. Encryption Password and Decryption Password - available if you select an Encryption Type of USER_PASSWORD, they lets you provide the specific encryption/decryption passwords.</td>
</tr>
<tr>
<td>DDL View</td>
<td>For details on using this tab, see “Viewing the SQL/DDL for an Object” on page 447.</td>
</tr>
</tbody>
</table>

3. When finished, you can submit your changes. For details, see ”Previewing and Submitting Object Editor Changes” on page 450.

CERTIFICATES EDITOR (SQL SERVER)
The Certificates Editor lets you view and modify check certificate properties.
To edit a certificate

1. Open an editor on the certificate. For details, see Opening an Object Editor.

2. Use the following table as a guide to understanding and modifying the settings on the tabs of this editor:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Properties</td>
<td>This tab lets you view all properties assigned when the certificate was created. For more information, see &quot;Certificates (SQL Server) - Properties&quot; on page 327. In addition, this tab lets you modify the following properties: Authorization Owner - the AUTHORIZATION argument. Active for Begin Dialog - the ON/OFF values for a ACTIVE FOR BEGIN_DIALOG = option. Change Encryption Mechanism - activates the Encryption Type control, letting you change the encryption method used for this certificate. Encryption Type - lets you select among encryption using the MASTER KEY, a USER_PASSWORD, or NONE. Encryption Password - available if you select an Encryption Type of USER_PASSWORD, it lets you provide the specific encryption password.</td>
</tr>
<tr>
<td>DDL View</td>
<td>For details on using this tab, see &quot;Viewing the SQL/DDL for an Object&quot; on page 447.</td>
</tr>
</tbody>
</table>

3. When finished, you can submit your changes. For details, see "Previewing and Submitting Object Editor Changes" on page 450.

CHECK CONSTRAINTS EDITOR (SQL SERVER)
The Check Constraints Editor lets you view and modify check constraints properties and edit the check constraint expression.

To edit a check constraint

1. Open an editor on the check constraint. For details, see "Opening an Object Editor" on page 444.

2. Use the following table as a guide to understanding and modifying the settings on the tabs of this editor:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Definition</td>
<td>Use the Enabled check box to enable or disable the check constraint. Use the Not For Replication check box to enable or disable the check constraint for replication. You can also edit the condition in the Check Condition box. The Table Column button opens a dialog that lets you select and paste column names into the check condition expression.</td>
</tr>
<tr>
<td>DDL View</td>
<td>For details on using this tab, see &quot;Viewing the SQL/DDL for an Object&quot; on page 447.</td>
</tr>
</tbody>
</table>

3. When finished, you can submit your changes. For details, see "Previewing and Submitting Object Editor Changes" on page 450.
Databases Editor (SQL Server)
The Databases Editor lets you manage basic properties, log and data files for a database.

To edit a database
1. Open an editor on the database. For details, see "Opening an Object Editor" on page 444.
2. Use the following table as a guide to understanding and modifying the settings on the tabs of this editor:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Options</td>
<td>Lets you work with options in the following categories:</td>
</tr>
</tbody>
</table>
| Creation Properties | Lets you choose values for the Compatible Level and Owner settings.  
NOTE: The Compatible level option sets certain database behaviors to be compatible with the specified earlier version of Microsoft® SQL Server. The compatibility level affects the behaviors in the specified database, not the entire server. To set database options for all future databases, set the database options on the model database.  
NOTE: When changing the database owner (dbo) select the check box to transfer the existing aliases of users who could act as the old dbo (including their permissions) to the new dbo. |
| Properties        | Lets you set the following properties: ANSI null default, ANSI nulls, ANSI padding, ANSI warnings, arithabort, auto create statistics, auto update statistics, auto close, auto shrink, concat null yields nul, cursor close on commit, db chaining, dbo use only, default to local cursor, merge publish, numeric roundabout, offline, published, quoted identifier, read only, recursive triggers, select into/bulkcopy/pllsort, single user, subscribed, torn page detection, and trunc log on chkpt. |
| Placement         | Displays the currently defined data files for the database. Optionally, you can:  
Select a file from the list on the left and in the Device File Properties group, modify the Size, File Growth Rate, Max Size, and Unlimited Max Size settings.  
Click the New button, provide a Device File Name for the new file, and use the other settings in the Device File Properties group to provide additional details for the file.  
Select a file from the list on the left and click Delete to remove the file. |
| Transaction Log   | Displays the currently defined transaction logs for the database. Optionally, you can:  
Select a transaction log from the list on the left and in the Log Device Properties group, modify the Size, File Growth Rate, Max Size, and Unlimited Max Size settings.  
Click the New button, provide a Device File Name for the new transaction log, and use the other settings in the Log Device Properties group to provide additional details for the transaction log.  
Select a transaction log from the list on the left and click Delete to remove the transaction log. |
| Space             | Lets you view pie charts showing the data space usage and the transaction log (if available) space usage for the database.                                                                                                                                                |
| DDL View          | For details on using this tab, see "Viewing the SQL/DDL for an Object" on page 447.                                                                                                                                   |
When finished, you can submit your changes. For details, see "Previewing and Submitting Object Editor Changes" on page 450.

DATABASE TRIGGERS EDITOR (SQL SERVER)
The Database Triggers Editor lets you enable or disable a database trigger and modify the body of the generated CREATE TRIGGER statement.

To edit a database trigger:
1. Open an editor on the database trigger. For details, see "Opening an Object Editor" on page 444.
2. Use the following table as a guide to understanding and modifying the settings on the tabs of this editor:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Properties</td>
<td>Select the Enabled check box to enable the database trigger or deselect it to disable the trigger. In addition to the name and creation date details, this tab also lets you view the Trigger Timing and Encrypted property settings you chose when creating the trigger. For details on these properties, see &quot;Database Triggers (SQL Server) - Properties&quot; on page 330.</td>
</tr>
<tr>
<td>Definition</td>
<td>Lets you modify the CREATE TRIGGER statement.</td>
</tr>
<tr>
<td>Dependencies</td>
<td>Lists referring and referenced objects potentially impacted by the change. For details, see &quot;Working with Object Dependencies&quot; on page 449.</td>
</tr>
<tr>
<td>Trigger Events</td>
<td>Lets you view the DDL events you selected to fire this trigger.</td>
</tr>
</tbody>
</table>

When finished, you can submit your changes. For details, see "Previewing and Submitting Object Editor Changes" on page 450.

DEFAULTS EDITOR (SQL SERVER)
The Defaults Editor lets you change the owner and value of a default.

To edit a default
1. Open an editor on the default. For details, see "Opening an Object Editor" on page 444.
2. Use the following table as a guide to understanding and modifying the settings on the tabs of this editor:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Properties</td>
<td>Lets you modify the Value of the Default and the owning Schema.</td>
</tr>
<tr>
<td>Dependencies</td>
<td>For details on using this tab, see &quot;Working with Object Dependencies&quot; on page 449.</td>
</tr>
<tr>
<td>DDL View</td>
<td>For details on using this tab, see &quot;Viewing the SQL/DDL for an Object&quot; on page 447.</td>
</tr>
</tbody>
</table>
3 When finished, you can submit your changes. For details, see "Previewing and Submitting Object Editor Changes" on page 450.

EXTENDED PROCEDURES EDITOR (SQL SERVER)

The Procedures Editor lets you modify the library name for an extended procedure. It also lets you work with dependencies and permissions.

NOTE: Extended Procedures are only available on the master database.

To edit an extended procedure
1 Open an editor on the extended procedure. For details, see "Opening an Object Editor" on page 444.
2 Use the following table as a guide to understanding and modifying the settings on the tabs of this editor:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Properties</td>
<td>Lets you provide a dynamic-link library (DLL) Library Name for the extended procedure.</td>
</tr>
<tr>
<td>Dependencies</td>
<td>For details on using this tab, see &quot;Working with Object Dependencies&quot; on page 449.</td>
</tr>
<tr>
<td>Permissions</td>
<td>For details on using this tab, see &quot;Working with Privileges and Permissions&quot; on page 447.</td>
</tr>
<tr>
<td>DDL View</td>
<td>For details on using this tab, see &quot;Viewing the SQL/DDL for an Object&quot; on page 447.</td>
</tr>
</tbody>
</table>

3 When finished, you can submit your changes. For details, see "Previewing and Submitting Object Editor Changes" on page 450.

FOREIGN KEYS EDITOR (SQL SERVER)

The Foreign Keys Editor lets you manage the columns and basic properties of a foreign key.

To edit a foreign key
1 Open an editor on the foreign key. For details, see "Opening an Object Editor" on page 444.
2 Use the following table as a guide to understanding and modifying the settings on the tabs of this editor:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Column Mapping</td>
<td>The existing column mapping for the foreign key is represented by selected columns in the Main Table and Referenced Table lists. Additional candidates in the Referenced Table list are indicated by enabled column check boxes. If necessary, use the Table dropdown in the Referenced Table group to choose a new table for this foreign key. Select or deselect columns in the Main Table list and Referenced Table list to form the referential constraint between the two tables.</td>
</tr>
</tbody>
</table>

3 When finished, you can submit your changes. For details, see "Previewing and Submitting Object Editor Changes" on page 450.
### FULL-TEXT CATALOGS EDITOR (SQL SERVER)

The Full-text Catalogs Editor lets you work with the basic definition and dependencies of a full-text catalog.

**To edit a full-text catalog:**

1. Open an editor on the full-text catalog. For details, see "Opening an Object Editor" on page 444.

2. Use the following table as a guide to understanding and modifying the settings on the tabs of this editor:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Properties</td>
<td>Lets you specify Enabled and Not For Replication properties. This tab also lets you select a Delete rule and an Update rule (NONE, SET NULL, SET DEFAULT, CASCADE).</td>
</tr>
<tr>
<td>DDL View</td>
<td>For details on using this tab, see &quot;Viewing the SQL/DDO for an Object&quot; on page 447.</td>
</tr>
</tbody>
</table>

3. When finished, you can submit your changes. For details, see "Previewing and Submitting Object Editor Changes" on page 450.

### FULL-TEXT INDEXES EDITOR (SQL SERVER)

The Full-text Indexes Editor lets you work with the basic definition and dependencies of a full-text index.

**To edit a full-text index:**

1. Open an editor on the full-text index. For details, see "Opening an Object Editor" on page 444.

2. Use the following table as a guide to understanding and modifying the settings on the tabs of this editor:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Properties</td>
<td>Lets you view the Parent Type, Parent Schema, Parent Name, Key Index, and Full-text Catalog Name properties for the partition scheme. It also lets you modify the Filegroup Name (SQL Server 2008 ^), Change Tracking, and Stoplist (SQL Server 2008 ^) properties. For more information on these properties, see Full-text Catalogs (SQL Server) - Properties.</td>
</tr>
<tr>
<td>Dependencies</td>
<td>For details on using this tab, see &quot;Working with Object Dependencies&quot; on page 449.</td>
</tr>
<tr>
<td>DDL View</td>
<td>For details on using this tab, see &quot;Viewing the SQL/DDO for an Object&quot; on page 447.</td>
</tr>
</tbody>
</table>

3. When finished, you can submit your changes. For details, see "Previewing and Submitting Object Editor Changes" on page 450.
To edit a full-text index:
1. Open an editor on the full-text index. For details, see "Opening an Object Editor" on page 444.
2. Use the following table as a guide to understanding and modifying the settings on the tabs of this editor:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Properties</td>
<td>Lets you view the Name, property and modify the Accent Sensitive, Default, and Authorization Owner properties. For more information on these properties, see &quot;Full-text Indexes (SQL Server) - Properties&quot; on page 335.</td>
</tr>
<tr>
<td>Dependencies</td>
<td>For details on using this tab, see &quot;Working with Object Dependencies&quot; on page 449.</td>
</tr>
<tr>
<td>DDL View</td>
<td>For details on using this tab, see &quot;Viewing the SQL/DDL for an Object&quot; on page 447.</td>
</tr>
</tbody>
</table>

3. When finished, you can submit your changes. For details, see "Previewing and Submitting Object Editor Changes" on page 450.

FUNCTIONS EDITOR (SQL SERVER)
The Functions Editor lets you view and modify function definitions and dependencies.

To edit a function
1. Open an editor on the function. For details, see "Opening an Object Editor" on page 444.
2. Use the following table as a guide to understanding and modifying the settings on the tabs of this editor:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Properties</td>
<td>Lets you modify the owning Schema of the function.</td>
</tr>
<tr>
<td>Definition</td>
<td>Lets you view and modify the dynamic-link library (DLL) or view the data definition language (DDL).</td>
</tr>
<tr>
<td>Dependencies</td>
<td>For details on using this tab, see &quot;Working with Object Dependencies&quot; on page 449.</td>
</tr>
<tr>
<td>Permissions</td>
<td>For details on using this tab, see &quot;Working with Privileges and Permissions&quot; on page 447.</td>
</tr>
</tbody>
</table>

3. When finished, you can submit your changes. For details, see "Previewing and Submitting Object Editor Changes" on page 450.

INDEXES EDITOR (SQL SERVER)
The Indexes Editor lets you manage columns and basic properties of an index and view index statistics.
To edit an index
1. Open an editor on the index. For details, see "Opening an Object Editor" on page 444.
2. Use the following table as a guide to understanding and modifying the settings on the tabs of this editor:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Columns</td>
<td>Lets you manage columns that make up the index. On opening, this tab shows the existing columns. For each column, the datatype (and if applicable the precision in brackets) and whether the table definition permits nulls in the target table column. Optionally you can:</td>
</tr>
<tr>
<td></td>
<td>Change the Sort order of a column.</td>
</tr>
<tr>
<td></td>
<td>Click the New button and select a column name from the dropdown, to add a column to the index.</td>
</tr>
<tr>
<td></td>
<td>Select a column and click the Drop button to delete the column from the index.</td>
</tr>
<tr>
<td></td>
<td>Select a column and use the arrow buttons to reorder the columns in the index.</td>
</tr>
<tr>
<td>Properties</td>
<td>Lets you work with settings in the following categories:</td>
</tr>
<tr>
<td>Creation</td>
<td>In addition to displaying identifying information, you can modify the Build Online and Max degree of parallelism properties. For details on these properties, see <em>Indexes Wizard (SQL Server)</em> on page 336.</td>
</tr>
<tr>
<td>Attributes</td>
<td>Lets you set Index Type, Clustered, Ignore Duplicate Key (for Index Type of UNIQUE), Statistics Recompute, Allow Row Locks, and Allow Page Locks properties. For details on these properties, see <em>Indexes Wizard (SQL Server)</em> on page 336.</td>
</tr>
<tr>
<td></td>
<td>NOTE: You cannot reorganize an index (primary key, or unique key) that has an Allow Page Locks property set to FALSE. For information on reorganizing indexes, see <em>Reorganize (SQL Server indexes, primary keys, and unique keys)</em> on page 665.</td>
</tr>
<tr>
<td>Storage</td>
<td>Lets you set Partitioned, Partition Scheme, Partition Column, Fill Factor, File Group, Pad Index, and Sort in Tempdb settings.</td>
</tr>
<tr>
<td>Statistics</td>
<td>Lets you view statistics in the following categories:</td>
</tr>
<tr>
<td>Page Statistics</td>
<td>Data Pages, Reserved Pages, Used Pages, and Total Pages Modified.</td>
</tr>
<tr>
<td>Row Statistics</td>
<td>Maximum Row Size, Minimum Row Size, Max Size of Non-Leaf Index Row, and Total Rows Modified.</td>
</tr>
<tr>
<td>DDL View</td>
<td>For details on using this tab, see &quot;Viewing the SQL/DDL for an Object&quot; on page 447.</td>
</tr>
</tbody>
</table>
3. When finished, you can submit your changes. For details, see "Previewing and Submitting Object Editor Changes" on page 450.

Logins Editor (SQL Server)
The Logins Editor lets you manage basic properties for a login, associated users and roles, and accounting.
To edit a login:
1. Open an editor on the login. For details, see "Opening an Object Editor" on page 444.
2. Use the following table as a guide to understanding and modifying the settings on the tabs of this editor:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Properties</td>
<td>Lets you view or modify the following properties set when creating the login: Name, Default Database, Default Language, Password, Check Policy, Check Expiration, Must Change, Certificate, and Asymmetric Key. For detailed information on these settings, see &quot;Logins Wizard (SQL Server)&quot; on page 338. In addition, when editing an existing login, you have access to the following settings: Currently Logged In Displays whether the user is currently logged in. Enabled Enabled, an ALTER LOGIN... ENABLE is submitted following the CREATE LOGIN statement issued by the editor. Disabled, an ALTER LOGIN... DISABLE is submitted. Server Roles Lets you add the login as a member of one or more fixed server roles. For more information, see &quot;Logins (SQL Server) - Server Roles&quot; on page 340. Users Lets you add and remove user accounts for this login to specified databases. For more detailed information, see &quot;Logins (SQL Server) - Users&quot; on page 340. DDL For details on using this tab, see &quot;Viewing the SQL/DDL for an Object&quot; on page 447.</td>
</tr>
<tr>
<td>Dependencies</td>
<td>For details on using this tab, see &quot;Working with Object Dependencies&quot; on page 449.</td>
</tr>
<tr>
<td>DDL View</td>
<td>For details on using this tab, see &quot;Viewing the SQL/DDL for an Object&quot; on page 447.</td>
</tr>
</tbody>
</table>

3. When finished, you can submit your changes. For details, see "Previewing and Submitting Object Editor Changes" on page 450.

PARTITION FUNCTIONS EDITOR (SQL SERVER)
The Partition Functions Editor lets you view the basic definition and work with dependencies of a partition function.

To edit a partition function:
1. Open an editor on the partition function. For details, see "Opening an Object Editor" on page 444.
2. Use the following table as a guide to understanding and modifying the settings on the tabs of this editor:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Properties</td>
<td>Lets you view the Name, Input Parameter Type, Range, and Function Values properties for the partition function. For more information on these properties, see &quot;Partition Functions (SQL Server) - Properties&quot; on page 341.</td>
</tr>
<tr>
<td>Dependencies</td>
<td>For details on using this tab, see &quot;Working with Object Dependencies&quot; on page 449.</td>
</tr>
<tr>
<td>DDL View</td>
<td>For details on using this tab, see &quot;Viewing the SQL/DDL for an Object&quot; on page 447.</td>
</tr>
</tbody>
</table>
3 When finished, you can submit your changes. For details, see "Previewing and Submitting Object Editor Changes" on page 450.

PARTITION SCHEMES EDITOR (SQL SERVER)
The Partition Schemes Editor lets you view the basic definition and work with dependencies of a partition scheme.

To edit a partition scheme:
1 Open an editor on the partition scheme. For details, see "Opening an Object Editor" on page 444.
2 Use the following table as a guide to understanding and modifying the settings on the tabs of this editor:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Properties</strong></td>
<td>Lets you view the Name, Partition Function, and Filegroup Name properties for the partition scheme. For more information on these properties, see &quot;Partition Schemes (SQL Server) - Properties&quot; on page 342.</td>
</tr>
<tr>
<td><strong>Dependencies</strong></td>
<td>For details on using this tab, see &quot;Working with Object Dependencies&quot; on page 449.</td>
</tr>
<tr>
<td><strong>DDL View</strong></td>
<td>For details on using this tab, see &quot;Viewing the SQL/DDL for an Object&quot; on page 447.</td>
</tr>
</tbody>
</table>

3 When finished, you can submit your changes. For details, see "Previewing and Submitting Object Editor Changes" on page 450.

PRIMARY KEYS EDITOR (SQL SERVER)
The Primary Keys Editor lets you manage the columns and basic properties for a primary key and lets you view page and row statistics.
To edit a primary key

1. Open an editor on the primary key. For details, see "Opening an Object Editor" on page 444.

2. Use the following table as a guide to understanding and modifying the settings on the tabs of this editor:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Columns</td>
<td>Lets you manage columns that make up the primary key. On opening, this tab shows the existing columns. For each column, the listing shows the datatype (and if applicable the precision in brackets) and whether the table definition permits nulls in the target table column. Optionally you can:</td>
</tr>
<tr>
<td></td>
<td>Change the Sort order of a column.</td>
</tr>
<tr>
<td></td>
<td>Click the New button and select a column name from the dropdown, to add a column to the primary key.</td>
</tr>
<tr>
<td></td>
<td>Select a column and click the Drop button to delete the column from the primary key.</td>
</tr>
<tr>
<td></td>
<td>Select a column and use the arrow buttons to reorder the columns in the primary key.</td>
</tr>
<tr>
<td>Properties</td>
<td>Lets you work with settings in the following categories:</td>
</tr>
<tr>
<td>Creation</td>
<td>In addition to displaying identifying information, you can modify the Build Online and Max degree of parallelism properties. For details on these properties, see &quot;Primary Keys Wizard (SQL Server)&quot; on page 342.</td>
</tr>
<tr>
<td>Attributes</td>
<td>Clustered - Indicates whether the target primary key is clustered.</td>
</tr>
<tr>
<td></td>
<td>Ignore Duplicate Key - Indicates whether the target primary key ignores duplicate key values. If you select this option, the transaction that generated the duplicate key values can continue.</td>
</tr>
<tr>
<td></td>
<td>Statistics Recompute - Indicates that index statistics are automatically recomputed as the index is updated. Microsoft does not recommend this.</td>
</tr>
<tr>
<td>Storage</td>
<td>File Group - Lets you select a file group.</td>
</tr>
<tr>
<td></td>
<td>Fill Factor - Lets you specify the fill factor that specifies how full each index page can be. If no fill factor is specified, Microsoft SQL Server uses the database’s default fill factor.</td>
</tr>
<tr>
<td></td>
<td>Pad Index - If you specified a Fill factor of more than 0 percent, and you selected the option to create a unique index, you can specify to use the same percentage you specified in Fill Factor as the space to leave open on each interior node. By default, Microsoft SQL Server sets a 2 row index size.</td>
</tr>
<tr>
<td>Statistics</td>
<td>Lets you view statistics in the following categories:</td>
</tr>
<tr>
<td>Page Statistics</td>
<td>Data Pages, Reserved Pages, Used Pages, and Total Pages Modified.</td>
</tr>
<tr>
<td>Row Statistics</td>
<td>Maximum Row Size, Minimum Row Size, Max Size of Non-Leaf Index Row, and Total Rows Modified.</td>
</tr>
<tr>
<td>DDL View</td>
<td>For details on using this tab, see &quot;Viewing the SQL/DDL for an Object&quot; on page 447.</td>
</tr>
</tbody>
</table>

3. When finished, you can submit your changes. For details, see "Previewing and Submitting Object Editor Changes" on page 450.
MODIFYING OBJECTS USING EDITORS

PROCEDURES EDITOR (SQL SERVER)
The Procedures Editor lets you manage properties, the definition, dependencies, and permissions for a procedure.

To edit a procedure
1. Open an editor on the procedure. For details, see "Opening an Object Editor" on page 444.
2. Use the following table as a guide to understanding and modifying the settings on the tabs of this editor:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Properties</td>
<td>Lets you change the owning <strong>Schema</strong>.</td>
</tr>
<tr>
<td>Definition</td>
<td>Lets you view the SQL code for the procedure.</td>
</tr>
<tr>
<td>Dependencies</td>
<td>For details on using this tab, see &quot;Working with Object Dependencies&quot; on page 449.</td>
</tr>
<tr>
<td>Permissions</td>
<td>For details on using this tab, see &quot;Working with Privileges and Permissions&quot; on page 447.</td>
</tr>
</tbody>
</table>

3. When finished, you can submit your changes. For details, see "Previewing and Submitting Object Editor Changes" on page 450.

ROLES EDITOR (SQL SERVER)
The Roles Editor lets you manage the users for a role.

To edit a role
1. Open an editor on the role. For details, see "Opening an Object Editor" on page 444.
2. Use the following table as a guide to understanding and modifying the settings on the tabs of this editor:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Properties</td>
<td>Displays the <strong>Name</strong>, and either a <strong>Role Type</strong> of STANDARD and an <strong>Authorization Owner</strong> or a <strong>Role Type</strong> of APPLICATION and a <strong>Password</strong>.</td>
</tr>
<tr>
<td>Users</td>
<td>Let you manage users for the role. A user becomes associated with an application role after running the target application. Use the <strong>Join Rule</strong> and <strong>Leave Role</strong> buttons to move users between the <strong>Users In Role</strong> and <strong>Users Not In Role</strong> lists.</td>
</tr>
<tr>
<td>Object Privileges and System Privileges</td>
<td>For details on using these tabs, see &quot;Working with Privileges and Permissions&quot; on page 447.</td>
</tr>
<tr>
<td>DDL View</td>
<td>For details on using this tab, see &quot;Viewing the SQL/DDL for an Object&quot; on page 447.</td>
</tr>
</tbody>
</table>

3. When finished, you can submit your changes. For details, see "Previewing and Submitting Object Editor Changes" on page 450.
RULES EDITOR (SQL SERVER)
The Rules Editor lets you view or modify basic properties of a rule.

To edit a rule
1. Open an editor on the rule. For details, see "Opening an Object Editor" on page 444.
2. Use the following table as a guide to understanding and modifying the settings on the tabs of this editor:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Properties</td>
<td>Lets you specify whether the rule is <strong>Enabled</strong> and view the <strong>Fire On Insert</strong>, <strong>Fire On Update</strong>, <strong>Fire On Delete</strong>, and <strong>Encrypted</strong> settings.</td>
</tr>
<tr>
<td>Definition</td>
<td>Lets you view and modify the SQL code that will implement any changes you make using this editor.</td>
</tr>
<tr>
<td>Dependencies</td>
<td>For details on using this tab, see &quot;Working with Object Dependencies&quot; on page 449.</td>
</tr>
</tbody>
</table>

3. When finished, you can submit your changes. For details, see "Previewing and Submitting Object Editor Changes" on page 450.

SCHEMAS EDITOR (SQL SERVER)
The Schemas Editor lets you change the owner of a group and manage the objects contained in the schema.

To edit a user
1. Open an editor on the user. For details, see "Opening an Object Editor" on page 444.
2. Use the following table as a guide to understanding and modifying the settings on the tabs of this editor:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Properties</td>
<td>Lets you modify the <strong>Owner</strong> of the schema.</td>
</tr>
<tr>
<td>Permissions</td>
<td>For details on using this tab, see &quot;Working with Privileges and Permissions&quot; on page 447.</td>
</tr>
<tr>
<td>Objects</td>
<td>Displays the specific objects owned by the schema, grouped under object type folders. Optionally, you can:</td>
</tr>
<tr>
<td>DDL View</td>
<td>For details on using this tab, see &quot;Viewing the SQL/DDL for an Object&quot; on page 447.</td>
</tr>
</tbody>
</table>

3. When finished, you can submit your changes. For details, see "Previewing and Submitting Object Editor Changes" on page 450.
SYMMETRIC KEY EDITOR (SQL SERVER)
The Symmetric Key Editor lets you view creation details for a key and modify its encryption mechanisms.

To edit a symmetric key:
1. Open an editor on the symmetric key. For details, see "Opening an Object Editor" on page 444.
2. Use the following table as a guide to understanding and modifying the settings on the tabs of this editor:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Properties</td>
<td>Lets you view the Authorization Owner, Name, Create Date, Update Date, Provider Name, Key Algorithm, and Key Length properties. For more information, see &quot;Symmetric Keys (SQL Server) - Properties&quot; on page 348.</td>
</tr>
<tr>
<td>Encryption Mechanisms</td>
<td>Lets you manage the encryption mechanisms for this key. For detailed instructions, see &quot;Symmetric Keys (SQL Server) - Properties&quot; on page 348.</td>
</tr>
<tr>
<td>DDL View</td>
<td>For details on using this tab, see &quot;Viewing the SQL/DDL for an Object&quot; on page 447.</td>
</tr>
</tbody>
</table>

3. When finished, you can submit your changes. For details, see "Previewing and Submitting Object Editor Changes" on page 450.

SYNONYMS EDITOR (SQL SERVER)
The Synonyms Editor lets you view the basic definition and work with dependencies of a partition scheme.

To edit a synonym:
1. Open an editor on the synonym. For details, see "Opening an Object Editor" on page 444.
2. Use the following table as a guide to understanding and modifying the settings on the tabs of this editor:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Properties</td>
<td>Lets you view the Schema, Name, Server, Database, Referenced Object Type, Referenced Object Owner, and Referenced Object Name properties for the synonym. For more information on these properties, see &quot;Synonyms (SQL Server) - Properties&quot; on page 351. This tab also includes a CreateDate property showing the data and time the synonym was created.</td>
</tr>
<tr>
<td>Dependencies</td>
<td>For details on using this tab, see &quot;Working with Object Dependencies&quot; on page 449.</td>
</tr>
<tr>
<td>DDL View</td>
<td>For details on using this tab, see &quot;Viewing the SQL/DDL for an Object&quot; on page 447.</td>
</tr>
</tbody>
</table>

3. When finished, you can submit your changes. For details, see "Previewing and Submitting Object Editor Changes" on page 450.
TABLES EDITOR (SQL SERVER)
The Tables Editor lets you manage columns, basic properties, indexes, and constraints for a table and view space usage details.

To edit a table
1. Open an editor on the table. For details, see "Opening an Object Editor" on page 444.
2. Use the following table as a guide to understanding and modifying the settings on the tabs of this editor:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Columns</td>
<td>Displays the currently defined columns in the table. Optionally, you can: Select a column, and in the Property/Value list modify property values for that column. Click Add Column, provide a name for the new column, and set property values for the column. Select a column and click Delete to remove the column from the table.</td>
</tr>
<tr>
<td>Properties</td>
<td>Lets you work with settings in the following categories:</td>
</tr>
<tr>
<td>Physical Storage</td>
<td>Lets you view the Partitioned and Partition Scheme properties. Lets you specify a Filegroup and Text Image Filegroup. This is only available for Microsoft SQL Server 7.0 and later.</td>
</tr>
<tr>
<td>Full-Text Index</td>
<td>Lets you view whether Full-Text Indexing is installed and active. The full-text index feature provides support for sophisticated word searches in character string data. A full-text index stores information about significant words and their location within a given column. This information is used to quickly complete full-text queries that search for rows with particular words or combinations of words. This feature is available for Microsoft SQL Server 8.0 or later.</td>
</tr>
<tr>
<td>Text In Row</td>
<td>Lets you enable Text In Row Data and specify a limit.</td>
</tr>
<tr>
<td>Indexes</td>
<td>Displays any indexes currently defined for the table. Optionally, you can: Click Add to open an Index editor, letting you create a new index for this table. For more information, see &quot;Indexes Wizard (SQL Server)&quot; on page 336. Select an index and click Edit to open an wizard that lets you modify that index. For more information, see &quot;Indexes Editor (SQL Server)&quot; on page 507. Select an index and click Drop to open a dialog that lets you confirm that you want to drop the index. When dropping an index with the Clustered option enabled, the confirmation dialog includes an Online option that lets you specify an online drop (ONLINE-ON clause).</td>
</tr>
</tbody>
</table>
### MODIFYING OBJECTS USING EDITORS

<table>
<thead>
<tr>
<th>Tab</th>
<th>Settings and tasks</th>
</tr>
</thead>
</table>
| Constraints | Lets you manage constraints for the table. Constraints are grouped by type, under folders. Optionally take one of the following actions:  
- Select a constraint type folder and click **Add** to open a dialog that lets you add a constraint of that type.  
- Select a constraint and click **Edit** to open a dialog that lets you modify the constraint details.  
- Select a constraint and click **Drop** to open a dialog that lets you confirm that you want to drop the index. When dropping a clustered unique key or clustered primary key, the confirmation dialog includes an **Online** option that lets you specify an online drop (ONLINE-ON clause). |
| Space       | Lets you view pie charts showing the space usage for the table. Optionally you can double-click a slice in the pie chart for detailed statistics. |
| Dependencies| For details on using this tab, see "Working with Object Dependencies" on page 449. |
| Permissions | For details on using this tab, see "Working with Privileges and Permissions" on page 447. |
| DDL View    | For details on using this tab, see "Viewing the SQL/DDL for an Object" on page 447. |

3. When finished, you can submit your changes. For details, see "Previewing and Submitting Object Editor Changes" on page 450.

### TRIGGERS EDITOR (SQL SERVER)

The Triggers Editor lets you enable and disable a trigger, view and modify the CREATE TRIGGER statement that will implement changes, and manage dependencies.

**To edit a trigger**

1. Open an editor on the trigger. For details, see "Opening an Object Editor" on page 444.

2. Use the following table as a guide to understanding and modifying the settings on the tabs of this editor:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Properties</td>
<td>Lets you set the <strong>Enabled</strong> property. It also lets you view the <strong>Trigger Timing</strong> (AFTER, INSTEAD OF), <strong>Fire On Insert</strong>, <strong>Fire On Update</strong>, <strong>Fire On Delete</strong>, and <strong>Encrypted</strong> properties.</td>
</tr>
<tr>
<td>Definition</td>
<td>Lets you modify the CREATE TRIGGER body for a trigger. To modify a trigger, edit the text of the trigger body in the Trigger Text area. Rapid SQL must drop then create the trigger.</td>
</tr>
<tr>
<td>Dependencies</td>
<td>For details on using this tab, see &quot;Working with Object Dependencies&quot; on page 449.</td>
</tr>
</tbody>
</table>

3. When finished, you can submit your changes. For details, see "Previewing and Submitting Object Editor Changes" on page 450.
**UNIQUE KEYS EDITOR (SQL SERVER)**

The Unique Keys Editor lets you manage columns and properties for a unique key and view associated statistics.

### To edit a unique key

1. Open an editor on the unique key. For details, see "Opening an Object Editor" on page 444.

2. Use the following table as a guide to understanding and modifying the settings on the tabs of this editor:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Columns</td>
<td>Lets you manage columns that make up the unique key. On opening, this tab shows the existing columns. For each column, the listing displays the datatype (and if applicable the precision in brackets) and whether the table definition permits nulls in the target table column. Optionally you can:</td>
</tr>
<tr>
<td></td>
<td>Change the <strong>Sort</strong> order of a column.</td>
</tr>
<tr>
<td></td>
<td>Click the <strong>New</strong> button and select a column name from the dropdown, to add a column to the index.</td>
</tr>
<tr>
<td></td>
<td>Select a column and click the <strong>Drop</strong> button to delete the column from the index.</td>
</tr>
<tr>
<td></td>
<td>Select a column and use the arrow buttons to reorder the columns in the index.</td>
</tr>
<tr>
<td>Properties</td>
<td>Lets you work with settings in the following categories:</td>
</tr>
<tr>
<td>Creation</td>
<td>In addition to displaying identifying information, you can modify the <strong>Build Online</strong> and <strong>Max degree of parallelism</strong> properties. For details on these properties, see &quot;Unique Keys Wizard (SQL Server)&quot; on page 355.</td>
</tr>
<tr>
<td>Attributes</td>
<td><strong>Clustered</strong> - Indicates whether the target index is clustered.</td>
</tr>
<tr>
<td></td>
<td><strong>Ignore Duplicate Key</strong> - Indicates whether the target primary key ignores duplicate key values. If you select his option, the transaction that generated the duplicate key values can continue.</td>
</tr>
<tr>
<td></td>
<td><strong>Statistics Recompute</strong> - Indicates that index statistics are automatically recomputed as the index is updated. Microsoft does not recommend this.</td>
</tr>
<tr>
<td>Storage</td>
<td><strong>File Group</strong> - Lets you specify the filegroup on which to place the index. This is for Microsoft SQL Server 7.0 or later.</td>
</tr>
<tr>
<td></td>
<td><strong>Fill Factor</strong> - Lets you specify a percentage that indicates how full Microsoft SQL Server should make the leaf level of each index page during index creation. When an index page fills up, Microsoft SQL Server must take time to split the index page to make room for new rows, which is quite expensive. For update-intensive tables, a properly chosen Fill factor value yields better update performance than an improper Fill factor value.</td>
</tr>
<tr>
<td></td>
<td><strong>Pad Index</strong> - If you specified a Fill factor of more than 0 percent, and you selected the option to create a unique index, you can specify to use the same percentage you specified in Fill Factor as the space to leave open on each interior node. By default, Microsoft SQL Server sets a 2 row index size.</td>
</tr>
</tbody>
</table>
When finished, you can submit your changes. For details, see "Previewing and Submitting Object Editor Changes" on page 450.

**Users Editor (SQL Server)**

The Users Editor lets you manage properties, assign roles, and manage object bindings for a user.

**To edit a user**

1. Open an editor on the user. For details, see "Opening an Object Editor" on page 444.

2. Use the following table as a guide to understanding and modifying the settings on the tabs of this editor:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Properties</strong></td>
<td>Lets you view the <strong>Without Login</strong>, <strong>Login Name</strong>, <strong>Name</strong>, <strong>User Type</strong>, <strong>Certificate</strong>, <strong>Asymmetric Key</strong>, and <strong>Default Schema</strong> properties.</td>
</tr>
<tr>
<td><strong>Roles</strong></td>
<td>Lets you assign roles to a user by selecting the check boxes associated with the roles to be assigned.</td>
</tr>
<tr>
<td><strong>Objects</strong></td>
<td>Lets you manage database objects (Defaults, Indexes, Procedures, Rules, Tables, Triggers, User Datatypes, Views) associated with the user. Objects are organized in a tree structure with folders containing the objects. Optionally, take one of the following actions:</td>
</tr>
<tr>
<td></td>
<td>Select an object and click <strong>Edit</strong> to open an object editor on the selected object. For information on each editor, use the links in &quot;Microsoft SQL Server Object Editors&quot; on page 500.</td>
</tr>
<tr>
<td></td>
<td>Select an object and click <strong>Drop</strong> to initiate dropping the selected object.</td>
</tr>
<tr>
<td><strong>Object Permissions</strong> and <strong>System Permissions</strong></td>
<td>For details on using these tabs, see &quot;Working with Privileges and Permissions&quot; on page 447.</td>
</tr>
<tr>
<td><strong>DDL View</strong></td>
<td>For details on using this tab, see &quot;Viewing the SQL/DDL for an Object&quot; on page 447.</td>
</tr>
</tbody>
</table>

When finished, you can submit your changes. For details, see "Previewing and Submitting Object Editor Changes" on page 450.
USER DATATYPES EDITOR (SQL SERVER)
The User Datatypes Editor lets you modify the base datatype, rule and default bindings, and referencing or referenced objects for a user datatype.

To edit a user datatype
1. Open an editor on the user datatype. For details, see "Opening an Object Editor" on page 444.
2. Use the following table as a guide to understanding and modifying the settings on the tabs of this editor:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Properties</td>
<td>In addition to letting you change the Schema, this tab lets you work with settings in the following categories:</td>
</tr>
<tr>
<td></td>
<td><strong>Base Datatype</strong></td>
</tr>
<tr>
<td></td>
<td><strong>Bindings</strong></td>
</tr>
<tr>
<td>Usage</td>
<td>Lets you manage database objects referencing or referenced by a user datatype. Objects are grouped within object type folders. Optionally, you can:</td>
</tr>
<tr>
<td></td>
<td>Edit to open an object editor on the selected object.</td>
</tr>
<tr>
<td></td>
<td>Drop to initiate dropping the selected object.</td>
</tr>
<tr>
<td>DDL View</td>
<td>For details on using this tab, see &quot;Viewing the SQL/DDL for an Object&quot; on page 447.</td>
</tr>
</tbody>
</table>

3. When finished, you can submit your changes. For details, see "Previewing and Submitting Object Editor Changes" on page 450.

USER MESSAGES EDITOR (SQL SERVER)

**NOTE:** User Messages are only on the master database.

The User Messages Editor lets you view or modify basic properties of a user message. It also lets you add, edit, or delete individual language versions of the message.
MODIFYING OBJECTS USING EDITORS

To edit a user message

1. Open an editor on the user message. For details, see "Opening an Object Editor" on page 444.

2. Use the following table as a guide to understanding and modifying the settings on the tabs of this editor:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Properties</td>
<td>Lets you work with the following properties:</td>
</tr>
<tr>
<td>Message Number</td>
<td>Displays the message number chosen when the user message was created.</td>
</tr>
<tr>
<td>Severity</td>
<td>Lets you modify the SQL Server error severity level (001-025).</td>
</tr>
<tr>
<td>Write to NT Event Log</td>
<td>Lets you specify that the message is always written to the Windows NT Event Log.</td>
</tr>
<tr>
<td>Information</td>
<td>Displays the currently-defined language versions for this message number. Optionally you can:</td>
</tr>
<tr>
<td></td>
<td>Create a new language version for this message number. Click the Add new text for the user message button, and in the dialog box that opens, select a Language and provide the Message Text.</td>
</tr>
<tr>
<td></td>
<td>Select a language version of the message and click the Modify user message text button. This opens a dialog that lets you modify the Language or Message Text.</td>
</tr>
<tr>
<td></td>
<td>Select a language version of the message and click the Remove user message text button.</td>
</tr>
<tr>
<td></td>
<td>NOTE: You cannot create two versions of a message for the same language.</td>
</tr>
<tr>
<td></td>
<td>NOTE: For a given message number there should always be a least one, us_english version of the message.</td>
</tr>
<tr>
<td>DDL View</td>
<td>For details on using this tab, see &quot;Viewing the SQL/DDL for an Object&quot; on page 447.</td>
</tr>
</tbody>
</table>

3. When finished, you can submit your changes. For details, see "Previewing and Submitting Object Editor Changes" on page 450.

VIEWS EDITOR (SQL SERVER)
The Views Editor lets you view columns and change the schema of a view.

To edit a view

1. Open an editor on the view. For details, see "Opening an Object Editor" on page 444.

2. Use the following table as a guide to understanding and modifying the settings on the tabs of this editor:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Properties</td>
<td>Displays a list of the columns that make up the view. Details include the column Name, its Datatype, and whether the definition allows Nulls. This tab also lets you change the Schema owning the view.</td>
</tr>
</tbody>
</table>
MODIFYING OBJECTS USING EDITORS

3. When finished, you can submit your changes. For details, see "Previewing and Submitting Object Editor Changes" on page 450.

MYSQL EDITORS

Rapid SQL includes an Object Editor for all supported MySQL objects. To see an Editor for a specific object, click the corresponding link below:

- Database editor (MySQL)
- Foreign Keys editor (MySQL)
- Functions editor (MySQL)
- Indexes, Primary Keys, and Unique Keys editors (MySQL)
- Tables editor (MySQL)
- Users editor (MySQL)

For access to object editors for different supported DBMS platforms and an introduction to editor usage, see “Modifying objects using editors” on page 443.

DATABASE EDITOR (MYSQL)

The Databases Editor lets you manage basic properties and privileges for a database.

To edit a database:

1. Open an editor on the database. For details, see "Opening an Object Editor" on page 444.

2. Use the following table as a guide to understanding and modifying the settings on the tabs of this editor:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Properties</td>
<td>Lets you modify the <strong>Default Character Set</strong> and <strong>Collation</strong> properties. For details on these properties, see <strong>Databases - Properties</strong>.</td>
</tr>
<tr>
<td>Privileges</td>
<td>For details on using this tab, see &quot;Working with Privileges and Permissions&quot; on page 447.</td>
</tr>
<tr>
<td>DDL View</td>
<td>For details on using this tab, see &quot;Viewing the SQL/DDL for an Object&quot; on page 447.</td>
</tr>
</tbody>
</table>

3. When finished, you can submit your changes. For details, see "Previewing and Submitting Object Editor Changes" on page 450.
FOREIGN KEYS EDITOR (MySQL)
The Foreign Keys Editor lets you manage column mapping, delete, and update actions for a foreign key.

To edit a foreign key:
1. Open an editor on the foreign key. For details, see "Opening an Object Editor" on page 444.
2. Use the following table as a guide to understanding and modifying the settings on the tabs of this editor:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Column Mapping</td>
<td>The existing column mapping for the foreign key is represented by selected columns in the Main Table and Referenced Table lists. Additional candidates in the Referenced Table list are indicated by enabled column check boxes. If necessary, use the Table dropdown in the Referenced Table group to choose a new table for this foreign key. Select or deselect columns in the Main Table list and Referenced Table list to form the referential constraint between the two tables.</td>
</tr>
<tr>
<td>Properties</td>
<td>Lets you modify the On Delete and On Update (NO ACTION, RESTRICT, CASCADE, SET NULL) reference options.</td>
</tr>
<tr>
<td>DDL View</td>
<td>For details on using this tab, see &quot;Viewing the SQL/DDL for an Object&quot; on page 447.</td>
</tr>
</tbody>
</table>

3. When finished, you can submit your changes. For details, see "Previewing and Submitting Object Editor Changes" on page 450.

FUNCTIONS EDITOR (MySQL)
The MySQL Functions editor lets you view properties of a basic function declaration.

To edit a function:
1. Open an editor on the function. For details, see "Opening an Object Editor" on page 444.
2. Use the following table as a guide to understanding and modifying the settings on the tabs of this editor:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Properties</td>
<td>Lets you view the Function Name, Return Type, and Shared Object Library properties. For details on these properties, see &quot;Functions - Properties&quot; on page 362. Under Specify Columns in Index, you can change the selection of columns that make up the index, primary key, or unique key.</td>
</tr>
<tr>
<td>DDL View</td>
<td>For details on using this tab, see &quot;Viewing the SQL/DDL for an Object&quot; on page 447.</td>
</tr>
</tbody>
</table>

3. When finished, you can submit your changes. For details, see "Previewing and Submitting Object Editor Changes" on page 450.
INDEXES, PRIMARY KEYS, AND UNIQUE KEYS EDITORS (MySQL)
These editors lets you manage columns and view properties of an index, primary key, or unique key.

To edit an index:
1. Open an editor on the index. For details, see "Opening an Object Editor" on page 444.
2. Use the following table as a guide to understanding and modifying the settings on the tabs of this editor:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Properties</td>
<td>Lets you view the <strong>Table Name</strong>, <strong>Index Name</strong>, <strong>Constraint Type</strong>, and <strong>Index Type</strong> properties. For details on these properties, see &quot;Indexes, Primary Keys, or Unique Keys - Properties&quot; on page 363. Under <strong>Specify Columns</strong> in Index, you can change the selection of columns that make up the index, primary key, or unique key.</td>
</tr>
<tr>
<td>DDL View</td>
<td>For details on using this tab, see &quot;Viewing the SQL/DDL for an Object&quot; on page 447.</td>
</tr>
</tbody>
</table>

3. When finished, you can submit your changes. For details, see "Previewing and Submitting Object Editor Changes" on page 450.

TABLES EDITOR (MySQL)
The MySQL Tables editor lets you modify basic properties and view usage statistics for a MySQL table.

To edit a table:
1. Open an editor on the index. For details, see "Opening an Object Editor" on page 444.
2. Use the following table as a guide to understanding and modifying the settings on the tabs of this editor:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Columns</td>
<td>Displays the currently defined columns in the table. Optionally, you can:</td>
</tr>
<tr>
<td></td>
<td>Select a column, and in the <strong>Property/Value</strong> list modify property values for that column.</td>
</tr>
<tr>
<td></td>
<td>Click <strong>Add Column</strong>, provide a name for the new column, and set property values for the column.</td>
</tr>
<tr>
<td></td>
<td>Select a column and click <strong>Delete</strong> to remove the column from the table.</td>
</tr>
<tr>
<td>Properties</td>
<td>Lets you work with the following settings: <strong>Table Name</strong>, <strong>Storage Type</strong>, <strong>Row Format</strong>, <strong>Default Character Set</strong>, <strong>Default Collation</strong>, <strong>Auto Increment</strong>, <strong>Comment</strong>, <strong>Min Rows</strong>, <strong>Max Rows</strong>, <strong>Average Row Length</strong>, <strong>Pack Keys</strong>, <strong>Checksum</strong>, and <strong>Delay Key Write</strong>. For details on these properties, see &quot;Tables - Properties&quot; on page 364.</td>
</tr>
<tr>
<td>Indexes</td>
<td>Lets you add, delete, or modify table indexes. For details on available options, see &quot;Tables - Indexes&quot; on page 365.</td>
</tr>
</tbody>
</table>
MODIFYING OBJECTS USING EDITORS

When finished, you can submit your changes. For details, see "Previewing and Submitting Object Editor Changes" on page 450.

USERS EDITOR (MySQL)
The MySQL Functions editor lets you work with basic properties, host details, and privileges for a user.

To edit a user:
1 Open an editor on the user. For details, see "Opening an Object Editor" on page 444.
2 Use the following table as a guide to understanding and modifying the settings on the tabs of this editor:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Foreign Keys</td>
<td>For INNODB tables, this tab lets you add, delete, or modify table foreign keys. For details on available options, see &quot;Tables - Foreign Keys&quot; on page 365.</td>
</tr>
<tr>
<td>MERGE tables</td>
<td>For MRG_MyISAM tables, this tab lets you work with the collection of identical MyISAM tables that are to be used as a single table. For more information, see &quot;Tables - MERGE Tables&quot; on page 366.</td>
</tr>
<tr>
<td>Privileges</td>
<td>For details on using this tab, see &quot;Working with Privileges and Permissions&quot; on page 447.</td>
</tr>
<tr>
<td>Space</td>
<td>Lets you view graphical and numerical table usage statistics. Values include Data Length, Index Length, Data Free, Max Data Length, Rows, and Average Row Length.</td>
</tr>
<tr>
<td>DDL View</td>
<td>For details on using this tab, see &quot;Viewing the SQL/DDL for an Object&quot; on page 447.</td>
</tr>
</tbody>
</table>

3 When finished, you can submit your changes. For details, see "Previewing and Submitting Object Editor Changes" on page 450.

Tab                        | Settings and tasks                                                                 |
----------------------------|-----------------------------------------------------------------------------------|
User Information            | Lets you view the User Name property and lets you modify the Full Name, Description, Email, and Contact Information properties. For details on these properties, see "Users wizard (MySQL)" on page 366. |
User Hosts                  | Add a new host to the list by clicking the New button. Use the associated dropdown to select a valid host-name value (such as localhost or %), overwriting the text as necessary to provide a specific quoted identifier. Provide a password in the Password and Confirm fields and click Apply. Remove a selected host from the list by clicking the Delete button. |
Object Privileges and System Privileges | For details on using these tabs, see "Working with Privileges and Permissions" on page 447. |
DDL View                    | For details on using this tab, see Viewing the SQL/DDL for an Object. |
ORACLE OBJECT EDITORS

Rapid SQL includes an Object Editor for all supported Oracle objects. To see an Editor for a specific object, click the corresponding link below.

NOTE: If an objects has dependent objects, such as tables, triggers, procedures and views, you can view and access their dependent objects in the editor.

- Check Constraints Editor (Oracle)
- Clusters Editor (Oracle)
- Database Links Editor (Oracle)
- Directories Editor (Oracle)
- Foreign Keys Editor (Oracle)
- Functions Editor (Oracle)
- Indexes Editor (Oracle)
- Job Queue Editor (Oracle)
- Jobs Editor (Oracle)
- Libraries Editor (Oracle)
- Materialized Views Editor (Oracle)
- Materialized View Logs Editor (Oracle)
- Outlines Editor (Oracle)
- Package Bodies Editor (Oracle)
- Packages Editor (Oracle)
- Primary Keys Editor (Oracle)
- Procedures Editor (Oracle)
- Programs Editor (Oracle)
- Profiles Editor (Oracle)
- Redo Log Groups Editor (Oracle)
- Roles Editor (Oracle)
- Rollback Segments Editor (Oracle)
- Schedules Editor (Oracle)
- Sequences Editor (Oracle)
- Synonyms Editor (Oracle)
• Tables Editor (Oracle)
• Tablespaces Editor (Oracle)
• Triggers Editor (Oracle)
• Type Bodies Editor (Oracle)
• Types Editor (Oracle)
• Unique Keys Editor (Oracle)
• Users Editor (Oracle)
• Views Editor (Oracle)

For access to object editors for different supported DBMS platforms and an introduction to editor usage, see "Modifying objects using editors" on page 443.

CHECK CONSTRAINTS EDITOR (Oracle)
The Check Constraints Editor lets you modify and enable/disable check constraints.

To edit a check constraint
1 Open an editor on the check constraint. For details, see "Opening an Object Editor" on page 444.

2 Use the following table as a guide to understanding and modifying the settings on the tabs of this editor:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Definition</td>
<td>Use the Enabled control to enable/disable the check constraint. You can also edit the condition in the Check Condition box. The Table Columns button acts a time saver in editing the condition. It opens a dialog that lets you select and paste column names into the check condition expression.</td>
</tr>
<tr>
<td>DDL View</td>
<td>For details on using this tab, see &quot;Viewing the SQL/DDL for an Object&quot; on page 447.</td>
</tr>
</tbody>
</table>

3 When finished, you can submit your changes. For details, see "Previewing and Submitting Object Editor Changes" on page 450.

CLUSTERS EDITOR (Oracle)
The Clusters Editor lets you manage cluster column and table details, view and modify storage and space parameters, and manage performance settings for a cluster.
To edit a cluster

1. Open an editor on the cluster. For details, see "Opening an Object Editor" on page 444.

2. Use the following table as a guide to understanding and modifying the settings on the tabs of this editor:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Columns</strong></td>
<td>Use the controls in the General Properties group to specify a hash or index Cluster Type and to specify a Key Size for the cluster. If you specify a hash cluster type, use the controls in the Hash Specifications group to specify the number of hash keys and to specify use of either the default hash function or a specified expression used as the hash function.</td>
</tr>
<tr>
<td><strong>Storage</strong></td>
<td>Lets you manage storage for a cluster:</td>
</tr>
</tbody>
</table>
| **Data Block Storage** | Each transaction that updates a data block requires a transaction entry.  
Percent Free - minimum percentage of free space in a block  
Percent Used - minimum percentage of used space in a block.  
Initial transactions - The initial parameter ensures that a minimum number of concurrent transactions can update a data block, avoiding the overhead of allocating a transaction entry dynamically.  
Maximum transactions - The maximum parameter limits concurrency on a data block. |
| **Extents** | The unit of space allocated to an object whenever the object needs more space.  
Initial Extent - The initial space extent (in bytes) allocated to the object.  
Next Extent - The next extent (in bytes) that the object will attempt to allocate when more space for the object is required.  
Minimum Extents - The appropriate minimum extents value for the object.  
Maximum Extents - The appropriate maximum extents value for the object.  
Percent Increase - Magnifies how an object grows and, can materially affect available free space in a tablespace. Select a value in the corresponding box. |
| **Performance** | Lets you modify the following performance settings: |
| **Parallel Query Option group** | Lets you specify Degrees and Instances settings for processing queries using many query server processes running against multiple CPUs, which provides substantial performance gains such as reduction of the query completion time. |
| **Cache group** | The Cache setting keeps the blocks in memory by placing it at the most recently used end. This option is useful for small lookup tables. |
| **Space** | Lets you view the following usage and the space distribution details: |
| **Space Utilization group** | Displays the percent of space reserved for future updates. |
| **FreeLists group** | Displays the allocation of data blocks when concurrent processes are issued against the cluster. Identifying multiple freelists can reduce contention for freelists when concurrent inserts take place and potentially improve the performance of the cluster. |
| **Extents group** | The unit of space allocated to an object whenever the object needs more space. |
MODIFYING OBJECTS USING EDITORS

<table>
<thead>
<tr>
<th>Tab</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tables</td>
<td>Lets you view details for each cluster column. Details for each column include the key column in the cluster, the clustered table name, and the key column in the table.</td>
</tr>
<tr>
<td>DDL</td>
<td>For details on using this tab, see &quot;Viewing the SQL/DDL for an Object&quot; on page 447.</td>
</tr>
</tbody>
</table>

3 When finished, you can submit your changes. For details, see "Previewing and Submitting Object Editor Changes" on page 450.

DATABASE LINKS EDITOR (ORACLE)
The Database Links Editor lets you view connection string information for a database link.

To edit a database link
1 Open an editor on the database link. For details, see "Opening an Object Editor" on page 444.
2 Use the following table as a guide to understanding and modifying the settings on the tabs of this editor:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Definition</td>
<td>Displays connection string information for a database link. Details include the Public setting, the User name and Password associated with the database link, and a Connect String.</td>
</tr>
<tr>
<td>DDL</td>
<td>For details on using this tab, see &quot;Viewing the SQL/DDL for an Object&quot; on page 447.</td>
</tr>
</tbody>
</table>

3 When finished, you can submit your changes. For details, see "Previewing and Submitting Object Editor Changes" on page 450.

DIRECTORIES EDITOR (ORACLE)
The Directories Editor lets you change the path for a directory and modify associated privileges.

To edit a directory object
1 Open an editor on the directory. For details, see "Opening an Object Editor" on page 444.
2 Use the following table as a guide to understanding and modifying the settings on the tabs of this editor:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Definition</td>
<td>Lets you view or modify the SQL code for the directory.</td>
</tr>
<tr>
<td>Privileges</td>
<td>For details on using this tab, see &quot;Working with Privileges and Permissions&quot; on page 447.</td>
</tr>
</tbody>
</table>

3 When finished, you can submit your changes. For details, see "Previewing and Submitting Object Editor Changes" on page 450.
FOREIGN KEYS EDITOR (ORACLE)
The Foreign Keys Editor lets you enable a foreign key, manage its column mappings, and specify a delete rule.

To edit a foreign key
1. Open an editor on the foreign key. For details, see "Opening an Object Editor" on page 444.
2. Use the following table as a guide to understanding and modifying the settings on the tabs of this editor:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Column Mapping</td>
<td>The existing column mapping for the foreign key is represented by selected columns in the Main Table and Referenced Table lists. Additional candidates in the Referenced Table list are indicated by enabled column check boxes. If necessary, use the Table dropdown in the Referenced Table group to choose a new table for this foreign key. Select or deselect columns in the Main Table list and Referenced Table list to form the referential constraint between the two tables.</td>
</tr>
<tr>
<td>Properties</td>
<td>Lets you set the foreign key as Enabled and specify a Delete Rule of CASCADE or NO ACTION.</td>
</tr>
<tr>
<td>DDL View</td>
<td>For details on using this tab, see &quot;Viewing the SQL/DDL for an Object&quot; on page 447.</td>
</tr>
</tbody>
</table>

3. When finished, you can submit your changes. For details, see "Previewing and Submitting Object Editor Changes" on page 450.

FUNCTIONS EDITOR (ORACLE)
The Functions Editor lets you modify basic properties and modify the CREATE/REPLACE DDL for a function.

To edit a function
1. Open an editor on the function. For details, see "Opening an Object Editor" on page 444.
2. Use the following table as a guide to understanding and modifying the settings on the tabs of this editor:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Properties</td>
<td>Lets you view properties in the following categories:</td>
</tr>
<tr>
<td></td>
<td>Properties Lets you view Status and Last Modified details for the function</td>
</tr>
<tr>
<td></td>
<td>Size Information Lets you view Source Size, Parsed Size, Code Size, and Error Size for the function</td>
</tr>
<tr>
<td>Definition</td>
<td>Lets you modify the CREATE OR REPLACE FUNCTION DDL for the function.</td>
</tr>
<tr>
<td>Dependencies</td>
<td>For details on using this tab, see &quot;Working with Object Dependencies&quot; on page 449.</td>
</tr>
</tbody>
</table>
When finished, you can submit your changes. For details, see "Previewing and Submitting Object Editor Changes" on page 450.

INDEXES EDITOR (ORACLE)
The Indexes Editor lets you manage columns, basic properties, storage, space, and partitioning for an index.

To edit an index
1. Open an editor on the index. For details, see "Opening an Object Editor" on page 444.
2. Use the following table as a guide to understanding and modifying the settings on the tabs of this editor:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Columns</td>
<td>Displays a listing of the columns making up the index. Optionally, you can:</td>
</tr>
<tr>
<td></td>
<td>Use the Sort column check box to specify a sort option.</td>
</tr>
<tr>
<td></td>
<td>Click the New button to add a new column to the index.</td>
</tr>
<tr>
<td></td>
<td>Select an existing column and click the Delete button to delete that column from the index.</td>
</tr>
<tr>
<td>Properties</td>
<td>Lets you work with settings in the following categories:</td>
</tr>
<tr>
<td>Attributes</td>
<td>Lets you view IsValid and Function-Based properties. Lets you set Index Type (UNIQUE, NONUNIQUE, BITMAP), No Sort, Logging, Reverse, and Invisible properties.</td>
</tr>
<tr>
<td>Parallel Query Option</td>
<td>Lets you view the No Parallel Execution property. Lets you set the Parallel Degree and Parallel Instances values.</td>
</tr>
<tr>
<td>Storage</td>
<td>Lets you work with settings in the following categories:</td>
</tr>
<tr>
<td>Data Block Storage</td>
<td>Lets you choose the Tablespace, and specify Percent Free, Initial Transactions, and Max Transactions values.</td>
</tr>
<tr>
<td>Extents</td>
<td>Lets you specify Initial Extent, NextExtent, Minimum Extents, Maximum Extents, and Percent Increase values.</td>
</tr>
<tr>
<td>Freelists</td>
<td>Lets you specify Freelists and Freelist Groups values.</td>
</tr>
<tr>
<td>Buffer Pool</td>
<td>Lets you specify a buffer pool.</td>
</tr>
</tbody>
</table>
## MODIFYING OBJECTS USING EDITORS

<table>
<thead>
<tr>
<th>Tab</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Space</strong></td>
<td>Lets you view settings in the following categories:</td>
</tr>
<tr>
<td><strong>Space Utilization</strong></td>
<td>Lets you view the <strong>Size</strong> and number of <strong>Blocks</strong> settings.</td>
</tr>
<tr>
<td><strong>Statistics</strong></td>
<td>Lets you view <strong>Index Level</strong>, <strong>Distinct Keys</strong>, <strong>Cluster Factor</strong>, <strong>Leaf Blocks</strong>, <strong>Leaf Blks/Key</strong> and <strong>Data Blks/Key</strong> properties.</td>
</tr>
<tr>
<td><strong>Partition</strong></td>
<td>If the index is not currently partitioned, you can click the <strong>Convert To Partitioned</strong> button to partition the index. For more information, see “Partitioning Oracle indexes, primary keys, and unique keys” on page 554.</td>
</tr>
<tr>
<td><strong>Properties</strong></td>
<td>If the index is currently partitioned, this tab displays the following partition details:</td>
</tr>
<tr>
<td></td>
<td>Lets you view the <strong>Locality</strong> (Global/Local), <strong>Alignment</strong> (Prefixed/Non-Prefixed), <strong>Partition Type</strong> (RANGE or HASH), and <strong>Subpartition type</strong> properties.</td>
</tr>
<tr>
<td></td>
<td>Click the <strong>Edit Partition</strong> button to edit partition details. or more information, see “Partitioning Oracle indexes, primary keys, and unique keys” on page 554.</td>
</tr>
<tr>
<td></td>
<td>Click the <strong>Drop Partition</strong> button to revert to an unpartitioned index.</td>
</tr>
<tr>
<td><strong>Columns</strong></td>
<td>Displays partitioning columns.</td>
</tr>
<tr>
<td><strong>Partition Definitions</strong></td>
<td>Displays the list of partition definitions. For each partition definition, listing shows the partition definition <strong>Value</strong>, the associated <strong>Tablespace</strong>, and whether the index is <strong>Usable</strong> or has been marked as Unusable by Oracle. Use the <strong>Partition Commands</strong> menu <strong>Mark Unusable</strong> or <strong>Rebuild</strong> commands to change the current <strong>Usable</strong> value.</td>
</tr>
<tr>
<td><strong>DDL View</strong></td>
<td>For details on using this tab, see “Viewing the SQL/DDL for an Object” on page 447.</td>
</tr>
</tbody>
</table>
MODIFYING OBJECTS USING EDITORS

JOB QUEUE EDITOR (ORACLE)
The Job Queue Editor lets you change the sql procedure specified for the job as well as manage the job’s schedule and status.

To edit a job queue
1. Open an editor on the job queue. For details, see "Opening an Object Editor" on page 444.
2. Use the following table as a guide to understanding and modifying the settings on the tabs of this editor:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Properties</td>
<td>Lets you modify the Submit as disabled, Next Date, Run Again, Every, Time Unit, Use Custom Expression, and Custom Expression properties. For details on these properties, see &quot;Job Queues (Oracle) - Properties&quot; on page 378. This tab also displays the following properties: Job - the unique identifier assigned when the job was created. User - the user who submitted the job. Schema User - the user schema for which to parse the job Priv User - the user whose privileges the job is to run under.</td>
</tr>
<tr>
<td>Definition</td>
<td>This tab lets you modify the DBMS_JOB.SUBMIT call’s WHAT parameter, specifying the name of the PL/SQL procedure to run.</td>
</tr>
<tr>
<td>DDL</td>
<td>For details on using this tab, see &quot;Viewing the SQL/DDL for an Object&quot; on page 447.</td>
</tr>
</tbody>
</table>

3. When finished, you can submit your changes. For details, see "Previewing and Submitting Object Editor Changes" on page 450.

JOBS EDITOR (ORACLE)
The Jobs Editor lets you modify details of a job.

To edit a job
1. Open an editor on the job. For details, see "Opening an Object Editor" on page 444.
2. Use the following table as a guide to understanding and modifying the settings on the tabs of this editor:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Properties</td>
<td>For details on using these settings, see &quot;Jobs (Oracle) - Properties&quot; on page 379.</td>
</tr>
<tr>
<td>DDL View</td>
<td>For details on using this tab, see &quot;Viewing the SQL/DDL for an Object&quot; on page 447.</td>
</tr>
</tbody>
</table>

3. When finished, you can submit your changes. For details, see "Previewing and Submitting Object Editor Changes" on page 450.
**LIBRARIES EDITOR (ORACLE)**

The Libraries Editor lets you view and modify library definitions and manage dependencies and privileges for the library.

**To edit a library**

1. Open an editor on the library. For details, see "Opening an Object Editor" on page 444.

2. Use the following table as a guide to understanding and modifying the settings on the tabs of this editor:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Definition</strong></td>
<td>The <strong>Definition</strong> tab of the Libraries Editor lets you modify the file name and path for a library and view the current status and whether the library is dynamic.</td>
</tr>
<tr>
<td>Dependencies</td>
<td>For details on using this tab, see &quot;Working with Object Dependencies&quot; on page 449.</td>
</tr>
<tr>
<td>Privileges</td>
<td>For details on using this tab, see &quot;Working with Privileges and Permissions&quot; on page 447.</td>
</tr>
<tr>
<td>DDL View</td>
<td>For details on using this tab, see &quot;Viewing the SQL/DDL for an Object&quot; on page 447.</td>
</tr>
</tbody>
</table>

3. When finished, you can submit your changes. For details, see "Previewing and Submitting Object Editor Changes" on page 450.

**MATERIALIZED VIEWS EDITOR (ORACLE)**

The Materialized Views Editor lets you view and modify materialized view information and partitions.

**To edit a materialized view**

1. Open an editor on the materialized view. For details, see "Opening an Object Editor" on page 444.

2. Use the following table as a guide to understanding and modifying the settings on the tabs of this editor:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Information</strong></td>
<td>Lets you work with properties in the following categories:</td>
</tr>
<tr>
<td>Master</td>
<td>Lets you work with the <strong>Table Name</strong> and <strong>Master View</strong> properties.</td>
</tr>
<tr>
<td>Last Refresh</td>
<td>Lets you work with the <strong>Last Date</strong> and <strong>Errors</strong> properties.</td>
</tr>
<tr>
<td>Refresh</td>
<td>Lets you work with the <strong>Type</strong>, <strong>Refresh Method</strong>, and <strong>Mode</strong> properties.</td>
</tr>
<tr>
<td>Configuration</td>
<td></td>
</tr>
<tr>
<td>Rollback Usage</td>
<td>Lets you work with the <strong>Local</strong> and <strong>Master</strong> properties.</td>
</tr>
<tr>
<td>Options</td>
<td>Lets you work with the <strong>Updatable</strong> and <strong>Enable Query Rewrite</strong> properties.</td>
</tr>
</tbody>
</table>
### MODIFYING OBJECTS USING EDITORS

<table>
<thead>
<tr>
<th>Tab</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Storage</strong></td>
<td>Lets you work with properties in the following categories:</td>
</tr>
<tr>
<td><strong>Placement</strong></td>
<td>Lets you work with <strong>Tablespace</strong> and <strong>Cluster</strong> values.</td>
</tr>
<tr>
<td><strong>Data Block Storage</strong></td>
<td>Lets you work with <strong>Percent Free</strong>, <strong>Percent Used</strong>, <strong>Initial transactions</strong>, and <strong>Maximum transactions</strong> values.</td>
</tr>
<tr>
<td><strong>Extents</strong></td>
<td>Lets you work with <strong>Initial Extent</strong>, <strong>Next Extent</strong>, <strong>Minimum Extents</strong>, <strong>Maximum Extents</strong>, and <strong>Percent Increase</strong> values.</td>
</tr>
<tr>
<td><strong>Performance</strong></td>
<td>Lets you work with settings in the following categories:</td>
</tr>
<tr>
<td><strong>Parallel Query Option</strong></td>
<td>The Parallel server query option lets you process queries using many query server processes running against multiple CPUs. This option provides substantial performance gains such as reduction of the query completion time.</td>
</tr>
<tr>
<td></td>
<td><strong>Degrees</strong> - Lets you type a value indicating the number of query server processes that should be used in the operation.</td>
</tr>
<tr>
<td></td>
<td><strong>Instances</strong> - Lets you type a value indicating how you want the parallel query partitioned between the Parallel Servers.</td>
</tr>
<tr>
<td><strong>Logging</strong></td>
<td>Select <strong>Logging</strong> to create a log for all Materialized View updates.</td>
</tr>
<tr>
<td><strong>Cache</strong></td>
<td>Select <strong>Cache</strong> if you want Oracle to put data you access frequently at the most recently used end of the list in the buffer cache when a full table scan is performed. This option is useful for small lookup tables.</td>
</tr>
<tr>
<td><strong>Query</strong></td>
<td>Displays the associated query.</td>
</tr>
<tr>
<td><strong>Partitions</strong></td>
<td>Displays the partitioning method, including Range-Hash Composite or Range-List Composite.</td>
</tr>
<tr>
<td><strong>Partitioning Method</strong></td>
<td>Hash partitions partition the table according to a hash function. Composite partitions use both range and hash types, first partitioning the data by a range of values, and then further dividing the partitions into subpartitions by way of a hash function.</td>
</tr>
<tr>
<td></td>
<td>List partitioning lets you control how rows map to partitions.</td>
</tr>
<tr>
<td></td>
<td>You can specify a list of discrete values for the partitioning column in the description for each partition.</td>
</tr>
<tr>
<td><strong>Row Movement</strong></td>
<td>If its key is updated, migrates the row to a new partition.</td>
</tr>
<tr>
<td><strong>Partitioning Columns</strong></td>
<td>Displays partitioning columns.</td>
</tr>
<tr>
<td><strong>Subpartitioning Columns</strong></td>
<td>Displays subpartitioning columns.</td>
</tr>
<tr>
<td><strong>Partitions</strong></td>
<td>Click <strong>Add</strong> or <strong>Edit</strong> to open the <strong>Partition</strong> dialog.</td>
</tr>
<tr>
<td></td>
<td>Click <strong>Drop</strong> to drop a partition.</td>
</tr>
<tr>
<td><strong>Subpartition Template</strong></td>
<td>If the partitioning type is Range-Hash Composite, displays a list of subpartitions in the subpartition template.</td>
</tr>
<tr>
<td></td>
<td>Click <strong>Add, Insert, or Edit</strong> to open the <strong>Subpartition</strong> dialog.</td>
</tr>
<tr>
<td></td>
<td>Click <strong>Drop</strong> to drop a subpartition.</td>
</tr>
<tr>
<td><strong>Dependencies</strong></td>
<td>For details on using this tab, see &quot;Working with Object Dependencies&quot; on page 449.</td>
</tr>
<tr>
<td><strong>Privileges</strong></td>
<td>For details on using this tab, see &quot;Working with Privileges and Permissions&quot; on page 447.</td>
</tr>
<tr>
<td><strong>DDL View</strong></td>
<td>For details on using this tab, see &quot;Viewing the SQL/DDL for an Object&quot; on page 447.</td>
</tr>
</tbody>
</table>
3 When finished, you can submit your changes. For details, see "Previewing and Submitting Object Editor Changes" on page 450.

**MATERIALIZED VIEW LOGS EDITOR (ORACLE)**

The Materialized View Logs Editor lets you view replication log table details, and manage space, storage, and performance details for a materialized view log.

**To edit a materialized view log**

1. Open an editor on the materialized view log. For details, see "Opening an Object Editor" on page 444.

2. Use the following table as a guide to understanding and modifying the settings on the tabs of this editor:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Information</td>
<td>Displays information on the log table used for replication.</td>
</tr>
<tr>
<td>Storage</td>
<td>Lets you work with settings in the following categories:</td>
</tr>
<tr>
<td>Data Block Storage</td>
<td>Lets you view the associated <strong>Tablespace</strong> and <strong>Initial Transactions</strong> value, and modify the <strong>Percent Free, Percent Used</strong>, and <strong>Max Transactions</strong> values.</td>
</tr>
<tr>
<td>Extents</td>
<td>Lets you view <strong>Initial Extent, Next Extent, Minimum Extents, Maximum Extents</strong>, and <strong>Percent Increase</strong> values.</td>
</tr>
<tr>
<td>Column Filtering</td>
<td>Lets you select the filter columns to be recorded in the materialized view log. You can specify only one primary key, one ROWID and one filter column list per materialized view log. The ROWID is a globally unique identifier for a row in a database. It is created at the time the row is inserted into a table, and destroyed when it is removed from a table.</td>
</tr>
<tr>
<td>Performance</td>
<td>Lets you work with settings in the following categories:</td>
</tr>
<tr>
<td>Parallel Query Option</td>
<td>The Parallel server query option lets you process queries using many query server processes running against multiple CPUs. This option provides substantial performance gains such as reduction of the query completion time.</td>
</tr>
<tr>
<td></td>
<td><strong>Degrees</strong> - Lets you type a value indicating the number of query server processes that should be used in the operation.</td>
</tr>
<tr>
<td></td>
<td><strong>Instances</strong> - Lets you type a value indicating how you want the parallel query partitioned between the Parallel Servers.</td>
</tr>
<tr>
<td>Logging</td>
<td>Select <strong>Logging</strong> to create a log for all Materialized View updates.</td>
</tr>
<tr>
<td>Cache</td>
<td>Select <strong>Cache</strong> if you want Oracle to put data you access frequently at the most recently used end of the list in the buffer cache when a full table scan is performed. This option is useful for small lookup tables.</td>
</tr>
<tr>
<td>Dependencies</td>
<td>For details on using this tab, see &quot;Working with Object Dependencies&quot; on page 449.</td>
</tr>
</tbody>
</table>
3 When finished, you can submit your changes. For details, see "Previewing and Submitting Object Editor Changes" on page 450.

**OUTLINES EDITOR (ORACLE)**

The Outlines Editor lets you view information on an outline, and modify its category and associated SQL statement.

**NOTE:** The only SQL statements possible with stored outlines are SELECT, DELETE, UPDATE, INSERT…SELECT, and CREATE TABLE…AS SELECT.

**To edit an outline**

1. Open an editor on the outline. For details, see "Opening an Object Editor" on page 444.
2. Use the following table as a guide to understanding and modifying the settings on the tabs of this editor:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Properties</td>
<td>In addition to displaying basic creation and identification properties, this tab lets you select a new <strong>Category</strong> for the outline.</td>
</tr>
<tr>
<td>Definition</td>
<td>Lets you view and modify the SQL Statement associated with the outline.</td>
</tr>
<tr>
<td>DDL View</td>
<td>For details on using this tab, see &quot;Viewing the SQL/DDL for an Object&quot; on page 447.</td>
</tr>
</tbody>
</table>

3 When finished, you can submit your changes. For details, see "Previewing and Submitting Object Editor Changes" on page 450.

**PACKAGE BODIES EDITOR (ORACLE)**

While listed as separate objects in the Datasource Navigator, package bodies are created and edited on the **Body** tab of the Packages Editor. For details, see "Packages Editor (Oracle)" on page 536.

**PACKAGES EDITOR (ORACLE)**

The Packages Editor lets you view and modify header and body specifications of a package.
To edit package

1. Open an editor on the package. For details, see "Opening an Object Editor" on page 444.

2. Use the following table as a guide to understanding and modifying the settings on the tabs of this editor:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Header</td>
<td>Lets you modify the package header specifications.</td>
</tr>
<tr>
<td>Body</td>
<td>Lets you modify the package body specifications.</td>
</tr>
<tr>
<td>Information</td>
<td>Lets you work with status and size properties in the following categories:</td>
</tr>
<tr>
<td></td>
<td><strong>Header and Body</strong> Let you view Status, Created, and Last Modified Source Size, Parsed Size, Code Size, and Error Size details for the header and body of the package.</td>
</tr>
<tr>
<td>Dependencies</td>
<td>For details on using this tab, see &quot;Working with Object Dependencies&quot; on page 449.</td>
</tr>
<tr>
<td>Permissions</td>
<td>For details on using this tab, see &quot;Working with Privileges and Permissions&quot; on page 447.</td>
</tr>
</tbody>
</table>

3. When finished, you can submit your changes. For details, see "Previewing and Submitting Object Editor Changes" on page 450.

**PRIMARY KEYS EDITOR (ORACLE)**

The Primary Keys Editor lets you manage columns, basic properties, storage and space, and partitions for a primary key.

To edit primary key

1. Open an editor on the primary key. For details, see "Opening an Object Editor" on page 444.

2. Use the following table as a guide to understanding and modifying the settings on the tabs of this editor:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Columns</td>
<td>Displays a listing of the columns making up the primary key. Optionally, you can:</td>
</tr>
<tr>
<td></td>
<td>Click the <strong>New</strong> button to add a new column to the index.</td>
</tr>
<tr>
<td></td>
<td>Select an existing column and click the <strong>Delete</strong> button to delete that column from the index.</td>
</tr>
<tr>
<td>Properties</td>
<td>Lets you work with settings in the following categories:</td>
</tr>
<tr>
<td>Enforcing Index</td>
<td>Lets you view User Defined, Index Owner, and Index Name properties.</td>
</tr>
<tr>
<td>Attributes</td>
<td>Lets you work with No Sort (only available if Enabled is set), Logging (YES, NO, or NONE), Reverse (disabled if No Sort is enabled), Validate, Deferrable, Deferred (IMMEDIATE or DEFERRED and only enabled if Deferrable is enabled), Enabled, Cascade (disabled if Enabled is set), Rely and Update Date properties.</td>
</tr>
</tbody>
</table>
### Tab | Settings and tasks
--- | ---
**Storage** | Lets you work with settings in the following categories:

- **Data Block Storage**<br> Lets you specify **Tablespace**, **Percent Free**, **Initial Transactions**, and **Max Transactions** values.<br>Note: You should never place primary keys on the SYSTEM tablespace.

- **Extents**<br> Displays **Initial Extent**, **Next Extent**, **Percent Increase**, **Minimum Extents**, and **Maximum Extents** values.

- **Freelists**<br> Lets you specify **Freelists** and **Freelist Groups** values.

- **Buffer Pool**<br> Lets you specify a buffer pool.

**Space** | Lets you work with settings in the following categories:

- **Space Utilization**<br> Lets you view **Size** and **Blocks** properties.

- **Statistics**<br> Lets you view **Index Level**, **Distinct Keys**, **Cluster Factor**, **Leaf Blocks**, **Leaf Blks/Key**, and **Data Blks/Key** properties.

**Partition**<br> If the primary key is currently partitioned, this tab displays the following partition details:

- **Properties**<br> Lets you view the **Locality** (Global/Local), **Alignment** (Prefixed/Non-Prefixed), **Partition Type** (RANGE or HASH), and **Subpartition type** properties.

  - Click the **Edit Partition** button to edit partition details. Or more information, see [Partitioning Oracle indexes, primary keys, and unique keys](#).

  - Click the **Drop Partition** button to revert to an unpartitioned primary key.

  - Use the **Partition Commands** menu items to initiate object actions. For details, see the following topics:
    - *Allocate Extent* on page 582
    - *Analyze* on page 583
    - *Coalesce* on page 599
    - *Deallocate Unused Space* on page 616

  - **Mark Unusable** - opens a dialog that lets you select one or more partitions to be marked as unusable.

  - **Rebuild** - opens a dialog that lets you select a partition to be rebuilt.

  - **Split** - opens a dialog that lets you divide a single partition into two partitions. You can split partitions if a single partition is causing maintenance problems because it is too large.

- **Columns**<br> Displays partitioning columns.

- **Partition Definitions**<br> Displays details for each partition.

  - If the primary key is not currently partitioned, you can click the **Convert To Partitioned** button to partition the primary key. For more information, see [Partitioning Oracle indexes, primary keys, and unique keys](#).

**DDL View**<br> For details on using this tab, see "**Viewing the SQL/DDL for an Object**" on page 447.

---

3 When finished, you can submit your changes. For details, see "**Previewing and Submitting Object Editor Changes**" on page 450.
MODIFYING OBJECTS USING EDITORS

PROCEDURES EDITOR (ORACLE)
The Procedures Editor lets you view and modify the SQL code and properties of a procedure.

To edit a procedure
1. Open an editor on the procedure. For details, see "Opening an Object Editor" on page 444.
2. Use the following table as a guide to understanding and modifying the settings on the tabs of this editor:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Properties</strong></td>
<td>Lets you work with properties in the following categories:</td>
</tr>
<tr>
<td>Properties</td>
<td>Lets you view <strong>Status</strong>, and <strong>Last Modified</strong> properties.</td>
</tr>
<tr>
<td>Size Information</td>
<td>Lets you view <strong>Source Size</strong>, <strong>Parsed Size</strong>, <strong>Code Size</strong>, and <strong>Error Size</strong></td>
</tr>
<tr>
<td><strong>Definition</strong></td>
<td>Lets you modify the SQL code for a procedure.</td>
</tr>
<tr>
<td><strong>Dependencies</strong></td>
<td>For details on using this tab, see &quot;Working with Object Dependencies&quot; on page 449.</td>
</tr>
<tr>
<td><strong>Permissions</strong></td>
<td>For details on using this tab, see &quot;Working with Privileges and Permissions&quot; on page 447.</td>
</tr>
</tbody>
</table>
3. When finished, you can submit your changes. For details, see "Previewing and Submitting Object Editor Changes" on page 450.

PROFILES EDITOR (ORACLE)
The Profiles Editor lets you manage limits and manage user assignments for the profile.
To edit a profile
1. Open an editor on the profile. For details, see "Opening an Object Editor" on page 444.
2. Use the following table as a guide to understanding and modifying the settings on the tabs of this editor:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resources</td>
<td>Lets you work with settings in the following categories:</td>
</tr>
<tr>
<td></td>
<td><strong>General Limits</strong>Lets you specify <strong>Composite Limit</strong> and <strong>Private SGA</strong> settings.</td>
</tr>
<tr>
<td></td>
<td><strong>Session Limits</strong>Lets you specify the limit on the amount of private space a session can allocate in the shared pool of the SGA. Specific settings are <strong>Sessions Per User</strong>, <strong>CPU Per Session</strong>, <strong>Logical Reads</strong>.</td>
</tr>
<tr>
<td></td>
<td><strong>Time Limits</strong>Lets you specify the limit on total connection time per session. Specific settings are <strong>Connect Time</strong> and <strong>Idle Time</strong>.</td>
</tr>
<tr>
<td></td>
<td><strong>Call Limits</strong>Lets you specify the CPU time limit for a call (a parse, execute, or fetch), expressed in hundredths of seconds. Specific settings are <strong>CPU Per Call</strong> and <strong>Logical Reads</strong>.</td>
</tr>
<tr>
<td></td>
<td><strong>Login Limits</strong>Lets you specify the number of <strong>Failed Login Attempts</strong> on the user account before the account is locked and the <strong>Account Lock Time</strong>.</td>
</tr>
<tr>
<td></td>
<td><strong>Password Limits</strong>Lets you specify the <strong>Lifetime</strong>, <strong>Reuse Time</strong>, <strong>Reuse Max</strong>, <strong>Grace Period</strong> and a <strong>Verify Function</strong> for passwords.</td>
</tr>
<tr>
<td>Users</td>
<td>Use the <strong>Assign</strong> button to open a dialog that lets you assign a user to this profile or select a user from the list, and click the <strong>Unassign</strong> button to open a dialog prompting you to confirm that the user is to be unassigned.</td>
</tr>
<tr>
<td>DDL</td>
<td>For details on using this tab, see &quot;Viewing the SQL/DDL for an Object&quot; on page 447.</td>
</tr>
</tbody>
</table>

3. When finished, you can submit your changes. For details, see "Previewing and Submitting Object Editor Changes" on page 450.

**PROGRAMS EDITOR (ORACLE)**
The Programs Editor lets you modify details of a program.

To edit a program
1. Open an editor on the program. For details, see "Opening an Object Editor" on page 444.
2. Use the following table as a guide to understanding and modifying the settings on the tabs of this editor:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action</td>
<td>For details on using these settings, see &quot;Programs (Oracle) - Action&quot; on page 395.</td>
</tr>
<tr>
<td>Arguments</td>
<td>For details on using these settings, see &quot;Programs (Oracle) - Arguments&quot; on page 395.</td>
</tr>
<tr>
<td>DDL View</td>
<td>For details on using this tab, see &quot;Viewing the SQL/DDL for an Object&quot; on page 447.</td>
</tr>
</tbody>
</table>
3 When finished, you can submit your changes. For details, see "Previewing and Submitting Object Editor Changes" on page 450.

**REDO LOG GROUPS EDITOR (ORACLE)**
The Redo Log Groups Editor lets you manage the members in a redo log group.

**To edit a redo log group**
1 Open an editor on the redo log group. For details, see "Opening an Object Editor" on page 444.
2 Use the following table as a guide to understanding and modifying the settings on the tabs of this editor:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Redo Log Members</td>
<td>Lets you add new members to the redo log group, edit existing members, and delete members from the redo log group.</td>
</tr>
<tr>
<td>DDL View</td>
<td>For details on using this tab, see &quot;Viewing the SQL/DDL for an Object&quot; on page 447.</td>
</tr>
</tbody>
</table>

3 When finished, you can submit your changes. For details, see "Previewing and Submitting Object Editor Changes" on page 450.

**ROLES EDITOR (ORACLE)**
The Roles Editor lets you manage authentication and grant/revoke profiles for users and logins.

**To edit a role**
1 Open an editor on the role. For details, see "Opening an Object Editor" on page 444.
2 Use the following table as a guide to understanding and modifying the settings on the tabs of this editor:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Authentication</td>
<td>Lets you manage role identity. When creating a role, you must establish certain rules governing its use. You can specify whether or not a role must be identified when used. If you require role identification, you can authenticate the user externally through the operating system, or with a specific password. If you specified that the role requires identification, provide a Password and specify whether the role is to be authenticated Globally or Externally.</td>
</tr>
<tr>
<td>User/Roles</td>
<td>Displays permissions for this role to logins or users. Click Grant to open a dialog that lets you grant this role to a login or another role. Select a role or login and click Revoke to revoke the role or login.</td>
</tr>
<tr>
<td>Object Privileges and System Privileges</td>
<td>For details on using this tab, see &quot;Working with Privileges and Permissions&quot; on page 447.</td>
</tr>
</tbody>
</table>
MODIFYING OBJECTS USING EDITORS

<table>
<thead>
<tr>
<th>Tab</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>DDL View</td>
<td>For details on using this tab, see &quot;Viewing the SQL/DDL for an Object&quot; on page 447.</td>
</tr>
</tbody>
</table>

3. When finished, you can submit your changes. For details, see "Previewing and Submitting Object Editor Changes" on page 450.

For information on activating and deactivating roles for the current login in the current session, see "Role Activation" on page 681.

ROLLBACK SEGMENTS EDITOR (ORACLE)
The Rollback Segments Editor lets you view rollback segment status, manage rollback segment storage, and view activity levels.

To edit a rollback segment
1. Open an editor on the rollback segment. For details, see "Opening an Object Editor" on page 444.
2. Use the following table as a guide to understanding and modifying the settings on the tabs of this editor:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status</td>
<td>Lets you enable and disable a rollback segment and displays status details for the rollback segment. The tab displays whether the rollback segment is online or offline and provides the associated Tablespace, Size, and No. of Extents.</td>
</tr>
<tr>
<td>Storage</td>
<td>Lets you work with settings in the following categories:</td>
</tr>
<tr>
<td></td>
<td><strong>Extents</strong> - The unit of space allocated to an object whenever the object needs more space.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Initial Extent</strong> - The initial space extent (in bytes) allocated to the object.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Next Extent</strong> - The next extent (in bytes) that the object will attempt to allocate when more space for the object is required.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Optimal Size</strong> - optimal extent size</td>
</tr>
<tr>
<td></td>
<td>- <strong>Minimum Extents</strong> - The appropriate minimum extents value for the object.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Maximum Extents</strong> - The appropriate maximum extents value for the object.</td>
</tr>
<tr>
<td></td>
<td><strong>Extent Detail</strong> - Displays extent details.</td>
</tr>
<tr>
<td>Activity</td>
<td>Lets you work with settings in the following categories:</td>
</tr>
<tr>
<td></td>
<td><strong>Activity Levels</strong> - Displays Active Transactions, Writes, Gets and Waits values.</td>
</tr>
<tr>
<td></td>
<td><strong>Dynamic Sizing</strong> - Displays High Watermark, Extends, Shrinks, and Wraps values.</td>
</tr>
<tr>
<td>DDL</td>
<td>For details on using this tab, see &quot;Viewing the SQL/DDL for an Object&quot; on page 447.</td>
</tr>
</tbody>
</table>

3. When finished, you can submit your changes. For details, see "Previewing and Submitting Object Editor Changes" on page 450.
SCHEDULES EDITOR (ORACLE)
The Schedules Editor lets you modify details of a schedule.

To edit a schedule
1. Open an editor on the schedule. For details, see "Opening an Object Editor" on page 444.
2. Use the following table as a guide to understanding and modifying the settings on the tabs of this editor:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action</td>
<td>For details on using these settings, see &quot;Schedules (Oracle) - Properties&quot; on page 398.</td>
</tr>
<tr>
<td>DDL View</td>
<td>For details on using this tab, see &quot;Viewing the SQL/DDL for an Object&quot; on page 447.</td>
</tr>
</tbody>
</table>

3. When finished, you can submit your changes. For details, see "Previewing and Submitting Object Editor Changes" on page 450.

SEQUENCES EDITOR (ORACLE)
The Sequences Editor lets you manage parameters for a sequence, manage database objects dependent on the sequence, and manage privileges for the sequence.

To edit a sequence
1. Open an editor on the sequence. For details, see "Opening an Object Editor" on page 444.
2. Use the following table as a guide to understanding and modifying the settings on the tabs of this editor:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Definition</td>
<td>Lets you work with settings in the following categories:</td>
</tr>
<tr>
<td>Parameters</td>
<td>Lets you specify increment, minimum value and maximum value settings.</td>
</tr>
<tr>
<td>Current/Next Sequence Numbers</td>
<td>Lets you work with sequence cycle numbers.</td>
</tr>
<tr>
<td>Options</td>
<td>Lets you specify Cache Size, Cycle When Reach Max/Min, and Generate Numbers in Order (useful when you are using the sequence number as a timestamp) values.</td>
</tr>
<tr>
<td>Dependencies</td>
<td>For details on using this tab, see &quot;Working with Object Dependencies&quot; on page 449.</td>
</tr>
<tr>
<td>Privileges</td>
<td>For details on using this tab, see &quot;Working with Privileges and Permissions&quot; on page 447.</td>
</tr>
<tr>
<td>DDL</td>
<td>For details on using this tab, see &quot;Viewing the SQL/DDL for an Object&quot; on page 447.</td>
</tr>
</tbody>
</table>

3. When finished, you can submit your changes. For details, see "Previewing and Submitting Object Editor Changes" on page 450.
SYNONYMS EDITOR (ORACLE)
The Synonyms Editor lets you view base object information and manage database objects dependent on a synonym.

To edit a synonym
1. Open an editor on the synonym. For details, see "Opening an Object Editor" on page 444.
2. Use the following table as a guide to understanding and modifying the settings on the tabs of this editor:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Properties</td>
<td>Displays the type, owner, name, and other details of the object referenced by the synonym.</td>
</tr>
<tr>
<td>Dependencies</td>
<td>For details on using this tab, see &quot;Working with Object Dependencies&quot; on page 449.</td>
</tr>
<tr>
<td>DDL View</td>
<td>For details on using this tab, see &quot;Viewing the SQL/DDL for an Object&quot; on page 447.</td>
</tr>
</tbody>
</table>

3. When finished, you can submit your changes. For details, see "Previewing and Submitting Object Editor Changes" on page 450.

TABLES EDITOR (ORACLE)
The Tables Editor lets you manage columns, constraints, storage and space, and partitions for a table.
To edit a table

1. Open an editor on the table. For details, see "Opening an Object Editor" on page 444.

2. Use the following table as a guide to understanding and modifying the settings on the tabs of this editor:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Settings and tasks</th>
</tr>
</thead>
</table>
| Columns      | Displays the currently defined columns in the table. For any selected column, the Property/Value list provides additional detail on that column. Available properties depend on the datatype you choose as well as on the property values you select. **Virtual** - indicates whether this column is defined as an Oracle virtual column. If selected, the value is provided by the calculation in the **Default Value** box. **Datatype** properties - lets you select a type and depending on your selection, additional properties such as **Scale**, **Width**, and **Unused** may be available. **Allow Nulls** - Select this check box to allow nulls in this column. **Encryption** properties include **Password**, **Salted**, and **EncryptionAlgorithm**. **Default Value** - If **Virtual** is selected, this box lets you specify a valid Oracle column expression. Otherwise, it can contain a pseudocolumn (CURRENT_TIMESTAMP, USER, SYSDATE, or UID) or an expression. lets you choose among CURRENT_TIMESTAMP, USER, SYSDATE, and UID. **Comment** lets you add a comment to the column. **LOB Storage** settings are available for bfile, blob, clob, and nclob types. They include **Segment Name**, **Configuration** properties (Tablespace, Chunk, Percent Version, Enable Storage In Row, Cache, and Logging), and **Storage** properties (Initial Extent, Next Extent, Percent Increase, Minimum Extents, Maximum Extents, Free Lists, and Free List Groups). Optionally, you can:

- Select a column, and in the Property/Value list modify property values for that column.
- Click **Add Column**, provide a name for the new column, and set property values for the column.
- Select a column and click **Delete** to remove the column from the table.

<table>
<thead>
<tr>
<th>Properties</th>
<th>Lets you work with settings in the following categories:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table</td>
<td>Lets you work with the following properties, corresponding to CREATE TABLE clauses: <strong>Cache</strong>, <strong>Row Movement</strong>, <strong>Parallel Degree</strong>, and <strong>Parallel Instances</strong>.</td>
</tr>
<tr>
<td>Physical</td>
<td>Lets you view the <strong>Row Organization</strong> property. Lets you set the <strong>Logging</strong> and <strong>Table Compression</strong> properties.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Indexes</th>
<th>Lets you manage indexes for a table. On opening, the list of current indexes for the table is displayed. Optionally, take one of the following actions:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Click <strong>Add</strong> to open a dialog that lets you add a new index to the table.</td>
</tr>
<tr>
<td></td>
<td>Select an index and click <strong>Edit</strong> to open a dialog that lets you edit index properties.</td>
</tr>
<tr>
<td></td>
<td>Select an index and click <strong>Drop</strong> to open a dialog that lets you remove the index from the table.</td>
</tr>
<tr>
<td>Tab</td>
<td>Settings and tasks</td>
</tr>
<tr>
<td>------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Constraints</td>
<td>Lets you manage constraints for the table. Constraints are grouped by type, under folders. Optionally take one of the following actions:</td>
</tr>
<tr>
<td></td>
<td>Select a constraint type folder and click <strong>Add</strong> to open a dialog that lets you add a constraint of that type.</td>
</tr>
<tr>
<td></td>
<td>Select a constraint and click <strong>Edit</strong> to open a dialog that lets you modify the constraint details.</td>
</tr>
<tr>
<td></td>
<td>Select a constraint and click <strong>Drop</strong> to remove the constraint.</td>
</tr>
<tr>
<td>Storage</td>
<td>Lets you work with settings in the following categories:</td>
</tr>
<tr>
<td></td>
<td><strong>Data Block Storage</strong> lets you choose the <strong>Tablespace Name</strong>, and specify <strong>Percent Free</strong>, <strong>Initial Transactions</strong>, and <strong>Max Transactions</strong> values.</td>
</tr>
<tr>
<td></td>
<td><strong>Extents</strong> lets you view <strong>Initial Extent</strong>, <strong>Next Extent</strong>, <strong>Minimum Extents</strong>, <strong>Maximum Extents</strong>, and <strong>Percent Increase</strong> values.</td>
</tr>
<tr>
<td></td>
<td><strong>Freelists</strong> lets you specify <strong>Freelists</strong> and <strong>Freelist Groups</strong> values.</td>
</tr>
<tr>
<td></td>
<td><strong>Bufferpool</strong> lets you specify a <strong>Buffer Pool</strong>.</td>
</tr>
<tr>
<td>IOT Properties</td>
<td>Lets you work with settings in the following categories:</td>
</tr>
<tr>
<td></td>
<td><strong>Ungrouped</strong> lets you specify an overflow segment.</td>
</tr>
<tr>
<td></td>
<td><strong>Percent Threshold</strong> lets you specify the percentage of space reserved for an index-organized table.</td>
</tr>
<tr>
<td></td>
<td><strong>Key Compression</strong> lets you enable or disable compression and provide a compression value.</td>
</tr>
<tr>
<td>Space</td>
<td>Lets you work with settings in the following categories:</td>
</tr>
<tr>
<td></td>
<td><strong>Space Utilization</strong> lets you view <strong>Size</strong> and number of <strong>Blocks</strong>.</td>
</tr>
<tr>
<td></td>
<td><strong>Row Information</strong> lets you view the <strong>Number of Rows</strong>, <strong>Average Row Length</strong>, and <strong>Chain Rows</strong> properties.</td>
</tr>
<tr>
<td></td>
<td><strong>Extents</strong> lets you view the <strong>Number of Extents</strong> and <strong>Maximum Extents</strong> values.</td>
</tr>
<tr>
<td>LOB columns</td>
<td>Lets you work with settings in the following categories:</td>
</tr>
<tr>
<td></td>
<td><strong>LOB Column Segment and LOB Column Index</strong> lets you view the <strong>Segment Name</strong>, <strong>No. of Extents</strong>, <strong>Max Extents</strong>, <strong>Size</strong>, and <strong>Blocks</strong> properties.</td>
</tr>
<tr>
<td></td>
<td><strong>Segment Extents and Index Extents</strong> lets you view the <strong>Extent ID</strong>, <strong>File ID</strong>, <strong>Block ID</strong> and number of <strong>Blocks</strong> properties for segment and index extents.</td>
</tr>
<tr>
<td>Partition</td>
<td>Lets you work with table partitions</td>
</tr>
<tr>
<td>Comment</td>
<td>For details on using this tab, see &quot;Adding a Comment to an object&quot; on page 450.</td>
</tr>
<tr>
<td>Dependencies</td>
<td>For details on using this tab, see &quot;Working with Object Dependencies&quot; on page 449.</td>
</tr>
<tr>
<td>Permissions</td>
<td>For details on using this tab, see &quot;Working with Privileges and Permissions&quot; on page 447.</td>
</tr>
<tr>
<td>DDL View</td>
<td>For details on using this tab, see &quot;Viewing the SQL/DDL for an Object&quot; on page 447.</td>
</tr>
</tbody>
</table>

3. When finished, you can submit your changes. For details, see "Previewing and Submitting Object Editor Changes" on page 450.
TABLESPACES EDITOR (ORACLE)

The Tablespaces Editor lets you manage datafiles, space, storage, quotas, and objects for a tablespace.

To edit a tablespace

1. Open an editor on the tablespace. For details, see "Opening an Object Editor" on page 444.

2. Use the following table as a guide to understanding and modifying the settings on the tabs of this editor:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Datafiles</td>
<td>The tab lists details for each datafile on the tablespace. Optionally you can add or delete files or edit file attributes. For detailed information on using this tab, see &quot;Tablespaces (Oracle) - Datafiles&quot; on page 411.</td>
</tr>
<tr>
<td>Properties</td>
<td>This tab lets you view the Name, Big File, Type, Encrypted, Locally Managed, Minimum Extent Size, Uniform Allocation, Use Default Block Size, Block Size, Automatic Segment Space Management, Initial Extent, Next Extent, Minimum Extents, Maximum Extents, and Percent Increase properties. This tab lets you modify the Status, Logging, Force Logging, and Compression Type properties. For more information on these properties, see &quot;Tablespaces (Oracle) - Properties&quot; on page 409.</td>
</tr>
<tr>
<td>Extent Details</td>
<td>Provides details (Name, Type, File ID, Extent ID, Block ID, Blocks, and Bytes) for each extent in the tablespace.</td>
</tr>
<tr>
<td>Space</td>
<td>Displays free blocks versus used blocks statistics for the tablespace, including a pie chart representation.</td>
</tr>
<tr>
<td>Map</td>
<td>This tab presents a graphical, segment map of the tablespace. The map is color-coded to show usage of each segment (FREE, SELECTED, OTHER, TEMPORARY, ROLLBACK, CACHE, TABLE, INDEX, TABLE PARTITION, NESTED TABLE, INDEX PARTITION, INDEX SUBPARTITION, TEXT, CLUSTER, LOB, LOBSEGMENT, LOBINDEX, or LOB PARTITION). Optionally you can:</td>
</tr>
<tr>
<td></td>
<td>Click Legend to view the color legend of the map.</td>
</tr>
<tr>
<td></td>
<td>Hover the mouse over a segment to display its Segment ID, Block ID, Size (kb), Size (in blocks), Tablespace File ID, and Segment Type details.</td>
</tr>
<tr>
<td></td>
<td>Click Display to open a window that aids in navigating the graphical segment map. The Overview window displays a smaller version of the segment map. The selected area can be dragged up and down the window, displaying the selected area in the larger, main map. The selected area can also be resized, to display a larger or smaller area in the main map.</td>
</tr>
<tr>
<td></td>
<td>Select an INDEX or TABLE segment on the map and click Reorganize to initiate a Rebuild Indexes or Reorganize (respectively) action. For details, see &quot;Rebuild Index&quot; on page 657 and &quot;Reorganize /Reorg&quot; on page 664.</td>
</tr>
<tr>
<td></td>
<td>The Object Demographics area provides a tabular representation of the tablespace map. It provides details on a segment-by-segment basis.</td>
</tr>
<tr>
<td></td>
<td>For background information, see &quot;About Oracle Tablespace Storage&quot; on page 549.</td>
</tr>
</tbody>
</table>
When finished, you can submit your changes. For details, see "Previewing and Submitting Object Editor Changes" on page 450.

Adding or Editing User Tablespace Quotas

When you assign a quota:

- Users with privileges to create certain types of objects can create those objects in the specified tablespace.
- Oracle limits the amount of space that can be allocated for storage of a user’s objects within the specified tablespace to the amount of the quota. Users with privileges to create certain types of objects can create those objects in the specified tablespace.

**NOTE:** This functionality is available for Oracle only.

User tablespace quotas are added and modified from the Tablespaces editor. For more information, see "Tablespaces Editor (Oracle)" on page 547.

The table below describes the options and functionality on the Add User Quota... or Edit User Quota... dialogs:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>User selection list</td>
<td>Lets you select one or more users to assign a quota.</td>
</tr>
<tr>
<td></td>
<td>(Add only)</td>
</tr>
<tr>
<td>Quota</td>
<td>Lets you set a quota for the selected user or users. You can select an unlimited, or a specified size.</td>
</tr>
<tr>
<td></td>
<td>Unlimited - Lets you place an unlimited quota on the tablespace.</td>
</tr>
<tr>
<td></td>
<td>Other - Lets you place a specified quota in KB or MB on the tablespace.</td>
</tr>
</tbody>
</table>
ABOUT ORACLE TABLESPACE STORAGE
The Storage tab of the Tablespace Editor lets you view storage details for tablespaces on the current datasource.

**TIP:** Always create tablespaces for user data and never place user tables and indexes in the SYSTEM tablespace. Placing user objects in the SYSTEM tablespace can degrade performance and introduce space-related headaches to the database.

Oracle or later supports locally managed tablespaces, which can all but eliminate the problem of tablespace fragmentation. It totally does away with the storage parameters of MINEXTENTS, MAXEXENTS, PCTINCREASE, and NEXT. With locally managed tablespaces you either specify the initial extent size and let Oracle automatically size all other extents, or specify a uniform extent size for everything.

**TIP:** One of the best ways to avoid fragmentation in a tablespace is to pre-allocate the space that your objects will use. If possible, plan for one to two years’ growth for each object and allocate your space accordingly. Having initial empty objects will not affect table scan times as Oracle only scans up to the high-water mark (the last used block) in a table.

Of all your tablespaces, you want to avoid fragmentation problems in your SYSTEM tablespace the most as this is the major hotbed tablespace for Oracle activities. The easiest way to avoid this is to not allow any user (even the default DBA ID’s SYS and SYSTEM) to have access to it. There are three ways to do this:

- Ensure no user has a DEFAULT or TEMPORARY tablespace assignment of SYSTEM.
- Ensure no user has a quota set for SYSTEM.

Ensure no user has been granted the UNLIMITED TABLESPACE privilege.

TRIGGERS EDITOR (ORACLE)
The Triggers Editor lets you modify actions, events, and other details for a trigger.
To edit a trigger
1. Open an editor on the trigger. For details, see "Opening an Object Editor" on page 444.
2. Use the following table as a guide to understanding and modifying the settings on the tabs of this editor:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Properties</td>
<td>In addition to displaying basic identification and creation properties, this tab lets you work with settings in the following categories:</td>
</tr>
<tr>
<td>Attributes</td>
<td>Lets you specify whether the trigger is Enabled, select the Trigger Timing (BEFORE, AFTER, COMPOUND), and the Trigger Type (ROW, STATEMENT).</td>
</tr>
<tr>
<td>Correlation Names</td>
<td>Lets you provide an Old Table Alias and a New Table Alias as well as construct a When Clause.</td>
</tr>
<tr>
<td>Status</td>
<td>Lets you view Object Status, Create Date, Last Modified, and Base Object Type properties.</td>
</tr>
<tr>
<td>Size Information</td>
<td>Lets you view Source Size, Parsed Size, Code Size, and Error Size properties.</td>
</tr>
<tr>
<td></td>
<td>For detailed information on these properties, see &quot;Triggers (Oracle) - Properties&quot; on page 412.</td>
</tr>
<tr>
<td>Events</td>
<td>Lets you select the DDL, DML, or Database manipulation events that fire this trigger. For detailed information, see &quot;Triggers (Oracle) - Events&quot; on page 413.</td>
</tr>
<tr>
<td>Column Selection</td>
<td>For triggers firing on UPDATE events, lets you work with the associated columns. For detailed information, see &quot;Triggers (Oracle) - Column Selection&quot; on page 413.</td>
</tr>
<tr>
<td>Action</td>
<td>Lets you modify the trigger action PL/SQL block for any trigger on the datasource. You modify the body of the trigger in the Trigger Action (PL/SQL Block) area. For detailed information, see &quot;Triggers (Oracle) - Action&quot; on page 413.</td>
</tr>
<tr>
<td>Dependencies</td>
<td>For details on using this tab, see &quot;Working with Object Dependencies&quot; on page 449.</td>
</tr>
<tr>
<td>DDL View</td>
<td>For details on using this tab, see &quot;Viewing the SQL/DDL for an Object&quot; on page 447.</td>
</tr>
</tbody>
</table>

3. When finished, you can submit your changes. For details, see "Previewing and Submitting Object Editor Changes" on page 450.

**TYPE BODIES EDITOR (ORACLE)**
The Type Bodies Editor contains the code for the methods that implement an object type. To create or replace a type body in one of your schema, you must have the CREATE TYPE or CREATE ANY TYPE system privilege. To replace a type in another user’s schema, you must have the DROP ANY TYPE system privilege.

While listed as separate objects in the Datasource Navigator, type bodies are created and edited on the Body tab of the Types Editor. For details, see "Types Editor (Oracle)" on page 551.
TYPES EDITOR (ORACLE)
The Types Editor lets you manage header text and body text for a type.

To edit a type
1. Open an editor on the type. For details, see "Opening an Object Editor" on page 444.
2. Use the following table as a guide to understanding and modifying the settings on the tabs of this editor:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Header</td>
<td>Lets you manage the type header text.</td>
</tr>
<tr>
<td>Body</td>
<td>Lets you create and modify type body text for the type. For information on creating type bodies, see &quot;Object Types Wizard (Oracle)&quot; on page 414.</td>
</tr>
<tr>
<td>Information</td>
<td>Displays the header and body information for a type.</td>
</tr>
<tr>
<td>Dependencies</td>
<td>For details on using this tab, see &quot;Working with Object Dependencies&quot; on page 449.</td>
</tr>
<tr>
<td>Privileges</td>
<td>For details on using this tab, see &quot;Working with Privileges and Permissions&quot; on page 447.</td>
</tr>
</tbody>
</table>

3. When finished, you can submit your changes. For details, see "Previewing and Submitting Object Editor Changes" on page 450.

UNIQUE KEYS EDITOR (ORACLE)
The Unique Keys Editor lets you manage columns, basic properties, storage and space, and partitions for a unique key.

To edit a unique key:
1. Open an editor on the unique key. For details, see "Opening an Object Editor" on page 444.
2. Use the following table as a guide to understanding and modifying the settings on the tabs of this editor:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Columns</td>
<td>Displays a listing of the columns making up the index. Details include the Column name, the Datatype, and whether the definition allows Nulls. Optionally, you can:</td>
</tr>
<tr>
<td></td>
<td>Click the New button to add a new column to the index.</td>
</tr>
<tr>
<td></td>
<td>Select an existing column and click the Delete button to delete that column from the index.</td>
</tr>
<tr>
<td>Properties</td>
<td>In addition to displaying basic identification information, this tablets you work with settings in the following categories:</td>
</tr>
<tr>
<td>Enforcing Index</td>
<td>Lets you view User-Defined, Index Owner, and Index Name settings.</td>
</tr>
<tr>
<td>Attributes</td>
<td>Lets you set No Sort, Logging, Reverse, Validate, Deferrable, Deferred, Enabled, Cascade, Rely, and Update Date properties.</td>
</tr>
</tbody>
</table>
### Storage

<table>
<thead>
<tr>
<th>Tab</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Data Block Storage</strong></td>
<td>Lets you choose the <strong>Tablespace Name</strong>, and specify <strong>Percent Free</strong>, <strong>Initial Transactions</strong>, and <strong>Max Transactions</strong> values.</td>
</tr>
<tr>
<td><strong>Extents</strong></td>
<td>Lets you specify <strong>Initial Extent</strong>, <strong>Next Extent</strong>, <strong>Minimum Extents</strong>, <strong>Maximum Extents</strong>, and <strong>Percent Increase</strong> values.</td>
</tr>
<tr>
<td><strong>Freelists</strong></td>
<td>Free lists let you manage the allocation of data blocks when concurrent processes are issued against the cluster. Identifying multiple free lists can reduce contention for free lists when concurrent inserts take place and potentially improve the performance of the cluster. This tab lets you specify <strong>Freelists</strong> and <strong>Freelist Groups</strong> values.</td>
</tr>
<tr>
<td><strong>Buffer Pool</strong></td>
<td>Lets you select a <strong>Buffer Pool</strong>.</td>
</tr>
</tbody>
</table>

### Space

<table>
<thead>
<tr>
<th>Tab</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Space Utilization</strong></td>
<td>Displays the <strong>Size</strong> and number of <strong>Blocks</strong> properties.</td>
</tr>
<tr>
<td><strong>Statistics</strong></td>
<td>Lets you view <strong>Index Level</strong>, <strong>Distinct Keys</strong>, <strong>Cluster Factor</strong>, <strong>Leaf Blocks</strong>, <strong>Leaf Blks/Key</strong>, and <strong>Data Blks/Key</strong> settings.</td>
</tr>
<tr>
<td><strong>Extents</strong></td>
<td>The unit of space allocated to an object whenever the object needs more space. This tab lets you view <strong>Number of Extents</strong> and <strong>Maximum Extents</strong> properties.</td>
</tr>
</tbody>
</table>

### Partition

If the unique key is currently partitioned, this tab displays the following partition details:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Properties</strong></td>
<td>Lets you view the <strong>Locality</strong> (Global/Local), <strong>Alignment</strong> (Prefixed/Non-Prefixed), <strong>Partition Type</strong> (RANGE or HASH), and <strong>Subpartition type</strong> properties.</td>
</tr>
<tr>
<td><strong>Columns</strong></td>
<td>Displays partitioning columns.</td>
</tr>
<tr>
<td><strong>Partition Definitions</strong></td>
<td>Displays details for each partition.</td>
</tr>
<tr>
<td><strong>DDL View</strong></td>
<td>For details on using this tab, see &quot;Viewing the SQL/DDL for an Object&quot; on page 447.</td>
</tr>
</tbody>
</table>

3. When finished, you can submit your changes. For details, see "Previewing and Submitting Object Editor Changes" on page 450.
MODIFYING OBJECTS USING EDITORS

USERS EDITOR (ORACLE)

The Users Editor lets you manage basic properties, roles, tablespace quotas, and associated objects for a user.

To edit a user

1. Open an editor on the user. For details, see "Opening an Object Editor" on page 444.

2. Use the following table as a guide to understanding and modifying the settings on the tabs of this editor:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Properties</strong></td>
<td>Lets you work with settings in the following categories:</td>
</tr>
<tr>
<td></td>
<td><strong>Defaults</strong> - Lets you select a Default Tablespace and Temporary Tablespace as well as select the Profile used by this user. For more on creating profiles, see &quot;Profiles Wizard (Oracle)&quot; on page 392.</td>
</tr>
<tr>
<td></td>
<td><strong>Account</strong> - Identified By - Lets you select among REQUIRED YES, REQUIRED EXTERNAL, and REQUIRED_GLOBAL. Password - (available with Identified By value of REQUIRED_YES only) lets you specify a password. External Name - (available with Identified By value of REQUIRED_GLOBAL only) lets you specify the name of the user in the enterprise directory service. Account Locked - lets you lock this user account. Password Expired - (available with Identified By value of REQUIRED_YES only) lets you mark the password as expired, forcing the user to change their password before being allowed to connect.</td>
</tr>
<tr>
<td></td>
<td><strong>Role</strong> - Lets you select the roles that are to be assigned to this user.</td>
</tr>
<tr>
<td></td>
<td><strong>Quota</strong> - Lets you set tablespace quotas for the user. Set an unlimited quota by selecting a tablespace and selecting the Unlimited radio button. Set a specific quota by selecting a tablespace, selecting the Other radio button, and providing a Quota value in kilobytes or megabytes.</td>
</tr>
<tr>
<td></td>
<td><strong>Objects</strong> - Lets you manage database objects associated with a user. Objects are grouped within object type folders. Optionally, you can: Select an object and click Edit to open an object editor on the selected object. Select an object and click Drop to initiate dropping the selected object.</td>
</tr>
<tr>
<td></td>
<td><strong>Object Privileges</strong> and <strong>System Privileges</strong> - For details on using these tabs, see &quot;Working with Privileges and Permissions&quot; on page 447.</td>
</tr>
<tr>
<td></td>
<td><strong>DDL View</strong> - For details on using this tab, see &quot;Viewing the SQL/DDL for an Object&quot; on page 447.</td>
</tr>
</tbody>
</table>

3. When finished, you can submit your changes. For details, see "Previewing and Submitting Object Editor Changes" on page 450.
MODIFYING OBJECTS USING EDITORS

VIEWS EDITOR (ORACLE)
The Views Editor lets you work with view columns and manage the dependencies and permissions for the view.

To edit a view
1. Open an editor on the view. For details, see "Opening an Object Editor" on page 444.
2. Use the following table as a guide to understanding and modifying the settings on the tabs of this editor:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Properties</td>
<td>Displays a listing of the columns making up the view.</td>
</tr>
<tr>
<td>Definition</td>
<td>Lets you view and modify the DDL that will implement any changes made with the editor.</td>
</tr>
<tr>
<td>Comment</td>
<td>For details on using this tab, see &quot;Adding a Comment to an object&quot; on page 450.</td>
</tr>
<tr>
<td>Dependencies</td>
<td>For details on using this tab, see &quot;Working with Object Dependencies&quot; on page 449.</td>
</tr>
<tr>
<td>Permissions</td>
<td>For details on using this tab, see &quot;Working with Privileges and Permissions&quot; on page 447.</td>
</tr>
</tbody>
</table>

3. When finished, you can submit your changes. For details, see "Previewing and Submitting Object Editor Changes" on page 450.

PARTITIONING ORACLE INDEXES, PRIMARY KEYS, AND UNIQUE KEYS
The Add Partition wizard lets you partition an Oracle index, primary key, or unique key.

To partition an index, primary key, or unique key
1. Open an editor on the index, primary key, or unique key. For details, see "Opening an Object Editor" on page 444.
2. On the Partition tab, click Convert to Partitioned.
   NOTE: If the object is already partitioned, the Convert to Partitioned button is not present.
3. Use the following table as a guide to understanding and modifying the settings on the tabs of this editor:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Properties</td>
<td>In addition to displaying basic identification and ownership properties, this pane lets you work with the following settings:</td>
</tr>
<tr>
<td></td>
<td>Locality - GLOBAL or LOCAL.</td>
</tr>
<tr>
<td></td>
<td>Alignment - displays whether this partitioned object is prefixed or non-prefixed.</td>
</tr>
<tr>
<td></td>
<td>Partition Type - RANGE or HASH.</td>
</tr>
<tr>
<td></td>
<td>Subpartition Type - displays the subpartition type.</td>
</tr>
<tr>
<td>Columns</td>
<td>For each column to be added, click New to add a column, select a Column name, and specify a Sort order.</td>
</tr>
</tbody>
</table>
MODIFYING OBJECTS USING EDITORS

<table>
<thead>
<tr>
<th>Tab</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Range Definitions</strong> (only available for a <strong>Partition Type</strong> of <strong>RANGE</strong>)</td>
<td>Lets you create an ordered list of partitions. For each partition, click <strong>New</strong> to open the Add Partition Definition wizard. On the Partition Definition pane, provide a Name, select a Tablespace, and enable or disable Logging. On the Storage pane, provide <strong>Data Block Storage, Extents, and Freelists</strong> property values. Click <strong>Add</strong>. The Range Definitions pane also lets you edit and remove partitions.</td>
</tr>
</tbody>
</table>
| **Hash Definitions** (only available for a **Partition Type** of **HASH**) | Lets you specify a Partition method:  
  - **None**  
  - **Number of Partitions** - Specify a **Number of Partitions**, and then for each partition, click the New button and select a tablespace.  
  - **By Partition Name** - For each partition, click **New**, specify a Name and select a Tablespace. |

4 When ready, click **Finish**.

SYBASE ASE OBJECT EDITORS

Rapid SQL includes an Object Editor for all supported Sybase ASE objects. To see an Editor for a specific object, click the corresponding link below:

NOTE: If an objects has dependent objects, such as tables, triggers, procedures and views, you can view and access their dependent objects in the editor.

- [Aliases Editor (Sybase ASE)](
- [Check Constraints Editor (Sybase ASE)](
- [Databases Editor (Sybase ASE)](
- [Defaults Editor (Sybase ASE)](
- [Extended Procedures Editor (Sybase ASE)](
- [Foreign Keys Editor (Sybase ASE)](
- [Functions Editor (Sybase ASE)](
- [Groups Editor (Sybase ASE)](
- [Indexes Editor (Sybase ASE)](
- [Logins Editor (Sybase ASE)](
- [Primary Keys Editor (Sybase ASE)](
- [Procedures Editor (Sybase ASE)](
- [Rules Editor (Sybase ASE)](
- [Segments Editor (Sybase ASE)](
- [Tables Editor (Sybase ASE)](

RAPID SQL XE4/8.5 USER GUIDE 555
MODIFYING OBJECTS USING EDITORS

- **Triggers Editor (Sybase ASE)**
- **Unique Keys Editor (Sybase ASE)**
- **User Datatypes Editor (Sybase ASE)**
- **Users Editor (Sybase ASE)**
- **Users Editor (Sybase ASE)**

For access to object editors for different supported DBMS platforms and an introduction to editor usage, see "Modifying objects using editors" on page 443.

**ALIASES EDITOR (SYBASE ASE)**
The Aliases Editor lets you view and modify an alias definition.

**To edit an alias**

1. Open an editor on the alias. For details, see "Opening an Object Editor" on page 444.
2. Use the following table as a guide to understanding and modifying the settings on the tabs of this editor:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Properties</strong></td>
<td>Lets you change the user referenced by the alias.</td>
</tr>
<tr>
<td><strong>DDL View</strong></td>
<td>For details on using this tab, see &quot;Viewing the SQL/DDL for an Object&quot; on page 447.</td>
</tr>
</tbody>
</table>

3. When finished, you can submit your changes. For details, see "Previewing and Submitting Object Editor Changes" on page 450.

**CHECK CONSTRAINTS EDITOR (SYBASE ASE)**
The Check Constraints Editor lets you manage a check constraint definition and modify the condition expression.
To edit a check constraint
1. Open an editor on the check constraint. For details, see "Opening an Object Editor" on page 444.

2. Use the following table as a guide to understanding and modifying the settings on the tabs of this editor:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Definition</strong></td>
<td>Lets you edit the condition in the Check Condition box. The Table Columns button acts a time saver in editing the condition. It opens a dialog that lets you select and paste column names into the check condition expression. NOTE: If the Check Condition box shows a Source text for this compiled object is hidden message, source text for this compiled object has been hidden. For more information, see Hide Text.</td>
</tr>
<tr>
<td><strong>DDL View</strong></td>
<td>For details on using this tab, see Viewing the SQL/DDL for an Object *on page 447.</td>
</tr>
</tbody>
</table>

3. When finished, you can submit your changes. For details, see "Previewing and Submitting Object Editor Changes" on page 450.

DATABASES EDITOR (SYBASE ASE)
The Databases Editor lets you manage properties, placement, and binds for a database as well as view associated space statistics.

To edit a database
1. Open an editor on the database. For details, see "Opening an Object Editor" on page 444.

2. Use the following table as a guide to understanding and modifying the settings on the tabs of this editor:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Properties</strong></td>
<td>For information on working with these settings, see Databases (Sybase ASE) -&gt; Properties *on page 421.</td>
</tr>
<tr>
<td><strong>Placement</strong></td>
<td>Displays device fragments. Optionally you can:</td>
</tr>
<tr>
<td></td>
<td>Select a fragment to view the Device Name, Size, and Device Type (DATA AND LOG or DATA ONLY) for the fragment.</td>
</tr>
<tr>
<td></td>
<td>Click the New button to open a dialog that lets you provide the data device and log device details for a new database fragment. NOTE: We strongly recommend that you place the transaction log on a separate device from all other database fragments.</td>
</tr>
<tr>
<td><strong>Space</strong></td>
<td>Lets you view pie charts showing the data space usage and the transaction log (if available) space usage for the database.</td>
</tr>
<tr>
<td><strong>Bindings</strong></td>
<td>This tab is only available for databases created with a Type of TEMP. It displays all applications or logins bound to the database. Optionally, you can:</td>
</tr>
</tbody>
</table>
When finished, you can submit your changes. For details, see "Previewing and Submitting Object Editor Changes" on page 450.

**DEFAULTS EDITOR (SYBASE ASE)**

The Defaults Editor lets you modify the value and manage bindings for a default.

**To edit a default**

1. Open an editor on the default. For details, see "Opening an Object Editor" on page 444.

2. Use the following table as a guide to understanding and modifying the settings on the tabs of this editor:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Properties</td>
<td>Lets you change the Value of the default.</td>
</tr>
<tr>
<td></td>
<td>NOTE: If the Value box shows a Source text for this compiled object is hidden message, source text for this compiled object has been hidden. For more information, see &quot;Hide Text&quot; on page 640.</td>
</tr>
<tr>
<td>Dependencies</td>
<td>For details on using this tab, see &quot;Working with Object Dependencies&quot; on page 449.</td>
</tr>
<tr>
<td>DDL View</td>
<td>For details on using this tab, see &quot;Viewing the SQL/DDL for an Object&quot; on page 447.</td>
</tr>
</tbody>
</table>

When finished, you can submit your changes. For details, see "Previewing and Submitting Object Editor Changes" on page 450.

**EXTENDED PROCEDURES EDITOR (SYBASE ASE)**

The Procedures Editor lets you view and modify an extended procedure definition.
To edit an extended procedure

1. Open an editor on the extended procedure. For details, see "Opening an Object Editor" on page 444.

2. Use the following table as a guide to understanding and modifying the settings on the tabs of this editor:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Properties</td>
<td>Lets you specify the <strong>Library Name</strong> for the extended procedure.</td>
</tr>
<tr>
<td></td>
<td><strong>NOTE:</strong> If the <strong>Library Name</strong> box shows a Source text for this compiled object is hidden message, source text for this compiled object has been hidden. For more information, see &quot;Hide Text&quot; on page 640.</td>
</tr>
<tr>
<td>DDL View</td>
<td>For details on using this tab, see Viewing the SQL/DDL for an Object.</td>
</tr>
<tr>
<td>Dependencies</td>
<td>For details on using this tab, see &quot;Working with Object Dependencies&quot; on page 449.</td>
</tr>
<tr>
<td>Permissions</td>
<td>For details on using this tab, see &quot;Working with Privileges and Permissions&quot; on page 447.</td>
</tr>
</tbody>
</table>

3. When finished, you can submit your changes. For details, see "Previewing and Submitting Object Editor Changes" on page 450.

**FOREIGN KEYS EDITOR (SYBASE ASE)**
The Foreign Keys Editor lets you modify the column mapping and specify properties of a foreign key.

To edit a foreign key

1. Open an editor on the foreign key. For details, see "Opening an Object Editor" on page 444.

2. Use the following table as a guide to understanding and modifying the settings on the tabs of this editor:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Column Mappings</td>
<td>The existing column mapping for the foreign key is represented by selected columns in the <strong>Main Table</strong> and <strong>Referenced Table</strong> lists. Additional candidates in the <strong>Referenced Table</strong> list are indicated by enabled column check boxes. If necessary, use the <strong>Table</strong> dropdown in the <strong>Referenced Table</strong> group to choose a new table for this foreign key. Select or deselect columns in the <strong>Main Table</strong> list and <strong>Referenced Table</strong> list to form the referential constraint between the two tables.</td>
</tr>
<tr>
<td>Properties</td>
<td>Lets you specify a <strong>Match Full</strong> value of TRUE or FALSE.</td>
</tr>
<tr>
<td>DDL View</td>
<td>For details on using this tab, see &quot;Viewing the SQL/DDL for an Object&quot; on page 447.</td>
</tr>
</tbody>
</table>

3. When finished, you can submit your changes. For details, see "Previewing and Submitting Object Editor Changes" on page 450.
FUNCTIONS EDITOR (SYBASE ASE)
The Functions Editor lets you view and modify the body of a function, as well as work with permissions and dependencies.

To edit a function:
1. Open an editor on the function. For details, see "Opening an Object Editor" on page 444.
2. Use the following table as a guide to understanding and modifying the settings on the tabs of this editor:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Settings and tasks</th>
</tr>
</thead>
</table>
| Definition   | Lets you view and modify the CREATE FUNCTION statement, including the function body, for the function.  
                  NOTE: If the Definition tab for the function shows a Source text for this compiled object is hidden message, source text for this compiled object has been hidden. For more information, see "Hide Text" on page 640. |
| Dependencies | For details on using this tab, see "Working with Object Dependencies" on page 449. |
| Permissions  | For details on using this tab, see "Working with Privileges and Permissions" on page 447. |

3. When finished, you can submit your changes. For details, see "Previewing and Submitting Object Editor Changes" on page 450.

GROUPS EDITOR (SYBASE ASE)
The Groups Editor lets you manage users in a group and the group’s associated privileges.

TIP: The refresh button lets you refresh or clear the editor’s contents, and log SQL.

To edit a group:
1. Open an editor on the group. For details, see "Opening an Object Editor" on page 444.
2. Use the following table as a guide to understanding and modifying the settings on the tabs of this editor:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Users</td>
<td>Lets you add users to, or remove users from the group. To move a user from one of the Users Not In Group or Users In Group lists to the other list, select the user in the list and click the Join Group or Leave Group button.</td>
</tr>
<tr>
<td>Object Privileges</td>
<td>For details on using this tab, see &quot;Working with Privileges and Permissions&quot; on page 447.</td>
</tr>
<tr>
<td>System Privileges</td>
<td>For details on using this tab, see &quot;Working with Privileges and Permissions&quot; on page 447.</td>
</tr>
<tr>
<td>DDL</td>
<td>For details on using this tab, see &quot;Viewing the SQL/DDL for an Object&quot; on page 447.</td>
</tr>
</tbody>
</table>

3. When finished, you can submit your changes. For details, see "Previewing and Submitting Object Editor Changes" on page 450.
INDEXES EDITOR (SYBASE ASE)

The Indexes Editor lets you manage columns, properties, and partitions, and view statistics for an index.

To edit an index

1. Open an editor on the index. For details, see "Opening an Object Editor" on page 444.

2. Use the following table as a guide to understanding and modifying the settings on the tabs of this editor:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Columns</td>
<td>Lets you manage columns that make up the index. On opening, this tab shows the existing columns. For each column, the datatype (and if applicable the precision in brackets) and whether the table definition permits nulls in the target table column. Optionally you can:</td>
</tr>
<tr>
<td></td>
<td>Change the Sort order of a column.</td>
</tr>
<tr>
<td></td>
<td>Click the New button and select a column name from the dropdown, to add a column to the index.</td>
</tr>
<tr>
<td></td>
<td>Select a column and click the Drop button to delete the column from the index.</td>
</tr>
<tr>
<td></td>
<td>Select a column and use the arrow buttons to reorder the columns in the index.</td>
</tr>
<tr>
<td>Properties</td>
<td>Lets you work with settings in the following categories:</td>
</tr>
<tr>
<td>Attributes</td>
<td>Has the Index Type (UNIQUE or NONUNIQUE), Clustered, Ignore Duplicate Key (available with Index Type of UNIQUE), Ignore Duplicate Rows (available with Clustered enabled), Allow Duplicate Rows (available with Clustered enabled), and Maximum Rows Per Page properties.</td>
</tr>
<tr>
<td>Storage</td>
<td>Lets you set Reserve Page Gap, Segment Name, Fill Factor, Prefetch Strategy, MRU Replacement Strategy settings</td>
</tr>
<tr>
<td>Partition</td>
<td>Lets you work with settings in the following categories:</td>
</tr>
<tr>
<td>Properties</td>
<td>Lets you view the Locality (Global/Local), Alignment (Prefixed/Non-Prefixed), Partition Type (including Range-Hash Composite or Range-List Composite), and Subpartition type properties.</td>
</tr>
<tr>
<td>Columns</td>
<td>Displays partitioning columns.</td>
</tr>
<tr>
<td>Partition Definitions</td>
<td>Displays details for each partition.</td>
</tr>
<tr>
<td>Statistics</td>
<td>Lets you view statistics in the following categories:</td>
</tr>
<tr>
<td>Page Statistics</td>
<td>Data Pages, Reserved Pages, Used Pages, OAM Page Ratio, and Index Page Ratio.</td>
</tr>
<tr>
<td>Row Statistics</td>
<td>Maximum Row Size, Minimum Row Size, Max Size of Non-Leaf Index Row, and Maximum Rows Per Page.</td>
</tr>
<tr>
<td>DDL View</td>
<td>For details on using this tab, see &quot;Viewing the SQL/DDL for an Object&quot; on page 447.</td>
</tr>
</tbody>
</table>

3. When finished, you can submit your changes. For details, see "Previewing and Submitting Object Editor Changes" on page 450.
LOGINS EDITOR (SYBASE ASE)
The Logins Editor lets you manage basic properties for a login, associated users and roles, and accounting.

To edit a login:
1. Open an editor on the login. For details, see "Opening an Object Editor" on page 444.
2. Use the following table as a guide to understanding and modifying the settings on the tabs of this editor:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Properties</td>
<td>Lets you work with the following properties set when creating the login: Name, FullName, Default database, Default language, Locked, Password, Password expiration, Minimum password length, Maximum Login attempts, and Authentication Mechanism. For detailed information on these settings, see &quot;Logins Wizard (Sybase ASE)&quot; on page 427. In addition, when editing an existing login, you have access to the following settings:</td>
</tr>
<tr>
<td></td>
<td>Is currently logged in Displays whether the user is currently logged in.</td>
</tr>
<tr>
<td></td>
<td>Login trigger Displays the login trigger currently configured for this login. This is the stored procedure automatically executed when the user logs on. For information on configuring login triggers for a login, see &quot;Add/Modify Login Trigger&quot; on page 581 and &quot;Drop Login Trigger&quot; on page 624.</td>
</tr>
<tr>
<td>Users</td>
<td>Lets you maintain database user accounts for a login. For more detailed information, see &quot;Logins (Sybase ASE) - Users&quot; on page 429.</td>
</tr>
<tr>
<td>Roles</td>
<td>Lets you maintain the roles granted to this login. For more detailed information, see &quot;Logins (Sybase ASE) - Users&quot; on page 429. For information on activating and deactivating roles for the current login in the current session, see &quot;Role Activation&quot; on page 681.</td>
</tr>
<tr>
<td>Accounting</td>
<td>The Accounting tab of the Logins Editor lets you manage chargeback accounting statistics for every login on the current server. Chargeback accounting statistics are CPU and I/O usage statistics that Sybase ASE accumulates for every login. To start a new accounting period, the system administrator must clear all previous login statistics. Optionally, you can click the Clear Statistics button to start a new accounting interval. The Clear Statistics dialog lets you clear statistics immediately or use scheduling options.</td>
</tr>
<tr>
<td>DDL</td>
<td>For details on using this tab, see &quot;Viewing the SQL/DDL for an Object&quot; on page 447.</td>
</tr>
</tbody>
</table>

3. When finished, you can submit your changes. For details, see "Previewing and Submitting Object Editor Changes" on page 450.

PRIMARY KEYS EDITOR (SYBASE ASE)
The Primary Keys Editor lets you manage the columns that make up the primary key and its basic properties, as well as view statistics for the primary key.
To edit a primary key

1. Open an editor on the primary key. For details, see "Opening an Object Editor" on page 444.

2. Use the following table as a guide to understanding and modifying the settings on the tabs of this editor:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Columns</td>
<td>Lets you manage columns that make up the primary key. On opening, this tab shows the existing columns. For each column, the datatype (and if applicable the precision in brackets) and whether the table definition permits nulls in the target table column. Optionally you can:</td>
</tr>
<tr>
<td></td>
<td>Change the Sort order of a column.</td>
</tr>
<tr>
<td></td>
<td>Click the New button and select a column name from the dropdown, to add a column to the primary key.</td>
</tr>
<tr>
<td></td>
<td>Select a column and click the Drop button to delete the column from the primary key.</td>
</tr>
<tr>
<td></td>
<td>Select a column and use the arrow buttons to reorder the columns in the primary key.</td>
</tr>
<tr>
<td>Properties</td>
<td>Lets you work with settings in the following categories:</td>
</tr>
<tr>
<td>Attributes</td>
<td>Lets you set the Clustered and Maximum Rows Per Page properties.</td>
</tr>
<tr>
<td>Storage</td>
<td>Lets you set Reserve Page Gap, Segment (DEFAULT, LOGSEGMENT or SYSTEM), and Fill Factor properties.</td>
</tr>
<tr>
<td>Statistics</td>
<td>Lets you view statistics in the following categories:</td>
</tr>
<tr>
<td>Page Statistics</td>
<td>Data Pages, Reserved Pages, Used Pages, OAM Page Ratio, and Index Page Ratio.</td>
</tr>
<tr>
<td>Row Statistics</td>
<td>Maximum Row Size, Minimum Row Size, Max Size of Non-Leaf Index Row, and Maximum Rows Per Page.</td>
</tr>
<tr>
<td>DDL View</td>
<td>For details on using this tab, see &quot;Viewing the SQL/DDL for an Object&quot; on page 447.</td>
</tr>
</tbody>
</table>

3. When finished, you can submit your changes. For details, see "Previewing and Submitting Object Editor Changes" on page 450.

**PROCEDURES EDITOR (SYBASE ASE)**

The Procedures Editor lets you view and modify procedure definitions and modify associated privileges and dependencies.
MODIFYING OBJECTS USING EDITORS

To edit a procedure
1. Open an editor on the procedure. For details, see "Opening an Object Editor" on page 444.
2. Use the following table as a guide to understanding and modifying the settings on the tabs of this editor:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Definition</td>
<td>Lets you modify the SQL code for a procedure.</td>
</tr>
<tr>
<td></td>
<td>NOTE: If the Definition tab for the procedure shows a Source text for this compiled object is hidden message, source text for this compiled object has been hidden. For more information, see &quot;Hide Text&quot; on page 640.</td>
</tr>
<tr>
<td>Dependencies</td>
<td>For details on using this tab, see &quot;Working with Object Dependencies&quot; on page 449.</td>
</tr>
<tr>
<td>Permissions</td>
<td>For details on using this tab, see &quot;Working with Privileges and Permissions&quot; on page 447.</td>
</tr>
</tbody>
</table>

3. When finished, you can submit your changes. For details, see "Previewing and Submitting Object Editor Changes" on page 450.

RULES EDITOR (SYBASE ASE)
The Rules Editor lets you modify basic properties of a rule.

To edit a rule
1. Open an editor on the rule. For details, see "Opening an Object Editor" on page 444.
2. Use the following table as a guide to understanding and modifying the settings on the tabs of this editor:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Properties</td>
<td>Lets you specify a Restriction and select a Type (STANDARD_RULE, AND_ACCESS_RULE, OR_ACCESS_RULE).</td>
</tr>
<tr>
<td></td>
<td>NOTE: If the Restriction box shows a Source text for this compiled object is hidden message, source text for this compiled object has been hidden. For more information, see &quot;Hide Text&quot; on page 640.</td>
</tr>
<tr>
<td>Dependencies</td>
<td>For details on using this tab, see &quot;Working with Object Dependencies&quot; on page 449.</td>
</tr>
<tr>
<td>DDL View</td>
<td>For details on using this tab, see &quot;Viewing the SQL/DDL for an Object&quot; on page 447.</td>
</tr>
</tbody>
</table>

3. When finished, you can submit your changes. For details, see "Previewing and Submitting Object Editor Changes" on page 450.

SEGMENTS EDITOR (SYBASE ASE)
The Segments Editor lets you manage segment location, associated objects, segment space, and segment thresholds.
To edit a segment

1. Open an editor on the segment. For details, see [Opening an Object Editor](#).

2. Use the following table as a guide to understanding and modifying the settings on the tabs of this editor:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Properties</strong></td>
<td>This tab lets you view the <strong>Name</strong> and <strong>Max Size</strong> settings you specified when creating the segment. It also lets you change the <strong>Grow By</strong> and <strong>Threshold Free Space</strong> settings. For information on these settings, see &quot;Segments (Sybase ASE) - Properties&quot; on page 433. This tab also displays a <strong>Hysteresis</strong> value, the global variable <code>@thresh_hysteresis</code>, that controls threshold sensitivity to variations in free space.</td>
</tr>
<tr>
<td><strong>Location</strong></td>
<td>Lets you <strong>Drop</strong> or <strong>Extend</strong> selected segments.</td>
</tr>
<tr>
<td><strong>Objects</strong></td>
<td>Lets you manage database objects associated with the segment. Objects are organized in a tree structure. You can open an object editor on a table, index, or constraint by double-clicking that object. For information on specific editors, see &quot;Sybase ASE Object Editors&quot; on page 555.</td>
</tr>
<tr>
<td><strong>Space</strong></td>
<td>Displays a summary of segment space distribution, broken down into data, indexes, unused, and other. Also provides reserved, data, indexes, and unused space values for each object on the segment.</td>
</tr>
<tr>
<td><strong>Threshold</strong></td>
<td>Displays a list of the free pages thresholds for the segment. For a selected threshold, the <strong>Property/Value</strong> list displays the associated procedure name. Optionally you can:</td>
</tr>
<tr>
<td></td>
<td>- Click the <strong>Add</strong> button to specify the number of free pages and procedure name for a new segment threshold.</td>
</tr>
<tr>
<td></td>
<td>- Select an existing threshold and modify the threshold’s procedure name value.</td>
</tr>
<tr>
<td></td>
<td>- Select an existing threshold and click the <strong>Delete</strong> button to delete that threshold</td>
</tr>
<tr>
<td><strong>DDL</strong></td>
<td>For details on using this tab, see <a href="#">Viewing the SQL/DDL for an Object</a>.</td>
</tr>
</tbody>
</table>

3. When finished, you can submit your changes. For details, see "Previewing and Submitting Object Editor Changes" on page 450.

**TABLES EDITOR (SYBASE ASE)**

The Tables Editor lets you manage columns, basic properties, constraints, storage and space, and partitions of a table.

---

RAPID SQL XE4/8.5 USER GUIDE 565
To edit a table

1. Open an editor on the table. For details, see "Opening an Object Editor" on page 444.

2. Use the following table as a guide to understanding and modifying the settings on the tabs of this editor:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Settings and tasks</th>
</tr>
</thead>
</table>
| **Columns**          | Displays the currently defined columns in the table. For any selected column, the Property/Value list provides additional detail on that column. Available properties depend on the datatype you choose as well as on the property values you select:  
  **Computed** and **Computed Expression** - Let you define a column as a computed column and provide the computed column expression.  
  **Type** - Lets you select a datatype (depending on the type, additional properties such as **Size**, **Width**, and **Scale** may be available).  
  **Identity Column** - Select this check box to define the column as an identity column.  
  **Allow Nulls** - Select this check box to allow nulls in this column.  
  **Default Collation** - available for text/character datatypes, lets you specify a default collation.  
  **Default Value** - Lets you type a constant value or select a function returning a constant value to serve as the default for the column  
  **Default Binding** and **Rule Binding** - Let you bind a rule or default to a column. Optionally, you can:  
  - Select a column, and in the Property/Value list modify property values for that column.  
  - Click **Add Column**, provide a name for the new column, and set property values for the column.  
  - Select a column and click **Delete** to remove the column from the table. |
| **Properties**       | Lets you work with properties in the following categories:  
  **Physical Storage** - Lets you set the **Segment Name** (DEFAULT, SYSTEM), **Maximum Rows Per Page**, **Reserve Page Gap**, and **Identity Gap** properties.  
  **Cache Strategy** - Lets you set **MRU Replacement Strategy** and **Prefetch Strategy** properties.  
  **Row Locking Strategy** - Lets you view the **Expected Row Size** property and set the **Lock Scheme** (ALLPAGES, DATAPAGES, ROWPAGES) property. |
| **Indexes**          | Lets you manage indexes for a table. On opening, the list of current indexes for the table is displayed. Optionally, take one of the following actions:  
  - Click **Add** to open a dialog that lets you add a new index to the table.  
  - Select an index and click **Edit** to open a dialog that lets you edit index properties.  
  - Select an index and click **Drop** to open a dialog that lets you remove the index from the table. |
3 When finished, you can submit your changes. For details, see "Previewing and Submitting Object Editor Changes" on page 450.

### Partitioning Sybase ASE Tables

The **Create Partition** and **Edit Partition** wizards let you work with table partitions.

#### To create or edit table partitions

1. Open an editor on a table. For details, see "Opening an Object Editor" on page 444.
2. On the **Partition** tab, click the **Create Partition** or **Edit Partition** button.
3. Use the following table as a guide to understanding and modifying the settings on the tabs of this wizard:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Properties</strong></td>
<td>In addition to displaying basic identification and ownership properties, this pane lets you select a <strong>Partition Type</strong> (ROUNDROBIN, HASH, LIST, RANGE).</td>
</tr>
<tr>
<td><strong>Columns</strong> (not available for a <strong>Partition Type</strong> of ROUNDROBIN)</td>
<td>For each column to be added, click <strong>New</strong> to add a column and select a <strong>Column</strong> name.</td>
</tr>
<tr>
<td><strong>Range Definitions</strong> (only available for a <strong>Partition Type</strong> of RANGE)</td>
<td>Lets you create an ordered list of partitions. For each partition, click <strong>New</strong> to open the Add Partition Definition wizard. Provide a <strong>Name</strong>, select a <strong>Segment</strong>, (DEFAULT, SYSTEM, LOGSEGMENT) and click <strong>Add</strong>. The <strong>Range Definitions</strong> pane also lets you edit and remove partitions.</td>
</tr>
</tbody>
</table>
When ready, click **Finish**.

**TRIGGERS EDITOR (SYBASE ASE)**
The Triggers Editor lets you modify the trigger body of a trigger and change its enabled/disabled status.

To edit a trigger:
1. Open an editor on the trigger. For details, see "Opening an Object Editor" on page 444.
2. Use the following table as a guide to understanding and modifying the settings on the tabs of this editor:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Properties</strong></td>
<td>Lets you view the basic identifying properties of the trigger and its parent view or table: <strong>Parent Type</strong>, <strong>Parent Owner</strong>, <strong>Parent Name</strong>, <strong>Owner</strong>, <strong>Name</strong>, <strong>Create Date</strong>, <strong>Fire On Insert</strong>, <strong>Fire On Update</strong>, and <strong>Fire On Delete</strong>. For details on these properties, see &quot;Triggers (Sybase ASE) - Properties&quot; on page 437. This panel also lets you specify whether the trigger is Enabled.</td>
</tr>
<tr>
<td><strong>Definition</strong></td>
<td>Lets you modify the CREATE TRIGGER body for a trigger. To modify a trigger, Rapid SQL must drop then create the trigger. NOTE: If the Definition tab for the trigger shows a Source text for this compiled object is hidden message, source text for this compiled object has been hidden. For more information, see &quot;Hide Text&quot; on page 640.</td>
</tr>
<tr>
<td><strong>Dependencies</strong></td>
<td>For details on using this tab, see &quot;Working with Object Dependencies&quot; on page 449.</td>
</tr>
</tbody>
</table>

3. When finished, you can submit your changes. For details, see "Previewing and Submitting Object Editor Changes" on page 450.

**UNIQUE KEYS EDITOR (SYBASE ASE)**
The Unique Keys Editor lets you manage the columns and basic properties for a unique key as well as view page and row statistics.
To edit a unique key
1. Open an editor on the unique key. For details, see "Opening an Object Editor" on page 444.
2. Use the following table as a guide to understanding and modifying the settings on the tabs of this editor:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Columns</td>
<td>Lets you manage columns that make up the unique key. On opening, this tab shows the existing columns. For each column, the datatype (and if applicable the precision in brackets) and whether the table definition permits nulls in the target table column. Optionally you can:</td>
</tr>
<tr>
<td></td>
<td>Change the Sort order of a column.</td>
</tr>
<tr>
<td></td>
<td>Click the New button and select a column name from the dropdown, to add a column to the index.</td>
</tr>
<tr>
<td></td>
<td>Select a column and click the Drop button to delete the column from the index.</td>
</tr>
<tr>
<td></td>
<td>Select a column and use the arrow buttons to reorder the columns in the index.</td>
</tr>
<tr>
<td>Properties</td>
<td>Lets you work with properties in the following categories:</td>
</tr>
<tr>
<td>Attributes</td>
<td>Lets you set Clustered and Maximum Rows Per Page properties.</td>
</tr>
<tr>
<td>Storage</td>
<td>Lets you set the Reserve Page Gap, and Segment (DEFAULT, LOGSEGMENT, SYSTEM) properties.</td>
</tr>
<tr>
<td>Statistics</td>
<td>Lets you view statistics in the following categories:</td>
</tr>
<tr>
<td>Page Statistics</td>
<td>Data Pages, Reserved Pages, Used Pages, OAM Page Ratio, and Index Page Ratio.</td>
</tr>
<tr>
<td>Row Statistics</td>
<td>Maximum Row Size, Minimum Row Size, Max Size of Non-Leaf Index Row, and Maximum Rows Per Page.</td>
</tr>
<tr>
<td>DDL View</td>
<td>For details on using this tab, see &quot;Viewing the SQL/DDL for an Object&quot; on page 447.</td>
</tr>
</tbody>
</table>

3. When finished, you can submit your changes. For details, see "Previewing and Submitting Object Editor Changes" on page 450.

USER DATATYPES EDITOR (SYBASE ASE)
The User Datatypes Editor lets you view and modify user datatype definitions and view objects associated with a user datatype.
To edit a user datatype
1. Open an editor on the user datatype. For details, see "Opening an Object Editor" on page 444.
2. Use the following table as a guide to understanding and modifying the settings on the tabs of this editor:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Properties</td>
<td>Lets you work with properties in the following categories:</td>
</tr>
<tr>
<td></td>
<td><strong>Base datatype</strong> Lets you set <strong>Type</strong>, <strong>Size</strong>, <strong>Allow Nulls</strong>, and <strong>Identity</strong> settings.</td>
</tr>
<tr>
<td></td>
<td><strong>Bindings</strong> Lets you set <strong>Default Binding</strong> and <strong>Rule Binding</strong> properties.</td>
</tr>
<tr>
<td>Usage</td>
<td>Displays all objects referring to or referenced by a user datatype.</td>
</tr>
<tr>
<td>DDL View</td>
<td>For details on using this tab, see &quot;Viewing the SQL/DDL for an Object&quot; on page 447.</td>
</tr>
</tbody>
</table>

3. When finished, you can submit your changes. For details, see "Previewing and Submitting Object Editor Changes" on page 450.

**USER MESSAGES EDITOR (Sybase ASE)**
The User Messages Editor lets you manage user messages and their respective object bindings.

**NOTE:** On Sybase ASE, user messages are only available under the Master database.

To edit a user message
1. Open an editor on the user message. For details, see "Opening an Object Editor" on page 444.
2. Use the following table as a guide to understanding and modifying the settings on the tabs of this editor:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Information</td>
<td>Displays the message text for each language version of the message and offers the options to add a new language version, drop a language version, or modify a language version. For detailed instructions, see &quot;User Messages (Sybase ASE) - Information&quot; on page 440.</td>
</tr>
<tr>
<td>Bindings</td>
<td>Displays any constraints to which the user message is bound. This tab also lets you create new bindings and delete current bindings. For details, see &quot;User Messages (Sybase ASE) - Bindings&quot; on page 441.</td>
</tr>
<tr>
<td>DDL View</td>
<td>For details on using this tab, see &quot;Viewing the SQL/DDL for an Object&quot; on page 447.</td>
</tr>
</tbody>
</table>

3. When finished, you can submit your changes. For details, see "Previewing and Submitting Object Editor Changes" on page 450.
**MODIFYING OBJECTS USING EDITORS**

**USERS EDITOR (SYBASE ASE)**
The Users Editor lets you view and modify user definitions and manage associated logins and objects.

**To edit a user**

1. Open an editor on the user. For details, see "Opening an Object Editor" on page 444.

2. Use the following table as a guide to understanding and modifying the settings on the tabs of this editor:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Properties</strong></td>
<td>Lets you view the user Name and Login Name for the user. Lets you specify a Group Name for the user.</td>
</tr>
<tr>
<td><strong>Logins</strong></td>
<td>Lets you assign logins to a user by selecting associated check boxes.</td>
</tr>
<tr>
<td><strong>Objects</strong></td>
<td>Lets you manage database objects associated with the user. Objects are organized in a tree structure with folders containing the objects. Optionally, take one of the following actions:</td>
</tr>
<tr>
<td></td>
<td>Select an object and click <strong>Edit</strong> to open an object editor on the selected object.</td>
</tr>
<tr>
<td></td>
<td>Select an object and click <strong>Drop</strong> to initiate dropping the selected object.</td>
</tr>
<tr>
<td><strong>Object Permissions and System Permissions</strong></td>
<td>For details on using these tab, see &quot;Working with Privileges and Permissions&quot; on page 447.</td>
</tr>
<tr>
<td><strong>Comment</strong></td>
<td>For details on using this tab, see Adding a Comment to an object.</td>
</tr>
<tr>
<td><strong>DDL View</strong></td>
<td>For details on using this tab, see &quot;Viewing the SQL/DDL for an Object&quot; on page 447.</td>
</tr>
</tbody>
</table>

3. When finished, you can submit your changes. For details, see "Previewing and Submitting Object Editor Changes" on page 450.

**VIEWS EDITOR (SYBASE ASE)**
The Views Editor lets you view the columns for the view and work directly with the SQL to create the view.

**To edit a view**

1. Open an editor on the view. For details, see "Opening an Object Editor" on page 444.

2. Use the following table as a guide to understanding and modifying the settings on the tabs of this editor:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Properties</strong></td>
<td>Displays all columns for the view. Details for each column include the Column Name, the Datatype (and if applicable, with the precision in parentheses), and whether or not Nulls are allowed for that column.</td>
</tr>
<tr>
<td>Tab</td>
<td>Settings and tasks</td>
</tr>
<tr>
<td>-----------------</td>
<td>-----------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Definition</strong></td>
<td>Displays the SQL (CREATE VIEW) for the view.</td>
</tr>
<tr>
<td></td>
<td>NOTE: If the <strong>Definition</strong> tab for the view shows a <strong>Source text for this compiled object is hidden</strong> message, source text for this compiled object has been hidden. For more information, see &quot;Hide Text&quot; on page 640.</td>
</tr>
<tr>
<td><strong>Dependencies</strong></td>
<td>For details on using this tab, see &quot;Working with Object Dependencies&quot; on page 449.</td>
</tr>
<tr>
<td><strong>Permissions</strong></td>
<td>For details on using this tab, see &quot;Working with Privileges and Permissions&quot; on page 447.</td>
</tr>
</tbody>
</table>

3 When finished, you can submit your changes. For details, see "Previewing and Submitting Object Editor Changes" on page 450.
OBJECT ACTIONS

In addition to letting you create and perform basic editing on various object types, Rapid SQL offers a number of actions that can be applied to objects. While object action support differs by DBMS platform, they are most commonly implementations of:

- ALTER OBJECT TYPE clauses/options not typically available from object editors, such as REBUILD INDEX and RENAME
- Other SQL commands such as TRUNCATE, REORG, and LOCK
- System procedures and other available utilities

Most object actions are implemented as multi-panel wizards that guide you through the action. For an introduction to invoking object actions and working through the panels, see "Overview of object actions/operations execution" on page 573.

For a listing of available actions and access to detailed instructions, see "Available object actions by DBMS" on page 577.

OVERVIEW OF OBJECT ACTIONS/OPERATIONS EXECUTION

Most commonly, initiating an object operation opens a wizard with panels that guide you through initiating the action. For details, see the following topics

- Initiating an object operation
- Using object operation wizards

INITIATING AN OBJECT OPERATION

Object operations are most commonly available as right-click context menu selections on the Database Navigator, available with one or more objects selected.
To verify availability of an object action for a specific object type and DBMS platform, see the topic covering that object type in "Supported Objects" on page 179.

To Initiate an Object Operation

1. Connect to the datasource that contains the object you want to perform the operation against. For more information, see "Connecting to Datasources" on page 153.

2. On the Database Navigator, expand nodes until the target object type is visible and then expand the target object type. See the following topics for more information:
   - "Database Explorer" on page 30 - for general information on working with the Explorer.
   - "Supported Objects" on page 179, specific object type topic - for information on navigating Datasource Navigator nodes to the target object type.

Rapid SQL displays objects of that type.
3. Take one of the following actions:

- To initiate an operation against a single object, right-click the object and select the operation from the context menu.
- To initiate an operation against a multiple objects, use CTRL-clicking to select multiple objects, right-click one of the selected objects and then select an operation from the context menu.

**NOTE:** Not all object operations can be applied to multiple objects.

Rapid SQL opens the wizard for the selected object operation.

For information on using the wizard panels to provide required information and execute an operation, see "Using object operation wizards" on page 575.

**USING OBJECT OPERATION WIZARDS**

A typical object operation wizard is a multi-panel window that walks you through the steps necessary to execute the operation. The wizard typically opens on a first panel named either **Action Options** or using a name specific to that object action. For example, the first panels for the **Rename** and **Drop** operations:

![wizard panels](image)

The wizard's **Next** and **Back** buttons let you navigate through the wizard panels. While the remaining panels of the wizard differ by action type, the following are the most common:

- **Dependencies**
- **Preview**
After providing information and inspecting settings on the panels, there are two execution options:

- Use the **Execute** (or **Finish**) button to execute the operation immediately
- Use the **Schedule** button to schedule the operation to execute the operation at a later time or to be executed on a regular basis. For information, see "Scheduling" on page 843.

**DEPENDENCIES**
For those object action wizards that include a **Dependencies** panel, it lists the objects potentially impacted by this object action. Within the main categories of **Referencing Objects** and **Referenced Objects**, objects are grouped within object type folders.

**CAUTION:** A **Dependencies** panel, if present, is provided for information only. Rapid SQL does not attempt to resolve the current action in referenced or referring objects.

**PREVIEW**
The Preview panel lets you inspect the SQL generated by wizards or editors when you create, edit, or perform other actions against a database object. Depending on the action being taken, this panel may contain the following controls:

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Save icon]</td>
<td>Lets you save the SQL.</td>
</tr>
<tr>
<td>![Print icon]</td>
<td>Lets you print the SQL.</td>
</tr>
<tr>
<td>![Email icon]</td>
<td>Lets you send the SQL via e-mail.</td>
</tr>
<tr>
<td>![Editor icon]</td>
<td>Opens an SQL Editor on the SQL contained in the Preview dialog. For more information, see &quot;Using the SQL Editor&quot; on page 791.</td>
</tr>
<tr>
<td>![Schedule icon]</td>
<td>Opens a dialog that lets you select job scheduling options. Once you have selected your options, a third-party job scheduler opens. For more information, see &quot;Scheduling&quot; on page 843.</td>
</tr>
<tr>
<td>![Execute icon]</td>
<td>Executes the SQL.</td>
</tr>
<tr>
<td>![Cancel icon]</td>
<td>Closes the Preview dialog without executing the SQL and returns you to the wizard, editor, or dialog box from which you invoked the Preview dialog. Since you cannot edit the SQL in the Preview dialog, this lets you make changes before once again previewing and then executing the SQL.</td>
</tr>
</tbody>
</table>
### AVAILABLE OBJECT ACTIONS BY DBMS

The table below lists the object actions provided by Rapid SQL

<table>
<thead>
<tr>
<th>Action</th>
<th>DB2 LUW</th>
<th>DB2 z/OS</th>
<th>IITB/FBD</th>
<th>MySQL</th>
<th>ORCL</th>
<th>SQL SVR</th>
<th>SYB ASE</th>
<th>SYB IQ</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add or Modify Check Constraint</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Add/Modify Login Trigger</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>Add Private Key</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Allocate Extent</td>
<td></td>
<td></td>
<td></td>
<td>✓</td>
<td></td>
<td>✓</td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>Analyze</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✓</td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>Analyze Tables</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✓</td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>Attach Database</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Backup Certificate</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>Bind Package</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Bind To Temporary Database</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>Build</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Build Query</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Change Access Status</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Change Category</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>Change Password</td>
<td></td>
<td></td>
<td></td>
<td>✓</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Change Status</td>
<td></td>
<td></td>
<td></td>
<td>✓</td>
<td></td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Check Tables</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Checkpoint</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Checksum Tables</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Coalesce</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>Compile</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Convert Tables</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Copy Object Names</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Copy Schema</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Create Alias</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Create Clone</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Create Insert Statements</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Create Like</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Create Synonym</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>Create View</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>DBCC</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✓</td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>Deallocate Unused Space</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Delete Statistics</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✓</td>
</tr>
</tbody>
</table>
### OBJECT ACTIONS > OBJECT ACTIONS

<table>
<thead>
<tr>
<th>Action</th>
<th>DB2 LUW</th>
<th>DB2 z/OS</th>
<th>IITB/FBD</th>
<th>MySQL</th>
<th>ORCL</th>
<th>SQL SVR</th>
<th>SYB ASE</th>
<th>SYB IQ</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Describe</strong></td>
<td>✔</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Detach Database</strong></td>
<td></td>
<td>✔</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Disable Index</strong></td>
<td>✔</td>
<td>✔</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Disable Job</strong></td>
<td></td>
<td>✔</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Disable Keys</strong></td>
<td>✔</td>
<td>✔</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Disable/Enable Triggers</strong></td>
<td>✔</td>
<td>✔</td>
<td></td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td><strong>Drop</strong></td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td><strong>Drop Automatic Storage Path(s)</strong></td>
<td>✔</td>
<td>✔</td>
<td></td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td><strong>Drop By Category</strong></td>
<td></td>
<td>✔</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Drop Clone</strong></td>
<td>✔</td>
<td>✔</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Drop Java</strong></td>
<td></td>
<td>✔</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Drop Login Trigger</strong></td>
<td></td>
<td>✔</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Drop Materialized Query Table</strong></td>
<td>✔</td>
<td>✔</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Drop Unused</strong></td>
<td>✔</td>
<td>✔</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Drop Unused Columns</strong></td>
<td>✔</td>
<td>✔</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Edit Data</strong></td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td></td>
</tr>
<tr>
<td><strong>Enable Job (Job Queue)</strong></td>
<td>✔</td>
<td>✔</td>
<td></td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td><strong>Enable Keys</strong></td>
<td>✔</td>
<td>✔</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Enable Recycle Bin</strong></td>
<td>✔</td>
<td>✔</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Enable/Disable (Oracle Jobs)</strong></td>
<td>✔</td>
<td>✔</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Estimate Size</strong></td>
<td>✔</td>
<td>✔</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Exchange Data With Clone</strong></td>
<td>✔</td>
<td>✔</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Execute</strong></td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td><strong>Extract</strong></td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td><strong>Extract Data as XML</strong></td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td><strong>Flush Cache</strong></td>
<td>✔</td>
<td>✔</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Flush Tables</strong></td>
<td>✔</td>
<td>✔</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Free (Packages)</strong></td>
<td>✔</td>
<td>✔</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Free Plan</strong></td>
<td>✔</td>
<td>✔</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Generate Package/Procedure/Statement</strong></td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td><strong>Hide Text</strong></td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Action</td>
<td>DB2 LUW</td>
<td>DB2 z/OS</td>
<td>IITB/FBD</td>
<td>MySQL</td>
<td>ORCL</td>
<td>SQL SVR</td>
<td>SYB ASE</td>
<td>SYB IQ</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>---------</td>
<td>---------</td>
<td>---------</td>
<td>-------</td>
<td>------</td>
<td>---------</td>
<td>--------</td>
<td>--------</td>
</tr>
<tr>
<td>Import Data From File</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Load Java</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Lock</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Lower High Water Mark</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Move Log</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Move Table</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Next Used Filegroup</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Object Properties</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Optimize Tables</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Place</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Population status</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Purge Recycle Bin</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Purge Recycle Bin Entry</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Quiesce</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Reassign By Category</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Rebalance</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Rebind Packages</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Rebind Plans</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Rebuild (Full-text Catalogs)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Rebuild Index</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Rebuild Outlines</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Rebuild Table</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Recompile</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Refresh Table</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Rename</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Reorganize/Reorg</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Repair Tables</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Report</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Resynchronize</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Run Job (Oracle Jobs)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Run Job (job queues)</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Role Activation</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Run Job (job queues)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Schema</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Select * From</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
</tbody>
</table>
ADD OR MODIFY CHECK CONSTRAINT
This action opens a Check Constraints Editor or Check Constraints Wizard.

Platform Availability
- **DB2 LUW, DB2 z/OS, ITB/FBD, MySQL, ORCL, SQL SVR, SYB ASE**

To Open the Check Constraint Editor or Check Constraint Wizard
1. On the Navigator, right-click the Check Constraints node and select Create.
2. Use the following table as a guide to creating or editing the constraint:

<table>
<thead>
<tr>
<th>Step</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Definition</strong></td>
<td><strong>Table Owner or Table Schema</strong> (DB2 LUW, DB2 z/OS, SQL Server, Oracle, Sybase ASE)</td>
</tr>
<tr>
<td></td>
<td><strong>Table or Table Name</strong> (DB2 LUW, DB2 z/OS, Interbase/Firebird, SQL Server, Oracle, Sybase ASE)</td>
</tr>
<tr>
<td></td>
<td><strong>Name</strong> (DB2 LUW, DB2 z/OS, Interbase/Firebird, SQL Server, Oracle, Sybase ASE)</td>
</tr>
<tr>
<td></td>
<td><strong>Enabled or Enforced</strong> (DB2 LUW, DB2 z/OS, SQL Server, Oracle)</td>
</tr>
</tbody>
</table>
ADD/MODIFY LOGIN TRIGGER

This action lets you build and submit an sp_modifylogin call that specifies a login script option. The target login trigger can be any stored procedure located on the user's default database, and the procedure will run each time the user successfully logs in. The action can be used to:

- Add a login trigger to a login that currently has no login trigger configured
- Change the specified stored procedure for a login that already has a login trigger configured

Platform Availability

- **SYB ASE**

To Specify the Stored Procedure Used as a Login Trigger for a Login:

1. Expand the Logins node. Rapid SQL displays all logins for the datasource.
2. Right-click a login and select Login Trigger Actions > Add/Modify Login Trigger from the context menu. Rapid SQL opens the Add/Modify Login Trigger dialog.
3. Use the following table as a guide to understanding and modifying settings in the wizard:

<table>
<thead>
<tr>
<th>Step</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action options</td>
<td>From the Login Procedure dropdown, choose the default database stored procedure that is to be configured as the login trigger for this login.</td>
</tr>
<tr>
<td>Dependencies</td>
<td>Review the referring and referred objects that will be automatically resolved when you execute this operation. For details, see &quot;Dependencies&quot; on page 576.</td>
</tr>
<tr>
<td>Preview</td>
<td>Preview the DDL generated for the operation and when ready, click Execute.</td>
</tr>
</tbody>
</table>

After executing this action, the specified stored procedure name is available in the Login editor. For details, see "Logins Editor (Sybase ASE)" on page 562.
ADD PRIVATE KEY

The **ADD PRIVATE KEY** object action builds and submits an ALTER CERTIFICATE... WITH PRIVATE KEY statement, optionally including a DECRIPTION BY PASSWORD argument. This lets you change the private key for a certificate, add a private key to a certificate that currently does not have one, and optionally, specify a decryption password.

**NOTE:** This functionality is available for Microsoft SQL Server only.

To change a certificate's private key

1. Initiate an **ADD PRIVATE KEY** action against a certificate. For more information see "Initiating an object operation" on page 573.

   Rapid SQL opens the **ADD PRIVATE KEY** dialog box.

2. Use the following table as a guide to understanding and modifying settings in the dialog:

<table>
<thead>
<tr>
<th>Step</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action options</td>
<td>Lets you work with the following settings:</td>
</tr>
<tr>
<td></td>
<td><strong>Private Key File</strong></td>
</tr>
<tr>
<td></td>
<td><strong>Decryption Password</strong></td>
</tr>
<tr>
<td>Dependencies</td>
<td>Review the referring and referred objects that will be automatically resolved when you execute this operation. For details, see &quot;Dependencies&quot; on page 576.</td>
</tr>
<tr>
<td>Preview</td>
<td>Displays the DDL that will execute the object action. For details, see &quot;Preview&quot; on page 576.</td>
</tr>
</tbody>
</table>

3. Finally, use the **Execute** button to create the object.

For related information, see "Backup Certificate" on page 586.

ALLOCATE EXTENT

The **ALLOCATE EXTENT** dialog lets you explicitly allocate extents for clusters, tables, and indexes in Oracle. Though Oracle dynamically allocates extents when additional space is required, explicit allocation of additional extents can be useful if you know that an object grows.

Explicit allocation of additional extents can be particularly helpful when using Oracle Parallel Server. When using Oracle Parallel Server and allocating additional extents, you can allocate an extent explicitly to a specific instance in order to minimize contention for free space among multiple instances.
Platform Availability

- ORCL

Important Notes
For composite-partitioned tables, you can allocate extents to subpartitions as well as partitions.

To Allocate an Extent for a Cluster, Table, or Index

1. Initiate an **Allocate Extent** action against a table, cluster, index, primary key, or unique key. For more information see "Initiating an object operation" on page 573.

2. Use the following table as a guide to setting the options on this dialog:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Extent Size</strong></td>
<td>Specify an extent size in KBs or MBs.</td>
</tr>
<tr>
<td><strong>Datafile</strong></td>
<td>Lets you select the new datafile. You can choose a specific datafile from which to take space for the added extent. If you choose (Default), Oracle takes the space from any accessible datafile in the tablespace containing the table, index, or cluster.</td>
</tr>
<tr>
<td><strong>Instance</strong></td>
<td>Lets you specify a freelist from which to draw the extent. If you are using Oracle Parallel Server, you can assign the new extent to a freelist group associated with a specific instance. The number you enter in the Instance text box should be the number of the freelist group that you wish to use, rather than the number of the specific instance. If you are using Oracle Parallel Server and you omit this parameter, Oracle allocates the extent, but the extent is drawn from the master freelist by default. Only use this parameter for Oracle Parallel Server. NOTE: The number you enter in the Instance field should be the number of the freelist group that you wish to use, rather than the number of the specific instance.</td>
</tr>
</tbody>
</table>

3. Click **Execute**. For information on the scheduling option, see "Scheduling" on page 843.

**ANALYZE**
This action lets you work with statistics for tables, indexes (primary keys and unique keys), and clusters.

Platform Availability

- ORCL
When using this action, Rapid SQL lets you build and submit the following ANALYZE statement variations or DBMS_STATS package procedure calls:

<table>
<thead>
<tr>
<th>Options</th>
<th>ANALYZE statement variation or DBMS_STATS call generated</th>
</tr>
</thead>
<tbody>
<tr>
<td>Compute Statistics</td>
<td>ANALYZE INDEX/CLUSTER/TABLE... COMPUTE STATISTICS</td>
</tr>
</tbody>
</table>
| Gather Statistics     | DBMS_STATS.GATHER_INDEX_STATS  
                        | DBMS_STATS.GATHER_TABLE_STATS,                                           |
| Delete Statistics     | ANALYZE INDEX/CLUSTER/TABLE... DELETE STATISTICS  
                        | DBMS_STATS.DELETE_INDEX_STATS  
                        | DBMS_STATS.DELETE_TABLE_STATS                                    |
| Estimate Statistics   | ANALYZE INDEX/TABLE/CLUSTER... ESTIMATE STATISTICS                                                                       |
| Validate Structure    | ANALYZE INDEX/TABLE/CLUSTER... VALIDATE STRUCTURE                                                                         |
| Import Statistics     | DBMS_STATS.IMPORT_INDEX_STATS  
                        | DBMS_STATS.IMPORT_TABLE_STATS                                          |
| List Chained Row Into Table | ANALYZE TABLE/CLUSTER... LIST CHAINED ROWS INTO                                      |

**NOTE:** Before using this object action, consult Oracle documentation for information on the ANALYZE statement and relevant DBMS_STATS package procedures. Be familiar with restrictions, required permissions, partition options, parameter values, and requirements. For more information, see Accessing Third Party Documentation.

**To obtain or modify statistics for a database object:**

1. Initiate an **Analyze** action against one or more clusters, indexes, primary keys, unique keys, or tables. For more information see "Initiating an object operation" on page 573.

2. Use the following table as a guide to understanding and modifying settings in the **Analyze** wizard:

<table>
<thead>
<tr>
<th>Step</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action Options</td>
<td>Take the following steps:</td>
</tr>
<tr>
<td></td>
<td>If you are not working against a cluster, either select the Use dbms_stats_package check box to generate one of the DBMS_STATS procedure calls or deselect the Use dbms_stats_package check box to generate an ANALYZE statement variation.</td>
</tr>
<tr>
<td></td>
<td>From the Type dropdown, select one of the Rapid SQL options from the table above.</td>
</tr>
<tr>
<td></td>
<td>Additional options are offered depending on the Type value you choose. They correspond to ANALYZE statement clauses or DBMS_STATS procedure parameters. See Oracle documentation for details.</td>
</tr>
<tr>
<td>Preview</td>
<td>Displays the DDL that will execute the object action. For details, see &quot;Preview&quot; on page 576.</td>
</tr>
</tbody>
</table>

3. Click **Execute**. For information on the scheduling option, see "Scheduling" on page 843.
ANALYZE TABLES
Rapid SQL lets you issue an ANALYZE TABLE statement, analyzing and storing the key distribution for a table.

Platform Availability
- MySQL

To analyze a table:
1. Initiate an **Analyze Tables** action against one or more tables. For more information see "Initiating an object operation" on page 573.
2. Use the following table as a guide to understanding and modifying settings in this wizard:

<table>
<thead>
<tr>
<th>Step</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Action Options</strong></td>
<td>Lets you review the tables you selected.</td>
</tr>
<tr>
<td><strong>Dependencies</strong></td>
<td>Lists referring and referenced objects potentially impacted by the change. For details, see &quot;Dependencies&quot; on page 576.</td>
</tr>
<tr>
<td><strong>Preview</strong></td>
<td>Displays the DDL that will execute the object action. For more information, see &quot;Preview&quot; on page 576.</td>
</tr>
</tbody>
</table>

3. Click **Execute**. For information on the scheduling option, see "Scheduling" on page 843.

ATTACH DATABASE
The **Attach Database** object action lets you specify a set of previously detached data and transaction files to be used to attach a database to a Microsoft SQL Server instance. This makes the database available in exactly the same state it was in when it was detached.

Platform Availability
- SQL SVR

To Attach a Database
1. Initiate an **Attach Database** action against a database. For more information see "Initiating an object operation" on page 573.
   - Rapid SQL opens the **Attach Database File(s)** dialog.
2. In the **Database Name to be Attached** box, type the database name.
3 In the grid, do one of the following:

- Select the target database file(s).
- To add database file(s), click Add and then enter the name of the MDF (master data file) of the database to attach.
  
  Rapid SQL automatically adds the appropriate *.ldf file.

4 To drop database file(s), click Drop and then select the target file(s).

5 Click Execute. For information on the scheduling option, see "Scheduling" on page 843.

Related Information
- "Detach Database" on page 617

BACKUP CERTIFICATE

The Backup Certificate object action builds and submits a BACKUP CERTIFICATE... TO FILE statement with optionally, a WITH PRIVATE KEY clause. This lets you back up a certificate to file.

NOTE: This functionality is available for Microsoft SQL Server only.

To write a certificate to disk

1 Initiate a Backup Certificate action against a certificate. For more information see "Initiating an object operation" on page 573.

  Rapid SQL opens the Attach Database File(s) dialog box.

2 Use the following table as a guide to understanding and modifying settings in the dialog:

<table>
<thead>
<tr>
<th>Step</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Action options</strong></td>
<td>Lets you work with the following settings:</td>
</tr>
<tr>
<td>File</td>
<td>The full path and filename (local or UNC) of the file to which the certificate is to be written.</td>
</tr>
<tr>
<td>Private Key File</td>
<td>The full path and filename (local or UNC) of the file to which the private key is to be written.</td>
</tr>
<tr>
<td>Encryption Password</td>
<td>The password used to encrypt the private key before writing the key to the backup file.</td>
</tr>
<tr>
<td>Decryption Password</td>
<td>The password used to decrypt the private key before backing up the key.</td>
</tr>
<tr>
<td>Dependencies</td>
<td>Lets you review the objects potentially impacted by this action. For more information, see &quot;Dependencies&quot; on page 576.</td>
</tr>
<tr>
<td>Preview</td>
<td>Preview the DDL generated for the operation and when ready, use the Schedule or Execute button to perform this action.</td>
</tr>
</tbody>
</table>

3 Finally, use the Execute button to create the object.
For related information, see "Add Private Key" on page 582.

**BIND PACKAGE**
The Bind Package Wizard lets you set package parameters, add environments, and set package properties.

**Platform Availability**
- **DB2 z/OS**

**To Package Parameters, Add Environments, and Set Package Properties**
1. Expand an owning schema, right-click Packages, and select Bind from the context menu.
   
   Rapid SQL opens the **Bind Package** wizard.

2. Use the following table as a guide to understanding and setting options on this wizard:

<table>
<thead>
<tr>
<th>Step</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td><strong>Location</strong></td>
</tr>
<tr>
<td></td>
<td>Lets you select the name of the location to connect to.</td>
</tr>
<tr>
<td></td>
<td><strong>Collection</strong></td>
</tr>
<tr>
<td></td>
<td>Lets you select the location of the DBMS where the package binds and where the description of the package resides.</td>
</tr>
<tr>
<td></td>
<td><strong>Would you like to Copy an Existing Package from Another Collection</strong></td>
</tr>
<tr>
<td></td>
<td><strong>New Package</strong> (available if you select No for the Would you like... control)</td>
</tr>
<tr>
<td></td>
<td>Lets you select a Package Name and PDS Name.</td>
</tr>
<tr>
<td></td>
<td><strong>Copy Package</strong> (available if you select Yes for the Would you like... control)</td>
</tr>
<tr>
<td></td>
<td>Lets you qualify with the following:</td>
</tr>
<tr>
<td></td>
<td><strong>Collection</strong> - the collection to copy from.</td>
</tr>
<tr>
<td></td>
<td><strong>Options</strong> - COMMAND or COMPOSITE.</td>
</tr>
<tr>
<td></td>
<td><strong>Package</strong> - Lets you select a package.</td>
</tr>
<tr>
<td></td>
<td><strong>Version</strong> - Lets you select a version of the package.</td>
</tr>
<tr>
<td>2</td>
<td>Lets you select a package Owner, a Qualifier (the package creator), an Action of ADD or REPLACE, and the Version of the package.</td>
</tr>
<tr>
<td>Step</td>
<td>Settings and tasks</td>
</tr>
<tr>
<td>------</td>
<td>-------------------</td>
</tr>
<tr>
<td>3</td>
<td><strong>Isolation</strong></td>
</tr>
<tr>
<td></td>
<td><strong>Keep Dynamic</strong></td>
</tr>
<tr>
<td></td>
<td><strong>Current Data</strong></td>
</tr>
<tr>
<td></td>
<td><strong>Degree</strong></td>
</tr>
<tr>
<td></td>
<td><strong>DB Protocol</strong></td>
</tr>
<tr>
<td></td>
<td><strong>Dynamic Rules</strong></td>
</tr>
<tr>
<td></td>
<td><strong>Release</strong></td>
</tr>
<tr>
<td></td>
<td><strong>Validate</strong></td>
</tr>
</tbody>
</table>
3 When ready, click Finish.

**BIND TO TEMPORARY DATABASE**
This action builds and submits a `sp_tempdb bind` system procedure call. It lets you bind a login to a temporary database.

**Platform Availability**
- SYB ASE

**To Bind a Login to a Temporary Database**
1. Initiate a Bind To Temporary Database action against one or more logins. For more information see "Initiating an object operation" on page 573.
2. Use the following table as a guide to understanding and modifying settings in the Bind To Temporary Database wizard:

<table>
<thead>
<tr>
<th>Step</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Action Options</strong></td>
<td>Select the target temporary database from the Bind To Temporary Database dropdown.</td>
</tr>
<tr>
<td><strong>Dependencies</strong></td>
<td>Lists referring and referenced objects potentially impacted by the change. For details, see &quot;Dependencies&quot; on page 576.</td>
</tr>
<tr>
<td><strong>Preview</strong></td>
<td>Displays the DDL that will execute the object action. For details, see &quot;Preview&quot; on page 576.</td>
</tr>
</tbody>
</table>

3. Click Execute. For information on the scheduling option, see "Scheduling" on page 843.
BUILD
This action lets you build a procedure, specifying a Build utility function (ALTER_REBUILD, REBUILD, REBIND, or DESTROY), a Build owner, Precompile options, Compile options, Prelink options, Link options, and Bind options.

Platform Availability
• DB2 z/OS

To Build a Procedure
1 Initiate a Build action against a procedure. For more information see "Initiating an object operation" on page 573.
2 Type or select the build options in the Procedure Build Options dialog:
3 Click Build.

BUILD QUERY
Right-clicking a table and selecting Build Query opens a tool that lets you create, structure, and manipulate queries. For details, see "Query Builder" on page 848.

CHANGE ACCESS STATUS
This action builds and submits a basic ALTER TABLE... READ ONLY/READ WRITE statement. This lets you toggle the table between READ ONLY and READ/WRITE modes.

NOTE: The Browser listing for an Oracle table has a Read-Only field that displays the current status for a table. For more information, see "Browsers" on page 33.

Platform Availability
• ORCL 11g

To Change Between READ ONLY and READ WRITE Modes for a Table
1 Initiate a Change Access Status action against one or more tables. For more information, see "Initiating an object operation" on page 573.
2 Use the following table as a guide to understanding and modifying settings in the dialog:

<table>
<thead>
<tr>
<th>Step</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action options</td>
<td>Select the Read-only check box to generate a ALTER TABLE... READ ONLY statement, putting the table into read-only mode. Deselect the Read-only check box to generate a ALTER TABLE... READ WRITE statement, putting the table into read-write mode.</td>
</tr>
<tr>
<td>Dependencies</td>
<td>Lets you review the objects potentially impacted by this action. For more information, see &quot;Dependencies&quot; on page 576.</td>
</tr>
</tbody>
</table>
3. Click **Execute**. For information on the scheduling option, see "**Scheduling**" on page 843.

### CHANGE CATEGORY

Rapid SQL lets you change the category of a target Stored Outline.

#### Platform Availability

- **ORCL**

#### To Change the Category of a Stored Outline

1. Initiate a **Change Category** action against a stored outline. For more information see "**Initiating an object operation**" on page 573.

2. Use the following table as a guide to understanding and modifying settings in the **Change Category** wizard:

<table>
<thead>
<tr>
<th>Step</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action options</td>
<td>From the Category dropdown, choose a new, target category.</td>
</tr>
<tr>
<td>Dependencies</td>
<td>Review the referring and referred objects that will be automatically resolved when you execute this operation. For more information, see &quot;<strong>Dependencies</strong>&quot; on page 576.</td>
</tr>
<tr>
<td>Preview</td>
<td>Displays the DDL that will execute the object action. For details, see &quot;<strong>Preview</strong>&quot; on page 576.</td>
</tr>
</tbody>
</table>

3. Click **Execute**. For information on the scheduling option, see "**Scheduling**" on page 843.

#### Related Information

- "**Drop By Category**" on page 622
- "**Reassign By Category**" on page 654

### CHANGE PASSWORD

The **Change Password** dialog lets you change user or login passwords, which you should do on a regular basis to guard against security leaks.

#### Platform Availability

- **MySQL, ORCL, SQL SVR, SYB ASE**
To Change the Password for a User or Login
1. Take one of the following actions:
   • For Sybase ASE or SQL Server, expand the Logins node.
   • For MySQL and Oracle, expand the Users node.
2. Right-click the user or login, and then select Change Password from the context menu.
   Rapid SQL opens the Change Password dialog.
3. For Oracle and SQL Server datasources, in the Old Password box, type the old password.
   Providing the old password is optional on SQL Server datasources.
4. In the New Password box, type the new password.
5. In the Confirm Password box, type the new password.
6. Click Execute. For information on the scheduling option, see "Scheduling" on page 843.

CHANGE STATUS
You can change the status of a number of relevant object types. For details, see the following topics:
• Change Status (InterBase Triggers)
• Change Status (Oracle, SQL Server, and Sybase ASE triggers)
• Change Status (SQL Server DDL triggers)
• Change Status (Full-text Indexes)
• Change Status (check constraints)
• Change Status (tablespaces)

CHANGE STATUS (INTERBASE TRIGGERS)
This action lets you build an ALTER TRIGGER statement with an ACTIVE or INACTIVE argument, and issue the statement against one or more triggers.

To Change the Status of a Trigger:
1. Initiate a Change Status action against one or more triggers. For more information see "Initiating an object operation." on page 573.
2. Use the following table as a guide to understanding and modifying settings in the dialog:

<table>
<thead>
<tr>
<th>Step</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action options</td>
<td>With Enabled selected, the ALTER TRIGGER statement is created with an ACTIVE argument. Deselected, the ALTER TRIGGER statement is created with an INACTIVE argument.</td>
</tr>
</tbody>
</table>
3 Click **Execute**. For information on the scheduling option, see "[Scheduling](#)" on page 843.

**Change Status (Oracle, SQL Server, and Sybase ASE Triggers)**

The **Change Status** object action lets you build an issue an ALTER TABLE statement that specifies a DISABLE (DISABLE TRIGGER) or ENABLE (ENABLE TRIGGER) option. This lets you enable or disable any triggers.

Loading a database from a previous dump causes any triggers defined in the database to fire. To speed the time required to load a database you should disable triggers.

**NOTE:** Disabling triggers can lead to problems with maintaining referential integrity and business rules

**To enable or disable a trigger:**

1. Initiate a **Change Status** action against one or more triggers. For more information see "[Initiating an object operation](#)" on page 573.

2. Use the following table as a guide to understanding and modifying settings in the **Change Status** wizard:

<table>
<thead>
<tr>
<th>Step</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dependencies</td>
<td>Lists referring and referenced objects potentially impacted by the change. For details, see &quot;<a href="#">Dependencies</a>&quot; on page 576.</td>
</tr>
<tr>
<td>Preview</td>
<td>Preview the DDL generated for the operation. For more information, see &quot;<a href="#">Preview</a>&quot; on page 576.</td>
</tr>
</tbody>
</table>

3 Click **Execute**. For information on the scheduling option, see "[Scheduling](#)" on page 843.

**Change Status (SQL Server DDL Triggers)**

The **Change Status** object action lets you build and issue a DISABLE TRIGGER... ON DATABASE or ENABLE TRIGGER... ON DATABASE statement. This lets you enable or disable one or more database triggers.

**NOTE:** The Browser listing for a database trigger indicates its current status. For more information, see "[Browsers](#)" on page 33.
To enable or disable a trigger:

1. Initiate a Change Status action against one or more triggers. For more information see "Initiating an object operation" on page 573.

2. Use the following table as a guide to understanding and modifying settings in the Change Status wizard:

<table>
<thead>
<tr>
<th>Step</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action Options</td>
<td>Select the Enabled check box to enable the trigger. Deselect it to disable the trigger.</td>
</tr>
<tr>
<td>Dependencies</td>
<td>Lists referring and referenced objects potentially impacted by the change. For details, see &quot;Dependencies&quot; on page 576.</td>
</tr>
<tr>
<td>Preview</td>
<td>Displays the DDL that will execute the object action. For details, see &quot;Preview&quot; on page 576.</td>
</tr>
</tbody>
</table>

3. Click Execute. For information on the scheduling option, see "Scheduling" on page 843.

CHANGE STATUS (FULL-TEXT INDEXES)

The action builds and submits an ALTER FULLTEXT INDEX statement with an ENABLE or DISABLE argument, letting you enable or disable the full-text index. Full-text searching is unavailable on tables or views with a disabled full-text index.

Platform Availability

- SQL SVR

To Enable or Disable a Full-text Index

1. Initiate a Change Status action against one or more full-text indexes. For more information, see "Initiating an object operation" on page 573.

2. Use the following table as a guide to understanding and modifying settings in the dialog:

<table>
<thead>
<tr>
<th>Step</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action Options</td>
<td>Select the Enabled check box to enable the full-text index. Deselect the Enabled check box to disable the full-text index. Note that on opening the dialog, the Enabled check box state reflects whether the index is currently enabled or disabled.</td>
</tr>
<tr>
<td>Preview</td>
<td>Preview the DDL generated for the operation. For more information, see &quot;Preview&quot; on page 576.</td>
</tr>
</tbody>
</table>

3. Click Execute. For information on the scheduling option, see "Scheduling" on page 843.

CHANGE STATUS (CHECK CONSTRAINTS)

Rapid SQL lets you change the enabled/disabled status of check constraints, foreign key constraints, primary key constraints, and unique key constraints.

For detailed instructions, see:
• Setting constraint status for Microsoft SQL Server objects
• Setting Constraint Status for Oracle Objects

SETTING CONSTRAINT STATUS FOR MICROSOFT SQL SERVER OBJECTS

The Set Constraint Status dialog lets you specify the ability of a group of constraints to be replicated, and (for Microsoft SQL Server version 7 or later) enable or disable check constraints, foreign key constraints, primary key constraints, and unique key constraints.

Completing the Set Constraint(s) Status Dialog Box

To complete this dialog, do the following:

1. Initiate a Change Status action against one or more check constraints. For more information see "Initiating an object operation" on page 573.

2. Use the following table as a guide to understanding and modifying the settings on the Change Status wizard:

<table>
<thead>
<tr>
<th>Step</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action Options</td>
<td>Enabled: Deselect to temporarily override listed check constraints. Useful when you need to execute special processes that would ordinarily incur constraint-related errors.</td>
</tr>
<tr>
<td></td>
<td>Not for Replication: When you duplicate the table schema and data of a source database containing constraints marked &quot;Not for Replication&quot;, these objects are not carried over to the duplicate of the schema.</td>
</tr>
<tr>
<td>Dependencies</td>
<td>View the dependencies on the tablespace. For more information, see &quot;Dependencies&quot; on page 576.</td>
</tr>
<tr>
<td>Preview</td>
<td>Preview the DDL generated from your choices. For more information, see &quot;Preview&quot; on page 576.</td>
</tr>
</tbody>
</table>

3. Use the Execute or Schedule button to complete the operation.

SETTING CONSTRAINT STATUS FOR ORACLE OBJECTS

The Set Constraint(s) Status dialog lets you change the status of check constraints, foreign key constraints, primary key constraints, and unique key constraints. Rapid SQL lets you enable or disable selected constraints and, in the case of primary key and unique key constraints, lets you enable with or without validation and disable with or without the changes cascading.

When enabled, the rule defined by the constraint is enforced on the data values in the columns on which the constraint is placed. When disabled, the constraint rule is not enforced but the constraint continues to be stored in the data dictionary.
Temporarily disabling constraints can improve performance when you are loading large amounts of data or when you are making massive changes to a table. Disabling constraints also can be useful if you are importing or exporting one table at a time.

**NOTE:** Primary keys for index-organized tables cannot be disabled.

**NOTE:** You cannot drop a unique or primary key constraint that is part of a referential integrity constraint without also dropping the foreign key. To drop the referenced key and the foreign key together, select the Cascade check box in the Set Constraint(s) Status dialog.

The table below describes the options and functionality on the Set Constraint(s) Status dialog.

**NOTE:** The options differ by object.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable</td>
<td>Enabling the constraint and not selecting the Validate check box automatically uses Oracle ENABLE NOVALIDATE clause which enables a constraint so that it does not validate the existing data. A table using constraints in enable novalidate mode can contain invalid data but you cannot add new invalid data to that table. The enable novalidate mode is useful as an intermediate state or when you do not want the constraint to check for possible exceptions (e.g., after a data warehouse load).</td>
</tr>
<tr>
<td>Validate</td>
<td>Enabling the constraint and selecting the Validate check box causes Oracle to validate all existing data in the key columns of the table with the constraint. If an exception exists, Oracle returns an error and the constraint remains disabled.</td>
</tr>
<tr>
<td>Cascade</td>
<td>Selecting the Cascade check box when disabling a primary key or foreign key constraint instructs Oracle to simultaneously disable any constraints that depend on the primary or unique key. Selecting the Delete Cascade check box instructs Oracle to delete data in the child table (on which the foreign key is defined) if the referenced data is the parent table is deleted.</td>
</tr>
</tbody>
</table>

**Completing the Set Constraint(s) Status Dialog Box**

To complete this dialog box, do the following:

1. Initiate a Change Status action against one or more check constraints. For more information see “Initiating an object operation” on page 573.
2. Use the table above to select dialog box options.
3. Use the Execute or Schedule button to complete the operation.

**CHANGE STATUS (TABLESPACES)**

You can change the online, offline, or read only status of a tablespace to control access to its segments. In addition, when setting a tablespace offline, you can choose between NORMAL, TEMPORARY, or IMMEDIATE modes of taking the tablespace offline.

**Platform Availability**

- ORCL
To Change the Status of a Tablespace

1. Initiate a Change Status action against one or more tablespaces. For more information see "Initiating an object operation" on page 573.

2. Use the following table as a guide to understanding and modifying settings in the Change Status wizard:

<table>
<thead>
<tr>
<th>Step</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Action options</strong></td>
<td>From the Change Status dropdown, select ONLINE, OFFLINE, or READ ONLY. If you select OFFLINE, from the OfflineMode dropdown, select NORMAL, TEMPORARY, or IMMEDIATE.</td>
</tr>
<tr>
<td><strong>Dependencies</strong></td>
<td>Review the referring and referred objects that will be automatically resolved when you execute this operation. For more information, see &quot;Dependencies&quot; on page 576.</td>
</tr>
<tr>
<td><strong>Preview</strong></td>
<td>Preview the DDL generated for the operation. For more information, see &quot;Preview&quot; on page 576.</td>
</tr>
</tbody>
</table>

### CHECK TABLES

Rapid SQL lets you issue a CHECK TABLE statement, checking one or more tables for errors. This operation returns a standard CHECK TABLE result set. Each returned message consists of Table (name), Op (with a value of CHECK), Msg_type (STATUS, ERROR, INFO, WARNING), and Msg_text components.

#### Platform Availability

- MySQL

### To Check a Table for Errors

1. Initiate a Check Tables action against one or more tables. For more information see "Initiating an object operation" on page 573.

2. Use the following table as a guide to understanding and modifying settings in this wizard:

<table>
<thead>
<tr>
<th>Step</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Action Options</strong></td>
<td>Changed: Only check tables that have changed since the last check. Extended: Perform a full key lookup for all keys in each row. Fast: Check only tables that have not been properly closed. Medium: Scan rows to verify that deleted links are valid. Calculate a key checksum for the rows and verify using a calculated checksum for keys. Quick: Perform a full key lookup for all keys in each row.</td>
</tr>
<tr>
<td><strong>Preview</strong></td>
<td>Displays the DDL that will execute the object action. For more information, see &quot;Preview&quot; on page 576.</td>
</tr>
</tbody>
</table>

3. Click Execute. For information on the scheduling option, see "Scheduling" on page 843.

The results set opens on the Results tab of an ISQL editor window. For more information, see "Using the Results Editor" on page 832.
CHECKPOINT
Running a Checkpoint lets you force all dirty pages for the current database to be written to disk. A dirty page is any data or log page which, after being read into the buffer cache, is modified but not yet written to disk. The Checkpoint statement saves time in a subsequent recovery by creating a point at which all modifications to data and log pages are guaranteed to have been written to disk. If the current database is in log-truncate mode, CHECKPOINT also truncates the inactive portion of the log.

Platform Availability
- SQL SVR, SYBASE

Important Notes
The default permission for executing a checkpoint is the db_owner fixed database role.

To Run a Checkpoint Against One or More Databases
1. Initiate a Checkpoint action against one or more databases. For more information see "Initiating an object operation" on page 573.
2. Use the following table as a guide to working through the panels of the Checkpoint dialog:

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action options</td>
<td>Displays the names of the database(s) you chose.</td>
</tr>
<tr>
<td>Preview</td>
<td>Displays the DDL generated to execute the Checkpoint operation. For more information, see &quot;Preview&quot; on page 576.</td>
</tr>
</tbody>
</table>

3. Use one of the Schedule or Execute buttons to execute the Checkpoint.

CHECKSUM TABLES
Rapid SQL lets you issue a CHECKSUM TABLE statement, returning a live checksum.

Platform Availability
- MySQL

To Check a Table for Errors:
1. Initiate a Checksum Tables action against one or more tables. For more information see "Initiating an object operation" on page 573.
2. Use the following table as a guide to understanding and modifying settings in this wizard:

<table>
<thead>
<tr>
<th>Step</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action Options</td>
<td>Extended</td>
</tr>
</tbody>
</table>
3 Click **Execute**. For information on the scheduling option, see "**Scheduling**" on page 843.

The results set opens on the **Results** tab of an ISQL editor window. For more information, see "**Using the Results Editor**" on page 832.

**COALESCE**

You can maximize the size of free space chunks in tablespaces to avoid the situation in which an object cannot acquire enough contiguous free space to accommodate its next extent size. Towards this goal, look for opportunities to coalesce adjacent blocks of free space into a single, larger block.

Oracle automatically coalesces adjacent free space chunks with a background process. However, it still supports the commands for coalescing free space manually. Depending on the size of the tablespace, coalescing its free space can take a long time. So determine when to perform this operation. If you coalesce immediately, Rapid SQL locks the tablespace.

**Platform Availability**

- **ORCL**

**Important Notes**

- You cannot coalesce on an UNDO tablespace.

**To Coalesce a Tablespace**

1 Initiate a **Coalesce** action against one or more tablespaces. For more information see "**Initiating an object operation**" on page 573.

2 Use the following table as a guide to understanding and modifying settings in the **Coalesce** wizard:

<table>
<thead>
<tr>
<th>Step</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Quick</strong></td>
<td>Specifies that the live checksum is to be reported. For information on enabling a live checksum for a table, see &quot;<strong>Tables wizard (MySQL)</strong>&quot; on page 363.</td>
</tr>
<tr>
<td><strong>Preview</strong></td>
<td>Displays the DDL that will execute the object action. For more information, see &quot;<strong>Preview</strong>&quot; on page 576.</td>
</tr>
</tbody>
</table>
COMPILE

Rapid SQL lets you recompile specific objects by issuing the proper ALTER statement. The explicit recompilation of invalid objects eliminates the need for implicit run-time recompilation which, in turn, can cause run-time compilation errors and performance overhead. Recompile objects after you make changes to that object or dependent objects.

The following table lists the object types by DBMS for which the Compile operation is available:

<table>
<thead>
<tr>
<th>DB2 LUW</th>
<th>Oracle</th>
<th>Functions</th>
<th>Java Sources</th>
<th>Materialized Views</th>
<th>Packages</th>
<th>Package Bodies</th>
<th>Procedures</th>
<th>Procedures</th>
<th>Schema</th>
<th>Types and Type Bodies</th>
<th>Views</th>
</tr>
</thead>
</table>

**NOTE:** The objects you can compile and the steps in compiling them differ according to the type of data source you are working against. Before proceeding, make sure you are familiar with the material in “Compiling Oracle Objects” on page 601.

To Compile an Object

1. Initiate a Compile action against one or more supported objects (see the table above). For more information see “Initiating an object operation” on page 573.

Rapid SQL opens the Compile wizard. Options offered on the Action Options tab differ by object type. For example, no options are provided when compiling Java Sources, while a full range of dependent object-based and debug options are provided when compiling procedures.
Use the following table as a guide to working through the panels of the dialog box:

<table>
<thead>
<tr>
<th>Step</th>
<th>Settings and tasks</th>
<th>Availability</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Action options</strong></td>
<td><strong>Compile dependents</strong></td>
<td><strong>DB2 LUW Procedures</strong></td>
</tr>
<tr>
<td></td>
<td>If enabled, this option compiles statements for all objects referenced by the object</td>
<td>Oracle Functions, Packages, Procedures, Types, and Views</td>
</tr>
<tr>
<td></td>
<td>being compiled. For example, if you compile a function that references a specific</td>
<td></td>
</tr>
<tr>
<td></td>
<td>procedure and you select to compile the dependent objects, an ALTER COMPILE</td>
<td></td>
</tr>
<tr>
<td></td>
<td>statement is created for that referenced procedure. If disabled, only the current</td>
<td></td>
</tr>
<tr>
<td></td>
<td>object is compiled and the object's dependencies are ignored. This is the</td>
<td></td>
</tr>
<tr>
<td></td>
<td>default setting.</td>
<td></td>
</tr>
<tr>
<td>**Compile only invalid</td>
<td>If you enabled the <strong>Compile dependents</strong> option, enabling this option compiles</td>
<td><strong>DB2 LUW Procedures</strong></td>
</tr>
<tr>
<td><strong>dependents</strong></td>
<td>only invalid dependent objects - Creates ALTER COMPILE statements for only those</td>
<td>Oracle Functions, Packages, Procedures, Types, and Views</td>
</tr>
<tr>
<td></td>
<td>objects that are currently invalid.</td>
<td></td>
</tr>
<tr>
<td>**Compile system</td>
<td>If you enabled the <strong>Compile dependents</strong> option, enabling this option compiles</td>
<td><strong>DB2 LUW Procedures</strong></td>
</tr>
<tr>
<td><strong>dependents</strong></td>
<td>dependent system objects - Compiles all of the referenced objects with the debug</td>
<td>Oracle Functions, Packages, Procedures, Types, and Views</td>
</tr>
<tr>
<td></td>
<td>option.</td>
<td></td>
</tr>
<tr>
<td><strong>Compile with debug</strong></td>
<td>Enabling this option instructs the Oracle PL/SQL compiler to generate and store</td>
<td><strong>DB2 LUW Procedures</strong></td>
</tr>
<tr>
<td></td>
<td>the code for use in debugging sessions.</td>
<td>Oracle Functions, Packages, Package Bodies, Procedures, Types, Type Bodies,</td>
</tr>
<tr>
<td></td>
<td></td>
<td>and Views</td>
</tr>
<tr>
<td><strong>Keep specific name</strong></td>
<td>When enabled, compilation will keep the current name.</td>
<td><strong>DB2 LUW Procedures</strong></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Dependencies</strong></td>
<td>Lets you review any dependencies before you proceed. For more information, see</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&quot;Dependencies&quot; on page 576.</td>
<td></td>
</tr>
<tr>
<td><strong>Preview</strong></td>
<td>Displays the DDL generated to execute the Checkpoint operation. For more</td>
<td></td>
</tr>
<tr>
<td></td>
<td>information, see &quot;Preview&quot; on page 576.</td>
<td></td>
</tr>
</tbody>
</table>

3. Click **Execute**. For information on the scheduling option, see "**Scheduling**" on page 843.

**Compiling Oracle Objects**
To recompile an object it must belong to your schema or you need ALTER ANY privileges on that object. You must also have appropriate privileges for any associated objects. Prior to compiling objects of a particular type, see the relevant topic below:

- [Notes on Compiling Oracle Functions](#)
- [Notes on Compiling Oracle Java Sources](#)
- [Notes on Compiling Oracle Materialized Views](#)
- [Notes on Compiling Oracle Packages and Package Bodies](#)
NOTES ON COMPILING ORACLE FUNCTIONS
Rapid SQL lets you recompile a function. Oracle first recompiles any invalid objects on which the function depends. In addition, it marks any objects that depend on the function as invalid.

To recompile a function that is part of a package, compile the package itself. Rapid SQL uses the ALTER FUNCTION statement to compile a stand-alone function. However, you should not use the ALTER FUNCTION statement to individually recompile a function that is part of a package.

For more information, see "Compile" on page 600.

NOTES ON COMPILING ORACLE JAVA SOURCES
Oracle lets you compile a Java source. Oracle resolves references to other Java sources.

For more information, see "Compile" on page 600.

NOTES ON COMPILING ORACLE MATERIALIZED VIEWS
Rapid SQL lets you compile materialized views. If a materialized view fails to revalidate after you recompile, that materialized view cannot be fast refreshed ON DEMAND or used for query rewrite.

For more information, see "Compile" on page 600.

NOTES ON COMPILING ORACLE PACKAGES AND PACKAGE BODIES
Rapid SQL lets you recompile a package, and recompiles all package objects together.

Recompiling a package in Rapid SQL compiles both the package specification and the package body by issuing two consecutive ALTER statements. However, Rapid SQL shows only the ALTER statement for the specification in the Preview: Confirm Compile dialog. You can recompile only the package body by explicitly compiling the package body itself.

When recompiling the entire package, Oracle recompiles the package even if it is invalid. However, if there are compilation errors, the package remains invalid and Oracle invalidates all dependent objects.

Recompiling only a package body does not invalidate objects that depend upon the package specification regardless of whether or not the package body has compilation errors.

For more information, see "Compile" on page 600.
NOTES ON COMPILING ORACLE PROCEDURES
Rapid SQL lets you compile a procedure that is part of a package, by compiling the package itself. Rapid SQL uses the ALTER PROCEDURE statement to compile a stand-alone procedure. However, you should not use the ALTER PROCEDURE statement to individually recompile a procedure that is part of a package.

For more information, see "Compile" on page 600.

NOTES ON COMPILING ORACLE TYPES AND TYPE BODIES
Rapid SQL lets you recompile a type. Rapid SQL recompiles both the type specification and the type body.

For more information, see "Compile" on page 600.

NOTES ON COMPILING ORACLE VIEWS
Rapid SQL lets you recompile a view when you have altered an object referenced by that view.

When you recompile a view, Oracle invalidates all dependant objects.

For more information, see "Compile" on page 600.

CONVERT TABLES
This action lets you build and submit an ALTER TABLE statement, specifying an ENGINE= option, specifying any available storage engine.

NOTE: For information on how to quickly convert a table to use the INNODB storage engine, see "Rebuild Table" on page 660.

Platform Availability
• MySQL

To Change the Storage Engine for a Table
1. Initiate a Convert Tables action against one or more tables. For more information see "Initiating an object operation" on page 573.

2. Use the following table as a guide to understanding and modifying settings in this wizard:

<table>
<thead>
<tr>
<th>Step</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action Options</td>
<td>Use the Convert To dropdown to select an available storage engine.</td>
</tr>
<tr>
<td>Dependencies</td>
<td>Lists referring and referenced objects potentially impacted by the change. For details, see &quot;Dependencies&quot; on page 576.</td>
</tr>
<tr>
<td>Preview</td>
<td>Displays the DDL that will execute the object action. For more information, see &quot;Preview&quot; on page 576.</td>
</tr>
</tbody>
</table>

3. Click Execute. For information on the scheduling option, see "Scheduling" on page 843.
COPY OBJECT NAMES
The Copy Object Names functionality lets you copy and then paste object name(s) into other applications.

Platform Availability
- ORCL, SQL SVR

To Copy an Object Name to be Pasted into Another Application
1 On the Database Navigator, expand nodes until the target object type is visible and then expand the target object type.

2 Right-click on the specific database object or objects and select Copy object name(s).

COPY SCHEMA
This action lets you quickly make copies of a database schema and its corresponding objects.

Platform Availability
- DB2 LUW

To Copy a Schema
1 In the data sources pane, right-click a data source and select Copy Schema from the context menu.

2 Use the following table as a guide to understanding and choosing options the options in the Copying Schema dialog:

<table>
<thead>
<tr>
<th>Pane</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action Options</td>
<td>Lets you specify Copying Schema, Target Schema, specify a Copy Mode of COPY, COPYNO, or DDL, specify a Log filename (COPY and COPYNO modes only), select an Object Owner, and Error table schema, provide an Error table name, and specify a Drop error table after action execution options.</td>
</tr>
<tr>
<td>Tablespace mapping</td>
<td>Lets you specify source and target tablespace options.</td>
</tr>
<tr>
<td>Preview</td>
<td>Displays the DDL generated to execute the operation. For more information, see &quot;Preview&quot; on page 576.</td>
</tr>
</tbody>
</table>

3 Execute or Schedule the action.
CREATE ALIAS
The **Create Alias** object action lets you create an alias to a selected object. The following table shows the object types for which this action is available:

<table>
<thead>
<tr>
<th></th>
<th>Materialized Query Tables</th>
<th>Sequences</th>
<th>Tables</th>
<th>Views</th>
</tr>
</thead>
<tbody>
<tr>
<td>DB2 LUW</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>DB2 z/OS</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
</tbody>
</table>

To create an alias to one of the supported object types:

1. Initiate a **Create Alias** action against a supported object (see the table above). For more information see "Initiating an object operation" on page 573.

   Rapid SQL opens the Alias Wizard. For information on using the Alias editor, see the topic corresponding to the DBMS you are working against:
   - "Aliases Wizard (DB2 LUW)" on page 252
   - "Aliases Wizard (DB2 Z/OS)" on page 279

CREATE CLONE
Rapid SQL provides support for the ADD CLONE option functionality, letting you create a clone on an existing base table. This creates a table with a cloned definition but with no data.

**NOTE:** The base table must reside on a universal tablespace. For more information, see "Tablespaces Wizard (DB2 Z/OS)" on page 297.

Platform Availability
- **DB2 z/OS** version 9 ^

To Create a Clone for One or More Tables:

1. Initiate a **Create Clone** action against one or more tables. For more information see "Initiating an object operation" on page 573.

2. Use the following table as a guide to understanding and modifying settings in the **Create Clone** wizard:

<table>
<thead>
<tr>
<th>Step</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action Options</td>
<td>Lets you provide a <strong>Clone Name</strong>.</td>
</tr>
<tr>
<td>Dependencies</td>
<td>Lists referring and referenced objects potentially impacted by the change. For details, see &quot;Dependencies&quot; on page 576.</td>
</tr>
<tr>
<td>Preview</td>
<td>Displays the DDL that will execute the object action. For more information, see &quot;Preview&quot; on page 576.</td>
</tr>
</tbody>
</table>

3. Click **Execute**. For information on the scheduling option, see "Scheduling" on page 843.
The clone for a table is not displayed in the Datasource Navigator listing of tables for a data source. To determine whether a table has a clone, see the Dependencies tab/panel on a Table editor or on the wizard for object actions such as Drop or Rename.

After creating a clone for a table, you can exchange data between the base table and the clone.

Related Information
- "Exchange Data With Clone" on page 631
- "Drop Clone" on page 622

CREATE INSERT STATEMENTS
The Create Insert Statements dialog box lets you automatically create a set of Insert Statements for selected columns and records and based on the data in a table.

```
1  --
2  -- TABLE INSERT STATEMENTS
3  --
4  INSERT INTO DE2ADMIN.AUTHOR ( AU_FNAME, PHONE )
5     VALUES ( 'Johnson', '4084967223' )
6  ;
7  INSERT INTO DE2ADMIN.AUTHOR ( AU_FNAME, PHONE )
8     VALUES ( 'Marjorie', '4159867020' )
9  ;
```

Platform Availability
- DB2 LUW, DB2 z/OS, ITB/FBD, MySQL, ORCL, SQL SVR, SYB ASE

To Create Insert Statements Based on Existing Table Data
1. In the left pane of the application, select the Tables node.
   Rapid SQL displays the tables.
2. In the right pane of the application, right-click a table, and then select Create Insert Statements.
   Rapid SQL opens the Create Insert Statements dialog.
3. In Columns, select columns to be included in the INSERT statement.
4. Optionally, in the Where box, type a WHERE clause.
5. Enable or disable Include owner information in insert statements.
6 Enable or disable **Set row count**, which lets you specify a row count, the number of rows in a table that were affected by the Insert statement executed against the table, or a view based on the table.

7 Click **OK**.

An ISQL window opens with a set of Insert statements corresponding to the criteria you provided and the table data. For more information, see "**Using the Results Editor**" on page 832.

**CREATE LIKE**

The Create Like Editor lets you create a new object based on an existing object. The following table shows availability of the **Create Like** function for particular object types by DBMS:

<table>
<thead>
<tr>
<th>DB2 LUW</th>
<th>DB2 Z/OS</th>
<th>ITB/FBD</th>
<th>MySQL</th>
<th>SQL Server</th>
<th>Oracle</th>
<th>Sybase ASE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Materialized Query</td>
<td>Tables</td>
<td>Tables</td>
<td>Tables</td>
<td>Logins</td>
<td>Tables</td>
<td>Logins</td>
</tr>
<tr>
<td>Tables</td>
<td></td>
<td></td>
<td></td>
<td>Tables</td>
<td></td>
<td>Tables</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Users</td>
<td></td>
<td>Users</td>
</tr>
</tbody>
</table>

To **Create an Object B**ased on Another Object

1 Initiate a **Create Like** action against a table. For more information see "**Initiating an object operation**" on page 573.

Rapid SQL opens a Create Like wizard.

2 Provide a name for the new object.
3 Modify settings on each panel of the wizard as required.

For particular object types, tasks and settings on the panels of the Create Like wizard are similar to those for the object editors for that object type. For information, see:

- "Materialized Query Tables Editor (IBM DB2 LUW)" on page 457
- "Tables Editor (IBM DB2 LUW)" on page 463
- "Tables Editor (IBM DB2 Z/OS)" on page 481
- "Tables editor (InterBase/Firebird)" on page 496
- "Tables editor (MySQL)" on page 523
- "Logins Editor (SQL Server)" on page 508
- "Tables Editor (SQL Server)" on page 515
- "Users Editor (SQL Server)" on page 518
- "Tables Editor (Oracle)" on page 544
- "Logins Editor (Sybase ASE)" on page 562
- "Tables Editor (Sybase ASE)" on page 565
- "Users Editor (Sybase ASE)" on page 571

4 Click **Execute** to create the new object.

CREATE OR EDIT JAVA SOURCE

The Java Editor lets you enter Java code. The table below describes the Java Editor toolbar options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lock/Unlock Connection</td>
<td>Click to lock or unlock connection.</td>
</tr>
<tr>
<td>Create</td>
<td>Click to open the <strong>Create Options</strong> dialog, which lets you select the options for creating the java source.</td>
</tr>
<tr>
<td>Errors</td>
<td>Click to split the workspace in half, displaying the error messages in the lower half of the workspace.</td>
</tr>
</tbody>
</table>

When you add a script in a new file, you not only choose a name for the file, but choose among create options. Finally, when you complete your script, you can Preview, Schedule or immediately Execute it.

**Platform Availability**

- **ORCL**
CREATE SYNONYM
Rapid SQL lets you perform an ad hoc Create Synonym operation against a specific object displayed in the Datasource Navigator. For background information, see "Synonyms" on page 229.

Platform Availability
- ORCL

You can perform this operation against the following object types:

<table>
<thead>
<tr>
<th>Functions</th>
<th>Materialized Views</th>
<th>Packages</th>
<th>Package Bodies</th>
</tr>
</thead>
<tbody>
<tr>
<td>Procedures</td>
<td>Sequences</td>
<td>Tables</td>
<td>Views</td>
</tr>
</tbody>
</table>

To Create a Synonym for an Object
1. Expand the node corresponding to one of the object types supported for this operation, listed in the table above.
   - The right-hand pane is populated with all objects of that type.
2. Right-click the target object and select Create Synonym from the context menu.
3. A Create Synonym wizard opens.

For information on using the wizard, see "Synonyms Wizard (Oracle)" on page 400.

CREATE VIEW
Right-clicking one or more tables in the Navigator and selecting Create View opens a wizard that lets you create a new view. For more information, see the following topics:

- Views Wizard (DB2 LUW)
- Views Wizard (DB2 Z/OS)
- Views Wizard (ITB/FBD)
- Views Wizard (SQL Server)
- Views Wizard (Oracle)
- Views Wizard (Sybase ASE)

DBCC
Rapid SQL’s DBCC (Database Consistency Check) function box lets you:
- Specify single or multiple tables or indexes for validation.
• Perform database-wide validations.
• Perform object-level validations of databases.

Platform Availability
• SQL SVR, SYB ASE

To Perform a Database Consistency Check
1 Initiate a DBCC action against a database, table, or index, as follows:
   • If you are checking consistency of a Sybase ASE or SQL Server database or a SQL Server table, right-click the object and select DBCC from the context menu, as appropriate.
   • If you are checking consistency of a Sybase ASE table, right-click the table and select either DBCC > Check Allocation, DBCC > Check Table, DBCC > Check Text, or DBCC > Rebuild Index from the context menu, as appropriate.
   • If you are checking consistency of a Sybase ASE index, right-click the index and select either DBCC > Check Allocation, or DBCC > Check Index from the context menu, as appropriate.
   • If you are checking consistency of a SQL Server index, right-click the table and select either DBCC > Check Fragmentation, DBCC > Update Usage, DBCC > Check Index, or DBCC > Show Statistics from the context menu, as appropriate.

   For more information see "Initiating an object operation" on page 573.

   Rapid SQL opens a dialog that lets you specify DBCC options.

2 See the following topics as a guide to understanding and setting options on the dialog:
   • DBCC for Microsoft SQL Server Databases
   • DBCC for Microsoft SQL Server Tables
   • DBCC for Microsoft SQL Server Indexes
   • DBCC for Sybase ASE Databases
   • DBCC for Sybase ASE Tables
   • DBCC for Sybase ASE Indexes

3 Click Execute. For information on the scheduling option, see "Scheduling" on page 843.

DBCC FOR MICROSOFT SQL SERVER
The DBCC (Database Consistency Check) dialog lets you specify single or multiple tables or indexes for validation in Microsoft SQL Server. Use this dialog box to perform table-level or index-level validations of databases which are too large to undergo database-level DBCC operations in a time-efficient manner.

The DBCC dialog includes the following elements:
• A window displaying the target database objects
• A drop-down list of DBCC Operations
• Buttons for previewing the operation’s SQL code, scheduling the operation, and executing the operation

For more information, see:

DBCC for Microsoft SQL Server Databases
DBCC for Microsoft SQL Server Tables
DBCC for Microsoft SQL Server Indexes

DBCC FOR MICROSOFT SQL SERVER DATABASES
The DBCC dialog for databases lets you perform database-wide validations. You should validate your databases as part of regular database maintenance to guard against corruption and failure. Microsoft SQL Server offers a set of DBCC commands to validate the integrity of your databases. Generally, you should perform these DBCC commands prior to dumping your databases to ensure that you are capturing clean backups of your databases.

The fundamental difference between the DBCC dialog for databases, tables and indexes is the content of the DBCC Operation drop-down list.

The table below describes the options and functionality on the DBCC dialog.

<table>
<thead>
<tr>
<th>DBCC Operation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Check Allocation</td>
<td>Executes a DBCC CHECKALLOC command. Makes sure that all data and index panels are correctly allocated and used. It reports on the amount of space allocated and used in the database. When checking allocation, you have the option to skip non-clustered indexes by selecting the Skip non-clustered indexes check box.</td>
</tr>
<tr>
<td>Check Catalog</td>
<td>Executes a DBCC CHECKCATALOG command. Checks for consistency in and between system tables.</td>
</tr>
<tr>
<td>Check Database</td>
<td>Executes a DBCC CHECKDB command. Verifies that all tables and indexes are properly linked, that indexes are in proper sorted order, that all pointers are consistent, that the data on each panel is reasonable, and that panel offsets are reasonable. When checking a database, you have the option to skip non-clustered indexes by selecting the Skip non-clustered indexes check box.</td>
</tr>
<tr>
<td>Check FileGroup</td>
<td>Executes a DBCC CHECKFILEGROUP command. Verifies that all tables and indexes for the specified filegroup are properly linked, that indexes are in proper sorted order, that all pointers are consistent, that the data on each panel is reasonable, and that panel offsets are reasonable. When checking filegroups, you have the option to skip non-clustered indexes by selecting the Skip non-clustered indexes check box.</td>
</tr>
<tr>
<td>Show Oldest Transaction</td>
<td>Executes a DBCC OPENTRAN command. Displays information on the oldest active transaction and the oldest distributed and non distributed replicated transactions, if any, within the specified database.</td>
</tr>
<tr>
<td>Update Usage</td>
<td>Executes a DBCC UPDATEUSAGE command. Reports and corrects the rows, used, reserved, and dpanels columns of the sysindexes table for any clustered indexes on objects of the type U (user-defined table) or S (system table).</td>
</tr>
</tbody>
</table>

For more information, see "DBCC" on page 609.
**DBCC for Microsoft SQL Server Tables**

The DBCC dialog for tables lets you perform table-level validations of databases. The fundamental difference between the DBCC dialog for tables and indexes is the content of the DBCC Operation drop-down list.

The table below describes the options and functionality on the DBCC dialog.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Check Current Identity Value</strong></td>
<td>Checks the current identity value for the target objects, correcting values if needed depending on parameter specifications. Identity columns created with a NOT FOR REPLICATION clause in either the CREATE TABLE or ALTER TABLE statement are not corrected by this operation.</td>
</tr>
<tr>
<td><strong>Check Fragmentation</strong></td>
<td>Displays the target table’s data and index fragmentation information, determining whether the table is heavily fragmented. When a table is heavily fragmented, you can reduce fragmentation and improve read performance by dropping and recreating a clustered index (without using the SORTED_DATA option). Doing so reorganizes the data, resulting in full data pages. To adjust the level of fullness, use the Rebuild Index operation’s FILLFACTOR option. When INSERT, UPDATE, and DELETE statements fragment tables, they usually do so with unequal distribution across the entire database so that each page varies in fullness over time, forcing additional page reads for queries that scan part or all of a table.</td>
</tr>
<tr>
<td><strong>Check Table</strong></td>
<td>Checks the linkages and sizes of text, ntext and image pages for selected tables. For the data, index, text, ntext, and image pages of the target tables, this operation also checks that index and data pages are correctly linked, indexes are in their proper sorted order, pointers are consistent, the data on each page is reasonable, and the page offsets are reasonable. DBCC CHECKTABLE requires a shared lock on all tables and indexes in the database for the duration of the operation. However, DBCC CHECKTABLE does not check the allocations of pages in the specified table (for this, use DBCC CHECKALLOC). To perform DBCC CHECKTABLE on every table in the database, use DBCC CHECKDB.</td>
</tr>
<tr>
<td><strong>Check Text/Image Allocation</strong></td>
<td>Checks the allocation of text, ntext, or image columns for a table. In later versions of Microsoft SQL, use DBCC CHECKTABLE to check the integrity of the data, index, text, ntext, and image pages for the target table.</td>
</tr>
<tr>
<td><strong>Pin Table</strong></td>
<td>Pins target tables in memory so that they are not flushed when Microsoft SQL Server needs space to read in new pages. DBCC PINTABLE is best used for keeping small, frequently referenced tables in memory. Pinning a large table can consume a large portion of the buffer cache, leaving inadequate memory to service other tables in the system. A pinned table that is larger than the buffer cache itself can fill the entire cache, necessitating a shut down of the system by a sysadmin user, who must then restart Microsoft SQL Server and unpin the table. Pinning too many small tables can result in a similar problem.</td>
</tr>
<tr>
<td><strong>Rebuild Index</strong></td>
<td>Dynamically rebuilds one, multiple, or all indexes for a table in the target database, allowing indexes which enforce either primary key or unique constraints to be rebuilt without need for dropping and recreating. This operation is not supported for use on system tables.</td>
</tr>
<tr>
<td><strong>Unpin Table</strong></td>
<td>Marks target tables as unpinned, rendering their pages flushable from the buffer cache if space is needed to read in a new page from disk.</td>
</tr>
</tbody>
</table>
Rapid SQL supports the following Database Console Commands, letting you perform index-level validations of databases.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Update Usage</td>
<td>Reports and corrects inaccuracies in the sysindexes table (which can result in incorrect space usage reports by the sp_spaceused system stored procedure) and corrects the rows, used, reserved, and dpages columns of the sysindexes table for tables and clustered indexes. If there are no inaccuracies in sysindexes, DBCC UPDATEUSAGE returns no data. Use this operation to synchronize space-usage counters. Executing this operation on large tables or databases can require some time, so it should typically be used only when you suspect incorrect values returned by sp_spaceused.</td>
</tr>
</tbody>
</table>

For more information, see “DBCC” on page 609.

DBCC FOR SYBASE ASE

The DBCC (Database Consistency Check) dialog lets you specify single or multiple databases, tables or indexes for validation in Sybase ASE. Use this dialog box to perform table-level or index-level validations of databases which are too large to undergo database-level DBCC operations in a time-efficient manner.

The DBCC dialog includes the following elements:

- A window displaying the target database objects
- A drop-down list of DBCC Operations

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Check</td>
<td>Lets you build and submit a DBCC SHOWCONTIG command, to display fragmentation information for the selected index, letting you determine whether the table is heavily fragmented. When a table is heavily fragmented, you can reduce fragmentation and improve read performance by dropping and recreating a clustered index. For details, see “Rebuild Index (SQL Server)” on page 659.</td>
</tr>
<tr>
<td>Fragmentation</td>
<td></td>
</tr>
<tr>
<td>Update Usage</td>
<td>Lets you build and submit a DBCC UPDATEUSAGE command, reporting on and correcting pages and row count inaccuracies that can result in incorrect space usage reports. The Count Rows control lets you add a WITH COUNT_ROWS argument, dictating that the row count column be corrected as necessary. The No Informational Messages control lets you add a WITH NO_INFOMSGS argument, suppressing all informational messages.</td>
</tr>
<tr>
<td>Check Index</td>
<td>Lets you build and submit a DBCC CHECKTABLE command, verifying the integrity of pages and structures of the table or indexed view. Disabling the Show Informational Messages control adds a WITH NO_INFOMSGS argument, suppressing informational messages.</td>
</tr>
<tr>
<td>Show Statistics</td>
<td>Lets you build and submit a DBCC SHOW_STATISTICS command, displaying current query optimization statistics for the owning table or indexed view.</td>
</tr>
</tbody>
</table>

For more information, see “DBCC” on page 609.
• Buttons for previewing the operation’s SQL code, scheduling the operation, and executing the operation

For more information, see:

DBCC for Sybase ASE Databases
DBCC for Sybase ASE Tables
DBCC for Sybase ASE Indexes

DBCC FOR SYBASE ASE DATABASES
The **DBCC** dialog for databases lets you perform database-wide validations. The fundamental difference between the **DBCC** dialog for databases, tables and indexes is the content of the DBCC Operation drop-down list.

The table below describes the options and functionality on the **DBCC** dialog.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Check Allocation</td>
<td>Checks the allocation and use of all pages in the target database.</td>
</tr>
<tr>
<td>Check Catalog</td>
<td>Checks for consistency in and between system tables in the target database.</td>
</tr>
<tr>
<td>Check Database</td>
<td>Checks the allocation and structural integrity of all the objects in the target database.</td>
</tr>
<tr>
<td>Check Storage</td>
<td>Checks the target database for allocation, OAM page entries, page consistency, text valued columns, allocation of text valued columns, and text column chains. The results of this operation are stored in the <code>dbccdb</code> database.</td>
</tr>
<tr>
<td>Database Repair</td>
<td>Drops a damaged database.</td>
</tr>
</tbody>
</table>

For more information, see **“DBCC” on page 609**.

DBCC FOR SYBASE ASE TABLES
The **DBCC** dialog for tables lets you perform table-level validations of databases. The fundamental difference between the **DBCC** dialog for tables and indexes is the content of the DBCC Operation drop-down list.

The table below describes the options and functionality on the **DBCC** dialog.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Check Allocation</td>
<td>Checks the database to see that every page is correctly allocated, and that no allocated page is unused. Use TABLEALLOC frequently (daily) to check page linkages in the Adaptive Server before performing a database dump to ensure the integrity of the dumped data.</td>
</tr>
<tr>
<td>Check Table</td>
<td>Checks the linkages and sizes of text, ntext and image pages for selected tables. For the data, index, text, ntext, and image pages of the target tables, this operation also checks that index and data pages are correctly linked, indexes are in their proper sorted order, pointers are consistent, the data on each page is reasonable, and the page offsets are reasonable. DBCC CHECKTABLE requires a shared lock on all tables and indexes in the database for the duration of the operation. However, DBCC CHECKTABLE does not check the allocations of pages in the specified table (for this, use DBCC CHECKALLOC). To perform DBCC CHECKTABLE on every table in the database, use DBCC CHECKDB.</td>
</tr>
</tbody>
</table>
DBCC Operation Options

Rapid SQL offers additional options for selected operations which you can specify to further customize a database consistency check. The table below describes each option:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Check Text</td>
<td>Upgrades text values after you have changed an Adaptive Server’s character set to a multibyte character set.</td>
</tr>
<tr>
<td>Rebuild Index</td>
<td>Dynamically rebuilds one, multiple, or all indexes for a table in the target database, allowing indexes which enforce either primary key or unique constraints to be rebuilt without need for dropping and recreating. This operation is not supported for use on system tables.</td>
</tr>
</tbody>
</table>

DBCC FOR SYBASE ASE INDEXES

The DBCC dialog for indexes lets you perform index-level validations of databases. Unlike the DBCC dialog for tables, this DBCC dialog offers only one option on the DBCC Operation drop-down list: Check Allocation. This option checks the specified database to see that all pages are correctly allocated and that no allocated page is unused.

The table below describes the options and functionality on the DBCC dialog.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Error Option</td>
<td>Click Fix Error to instruct Rapid SQL to fix any allocation errors it finds. You must put your database in single-user mode to fix errors, so specify this option during times of low usage.</td>
</tr>
<tr>
<td>Job Scope</td>
<td>Select Optimize to produce a report based on the allocation pages listed in the object allocation map (OAM) pages for the table. It does not report and cannot fix unreferenced extents on allocation pages that are not listed in the OAM pages. The optimized option is the default. Select Full to perform the equivalent of a table-level CHECKALLOC, reporting all types of allocation errors. Select Fast to produce an exception report of pages that are referenced but not allocated in the extent. Fast does not produce an allocation report.</td>
</tr>
<tr>
<td>Update Index</td>
<td>Click this check box to skip non-clustered indexes when updating index options.</td>
</tr>
</tbody>
</table>

For more information, see "DBCC" on page 609.
DEALLOCATE UNUSED SPACE

The Deallocate Unused Space dialog lets you deallocate space from clusters, indexes, and tables. You can also deallocate unused space from table partitions and subpartitions. When you find that allocated space is not being used, you can free that space for use by other objects by explicitly deallocating space. Oracle releases the freed space to the user quota for the tablespace in which the deallocation occurs.

Oracle deallocates unused space from the end of the object toward the high water mark. In other words, Oracle frees space starting with the space that would have been used last. If an extent is completely contained in the space to be deallocated, then the whole extent is freed. If an extent is only partially contained in the space to be deallocated, then Oracle shrinks that extent to the size of the used space up to the high water mark, and frees the unused space in the extent.

If you are deallocating unused space from and index and the index is range-partitioned or hash-partitioned, Oracle deallocates unused space from each partition in the index. If an index is a local index on a composite-partitioned table, Oracle deallocates unused space from each of the subpartitions in the index.

**TIP:** You can verify that the deallocated space is freed by going to the Space tab in the appropriate Rapid SQL editor.

Platform Availability

- ORCL

To Deallocate Unused Space from an Index or Table

1. Initiate a Deallocate Unused Space action against one or more Clusters, Indexes, Primary Keys, Tables, or Unique Keys. For more information see "Initiating an object operation" on page 573.

   Rapid SQL opens the Deallocate Unused Space dialog.

2. Use the following table as a guide to understanding and specifying options on this dialog:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Specify the number of bytes above the high-water mark that the objects</td>
<td>If you do not specify an amount of unused space and the high water mark is above the size of INITIAL and MINEXTENTS, then all of the unused space is freed. If the high water mark is less than the size of INITIAL or MINEXTENTS, then all unused space above MINEXTENTS is freed.</td>
</tr>
<tr>
<td>will have after deallocation. If no value is specified, all unused</td>
<td>If you specify an amount of unused space and the remaining number of extents is smaller than MINEXTENTS, then the MINEXTENTS value changes to reflect the new number. If the initial extent becomes smaller as a result of the deallocation, the INITIAL value changes to reflect the new size of the initial extent.</td>
</tr>
<tr>
<td>space will be freed.</td>
<td></td>
</tr>
</tbody>
</table>

3. Click Execute. For information on the scheduling option, see "Scheduling" on page 843.
DELETE STATISTICS

Lets you create and issue a DELETE STATISTICS statement, allowing you to delete statistics for a table or for specified columns of a table.

Platform Availability

- SYB ASE

To Delete Statistics for a Table

1. Initiate a **Delete Statistics** action against one or more tables. For more information see "Initiating an object operation" on page 573.

2. Use the following table as a guide to understanding and modifying settings in the **Delete Statistics** wizard:

<table>
<thead>
<tr>
<th>Step</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action options</td>
<td>Displays the names of the tables you selected and if appropriate, lets you select a specific Partition Name.</td>
</tr>
<tr>
<td>Columns (Sybase ASE 15 only)</td>
<td>All columns - lets you delete statistics for all columns in the table. Specific columns - select this option and then select check boxes associated with each specific column for which statistics are to be deleted.</td>
</tr>
<tr>
<td>Dependencies</td>
<td>Review the referring and referred objects that will be automatically resolved when you execute this operation. For more information, see &quot;Dependencies&quot; on page 576.</td>
</tr>
<tr>
<td>Preview</td>
<td>Preview the DDL generated for the operation. For more information, see &quot;Preview&quot; on page 576.</td>
</tr>
</tbody>
</table>

3. Click **Execute**. For information on the scheduling option, see "Scheduling" on page 843.

DESCRIBE

Right-clicking a table, view, procedure or function in the Navigator and selecting **Describe** opens a window that lets you view columnar information (for tables and views) or input parameter information (for procedures and functions). For details, see "Describe Window" on page 31.

DETACH DATABASE

The **Detach Database** object action removes the database from the server but leaves the database intact within the data and transaction log files that compose the database. These data and transaction log files can then be used to attach the database to any instance of Microsoft SQL Server, including the server from which the database was detached. This makes the database available in exactly the same state it was in when it was detached.
Platform Availability
- SQL SVR

To Detach Data and Transaction Files for a Database
1. Initiate a Detach Database action against a database. For more information see "Initiating an object operation" on page 573.

Rapid SQL opens the Detach Database(s) dialog.
2. To skip the UPDATE STATISTICS operation when detaching the database, select the Skip Checks check box for the target database(s).

   **TIP:** This option is useful for databases that are to be moved to read-only media.

3. Click Execute. For information on the scheduling option, see "Scheduling" on page 843.

Related Information
- "Attach Database" on page 585

DISABLE INDEX
The Disable Index(es) action lets you mark an index as disabled or inactive and unavailable for use.

Platform Availability
- ITB/FBD, SQL SVR

   **NOTE:** On SQL Server this action can also be applied to primary keys and unique keys.

To Disable an Index
1. Initiate a Disable Index(es) action against one or more indexes. For more information see "Initiating an object operation" on page 573.

2. Use the following table as a guide to understanding and modifying settings in the wizard:

<table>
<thead>
<tr>
<th>Step</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action options</td>
<td>Displays the name of the index, primary key, or unique key being disabled.</td>
</tr>
<tr>
<td>Dependencies</td>
<td>Review the referring and referred objects that will be automatically resolved when you execute this operation. For more information, see &quot;Dependencies&quot; on page 576.</td>
</tr>
<tr>
<td>Preview</td>
<td>Preview the DDL generated for the operation. For more information, see &quot;Preview&quot; on page 576.</td>
</tr>
</tbody>
</table>

3. Click Execute. For information on the scheduling option, see "Scheduling" on page 843.
DISABLE JOB
Rapid SQL lets you enable or disable any job queue. Job Queues are built-in mechanisms that let you schedule a variety of SQL-based or command-line driven tasks.

Platform Availability
- ORCL

To Disable a Job Queue
1. Initiate a Disable Job action against a job queue. For more information see "Initiating an object operation" on page 573.
   Rapid SQL opens the Disable dialog.
2. Click Execute. For information on the scheduling option, see "Scheduling" on page 843.

Related Information
"Enable Job (Job Queue)" on page 627
"Run Job (job queues)" on page 683.

DISABLE KEYS
Rapid SQL lets you issue an ALTER TABLE statement that specifies the DISABLE KEYS option. This action tells MySQL stop updating nonunique indexes.

Platform Availability
- MySQL

To Stop Updates to Nonunique Indexes
1. Initiate a Disable Keys action against one or more tables. For more information see "Initiating an object operation" on page 573.
   Rapid SQL opens the Disable Keys dialog.
2. Use the following table as a guide to understanding and modifying settings in this wizard:

<table>
<thead>
<tr>
<th>Step</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action Options</td>
<td>Lets you review the tables you selected.</td>
</tr>
<tr>
<td>Dependencies</td>
<td>Lists referring and referenced objects potentially impacted by the change. For details, see &quot;Dependencies&quot; on page 576.</td>
</tr>
<tr>
<td>Preview</td>
<td>Displays the DDL that will execute the object action. For more information, see &quot;Preview&quot; on page 576.</td>
</tr>
</tbody>
</table>
3 Click **Execute**. For information on the scheduling option, see "Scheduling" on page 843.

**NOTE:** You can subsequently recreate missing indexes. For details, see "Enable Keys" on page 628.

**DISABLE/ENABLE TRIGGERS**
These actions let you build and submit ALTER TABLE statements that specify ENABLE TRIGGER or DISABLE TRIGGER options.

**Platform Availability**
- **SQL SVR, SYB ASE**

**To Enable or Disable Triggers for a Table**
1 On the Database Navigator, select the **Tables** node. Rapid SQL displays the tables.

2 On the Database Navigator, right-click one or more selected tables and select **Enable Triggers** or **Disable Triggers**.

   Rapid SQL opens the **Enable Triggers** or **Disable Triggers** dialog, as appropriate.

3 Click **Execute**.

**DROP**
The **Confirm Drop** dialog lets you drop one or more database objects and remove their definition from the system catalog.

**Platform Availability**
- **DB2 LUW, DB2 z/OS, ITB/FBD, MySQL, ORCL, SQL SVR, SYB ASE, SYB IQ**

**To Drop an Object**
1 Initiate a **Drop** action against one or more objects. For more information see "Initiating an object operation" on page 573.

   Rapid SQL opens the **Confirm Drop** dialog on the **Action Options** panel.

2 On the **Action Options** panel, select any options specific to the object type or configuration of the object you are dropping.
3 Navigate to the **Dependencies** pane to view database objects that are dependent on the object you are dropping.

**NOTE:** For Microsoft SQL Server, when dropping Logins, you also have the option to delete corresponding user objects.

**NOTE:** For Microsoft SQL Server, when dropping Databases, you also have the option to delete the backup and restore history for the database.

4 Navigate to the **Preview** pane to verify that the correct DDL was created, and if necessary navigate backward and modify your choices.

5 Click **Execute** to drop the object.

### DROP AUTOMATIC STORAGE PATH(S)

This action lets you remove tablespace storage paths on a datasource and subsequently rebalance any affected tablespaces. It builds and submits:

- An ALTER DATABASE DROP STORAGE ON... statement specifying the storage paths to be removed
- Optionally, one ALTER TABLESPACE... REBALANCE statement for each tablespace impacted by the ALTER DATABASE DROP STORAGE ON... statement

### Platform Availability

- **DB2 LUW** 9.7^  

### Prerequisites or Setup Tasks

This object action is only available for datasources configured for autostorage and that have at least two autostorage paths configured.

### To drop storage paths on a datasource

1 Initiate a **Drop Automatic Storage Path(s)** action against a datasource. For more information see "**Initiating an object operation**" on page 573.

2 Use the following table as a guide to understanding and modifying settings in this wizard:

<table>
<thead>
<tr>
<th>Step</th>
<th>Settings and tasks</th>
</tr>
</thead>
</table>
| **Path(s) Selection**  | **Path:** Select the check box associated with each storage path that is to be dropped. This object action will not allow you to select all storage paths on a datasource. At least one path must be left active.  
**Rebalance the affected tablespaces:** Selecting this check box generates an ALTER TABLESPACE... REBALANCE statement for each tablespace affected by the storage paths you selected to drop. |
3 Click **Execute**. For information on the scheduling option, see "**Scheduling**" on page 843.

For related information, see "**Rebalance**" on page 655.

### DROP BY CATEGORY

This action lets you build and submit one or more calls to the `outln_pkg.drop_by_cat` subprogram, letting you drop outlines belonging to specified categories.

#### Platform Availability

- **ORCL**

### To Drop One or More Stored Outlines of a Particular Category

1. Initiate a **Drop By Category** action against one or more stored outlines. For more information see "**Initiating an object operation**" on page 573.

2. Use the following table as a guide to understanding and modifying settings in this **Drop By Category** wizard:

<table>
<thead>
<tr>
<th>Step</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Action Options</strong></td>
<td>Select the categories to drop.</td>
</tr>
<tr>
<td><strong>Preview</strong></td>
<td>Displays the DDL that will execute the object action. For more information, see &quot;<strong>Preview</strong>&quot; on page 576.</td>
</tr>
</tbody>
</table>

3. Click **Execute**. For information on the scheduling option, see "**Scheduling**" on page 843.

#### Related Information

- "**Change Category**" on page 591
- "**Reassign By Category**" on page 654

### DROP CLONE

If you have created a clone from a base table, you can drop that clone. To determine whether a table has a clone, see the **Dependencies** tab/panel on a Table editor or on the wizard for object actions such as Drop or Rename.

#### Platform Availability

- **DB2 z/OS** version 9

---

[622 RAPID SQL XE4/8.5 USER GUIDE](#)
To Drop the Clones of One or More Tables

1. Initiate a Drop Clone action against one or more tables. For more information see "Initiating an object operation" on page 573.

2. Use the following table as a guide to understanding and modifying settings in the Confirm Drop Clone wizard:

<table>
<thead>
<tr>
<th>Step</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action Options</td>
<td>Lets you review the action you initiated.</td>
</tr>
<tr>
<td>Dependencies</td>
<td>Lists referring and referenced objects potentially impacted by the change. For details, see &quot;Dependencies&quot; on page 576.</td>
</tr>
<tr>
<td>Preview</td>
<td>Displays the DDL that will execute the object action.</td>
</tr>
</tbody>
</table>

3. Click Execute. For information on the scheduling option, see "Scheduling" on page 843.

Related Information

- "Create Clone" on page 605
- "Exchange Data With Clone" on page 631

DROP JAVA

This action lets you make use of the dropjava tool, deleting schema objects corresponding to Java files.

Platform Availability

- ORCL

To Drop Schema Objects Associated with a Java File

1. Initiate a Drop Java action against one or more Java Classes. For more information see "Initiating an object operation" on page 573.

2. Use the following table as a guide to understanding and modifying settings on the Drop Java Objects dialog:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Who Owns the Java Object</td>
<td>Select the owner of objects to be dropped.</td>
</tr>
<tr>
<td>File to be dropped</td>
<td>Use these controls to build a list of Java files for which associated objects are to be dropped.</td>
</tr>
<tr>
<td>Drop Synonym</td>
<td>Drops any synonyms defined for objects being dropped.</td>
</tr>
</tbody>
</table>

3. Click Execute. For information on the scheduling option, see "Scheduling" on page 843.
Related Information

- "Load Java" on page 642

**DROP LOGIN TRIGGER**

The Drop Login Trigger action lets you build and submit an sp_modifylogin call that specifies a NULL login script option. This removes the configured login trigger for the login, the default database stored procedure that executes each time the user successfully logs in.

**NOTE:** If a login has a login trigger configured, the specified stored procedure name is visible in the Login editor. For details, see "Logins Editor (Sybase ASE)" on page 562.

**Platform Availability**

- **SYB ASE**

**To Remove the Currently Configured Login Trigger for a Login**

1. Expand the **Logins** node. Rapid SQL displays all logins for the datasource.

2. Right-click a login and select **Login Trigger Actions > Drop Login Trigger** from the context menu. Rapid SQL opens the **Drop Login Trigger** dialog.

3. Use the following table as a guide to understanding and modifying settings in the wizard:

<table>
<thead>
<tr>
<th>Step</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action options</td>
<td>Displays the login you selected to run the action against.</td>
</tr>
<tr>
<td>Dependencies</td>
<td>Review the referring and referred objects that will be automatically resolved when you execute this operation. For details, see &quot;Dependencies&quot; on page 576.</td>
</tr>
<tr>
<td>Preview</td>
<td>Preview the DDL generated for the operation. For more information, see &quot;Preview&quot; on page 576.</td>
</tr>
</tbody>
</table>

**Related Information**

- "Add/Modify Login Trigger" on page 581

**DROP MATERIALIZED QUERY TABLE**

The **Drop Materialized Query** action lets you convert a materialized query table to a regular table.

**Platform Availability**

- **DB2 LUW**
To Convert a Materialized Query Table to a Regular Table
1. Initiate a Drop Materialized Query Table action against one or more materialized query tables. For more information see "Initiating an object operation" on page 573.

   Rapid SQL opens the Confirm MQT Conversion to Regular dialog.

2. Click Execute. For information on the scheduling option, see "Scheduling" on page 843.

DROP UNUSED
This action lets you build and submit one or more calls to the `outln_pkg.drop_unused` subprogram, letting you drop outlines that have not been used since being created.

Platform Availability
- ORCL

To Drop One or More Unused Stored Outlines
1. Initiate a Drop Unused action against one or more stored outlines. For more information see "Initiating an object operation" on page 573.

   Rapid SQL opens the Drop Unused dialog.

2. Use the following table as a guide to understanding and modifying settings in this wizard:

<table>
<thead>
<tr>
<th>Step</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Preview</td>
<td>Displays the DDL that will execute the object action. For more information, see &quot;Preview&quot; on page 576.</td>
</tr>
</tbody>
</table>

3. Click Execute. For information on the scheduling option, see "Scheduling" on page 843.

DROP UNUSED COLUMNS
This action lets you build and submit an ALTER TABLE... DROP UNUSED COLUMNS statement, letting you remove columns currently marked as unused.

Platform Availability
- ORCL
To Drop the Clones of one or more Tables

1. Initiate a **Drop Unused Columns** action against one or more tables. For more information see "Initiating an object operation" on page 573.

2. Use the following table as a guide to understanding and modifying settings in the **Drop Unused Columns** wizard:

<table>
<thead>
<tr>
<th>Step</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action Options</td>
<td>Displays the tables you selected</td>
</tr>
<tr>
<td>Dependencies</td>
<td>Lists referring and referenced objects potentially impacted by the change. For details, see &quot;Dependencies&quot; on page 576.</td>
</tr>
<tr>
<td>Preview</td>
<td>Displays the DDL that will execute the object action. For details, see &quot;Preview&quot; on page 576.</td>
</tr>
</tbody>
</table>

3. Click **Execute**. For information on the other options, see **Preview** and **Scheduling**.

EDIT DATA

Right-clicking a table and selecting Edit Data lets you edit table data. For details, see "Data Editor" on page 889.

ENABLE/DISABLE (ORACLE JOBS)

This action builds and submits a DBMS_SCHEDULER.DISABLE or DBMS_SCHEDULER.ENABLE call, letting you enable or disable a job or program.

Platform Availability

- **ORCL 10g**

To enable or disable a job or program

1. On a connected Oracle datasource, expand the **Scheduler** nodes and select the **Jobs** or **Programs** node.

2. Right-click a job or program and select **Enable/Disable** from the context menu.

3. Use the following table as a guide to understanding and modifying settings in the dialog:

<table>
<thead>
<tr>
<th>Step</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action options</td>
<td>Select the <strong>Enabled</strong> check box to enable the job or program. Leave the <strong>Enabled</strong> check box deselected to disable the job or program.</td>
</tr>
<tr>
<td>Dependencies</td>
<td>Lists referring and referenced objects potentially impacted by the change. For details, see &quot;Dependencies&quot; on page 576.</td>
</tr>
<tr>
<td>Preview</td>
<td>Displays the DDL that will execute the object action. For details, see &quot;Preview&quot; on page 576.</td>
</tr>
</tbody>
</table>

4. Click **Execute**. For information on the scheduling option, see "Scheduling" on page 965.
ENABLE/DISABLE STORED OUTLINE AUTO-CREATION/AUTO-USE

Rapid SQL provides two operations that can be performed against one or more stored outlines, that dictate whether execution plans are automatically generated or used:

- **Enable/disable stored outline auto-creation**
  
  Lets you specify whether Oracle to create a stored outline for every query submitted to the server.

- **Enable/disable stored outline auto-use**
  
  Lets you specify whether Oracle uses stored outlines to generate execution plans.

Platform Availability

- **ORCL**

To Specify Whether Stored Outlines are Automatically Created and Used

1. Initiate an Enable/disable stored outline auto-use or Enable/disable stored outline auto-creation action against one or more stored outlines. For more information see "Initiating an object operation" on page 573.

2. Use the following table as a guide to understanding and modifying settings in the wizard:

<table>
<thead>
<tr>
<th>Step</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action Options</td>
<td>Automatically create stored outlines or Automatically use stored outlines</td>
</tr>
<tr>
<td>Category</td>
<td>Lets you select an outline category. This option is only available if you enabled the feature.</td>
</tr>
<tr>
<td>No Override</td>
<td>If selected, outlines will not override. This option is only available if you enabled the feature.</td>
</tr>
<tr>
<td>Dependencies</td>
<td>Review the referring and referred objects that will be automatically resolved when you execute this operation.</td>
</tr>
<tr>
<td>Preview</td>
<td>Preview the DDL generated for the operation. For more information, see &quot;Preview&quot; on page 576.</td>
</tr>
</tbody>
</table>

3. When ready, click **Execute**.

ENABLE JOB (JOB QUEUE)

Rapid SQL lets you enable or disable any job queue. Job Queues are built-in mechanisms that let you schedule a variety of SQL-based or command-line driven tasks.

Platform Availability

- **ORCL**
To Enable a Job Queue

1. Initiate an **Enable Job** action against a job queue. For more information see "Initiating an object operation" on page 573.

   Rapid SQL opens the **Enable** dialog.

2. Click **Execute**. For information on the scheduling option, see "Scheduling" on page 843.

Related Information

- "**Disable Job**" on page 619
- "**Run Job (job queues)**" on page 683

**ENABLE KEYS**

Rapid SQL lets you issue an ALTER TABLE statement that specifies the ENABLE KEYS option. This action tells MySQL to recreate missing indexes.

**Platform Availability**

- **MySQL**

To Recreate Missing Indexes

1. Initiate an **Enable Keys** action against one or more tables. For more information see "Initiating an object operation" on page 573.

   Rapid SQL opens the **Enable Keys** dialog.

2. Use the following table as a guide to understanding and modifying settings in this wizard:

<table>
<thead>
<tr>
<th>Step</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action Options</td>
<td>Lets you review the tables you selected.</td>
</tr>
<tr>
<td>Dependencies</td>
<td>Lists referring and referenced objects potentially impacted by the change. For details, see &quot;Dependencies&quot; on page 576.</td>
</tr>
<tr>
<td>Preview</td>
<td>Displays the DDL that will execute the object action. For more information, see &quot;Preview&quot; on page 576.</td>
</tr>
</tbody>
</table>

3. Click **Execute**. For information on the scheduling option, see "Scheduling" on page 843.

   **NOTE:** You can also instruct MySQL to stop updating nonunique indexes. For details, see "**Disable Keys**" on page 619.

**ENABLE RECYCLE BIN**

This action builds and submits an ALTER SYSTEM SET "_recyclebin"=TRUE or ALTER SYSTEM SET "_recyclebin"=FALSE statement, letting you enable or disable the Oracle Recycle Bin.
This action lets you enable or disable the Oracle Recycle Bin, building and submitting one of the following version-specific statement variations:

- **Oracle 10g R1** - `ALTER SYSTEM SET "_recyclebin" TRUE / FALSE`
- **Oracle 10g R2** - `ALTER SYSTEM SET RECYCLEBIN ON / OFF SCOPE=BOTH`
- **Oracle 11g** - `ALTER SYSTEM SET RECYCLEBIN ON / OFF DEFERRED SCOPE=BOTH` (note that in this case, the change takes effect after reconnecting to the datasource)

When the Recycle Bin is enabled, dropped objects are stored in the Recycle Bin until explicitly purged.

**To Enable or Disable the Recycle Bin**

1. Right-click an Oracle datasource node, and select **Enable Recycle Bin** from the context menu.

2. Use the following table as a guide to understanding and modifying settings in this wizard:

<table>
<thead>
<tr>
<th>Panel</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action Options</td>
<td>Select the <strong>Enable</strong> check box to enable Recycle Bin functionality. Deselect the <strong>Enable</strong> check box to disable the feature.</td>
</tr>
<tr>
<td>Preview</td>
<td>Displays the DDL that will execute the object action. For details, see &quot;Preview&quot; on page 576.</td>
</tr>
</tbody>
</table>

**NOTE:** In general, you can determine the current enabled/disabled state of the Recycle Bin by opening the **Enable Recycle Bin** dialog. If the **Enable** check box is selected, the Recycle Bin is currently enabled. However, that the **Enable Recycle Bin** action reads the current state of the Recycle Bin by querying the v$parameter object. On some Oracle 10g R1 servers, the "_recyclebin" parameter does not appear listed in v$parameter – it is hidden. As a result, for this specific case, the value of the check box when opening the **Enable Recycle Bin** dialog will always be TRUE, regardless of the actual value.

3. Click **Execute**. For information on the scheduling option, see "Scheduling" on page 843.

**Related Information**

- "Recycle Bin" on page 222 (for a support summary including topics such as displaying Recycle Bin contents)
- "Flashback Recycle Bin Entry" on page 635
- "Purge Recycle Bin Entry" on page 652
- "Purge Recycle Bin" on page 650

**ERROR**

The Error message displays a warning. After reading the warning, click **Close** to continue.
ESTIMATE SIZE
The **Estimate Size** dialog for tables and indexes lets you estimate how large a table or index will become given a row growth projection. The results let you proactively plan your space-related object needs.

Platform Availability
- ORCL, SYB ASE

To Estimate Size for a Table or Index
1. Initiate an **Estimate Size** action against one or more tables or indexes. For more information see "Initiating an object operation" on page 573.
   
   Rapid SQL opens the **Estimate Size** dialog.

2. Use the following topics as a guide to estimating size and using the other options offered on this dialog:
   - Estimating Oracle index or table sizes
   - Estimating Sybase ASE index or table sizes

ESTIMATING ORACLE INDEX OR TABLE SIZES
The **Estimate Size** dialog remains open until you manually close it. This lets you run several estimations, varying the method and various metrics. Each estimation run is a three-step process:

1. Select a size estimation method:
   - **Use current row data from current statistics** - The table or index must have been previously analyzed for statistics to be obtained. Note that the Analyze Index(es) and Analyze Table(s) buttons can be used to initiate this action. For more details, see Analyze.
   - **Use table/index definition source** - The maximum row length for the index or table will be calculated. Note that this usually produces much higher space estimates.
   - **Manually enter estimation metrics** - Manually enter in data for space estimates if the objects have no data or if the index definition source method is not desired.

2. Depending on the method you chose, provide additional metrics:
   - Percent Free
   - Row Size
   - Number of rows

3. Click the **Estimate Size** button and view the estimate in the **Estimated Index Size** box.

Other options include:
- Use the **Report** button to generate an HTML report of results
• Use the Save As button to save a result grid file
• Use the Owner and Name controls to select another table or index for size estimates.
• Use the Add Index or Add Table button to add another table or index to your size estimates. Similarly, use the Remove Index or Remove Table button to remove a table or index from the dialog.

ESTIMATING SYBASE ASE INDEX OR TABLE SIZES
The Estimate Size dialog remains open until you manually close it. This lets you run several estimations, varying the available metrics. Each estimation run is a two-step process:

1. Provide the metrics for your estimate:
   • Fill Factor (indexes only) - Specify a percentage of how full each index page can become.
   • Number of rows - Specify the number of rows for your size estimate.
   
   NOTE: Optionally you can use the Update Statistics button to open a dialog that lets you generate new statistics for the index or table. For details, see “Update Statistics” on page 697.

2. Click the Estimate Size button and view the estimate in the Estimated Index Size box.

Other options include:
• Use the Report button to generate an HTML report of results
• Use the Save As button to save a result grid file
• Use the Database, Owner, Table Name, and Index Name controls to select another table or index for size estimates.
• Use the Add Index or Add Table button to add another table or index to your size estimates. Similarly, use the Remove Index or Remove Table button to remove a table or index from the dialog.

EXCHANGE DATA WITH CLONE
This action lets you issue an EXCHANGE statement with the DATA BETWEEN TABLE table1 AND table2 syntax, letting you swap data between a base table and its clone. To determine whether a table has a clone, see the Dependencies tab/panel on a Table editor or on the wizard for object actions such as Drop or Rename.

Platform Availability
• DB2 z/OS version 9 ^
To Exchange Data Between One or More Tables and their Clones

1. Initiate a Clone Actions > Exchange Data With Clone action against one or more tables. For more information see "Initiating an object operation" on page 573.

   Rapid SQL opens the Exchange Data With Clone dialog.

2. Use the following table as a guide to understanding and modifying settings in this wizard:

<table>
<thead>
<tr>
<th>Step</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action Options</td>
<td>Lets you review the action you initiated.</td>
</tr>
<tr>
<td>Dependencies</td>
<td>Lists referring and referenced objects potentially impacted by the change. For details, see &quot;Dependencies&quot; on page 576.</td>
</tr>
<tr>
<td>Preview</td>
<td>Displays the DDL that will execute the object action. For more information, see &quot;Preview&quot; on page 576.</td>
</tr>
</tbody>
</table>

3. Click Execute. For information on the scheduling option, see "Scheduling" on page 843.

Related Information

- "Create Clone" on page 605
- "Drop Clone" on page 622

EXECUTE

The Execution dialog lets you execute extended procedures, functions, and procedures.

Platform and object type availability

<table>
<thead>
<tr>
<th></th>
<th>DB2 LUW</th>
<th>DB2 z/OS</th>
<th>ITB/FBD</th>
<th>MySQL</th>
<th>Oracle</th>
<th>SQL Server</th>
<th>Sybase ASE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Extended procedures</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>Functions</td>
<td></td>
<td>✓</td>
<td></td>
<td></td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Procedures</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
</tbody>
</table>

To Compile an Extended Procedure, Function, or Procedure

1. Expand the node corresponding to valid object type. Objects of that type are displayed below the object type node.

2. Right click the target object and select Execute from the context menu.

   **NOTE:** If the extended procedure, function, or procedure takes input parameters, Rapid SQL opens an execution dialog. For more information, see Working With Execution Parameters.
The Results editor opens, showing either results of a successfully executed extended procedure, function, or procedure, or showing error messages if execution was not successful. For details, see "Using the Results Editor" on page 832.

WORKING WITH EXECUTION PARAMETERS
If you initiate an Execute action against an extended procedure, function, or procedure that takes input parameters, Rapid SQL opens a dialog that lets you provide parameter values and otherwise manage parameters.

The Procedure Execution dialog lets you:

- Save input parameters as *.prm files to preserve specific input parameter configurations.
- Open *.prm files to save the effort of reentering specific input parameters.
- Reset parameters to their default setting.

The table below describes the options and functionality of the Procedure Execution dialog:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Parameter</td>
<td>Specify the required input parameters in this window. If input parameters are not required for the execution of the target procedure, a message displays in this window, stating that the procedure “has no input parameters. Press execute to run it.”</td>
</tr>
<tr>
<td>Open</td>
<td>Click to open an Open dialog, from which you can open an existing *.prm file. The saved parameters immediately populate the dialog box upon opening.</td>
</tr>
<tr>
<td>Save</td>
<td>Click to save the values of your input parameters as a *.prm file. You can reopen a saved *.prm file from this dialog box at any time.</td>
</tr>
<tr>
<td>Reset</td>
<td>Click to reset the parameters in the Parameter window to their default values.</td>
</tr>
<tr>
<td>Default</td>
<td>Select to gather default information from the data dictionary. ORACLE ONLY: You can not specify non-default parameters after specifying a default parameter.</td>
</tr>
<tr>
<td>Continue</td>
<td>Click to execute the procedure once you have entered values for all required parameters in the Parameter window.</td>
</tr>
</tbody>
</table>

For more general information on the Execute operation, see "Execute" on page 632.

EXTRACT
Rapid SQL lets you extract the statements required to create existing objects into an Interactive SQL window.

**NOTE:** For information on setting preferences for this action, see "DDL Extract Options" on page 98.

Platform Availability
- **DB2 LUW, DB2 z/OS, ITB/FBD, MySQL, ORCL, SQL SVR, SYB ASE, SYB IQ**
To Extract the DDL for an Object
1. Initiate an Extract action against one or more objects. For more information see "Initiating an object operation" on page 573.

Rapid SQL opens the DDL Editor with the DDL to create the selected objects. For more information, see "Using the DDL Editor" on page 845.

EXTRACT DATA AS XML
This function allows you to take SQL data, extract it, and make it available as XML data. The XML Editor Filter allows you to pick and choose among columns and designate rows and then creates the For XML statement that enables the operation. The resulting XML document is created and presented in an active XML Editor. At this point the document can be saved in XML format.

CAUTION: To use the Extract Data as XML feature in Sybase ASE, you must first purchase and install an XML Services license from Sybase.

Platform Availability
- ORCL 9i, SQL SVR, SYB ASE 12.5.1

To Open the XML Editor Filter
1. Initiate an Extract Data as XML action against a table. For more information see "Initiating an object operation" on page 573.

Rapid SQL opens an XML Editor Filter dialog.
2. In the Columns area, select the check boxes corresponding to the columns with data you want to extract.
3. Optionally, in the Where box, type a WHERE clause to qualify the records that will be extracted.
   
   NOTE: As you select options, inspect the Select box to verify the query you are creating.

4. Use the table below as a guide to understanding and specifying the optional DBMS-specific settings in this dialog:

<table>
<thead>
<tr>
<th>DBMS</th>
<th>Setting or group</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sybase ASE</td>
<td>Refer to Sybase online documentation for details on XML mapping information. For assistance, see &quot;Accessing Third Party Documentation&quot; on page 21.</td>
<td></td>
</tr>
<tr>
<td>Oracle</td>
<td>Row Set Tag</td>
<td>Identify the XML element name you want to use to replace the Row Set tag.</td>
</tr>
<tr>
<td></td>
<td>Row Tag</td>
<td>Identify the XML element names you want to use to replace the Row tag.</td>
</tr>
<tr>
<td></td>
<td>Max Rows.</td>
<td>The maximum number of rows to fetch.</td>
</tr>
</tbody>
</table>
5 When ready, click **OK**. Rapid SQL opens an XML representation of the extracted data in an XML editor.

### Flashback Recycle Bin Entry

This action lets you build and submit a `FLASHBACK TABLE... TO BEFORE DROP` statement against a table in the Recycle Bin. This recovers the table and restores it to its state immediately before the drop.

**NOTE:** The Datasource Explorer entry for a Recycle Bin entry has a **Can Undrop** field that indicates whether a Flashback Recycle Bin Entry action can be performed against the item.

#### Platform Availability

- **ORCL** 10g

#### To Recover a Table Currently in the Recycle Bin

1. Expand the **Recycle Bin** node to display its contents.

2. Right-click one or more selected tables in the Recycle Bin and select **Flashback Recycle Bin Entry** from the context menu. The **Flashback Recycle Bin Entry** dialog opens.

3. Use the following table as a guide to understanding and modifying settings in the wizard:

<table>
<thead>
<tr>
<th>Step</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action options</td>
<td>Displays the table entries you selected to restore.</td>
</tr>
<tr>
<td>Dependencies</td>
<td>Review the referring and referred objects that will be automatically resolved when you execute this operation. For details, see “Dependencies” on page 576.</td>
</tr>
<tr>
<td>Preview</td>
<td>Preview the DDL generated for the operation. For more information, see “Preview” on page 576.</td>
</tr>
</tbody>
</table>
4 Click **Execute**. For information on the scheduling option, see "**Scheduling**" on page 843.

**Related Information**
- "**Recycle Bin**" on page 222 (for a support summary including topics such as displaying Recycle Bin contents)
- "**Enable Recycle Bin**" on page 628
- "**Purge Recycle Bin Entry**" on page 652
- "**Purge Recycle Bin**" on page 650

**FLASHBACK TABLE**
This action builds and submits a FLASHBACK TABLE statement, letting you restore a table to a state at some specified time in the past.

**NOTE:** Before using this object action, consult Oracle documentation for information on restrictions, required permissions, and details on System Change Numbers and Restore Points. For more information, see "**Accessing Third Party Documentation**" on page 21.

**Platform Availability**
- **ORCL 10g ^

  **NOTE:** Available options differ by the version of Oracle that Rapid SQL is working against.
To Restore a Table to Some Previous State

1. Initiate a Flashback Table action against a table. For more information see "Initiating an object operation" on page 573.

2. Use the following table as a guide to understanding and modifying settings on the dialog:

<table>
<thead>
<tr>
<th>Panel</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action Options</td>
<td>Lets you select a specific FLASHBACK TABLE clause:</td>
</tr>
<tr>
<td>Type</td>
<td><strong>BEFORE DROP</strong> - If the table is currently in the Recycle Bin, the table will be</td>
</tr>
<tr>
<td></td>
<td>restored to its state immediately before being dropped.</td>
</tr>
<tr>
<td></td>
<td><strong>SCN</strong> - restores the table to a time corresponding to a specified System Change</td>
</tr>
<tr>
<td></td>
<td>Number.</td>
</tr>
<tr>
<td></td>
<td><strong>TIMESTAMP</strong> - restores the table to a time corresponding to a specified</td>
</tr>
<tr>
<td></td>
<td>timestamp value.</td>
</tr>
<tr>
<td></td>
<td><strong>RESTORE POINT</strong> - (10g R2 ^) restores the table to a time corresponding to a</td>
</tr>
<tr>
<td></td>
<td>specified name associated with an SCN.</td>
</tr>
<tr>
<td>SCN</td>
<td>If you selected a <strong>Type</strong> value of SCN, type a System Change Number.</td>
</tr>
<tr>
<td>Timestamp</td>
<td>If you selected a <strong>Type</strong> value of TIMESTAMP, use this control to provide a</td>
</tr>
<tr>
<td></td>
<td>timestamp.</td>
</tr>
<tr>
<td>Restore Point (10g R2 ^)</td>
<td>If you selected a <strong>Type</strong> value of RESTORE POINT, select a restore point.</td>
</tr>
<tr>
<td>Enable Trigger</td>
<td>If you selected a <strong>Type</strong> value of SCN, TIMESTAMP, or RESTORE POINT, selecting</td>
</tr>
<tr>
<td></td>
<td>this check box overrides the default behavior, ensuring that triggers remain</td>
</tr>
<tr>
<td></td>
<td>enabled during the flashback process.</td>
</tr>
<tr>
<td>Rename To</td>
<td>If you selected a <strong>Type</strong> value of BEFORE DROP, specify a new name for the table</td>
</tr>
<tr>
<td></td>
<td>being retrieved from the Recycle Bin.</td>
</tr>
<tr>
<td>Dependencies</td>
<td>For details on using this tab, see &quot;Dependencies&quot; on page 576.</td>
</tr>
<tr>
<td>Preview</td>
<td>Displays the DDL that will execute the object action. For details, see &quot;Preview&quot; on</td>
</tr>
<tr>
<td></td>
<td>page 576.</td>
</tr>
</tbody>
</table>

3. Click **Execute**. For information on the scheduling option, see "Scheduling" on page 843.

**Related Information**

"Flashback Recycle Bin Entry" on page 635

**FLUSH CACHE**

Rapid SQL lets you clear all dynamic SQL in the cache for a package and forces IBM DB2 for Linux, Unix, and Windows to recompile the SQL the next time it is called.

**Platform Availability**

- **DB2 LUW**
To Flush the Cache for a Package
1. Initiate a **Flush Cache** action against a package. For more information see "Initiating an object operation" on page 573.

   Rapid SQL opens the **Flush Package Cache** dialog.

2. Click **Execute**. For information on the scheduling option, see "Scheduling" on page 843.

FLUSH TABLES
This action lets you build and submit a FLUSH statement, specifying a TABLE or TABLES option. This flushes the specified tables and removes all query results from the query cache.

Platform Availability
- MySQL

To Flush One or More Tables
1. Initiate a **Flush Tables** action against one or more stored tables. For more information see "Initiating an object operation" on page 573.

2. Use the following table as a guide to understanding and modifying settings in this wizard:

<table>
<thead>
<tr>
<th>Step</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Action Options</strong></td>
<td>Displays the tables selected for this flush operation.</td>
</tr>
<tr>
<td><strong>Dependencies</strong></td>
<td>Lists referring and referenced objects potentially impacted by the change. For details, see &quot;Dependencies&quot; on page 576.</td>
</tr>
<tr>
<td><strong>Preview</strong></td>
<td>Displays the DDL that will execute the object action. For more information, see &quot;Preview&quot; on page 576.</td>
</tr>
</tbody>
</table>

3. Click **Execute**. For information on the scheduling option, see "Scheduling" on page 843.

FREE (PACKAGES)
Rapid SQL lets you delete one or more packages.

Platform Availability
- DB2 z/OS
To Delete Packages

1. Initiate a **Free Packages** action against one or more packages. For more information see "Initiating an object operation" on page 573.

2. Use the following table as a guide to understanding and modifying settings in the Confirm Free wizard:

<table>
<thead>
<tr>
<th>Step</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Action Options</strong></td>
<td>Displays the names of the packages you chose to free. This panel also lets you select a <strong>Order Drop By Selection</strong> setting, which dictates whether drop statements are generated in the order objects are selected.</td>
</tr>
<tr>
<td><strong>Dependencies</strong></td>
<td>Lists referring and referenced objects potentially impacted by the change. For details, see &quot;Dependencies&quot; on page 576.</td>
</tr>
<tr>
<td><strong>Preview</strong></td>
<td>Displays the DDL that will execute the object action. For more information, see &quot;Preview&quot; on page 576.</td>
</tr>
</tbody>
</table>

3. Click **Execute**. For information on the scheduling option, see "Scheduling" on page 843.

**FREE PLAN**
This action lets you drop plans associated with packages.

To Drop a Plan Associated with a Package

- Click the **Free** button on the **Plans/Packlists** tab of the Packages editor. For more information, see "Packages Editor (IBM DB2 Z/OS)" on page 476.

For more information on dropping database objects, see "Drop" on page 620.

**GENERATE PACKAGE/PROCEDURE/STATEMENT**
Rapid SQL lets you generate simple packages, procedures, and statements for selected tables and lets you generate a simple select statement for views. Because the packages and procedures generated by Rapid SQL are rudimentary, they are intended merely as a starting point and should be modified to reflect your specific needs. Rapid SQL opens the generated statements in the ISQL Window.

When Rapid SQL creates a package from a table, it generates a series of procedures designed to emulate the typical variety of procedures in a package. Rapid SQL lets you choose the IN and OUT columns and generates the procedures based on your selections. Rapid SQL creates procedures and statements from tables in the same way.

**Platform Availability**
- **DB2 z/OS**, **ITB/FBD**, **ORCL**, **SQL SVR**, **SYB ASE**
Important Notes

None

For more information, see:

- Generate Packages, Procedures, and Statements
- Generate Select Statement

GENERATE PACKAGES, PROCEDURES, AND STATEMENTS

Rapid SQL opens this dialog box when you want to generate code for an Insert, Update, or Delete statement. This dialog box lets you specify the columns you want to include in the generation of an Insert, Update, or Delete statement or procedure.

GENERATE SELECT STATEMENT

Rapid SQL opens this dialog box when you want to generate code for a Select statement. This dialog box includes two panes: one for specifying Input Columns, one for specifying Output Columns.

**NOTE:** This dialog box mirrors the functionality of Rapid SQL’s Embarcadero Code Generator dialog box, which is accessible from the application’s Tools menu and Tools toolbar.

The **Select 1 or More Columns** dialog lets you specify the IN and OUT columns for a package or procedure, or the columns to select for a Select statement and any associated WHERE clause. Rapid SQL uses the Input Columns to generate the WHERE clause.

HIDE TEXT

This action lets you build and submit sp_hidetext calls against one or more objects. This allows you to hide the source text for particular object types:

**CAUTION:** The Hide Text action is irreversible. Once hidden, source text cannot be made viewable or otherwise retrievable again.

**NOTE:** For details on the specific elements hidden, consult Sybase documentation. See "Accessing Third Party Documentation" on page 21.

Within Rapid SQL, when viewing an object after hiding text, hidden elements occupying entire tabs or individual property boxes, are annotated with a **Source text for this compiled object is hidden** message.
Hide Text can be applied both to individual objects and to objects containing or owning other objects. Supported object types for which Hide Text can be applied to individual objects, and the resulting Rapid SQL-specific hidden elements in object editors are as follows:

<table>
<thead>
<tr>
<th>Object Type</th>
<th>Hidden Element Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>Check constraints</td>
<td>Check Condition box, Definition tab.</td>
</tr>
<tr>
<td>Defaults</td>
<td>Value box, Properties tab.</td>
</tr>
<tr>
<td>Extended procedures</td>
<td>Library name box, Properties tab.</td>
</tr>
<tr>
<td>Functions</td>
<td>Definition tab.</td>
</tr>
<tr>
<td>Procedures</td>
<td>Definition tab.</td>
</tr>
<tr>
<td>Rules</td>
<td>Restriction box, Properties tab.</td>
</tr>
<tr>
<td>Triggers</td>
<td>Definition tab.</td>
</tr>
<tr>
<td>Views</td>
<td>Definition tab.</td>
</tr>
</tbody>
</table>

Object-containing or object-referencing object types to which Hide Text can be applied are as follows:

<table>
<thead>
<tr>
<th>Object Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Databases</td>
<td>Hides the source text of all compiled objects in the selected database.</td>
</tr>
<tr>
<td>Tables</td>
<td>Hides the source text of all check constraints, defaults, and triggers defined on the selected table.</td>
</tr>
<tr>
<td>Users</td>
<td>Hides the source text of all compiled objects owned by the selected user.</td>
</tr>
</tbody>
</table>

**CAUTION:** Because of the potentially broad scope of hiding text for users and databases, you should exercise extreme care when applying Hide Text to those object types.

**Platform Availability**

- **SYB ASE**

**To Permanently Hide the Source Text for One or More Objects**

1. In the Database Navigator, expand the node corresponding to one of the target object types. Objects of that type are shown below the object type node.
2. Right-click one or more selected objects, and then select Hide Text from the context menu. The Confirm Hide Text dialog opens.
3  Use the following table as a guide to understanding and modifying settings in the wizard:

<table>
<thead>
<tr>
<th>Step</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action options</td>
<td>Displays the name of the objects you selected.</td>
</tr>
<tr>
<td>Dependencies</td>
<td>Review the referring and referred objects that will be automatically resolved when you execute this operation. For more information, see &quot;Dependencies&quot; on page 576.</td>
</tr>
<tr>
<td>Preview</td>
<td>Preview the DDL generated for the operation. For more information, see &quot;Preview&quot; on page 576.</td>
</tr>
</tbody>
</table>

4  Click **Execute**. For information on the scheduling option, see "Scheduling" on page 843.

Browser views for supported objects show a **Hidden** property that indicates whether **Hide Text** has been applied to the object. **Y** indicates that source text for this compiled object has been irreversibly hidden.

**IMPORT DATA FROM FILE**
Right-clicking a table in the Navigator and selecting **Import Data From File** opens a dialog that lets you import table data from a file. For details, see "Import Data" on page 899.

**LOAD JAVA**
Before you can call Java stored procedures, you must load them into the Oracle database and publish them to SQL.

**NOTE:** This functionality is available for Oracle only.

**NOTE:** For related information, see "Drop Java" on page 623.

The Java Load Wizard lets you:

- Select the owner of the Java object and the files to load.
- Select options for the loading of the files.
- Select Resolver options.

For more information, see **Java Load Wizard - Panel 1**.

**JAVA LOAD WIZARD - PANEL 1**
The table below describes the options of the first panel of the Java Load Wizard.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Who owns the Java Object?</td>
<td>Lets you select the owner of the Java object.</td>
</tr>
<tr>
<td>Select files to be loaded</td>
<td>Select a file, and then click <strong>Add</strong>.</td>
</tr>
</tbody>
</table>
JAVA LOAD WIZARD - PANEL 2
The table below describes the options of the second panel of the Java Load Wizard.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>When do you want the Java files to be resolved?</td>
<td>Lets you specify when the source file is loaded as a source schema object, the source file is compiled, class schema objects are created for each class defined in the compiled .java file, and the compiled code is stored in the class schema objects.</td>
</tr>
<tr>
<td>Select the Encoding Options</td>
<td>Lets you specify the encoding of the .java file.</td>
</tr>
<tr>
<td>Grant Access to the following users</td>
<td>Lets you select one or more users.</td>
</tr>
</tbody>
</table>

JAVA LOAD WIZARD - PANEL 3
The table below describes the options of the third panel of the Java Load Wizard.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Other Load Options</td>
<td>OPTIONAL: Lets you select options.</td>
</tr>
<tr>
<td>Add Resolver Options</td>
<td>Lets you specify the objects to search within the schemas defined.</td>
</tr>
<tr>
<td>Add</td>
<td>Click to open the Select a Resolver Option dialog to add a new resolver option in the list.</td>
</tr>
<tr>
<td>Edit</td>
<td>Click to open the Resolver Edit dialog to modify a resolver option.</td>
</tr>
<tr>
<td>Remove</td>
<td>Select one or more resolver option and click to delete.</td>
</tr>
</tbody>
</table>

LOCK
The Lock Table dialog lets you lock tables to prevent other users from reading or updating the table data. Locking a table saves the time of locking each row of the table that needs to be updated. Lock mode options preventing other users from viewing or modifying table data, or allowing other users to view but not modify table data. Rapid SQL releases locks at the end of a transaction.

Platform Availability
- DB2 LUW

To Lock a Table
1. Initiate a Lock action against one or more tables. For more information see "Initiating an object operation" on page 573.

   Rapid SQL opens the Lock Table dialog.
2. Select a Lock Mode option:
   - Share - Lets other users view but not modify the table data.
   - Exclusive - Prevents other users from viewing or modifying the table data.

3. Click **Execute**. For information on the scheduling option, see "**Scheduling**" on page 843.

**LOWER HIGH WATER MARK**

Against automatically-managed tablespaces, this action lets you build and submit an ALTER TABLESPACE... REDUCE statement, specifying that existing containers be reduced by a specified size.

Against database-managed tablespaces, you build and submit an ALTER TABLESPACE... LOWER HIGH WATER MARK statement followed by an ALTER TABLESPACE... REDUCE statement, explicitly lowering the high water mark before reducing the size of the tablespace.

**NOTE:** Before using this object action, consult DB2 LUW documentation for information on automatic and non-automatic storage, storage reclaimability, as well as database versus system-managed tablespaces. For more information, see "**Accessing Third Party Documentation**" on page 21.

**Platform Availability**

- **DB2 LUW 9.7** ^

**To Lower the High Water Mark for a Tablespace**

1. Initiate a **Lower High Water Mark** action against a tablespace. For more information see "**Initiating an object operation**" on page 573.

2. Use the following table as a guide to understanding and choosing options in the **Lower High Water Mark** dialog:

<table>
<thead>
<tr>
<th>Pane</th>
<th>Options</th>
</tr>
</thead>
</table>
| **Action Options** | Against automatically-managed tablespaces, this pane lets you provide the REDUCE option value for the generated ALTER TABLESPACE statement. Two options are provided. Selecting **MAX** specifies that the high water mark be lowered by moving the maximum number of extents to the beginning of the tablespace. Specifying a **Size** and **Unit** specifies the numeric value by which the tablespace is to be reduced through extent movement.
   Against database-managed tablespaces, this pane only allows you to specify that **All Containers** are to be decreased by a specified **Size** (in Pages, KB, MB, or GB **Units**). If you want to specify individual containers, use the **Containers** panel. |

**MOVE LOG**

Rapid SQL lets you move a transaction log from one device to another.

**Platform Availability**
- SYBASE

**To Move a Database Transaction Log to Another Device**

1. Initiate a Move Log action against one or more databases. For more information see "Initiating an object operation" on page 573.

   Rapid SQL opens the Move Log dialog.

2. From the New Device dropdown, select the defined device to which you want to move the transaction log.

3. Click Execute. For information on the scheduling option, see "Scheduling" on page 843.
MOVE TABLE

The Move Table action lets you move data in an active table into a new, identically-named table, leaving the data online and available for use. This action lets you build and submit one or more SYSPROC.ADMIN_MOVE_TABLE calls. A single call, corresponding to the MOVE command, lets you execute all move operations in a single step. Multiple calls correspond to use of the INIT, COPY, REPLAY, VERIFY, SWAP, CLEANUP or CANCEL commands, and let you execute the move operations in individual steps.

**NOTE:** Before using this object action, consult DB2 LUW documentation for information on the ADMIN_MOVE_TABLE procedure, specifically the options and parameters used by the procedure. For more information, see "Accessing Third Party Documentation" on page 21.

**Platform Availability**
- **DB2 LUW** 9.7 ^
To move table data

1. Initiate a Move Table action against a table. For more information see "Initiating an object operation" on page 573.

2. Use the following table as a guide to understanding and choosing options the options in the dialog:

<table>
<thead>
<tr>
<th>Pane</th>
<th>Categories and Option Descriptions</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Action Options</strong></td>
<td><strong>Method</strong></td>
</tr>
<tr>
<td></td>
<td>The Use Target Table option lets you select from the two methods available with use of the ADMIN_MOVE_TABLE procedure. Select the Use Target Table check box if you have already created the target table, and are using this action to move the data to that table. Leave the Use Target Table check box unselected to specify tablespaces used by the new table and have this action create the table before moving data to the new table.</td>
</tr>
</tbody>
</table>

| **Tablespace** | These options are only available with the Use Target Table check box deselected. They let you optionally specify new data, index, and LOB tablespaces for the target table. |

| **Target Table** | This option is only available with the Use Target Table check box selected. It lets you specify an existing table to be used as the target table during the move. |

| **Operations** | The Generate... options correspond to the ADMIN_MOVE_TABLE Operation input parameters. These can be used in one of two mutually exclusive ways. You can generate a single ADMIN_MOVE_TABLE call specifying MOVE to have all operations performed at one time. Alternatively, you can generate one or more ADMIN_MOVE_TABLE calls corresponding to each of the selected INIT, COPY, REPLAY, VERIFY, SWAP, CLEANUP, or CANCEL options, to have the table moved one step at a time. |

| MOV,E, INIT, COPY, REPLAY, VERIFY, SWAP, CLEANUP, and CANCEL Options | A set of options is displayed for each selected Generate... option. Depending on the Generate... selection, KEEP, COPY_USE_LOAD, COPY_WITH_INDEXES, FORCE, NO_STATS, COPY_STATS, NO_AUTO_REVAL, REORG, NO_TARGET_LOCKSIZE, CLUSTER, NON_CLUSTER, and LOAD_MSGPATH options may be available. Keep in mind that CLUSTER and NON_CLUSTER options are mutually exclusive and that LOAD_MSGPATH is only available when COPY_USE_LOAD is selected. |

| Preview | Displays the DDL generated to execute the operation. For more information, see "Preview" on page 576. |

3. Click the Execute or Schedule button.

**NEXT USED FILEGROUP**

This action builds and submits an ALTER PARTITION SCHEME... NEXT USED statement, letting you alter the designated NEXT USED filegroup for a partition scheme.

**Platform Availability**

- SQL SVR
To Change a Partition Scheme’s Next Used Filegroup
1. Initiate a **Next Used Filegroup** action against a partition scheme. For more information, see "Initiating an object operation" on page 573.

2. Use the following table as a guide to understanding and modifying settings in the dialog:

<table>
<thead>
<tr>
<th>Step</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Next Used Filegroup</td>
<td>Select the new filegroup from the <strong>Filegroup Name</strong> dropdown.</td>
</tr>
<tr>
<td>Preview</td>
<td>Preview the DDL generated for the operation. For more information, see &quot;Preview&quot; on page 576.</td>
</tr>
</tbody>
</table>

3. Click **Execute**. For information on the scheduling option, see "Scheduling" on page 843.

**OBJECT PROPERTIES**
This action submits a **sp_iqhelp** procedure call against a selected object of one of the following types:

- Domains
- Events
- Functions
- Procedures
- System Tables
- Tables
- Views

Standard **sp_iqhelp** output, providing information about the object, is opened in a Results Editor.

**Platform Availability**
- SYB IQ

**To display sp_iqhelp information for an object**
1. Initiate an **Object Properties** action against an object of one of the types in the table above. For more information see "Initiating an object operation" on page 573.

Rapid SQL opens the output in a Results Editor.

**OPTIMIZE TABLES**
Rapid SQL lets you issue an OPTIMIZE TABLE statement, reclaiming unused space and defragmenting the data file.

**Platform Availability**
- MySQL
To Optimize Table Storage

1. Initiate an **Optimize Tables** action against one or more tables. For more information see "Initiating an object operation" on page 573.

   Rapid SQL opens the **Optimize Tables** dialog.

2. Use the following table as a guide to understanding and modifying settings in this wizard:

<table>
<thead>
<tr>
<th>Step</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action Options</td>
<td>Lets you review the tables you selected.</td>
</tr>
<tr>
<td>Dependencies</td>
<td>Lists referring and referenced objects potentially impacted by the change. For details, see &quot;Dependencies&quot; on page 576.</td>
</tr>
<tr>
<td>Preview</td>
<td>Displays the DDL that will execute the object action. For more information, see &quot;Preview&quot; on page 576.</td>
</tr>
</tbody>
</table>

3. Click **Execute**. For information on the scheduling option, see "Scheduling" on page 843.

**PLACE**

The **Placement** dialog lets you place tables and indexes on different segments. From a performance standpoint it is not recommended to have a table and its supporting indexes on the same device or disk segment. It is also good to have more frequently accessed indexes and tables grouped together on higher speed devices, if possible.

**Platform Availability**

- **SYBASE**

**To Place an Index or Table on a Segment**

1. Initiate a **Place** action against one or more tables or indexes. For more information see "Initiating an object operation" on page 573.

2. Use the following table as a guide to understanding and modifying settings in the **Place** wizard:

<table>
<thead>
<tr>
<th>Step</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action options</td>
<td>Use the <strong>Segment</strong> dropdown to specify the segment on which you can place objects, the default, logsegment or system.</td>
</tr>
<tr>
<td>Dependencies</td>
<td>Review the referring and referred objects that will be automatically resolved when you execute this operation. For more information, see &quot;Dependencies&quot; on page 576.</td>
</tr>
<tr>
<td>Preview</td>
<td>Preview the DDL generated for the operation. For more information, see &quot;Preview&quot; on page 576.</td>
</tr>
</tbody>
</table>

3. Click **Execute**. For information on the scheduling option, see "Scheduling" on page 843.
POPULATION STATUS
This action builds and submits an ALTER FULLTEXT INDEX statement with a START {FULL|INCREMENTAL|UPDATE} POPULATION or STOP | PAUSE | RESUME POPULATION argument, letting you start, stop, pause or resume population of the full-text index.

NOTE: Before using this action, consult Microsoft SQL Server documentation for detailed information on topics such as timestamp column restrictions on the INCREMENTAL option and the interaction of these options with the background update index and auto change tracking features. For more information, see “Accessing Third Party Documentation” on page 21.

Platform Availability
- SQL SVR

To Control Population of a Full-text Index
1. Initiate a Population Status action against one or more full-text indexes. For more information, see “Initiating an object operation” on page 573.

2. Use the following table as a guide to understanding and modifying settings in the dialog:

<table>
<thead>
<tr>
<th>Step</th>
<th>Settings and tasks</th>
</tr>
</thead>
</table>
| Action Options | Select an option from the Action dropdown:  
START FULL - every row of the table is retrieved for full-text indexing, even rows that have already been indexed.  
START INCREMENTAL - only the rows modified since the last population are retrieved. This option only works properly against tables with a timestamp column.  
START UPDATE - only insertions, updates, or deletions processed since the last change-tracking index update. Change-tracking population must be enabled on the table, but the background update index or the auto change tracking should be disabled.  
STOP - stops a paused population or population in progress.  
PAUSE - pauses a FULL population in progress  
RESUME - resumes a paused FULL population. |
| Preview | Preview the DDL generated for the operation. For more information, see “Preview” on page 576. |

3. Click Execute. For information on the scheduling option, see “Scheduling” on page 843.

PURGE RECYCLE BIN
This action builds and submits a PURGE RECYCLEBIN, PURGE DBA_RECYCLEBIN, PURGE TABLESPACE tablespacename, or PURGE TABLESPACE tablespacename USER username statement. This lets you select one of the following purge Recycle Bin options:

- Purge all objects belonging to the current user
- Purge all objects belonging to all users
• Purge all objects residing on a specified tablespace
• Purge all objects residing on a specified tablespace and belonging to a specified user

Platform Availability
• ORCL 10g

To Purge Objects in the Recycle Bin Tables and Associated Objects
1. Right-click the Recycle Bin node and select Purge Recycle Bin from the context menu.
2. Use the following table as a guide to understanding and modifying settings on the Confirm Purge Recycle Bin wizard:

<table>
<thead>
<tr>
<th>Panel</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action Options</td>
<td>Select a PURGE option type: RECYCLEBIN purges all objects belonging to the current user. DBA_RECYCLEBIN purges objects system wide. TABLESPACE purges objects residing on a specific tablespace.</td>
</tr>
<tr>
<td>Tablespace</td>
<td>If you selected a Purge value of TABLESPACE, select the tablespace for which all residing objects will be purged. Optionally, use the User control to further qualify the objects that will be purged.</td>
</tr>
<tr>
<td>User</td>
<td>If you selected a Purge value of TABLESPACE, you can use this control to restrict purging to only those tablespace-residing objects belonging to a particular user.</td>
</tr>
<tr>
<td>Preview</td>
<td>Displays the DDL that will execute the object action. For details, see &quot;Preview&quot; on page 576.</td>
</tr>
</tbody>
</table>

3. Click Execute. For information on the scheduling option, see "Scheduling" on page 843.

Related Information
• "Recycle Bin" on page 222 (for a support summary including topics such as displaying Recycle Bin contents)
• "Enable Recycle Bin" on page 628
• "Flashback Recycle Bin Entry" on page 635
• "Purge Recycle Bin Entry" on page 652
PURGE RECYCLE BIN ENTRY

This action builds and submits a PURGE INDEX or PURGE TABLE statement, letting you permanently delete tables or indexes from the Oracle Recycle Bin. Once purged, the tables or indexes and any associated objects that were contained in the Recycle Bin are no longer retrievable.

**NOTE:** The Datasource Explorer entry for a Recycle Bin entry has a Can Purge field that indicates whether a Purge Recycle Bin Entry action can be performed against the item.

Platform Availability

- **ORCL 10g**

To Permanently Purge Selected Tables or Indexes Currently in the Recycle Bin

1. Expand the Recycle Bin node to display its contents.
2. Right-click one or more selected tables or indexes in the Recycle Bin and select Purge Recycle Bin Entry from the context menu. The Confirm Purge Recycle Bin Entry dialog opens.
3. Use the following table as a guide to understanding and modifying settings in the wizard:

<table>
<thead>
<tr>
<th>Step</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action options</td>
<td>Displays the table and index entries you selected to purge.</td>
</tr>
<tr>
<td>Dependencies</td>
<td>Review the referring and referred objects that will be automatically resolved when you execute this operation. For details, see &quot;Dependencies&quot; on page 576.</td>
</tr>
<tr>
<td>Preview</td>
<td>Preview the DDL generated for the operation. For more information, see &quot;Preview&quot; on page 576.</td>
</tr>
</tbody>
</table>

4. Click Execute. For information on the scheduling option, see "Scheduling" on page 843.

**NOTE:** When dropping tables on a datasource with the Recycle Bin feature enabled, the Rapid SQL Drop action has an option that lets you immediately purge the table.

Related Information

- "Recycle Bin" on page 222 (for a support summary including topics such as displaying Recycle Bin contents)
- "Enable Recycle Bin" on page 628
- "Flashback Recycle Bin Entry" on page 635
- "Purge Recycle Bin" on page 650

QUIESCE

Rapid SQL lets you quiesce at the instance or database level. For details, see the following topics:
• Quiesce (Database)
• Quiesce (Instance)

QUIESCE (DATABASE)
This action lets you restrict user access to a database.

Platform Availability
• DB2 LUW

**NOTE:** Rapid SQL does not support **Quiesce Database** for a DB2 8 server from an IBM DB2 for Linux, Unix, and Windows client or for an IBM DB2 for Linux, Unix, and Windows 7 server from an IBM DB2 for Linux, Unix, and Windows client.

To Quiesce a Database
1. On the Navigator, right-click a datasource node and select **Command > Quiesce** from the context menu. Provide login credentials if prompted.

2. Use the following table as a guide to understanding and modifying settings on the **Quiesce Database** dialog:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connections</td>
<td>Lets you select an <strong>Immediate</strong> quiesce or <strong>Defer</strong>.</td>
</tr>
</tbody>
</table>

3. Click **Execute**.

Related Information
• "**Unquiesce**" on page 697

QUIESCE (INSTANCE)
This action lets you restrict user access to an instance.

Platform Availability
• DB2 LUW

To Quiesce an Instance
1. On the Navigator, right-click the **Instance** node.

2. Select **Command > Quiesce** from the context menu. Provide login credentials if prompted.
3. Use the following table as a guide to understanding and modifying settings on the Quiesce Instance dialog:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>For user</td>
<td>Select this radio button to restrict a user and then type the user name in the associated box.</td>
</tr>
<tr>
<td>For group</td>
<td>Select this radio button to restrict a group and then type the group name in the associated box.</td>
</tr>
<tr>
<td>Connections</td>
<td>Lets you select an Immediate quiesce or Defer.</td>
</tr>
</tbody>
</table>

4. Click Execute.

Related Information
- "Unquiesce" on page 697

REASSIGN BY CATEGORY
Rapid SQL lets you reassign the category of stored outlines in Oracle.

Outlines are a set of results for the execution plan generation of a particular SQL statement. When you create an outline, plan stability examines the optimization results using the same data used to generate the execution plan. That is, Oracle uses the input to the execution plan to generate an outline, and not the execution plan itself.

Platform Availability
- ORCL

To Reassign a Stored Outline to a Different Category
1. Initiate a Reassign By Category action against one or more stored outlines. For more information see "Initiating an object operation" on page 573.

2. Use the following table as a guide to understanding and modifying settings in the Reassign By Category wizard:

<table>
<thead>
<tr>
<th>Step</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action options</td>
<td>Displays the outlines you selected. Select a new category for the outline or outlines from the Category dropdown.</td>
</tr>
<tr>
<td>Preview</td>
<td>Preview the DDL generated for the operation. For more information, see &quot;Preview&quot; on page 576.</td>
</tr>
</tbody>
</table>

3. Click Execute. For information on the scheduling option, see "Scheduling" on page 843.

Related Information
- "Change Category" on page 591
• "Drop By Category" on page 622

REBALANCE
This action lets you build and submit one or more ALTER TABLESPACE... REBALANCE statements. This creates containers on recently added storage paths and drops containers from storage paths that are in DROP PENDING state.

Platform Availability
• DB2 LUW 9.7

Prerequisites or Setup Tasks
This object action is only available for tablespaces that meet the following criteria:

• The tablespace must use automatic storage. That is, in the Tablespace Editor, the Use Automatic Storage property is selected. For more information see "Tablespsces Editor (IBM DB2 LUW)" on page 466.

• In the Tablespace Editor, the Type property specifies LARGE or REGULAR.

To rebalance a tablespace
1 Initiate a Rebalance action against one or more tablespaces.
2 Use the following table as a guide to understanding and modifying settings in this wizard:

<table>
<thead>
<tr>
<th>Step</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action Options</td>
<td>Displays the tablespaces selected for this operation.</td>
</tr>
<tr>
<td>Dependencies</td>
<td>Review the referring and referred objects that will be automatically resolved when you execute this operation. For details, see &quot;Dependencies&quot; on page 576.</td>
</tr>
<tr>
<td>Preview</td>
<td>Displays the DDL that will execute the object action. For more information, see &quot;Preview&quot; on page 576.</td>
</tr>
</tbody>
</table>

3 Click Execute. For information on the scheduling option, see "Scheduling" on page 843.

Related Information
• See "Drop Automatic Storage Path(s)" on page 621.

REBIND PACKAGES
The Rebind Package dialog lets you update the best access path for SQL statements when the contents of a package changes.

TIP: If the physical storage of a package is changed or dropped, rebinding updates the path of the SQL statements.
Platform Availability

- DB2 LUW, DB2 z/OS

To Rebind One or More Packages

1. Initiate a **Rebind Packages** action against one or more packages. For more information see "Initiating an object operation" on page 573.

   Rapid SQL opens the **Rebinding Package** dialog.

2. Click **Execute**. For information on the scheduling option, see "Scheduling" on page 843.

**REBIND PLANS**

This action lets you update the best access path for SQL statements when the contents of a plan change.

**TIP:** If the physical storage of a plan is changed or dropped, rebinding updates the path of the SQL statements.

Platform Availability

- DB2 z/OS

To Rebind a Plan Associated with a Package

- Click the **Rebind** button on the **Plans/Packlists** tab of the Packages editor. For more information, see "Packages Editor (IBM DB2 Z/OS)" on page 476.

**REBUILD (FULL-TEXT CATALOGS)**

This action builds and submits a basic ALTER FULLTEXT CATALOG catalogname REBUILD statement, with no additional options or arguments. This lets you rebuild the entire catalog by deleting the existing catalog and building a new one.

Platform Availability

- SQL SVR

To Rebuild a Full-text Catalog

1. Initiate a **Rebuild** action against one or more full-text catalogs. For more information, see "Initiating an object operation" on page 573.

2. Use the following table as a guide to understanding and modifying settings in the dialog:

<table>
<thead>
<tr>
<th>Step</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action options</td>
<td>Displays the catalogs you selected.</td>
</tr>
</tbody>
</table>
3 Click **Execute**. For information on the scheduling option, see "**Scheduling**" on page 843.

**REBUILD INDEX**

See the following topics for DBMS-specific instructions on rebuilding indexes:

- [Rebuild Index (Oracle)](#)
- [Rebuild Index (SQL Server)](#)
- [Rebuild Indexes (InterBase/Firebird)](#)

**REBUILD INDEX (ORACLE)**

The **Rebuild Indexes** dialog lets you rebuild an index that has become fragmented. Rebuilding an index is a good alternative to coalescing an index because you can move the index to a different tablespace and change both tablespace and storage parameters while eliminating fragmentation. However, rebuilding an index has a higher cost than coalescing an index. These same qualities also make rebuilding an index a viable alternative to dropping an index then re-creating it.

As a rule of thumb, check indexes for rebuilds when their level (or tree depth) reaches four or greater, or many deleted leaf rows are found. The **Rebuild Indexes** dialog can also be used to easily move an index from one tablespace to another.

**Important Notes**

- If you are rebuilding a function-based index, the index is enabled when the rebuild is finished.
- You cannot rebuild a partitioned index. You must rebuild each partition or subpartition individually.

The table below describes the options and functionality on the **Rebuild** dialog.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>New Tablespace</td>
<td>Defaults to the tablespace which currently includes the index. To change the tablespace containing the index, choose a new tablespace from the list.</td>
</tr>
<tr>
<td>Logging</td>
<td>Recoverable - The creation of the index logs in the redo log file. Non-Recoverable - The creation of the index is not logged in the redo log file.</td>
</tr>
</tbody>
</table>
To Rebuild an Oracle Index

1 Initiate a Rebuild action against one or more indexes. For more information see "Initiating an object operation" on page 573.

Rapid SQL opens the Rebuild Indexes dialog.

2 To move the index to a new tablespace, click the New Tablespace list and then click the new tablespace.

3 In the Logging box, click:

   • The Recoverable option button to make the operation log in the redo file.
   • The Non-Recoverable option button if you do not want the operation logged in the redo file.

4 If you are using Parallel Server, select the Parallel Server check box and:

   • Type a value indicating the number of query server processes that should be used in the operation in the Degree box.
   • Type a value indicating how you want the parallel query partitioned between the Parallel Servers in the Instances box.

5 In the Order box:

   • Click the Reverse option button to rebuild the index to store the bytes of the index block in reverse order.
   • Click the No Reverse option button to rebuild the index to store the bytes of the index block in order.

6 Click Execute. For information on the scheduling option, see "Scheduling" on page 843.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use Parallel Processes</td>
<td>Performs processes for the sequential execution of a SQL statement in parallel using multiple parallel processes. One process, known as the parallel execution coordinator, dispatches the execution of a statement to several parallel execution servers and coordinates the results from all of the server processes to send the results back to the user. <strong>NOTE:</strong> Only available for Oracle with the Parallel Server option. NOPARALLEL execution - Select this if you are concerned that the cost of synchronizing parallel processes will impede the throughput of data.</td>
</tr>
<tr>
<td>Order</td>
<td>Reverse - Instructs Oracle to store the bytes of the index block in reverse order and to exclude the ROWID when rebuilding the index. No Reverse - Instructs Oracle to store the bytes of the index block in normal order when rebuilding the index.</td>
</tr>
</tbody>
</table>
REBUILD INDEX (SQL Server)
The Rebuild Indexes dialog lets you rebuild an entire index, primary key, or unique key or a single partition of those objects. Depending on your choice, a number of REBUILD WITH clause options are available.

To Rebuild an Index
1. Initiate a Rebuild Index action against one or more indexes, primary keys, or unique keys. For more information see "Initiating an object operation" on page 573.
2. Use the following table as a guide to understanding and modifying settings in the Rebuild Index wizard:

<table>
<thead>
<tr>
<th>Step</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action options</td>
<td>To rebuild a single partition, specify a Partition number and optionally, provide Sort in tempdb and MaxDOP property values used to create the REBUILD WITH clause. To rebuild the entire index, primary key, or unique key, DO NOT provide a Partition Number, and optionally, provide Pad Index, Sort in tempdb, Ignore Duplicate Key, Statistics no recompute, Online, Allow Row Locks, Allow Page Locks, MaxDOP, and Fill Factor property values used to create the REBUILD WITH clause. For more information on these properties, see &quot;Indexes Wizard (SQL Server)&quot; on page 336.</td>
</tr>
<tr>
<td>Dependencies</td>
<td>Lets you review the objects potentially impacted by this action.</td>
</tr>
<tr>
<td>Preview</td>
<td>Preview the DDL generated for the operation. For more information, see &quot;Preview&quot; on page 576.</td>
</tr>
</tbody>
</table>

3. Click Execute. For information on the scheduling option, see "Scheduling" on page 843.

REBUILD INDEXES (INTERBase/Firebird)
This action rebuilds indexes by issuing ALTER INDEX/INACTIVE followed by ALTER INDEX/ACTIVE statements.

To Rebuild an Index
1. On the Database Navigator, expand nodes until the Indexes node is displayed.
2. Expand the indexes node and select one or more indexes.
3. Right-click the selected indexes and select Rebuild Indexes from the context menu. The Rebuild Index dialog opens.
4. Use the following table as a guide to understanding and modifying settings in the wizard:

<table>
<thead>
<tr>
<th>Step</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action options</td>
<td>Displays the indexes you chose to rebuild.</td>
</tr>
<tr>
<td>Dependencies</td>
<td>Lists referring and referenced objects potentially impacted by the change. For details, see Dependencies.</td>
</tr>
<tr>
<td>Preview</td>
<td>Preview the DDL generated for the operation and when ready, use the Schedule or Execute button to perform this action.</td>
</tr>
</tbody>
</table>
5 Click **Execute**. For information on the scheduling option, see “**Scheduling**” on page 843.

**REBUILD OUTLINES**
Rapid SQL lets you rebuild one or more stored outlines in a single operation.

**Platform Availability**
- **ORCL**

**To Rebuild a Stored Outline**
1 Initiate a **Rebuild Outlines** action against one or more stored outlines. For more information see “**Initiating an object operation**” on page 573.

2 Use the following table as a guide to understanding and modifying settings in the **Rebuild Outlines** dialog:

<table>
<thead>
<tr>
<th>Step</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action options</td>
<td>Displays the stored outlines you selected.</td>
</tr>
<tr>
<td>Dependencies</td>
<td>Lets you review the objects potentially impacted by this action.</td>
</tr>
<tr>
<td>Preview</td>
<td>Preview the DDL generated for the operation. For more information, see “<strong>Preview</strong>” on page 576.</td>
</tr>
</tbody>
</table>

3 Click **Execute**. For information on the scheduling option, see “**Scheduling**” on page 843.

**REBUILD TABLE**
This action builds and submits an ALTER TABLE statement with an ENGINE=InnoDB option.

**Platform Availability**
- **MySQL**

**To Rebuild a Table**
1 Initiate a **Rebuild Table** action against one or more tables. For more information, see “**Initiating an object operation**” on page 573.

2 Use the following table as a guide to understanding and modifying settings in the **Rebuild Table** dialog:

<table>
<thead>
<tr>
<th>Step</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action options</td>
<td>Displays the tables you selected.</td>
</tr>
<tr>
<td>Dependencies</td>
<td>Lets you review the objects potentially impacted by this action. For more information, see “<strong>Dependencies</strong>” on page 576.</td>
</tr>
</tbody>
</table>
3  Click **Execute**. For information on the scheduling option, see "**Scheduling**" on page 843.

**RECOMPILE**

Rapid SQL lets you recompile one or more tables. Recompilation causes each procedure and trigger that uses the target table to be recompiled the next time it runs.

The queries used by procedures and triggers are optimized only once, when they are compiled. As you add indexes or make other changes to your database that affect its statistics, your compiled procedures and triggers may lose efficiency. By recompiling the procedures and triggers that act on a table, you can optimize the queries for maximum efficiency.

**Platform Availability**

- SQL SVR, SYB ASE

**To Recompile One or More Tables**

1  Initiate a **Recompile** action against one or more tables. For more information see "**Initiating an object operation**" on page 573.

   Rapid SQL opens the **Recompile Tables** dialog.

2  Click **Execute**. For information on the scheduling option, see "**Scheduling**" on page 843.

**REFRESH TABLE**

The **Refresh Table** dialog lets you reload materialized query tables that have been defined with refresh options.

**Platform Availability**

- DB2 LUW
To Reload a Materialized Query Table

1. Initiate a Refresh Table action against one or more materialized query tables. For more information see "Initiating an object operation" on page 573.

2. Use the following table as a guide to understanding and modifying settings on the Refresh Materialized Query Table dialog:

<table>
<thead>
<tr>
<th>Pane</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action Options</td>
<td>Select an Online Option of ALLOW NO ACCESS, ALLOW READ ACCESS or ALLOW WRITE ACCESS. Enable or disable Query Optimization. Select an INCREMENTAL or NOT INCREMENTAL Refresh Option.</td>
</tr>
<tr>
<td>Preview</td>
<td>Preview the DDL generated by the options you chose. For more information, see &quot;Preview&quot; on page 576.</td>
</tr>
</tbody>
</table>

3. Click Execute. For information on the scheduling option, see "Scheduling" on page 843.

Important Notes

For procedures on restoring a damaged master database, consult the Commands Reference Manual.

RENAMEN

This action lets you rename an object. In general, all referenced or referring objects are updated to reflect the new name.

The following table outlines object type support for the operation for all supported DBMS:

<table>
<thead>
<tr>
<th></th>
<th>DB2 LUW</th>
<th>DB2 z/OS</th>
<th>ITB/FBD</th>
<th>MySQL</th>
<th>Oracle</th>
<th>SQL SVR</th>
<th>Sybase ASE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Blob filters</td>
<td>✔</td>
<td></td>
<td></td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Check constraints</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Databases</td>
<td></td>
<td></td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Defaults</td>
<td>✔</td>
<td></td>
<td></td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Domains</td>
<td>✔</td>
<td></td>
<td></td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Exceptions</td>
<td>✔</td>
<td></td>
<td></td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Extended procedures</td>
<td></td>
<td></td>
<td></td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Foreign keys</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Generators</td>
<td>✔</td>
<td></td>
<td></td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Indexes</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Materialized Views</td>
<td></td>
<td></td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Primary keys</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Procedures</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
</tbody>
</table>
The following table notes the exceptions and provides prerequisite tasks to be performed before renaming an object.

<table>
<thead>
<tr>
<th>DBMS</th>
<th>Notes and restrictions on renaming</th>
</tr>
</thead>
<tbody>
<tr>
<td>Microsoft SQL Server</td>
<td>Microsoft SQL Server lets you rename a database if you own it. Before renaming a database, set it to single-user mode. Microsoft SQL Server will not rename a table if it is referenced within the body of other objects that call it, such as tables, triggers or views. As a result, renaming a table can result in broken dependencies with other objects. Also, Microsoft SQL Server does not let you rename System Tables.</td>
</tr>
<tr>
<td>IBM DB2 for OS/390 and z/OS</td>
<td>Rapid SQL lets you rename a primary key if the underlying table has only one owner. The rename operation does not rename the table if it is referenced within the body of other objects, such as tables, triggers or views, that call it. As a result, renaming a table can result in broken dependencies with other objects.</td>
</tr>
<tr>
<td>Sybase ASE</td>
<td>Before renaming a database, set it to single-user mode. System indexes can not be renamed. The rename operation does not rename the stored procedure if it is referenced within the body of other objects, such as another stored procedure, that call it. As a result, renaming a stored procedure can result in broken dependencies with other objects. The rename operation does not rename the table if it is referenced within the body of other objects, such as tables, triggers or views, that call it. As a result, renaming a table can result in broken dependencies with other objects. The rename operation does not rename the view if it is referenced within the body of other objects, such as stored procedures, triggers or other views, that call it. As a result, renaming a view can result in broken dependencies with other objects. Databases with a <strong>Type</strong> of ARCHIVE or with the <strong>In-memory</strong> property selected cannot be renamed. For more information, see &quot;<a href="#">Databases (Sybase ASE) - Properties</a>&quot; on page 421.</td>
</tr>
</tbody>
</table>
To Rename an Object

1. Initiate a Rename action against a supported object (see the table above). For more information see "Initiating an object operation" on page 573.

2. Use the following table as a guide to understanding and modifying settings in the Rename dialog:

<table>
<thead>
<tr>
<th>Step</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rename</td>
<td>Name Provide the new name for the object.</td>
</tr>
<tr>
<td>Dependencies</td>
<td>Review the referring and referred objects for which naming</td>
</tr>
<tr>
<td>Preview</td>
<td>Preview the DDL generated for the operation. For more</td>
</tr>
</tbody>
</table>

3. Click Execute. For information on the scheduling option, see "Scheduling" on page 843.

REORGANIZE /REORG
Rapid SQL offer Reorganize or Reorg options against the following DBMS platform/object types:

- Reorganizing IBM DB2 for Linux, Unix, and Windows Objects
- Reorganizing Oracle Objects
- Reorganize (SQL Server indexes, primary keys, and unique keys)
- Reorganize (SQL Server Full-text Catalogs)
- Reorganize (Sybase ASE Indexes and Tables)
- Reorg Index (DB2 z/OS)
- Reorg (DB2 z/OS Tablespaces)
Reorganizing IBM DB2 for Linux, Unix, and Windows Objects

Reorganize Dialog Box (One Table)
The table below describes the options and functionality on the Reorganize dialog.

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
</table>
| Action Options            |  • Choose a **Reorg Type** of table or all indexes of the table.  
  • Optionally, choose an **Index Schema** and specify an **Index name**.  
  • Enable or disable **Inplace Reorg** and if you enable, choose an **Inplace reorg mode** of Start, Stop, Pause, or Resume.  
  • Select an **Access mode** to control read and write access.  
  • Select an **Index reorg mode** to clean up empty pages, delete after cleaning up empty pages, or convert to a type 2 index.  
  • If you did not enable **Inplace Reorg**, select a **Tablespace**.  
  • Select a **Long Tablespace**.  
  • Enable or disable the following options: **Index scan**, **Reorg long field and LOB data**, **Reset Dictionary**, **No truncate table**, and **Reorganize all partitions**.  |
| Partitions                | If you did not enable **Reorganize all partitions**, select the partitions to reorganize.                                                                                                                    |
| Preview                   | Preview the DDL code generated from your choices. For more information, see "Preview" on page 576.                                                                                                              |

Reorganize Dialog Box (Multiple Tables)
The table below describes the options and functionality on the Reorganize dialog.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Temporary Tablespace</td>
<td>Associates a temporary tablespace with the table’s tablespace. You can select another tablespace from the list.</td>
</tr>
</tbody>
</table>

Reorganize (SQL Server Indexes, Primary Keys, and Unique Keys)
The Reorganize Indexes dialog lets you reorganize an entire index, primary key, or unique key or a single partition of that object. It also lets you specify a LOB_COMPACTION option.

**NOTE:** You cannot reorganize an index (primary key, or unique key) that has an **Allow Page Locks** property set to FALSE. For information on setting index properties, see "Indexes Editor (SQL Server)" on page 507.
To reorganize an index
1. Initiate a Reorganize action against an index, primary key, or unique key. For more information see "Initiating an object operation" on page 573.

   The Reorganize Index wizard opens.
2. Use the following table as a guide to understanding and modifying settings in the wizard:

<table>
<thead>
<tr>
<th>Step</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action options</td>
<td>To reorganize a single partition, specify a Partition number and optionally, specify Lob Compaction used to create the REORGANIZE WITH clause. To reorganize the entire index, primary key, or unique key, DO NOT provide a Partition Number, and optionally, specify Lob Compaction used to create the REORGANIZE WITH clause.</td>
</tr>
<tr>
<td>Dependencies</td>
<td>Review the referring and referred objects that will be automatically resolved when you execute this operation. For more information, see &quot;Dependencies&quot; on page 576.</td>
</tr>
<tr>
<td>Preview</td>
<td>Preview the DDL generated for the operation. For more information, see &quot;Preview&quot; on page 576.</td>
</tr>
</tbody>
</table>

3. Click Execute. For information on the scheduling option, see "Scheduling" on page 843.

REORGANIZING ORACLE OBJECTS
The Reorganize dialog lets you reduce query processing time against tables.

To Reorganize an Oracle Table
1. Initiate a Reorganize action against a table. For more information see "Initiating an object operation" on page 573.
2. Use the following table as a guide to understanding and modifying settings in the Reorganize dialog:

<table>
<thead>
<tr>
<th>Panel</th>
<th>Group</th>
<th>Setting and description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action Options</td>
<td>Reorganize method</td>
<td>Online - If selected, reorganization is carried out online, using DBMS_REDEFINITION procedures. DBMS_REDEFINITION is Oracle's online table reorganization package and is available for Oracle 9i. During an online reorganization, the table can still be accessed using DML statements like SELECT and UPDATE. If this check box is unselected, reorganization is carried out using a series of simple ALTER TABLE statements. This method is intended for offline usage.</td>
</tr>
<tr>
<td>Tablespace</td>
<td></td>
<td>If you want to move the table(s) to a new tablespace, select the new tablespace from this list.</td>
</tr>
<tr>
<td>Data Block Storage</td>
<td></td>
<td>Type ALTER TABLE property values for the Percent Free (PCTFREE property), Percent Used (PCTUSED property), Initial Transactions (INITTRANS property), and Max Transactions (MAXTRANS property).</td>
</tr>
</tbody>
</table>
3 Click **Execute**. For information on the scheduling option, see “Scheduling” on page 843.

**REORGANIZE (SQL Server Full-text Catalogs)**

This action builds and submits a basic ALTER FULLTEXT CATALOG `catalogname` REORGANIZE statement, with no additional options or arguments. This lets you merge smaller indexes into a larger, master index.

**To reorganize a full-text catalog:**

1. Initiate a **Reorganize** action against one or more full-text catalogs. For more information, see “Initiating an object operation” on page 573.

2. Use the following table as a guide to understanding and modifying settings in the dialog:

<table>
<thead>
<tr>
<th>Step</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Action Options</strong></td>
<td>Displays the catalogs you selected.</td>
</tr>
<tr>
<td><strong>Dependencies</strong></td>
<td>Lets you review the objects potentially impacted by this action. For more information, see &quot;Dependencies&quot; on page 576.</td>
</tr>
<tr>
<td><strong>Preview</strong></td>
<td>Preview the DDL generated for the operation. For more information, see &quot;Preview&quot; on page 576.</td>
</tr>
</tbody>
</table>

3 Click **Execute**. For information on the scheduling option, see “Scheduling” on page 843.

**REORGANIZE (Sybase ASE Indexes and Tables)**

The **Reorganize** dialog lets you reduce query processing time against tables. This functionality is available for both tables and indexes.
For more information, see

- Reorganizing Sybase ASE Tables
- Reorganize Sybase ASE Indexes

**REORGANIZING SYBASE ASE TABLES**

This action lets you build and submit one of four REORG subcommands: FORWARDED_ROWS, RECLAIM_SPACE, COMPACT, or REBUILD. REORG optimizes the use of table space and improves performance.

The **Reorganize Table** dialog lets you reduce the query processing time against a table by reorganizing the table to ensure that space is properly allocated to it. For lengthy reorganization processes, this dialog box also lets you execute a process in increments, lets you resume an incomplete process, and lets you specify the duration of each increment. For more information, see *Incremental Reorganizations*.

**TIP:** Frequent update activity on a table can cause data rows to migrate and to chain over multiple data pages. Chained or forwarded rows can degrade performance because more physical reads are required to access a row of data. Consequently, you should monitor chained rows regularly to spot performance bottlenecks before they become severe. In addition, altering physical storage parameters can lead to fragmentation of space on your data pages, which also results in reduced performance levels.

You should consider reorganizing a table if you are experiencing slow performance due to:

- A large number of chained or forwarded rows on your data pages
- A large amount of fragmentation in your data pages

**NOTE:** You can reorganize tables in Sybase ASE versions 12 and 12.5.

The table below describes the options and functionality on the **Reorganize Table** dialog:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Compact</td>
<td>Lets you reclaim space and undo row forwarding. Minimizes interference with other activities by using multiple small transactions of brief duration. Each transaction is limited to eight pages of reorg processing. These three commands also provide resume and time options that allow you to set a time limit on how long a reorg runs and to resume a reorg from the point at which the previous reorg stopped, making it possible to use a series of partial reorganizations at off-peak times to reorg a large table. For information on result options, see &quot;<strong>Incremental Reorganizations</strong>&quot; on page 669.</td>
</tr>
</tbody>
</table>
### Incremental Reorganizations

If target tables are too long to reorganize in one session, Rapid SQL lets you reorganize them in increments over multiple sessions by specifying a maximum duration for each session. After Rapid SQL reorganizes tables for the specified duration, the operation stops until you resume it again from the Options box of the **Reorganize Table** dialog. The Options box lets you specify to resume a previously initiated but incomplete partial reorganization. It also lets you specify the duration for which you want the resumed reorganization to continue before stopping again. The Option box is disabled for the rebuild command.

**NOTE:** The duration you specify refers to elapsed time, not CPU time.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Reclaim Space</strong></td>
<td>Lets you reclaim unused space resulting from deletions and row-shortening updates on a page. Minimizes interference with other activities by using multiple small transactions of brief duration. Each transaction is limited to eight pages of reorg processing. These three commands also provide resume and time options that allow you to set a time limit on how long a reorg runs and to resume a reorg from the point at which the previous reorg stopped, making it possible to use a series of partial reorganizations at off-peak times to reorg a large table. For information on result options, see &quot;Incremental Reorganizations&quot; on page 669.</td>
</tr>
<tr>
<td><strong>Rebuild</strong></td>
<td>Lets you undo row forwarding and reclaim unused page space. It also rewrites all rows to comply with the target table’s clustered index, writes rows to data pages to comply with space management setting changes (via sp_chgattribute), and drops and re-creates all the target table’s (or tables’) indexes. Reorg rebuild holds an exclusive table lock for its entire duration. On a large table this can be a significant amount of time. However, reorg rebuild accomplishes everything that dropping and re-creating a clustered index does and takes less time. In addition, reorg rebuild rebuilds the table using all of the table’s current space management settings. Dropping and re-creating an index does not use the space management setting for reservepagegap. In most cases, reorg rebuild requires additional disk space equal to the size of the table it is rebuilding and its indexes.</td>
</tr>
<tr>
<td><strong>Undo Row Forwarding</strong></td>
<td>Lets you undo row forwarding, a process that occurs when an update increases a row’s length in a data-only-locked table such that the row is too large to fit on its original page.</td>
</tr>
<tr>
<td><strong>Options</strong></td>
<td>Start at the point where a previous reorg left off - Select to resume a previously initiated but incomplete partial reorganization. Then specify the duration for which you want the resumed reorganization to continue before stopping again. This box is disabled for the rebuild command.</td>
</tr>
</tbody>
</table>
In the option box, if you select the check box without specifying a duration, Rapid SQL executes the reorg at the point where the previous reorg stopped and continues to the end of the target tables. If you clear the check box and specify a duration, the reorg starts at the beginning of the target tables and continues for the specified number of minutes. If you select the check box and specify a duration, Rapid SQL runs the reorg from the point where it last left off, and continues for the specified number of minutes.

**NOTE:** If you reorganize a table using one command (Compact, Reclaim Space, or Undo Forwarding) for a specified duration, you cannot resume the process from its resume point using a different command. For example, you cannot compact a table for an hour, and then reclaim space on the remainder of the table. A resumed reorganization process must utilize the same command from start to finish. Selecting a different command begins a new reorganization process.

**CAUTION:** While this option lets you reorganize a large table in multiple manageable pieces, any updates to the table between reorganization runs can cause pages to be skipped or processed more than once.

Reorganize Sybase ASE Indexes

The **Reorganize Index** dialog lets you reduce the query processing time against a table by running a reorg rebuild command on the target index.

This operation:

- Undoes row forwarding and reclaim unused page space
- Rewrites all rows in the table to comply with the table’s clustered index
- Writes rows to data pages to comply with space management setting changes (via `sp_chgattribute`)
- Drops and re-creates the table’s indexes

Reorg rebuild holds an exclusive table lock for its entire duration. On a large table this can be a significant amount of time. However, reorg rebuild accomplishes everything that dropping and re-creating a clustered index does and takes less time. In addition, reorg rebuild rebuilds the table using all of the table’s current space management settings. Dropping and re-creating an index does not use the space management setting for `reservepagegap`. In most cases, reorg rebuild requires additional disk space equal to the size of the table it is rebuilding and its indexes.

Reorg Index (DB2 z/OS)

This action lets you build and submit a REORG INDEX utility call.

**NOTE:** Before using this action consult IBM documentation for details on REORG INDEX utility options. For online access to DB2 documentation, see “Accessing Third Party Documentation” on page 21.
To Reorganize an Index

1. Initiate a **Set Default** action against a tablespace. For more information see "Initiating an object operation" on page 573.

2. Use the following table as a guide to understanding and modifying settings in this wizard. Note that some settings are only available based on other selections.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select Indexes</td>
<td>On opening, the list displays the index you chose to reorganize. Optionally, you can add more indexes to the list that are to be reorganized by clicking <strong>Add</strong>. Adding indexes using the Index Selector dialog is a two-step process. Use the Database Like, Index Creator, Index Like, and Match Case controls to provide a search criteria pattern and then click <strong>Query</strong> to display qualified indexes in the Index Selector list. Then select one or more indexes from the list, click <strong>Add</strong>, and close the dialog. To remove a selected index from the list to be reorganized, select the index in the list and click <strong>Delete</strong>.</td>
</tr>
<tr>
<td>Do you want the utility to be reusable</td>
<td>Select this check box to make the utility restartable.</td>
</tr>
<tr>
<td>Share Level</td>
<td>Lets you select share level that allows users to view but not modify the table data: REFERENCE, CHANGE, or None.</td>
</tr>
</tbody>
</table>
| Deadline              | Lets you specify a deadline for the switch phase of reorganization to start. If Rapid SQL estimates that the switch phase will not start by the deadline, Rapid SQL terminates reorganization.  
  **None** - Specifies that there is no deadline for the read-only iteration of log processing.  
  **Timestamp** - Specifies the deadline for the switch phase to start processing.  
  *labeled-duration-expression* - Click the ... button to open a dialog that lets you build a custom CURRENT_TIMESTAMP or CURRENT_DATE value. |
| Drain Specification   | Lets you specify that DB2 drains the write claim class after the delay. The number of log records, and thus the estimated time, for a future iteration of log processing will be 0. |
| Fast Switch           | Keeps the data set name unchanged and updates the catalog to reference the newly reorganized data set. |
| Maxro (only available with a Share Level of CHANGE) | Lets you DEFER or specify the maximum amount of time for the last iteration (read-only access iteration) of log processing. |
| Drain (only available with a Share Level of CHANGE) | Lets you specify drain behavior (WRITERS or ALL) at the end of the log phase after the MAXRO threshold is passed and when the last log iteration is to be applied: |
| Long Log (only available with a Share Level of CHANGE) | Lets you provide a LONGLOG value of CONTINUE, DRAIN, or TERM |
| Delay (only available with a Share Level of CHANGE) | Lets you specify the minimum interval between the time REORG sends the LONGLOG message to the console and the time REORG performs the action specified by the Long Log setting. |
| Timeout (only available with a Share Level of CHANGE) | Lets you specify a timeout option of ABEND or TERM. |
When ready, click **Finish**.

**REORG (DB2 z/OS TABLESPACES)**

The Reorganize Tablespace Wizard reorganizes a tablespace to improve access performance and reclaim fragmented space. The wizard can also reorganize a single partition or range of partitions of a partitioned table space. You can specify the degree of access to the data during reorganization, and optionally collect inline statistics.

**Completing the Reorganize Tablespace Wizard**

To complete the Reorganize Tablespace Wizard, do the following:

1. Initiate a **Reorg** action against a tablespace. For more information see "[Initiating an object operation](#)" on page 573.

   Rapid SQL opens the **Reorganize Tablespace** Wizard.

2. Complete the wizard panels, and then click **Finish**.

   Rapid SQL opens the **Preview** dialog.
**REORGANIZE TABLESPACE WIZARD - PANEL 1**
The table below describes the options and functionality on this panel of the Reorganize Tablespace Wizard:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Do you want the utility to be restartable?</td>
<td>Select to make the utility restartable.</td>
</tr>
<tr>
<td>Database</td>
<td>Displays the list of databases in the system. You can select the tablespace database or click the filter button to limit the list of databases to a string pattern.</td>
</tr>
<tr>
<td>Tablespace</td>
<td>Displays the list of tablespaces.</td>
</tr>
<tr>
<td>Partition</td>
<td>Lets you specify a partition or a range of partitions.</td>
</tr>
<tr>
<td>Reuse</td>
<td>Select to reuse this tablespace.</td>
</tr>
</tbody>
</table>

**REORGANIZE TABLESPACE WIZARD - PANEL 2**
The table below describes the options and functionality on this panel of the Reorganize Tablespace Wizard:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Log</td>
<td></td>
<td>List of the sequence of events after you execute the wizard.</td>
</tr>
<tr>
<td>Sort Data</td>
<td></td>
<td>Sorts columns alphanumerically in single result sets.</td>
</tr>
<tr>
<td>No Sysrec</td>
<td></td>
<td>Select Yes for no sysrec.</td>
</tr>
<tr>
<td>Sortkeys</td>
<td></td>
<td>Select Yes for sortkeys. Specifies that index keys are to be sorted and built in parallel during the SORTBLD phase to improve performance.</td>
</tr>
</tbody>
</table>

**REORGANIZE TABLESPACE WIZARD - PANEL 3**
The table below describes the options and functionality on this panel of the Reorganize Tablespace Wizard:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Share level</td>
<td>Lets you select share level that allows users to view but not modify the table data: None, Reference, or Change.</td>
</tr>
<tr>
<td>Deadline</td>
<td>Lets you specify a deadline for the switch phase of reorganization to start. If Rapid SQL estimates that the switch phase will not start by the deadline, Rapid SQL terminates reorganization. None - Specifies that there is no deadline for the read-only iteration of log processing. Timestamp - Specifies the deadline for the switch phase to start processing. Click the button to open the Deadline Expression Builder dialog.</td>
</tr>
<tr>
<td>Drain Specification</td>
<td>Allows you to specify that DB2 drains the write claim class after the delay. The number of log records, and thus the estimated time, for a future iteration of log processing will be 0.</td>
</tr>
<tr>
<td>Fast Switch</td>
<td>Keeps the data set name unchanged and updates the catalog to reference the newly reorganized data set.</td>
</tr>
</tbody>
</table>
Deadline Expression Builder
The table below describes the options and functionality on the Deadline Expression Builder dialog:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Current Date</td>
<td>Lets you select today as the basis of the deadline, click + or -, type the number of years, months, days, hours, minutes, seconds and microseconds.</td>
</tr>
<tr>
<td>Current Timestamp</td>
<td>Lets you select the current timestamp as the basis of the deadline, click + or -, type the number of years, months, days, hours, minutes, seconds and microseconds.</td>
</tr>
</tbody>
</table>

**REORGANIZE TABLESPACE WIZARD - PANEL 4**
The table below describes the options and functionality on this panel of the Reorganize Tablespace Wizard:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Local Site Primary</td>
<td>Lets you specify the Local Site Primary.</td>
</tr>
<tr>
<td>Local Site Backup</td>
<td>Lets you specify the Local Site Backup.</td>
</tr>
<tr>
<td>Recovery Site Primary</td>
<td>Lets you specify the Recovery Site Primary.</td>
</tr>
<tr>
<td>Recovery Site Backup</td>
<td>Lets you specify the Recovery Site Backup.</td>
</tr>
</tbody>
</table>

**REORGANIZE TABLESPACE WIZARD - PANEL 5**
The table below describes the options and functionality on this panel of the Reorganize Tablespace Wizard:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off Pos Limit</td>
<td>The specified value is compared to the result of the calculation (NEAROFFPOSF + FAROFFPOSF) × 100 / CARDF for the specified partitions in SYSIBM.SYSINDEXPART for the explicit clustering indexes for every table in the specified table space. Alternatively, the values in SYSINDEXPART are checked for a single non-partitioned table space, or for each partition if you specified an entire partitioned table space as the target object. If at least one calculated value exceeds the OFFPOSLIMIT value, REORG is performed or recommended. NOTE: This option is valid for non-LOB table spaces only.</td>
</tr>
<tr>
<td>Ind Ref Limit</td>
<td>The specified value is compared to the result of the calculation (NEARINDREF + FARINDREF) × 100 / CARDF for the specified partitions in SYSIBM.SYSTABLEPART for the specified table space. Alternatively, the values in SYSTABLEPART are checked for a single non-partitioned table space, or for each partition if you specified an entire partitioned table space as the target object. If at least one calculated value exceeds the INDREFLIMIT value, REORG is performed or recommended. NOTE: This option is valid for non-LOB table spaces only.</td>
</tr>
<tr>
<td>Report Only</td>
<td>The reorganization is only recommended, not performed.</td>
</tr>
</tbody>
</table>
The table below describes the options and functionality on this panel of the Reorganize Tablespace Wizard:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unload</td>
<td>Specifies whether the utility job is to continue processing or end after the data is unloaded. Continue - Specifies that, after the data has been unloaded, the utility continues processing. Pause - Specifies that after the data has been unloaded, processing ends. Only - Specifies that after the data has been unloaded, the utility job ends and the status in SYSIBM.SYSUTIL corresponding to this utility ID is removed. External - Specifies that after the data has been unloaded, the utility job is to end and the status in SYSIBM.SYSUTIL corresponding to this utility ID is removed.</td>
</tr>
</tbody>
</table>

### REORGANIZE TABLESPACE WIZARD - PANEL 5

**NOTE:** This panel is displays only if the share level is Change.

### Option Description

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table Owner</td>
<td>Displays the schema names in the system.</td>
</tr>
<tr>
<td>Table</td>
<td>Displays all tables for the selected schema.</td>
</tr>
<tr>
<td>Maxrow</td>
<td>Lets you specify the maximum amount of time for the last iteration of log processing. During that iteration, applications have read-only access. Type an integer value or select DEFER. DEFER Specifies that the iterations of log processing with read/write access can continue indefinitely.</td>
</tr>
<tr>
<td>Drain</td>
<td>Lets you select Writers or All. Specifies that Rapid SQL drains the write claim class after the delay. The number of log records, and thus the estimated time, for a future iteration of log processing will be 0.</td>
</tr>
<tr>
<td>Long Log</td>
<td>Lets you specify the action that Rapid SQL performs (after sending the LONGLOG message to the console) if the number of log records that are processed during the next iteration is not sufficiently lower than the number of log records that were processed during the previous iterations. Continue - Specifies that Rapid SQL continues performing reorganization. Term - Specifies that Rapid SQL terminates reorganization after the delay. Drain - Specifies that Rapid SQL drains the write claim class after the delay. The number of log records, and thus the estimated time, for a future iteration of log processing will be 0.</td>
</tr>
<tr>
<td>Delay</td>
<td>Lets you type a lower bound for the interval between the time when REORG sends the LONGLOG message to the console and the time when REORG performs the action specified by the LONGLOG parameter.</td>
</tr>
<tr>
<td>Timeout</td>
<td>Lets you select timeout option: Abend - Abnormal end of task Term - Termination</td>
</tr>
</tbody>
</table>

### REORGANIZE TABLESPACE WIZARD - PANEL 6

**NOTE:** This panel is displays only if the share level is Reference or Change.
The table below describes the options and functionality on this panel of the Reorganize Tablespace Wizard:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Local Site Primary Copy</td>
<td>Lets you specify the Local Site Primary Copy.</td>
</tr>
<tr>
<td>Local Site Backup Copy</td>
<td>Lets you specify the Local Site Backup Copy.</td>
</tr>
<tr>
<td>Recovery Site Primary Copy</td>
<td>Lets you specify the Recovery Site Primary Copy.</td>
</tr>
<tr>
<td>Recovery Site Backup Copy</td>
<td>Lets you specify the Recovery Site Backup Copy.</td>
</tr>
</tbody>
</table>

**REORGANIZE TABLESPACE WIZARD - PANEL 7**

The table below describes the options and functionality on this panel of the Reorganize Tablespace Wizard:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off Pos Limit</td>
<td>The specified value is compared to the result of the calculation ((\text{NEAROFFPOSF} + \text{FAROFFPOSF}) \times 100 / \text{CARDF}) for the specified partitions in SYSIBM.SYSINDEXPART for the explicit clustering indexes for every table in the specified table space. Alternatively, the values in SYSINDEXPART are checked for a single non-partitioned table space, or for each partition if you specified an entire partitioned table space as the target object. If at least one calculated value exceeds the OFFPOSLIMIT value, REORG is performed or recommended. NOTE: This option is valid for non-LOB table spaces only.</td>
</tr>
<tr>
<td>Ind Ref Limit</td>
<td>The specified value is compared to the result of the calculation ((\text{NEARINDREF} + \text{FARINDREF}) \times 100 / \text{CARDF}) for the specified partitions in SYSIBM.SYSTABLEPART for the specified table space. Alternatively, the values in SYSTABLEPART are checked for a single non-partitioned table space, or for each partition if you specified an entire partitioned table space as the target object. If at least one calculated value exceeds the INDREFLIMIT value, REORG is performed or recommended. NOTE: This option is valid for non-LOB table spaces only.</td>
</tr>
<tr>
<td>Report Only</td>
<td>The reorganization is only recommended, not performed.</td>
</tr>
<tr>
<td>Unload</td>
<td>Specifies whether the utility job is to continue processing or end after the data is unloaded. Continue - Specifies that, after the data has been unloaded, the utility continues processing. Pause - Specifies that after the data has been unloaded, processing ends. Only - Specifies that after the data has been unloaded, the utility job ends and the status in SYSIBM.SYSUTIL corresponding to this utility ID is removed. External - Specifies that after the data has been unloaded, the utility job is to end and the status in SYSIBM.SYSUTIL corresponding to this utility ID is removed.</td>
</tr>
</tbody>
</table>
REORGANIZE TABLESPACE WIZARD - PANEL 6
The table below describes the options and functionality on this panel of the Reorganize Tablespace Wizard:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Do you want to keep the dictionary?</td>
<td>A collection of language-related linguistic information used during text analysis, indexing, retrieval, and highlighting of documents in a particular language. NOTE: Available only if Continue or Pause option was specified for Unload on the previous panel.</td>
</tr>
<tr>
<td>Do you want to specify statistics?</td>
<td>Lets you include statistics for the tablespace in the SQL statement. Enabled only if Continue or Pause option was specified for Unload on the previous panel.</td>
</tr>
<tr>
<td>Do you want to output message to SYSPRINT?</td>
<td>Lets you specify to output message to SYSPRINT.</td>
</tr>
<tr>
<td>Do you want to force aggregation or rollup processing to be done even though some parts do not contain data?</td>
<td>Lets you specify to process with forced aggregation, gathered into a mass, or rollup.</td>
</tr>
</tbody>
</table>

REORGANIZE TABLESPACE WIZARD - STATISTICS TABLES
The table below describes the options and functionality on this panel of the Reorganize Tablespace Wizard:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select Tables</td>
<td>Lets you select tables (and columns) to collect statistics for. The sample column is editable and you can type an integer value into this column.</td>
</tr>
<tr>
<td>Add</td>
<td>Opens the Table Selector Dialog Box.</td>
</tr>
<tr>
<td>Set Properties</td>
<td>Lets you customize the selection of columns in the selected tables.</td>
</tr>
</tbody>
</table>

REORGANIZE TABLESPACE WIZARD - STATISTICS INDEXES
The table below describes the options and functionality on this panel of the Reorganize Tablespace Wizard:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select Index</td>
<td>Lets you specify the indexes and the correlation values for collecting the statistics. The sample column is editable and you can type an integer value into this column.</td>
</tr>
<tr>
<td>Add</td>
<td>Opens the Index Selector Dialog Box.</td>
</tr>
<tr>
<td>Set Properties</td>
<td>Lets you specify the correlation information for each index.</td>
</tr>
</tbody>
</table>
## REORGANIZE TABLESPACE WIZARD - PANEL 7
The table below describes the options and functionality on this panel of the Reorganize Tablespace Wizard:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Punch DDN</td>
<td>Lets you select punch DDN from the list. Contains generated LOAD statements that let you reload the discarded data. Required if Unload External option is chosen on Panel 5.</td>
</tr>
<tr>
<td>Discard DDN</td>
<td>Lets you select discard DDN from the list.</td>
</tr>
<tr>
<td>Unload DDN</td>
<td>Lets you select DD name of the unload data set. Required unless NOSYSREC on Panel 2 or Share level CHANGE Panel 3 is selected.</td>
</tr>
<tr>
<td>Work DDN</td>
<td>Lets you select the DD statement for a temporary data set used for intermediate output.</td>
</tr>
</tbody>
</table>

## REORGANIZE TABLESPACE WIZARD - PANEL 7
The table below describes the options and functionality on this panel of the Reorganize Tablespace Wizard:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Discard</td>
<td>Lets you select discard DDN from the list.</td>
</tr>
<tr>
<td>No Pad</td>
<td>Rapid SQL does not add a character to fill empty space.</td>
</tr>
<tr>
<td>Add</td>
<td>Opens the Table Selector Dialog Box.</td>
</tr>
<tr>
<td>Set Condition</td>
<td>Lets you customize the selection of columns in the selected tables.</td>
</tr>
</tbody>
</table>

## REORGANIZE TABLESPACE WIZARD - PANEL 8
The table below describes the options and functionality on this panel of the Reorganize Tablespace Wizard:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Would you like to specify the device type?</td>
<td>Lets you specify the device type.</td>
</tr>
<tr>
<td>Do you want to specify the sort number?</td>
<td>Lets you type the number of datasets to be dynamically allocated by the sort program. The range of the text field is 0 to 2147483647.</td>
</tr>
<tr>
<td>Preformat</td>
<td>Lets you specify that the remaining pages are preformatted up to the high allocated RBA in the table space and index spaces associated with the table specified in table-name. The preformatting occurs after the data has been loaded and the indexes are built.</td>
</tr>
</tbody>
</table>
REORGANIZE TABLESPACE WIZARD - PANEL 9

The table below describes the options and functionality on this panel of the Reorganize Tablespace Wizard:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Punch DDN</td>
<td>Lets you select punch DDN from the list. Contains generated LOAD statements that let you reload the discarded data. Required if Unload External option is chosen on Panel 5.</td>
</tr>
<tr>
<td>Discard DDN</td>
<td>Lets you select discard DDN from the list.</td>
</tr>
<tr>
<td>Unload DDN</td>
<td>Lets you select DD name of the unload data set. Required unless NOSYSREC on Panel 2 or Share level CHANGE Panel 3 is selected.</td>
</tr>
<tr>
<td>Work DDN</td>
<td>Lets you select the DD statement for a temporary data set used for intermediate output.</td>
</tr>
</tbody>
</table>

Condition Dialog Box

The **Condition** dialog lets you type free form condition text.

**NOTE:** Rapid SQL does not test the correctness of the condition text.

REPAIR TABLES

This action builds and submits a REPAIR TABLE statement, letting you repair a corrupted table. This operation returns a standard REPAIR TABLE result set. Each returned message consists of **Table** (name), **Op** (with a value of REPAIR), **Msg_type** (STATUS, ERROR, INFO, WARNING), and **Msg_text** components.

Platform Availability

- MySQL

To Repair a Possibly Corrupted Table

1. On the Datasource Navigator, expand nodes until the **Tables** node is visible.
2. Expand the **Tables** node.
3. Right-click one or more selected tables and select **Repair Tables** from the context menu.
   Rapid SQL opens the **Repair Tables** dialog.
4. Use the following table as a guide to understanding and modifying settings in this wizard:

<table>
<thead>
<tr>
<th>Step</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action Options</td>
<td>Quick</td>
</tr>
<tr>
<td></td>
<td>Extended</td>
</tr>
<tr>
<td></td>
<td>Use FRM file</td>
</tr>
</tbody>
</table>
5 Click **Execute**. For information on the scheduling option, see "**Scheduling**" on page 843.

The results set opens on the **Results** tab of an ISQL editor window. For more information, see "**Using the Results Editor**" on page 832.

### REPORT

Rapid SQL lets you generate a detailed report of one or more objects of a given type for a single database. For each object, the report contains information similar to that available in the object editor for that object type. The report opens in Rapid SQL's built-in HTML browser and is also written to an .htm file.

#### Platform Availability

- **DB2 LUW, DB2 z/OS, ITB/FBD, MySQL, ORCL, SQL SVR, SYB ASE**

#### To Generate a Detail Report on One or More Objects

1. On the Datasource Navigator, expand the target object node.
   
   Rapid SQL displays the target objects.

2. Right-click one or more selected objects, and then select **Report** from the context menu.
   
   Rapid SQL opens the **Report** dialog.

3. In **Report Home Page File Name**, type the report name or click **Browse** to locate the report.

4. Use the **Append date and time stamp to report file name** and **Save report in date specific folders** controls to ensure that the disk files are not overwritten each time you generate reports against the specified file name.

5. In **Report Title**, type the title that is to appear in the report.

6. If you selected multiple objects, use the **Report Options** controls to specify a **Single HTML File for All Objects** or **Separate HTML Files for Each Object**.

7. Click **Execute**.
   
   Rapid SQL opens the report in the built-in browser and writes a copy to disk.
**RESTART**
The **Restart Sequence** dialog lets you restart a sequence, starting at the value specified in the sequence definition or starting at a specified value.

**Platform Availability**
- **DB2 LUW**

**To Rebuild a Stored Outline**
1. Initiate a **Restart** action against a sequence object. For more information see "Initiating an object operation" on page 573.
   
   Rapid SQL opens the **Restart Sequence** dialog.

2. Select one of the following **Restart Sequence at** options:
   - **Originating Value** use the value specified in the object definition
   - **This value** lets you specify a custom start value

3. Click **Execute**. For information on the scheduling option, see "Scheduling" on page 843.

**RESYNCHRONIZE**
This action executes an ALTER DATABASE... FOR PROXY_UPDATE statement, forcing resynchronization of proxy tables within the proxy database.

**NOTE:**
This functionality is available for Sybase ASE 12.5.

**To manually resynchronize proxy tables**
1. Initiate a **Resynchronize** action against one or more databases. For more information, see Initiating an object operation.

2. Use the following table as a guide to understanding and modifying settings in the dialog:

<table>
<thead>
<tr>
<th>Step</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action options</td>
<td>Lists the database or databases you selected to resynchronize.</td>
</tr>
<tr>
<td>Preview</td>
<td>Lets you preview the DDL generated for the operation.</td>
</tr>
</tbody>
</table>

3. Click **Execute**. For information on the other options, see **Preview** and **Scheduling**.

**ROLE ACTIVATION**
Rapid SQL lets you activate or deactivate roles for the current session. The **Role Activation** action builds and submits one or more SET ROLE commands.
Platform Availability
• ORCL, SYB ASE

To Enable or Disable One or More Roles in the Current Rapid SQL Session
1 Right-click on a connected Sybase ASE or Oracle datasource node and select Role Activation from the context menu. The Role Activation dialog opens.
2 Use the following table as a guide to understanding and modifying settings in the wizard:

<table>
<thead>
<tr>
<th>Panel</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Role Activation</td>
<td>The list contains entries for each role that has been granted to the current login. For information on granting/assigning roles to a login or user, see Users Editor (Oracle) and Logins Editor (Sybase ASE). To activate a role, select the Active check box associated with the role. If the role is configured to require a password, provide it in the Password box. To deactivate a role, deselect the Active check box associated with the role.</td>
</tr>
<tr>
<td>Preview</td>
<td>Preview the DDL generated for the operation and when ready, click Execute.</td>
</tr>
</tbody>
</table>

3 Click Execute.

RUN JOB (ORACLE JOBS)
This action builds and submits a DBMS_SCHEDULER.RUN_JOB call, letting you run a job immediately.

Platform Availability
• ORCL 10g

To run a job immediately
1 On a connected Oracle datasource, expand the Scheduler nodes and select the Jobs node.
2 Right-click a job and select Run Job from the context menu.
3 Use the following table as a guide to understanding and modifying settings in the dialog:

<table>
<thead>
<tr>
<th>Step</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action options</td>
<td>Select the Use current session check box to provide a USE_CURRENT_SESSION attribute value of TRUE. Deselect the Use current session check box to provide a use_current_session attribute value of FALSE.</td>
</tr>
<tr>
<td>Dependencies</td>
<td>Lists referring and referenced objects potentially impacted by the change. For details, see &quot;Dependencies&quot; on page 576.</td>
</tr>
<tr>
<td>Preview</td>
<td>Displays the DDL that will execute the object action. For details, see &quot;Preview&quot; on page 576.</td>
</tr>
</tbody>
</table>

4 Click Execute. For information on the scheduling option, see "Scheduling" on page 965.
RUN JOB (JOB QUEUES)
Rapid SQL lets you immediately run any defined job queue, regardless of its current schedule. Job Queues are built-in mechanisms that let you schedule a variety of SQL-based or command-line driven tasks.

Platform Availability
- ORCL

To Run a Job
1. Initiate a Run Job action against a job queue. For more information see "Initiating an object operation" on page 573.
   Rapid SQL opens the Run dialog.
2. Click Execute. For information on the scheduling option, see "Scheduling" on page 843.

Related Information
- "Enable Job (Job Queue)" on page 627
- "Disable Job" on page 619

SCHEMA
The Schema dialog lets you view key properties of the columns in a table or view.

Platform Availability
- DB2 LUW, DB2 z/OS, ITB/FBD, MySQL, ORCL, SQL SVR, SYB ASE

To View a Column Summary for a Table or View
1. Initiate a Schema action against a table or view. For more information see "Initiating an object operation" on page 573.
   Rapid SQL opens Schema results in a Results Editor. For information on functionality offered, see "Using the Results Editor" on page 832.

SELECT * FROM
This action lets you retrieve all data contained in tables or views. Results are displayed in a row and column grid.

Platform Availability
- DB2 LUW, DB2 z/OS, ITB/FBD, MySQL, ORCL, SQL SVR, SYB ASE
To Select All Data in One or More Tables or Views

1. Initiate a **Select * From** action against one or more tables or views. For more information see "**Initiating an object operation**" on page 573.

For each selected table or view, Rapid SQL opens a two-tabbed window:

- The **Results** tab displays the data selected from the table, in a grid similar to a spreadsheet. Right-click and toolbar options offer many of the functions provided in the Results editor. For more information, see "**Using the Results Editor**" on page 832.

- The **Query** tab displays the full query generated for the operation. Right-click and toolbar options offer many of the functions provided in the ISQL editor. For more information, see "**Using the SQL Editor**" on page 791.

**SET DEFAULT**

This function lets you set a tablespace as the default tablespace. Users created without a specified default tablespace will be assigned this default tablespace. If no default tablespace is set, users created without a specified tablespace will have their default tablespace set to SYSTEM.

**Platform Availability**

- **ORCL 10g**

**To Set a Tablespace as the Default**

1. Initiate a **Set Default** action against a tablespace. For more information see "**Initiating an object operation**" on page 573.

2. Use the following table as a guide to understanding and modifying settings in the **Set Default** wizard:

<table>
<thead>
<tr>
<th>Step</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Action options</strong></td>
<td>Verify that the panel displays the tablespace to be set as default.</td>
</tr>
<tr>
<td><strong>Dependencies</strong></td>
<td>Review the referring and referred objects that will be automatically resolved when you execute this operation. For more information, see &quot;<strong>Dependencies</strong>&quot; on page 576.</td>
</tr>
<tr>
<td><strong>Preview</strong></td>
<td>Preview the DDL generated for the operation. For more information, see &quot;<strong>Preview</strong>&quot; on page 576.</td>
</tr>
</tbody>
</table>
SET INTEGRITY

Rapid SQL provides an implementation of the DB2 SET INTEGRITY statement, letting you perform tasks such as taking tables into and out of set integrity pending state, placing tables into full access state, and pruning the contents of one or more staging tables.

**NOTE:** This operation should not be performed without an in-depth understanding of the SET INTEGRITY statement. For online access to DB2 documentation, see "Accessing Third Party Documentation" on page 21.

Platform Availability

- **DB2 LUW**

To Open the Set Integrity Wizard

1. On the Navigator, expand a DB2 database, and click or expand the Table node.
2. Select the appropriate table(s), right-click, and choose Set Integrity from the menu. You can select more than one table by clicking CTRL + the tables you want.
   OR
   Select the appropriate table, click Command on the toolbar, and then choose Set Integrity from the drop-down menu.

The table below lists all fields you can see in the Set Integrity Wizard. Depending on the options you choose, you may not see them all.

<table>
<thead>
<tr>
<th>Required Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tables</td>
<td>The list of one or more tables you selected appear.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Integrity Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>OFF</td>
<td>When selected, tables have their foreign key and check constraints, and column generation disabled and so are put in a pending state. This also means materialized query or staging tables are not immediately refreshed and are put in a pending state.</td>
</tr>
<tr>
<td>TO DATALINK RECONCILE PENDING</td>
<td>When selected, DATALINK integrity is disabled and tables are put in a check pending no access state. Dependent and descendant tables are not affected.</td>
</tr>
<tr>
<td>IMMEDIATE CHECKED</td>
<td>This turns on a table’s integrity checking turned on. Any checking that was deferred is carried out.</td>
</tr>
<tr>
<td>FULL ACCESS</td>
<td>Tables become fully accessible as soon as the SET INTEGRITY statement executes.</td>
</tr>
<tr>
<td>PRUNE</td>
<td>This is appropriate only for staging tables. The content of the staging table is pruned and set to an inconsistent state. If any table in the table-name list is not a staging table, an error is returned.</td>
</tr>
<tr>
<td>UNCHECKED</td>
<td>Allows you turn on some or all integrity checking but the table will not be checked for integrity violations. This can affect data integrity.</td>
</tr>
<tr>
<td>Required Field</td>
<td>Description</td>
</tr>
<tr>
<td>----------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Specifies the readability of the table while it is in check pending state:</td>
<td>NO ACCESS—The table(s) are put in a check pending no access state so read/write access to the table is prohibited. READ ACCESS—The table(s) are put in a check pending read state. This allows read access to the non-appended portions of any tables.</td>
</tr>
<tr>
<td>Specifies whether to be immediately cascaded to all descendents</td>
<td>CASCADE IMMEDIATE—The check pending state for foreign key constraints is immediately extended to descendant foreign key constraints or to materialized query or staging tables. CASCADE DEFERRED—Only the selected tables are put in the check pending state. Descendant foreign key, materialized query, or staging tables remain unchanged.</td>
</tr>
<tr>
<td>Descendent Types</td>
<td>Materialized Query Tables—When selected, the check pending state is immediately cascaded to only descendant materialized query tables. Foreign Key Tables—When selected, the check pending state is cascaded immediately only to descendant foreign key tables. Staging Tables—When selected, the check pending state is cascaded immediately only to descendant staging tables.</td>
</tr>
<tr>
<td>Do you want to check on the appended portion (if any) of the table?</td>
<td>Default/Yes/No</td>
</tr>
<tr>
<td>List of Base Tables</td>
<td>Any row that is in violation of a foreign key or check constraint is copied to the exception table you select.</td>
</tr>
<tr>
<td>Integrity Options: IMMEDIATE UNCHECKED</td>
<td>Foreign Key—These constraints are turned on when the table is removed from check pending status. Check—Check constraints are turned on when the table is removed from check pending status. Datalink Reconcile Pending—DATALINK integrity constraints are turned on when the table is removed from check pending status. Materialized Query—Immediate refreshing is turned on for a materialized query table when it is removed from a check pending state. Generated Column—When the table is removed from check pending status, generated columns are turned on. Staging—Immediate propagation is turned on for a staging table.</td>
</tr>
<tr>
<td>Do you want tables to become fully accessible after the SET INTEGRITY statement executes?</td>
<td>Yes/No</td>
</tr>
</tbody>
</table>
3 When ready, click the **Finish** button to preview and submit the generated DDL. For more information, see "**Preview**" on page 576.

**SET ONLINE/OFFLINE**

The **Set Database(s) Online/Offline** dialog lets you disable your databases to prevent access, and enable your databases to grant access through the **Datasource** menu.

**Platform Availability**

- **SQL SVR, SYBASE**

**Important Notes**

For Sybase ASE, Rapid SQL only lets you set databases online.

**To Set One or More Databases Online or Offline**

1. Initiate a **Set Online/Offline** action against one or more databases. For more information see "**Initiating an object operation**" on page 573.

2. Use the following table as a guide to working through the panels of the **Set Online/Offline** dialog:

<table>
<thead>
<tr>
<th>Step</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action options</td>
<td>Set offline (SQL Server only)</td>
</tr>
<tr>
<td>Dependencies</td>
<td></td>
</tr>
<tr>
<td>Preview</td>
<td></td>
</tr>
</tbody>
</table>

3. Click **Execute**. For information on the scheduling option, see "**Scheduling**" on page 843.

**SET STATISTICS**

This action creates and submits a SET STATISTICS statement, letting you recompute the selectivity of an index.

**Platform Availability**

- **ITB/FBD**
To Recompute the Selectivity of an Index:
1. On the Database Navigator, expand nodes until the **Indexes** node is visible, and then expand the **Indexes** node.
2. Select one or more indexes.
3. Right click the selected indexes and select **Set Statistics** from the context menu.
   Fast SQL opens the **Set Statistics** dialog.
4. Use the following table as a guide to understanding and modifying settings in this wizard:

<table>
<thead>
<tr>
<th>Step</th>
<th>Action Options</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action Options</td>
<td>Displays the indexes you selected.</td>
<td></td>
</tr>
<tr>
<td>Dependencies</td>
<td>Lists referring and referenced objects potentially impacted by the change. For details, see &quot;<strong>Dependencies</strong>&quot; on page 576.</td>
<td></td>
</tr>
<tr>
<td>Preview</td>
<td>Displays the DDL that will execute the object action.</td>
<td></td>
</tr>
</tbody>
</table>

5. Click **Execute**. For information on the scheduling option, see "**Scheduling**" on page 843.

**SET UNDO**

**Set UNDO Tablespace** dialog lets you dynamically set an UNDO tablespace if the tablespace is running in AUTO UNDO mode.

**Platform Availability**
- **ORCL 9i**

To Dynamically Set an UNDO Tablespace
1. Initiate a **Set Undo** action against a tablespace. For more information see "**Initiating an object operation**" on page 573.
2. Use the following table as a guide to understanding and modifying the settings on the **Set Undo Tablespace** wizard:

<table>
<thead>
<tr>
<th>Step</th>
<th>Functionality</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action Options</td>
<td>Displays the tablespace you selected to be set as an Undo tablespace.</td>
</tr>
<tr>
<td>Dependencies</td>
<td>Lists referring and referenced objects potentially impacted by the change. For details, see &quot;<strong>Dependencies</strong>&quot; on page 576.</td>
</tr>
<tr>
<td>Preview</td>
<td>Preview the DDL generated from your choices. For more information, see &quot;<strong>Preview</strong>&quot; on page 576.</td>
</tr>
</tbody>
</table>

3. Click **Execute**. For information on the scheduling option, see "**Scheduling**" on page 843.
SHRINK
For details on using Rapid SQL Shrink operations to save or reclaim space, see the following topics:

- Shrinking SQL Server databases
- Shrinking Oracle rollback segments
- Shrinking Oracle tables or indexes

SHRINKING SQL SERVER DATABASES
Rapid SQL lets you reclaim space from a database that is too large.

To Shrink a SQL Server Database
1. Initiate a Shrink action against one or more databases. For more information see "Initiating an object operation" on page 573.

2. Use the following table as a guide to understanding and modifying the settings on the Shrink wizard:

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action Options</td>
<td>Displays the databases you selected and lets you work with the following settings:</td>
</tr>
<tr>
<td>Move data pages to beginning of file before shrink</td>
<td>Select to move data pages to the beginning of the file before the shrink.</td>
</tr>
<tr>
<td>Release All Unused Space</td>
<td>Deselect to set the target free space to retain, and then in the Target Free Space to Retain (percent) box, type the new value of free space to retain. The new size for the database must be at least as large as the Minimum Allowable Size displayed in the Current File Size box.</td>
</tr>
<tr>
<td>Target free space percent after shrink</td>
<td>Lets you specify the target free space percent after the shrink.</td>
</tr>
<tr>
<td>Preview</td>
<td>Preview the DDL generated from your choices. For more information, see &quot;Preview&quot; on page 576.</td>
</tr>
</tbody>
</table>

3. Click Execute. For information on the other options, see Preview and Scheduling.

SHRINKING ORACLE ROLLBACK SEGMENTS
Rapid SQL lets you shrink the size of rollback segments. The proper sizing of rollback segments is critical to their overall performance. Performance degrades whenever a rollback segment must extend, wrap or shrink in response to transaction loads. Ideally, you want to make the extents of rollback segments as small as possible while still ensuring that each transaction can fit into a single extent.

After an abnormally large transaction load, you might consider shrinking a rollback segment to eliminate unnecessary space. Oracle lets you shrink a rollback segment manually by a specific amount or back to its Optimal Size.
Important Notes
For Oracle 9 or later, Shrink is not available if auto-UNDO management is enabled.

To Shrink the Size of One or More Rollback Segments
1. Initiate a **Shrink** action against one or more rollback segments. For more information see "Initiating an object operation" on page 573.
2. Use the following table as a guide to understanding and modifying the settings on the **Shrink** wizard:

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action Options</td>
<td>Displays the rollback segments you selected and lets you work with the following settings:</td>
</tr>
<tr>
<td>Specify the size...</td>
<td>If you do not provide a specific number the Rollback Segment uses the OPTIMAL value specified in the Storage clause. If an OPTIMAL value is not specified, the size defaults to the MINEXTENTS value of the Storage clause.</td>
</tr>
<tr>
<td>Preview</td>
<td>Preview the DDL generated from your choices. For more information, see &quot;Preview&quot; on page 576.</td>
</tr>
</tbody>
</table>

3. Click **Execute**. For information on the scheduling option, see "Scheduling" on page 843.

**SHRINKING ORACLE TABLES OR INDEXES**
Rapid SQL lets you shrink the size of tables or indexes.

Important Notes
Shrink is only available for tables in which the **Row Movement** property is enabled. For information on setting the **Row Movement** when creating or editing a table, see "Tables Wizard (Oracle)" on page 401 and "Tables Editor (Oracle)" on page 544.

To Shrink the Size of One or More Indexes or Tables
1. Initiate a **Shrink** action against one or more indexes or tables. For more information see "Initiating an object operation" on page 573.
2. Use the following table as a guide to understanding and modifying the settings on the **Shrink** wizard:

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action Options</td>
<td>Displays the objects you selected and lets you work with the following settings:</td>
</tr>
<tr>
<td>Compact</td>
<td>Enable <strong>Compact</strong> to restrict shrinking to defragmenting the segment space and compact rows.</td>
</tr>
<tr>
<td>Cascade</td>
<td>Enable <strong>Cascade</strong> to simultaneously shrink all dependent objects.</td>
</tr>
<tr>
<td>Dependencies</td>
<td>Lists referring and referenced objects potentially impacted by the change. For details, see &quot;Dependencies&quot; on page 576.</td>
</tr>
</tbody>
</table>
START DATABASE

The **Start Database** dialog lets you start a database:

- When the database that has been stopped with a **Stop Database** dialog. For more information, see "Stop Database" on page 692.

- After a tablespace, partition, or index has been placed in group buffer pool RECOVER pending status (GRECP) or if pages have been put on the logical page list (LPL) for that object.

Depending on the specified options, the database can be made available for read-only processing, read-write processing, or utility-only processing. In a data sharing environment, the command can be issued from any DB2 on the group that has access to the database.

**Platform Availability**

- **DB2 z/OS**

**To Start a Database**

1. On the Datasource Navigator, expand the **Databases** node.

   Rapid SQL displays objects of the selected type.

2. Right-click the target object and select **Start Database** from the context menu.

   Rapid SQL opens the **Start Database** dialog.

3. Use the following table as a guide to understanding and settings options on this dialog:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Database Grid</td>
<td>The Partition column is editable and can include one or more unique numeric values separated by commas. Initially the Partition column is blank. No validation is made for the correctness of partition numbers so make sure that the partitions exist.</td>
</tr>
<tr>
<td>Access</td>
<td>Lets you select access options of Read/Write, Read only, Utility only or Force.</td>
</tr>
</tbody>
</table>

4. Click **Execute**. For information on the scheduling option, see "Scheduling" on page 843.
STOP DATABASE
The Stop Database dialog lets you stop a database, optionally letting you allow running applications access until their next COMMIT.

Platform Availability
- DB2 z/OS

To Stop a Database
1. On the Database Explorer, expand the Databases node.
   Rapid SQL displays objects of the selected type.
2. Right-click the target object and select Stop Database from the context menu.
   Rapid SQL opens the Stop Database dialog.
3. Use the following table as a guide to understanding and settings options on this dialog:

<table>
<thead>
<tr>
<th>Option</th>
<th>Functionality</th>
</tr>
</thead>
<tbody>
<tr>
<td>Database Grid</td>
<td>The Partition column is editable and can include one or more unique numeric values separated by commas. Initially the Partition column is blank. No validation is made for the correctness of partition numbers so make sure that the partitions exist.</td>
</tr>
<tr>
<td>Stop at COMMIT</td>
<td>Enabling this option sends the STOP DATABASE statement with an AT(COMMIT) clause, allowing running applications to continue access until their next commit.</td>
</tr>
</tbody>
</table>
4. Click Execute. For information on the scheduling option, see "Scheduling" on page 843.

STOP JOB
This action builds and submits a DBMS_SCHEDULER.STOP_JOB call, letting you stop a job immediately.

Platform Availability
- ORCL 10g ^

To stop a job
1. On a connected Oracle datasource, expand the Scheduler nodes and select the Jobs node.
2. Right-click a job and select Stop Job from the context menu.
3. Use the following table as a guide to understanding and modifying settings in the dialog:

<table>
<thead>
<tr>
<th>Step</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action options</td>
<td>Select the <strong>Force Stop</strong> check box to provide a FORCE attribute value of TRUE forcing the job to terminate immediately. Deselect the <strong>Use current session</strong> check box to provide a FORCE attribute value of FALSE.</td>
</tr>
<tr>
<td>Dependencies</td>
<td>Lists referring and referenced objects potentially impacted by the change. For details, see &quot;Dependencies&quot; on page 576.</td>
</tr>
<tr>
<td>Preview</td>
<td>Displays the DDL that will execute the object action. For details, see &quot;Preview&quot; on page 576.</td>
</tr>
</tbody>
</table>

4. Click **Execute**. For information on the scheduling option, see "Scheduling" on page 965.

**SWITCH ONLINE**

The **Switch Online** dialog lets you access a tablespace by switching it online after the parent container(s) have been recovered or restored.

**Platform Availability**

- **DB2 LUW**

**To Switch a Tablespace Online:**

1. Initiate a **Switch Online** action against one or more tablespaces. For more information see "Initiating an object operation" on page 573.

   Rapid SQL opens the **Switch Online** dialog.

2. Click **Execute**. For information on the scheduling option, see "Scheduling" on page 843.

**TRANSFER OWNERSHIP**

Rapid SQL lets an object owner or a user with SECADM authority transfer ownership of an object to another user. The new user is automatically granted the same privileges as the former owner. Ownership can be transferred on an object-by-object basis or you can transfer all objects currently owned by an individual user.

**Platform Availability and object type support**

- **DB2 LUW** 9.1 ^

The following table lists the object types that support ownership transfer:

<table>
<thead>
<tr>
<th>Aliases</th>
<th>Check Constraints</th>
<th>Event Monitors</th>
<th>Foreign Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Functions</td>
<td>Indexes</td>
<td>Primary Keys</td>
<td>Procedures</td>
</tr>
<tr>
<td>Materialized Query Tables</td>
<td>Schema</td>
<td>Sequences</td>
<td>Structured Types</td>
</tr>
</tbody>
</table>
To Transfer Ownership of an Object

1. Initiate a Transfer Ownership action against one or more supported objects (see table above). For more information see "Initiating an object operation" on page 573.

2. Use the following table as a guide to understanding and modifying settings in the Transfer Ownership wizard:

<table>
<thead>
<tr>
<th>Step</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action options</td>
<td>If you initiated the ownership transfer against a user, select the specific objects belonging to that user that are to be assigned to a new user. Use the New Owner dropdown to select a defined user as the new owner of the selected object or objects.</td>
</tr>
<tr>
<td>Preview</td>
<td>Preview the DDL generated for the operation. For more information, see &quot;Preview&quot; on page 576.</td>
</tr>
</tbody>
</table>

TRUNCATE

Rapid SQL lets you quickly delete the rows of one or more tables or clusters. Truncating a table is a faster alternative to deleting all of its rows.

**CAUTION:** If you truncate a table, Rapid SQL deletes all the rows. These rows are not logged as individual drops and cannot be recovered from a transaction log or other type of log.

Platform Availability

- DB2 LUW, DB2 z/OS, MySQL, ORCL, SQL SVR, SYBASE

To Truncate a Table or Cluster

1. Initiate a Truncate or Truncate Table action against one or more tables or clusters. For more information see "Initiating an object operation" on page 573.

   Rapid SQL opens the Truncate wizard/dialog box.

2. For help with DBMS-specific settings and additional information, see the following topics:
   - Notes on truncating Oracle objects
   - Notes on truncating Sybase ASE objects
   - Notes on truncating IBM DB2 z/OS objects

3. Click Execute. For information on the scheduling option, see "Scheduling" on page 843.
NOTES ON TRUNCATING ORACLE OBJECTS

You can truncate any table or cluster in their schema or, if you have the DROP ANY TABLE system privilege, you can truncate any table in any schema.

Observe the following when truncating tables or clusters:

- Before truncating a cluster or table containing a parent key, disable all referencing foreign keys existing in different tables.
- Truncating a cluster or table does not generate any rollback information and commits immediately.
- Oracle alters the storage parameter NEXT to the size of the last extent deleted from the segment.
- Oracle automatically deletes all data in the table's indexes and any materialized view direct-load INSERT information associated with a truncated table.
- If the table is not empty, all associated nonpartitioned indexes and all partitions of associated global partitioned indexes are marked unusable.
- You cannot truncate a hash cluster nor can you truncate individual tables in a hash cluster or an index cluster.

When you truncate a table or cluster, you can specify whether space currently allocated for the table is returned to the containing tablespace or if it is returned to the system. The table below describes the Truncate dialog options available when truncating an Oracle table or cluster:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Drop Storage</td>
<td>Select if you want the freed extents returned to the system where they can be used by other objects.</td>
</tr>
<tr>
<td>Reuse Storage</td>
<td>Select if you want the space to remain allocated to the table or cluster you have just truncated.</td>
</tr>
</tbody>
</table>

NOTES ON TRUNCATING SYBASE ASE OBJECTS

Truncate against a Sybase ASE table can be applied to the entire table or to a single partition.

**NOTE:** You cannot truncate a table referenced by a foreign key constraint. Instead, use a DELETE statement without a WHERE clause.

**TIP:** When you truncate a table, Sybase ASE removes all rows from the target table, but retains the table structure (its indexes, columns, constraints, etc.). The counter used by an identity for new rows is reset to the seed for the column. To retain the identity counter, use a DELETE statement instead of TRUNCATE. To remove the target table definition and its data, use a DROP TABLE statement.
The following table shows the settings on the Truncate Table dialog:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Partition Name</td>
<td>Selecting a partition name from the dropdown restricts the truncate operation to a single partition.</td>
</tr>
</tbody>
</table>

**NOTES ON TRUNCATING IBM DB2 z/OS OBJECTS**

When truncating an IBM DB2 z/OS table, the **Action Options** tab offers the following settings:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reuse Storage</td>
<td>Corresponds to the DROP STORAGE/REUSE STORAGE clause of a TRUNCATE TABLE statement. This setting specifies whether storage currently allocated to the table is reused or dropped.</td>
</tr>
<tr>
<td>Restrict When Delete Triggers</td>
<td>Corresponds to the RESTRICT WHEN DELETE TRIGGERS/IGNORE DELETE TRIGGERS clause of a TRUNCATE TABLE statement. When enabled, an error is returned if triggers are defined for the table. When disabled, triggers defined for the table are not activated by the Truncate operation.</td>
</tr>
<tr>
<td>Immediate</td>
<td>Corresponds to the IMMEDIATE clause of a TRUNCATE TABLE statement. If enabled, the truncate operation is executed immediately and cannot be undone. If disabled, a Rollback can undo the Truncate operation.</td>
</tr>
</tbody>
</table>

**UNBIND FROM TEMPORARY DATABASE**

This action builds and submits a `sp_tempdb` `unbind` system procedure call. It lets you unbind a login from a temporary database.

**Platform Availability**

- **SYB ASE**

**To Unbind a Login from a Temporary Database**

1. Initiate a **Unbind From Temporary Database** action against one or more logins. For more information see "Initiating an object operation" on page 573.

2. Use the following table as a guide to understanding and modifying settings in the **Unbind From Temporary Database** wizard:

<table>
<thead>
<tr>
<th>Step</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action Options</td>
<td>Displays the logins you selected for unbinding.</td>
</tr>
<tr>
<td>Dependencies</td>
<td>Lists referring and referenced objects potentially impacted by the change. For details, see &quot;Dependencies&quot; on page 576.</td>
</tr>
<tr>
<td>Preview</td>
<td>Displays the DDL that will execute the object action. For details, see &quot;Preview&quot; on page 576.</td>
</tr>
</tbody>
</table>

3. Click **Execute**. For information on the scheduling option, see "Scheduling" on page 843.
UNQUIESCE
The Unquiesce operation lets you restore user access to a single database or all databases of an instance previously quiesced.

Platform Availability
- **DB2 LUW**

**NOTE:** Rapid SQL does not support Unquiesce Database for supported servers from IBM DB2 for Windows/Unix 7 or earlier clients.

To Restore User Access to a Database
1. Take one of the following actions, based on whether you are unquiescing a single database or all databases on an instance:
   - Right-click a datasource node and select **Command > Unquiesce** from the context menu.
   - Right-click the Instance node, select **Command > Unquiesce** from the context menu, and provide credentials if prompted.

   Rapid SQL opens the **Unquiesce Database** or **Unquiesce Database** dialog.
2. Click **Execute**.

Related Information
- "**Quiesce**" on page 652

UPDATE STATISTICS
The **Update Statistics** dialog lets you update the statistics for an active table or index. As indexes grow and shrink in response to data modification, the accuracy of their statistics can deteriorate.

The following topics provide details on updating statistics by supported DBMS and object type:
- **Updating statistics for tables or indexes (IBM DB2 for Linux, Unix, and Windows)**
- **Updating statistics for views (IBM DB2 for Windows, Unix, and Linux)**
- **Updating statistics for databases, indexes, or tables (Microsoft SQL Server)**
- **Updating statistics for indexes or tables (Sybase ASE)**
**To Update Statistics for an Index or Table**

1. Initiate an **Update Statistics** action against one or more tables or indexes. For more information see "Initiating an object operation" on page 573.

   Rapid SQL opens the **Update Statistics** dialog.

2. Use the following table as a guide to understanding and modifying the settings in this dialog.

<table>
<thead>
<tr>
<th>Tab</th>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table Options</td>
<td>Update table statistics</td>
<td>Updates table statistics.</td>
</tr>
<tr>
<td></td>
<td><strong>Distribution Options</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Do not collect column statistics - Column statistics provide information that the optimizer uses to choose the best access plans for queries.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Collect column statistics on key columns only - Collects column statistics on columns that make up all the indexes defined on the table.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Collect column statistics on all columns - Collects column statistics for all columns. Column statistics provide information that the optimizer uses to choose the best access plans for queries.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Frequency - Lets you specify the maximum number of frequency values to collect, between 1 and 32767.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Quantiles - Lets you specify the maximum number of distribution quantile values to collect, between 1 and 32767.</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Column Options</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Do not collect distribution statistics - Does not collect basic statistics or distribution statistics on the columns.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Collect distribution statistics on key columns only - Collects both basic statistics and distribution statistics on key columns only.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Collect distribution statistics on all columns - Collects both basic statistics and distribution statistics on all columns. For efficiency both of RUNSTATS and subsequent query-plan analysis, you might collect distribution statistics on only the table columns that queries use in WHERE, GROUP BY, and similar clauses. You might also collect cardinality statistics on combined groups of columns. The optimizer uses such information to detect column correlation when it estimates selectivity for queries that reference the columns in the group.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Exclude XML columns - Lets you collect statistics on non-XML columns only. XML columns are not included in statistics collection.</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Index Options</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Update index statistics</td>
<td>Lets you enable and disable statistics updates for indexes and controls the following settings:</td>
</tr>
<tr>
<td></td>
<td>Collect extended index statistics - Collects extended index statistics, the CLUSTERFACTOR and PAGE_FETCH_PAIRS statistics that are gathered for relatively large indexes.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Collect sample statistics</td>
<td>Rapid SQL uses a CPU sampling technique when compiling the extended index statistics. If the option is not specified, every entry in the index is examined to compute the extended index statistics.</td>
</tr>
</tbody>
</table>
Click **Execute**. For information on the **Preview** option, see **Preview**.

### UpdAtIng StatisticS for views (IBM DB2 for windows, Unix, and Linux)

For IBM DB2 for Windows, Unix, and Linux, Rapid SQL lets you update the statistics for a view.

#### To Update Statistics for a View

1. Initiate an **Update Statistics** action against one or more views. For more information see "[Initiating an object operation](#)" on page 573.

2. Use the following table as a guide to choosing options:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Access</strong></td>
<td><strong>Allow read only access during collection</strong></td>
<td>Allows read only access while Rapid SQL updates the statistics.</td>
</tr>
<tr>
<td></td>
<td><strong>Allow read/write access during collection</strong></td>
<td>Allows read and write access while Rapid SQL updates the statistics.</td>
</tr>
</tbody>
</table>

3. **Schedule** or **Execute** the statistics update.

### UpdAtIng StatisticS for databases, indexes, or tables (Microsoft SQL Server)

You can update statistics so that Microsoft SQL Server performs the most efficient query possible. This feature updates statistical information on your database so that the query processor can determine the optimal strategy for evaluating a query. These statistics record the key values used for distribution in an database.

You can use the **Update Statistics** dialog if there is significant change in the key values in the database, if a large amount of data in an indexed column has been added, changed, or removed, or if a table has been truncated causing significant changes in the distribution of key values.
The **Update Statistics** dialog lets you specify tables and indexes for validation. This dialog box offers different update options depending on your version of Microsoft SQL Server.

**TIP:** Avoid updating statistics on your target tables during busy access periods. Microsoft SQL Server locks remote tables and indexes while reading data for update statistics.

For Microsoft SQL Server version 7 or later, the **Update Statistics** dialog lets you specify a full or a percentage of a full scan to be used for updating table or index statistics. It also lets you enable or disable future automatic recomputations of statistics. These recomputations are made at Microsoft SQL Server's discretion. When updating statistics for tables, this dialog box also lets you specify the type of statistics you require.

### To Update Statistics for a Database, Index, or Table

1. Initiate an **Update Statistics** action against one or more databases, indexes, or tables. For more information see "[Initiating an object operation](#)" on page 573.

2. Use the following table as a guide to understanding and modifying the settings in the **Update Statistics** dialog:

<table>
<thead>
<tr>
<th>Step</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action Options</td>
<td><strong>Scan Range</strong> (tables and indexes only)</td>
</tr>
<tr>
<td></td>
<td><strong>Sample Count</strong> (tables and indexes only)</td>
</tr>
<tr>
<td></td>
<td><strong>Sample Unit</strong> (tables and indexes only)</td>
</tr>
<tr>
<td></td>
<td><strong>Statistics Type</strong> (tables only)</td>
</tr>
<tr>
<td></td>
<td><strong>Statistics Recompute</strong> (tables and indexes only)</td>
</tr>
<tr>
<td>Dependencies (tables and indexes only)</td>
<td>Lets you view referencing or referenced objects.</td>
</tr>
<tr>
<td>Preview</td>
<td>Lets you view the DDL generated for the operation. For more information, see &quot;<a href="#">Preview</a>&quot; on page 576.</td>
</tr>
</tbody>
</table>

3. Use the **Execute** or **Schedule** button to perform the operation.
**Updating statistics for indexes or tables (Sybase ASE)**

The **Update Statistics** dialog lets you specify tables and indexes for validation. This dialog box offers different update options depending on your version of Sybase ASE.

**TIP:** Avoid updating statistics on your target tables during busy access periods. Sybase ASE locks remote tables and indexes while reading data for update statistics.

**To Update Statistics for a Database, Index, or Table**

1. Initiate an **Update Statistics** action against one or more tables or indexes. For more information see "Initiating an object operation" on page 573.

2. Use the following table as a guide to understanding and modifying the settings in the **Update Statistics** dialog:

<table>
<thead>
<tr>
<th>Step</th>
<th>Settings and tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Action Options</strong></td>
<td><strong>Index</strong> (tables only)</td>
</tr>
<tr>
<td></td>
<td><strong>Table</strong> (tables only)</td>
</tr>
<tr>
<td><strong>Partition Name</strong> (available when a single index or table is selected)</td>
<td><strong>The name of the partition to be updated.</strong></td>
</tr>
<tr>
<td><strong>Step Values</strong></td>
<td><strong>Lets you specify the number of histogram steps.</strong></td>
</tr>
<tr>
<td><strong>Consumers</strong></td>
<td><strong>Specifies the number of consumer processes to be used for a sort when a list of columns is provided and parallel query processing is enabled.</strong></td>
</tr>
<tr>
<td><strong>Sampling Percent</strong></td>
<td><strong>Specifies the percentage of the column to be randomly sampled in order to gather statistics.</strong></td>
</tr>
<tr>
<td><strong>Dependencies</strong></td>
<td><strong>Lists referring and referenced objects potentially impacted by the change. For details, see &quot;Dependencies&quot; on page 576.</strong></td>
</tr>
<tr>
<td><strong>Preview</strong></td>
<td><strong>Lets you view the DDL generated for the operation. For more information, see &quot;Preview&quot; on page 576.</strong></td>
</tr>
</tbody>
</table>

3. Use the **Execute** or **Schedule** button to perform the operation.
SQL Scripting

Rapid SQL incorporates a powerful SQL scripting environment, the ISQL Editor. The ISQL Editor lets you write, debug, test and deploy solid SQL code for your database applications. The scripting environment lets you:

- Open multiple interactive script windows.
- Execute multiple scripts on the same desktop.
- Capture multiple result sets on the same desktop.

Rapid SQL’s scripting environment is comprised of different windows:

- ISQL Editor
- DDL Editor
- Results Editor

These windows are context sensitive to the type of script you are opening or extracting. For example, if you extract the schema for a table, Rapid SQL opens a DDL Window containing the script. If you execute a script, a result window displays containing the results of your execution statement.

**TIP:** Since you must drop a database object before you can recreate it, you can set the DDL Editor to automatically include DROP statements for specified objects.

**TIP:** You can have multiple ISQL windows open at the same time, with each running separate queries.

ISQL Editor

The ISQL Editor includes the ISQL Window and DDL Editor.

The ISQL Window lets you:

- Insert files and open files.
- Rename and configure query tabs.
- Find and replace with regular expressions.
• Mail your script files.

  **TIP:** To enlarge or reduce (zoom) the display font size, press Ctrl-= or Ctrl-- (plus or minus on the numeric pad), or hold the Ctrl key while scrolling the mouse wheel. To return to the default size, press Ctrl-/ (on the numeric pad).

  **TIP:** To toggle to the next SQL window, press CTRL +T.

  **TIP:** The row limit option lets you display only the first ‘n’ rows from any submitted query.

  **TIP:** For Oracle, Rapid SQL displays REF CURSOR contents in the ISQL Window and **Results Tab**.

  **TIP:** For IBM DB2 LUW for Linux, Unix, and Windows and Oracle, you can access the Code Completion functionality with the CTRL+K shortcut.

**Related Topics**

- Toolbar Options
- Opening ISQL Windows
- Opening DDL Editors
- Opening Script Files
- Inserting Files into an ISQL Window
- Splitter Windows
- Find and Replace in an ISQL Window
- Regular Expressions
- Navigating in an ISQL Window
- Scheduling
- Sending SQL Scripts
- Renaming and Closing Query Window Tabs
- Printing a Script
- Saving and Closing Scripts
- SQL Preprocessor
- "Automated Error Detection and Coding Aid Features" on page 712
- Bind Variable Parameterization in Prepared Statements (Dynamic SQL)
PREPROCESSING #DEFINE AND #INCLUDE DIRECTIVES

Rapid SQL provides SQL preprocessing similar to functionality provided by C language compiler directives. The ISQL Editor supports a simplified version of the following directives.

- **#include** provides a means to include the contents of a file in a script at the location of the directive
- **#define** provides a simple, global search and replace function within a script

The following figure illustrates the result of basic preprocessing of a script, nesting of **#define** directives/references, and the notations required by the ISQL editor. The original script includes two **#define** directives and a **#include** reference to a one-line file named `fileForInclude.sql`. The referenced file includes two identifiers to be replaced with **#define** processing.

**Script content before SQL preprocessing**

```
1  #define &table JOBS
2  #define &owner HR
3
4  #include<fileForInclude.sql>
```

**Contents of fileForInclude.sql**

```
1  SELECT * FROM &owner.&table
```

**Script content produced by SQL preprocessing**

```
1  --#define &table JOBS
2  --#define &owner HR
3
4  --#include<fileForInclude.sql>
5  SELECT * FROM HR.JOBS
```

The key steps in working with SQL preprocessing are:

- **Preparing the ISQL editor for #include and #define preprocessing** - Prior to using SQL preprocessing features, you should set the paths that will be searched in processing **#include** directives. For details, see [Setting Up Rapid SQL to Preprocess #include Directives](#).

- **Using #define and #include directives in scripts** - While the supported directives approximate typical C language **#define** and **#include** functionality, there are differences in functionality and required syntax. For example, identifiers in the **#define** directive and in all instances to be replaced, must be prefixed with two ampersand characters (**#define &PI 3.14159**). For detailed information, see [#include Functionality and Syntax](#) and [#define Functionality and Syntax](#).
• **Preprocessing and executing scripts containing #define and #include directives** - The ISQL Editor offers two preprocessing options. You can have a script preprocessed without being executed, opening the processed script in a new editor window with all #define and #include substitutions made. This lets you view the processed script before execution or continue working with the processed SQL. Alternatively, you can have the script preprocessed and executed in a single step. For details, see Preprocessing and Executing Scripts Containing #define and #include Directives.

**SETTING UP RAPID SQL TO PREPROCESS #INCLUDE DIRECTIVES**

In ISQL editor processing of a #include directive, Rapid SQL searches the following locations, in the following order, for the specified file:

1. The location specified on the Datasource Properties tab of the Datasource Registration Wizard/Editor. For details, see Registering or editing datasources.

2. The location specified on the Directories tab of the Options editor. For details, see Directories Options.

   **NOTE:** For detailed information on setting Rapid SQL options, see Specifying Rapid SQL application and feature options.

Before using SQL preprocessing, ensure that server side or server side and local search paths for include files are specified.

**#INCLUDE FUNCTIONALITY AND SYNTAX**

Rapid SQL support for the #include directive provides a means to include the contents of a file in a script at the location of the directive. For example, if a script contains the following:

```sql
#include mydeclarations.sql
```

then on preprocessing of the script, there are two effects:

- The line containing the #include directive is commented out before the script is sent to the database
- The text in the file mydeclarations.sql is placed in the script following the commented out line with the #include directive.

The #include directive is supported for simple file names only. Supported syntax of the #include directive for use in the ISQL editor, Procedure Object Editor, or Package Body Object Editor, is as follows:

```sql
#include <filename.ext>
```

where:
• *filename.ext* is a simple filename and extension

**NOTE:** For those familiar with C compiler functionality, angle bracket and quoted forms are supported only indirectly. While `#include <filename.ext>` and `#include "filename.ext"` forms are valid, they are functionally equivalent to the `#include filename.ext`. Using the angle bracket or quoted forms has no effect on locations searched for the target file. Searches are performed in the locations specified in the setup for this feature. For details, see Setting Up Rapid SQL to Preprocess `#include` Directives.

Error processing is as follows:

• If the preprocessor fails to include the specified file, it displays an error message noting the reason for the failure (such as the file does not exist, insufficient permissions on the file, or file too large). Preprocessing or execution of the script cannot continue until the error is corrected.

• If the file is found in the first search location specified in Setting Up Rapid SQL to Preprocess `#include` Directives but cannot be opened (permission denied for example), no attempt will be made to locate the file in the second specified search location.

### #DEFINE Functionality and Syntax

The `#define` directive provides a simple, global search and replace function within a script. For example, if a script contains the following:

```
#define &&PI 3.14159
```

then on execution of the script, there are two effects:

• All instances of `&&PI` in the script would be replaced by `3.14159` on execution of the script

• The line containing the `#define` directive is commented out before the script is sent to the database

The `#define` directive is supported for symbolic constants only. Supported syntax of the `#define` directive for use in the ISQL editor, Procedure Object Editor, or Package Body Object Editor, is as follows:

```
#define &&Identifier Replacement_text
```

where:

• `Identifier` is any character string appearing in the script

• `Replacement_text` is the string that will replace all instances of the string specified by the `Identifier` argument. Valid values are strings, numbers or combinations consisting of the digits `0-9`, characters `a-z`, characters `A-Z`, and the underscore character.

**NOTE:** In addition to the actual `#define` directive appearing in a script, the ampersand notation is also required in all references that are to be replaced. References that are not prefixed with ampersand characters are not processed.

Nested `#define` directives are also supported. For example if a script contains the following:
#define &&myTable Clients
#define &&embtClients Embarcadero
#define &&tempTable New&&myTable
#define &&embtTempTable &&embtClients&&myTable

Select * from &&tempTable;
Select * from &&embtTempTable

then after preprocessing, the contents of the script would be as follows:

Select * from NewClients;
Select * from EmbarcaderoClients

PREPROCESSING AND EXECUTING SCRIPTS CONTAINING #DEFINE AND #INCLUDE DIRECTIVES

The ISQL editor offers two preprocess/execute modes:

- Rapid SQL can preprocess the script, opening the script in a new tab, with all #define and #include substitutions made. This lets you view your preprocessed script or continue with edits after preprocessing, before executing it in the new tab.

- Rapid SQL can preprocess and execute the script in a single step.

Preprocessing or preprocessing/executing the script consists of selecting a mode and the executing the script. Preprocessing mode is controlled by the preprocessing dropdown on the ISQL editor toolbar.

To preprocess a script and have the preprocessed script opened in a new tab:

1. From the Preprocess dropdown, select Pre-Process Only. The Preprocess dropdown icon takes on a distinctive appearance to indicate Pre-Process Only mode.

2. On the ISQL toolbar, click the Execute button.

The script with all #define and #include replacements made, opens in a new ISQL editor.

NOTE: For details on error processing and specific handling of directives, see #include Functionality and Syntax and #define Functionality and Syntax.
To preprocess and execute a script in a single step:

1. From the Preprocess dropdown, select **Pre-Process and Execute**.

2. On the ISQL toolbar, click the Execute button.

   The script executes. While the script sent to the server for execution includes all `#define` and `#include` substitutions, the new **Query** tab contains the original, unprocessed script.

For related information, see the following topics:

- See [Executing Scripts](#) for other script execution options
- See [Preprocessing #define and #include Directives](#) for an introduction to SQL preprocessing in the ISQL editor

**TOOLBAR OPTIONS**

The table below describes the options of the ISQL Editor toolbar:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lock</td>
<td>Lets you lock an ISQL Window to a specific datasource connection:</td>
</tr>
<tr>
<td></td>
<td><strong>Locked</strong> (manual session termination) - the ISQL window will open a session and keep it open while the window remains open, unless the DBMS terminates the session due to a timeout, or the session is closed. The ISQL Window does not respond to datasource change events in other windows, and only uses the current connection for subsequent execution.</td>
</tr>
<tr>
<td></td>
<td><strong>Unlocked</strong> (automatic session terminations) - the ISQL window will execute each statement in a new session with no session state maintained between them.</td>
</tr>
<tr>
<td></td>
<td>When explicitly unlocking an ISQL window, the connection can be returned to the connection pool or disconnected. For details, see the DBMS specific information under <strong>ISQL Options</strong>.</td>
</tr>
<tr>
<td>Execute</td>
<td>Executes the script.</td>
</tr>
<tr>
<td>Step Execute</td>
<td>Initiates step execution of the script. For more information, see <a href="#">Step Execution Facility</a>.</td>
</tr>
<tr>
<td>Schedule</td>
<td>Opens a dialog that lets you schedule an SQL job. For more information, see <a href="#">Scheduling</a>.</td>
</tr>
<tr>
<td>SQL Begin Transaction</td>
<td>Toggles the Begin Transaction status on and off.</td>
</tr>
<tr>
<td>SQL Rollback</td>
<td>Performs a rollback on the current transaction.</td>
</tr>
<tr>
<td>SQL Commit</td>
<td>Commits the current transaction.</td>
</tr>
<tr>
<td>Debug</td>
<td>Opens the Embarcadero SQL Debugger.</td>
</tr>
<tr>
<td>Preprocess</td>
<td>Lets you set a preprocessing state for execution of the script.</td>
</tr>
<tr>
<td></td>
<td>If you select <strong>Pre-process Only</strong>, subsequent use of the Execute button will result in the script being preprocessed without being executed. The script opens in a new editor window with all <code>#define</code> and <code>#include</code> substitutions made.</td>
</tr>
<tr>
<td></td>
<td>If you select <strong>Pre-process and Execute</strong>, all <code>#include</code> and <code>#define</code> directives are carried out and the script is executed. No new editor window opens.</td>
</tr>
<tr>
<td></td>
<td>For more information, see <a href="#">Preprocessing #define and #include Directives</a>.</td>
</tr>
</tbody>
</table>

RAPID SQL XE4/8.5 USER GUIDE 709
A script is a collection of SQL statements used to perform a task. Scripts, stored as files, form the foundation of most application projects. Definitions of tables, indexes, stored procedures, as well as reports and batch jobs, are usually stored in script files and shared by groups of developers using version control software. You can manage SQL scripts in SQL windows. Rapid SQL lets you open multiple SQL windows in one or more workspaces.

Opening ISQL Windows
To open the ISQL Window, do the following:

1. On the File menu, click New ISQL.
2. OR
   On the Main tool bar, click New ISQL.
   Rapid SQL opens an SQL window in your current workspace.

For more information, see
ISQL Window Status Bar
ISQL Editor

ISQL Window Status Bar
The ISQL window Status bar lets you view:

- Auto commit status (Oracle) - Automatically commits SQL statements as soon as the statements are run.
• Begin Transaction ON/OFF (SQL Server and Sybase ASE)

  **TIP:** For Microsoft SQL Server and Sybase ASE, to set Begin Transaction status to “Yes”, on the ISQL Window toolbar, click the SQL Begin Tran button.

  **TIP:** For Oracle, you can apply auto commit status changes to all open ISQL windows. You can modify the Oracle Auto Commit status and ISQL tab of the Options Editor. For details, see ISQL Options.

**BIND VARIABLE PARAMETERIZATION IN PREPARED STATEMENTS (DYNAMIC SQL)**

Rapid SQL lets you provide bind variable values when executing scripts containing prepared statements. Bind variables, or parameterized literals, can help optimize explain/execution plan usage by minimizing the requirement to “hard parse” queries or statements that differ by one or more literal values.

In scripts, Rapid SQL recognizes named or unnamed variables that use the following notation:

<table>
<thead>
<tr>
<th>DBMS Platform/Driver Type</th>
<th>Notation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Oracle with native driver</td>
<td>:&lt;name&gt; or :&lt;number&gt;</td>
</tr>
<tr>
<td>Oracle With JDBC driver</td>
<td>?</td>
</tr>
<tr>
<td>All other platforms/drivers</td>
<td>?</td>
</tr>
</tbody>
</table>

For example:

- `SELECT * FROM MYTABLE WHERE MYCOLUMN = ?`
- `CALL MYPROC ( :a, :b, :c )`

  **NOTE:** Support for bind variables is enabled on a editor window-by-editor window basis. Bind variable parameterization is enabled by setting the Prepare Batch Query Option, available on all DBMS platforms. For details, see “Setting up the Execution Environment with Query options” on page 815.

For an enabled SQL Editor window, when using execution options, whenever a statement containing bind variable notation is encountered, a Bind Variables dialog opens.
For each bind variable in the current statement, the dialog lets you specify:

- A type
- An IN, OUT, or INOUT designation for elements such as function or procedure parameters or arguments, variables used in INTO clauses of an INSERT statements and variables used in RETURNING clauses of an Update statements.
- A value

You can then execute, skip the statement, or abort execution for the currently running script.

**AUTOMATED ERROR DETECTION AND CODING AID FEATURES**

Rapid SQL analyzes code as you add content to an ISQL editor session and offers the following automated features:

- **Syntax Checking** automatically flags syntactical errors in your scripts
- **Semantic Validation** detects object name references to objects not present in the datasource index.
- **Code Complete** lets you insert or replace object names, selected from suggestion lists, as you edit a script.
- **Hyperlink Object Actions** let you invoke common object operations such as Open and Extract, as well as object type-specific operations, from object names referenced in a script.

**SYNTAX CHECKING**

The ISQL editor can perform on-the-fly or manually-initiated syntax checking. Rapid SQL checks the syntax of the current contents of an ISQL Editor window against the SQL dialect native to the datasource to which the ISQL editor session is connected. Syntax checking can be performed regardless of whether an ISQL editor session is locked to a datasource.
For each syntax error detected, Rapid SQL annotates your script and offers assistance as follows:

- Line numbers for lines containing syntax errors are flagged with an error icon.
- Hovering the mouse over an error icon displays a tooltip with an error message.
- The specific error in the line of code is underlined in red.

```
BEGIN
    v_start_year := TO_NUMBER(TO_CHAR(p_start_date, 'Y'));
    p_years_elapsed := v_end_year - v_start_year;
END YEARS_ELAPSED;
```

**NOTE:** A line-by-line listing of individual syntax errors is also available in the ISQL editor’s Error pane. For more information, see About the Error pane.

Rapid SQL can be configured to perform syntax checks automatically or to require a syntax check to be initiated manually:

- **Automatic** - Automatic syntax checking is enabled from the Options Editor. For details, see ISQL Options - Code Assist Tab.
  
  If the Enable Real-time syntax checking check box is selected, a syntax check is performed whenever there is an interval of 1.5 seconds or more between key strokes. Syntax error annotations persist until the error is corrected and the next automatic syntax check is executed.

- **Manual** - If automatic syntax checking is disabled, a syntax check is only performed when you click the Syntax button on the ISQL editor toolbar:

  ![Syntax Check](image)

  When automatic syntax checking is disabled, syntax error annotations persist until the error is corrected and you explicitly run another syntax check.

**Semantic Validation**

Semantic validation is an on-the-fly ISQL editor feature that verifies that object names are correctly specified. It ensures that the names of supported object types (columns, tables, synonyms, and views) present in a script match those for the connected datasource. Minimizing errors associated with typographical errors or references to obsolete object definitions, Rapid SQL analyzes the names of supported object types as you type, and raises an error condition when it detects a name not present on the datasource.
A semantic error can indicate one of the following conditions:

- The object name as specified in the script is not present on the database
- The referenced object is hidden by a SQL filter
- The schema information that Rapid SQL obtains to implement this feature is outdated. This can happen if other users or applications modify the schema during your ISQL editor session. For information on refreshing this information, see ISQL Options - Code Assist Tab.

When making use of this feature, always consider the following points:

- Semantic validation is only available for objects and object types configured to be included in the datasource index. For more information, see “ISQL Options - Code Assist - Advanced Tab” on page 117.
- For SQL Server and Sybase ASE datasources, statements that contain temporary table names (that is, tables whose name begins with the # character) are ignored by the semantic validation feature.
- Semantic errors in a statement are not displayed for a statement that currently has outstanding syntax errors. For more information, see Syntax Checking.
- For SQL Server and Sybase ASE datasources, system table names (that is tables whose name begins with the # character) are ignored by the semantic validation feature.
- While semantic errors can be flagged with an ERROR severity level, they can be more easily distinguished from syntax errors by setting a severity level of WARNING. Similarly, if you do not want semantic errors flagged, you can set the severity level to IGNORE. For details, see ISQL Options - Code Assist Tab.
- Ensure that the ISQL Editor window is connected to a datasource. Rapid SQL requires a datasource name in order to resolve an object name.

In the case of SQL Server and Sybase ASE, you must also select a database. The exception to this requirement is scripts that have a USE statement, specifying a database, appearing before any object name references.

**NOTE:** A line-by-line listing of individual semantic errors is also available in the ISQL editor’s Error pane. For more information, see About the Error pane.
Code Complete

Code Complete lets you quickly and accurately write DML and call\execute statements by providing a fast and intuitive lookup for database objects. Code Complete lets you select from a suggestion box that lists objects appropriate at the cursor location within a statement. Code Complete offers intelligent suggestions in providing simple object names or in constructing fully-qualified names.

This feature becomes available at all points in INSERT, UPDATE, DELETE, SELECT, CALL, and EXEC statements, including all legal clauses, where a reference to the name of one of the following object types is valid:

- Columns
- Tables
- Views
- Functions
- Procedures
- Packages
- Synonyms

Before using the Code Complete feature, complete the following setup tasks:

- Ensure that the object types for which Code Complete is to be available, are being indexed in the datasource index. For details, see "ISQL Options - Code Assist - Advanced Tab" on page 117.
- By default, Code Complete is enabled and configured for automatic invocation. For information on enabling or disabling this feature and configuring auto-activation and other Code Complete preferences, see "ISQL Options - Code Assist Tab" on page 115.

When the Code Complete feature is enabled, it can be invoked in two ways:

- Automatically, if auto-activation is enabled. A Code Complete suggestion box is offered when you start typing an object name in a relevant location and then stop typing for an interval that exceeds the specified auto-activation delay.
• Manually, if auto-activation is disabled or if the specified auto-activation delay is sufficiently large, by pressing CONTROL+SPACE or typing a period (.)

**NOTE:** By default, Code Complete is enabled and configured for automatic invocation. For information on enabling or disabling this feature and configuring auto-activation and other Code Complete preferences, see [ISQL Options - Code Assist Tab](#).

Code Complete offers context sensitive suggestions based on the cursor location within the statement when Code Complete is invoked. For example:

• **When invoked without any preceding text** - Code Complete will supply basic suggestions appropriate to that clause.

For example, suggestions for the table name in a FROM clause would help a user construct a qualified table or view name. Against a SQL Server datasource for example, this would include schemas and databases.

```sql
SELECT * FROM ADMINISTRATOR
```

Suggestions for the column name in a WHERE clause in the same statement would contain the schemas, databases and tables/views referenced in the FROM clause as well as a listing of the applicable columns based on the referenced tables/views.

```sql
SELECT * FROM app.emp
```

```sql
WHERE cl1
```

- Column: master.app.emp int(10,0)
- emp: [TABLE] master app
- app: [SCHEMA] master
- master: [DATABASE]
• **After the delimiter within an object name** - Code Complete offers a list that lets you select the next element to build a fully qualified object name.

```sql
SELECT XDB...,
```

• **After typing one or more characters of an object name** - Code Complete offers a listing of the names of all object name elements, relevant to the cursor location within the object name, that start with the typed characters.

```sql
SELECT * FROM F...
```
• At any point within a partially-specified or complete object name - Code Complete offers all selections appropriate to the location of the cursor.

To insert or replace a suggestion:

1. Double-click an object name or object name element in the list. Alternatively, you can use the arrow keys and press ENTER.

To dismiss the suggestion list without making a selection:

1. Click anywhere outside the suggestion list or press ESC.

**NOTE:** The schema information that Rapid SQL obtains to implement this feature can be outdated by the actions of other users or applications during an ISQL editor session. For information on refreshing this information, see ISQL Options - Code Assist Tab.

**HYPERLINK OBJECT ACTIONS**

Hyperlinks let you invoke object actions against object names referenced in an ISQL Editor script. A configured keystroke combination (default, CTRL+right-click) opens a menu with commands specific to the supported object type:
NOTE: In addition to the object type-specific options, the context menu also includes SQL editor options typically available when right-clicking in the editor.

The following table shows the object action availability for supported object type hyperlinks in the SQL editor:

<table>
<thead>
<tr>
<th>Action (and notes)</th>
<th>Object type</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Table</td>
</tr>
<tr>
<td>Build Query</td>
<td>✓</td>
</tr>
<tr>
<td>Compile</td>
<td>For more information, see Query Builder</td>
</tr>
<tr>
<td>Create Like</td>
<td>✓</td>
</tr>
<tr>
<td>Create View</td>
<td>✓</td>
</tr>
<tr>
<td>Debug</td>
<td>For more information, see Rapid SQL Add-On Tools</td>
</tr>
<tr>
<td>Describe</td>
<td>For more information, see Describe Window</td>
</tr>
<tr>
<td>Drop</td>
<td>✓</td>
</tr>
<tr>
<td>Edit Data</td>
<td>For more information, see Data Editor</td>
</tr>
<tr>
<td>Execute</td>
<td>For more information, see Executing Scripts</td>
</tr>
<tr>
<td>Extract</td>
<td>✓</td>
</tr>
<tr>
<td>Import Data From File</td>
<td>For more information, see Import Data</td>
</tr>
</tbody>
</table>
Before using the Hyperlinks feature, complete the following setup tasks:

- Ensure that the object types for which Hyperlink object actions are to be available, are being indexed in the datasource index. For details, see "ISQL Options - Code Assist - Advanced Tab" on page 117.

- Ensure that the Hyperlink feature has been enabled, the appropriate keystroke combination configured, and the menu details selected. For details, see "ISQL Options - Code Assist - Main Tab" on page 115.

Once setup tasks are complete, the Hyperlinks feature is available in the SQL Editor.

To invoke an object action using the Hyperlink feature

1. Use the configured keystroke combination anywhere within the text of an object name reference for a supported object type.

2. Select an object action from the context menu. For more information, see the online help for the selected action.

Using Code Templates

Code templates are complete code blocks that can be easily added to open windows or scripts with a few keystrokes. Templates let you define standard or common code units such as loops, comment blocks, query structures, and so on, add them to your code and edit them accordingly.

When you activate Code Assist by typing CTRL+SPACE, the Code Assist menu opens, offering any defined code templates for the currently connected DBMS platform.

Selecting the short name for the code template and pressing RETURN adds the template at the cursor position.
Rapid SQL loads a default set of code templates at startup but you can also add and delete templates from the currently available set. In addition, you can save sets of templates to file and subsequently load specific template sets, allowing you to customize your templates to different platforms or development projects.

Before making use of this feature, you should be familiar with the following tasks:

- Enabling the code templates feature. For details, see Enabling the Code Templates and Auto Replace Features.
- Maintaining the list of available templates. For details, see Maintaining Code Template Definitions and Loading and Saving Custom Code Workbench Settings.

**USING AUTO REPLACE EXPRESSIONS**

Rapid SQL lets you define shortcuts consisting of a few characters that represent longer character strings. Instances of these Auto Replace expressions are automatically replaced by the replacement string on activation events such as typing SPACE, TAB, or RETURN. This feature is useful for creating shortcuts for one-line commands or SQL statement subsets, or even to detect and fix common typographical errors such as `teh` for `the`.

For example, consider an Auto Replace definition with an expression of `sel` to represent `Select * From`:

If the associated activation event includes a SPACE, then on typing `sel` followed by typing SPACE, the following replacement occurs.
Rapid SQL loads a default set of Auto Replace definitions at startup but you can also add, edit, and delete Auto Replace definitions. In addition, you can save sets of definitions to file and subsequently load specific Auto Replace definitions, allowing you to customize your templates to different platforms or development projects.

Before making use of this feature, you should be familiar with the following tasks:

- Enabling the Auto Replace feature. For details, see Enabling the Code Templates and Auto Replace Features.
- Creating and maintaining the list of available Auto Replace definitions. For details, see Maintaining Auto Replace Expressions and Loading and Saving Custom Code Workbench Settings.

**DDL EDITORS**

** NOTE:** This functionality is available for all platforms.

Rapid SQL lets you open a new DDL Editor when you want to create a script that is tied to an object type in your database. The DDL Editor opens containing a template script for the selected object type. Because the DDL Editor is directly tied to a database, database warning messages can be issued. For example, if you have a create table script which includes a DROP TABLE statement, the DDL Editor warns you about the existence of this statement and that you could lose existing table data.

**Important Notes**

None

The table below describes the options and functionality on the Create New Database Object dialog box.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Object Type</td>
<td>Lets you select the object type to which you want to attach the script.</td>
</tr>
<tr>
<td>Owner</td>
<td>Lets you type the name of the object owner for the object. The name of the owner connected to the current datasource is used as the default.</td>
</tr>
<tr>
<td>Object Name</td>
<td>Lets you type the name of the object type.</td>
</tr>
</tbody>
</table>

Rapid SQL opens a DDL Editor containing a template for the object type you selected. For more information, see Opening DDL Editors.
**OPENING DDL EDITORS**

To open DDL Editors, do the following.

1. On the File menu, click New DDL Editor.
   
   OR
   
   On the Main toolbar, click the Down arrow on New, and then click DDL Editor.

2. In Object Type select the object type to which you want to attach the script.

3. In Owner type the name of the object owner for the object. The name of the owner connected to the current datasource is used as the default.

4. In Object Name type the name of the object type.

5. Click OK.
   
   Rapid SQL pastes the DDL into the ISQL Editor.

For more information, see [ISQL Editor](#).

**OPEN FILES**

**NOTE:** This functionality is available for all platforms.

The Open Files dialog box lets you open existing files.

**Important Notes**

None

The table below describes the options and functionality on the Open Files dialog box.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>File Name</td>
<td>Lets you type a script file name. You can open multiple script files simultaneously by selecting multiple file names in the file list.</td>
</tr>
<tr>
<td>Files of Type</td>
<td>Lets you control the files displayed in the file list by changing the selection. Rapid SQL displays multiple default file extensions.</td>
</tr>
<tr>
<td>Open Button</td>
<td>Click to open one or more files into the current workspace.</td>
</tr>
</tbody>
</table>
Completing the Open Files Dialog Box
To complete the Open Files dialog box, do the following:

1. On the File menu, click Open.
   OR
   On the Main toolbar, click Open.
2. Select a script file.
   OR
3. In File Name, type a script file name.
4. In Files of type, select types of files to display.
5. Click Open to open one or more files into the current workspace.
   Rapid SQL pastes the script into the ISQL Editor.

For more information, see ISQL Editor.

What Type of File

NOTE: This functionality is available for all platforms.

The What Type of File Is dialog box lets you select options for unknown file types.

Important Notes
None

The table below describes the options and functionality on the What Type of File Is dialog box:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>The file is a general purpose SQL script</td>
<td>Select if the unknown file is a SQL script.</td>
</tr>
<tr>
<td>The file contains the DDL to create a database object of the file contains Oracle Anonymous PL/SQL.</td>
<td>Lets you select object type, type the owner, and object name.</td>
</tr>
<tr>
<td>Always open unknown files into a SQL window without prompting.</td>
<td>Select to hide What Type of File Is Dialog Box for future unknown file types.</td>
</tr>
</tbody>
</table>

For more information, see Completing the What Type of File Is Dialog Box.
COMPLETING THE WHAT TYPE OF FILE IS DIALOG BOX
To complete the What Type of File Is dialog box, do the following:

1. On the File Menu, click Open.
   Rapid SQL opens the Open File(s) dialog box.
2. In the Open File(s) dialog box, select the target script, and then click Open.
   Rapid SQL opens the What type of file dialog box.
3. Select options, and then click OK.
   Rapid SQL opens the target script in an SQL Editor.

For more information, see ISQL Editor.

INSERT FILE INTO CURRENT FILE

NOTE: This functionality is available for all platforms.

The ISQL Editor facilitates the reuse of SQL scripts by letting you insert an existing file into another script.

The table below describes the options and functionality on the Insert File into Current File dialog box.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>File Name</td>
<td>Lets you type a script file name. You can open multiple script files simultaneously by selecting multiple file names in the file list.</td>
</tr>
<tr>
<td>Files of Type</td>
<td>Lets you control the files displayed in the file list by changing the selection. Rapid SQL displays multiple default file extensions.</td>
</tr>
<tr>
<td>Open Button</td>
<td>Click to insert one or more files into the current workspace.</td>
</tr>
</tbody>
</table>

Important Notes
None

For more information, see Completing the Insert File into Current File Dialog Box.
COMPLETING THE INSERT FILE INTO CURRENT FILE DIALOG BOX
To complete the Insert File into Current File dialog box, do the following:
1. On the Edit menu, click Edit Insert File.
   OR
2. On the Edit tool bar, click Edit Insert File.
   Rapid SQL opens the Insert File into Current File dialog box.
   OR
3. In File Name, type a script file name.
4. In Files of type, select types of files to display.
5. Click Open to insert one or more files into the current workspace.
   Rapid SQL inserts the file.
For more information, see ISQL Editor.

SPLITTING WINDOWS
You can split a SQL window into four different screens so that you can view different sections of a document simultaneously. You have the option to split the ISQL Window horizontally, vertically or into quadrants.

Splitting the ISQL Window Horizontally
To split the ISQL Window horizontally, do the following:
1. Point to the split box at the top of the vertical scroll bar on the right side of the SQL window.
2. When the pointer changes, drag it to the desired position.

Splitting the ISQL Window Vertically
To split the ISQL Window vertically, do the following:
1. Point to the split box at the top of the horizontal scroll bar on the bottom left side of the SQL window.
2. When the pointer changes, drag it to the desired position.

Removing Splits from an ISQL Window
Double-click the appropriate split bar to return the SQL window to its normal state.
For more information, see ISQL Editor.
FIND

NOTE: This functionality is available for all platforms.

The Find dialog box lets you search text in your SQL scripts.

Important Notes
None

The table below describes the options and functionality on the Find dialog box.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Find What</td>
<td>Lets you type your search string.</td>
</tr>
<tr>
<td>Match whole word only</td>
<td>Select to search for only the complete word.</td>
</tr>
<tr>
<td>Match Case</td>
<td>Select to make the search case-sensitive.</td>
</tr>
<tr>
<td>Regular expression</td>
<td>Select if you are looking for a regular text expression.</td>
</tr>
<tr>
<td>Wrap around search</td>
<td>Lets you search from the end of the script and back to the insertion point.</td>
</tr>
<tr>
<td>Direction</td>
<td>Lets you specify the direction you want to search. Click the Up or Down option button.</td>
</tr>
<tr>
<td>Find Next Button</td>
<td>Click to find the next occurrence of your search string.</td>
</tr>
<tr>
<td>Mark All Button</td>
<td>Click to place a small blue dot next to every line number in the script which meets the required search string criteria.</td>
</tr>
</tbody>
</table>

For more information, see Completing the Find Dialog Box.

COMPLETING THE FIND DIALOG BOX

To complete the Find dialog box, do the following

1. On the Edit menu, click Find.
   OR
   On the Edit tool bar, click Find.
2. In Find What, type your search string.
3. Select Match whole word only to search for only the complete word.
4. Select Match Case to make the search case-sensitive.
5. Select Regular expression to search for a regular text expression.
6 Select Wrap around search to search from the end of the script and back to the insertion point.

7 In Direction, click Up or Down.

8 Click Find Next to find the next occurrence of your search string.

9 Click Mark All to place a small blue dot next to every line number in the script which meets the required search string criteria.

   The ISQL Editor highlights the object name if it matches the search criteria.

   For more information, see Find.

REPLACE

   NOTE: This functionality is available for all platforms.

The Replace dialog box lets you search and replace text in your SQL scripts.

The table below describes the options and functionality on the Replace dialog box.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Find What</td>
<td>Lets you type your search string.</td>
</tr>
<tr>
<td>Replace With</td>
<td>Lets you type the replacement text.</td>
</tr>
<tr>
<td>Match Case</td>
<td>Select to make the search case-sensitive.</td>
</tr>
<tr>
<td>Regular expression</td>
<td>Select if you are looking for a regular text expression.</td>
</tr>
<tr>
<td>Wrap around search</td>
<td>Lets you search from the end of the script and back to the insertion point.</td>
</tr>
<tr>
<td>Direction</td>
<td>Lets you specify the direction you want to search. Click the Up or Down option button.</td>
</tr>
<tr>
<td>Find Next Button</td>
<td>Click to find the next occurrence of your search string.</td>
</tr>
<tr>
<td>Replace Button</td>
<td>Click replace the current selection.</td>
</tr>
<tr>
<td>Replace All Button</td>
<td>Click to automatically find and replace all occurrences of your search string within the current window.</td>
</tr>
</tbody>
</table>

For more information, see Completing the Replace Dialog Box.
COMPLETING THE REPLACE DIALOG BOX
To complete the Replace dialog box, do the following:

1. On the Edit menu, click Replace.

   OR

2. On the Edit tool bar, click Replace.

3. In Find What, type your search string.

4. In Replace With, type the replacement text.

5. Select Match whole word only to search for only the complete word.

6. Select Match Case to make the search case-sensitive.

7. Select Regular expression to search for a regular text expression.

8. Select Wrap around search to search from the end of the script and back to the insertion point.

9. In Direction, click Up or Down.

10. Click Find Next to find the next occurrence of your search string.

11. Click Replace to replace the current selection.

12. Click Replace All to automatically find and replace all occurrences of your search string within the current window.

For more information, see **ISQL Editor**.

REGULAR EXPRESSIONS SUPPORT IN RAPID SQL

Some features, such as file search, SQL Editor search, and Browser list filtering, support the use of regular expressions. This provides flexibility in searches and other situations in which text string qualification is required.

Detailed documentation on regular expressions is beyond the scope of this document. For descriptions of syntax and metacharacters, consult third-party documentation on the regular expressions standard. The following table provides short descriptions of the most commonly used regular expression metacharacters used with Rapid SQL features:

<table>
<thead>
<tr>
<th>Metacharacter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>.</td>
<td>Matches any single character.</td>
</tr>
<tr>
<td>*</td>
<td>Matches zero or more characters.</td>
</tr>
<tr>
<td>+</td>
<td>Matches one or more characters.</td>
</tr>
<tr>
<td>^</td>
<td>The start of a string.</td>
</tr>
<tr>
<td>$</td>
<td>The end of a string.</td>
</tr>
<tr>
<td>\b</td>
<td>Word boundary.</td>
</tr>
</tbody>
</table>
In the case of some specific features, regular expression usage must be enabled or configured. For more information, see the Rapid SQL feature topics for details:

- "Find/Replace Options in Coding Environments" on page 786
- "Find in Files" on page 836
- "Column filtering in the Browser" on page 27

### GOTO

**NOTE:** This functionality is available for all platforms.

The Goto dialog box lets you move to a specific line or column in your script.

#### Important Notes

None

The table below describes the options on the Goto dialog box:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Line Number</td>
<td>Lets you type or select the target line number.</td>
</tr>
</tbody>
</table>

#### Completing the Goto Dialog Box

To complete the Goto dialog box, do the following:

1. On the Edit menu, click Goto.

   Rapid SQL opens the Go To dialog box.
2. In Line Number, type or select the target line number.
3. Click OK.
   Rapid SQL moves the cursor to the target line.
For more information, see ISQL Editor.

**SENDING SQL SCRIPTS**

If you have MAPI-compliant E-mail software installed on your computer, then you can send SQL scripts to other users.

To send a SQL script, do the following:

1. On the File menu, click Send.
   OR
   On the Main tool bar, click Send.
   Rapid SQL opens your E-mail application.
2. In the Address box, type the name of the addressee(s) and any other options.
   NOTE: The ISQL Editor automatically attaches a file containing your SQL script to the e-mail message.
3. Click Send.
   Rapid SQL sends the result set to the specified addressee(s).
For more information, see ISQL Editor.

**RENAMEING AND CLOSING QUERY WINDOW TABS**

SQL windows are tabbed windows that can be closed or renamed.

To rename a Query Tab, you need an open SQL window that includes an executed script. For information on how to execute scripts, see:

- Executing Scripts
- Script Execution Facility
Renaming a Query Window Tab
To rename a Query Window Tab, do the following:

1 Right-click the Query Tab on the SQL window, and then click Rename.
   Rapid SQL opens the Rename Tab dialog box.
   **NOTE:** The Query Tab can be located on the top or bottom of the SQL window. You can set
   the location of the tab when configuring Datasource options.

2 In the New Name box, type the name of the new Query window.
3 Click OK.
   Rapid SQL changes the name and closes the Rename Tab dialog box. The new name of the
   tab displays directly on the Query Window Tab at the top of the window.

Closing a Query Window Tab
To close a Query Window Tab, do the following:

1 At the top of the ISQL window, right-click the Query Tab, and then click Close or Close All.
   Rapid SQL closes the Query.
For more information, see ISQL Editor.

PRINT
   **NOTE:** This functionality is available for all platforms.

The Print dialog box lets you can specify a range of panels to print, or print the contents of a
script window to a file.

Important Notes
None

The table below describes the options and functionality on the Print dialog box.

<table>
<thead>
<tr>
<th>Tab</th>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scope</td>
<td>Printer</td>
<td>Displays default printer.</td>
</tr>
<tr>
<td></td>
<td>Print Range</td>
<td>Lets you select the appropriate print range.</td>
</tr>
<tr>
<td></td>
<td>Number of Copies</td>
<td>Lets you click the Up or Down arrow or type the number of copies you want.</td>
</tr>
<tr>
<td>Page Setup</td>
<td>Header</td>
<td>Lets you type header type to display at the top of the page.</td>
</tr>
</tbody>
</table>
The table below describes the buttons on the Print dialog box:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Footer</td>
<td>Lets you type header type to display at the bottom of the page.</td>
<td></td>
</tr>
<tr>
<td>Header/Footer not within Margins</td>
<td>Select to position header and footer outside the margins.</td>
<td></td>
</tr>
<tr>
<td>Margins</td>
<td>Lets you specify margins in either inches or centimeters.</td>
<td></td>
</tr>
<tr>
<td>Options</td>
<td>Chromacoding</td>
<td>Lets you select Use Color if you have a color printer. Lets you select Use Font if script includes italics and bold fonts.</td>
</tr>
<tr>
<td>Line Numbering</td>
<td>Lets you specify the interval between numbered lines.</td>
<td></td>
</tr>
<tr>
<td>Other Options</td>
<td>Lets you select other options.</td>
<td></td>
</tr>
<tr>
<td>Documents</td>
<td>Document Box</td>
<td>Lets you select documents to print.</td>
</tr>
<tr>
<td></td>
<td>Clear</td>
<td>Click to clear list.</td>
</tr>
<tr>
<td></td>
<td>Invert</td>
<td>Click to switch printing order.</td>
</tr>
<tr>
<td>Configurations</td>
<td>New Configuration Name</td>
<td>Lets you type a new configuration which saves you current settings, and then click Create.</td>
</tr>
<tr>
<td></td>
<td>Delete</td>
<td>Lets you delete an existing configuration.</td>
</tr>
<tr>
<td></td>
<td>Load</td>
<td>Lets you load an existing configuration.</td>
</tr>
<tr>
<td></td>
<td>Update</td>
<td>Lets you update an existing configuration.</td>
</tr>
</tbody>
</table>

For more information, see [Completing the Print Dialog Box](#).
COMPLETING THE PRINT DIALOG BOX
To complete the Print dialog box, do the following:

1. On the File menu, click Print.
   OR
   On the Main tool bar, click Print.

2. On the tabs, select options.

3. Click Print.

For more information, see ISQL Editor.

SAVING AND CLOSING SCRIPTS
Untitled scripts are named SQL1…SQLn by default, and all scripts are saved with the SQL extension. You can save your files with any valid name.

For more information, see:
- Saving a Script
- Closing a Script
- About the Error pane
- ISQL Editor

SAVING A SCRIPT
To complete the Save dialog box, do the following:

1. On the File menu, click Save.
   OR
   On the Main tool bar, click Save.

   Rapid SQL opens the Save As dialog box.

2. If this is a new file, in the File Name box, type the name of the file.

3. If this is an existing file and you want to use save as, on the Main menu, click Save As, and in the File Name box, type the name of the file.

4. Click Save.

   Rapid SQL closes the Save As dialog box.

For more information, see Saving and Closing Scripts.
SAVING MODIFIED DOCUMENTS
The table below describes the options and functionality on the Save Modified Documents dialog box:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Save All</td>
<td>Click to save documents in all open ISQL windows.</td>
</tr>
<tr>
<td>Save Selected</td>
<td>Click to save selected documents.</td>
</tr>
<tr>
<td>Invert</td>
<td>Click to clear selection.</td>
</tr>
<tr>
<td>Save None</td>
<td>Click to not save documents and close the application.</td>
</tr>
</tbody>
</table>

Important Notes
None
For more information, see Saving and Closing Scripts.

CLOSING A SCRIPT
To close a script, do the following:

1. On the Main menu, click Close.
   OR
   On the ISQL window tool bar, click Close.
   OR
   In the upper right corner of the window, double-click the System menu icon.
   Rapid SQL starts closing the script.

2. If you have not saved your script, Rapid SQL prompts you to save the file. Click Yes to save and No to close without saving.

For more information, see Saving and Closing Scripts.

ABOUT THE ERROR PANES
You can view errors currently present in an ISQL editor window in a separate pane. The error pane provides a dynamic, line-by-line listing of the following error types:

- **Semantic** - errors in specified object names. Semantic problems persist in the Error pane until they are corrected. For more information, see Semantic Validation.
• **Syntactic** - syntax problems associated with the SQL dialect of the data source to which the ISQL Editor session is connected. Syntax problems persist in the Error pane until they are corrected. For more information, see [Syntax Checking](#).

• **Execution** - errors detected the last time the script was executed in the current ISQL editor window. Execution errors persist in the Error pane until they are refreshed by a subsequent execution.

A single menu command toggles the error pane open and closed.

**To open or close the error pane:**

1. On the Query menu, select *Show Errors*.

For more information, see [ISQL Editor](#).

---

**EDITING SCRIPTS**

The ISQL Window incorporates a powerful editor that lets you edit your SQL scripts. The ISQL Window includes editing features such as:

- Uppercase or lowercase character conversion.
- Commenting and uncommenting blocks of text.
- Selecting text.
- Inserting PL/SQL tags.
- Setting and navigating with bookmarks.

The ISQL Editor provides [Paste SQL Syntax](#) and [Paste SQL Statements](#) utilities from which you can paste syntax for SQL commands and functions directly into an ISQL Window.

**Editing a Script**

To edit a script, do the following:

1. In the SQL window, type your changes or additions.

2. When you are finished with your changes, on the ISQL window tool bar, click *Execute* to compile the script.

For more information, see [ISQL Editor](#).

---

**PASTE SQL SYNTAX**

**NOTE:** This functionality is available for all platforms.
The Paste SQL Syntax facility lets you paste SQL syntax without having to refer to documentation to find syntax for SQL commands. You can also paste the SQL directly into an ISQL window. The Paste SQL Syntax facility that includes SQL syntax for:

- Commands
- Functions
- XML
- Other object syntax

**Important Notes**

None

The table below describes the options and functionality on the SQL Syntax dialog box.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SQL Statements</td>
<td>Lets you select the target command, functions, or optimizer hint.</td>
</tr>
<tr>
<td>Syntax</td>
<td>Displays the syntax.</td>
</tr>
<tr>
<td>Paste Button</td>
<td>Click to paste the SQL statement into your ISQL Window.</td>
</tr>
</tbody>
</table>

**NOTE:** You must change the placeholders (e.g., expression) in the statements to reflect the specific objects in your database. For assistance with basic SQL statements, such as Select, Insert, Update, or Delete, use the Paste SQL Statement facility instead.

The table below describes options for each RDBMS platform:

<table>
<thead>
<tr>
<th>RDBMS Platform</th>
<th>Oracle SQL Commands</th>
<th>Sybase ASE SQL Commands</th>
<th>Microsoft SQL Commands</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number Functions</td>
<td>Aggregate Functions</td>
<td>Aggregate Functions</td>
<td></td>
</tr>
<tr>
<td>Character Functions</td>
<td>Datatype Conversion Functions</td>
<td>Datatype Conversion Functions</td>
<td></td>
</tr>
<tr>
<td>Date Functions</td>
<td>Date Functions</td>
<td>Date Functions</td>
<td></td>
</tr>
<tr>
<td>Conversion Functions</td>
<td>Mathematical Functions</td>
<td>Mathematical Functions</td>
<td></td>
</tr>
<tr>
<td>Group Functions</td>
<td>String Functions</td>
<td>String Functions</td>
<td></td>
</tr>
<tr>
<td>Other Functions (User, NVL, etc.)</td>
<td>System Functions</td>
<td>System Functions</td>
<td></td>
</tr>
<tr>
<td>Optimizer Hints</td>
<td>System Diagnostics</td>
<td>Text/Image Functions</td>
<td></td>
</tr>
</tbody>
</table>

For more information, see [Completing the SQL Syntax Dialog Box](#).
COMPLETING THE SQL SYNTAX DIALOG BOX
To complete the SQL Syntax dialog box, do the following:

1. Place your insertion point in an open SQL window.
2. On the Edit menu, click Paste SQL Syntax.
   OR
   On the ISQL Window tool bar, click Paste SQL Syntax.
3. In SQL Statements, select the target command, functions, or optimizer hint.
4. To paste the SQL statement into your ISQL Window, click Paste.

For more information, see Editing Scripts.

PASTE SQL STATEMENTS

NOTE: The functionality is available for all platforms.

The Paste SQL Statement facility lets you create Select, Insert, Update, and Delete SQL statements. The Paste SQL Statement window displays all available database object names from which you can choose to construct SQL statements. These statements are dependent on the object type you choose.

Important Notes
None

The table below describes the options and functionality on the Paste SQL dialog box.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Datasource</td>
<td>Lets you select the target datasource.</td>
</tr>
<tr>
<td>Database</td>
<td>Lets you select the target database.</td>
</tr>
<tr>
<td>Owner</td>
<td>Lets you select the owner.</td>
</tr>
<tr>
<td>Object Type</td>
<td>Lets you select the target object type.</td>
</tr>
<tr>
<td>Select</td>
<td>Click if you want a SELECT SQL statement.</td>
</tr>
<tr>
<td>Update</td>
<td>Click if you want an UPDATE SQL statement.</td>
</tr>
<tr>
<td>Insert</td>
<td>Click if you want an INSERT SQL statement.</td>
</tr>
<tr>
<td>Delete</td>
<td>Click if you want a DELETE SQL statement.</td>
</tr>
</tbody>
</table>
For more information, see **Completing the Paste SQL Dialog Box**.

### Completing the Paste SQL Dialog Box

To complete the Paste dialog box, do the following:

1. Place your insertion point in an open Editor window.
2. On the Edit menu, click Paste SQL.
   - OR
   - On the Editor window tool bar, click Paste SQL.
3. In Datasource, select the target datasource.
4. In Database, select the target database.
5. In Owner, select the owner.
6. In Object Type, select the target object type.
7. Click Select if you want a SELECT SQL statement.
8. Click Update if you want an UPDATE SQL statement.
9. Click Insert if you want an INSERT SQL statement.
Click Delete if you want a DELETE SQL statement.

In the Object Type Box, select the check box next to the target object type, or click All to select all.

Click Paste to paste this object into your Editor window.

In the Middle Box, click the target object type properties or click All to select all.

Click Paste to paste the object properties into your Editor window, under the Object Type box.

Rapid SQL the SQL statement in the right box.

In the Right Box, click Paste when you are satisfied with the entire SQL statement.

Rapid SQL pastes the SQL statement into your Editor window.

For more information, see Editing Scripts.

SELECTING TEXT
The ISQL Editor lets you select a single word, a single line, or a block of text.

Selecting a Single Word
To select a single word, do the following:

1. In the ISQL Editor window, position the pointer in the word and double-click.

Selecting a Line of Text
Rapid SQL offers two ways to select a line of text:

1. In the ISQL Editor window, click the line number listed on the left side of the window.

   OR

2. Position the pointer at the beginning of the line of text, hold down the SHIFT key, and then click the end of the line of text.

Selecting a Block of Text
To select a block of text, do the following:

1. In the ISQL Editor window, drag until the block of text is selected.

For more information, see Editing Scripts.
MOVING AND COPYING TEXT IN AN ISQL WINDOW
You can move or copy information anywhere in an Editor window or into a different Editor window by dragging it.

Moving Text
To move text, do the following:
1. In the ISQL Editor window, select the text you want to move.
2. Drag to the target location.

Copying Text
To copy text, do the following:
1. In the ISQL Editor window, select the text you want to copy.
2. On the Edit menu, click Copy.
3. Drag to the target location.

NOTE: If you are dragging between different Editor windows, arrange the Editor windows so that the source and destination windows are open and visible. You must be able to see both the original and target locations.

For more information, see Editing Scripts.

COMMENTING AND UNCOMMENTING SCRIPTS
For most developers and development teams, documenting code is a fundamental part of the coding process. Besides contributing explanatory material for others who need to analyze or maintain your code later, the ability to comment and uncomment code can be very useful for bypassing statements in a procedure during compilation.

Commenting Code
To commenting out code, do the following:
1. On the Edit menu, click Comment Out.

OR
Select a line of code, and on the Edit tool bar, click Comment Out.

Rapid SQL comments code.
**Uncommenting Code**
To uncomment code, do the following:

1. On the Edit menu, click *Undo Comment Out*.
   
   OR
   
   Select a line of code, and on the Edit tool bar, click *Undo Comment Out*.
   
   Rapid SQL uncomments code.

For more information, see *Editing Scripts*.

**CHANGING CASE**
When writing SQL scripts, you can change the letter casing of certain statements or lines of code. You can change case from lowercase to uppercase, or from uppercase to lowercase, using the case functions.

**Changing Case**
To change case, do the following:

1. Select one or more letters in your script.

2. On the Edit menu, click Upper Case.
   
   OR
   
   On the *Edit* menu, click *Lower Case*.
   
   OR
   
   On the *Edit* tool bar, click *Upper Case*.
   
   OR
   
   On the *Edit* tool bar, click *Lower Case*.
   
   Rapid SQL changes the case.

For more information, see *Editing Scripts*.

**CUTTING, COPYING AND PASTING TEXT AND COLUMNS IN AN ISQL WINDOW**
The Editor window incorporates Cut, Copy and Paste text, and whole columns functions. You can move the selected text or columns to and from the Windows clipboard.

For more information, see:

*Copying and Pasting Text*

*Cutting and Pasting Text*

*Copying and Pasting a Column*
Cutting and Pasting a Column

COPYING AND PASTING TEXT
To copy and paste text, do the following:

1. In the Editor window, select the target text.
2. On the Edit menu, click Copy.
   OR
   On the Editor tool bar, click Copy.
   Rapid SQL copies the text.
3. On the Edit menu, click Paste.
   OR
   On the Editor tool bar, click Paste.
   Rapid SQL pastes the text.

For more information, see Cutting, Copying and Pasting Text and Columns in an ISQL Window.

CUTTING AND PASTING TEXT
To cut and paste text, do the following:

1. In the Editor window, select the target text.
2. On the Edit menu, click Cut.
   OR
   On the Editor tool bar, click Cut.
   Rapid SQL cuts the text.
3. On the Edit menu, click Paste.
   OR
   On the Editor tool bar, click Paste.
   Rapid SQL pastes the text.

For more information, see Cutting, Copying and Pasting Text and Columns in an ISQL Window.

COPYING AND PASTING A COLUMN
To copy and paste a column, do the following:

1. In the Editor window, position the pointer in front of the column of the target text.
2. Press ALT and simultaneously drag the pointer over the target column.
3 On the Edit menu, click Copy.
   OR
   On the Editor tool bar, click Copy.
   OR
   Right-click the text, and then click Copy.
   Rapid SQL copies the column.
4 In the Editor window, position the pointer where you want to paste the column.
5 On the Edit menu, click Paste.
   OR
   On the Editor tool bar, click Paste.
   OR
   Right-click the text, and then click Paste.
   Rapid SQL pastes the column.

For more information, see Cutting, Copying and Pasting Text and Columns in an ISQL Window.

CUTTING AND PASTING A COLUMN
To cut and paste a column, do the following:
1 In the Editor window, position the pointer in front of the column of the target text.
2 Press ALT and simultaneously drag the pointer over the target.
3 On the Edit menu, click Cut.
   OR
   On the Editor tool bar, click Cut.
   OR
   Right-click the text, and then click Cut.
   Rapid SQL cuts the column.
4 In the Editor window, position the pointer where you want to paste the column.
5 On the Edit menu, click Paste.
   OR
   On the Editor tool bar, click Paste.
   OR
   Right-click the text, and then click Paste.
   Rapid SQL pastes the column.
For more information, see Cutting, Copying and Pasting Text and Columns in an ISQL Window.

**SETTING BOOKMARKS**

Bookmarks are useful tools for navigating throughout an Editor window. You can jump back and forth between bookmarks easily, and there is no practical limit to the number of bookmarks you can set.

The table below describes the options for setting bookmarks:

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bookmarks:</td>
<td>Bookmarks are valuable navigation aids for jumping from one portion of a script to another. You can add bookmarks in important areas of your scripts, then jump back and forth between bookmarks.</td>
</tr>
</tbody>
</table>

Setting a Bookmark

To set a bookmark, do the following:

1. In the Editor window, position the pointer in front of the line you want to bookmark.
2. On the Editor window tool bar, click Bookmark.
   - Rapid SQL inserts a blue dot in the gutter next to the line you have book marked.

For more information, see:

- Moving Between Bookmarks
- Clearing Bookmarks

Moving Between Bookmarks

You use the Next Bookmark and the Previous Bookmark buttons to move back and forth between bookmarks.

Goto the Next Bookmark

To goto the next bookmark, do the following:

1. In the Editor window, position the pointer where you have set bookmarks, and then click Bookmark.
   - Rapid SQL jumps to the next bookmark.
Goto the Previous Bookmark
To goto the previous bookmark, do the following:

1. In the Editor window, position the pointer where you have set bookmarks, and then click Goto Bookmark.
   
   Rapid SQL jumps to the previous bookmark.

For more information, see Setting Bookmarks.

CLEARING BOOKMARKS
To clear bookmarks, do the following:

1. On the Editor tool bar, click Clear Bookmark.
   
   Rapid SQL clears all bookmarks.

   **NOTE:** This does not clear any error indicators (red dots) that might be showing in the gutter.

For more information, see Setting Bookmarks.

EXECUTING SCRIPTS
The ISQL Editor lets you execute all or part of your SQL scripts. Unless you are executing large scripts that have multiple statements within them, or you need to view optimizer statistics, you execute most of your SQL scripts without options.

**NOTE:** For Oracle Client 8.0.5, if you execute a multi-line SQL statement with an error in the syntax, the cursor does not jump to the line of the error.

The ISQL Editor incorporates multiple features to refine and ease script execution. The table below describes these features:

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Script Execution Facility</strong></td>
<td>The Script Execution Facility lets you execute scripts in parallel against multiple datasources. The facility also lets you schedule a job to perform the script execution at the appointed time, which saves development time and ensures accuracy and integrity across your databases.</td>
</tr>
<tr>
<td><strong>Executing the Current Statement</strong></td>
<td>Executes the statement in which the cursor is currently placed.</td>
</tr>
<tr>
<td><strong>Step Execution Facility</strong></td>
<td>The Step Execution Facility processes batches from one delimiter to the next.</td>
</tr>
<tr>
<td><strong>Query Plan</strong></td>
<td>The Query Plan Facility provides a graphical display that lets you identify the execution path that your SQL follows. Rapid SQL’s Query Plan window now displays data for the estimated costs, number of rows, and bytes returned by each plan step.</td>
</tr>
</tbody>
</table>
Executing a Script
To execute a script, do the following:

1. On the Editor window tool bar, click Execute.

   OR

   In the Editor window, right-click, and then click Execute.

   Rapid SQL starts executing the script.

Executing Partial Scripts
To execute a partial script, select the portion of the script to be executed and follow the steps outlined above. This feature is helpful while debugging large scripts and stored procedures.

SCRIPT EXECUTION FACILITY
Rapid SQL has a Script Execution Facility that lets you run parallel queries against multiple datasources. This facility is also a stand-alone utility that is available from the utilities tool bar. If used as a stand-alone utility, you can directly type your script or copy and paste a script in an additional tab. Once you have selected the desired options, Rapid SQL establishes multiple threads and database connections to run the script simultaneously against the selected target datasources. Additionally, ANSI SQL scripts can run against multiple datasources from different DBMS vendors.

The Script Execution Facility runs with two output modes:
- Graphical
- File

Graphical output mode opens multiple result windows, one for each target datasource.

File output mode sends all output to a specified file or files. This feature allows for the execution of scripts against a large number of target datasources in a single operation and enables scheduling capabilities.

Once the scripts have finished executing, you have the option to send a notification message indicating that the script execution has completed via e-mail or Net Send. This message includes attachments of all the output files generated.

For more information, see Executing Scripts Against Multiple Datasources.
EXECUTING SCRIPTS AGAINST MULTIPLE DATASOURCES
To execute scripts against multiple datasources, do the following:

1. On the Utilities menu, click Script Execution Facility.
   OR
   On the Utilities tool bar, click Script Execution Facility.
   OR
   On the Editor window tool bar, click Script Execution Facility.

The table below describes the options and functionality on the Script Execution Facility dialog box.

**NOTE:** This option is not available for a DDL Editor or PL/SQL Editor. To execute a script from a DDL or a PL/SQL Editor, use the stand-alone Script Execution Facility.

2. If you selected File output:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Script</td>
<td>Lets you type, copy and paste, or cut and paste a script.</td>
</tr>
<tr>
<td>Target</td>
<td>Only Connected Datasources - Select to see only your currently connected datasources. All DBMS Types - Select to see all DBMS types. In the Datasource grid, select the check boxes next to the datasources against which you want to run your query, or click Select All to select all datasources. Database - Lets you type the name of the target database.</td>
</tr>
<tr>
<td>Output</td>
<td>Specify how you want the output to be handled Graphical Output - Select for graphical output. File Output - Select for file output. In the Directory box, type the full path and directory name in which you want to place the output file, or click Browse File icon to locate the directory. Click the File Type list to specify the file type you want to apply to the output file. Include column titles when saving - Select to include column titles in your saved file. Open files with registered applications - Select to open the files with registered application.</td>
</tr>
<tr>
<td>Notify</td>
<td>Job Description - Lets you type a job description to supply a subject in your e-mail message. E-mail addresses - Lets you type the e-mail address(es) separated by semi-colons. Net Send User Names - Lets you type the Net Send user name(s) separated by semi-colons.</td>
</tr>
</tbody>
</table>
COMPILATION ERROR TAB
Rapid SQL displays any errors encountered when a package, function or procedure was last compiled by a user in a separate tab of those object editors. The Errors Tab provides the line number, column position and error message for each compilation error.

For more information, see Executing Scripts.

COMMAND HISTORY
The ISQL Editor is equipped with a command history box, which lets you keep a history of previously used SQL commands. The Command History is a list that is available in the Results window. Command history lets you go back and run previously used commands from the list rather than opening or inserting a script.

Executing from Command History
To execute from Command History, do the following:

1  In the Results window, click the Command History list, and then click the command you want to execute.

   The Query window is automatically populated with the selected command.

2  To execute the command, click Execute.

For more information, see Executing Scripts.

CANCELING A QUERY
The ISQL Editor lets you cancel a query while the rows are still being returned.

Canceling a Query
To cancel a query, do the following:

1  On the Editor window tool bar, click Cancel.

   NOTE: This button is only enabled after a script has begun executing.
For more information, see Executing Scripts.

STEP EXECUTION FACILITY

Step execution of scripts is an invaluable method to debug your scripts. The Step Execution facility lets you step through each batch in your script. While some batches can include many lines of code, some batches can consist of one line. Rapid SQL parses the statements and moves from batch to batch during the step execution process, each step controlled by you clicking the step execution button.

The table below describes how Rapid SQL provides a number of useful tools for working with step execution of your scripts:

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ISQL Window Gutter</td>
<td>The ISQL Window Gutter is a vertical gray display bar located to the left of the ISQL window. It includes location indicators such as line numbers, error indicators, and bookmarks. The gutter is a quick visual cue to your current position in the script.</td>
</tr>
<tr>
<td>Script Line Numbers</td>
<td>Line numbers are included to let you navigate large scripts. Error messages in the output window indicate the line number where the error occurred.</td>
</tr>
<tr>
<td>Automatic Error Flagging</td>
<td>When using the Step Execution mode, Rapid SQL flags errors with a red dot in the ISQL window gutter. The errors are flagged sequentially as they are stepped into.</td>
</tr>
<tr>
<td>Point and Click Error Navigation</td>
<td>Rapid SQL displays errors in the output window at the bottom of the screen and selects the errors as they occur. You can click each error and Rapid SQL takes you directly to the line where that error occurred.</td>
</tr>
<tr>
<td>Step</td>
<td>Click the Step button to step into the next batch of code.</td>
</tr>
<tr>
<td>Step Back</td>
<td>Click the Step Back icon to step back to the most previous batch of code.</td>
</tr>
<tr>
<td>Step Over</td>
<td>Click the Step Over icon to jump over a batch to the next batch.</td>
</tr>
<tr>
<td>Run to Cursor</td>
<td>Click the Run to Cursor icon to execute all of the code between the beginning of the script to wherever you have inserted the pointer.</td>
</tr>
<tr>
<td>Cancel Step Execution</td>
<td>Click the Cancel Step Execution icon to change to regular execution mode.</td>
</tr>
</tbody>
</table>

For more information, see Using the Step Execution Facility.
**Using the Step Execution Facility**

Rapid SQL offers three ways to use the step execution facility:

1. Open a script.
2. On the Query menu, click *Step-Execute*.
   
   OR
   
   On the Editor window tool bar, click Step-Execute.
   
   OR
   
   Right-click, and then click, Step-Execute.

Rapid SQL starts the procedure and displays errors at the bottom of the Editor window.

**NOTE:** Rapid SQL indicates each executing line with a yellow arrow in the gutter of the Editor window. The gutter is that gray area between the line numbers on the left and the code window. As you step through your batches, Rapid SQL moves the arrow to indicate your current location.

3. To continue stepping through the script, on the Editor window tool bar, click Step, which displays in the Editor window after you have started the Step Execute procedure.
4. To step back, on the Editor window tool bar, click Step Back, which displays in the Editor window after you have started the Step Execute procedure.
5. To step over a batch and execute the next batch, on the Editor window tool bar, click Step Over, which displays in the Editor window after you have started the Step Execute procedure.
6. To stop Step Execution mode, on the Editor window tool bar, click Stop Step Execute, which displays in the Editor window after you have started the Step Execute procedure.
7. To Run to Cursor, on the Editor window tool bar, click Run to Cursor, which is available when the pointer is in the Editor window.

For more information, see *Executing Scripts*.

**Executing the Current Statement**

The *Execute Statement* command lets you execute an individual statement where statements in the script are terminated with a valid delimiter (`;` or `/`).

**NOTE:** The *Execute Statement* command is only available if the Scan entire file for context option in the Options Editor is selected. For details, see "[ISQL Options - Code Assist - Advanced Tab](#)" on page 117.

To execute a delimiter-terminated statement

1. Place the cursor anywhere within the statement.
2. From the Query menu, select *Execute Statement*. 
The statement is executed and if results are returned, the Results Editor opens. For details, see "Using the Results Editor" on page 832.

As a visual aid, Rapid SQL highlights the executed statement.

```
SELECT * FROM ADMINISTRATOR.DEPARTMENT;
SELECT * FROM ADMINISTRATOR.EMPLOYEE;
SELECT * FROM ADMINISTRATOR.CUSTOMER;
```

For similar options and context information, see "Execution and Execution-related SQL Editor options" on page 814.

**USING THE QUERY PLAN FACILITY**

Each RDBMS platform lets you view the execution path that your SQL follows. For details, see the following topics:

- Viewing a tree-based Query Plan (IBM DB2 for LUW, SQL Server, Sybase ASE)
- Viewing a graphical Query Plan (Oracle)

**VIEWING A TREE-BASED QUERY PLAN (IBM DB2 FOR LUW, SQL SERVER, SYBASE ASE)**

For IBM DB2 for Windows, Unix, and Linux, Microsoft SQL Server, and Sybase ASE, Rapid SQL lets you view a tree-based representation of a query plan. The Query Plan toolbar button is a toggle. Set it to enable the Show Plan mode.

Rapid SQL’s Query Plan window displays data for the estimated costs, number of rows, and bytes returned by each plan step.

**NOTE:** For IBM DB2 for Linux, Unix, and Windows, Rapid SQL includes a tree view of statements and associated costs.

**To view a tree-based representation of a query plan**

1. Open a script.
2. On the Query menu, click Query Plan.
   
   Rapid SQL starts the Show Plan mode.
3. To generate the Show Plan in a separate result window, click Execute.

For more information, see Query options.

**VIEWING A GRAPHICAL QUERY PLAN (ORACLE)**

For Oracle, Rapid SQL lets you view a graphical representation of a query plan. You can toggle the view between the graph-based view and a tree-based view, view details for each step, and work with a number of viewing options.

The Query Plan toolbar button is a toggle. Set it to enable the Show Plan mode.
To view a graphical representation of a query plan

1. Open a script.
2. On the Query menu, click Query Plan.
   Rapid SQL starts the Show Plan mode.
3. To generate the Show Plan in a separate result window, click Execute.

Options when working with the Query Plan facility include:

- Hovering the mouse over an execution step node to display detailed cost details for that step
- Right-clicking and choosing Find Node or Find Next Node to search large plans for nodes whose label contains a specified text string
- Right-clicking and choosing Zoom In or Zoom Out
- Right-clicking and choosing an Orientation sub-menu command to change the orientation of the view
- Right-clicking and choosing Overview Window to open a small window showing the entire plan
- Right-clicking and choosing Save to File to open a dialog that lets you save the graphical plan as a graphics file
- Clicking the Query Plan button to toggle between the graphical view and a tree-based view
- For multiple plans created from the same script/ISQL window, using the dropdown at the top of the plan to change the plan displayed

QUERY OPTIONS

Rapid SQL offers a set of options corresponding to DBMS-specific query options. They let you customize the execution environment for an ISQL session with query-handling directives in areas such as performance, logging/reporting, and error handling.

See the following topics for descriptions of the options available for the DBMS you are working against:

- DB2 LUW Query options
- DB2 z/OS Query options
- MySQL Query options
- Oracle Query options
- SQL Server Query options
- Sybase ASE Query options
• **Sybase IQ Query options**

If you do not change the default settings, Rapid SQL will use a set of default query option settings to send to the server, one set per DBMS platform. You can, however, save a set of query option settings for each DBMS, and have that set of settings used as the default for ISQL sessions against that platform. As well, during any ISQL session, you can modify the query option settings for the current session.

The query options you select apply only to the current ISQL window instance. In addition, non-default query option settings you specify are not saved. You can however, save a set of query option settings to a file and subsequently open that file in other ISQL editor sections to have those settings applied to that session.

To specify query options:

1. With the SQL Editor open, select **Query Options** from the **Query** menu.
   
   Once open, you have the following options:

   • Set each option manually using the associated check box. For detailed descriptions of query options, see [When query options are sent to the server](#).
   
   • Use the Save button to open a dialog that lets you save the current option query settings to an XML file. The dialog also has a Load these query options as default option that lets you use the settings in the saved file as the default query option settings for the current platform. Exercising this option sets the Load Query Options feature on the DBMS-specific ISQL tab of the Options editor to specify the file you saved. For more information, see [ISQL Options](#).
   
   • Use the Load button to open a dialog that lets you locate and open a previously-saved XML file containing query option settings.
   
   • Use the Reset button to restore the Rapid SQL query option defaults.

2. Click **OK** to set query options for the current ISQL window session.

   **NOTE:** For information on conditions for which query options are sent to the server, see [When query options are sent to the server](#).

**When query options are sent to the server**

Rapid SQL optimizes sending query options to the server for locked connections. Since an unlocked connection results in a new connection for each execution, query options must be sent with each execution. The following table outlines the specific cases:

<table>
<thead>
<tr>
<th>Session unlocked</th>
<th>When you open an ISQL window, if you not lock the connection, all query options are sent to the server each time you execute a script, immediately before executing the actual script. As long as the connection remains unlocked, all query options are sent to the server at each execution. Similarly if you unlock a currently locked session, all query options are sent to the server at each subsequent execution. For information on locking sessions, see <a href="#">Toolbar Options</a>.</th>
</tr>
</thead>
</table>
The following settings are available when setting query options against a DB2 LUW datasource:

<table>
<thead>
<tr>
<th>Category</th>
<th>Query Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Execution Options</td>
<td>Batch Delimiter</td>
<td>The batch separator must be a viewable character and not a space, new line, or tab. The default (semi-colon) has been selected to ensure compatibility with the features of Rapid SQL and the respective platform, but can be customized. Note: A custom delimiter works only from within an ISQL window and can’t be used for extraction operations.</td>
</tr>
<tr>
<td></td>
<td>Check syntax when executing</td>
<td>TRUE/FALSE</td>
</tr>
<tr>
<td></td>
<td>Create Explain plan tables if required</td>
<td>If set to TRUE, Explain Plan tables are created, as necessary. If set to FALSE and you don’t manually create tables, Explain Plan operations will fail.</td>
</tr>
<tr>
<td></td>
<td>Create explain plan tables on the SYSTOOLS schema</td>
<td>If set to TRUE, Explain Plan tables are created on the SYSTOOLS schema. If the tables already exist in the user's default schema, Rapid SQL continues to use those tables. Refer to DB2 documentation for a listing of Explain Plan tables that must be deleted in order to use the SYSTOOLS option. If set to FALSE, Explain Plan tables are created under the user’s default schema.</td>
</tr>
<tr>
<td></td>
<td>Max Errors Before Aborting</td>
<td>Select the maximum number of errors encountered before Rapid SQL aborts a script. Setting this value to zero disables the feature.</td>
</tr>
<tr>
<td></td>
<td>Row Count</td>
<td>When set to TRUE, Rapid SQL terminates the query after returning the specified number of rows.</td>
</tr>
<tr>
<td></td>
<td>Run Script with batch execution</td>
<td>TRUE/FALSE</td>
</tr>
<tr>
<td>Transactions</td>
<td>Isolation Level</td>
<td>Lets you set DB2 Isolation Levels of UNCOMMITTED READ, RESET, CURSOR STABILITY, REPEATABLE READ, or READ STABILITY.</td>
</tr>
<tr>
<td></td>
<td>Prepare Batch</td>
<td>For the current SQL Editor window, setting this check box enables bind variable parameterization. This lets you provide named and unnamed variable values as a script executes. For details, see “Bind Variable Parameterization in Prepared Statements (Dynamic SQL)” on page 711.</td>
</tr>
</tbody>
</table>

For more general information, see Query options.
DB2 z/OS Query Options

The following settings are available when setting query options against a DB2 z/OS datasource:

<table>
<thead>
<tr>
<th>Query Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Batch Delimiter</td>
<td>The batch separator must be a viewable character and not a space, new line, or tab. The default (semi-colon) has been selected to ensure compatibility with the features of Rapid SQL and the respective platform, but can be customized. Note: A custom delimiter works only from within an ISQL window and can’t be used for extraction operations.</td>
</tr>
<tr>
<td>Check syntax when executing</td>
<td>TRUE/FALSE</td>
</tr>
<tr>
<td>Max Errors Before Aborting</td>
<td>Select the maximum number of errors encountered before Rapid SQL aborts a script. Setting this value to zero disables the feature.</td>
</tr>
<tr>
<td>Row Count</td>
<td>When set to TRUE, Rapid SQL terminates the query after returning the specified number of rows.</td>
</tr>
<tr>
<td>Run Script with batch execution</td>
<td>TRUE/FALSE</td>
</tr>
<tr>
<td>Prepare Batch</td>
<td>For the current SQL Editor window, setting this check box enables bind variable parameterization. This lets you provide named and unnamed variable values as a script executes. For details, see &quot;Bind Variable Parameterization in Prepared Statements (Dynamic SQL)&quot; on page 711.</td>
</tr>
</tbody>
</table>

For more general information, see Query options.

InterBase/Firebird Query Options

The following settings are available when setting query options against an InterBase/Firebird datasource:

<table>
<thead>
<tr>
<th>Query Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Batch Delimiter</td>
<td>A delimiting character used to separate multiple SQL statements within a statement batch.</td>
</tr>
<tr>
<td>Prepare Batch</td>
<td>For the current SQL Editor window, setting this check box enables bind variable parameterization. This lets you provide named and unnamed variable values as a script executes. For details, see &quot;Bind Variable Parameterization in Prepared Statements (Dynamic SQL)&quot; on page 711.</td>
</tr>
</tbody>
</table>

MySQL Query Options

The following settings are available when setting query options against a MySQL datasource:

<table>
<thead>
<tr>
<th>Query Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Batch Delimiter</td>
<td>The batch separator must be a viewable character and not a space, new line, or tab. The default (semi-colon) has been selected to ensure compatibility with the features of Rapid SQL and the respective platform, but can be customized. Note: A custom delimiter works only from within an ISQL window and can’t be used for extraction operations.</td>
</tr>
<tr>
<td>Query Option</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Big Tables</td>
<td>When set to TRUE, allows big result sets by saving all temporary sets to file. This can slow queries.</td>
</tr>
<tr>
<td>Client Character</td>
<td>Default character set.</td>
</tr>
<tr>
<td>Insert ID</td>
<td>Choose a value to be used a following INSERT or ALTER TABLE statement when you supply an AUTO_INCREMENT value.</td>
</tr>
<tr>
<td>Interactive Timeout</td>
<td>28800 default</td>
</tr>
<tr>
<td>Last Insert ID</td>
<td>Set the value to be stored in the binary log when you use LAST_INSERT_ID() in a statement that updates a table.</td>
</tr>
<tr>
<td>Max Errors Before Aborting</td>
<td>Select the maximum number of errors encountered before Rapid SQL aborts a script. Setting this value to zero disables the feature.</td>
</tr>
<tr>
<td>Query Cache Type</td>
<td>The query is cached for ON or DEMAND.</td>
</tr>
<tr>
<td>Row Count</td>
<td>When set to TRUE, Rapid SQL terminates the query after returning the specified number of rows.</td>
</tr>
<tr>
<td>SET Other Variables</td>
<td>Variables to be set at runtime.</td>
</tr>
<tr>
<td>SQL Auto IS NULL</td>
<td>When set to TRUE, enables you to find the last inserted row for a table.</td>
</tr>
<tr>
<td>SQL Big Selects</td>
<td>When set to TRUE, SELECT statements likely to take a very long time to execute will be aborted (i.e., where the number of rows examined exceeds the max join size)</td>
</tr>
<tr>
<td>SQL Big Tables</td>
<td>TRUE/FALSE</td>
</tr>
<tr>
<td>SQL Buffer Result</td>
<td>When set to TRUE, forces results from SELECT statements into temporary tables.</td>
</tr>
<tr>
<td>SQL Log Bin</td>
<td>When set to TRUE, allows logging to the binary log.</td>
</tr>
<tr>
<td>SQL Log Off</td>
<td>When set to TRUE, no logging is done to the general query log.</td>
</tr>
<tr>
<td>SQL Log Update</td>
<td>When set to TRUE, allows logging to the binary log.</td>
</tr>
<tr>
<td>SQL Low Priority Updates</td>
<td>When set to TRUE, gives table modifying operations lower priority than SELECT operations.</td>
</tr>
<tr>
<td>SQL Max Join Size</td>
<td>When set to TRUE, you can catch SELECT statements where keys are not used properly and that would probably take a long time. Set it if your users tend to perform joins that lack a WHERE clause, that take a long time, or that return millions of rows.</td>
</tr>
<tr>
<td>SQL Quote Show Create</td>
<td>When set to TRUE, table and column names will be quoted.</td>
</tr>
<tr>
<td>SQL Safe Updates</td>
<td>When set to TRUE, the query aborts UPDATE or DELETE statements that do not use a key in the WHERE clause or a LIMIT clause. This makes it possible to catch UPDATE or DELETE statements where keys are not used properly and that would probably change or delete a large number of rows</td>
</tr>
<tr>
<td>SQL Select</td>
<td>The maximum number of records that should be returned from SELECT statements.</td>
</tr>
<tr>
<td>SQL Warnings</td>
<td>Defines whether or not single row insert statements generate an information string in the event of a warning.</td>
</tr>
<tr>
<td>Transaction Isolation</td>
<td>Repeatable Read is the default. Read Committed, Read Uncommitted, and Serializable are the other options. Refer to MS SQL Query Options dialog box for an explanation.</td>
</tr>
<tr>
<td>Unique Checks</td>
<td>Performs uniqueness checks for secondary indexes of MyISAM tables.</td>
</tr>
<tr>
<td>Prepare Batch</td>
<td>For the current SQL Editor window, setting this check box enables bind variable parameterization. This lets you provide named and unnamed variable values as a script executes. For details, see “Bind Variable Parameterization in Prepared Statements (Dynamic SQL)” on page 711.</td>
</tr>
</tbody>
</table>
For more general information, see [Query options](#).

**ORACLE QUERY OPTIONS**

The following settings are available when setting query options against an Oracle datasource:

<table>
<thead>
<tr>
<th>Category</th>
<th>Query Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Query Analysis</td>
<td>Network Activity</td>
<td>True/False</td>
</tr>
<tr>
<td></td>
<td>Execution Information</td>
<td>True/False</td>
</tr>
<tr>
<td></td>
<td>I/O Activity</td>
<td>True/False</td>
</tr>
<tr>
<td></td>
<td>Sort Activity</td>
<td>TRUE/FALSE</td>
</tr>
<tr>
<td></td>
<td>Index Activity</td>
<td>True/False</td>
</tr>
<tr>
<td></td>
<td>Parse Activity</td>
<td>TRUE/FALSE</td>
</tr>
<tr>
<td></td>
<td>Table Activity</td>
<td>True/False</td>
</tr>
<tr>
<td></td>
<td>OS Activity</td>
<td>TRUE/FALSE</td>
</tr>
<tr>
<td></td>
<td>Wait Activity</td>
<td>True/False</td>
</tr>
<tr>
<td>Miscellaneous</td>
<td>Batch Delimiter</td>
<td>The batch separator must be a viewable character and not a space, new line, or tab. The default (“/”) has been selected to ensure compatibility with the features of Rapid SQL and the respective platform, but can be customized. Note: A custom delimiter works only from within an ISQL window and can’t be used for extraction operations.</td>
</tr>
<tr>
<td></td>
<td>Check syntax when executing</td>
<td>TRUE/FALSE</td>
</tr>
<tr>
<td></td>
<td>LONG Size Bytes</td>
<td>8,192 is the default</td>
</tr>
<tr>
<td></td>
<td>Max Errors Before Aborting</td>
<td>Select the maximum number of errors encountered before Rapid SQL aborts a script. Setting this value to zero disables the feature.</td>
</tr>
<tr>
<td></td>
<td>Row Count</td>
<td>When set to TRUE, Rapid SQL terminates the query after returning the specified number of rows.</td>
</tr>
<tr>
<td></td>
<td>Run Script with batch execution</td>
<td>TRUE/FALSE</td>
</tr>
<tr>
<td></td>
<td>Prepare Batch</td>
<td>For the current SQL Editor window, setting this check box enables bind variable parameterization. This lets you provide named and unnamed variable values as a script executes. For details, see <a href="#">“Bind Variable Parameterization in Prepared Statements (Dynamic SQL)” on page 711</a>.</td>
</tr>
</tbody>
</table>

For more general information, see [Query options](#).
## SQL Server Query Options

The following settings are available when setting query options against a SQL Server datasource:

<table>
<thead>
<tr>
<th>Category</th>
<th>Query Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Query Analysis</td>
<td>Show Plan</td>
<td>When set to TRUE, reports data retrieval methods chosen by the Microsoft SQL Server query optimizer.</td>
</tr>
<tr>
<td></td>
<td>No Count</td>
<td>Terminates the message indicating the number of rows affected by a Transact-SQL statement from being returned as part of the results.</td>
</tr>
<tr>
<td></td>
<td>No Exec</td>
<td>When set to TRUE, compiles each query without executing it.</td>
</tr>
<tr>
<td></td>
<td>Force Plan</td>
<td>When set to TRUE, processes a join in the same order as tables appear in the FROM clause of a SELECT statement only.</td>
</tr>
<tr>
<td></td>
<td>Statistics I/O</td>
<td>Lets you display information regarding the amount of disk activity generated by Transact-SQL statements.</td>
</tr>
<tr>
<td></td>
<td>Statistics Time</td>
<td>Displays the number of milliseconds required to parse, compile, and execute each statement.</td>
</tr>
<tr>
<td></td>
<td>Parse Only</td>
<td>When set to TRUE, checks the syntax of each Transact-SQL statement and returns any error messages without compiling or executing the statement. When TRUE, makes Microsoft SQL Server only parse the statement. When FALSE, makes Microsoft SQL Server compile and execute the statement. Do not use Parse Only in a stored procedure or a trigger.</td>
</tr>
<tr>
<td>Arithmetic</td>
<td>Ignore Overflow</td>
<td>When set to TRUE, Rapid SQL will ignore any overflow caused by a resulting value that is larger than a column's specified size.</td>
</tr>
<tr>
<td></td>
<td>Abort On Overflow</td>
<td>If set to TRUE, queries will be aborted on encountering a value greater than the specified size.</td>
</tr>
<tr>
<td>SET Options</td>
<td></td>
<td>The Send Set Options setting dictates whether the remaining ANSI SQL Options in this category are sent to the server. The default for this option is set using the Enable SET query options setting on the ISQL tab of the Options editor. For details, see ISQL Options. If the Send Set Options setting is enabled, the remaining settings in this category let you specify the specific ANSI SQL options that are sent to the server: ansi_defaults, ansi_nulls, ansi_null_dflt_on, QUOTED IDENTIFIER, cursor_close_on_commit, ANSI_PADDING, ANSI WARNINGS, IMPLICIT_TRANSACTIONS, and CONCAT_NULL_YIELDS_NULL. The initial default values are hard-coded, not obtained from server settings.</td>
</tr>
</tbody>
</table>
## Transactions

<table>
<thead>
<tr>
<th>Query Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| Isolation Level    | Read Committed: Microsoft SQL Server default transaction isolation level. Specifies that shared locks are held while data is read to avoid dirty reads. You can change the data before the end of the transaction, resulting in nonrepeatable reads or phantom data.  
Read Uncommitted: The lowest level of transaction isolation. Transactions are isolated to ensure that physically corrupt data is not read. Applies dirty read, or isolation level 0 locking, which ensures that no shared locks are issued and no exclusive locks are honored.  
If set, it is possible to read uncommitted or dirty data values in the data can be changed and rows can appear or disappear in the data set before the end of the transaction.  
Repeatable Read: Places locks on all data used in a query, preventing other users from updating the data. Other users can insert new phantom rows into the data and are included in later reads in the current transaction.  
Concurrency is lower than Read Committed. Use this option only when necessary.  
Serializable: The highest level of transaction isolation. Transactions are completely isolated from one another. Places a range lock on the data set, preventing other users from updating or inserting rows into the data set until the transaction is complete.  
Concurrency is lower than Repeatable Read. Use this option only when necessary. |

## Miscellaneous

<table>
<thead>
<tr>
<th>Query Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| Batch Delimiter       | The batch separator must be a viewable character and not a space, new line, or tab. The default ("go") has been selected to ensure compatibility with the features of Rapid SQL and the respective platform, but can be customized.  
Note: A custom delimiter works only from within an ISQL window and can't be used for extraction operations. |
| Max Errors Before Aborting | Select the maximum number of errors encountered before Rapid SQL aborts a script. Setting this value to zero disables the feature. |
| Row Count             | When set to TRUE, Rapid SQL terminates the query after returning the specified number of rows.                                                                 |
| Run Script with batch execution | TRUE/FALSE                                                                                                                                 |
| Text Size             | 8,192 is the default                                                                                                                           |
| Prepare Batch         | For the current SQL Editor window, setting this check box enables bind variable parameterization. This lets you provide named and unnamed variable values as a script executes. For details, see "Bind Variable Parameterization in Prepared Statements (Dynamic SQL)" on page 711. |

For more general information, see [Query options](#).
SYBASE ASE QUERY OPTIONS

The following settings are available when setting query options against a Sybase ASE datasource:

<table>
<thead>
<tr>
<th>Category</th>
<th>Query Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Query Analysis</td>
<td>Show Plan</td>
<td>When set to TRUE, reports data retrieval methods chosen by the Microsoft SQL Server query optimizer.</td>
</tr>
<tr>
<td></td>
<td>No Count</td>
<td>Terminates the message indicating the number of rows affected by a Transact-SQL statement from being returned as part of the results.</td>
</tr>
<tr>
<td></td>
<td>No Exec</td>
<td>When set to TRUE, compiles each query without executing it.</td>
</tr>
<tr>
<td></td>
<td>Statistics I/O</td>
<td>Lets you display information regarding the amount of disk activity generated by Transact-SQL statements.</td>
</tr>
<tr>
<td></td>
<td>Statistics Time</td>
<td>Displays the number of milliseconds required to parse, compile, and execute each statement.</td>
</tr>
<tr>
<td></td>
<td>Statistics Subquery Cache</td>
<td>Displays the number of cache hits, misses, and the number of rows in the subquery cache for each subquery.</td>
</tr>
<tr>
<td></td>
<td>Force Plan</td>
<td>When set to TRUE, processes a join in the same order as tables appear in the FROM clause of a SELECT statement only.</td>
</tr>
<tr>
<td></td>
<td>Prefetch</td>
<td>When set to TRUE, enables large I/Os to the data cache. When set to FALSE, disables large I/Os to the data cache.</td>
</tr>
<tr>
<td></td>
<td>Parse Only</td>
<td>When set to TRUE, checks the syntax of each Transact-SQL statement and returns any error messages without compiling or executing the statement. When TRUE, makes Microsoft SQL Server only parse the statement. When FALSE, makes Microsoft SQL Server compile and execute the statement. Do not use Parse Only in a stored procedure or a trigger.</td>
</tr>
<tr>
<td>Transactions</td>
<td>Chained</td>
<td>Invokes a begin transaction before the following statements: delete, insert, open, fetch, select, and update. You must still explicitly close the transaction with a commit.</td>
</tr>
<tr>
<td>Isolation Level</td>
<td>0</td>
<td>1: Sybase default isolation level. Prevents dirty reads. 2: Prevents dirty and non-repeatable reads. 3: Prevents dirty and non-repeatable reads and phantoms. This level is equivalent to performing all selects with holdlock.</td>
</tr>
<tr>
<td>Arithmetic</td>
<td>Ignore Overflow</td>
<td>When set to TRUE, Rapid SQL will ignore any overflow caused by a resulting value that is larger than a column’s specified size.</td>
</tr>
<tr>
<td></td>
<td>Abort On Overflow</td>
<td>If set to TRUE, queries will be aborted on encountering a value greater than the specified size.</td>
</tr>
<tr>
<td></td>
<td>Abort On Truncation</td>
<td>Specifies behavior following a loss of scale by an exact numeric datatype during an implicit datatype conversion. When set to TRUE, a statement that causes the error is aborted but other statements in the transaction or batch continue to be processed. When set to FALSE, Rapid SQL truncates the query results and continues processing.</td>
</tr>
<tr>
<td>Category</td>
<td>Query Option</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------</td>
<td>-----------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>DBCC Traceflags</td>
<td>Index Selection</td>
<td>Valuable when tuning query performance.</td>
</tr>
<tr>
<td></td>
<td>Join Selection</td>
<td>Valuable when tuning query performance.</td>
</tr>
<tr>
<td></td>
<td>Output to Execution Window</td>
<td>TRUE/FALSE</td>
</tr>
<tr>
<td></td>
<td>Output to Server Error Log</td>
<td>TRUE/FALSE</td>
</tr>
<tr>
<td>Miscellaneous</td>
<td>ANSI NULL</td>
<td>When set to TRUE, controls results of logical operations with NULL values.</td>
</tr>
<tr>
<td></td>
<td>Set Quoted Identifier</td>
<td>TRUE/FALSE</td>
</tr>
<tr>
<td></td>
<td>Batch Delimiter</td>
<td>The batch separator must be a viewable character and not a space, new line, or tab. The default (“go”) has been selected to ensure compatibility with the features of Rapid SQL and the respective platform, but can be customized. Note: A custom delimiter works only from within an ISQL window and can’t be used for extraction operations.</td>
</tr>
<tr>
<td></td>
<td>Row Count</td>
<td>When set to TRUE, Rapid SQL terminates the query after returning the specified number of rows.</td>
</tr>
<tr>
<td></td>
<td>Table Count</td>
<td>Sets the number of tables that Sybase ASE considers at one time while optimizing a join.</td>
</tr>
<tr>
<td></td>
<td>Text Size</td>
<td>8,192 is the default</td>
</tr>
<tr>
<td></td>
<td>Max Errors Before Aborting</td>
<td>Select the maximum number of errors encountered before Rapid SQL aborts a script. Setting this value to zero disables the feature.</td>
</tr>
<tr>
<td></td>
<td>Run Script with batch execution</td>
<td>TRUE/FALSE</td>
</tr>
</tbody>
</table>
For more general information, see [Query options](#).

### SYBASE IQ QUERY OPTIONS

The following settings are available when setting query options against a Sybase IQ datasource:

<table>
<thead>
<tr>
<th>Query Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Send SET Options</td>
<td>The Send SET Options setting applies to all settings except those in the bottom-most Miscellaneous category. It dictates whether the child options are sent to the server. The default for this option is set using the Enable SET query option setting on the ISQL tab of the Options editor. For details, see <a href="#">ISQL Options</a>.</td>
</tr>
<tr>
<td>Query Option</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Isolation Level</td>
<td>Specifies the locking isolation level for Catalog Store tables.</td>
</tr>
<tr>
<td>Allow Nulls By Default</td>
<td>Sets the ALLOW_NULLS_BY_DEFAULT option, controlling whether new columns created without specifying either NULL/NOT NULL are allowed to contain NULL values.</td>
</tr>
<tr>
<td>ANSI Null</td>
<td>Sets the ANSINULL option, controlling the interpretation of using = and != with NULL.</td>
</tr>
<tr>
<td>Conversion Error</td>
<td>Sets the CONVERSION_ERROR option, controlling reporting of data type conversion failures on fetching information.</td>
</tr>
<tr>
<td>Divide-by-zero Error</td>
<td>Sets the DIVIDE_BY_ZERO_ERROR option, controlling reporting of division by zero.</td>
</tr>
<tr>
<td>SET quoted_identifier</td>
<td>Sets the QUOTED_IDENTIFIER option, controlling the interpretation of strings enclosed in double quotes.</td>
</tr>
<tr>
<td>SQL Flagger Error Level</td>
<td>Sets the SQL_FLAGGER_ERROR_LEVEL option, controlling the behavior in response to any SQL code that is not part of the specified standard.</td>
</tr>
<tr>
<td>SQL Flagger Warning Level</td>
<td>Sets the SQL_FLAGGER_WARNING_LEVEL option, controlling the response to any SQL that is not part of the specified standard.</td>
</tr>
<tr>
<td>String R-Truncation</td>
<td>Sets the STRING_RTRUNCATION option, determining whether an error is raised when an INSERT or UPDATE truncates a CHAR or VARCHAR string.</td>
</tr>
<tr>
<td>T-SQL Variables</td>
<td>Sets the TSQL_VARIABLES option, controlling whether the @ sign can be used as a prefix for Embedded SQL host variable names.</td>
</tr>
<tr>
<td>Disable RI Check</td>
<td>Sets the DISABLE_RI_CHECK option, allowing LOAD, INSERT, UPDATE, or DELETE operations to bypass the referential integrity check to improve performance.</td>
</tr>
<tr>
<td>Early Predicate Execution</td>
<td>Sets the EARLY_PREDICATE_EXECUTION option, controlling whether simple local predicates are executed before query optimization.</td>
</tr>
<tr>
<td>Extended Join Syntax</td>
<td>Sets the EXTENDED_JOIN_SYNTAX option, controlling whether queries with an ambiguous syntax for multi-table joins are allowed or reported as an error.</td>
</tr>
<tr>
<td>Index Advisor</td>
<td>Sets the INDEX_ADVISOR option, generating messages suggesting additional column indexes that may improve performance of queries.</td>
</tr>
<tr>
<td>Index Advisor Max Rows</td>
<td>Sets the INDEX_ADVISOR_MAX_ROWS option, setting the maximum number of unique advice messages stored by the index advisor.</td>
</tr>
<tr>
<td>Infer Subquery Predicates</td>
<td>Sets the INFER_SUBQUERY_PREDICATES option, controlling the optimizer's inference of additional subquery predicates.</td>
</tr>
<tr>
<td>Join Optimization</td>
<td>Sets the JOIN_OPTIMIZATION option, enabling or disabling the optimization of the join order.</td>
</tr>
<tr>
<td>Large Doubles Accumulator</td>
<td>Sets the LARGE_DOUBLES_ACCUMULATOR option, controlling which accumulator to use for SUM or AVG of floating-point numbers.</td>
</tr>
<tr>
<td>Minimize Storage</td>
<td>Sets the MINIMIZE_STORAGE option, minimizing use of disk space for newly created columns.</td>
</tr>
<tr>
<td>No Exec</td>
<td>Sets the NOEXEC option, generating the optimizer query plans instead of executing the plan.</td>
</tr>
<tr>
<td>Non ANSI NULL Varchar</td>
<td>Sets the NON_ANSI_NULL_VARCHAR option, controlling whether zero-length VARCHAR data is treated as NULLs for INSERT, ILOAD, and UPDATE operations.</td>
</tr>
<tr>
<td>On Charset Conversion Error</td>
<td>Sets the ON_CHARSET_CONVERSION_FAILURE option, controlling the action taken on a character conversion error.</td>
</tr>
<tr>
<td>Query Name</td>
<td>Sets the QUERY_NAME option, giving a name to an executed query in its query plan.</td>
</tr>
<tr>
<td>Query Detail</td>
<td>Sets the QUERY_DETAIL option, specifying whether additional query information is included in the Query Detail section of the query plan.</td>
</tr>
</tbody>
</table>
### Query Options

<table>
<thead>
<tr>
<th>Query Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Query Plan</td>
<td>Sets the QUERY_PLAN option, specifying whether or not additional query plans are printed to the message file.</td>
</tr>
<tr>
<td>Query Plan After Run</td>
<td>Sets the QUERY_PLAN_AFTER_RUN option, printing the entire query plan after query execution is complete.</td>
</tr>
<tr>
<td>Query Plan as HTML</td>
<td>Sets the QUERY_PLAN_AS_HTML option, generating graphical query plans in HTML format.</td>
</tr>
<tr>
<td>Query Plan as HTML Directory</td>
<td>Sets the QUERY_PLAN_AS_HTML_DIRECTORY option, specifying the directory into which Sybase IQ writes HTML query plans.</td>
</tr>
<tr>
<td>Query Rows Returned Limit</td>
<td>Sets the QUERY_ROWS_RETURNED_LIMIT option, setting the row threshold for rejecting queries based on an estimated size of the result set.</td>
</tr>
<tr>
<td>Query TempSpace Limit</td>
<td>Sets the QUERY_TEMP_SPACE_LIMIT option, specifying the maximum estimated amount of temp space before rejecting a query.</td>
</tr>
<tr>
<td>Query Timing</td>
<td>Sets the QUERY_TIMING option, determining whether specific timing statistics are collected and displayed.</td>
</tr>
<tr>
<td>Batch Delimiter</td>
<td>A delimiting character used to separate multiple SQL statements within a statement batch.</td>
</tr>
<tr>
<td>Row Count</td>
<td>Lets you limit the number of rows returned by a query.</td>
</tr>
<tr>
<td>Max Errors Before Aborting</td>
<td>Lets you limit the number of errors returned before aborting a query.</td>
</tr>
<tr>
<td>Run Script With Batch Execution</td>
<td>When selected, scripts are executed statement by statement (batch delimited).</td>
</tr>
<tr>
<td>Prepare Batch</td>
<td>For the current SQL Editor window, setting this check box enables bind variable parameterization. This lets you provide named and unnamed variable values as a script executes. For details, see &quot;Bind Variable Parameterization in Prepared Statements (Dynamic SQL)&quot; on page 711.</td>
</tr>
</tbody>
</table>

For more general information, see [Query options](#).

### Result Options

The Result Options dialog box lets you set the SQL Results Window options. The table below describes Results options:

<table>
<thead>
<tr>
<th>Interface Element</th>
<th>Option</th>
<th>Description</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Result Window</td>
<td>Single Window</td>
<td>Displays all results in one tabbed result window. Multiple result sets are appended together in the window. Single Window and Multiple Windows options are mutually exclusive.</td>
<td>Selected</td>
</tr>
</tbody>
</table>
**Using the Token Matching Capability**

When you are working with a large script with multiple levels of embedded steps, compare left and right parentheses, curly braces, square brackets and BEGIN/END pairs to make sure that you have delimited your code properly.

The Token Matching capability of Rapid SQL helps you achieve clean code.
Finding Matching Tokens
To find matching tokens, do the following:

1. Position the insertion pointer just to the left of the first token in a token pair you want to locate.
2. Click Match Token.

   Rapid SQL jumps the pointer to the next available token.

For more information, see Query Plan Facility.

RESULTS EDITOR

The results of your SQL queries are displayed in the Results Tab of each Editor Window, which captures result sets in a virtual data grid that accommodates large result sets. The data grid offers many of the features of a basic Windows spreadsheet, giving you a great deal of flexibility in editing the worksheet and formatting its contents.

**TIP:** For Oracle, Rapid SQL displays REF CURSOR contents in the ISQL Window and Results Tab.

You have many choices for navigating and viewing your SQL query results. The Results window includes functionality to set result window options, find and replace, export data to other products such as Microsoft Excel, and mail your results files.

For more information, see Configuring Result Set Windows.

CONFIGURING RESULT SET WINDOWS

Result set windows can be configured in a variety of ways. You can configure your result set windows to present result sets in multiple or single panels, attached or detached from the corresponding ISQL window. These options can be set globally to save you the hassle of setting options for each result window. Additionally, Result windows can be torn off and dropped onto an open area of the workspace to create separate windows. These are known as Tear Off Tab Windows.

You can set the Result Window to display result sets in any of the following modes:

- Single result sets in one attached tab window.
- Multiple result sets in one attached tab window.
- Single result sets in one separate unattached tab windows.
- Multiple result sets in one separate unattached tab windows.
- Tear Off Tab windows.
**VIEWING MULTIPLE RESULT SETS IN SEPARATE UNATTACHED WINDOWS**  
To set the option to have multiple result sets displayed in multiple unattached windows, do the following:

1. On the **File** menu, click **Options**.
   
   **OR**
   
   On the **Main** tool bar, click **Options**.
   
   Rapid SQL opens the **Options Editor**.

2. In the Options Editor, click the list, and then click **Results** or click the **Results Tab**.

3. In the **Results Window grid**, click the **Multiple Windows** option.

4. In the **Results Window grid**, click the **Unattached** option.

5. Click **OK**.

   Rapid SQL saves the settings and closes the Options Editor.

For more information, see [Configuring Result Set Windows](#).

---

**VIEWING MULTIPLE RESULT SETS IN ONE ATTACHED TAB WINDOW**  
To set the option to have multiple result sets displayed in one attached tab window, do the following:

1. On the **File** menu, click **Options**.
   
   **OR**
   
   On the **Main** tool bar, click **Options**.
   
   Rapid SQL opens the **Options Editor**.

2. In the Options Editor, click the list, and then click **Results** or click the **Results Tab**.

3. In the **Results Window grid**, click the **Multiple Windows** option.

4. In the **Results Window grid**, click the **Attached to Editor** option.

5. Click **OK**.

   Rapid SQL saves the settings and closes the Options Editor.

For more information, see [Configuring Result Set Windows](#).
VIEWING SINGLE RESULT SETS IN ONE SEPARATE UNATTACHED WINDOW
To set the option to have a single result set displayed in one unattached window, do the following:

1. On the File menu, click Options.
2. In the Options Editor, click the list, and then click Results or click the Results Tab.
3. In the Results Window grid, click the Single Window option.
4. Click OK.

Rapid SQL saves the settings and closes the Options Editor.

For more information, see Configuring Result Set Windows.

VIEWING SINGLE RESULT SETS IN ONE ATTACHED TAB WINDOW
To set the option have all SQL query results displayed in a single attached tab window, do the following:

1. On the File menu, click Options.
2. In the Options Editor, click the list, and then click Results or click the Results Tab.
3. In the Results Window grid, click the Multiple Windows option.
4. In the Results Window grid, click the Attached to Editor option.
5. To re-use the same result set window for subsequent result sets, select the Reuse window check box. This option is only valid for single, attached result windows.
6. Click OK.

Rapid SQL saves the settings and closes the Options Editor.

For more information, see Configuring Result Set Windows.
**EXPORTING DATA TO OTHER PRODUCTS**
You can export data from a result set to traditional spreadsheet products, such as Microsoft Excel. You can copy part or all of a result set and paste it into your traditional spreadsheet product by way of the Microsoft Windows Clipboard function. You can also save your result sets as tab delimited files, comma separated files or as HTML tables. HTML tables can be opened in your default Internet browser. Tab delimited files and CSV files can be opened in any spreadsheet or word processing program.

**NOTE:** Rapid SQL supports pipe delimited ("|" ) files when you save result sets.

For more information, see *Results Editor*.

**SETTING RESULT WINDOWS TO READ ONLY MODE**
To set your result windows to read only mode to keep anyone from accidentally editing or altering a result set, do the following:

1. Select a *Result* window that you want to make read only.
2. On the Edit menu, click *Read Only*.

Rapid SQL places a check-mark next to read only and sets the command.

**NOTE:** The Read Only command is a toggle. When it is set, the formatting buttons on the Edit menu are not available.

For more information, see *Results Editor*.

**RESULT WINDOW STATUS BAR**
The Result Window Status Bar displays information about each Result window at the bottom of each window. You can display or hide the status bar by setting the Status Bar preference. This preference applies to all result windows.

For more information, see *Results Editor*.

**MAILING RESULT SETS**
If you have MAPI-compliant electronic mail software installed on your computer, then you can mail result sets to other users.
Mailing a Result Set
To mail a result set, do the following:

1. Open the Message dialog box:
2. On the *File* menu, click *Send*.

   OR
   On the *File* tool bar, click *Send*.
   Rapid SQL opens the open Message dialog box.
3. In the *Address* box, type the name of the addressee(s) and any other options.
   The ISQL Editor automatically attaches a file containing your result set to the mail message.
4. Click *Send*.
   Rapid SQL sends the result set to the specified addressee(s).

For more information, see *Results Editor*.

CLOSING AND RENAMING RESULT WINDOW TABS
Rapid SQL lets you close or rename tabbed Result set windows.

Renaming a Result Window Tab
To rename a Result Window Tab, do the following:

1. Place your pointer over the Results Tab.
2. Right-click the Results Tab, and then click *Rename*.
   Rapid SQL opens the Rename Tab Editor.
3. In the *New Name* box, type the new name.
4. Click OK.
   Rapid SQL changes the name and closes the Rename Tab Editor.

Closing a Result Window Tab
To close a Result Window Tab, do the following:

1. On the *Result Window Tab* tool bar, click *Close*.

   OR
   Right-click the Results Tab, and then click *Close*.
   Rapid SQL closes the Result Window Tab.
SAVING AND CLOSING RESULT SETS
You can save your result sets using the standard Save and Save As functions. You can save multiple copies of the same result set and modify each copy to specific formatting requirements.

Saving Results
To save results, do the following:
1. On the File menu, click Save.
   OR
   On the Main tool bar, click Save.
   Rapid SQL opens the Save Results dialog box.
2. In the File name box, type the name of the result set.
3. In Save as type, select the file type.
   TIP: You can now save data in Excel 2000 or later .xls, user-specified delimited .txt, and XML formats.
4. To include column titles, select Include column titles when saving.
5. For delimited results, in User Specified Delimiter type the delimiter.
6. Click Save.
   Rapid SQL saves the file and closes the Save As dialog box.

Closing a Result Set
To close a result set, do the following:
1. On the Main menu, click Close.
   OR
   On the Result tool bar, click Close.
   OR
   In the upper-right corner of the window, double-click the System menu icon.
   Rapid SQL closes the Result Set.
2. If you have not saved your result set, Rapid SQL prompts you to save the file. Click Yes to save and No to close without saving.

For more information, see Results Editor.
EDITING RESULT SETS
The Results Editor provides many ways to edit and customize your result windows. The Data Grid offers a host of features for manipulating, sorting and formatting data.

Topics
- Cutting, Copying, and Pasting Cell Contents
- Cutting, Copying, and Pasting Rows
- Cutting, Copying, and Pasting Columns
- Adding and Inserting Rows
- Adding and Inserting Columns
- Deleting Rows and Column
- Resizing Rows and Columns
- Sorting Data

CUTTING, COPYING, AND PASTING CELL CONTENTS
The Result window supports standard cut, copy and paste functionality.

Cutting Cell Contents
To cut cell contents, do the following:

1. In the Results window, double click or tab to the target cell. A double line bounds the selected cell. You can also select text using standard text selection techniques.

2. On the Edit menu, click Cut.
   OR
   On the Result tool bar, click Cut.
Rapid SQL cuts the cell.
Copying Cell Contents
To copy cell contents, do the following:

1. In the Results window, double click or tab to the target cell. A double line bounds the selected cell. You can also select text using standard text selection techniques.

2. On the Edit menu, click Copy.
   OR
   On the Result tool bar, click Copy.
   Rapid SQL copies the cell.

Pasting Cell Contents
To paste cell contents, do the following:

1. In the Results window, double click or tab to the target cell. A double line bounds the selected cell.

2. On the Edit menu, click Paste.
   OR
   On the Result tool bar, click Paste.
   Rapid SQL pastes the cell.

For more information, see Editing Result Sets.

Cutting, Copying, and Pasting Rows
You can perform standard cut, copy, and paste functions on rows, just as you can on individual cells.

Cutting Rows
To cut a row, do the following:

1. In the Results window, click the numbered row heading on the left side of the row.

2. On the Edit menu, click Cut.
   OR
   On the Result tool bar, click Cut.
   Rapid SQL cuts the row.
Copying Rows
To copy rows, do the following:
1. In the Results window, double click or tab to the target row. A double line bounds the selected row. You can also select text using standard text selection techniques.
2. On the Edit menu, click Copy.
   OR
   On the Result tool bar, click Copy.
   Rapid SQL copies the row.

Pasting Rows
To paste rows, do the following:
1. In the Results window, double click or tab to the target row. A double line bounds the selected row.
2. On the Edit menu, click Paste.
   OR
   On the Result tool bar, click Paste.
   Rapid SQL pastes the row.
For more information, see Editing Result Sets.

Cutting, Copying, and Pasting Columns
You can perform standard cut, copy, and paste functions on columns, just as you can on rows.

Cutting Columns
To cut columns, do the following:
1. In the Results window, click the column heading above the first row.
2. On the Edit menu, click Cut.
   OR
   On the Result tool bar, click Cut.
   Rapid SQL cuts the column.
Copying Columns
To copy columns, do the following:
1. In the Results window, click the column heading.
2. On the Edit menu, click Copy.
   OR
   On the Result tool bar, click Copy.
   Rapid SQL copies the column.

Pasting Columns
To paste columns, do the following:
1. In the Results window, click the column heading above the first row to select the target column.
2. On the Edit menu, click Paste.
   OR
   On the Result tool bar, click Paste.
   Rapid SQL pastes the column.
For more information, see Editing Result Sets.

Adding and Inserting Rows
You can add or insert rows to expand or rearrange your result sets.

Adding a Row
To add a row, do the following:
1. To add a row as the last row of the result set, position the pointer inside the result set.
2. On the Edit menu, click Add Row.
3. To add a row inside the result set, click the numbered row heading where you want to add a row.
4. On the Edit menu, click Add Row.

Inserting a Row
To insert a row, do the following:
1. To insert a row as the last row of the result set, position the pointer inside the result set.
2. On the Edit menu, click Insert Row.
3. To insert a row inside the result set, click the numbered row heading where you want to insert a row.

4. On the Edit menu, click Insert Row.

For more information, see Editing Result Sets.

**ADDING AND INSERTING COLUMNS**

You can add or insert columns to expand or rearrange your result sets.

**Adding a Column**

To add a column, do the following:

1. Position the pointer inside the result set.
2. Select Edit, Add Column from the main menu. The new column is added as the last column of the result set.

**Inserting a Column**

To insert a column, do the following:

1. Select the column where you want to insert a column.
2. Select Edit, Insert Column from the main menu. The new column is inserted to the left of the column that you selected.

For more information, see Editing Result Sets.

**DELETING ROWS AND COLUMNS**

You can delete entire rows and columns to edit your result sets.

**Deleting a Row**

To delete a row, do the following:

1. Select the target row of data to delete.
2. On the Edit menu, click Delete Row.

   OR

   Right-click the row, and then click Delete Row.

   Rapid SQL deletes the row.
Deleting a Column
To delete a column, do the following:

1. Select the target column of data to delete.
2. On the Edit menu, click Delete Column.

OR

Right-click the column, and then click Delete Column.

Rapid SQL deletes the column.

For more information, see Editing Result Sets.

RESIZING ROWS AND COLUMNS
Resizing rows and columns can aid readability of the spreadsheet contents or condense space for editing and formatting purposes.

Resizing Rows to Their Default Height
To resize rows to their default height, do the following:

1. Select one or more rows by clicking on the numbered row headings to the left of the rows.
2. Right-click the selected rows, and then click Resize Rows.

Resizing Rows to a New Height
To resize rows to a new height, do the following:

1. Select one or more rows by clicking the numbered row headings to the left of the rows.
2. Change the pointer to a solid horizontal bar with arrows on top and bottom by moving it to one of the upper or lower borders of the row heading.
3. Click and grab the row border and drag the pointer to enlarge or shrink the height of the row.

Resizing Columns to Their Default Widths
To resize columns to their default widths, do the following:

1. Select one or more columns by clicking the column headings.
2. Right-click the selected columns, and then click Resize Columns.
**Resizing Columns to a New Width**

To resize columns to a new width, do the following:

1. Select one or more columns by clicking the column headings.
2. Change the pointer to a solid horizontal bar with arrows on top and bottom by moving it to one of the upper or lower borders of the column heading.
3. Click and grab the column border and drag the pointer to enlarge or shrink the height of the column.

For more information, see *Editing Result Sets*.

**SORTING DATA**

To order and organize data in a coherent manner, you can sort columns alphanumerically in single result sets.

**Sorting Data**

To sort data, do the following:

1. In the data grid, select the column(s) you want to sort.
2. Double click the column header(s) to sort the data in the column in ascending, alphanumeric order. To sort the column in descending order, double click the column header again.

   **NOTE:** This option is not valid for multiple result sets.

For more information, see *Editing Result Sets*.

**FORMATTING RESULT SETS**

The ISQL Editor provides flexibility in formatting result sets, for analysis and reporting, from within a Result Window. Result sets can be formatted to best suit your purpose, whether it be sending via e-mail, printing, or exporting a file to other programs, such as Microsoft Excel. Some of these features change only the screen display of the results, while others allow you to format for printing.

**Topics**

- Setting Alignment Properties
- Setting Border Properties
- Setting Result Set Display Properties
- Setting Fonts
- Setting Colors
SETTING ALIGNMENT PROPERTIES IN RESULT WINDOWS

You can use the format menu or the shortcut menu to alter result set alignment properties. Selecting the Alignment command displays the Format Styles tabbed dialog box:

Setting Alignment Properties

To set alignment properties, do the following:

1. On the Format menu, click Alignment.
   OR
   Right-click the Result data grid, and then click Alignment. Rapid SQL opens the Format Styles dialog box.
2. Click the Align Tab.
3. To change Horizontal properties, click the appropriate option button in the Horizontal box.
4. To enable Wrap Text, Allow Enter and/or Auto Size, select the appropriate check boxes.
5. To disable Wrap Text, Allow Enter and/or Auto Size, select the appropriate check boxes and deselect these options.

The table below describes alignment properties:

<table>
<thead>
<tr>
<th>Property</th>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Horizontal</td>
<td>Standard</td>
<td>Aligns data in cells based on their default datatype alignment properties. For example, numbers are right aligned, whereas text is left aligned.</td>
</tr>
<tr>
<td></td>
<td>Left Aligned</td>
<td>Forces all data to be left aligned, regardless of datatype</td>
</tr>
<tr>
<td></td>
<td>Center</td>
<td>Forces centering of all data, regardless of datatype</td>
</tr>
<tr>
<td></td>
<td>Right Aligned</td>
<td>Forces all data to be right aligned, regardless of datatype</td>
</tr>
<tr>
<td>Vertical</td>
<td>Standard</td>
<td>Aligns data in cells based on their default datatype alignment properties. For example, numbers are right aligned, whereas text is left aligned.</td>
</tr>
<tr>
<td></td>
<td>Top</td>
<td>Forces all data to be aligned to the top of each cell</td>
</tr>
<tr>
<td></td>
<td>Center</td>
<td>Forces all data to be aligned in the center of each cell</td>
</tr>
<tr>
<td></td>
<td>Bottom</td>
<td>Forces all data to be aligned at the bottom of each cell</td>
</tr>
<tr>
<td>Wrap Text</td>
<td></td>
<td>Specifies that data exceeding the length of the cell should wrap to additional lines in the same cell</td>
</tr>
<tr>
<td>Allow Enter</td>
<td></td>
<td>Specifies that the contents of cells can be edited or not</td>
</tr>
<tr>
<td>Auto Size</td>
<td></td>
<td>Specifies whether or not rows should size automatically to accommodate the longest data item in a column</td>
</tr>
</tbody>
</table>

For more information, see Formatting Result Sets.
FORMAT BORDER STYLES
You can use the format menu or the shortcut menu to alter border properties. Selecting the Border command displays the Format Styles tabbed dialog box.

Completing the Format Styles Dialog Box
To complete the Format Styles dialog box, do the following:

1. On the Format menu, click Borders.
   OR
   Right-click the Result data grid, and then click Borders. Rapid SQL opens the Format Styles dialog box.

2. Click the Borders Tab.

3. On the Border box, you can indicate whether or not a border should appear on the top, bottom, right, left, or for a range of cells by clicking the corresponding boxes.

4. To set a range of cells apart by setting a particular border style around that range, select the range in the result set before opening the Format Styles dialog box. To select the Range property, click the range box.

5. In the Type box, you can select the type of line you want to border the cell or cells by clicking the corresponding boxes.

6. To select a color, click the Color list, and then click the border color.

7. Click OK.
   Rapid SQL saves your changes and closes the Format Styles dialog box.

For more information, see Formatting Result Sets.

DISPLAY SETTINGS
You can use the format menu or the shortcut menu to alter display properties. Selecting the Properties command displays the Display Setting dialog box.

The Display Settings dialog box lets you set a number of format properties for the result set window:

- How titles and grid lines are displayed.
- How lines in the grid are displayed.
- How the result set window background is displayed.
- How current cells, rows and columns are indicated.
Completing the Display Settings Dialog Box
To complete the Display Settings dialog box, do the following:

1. On the Format menu, click Properties.
   OR
   Right-click the Result data grid, and then click Properties.
   Rapid SQL opens the Display Settings dialog box.
2. In the Titles and Gridlines box, select the target display properties check boxes. The change is displayed in the right-pane Preview window of the Properties dialog box.
3. In the Color box, click the property you want to change, and then click the new color. Changes are propagated automatically when you change them.
4. To alter the user properties, in the User Properties list, click the attribute you want applied to the current cell.
5. To save your changes to the current configuration, select the Save settings to profile check box.
6. Click OK.
   Rapid SQL saves your changes and closes the Properties dialog box.

For more information, see Formatting Result Sets.

FORMAT FONT STYLES
You can use the format menu or the shortcut menu to alter font properties. Selecting the Font command displays the Format Styles tabbed dialog box.

Completing the Format Styles Dialog Box
To complete the Format Styles dialog box, do the following:

1. On the Format menu, click Font.
   OR
   Right-click the Result data grid, and then click Font.
   Rapid SQL opens the Format Styles dialog box.
2. Click the Font Tab.
3. In the Font Combo box, type or click the font you want to use.
4. In the Outline Combo box, type or click the outline you want to use.
5. In the Size Combo box, type or click the size you want to use.
6 To make a line cross through the length of the text, in the Effects box, select the Strikeout check box.

7 To underline the text, in the Effects box, select the Underline check box.

8 To change the text color, click the Text Color list, and then click the new color.
   The Preview box displays the sample text of your selections

For more information, see Formatting Result Sets.

**FORMAT COLOR STYLES**

You can use the format menu or the shortcut menu to alter color properties. Selecting the Color command displays the Format Styles tabbed dialog box.

The table below describes the options and functionality on the Format Styles dialog box:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| Interior | To change the result set pattern, in the box, click the list, and then click a new pattern.  
To set the foreground color of the result set, in the box, click a foreground group color button.  
To set the background color of the result set, in the box, click a background group color button. |
| 3D-Effect | To change the 3D-Effect, in the box, click the appropriate option button:  
The Normal option button provides a standard flat appearance.  
The Raised option button provides a raised 3D appearance in the selected cells.  
The Inset option button provides a depressed appearance in the selected cells. The default is typically set to Normal. |

**Completing the Format Styles Dialog Box**

To complete the Format Styles dialog box, do the following:

1 On the Format menu, click Color.

   OR

   Right-click the Result data grid, and then click Color.

   Rapid SQL opens the Format Styles dialog box.

For more information, see Formatting Result Sets.
NOTES ON XML TYPES AND UNICODE DISPLAY IN THE RESULTS EDITOR

When viewing data in the Results grid, keep the following in mind:

- XML data types are supported for IBM DB2 for Windows, Unix, and Linux, Microsoft SQL Server, and Oracle. In the Results grid, XML data types are displayed as LOB content.

- Support for display of Unicode characters is provided as follows:
  
  - IBM DB2 for Windows, Unix, and Linux: `character`, `clob`, `varchar`, and `longvarchar` types
  
  - SQL Server: `nchar`, `nvarchar`, `ntext`, and `nvarchar(max)` types
  
  - Oracle 9i, and 10g: `NCHAR`, `NVARCHAR2` and `NCLOB` for non-Unicode UTF8 Character Set Instances and `NCHAR`, `NVARCHAR2`, `CHAR`, `VARCHAR2`, `LONG`, `NCLOB` and `CLOB` for Unicode UTF8 Character Set Instances
  
  - Sybase ASE 12.5 and 15.2: `UNICHAR`, `UNIVARCHAR` and `UNITEXT` for non-Unicode UTF8 Character Set Instances and `UNICHAR`, `UNIVARCHAR`, `UNITEXT`, `NCHAR`, `NVARCHAR`, `CHAR`, `VARCHAR` and `TEXT` for Unicode UTF8 Character Set Instances
PERMISSIONS MANAGEMENT

Rapid SQL includes permissions management capabilities that include:

- Explicit Permissions
- Cascading Permissions
- Using Roles to Grant Permissions and Privileges
- Using Roles to Revoke Permissions and Privileges
- Grant Privilege(s) To
- Revoke Privilege(s) From
- Deny Privileges From

EXPLICIT PERMISSIONS

Explicit permissions are permissions specifically granted by one user to another. Granting a permission is an integral part of database security and management. Rapid SQL tracks explicit permission changes across your enterprise. Multiple explicit permissions can be consolidated in roles. Different groups and roles can share permissions for an object. Rapid SQL lets you grant permissions with the Roles Editor. Embarcadero lets you edit permissions on the Privileges tabs of the object editors.

**TIP:** The Admin option is similar to the grantable option for privileges. If the user has the admin option, they can grant that role to other people.

**TIP:** In most cases, you will want to make all roles granted, default roles. If you do not make a role default for a user, they will have to enable it with a SQL command. To avoid this complication, assign roles as default unless business rules specify otherwise.

**TIP:** The Grantable option gives the user the ability to grant that privilege to other users. Use the Grantable option SPARINGLY.

For more information, see Permissions Management.

CASCADING PERMISSIONS

Cascading permissions are the path of privileges granted from one user to another user, group, or role. Using cascading permissions is a way to manage multiple sets of permissions and privileges for groups of users. When you drop a user with a revoke cascade command, all permissions and privileges granted by the dropped user are also revoked. Embarcadero lets you edit and set grant permission parameters with the Permissions Editor.

Once a user with grant permission privileges is dropped with cascade, reinstate permissions for all affected users.
USING ROLES TO GRANT PERMISSIONS AND PRIVILEGES
Roles are sets of user privileges you associate with access to objects within a database. Roles streamline the process of granting permissions. You can use roles to grant sets of permissions and privileges to users and groups. Rapid SQL lets you grant permissions to roles with the Roles Editor.

For more information, see Permissions Management.

USING ROLES TO REVOKE PERMISSIONS AND PRIVILEGES
Roles can be effective in revoking permissions and privileges from users. Rather than individually revoke permissions from users, you can revoke groups of permissions from multiple users simultaneously using roles. Rapid SQL lets you revoke permissions with the Roles Editor.

Rapid SQL lets you identify existing users and their database permissions, and to detect and manage changes to user permissions by rolling change back or forward. Rapid SQL lets you manage database permissions in a cross-platform database environment. and gives you the ability to compare objects/permissions and migrate them to other instances. Using the compare functionality for permissions management, Rapid SQL gives you:

- Enhanced permissions management across the enterprise (Oracle, Sybase ASE, Microsoft SQL Server, and IBM DB2 LUW for Linux, Unix, and Windows).
- Faster detection of changed user rights.
- Ability to detect database accounts (users/logins) that are invalid.
- Rollback of invalid permissions in a single click.
- Archives of users, groups, roles and their permissions.

For more information, see Permissions Management.

GRANT PRIVILEGE(S) TO
The Grant Privilege(s) To dialog box lets you select or clear the check boxes corresponding to the target privileges.

Permissions and privileges allow or limit access to system database administration and database objects. To manage databases, it is important to monitor who can access the enterprise structure and change the underlying schema. It is also important to monitor who can grant and revoke permissions and privileges in the enterprise. Rapid SQL lets you manage permissions and privileges in the Grant Privilege(s) To dialog box.
On the Privileges Tab of the editor, you can see whether a privilege was inherited from a role or group, or if it was granted explicitly by a user. Rapid SQL also shows if the privilege is grantable (granted with the GRANT OPTION.) The table below describes the icons:

**NOTE:** The available privileges depend on the target DBMS and object.

The table below describes the options and functionality on the Grant Privilege(s) From Dialog Box:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Privilege</td>
<td>Lets you select or clear the check boxes corresponding to the target privileges.</td>
</tr>
<tr>
<td>Grantable</td>
<td>Select No to prevent cascading the privileges to other users.</td>
</tr>
</tbody>
</table>

The table below describes the object permissions:

<table>
<thead>
<tr>
<th>Object</th>
<th>Permission(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Index</td>
<td>CONTROL</td>
</tr>
<tr>
<td>Packages</td>
<td>BIND, CONTROL, EXECUTE</td>
</tr>
<tr>
<td>Schema</td>
<td>ALTERIN, CREATIN, DROPIN (w/GRANT OPTION)</td>
</tr>
<tr>
<td>Tables</td>
<td>ALTER, CONTROL, DELETE, INDEX, INSERT, REFERENCES (&amp; on column), SELECT, UPDATE (&amp; on column) (w/GRANT OPTION)</td>
</tr>
<tr>
<td>Tablespaces</td>
<td>USE (w/GRANT OPTION)</td>
</tr>
<tr>
<td>Views</td>
<td>CONTROL, DELETE, INSERT, SELECT, UPDATE (&amp; on column) (w/GRANT OPTION)</td>
</tr>
</tbody>
</table>

For more information, see: [Permissions Management](#)

**REVOKE PRIVILEGE(S) FROM**

The table below describes the options and functionality on the Revoke Privilege(s) From dialog box:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Privilege</td>
<td>Lets you select or clear the check boxes corresponding to the target privileges.</td>
</tr>
<tr>
<td>Cascade</td>
<td>Select No to prevent cascading the revocation privileges to other users.</td>
</tr>
</tbody>
</table>
DENY PRIVILEGES FROM

**NOTE:** Deny Privileges is available for Microsoft SQL Server only.

The Deny Privileges From dialog box lets you deny a privilege from a security account in the current database.

The table below describes the options and functionality on the Deny Privilege(s) From dialog box:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Privilege</td>
<td>Lets you select or clear the check boxes corresponding to the target privileges.</td>
</tr>
<tr>
<td>Cascade</td>
<td>Select No to prevent cascading the deny privileges to other users.</td>
</tr>
</tbody>
</table>

**TIP:** On the editor, the Deny privilege can be Revoked, just as a Grant permission can be revoked.

For more information, see:

Permissions Management
PROJECT MANAGEMENT

Rapid SQL offers the following project management-oriented functions:

- **Project support**
- **Version Control**

PROJECT SUPPORT

Rapid SQL database project management facilities help you organize, alter, and keep track of changes to database objects or SQL scripts. The project management facilities act as a repository to maintain all source code for a database project. Rapid SQL also incorporates version control functions and build management facilities to help you manage and build projects. Once a project has been created, Rapid SQL lets you:

- Review a file's history.
- Return to earlier versions of a file.
- Develop concurrently.

A project generally includes SQL script files that you can maintain and create in unison with your database administration and development cycle. Projects can also contain subfolders (for easy categorization) as well as other projects (subprojects.) You can create projects manually by inserting existing SQL script files. You can also create projects automatically by reverse-engineering a database schema or an existing version control project.

When administering or developing SQL database schemas, SQL source code files are the foundation of effective change management for database objects. The DDL commands used to create database objects on SQL database servers are often in a constant state of flux as new columns and constraints are added to table schemas or stored procedure logic is changed. The ability to track and store these changes to files directly from Rapid SQL alleviates any disruption in the development environment.

Lengthy script files containing the DDL to compile stored procedures and triggers on a database server such as Oracle or Sybase Adaptive Server go through constant revisions similar to C program files and word processing documents. Rapid SQL's Project Management facilities let you effectively monitor revisions for your database servers.

For more information, see:

- Create a New Project
- Working With Projects
CREATE A NEW PROJECT

Creating a project can be a very time-consuming task. Rapid SQL eases this task by providing step-by-step wizards to guide you through the process. You have a variety of options to choose from when you create a new project. Rapid SQL lets you create new projects:

- From a database.
- From existing files.
- From a version control project.
- Without initialization.

The **New Project dialog box** lets you select how you want to create a new project. Using the New Project dialog box, you can name, specify a file location, and provide a description of the project.

NEW PROJECT DIALOG BOX

The New Project dialog box lets you select how you want to create a new project. Using the New Project dialog box, you can name, specify a file location, and provide a description of the project.

Important Notes

None

The table below describes the options and functionality of the New Project dialog box:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Lets you enter a name for the project.</td>
</tr>
<tr>
<td>Location</td>
<td>Lets you type or browse and locate a directory for the project. <strong>NOTE</strong>: This is set as the working directory for your project.</td>
</tr>
<tr>
<td>Description</td>
<td>OPTIONAL: Lets you enter a description of the project.</td>
</tr>
</tbody>
</table>
| Initialize New Project  | Lets you select how you want to create a new project. 
                          | **From Database** - Lets you reverse engineer an existing database. 
                          | **From Existing Files** - Lets you create a project from scratch, or use an existing project. 
                          | **From Version Control** - Lets you reverse-engineer a project from existing version control system projects. This is helpful for users who have already created database projects in their version control systems. 
                          | **Do Not Initialize** - Lets you create an empty project where you can later add files and/or database objects. |

For more information, see [Completing the New Project Dialog Box](#).
COMPLETING THE NEW PROJECT DIALOG BOX
To complete the New Project Dialog Box, do the following:

1. On the File menu, select New, and then Project. Rapid SQL opens the New Project Dialog Box.

2. In Name, enter a name for the project.

3. In Location, type or browse and locate a directory for the project.

4. OPTIONAL: In Description, lets you enter a description of the project.

5. In Initialize New Project, select how you want to create a new project.

6. Click OK.

CREATE A NEW PROJECT FROM A DATABASE
Rapid SQL offers a context-sensitive wizard that reverse-engineers all or part of an existing database. When extracting database schema, Rapid SQL captures the complete definition of the following objects:

- Tables
- Views
- Stored Procedures
- Functions

Rapid SQL then creates a project containing files based on the relevant object types. Rapid SQL creates a separate file for each database object.

Reverse engineering is a powerful tool for analyzing, controlling, and documenting existing database objects. You can use the extracted SQL source code for archival and reference purposes.

Important Notes

- You must create a New Project from a Database in order to access the New Project Reverse Engineering Wizard.

- Rapid SQL automatically discovers and sets the project script file build order by referencing the system catalog to determine dependencies.

- In the New Project dialog box, you must select the From Database option.

For more information, see Creating a New Project from a Database.
CREATING A NEW PROJECT FROM A DATABASE
To create a new project, do the following:

1. On the File menu, click New, and then click Project.

   OR

   On the Main toolbar, click the drop-down arrow to the right of the New button.

   OR

   On the Project toolbar, click the New Project.

   OR

   In the workspace, right-click New, and then click Project.

   Rapid SQL opens the New Project dialog box.

2. Complete the New Project dialog box and select the From Database option.

3. Click OK.

   Rapid SQL opens the New Project Reverse Engineering Wizard.


COMPLETING THE NEW PROJECT REVERSE ENGINEERING WIZARD

NOTE: You must create a New Project from a Database in order to access the New Project Reverse Engineering Wizard.

NOTE: Rapid SQL automatically discovers and sets the project script file build order by referencing the system catalog to determine dependencies.

To complete the New Project Reverse Engineering Wizard, do the following:

1. Complete the New Project dialog box, and then click OK.

   NOTE: You must select the From Database option.

   Rapid SQL opens the New Project Reverse Engineering Wizard.

2. Complete the wizard.

3. To make changes, click Back to the appropriate panels of the Wizard and make changes.

4. When you are satisfied with the definition, click Execute.

   Rapid SQL starts creating project files from database.

For more information, see New Project Reverse Engineering Wizard - Panel.
NEW PROJECT REVERSE ENGINEERING WIZARD - PANEL 1
The first panel of the New Project Reverse Engineering Wizard lets you specify the datasource that you want to reverse engineer into a project.

The table below describes the options and functionality of the first panel of the New Project Reverse Engineering Wizard:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select a Datasource</td>
<td>Lets you select a datasource to reverse engineer. Select a datasource.</td>
</tr>
</tbody>
</table>

For more information, see [Completing the New Project Reverse Engineering Wizard](#).

NEW PROJECT REVERSE ENGINEERING WIZARD - PANEL 2
The second panel of the New Project Reverse Engineering Wizard lets you specify the target database on the server.

The table below describes the options and functionality of the second panel of the New Project Reverse Engineering Wizard:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select Database to reverse-engineer</td>
<td>Lets you select a database to reverse engineer. Select a database.</td>
</tr>
</tbody>
</table>

For more information, see [Completing the New Project Reverse Engineering Wizard](#).

NEW PROJECT REVERSE ENGINEERING WIZARD - PANEL 2
The third panel of the New Project Reverse Engineering Wizard lets you specify the database object owners, the database object types, and general script types of the objects you want to extract.

The table below describes the options and functionality of the third panel of the New Project Reverse Engineering Wizard:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select Database Object Types</td>
<td>Owner list - Lets you select the owner of the objects you want to extract.</td>
</tr>
<tr>
<td></td>
<td>Objects - Lets you select the objects types you want to extract.</td>
</tr>
<tr>
<td></td>
<td>TIP: To select or deselect all object types right-click to Select or Unselect all.</td>
</tr>
<tr>
<td>Extract Scope</td>
<td>Lets you select the objects to extract from the database.</td>
</tr>
<tr>
<td></td>
<td>All Objects - Lets you extract all objects for each object type that you select. Opens Panel 4 for All Objects.</td>
</tr>
<tr>
<td></td>
<td>Selected Objects Only - Lets you specify the specific objects that you want to extract. Opens Panel 4 for Selected Objects.</td>
</tr>
<tr>
<td></td>
<td>NOTE: Rapid SQL continues to a different Panel 4 depending on which option you choose for the Extract Scope.</td>
</tr>
</tbody>
</table>

For more information, see [Completing the New Project Reverse Engineering Wizard](#).
New Project Reverse Engineering Wizard - Panel 3 for All Objects
This panel of the New Project Reverse Engineering Wizard lets you specify the ownership.

The table below describes the options and functionality of the fourth panel of the New Project Reverse Engineering Wizard for All Objects:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Include Indexes with Table DDL</td>
<td>If selected, includes indexes when extracting table DDL.</td>
</tr>
<tr>
<td>Include FKs with Table DDL</td>
<td>If selected, includes foreign keys when extracting table DDL.</td>
</tr>
<tr>
<td>Include Drop Statement</td>
<td>If selected, includes drop statements when extracting database SQL.</td>
</tr>
<tr>
<td>Include Object Privileges</td>
<td>If selected, includes object privileges when extracting database SQL.</td>
</tr>
</tbody>
</table>

For more information, see [Completing the New Project Reverse Engineering Wizard](#).

**NEW PROJECT REVERSE ENGINEERING WIZARD - PANEL 4 FOR SELECTED OBJECTS**
This panel of the New Project Reverse Engineering Wizard only applies if you have chosen to generate a customized script. You can select specify objects and set script options for each object type.

The table below describes the options and functionality of the fourth panel of the New Project Reverse Engineering Wizard for selected objects.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Object Type</td>
<td>Lets you select an object type.</td>
</tr>
<tr>
<td>Object list</td>
<td>Lists the owner and names of objects for the selected type in the database.</td>
</tr>
<tr>
<td>Options for Objects</td>
<td>Lets you select an option for the object type.</td>
</tr>
<tr>
<td><strong>NOTE:</strong></td>
<td>You must select options and statements for each object type you select.</td>
</tr>
<tr>
<td>Include Indexes with Table DDL</td>
<td>If selected, includes indexes when extracting table DDL.</td>
</tr>
<tr>
<td>Include FKs with Table DDL</td>
<td>If selected, includes foreign keys when extracting table DDL.</td>
</tr>
<tr>
<td>Include Drop Statement</td>
<td>If selected, includes drop statements when extracting database SQL.</td>
</tr>
<tr>
<td>Include Object Privileges</td>
<td>If selected, includes object privileges when extracting database SQL.</td>
</tr>
</tbody>
</table>

For more information, see [Completing the New Project Reverse Engineering Wizard](#).
NEW PROJECT REVERSE ENGINEERING WIZARD - PANEL 4
This panel of the New Project Reverse Engineering Wizard lets you review the Reverse Engineering definition to verify its accuracy.

**NOTE:** If you have specified to integrate Rapid SQL with an underlying version control system during installation, Rapid SQL asks to add the new files to version control. Click Yes to add the files.

For more information, see [Completing the New Project Reverse Engineering Wizard](#).

CREATE A NEW PROJECT FROM EXISTING FILES
Rapid SQL lets you create a new project from:
- Scratch.
- Existing files.

To create a new project from an existing file, do the following:

1. On the File menu, click New, and then click Project.
   - OR
   - On the Main toolbar, click the drop-down arrow to the right of the New button.
   - OR
   - On the Project toolbar, click the New Project.
   - OR
   - In the workspace, right-click New, and then click Project.

   Rapid SQL opens the New Project dialog box.

2. Complete the [New Project dialog box](#) and select the From Existing Files option.

3. Click OK.

   Rapid SQL opens the Add File(s) to Project dialog box.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Statements</td>
<td>Lets you select a script option for the particular object type. Note: Statements vary depending on the option and object type selected.</td>
</tr>
</tbody>
</table>
4 In the Add File(s) to Project dialog box, type the files that you want to add in the File name field. Use the following to help locate the files:

- In Directories, browse by clicking a directory.
- In the List files of type list, select a file type.
- In the Drives list, select a drive.

5 Click Add to add a file or click Add All to add all the files.

6 When you finish, click OK.

Rapid SQL creates the project.

**NOTE:** If you have specified to integrate Rapid SQL with an underlying version control system during installation, Rapid SQL asks to add the new files to version control. Click Yes to add the files.

---

**CREATE A NEW PROJECT FROM A VERSION CONTROL PROJECT**

Rapid SQL lets you reverse-engineer a project from existing version control system projects. This is helpful if you have already created database projects in a version control system.

**NOTE:** The Intersolv PVCS API does not support the creation of a project from a source code control project.

Rapid SQL also lets you create a project from a version control project that contains sub-directories, while including files from those sub-directories in the Rapid SQL project.

To create a new project from a Version Control project, do the following:

1 On the File menu, click New, and then click Project.
   OR
   On the Main toolbar, click the drop-down arrow to the right of the New button.
   OR
   On the Project toolbar, click the New Project.
   OR
   In the workspace, right-click New, and then click Project.

Rapid SQL opens the New Project dialog box.

2 Complete the New Project dialog box and select From Version Control Project.

3 Click OK.

Rapid SQL opens the Choose project from (Version Control name) dialog box.

4 Select the project or files you want to include, and then click OK.

Rapid SQL opens the Files to be included in (project path) dialog box.
5 Select the project of files you want to include, and then click OK.
Rapid SQL creates the project.

CREATE A NEW PROJECT WITHOUT INITIALIZATION
Rapid SQL gives you the option to not initialize a project. Rapid SQL creates a project tab with the name you specify in the New Project dialog box. This tab functions as a shell to:

- Add files.
- Add database objects.

To create a new project without initialization, do the following:

1 On the File menu, click New, and then click Project.
   OR
   On the Main toolbar, click the drop-down arrow to the right of the New button.
   OR
   On the Project toolbar, click the New Project.
   OR
   In the workspace, right-click New, and then click Project.
   Rapid SQL opens the New Project dialog box.

2 Complete the New Project dialog box and select the Do Not Initialize option.

3 Click OK.
   Rapid SQL creates the Project Tab.

WORKING WITH PROJECTS
A project is similar to a file system. Both are a collection of files that you create and maintain. Because projects are hierarchical, you can place a subproject under another project, and a subproject under a subproject. Once you have created a new project, Rapid SQL provides many functions to help you maintain and modify the project.

Related Topics
New Project Dialog Box
Opening an Existing Project
Opening a Recent Project
Closing a Project
OPENING AN EXISTING PROJECT
To open an existing project, do the following:

1. On the *File* menu click *Open Project*.
   - Rapid SQL opens the Open Project dialog box.

2. In *File name*, type the name and location of the project or use browse to locate the project.
   - **NOTE:** Project files are designated with a *.epj* extension.

3. Click Open.
   - Rapid SQL opens the Project Tab containing the project.

For more information, see *Working with Projects*.

OPENING A RECENT PROJECT
To open a recent project, do the following:

1. On the *File* menu select *Recent Project*, and then select a project.
   - Rapid SQL opens the Project Tab containing the project.

For more information, see *Working with Projects*.
CLOSING A PROJECT
To close a project, do the following:

1. On the File menu, click Close Project.
2. On the Project Tab, right-click and then click Close Project.

   Rapid SQL closes the project.

For more information, see Working with Projects.

BUILD PROJECT
The Build Project dialog box lets you:

- Generate a project build script and display it in a SQL window.
- Execute the project build immediately on build target.
- Schedule a project build.

Important Notes
None

The table below describes the Build Project dialog box:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Datasource</td>
<td>Displays the target datasource.</td>
</tr>
<tr>
<td>Database</td>
<td>Displays the target database.</td>
</tr>
<tr>
<td>Build subprojects</td>
<td>Select to include subprojects.</td>
</tr>
<tr>
<td>Generate a Project Build Script and Display it in a SQL window.</td>
<td>Select to generate the project build script and have Rapid SQL display it in a SQL window.</td>
</tr>
<tr>
<td>Execute Project Build Immediately on Build Target</td>
<td>Select to execute build immediately.</td>
</tr>
<tr>
<td>Schedule Project Build for a Later Time</td>
<td>Select to schedule the build and then specify optional options.</td>
</tr>
</tbody>
</table>

For more information, see Completing the Build Project Dialog Box.

COMPLETING THE BUILD PROJECT DIALOG BOX
To complete the Build Project dialog box, do the following:

1. On the File menu click Open Project.

   Rapid SQL opens the Open Project dialog box.
2 In File name, type the name and location of the project or use browse to locate the project.

   NOTE: Project files are designated with a *.epj extension.

3 Click Open.

   Rapid SQL opens the Project Tab containing the project.

1 On the Project Tab, right-click the target project, and then select Build.

   Rapid SQL opens the Build Project dialog box.

2 Select options.

3 Click OK.

   Rapid SQL builds the project according to your specifications.

### SET BUILD ORDER

You can specify the order in which you want Rapid SQL to build your project files in the Set Build Order dialog box. If you created your project manually or from a version control project, you must specify a build order, otherwise the files are built in the order that they appear in the tree of the Project Tab.

#### Setting Build Order

1 On the File menu click Open Project.

   Rapid SQL opens the Open Project dialog box.

2 In File name, type the name and location of the project or use browse to locate the project.

   NOTE: Project files are designated with a *.epj extension.

3 Click Open.

   Rapid SQL opens the Project Tab containing the project.

4 On the Project menu, click Build Order.

   OR

   On the Project toolbar, click Build Order.

   OR

   On the Project Tab, right-click a project file, and then click Build.

   Rapid SQL opens the Set Build Order dialog box.

5 Click the files you want to move and then click the Up and Down to change the order to build the files.
6 When you finish specifying the order, select OK.

Rapid SQL sets the build order.

NOTE: The next time you build the project, Rapid SQL uses this build order.

ADD DATABASE OBJECT FILE(S) TO PROJECT WIZARD
You can add database objects to an existing project using a simple wizard that can reverse-engineer an entire database or any portion of it. This lets you keep your project in sync with databases where objects are constantly being created and updated.

For more information, see:

Working with Projects
Completing the Add Database Object File(s) to Project Wizard

COMPLETING THE ADD DATABASE OBJECT FILE(S) TO PROJECT WIZARD
To add database objects to a project, do the following:

1 On the File menu click Open Project.

Rapid SQL opens the Open Project dialog box.

2 In File name, type the name and location of the project or use browse to locate the project.

NOTE: Project files are designated with a *.epj extension.

3 Click Open.

Rapid SQL opens the Project Tab containing the project.

4 On the Project menu, click Add Database Objects.

OR

On the Project toolbar click Add Database Objects.

OR

On the Project Tab, right-click and then click Add Database Objects.

Rapid SQL opens the first panel of the Add Database Object File(s) to Project Wizard.

For more information, see Add Database Objects to a Project Wizard.

ADD DATABASE OBJECT FILE(S) TO PROJECT WIZARD - PANEL 1
The first panel of the Add Database Object File(s) to Project Wizard lets you specify the datasource that you want to reverse engineer into a project.
The table below describes the options and functionality of the first panel of the Add Database Object File(s) to Project:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select a Datasource</td>
<td>Lets you select a datasource to reverse engineer.</td>
</tr>
</tbody>
</table>

For more information, see [Completing the Add Database Object File(s) to Project Wizard](#).

**ADD DATABASE OBJECT FILE(S) TO PROJECT WIZARD - PANEL 2**

The second panel of the Add Database Object File(s) to Project Wizard lets you specify the target database on the server.

The table below describes the options and functionality of the second panel of the Add Database Object File(s) to Project:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select Database to reverse-engineer</td>
<td>Lets you select a database to reverse engineer.</td>
</tr>
</tbody>
</table>

For more information, see [Completing the Add Database Object File(s) to Project Wizard](#).

**ADD DATABASE OBJECT FILE(S) TO PROJECT WIZARD - PANEL 3**

The third panel of the Add Database Object File(s) to Project Wizard lets you specify the database object owners, the database object types, and general script types of the objects you want to extract.

The table below describes the options and functionality of the third panel of the Add Database Object File(s) to Project:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select Database Object Types</td>
<td>Owner list - Lets you select the owner of the objects you want to extract.</td>
</tr>
<tr>
<td></td>
<td>Objects - Lets you select the objects types you want to extract.</td>
</tr>
<tr>
<td></td>
<td>TIP: To select or deselect all object types, in the Object list, right-click to Select or Unselect all.</td>
</tr>
<tr>
<td>Extract Scope</td>
<td>Lets you select the objects to extract from the database.</td>
</tr>
<tr>
<td></td>
<td>All Objects - Lets you extract all objects for each object type that you select. Opens Panel 4 for All Objects.</td>
</tr>
<tr>
<td></td>
<td>Selected Objects Only - Lets you specify the specific objects that you want to extract. Opens Panel 4 for Selected Objects.</td>
</tr>
<tr>
<td></td>
<td>NOTE: Rapid SQL opens a different Panel 4 depending on which option you choose for the Extract Scope.</td>
</tr>
<tr>
<td>Include Indexes with Table DDL</td>
<td>Includes indexes when extracting table DDL.</td>
</tr>
<tr>
<td>Include FKS with Table DDL</td>
<td>Includes foreign keys when extracting table DDL.</td>
</tr>
<tr>
<td>Include Drop Statement</td>
<td>Includes drop statements when extracting database SQL.</td>
</tr>
</tbody>
</table>
For more information, see [Completing the Add Database Object File(s) to Project Wizard](#).

### ADD DATABASE OBJECT FILE(S) TO PROJECT WIZARD - PANEL 4 FOR SELECTED OBJECTS

This panel of the Add Database Object File(s) to Project Wizard only applies if you have chosen to generate a customized script. You can select specify objects and set script options for each object type.

The table below describes the options and functionality of the fourth panel of the Add Database Object File(s) to Project for selected objects.

**NOTE:** You must select options and statements for each object type you select.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Object Type list</td>
<td>Lets you select an object type.</td>
</tr>
<tr>
<td>Object list</td>
<td>Lists the owner and names of objects for the selected type in the database.</td>
</tr>
<tr>
<td>Options for Object list</td>
<td>Lets you select an option for the object type.</td>
</tr>
<tr>
<td></td>
<td>NOTE: Options vary depending on the object type selected.</td>
</tr>
<tr>
<td>Statement list</td>
<td>Lets you select a script option for the particular object type.</td>
</tr>
<tr>
<td></td>
<td>NOTE: Statements vary depending on the option and object type selected.</td>
</tr>
</tbody>
</table>

For more information, see [Completing the Add Database Object File(s) to Project Wizard](#).

### Add Database Object File(s) to Project Wizard - Panel 4 for All Objects

The fourth panel of the Add Database Object File(s) to Project Wizard lets you specify the ownership.

The table below describes the options and functionality of the fourth panel of the Add Database Object File(s) to Project for All Objects:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Retain</td>
<td>Select to include the existing object owners' names in the CREATE statements.</td>
</tr>
<tr>
<td>Exclude</td>
<td>Select to exclude the object owners’ names in the CREATE statements.</td>
</tr>
<tr>
<td>Transfer</td>
<td>Select to include the designated owner’s name in the CREATE statements. Select a user.</td>
</tr>
</tbody>
</table>

For more information, see [Completing the Add Database Object File(s) to Project Wizard](#).
ADD DATABASE OBJECT FILE(S) TO PROJECT WIZARD - PANEL 5
This panel of the Add Database Object File(s) to Project Wizard lets you retain, exclude, or transfer object ownership.

The table below describes the options and functionality on this panel:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Retain</td>
<td>Select to retain object ownership.</td>
</tr>
<tr>
<td>Exclude</td>
<td>Select to exclude object ownership.</td>
</tr>
<tr>
<td>Transfer ownership to following user:</td>
<td>Select to transfer ownership, and then select the target user from the list.</td>
</tr>
</tbody>
</table>

For more information, see [Completing the Add Database Object File(s) to Project Wizard](#).

ADD DATABASE OBJECT FILE(S) TO PROJECT WIZARD - PANEL 6
This panel of the Add Database Object File(s) to Project Wizard lets you review the Reverse Engineering definition to verify its accuracy.

**NOTE:** If you have specified to integrate Rapid SQL with an underlying version control system during installation, Rapid SQL asks to add the new files to version control. Click Yes to add the files.

For more information, see [Completing the Add Database Object File(s) to Project Wizard](#).

EXECUTE PROJECT FILES
You can directly execute project script files from the Project Tab using the File Execution Facility. You can also execute multiple scripts in parallel against different datasources. If a file has been placed under version control, you need to perform a Check Out operation to execute the file. Otherwise, the file opens in read-only mode.

For more information, see:

- Working with Projects
- Executing Project Files

**EXECUTING PROJECT FILES**

To execute project files, do the following:

1. On the Project Tab, right-click the files you want to execute, and then click File Execution Facility.

   Rapid SQL opens the Script Execution Facility dialog box.

For more information, see [Execute Project Files](#).
**ADD FILE(S) TO A PROJECT**

You can add external files to your project. This lets you manipulate and expand your project as needed.

The Add File(s) to Project dialog box lets you add files to a project.

The table below describes the options and functionality of the Add Files to Project dialog box:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>File Name</td>
<td>Lets you type the files that you want to add.</td>
</tr>
<tr>
<td>Directories</td>
<td>Lets you browse by selecting a directory.</td>
</tr>
<tr>
<td>List files of type</td>
<td>Lets you select a file type.</td>
</tr>
<tr>
<td>Drives</td>
<td>Lets you select a drive.</td>
</tr>
<tr>
<td>Network</td>
<td>Open the Map Network Drive dialog box.</td>
</tr>
<tr>
<td>Add</td>
<td>Lets you add a file.</td>
</tr>
<tr>
<td>Add All</td>
<td>Lets you add all the files.</td>
</tr>
</tbody>
</table>

For more information, see:

[Working with Projects](#)

[Completing the Add Files to Project Dialog Box](#)

**COMPLETING THE ADD FILE(S) TO PROJECT DIALOG BOX**

To add files to a project from, do the following:

1. On the *Project* menu, click *Add Files*.
   
   OR
   
   On the *Project* Tab, right-click and then click *Add Files*.

   Rapid SQL opens the *Add Files to Project* dialog box.

2. In *File name*, type the file name(s) or select the file(s) that you want to add to the project.

3. In *Directories* browse for the project that contains the file(s) that you want to add to the project.

4. In the *List files of type* select the type of files you want to add to the project.

5. In *Drives* select a drive.

6. Click *Network* to open the Map Network Drive dialog box.

7. Click *Add* to add a file or click *Add All* to add all of the files.

8. Click *OK*.

   Rapid SQL adds the files to the project.
OPEN A FILE FROM A PROJECT
You can open a file directly from the Project Tab using a number of different methods.
For more information, see:
Working with Projects
Opening a File from a Project

OPENING A FILE FROM A PROJECT
To open a file from a project, do the following:
1. On the Project Tab, right-click the file(s) you want to open, and then click Open.
   OR
   On the Project Tab, double-click the file(s).
   Rapid SQL opens the file(s) in a new SQL window.
For more information, see Open a File from a Project.

SUBPROJECTS
Subprojects are projects within projects. You can use them to help categorize your source code files. On the Project Tab of the Database Explorer Rapid SQL lets you:
- Create subprojects.
- Delete subprojects.
- Rename subprojects.
- Sort subprojects.
For more information, see Working with Projects.

CREATING A NEW SUBPROJECT
Rapid SQL offers three ways to create a new subproject:
1. On the File menu click Open Project.
   Rapid SQL opens the Open Project dialog box.
2. In File name, type the name and location of the project or use browse to locate the project.
   
   NOTE: Project files are designated with a *.epj extension.
3. Click Open.
   Rapid SQL opens the Project Tab containing the project.
4 On the Project menu, click New SubProject.
   OR
   On the Project toolbar, click New SubProject.
   OR
   On the Project Tab, right-click the project or subproject, and then click New SubProject.

5 Type the name of the new subproject and then press Enter.
For more information, see Subprojects.

DELETING A SUBPROJECT
To delete a project, do the following:

1 On the File menu click Open Project.
   Rapid SQL opens the Open Project dialog box.

2 In File name, type the name and location of the project or use browse to locate the project.
   NOTE: Project files are designated with a *.epj extension.

3 Click Open.
   Rapid SQL opens the Project Tab containing the project.

4 On the Project Tab, right-click a subproject, and then click Delete.
   OR
   On the Project Tab, select a subproject, and then click Delete.
   Rapid SQL opens the Confirm Delete dialog box.

5 In the Confirm Delete dialog box, select the Delete local copy to delete the local copy of the subproject, and then click OK.
   Rapid SQL deletes the subproject.
For more information, see Subprojects.

CONFIRM DELETE DIALOG BOX
The table below describes the options and functionality on the Confirm Delete Dialog Box:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delete local copy</td>
<td>Deletes the local copy of the subproject.</td>
</tr>
</tbody>
</table>

For more information, see Deleting a Subproject.
**RENAMING A SUBPROJECT**

To rename a subproject, do the following:

1. **On the File menu click Open Project.**
   
   Rapid SQL opens the Open Project dialog box.

2. **In File name, type the name and location of the project or use browse to locate the project.**
   
   **NOTE:** Project files are designated with a *.epj extension.

3. **Click Open.**
   
   Rapid SQL opens the Project Tab containing the project.

4. **On the Project Tab, right-click a subproject, and then click Rename.**

5. **Type the name of the new subproject and then press Enter.**
   
   Rapid SQL renames the subproject.

For more information, see Subprojects.

**SORTING SUBPROJECTS**

So sort a subproject, do the following:

1. **On the File menu click Open Project.**
   
   Rapid SQL opens the Open Project dialog box.

2. **In File name, type the name and location of the project or use browse to locate the project.**
   
   **NOTE:** Project files are designated with a *.epj extension.

3. **Click Open.**
   
   Rapid SQL opens the Project Tab containing the project.

4. **On the Project Tab, right-click the directory containing the subprojects you want to sort and then click Sort.**
   
   Rapid SQL sorts the subproject(s).

For more information, see Subprojects.

**PROJECT PROPERTIES**

Rapid SQL lets you view properties of Projects, Subprojects and individual files in Projects or Subprojects. The Project Properties, Subproject Properties, and File Properties dialog boxes display information about the Projects, Subprojects, and files.

For more information, see Working with Projects.
VIEWING PROJECT PROPERTIES
To view project properties, do the following:

1. On the File menu click Open Project.
   Rapid SQL opens the Open Project dialog box.
2. In File name, type the name and location of the project or use browse to locate the project.
   **NOTE:** Project files are designated with a *.epj* extension.
3. Click Open.
   Rapid SQL opens the Project Tab containing the project.
4. On the Project menu, click Project Properties.
   OR
   On the Project Tab, right-click a project and then click Properties.
   Rapid SQL opens the Project File Properties dialog box.
5. Complete the Project File Properties dialog box.
6. Click OK.

For more information, see:
- [Project Properties](#)
- [Project File Properties Dialog Box](#)

### PROJECT FILE PROPERTIES DIALOG BOX
The table below describes the options and functionality of the Project Properties dialog box:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Displays the name of the project.</td>
</tr>
<tr>
<td>Full Specification</td>
<td>Displays the project location.</td>
</tr>
<tr>
<td>Description</td>
<td>Displays the project description. Optional: lets you type or edit the project description.</td>
</tr>
<tr>
<td>Associated Datasource</td>
<td>Lets you select a datasource for the project.</td>
</tr>
<tr>
<td>Associated Database</td>
<td>Lets you type the name of the database.</td>
</tr>
</tbody>
</table>

For more information, see [Viewing Project Properties](#).
VIEWING SUBPROJECT PROPERTIES
To view subproject properties, do the following:

1. On the **File** menu click **Open Project**.
   Rapid SQL opens the Open Project dialog box.

2. In **File name**, type the name and location of the project or use browse to locate the project.
   **NOTE:** Project files are designated with a *.epj extension.

3. Click Open.
   Rapid SQL opens the Project Tab containing the project.

4. On the Project Tab, select a subproject.

5. Right-click the subproject, and then click Properties.
   Rapid SQL opens the Subproject Properties dialog box.

6. Complete the **Subproject Properties dialog box**.

7. Click OK.

For more information, see:
- **Project Properties**
- **Subproject Properties Dialog Box**

**SUBPROJECT PROPERTIES DIALOG BOX**
The table below describes the options and functionality of the Subproject Properties dialog box:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Displays the name of the subproject. You can enter or edit the subproject name.</td>
</tr>
<tr>
<td>Full Specification</td>
<td>Displays the subproject location.</td>
</tr>
<tr>
<td>Status</td>
<td>Displays the subproject status.</td>
</tr>
</tbody>
</table>

For more information, see **Viewing Subproject Properties**.

VIEWING FILE PROPERTIES
To view file properties, do the following:

1. Click **File** and then **Open Project**.
   Rapid SQL opens the Open Project dialog box.

2. Type the project name or select the project.
3 Click Open.
   Rapid SQL opens the project on the Projects Tab.

4 On the Project Tab, select a file.

5 Right-click the file, and then click Properties.
   Rapid SQL opens the File Properties dialog box.

6 Complete the File Properties dialog box.

7 Click OK.

For more information, see:

Project Properties
File Properties Dialog Box

FILE PROPERTIES DIALOG BOX
The table below describes the options and functionality of the File Properties dialog box:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Displays the file name.</td>
</tr>
<tr>
<td>Full Specification</td>
<td>Displays the file location.</td>
</tr>
</tbody>
</table>
| Description     | Displays the file description.  
|                 | OPTIONAL: Type or edit the file description.          |
| Include In Build| Sets the file to be included in the build.            |
| Last Modified   | Displays the date and time of the last modification.  |
| Size            | Displays the file size.                               |
| Status          | Displays the file status.                             |
| Object Type     | Displays the file object type. Select an object type if the file is unspecified. |


**VERSION CONTROL**

Version control archives files and tracks changes to files over time. With an integrated version control in Rapid SQL, you can easily track changes to database objects.

Version control addresses the following issues:

- **Team Development** By controlling access to a file so that only one person at a time can modify it, prevents accidental replacement or loss of another user’s changes.

- **Version Tracking** By archiving and tracking versions of source code files, you can retrieve them if necessary, thereby effectively creating files so that source code can be reused.

- **Safety** By adding database object scripts and files, it creates backups in case of loss, thereby ensuring a recovered version of source code.

When you create a project, Rapid SQL lets you place the project immediately into version control. You can also add projects and files to version control later.

To use integrated version control in Rapid SQL, you must have the version control client software installed on the same computer as Rapid SQL. You must also select the appropriate version control system during installation or after installation on the [Version Control Tab of the Option Editor](#).

Rapid SQL offers version control integration for the following version control systems:

- Rational ClearCase 5.0 and 6.0
- Merant/Intersolv PVCS Version Manager version 6.0
- Microsoft Visual SourceSafe 5.0 and 6.0
- MKS Source Integrity version 7.3c

For more information, see:

[Version Control Integration](#)

[Version Control Configuration](#)

[Using Version Control](#)

**VERSION CONTROL INTEGRATION**

Rapid SQL offers version control integration so you can take advantage of the following version control systems:

- Rational ClearCase 5.0 and 6.0
- Merant Version Manager version 6.0 or later
- Microsoft Visual SourceSafe 5.0 and 6.0
- MKS Source Integrity version 7.3c
VERSION CONTROL

For more information, see:
Integrating with Merant Version Manager
Integrating with Microsoft Visual Source Safe
Integrating with MKS Source Integrity

INTEGRATING WITH MERANT VERSION MANAGER
Rapid SQL works with Merant Version Manager version 6.0. or later.

To integrate Merant Version Manager with Rapid SQL, do the following:

1. Install Merant Version Manager (formerly PVCS) 8.0.
2. In the setup option for the client, select IDE Client.

This installs the correct DLLs and registry entries, and "Merant Version Manager" appears in the Version Control Tab of the Options Editor.

NOTE: To use Rapid SQL with an existing Merant project, you must import the individual files into a native Rapid SQL project. Merant does not provide the third party API support for projects that it does for basic version control operations on archived files.

For more information, see Version Control Integration.

INTEGRATING WITH MICROSOFT VISUAL SOURCESAFE
Rapid SQL works with Microsoft Visual SourceSafe versions 5.0. and 6.0. Rapid SQL uses your default Visual SourceSafe database unless you override the setting on the Version Control Tab of the Option Editor. This file is always called srcsafe.ini.

Troubleshooting
If you are having trouble configuring Rapid SQL to use Visual SourceSafe, check the system registry to determine that the COM automation portion of Visual SourceSafe has been properly installed. To check the registry, do the following:

1. From the Windows Start button, click Run and then type REGEDIT to view the system registry.

   Windows opens the Registry Editor.

2. Click the HKEY_CLASSES_ROOT directory.
3. Click the SourceSafe key.
4. Ensure that the Key contains the subkeys CLSID and CurVer.
5. If either of these keys are missing, reinstall Visual SourceSafe.
For more information, see Version Control Integration.

INTEGRATING WITH MKS SOURCE INTEGRITY
Rapid SQL works with MKS Source Integrity version 7.3c.

1. After installing MKS Source Integrity, install the MKS Source Integrity Extensions.

For more information, see Version Control Integration.

VERSION CONTROL CONFIGURATION
Rapid SQL lets you configure version control. You can add or remove entire projects or specific files to and from version control. The Version Control Tab of the Option Editor lets you configure version controls to your specific needs.

To use version control functions, you must have a version control system up and running on your system. You can integrate Rapid SQL with:

- Rational ClearCase 5.0 and 6.0
- Merant Version Manager version 6.0 or later
- Microsoft Visual SourceSafe 5.0 and 6.0
- MKS Source Integrity version 7.3c

Configuring Version Control During Installation
1. If you have version control installed on your machine, during the Rapid SQL installation, select the option for your version control system.

   **NOTE:** If you select None, Rapid SQL does not support any version control functions in Rapid SQL until you select a version control system from the application. See below.

Configuring Version Control After Installation
1. On the File menu, click Options.
   Rapid SQL opens the Options Editor.
2. Select Version Control to open the Version Control Tab.
3. Select your version control system.
4. Click OK.
WORKING WITH PROJECTS IN VERSION CONTROL

Projects can exist independently of version control. You can add an entire project to version control at any point. When you decide to place a project under version control, Rapid SQL creates a project on the underlying version control system that has been specified.

Once a project or file has been added to version control, the features of your version control system are available directly from the Project Tab within Rapid SQL. Any changes you make to a project or file from within Rapid SQL are simultaneously changed in your version control system.

The table below describes the options and functionality on the Add to Version Control dialog box:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Files to be added</td>
<td>Lets you select files to add to Version Control.</td>
</tr>
<tr>
<td>Comment</td>
<td>OPTIONAL: Lets you add a comment.</td>
</tr>
<tr>
<td>Check out immediately</td>
<td>Select to add file and keep it checked-out.</td>
</tr>
<tr>
<td>Store only latest</td>
<td>Select to add the latest version.</td>
</tr>
<tr>
<td>Remove local copy</td>
<td>Select to add file and remove the local copy.</td>
</tr>
</tbody>
</table>

For more information, see:

Completing the Add to Version Control Dialog Box

COMPLETING THE ADD TO VERSION CONTROL DIALOG BOX

To add a project to version, do the following:

1. Click File and then Open Project.
   - Rapid SQL opens the Open Project dialog box.
2. Type the project name or select the project.
3. Click Open.
   - Rapid SQL opens the project on the Projects Tab.
4. On the Project menu, click Version Control.
   - OR
   - On the Project Tab, right-click a project file.
   - Rapid SQL opens the Add to Version Control dialog box.
5. Click Add to Version Control.
6. Select options.
7 Click OK to add a project, and then click Create.

Rapid SQL adds the project to version control.

NOTE: Rapid SQL dims the project file icon to indicate that the project has been placed under version control.

For information on opening projects, see Working with Projects.

WORKING WITH FILES IN VERSION CONTROL

Rapid SQL lets you view and work with files stored in various projects in a version control system without including the files in a Rapid SQL project. The Add Version Control Files dialog box lets you create a list of files in a version control system, select the version control project, and then add it and its files to the VC Files Tab.

The table below describes the options and functionality on the Add Version Control Files dialog box:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project</td>
<td>Lets you type the version control project path.</td>
</tr>
<tr>
<td>Browse</td>
<td>Click to open Choose project from (version control name) dialog box.</td>
</tr>
<tr>
<td>List Files</td>
<td>Click to view the project’s files in the Version control project files tree.</td>
</tr>
<tr>
<td>File Types</td>
<td>Click to list the project’s available files, filtered by file type.</td>
</tr>
<tr>
<td>Version control project files</td>
<td>List the project available files.</td>
</tr>
</tbody>
</table>

NOTE: If the VC Files Tab is already open and contains files from the project previously selected in the Add Version Control Files dialog box, only files not already in the VC Files Tab will be listed.

| Add                                       | Click to add selected file(s) to the Files being added to version control files list box. |
| Add All                                   | Click to add all file(s) to the Files being added to version control files list box. |
| Files being added to version control files list | Displays the files that will appear on the VC Tab.                              |
| Remove                                    | Click to remove selected file from the Files being added to version control files list box. |
| Check Out                                 | Select to automatically check out the file from version control on the VC Files Tab. |
| Get Latest Version                        | Select to automatically get latest version of the file from version control on the VC Files Tab. |

For more information, see:
Completing the Add Version Control Files Dialog Box

To add files to version control, do the following:

1. Click File and then Open Version Control Files List.
   
   Rapid SQL opens the version control system login dialog box.

2. Type login information.
   
   Rapid SQL opens the Add Version Control Files dialog box.

3. In Project, type the project name, or click Browse to open the Choose project from (version control name) dialog box.

4. Select the project and click OK.
   
   Rapid SQL displays the files in the Version control project files box.

5. Click File Types to list the project's available files, filtered by file type.

6. In List files of type select the type of files to list.

7. In the Version control project files box, select the target files and click Add or Add All to add the files to the version control files list.

8. In Options, select Check Out or Get Latest Version.

9. Click OK.

   Rapid SQL opens the Check Out File or Get File dialog box.

10. In Comment, type a comment. If you select multiple files, the comment will apply to all the files.

11. In To, type the directory to place the file(s).

12. For SourceSafe, for advanced options, click Advanced.

13. Click OK.

   Rapid SQL adds the files in the Files being added to version control files list box to the VC Files Tab. If you selected the Check Out option, Rapid SQL opens the Check Out (Files) dialog box. If you selected the Get Latest Version option, Rapid SQL opens the Get from Version Control dialog box.

Using Version Control

Once you add a project or file to version control, most functions found in the underlying version control system are available directly from the Rapid SQL interface, including the VC Files Tab. Basic version control procedures include:
• **Get Latest Version**  
• **Check Out**  
• **Check In**  
• **Undo Check Out**  
• **Open**  
• **Show History**  
• **Show Difference**  
• **Version Control Properties**

**NOTE:** Your Rapid SQL version control functionality depends on your underlying version control system. For more information on version control procedures, consult the documentation included with your version control system.

**VC FILES TAB**
The VC Files Tab displays version control files listed in the * . evc (Embarcadero version control file.) The tab displays file icons indicating their current status, for example if they are checked out to the user logged in to the source control system. The files can be opened from this list, as well as operated on to manipulate their version control properties. For example, a file can be checked out or checked into the system from the VC File Tab.

The table below describes the VC Files Tab icons:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>File</td>
<td>File is not checked out by anyone.</td>
</tr>
<tr>
<td>File with single red check mark</td>
<td>File is checked out non-exclusively and only by the user logged into source control.</td>
</tr>
<tr>
<td>File with a single black check mark</td>
<td>File is checked out non-exclusively only by a one user who is not the user logged into source control.</td>
</tr>
<tr>
<td>File with a single red check mark and a red border</td>
<td>File is checked out exclusively and only by the user logged in to source control.</td>
</tr>
<tr>
<td>File with a single black check mark and a red border</td>
<td>File is checked out exclusively and only by a user who is not the user logged in to source control.</td>
</tr>
<tr>
<td>File with two red check marks</td>
<td>File is checked out by multiple users, including the user logged in to source control.</td>
</tr>
<tr>
<td>File with two black check marks</td>
<td>File is checked out by multiple users, not including the user logged in to source control.</td>
</tr>
</tbody>
</table>

For more information, see:  
**VC Files Tab Available Functionality**
Opening the VC Files Tab

Closing the VC Files Tab

VC Files Tab Available Functionality
Once the files are on the list in the VC Files Tab, you can use the various version control functionalities.

At the VC Files level, Rapid SQL lets you:
- Add Files
- Sort
- Get Latest Version
- Check Out
- Check In
- Undo Checkout
- Remove from Version Control
- Expand All
- Collapse All
- Refresh
- Close Files List

At the Project level, Rapid SQL lets you:
- Add Files
- Delete
- Sort
- Get Latest Version
- Check Out
- Check In
- Undo Checkout
- Remove from Version Control
- Expand All
- Collapse All
- Refresh
At the Directory (file type) level, Rapid SQL lets you:

- Add Files
- Delete
- Sort
- Get Latest Version
- Check Out
- Check In
- Undo Checkout
- Remove from Version Control
- Expand All
- Collapse All
- Refresh
- Close Files List

At the File level, Rapid SQL lets you:

- Open
- Delete
- Get Latest Version
- Check Out
- Check In
- Undo Checkout
- Show History
- Show Differences
- Remove from Version Control
- Version Control Properties
- Refresh
- Close Files List

For more information, see:

Opening the VC Files Tab
Closing the VC Files Tab
OPENING THE VC FILES TAB
1. Select File, Open Version Control File List.

   If you have files on your version control list, Rapid SQL opens the VC Files Tab. If you do not have files on your version control list, Rapid SQL opens the Add Version Control Files dialog box.

For more information, see:

Working with Files in Version Control
Closing the VC Files Tab

CLOSING THE VC FILES TAB
1. Select File, Close Version Control File List.

   Rapid SQL closes the VC Files Tab.

For more information, see:

Working with Files in Version Control
Opening the VC Files Tab

VERSION CONTROL FUNCTIONALITY - OPEN
The Open functionality opens the selected file(s) with the application registered for the type(s) of the selected file(s).

For more information, see Working with Files in Version Control.

VERSION CONTROL FUNCTIONALITY - DELETE
The Delete functionality deletes the local copy of the selected item from the tree. To remove a file from version control, see Remove From Version Control.

For more information, see Working with Files in Version Control.

VERSION CONTROL FUNCTIONALITY - SORT
The Sort functionality sorts the tree items alphabetically.

For more information, see Working with Files in Version Control.
VERSION CONTROL FUNCTIONALITY - GET LATEST VERSION

The Get Latest Version functionality lets you access the latest version of a file for viewing only. The Get functionality creates a local copy of the most current version of a project file in your working folder. The file is read-only, so any modifications cannot be saved.

Before working with a project, you should perform a Get on the entire project to ensure that you are working with the latest copy of the project. You should also perform a project-level, recursive Get at intervals to ensure that you have the latest version of files, in the event that they have been altered by others working on the same project.

The following table describes the option and functionality on the Get from Version Control dialog box:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Files to Get</td>
<td>Lets you select file(s) to get latest version of.</td>
</tr>
<tr>
<td>Advanced</td>
<td>Click to open the Advanced Get Options dialog box.</td>
</tr>
</tbody>
</table>

**TIP:** You can specify the file directory in the Version Control option of the Options Editor. For details, see Version Control Options.

Getting Latest Version of a Project

To get the latest version of project, do the following:

1. Click File and then Open Project.
   
   Rapid SQL opens the Open Project dialog box.

2. Type the project name or select the project.

3. Click Open.
   
   Rapid SQL opens the project on the Projects Tab.

4. Click the project or target files.

5. On the Project menu, click Version Control.
   
   OR
   
   On the Project toolbar, click Version Control.
   
   OR
   
   On the Project Tab, right-click a project or file.
   
   Rapid SQL opens the Get From Version Control dialog box.

6. Click Get Latest Version.
   
   Rapid SQL opens the Get From Version Control dialog box.

7. In the Files to Get box, click the project or files.
8 For advanced options, click Advanced.
9 Click OK.
   Rapid SQL writes the most current version of the file to your working directory.

**Getting Latest Version of a File**

To get the latest version of a file, do the following:

1 On the VC Tab, right-click the target file(s) and select Get Latest Version.
   Rapid SQL opens the Get From Version Control dialog box.
2 Click Get Latest Version.
   Rapid SQL opens the Get From Version Control dialog box.
3 In the Files to Get box, select the file(s).
4 For advanced options, click Advanced.
5 Click OK.
   Rapid SQL writes the most current version of the file to the VC Tab.

For more information, see Using Version Control.

**VERSION CONTROL FUNCTIONALITY - CHECK OUT**

The Check Out functionality retrieves a copy of one or more selected files and creates a writable working file copy in the working directory. You must perform a Check Out to edit any file that has been placed under version control.

You can check out a single file, multiple files at once or an entire project. Rapid SQL displays a red check mark over the file icon to indicate that the file has been checked out and is writable. This does not prevent other users from performing a Get or a Check Out on the file unless you are using the exclusive Check Out feature found in MKS Source Integrity and Merant/Intersolv PVCS.

The following table describes the options and functionality on the Check Out File(s) dialog box:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Files to be Checked Out</td>
<td>Displays list of files that are eligible for check out. A black mark indicates that another user has the file(s) checked out.</td>
</tr>
<tr>
<td>Advanced</td>
<td>Click to open the Advanced Check Out Options dialog box.</td>
</tr>
</tbody>
</table>

**TIP:** You can specify the file directory in the Version Control Working Directory option of the Options Editor. For details, see Version Control Options.
Checking Out a Project
To check-out a project, do the following:

1. Click File and then Open Project.
   Rapid SQL opens the Open Project dialog box.
2. Type the project name or select the project.
3. Click Open.
   Rapid SQL opens the project on the Projects Tab.
4. Select the target project.
5. On the Project menu, click Version Control.
   OR
   On the Project toolbar, click Check Out.
   OR
   On the Project Tab, right-click a project.
6. Select Check Out.
   Rapid SQL opens the Check Out dialog box.
7. In the Files to Be Checked Out box select the project.
8. For advanced options, click Advanced.
9. Click OK.
   Rapid SQL checks out the project or files from version control and writes the most current
   version of the file to your working directory.

Check Out a File
To check out a file, do the following:

1. On the VC Tab, right-click the target file(s) and select Check Out.
   Rapid SQL opens the Check Out File(s) dialog box.
2. In the Check Out File(s) dialog box select the files.
3. For advanced options, click Advanced.
4. Click OK.
   Rapid SQL checks out the file(s) from version control and writes the most current version
   of the file to the VC Tab.

For more information, see Using Version Control.
**VERSION CONTROL FUNCTIONALITY - CHECK IN**

After editing your files, you must Check In the revised file in order to save the changes you made to the file in a project. The Check In functionality stores the new version of the updated file in the current project. The Check In functionality is only available if you have Checked Out a file. You have the option to Check In an entire project or individual files.

**TIP:** You can specify the file directory in the Version Control Working Directory option of the Options Editor. For details, see Version Control Options.

The table below describes the options and functionality on the Check In dialog box:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Files to be checked in</td>
<td>Lets you specify the file(s) to check in.</td>
</tr>
<tr>
<td>Keep checked out</td>
<td>Adds latest version(s) of file(s) to source control but keeps the file(s) checked out.</td>
</tr>
<tr>
<td>Comment</td>
<td>OPTIONAL: Lets you type an optional comment.</td>
</tr>
</tbody>
</table>

**Checking In a Project**

To check-in a project, do the following:

1. Click File and then Open Project.
   
   Rapid SQL opens the Open Project dialog box.
2. Type the project name or select the project.
3. Click Open.
   
   Rapid SQL opens the project on the Projects Tab.
4. On the **Project** menu, click Version Control, and then Check In.
   
   **OR**
   
   On the **Version Control** toolbar, click Check In.
   
   **OR**
   
   On the **Project** Tab, right-click a project or file, and then Check In.
   
   Rapid SQL opens the Check In dialog box.
5. In the **Files to Be Checked In** box click the project or files.
6. To update the version control copy but keep the project or files checked out so that you can continue working, select the **Keep Checked Out** check box.
7. To remove the file from the working directory and from the *.xml file, and from the VC Files Tab, select Remove Local Copy.
8. **OPTIONAL:** In the **Comment** text box type a description of the changes.
9 Click OK.  
Rapid SQL saves the modified project into version control.

**Check In a File**

To check in a file, do the following:

1. On the VC Tab, right-click the target file(s) and select Check In.  
   Rapid SQL opens the Check In File(s) dialog box.
2. In the *Check In File(s) dialog* box select the files.
3. To update the version control copy but keep the files checked out so that you can continue working, select the *Keep Checked Out* check box.
4. To remove the file from the working directory and from the *.evc file, and from the VC Files Tab, select Remove Local Copy.
5. **OPTIONAL:** In the *Comment* text box type a description of the changes.
6. Click OK.  
   Rapid SQL saves the modified file(s) into version control.

For more information, see [Using Version Control](#).

**VERSION CONTROL FUNCTIONALITY - UNDO CHECK OUT**

If you decide that you do not want to save any revisions you have made to a checked out file, you can undo the procedure that releases the lock placed on the project or file. However, you do not have the option of deleting the local copy of the file.

**TIP:** You can specify the file directory in the Version Control Working Directory option of the Options Editor. For details, see [Version Control Options](#).

The table below describes the options and functionality on the Undo Check Out dialog box.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cancel the checkout for the following files</td>
<td>Lets you specify the files to undo checkout.</td>
</tr>
<tr>
<td>Advanced</td>
<td>Opens the Undo Check Out Advanced Options dialog box that lets you leave, replace, or apply the default action to your local copy.</td>
</tr>
</tbody>
</table>
**Undoing Checkout for a Project**
To undo a checkout, do the following:

1. Click File and then Open Project.
   - Rapid SQL opens the Open Project dialog box.

2. Type the project name or select the project.

3. Click Open.
   - Rapid SQL opens the project on the Projects Tab.

4. Click the project.

5. On the Project menu, click Version Control.
   OR
   On the Project toolbar, click Undo Check Out.
   OR
   On the Project Tab, right-click a project or file.

6. Click **Undo Check Out**.
   - Rapid SQL opens the Undo Check Out dialog box.

7. In the **Cancel the check out for the following files** box of the **Undo Check Out** dialog box, click the project.

8. Click **OK**.
   - Rapid SQL undoes the check out the project from version control.

**NOTE:** If you Undo Check Out, you lose any changes you have made to the local copy of your project.

**Undoing Checkout for a File**
To undo checkout for a file, do the following:

1. On the VC Tab, right-click the target file(s) and select Undo Checkout.
   - Rapid SQL opens the Undo Checkout dialog box.

2. In the **Cancel the check out for the following files** box of the **Undo Check Out** dialog box, click the project.

3. Click **OK**.
   - Rapid SQL undoes the check out the file from version control.

**NOTE:** If you Undo Check Out, you lose any changes you have made to the local copy of your file(s).
For more information, see Using Version Control.

**VERSION CONTROL FUNCTIONALITY - SHOW HISTORY**
The Show History functionality lets you view the history of version control files.

**Showing History for a Project**
To show history, do the following:

1. Click File and then Open Project.
   Rapid SQL opens the Open Project dialog box.
2. Type the project name or select the project.
3. Click Open.
   Rapid SQL opens the project on the Projects Tab.
4. Click the target file.
5. On the **Project** menu, click Version Control, and then select Show History.
   OR
   On the Project Tab, right-click the a file, and then select Show History.
   Rapid SQL opens the History Options dialog box.

   **NOTE:** The History dialog box depends on your version control system.

**Showing History for a File**
To show history, do the following:

1. On the **VC** Tab, right-click the target file(s) and select Show History.
   Rapid SQL opens the History Options dialog box.

   **NOTE:** The History dialog box depends on your version control system.

For more information, see Using Version Control.

**VERSION CONTROL FUNCTIONALITY - SHOW DIFFERENCES**
The Show Differences functionality lets you view any differences between the current files in your working folder and the master files in the version control database. You cannot make changes to the files from this dialog box because it is used for display purposes only.
**Viewing Project Differences**

To view project differences, do the following:

1. Click File and then Open Project.
   
   Rapid SQL opens the Open Project dialog box.

2. Type the project name or select the project.

3. Click Open.
   
   Rapid SQL opens the project on the Projects Tab.

4. Click the target file.

5. On the Project menu, click Version Control.

   OR

   On the Project Tab, right-click a file.

6. Click **Show Differences**.

   Rapid SQL opens the Differences dialog box.

   If the file in your working directory is the same as the one in the project, a message tells you they are identical. If there are differences, the Differences dialog box from your version control system opens and displays the two versions of the file side-by-side, highlighting any differences.

7. In the **Differences** dialog box, you can maneuver through the files by using the Up and Down arrows.

8. To set **Diff Options**, click the **Options** button.

   **NOTE:** The Differences dialog box and Options depend on your version control system.

**Showing History for a File**

To show history, do the following:

1. On the VC Tab, right-click the target file(s) and select Show History.

   Rapid SQL opens the Difference Options dialog box.

2. In the **Difference Options** dialog box, you can maneuver through the files by using the Up and Down arrows.

   **NOTE:** The Difference Options dialog box and options depend on your version control system.

For more information, see [Using Version Control](#).
**VERSION CONTROL FUNCTIONALITY - REMOVE FROM VERSION CONTROL**

The Remove from Version Control functionality lets you remove entire projects or files from version control.

**NOTE:** This functionality does not destroy the file permanently from the source control system or remove the local copies of the file(s).

**Removing a Project from Version Control**

To remove a project from Version Control, do the following:

1. Click File and then Open Project.
   
Rapid SQL opens the Open Project dialog box.

2. Type the project name or select the project.

3. Click Open.
   
Rapid SQL opens the project on the Projects Tab.

4. On the Project menu, click Version Control, and then click Remove from Version Control.
   OR
   On the Project Tab, right-click a project file, and then click Remove from Version Control.
   
Rapid SQL opens the Remove File(s) dialog box.

5. To permanently destroy the project select the check box, click OK.
   
Rapid SQL removes the project from version control. The project remains active in Rapid SQL.

**Removing a File from Version Control**

The table below describes the options and functionality of the Remove Files dialog box:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Files to be removed</td>
<td>Lets you specify the files to be removed from version control. NOTE: Does not delete the file(s) in version control.</td>
</tr>
</tbody>
</table>

To remove a file from Version Control, do the following:

1. On the VC Tab, right-click the target file(s) and select Remove from Version Control.
   
Rapid SQL opens the Remove File(s) dialog box.

2. Specify the file(s).

3. Click OK.

Rapid SQL removes the file(s) from version control. The project remains active in Rapid SQL.
For more information, see Working with Files in Version Control.

**VERSION CONTROL PROPERTIES**
The Version Control File Properties dialog box displays general information and check out status, links, and paths.

**Viewing Version Control Properties for a Project**
To view the version control properties, do the following:

1. Click File and then Open Project.
   
   Rapid SQL opens the Open Project dialog box.

2. Type the project name or select the project.

3. Click Open.
   
   Rapid SQL opens the project on the Projects Tab.

4. Click the target file.

5. On the **Project** menu, click Version Control, and then Version Control Properties.

   **OR**

   On the Project Tab, right-click the a file, and then select Version Control Properties.

   Rapid SQL opens the Version Control Properties dialog box.

6. Review properties.

7. Click Close.

**Viewing Version Control Properties for a File**
To view the version control properties, do the following:

1. On the VC Tab, right-click the target file(s) and select Version Control Properties.

   Rapid SQL opens the Version Control Properties dialog box.

2. Review properties.

3. Click Close.

For more information, see Using Version Control.

**VERSION CONTROL FUNCTIONALITY - EXPAND ALL**
The Expand All functionality expands all tree items under the selected item(s).
For more information, see Working with Files in Version Control.

VERSION CONTROL FUNCTIONALITY - COLLAPSE ALL
The Collapse All functionality collapses all tree items under a selected item(s).
For more information, see Working with Files in Version Control.

VERSION CONTROL FUNCTIONALITY - REFRESH
The Refresh functionality obtains the current version control status for the file(s).
For more information, see Working with Files in Version Control.

VERSION CONTROL FUNCTIONALITY - CLOSE FILES LIST
The Close Files List functionality closes the list of files.
For more information, see Working with Files in Version Control.
Tools

Rapid SQL incorporates a number of powerful tools to help you create, edit and manage your development environment. You can use Tools to:

- Conduct extensive database searches across multiple databases.
- Execute scripts or files across multiple databases.
- Schedule tasks.
- Identify differences in files or objects.
- Graphically build complex queries.
- Auto-generate complete procedures and packages.
- Code and test basic macros.
- Administer your ODBC data sources.

Tools is divided into sections. The table below describes each section:

<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Find in Files</td>
<td>This section describes the Find in Files dialog box that lets you find a phrase or character in your files.</td>
</tr>
<tr>
<td>Database Search</td>
<td>This section describes the powerful database search utility that helps you to find instances of a string across multiple databases.</td>
</tr>
<tr>
<td>Script Execution Facility</td>
<td>This section describes the Rapid SQL Script Execution Facility, a stand-alone utility that establishes multiple threads and database connections letting you simultaneously execute SQL statements against multiple Oracle, Sybase Adaptive Server, Microsoft SQL Server, and IBM DB2 LUW for Open Systems datasources.</td>
</tr>
<tr>
<td>File Execution Facility</td>
<td>This section describes the Rapid SQL File Execution Facility, a stand-alone utility that establishes multiple threads and database connections that lets you execute parallel queries and ANSI SQL files against multiple, cross-platform datasources.</td>
</tr>
<tr>
<td>Scheduling</td>
<td>The Rapid SQL scheduling programs and utilities let you schedule and execute jobs on local datasources anytime.</td>
</tr>
<tr>
<td>Visual Difference</td>
<td>Rapid SQL lets you compare two files or database objects. Using the Visual Difference Utility, you can easily synchronize and analyze database objects or files across multiple database platforms.</td>
</tr>
<tr>
<td>Query Builder</td>
<td>This section describes Query Builder, a tool that lets you construct, structure, and manipulate up to five different types of queries simultaneously.</td>
</tr>
</tbody>
</table>
FIND IN FILES

The Find in Files dialog box lets you find a phrase or character in your files.

Completing the Find in Files Dialog Box

1. On the Tools menu, click Find in Files.
   OR
   On the Tools toolbar, click Find in Files.

   Rapid SQL opens the Find in Files dialog box.

---

<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Editor</td>
<td>This section describes the Data Editor to edit your tables in real-time. The Data Editor supports all editable datatypes and is an alternative way to add, edit, or delete data from your tables.</td>
</tr>
<tr>
<td>Code Generation Facility</td>
<td>This section describes the Code Generation Facility that offers a quick way to generate DML statements for tables and views.</td>
</tr>
<tr>
<td>Import Data</td>
<td>This section describes the Import Data Wizard that lets you create insert statements based on external files including Excel spreadsheets and text files.</td>
</tr>
<tr>
<td>Embarcadero Products</td>
<td>The Tools menu lists all installed Embarcadero Technologies products. This lets you toggle to or start another Embarcadero product.</td>
</tr>
<tr>
<td>Code Workbench</td>
<td>This section describes the Code Workbench that lets you enable table column look-up and population in the ISQL window, define auto replacement expressions that can be used to quickly insert commonly used blocks of SQL syntax or commands in any open window and to import and export Code Workbench specific settings for client sharing purposes.</td>
</tr>
</tbody>
</table>
The table below describes the options and functionality on the Find in Files dialog box:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Find what</td>
<td>Specifies the character(s) or phrase you want to find. Use the browse arrow button next to the textbox to choose options from a pop-up list.</td>
</tr>
<tr>
<td>In files/file types</td>
<td>Specifies the files in which to search for the character(s) or phrase. Either enter the filename(s) in the drop-down box, or click the arrow to choose a file type.</td>
</tr>
<tr>
<td>In folder</td>
<td>Specifies the directory where the file(s) is located. Click the browse button to view your Windows Explorer.</td>
</tr>
<tr>
<td>Match whole word only</td>
<td>Specifies the application to find only the entire phrase.</td>
</tr>
<tr>
<td>Match case</td>
<td>Specifies the application to find only the specified phrase in the case you have entered.</td>
</tr>
<tr>
<td>Regular Expression</td>
<td>Tells the application whether the specified character(s) is a regular expression.</td>
</tr>
<tr>
<td>Look in subfolders</td>
<td>Specifies the application to search the file(s) any folders located within the specified folder.</td>
</tr>
<tr>
<td>Output to Pane 2</td>
<td>Specifies the application to display the results in another window.</td>
</tr>
</tbody>
</table>

**NOTE:** You can also use the Find feature to locate a phrase or character in an ISQL window.

**DATABASE SEARCH**

The powerful database search utility helps you to find instances of a string across multiple databases.

**Starting the Database Search Wizard**

1. On the Tools menu, click Database Search.
   
   OR
   
   On the Tools toolbar, click Database Search.
   
   Rapid SQL opens the first panel of the Database Search Wizard.

**DATABASE SEARCH WIZARD - PANEL 1**

The first panel of the Database Search Wizard lets you specify the owner.
The table below describes the options and functionality on the first panel of the Database Search Wizard:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select the owner(s) whose objects you would like to search</td>
<td>Lets you expand the nodes, select the target owner, and then click the right arrow button to include the target owner.</td>
</tr>
</tbody>
</table>

1 Click Next.

Rapid SQL opens the next panel of the wizard.

**DATABASE SEARCH WIZARD - PANEL 2**

The second panel of the Database Search Wizard lets you specify the search criteria.

The table below describes the options and functionality on the second panel of the Database Search Wizard:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Search Database For</td>
<td>Lets you enter the search string. Strings can also be searched for using DB2-standard wildcards. And for multiple string searches, separate each string with a vertical bar (for example, DEPARTMENTS</td>
</tr>
<tr>
<td>Match Case</td>
<td>Select Yes to make the search case sensitive.</td>
</tr>
<tr>
<td>Search DDL of these Objects</td>
<td>In the grid, select the target object check boxes.</td>
</tr>
</tbody>
</table>

1 Click Execute to start the operation.

Rapid SQL displays a progress dialog box while the search runs. When the search completes, Rapid SQL opens the **Database Search Window**.

**DATABASE SEARCH RESULTS**

Rapid SQL displays Database Search operation results in a Database Search Window, listing all of the objects containing the search string in the left pane. You can browse instances of the search string by selecting different objects in the tree. The DDL of the objects displays in the right pane and the search string is highlighted.
The table below describes the buttons on the Database Search Window toolbar:

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Search</td>
<td>Opens the first panel of the Database Search Wizard.</td>
</tr>
<tr>
<td>Criteria</td>
<td>Opens the Search Criteria dialog box.</td>
</tr>
<tr>
<td>Open</td>
<td>Opens the editor for the target object.</td>
</tr>
<tr>
<td>Extract</td>
<td>Lets you extract the target object.</td>
</tr>
<tr>
<td>Print</td>
<td>Lets you print the target object SQL.</td>
</tr>
</tbody>
</table>

**SCRIPT EXECUTION FACILITY**

Rapid SQL’s Script Execution Facility is a stand-alone utility that establishes multiple threads and database connections letting you simultaneously execute SQL statements against multiple Oracle, Sybase Adaptive Server, Microsoft SQL Server, and IBM DB2 LUW for Linux, Unix, and Windows datasources. After completing a scheduled job, Rapid SQL generates a results report that lists errors, verifies script execution, and details the output of the job. The Script Execution Facility also works in conjunction with Rapid SQL’s scheduling facilities, letting you schedule script execution jobs. When used in conjunction with a scheduler, Rapid SQL can automatically send the results report to any e-mail or network recipients. The Script Execution Facility is a tabbed dialog box where you set the parameters and options for the script execution. In the Script Execution Facility dialog box you can:

- Type or paste the target SQL script.
- Specify the datasources against which to execute the script.
- Specify the output mode for the results report.
- Open one of the Rapid SQL scheduling programs to schedule the script execution.
- Specify execution notification e-mail and Net Send addresses.

For more information, see [Completing the Script/File Execution Facility](#).

**FILE EXECUTION FACILITY**

Rapid SQL’s File Execution Facility is a stand-alone utility that establishes multiple threads and database connections that lets you execute parallel queries and ANSI SQL files against multiple, cross-platform datasources. The Script Execution Facility also works in conjunction with Rapid SQL’s scheduling facilities, letting you schedule script execution jobs. After completing a scheduled job, Rapid SQL generates a results report that lists errors, verifies execution, and details the output of the job. When used in conjunction with a scheduler, Rapid SQL can automatically send the results report to any e-mail or network recipients. The File Execution Facility is a tabbed dialog box where you set the parameters and options for the file execution. In the File Execution Facility dialog box you can:
• Specify the target files or ANSI SQL scripts.
• Specify the datasources against which to execute the files.
• Specify the output mode for the results report.
• Open one of the Rapid SQL scheduling programs to schedule the file execution.
• Specify execution notification e-mail and Net Send addresses.

For more information, see Completing the Script/File Execution Facility.

COMPLETING THE SCRIPT/FILE EXECUTION FACILITY
Rapid SQL lets you run parallel queries against multiple datasources with the File Execution Facility.

1 On the Tools menu, click Script Execution Facility or File Execution Facility.
OR
   On the Tools toolbar, click Script Execution Facility or File Execution Facility.
   Rapid SQL opens the Script or File Execution Facility dialog box.

2 Complete the Script Tab (Script Execution Facility)
3 Complete the Files Tab (File Execution Facility)
4 Complete the Target Tab.
5 Complete the Output Tab.
6 Complete the Notify Tab.

For more information, see:
File Execution Facility
Script Execution Facility

SCRIPT EXECUTION FACILITY - SCRIPT TAB
The table below describes the options and functionality on the Script Tab of the File/Script Execution Facility:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Script box</td>
<td>Lets you type or paste a script.</td>
</tr>
</tbody>
</table>

For more information, see:
File Execution Facility
**FILE EXECUTION FACILITY - FILES TAB**

The table below describes the options and functionality on the Files Tab of the File Execution Facility:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show Full File Paths</td>
<td>Select to display the full path. Deselect to display only the file name.</td>
</tr>
<tr>
<td>File Name</td>
<td>Displays the file names.</td>
</tr>
<tr>
<td>Add</td>
<td>Click to open the Select Files dialog box.</td>
</tr>
<tr>
<td>Remove</td>
<td>Click to remove the selected file.</td>
</tr>
<tr>
<td>View</td>
<td>Opens the View File dialog box.</td>
</tr>
<tr>
<td>Up</td>
<td>Click to move the selected file up in the list.</td>
</tr>
<tr>
<td>Down</td>
<td>Click to move the selected file down in the list.</td>
</tr>
</tbody>
</table>

For more information, see:

- [File Execution Facility](#)
- [Script Execution Facility](#)
- [Completing the Script/File Execution Facility](#)

**FILE/SCRIPT EXECUTION FACILITY - TARGET TAB**

The table below describes the options and functionality on the Target Tab of the File/Script Execution Facility:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| Select the Target Datasource(s) to Execute the Script Against | Only Connected Datasources - Displays only datasources that are currently connected in the Datasource grid.  
All DBMS Types - Displays all DBMS types in the Datasource grid. |
| Datasource grid                                  | Displays the target datasource(s) to execute the script/file against. Select a datasource name. If the datasource has multiple databases, type in a database in the Database box. |

For more information, see:

- [File Execution Facility](#)
- [Script Execution Facility](#)
FILE/SCRIPT EXECUTION FACILITY - OUTPUT TAB

The table below describes the options and functionality on the Output Tab of the File/Script Execution Facility:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Graphical Output</td>
<td>If selected, specifies a graphical output.</td>
</tr>
</tbody>
</table>
| File Output             | If selected, specifies a file output. Directory - Type or browse to enter the full path and directory name in which you want to place the output file.  
                           | File Type - Specifies a file type.  
                           | Include column titles when saving - If selected, lets you save column titles.  
                           | Open files with registered applications - If selected, opens files with registered applications.                                                                                                             |

For more information, see:

- File Execution Facility
- Script Execution Facility
- Completing the Script/File Execution Facility

FILE/SCRIPT EXECUTION FACILITY - NOTIFY TAB

The table below describes the options and functionality on the Notify Tab of the File/Script Execution Facility:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Job Description</td>
<td>Lets you enter a job description. This description will be the subject of the notification E-mail.</td>
</tr>
<tr>
<td>E-mail address</td>
<td>Lets you enter E-mail addresses. Separate each E-mail address with a semicolon (;).</td>
</tr>
<tr>
<td>Net Send User Names</td>
<td>Lets you enter net send user names. Separate each name with a semicolon (;).</td>
</tr>
</tbody>
</table>

For more information, see:

- File Execution Facility
- Script Execution Facility
- Completing the Script/File Execution Facility
SCHEDULING

The Rapid SQL scheduling programs and utilities let database administrators schedule and execute jobs on local datasources 24-hours-a-day, 7-days-a-week.

Rapid SQL offers the following programs and utilities to let you schedule routine tasks and jobs:

- Microsoft Task Scheduler
- ETSQLX Command Line Utility

MICROSOFT TASK SCHEDULER

Rapid SQL lets you use the Microsoft Task Scheduler to schedule jobs. The Microsoft Task Scheduler is included with various Microsoft applications. If you do not have this program on your system, the first time you attempt to schedule a job, Rapid SQL provides you with a link to the Microsoft Web site where you can download the Microsoft Task Scheduler at no cost.

NOTE: Rapid SQL’s ETSQLX command line utility runs a scheduled job even if Rapid SQL is not running. For more information, see ETSQLX Command Line Utility.

To open the Microsoft Job Scheduler from within Rapid SQL

1. On the Tools menu, click Scheduler.
2. Use the associated online Help for assistance with using this Microsoft utility.

ETSQLX COMMAND LINE UTILITY

Rapid SQL’s ETSQLX command line utility, is a multi threaded, cross-platform, SQL scripting engine. You can use ETSQLX in conjunction with the Microsoft Task Scheduler to schedule and automate routine jobs. ETSQLX creates batch files (with the extension.cfg) containing commands to execute automated and scheduled jobs. ETSQLX creates a directory, CFG, in which it stores the.cfg files. You can run.cfg files directly from the command line.

NOTE: ETSQLX supports.csv,.tab,.htm, and.html formats for result reports attachments.
VISUAL DIFFERENCE

Rapid SQL lets you compare two files or database objects. Using the Visual Difference dialog box, you can easily synchronize and analyze database objects or files across multiple database platforms. The files are displayed side by side in the Visual Difference dialog box. The Visual Difference Utility highlights any differences between two files. Viewing differences between objects and files helps you negotiate between the different phases of development as well as providing a visual aid to rapidly changing and evolving production environments.

**NOTE:** Because contents of the Visual Difference dialog box are read-only, you will not be able to modify your files or objects directly from this dialog box.

The Visual Difference dialog box is composed of two panes; the left pane displays your source object or file and the right pane shows your target object or file. The Visual Difference dialog box also contains its own toolbar which lets you:

- Search
- Navigate differences
- Set options
- Print

**Opening the Visual Difference Dialog Box**

1. On the **Tools** menu, click **Visual Diff**.

   OR

2. On the **Tools** toolbar, click **Visual Diff**.

   Rapid SQL opens the Visual Difference dialog box.

For more information, see:

- Comparing Files
- Comparing Database Objects
- Navigating in the Visual Difference Dialog Box
- Printing a Pane of the Visual Difference Dialog Box
- Searching in the Visual Difference Dialog Box
- Setting Options in the Visual Difference Dialog Box

**COMPARING FILES**

You can compare two files side-by-side in the Visual Difference dialog box. The file you want to compare is called the Source. The file you want to compare the first file to is the Target.
Comparing Items
   OR
   On the Tools toolbar, click Visual Diff.
   Rapid SQL opens the Visual Difference dialog box.
2. On the Visual Difference toolbar, click the Source icon or click the Down arrow next to the Source icon and then click File.
   Rapid SQL opens the Select the 1st File to Compare dialog box.
3. Click the file that you want to be the Source file.
4. On the Visual Difference toolbar, click the Target icon or click the Down arrow next to the Target icon and then click File.
   Rapid SQL opens the Select the 2nd File to Compare dialog box.
   NOTE: The Visual Difference Utility highlights all differences between the two files.

For more information, see Visual Difference Utility.

COMPARING DATABASE OBJECTS
The schema of database objects is automatically extracted so you can view the underlying differences between object and perform a side-by-side comparison in the Visual Difference Dialog.

Comparing Database Objects
   OR
   On the Tools toolbar, click Visual Diff.
   Rapid SQL opens the Visual Difference dialog box.
2. On the Visual Difference toolbar, click the Down arrow next to the Source icon and then click Database Object.
   Rapid SQL opens the Select the 1st Database Object to Compare dialog box.
3. Click the datasource and then click OK to connect.
4. Navigate through the datasource tree and double-click the database object that you want to be the Source.
5 On the Visual Difference toolbar, click the Down arrow next to the Target icon and then click Database Object.

Rapid SQL opens the Select the 2nd Database Object to Compare dialog box.

**NOTE:** The Visual Difference Utility highlights all differences between the two database objects.

For more information, see Visual Difference Utility.

**NAVIGATING IN THE VISUAL DIFFERENCE DIALOG BOX**
You can navigate through the Visual Difference dialog box using the up and down arrow buttons. You can move back and forth between highlighted differences in your compared files or database objects.

**Going To the Next Difference**
1 From the Visual Difference dialog box, click down arrow to go to the next difference.

**Going To the Previous Difference**
1 From the Visual Difference dialog box, click up arrow to go to the next difference.

For more information, see Visual Difference Utility.

**PRINTING A PANE OF THE VISUAL DIFFERENCE DIALOG BOX**
You can print each pane of the Visual Difference dialog box.

**Printing a Pane of the Visual Difference Dialog Box**
1 Position your cursor inside the pane you want to print.
2 Click the Print icon on the Visual Difference toolbar.
   Rapid SQL opens the Print Setup dialog box.
3 Click OK to print the pane.
   **NOTE:** You can only print one pane of the Visual Difference dialog box at a time.

For more information, see Visual Difference Utility.

**SEARCHING IN THE VISUAL DIFFERENCE DIALOG BOX**
The Visual Difference dialog box lets you search for text in your files or database objects.
Searching for Text
1. Place your cursor inside the pane you want to search.
2. Click the Find icon on the Visual Difference toolbar.
   Rapid SQL opens the Find dialog box.
3. In the Find What box, enter the search string.
4. To match whole words only, select the Match whole word only check box.
5. To make the search case sensitive, select the Match case check box.
6. Click Find Next to find the next occurrence of your search string. You can also click the Find Next icon on the Visual Difference toolbar to search for the next occurrence at a later time.

For more information, see Visual Difference Utility.

Setting Options in the Visual Difference Dialog Box
The Visual Difference dialog box lets you set display and comparison options to help you customize the dialog box to view differences in a comprehensive manner.

Setting Options
1. Click the Options icon on the Visual Difference toolbar.
   Rapid SQL opens the Visual Diff Options dialog box.

The following table describes the check box options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display Line Numbers</td>
<td>Indicates that line numbers should appear in the Visual Diff dialog box.</td>
<td>Off</td>
</tr>
<tr>
<td>Display Hidden Characters</td>
<td>Indicates that hidden characters (nonprintable) should be displayed.</td>
<td>Off</td>
</tr>
<tr>
<td>Ignore White Space</td>
<td>Indicates that White Space (such as spaces, carriage returns, line feeds, and tabs) should be ignored. If this option is set on, text will be considered equivalent regardless of white space, otherwise the text will be shown as being different.</td>
<td>On</td>
</tr>
<tr>
<td>Ignore Hidden Characters</td>
<td>Indicates that hidden characters (nonprintable) should be excluded.</td>
<td>Off</td>
</tr>
<tr>
<td>Ignore Case</td>
<td>Indicates that case should not be a differentiating factor.</td>
<td>On</td>
</tr>
</tbody>
</table>

2. Click OK.
   Rapid SQL accepts the options.
QUERY BUILDER

Query Builder is a database productivity tool that lets you construct, structure, and manipulate up to five different types of queries simultaneously. It includes a separate graphical interface that opens within your current workspace. You can run Query Builder against all Embarcadero Technologies supported database platforms.

Query Builder displays the interconnections of your queries as you work. The powerful visual components of Query Builder let you see your query grow and change to fit your needs. Query Builder eases the task of drawing data from tables by automatically creating correct SQL code as you build a statement. You can use Query Builder to create and execute SELECT statements for tables and views. You can also test queries, and easily adjust your information, before you save. Query Builder does not rely on knowledge of the underlying SQL code.

You can save and reopen queries in Query Builder. Query Builder automatically checks for changes in your tables or columns between the time you save the query and the time you reopen it.

The table below describes the types of queries available in Query Builder:

<table>
<thead>
<tr>
<th>Query Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SELECT</td>
<td>Create, manipulate and execute SELECT Statements for tables and views.</td>
</tr>
<tr>
<td>INSERT</td>
<td>Create and manipulate INSERT Statements for tables.</td>
</tr>
<tr>
<td>UPDATE</td>
<td>Create and manipulate UPDATE Statements for tables.</td>
</tr>
<tr>
<td>DELETE</td>
<td>Create and manipulate DELETE Statements for tables.</td>
</tr>
<tr>
<td>CREATE VIEW</td>
<td>Create and manipulate CREATE VIEW Statements for tables and views.</td>
</tr>
</tbody>
</table>

**NOTE:** You can execute SELECT statements directly from Query Builder. INSERT, UPDATE, DELETE, and CREATE VIEW statements must be moved to an ISQL Editor for execution.

For more information, see:
- Query Builder Design
- Using Query Builder
QUERY BUILDER DESIGN

Query Builder lets you build DML statements using an intuitive, graphical interface. It offers you a powerful and flexible way to quickly create complex statements without sacrificing time manipulating SQL code. Query Builder lets you add tables or columns, create joins, and change statements within the graphic display without leaving Rapid SQL. It also lets you have multiple sessions working at the same time.

Query Builder includes many different features to assist you in building and manipulating your query:

- Query Builder Statement Properties
- Workspace Windows
- Query Builder Explorer
- Tool Bar
- SQL Diagram Pane
- SQL Statement Pane

For more information, see Build Query.

WORKSPACE WINDOWS

The Workspace Windows provide a comprehensive view of your data structure and query. The table below describes the Workspace Windows:

<table>
<thead>
<tr>
<th>Pane</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Query Builder Explorer Window</td>
<td>Includes two tabs that display selected object details:</td>
</tr>
<tr>
<td></td>
<td>Tables/Views</td>
</tr>
<tr>
<td></td>
<td>DML</td>
</tr>
<tr>
<td>SQL Diagram Pane</td>
<td>Displays tables or views included in the current query.</td>
</tr>
<tr>
<td>SQL Statement Pane</td>
<td>Displays the SQL code, and when appropriate, a Results Tab.</td>
</tr>
</tbody>
</table>

For more information, see Build Query.

QUERY BUILDER EXPLORER WINDOW

The Query Builder Explorer is a separate tree that exposes all the tables and views in your target database. It also displays your current query structure. The Query Builder Explorer includes two tabs that display information about the selected objects:

- Tables/Views
- DML
Tables/Views Tab
The Tables/View Tab displays information about the selected tables or views. You can use the drop-down lists to change your table or view, and when appropriate, the owner. The table below describes each drop-down list on the Tables/Views Tab:

<table>
<thead>
<tr>
<th>List</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>First</td>
<td>Displays all databases for a target Microsoft SQL Server or Sybase ASE.</td>
</tr>
<tr>
<td>Second</td>
<td>Displays all valid owners.</td>
</tr>
</tbody>
</table>

NOTE: To change your current database, select the new database in the Explorer, and then open another Query Builder session. Query Builder prompts you to save the current session prior to opening a new session.

DML Tab
The DML Tab displays all the basic elements of a query statement in the SQL Statement Tree. You can access any element of the current statement display and perform SQL editing from the SQL Statement Tree.

For more information, see:
Creating a Clause Using the SQL Statement Tree
Build Query

SQL Diagram Pane
The SQL Diagram Pane displays tables, views, and joins included in the current query. You can manipulate elements of your query, using the mouse functionality, in the SQL Diagram Pane. From the SQL Diagram Pane you can:

- Add and Remove tables and views.
- Create and delete joins.
- Add and Subtract columns.

All changes in the SQL diagram reflect in correct SQL code in the SQL Statement Pane.

For more information, see Build Query.

SQL Statement Pane
The SQL Statement Pane displays the current query SQL code. When you run a query, Query Builder displays results to your query in the SQL Statement Pane. The SQL Statement Pane is divided into two tabs:

- SQL Tab
- **Results Tab**

**SQL Tab**
The SQL Tab displays the query in progress. It displays each element of your query as you build it, and updates as you do edits such as selecting or deselecting columns, adding clauses, and creating joins. Rapid SQL lets you open the current statement directly into an ISQL editor or copy it to the clipboard for later use.

**Results Tab**
The Results Tab displays the results of your executed query in the Results grid. To edit data, use the Data Editor application from Query Builder. When you begin building a new query, the tab title changes to Old Results until you execute the new query.

For more information, see Build Query.

**QUERY BUILDER TOOL BAR**
The Query Builder tool bar lets you access commonly used features.

The table below describes Query Builder tool bar functionality:

<table>
<thead>
<tr>
<th>Name</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copy</td>
<td>Copies the current SQL statement to the clipboard.</td>
</tr>
<tr>
<td>Statement Box</td>
<td>Displays the type of statement currently on display in the main workspace window.</td>
</tr>
<tr>
<td>Stop Execution</td>
<td>Stops an executing query.</td>
</tr>
<tr>
<td>Execute</td>
<td>Executes the current SELECT or CREATE VIEW statement. If the button is not available, the statement is not executable.</td>
</tr>
<tr>
<td>New</td>
<td>Adjusts to the target node in the Query Builder Explorer window.</td>
</tr>
<tr>
<td>Edit</td>
<td>Displays, on the DML Tab, the ORDER BY or GROUP BY dialog boxes when target node is selected.</td>
</tr>
<tr>
<td>Delete</td>
<td>Deletes the target object.</td>
</tr>
<tr>
<td>Auto Layout</td>
<td>Resets the main workspace to the auto layout mode.</td>
</tr>
<tr>
<td>Auto Join</td>
<td>Finds and joins, automatically, like items by name.</td>
</tr>
<tr>
<td>Statement Check</td>
<td>Checks query syntax.</td>
</tr>
<tr>
<td>Edit Data</td>
<td>Opens Data Editor.</td>
</tr>
<tr>
<td>Close</td>
<td>Closes the current query.</td>
</tr>
</tbody>
</table>

**NOTE:** Query Builder adjusts tool availability to match the current query functionality.

For more information, see Build Query.
TABLES AND VIEWS SHORTCUT MENUS
Query Builder includes a shortcut menu that lets you manipulate a table or view. The table below describes the table shortcut options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delete</td>
<td>Removes the table from the SQL Diagram Pane, and the SQL Statement.</td>
</tr>
<tr>
<td>Title Font</td>
<td>Specifies the table title font for this diagram.</td>
</tr>
<tr>
<td>Column Font</td>
<td>Specifies the column font for this diagram.</td>
</tr>
<tr>
<td>Background Color</td>
<td>Specifies the table background color for this diagram.</td>
</tr>
<tr>
<td>Select Star</td>
<td>Selects every column in the table.</td>
</tr>
<tr>
<td>Select None</td>
<td>Deselects every column in the table.</td>
</tr>
<tr>
<td>Bring to Front</td>
<td>Moves the table to the top layer of the diagram.</td>
</tr>
<tr>
<td>Properties</td>
<td>Opens the Table Properties dialog box.</td>
</tr>
</tbody>
</table>

**NOTE:** Your selection applies to all selected tables and views.

For more information, see Build Query.

TABLES AND VIEWS KEYBOARD COMMANDS
Query Builder provides a number of keyboard shortcuts that let you quickly construct queries. The table below describes the keyboard commands:

<table>
<thead>
<tr>
<th>Keyboard Command</th>
<th>Location</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ESCAPE</td>
<td>SQL Diagram Pane</td>
<td>Breaks off a join.</td>
</tr>
<tr>
<td>F5</td>
<td>Query Builder</td>
<td>Refreshes screen and runs Schema Change Detection. In a CREATE VIEW, this key adds the new view to the Table Tree Pane.</td>
</tr>
<tr>
<td>CTRL A</td>
<td>SQL Diagram Pane</td>
<td>Selects all tables and joins in the current diagram.</td>
</tr>
<tr>
<td>F1</td>
<td>Query builder and application</td>
<td>Obtains context sensitive Help.</td>
</tr>
</tbody>
</table>

For more information, see Build Query.
QUERY BUILDER DIALOG BOXES
Query Builder includes a number of dialog boxes to assist you in building and customizing your query.

<table>
<thead>
<tr>
<th>Dialog Box</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Statement Properties</td>
<td>Specifies general properties in an individual Query Builder session.</td>
</tr>
<tr>
<td>Table Properties</td>
<td>Specifies column selection and alias names for a table or view.</td>
</tr>
<tr>
<td>Column Properties</td>
<td>Specifies column functionality within SELECT and CREATE VIEW statements.</td>
</tr>
</tbody>
</table>

For more information, see Build Query.

STATEMENT PROPERTIES
The Statement Properties dialog box lets you customize properties in an individual Query Builder session. For example, you can set options to limit the number of rows returned in a query to save execution time, or turn off the auto join function to manually control all joins for an individual query. The table below describes the options and functionality of the Statement Properties dialog box.
<table>
<thead>
<tr>
<th>Interface Element</th>
<th>Option</th>
<th>Description</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Code Generation</td>
<td>Generate Use Database statement</td>
<td>Adds a line of SQL code indicating which database or instance is used in the statement.</td>
<td>Selected</td>
</tr>
<tr>
<td></td>
<td>Generate owner names</td>
<td>Adds a line of SQL code showing the table owner name as part of the query.</td>
<td>Selected</td>
</tr>
<tr>
<td></td>
<td>Include Row Count limits</td>
<td>Includes the output row limit set in the Execution settings.</td>
<td>Selected</td>
</tr>
<tr>
<td>Execution</td>
<td>Max Row Count in Results Set</td>
<td>Sets row count limits to build and check a query without congesting server processes when a query executes.</td>
<td>1000 rows</td>
</tr>
<tr>
<td>General</td>
<td>Show Column Data types in Query Diagram</td>
<td>Lets Query Builder reveal the data type in each column for tables in the SQL Diagram Pane.</td>
<td>Not selected</td>
</tr>
<tr>
<td></td>
<td>Confirm on Item delete</td>
<td>Lets Query Builder open a Confirm Delete dialog box when an item is deleted. NOTE: Clearing this function can result in unexpected changes to your query diagram and statement.</td>
<td>Selected</td>
</tr>
<tr>
<td></td>
<td>Auto populate views</td>
<td>Lets Query Builder automatically populate views.</td>
<td>Not selected</td>
</tr>
<tr>
<td>Auto Join</td>
<td>Require Indexes</td>
<td>Joins indexed columns automatically, and requires indexed columns for joins.</td>
<td>Selected</td>
</tr>
<tr>
<td></td>
<td>Require same data type</td>
<td>Automatically joins columns with the same data type.</td>
<td>Selected</td>
</tr>
<tr>
<td>Syntax Checker</td>
<td>Automatic Syntax Check</td>
<td>Lets Query Builder check syntax every time an execute statement, refresh or copy statement begins.</td>
<td>Selected</td>
</tr>
<tr>
<td></td>
<td>Run Automatically</td>
<td>Lets Query Builder automatically detect like names and data types and create joins for multiple tables.</td>
<td>Selected</td>
</tr>
<tr>
<td>Display</td>
<td>Columns Font</td>
<td>Lets you set the font, font style, size, and color of column fonts.</td>
<td>Available</td>
</tr>
<tr>
<td></td>
<td>Title Font</td>
<td>Lets you set the font, font style, size, and color of table/view title fonts.</td>
<td>Available</td>
</tr>
<tr>
<td></td>
<td>Table Color</td>
<td>Lets you set the background color of your tables in the SQL Diagram Pane.</td>
<td>Available</td>
</tr>
</tbody>
</table>

**NOTE:** If you set options while Query Builder is running, Rapid SQL displays a warning indicating that you are about to change options or properties.

For more information, see [Completing the Statement Properties Dialog Box](#).
COMPLETING THE STATEMENT PROPERTIES DIALOG BOX
To complete the Statement Properties dialog box, do the following:

1. On the Query Builder menu, click Statement Properties.

   OR
   In the SQL Diagram Pane, right-click, and then click Statement Properties.

2. Set options.

3. Click OK.
 Query Builder saves the options.

For more information, see Build Query.

TABLE PROPERTIES
The Tables Properties dialog box lets you set parameters for tables or views in your SQL Diagram. The table below describes the options and functionality on the Table Properties dialog box.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table Alias</td>
<td>Creates an alias name for your table.</td>
</tr>
<tr>
<td>Show Datatypes</td>
<td>Shows or hides the datatype for every column in the target table.</td>
</tr>
<tr>
<td>Displayed Columns</td>
<td>Displays columns visible in the SQL Diagram.</td>
</tr>
<tr>
<td>Hidden Columns</td>
<td>Displays columns hidden in the SQL Diagram.</td>
</tr>
<tr>
<td>Hide All</td>
<td>Moves all non selected columns in the table to the Hidden Columns window.</td>
</tr>
<tr>
<td>Display All</td>
<td>Moves all columns in the table to the Displayed Columns window.</td>
</tr>
<tr>
<td>Right Arrow</td>
<td>Moves a target file from Displayed Columns to Hidden Columns.</td>
</tr>
<tr>
<td>Left Arrow</td>
<td>Moves a target file from Hidden Columns to Displayed Columns.</td>
</tr>
</tbody>
</table>

For more information, see Completing the Table Properties Dialog Box.

COMPLETING THE TABLE PROPERTIES DIALOG BOX
To complete the Table Properties dialog box, do the following:

1. Double click the target table or view title bar.

   OR
   Right-click target table or view, and then click Properties.
2. If you only want to hide or display columns in your table, click the arrow button on the table title bar.

3. You can also edit view properties from the Table Properties dialog box.

4. Click OK.

   Query Builder saves the changes.

For more information, see Build Query.

COLUMN PROPERTIES
The Column Properties dialog box lets you set properties for individual columns in your SELECT or CREATE VIEW statements. You can set aggregate functions and create an alias for an individual column.

The Column Properties dialog box is not available for INSERT, UPDATE or DELETE statements.

The table below describes the options and functions Columns Properties dialog box:

<table>
<thead>
<tr>
<th>Interface Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tables/Views</td>
<td>Displays all tables and views in the SQL Diagram Pane.</td>
</tr>
<tr>
<td>Aggregate</td>
<td>Specifies aggregate options for the target column.</td>
</tr>
<tr>
<td></td>
<td>AVG - An average is taken for a column with an int or numeric datatype.</td>
</tr>
<tr>
<td></td>
<td>COUNT - Returns the number of rows which contain data for the target column.</td>
</tr>
<tr>
<td></td>
<td>MAX - Returns the highest number in a row in the column.</td>
</tr>
<tr>
<td></td>
<td>MIN - Returns the lowest number in a row in the column.</td>
</tr>
<tr>
<td></td>
<td>SUM - Returns the sum of the target column in all rows which contain data. This function is only operable on int or numeric datatypes.</td>
</tr>
<tr>
<td>Alias</td>
<td>Displays the alias name for the target column. Let you type the name of the alias.</td>
</tr>
<tr>
<td></td>
<td>NOTE: Query Builder displays the results of an aggregate column without a column name unless you create an alias for that column.</td>
</tr>
<tr>
<td>Available Columns</td>
<td>Displays all available columns in the target table or view.</td>
</tr>
<tr>
<td>Selected Columns</td>
<td>Displays all selected columns in the target table or view. To create an aggregate function or alias for a different column, select target column, select an aggregate function, and then type the name of the alias.</td>
</tr>
<tr>
<td>Select All</td>
<td>Moves all columns in the Available Columns box to the Selected Columns box.</td>
</tr>
<tr>
<td>Clear All</td>
<td>Moves all columns in the Selected Columns box to the Available Columns box.</td>
</tr>
</tbody>
</table>
Completing the Column Properties Dialog Box

To complete the Column Properties dialog box, do the following:

1. On the SQL Statement Tree, double-click target column.
2. Select options.
3. Click OK.

For more information, see Build Query.

JOIN PROPERTIES

Query Builder lets you edit joins with the Join editor. You can edit join parameters in a SELECT, UPDATE, DELETE, and CREATE VIEW Statement.

The table below describes the options and functionality on the Join dialog box.

<table>
<thead>
<tr>
<th>Interface Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Right Arrow</td>
<td>Moves target column in the Available Columns box to the Selected Columns box.</td>
</tr>
<tr>
<td>Left Arrow</td>
<td>Moves target column in the Selected Columns box to the Available Columns box.</td>
</tr>
<tr>
<td>Select List Statement</td>
<td>Displays the current query.</td>
</tr>
</tbody>
</table>

**NOTE:** For IBM DB2 LUW for Linux, Unix, and Windows servers, there is an additional join object in the SQL Statement Tree. The Join On node displays join relations between columns in IBM DB2 LUW for Linux, Unix, and Windows tables and views.
Completing the Join Dialog Box
To complete the Join dialog box, do the following:

1. In the SQL Diagram Pane, right-click the target join, and then click Properties.
   
   OR
   
   In the SQL Diagram Pane, double-click the target join.
   
   OR
   
   On the SQL Statement Tree, expand the Where and And nodes, and then double-click the target join.

2. Select options.

3. Click OK.

For more information, see Build Query.

Using Query Builder
Query Builder provides a visual display of your queries as you construct them. You can run Query Builder against any registered datasource in Rapid SQL. Query Builder lets you build five separate types of queries simultaneously:

- SELECT
- INSERT
- UPDATE
- DELETE
- CREATE VIEW

You can execute a SELECT statement from Query Builder. To execute an INSERT, UPDATE, DELETE, and CREATE VIEW statement, copy them to an ISQL Editor. You can also copy the statements to the clipboard for later use in the ISQL Editor. Query Builder also lets you save a statement at any time so that you can open them later for editing or execution.

Rapid SQL lets you open Query Builder with multiple tables or views with the same or different owners. If you open tables or views with different owners, Query Builder displays “All Owners” in the Owner drop-down list. You can start multiple Query Builder sessions from Rapid SQL. You can use different tables and views for each query. You can also toggle back and forth among each of the queries.

You can save and reopen queries in Query Builder. Query Builder automatically checks for changes in your database or instance between the time you save the query and the time you reopen it with the Schema Change detection component.

Query Builder is integrated with Data Editor so you can edit data in real time and then continue to build your query with the new information embedded in the query.
USING QUERY BUILDER
To use Query Builder, do the following:

- Select an instance or database
- Select a statement.
- Select a table(s) or view(s).
- Select a column or columns.

**NOTE:** You can start Query Builder directly from a table or view which automatically selects the instance or database which contains that table or view.

1. On the Tools menu, click Query Builder.
   
   OR
   
   On the Datasource Explorer, expand the Database or Schema node, click Tables, and then on the Command Menu, click Build Query.
   
   OR
   
   On the Tools tool bar, click Build Query.
   
   OR
   
   On the Explorer, expand Tables, right-click the target table(s), and then click Build Query.
   
   OR
   
   On the Explorer, expand Views, right-click the target view(s), and then click Build Query.

Rapid SQL opens Query Builder.

SELECTING A DATABASE
To create an SQL statement, first select an instance or database.

**NOTE:** You can start Query Builder directly from a table or view which automatically selects the database which contains that table or view.

If you are working with Microsoft SQL Server or Sybase ASE, Query Builder provides two drop-down lists. The first drop-down list displays all available databases for the target server. The second drop-down list displays owners.

If you are working with Oracle or IBM DB2 LUW for Linux, Unix, and Windows the first drop-down list is unavailable.

**NOTE:** You can start Query Builder directly from a table or view which automatically selects the database which contains that table or view.

1. Start Query Builder.

2. In the database drop-down list, click the target instance or database.
3 In the owners drop-down list, select the appropriate owner.

Query Builder is ready for Statement selection.

4 To select different instances or databases while Query Builder is running, on the Tables/Views Tab, in the database drop-down list, click the target instance or database.

Rapid SQL clears the current query and displays a warning prompt.

5 To save the current query, click Yes.

Rapid SQL opens the Save As dialog box.

6 To continue without saving, click No.

Rapid SQL clears the SQL Diagram Pane and SQL Statement Pane.

For more information on saving queries in Query Builder, see Saving and Reopening Queries.

SELECTING A STATEMENT
Query Builder lets you build SELECT, INSERT, UPDATE, DELETE, and CREATE VIEW queries simultaneously.

To select a statement, do the following:

1 On the Query Builder tool bar, click the statement drop-down list, and then click the target statement type.

OR

In the SQL Diagram Pane, right-click, and then click the target statement type.

For more information, see Using Query Builder.

SELECTING TABLES AND VIEWS
To build a query, open one or more tables or views in the SQL Diagram Pane. You can use different tables or views for each type of query.

TIP: For multiple tables: Press SHIFT+click for adjacent tables or CTRL+click for nonadjacent tables. You can also drag the bounding line with your pointer to select multiple tables.
To select a Table or View, do the following:

1. In the Tables/Views Tab, drag the target table or view to the Diagram Pane.

   OR

   In the Tables/Views Tab, click target table or view and then, on the Query Builder tool bar, click Add.

   OR

   In the Tables/Views Tab, right-click target table or view, and then click Add.

   Query Builder displays the target table(s) and view(s) in the SQL Diagram Pane.

For more information, see Using Query Builder.

SELECTING COLUMNS
You must select at least one column to build a query. Query Builder displays columns in each table in the SQL Diagram window. By default, Query Builder exposes every column in a table. You can select the columns you want to use for your query. Query Builder orders them, in your statement, in the select order.

Query Builder lets you select columns in the:

- SQL Diagram Pane.
- SQL Statement Tree.

You can select an individual column or all columns. Query Builder orders them, in your statement, in the select order. You can reorder columns after you set them in your diagram or statement.

For more information, see:

Selecting Columns in the SQL Diagram Pane
Selecting Columns in the SQL Statement Tree
Selecting All Columns

SELECTING COLUMNS IN THE SQL DIAGRAM PANE
To select a column in the SQL Diagram Pane, do the following:

1. Select the check box to the left of the target column name.

For more information, see Using Query Builder.

SELECTING COLUMNS IN THE SQL STATEMENT TREE
Query Builder lets you select and set individual properties using the Selected Column Properties Dialog Box.

For more information, see Using Query Builder.
SELECTING ALL COLUMNS
Query Builder uses columns in statements based on the order of selection. When you select all columns, Query Builder displays the columns in the order they appear in the table.

**NOTE:** Query Builder lets you select all columns in single or multiple tables.

To select all columns, do the following:

1. On the **Query Builder** menu, click Select Star.

OR

On the SQL Statement Tree, or in the SQL Diagram, right-click target table, or any of a group of selected tables, and then click Select Star.

For more information, see [Using Query Builder](#).

BUILDING A QUERY
Query Builder lets you build five different queries, which you can run separately or simultaneously, depending on your needs. The table below describes these queries:

<table>
<thead>
<tr>
<th>Query Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SELECT</td>
<td>Lets you create, manipulate and execute SELECT Statements for tables and views.</td>
</tr>
<tr>
<td>INSERT</td>
<td>Lets you create and manipulate INSERT Statements for tables.</td>
</tr>
<tr>
<td>UPDATE</td>
<td>Lets you create and manipulate UPDATE Statements for tables.</td>
</tr>
<tr>
<td>DELETE</td>
<td>Lets you create and manipulate DELETE Statements for tables.</td>
</tr>
<tr>
<td>CREATE VIEW</td>
<td>Lets you create and manipulate CREATE VIEW Statements for tables and views.</td>
</tr>
</tbody>
</table>

To build a Query, do the following:

- **Select an instance or database.**
- **Select a Statement.**
- **Select your table(s) or view(s).**
- **Select your columns.**

**NOTE:** You can start Query Builder directly from a table or view which automatically selects the database which contains that table or view.

Query Builder lets you build queries that include both **tables** and **views** in the SQL Diagram Pane for **SELECT** and **CREATE VIEW** statements. For the INSERT, UPDATE, and DELETE statements, use one or the other object, but you cannot use both.

Once you make your selections, you can edit, restructure, and streamline your query. Query Builder offers many options for streamlining your queries.
For more information, see:

- Working with Tables and Views in the SQL Diagram Pane
- Working with Columns in the SQL Diagram Pane
- Joins
- Creating a Clause using the SQL Statement Tree
- Moving Tables and Columns in the SQL Statement Tree
- Subqueries
- Aliases

**BUILDING A SELECT STATEMENT**

Query Builder lets you construct and execute simple-to-complex SELECT statements using data from any table or view. You can also create and edit joins for SELECT statements. Query Builder can check your query and warn you if there are syntax errors with the Syntax Checker.

To build a SELECT statement, do the following:

1. On the Tools menu, click Query Builder.
   - OR
   - On the Datasource Explorer, expand the Database or Schema node, click Tables, and then on the Command menu, click Build Query.
   - OR
   - On the Tools tool bar, click Query Builder.
   - OR
   - On the Explorer, expand Tables, right-click the target table(s), and then click Build Query.
   - OR
   - On the Explorer, expand Views, right-click the target view(s), and then click Build Query.

   Rapid SQL opens Query Builder.

2. In the statement drop-down list, click SELECT.

3. In the Table Tree Pane, select target table(s) or view(s) and move them to the SQL Diagram Pane.

4. In the target table or view, click target column(s), or click Select Star to select every column.

5. To check syntax, click Check.

6. To copy the statement, click Copy.

7. To execute the statement, click Execute.
Copying a SELECT Statement from the SQL Statement Pane
To copy any part of a statement from the SQL Statement Pane, do the following:

1. Open Query Builder, then begin a new SELECT statement.
   OR
   Open an existing SELECT statement.
2. In the SQL Statement Pane, select all, or the target portion of the statement.
3. On the Query Builder tool bar, click Copy.
   OR
   In the SQL Statement Pane, right-click, and then click Copy.

Query Builder makes the target statement portion available on the clipboard.

For more information, see Building a Query.

Building an INSERT Statement
Query Builder lets you construct and execute simple-to-complex INSERT statements using data from any table. To execute an INSERT statement, copy it to an ISQL Editor. You can also copy the statement to the clipboard for later use in the ISQL Editor. Query Builder also lets you save your statement at any time so that you can open it later for editing or execution.

Building an INSERT Statement
To build an INSERT Statement, do the following:

1. On the Tools menu, click Query Builder.
   OR
   On the Datasource Explorer, expand the Database or Schema node, click Tables, and then on the Command menu, click Build Query.
   OR
   On the Tools tool bar, click Query Builder.
   OR
   On the Explorer, expand Tables, right-click the target table(s), and then click Build Query.
   OR
   On the Explorer, expand Views, right-click the target view(s), and then click Build Query.

Rapid SQL opens Query Builder.

2. In the statement drop-down list, click INSERT.

3. In the Table Tree Pane, select target table, and move it to the SQL Diagram Pane.

4. In the target table, click target column(s).
Copying an INSERT Statement from the SQL Statement Pane
To copy any part of a statement from the SQL Statement Pane, do the following:

1. Open Query Builder, then begin a new INSERT statement.
   OR
   Open an existing INSERT statement.
2. In the SQL Statement Pane, select all, or the target portion of the statement.
3. On the Query Builder tool bar, click Copy.
   OR
   In the SQL Statement Pane, right-click, and then click Copy.
   Query Builder makes the target statement portion available on the clipboard.

For more information, see Building a Query.

Building an UPDATE Statement
Query Builder lets you construct and execute simple-to-complex UPDATE statement using data from any table. To execute an UPDATE statement, copy it to an ISQL Editor. You can also copy the statement to the clipboard for later use in the ISQL Editor. Query Builder also lets you save your statement at any time so that you can open it later for editing or execution.

Building an UPDATE Statement
To build an UPDATE statement, do the following:

1. On the Tools menu, click Query Builder.
   OR
   On the Datasource Explorer, expand the Database or Schema node, click Tables, and then on the Command menu, click Build Query.
   OR
   On the Tools tool bar, click Query Builder.
   OR
   On the Explorer, expand Tables, right-click the target table(s), and then click Build Query.
   OR
   On the Explorer, expand Views, right-click the target view(s), and then click Build Query.
   Rapid SQL opens Query Builder.
2. In the statement drop-down list, click UPDATE.
3. In the Table Tree Pane, select target table and move it to the SQL Diagram Pane.
4. In the target table, click target column(s).
Copying an UPDATE Statement from the SQL Statement Pane
To copy any part of a statement from the SQL Statement Pane, do the following:
1. Open Query Builder, then begin a new UPDATE statement.
   OR
   Open an existing UPDATE statement.
2. In the SQL Statement Pane, select all, or the target portion of the statement.
3. On the Query Builder tool bar, click Copy.
   OR
   In the SQL Statement Pane, right-click, and then click Copy.
Query Builder makes the target statement portion available on the clipboard.
For more information, see Building a Query.

Building a DELETE Statement
Query Builder lets you construct DELETE statements using data from any table. Query Builder displays a Confirmation Option Message box when you create a DELETE statement. You can set the Statement Properties dialog box to display or hide this message when creating a DELETE statement.
To execute a DELETE statement, copy it to an ISQL Editor. You can also copy the statement to the clipboard for later use in the ISQL Editor. Query Builder also lets you save your statement at any time so that you can open it later for editing or execution.

Building a DELETE Statement
To build a DELETE statement, do the following:
1. On the Tools menu, click Query Builder.
   OR
   On the Datasource Explorer, expand the Database or Schema node, click Tables, and then on the Command menu, click Build Query.
   OR
   On the Tools tool bar, click Query Builder.
   OR
   On the Explorer, expand Tables, right-click the target table(s), and then click Build Query.
   OR
   On the Explorer, expand Views, right-click the target view(s), and then click Build Query.
   Rapid SQL opens Query Builder.
2. In the statement drop-down list, click DELETE.
3 In the Table Tree Pane, select target table, and move it to the SQL Diagram Pane.

**Copying a DELETE Statement from the SQL Statement Pane**
To copy any part of a statement from the SQL Statement Pane, do the following:

1. Open Query Builder, then begin a new DELETE statement.
   OR
   Open an existing DELETE statement.
2. In the SQL Statement Pane, select all, or the target portion of the statement.
3. On the Query Builder tool bar, click Copy.
   OR
   In the SQL Statement Pane, right-click, and then click Copy.
   Query Builder makes the target statement portion available on the clipboard.

For more information, see Building a Query.

**BUILDING A CREATE VIEW STATEMENT**
Query Builder lets you construct and execute simple-to-complex CREATE VIEW statements using data from any table or view. You can also copy the statement to the clipboard for later use in the ISQL Editor. Query Builder also lets you save your statement at any time so that you can open it later for editing or execution.

To build a CREATE VIEW statement, do the following:

1. On the Tools menu, click Query Builder.
   OR
   On the Datasource Explorer, expand the Database or Schema node, click Tables, and on the Command menu, click Build Query.
   OR
   On the Tools tool bar, click Query Builder.
   OR
   On the Explorer, expand Tables, right-click the target table(s), and then click Build Query.
   OR
   On the Explorer, expand Views, right-click the target view(s), and then click Build Query.
   Rapid SQL opens Query Builder.
2. In the statement drop-down list, click CREATE VIEW.
3. In the Table Tree Pane, select target table or view and move it to the SQL Diagram Pane.
   **NOTE:** Query Builder supports multiple tables and views in a CREATE VIEW statement.
4 In the target table or view, click the target column(s).

5 To check syntax, click Check.

6 To copy the statement, click Copy.

7 To execute the CREATE VIEW Statement, click the SQL Statement Pane, and then press any key.

   Query Builder opens the Edit SQL dialog box.

8 Click OK.

**CAUTION:** If you have used this method previously, and you selected the Please do not show me this dialog again check box, on the Edit SQL dialog box, Query Builder does not display the Edit SQL dialog box. It pastes your statement directly to the ISQL Editor.

   Rapid SQL opens the ISQL Editor.

9 In the ISQL Editor, on the line, CREATE VIEW NAME AS, replace the word NAME with a name for your view.

10 On the tool bar, click Execute.

   Rapid SQL executes the CREATE VIEW query.

11 To close the Editor, click Close.

   Rapid SQL opens the ISQL Editor save message.

12 Click No.

   Rapid SQL returns to Query Builder.

13 To add the view to the table tree, on the Query Builder menu, click Refresh.

   OR

   Press F5.

   Query Builder adds the view to the Table Tree Pane.

**Copying a CREATE VIEW Statement from the SQL Statement Pane**

To copy any part of a statement from the SQL Statement Pane, do the following:

1 Open Query Builder, then begin a new CREATE VIEW statement.

   OR

   Open an existing CREATE VIEW statement.

2 In the SQL Statement Pane, select all, or the target portion of the statement.
3 On the Query Builder tool bar, click Copy.

OR

In the SQL Statement Pane, right-click, and then click Copy.

Query Builder makes the target statement portion available on the clipboard.

For more information, see Building a Query.

WORKING WITH TABLES AND VIEWS IN THE SQL DIAGRAM PANE
Query Builder lets you organize your tables and views in the SQL Diagram Pane. You can also customize appearance, change visual aspects, and adjust layout while continuing to manufacture a query. You can resize or customize a selected table and view, or move them to the front or back of the diagram. The key symbol indicates a column that is indexed or participates in a primary key.

• Selecting and Deselecting Tables and Views
• Moving Tables and Views
• Moving Additional Tables and Views to the SQL Diagram Pane
• Deleting Tables and Views

Query Builder can automatically dictate a layout in the SQL Diagram Pane using the Auto Layout button.

SELECTING AND DESSELECTING TABLES AND VIEWS
You can select tables and views in the SQL Diagram Pane. You can make changes to more than one table or view simultaneously by selecting multiple tables or views.

To select and deselect Tables and Views, do the following:

1 To select a table, click the table title bar.

2 To select more than one table, drag the pointer to enclose all target tables with the bounding line.

Query Builder selects all target tables; none have handles.

3 To select all tables, in the SQL Diagram, right-click, and then click Select All.

4 Click the SQL Diagram workspace to deselect all tables.

For more information, see Working with Tables and Views.

MOVING TABLES AND VIEWS
Query Builder lets you move tables and views in the SQL Diagram Pane. It also moves selections and joins with the tables and views.
To move Tables and Views, do the following:

1. To move a table or view, drag the title bar to the target location.

   **NOTE:** If you select more than one table or view, Query Builder moves all selected tables and views and any joins with the pointer.

For more information, see [*Working with Tables and Views*](#).

**MOVING ADDITIONAL TABLES AND VIEWS TO THE SQL DIAGRAM PANE**

Query Builder sets tables and views in your statement in the order that you move them to the SQL Diagram Pane. Tables and views moved into the Diagram Pane appear first in your statement, including all joins connecting that table. To change the order of tables, move them back into the Table Tree and re-select them in the order in which you would like to join them.

**Moving Additional Tables or Views**

To move additional tables or views, do the following:

1. Click the target table or view and drag it to the Diagram Pane.

   For multiple tables or views: Use SHIFT+click for adjacent tables or views or use CTRL+click for nonadjacent tables and views.

   **OR**

   Click the target table or view, and then on the Query Builder tool bar, click Add.

   **OR**

   Right-click the target table or view, and then click *Add*.

   For multiple tables or views: Use SHIFT+click for adjacent tables or views or use CTRL+click for non-adjacent tables and views.

   **NOTE:** Moving a table or view to the SQL Diagram Pane is not available while a query is executing.

For more information, see [*Working with Tables and Views*](#).
DELETING A TABLE OR VIEW
To delete tables from the SQL Diagram Pane, do the following:

1. Right-click the target table or view, and then click Delete.
   OR
   In the SQL Diagram, click target table or view, and then on the Query Builder tool bar, click Delete.
   OR
   In the SQL Diagram, right-click the target table or view, and then click Delete.

Query Builder deletes the table from the SQL Diagram, SQL Statement, and SQL Statement Tree.

For more information, see Working with Tables and Views.

WORKING WITH COLUMNS IN THE SQL DIAGRAM Pane
You can customize queries by selecting and deselecting columns in the SQL Diagram Pane. You can customize columns using the Selected Column Properties dialog box.

SELECTING AND Deselecting COLUMNS
You can select and deselect columns in the SQL Diagram. Query Builder lets you select and deselect individual columns or all columns. Your results reflect the order of selection. You can change the order of columns after you set them in your diagram or statement.

**TIP:** You can also select, re-order and deselect columns in the SQL Statement Tree.

Selecting Individual Columns
To select individual columns, do the following:

1. To select a column, in the SQL Diagram, select the check box to the left of the target column name.

Deselecting Individual Columns
To deselect individual columns, do the following:

1. To deselect a column, in the SQL Diagram, select the check box to the left of the target column name.

**NOTE:** When you clear the columns, Query Builder deletes the columns and any sub clauses from the SQL Statement Pane and SQL Statement Tree.
**Selecting All Columns**

To select all columns, do the following:

1. On the Query Builder menu, click Select Star.

   **OR**

   On the SQL Statement Tree, or in the SQL Diagram, right-click target table, or any of a group of selected tables, and then click Select Star.

   **NOTE:** Query Builder uses columns in statements based on the order of selection. When you select all columns, Query Builder displays the columns as they appear in the table.

**Deselecting All Columns**

To deselect all columns, do the following:

1. On the Query Builder menu, click Select None.

   **OR**

   On the SQL Statement Tree, or in the SQL Diagram, right-click target table, or any of a group of selected tables, and then click Select None.

   Query Builder adds or removes selected columns from the SQL Statement Tree and the SQL Statement Pane.

**SELECTING ALL OR DISTINCT COLUMNS**

Selecting ALL or DISTINCT columns is a way to filter data in your query. Selecting ALL columns means all rows displays results in the grid regardless of duplication in non-primary key columns. The DISTINCT column function is a query process that limits duplicate data in non-primary key columns to rows with the first iteration of any identical data. For example, if there are two identical addresses for different last names, and the column with a primary key does not participate in the query, only the row with the first instance of the address displays in the results of the query.

To select ALL or DISTINCT columns, do the following:

1. In the Statement Tree pane, right-click the ALL or DISTINCT node, click Properties, and then select the ALL or DISTINCT check box.

   **OR**

   In the Statement Tree pane, double click the ALL or DISTINCT node. Query Builder toggles to the opposite function.

   **NOTE:** You can change between ALL or DISTINCT at any time prior to executing or copying a query.
JOINS

Joins let you distill the information in your database to a usable form. Query Builder lets you create, manipulate, and edit work with joins without requiring knowledge of the underlying SQL code. Query Builder lets you create any type of join for SELECT and CREATE VIEW Statements. You can create self joins for UPDATE or DELETE Statements. You cannot create joins for INSERT Statements.

Query Builder includes four types of joins. The table below describes joins and their availability in Query Builder:

<table>
<thead>
<tr>
<th>Join</th>
<th>Statement Availability</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Inner Join</td>
<td>SELECT, CREATE VIEW,</td>
<td>Returns data from the joined tables that match the query's join criteria and set a relation between tables or views. Inner joins return results where the join condition is true.</td>
</tr>
<tr>
<td></td>
<td>DELETE, UPDATE</td>
<td></td>
</tr>
<tr>
<td>Left Outer Join</td>
<td>SELECT, CREATE VIEW</td>
<td>Returns all data from the primary table and data from the joined tables that match the query's join criteria and set a join relation operator from a column in a primary table or view to a column in a secondary table or view.</td>
</tr>
<tr>
<td>Right Outer Join</td>
<td>SELECT, CREATE VIEW</td>
<td>Returns all data from the primary table and data from the joined tables that match the query's join criteria and set a join relation operator from a column in a secondary table or view to a column in a primary table or view.</td>
</tr>
<tr>
<td>Self Join</td>
<td>SELECT, CREATE VIEW</td>
<td>Set a relation between columns in the same table.</td>
</tr>
</tbody>
</table>

In the Query Builder SQL Diagram Pane, you can create, edit, and delete joins. You can edit joins in the Join dialog box.

Joins are the way you can filter data in relational databases. Query Builder lets you change the types of joins between tables, views and columns. It is important that you have some knowledge of the data in your tables, and the datatypes for each column. This information helps you frame a better query, and filter your data for maximum effect.

For more information, see Joins.

INNER JOINS

Inner joins are the most common types of joins for SELECT statements. An inner join returns information from two tables where the relation between two target columns is true for both columns.

The join operand determines the relation results, for example, if the join operand is equals, then identical data, in two columns, is the only result. If the join operand is not equals, Query Builder only returns data that is different between two columns.
For example, if you have an inner join matching territory numbers between the table dbo.Managers and dbo.Clients, running the query returns all Managers and Clients with matching territory numbers:

Query Builder displays the following results from this query with an inner join

**NOTE:** Query Builder displays results of columns in the order of selection. You can reorder columns by deselecting and selecting in the SQL Diagram Pane, the Selected Columns Properties dialog box, or the SQL Statement Tree.

For more information, see [Joins](#).

**LEFT OUTER JOINS**

Left outer joins bring back a different data set than inner joins. Left outer joins retrieve all the data in columns selected from the primary table, and only matching data from the joined or secondary table.

For example, in the same pair of tables, a left inner join from dbo.Managers to dbo.Clients, where the columns Current Territory and Territory are joined, displays different results.

**NOTE:** There is one additional manager who does not have a client, but because a left outer join includes all data from selected columns in the primary table, the last entry in the illustration is displayed.

For more information, see [Joins](#).

**RIGHT OUTER JOINS**

Right outer joins return opposite results from a left outer join. In a right outer join, you are asking for all the information in the secondary table’s column, and the join operator’s matching information from the primary table.

For example, in the same set of data we used in the left outer join example, a right outer join returns all clients from dbo.Client, and only managers who match territory numbers, in the joined column.

**NOTE:** The managers are the same as the first, inner join, but a right outer join returns the additional clients without matching managers.

For more information, see [Joins](#).

**SELF JOINS**

A self join is a join within a single table. Query Builder lets you return specific information from a single table using a self join.

For example, in our example table, there is a column for the number of clients and another column with the goal client total for a territory.
A self join can ascertain which managers are reaching their quota. Notice that the join relation operator in the example is greater than or equal to, which shows managers exceeding quota as well.

For more information, see Joins.

**ADDING AND DELETING A JOIN IN THE SQL DIAGRAM PANE**
Query Builder lets you add and delete joins. This method adds a WHERE clause in your query. You can join different tables and or views in a SELECT or CREATE VIEW statement.

**Adding a Join**
To add a Join, do the following:

1. In the SQL Diagram Pane, drag the target column to the second column.

   Query Builder displays both a line joining the two columns in the SQL Diagram Pane and the corresponding SQL code in the SQL Statement Pane.

**Removing a Join**
Query Builder lets you remove joins from your query. Query Builder automatically deletes joins from the query in the SQL Statement Pane, when you remove them from the SQL Diagram Pane.

To remove a join, do the following:

1. Click the target join, and then on the Query Builder toolbar, click Delete.

   OR

   Right-click the target join, and then click Delete.

   Query Builder deletes the Join.

For more information, see Joins.

**EDITING JOINS**
Query Builder lets you edit joins with the Join editor. You can edit join parameters in a SELECT, UPDATE, DELETE, and CREATE VIEW Statement.

The table below describes the options in the Join dialog box:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>From Table Column</td>
<td>The primary column in the join.</td>
</tr>
<tr>
<td>To Table Column</td>
<td>The secondary column in the join.</td>
</tr>
<tr>
<td>Select the join relation</td>
<td>Click the target join operator. If it is not equals, the operator displays</td>
</tr>
<tr>
<td>operator</td>
<td>on the join in the SQL Diagram Pane.</td>
</tr>
<tr>
<td>Join Type: Inner</td>
<td>Click to make the join an inner join. Aggregates are only available for</td>
</tr>
<tr>
<td></td>
<td>inner joins.</td>
</tr>
</tbody>
</table>
Completing the Join Dialog Box
1 In the SQL Diagram Pane, right-click the target join, and then click Properties.

OR
In the SQL Diagram Pane, double-click the target join.

OR
On the SQL Statement Tree, expand the Where and And nodes, and then double-click the target join.

Query Builder opens the Join dialog box.

NOTE: For IBM DB2 LUW for Linux, Unix, and Windows servers, there is an additional join object in the SQL Statement Tree. The Join On node displays join relations between columns in IBM DB2 LUW for Linux, Unix, and Windows tables and views.

Changing a Join Color
Query Builder lets you change the color at a join in the SQL Diagram Pane. Complex statements using many tables and multiple joins can be easier to view if joins have different colors.

To change the color of a join, do the following:
1 Right-click the target join, and then click Color.

Query Builder opens the Color dialog box.

2 In the Basic colors grid, click a target color

OR
Click Define Custom Colors, then create a custom color.

NOTE: Query Builder lets you save custom colors for the current color. Click Add to Custom Color to have the option of using that color for your queries.

3 Click OK.

For more information, see Joins.
The Auto Layout function displays tables and views in the SQL Diagram Pane. It makes the best use of the available area in the SQL Diagram Pane by placing your tables and views in the most efficient manner. If the automatic join function is on, Query Builder displays all joins between columns in your diagram. Query Builder lets you run the automatic layout function any time you have tables or views in the SQL Diagram Pane.

**Using Auto Layout**
To use Auto Layout, do the following:

1. On the Query Builder menu, click Auto Layout.
   OR
   On the Query Builder tool bar, click Auto Layout.
   OR
   In the SQL Diagram Pane, right-click, and then click Auto Layout.

Query Builder organizes your tables in the SQL Diagram Pane.

**Auto Joins**
Query Builder includes an automatic join function that displays joins between selected tables and views in the SQL Diagram Pane. The Auto Join function seeks columns with the same name and data type. You can set global automatic join parameters in the Rapid SQL Options Editor. You can use the Statement Properties Editor to set local join parameters for the current Query Builder session without changing the global parameters.

**Using Auto Join**
To use Auto Join, do the following:

1. On the Query Builder menu, click Auto Join.
   OR
   On the Query Builder tool bar, click Auto Join.
   OR
   In the SQL Diagram Pane, right-click, and then click Auto Join.

Query Builder joins columns in the SQL Diagram Pane.
CREATING A CLAUSE USING THE SQL STATEMENT TREE

Query Builder lets you build more detailed WHERE, ORDER BY, GROUP BY, and HAVING clauses using the SQL Statement Tree. Query Builder lets you add clauses to SELECT, UPDATE, DELETE, and CREATE VIEW statements.

**NOTE:** Query Builder does not support clauses for INSERT statements.

The table below describes these clauses:

<table>
<thead>
<tr>
<th>Clause</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>WHERE</td>
<td>Limits rows in the query.</td>
</tr>
<tr>
<td>ORDER BY</td>
<td>Orders the results of the query to a target column.</td>
</tr>
<tr>
<td>GROUP BY</td>
<td>Groups target columns in the query.</td>
</tr>
<tr>
<td>HAVING</td>
<td>Filters out groups of data.</td>
</tr>
</tbody>
</table>

**CREATING A WHERE CLAUSE**

Query Builder lets you create a WHERE clause from the SQL Statement Tree which automatically displays in your query.

**NOTE:** Any additional WHERE clauses are displayed as **HAVING** clauses.

The table below describes the options and functionality on the Where dialog box.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operand (Left)</td>
<td>Lets you click the target column for the first part of your WHERE clause. NOTE: Query Builder lists every column in all tables in the SQL Diagram in the Operand lists.</td>
</tr>
<tr>
<td>Operator</td>
<td>Lets you select the target operator.</td>
</tr>
<tr>
<td>Operand (Right)</td>
<td>Lets you click the target column for the second part of your WHERE clause. Query Builder automatically writes the query language in the Statement option box.</td>
</tr>
</tbody>
</table>

**NOTE:** Query Builder does not display clause phrases created from the SQL Statement Tree in the SQL Diagram Pane.

**Creating a WHERE Clause**

To Create a WHERE clause, do the following:

1. Click the WHERE node, and then on the Query Builder tool bar, click New.
   OR
   Right-click the WHERE node, and then click New.
For more information, see Creating a Clause using the SQL Statement Tree.

DELETING A WHERE CLAUSE
To delete a WHERE clause, do the following:

1. Expand the AND node, and then on the Query Builder tool bar, click Delete.
   OR
   Expand the AND node, right-click target column and then click Delete.
   Query Builder deletes the target clause and removes it from the SQL Statement Pane.

For more information, see Creating a Clause using the SQL Statement Tree.

CREATING AN AND CLAUSE IN A WHERE CLAUSE
Query Builder lets you add an AND clause from the SQL Statement Tree which automatically displays in your query.

The table below describes the options and functionality on the Where dialog box.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operand (Left)</td>
<td>Lets you click the target column for the first part of your WHERE clause.</td>
</tr>
<tr>
<td>Operator</td>
<td>Lets you select the target operator.</td>
</tr>
<tr>
<td>Operand (Right)</td>
<td>Lets you click the target column for the second part of your WHERE clause. Query Builder automatically writes the query language in the Statement option box.</td>
</tr>
<tr>
<td>New Button</td>
<td>Click to clear your selections but remain in the Where dialog box. Query Builder adds another AND clause to your query.</td>
</tr>
</tbody>
</table>

To open the Where dialog box, do the following:

1. Click the AND node, and then on the Query Builder tool bar, click New.
   OR
   Expand the WHERE node, right-click the AND node, and then click New.

For more information, see Creating a Clause using the SQL Statement Tree.
DELETING AN AND CLAUSE
To delete an AND clause, do the following:

1. Expand the AND node, click target column, and then on the Query Builder toolbar, click Delete.

   OR

   Expand the AND node, click target column, and then on the keyboard press DELETE.

   OR

   Expand the AND node, right-click the target column, and then click Delete.

   Query Builder deletes the target clause and removes it from the SQL Statement Pane.

For more information, see Creating a Clause using the SQL Statement Tree.

INSERTING AN AND OR OR CLAUSE
Query Builder lets you insert an AND or an OR WHERE clause from the SQL Statement Tree which automatically displays in your query. Query Builder lets you insert AND or OR clauses at any appropriate point in the SQL Statement Tree.

The table below describes the options and functionality on the Where dialog box.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operand (Left)</td>
<td>Lets you click the target column for the first part of your WHERE clause.</td>
</tr>
<tr>
<td>Operator</td>
<td>Lets you select the target operator.</td>
</tr>
<tr>
<td>Operand (Right)</td>
<td>Lets you click the target column for the second part of your WHERE clause.</td>
</tr>
<tr>
<td>Query Builder</td>
<td>Automatically writes the query language in the Statement option box.</td>
</tr>
<tr>
<td>New Button</td>
<td>Click to clear your selections but remain in the Where dialog box.</td>
</tr>
<tr>
<td>Query Builder</td>
<td>Adds another AND clause to your query.</td>
</tr>
</tbody>
</table>

To insert an AND or OR Clause, do the following:

1. On the SQL Statement Tree, expand the WHERE node, right-click the target AND node, then click Insert, and then click And or Or.

For more information, see Creating a Clause using the SQL Statement Tree.
DELETING AN OR CLAUSE
To delete an OR clause, do the following:

1. Expand the OR node, and then on the Query Builder tool bar, click Delete.
   OR
   Expand the OR node, right-click the target column and then click Delete.
   QueryBuilder deletes the target clause and removes it from the SQL Statement Pane.

For more information, see Creating a Clause using the SQL Statement Tree.

CREATING AN ORDER BY CLAUSE
QueryBuilder lets you create an ORDER BY clause from the SQL Statement Tree which automatically displays in your query.

The table below describes the Order By Columns dialog box.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Available Columns</td>
<td>Select target column(s) and click the right arrow. Query Builder moves target column from the Available Columns list to the Order By Columns list. Note: Query Builder sorts query results based on the order that columns are placed in the ORDER BY clause.</td>
</tr>
<tr>
<td>Order</td>
<td>Lets you select the target sort order. ASC - Ascending DESC - Descending Query Builder displays the SQL language in the Order By Statement box.</td>
</tr>
</tbody>
</table>

To open the Order By Columns dialog box, do the following:

1. On the SQL Statement Tree, click the ORDER BY node, and then on the Query Builder tool bar, click Properties.
   OR
   On the SQL Statement Tree, right-click the ORDER BY node, and then click Properties.

For more information, see Creating a Clause using the SQL Statement Tree.
CHANGING THE SORT ORDER IN AN ORDER BY CLAUSE
To quickly change the sort order of a column in a query, do the following:

1. On the SQL Statement Tree, expand the ORDER BY node, and then double-click the target column.
   OR
   On the SQL Statement Tree, expand the ORDER BY node, then right-click the target column, and then click Properties.
   Query Builder opens the Order dialog box.
2. Click the target sort order, and then click OK.
   Query Builder appends the Order By clause for target column with the appropriate sort order in the SQL Statement Pane.

For more information, see Creating a Clause using the SQL Statement Tree.

DELETING AN ORDER BY CLAUSE
To delete an ORDER BY clause, do the following:

1. Expand the ORDER BY node, and then on the Query Builder tool bar, click Delete.
   OR
   Expand the ORDER BY node, right-click the target column, and then click Delete.
   Query Builder deletes the target clause and removes it from the SQL Statement Pane.

For more information, see Creating a Clause using the SQL Statement Tree.

CREATING A GROUP BY CLAUSE
The table below describes the options and functionality on the Group By Columns dialog box.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Selected Columns</td>
<td>Select target column(s) and click the right arrow. Or click the Select All button. Query Builder moves target column from the Selected Columns list to the Group By Columns list. NOTE: Query Builder sorts query results based on the order that columns are placed in the ORDER BY clause.</td>
</tr>
<tr>
<td>Clear All Button</td>
<td>Click to move target column from the Group By Columns list to the Selected Columns list. Query Builder displays the SQL language in the Group By Statement window.</td>
</tr>
</tbody>
</table>
Creating a GROUP BY Clause
To create a GROUP BY clause from the SQL Statement Tree which automatically displays in your query, do the following:

1. On the SQL Statement Tree, double-click the GROUP BY node.
   OR
   On the SQL Statement Tree, right-click the GROUP BY node, and then click New.

   Query Builder adds all the selected columns in your table(s) to the GROUP BY node in the SQL Statement Tree, and to the appropriate location in the SQL Statement Pane.

2. On the GROUP BY node, double-click any column.
   OR
   On the GROUP BY node, click any column, then on the Query Builder menu, click New.
   OR
   On the GROUP BY node, right-click any column, then click Properties.

For more information, see Creating a Clause using the SQL Statement Tree.

DELETING A GROUP BY CLAUSE
To delete a GROUP BY clause, do the following:

1. On the SQL Statement Tree expand the GROUP BY node, and then on the Query Builder tool bar, click Delete.
   OR
   On the SQL Statement Tree expand the GROUP BY node, right-click the target column, and then click Delete.

   Query Builder deletes the target clause and removes it from the SQL Statement Pane.

For more information, see Creating a Clause using the SQL Statement Tree.

CREATING A HAVING CLAUSE
A HAVING clause is a type of WHERE clause. It filters additional information from your tables. Query Builder lets you create a HAVING clause from the SQL Statement Tree which automatically displays in your query. Query Builder lists every column in all tables in the SQL Diagram in the Operand lists. Query Builder displays the datatype of a column in the operand boxes.

The table below describes the options and functionality on the Having dialog box.
NOTE: Query Builder does not display clause phrases created from the SQL Statement Tree in the SQL Diagram Pane.

To create a HAVING clause, do the following:

1. On the SQL Statement Tree, expand the HAVING node, and then expand the And node. If there is not a join listed on the And node, double-click And. If there is a join listed, use the shortcut option below.

   OR

   On the SQL Statement Tree, right-click the HAVING node, and then click New.

For more information, see Creating a Clause using the SQL Statement Tree.

DELETING A HAVING CLAUSE

To delete a HAVING clause, do the following:

1. On the SQL Statement Tree expand the HAVING node, and then on the Query Builder tool bar, click Delete.

   OR

   On the SQL Statement Tree expand the HAVING node, right-click the target column, and then click Delete.

   Query Builder deletes the target clause and removes it from the SQL Statement Pane.

For more information, see Creating a Clause using the SQL Statement Tree.

### Option | Description
--- | ---
Operand (Left) | Lets you click the target column for the first part of your HAVING clause.
Operator | Lets you select the target operator.
Operand (Right) | Lets you click the target column for the second part of your HAVING clause. Query Builder automatically writes the query language in the Statement option box.
New Button | Click to clear your selections but remain in the Having dialog box. Query Builder adds another AND clause to your query.
**CHANGING TABLES AND COLUMNS LOCATION IN THE SQL STATEMENT TREE**

Query Builder lets you move tables and columns on the SQL Statement Tree by dragging them to new locations. You can move columns from the AND and OR nodes to an AND or OR node on the WHERE and HAVING clause nodes. Query Builder changes the query in the SQL Statement Pane to match each move. Query Builder moves tables or columns you are dragging below target table or column.

To move a table or column in the SQL Statement Tree, do the following:

1. Expand target node, then drag the target table or column to a new location.
   
   Query Builder makes the appropriate change in the query in the SQL Statement Pane.
   
   **NOTE:** Query Builder lets you select multiple tables or columns.

2. To move a table or column to the bottom of a node, drag it to the target node.
   
   Query Builder displays the target table or column at the bottom of target node.

For more information, see [Creating a Clause using the SQL Statement Tree](#).

**SUBQUERIES**

Query Builder lets you build subqueries for SELECT and CREATE VIEW statements in the WHERE or HAVING clause. The table below describes the options available for a subquery in Query Builder:

<table>
<thead>
<tr>
<th>Operand</th>
<th>Location</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>EXISTS</td>
<td>Left operand</td>
<td>Specifies data that exists in a column.</td>
</tr>
<tr>
<td>NOT EXISTS</td>
<td>Left operand</td>
<td>Specifies data that does not exist in a column.</td>
</tr>
<tr>
<td>ANY</td>
<td>Right operand</td>
<td>Specifies data satisfying the operator parameters.</td>
</tr>
<tr>
<td>ALL</td>
<td>Right operand</td>
<td>Specifies data satisfying the operator parameters.</td>
</tr>
<tr>
<td>SELECT</td>
<td>Right operand</td>
<td>Specifies data satisfying the operator parameters.</td>
</tr>
</tbody>
</table>

The table below describes the options and functionality on the Where or Having dialog boxes.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operand (Left)</td>
<td>Lets you click the target column for the first part of your clause.</td>
</tr>
<tr>
<td>Operator</td>
<td>Lets you select the target operator.</td>
</tr>
<tr>
<td>Operand (Right)</td>
<td>Lets you click the target column for the second part of your clause.</td>
</tr>
<tr>
<td></td>
<td>Query Builder displays the working subquery in the Statement window.</td>
</tr>
<tr>
<td>Subquery</td>
<td>Paste or type the SUBQUERY statement.</td>
</tr>
</tbody>
</table>
To use the **WHERE** and **HAVING** dialog boxes to create subqueries, do the following:

1. On the SQL Statement Tree, expand the **Where** or **Having** node, and then expand the **And** node. If there is not a join listed on the **And** node, double-click **And**. If there is a join listed, use the shortcut option below.

   **OR**

   On the SQL Statement Tree, right-click the **Where** or **Having** node, and then click New.

For more information, see [Creating a Clause using the SQL Statement Tree](#).

### Syntax Checker

The Syntax Checker scans SQL statements for errors. You can check your syntax at any time while you are fashioning a query, or a Procedure or Function. Query Builder can automatically run a syntax check to validate your query when you are executing or copying a statement.

**NOTE:** Query Builder lets you continue with your query even if there are errors detected in the syntax.

### Using the Syntax Checker

The table below describes the possible syntax errors the Query Builder Syntax Checker tool displays, in order:

<table>
<thead>
<tr>
<th>Error</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Does the query contain duplicate aliases?</td>
<td>Query Builder returns an error message when it detects duplicate aliases.</td>
</tr>
<tr>
<td>If the query has a <strong>HAVING</strong> clause, is there a <strong>GROUP BY</strong> clause?</td>
<td>Query Builder returns an error message when it detects a <strong>HAVING</strong> clause without a <strong>GROUP BY</strong> clause.</td>
</tr>
<tr>
<td>If there are aggregates, or a <strong>GROUP BY</strong> clause, are all columns in one or the other?</td>
<td>Query Builder returns an error message when it detects an aggregate, or a <strong>GROUP BY</strong> clause without all columns in one or the other.</td>
</tr>
<tr>
<td>Are there joins against non-indexed columns, or columns not participating in a primary key?</td>
<td>Query Builder returns a warning when it detects a join against a non-indexed column, or a column not participating in a primary key.</td>
</tr>
<tr>
<td>Are there joins between different datatypes?</td>
<td>Query Builder returns a warning when it detects a join between different datatypes.</td>
</tr>
<tr>
<td>Are there cross-products in the query?</td>
<td>Query Builder returns a warning when it detects a cross-product in the query.</td>
</tr>
</tbody>
</table>
SAVING AND REOPENING QUERIES
You can save and reopen queries in Query Builder. Saving a query saves the SQL Diagram, SQL Statement, and Query Builder Explorer view. Query Builder automatically checks for changes in your database or instance between the time you save the query and the time you reopen it. Query Builder prompts you to save any time you try to close Query Builder, or any time you attempt quitting Rapid SQL.

Query Builder runs Schema Change detection any time you set a query to execute, refresh the data, or open a saved query.

Rapid SQL lets you open multiple saved queries simultaneously.

Saving Queries
To save a query using standard Save and Save As functions, do the following:

1. On the File menu, click Save or Save As.

OR

On the Main tool bar, click Save As.

Rapid SQL opens the Save As dialog box.

2. In the File name box, type the name of the query.

NOTE: By default, the product appends the.qbl extension to Query Builder files. If there is more than one Query Builder session in progress when you save, the file is further appended with an integer, for example.qbl2.

TIP: Rapid SQL lets you save data in text (*.txt) and XML (*.xml) file formats.

3. Click OK.

Rapid SQL saves the file and closes the Save As dialog box.

Reopening Queries
You can open a query using standard Open functions. Query Builder displays the Query Builder diagram, statement and Query Builder Explorer Pane and it checks the instance or database for schema changes.

The Query Builder Schema Change Detection component checks for:

- Renamed or dropped tables referenced in the query. Renamed tables that have been renamed are considered dropped.

- Renamed or dropped columns referenced in the query. Renamed columns are considered dropped and inserted.

- Columns added or reordered in tables referenced in the query.

If Query Builder detects a change, it opens the Schema Change Detected dialog box. The dialog box displays details of changes to your schema.
Query Builder opens an ISQL Editor with the last saved versions of the SQL statement.

**Using Data Editor with Query Builder**

SELECT statements. Rapid SQL lets you open multiple Data Editor sessions so that you can continue to change your data until you find the best match for your query.

**Caution:** Data Editor is a real-time editor. Changes in your data using Data Editor are permanent.

**Opening the Data Editor from Query Builder**

To open the Data Editor from Query Builder, do the following:

1. On the Tools menu, click Query Builder.
   
   OR
   
   On the Datasource Explorer, expand the Database or Schema node, click Tables, and then on the Command menu, click Build Query.
   
   OR
   
   On the Tools tool bar, click Query Builder.
   
   OR
   
   On the Explorer, expand Tables, right-click the target table(s), and then click Build Query.
   
   OR
   
   On the Explorer, expand Views, right-click the target view(s), and then click Build Query.
   
   Rapid SQL opens Query Builder.

2. Select a database or instance.

3. Select a table.

4. Select a column, or columns.

5. On the Query Builder menu, click Edit Data.
   
   OR
   
   On the Query Builder tool bar, click Edit Data.
   
   Rapid SQL opens Data Editor.

For more information on using the Data Editor, see [Using Data Editor](#).
DATA EDITOR

The Edit Data function opens the Data Editor. You can use the Data Editor to edit your tables in real-time. The Data Editor supports all editable datatypes and is an alternative way to add, edit, or delete data from your tables.

NOTE: You can use Data Editor within Query Builder to edit data in tables while you create SELECT statements. You can open multiple Data Editor sessions so that you can continue to change your data until you find the best match query.

The Data Editor includes a Data Editor Filter that lets you select the columns in your table that you want to edit. You must select at least one column to use the Data Editor. The Data Editor Filter is not available for the Query Builder.

For more information, see:

Data Editor Design
Using Data Editor

DATA EDITOR DESIGN

The Data Editor includes the following components:

- Edit Window
- ISQL Window
- Tool Bar
- Data Editor Filter
- Date/Time Format Builder
- Using Data Editor

DATA EDITOR EDIT WINDOW

Data Editor displays all the information in the target table in the Data Editor Edit Window. You can edit data directly in this window.

For more information, see:

ISQL Window
Tool Bar
Data Editor Filter
Date/Time Format Builder
Using Data Editor
DATA EDITOR

DATA EDITOR ISQL WINDOW
The Data Editor ISQL Window displays the active SQL statement, which uses the data from the target table.

When appropriate, Data Editor displays a History Tab. The History Tab displays all SQL Statements created in the current session. If there is an error, Data Editor displays an Error Tab. The Error Tab details any errors in data entry encountered during execution.

For more information, see:
- Edit Window
- Tool Bar
- Data Editor Filter
- Date/Time Format Builder
- Using Data Editor

DATA EDITOR TOOL BAR
The Data Editor tool bar lets you access commonly used features.

The table below describes the function of each Data Editor tool.

<table>
<thead>
<tr>
<th>Description</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stop Button.</td>
<td>Stops loading data to the Data Editor. Data Editor displays rows up to the stopping point.</td>
</tr>
<tr>
<td>List of options for the target table.</td>
<td>Displays the editing mode for the target table.</td>
</tr>
<tr>
<td>Execute SQL button</td>
<td>Executes the current SQL statement for the target table.</td>
</tr>
<tr>
<td>Insert Record button</td>
<td>Inserts new record for the target table. New records display at the end of the table. For related information, see Default Value Handling.</td>
</tr>
<tr>
<td>Save Current Row button</td>
<td>Saves data in the current selected row. Data Editor prompts to save when you attempt to leave a row in Live mode. For related information, see Default Value Handling.</td>
</tr>
<tr>
<td>Remove Data button</td>
<td>Removes data in target row. Data Editor displays an optional prompt.</td>
</tr>
<tr>
<td>Clear SQL Text button</td>
<td>Clears SQL text from the SQL Statement Pane.</td>
</tr>
<tr>
<td>Undo button</td>
<td>Undoes the most recent operation.</td>
</tr>
<tr>
<td>Redo button</td>
<td>Redoes the most recent operation.</td>
</tr>
<tr>
<td>First Record button</td>
<td>Moves to the first record in the target table.</td>
</tr>
<tr>
<td>Last Record button</td>
<td>Moves to the final record in the target table.</td>
</tr>
<tr>
<td>Filter Data button</td>
<td>Filters table using the target cell as the filter parameter.</td>
</tr>
<tr>
<td>Refresh button</td>
<td>Reloads data for target table.</td>
</tr>
</tbody>
</table>
For more information, see:

- Edit Window
- ISQL Window
- Data Editor Filter
- Date/Time Format Builder
- Using Data Editor

DATA EDITOR FILTER

The Data Editor Filter displays the columns of a target table and the corresponding SELECT SQL Statement. You can select columns from the filter for selective data editing.

For more information, see:

- Edit Window
- ISQL Window
- Tool Bar
- Date/Time Format Builder
- Using Data Editor

NOTES ON XML TYPES AND UNICODE DISPLAY IN THE DATA EDITOR

When working with data in the Data editor, keep the following in mind:

- XML data types are supported for IBM DB2 for Windows, Unix, and Linux, Microsoft SQL Server, and Oracle. In the Data editor, XML data types are displayed and entered as LOB content.
DATA EDITOR

• Support for display of Unicode characters is provided as follows:
  • IBM DB2 for Windows, Unix, and Linux: character, clob, varchar, and longvarchar types
  • SQL Server: nchar, nvarchar, ntext, and nvarchar(max) types.
  • Oracle 9i, and 10g: NCHAR, NVARCHAR2 and NCLOB for non-Unicode UTF8 Character Set Instances and NCHAR, NVARCHAR2, CHAR, VARCHAR2, LONG, NCLOB and CLOB for Unicode UTF8 Character Set Instances
  • Sybase ASE 12.5 and 15.2: UNICHAR, UNIVARCHAR and UNITEXT for non-Unicode UTF8 Character Set Instances and UNICHAR, UNIVARCHAR, UNITEXT, NCHAR, NVARCHAR, CHAR, VARCHAR and TEXT for Unicode UTF8 Character Set Instances

USING DATA EDITOR

Data Editor lets you edit data in your tables with any editable datatype without leaving the parent application. Data Editor lets you use your new data immediately.

CAUTION: Data Editor is a real-time editor. Changes in your data using Data Editor are permanent.

The table below describes the functions and options of the Data Editor:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Live</td>
<td>Edits data one row at a time. You must execute when you leave the row.</td>
</tr>
<tr>
<td>Batch</td>
<td>Edits data in multiple rows before executing.</td>
</tr>
</tbody>
</table>

NOTE: You can also use the Data Editor to edit date and time functions in a table.

NOTE: If you make an incorrect edit in a cell, Data Editor displays the error on the Error Tab of the ISQL Editor. Data Editor does not incorporate this error(s) in data into the table. Data Editor saves any changes in data prior to the error message.

CAUTION: Data Editor is a real-time editor. Changes in your data using Data Editor are permanent.

For more information, see:
Edit Window
ISQL Window
Tool Bar
Data Editor Filter
Date/Time Format Builder
Default Value Handling

EDITING DATE AND TIME FUNCTIONS
The Data Editor lets you edit date and time functions in a table. Data Editor uses a calendar tool to guarantee accurate input for date and time data. You can also change the display of date and time using the Date/Time Format Builder.

For more information, see:
Calendar Button
Date/Time Format Builder

DATE/TIME FORMAT BUILDER
The Date/Time Format Builder lets you customize your date/time display. The Data Editor uses this format to display your dates and times. You control how the Data Editor displays the dates and time by using predefined formats, or by customizing a format to fit your needs.

The Data Editor uses the default date/time format of your Operating System. If you do not make any global changes in Rapid SQL, the Date/Time Format Builder displays dates and times using the default formats of your operating system. If you make changes to dates and times in the Data Editor, Rapid SQL commits the changes in the format used by the database.

NOTE: The changes you make using the Date/Time Format Builder do not affect the way your database stores dates and times.

EDITING THE DATE/TIME DISPLAY
You can edit the date/time display on a global, table, or column level. The table below describes the different ways you can edit your date/time format display:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Global</td>
<td>Lets you make global changes to the Data Editor date display.</td>
<td>Options Editor</td>
</tr>
<tr>
<td>Grid</td>
<td>Lets you make changes to the date display of the entire Data Editor grid for that session only.</td>
<td>Data Editor grid</td>
</tr>
<tr>
<td>Column</td>
<td>Lets you make changes to the date display of a single column in the Data Editor for that session only.</td>
<td>Data Editor column</td>
</tr>
</tbody>
</table>

NOTE: Date/Time formats changed on a table or column level are valid for that session only.

Editing Date/Time Globally
You can use the Options Editor to make global changes to your date/time display in the Data Editor. When you change the date/time format, using the Options Editor, the Data Editor displays all dates and times in the global manner. To change the date/time display for a particular session, see Editing Grid Date/Time Format or Editing Column Date/Time Format.
To edit the date and time globally, do the following:

1. On the File menu, click Options.

   OR

   On the Main tool bar, click Options.

   Rapid SQL opens the Options Editor.

2. On the Options Editor, click the Data Editor Tab.

3. On the Data Editor Tab, click ...

   Rapid SQL opens the Date/Time Format Builder dialog box.

4. On the Date/Time Format Builder dialog box, click the Date/Time Format list, and then click the target predefined date/time format.

5. To customize the date/time format to your specifications, click Customize.

   Rapid SQL opens the Date/Time Format Builder dialog box.

6. On the Date/Time Format Builder dialog box, select the appropriate Date/Time Format Options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Date/Time Format</td>
<td>Displays the predefined Date/Time format.</td>
</tr>
<tr>
<td>Day Format</td>
<td>Lets you choose the day display.</td>
</tr>
<tr>
<td>Separator</td>
<td>Lets you choose the display separator between the day, month, and year.</td>
</tr>
<tr>
<td>Month Format</td>
<td>Lets you choose the month display.</td>
</tr>
<tr>
<td>Year Format</td>
<td>Lets you choose the year display.</td>
</tr>
<tr>
<td>Date Order</td>
<td>Lets you choose the date order display.</td>
</tr>
<tr>
<td>Hour Format</td>
<td>Lets you choose the hour display.</td>
</tr>
<tr>
<td>Minute</td>
<td>Lets you choose the minute display.</td>
</tr>
<tr>
<td>Sec Format</td>
<td>Lets you choose the second display.</td>
</tr>
<tr>
<td>AM/PM</td>
<td>Lets you choose the AM/PM display.</td>
</tr>
<tr>
<td>Date/Time Order</td>
<td>Lets you choose the date/time order display.</td>
</tr>
<tr>
<td>Format Display</td>
<td>Displays the current format.</td>
</tr>
<tr>
<td>Sample</td>
<td>Displays a sample of the current format.</td>
</tr>
</tbody>
</table>

7. When you have finished selecting the Date/Time format options, click OK.

   Rapid SQL accepts the date/time format changes and closes the Date/Time Format Builder dialog box.
8 On the Options Editor, select the appropriate Default Date/Time Format options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use Calendar Control as default</td>
<td>If selected, Rapid SQL uses the Calendar Control window.</td>
</tr>
<tr>
<td>Two-digit year system setting warning</td>
<td>If selected, Rapid SQL sends a warning when you use a two-digit year system setting.</td>
</tr>
</tbody>
</table>

9 Click OK.

Rapid SQL accepts the Default Date/Time Format changes and closes the Options Editor.

**NOTE:** To use a different format for a particular session, change the date/time at the session level.

**Editing Grid Date/Time**

You can change the date/time display for a particular session when working in the Data Editor. The Data Editor does not maintain the format changes once you close your session. To make this display permanent, use the *Editing Global Date/Time Format*.

To edit the grid date and time, do the following:

1 On the Datasource Explorer, select the target table.

2 Right-click the table, and then click Edit Data.

Rapid SQL opens the Data Editor.

3 On the Data Editor tool bar, click Date/Time Format Builder.

Rapid SQL opens the Date/Time Format Builder.

4 On the Date/Time Format Builder, click the Date/Time Format list, and then click the target predefined date/time format.

5 To customize the date/time format to your specifications, click Customize.

Rapid SQL opens the Date/Time Format Builder dialog box.

6 On the Date/Time Format Builder dialog box, select the appropriate Date/Time Format Options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Date/Time Format</td>
<td>Displays the predefined Date/Time format.</td>
</tr>
<tr>
<td>Day Format</td>
<td>Lets you choose the day display.</td>
</tr>
<tr>
<td>Separator</td>
<td>Lets you choose the display separator between the day, month, and year.</td>
</tr>
<tr>
<td>Month Format</td>
<td>Lets you choose the month display.</td>
</tr>
<tr>
<td>Year Format</td>
<td>Lets you choose the year display.</td>
</tr>
<tr>
<td>Date Order</td>
<td>Lets you choose the date order display.</td>
</tr>
</tbody>
</table>
When you have finished selecting the Date/Time format options, click OK.

Rapid SQL accepts the date/time format changes and closes the Date/Time Format Builder dialog box.

- To undo changes, on the Data Editor tool bar, click Undo Change.
- To redo changes, on the Data Editor tool bar, click Redo Change.

**NOTE:** Date/Time formats changed on a table level are valid for that session only.

### Editing Column Date/Time

You can change the date/time display for a particular column when working in the Data Editor. The Data Editor does not maintain the format changes once you close your session. To change the format for the entire grid, see Editing Grid Date/Time Format. To make this display permanent, Editing Global Date/Time Format.

To edit the column date and time, do the following:

1. On the Datasource Explorer, select the target table.
2. Right-click the table, and click Edit Data.
   
   Rapid SQL opens the Data Editor.
3. On the Data Editor, click the column header to select the column.
4. Right-click the column and click Format.
   
   Rapid SQL opens the Date/Time Format Builder.
5. On the Date/Time Format Builder dialog box, click the Date/Time Format list, and then click the target predefined date/time format.
6. To customize the date/time format to your specifications, click Customize.
   
   Rapid SQL opens the Date/Time Format Builder dialog box.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hour Format</td>
<td>Lets you choose the hour display.</td>
</tr>
<tr>
<td>Minute</td>
<td>Lets you choose the minute display.</td>
</tr>
<tr>
<td>Sec Format</td>
<td>Lets you choose the second display.</td>
</tr>
<tr>
<td>AM/PM</td>
<td>Lets you choose the AM/PM display.</td>
</tr>
<tr>
<td>Date/Time Order</td>
<td>Lets you choose the date/time order display.</td>
</tr>
<tr>
<td>Format Display</td>
<td>Displays the current format.</td>
</tr>
<tr>
<td>Sample</td>
<td>Displays a sample of the current format.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hour Format</td>
<td>Lets you choose the hour display.</td>
</tr>
<tr>
<td>Minute</td>
<td>Lets you choose the minute display.</td>
</tr>
<tr>
<td>Sec Format</td>
<td>Lets you choose the second display.</td>
</tr>
<tr>
<td>AM/PM</td>
<td>Lets you choose the AM/PM display.</td>
</tr>
<tr>
<td>Date/Time Order</td>
<td>Lets you choose the date/time order display.</td>
</tr>
<tr>
<td>Format Display</td>
<td>Displays the current format.</td>
</tr>
<tr>
<td>Sample</td>
<td>Displays a sample of the current format.</td>
</tr>
</tbody>
</table>
7 On the Date/Time Format Builder dialog box, select the appropriate Date/Time Format Options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Date/Time Format</td>
<td>Displays the predefined Date/Time format.</td>
</tr>
<tr>
<td>Day Format</td>
<td>Lets you choose the day display.</td>
</tr>
<tr>
<td>Separator</td>
<td>Lets you choose the display separator between the day, month, and year.</td>
</tr>
<tr>
<td>Month Format</td>
<td>Lets you choose the month display.</td>
</tr>
<tr>
<td>Year Format</td>
<td>Lets you choose the year display.</td>
</tr>
<tr>
<td>Date Order</td>
<td>Lets you choose the date order display.</td>
</tr>
<tr>
<td>Hour Format</td>
<td>Lets you choose the hour display.</td>
</tr>
<tr>
<td>Minute</td>
<td>Lets you choose the minute display.</td>
</tr>
<tr>
<td>Sec Format</td>
<td>Lets you choose the second display.</td>
</tr>
<tr>
<td>AM/PM</td>
<td>Lets you choose the AM/PM display.</td>
</tr>
<tr>
<td>Date/Time Order</td>
<td>Lets you choose the date/time order display.</td>
</tr>
<tr>
<td>Format Display</td>
<td>Displays the current format.</td>
</tr>
<tr>
<td>Sample</td>
<td>Displays a sample of the current format.</td>
</tr>
</tbody>
</table>

8 When you have finished selecting the Date/Time format options, click OK.

Rapid SQL accepts the date/time format changes and closes the Date/Time Format Builder dialog box.

- To undo changes, on the Data Editor tool bar, click Undo Format.
- To redo changes, on the Data Editor tool bar, click Redo Format.

**NOTE:** Date/Time formats changed on a column level are valid for that session only.

**DEFAULT VALUE HANDLING**

When adding new records, when the transaction committing a row occurs, if no value has been entered for a column defined as having a default value, the default value is used for that column and validation is not required. The default value is not visible in the Data Editor grid until you commit the record and use the Reload Data button to refresh the grid.

In the case of tables with all columns defined as having default values, for example, you can add multiple records by repeatedly clicking the Insert New Record and Save Current Row buttons.

**Page Setup**

The table below describes the options and functionality on the Page Setup dialog box:
The Rapid SQL Code Generation Facility offers a quick way to generate DML statements for
tables and views. The Code Generation Facility provides an efficient way to establish and
enforce coding standards within the application by generating code with standardized
formatting. The Code Generation Facility also lets you:

- Create packages and procedures for Oracle.
- Create procedures for IBM DB2 LUW, Microsoft SQL Server, and Sybase ASE.

**NOTE:** The Code Generation Facility can generate procedures for IBM DB2 LUW that are
based on tables but not views.

The table below describes the options and functionality on the Embarcadero Code Generator:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| Datasource List      | To change the default datasource, click the list and then click a new datasource.  
                        | NOTE: If you are not connected to the target datasource, click the Connect button to establish a connection.  
                        | The current datasource, and database and datasource user name where applicable, are preselected when you open Code Generation Facility. |
| Database List        | Lets you click the list and then click a target database.                   |
| Owner List           | Lets you click the list and then click the new owner.                       |
| Tables Option Button | Click this option to see a list of the tables in the scroll box. In the scroll box, click the target table to be used as a code generation base.  
                        | NOTE: The list of objects corresponds to the selected datasource owner schema. If there are no tables in the target schema, the list will be empty. |
IMPORT DATA

Using the Code Generation Facility


OR

On the Tools toolbar, click Code Generation Facility.

Rapid SQL opens the Embarcadero Code Generator dialog box.

IMPORT DATA

It is often necessary to import data into database tables from an external source. Developers commonly need to bring sample test data into a database to assist with Use Case scenarios. These scenarios may simulate particular data retrievals where segments of the data are preferred over performing a full data load. Business Analysts often acquire spreadsheets from outside sources. It is helpful to them to load this data into tables to perform more in-depth queries and pull meaningful data to make informed decisions.

### Option Description

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| Views Option Button | Click this option to see a list of the views in the scroll box. In the scroll box, click the target view to be used as a code generation base. 
NOTE: The list of objects corresponds to the selected datasource owner schema. If there are no views in the target schema, the list will be empty. |
| Select 1 or More Where Clause | In the grid, select the check boxes that correspond to the target where clauses. 
NOTE: Columns of primary keys are preselected. |
| Select 1 or More Output Columns | In the grid, select the check boxes that correspond to the target output columns. 
NOTE: All existing columns are preselected. |
| Provide and Output File Name | In the box, enter the file name in the File box or click the Browse button to locate the output file. |
| Open | Select to open the file after the procedure runs. |
| Execute Immediately | Select to execute the file immediately. |
| Generate | To generate an SQL statement for tables, click the Object Type list and then click the object type. 
NOTE: If you are generating an SQL statement for Views, you only have the Select option. |
| Grant Execute to | If you are a DBA or have DBA privileges, select the Users, Roles, and Groups check boxes to grant execute privileges. |
To leverage the power of Microsoft Excel, database users may prefer to pull data from the database and load it into spreadsheet. Once using manipulations like Average, Aggregate, Row Count, or simple additions or deletions have been used on the data, the need remains to import this massaged data back into the database. Additionally, once the data is placed back in the database, recurring reporting and documentation are easily accomplished.

Rapid SQL’s Import Data tool eliminates the time-consuming, manual process of working with data. The Import Data Wizard lets you pull data from a text file or a Microsoft Excel spreadsheet.

**Important Notes**

None

**Completing the Import Data Wizard**

1. On the **Tools** menu, click **Import Data**.

   Rapid SQL opens the **first panel** of the Import Data Wizard.

2. On the first panel of the Wizard, specify the location of the file and enter the catalogue, schema (owner), and table into which the data will be imported.

3. Click Next.

4. On the second panel of the Wizard, select the character delimited type for the columns in the data file – Tab, Semi colon, Comma, Space, or Other (Custom – Tilde, Ampersand etc.)

5. You can select the option that the first row of the data contains field names.

6. Click Next.

7. On the third panel of the Wizard, you can preview and confirm the data format. You can also use the custom mapping to match columns in the table.

8. If you need to make any changes, click Back to scroll back to the appropriate panels of the wizard to make your corrections.

9. Click Finish.

   Rapid SQL generates the Insert statements that can be saved as a *.sql file for re-use across several datasources (versus simply loading the data directly into the database).

---

**IMPORT DATA WIZARD - PANEL 1**

The table below describes the options and functionality on this panel of the Import Data Wizard:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Specify the file to be used in this data load operation.</td>
<td>Lets you type the file path or browse for the file.</td>
</tr>
</tbody>
</table>
IMPORT DATA

For more information, see Import Data.

IMPORT DATA WIZARD - PANEL 2 FOR TEXT FILES
The table below describes the options and functionality on this panel of the Import Data Wizard:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Which table do you want to load data into?</td>
<td>Lets you select the catalog, schema, and the table to create the insert statements.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>What character delimited the columns in the data file?</td>
<td>Lets you select the character delimited type for the columns in the data file: Tab, Semicolon, Comma, Space, or Other (Custom – Tilde, Ampersand etc.)</td>
</tr>
<tr>
<td>First Row Contains Field Names</td>
<td>Select for the first row of the data to contain field names.</td>
</tr>
</tbody>
</table>

For more information, see Import Data.

IMPORT DATA WIZARD - PANEL 3 FOR TEXT FILES
This panel of the Import Data Wizard lets you assign column names to fields. Column names in red indicate an invalid mandatory column names. Blue columns are already used.

For more information, see Import Data.

IMPORT DATA WIZARD - PANEL 2 FOR EXCEL FILES
The table below describes the options and functionality on this panel of the Import Data Wizard:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>The spreadsheet you have selected contains more than one worksheet. Which worksheet contains the data you wish to import?</td>
<td>Lets you select the worksheet to import.</td>
</tr>
<tr>
<td>Start Cell</td>
<td>Lets you type the first cell of data to import.</td>
</tr>
<tr>
<td>End Cell</td>
<td>Lets you type the last cell of data to import.</td>
</tr>
<tr>
<td>First Row Contains Field Names</td>
<td>Select to assign column names to fields in the grid.</td>
</tr>
</tbody>
</table>

For more information, see Import Data.
EMBARCADERO PRODUCTS

The Tools menu lists all installed Embarcadero Technologies products. This lets you toggle to or start another Embarcadero product.

To open the Performance Center web client, do the following:

CODE WORKBENCH

The Code Workbench is a multi-tabbed dialog that lets you enable and configure the following, time-saving ISQL editor features:

- **Code templates** - common, multi-line blocks of code you can add to a script with a couple of keystrokes and modify to the purpose of the script. For information on using this feature, see [Using Code Templates](#).

- **Auto replace** - commonly used SQL syntax or commands that can be added to a script using a shortcut, replacement expression. For information on using this feature, see [Using Auto Replace Expressions](#).

The Code Workbench lets you modify, add, and delete Code Template and Auto Replace resources. In addition, you can save your Code Workbench settings for the purpose of user-sharing or customization. The following topics provide detailed instructions and information on setting up these features:

- [Enabling the Code Templates and Auto Replace Features](#)
- [Maintaining Code Template Definitions](#)
- [Maintaining Auto Replace Expressions](#)
- [Loading and Saving Custom Code Workbench Settings](#)

ENABLING THE CODE TEMPLATES AND AUTO REPLACE FEATURES

In order to use the Code Templates or Auto Replace features, they must be enabled.
To enable the Code Templates or Auto Replace features


2. Use the following table as a guide to using the controls on the Settings panel:

<table>
<thead>
<tr>
<th>Group</th>
<th>Settings and descriptions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto Replace</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Enable Auto Replace</td>
</tr>
<tr>
<td></td>
<td>Replace substrings</td>
</tr>
<tr>
<td>Code Templates</td>
<td>Enable Code Templates</td>
</tr>
</tbody>
</table>

3. Either click OK to dismiss the dialog or use the other tabs to configure the code templates and auto replace features.

For information on configuring the Code Template and Auto Replace features, see Maintaining Code Template Definitions and Maintaining Auto Replace Expressions.

See also:
- Using Code Templates
- Using Auto Replace Expressions

MAINTAINING CODE TEMPLATE DEFINITIONS

Rapid SQL loads a default set of code templates automatically on startup. The Code Workbench lets you add templates to the currently loaded templates, edit any existing templates, or delete templates.

To modify the currently loaded code templates

1. From the Tools menu, select Code Workbench.

2. Select the Code Templates tab.
3 Use the following table as a guide to performing the template maintenance tasks offered on this tab:

<table>
<thead>
<tr>
<th>Task</th>
<th>Steps</th>
</tr>
</thead>
<tbody>
<tr>
<td>To add a new template</td>
<td>Click Add to open the <strong>Edit Code Template expression</strong> dialog and provide the following information:&lt;br&gt;&lt;br&gt;<strong>Shortcut</strong> - used to identify the template when the Code Assist menu is open.&lt;br&gt;<strong>Description</strong> - displayed in the <strong>Code Templates</strong> tab listing for this template.&lt;br&gt;<strong>Platform</strong> - Select a specific DBMS platform or select ALL. The template will be available in ISQL editor windows with connections to the specified platform or all platforms, accordingly.&lt;br&gt;<strong>Template</strong> - Type the code block that will be added at the cursor when this template is selected.</td>
</tr>
<tr>
<td>To edit a template</td>
<td>Select a template from the list, click <strong>Edit</strong> to open the <strong>Edit Code Template expression</strong> dialog, and edit the template values as per the descriptions above.</td>
</tr>
<tr>
<td>To delete a template</td>
<td>Select a template from the list, click <strong>Delete</strong> and when prompted to confirm, click <strong>Yes</strong>.</td>
</tr>
</tbody>
</table>

**NOTE:** You can also save the currently loaded code templates and other Code Workbench settings to an XML file for subsequent loading. This lets you share settings among users and tailor Code Template and Auto Replace settings to particular environments or projects. For details, see [Loading and Saving Custom Code Workbench Settings](#).

**MAINTAINING AUTO REPLACE EXPRESSIONS**

Rapid SQL is packaged with a set of default Auto Replace definitions, stored in the registry and loaded automatically on startup. The Code Workbench lets you add new definitions, edit any existing definitions, or delete definitions from the currently loaded set.

**To modify the currently loaded expressions**

1. From the **Tools** menu, select **Code Workbench**.
2. Select the **Auto Replace** tab.
3 Use the following table as a guide to performing the template maintenance tasks offered on this tab:

<table>
<thead>
<tr>
<th>Task</th>
<th>Steps</th>
</tr>
</thead>
<tbody>
<tr>
<td>To add a new expression</td>
<td>Click <strong>Add</strong> to open the <strong>Edit Auto Replace Expression</strong> dialog and provide the following information:</td>
</tr>
<tr>
<td></td>
<td><strong>Expression</strong> - the shortcut that will be replaced.</td>
</tr>
<tr>
<td></td>
<td><strong>Activation</strong> - Type one or more individual keys that are to trigger replacement in the ISQL editor. Valid activation keystrokes are SPACE, TAB, and RETURN. As you type, the following representations are shown in the <strong>Activation</strong> box: \s represents SPACE, \t represents TAB, and \n represents RETURN (newline).</td>
</tr>
<tr>
<td></td>
<td><strong>Replace With</strong> - Type the command or SQL syntax that will be replaced when one of the activation events occurs.</td>
</tr>
<tr>
<td>To edit an expression</td>
<td>Select an expression from the list, click <strong>Edit</strong> to open the <strong>Edit Auto Replace Expression</strong> dialog, and edit the expression values as per the descriptions above.</td>
</tr>
<tr>
<td>To create an expression based on an existing expression</td>
<td>Select an expression from the list, click <strong>Clone</strong> to open the <strong>Edit Auto Replace Expression</strong> dialog, prepopulated with values of the existing expression. Edit the expression values as per the descriptions above.</td>
</tr>
<tr>
<td>To delete an expression</td>
<td>Select an expression from the list, click <strong>Delete</strong> and when prompted to confirm, click <strong>Yes</strong>.</td>
</tr>
</tbody>
</table>

**NOTE:** You can also save the currently loaded Auto Replace expressions and other Code Workbench settings to an XML file and subsequently load those settings. This lets you share settings among users and tailor Auto Replace and Code Template settings to particular environments or projects. For details, see *Loading and Saving Custom Code Workbench Settings*.  

**LOADING AND SAVING CUSTOM CODE WORKBENCH SETTINGS**

At each startup, Rapid SQL loads a default set of code templates and auto replace definitions stored in the registry. The enabled/disabled status of the two features is retained on shutdown.

After changing the enabled/disabled status of the Code Templates or Auto Replace features, or modifying the associated templates or replacement expressions, you can save the status and currently loaded resources to an XML file. The ability to save, load, and restore settings means you can:

- Share Code Workbench settings among users
- Create custom Code Workbench settings tailored to DBMS platforms or coding projects
To make use of Code Workbench fie options

1. From the **Tools** menu, select **Code Workbench**.

2. Use the following table as a guide to performing the Code Workbench file option tasks:

<table>
<thead>
<tr>
<th>Task</th>
<th>Steps</th>
</tr>
</thead>
<tbody>
<tr>
<td>To save the current Code Workbench settings to an XML file:</td>
<td>Click <strong>Export Settings</strong> and use the <strong>Save As</strong> dialog to select a location and provide a name for the exported file.</td>
</tr>
<tr>
<td>To replace the currently loaded Code Workbench settings with a set of saved settings:</td>
<td>Click <strong>Import Settings</strong> and use the <strong>Open</strong> dialog to locate and select the settings file to be loaded.</td>
</tr>
<tr>
<td>To restore the default Code Workbench settings from the registry:</td>
<td>Click <strong>Restore Settings</strong>.</td>
</tr>
</tbody>
</table>

See also:

- [Maintaining Code Template Definitions](#)
- [Maintaining Auto Replace Expressions](#)

---

**CODE ANALYST**

The Code Analyst is a tool to identify time-consuming lines of code. Code Analyst lets you:

- Perform detailed response time analysis on the execution of procedures and foreign keys.
- Benchmark the execution of one or more procedures or functions to determine exactly what code objects and lines of code are taking the longest to run.
- Save response time metrics and perform intelligent compares against current execution times so you can determine deviations from previous acceptable response times.

**TIP:** You can set Code Analyst options in the **Code Analyst Options**.

**NOTE:** Availability of this feature depends on your Rapid SQL licensing. For more information, see [Licensing](#).

---

**Important Notes**

- For DB2, before profiling with Code Analyst, [Compile](#) all procedures with the debugging option selected.
- For Oracle, when using the Oracle Debugger, [Compile](#) all procedures with the debugging option selected before profiling with Code Analyst.

---

**Common Tasks**

[Creating a Code Analyst Session](#)
Identifying and Fixing Bottlenecks Using Code Analyst
Comparing Code Analyst Sessions
Cloning a Code Analyst Session
Deleting a Code Analyst Session
Stopping a Code Analyst Session Execution
Executing a Code Analyst Session
Scheduling a Code Analyst Session
Unscheduling a Code Analyst Session
Refreshing a Code Analyst Session
Saving Results in Code Analyst
Printing Results in Code Analyst
Viewing Run Details in Code Analyst
Viewing Unit Summary Information in Code Analyst
Viewing Unit Details in Code Analyst
Setting View Options for the Unit Detail Tab in Code Analyst
Extracting SQL Text in Code Analyst
Executing SQL in Code Analyst

CODE ANALYST DBMS NOTES

Code Analyst is available for:

- Microsoft SQL Server
- Oracle
- IBM DB2 LUW
- Sybase ASE

Rapid SQL utilizes debugger technology to capture the data for each line of executed code. For Oracle, you can use the debugger or using Oracle’s supplied DBMS_Profiler package.

**TIP:** For Oracle, you can specify to use the debugger or the DBMS_Profiler package on the Code Analyst Options.

The Code Analyst will step through each line of code, stopping to record data for those lines of code onto which a breakpoint can be issued. Some debuggers cannot capture time metrics for all lines of a stored procedure or function.
Procedures and functions that contain looping constructs will require more time to run. The additional amount of time needed to run is proportional to the number of iterations in the loop.

For more information, see:

IBM DB2 LUW Data Captured by Code Analyst
Microsoft SQL Server Data Captured by Code Analyst
Oracle Data Captured by Code Analyst
Sybase ASE Data Captured by Code Analyst

IBM DB2 LUW DATA CAPTURED BY CODE ANALYST
Code Analyst utilizes the IBM Debugger when capturing time data.

The debugger is verified to run on IBM DB2 LUW version 7.2 and up. There is a known issue running version 7.2 with Fixpack 9.

DB2 has documented limitations on lines of code can be profiled.
The following are SQL statements that are NOT valid break point lines:

BEGIN
BEGIN
BEGIN NOT ATOMIC
BEGIN ATOMIC
CLOSE CURSOR
DECLARE cursor WITH RETURN FOR <sql statement>
DECLARE , var without default
DECLARE CONDITION (CONDITION) FOR SQLSTATE (VALUE) "..."
DECLARE CONTINUE HANDLER
DECLARE CURSOR
DECLARE EXIT HANDLER
DECLARE RESULT_SET_LOCATOR [VARYING]
DECLARE SQLSTATE
DECLARE SQLCODE (unless there is a default)
DECLARE UNDO HANDLER (unless they are entered)
DO
ELSE
END
END CASE
END IF
END FOR
END REPEAT
END WHILE
ITERATE
LEAVE
LOOP
OPEN CURSOR
REPEAT (as a keyword alone)
RESIGNAL
SIGNAL
THEN
labels, e.g. P1:

**NOTE:** Code containing these statements will not have times associated with them.

For more information, see *Code Analyst DBMS Notes*.

**MICROSOFT SQL SERVER DATA CAPTURED BY CODE ANALYST**

In order to execute a Code Analyst session against a Microsoft SQL Server database, the SQL Server debugger must be installed and functioning properly. Please refer to *Embarcadero SQL Debugger for Microsoft SQL Server* for details concerning set up.

**Related Information**
*Code Analyst DBMS Notes*

**ORACLE DATA CAPTURED BY CODE ANALYST**

When using the PL/SQL Profiler, Oracle has documented an issue regarding extremely large times being returned by the profiler. The times are sometimes hundred times larger than the actual run time of the stored procedure or function. Oracle documents that this is a vendor/os problem rather than an Oracle problem, because the RDTSC instruction is reporting wrong time stamp counter. They indicate that they have seen this problem on some INTEL Pentium processors.

**Related Information**
*Code Analyst DBMS Notes*

**SYBASE ASE DATA CAPTURED BY CODE ANALYST**

Sybase ASE has documented a problem with their debugger API. The problem involves reporting the wrong line number through the debugger. Because of this bug, Code Analyst may report back data for blank lines or lines that contain comments. Sybase has fixed this problem release 12.5.2 of the database. All procedures affected must be dropped and recreated in order to correct the problem.

**Related Information**
*Code Analyst DBMS Notes*
CODE ANALYST REQUIREMENTS

Debuggers
The Code Analyst uses fully configured Embarcadero SQL Debuggers to profile, and therefore availability of this feature depends on your Rapid SQL licensing. For more information, see the following topics:

- Licensing
- Rapid SQL Add-On Tools

Using Code Analyst with the Oracle Profiler
Oracle users have the option of either using the Oracle Debugger or the Oracle Profiler with Code Analyst to capture statistics. To use Code Analyst with the profiler option, Oracle’s profiler package must be installed. The install is user specific, so it must be installed by each user wishing to use Code Analyst. To install the package, users can invoke the Rapid SQL PL/SQL Profiler.

TIP: You can set profiler options in the Code Analyst Options. You can specify that Code Analyst display the actual run time on the database, and does not include the time it takes to get to the server.

Privileges
For Oracle, SYS privileges are required to install the Code Analyst tables. If you do not have SYS privileges, ask your Server Administrator to log into the Oracle datasource as SYSDBA, and then open Code Analyst to install the tables.

During install, the following privileges are set for the Code Analyst tables.

- DB2 – Permissions are granted to the Public Group
- Oracle – Permissions are granted to the Public group.
- Microsoft SQL Server – Permissions are granted to the Public role.
- Sybase ASE – Permissions are granted to the Public group.

All users can use the Code Analyst but each user will only see their own run ids. Users need to belong to the public group.

TIP: You can check this/modify privileges in the Users Editor.

INSTALLING CODE ANALYST
To install Code Analyst, do the following:

2. In Select the database you would like to install the tables on, select a database.
3. For IBM DB2 LUW for Open Systems, in select the tablespace you would like to install the tables on, select a tablespace.

4. For IBM DB2 LUW for Open Systems, in select the schema you would like to install the tables on, select a schema. The default is EMBTCA schema.

5. In Select the filegroup you would like to install the tables to, select a filegroup.

Code Analyst installs the following repository tables in the repository:

- EMBT_CODE_ANA_RUNS - Holds all the code analyst sessions created by users.
- EMBT_CODE_ANA_UNITS - Holds all the objects to be run for all.
- EMBT_CODE_ANA_PARAMS - Contains all the parameters for the objects that were run.
- EMBT_CODE_ANA_DATA - Contains the run data and is used to populate all the charts and statistics.
- EMBT_CODE_ANA_VERSION - Contains the version number of code analyst.

Code Analyst opens to the Run Summary tab.

6. Create a session using the [Creating a Code Analyst Session](#).

### UNINSTALLING CODE ANALYST

The Uninstall functionality lets you uninstall Code Analyst from the server.

**NOTE:** To uninstall a repository table, you need create table and grant privileges. Generally, you need sysadmin privileges.


2. Select a session or object, and then select Uninstall.

Code Analyst removes the repository tables in the repository:

- EMBT_CODE_ANA_RUNS - Holds all the code analyst sessions created by users.
- EMBT_CODE_ANA_UNITS - Holds all the objects to be run for all.
- EMBT_CODE_ANA_PARAMS - Contains all the parameters for the objects that were run.
- EMBT_CODE_ANA_DATA - Contains the run data and is used to populate all the charts and statistics.
- EMBT_CODE_ANA_VERSION - Contains the version number of code analyst.
**CODE ANALYST PRODUCT DESIGN**

Code Analyst performs detailed response time analysis. Code Analyst steps through each line of code and profiles those lines of code that the debugger or profiler can capture time metrics for.

**NOTE:** Some debuggers do not capture time metrics for all lines of a procedure or function. For more information, see Code Analyst DBMS Notes.

After capturing the time metrics, Code Analyst displays the data in an easy-to-read format on the tabs.

The Code Analyst is comprised of the following tabs:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Run Summary</td>
<td>Session</td>
<td>Lets you select the run session(s).</td>
</tr>
<tr>
<td></td>
<td>Session</td>
<td>Displays the name of the session as created by the user.</td>
</tr>
<tr>
<td></td>
<td>Run ID</td>
<td>Displays the run ID for the run(s). This number is system generated.</td>
</tr>
<tr>
<td></td>
<td>Run Date</td>
<td>Displays the time and date of the session.</td>
</tr>
<tr>
<td></td>
<td>Total Profile Time (ms)</td>
<td>Displays the total time taken for the profiled code to execute. This time is limited to the lines of code that are profiled. Overhead is not included in this calculation.</td>
</tr>
<tr>
<td></td>
<td>Total Analysis Time</td>
<td>Displays the total time taken for the session to complete, including all overhead time needed to analyze the procedure or function.</td>
</tr>
<tr>
<td></td>
<td>Scheduler</td>
<td>Displays the scheduler used to schedule the session. This information displays until the scheduled job has been run.</td>
</tr>
<tr>
<td>Run Detail</td>
<td>Session</td>
<td>Lets you select the object execution session.</td>
</tr>
<tr>
<td></td>
<td>Run</td>
<td>Lets you select the object execution.</td>
</tr>
<tr>
<td></td>
<td>Unit Type</td>
<td>Lets you select the object type for the object execution.</td>
</tr>
<tr>
<td></td>
<td>Unit Owner</td>
<td>Lets you select the object owner for the object execution.</td>
</tr>
<tr>
<td></td>
<td>Unit Database</td>
<td>Lets you select the object database for the object execution.</td>
</tr>
<tr>
<td></td>
<td>Time Unit</td>
<td>Lets you specify the time unit for the Unit Execution graph.</td>
</tr>
<tr>
<td></td>
<td>Unit Name</td>
<td>Displays the owner of the procedure or function.</td>
</tr>
<tr>
<td></td>
<td>Unit Type</td>
<td>Displays the types of captured objects, including Anonymous Block, Function, Package Body, and Procedure for Oracle databases. Also displays SQL Statement and Procedure for the other platforms.</td>
</tr>
<tr>
<td></td>
<td>Unit Database</td>
<td>Displays the database on which the object is stored.</td>
</tr>
<tr>
<td></td>
<td>Total Profiled Time</td>
<td>Displays the total time taken for the profiled code to execute.</td>
</tr>
<tr>
<td></td>
<td>% of Profiled Time</td>
<td>Displays the percentage of the Total Profiled Time for the run that this unit accounts for.</td>
</tr>
<tr>
<td>Comparison</td>
<td>Base Run</td>
<td>Lets you select the earlier object execution.</td>
</tr>
<tr>
<td>Tab</td>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>-------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Unit Summary</td>
<td>Unit Owner</td>
<td>Lets you select the object owner for the session(s).</td>
</tr>
<tr>
<td></td>
<td>Unit Name</td>
<td>Lets you select the object name for the session(s).</td>
</tr>
<tr>
<td></td>
<td>Unit Database</td>
<td>Lets you select the object database for the session(s).</td>
</tr>
<tr>
<td></td>
<td>Number of Top Runs</td>
<td>Lets you specify the number of top object executions to display in the Top 5 Runs graph and select the unit of time for the Unit Time graph.</td>
</tr>
<tr>
<td></td>
<td>Session</td>
<td>Displays the name of the session as created by the user.</td>
</tr>
<tr>
<td></td>
<td>Run ID</td>
<td>Displays the unique id for the Run. This number is system generated.</td>
</tr>
<tr>
<td></td>
<td>Run Date</td>
<td>Displays the time and date of the session.</td>
</tr>
<tr>
<td></td>
<td>Total Analysis Time</td>
<td>Displays the total time taken for the session to complete, including all overhead time needed to analyze the procedure or function.</td>
</tr>
<tr>
<td></td>
<td>Total Profiled Time</td>
<td>Displays the total time taken for the profiled code to execute.</td>
</tr>
<tr>
<td></td>
<td>Unit Profiled Time</td>
<td>Displays the unit time for the session(s).</td>
</tr>
<tr>
<td></td>
<td>% of Profiled Time</td>
<td>Displays the percentage of the Total Profiled Time for the run that this unit accounts for.</td>
</tr>
<tr>
<td></td>
<td>% of Run Time</td>
<td>Displays the percentage of object execution time for the session(s).</td>
</tr>
<tr>
<td>Unit Detail</td>
<td>Session</td>
<td>Lets you select the session.</td>
</tr>
<tr>
<td></td>
<td>Run</td>
<td>Lets you select the object execution.</td>
</tr>
<tr>
<td></td>
<td>Unit Name</td>
<td>Lets you select the object name for the session.</td>
</tr>
<tr>
<td></td>
<td>Number of Top Lines</td>
<td>Lets you specify the number of top lines in the Top 5 Lines Execution Time graph and select the total time units.</td>
</tr>
<tr>
<td></td>
<td>Percentage Calculation</td>
<td>Lets you specify total object execution time or object run time.</td>
</tr>
<tr>
<td></td>
<td>Calls</td>
<td>Displays the number of times the line was executed.</td>
</tr>
<tr>
<td></td>
<td>Total Time</td>
<td>Displays the total time the line was executed.</td>
</tr>
<tr>
<td></td>
<td>% of Total Profiled</td>
<td>Displays the percentage of the Total Profiled Time that this line of code was responsible for.</td>
</tr>
</tbody>
</table>
Common Tasks

Creating a Code Analyst Session
Identifying and Fixing Bottlenecks Using Code Analyst
Comparing Code Analyst Sessions
Cloning a Code Analyst Session
Deleting a Code Analyst Session
Stopping a Code Analyst Session Execution
Executing a Code Analyst Session
Scheduling a Code Analyst Session
Unscheduling a Code Analyst Session
Refreshing a Code Analyst Session
Saving Results in Code Analyst
Printing Results in Code Analyst
Viewing Run Details in Code Analyst
Viewing Unit Summary Information in Code Analyst
Viewing Unit Details in Code Analyst
Setting View Options for the Unit Detail Tab in Code Analyst
Extracting SQL Text in Code Analyst
Executing SQL in Code Analyst

**CODE ANALYST TUTORIAL**

The following tutorial guides you through the process of using the Code Analyst.

<table>
<thead>
<tr>
<th>Tab</th>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Avg Time</td>
<td>Displays the average profiled time for this line.</td>
</tr>
<tr>
<td></td>
<td>Min Time</td>
<td>Displays the minimum recorded time for execution of this line.</td>
</tr>
<tr>
<td></td>
<td>Max Time</td>
<td>Displays the maximum recorded time for execution of this line.</td>
</tr>
<tr>
<td></td>
<td>Dependency</td>
<td>Displays the UNIT_NUMBER of the dependency object that was called by that line. Lets you right-click and quickly go to that UNIT_NUMBER to see its Unit detail information.</td>
</tr>
<tr>
<td></td>
<td>Source</td>
<td>Displays the object's SQL source code.</td>
</tr>
</tbody>
</table>
Creating a Code Analyst Session

   Initially, Code Analyst installs the repository tables. For more information, see Installing Code Analyst. Then Rapid SQL opens the Code Analyst to the Run Summary tab.

2. On the Code Analyst Tools toolbar, click the Create New Collection button.
   Rapid SQL opens the first panel of the Code Analyst Wizard.

3. Select the individual object or group of objects to analyze. In this example, an individual stored procedure (CREATE_ADMISSION2) is selected.
   **TIP:** Code Analyst does not let you select objects that do not have stored procedures.

4. Click Next.
   If the object(s) selected to be analyzed requires parameters, the second panel of the wizard prompts you to enter the parameters.

5. Double-click the object to set the parameters.

6. For IBM DB2 LUW for Open Systems and Oracle, the Compile button opens the Confirm Compile dialog box that lets you compile the objects to ensure that the Code Analyst can capture the time metrics.

7. Click Finish.
   Code Analyst displays a message that the Code Analyst will run longer than the actual code. Then Code Analyst analyzes the objects, using the Embarcadero SQL Debugger to profile and then opens the Run Detail tab.
   **TIP:** You can select the "Please do not show me this dialog again" option in the dialog box or set the option on the Code Analyst Options.
Identifying and Fixing Bottlenecks Using Code Analyst

The Run Detail tab displays the total time for the objects being analyzed. The tab information may be enough to identify the potential bottleneck.

1. To view more detailed information, double-click the Unit Name.

   Code Analyst opens to the Unit Detail tab.
The Unit Detail Tab displays the object code and other information related to the individual lines of code. You can determine which line of code is taking too long and why. The Unit Detail Tab is where you troubleshoot, and then resolve the problem in the **Modifying objects using editors**.

2. In Rapid SQL, open the object editor, and then modify the code on the Definition tab.
3. Click Alter.
4. In Code Analyst, on the Unit Detail Tab, click Execute.
Comparing Code Analyst Sessions

1. Click the Comparison tab.

Code Analyst has a Comparison facility to allow quick compares of two object executions, showing the base time and the new time, as well as the time differences. The Comparison tab lets you compare which of the two procedures or functions ran faster.

2. Examine the Time Diff which indicates improvement to code.

3. If necessary, continue to modify the code on the Definition tab of the object editor, and then press Alter.

4. In Code Analyst, on the Unit Detail Tab, click Execute.

5. Examine the Time Diff until the bottleneck is solved.

Common Tasks

Creating a Code Analyst Session
Identifying and Fixing Bottlenecks Using Code Analyst
Comparing Code Analyst Sessions
Cloning a Code Analyst Session
USING THE CODE ANALYST

When working with database code stored in database objects, it is sometimes difficult to pinpoint bottlenecks within the code. When situations like this arise, Code Analyst can assist in identifying the trouble spots. Code Analyst can be used to analyze one object or a group of objects. You select one or multiple objects, execute them, view the results, and save those results for later viewing or comparing.

Common Tasks

Creating a Code Analyst Session
Identifying and Fixing Bottlenecks Using Code Analyst
Comparing Code Analyst Sessions
Cloning a Code Analyst Session
Deleting a Code Analyst Session
Stopping a Code Analyst Session Execution
Executing a Code Analyst Session
Scheduling a Code Analyst Session
Unscheduling a Code Analyst Session
Refreshing a Code Analyst Session
Saving Results in Code Analyst
Printing Results in Code Analyst
Viewing Run Details in Code Analyst
Viewing Unit Summary Information in Code Analyst
Viewing Unit Details in Code Analyst
Setting View Options for the Unit Detail Tab in Code Analyst
Extracting SQL Text in Code Analyst
Executing SQL in Code Analyst
Refreshing a Code Analyst Session

Saving Results in Code Analyst

Printing Results in Code Analyst

Viewing Run Details in Code Analyst

Viewing Unit Summary Information in Code Analyst

Viewing Unit Details in Code Analyst

Setting View Options for the Unit Detail Tab in Code Analyst

Extracting SQL Text in Code Analyst

Executing SQL in Code Analyst

CREATING A CODE ANALYST SESSION

The Code Analyst Wizard creates a new Code Analysis session that creates data for the Code Analyst tabs:

   
   Rapid SQL opens the first panel of the Code Analyst Wizard.
3. Select the individual object or group of objects to analyze.
4. Click Next.
   
   If the object(s) selected to be analyzed requires parameters, the second panel of the wizard prompts you to enter the parameters.
5. Double-click the object to set the parameters.
6. For IBM DB2 LUW for Open Systems and Oracle, the Compile button opens the Confirm Compile dialog box that lets you compile the objects to ensure that the Code Analyst can capture the time metrics.
7. Click Finish.

   Code Analyst displays a message that the Code Analyst will run longer than the actual code. Then Code Analyst analyzes the objects, using the Embarcadero SQL Debugger to profile and then opens the Run Detail tab.

   **TIP:** You can also select the “Please do not show me this dialog again” option in the dialog box or set the option on the Code Analyst Options.

For more information, see Code Analyst Wizard.
**CODE ANALYST WIZARD**

The table below describes the options and functionality of the Code Analyst Wizard:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Session Name</td>
<td>Lets you type a name.</td>
</tr>
<tr>
<td>Select by Owner</td>
<td>Code Analyst Wizard queries the database to get the list of procedures and functions and lets you select objects to retrieve Codes for. Select to display available objects by owner, and then select the database(s).</td>
</tr>
<tr>
<td>Select by Object</td>
<td>Code Analyst Wizard queries the database to get the list of procedures and functions and lets you select objects to retrieve Codes for. Select to display available objects by object, and then select the object(s).</td>
</tr>
<tr>
<td>Object Name</td>
<td>Double-click each object to specify the input parameters. Specify which object executes first by clicking the Up and Down buttons.</td>
</tr>
<tr>
<td>Compile</td>
<td>IBM DB2 LUW FOR OPEN SYSTEMS AND ORACLE ONLY: Opens the Confirm Compile dialog box that lets you compile the objects to ensure that the Code Analyst can capture the time metrics.</td>
</tr>
<tr>
<td>Schedule</td>
<td>Opens the Select Scheduler dialog box or opens scheduling application.</td>
</tr>
<tr>
<td>Finish</td>
<td>Code Analyst analyzes the code.</td>
</tr>
</tbody>
</table>

For more information, see: [Creating a Code Analyst Session](#).

**IDENTIFYING AND FIXING BOTTLENECKS USING CODE ANALYST**

The Unit Detail Tab displays the object code and other information related to the individual lines of code. You can identify time-consuming lines of code in the Unit Detail Tab. The Unit Detail Tab is where you troubleshoot, and then resolve the problem in the [Modifying objects using editors](#).

2. Click the Unit Detail Tab.
   - Percent of Run Time displays the percentage of object execution time for the session(s).
3. Identify an object that contains time-consuming code.
4. In Rapid SQL, open the object editor, and then modify the code on the Definition tab.
5. Click Alter.
6. In Code Analyst, on the Unit Detail Tab, click Execute.
7. Click the Comparison tab.
The Comparison Tab lets you compare times of the objects in two different object executions to determine which run was more efficient. The Comparison Tab displays the base time and the new time, as well as the time differences. The Comparison tab lets you compare which of the two procedures or functions ran faster.

8. Examine the Time Diff which indicates improvement to code.

9. If necessary, continue to modify the code on the Definition tab of the object editor, and then press Alter.

10. Create new Code Analyst sessions and examine the Time Diff until the bottleneck is solved.

For more information, see:

- Code Analyst Product Design
- Using the Code Analyst

COMPARING CODE ANALYST SESSIONS
The Comparison Tab lets you compare times of the objects in two different object executions to determine which run was more efficient. The Comparison Tab displays the base time and the new time, as well as the time differences. The Comparison tab lets you compare which of the two procedures or functions ran faster.


2. On the Run Summary tab, right-click the sessions, and then select Compare.

3. Examine the Time Diff which indicates improvement to code.

For more information, see:

- Code Analyst Product Design
- Using the Code Analyst

CLONING A CODE ANALYST SESSION
The Clone Collection functionality lets you clone an existing Code Analyst session using the Code Analyst Wizard. Clone lets you reset the parameters or the order of the objects in the session without creating a new session.


2. On the Run Summary tab, select the session to clone.


Rapid SQL opens the first panel of the Code Analyst Wizard.

For more information, see:
DELETING A CODE ANALYST SESSION
The Delete Collection functionality lets you delete the selected Code Analyst session.

2. On the Run Summary tab, select the session to delete.
   Code Analyst deletes the session.

For more information, see:
Code Analyst Product Design
Using the Code Analyst

STOPPING A CODE ANALYST SESSION EXECUTION
The Stop Execution kills the execution of the selected collection.

2. On the Run Summary tab, select the session to kill.
   Code Analyst kills the execution.

For more information, see:
Code Analyst Product Design
Using the Code Analyst

EXECUTING A CODE ANALYST SESSION
The Execute Collection functionality extracts the SQL text and then executes the code.

2. On the Run Summary tab, select the session to execute.
   Code analyst extracts and executes the SQL.

For more information, see:
SCHEDULING A CODE ANALYST SESSION
The Schedule Session functionality lets you schedule the session for a future run.

2. On the Run Summary tab, select the session to schedule.

Code Analyst opens the default scheduler.

For more information, see:
Scheduling
Code Analyst Product Design
Using the Code Analyst

UN SCHEDULING A CODE ANALYST SESSION
The Delete Session functionality lets you remove the session from a schedule.

2. On the Run Summary tab, select the session to unschedule.

For more information, see:
Scheduling
Code Analyst Product Design
Using the Code Analyst

REFRESHING A CODE ANALYST SESSION
The Refresh Data functionality refreshes the data.

2. On the tab, on the Code Analyst Tools toolbar, click Refresh Data.

For more information, see:
Code Analyst Product Design
SAVING RESULTS IN CODE ANALYST
The Save functionality lets you save results for later viewing or comparing.

2. On the tab, right-click the session or unit, and then select Save.
   Code Analyst opens the Save Results dialog box.

For more information, see:
Code Analyst Product Design
Using the Code Analyst

PRINTING RESULTS IN CODE ANALYST
The Print functionality lets you print results for later viewing or comparing.

2. On the tab, right-click the session or unit, and then select Print.
   Code Analyst opens the Print Results dialog box.

For more information, see:
Code Analyst Product Design
Using the Code Analyst

VIEWING RUN DETAILS IN CODE ANALYST
The Run Detail tab displays the total time for the objects being analyzed. The tab information may be enough to identify the potential bottleneck.

To open the Run Details Tab in Code Analyst, do the following:

2. On the Run Summary tab, right-click the session, and then select Run Detail.
   OR
3. On the Unit Summary tab, right-click the session, and then select Run Detail.

For more information, see:
Code Analyst Product Design
Using the Code Analyst

Viewing Unit Summary Information in Code Analyst
The Unit Summary Tab in Code Analyst displays the individual runs for a session.
To open the Unit Summary Tab in Code Analyst, do the following:
2. On the Comparison tab, right-click the session, and then select Unit Summary.
For more information, see:
Code Analyst Product Design
Using the Code Analyst

Viewing Unit Details in Code Analyst
The Unit Detail Tab displays the object code and other information related to the individual lines of code. You can identify time-consuming lines of code in the Unit Detail Tab. The Unit Detail Tab is where you troubleshoot, and then resolve the problem in the Modifying objects using editors.
To open the Unit Details tab in Code Analyst, do the following:
2. On the Unit Summary tab, right-click the session, and then select Unit Detail.
For more information, see:
Code Analyst Product Design
Using the Code Analyst

Setting View Options for the Unit Detail Tab in Code Analyst
The table below describes the options on the shortcut menu for the Unit Details Tab in Code Analyst:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dependency Details</td>
<td>Displays dependency details.</td>
</tr>
<tr>
<td>Show Only Hit Lines</td>
<td>Displays only those lines with time metrics.</td>
</tr>
<tr>
<td>Show Only Missed Lines</td>
<td>Displays only those lines without time metrics.</td>
</tr>
<tr>
<td>Show All Lines</td>
<td>Resets the view to show all lines.</td>
</tr>
</tbody>
</table>
EXTRACTING SQL TEXT IN CODE ANALYST
The Extract SQL Text functionality extracts SQL text to an ISQL window.

2. On the Unit Detail tab, right-click the session, and then select Extract SQL Text.
   Code analyst extracts the SQL text to an ISQL window.

For more information, see:
Extract
Code Analyst Product Design
Using the Code Analyst

EXECUTING SQL IN CODE ANALYST
The Execute SQL functionality extracts SQL text to an ISQL window, and then executes the code.

2. On the Unit Detail tab, right-click the session, and then select Execute SQL.
   Code analyst extracts the SQL text to an ISQL window and executes the code.

For more information, see:
Execute
Code Analyst Product Design
Using the Code Analyst
RAPID SQL ADD-ON TOOLS

Rapid SQL includes the following add-on tools:

Embarcadero SQL Debugger for IBM DB2 LUW for Linux, Unix, and Windows
Embarcadero SQL Debugger for Microsoft SQL Server
Embarcadero SQL Debugger for Oracle
Embarcadero SQL Debugger for Sybase ASE
Rapid SQL PL/SQL Profiler
Code Analyst

EMBARCADERO SQL DEBUGGER FOR IBM DB2 LUW FOR LINUX, UNIX, AND WINDOWS

Embarcadero SQL Debugger for IBM DB2 LUW for Linux, Unix, and Windows lets you locate and fix bugs in procedures and triggers for IBM DB2 LUW for Linux, Unix, and Windows version 7.2 or later. Embarcadero SQL Debugger for IBM DB2 LUW for Linux, Unix, and Windows lets you debug triggers by debugging the procedures that call them.

NOTE: Availability of this feature depends on your Rapid SQL licensing. For more information, see Licensing.

TIP: For Rapid SQL, Code Analyst is a tool to identify time-consuming lines of code. Code Analyst lets you perform detailed response time analysis on the execution of Procedures and Functions.

The table below describes the sections of this chapter:

<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Embarcadero SQL Debugger for IBM DB2 LUW for Linux, Unix, and Windows Features</td>
<td>This section describes how Embarcadero SQL Debugger for IBM DB2 LUW for Linux, Unix, and Windows lets you identify problems within your code.</td>
</tr>
<tr>
<td>Embarcadero SQL Debugger for IBM DB2 LUW for Linux, Unix, and Windows Interface</td>
<td>This section describes the Embarcadero SQL Debugger for IBM DB2 LUW for Linux, Unix, and Windows graphical interface that includes an editor window and four debug view windows.</td>
</tr>
<tr>
<td>Embarcadero SQL Debugger for IBM DB2 LUW for Linux, Unix, and Windows Functionality</td>
<td>This section describes the functionality on the Embarcadero SQL Debugger for IBM DB2 LUW for Linux, Unix, and Windows.</td>
</tr>
</tbody>
</table>
EMBARCADERO SQL DEBUGGER FOR IBM DB2 LUW FOR LINUX, UNIX, AND WINDOWS

EMBARCADERO SQL DEBUGGER FOR IBM DB2 LUW FOR LINUX, UNIX, AND WINDOWS FEATURES

The Embarcadero SQL Debugger for IBM DB2 LUW for Linux, Unix, and Windows lets you identify problems within your code. The Embarcadero SQL Debugger for IBM DB2 LUW for Linux, Unix, and Windows lets you:

• Interactively step through the flow of script execution.
• Examine the value of variables.
• Solve logical problems with your script design.

NOTE: The Debugger is available on the Rapid SQL main menu, the Procedures window, the DDL Editor and ISQL windows.

The Embarcadero SQL Debugger for IBM DB2 LUW for Linux, Unix, and Windows offers fundamental debugging features and options to fine tune debugging. The table below describes these features:

<table>
<thead>
<tr>
<th>Debugging Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step Into</td>
<td>Lets you execute each instruction step-by-step and step inside a stored object.</td>
</tr>
<tr>
<td>Step Out</td>
<td>Lets you stop stepping through the current object and execute the remainder of the script. This option is only active when the pointer indicates a child dependent instruction.</td>
</tr>
<tr>
<td>Step Over</td>
<td>Lets you execute the current instruction without stepping into any child dependents.</td>
</tr>
<tr>
<td>Breakpoints</td>
<td>Lets you specify positions in a program where the debugger stops execution.</td>
</tr>
</tbody>
</table>

To set specific Debugger values on Rapid SQL’s Options Editor, see Debugger Options.

EMBARCADERO SQL DEBUGGER FOR IBM DB2 LUW FOR LINUX, UNIX, AND WINDOWS REQUIREMENTS

Embarcadero SQL Debugger for IBM DB2 LUW for Linux, Unix, and Windows requires proper configuration of the server and client.

For more information, see:
Prerequisites for Adding and Compiling Procedures
Configuring the IBM DB2 LUW for Linux, Unix, and Windows Server for Procedures
Prerequisites for Debugging Procedures

Prerequisites for Adding and Compiling Stored Procedures
The Embarcadero SQL Debugger for IBM DB2 LUW for Linux, Unix, and Windows requires the following products and components.

Client
- IBM DB2 LUW for Linux, Unix, and Windows 7.2 or later
- DB2 Application Development Client
- DB2 Administration Client
- Communications Protocols
- Stored Procedure Builder
- Applications Development Interfaces
- System Bind Files
- DB2 Connect Server Support
- Documentation
- Base DB2 LUW for Windows/Unix Support
- Administration and Configuration Tools

Server
- IBM DB2 LUW for Linux, Unix, and Windows 7.2 or later
- DB2 Enterprise Edition
- Communications Protocols
- Stored Procedure Builder
- Applications Development Interfaces
- System Bind Files
- DB2 Connect Server Support
- Documentation
- Base DB2 LUW for Windows/Unix Support
- Administration and Configuration Tools
• Microsoft Visual Studio, Visual C++
  
  **NOTE:** The server must have a local directory structure and file C:\program files\sqlib\function\routine\sr_cpath.bat. This file is installed with IBM DB2 LUW 7.2 and includes the C compiler options needed to compile the procedure on the server. If it is not found, install the IBM DB2 LUW 7.2 Administration and Configuration Tools option on the server.

**CONFIGURING THE IBM DB2 LUW FOR LINUX, UNIX, AND WINDOWS SERVER FOR PROCEDURES**

Rapid SQL lets you create procedures on the targeted server using Rapid SQL.

To create or run any procedure, set up the configuration environment and enable the C compiler options on the server.

To configure your server, do the following:

1. Open a DB2 Command Window, and then type:

   ```
   DB2set DB2_SQLROUTINE_COMPILER_PATH="C:\program files\sqlib\function\routine\sr_cpath.bat"
   ```

   DB2 sets the DB2_SQLROUTINE_COMPILER_PATH DB2 registry variable to call the required initialization script for the C compiler on the server.

To enable the C compiler options on your server:

1. Open the file C:\program files\sqlib\function\routine\sr_cpath.bat.
2. Remove the REM (remarks) prefix on the lines that match the version of Visual Studio that is installed on the server. VCV6 = version 6.0 and VCV5 = version 5.0.
   
   **NOTE:** Only remove the REM prefix on the lines that apply to your installation of Visual Studio
3. Restart the DB2 services on the server.

**PREREQUISITES FOR DEBUGGING PROCEDURES**

To enable debugging on the server, do the following:

1. Open a DB2 Command window and type:

   ```
   Db2set DB2ROUTINE_DEBUG=ON
   ```

   **NOTE:** Client must have a licensed or evaluation copy of the Embarcadero LUW SQL Debugger.

**EMBARCADERO SQL DEBUGGER FOR IBM DB2 LUW FOR LINUX, UNIX, AND WINDOWS OPTIONS**

You can specify debugger options from the Debug Tab of Rapid SQL’s Options editor. The Debug Tab of the Options Editor lets you set the duration of your debug initialization and debug session, enable DBMS output, and refresh dependencies.
Setting Debugger Options
To set debugger options, do the following:

1. On the File menu, click Options.

   OR

   On the Main toolbar, click Options.

   Rapid SQL opens the Options Editor.

2. Specify debugger options. The table below describes the options available:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Initialization Timeout (seconds)</td>
<td>Specifies the number of seconds Rapid SQL tries to initialize the debugger. If it cannot initialize the debugger in the specified time, a message displays in the Debug Output window.</td>
<td>60</td>
</tr>
<tr>
<td>Debug Session Timeout (seconds)</td>
<td>Specifies, in seconds, the length of your debug session.</td>
<td>7200</td>
</tr>
<tr>
<td>Enable DBMS Output</td>
<td>Toggles the print output. Enable this option if you use dbms_output.put_line calls in your procedures and you want these lines displayed.</td>
<td>Selected</td>
</tr>
<tr>
<td>Refresh Dependencies for each run</td>
<td>Refreshes dependencies for each run. This potentially time-consuming process is useful if the target procedure has rapidly varying dependencies that can require updating during the debugging process.</td>
<td>Cleared</td>
</tr>
</tbody>
</table>

3. Click Close.

   Rapid SQL closes the Options Editor.

For more information, see *Embarcadero SQL Debugger for IBM DB2 LUW for Linux, Unix, and Windows Features*.

**EMBARCADERO SQL DEBUGGER FOR IBM DB2 LUW FOR LINUX, UNIX, AND WINDOWS INTERFACE**

The Embarcadero SQL Debugger for IBM DB2 LUW for Linux, Unix, and Windows includes an editor window and four debug view windows. When you open a debug session, Rapid SQL extracts the code for the object into a DDL Editor and opens four debug view windows at the bottom of the screen. The four debug view windows are optional, dockable windows designed to let you debug your script.

**TIP:** All Embarcadero debuggers display Performance Metrics that let you measure the execution time of each statement in the debug session.
The Embarcadero SQL Debugger for IBM DB2 LUW for Linux, Unix, and Windows includes five windows:

1. **DDL Editor window**
2. **Watch window**
3. **Variables window**
4. **Call Stack window**
5. **Dependency Tree window**

### Working with T-SQL Debugger Windows

Rapid SQL lets you resize, move, dock and float the following windows:

- **Watch window**
- **Variables window**
- **Call Stack window**
- **Dependency Tree window**

1. To resize the target window, click its frame and drag it.
   
   Rapid SQL resizes the window.

2. To move and dock the target window, click its grab bar and drag it.
   
   Rapid SQL moves the window to its new location and docks it with surrounding windows.

3. To float the target window, press Shift, then click its grab bar and drag it.
   
   Rapid SQL frames the window in its own floating frame and moves the window to its new location.

### DDL Editor Window for Embarcadero SQL Debugger for IBM DB2 LUW for Linux, Unix, and Windows

The DDL Editor displays your code in read-only format. When you start debugging, the SQL Embarcadero SQL Debugger for IBM DB2 LUW for Linux, Unix, and Windows extracts your code into a DDL Editor. The DDL Editor uses the default Rapid SQL syntax coloring.

For more information, see [Embarcadero SQL Debugger for IBM DB2 LUW for Linux, Unix, and Windows Interface](#).

### Watch Window for Embarcadero SQL Debugger for IBM DB2 LUW for Linux, Unix, and Windows
The Watch window displays the watch variables for the database object you are debugging. The Watch window also lets you specify variables you want to evaluate or modify while debugging your program.

For example, to check what happens when a variable (x) has a value of 100, you can double-click the variable in the DDL Editor, drag it into the Watch Window, and change the value to 100. When you execute the script, the Debugger uses the value $x = 100$. This window is only visible when the T-SQL Debugger is active.

**NOTE:** Until you step at least once into a script, variables are not defined. Therefore, step at least once before dragging or typing a local variable in the Watch Window.

**NOTE:** When you exit a debug session and reenter it, the Embarcadero SQL Debugger for IBM DB2 LUW for Linux, Unix, and Windows retains any watch variables or breakpoints you have set.

### Opening and Closing the Watch Window

To open and close the Watch Window, do the following:

1. On the **Debug Menu**, on the **Debug Views sub-menu**, select or clear **Watch**.

   OR

2. Press ALT+3.

### Setting a Watch Variable

To set a Watch Variable, do the following:

1. In the **DDL Editor**, double-click the target variable and drag it to the **Watch window**.

2. In the **Watch window**, change the value of the variable.

3. On the **DDL Editor**, click **Debug**.

   The Embarcadero SQL Debugger for IBM DB2 LUW for Linux, Unix, and Windows executes the script using the new variable.

### Removing a Watch Variable

To remove a Watch variable, do the following:

1. In the **Watch window**, click the target variable and press **DELETE**.

For more information, see [Embarcadero SQL Debugger for IBM DB2 LUW for Linux, Unix, and Windows Interface](#).
LINUX, UNIX, AND WINDOWS
The Variables window displays the local variables and their current values during script execution.

NOTE: You cannot edit the variables in the Variables window.

If the DDL Editor displays an external database object, and that object is a dependent of the object you are debugging, then the Variables Window automatically refreshes and displays the variables for that particular object. The Variables Window is only visible when the Debugger is active.

The Embarcadero SQL Debugger for IBM DB2 LUW for Linux, Unix, and Windows also lets you monitor your variables while debugging.

Opening and Closing the Variables Window
To open and close the Variables Window, do the following:
1. On the Debug Menu, on the Debug Views sub-menu, select or clear Variable.
   OR
   Press ALT+4.

Monitoring Variables
To monitor the values of your variables while debugging, do the following:
1. In the SQL Editor, hold the pointer over the target variable.
   Rapid SQL opens a ScreenTip displaying the current value of that variable.

For more information, see Embarcadero SQL Debugger for IBM DB2 LUW for Linux, Unix, and Windows Interface.

CALL STACK WINDOW FOR EMBARCADERO SQL DEBUGGER FOR IBM DB2 LUW FOR LINUX, UNIX, AND WINDOWS
The Call Stack window displays the stack of currently active calls. The Call Stack Window is only visible when the Debugger is active.

Opening and Closing the Call Stack Window
To open and close the Call Stack Window, do the following:
1. On the Debug Menu, on the Debug Views sub-menu, select or clear Call Stack.
   OR
   Press ALT+5.
Using the Call Stack Window
To display a line of code that references the call in the DDL Editor, do the following:

1. In the Call Stack window, double-click the target line.

   In the DDL Editor, Rapid SQL displays a green arrow on the line of the referenced call.

For more information, see Embarcadero SQL Debugger for IBM DB2 LUW for Linux, Unix, and Windows Interface.

Dependency Tree Window for Embarcadero SQL Debugger for IBM DB2 LUW for Linux, Unix, and Windows
The Dependency Tree window displays any external database objects the script accesses. Rapid SQL displays these database objects in a hierarchical tree, with the child objects as database objects accessed by the parent objects. You can use this window to display the code for a dependent database object in the DDL Editor window. This window is only visible when the Debugger is active.

Opening and Closing the Dependency Tree Window
To open and close the Dependency Tree Window, do the following:

1. On the Debug Menu, on the Debug Views sub-menu, select or clear Dependencies.
   OR
   Press ALT+6.

Displaying Dependencies
To display the code for a dependent database object in the DDL Editor window, do the following:

1. In the Dependency Tree window, double-click the target object.

   Rapid SQL displays the SQL of the target object in the DDL Editor window.

For more information, see Embarcadero SQL Debugger for IBM DB2 LUW for Linux, Unix, and Windows Interface.

Embarcadero SQL Debugger for IBM DB2 LUW for Linux, Unix, and Windows Functionality
The Embarcadero SQL Debugger for IBM DB2 LUW for Linux, Unix, and Windows offers the following functionality:

- Input Parameters
- Step Into
- Step Out
- Step Over
- Run to Cursor
- Insert or Remove a Breakpoint
- Toggle Breakpoint
- Go
- Stop
- Restart
- Break
- Close

To use these functionalities, first open a debugging session.

**Input Parameters for EmbraCadero SQL Debugger for IBM DB2 LUW for Linux, Unix, and Windows**

Input parameters are set when you first create an object. If the object you want to debug requires input parameters, Rapid SQL opens a Procedure Execution dialog box and prompts you for the input parameters when you open a debugging session.

The Procedure Execution dialog box also lets you:

- Save input parameters as *.prm files to preserve specific input parameter configurations.
- Open *.prm files to save the effort of reentering specific input parameters.
- Reset parameters to their default setting.

The table below describes the options and functionality on Procedure Execution dialog box:

<table>
<thead>
<tr>
<th>Dialog box component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Owner drop-down list</td>
<td>Displays the current procedure’s owner</td>
</tr>
<tr>
<td>Procedure drop-down list</td>
<td>Displays the name of the current procedure.</td>
</tr>
<tr>
<td>Parameter window</td>
<td>Specify the required input parameters in this window. If input parameters</td>
</tr>
<tr>
<td></td>
<td>are not required for the execution of the target procedure, a message appears</td>
</tr>
<tr>
<td></td>
<td>in this window, stating that the procedure “has no input parameters. Press</td>
</tr>
<tr>
<td></td>
<td>execute to run it.”</td>
</tr>
<tr>
<td>Open button</td>
<td>Click to open an Open dialog box, from which you can open an existing *.prm</td>
</tr>
<tr>
<td></td>
<td>file. The saved parameters immediately populate the dialog box upon opening.</td>
</tr>
</tbody>
</table>
NOTE: You cannot debug a script that requires input parameters until you provide input parameters.

For more information, see Embarcadero SQL Debugger for IBM DB2 LUW for Linux, Unix, and Windows Functionality.

**STEP INTO FOR EMBARCADERO SQL DEBUGGER FOR IBM DB2 LUW FOR LINUX, UNIX, AND WINDOWS**

After you open a debugging session, Step Into lets you execute the current instruction. If the current instruction makes a call to a stored SQL object, the Embarcadero SQL Debugger for IBM DB2 LUW for Linux, Unix, and Windows steps inside the nested child object.
To use the Step Into facility, do the following:

1. On the Debug menu, click Step Into.
   OR
   On the DDL Editor toolbar, click Step Into.
   OR
   In the DDL Editor window, right-click, and then click Step Into.
   OR
   Press F11.

   The Embarcadero SQL Debugger for IBM DB2 LUW for Linux, Unix, and Windows moves the arrow to execute the current instruction.

For more information, see Embarcadero SQL Debugger for IBM DB2 LUW for Linux, Unix, and Windows Functionality.

**STEP OUT FOR EMBARCADERO SQL DEBUGGER FOR IBM DB2 LUW FOR LINUX, UNIX, AND WINDOWS**

After you open a debugging session, Step Out lets you execute the remainder of the dependent child object and resumes line-by-line, step-debugging in the parent object.

**NOTE:** Step Out is only active when the pointer indicates a child dependent instruction.

To use the Step Out facility, do the following:

1. On the Debug menu, click Step Out.
   OR
   On the DDL Editor toolbar, click Step Out.
   OR
   In the DDL Editor window, right-click, and then click Step Out.
   OR
   Press SHIFT+F11.

   The Embarcadero SQL Debugger for IBM DB2 LUW for Linux, Unix, and Windows stops stepping through the current object and executes the remainder of the script.

For more information, see Embarcadero SQL Debugger for IBM DB2 LUW for Linux, Unix, and Windows Functionality.

**STEP OVER FOR EMBARCADERO SQL DEBUGGER FOR IBM DB2 LUW FOR LINUX, UNIX, AND WINDOWS**
UNIX, AND WINDOWS

After you open a debugging session, Step Over lets you execute the current instruction without stepping into a nested child object if the instruction makes a call to a dependent object.

To use the Step Over, do the following:

1. On the Debug menu, click Step Over.
   OR
   On the DDL Editor toolbar, click Step Over.
   OR
   In the DDL Editor window, right-click, and then click Step Over.
   OR
   Press F10.

   The Embarcadero SQL Debugger for IBM DB2 LUW for Linux, Unix, and Windows executes the current instruction.

For more information, see Embarcadero SQL Debugger for IBM DB2 LUW for Linux, Unix, and Windows Functionality.

RUN TO CURSOR FOR EMBARCADERO SQL DEBUGGER FOR IBM DB2 LUW FOR LINUX, UNIX, AND WINDOWS

After you open a debugging session, Run to Cursor lets you execute all instructions between the yellow arrow and the cursor.

To use the Run to Cursor facility, do the following:

1. Scroll down from the yellow arrow to the target line.
2. Click the target line.

   Embarcadero SQL Debugger for IBM DB2 LUW for Linux, Unix, and Windows places the cursor on the target line.

3. On the Debug menu, click Run to Cursor.
   OR
   On the DDL Editor toolbar, click Run to Cursor.
   OR
   In the DDL Editor window, right-click, and then click Run to Cursor.
   OR
   Press CTRL+F10.

   The Embarcadero SQL Debugger for IBM DB2 LUW for Linux, Unix, and Windows executes all instructions between the pointer and the cursor.
For more information, see Embarcadero SQL Debugger for IBM DB2 LUW for Linux, Unix, and Windows Functionality.

**INSERT OR REMOVE BREAKPOINT FOR EMBARCADERO SQL DEBUGGER FOR IBM DB2 LUW FOR LINUX, UNIX, AND WINDOWS**

A breakpoint is a position in a program where a debugger stops execution. When you start debugging, Embarcadero SQL Debugger for IBM DB2 LUW for Linux, Unix, and Windows opens the script in a DDL Editor. A yellow arrow pointer indicates which line the Embarcadero SQL Debugger for IBM DB2 LUW for Linux, Unix, and Windows executes next.

The Embarcadero SQL Debugger for IBM DB2 LUW for Linux, Unix, and Windows executes all lines of code between the yellow arrow and the first breakpoint. If no breakpoints are present, Embarcadero SQL Debugger for IBM DB2 LUW for Linux, Unix, and Windows debugs the entire script.

While debugging you can set one or more breakpoints in the currently executing object or in any object in the program call stack. You can toggle, temporarily disable or enable breakpoints without having to add or remove breakpoints.

Rapid SQL’s Embarcadero SQL Debugger for IBM DB2 LUW for Linux, Unix, and Windows displays each enabled breakpoint as a red dot in the left margin of the DDL Editor Window, and each disabled breakpoint as a red circle.

Rapid SQL stores all breakpoints you set so that when you debug the same script on separate occasions, you can reuse the same breakpoints. After you open a debugging session, you can insert a breakpoint on the line where your cursor is located, and you can remove a breakpoint on the line where your cursor is located.

**NOTE:** Script execution stops at the first breakpoint.

To insert and remove breakpoints, do the following:

1. In the DDL Editor window, click the target line of SQL.
2. On the Debug menu, click Breakpoint.
   - OR
   - On the DDL Editor toolbar, click Breakpoint.
   - OR
   - In the DDL Editor window, right-click, and then click Breakpoint.
   - OR
   - Press F9.

   The Embarcadero SQL Debugger for IBM DB2 LUW for Linux, Unix, and Windows inserts a new breakpoint or removes an existing breakpoint on the target line of code.

For more information, see Embarcadero SQL Debugger for IBM DB2 LUW for Linux, Unix, and Windows Functionality.
TOGGLE BREAKPOINT FOR EMBARCADERO SQL DEBUGGER FOR IBM DB2 LUW FOR LINUX, UNIX, AND WINDOWS

After you open a debugging session and insert a breakpoint, Toggle Breakpoint lets you enable or disable that breakpoint. Embarcadero SQL Debugger for IBM DB2 LUW for Linux, Unix, and Windows displays each enabled breakpoint as a red dot in the left margin of the DDL Editor Window, and each disabled breakpoint as a red circle.

You can toggle any breakpoint in the DDL Editor window. When you exit a debugging session and reenter it, the Embarcadero SQL Debugger for IBM DB2 LUW for Linux, Unix, and Windows retains any breakpoints you set.

To use the Toggle Breakpoint facility, do the following:

1. In the DDL Editor window, click the line of the target breakpoint.
   OR
   On the DDL Editor toolbar, click Enable/Disable Breakpoint.
   OR
   In the DDL Editor window, right-click, and then click Enable/Disable Breakpoint.
   OR
   Press CTRL+F9.

   The Embarcadero SQL Debugger for IBM DB2 LUW for Linux, Unix, and Windows toggles the breakpoint indicated by the pointer.

For more information, see Embarcadero SQL Debugger for IBM DB2 LUW for Linux, Unix, and Windows Functionality.

GO FOR EMBARCADERO SQL DEBUGGER FOR IBM DB2 LUW FOR LINUX, UNIX, AND WINDOWS

After you open a debugging session, Go lets you execute all instructions stopping only when it encounters a breakpoint or when the program is complete.
To use the Go facility, do the following:

1. On the Debug menu, click Go.
   OR
   On the DDL Editor toolbar, click Go.
   OR
   In the DDL Editor window, right-click, and then click Go.
   OR
   Press F5.

   The Embarcadero SQL Debugger for IBM DB2 LUW for Linux, Unix, and Windows executes all instructions.

For more information, see Embarcadero SQL Debugger for IBM DB2 LUW for Linux, Unix, and Windows Functionality.

STOP FOR EMBARCADERO SQL DEBUGGER FOR IBM DB2 LUW FOR LINUX, UNIX, AND WINDOWS

After you open a debugging session, Stop lets you halt the script execution and terminate the session.

To use the Stop facility, do the following:

1. On the Debug menu, click Stop Debugging.
   OR
   On the DDL Editor toolbar, click Stop Debugging.
   OR
   In the DDL Editor window, right-click, and then click Stop Debugging.
   OR
   Press SHIFT+F5.

   The Embarcadero SQL Debugger for IBM DB2 LUW for Linux, Unix, and Windows stops the script execution and terminates the session.

For more information, see Embarcadero SQL Debugger for IBM DB2 LUW for Linux, Unix, and Windows Functionality.

RESTART FOR EMBARCADERO SQL DEBUGGER FOR IBM DB2 LUW FOR LINUX,
UNIX, AND WINDOWS
After you open a debugging session, Restart lets you terminate the current debug session and open a new one. When the new session opens, Rapid SQL prompts you for new input parameters.

To use the Restart facility, do the following:
1. On the Debug menu, click Restart.
   OR
   On the DDL Editor toolbar, click Restart.
   OR
   In the DDL Editor window, right-click, and then click Restart.
   OR
   Press CTRL+SHIFT+F5.
   The Embarcadero SQL Debugger for IBM DB2 LUW for Linux, Unix, and Windows restarts the debug session.

For more information, see Embarcadero SQL Debugger for IBM DB2 LUW for Linux, Unix, and Windows Functionality.

BREAK FOR EMBARCADERO SQL DEBUGGER FOR IBM DB2 LUW FOR LINUX, UNIX, AND WINDOWS
After you open a debugging session, Break lets you pause the debug session.

To use the Break facility, do the following:
1. On the Debug menu, click Break.
   OR
   On the DDL Editor toolbar, click Break.
   OR
   In the DDL Editor window, right-click, and then click Break.
   The Embarcadero SQL Debugger for IBM DB2 LUW for Linux, Unix, and Windows suspends the debug session.

For more information, see Embarcadero SQL Debugger for IBM DB2 LUW for Linux, Unix, and Windows Functionality.

CLOSE FOR EMBARCADERO SQL DEBUGGER FOR IBM DB2 LUW FOR LINUX, UNIX,
AND WINDOWS
After you open a debugging session, Close lets you close the DDL Editor and the Embarcadero SQL Debugger for IBM DB2 LUW for Linux, Unix, and Windows.

To use the Close facility, do the following:

1. On the DDL Editor toolbar, click Close.
   
   OR
   
   In the upper right corner of the window, click Close.

   OR
   
   In the DDL Editor window, right-click, and then click Close.

   The Embarcadero SQL Debugger for IBM DB2 LUW for Linux, Unix, and Windows closes the debug session.

For more information, see Embarcadero SQL Debugger for IBM DB2 LUW for Linux, Unix, and Windows Functionality.

USING THE EMBARCADERO SQL DEBUGGER FOR IBM DB2 LUW FOR LINUX, UNIX, AND WINDOWS
This section offers a general overview of how to use Embarcadero SQL Debugger for IBM DB2 LUW for Linux, Unix, and Windows’s full range of debugging functionality. After you open a debugging session for any procedure or trigger, you can begin debugging.

OPENING A DEBUGGING SESSION IN IBM DB2 LUW FOR LINUX, UNIX, AND WINDOWS
When you open a debugging session, Rapid SQL opens the five windows of the Embarcadero SQL Debugger for IBM DB2 LUW for Linux, Unix, and Windows interface. If the target script requires input parameters, Rapid SQL opens a Procedure Execution dialog box and prompts you for the necessary input parameters before displaying the target code in the SQL Editor window. When Rapid SQL displays the target script in the SQL Editor window, you can begin debugging.

NOTE: Embarcadero SQL Debugger for IBM DB2 LUW for Linux, Unix, and Windows only lets you debug the SQL script of procedures or triggers.

To debug triggers by debugging the procedures that call them, do the following:

1. On the Explorer Tab, click the node of the target trigger or procedure. The node expands and displays the Code object.

2. Double-click Code. The DDL Editor opens and displays the code of the target object.
3 On the Debug menu, click Start Debugging.
   OR
   On the SQL Editor toolbar, click Debug.
   OR
   In the DDL Editor window, right-click, and then click Debug.
   OR
   Press CTRL+F5.

4 On the toolbar, click Debug.
   OR
   In the DDL Editor window, right-click, and then click Debug.

   If the script requests input parameters, Rapid SQL opens a Procedure Execution dialog box.
   If the script does not require input parameters, Rapid SQL displays the script in the DDL Editor window for you to begin debugging.

   NOTE: You cannot use the Embarcadero SQL Debugger for IBM DB2 LUW for Linux, Unix, and Windows until it has fully initialized.

5 In the Procedure Execution dialog box, specify the appropriate parameters, and then click Continue.

   Rapid SQL displays the script in the DDL Editor window for you to begin debugging.

DEBUGGING AN SQL SCRIPT WITH EMBARCADERO SQL DEBUGGER FOR IBM DB2 LUW FOR LINUX, UNIX, AND WINDOWS

After you open a debugging session and enter any required input parameters, you can begin working with your script in the Embarcadero SQL Debugger for IBM DB2 LUW for Linux, Unix, and Windows.

Debugging an SQL Script

To debug a SQL Script, do the following:

1 On the Debug menu, click one of the T-SQL Debugger options (Step Into, Step Over, and so forth) or click Go.
   OR
   On the DDL Editor toolbar, click one of the T-SQL Debugger options (Step Into, Step Over, and so on) or click Go.

   NOTE: You can monitor the progress of your debug session in the Variables window.
2 On the Debug menu, click Breakpoint.

OR

On the DDL Editor toolbar, click Breakpoint.

OR

Press F9.

NOTE: When you set a breakpoint, the Call Stack window shows what was called before the breakpoint.

NOTE: You can use the Run to Cursor option to test the lines of code between a breakpoint and your cursor (indicated by the yellow arrow in the DDL Editor).

3 To check your variables:

1) In the DDL Editor, click a variable in your script and drag it to the Watch window.

2) In the Watch window, change the value of the watch variable, and then click Go to run your script and see the results of the new value.

4 To check a record in stored objects:

1) Drag the record to the Watch window.

2) In the Watch window, change the value of the record, then click Go to run your script and see the results of the new value.

5 To check the dependencies:

1) In the Dependency Tree window double-click the target dependent object to extract the code into a new DDL Editor.

2) Step through the script while monitoring the Dependency Tree window.

6 When you finish debugging the script, click Close.

Rapid SQL closes the T-SQL Debugger DDL Editor.

NOTE: When you exit a debug session and reenter it, the Embarcadero SQL Debugger for MSSQL retains any watch variables or breakpoints you have set.

Embarcadero SQL Debugger for Microsoft is a programming tool that helps you locate and fix bugs in Microsoft SQL Server procedures and triggers for Microsoft SQL Server version 7.0 or later.

NOTE: Availability of this feature depends on your Rapid SQL licensing. For more information, see Licensing.

Objects
You can use Embarcadero SQL Debugger for Microsoft to debug the following objects:
• Procedures
• Triggers

You can only debug triggers by debugging the procedures that call them.

**TIP:** The ‘[Code Analyst](#)’ is a tool to identify time-consuming lines of code. Code Analyst lets you perform detailed response time analysis on the execution of Procedures and Functions.

The table below describes the sections of this chapter:

<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Embarcadero SQL Debugger for Microsoft Features</strong></td>
<td>This section describes how Embarcadero SQL Debugger for Microsoft helps you identify problems within your code.</td>
</tr>
<tr>
<td><strong>Embarcadero SQL Debugger for Microsoft Interface</strong></td>
<td>This section describes the Embarcadero SQL Debugger for Microsoft graphical interface that includes an editor window and four debug view windows.</td>
</tr>
<tr>
<td><strong>Embarcadero SQL Debugger for Microsoft Functionality</strong></td>
<td>This section describes the way in which Embarcadero SQL Debugger for Microsoft functions.</td>
</tr>
<tr>
<td><strong>Using the Embarcadero SQL Debugger for Microsoft</strong></td>
<td>This section describes how to run a debug session.</td>
</tr>
</tbody>
</table>

**EMBARCADERO SQL DEBUGGER FOR MICROSOFT FEATURES**

The Embarcadero SQL Debugger for Microsoft helps you identify problems within your code. The Embarcadero SQL Debugger for Microsoft lets you:

• Interactively step through the flow of script execution.
• Examine the value of variables.
• Solve logical problems with your script design.

The Embarcadero SQL Debugger for Microsoft offers fundamental debugging features and several options to help fine tune debugging, as listed in the table below:

<table>
<thead>
<tr>
<th>Debugging Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Step Into</strong></td>
<td>Lets you execute each instruction step-by-step and step inside a stored object.</td>
</tr>
<tr>
<td><strong>Step Out</strong></td>
<td>Lets you stop stepping through the current object and execute the remainder of the script. This option is only active when the pointer indicates a child dependent instruction.</td>
</tr>
<tr>
<td><strong>Step Over</strong></td>
<td>Lets you execute the current instruction without stepping into any child dependents.</td>
</tr>
<tr>
<td>Debugging Feature</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Breakpoints</td>
<td>A position in a program where the debugger stops execution.</td>
</tr>
</tbody>
</table>

To set specific Debugger values on Rapid SQL’s Options Editor, see [Debugger Options](#).

**EMBARCADERO SQL DEBUGGER FOR MICROSOFT REQUIREMENTS**

To use the Embarcadero SQL Debugger for Microsoft, you must properly configure the server and client. For more information, see:

- [Server Requirements](#)
- [Client Requirements](#)

**SERVER REQUIREMENTS**

To use the Embarcadero SQL Debugger for Microsoft you must be running Windows 2000 or Windows NT 4.0 or later, and your Microsoft SQL Server version must be 7.0 or later.

**Setting Up the Server**

There are three parts to setting up the server:

- [Installing the Microsoft SQL Debugger Interface subcomponent](#)
- [Configuring the Service](#)
- [Configuring DCOM on the server](#)

**Enabling SQL Debugger for Microsoft on SQL Server SP3**

SQL Debugging is disabled by default in SQL Server SP3 and greater. Please refer to [Microsoft Support](#) for information regarding enabling the SQL Debugger for Microsoft on SQL Server SP3.

**INSTALLING THE MICROSOFT SQL DEBUGGER INTERFACE SUBCOMPONENT**

The Microsoft server must have the Development Tools, Debugger Interface subcomponent of Microsoft SQL Server 7.0. To determine if the Debugger Interface subcomponent is installed, locate the following files in the `\Program Files\Common Files\Microsoft Shared\SQL Debugging` directory:

- SQLDBREG.exe
- SQLDBG.dll

If these files are not in the `\Program Files\Common Files\Microsoft Shared\SQL Debugging` directory, you must install them before running the Embarcadero SQL Debugger for Microsoft.
Installing the Microsoft SQL Debugger Interface on the Server
To install the Debugger Interface subcomponent on the server after the initial installation, do the following:

   OR
   Start Microsoft SQL Server 7.0 Setup.

2. Select Custom Install.

   Microsoft SQL Server opens the Select Components dialog box:

3. In the Components box, select the Development Tools check box.

4. In the Sub-components box, select the Debugger Interface check box.

5. Click Next.

   Microsoft SQL Server proceeds through the Microsoft SQL Server wizard to install the components.

Configuring the Service
Configuring the service is an operating-system-dependent operation. See the instructions below for your server operating system.

- Windows 2000
- Windows NT 4.0

Windows 2000

1. On the Windows taskbar, click the Start button, click Settings, and then click Control Panel.

2. Double-click Administrative Tools, and then click Services.

   Windows opens the Services explorer.

3. In the right pane of the Services explorer, right click MSSQLServer, and then click Properties.

   Windows opens the Net Logon Properties dialog box.

4. Click the Logon Tab.

5. Select the This Account option button.

6. In the This Account box, type (or browse to locate) the logon user account (including domain name, if necessary) of the person using the Embarcadero SQL Debugger for Microsoft.

   **NOTE:** This person must have admin permissions on the server.

7. In the Password and Confirm Password boxes, type the password.

8. Click Apply.
9 Click the General Tab.

10 Click Start.

Windows starts the server and applies the changes.

**Important Notes about Microsoft SQL Server 2000 Service Pack 3 (SP3)**

By default, after you install Microsoft SQL Server 2000 Service Pack 3 (SP3), you cannot use the Embarcadero SQL Debugger for Microsoft. You may receive the following error message:

“Server: Msg 514, Level 16, State 1, Procedure sp_sdidebug, Line 1 [Microsoft][ODBC SQL Server Driver][SQL Server]Unable to communicate with debugger on [SQL Server Name] (Error = 0x80070005). Debugging disabled for connection 53.”

Microsoft made this change for security reasons. To enable debugging, a member of the sysadmins server role, such as sa, must explicitly enable debugging by running the following code:

```sql
Exec sp_sdidebug 'legacy_on'
```

You must repeat this procedure whenever you restart the server.

**Windows NT 4.0**

1 On the Windows taskbar, click the Start button, select Settings and then click Control Panel.

2 Double-click Services.

   Windows opens the Services dialog box.

3 In the Service list, select MSSQLServer and then click Startup.

4 In the Log On As: box, select the This Account option button.

5 In the This Account box, type the logon user account (including domain name, if necessary) of the person using the Embarcadero SQL Debugger for Microsoft.

   **NOTE:** This person must have admin permissions on the server.

6 In the Password and Confirm Password boxes, type the password.

7 Click OK.

   Windows returns to the Services dialog box.

8 Click Start.

   Windows starts the server and applies the changes.
**Configuring DCOM on the Server**

To configure DCOM, do the following:

1. After the server restarts, on the Windows taskbar, click the Start button, and then click Run.
2. In the Open box, type dcomcnfg.exe.
3. Click OK.

   Windows opens the Distributed COM Configuration Properties dialog box.
4. Click the Default Security Tab.
5. In the Default Access Permissions box, click Edit Default.

   Windows opens the Registry Value Permissions dialog box.
6. Click Add.

   Windows opens the Add Users and Groups dialog box.
7. In the Names box, select SYSTEM, and then click Add.
8. Click the Type of Access list and then click Allow Access.
9. To let any user use the Embarcadero SQL Debugger for Microsoft, you must grant them remote access on the server. To grant remote access, you must configure their DCOM permissions on the server. In the Names box, click the target users and then click Add.

   **NOTE:** You can add individual users or groups.

10. Click the Type of Access list and then click Allow Access.
11. Click OK.
12. Restart the server to apply the changes.

**Client Requirements**

There are three categories of client requirements for the Embarcadero SQL Debugger for Microsoft:

- Operating System
- Microsoft SQL Server 7.0, Client Connectivity Component
- Microsoft SQL Server 7.0, Development Tools - Debugger Interface Subcomponent

**Operating System**

The client must be running one of the following operating systems:

- Microsoft Windows 95
- Microsoft Windows 98
Important Notes about Microsoft SQL Server 2000 Service Pack 3 (SP3)

By default, after you install Microsoft SQL Server 2000 Service Pack 3 (SP3), you cannot use the Embarcadero SQL Debugger for Microsoft. You may receive the following error message:

“Server: Msg 514, Level 16, State 1, Procedure sp_sdidebug, Line 1 [Microsoft][ODBC SQL Server Driver][SQL Server]Unable to communicate with debugger on [SQL Server Name] (Error = 0x80070005). Debugging disabled for connection 53.”

Microsoft made this change for security reasons. To enable debugging, a member of the sysadmins server role, such as sa, must explicitly enable debugging by running the following code:

```
Exec sp_sdidebug 'legacy_on'
```

You must repeat this procedure whenever you restart the server.

Client Connectivity

The client must have the Client Connectivity component of Microsoft SQL Server 7.0 or later.

Microsoft Debugger Interface

The client must have the Development Tools, Debugger Interface subcomponent of Microsoft SQL Server 7.0 or later. To determine if the Debugger Interface subcomponent is installed, locate the following files in the `\Program Files\Common Files\Microsoft Shared\SQL Debugging` directory:

- `SQLDBREG.exe`
- `SQLDBG.dll`

If these files are not in the `\Program Files\Common Files\Microsoft Shared\SQL Debugging` directory, you must install them before running the Embarcadero SQL Debugger for Microsoft.

Installing the Microsoft SQL Debugger Interface on the Client

To install the Debugger Interface subcomponent on the client:

1. Start the Microsoft SQL Server Setup program.
2. Select Custom Install.

   Microsoft SQL Server opens the Select Components dialog box.

3. In the Components box, select the Development Tools check box.
4. In the Sub-Components box, select the Debugger Interface check box.
5 Click Next.

Microsoft SQL Server proceeds through the Microsoft SQL Server Wizard to install the components.

EMBARCADERO SQL DEBUGGER FOR MICROSOFT OPTIONS
You can specify T-SQL Debugger options from the Debug Tab of Rapid SQL’s Options editor. The Debug Tab of the Options Editor lets you set the duration of your debug initialization and debug session, enable DBMS output, and refresh dependencies.

Setting Debugger Options
To set debugger options, do the following:

1 On the File menu, click Options.

OR

On the Main toolbar, click Options.

Rapid SQL opens the Options Editor.

2 Specify debugger options. The table below describes the options available:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Initialization Timeout (seconds)</td>
<td>Specifies the number of seconds Rapid SQL tries to initialize the debugger. If it cannot initialize the debugger in the specified time, a message displays in the Debug Output window.</td>
<td>60</td>
</tr>
<tr>
<td>Debug Session Timeout (seconds)</td>
<td>Specifies, in seconds, the length of your debug session.</td>
<td>7200</td>
</tr>
<tr>
<td>Enable DBMS Output</td>
<td>Toggles the print output. Enable this option if you use dbms_output.put_line calls in your procedures and you want these lines displayed.</td>
<td>Selected</td>
</tr>
<tr>
<td>Refresh Dependencies for each run</td>
<td>Refreshes dependencies for each run. This potentially time-consuming process is useful if the target procedure has rapidly varying dependencies that can require updating during the debugging process.</td>
<td>Cleared</td>
</tr>
</tbody>
</table>

3 Click Close.

Rapid SQL closes the Options Editor.
EMBARCADERO SQL DEBUGGER FOR MICROSOFT INTERFACE

The Embarcadero SQL Debugger for Microsoft has a graphical interface that includes an editor window and four debug view windows. When you open a debug session, Rapid SQL extracts the code for the object into a DDL Editor and opens four debug view windows at the bottom of the screen. The four debug view windows are optional, dockable windows designed to help you debug your script.

**TIP:** All Embarcadero debuggers display Performance Metrics that let you measure the execution time of each statement in the debug session.

Embarcadero SQL Debugger for Microsoft’s five windows are:

1. **DDL Editor window**
2. **Watch window**
3. **Variables window**
4. **Call Stack window**
5. **Dependency Tree window**

**Working with T-SQL Debugger Windows**

Rapid SQL lets you resize, move, dock and float the following T-SQL Debugger windows:

- Watch
- Variables
- Call Stack
- Dependency Tree

To work with the above windows, do the following:

1. To resize the target window, click its frame and drag it.
   - Rapid SQL resizes the window.

2. To move and dock the target window, click its grab bar and drag it.
   - Rapid SQL moves the window to its new location and docks it with surrounding windows.

3. To float the target window, press Shift, then click its grab bar and drag it.
   - Rapid SQL frames the window in its own floating frame and moves the window to its new location.
**DDL Editor Window**
The Embarcadero SQL Debugger for Microsoft provides a DDL Editor that displays your code in read-only format. When you start debugging, the SQL Embarcadero SQL Debugger for Microsoft extracts your code into a DDL Editor. The DDL Editor uses the default Rapid SQL syntax coloring.

**Watch Window**
The Rapid SQL Embarcadero SQL Debugger for Microsoft provides a watch window that displays the watch variables for the database object you are debugging and lets you specify variables you want to evaluate or modify while debugging your program. For example, to check what happens when a variable (x) has a value of 100, you can double-click the variable in the DDL Editor, drag it into the Watch Window, and change the value to 100. When you execute the script, the Debugger uses the value x = 100. This window is only visible when the T-SQL Debugger is active.

**NOTE:** Until you step at least once into a script, variables are not defined. Therefore, you must step at least once before dragging or typing a local variable in the Watch Window.

**NOTE:** When you exit a debug session and reenter it, the Embarcadero SQL Debugger for Microsoft retains any watch variables or breakpoints you have set.

**Opening and Closing the Watch Window**
To open and close the Watch Window, do the following:

1. On the Debug Menu, on the Debug Views sub-menu, select or clear Watch.

   OR

2. Press ALT+3.

**Setting a Watch Variable**
To set a Watch Variable, do the following:

1. In the DDL Editor, double-click the target variable and drag it to the Watch window.

   **NOTE:** Microsoft SQL Server requires that local variables begin with @. You must drag the @ to the Watch Window.

2. In the Watch window, change the value of the variable.

3. On the DDL Editor, click Go.

   The Embarcadero SQL Debugger for Microsoft executes the script using the new variable.
**Removing a Watch Variable**

To remove a Watch Variable, do the following:

1. In the *Watch window*, click the target variable and press *DELETE*.

**VARIABLES WINDOW**

The Embarcadero SQL Debugger for Microsoft provides a variables window that displays the local variables and their current values during script execution. You cannot edit the variables in the Variables window. If the DDL Editor displays an external database object, and that object is a dependent of the object you are debugging, then the Variables Window automatically refreshes and displays the variables for that particular object. The Variables Window is only visible when the Debugger is active.

The Embarcadero SQL Debugger for Microsoft also lets you monitor your variables while debugging.

**Opening and Closing the Variables Window**

To open and close the Variables Window, do the following:

1. On the *Debug Menu*, on the *Debug Views* sub-menu, select or clear *Variable*.

   OR

   Press ALT+4.

**Monitoring Variables**

To monitor the values of your variables while debugging, do the following:

1. In the SQL Editor, hold the pointer over the target variable.

   Rapid SQL opens a ScreenTip displaying the current value of that variable.

**CALL STACK WINDOW**

The Embarcadero SQL Debugger for Microsoft provides a call stack window that displays the stack of currently active calls. The Call Stack Window is only visible when the Debugger is active.

**Opening and Closing the Call Stack Window**

To open and close the Call Stack Window, do the following:

1. On the *Debug Menu*, on the *Debug Views* sub-menu, select or clear *Call Stack*.

   OR

   Press ALT+5.
Using the Call Stack Window
To display a line of code that references the call in the DDL Editor, do the following:

1. In the Call Stack window, double-click the target line.

In the DDL Editor, Rapid SQL displays a green arrow on the line of the referenced call.

Dependency Tree Window
The Embarcadero SQL Debugger for Microsoft provides a dependency tree window that displays any external database objects the script accesses. Rapid SQL displays these database objects in a hierarchical tree, with the child objects as database objects accessed by the parent objects. You can use this window to display the code for a dependent database object in the DDL Editor window. This window is only visible when the Debugger is active.

Opening and Closing the Dependency Tree Window
To open and close the Dependency Tree Window, do the following:

1. On the Debug Menu, on the Debug Views sub-menu, select or clear Dependencies.
   
   OR
   
   Press ALT+6.

Displaying Dependencies
To display the code for a dependent database object in the DDL Editor window, do the following:

1. In the Dependency Tree window, double-click the target object.

   Rapid SQL displays the SQL of the target object in the DDL Editor window.

Embarcadero SQL Debugger for Microsoft Functionality
The Embarcadero SQL Debugger for Microsoft offers the following functionality:

- Input Parameters
- Step Into
- Step Out
- Step Over
- Run to Cursor
- Insert or Remove a Breakpoint
- Toggle Breakpoint
To make use of the above functionality, you must first open a debugging session.

**INPUT PARAMETERS**

Input parameters are set when you first create an object. If the object you want to debug requires input parameters, Rapid SQL opens a Procedure or Trigger Execution dialog box and prompts you for the input parameters when you open a debugging session.

This dialog box also lets you:

- Save input parameters as *.prm files to preserve specific input parameter configurations.
- Open *.prm files to save the effort of reentering specific input parameters.
- Reset parameters to their default setting.

The table below describes the options and functionality on Procedure Execution dialog box:

<table>
<thead>
<tr>
<th>Dialog box component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Owner drop-down list</td>
<td>Displays the current procedure's owner</td>
</tr>
<tr>
<td>Procedure drop-down list</td>
<td>Displays the name of the current procedure.</td>
</tr>
<tr>
<td>Parameter window</td>
<td>Specify the required input parameters in this window. If input parameters are not required for the execution of the target procedure, a message appears in this window, stating that the procedure “has no input parameters. Press execute to run it.”</td>
</tr>
<tr>
<td>Open button</td>
<td>Click to open an Open dialog box, from which you can open an existing *.prm file. The saved parameters immediately populate the dialog box upon opening.</td>
</tr>
<tr>
<td>Save button</td>
<td>Click to save the values of your input parameters as a *.prm file. You can reopen a saved *.prm file from this dialog box at any time.</td>
</tr>
<tr>
<td>Reset button</td>
<td>Click to reset the parameters in the Parameter window to their default values.</td>
</tr>
<tr>
<td>Execute button</td>
<td>Click to execute the procedure once you have entered values for all required parameters in the Parameter window.</td>
</tr>
</tbody>
</table>
You cannot debug a script that requires input parameters until you provide input parameters.

**STEP INTO**

After you open a debugging session, Step Into lets you execute the current instruction. If the current instruction makes a call to a stored SQL object, the Embarcadero SQL Debugger for Microsoft steps inside the nested child object.

**Step Into**

To use the Step Into facility, do the following:

1. On the Debug menu, click Step Into.

   OR

   On the DDL Editor toolbar, click Step Into.

   OR

   In the DDL Editor window, right-click and then click Step Into.

   OR

   Press F11.

The Embarcadero SQL Debugger for Microsoft moves the arrow to execute the current instruction.
**Step Out**
After you open a debugging session, Step Out lets you execute the remainder of the dependent child object and resumes line-by-line, step-debugging in the parent object.

**NOTE:** Step Out is only active when the pointer indicates a child dependent instruction.

**Step Out**
To use the Step Out facility, do the following:

1. On the Debug menu, click Step Out.
   
   OR
   On the DDL Editor toolbar, click Step Out.
   
   OR
   In the DDL Editor window, right-click and then click Step Out.
   
   OR
   Press SHIFT+F11.

   The Embarcadero SQL Debugger for Microsoft stops stepping through the current object and executes the remainder of the script.

**Step Over**
After you open a debugging session, Step Over lets you execute the current instruction without stepping into a nested child object if the instruction makes a call to a dependent object.

**Step Over**
To use the Step Over facility, do the following:

1. On the Debug menu, click Step Over.
   
   OR
   On the DDL Editor toolbar, click Step Over.
   
   OR
   In the DDL Editor window, right-click and then click Step Over.
   
   OR
   Press F10.

   The Embarcadero SQL Debugger for Microsoft executes the current instruction.
**RUN TO CURSOR**

After you open a debugging session, Run to Cursor lets you execute all instructions between the yellow arrow and the cursor.

**Run to Cursor**

To use the Run to Cursor facility, do the following:

1. Scroll down from the yellow arrow to the target line.
2. Click the target line.

   Embarcadero SQL Debugger for Microsoft places the cursor on the target line.
3. On the Debug menu, click Run to Cursor.
   OR
   On the DDL Editor toolbar, click Run to Cursor.
   OR
   In the DDL Editor window, right-click and then click Run to Cursor.
   OR
   Press CTRL+F10.

   The Embarcadero SQL Debugger for Microsoft executes all instructions between the pointer and the cursor.

**INSERT OR REMOVE BREAKPOINT**

A breakpoint is a position in a program where a debugger stops execution. When you start debugging, Embarcadero SQL Debugger for Microsoft opens the script in a DDL Editor. A yellow arrow pointer indicates which line the Embarcadero SQL Debugger for Microsoft executes next. The Embarcadero SQL Debugger for Microsoft executes all lines of code between the yellow arrow and the first breakpoint. If no breakpoints are present, Embarcadero SQL Debugger for Microsoft debugs the entire script.

While debugging you can set one or more breakpoints in the currently executing object or in any object in the program call stack. Breakpoints can be toggled, temporarily disabled, or enabled, without having to add or remove them. Rapid SQL Embarcadero SQL Debugger for Microsoft displays each enabled breakpoint as a red dot in the left margin of the DDL Editor Window, and each disabled breakpoint as a red circle.

Rapid SQL stores all breakpoints you set so that when you debug the same script on separate occasions, you can reuse the same breakpoints. After you open a debugging session, Insert Break lets you insert a breakpoint on the line where your cursor it located, and Remove Break lets you remove a breakpoint on the line where your cursor is located.

**NOTE:** Script execution stops at the first breakpoint.
Inserting or Removing a Breakpoint
To insert or remove a breakpoint, do the following:

1. In the DDL Editor window, click the target line of SQL.
2. On the Debug menu, click Breakpoint.
   OR
   On the DDL Editor toolbar, click Breakpoint.
   OR
   In the DDL Editor window, right-click and then click Breakpoint.
   OR
   Press F9.

The Embarcadero SQL Debugger for Microsoft inserts a new breakpoint or removes an existing breakpoint on the target line of code.

TOGGLE BREAKPOINT
After you open a debugging session and insert a breakpoint, Toggle Breakpoint lets you enable or disable that breakpoint. Embarcadero SQL Debugger for Microsoft displays each enabled breakpoint as a red dot in the left margin of the DDL Editor Window, and each disabled breakpoint as a red circle. You can toggle any breakpoint in the DDL Editor window. When you exit a debugging session and reenter it, the Embarcadero SQL Debugger for Microsoft retains any breakpoints you set.

Toggling a Breakpoint
To toggle a breakpoint, do the following:

1. In the DDL Editor window, click the line of the target breakpoint.
   OR
   On the DDL Editor toolbar, click Enable/Disable Breakpoint.
   OR
   In the DDL Editor window, right-click and then click Enable/Disable Breakpoint.
   OR
   Press CTRL+F9.

The Embarcadero SQL Debugger for Microsoft toggles the breakpoint indicated by the pointer.
**GO**

After you open a debugging session, Go lets you execute all instructions stopping only when it encounters a breakpoint or when the program is complete.

To use the Go facility, do the following:

1. On the **Debug** menu, click **Go**.
   
   OR
   
   On the **DDL Editor** toolbar, click **Go**.

   OR
   
   In the **DDL Editor** window, right-click and then click **Go**.

   OR
   
   Press F5.

   The Embarcadero SQL Debugger for Microsoft executes all instructions.

**STOP**

After you open a debugging session, Stop lets you halt the script execution and terminate the session.

To stop the debugger, do the following:

1. On the **Debug** menu, click **Stop Debugging**.

   OR
   
   On the **DDL Editor** toolbar, click **Stop Debugging**.

   OR
   
   In the **DDL Editor** window, right-click and then click **Stop Debugging**.

   OR
   
   Press SHIFT+F5.

   The Embarcadero SQL Debugger for Microsoft stops the script execution and terminates the session.
**RESTART**
After you open a debugging session, Restart lets you terminate the current debug session and open a new one. When the new session opens, Rapid SQL prompts you for new input parameters.

**Restart**
To restart the debugger, do the following:

1. On the Debug menu, click Restart.
   OR
   On the DDL Editor toolbar, click Restart.
   OR
   In the DDL Editor window, right-click and then click Restart.
   OR
   Press CTRL+SHIFT+F5.

The Embarcadero SQL Debugger for Microsoft restarts the debug session.

**BREAK**
After you open a debugging session, Break lets you pause the debug session.

**Break**
To pause the debugger, do the following:

1. On the Debug menu, click Break.
   OR
   On the DDL Editor toolbar, click Break.
   OR
   In the DDL Editor window, right-click and then click Break.

The Embarcadero SQL Debugger for Microsoft suspends the debug session.

**CLOSE**
After you open a debugging session, Close lets you close the DDL Editor and the Embarcadero SQL Debugger for Microsoft.
Close
1. On the DDL Editor toolbar, click Close.
   
   OR
   
   In the upper right corner of the window, click Close.
   
   OR
   
   In the DDL Editor window, right-click and then click Close.

   The Embarcadero SQL Debugger for Microsoft closes the debug session.

Using the Embarcadero SQL Debugger for Microsoft
This section offers a general overview of how to use Embarcadero SQL Debugger for Microsoft’s full range of debugging functionality. After you open a debugging session for any procedure or trigger, you can begin debugging.

For more detailed information, see Debugging a Sample Script.

Opening a Debugging Session
When you open a debugging session, Rapid SQL opens the five windows of the Embarcadero SQL Debugger for Microsoft interface. If the target script requires input parameters, Rapid SQL opens a Procedure Execution dialog box and prompts you for the necessary input parameters before displaying the target code in the SQL Editor window. When Rapid SQL displays the target script in the SQL Editor window, you can begin debugging.

   NOTE: Rapid SQL Embarcadero SQL Debugger for Microsoft only lets you debug the SQL script of procedures or triggers.

Opening a Debugging Session
To debug a trigger or procedure, do the following:

1. On the Explorer Tab, click the node of the target procedure.

   Rapid SQL opens the node and displays two items: Code and Privileges.

2. Under the target object node, double-click Code.

   Rapid SQL opens a DDL Editor displaying the code of the target object.
3 On the Debug menu, click Start Debugging.

OR
On the SQL Editor toolbar, click Debug.

OR
In the DDL Editor window, right-click and then click Debug.

OR
Press CTRL+F5.

If the script requests input parameters, Rapid SQL opens a Procedure Execution dialog box. If the script does not require input parameters, Rapid SQL displays the script in the DDL Editor window for you to begin debugging.

NOTE: You cannot use the Embarcadero SQL Debugger for Microsoft until it has fully initialized.

4 In the Procedure Execution dialog box, specify the appropriate parameters, and then click Continue.

Rapid SQL displays the script in the DDL Editor window for you to begin debugging.

DEBUGGING AN SQL SCRIPT
After you open a debugging session and enter any required input parameters, you can begin working with your script in the Embarcadero SQL Debugger for Microsoft.

Debugging an SQL Script
To debug a SQL script, do the following:

1 On the Debug menu, click one of the Embarcadero SQL Debugger for MSSQL Server options (Step Into, Step Over, and so forth) or click Go.

OR
On the DDL Editor toolbar, click one of the Embarcadero SQL Debugger for MSSQL Server options (Step Into, Step Over, and so on) or click Go.

NOTE: You can monitor the progress of your debug session in the Variables window.
2 On the Debug menu, click Breakpoint.

OR

On the DDL Editor toolbar, click Breakpoint.

OR

Press F9.

**NOTE:** When you set a breakpoint, the Call Stack window shows what was called before the breakpoint.

**NOTE:** You can use the Run to Cursor option to test the lines of code between a breakpoint and your cursor (indicated by the yellow arrow in the DDL Editor).

3 To check your variables, do the following:

1) In the DDL Editor, click a variable in your script and drag it to the Watch window.
2) In the Watch window, change the value of the watch variable and then click Go to run your script and see the results of the new value.

4 To check a record in stored objects, do the following:

1) Drag the record to the Watch window.
2) In the Watch window, change the value of the record, then click Go to run your script and see the results of the new value.

5 To check the dependencies, do the following:

1) In the Dependency Tree window double-click the target dependent object to extract the code into a new DDL Editor.
2) Step through the script while monitoring the Dependency Tree window.

6 When you finish debugging the script, click Close.

Rapid SQL closes the T-SQL Debugger DDL Editor.

**NOTE:** When you exit a debug session and reenter it, the Embarcadero SQL Debugger for MSSQL retains any watch variables or breakpoints you have set.

---

**DEBUGGING A SAMPLE SCRIPT**

This walk-through demonstrates basic debugging functionality. During the course of this walk-through you debug two procedures using the Embarcadero SQL Debugger for Microsoft.

This section is divided into the following seven sections, each designed to familiarize you with basic debugging features and functionality:

- Getting Started
- Testing a Procedure
- Starting the Debugging Session
GETTING STARTED

This part of Debugging the Sample Script explains how to create the following two procedures to be used for debugging:

- check_modulo
- calculate_sum_with_overflow_bug

NOTE: The procedure calculate_sum_with_overflow_bug intentionally includes a bug which prevents it from executing successfully. You use the Embarcadero SQL Debugger for Microsoft to identify this bug.

Overview

The Getting Started section guides you through:

- Creating procedure 1.
- Creating procedure 2.
- Confirming the creation of the procedures.

CREATING PROCEDURE 1

Procedure 1, check_modulo, calculates the modulo of any two user-specified numbers. The user passes the numbers into the procedure as input parameters. The procedure returns the result as an output parameter. If the modulo equals zero, procedure execution returns the output “YES”. If the modulo is not zero, procedure execution returns the output “NO”. This procedure is nested in the second procedure, calculate_sum_with_overflow_bug.

To create this procedure, you must open Rapid SQL, connect to a MSSQL datasource, open a new SQL editor and, in the SQL editor, type or copy and paste the following code:

```sql
CREATE PROCEDURE username.check_modulo
  @p_dividend_in INT,
  @p_divisor_in INT,
  @result VARCHAR(3) OUTPUT
AS
IF @p_dividend_in % @p_divisor_in = 0
  SELECT @result = 'YES'
ELSE
  SELECT @result = 'NO'
go
```

NOTE: For the purposes of this walk-through, this procedure was created under the user name Spence. Before executing the DDL above, substitute your user name for the word “username”.

- Breakpoints
- Step Into
- Step Out
- Correcting the Script
Creating Procedure 1
To create Procedure 1, do the following:

1. Start Rapid SQL.
2. Connect to a Microsoft SQL Server 7.0 datasource.
3. On the Datasource menu, click the database node and then click the target database.
   
   **NOTE:** For this walk-through, we recommend that you select a non-production database.

4. On the Main toolbar, click New.
   
   OR
   On the File menu, click New, and then click SQL.
   
   OR
   Press CTRL+N.
   
   Rapid SQL opens an SQL Editor in the current workspace.

5. In the SQL Editor, type the DDL for procedure check_modulo.
   
   **NOTE:** You must substitute your user name once in the DDL for this procedure.

6. On the SQL Editor toolbar, click Execute.
   
   Rapid SQL executes the script and creates Procedure 1, then opens the SQL Editor Results Tab with the results of the script execution. If you were not able to create the procedure, check the error messages to determine the problem.

Creating Procedure 2
Procedure 2, calculate_sum_with_overflow_bug, requires two user-specified numbers as input parameters. Upon execution, the procedure calculates the sum of the all numbers divisible by five between the two user-specified numbers. This procedure calls sample procedure 1 (check_modulo) to calculate the modulo of the user-specified numbers.

**NOTE:** The procedure calculate_sum_with_overflow_bug intentionally includes a bug which prevents it from executing successfully. You use the Embarcadero SQL Debugger for Microsoft to identify this bug.

**CAUTION:** When inputting parameters, you must enter the smaller number in the @p_num1_in int box.
To create this procedure, you must open Rapid SQL, connect to a MSSQL datasource, open a new SQL editor and, in the SQL editor, type or copy and paste the following code:

```sql
CREATE PROCEDURE username.calculate_sum_with_overflow_bug
@p_num1_in  INT,
@p_num2_in  INT,
@result TINYINT OUTPUT
/*INT-Integer (whole number) data from -2^31 (-2,147,483,648)
   through 2^31 - 1 (2,147,483,647).
   TINYINT-Integer data from 0 through 255.*/
AS
DECLARE @temp INT
DECLARE @temp_1 INT
DECLARE @v_divisor INT
DECLARE @v_condition VARCHAR(3)
SET @temp = @p_num1_in
SET @temp_1 = 0
SET @v_divisor = 5
SET @v_condition = 'NO'
WHILE 1=1
BEGIN
    SELECT @temp = @temp + 1 /*Increase temp starting from p_num1*/
    IF @temp = @p_num2_in /*Check if we reached p_num2*/
        /*If yes, leave the LOOP*/
        BREAK
    /*Call Procedure 2 to check if number is divisable by 5*/
    EXEC username.check_modulo @temp,@v_divisor,@result=@v_condition output
    IF @v_condition = 'YES'
        SELECT @temp_1 = @temp_1 + @temp
END /*WHILE LOOP*/
SELECT @result = @temp_1
RETURN
GO
```

**NOTE:** For the purposes of this walk-through, this procedure was created under the user name Spence. Before executing the DDL above, substitute your user name for the word “username”.

**Creating Procedure 2**

To create Procedure 2, do the following:

1. Start Rapid SQL.
2. Connect to a Microsoft SQL Server 7.0 datasource.
3. On the Datasource menu, click the database node and then click the target database.

**NOTE:** For this walk-through, we recommend that you select a non-production database.
4 On the Main toolbar, click New.

OR

On the File menu, click New, and then click SQL.

OR

Press CTRL+N.

Rapid SQL opens an SQL Editor in the current workspace.

5 In the SQL Editor, type the DDL for procedure calculate_sum_with_overflow_bug.

   **NOTE:** You must substitute your user name twice in the DDL for this procedure.

6 On the SQL Editor toolbar, click Execute.

   Rapid SQL executes the script and creates Procedure 2, then opens the SQL Editor Results Tab with the results of the script execution. If you were not able to create the procedure, check the error messages to determine the problem.

**CONFIRMING THE CREATION OF THE PROCEDURES**

After you create **Procedure 1** and **Procedure 2**, you can confirm their creation in Rapid SQL’s Database Explorer.

**Confirming the Creation of the Procedures**

To confirm creation of the procedures, do the following:

1 On the Explorer Tab, click the Explorer list, and then click Organize By Owner.

   The Explorer Tab refreshes with the new display configuration.

2 On the Explorer Tab, double-click the Databases node, and then double-click the target database node.

   Rapid SQL displays the list of object owners.

3 Double-click your user name to display a list of your objects.

4 Double-click Procedures to display a list of procedures and confirm the creation of check_modulo and calculate_sum_with_overflow_bug.

   You are now ready to begin testing a procedure.
TESTING A PROCEDURE

After you confirm the creation of the procedures, you must execute the procedure calculate_sum_with_overflow_bug (which includes a bug) to view its error message. This procedure requires two integer input parameters: @p_num1_in int and @p_num2_in int. For all integers between these two integers, this procedure identifies those divisible by 5, and then returns their sum.

**CAUTION:** When inputting parameters, you must enter the smaller number in the @p_num1_in int box.

Testing a Procedure

To test a procedure, do the following:

1. On the Explorer Tab, right-click calculate_sum_with_overflow_bug, and then click Execute.
   Rapid SQL opens the Procedure Execution window.
2. In the Value column of the @p_num1_in row, type 1.
3. In the Value column of the @p_num2_in row, type 11.
4. Click Execute.
   Rapid SQL compiles the procedure and opens a Results Tab, displaying the sum 15. There are two numbers between 1 and 11 that are divisible by 5: 5, and 10. The sum of these two numbers is 15.
5. On the Explorer Tab, right-click calculate_sum_with_overflow_bug, and then click Execute.
   Rapid SQL again opens the Procedure Execution window.
6. In the Value column of the @p_num1_in row, type 100.
7. In the Value column of the @p_num2_in row, type 121.
8. On the Procedure Execution window toolbar, click Execute.
   Rapid SQL returns an error stating “Arithmetic overflow occurred”. You are now ready to Start the Debugging Session.

STARTING THE DEBUGGING SESSION

After you test the procedure, you must open the procedure in Embarcadero SQL Debugger for Microsoft and enter input parameters before debugging. To start a session, do the following:

1. On the Explorer Tab, right-click the procedure, calculate_sum_with_overflow_bug, and then click Debug to start the debug session.
   Rapid SQL extracts the DDL for the procedure into a DDL Editor and opens the Procedure Execution dialog box.
2. In the Value column of the @p_num1_in row, type 100.
3. In the Value column of the @p_num2_in row, type 121.

4. Click Continue.

   Rapid SQL closes the dialog box and opens the Embarcadero SQL Debugger interface, which includes the following five windows:
   
   - **DDL Editor**
   - **Watch Window**
   - **Variables Window**
   - **Call Stack Window**
   - **Dependency Tree Window**

   You are now ready to **insert breakpoints**.

**BREAKPOINTS**

After you **start the debugging session**, you must insert a breakpoint into the code of the procedure `calculate_sum_with_overflow_bug`. Then you must run to the breakpoint. After you run to the breakpoint, Embarcadero SQL Debugger displays a yellow arrow on the red breakpoint icon and populates the Variables Window with values for the following variables:

<table>
<thead>
<tr>
<th>Variable</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>@temp</td>
<td>Current number</td>
</tr>
<tr>
<td>@p_num2_in</td>
<td>Second input parameter</td>
</tr>
<tr>
<td>@p_num1_in</td>
<td>First input parameter</td>
</tr>
<tr>
<td>@temp_1</td>
<td>Sum of the numbers, between the input parameters, divisible by 5</td>
</tr>
<tr>
<td>@result</td>
<td>Condition of the output parameter</td>
</tr>
<tr>
<td>@v_condition</td>
<td>Output parameter</td>
</tr>
<tr>
<td>@v_divisor</td>
<td>Divisor</td>
</tr>
</tbody>
</table>

**Breakpoints**

To insert a breakpoint, do the following:

1. In the DDL Editor, scroll to and click the following line:

   ```sql
   EXEC username.check_modulo @temp,@v_divisor,@result=@v_condition output
   ```

   **NOTE:** This line is located near the end of the procedure’s code.
2  On the Debug menu, click Breakpoint.
   
   OR
   On the DDL Editor toolbar, click Breakpoint.
   
   OR
   In the DDL Editor window, right-click and then click Breakpoint.
   
   OR
   Press F9.
   
   Rapid SQL inserts a breakpoint (indicated by dot) next to the number of the target line.

3  On the Debug menu, click Go.
   
   OR
   On the DDL Editor toolbar, click Go.
   
   OR
   In the DDL Editor window, right-click and then click Go.
   
   OR
   Press F5.
   
   Rapid SQL Embarcadero SQL Debugger for Microsoft displays the value of the variables before the breakpoint in the Variables Window.
   
   You are now ready to Step Into the code.

**STEP INTO**

After setting the breakpoint, you must step into the dependent procedure, check_modulo. To step into the dependent procedure, do the following:

1  On the Debug menu, click Step Into.
   
   OR
   On the DDL Editor toolbar, click Step Into.
   
   OR
   In the DDL Editor window, right-click and then click Step Into.
   
   OR
   Press F11.
   
   Rapid SQL extracts the DDL for the dependent, nested procedure into the DDL Editor.
2 Step Into again.

Rapid SQL executes the next part of the code and displays the values for the variables in the Variables Window.

The Call Stack Window displays calls to the procedures.

You are now ready to Step Out of the code.

STEP OUT

After you Step Into the modulo_check (nested procedure) code, you must step back out and return to the calculate_sum_with_overflow_bug (outside procedure) code. To step back out and return, do the following:

1 On the Debug menu, click Step Out.

OR

On the DDL Editor toolbar, click Step Out.

OR

In the DDL Editor window, right-click and then click Step Out.

OR

Press SHIFT+F11.

Rapid SQL opens the DDL Editor containing the code for calculate_sum_with_overflow_bug.

2 On the Debug menu, click Go.

OR

On the DDL Editor toolbar, click Go.

OR

In the DDL Editor window, right-click and then click Go.

OR

Press F5.

When the value of the variable, @temp is equal to the value of the variable, @p_num2_in, the WHILE LOOP is complete and the Embarcadero SQL Debugger for Microsoft continues to the next executable statement in the code.

3 While monitoring the value of the variables in the Variables Window, continue to click Go to cycle through the WHILE LOOP.

After executing the SELECT and RETURN statements, Rapid SQL closes the Debugger and opens a DDL Editor to the Results Tab.

Now you are ready to correct the script.
CORRECTING THE SCRIPT
When you finished Stepping Out of the nested code and encounter the error, you must do the following to fully fix the bug:

- Locate the source of the error
- Scroll to the line in the script displaying the error
- Analyze the code
- Correct the error
- Compile the corrected script

When you first executed the procedure, Rapid SQL displayed the error message “Arithmetic overflow error for data type tinyint, value = 450”. According to Microsoft SQL Server Books Online: “This error occurs when an attempt is made to convert a float or real data type value into a data type that cannot store the result. This error prevents the operation from being completed.”

The data type used in this procedure (TINYINT) stores values from 0 to 255. The sum of the four numbers between 100 and 121 that are divisible by 5 (105, 110, 115, and 120) is 450. But because the TINYINT variable @result can only accept a maximum value of 255, Rapid SQL returns the error message and the procedure fails.

Correcting the Script
To correct the script, do the following:

1. On the Explorer Tab, right-click calculate_sum_with_overflow_bug, and then click Extract.
   Rapid SQL extracts the DDL for the procedure into a DDL Editor.
2. On the Edit toolbar, click Find.
   Rapid SQL opens the Find dialog box.
3. In the Find What box, type TINYINT.
4. Click Find Next.
   Rapid SQL selects the first occurrence of TINYINT.
5. Change the data type for @result from TINYINT to INT.
6. On the DDL Editor toolbar, click Execute to execute the modified script.
   Rapid SQL executes the script and opens the Results Tab.
7. On the Explorer Tab, right-click calculate_sum_with_overflow_bug, and then click Execute.
   Rapid SQL opens the Procedure Execution dialog box.
8. In the Value column of the @p_num1_in row, type 100.
9. In the Value column of the @p_num2_in row, type 121.
10 Click Execute.

Rapid SQL executes the procedure with the new data type and opens the Results Tab, returning the value 450. You successfully corrected the script and debugged the procedure.

EMBARCADERO SQL DEBUGGER FOR ORACLE

Embarcadero SQL Debugger for Oracle is a programming tool that lets you debug functions, procedures and triggers for Oracle versions 7.3.3 or later.

Objects
Using Embarcadero SQL Debugger for Oracle, you can debug the following objects:

- Functions
- Procedures
- Triggers

You can only debug triggers by debugging the functions or procedures that call them. You cannot debug packages, but you can debug the functions and procedures within packages.

NOTE: You cannot debug any objects contained in the Exclusion List.

NOTE: Availability of this feature depends on your Rapid SQL licensing. For more information, see Licensing.

TIP: The Code Analyst is a tool to identify time-consuming lines of code. Code Analyst lets you perform detailed response time analysis on the execution of Procedures and Functions.

The table below describes the sections of this chapter:

<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Features</td>
<td>This section describes how the Embarcadero SQL Debugger for Oracle helps you identify problems within your code.</td>
</tr>
<tr>
<td>Interface</td>
<td>This section describes the Embarcadero SQL Debugger for Oracle graphical interface that includes an editor window and four debug view windows.</td>
</tr>
<tr>
<td>Functionality</td>
<td>This section describes the functions of the Embarcadero SQL Debugger for Oracle.</td>
</tr>
<tr>
<td>Using Embarcadero Debugger for Oracle</td>
<td>This section describes how to run a debug session.</td>
</tr>
</tbody>
</table>
DEBUGGING FEATURES

Embarcadero SQL Debugger for Oracle is designed to help identify problems within your code. Embarcadero SQL Debugger for Oracle lets you:

- Interactively step through the flow of script execution.
- Examine the value of variables.
- Solve logical problems with your script design.

Embarcadero SQL Debugger for Oracle offers fundamental debugging features, an Oracle Exclusion List and several options to help fine tune debugging, as listed in the table below:

<table>
<thead>
<tr>
<th>Debugging Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Step Into</strong></td>
<td>Lets you execute each instruction step-by-step and step inside a stored object if the object is not on the Exclusion List.</td>
</tr>
<tr>
<td><strong>Step Out</strong></td>
<td>Lets you stop stepping through the current object and execute the remainder of the script. This option is only active when the pointer indicates a child-dependent instruction.</td>
</tr>
<tr>
<td><strong>Step Over</strong></td>
<td>Lets you execute the current instruction without stepping into any child dependents.</td>
</tr>
<tr>
<td><strong>Breakpoints</strong></td>
<td>A position in a program where the debugger stops execution.</td>
</tr>
</tbody>
</table>

To set specific Debugger values on the Options Editor, see Debugger Options.

EXCLUSION LIST

Upon installation, Rapid SQL sets up an Exclusion List on your computer which includes packages that the application cannot debug. The Exclusion List is located in the Rapid SQL directory, at the default installation location C:\Program Files\Embarcadero\Nov2001\Shared\deborcex. etd. You can add or remove packages from this file by editing the Exclusion List.

Editing the Exclusion List

To Edit the Exclusion List, do the following:

1. Open the Exclusion List, deborcex. etd, in a text editor, such as Notepad or WordPad.
2. To add a package, enter the name of the package at the end of the list. Use the following format: OWNER.OBJECT_NAME.

   **NOTE:** There must be a carriage return after each item on the list.
To remove a package from the Exclusion List, delete the package from the list.

**NOTE:** Embarcadero SQL Debugger for Oracle does debug a package procedure listed on the Exclusion List.

4. Save the changes to `deborcex.etd`.

**EMBARCADERO SQL DEBUGGER FOR ORACLE OPTIONS**

You can specify PL/SQL Debugger options from the Debug Tab of Rapid SQL's Options editor. The Debug Tab of the Options Editor lets you set the duration of your debug initialization and debug session, enable DBMS output, and refresh dependencies.

**Setting Debugger Options**

To set debugger options, do the following:

1. On the **File** menu, click **Options**.

   **OR**

   On the **Main** toolbar, click **Options**.

   Rapid SQL opens the Options Editor.

2. On the Debug Tab, specify debugger options. The table below describes the options available:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Initialization Timeout (seconds)</td>
<td>Specifies the number of seconds Rapid SQL tries to initialize the debugger. If it cannot initialize the debugger in the specified time, a message displays in the Debug Output window.</td>
<td>60</td>
</tr>
<tr>
<td>Debug Session Timeout (seconds)</td>
<td>Specifies, in seconds, the length of your debug session.</td>
<td>7200</td>
</tr>
<tr>
<td>Enable DBMS Output</td>
<td>Toggles the print output. Enable this option if you use <code>dbms_output.put_line</code> calls in your procedures and you want these lines displayed.</td>
<td>Selected</td>
</tr>
<tr>
<td>Refresh Dependencies for each run</td>
<td>Refreshes dependencies for each run. This potentially time-consuming process is useful if the target procedure has rapidly varying dependencies that can require updating during the debugging process.</td>
<td>Cleared</td>
</tr>
</tbody>
</table>

3. Click Close.

   Rapid SQL closes the Options Editor.
EMBARCADERO SQL DEBUGGER FOR ORACLE INTERFACE

Embarcadero SQL Debugger for Oracle has a graphical interface that includes an editor window and four debug view windows. When you open a debug session, Rapid SQL extracts the code for the object into an SQL Editor and opens four debug view windows at the bottom of the screen.

**TIP:** All Embarcadero debuggers display Performance Metrics that let you measure the execution time of each statement in the debug session.

The four debug view windows are optional, dockable, floatable windows designed to help debug your script. Embarcadero SQL Debugger for Oracle’s five windows are:

- SQL Editor window
- Watch window
- Variables window
- Call Stack window
- Dependency Tree window

Working with Embarcadero SQL Debugger Windows

Rapid SQL lets you resize, move, dock and float the following Debugger windows:

- Watch
- Variables
- Call Stack
- Dependency Tree

To work with the above windows, do the following:

1. To resize the target window, click its frame and drag it
   
   Rapid SQL resizes the window.

2. To move and dock the target window, click its grab bar and drag it.
   
   Rapid SQL moves the window to its new location and docks it with surrounding windows.

3. To float the target window, press Shift, then click its grab bar and drag it.
   
   Rapid SQL frames the window in its own floating frame and moves the window to its new location.
SQL EDITOR WINDOW
Embarcadero SQL Debugger for Oracle provides an SQL Editor window that displays your code in Read-Only format. When you start debugging, Embarcadero SQL Debugger for Oracle extracts your code into an SQL Editor window, making it editable. The SQL Editor uses the default Rapid SQL syntax coloring.

**NOTE:** Rapid SQL displays LOB datatypes, and REF CURSOR variables, in the Results Tab.

WATCH WINDOW
Embarcadero SQL Debugger for Oracle provides a Watch window that displays the watch variables for the database object you are debugging and lets you specify variables you want to evaluate or modify while debugging your program. For example, to check what happens when a variable (x) has a value of 100, you can double-click that variable in the SQL Editor, drag it into the Watch window, and change the value to 100. When you execute the script, the debugger uses the value x=100. This window is only visible when the PL/SQL Debugger is active.

**NOTE:** You can type a fully qualified record variable into the Watch window.

**NOTE:** When you exit a debug session and reenter it, the Embarcadero SQL Debugger for Oracle retains any watch variables or breakpoints you have set.

Opening and Closing the Watch Window
To open and close the Watch Window, do the following:

1. On the **Debug Menu**, on the **Debug Views sub-menu**, select or clear **Watch**.

   OR

   Press ALT+3.

Setting a Watch Variable
To set a Watch Variable, do the following:

1. In the **SQL Editor**, double-click the target variable and drag it to the **Watch window**.

2. In the **Watch window**, change the value of the variable.

3. On the **SQL Editor** toolbar, click **Go**.

   Rapid SQL executes the script using the new value of the variable.
Removing a Watch Variable
1. In the Watch window, click the target variable and press DELETE.

VARIABLES WINDOW
Embarcadero SQL Debugger for Oracle provides a Variables window that displays the local variables and their current values during script execution. You cannot edit variables in the Variables window. This window is only visible when the Debugger is active. If the SQL Editor displays an external database object, and that object is a dependent of the object you are debugging, then the Variables window automatically refreshes and displays the variables for that particular object.

The Embarcadero SQL Debugger for Oracle also lets you monitor the value of your variables while debugging.

Opening and Closing the Variables Window
To open and close the Variables Window, do the following:
1. On the Debug Menu, on the Debug Views sub-menu, select or clear Variable.
   OR
   Press ALT+4.

Monitoring Variables
To monitor the values of your variables while debugging, do the following:
1. In the SQL Editor, hold the pointer over the target variable.
   Rapid SQL opens a ScreenTip displaying the current value of that variable.

CALL STACK WINDOW
Embarcadero SQL Debugger for Oracle provides a Call Stack window that displays the stack of currently active function calls. The Call Stack window is only visible when the PL/SQL Debugger is active.

Opening and Closing the Call Stack Window
To open and close the Call Stack Window, do the following:
1. On the Debug Menu, on the Debug Views sub-menu, select or clear Call Stack.
   OR
   Press ALT+5.
Using the Call Stack Window
To display a line of code that references the call in the SQL Editor, do the following:

1. In the Call Stack window, double-click the target line.

   In the SQL Editor, Rapid SQL displays a green arrow on the line of the referenced call.

Dependency Tree Window
Embarcadero SQL Debugger for Oracle provides a Dependency Tree window that displays any external database objects the script accesses. Rapid SQL displays these database objects in a hierarchical tree, with the child objects as database objects accessed by the parent objects. You can use this window to display the code for a dependent database object in the SQL Editor window. This window is only visible when the Debugger is active.

Opening and Closing the Dependency Tree Window
To open and close the Dependency Tree Window, do the following:

1. On the Debug Menu, on the Debug Views sub-menu, select or clear Dependencies.
   OR
   Press ALT+6.

Displaying Dependencies
To display the code for a dependent database object in the SQL Editor window, do the following:

1. In the Dependency Tree window, double-click the target object.

   Rapid SQL displays the SQL of the target object in the SQL Editor window.

Embarcadero SQL Debugger for Oracle Functionality
Embarcadero SQL Debugger for Oracle offers you the following functionality:

- Input Parameters
- Step Into
- Step Out
- Step Over
- Run to Cursor
- Insert or Remove Breakpoint
- Toggle Breakpoint
• Go
• Stop
• Restart
• Break.
• Close

To make use of the above functionality, you must first open a debugging session.

INPUT PARAMETERS
Input parameters are set when you first create an object. If the object you want to debug requires input parameters, Rapid SQL opens a Function, Procedure, or Trigger Execution dialog box and prompts you for the input parameters when you open a debugging session.

This dialog box also lets you:
• Save input parameters as *.prm files to preserve specific input parameter configurations.
• Open *.prm files to save the effort of reentering specific input parameters.
• Reset parameters to their default setting.

The table below describes the options and functionality on Procedure Execution dialog box:

The following table describes the options available in this dialog box:

<table>
<thead>
<tr>
<th>Dialog box component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Owner drop-down list</td>
<td>Displays the current procedure's owner</td>
</tr>
<tr>
<td>Procedure drop-down list</td>
<td>Displays the name of the current procedure.</td>
</tr>
</tbody>
</table>
| Parameter window | Specify the required input parameters in this window. If input parameters are not required for the execution of the target procedure, a message appears in this window, stating that the procedure "has no input parameters. Press execute to run it."
| Open button | Click to open an Open dialog box, from which you can open an existing *.prm file. The saved parameters immediately populate the dialog box upon opening. |
| Save button | Click to save the values of your input parameters as a *.prm file. You can reopen a saved *.prm file from this dialog box at any time. |
| Reset button | Click to reset the parameters in the Parameter window to their default values. |
| Execute button | Click to execute the procedure once you have entered values for all required parameters in the Parameter window. |
NOTE: You cannot debug a script that requires input parameters until you provide input parameters.

STEP INTO

After you open a debugging session, Step Into lets you execute the current instruction. If the current instruction makes a call to a stored Oracle object, Embarcadero SQL Debugger for Oracle steps inside the nested child object.

NOTE: Oracle 7.3 has problems running the debugger on an object with cursors.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Owner</td>
<td>Displays the current procedure's owner.</td>
</tr>
<tr>
<td>Procedure</td>
<td>Displays the name of the current procedure.</td>
</tr>
<tr>
<td>Parameter</td>
<td>Specify the required input parameters in this window. If input parameters are not required for the execution of the target procedure, a message displays in this window, stating that the procedure &quot;has no input parameters. Press execute to run it.&quot;</td>
</tr>
<tr>
<td>Open</td>
<td>Click to open an existing *.prm file. The saved parameters immediately populate the dialog box upon opening.</td>
</tr>
<tr>
<td>Save</td>
<td>Click to save the values of your input parameters as a *.prm file. You can reopen a saved *.prm file from this dialog box at any time.</td>
</tr>
<tr>
<td>Reset</td>
<td>Click to reset the parameters in the Parameter window to their default values.</td>
</tr>
<tr>
<td>Continue</td>
<td>Click to execute the procedure once you have entered values for all required parameters in the Parameter window.</td>
</tr>
</tbody>
</table>
Step Into
To use the Step Into facility, do the following:

1. On the Debug menu, click Step Into.
2. OR
   On the SQL Editor toolbar, click Step Into.
3. OR
   In the SQL Editor window, right-click and then click Step Into.
4. OR
   Press F11.

Embarcadero SQL Debugger for Oracle moves the arrow to execute the current instruction.

STEP OUT
After you open a debugging session, Step Out lets you execute the remainder of the dependent child object and resumes line-by-line, step-debugging in the parent object.

NOTE: Step Out is only active when the pointer indicates a child-dependent instruction.

NOTE: Oracle 7.3 has problems running the debugger on an object with cursors.

Step Out
To use the Step Out facility, do the following:

1. On the Debug menu, click Step Out.
2. OR
   On the SQL Editor toolbar, click Step Out.
3. OR
   In the SQL Editor window, right-click and then click Step Out.
4. OR
   Press SHIFT+F11.

Embarcadero SQL Debugger for Oracle stops stepping through the current object and executes the remainder of the script.

STEP OVER
After you open a debugging session, Step Over lets you execute the current instruction without stepping into a nested child object if the instruction makes a call to a dependent object.

NOTE: Oracle 7.3 has problems running the debugger on an object with cursors.
**Step Over**

To use the Step Over facility, do the following:

1. On the **Debug** menu, click **Step Over**.
   
   OR
   
   On the **SQL Editor** toolbar, click **Step Over**.
   
   OR
   
   In the **SQL Editor** window, right-click and then click **Step Over**.
   
   OR
   
   Press F10.

   Embarcadero SQL Debugger for Oracle executes the current instruction.

**Run to Cursor**

After you open a debugging session, Run to Cursor lets you execute all instructions between the yellow arrow and your cursor.

**Run to Cursor**

To use the Run to Cursor facility, do the following:

1. Scroll down from the yellow arrow to the target line.

2. Click the target line.

   Embarcadero SQL Debugger for Oracle places the cursor on the target line.

3. On the **Debug** menu, click **Run to Cursor**.
   
   OR
   
   On the **SQL Editor** toolbar, click **Run to Cursor**.
   
   OR
   
   In the **SQL Editor** window, right-click and then click **Run to Cursor**.
   
   OR
   
   Press CTRL+F10.

   Embarcadero SQL Debugger for Oracle executes all instructions between the pointer and your cursor.
INSERT OR REMOVE A BREAKPOINT

A breakpoint is a position in a program where a debugger stops execution. When you start debugging, Embarcadero SQL Debugger for Oracle opens the script in an SQL Editor window. A yellow pointer indicates which line the Debugger executes next. Embarcadero SQL Debugger for Oracle executes all lines of code between the pointer and the first breakpoint. If no breakpoints are present, Embarcadero SQL Debugger for Oracle debugs the entire script.

While debugging, you can set one or more breakpoints in the currently executing object or in any object in the program call stack. Breakpoints can be toggled, temporarily disabled, or enabled, without having to add or remove them. Embarcadero SQL Debugger for Oracle displays each enabled breakpoint as a red dot in the left margin of the SQL Editor Window, and each disabled breakpoint as a red circle.

Rapid SQL stores all breakpoints you set, so that when you debug the same script on separate occasions, you can reuse the same breakpoints.

After you open a debugging session, you can insert a breakpoint on the line where your cursor is located, and you can remove a breakpoint on the line where your cursor is located.

NOTE: Script execution stops at the first breakpoint.

Inserting or Removing a Breakpoint

To insert and remove a breakpoint, do the following:

1. In the SQL Editor window, click the target line of SQL.
2. On the Debug menu, click Breakpoint.

OR
On the SQL Editor toolbar, click Breakpoint.

OR
In the SQL Editor window, right-click and then click Breakpoint.

OR
Press F9.

Embarcadero SQL Debugger for Oracle inserts a new breakpoint or removes an existing breakpoint on the target line of code.

TOGGLE BREAKPOINT

After you open a debugging session and insert a breakpoint, Toggle Breakpoint lets you enable or disable that breakpoint. Embarcadero SQL Debugger for Oracle displays each enabled breakpoint as a red dot in the left margin of the SQL Editor Window, and each disabled breakpoint as a red circle. You can toggle any breakpoint in the SQL Editor window. When you exit a debugging session and reenter it, the Embarcadero SQL Debugger for Oracle retains any breakpoints you set.
**Toggling a Breakpoint**

To toggle a breakpoint, do the following:

1. In the SQL Editor window, click the line of the target breakpoint.
2. On the **Debug** menu, click **Enable/Disable Breakpoint**.
   OR
   On the **SQL Editor** toolbar, click **Enable/Disable Breakpoint**.
   OR
   In the **SQL Editor** window, right-click and then click **Enable/Disable Breakpoint**.
   OR
   Press CTRL+F9.

Embarcadero SQL Debugger for Oracle toggles the breakpoint indicated by the pointer.

**GO**

After you [open a debugging session](#), Go lets you execute all instructions, stopping only when it encounters a breakpoint or when the program is complete.

**Go**

Go use the Go facility, do the following:

1. On the **Debug** menu, click Go.
   OR
   On the **SQL Editor** toolbar, click Go.
   OR
   In the **SQL Editor** window, right-click and then click Go.
   OR
   Press F5.

Embarcadero SQL Debugger for Oracle executes all instructions.

**STOP**

After you [open a debugging session](#), Stop lets you halt the script execution and terminate the session.
**Stop**

To stop the debugger, do the following:

1. On the Debug menu, click *Stop Debugging*.
   
   OR
   
   On the SQL Editor toolbar, click *Stop Debugging*.
   
   OR
   
   In the SQL Editor window, right-click and then click *Stop Debugging*.
   
   OR
   
   Press SHIFT+F5.

   Embarcadero SQL Debugger for Oracle stops the script execution and terminates the session.

**RESTART**

After you open a debugging session, Restart lets you terminate the current debug session and open a new one. When the new session opens, Rapid SQL prompts you for new input parameters.

**Restart**

To restart the debugger, do the following:

1. On the Debug menu, click *Restart*.
   
   OR
   
   On the SQL Editor toolbar, click Restart.
   
   OR
   
   In the SQL Editor window, right-click and then click Restart.
   
   OR
   
   Press CTRL+SHIFT+F5.

   Embarcadero SQL Debugger for Oracle restarts the debug session.

**BREAK**

After you open a debugging session, Break lets you pause the debug session.
Break
To pause the session, do the following:
1. On the Debug menu, click Break.
   OR
   On the SQL Editor toolbar, click Break.
   OR
   In the SQL Editor window, right-click and then click Break.
Embarcadero SQL Debugger for Oracle suspends the debug session.

CLOSE
After you open a debugging session, Close lets you close the SQL Editor and the Embarcadero SQL Debugger for Oracle.

Close
To close the SQL Editor and the debugger, do the following:
1. On the SQL Editor toolbar, click Close.
   OR
   In the upper right corner of the window, click Close.
   OR
   In the SQL Editor window, right-click and then click Close.
Embarcadero SQL Debugger for Oracle closes the debug session.

USING THE EMBARCADERO SQL DEBUGGER FOR ORACLE
This section offers a general overview of how to use Embarcadero SQL Debugger for Oracle’s full range of debugging functionality. After you open a debugging session for any Oracle procedure or function, you can begin debugging.

For more detailed information, see Debugging a Sample Script.
OPENING A DEBUGGING SESSION
When you open a debugging session, Rapid SQL opens the five windows of the Embarcadero SQL Debugger for Oracle interface. If the target script requires input parameters, Rapid SQL opens a Procedure or Function Execution dialog box and prompts you for the necessary input parameters before displaying the target code in the SQL Editor window. When Rapid SQL displays the target script in the SQL Editor window, you can begin debugging.

NOTE: Embarcadero SQL Debugger for Oracle only lets you debug the SQL script of functions, triggers and procedures.

Opening a Debugging Session
To debug a function, trigger or procedure, do the following:

1. On the Explorer Tab, click the node of the target function, trigger, or procedure.
   Rapid SQL opens the node and displays two items: Code and Privileges.
2. Under the target object node, double-click Code.
   Rapid SQL opens an SQL editor displaying the code of the target object.
3. On the Debug menu, click Start Debugging.
   OR
   On the SQL Editor toolbar, click Debug.
   OR
   In the SQL Editor window, right-click and then click Debug.
   OR
   Press CTRL+F5.
If the script requests input parameters, Rapid SQL opens the Procedure or Function Execution dialog box. If the script does not require input parameters, Rapid SQL displays the script in the SQL Editor window for you to begin debugging.

NOTE: You cannot use the Embarcadero SQL Debugger for Oracle until it has fully initialized.

4. In the Procedure or Function Execution dialog box, specify the appropriate parameters, and then click Continue.
   Rapid SQL displays the script in the SQL Editor window for you to begin debugging.

NOTE: If the script requires Oracle types (tables, records, or Booleans) as input parameters, the PL/SQL Debugger generates an anonymous block.

DEBUGGING AN SQL SCRIPT
After you open a debugging session and enter any required input parameters, you can begin working with your script in the Debugger.
Debugging an SQL Script

To debug an SQL script, do the following:

1. On the Debug menu, click one of the PL/SQL Debugger options (Step Into, Step Over, and so forth) or click Go.

   OR

   On the SQL Editor toolbar, click one of the PL/SQL Debugger options (Step Into, Step Over, and so on) or click Go.

   NOTE: You can monitor the progress of your debug session in the Variables window.

2. On the Debug menu, click Breakpoint.

   OR

   On the SQL Editor toolbar, click Breakpoint.

   OR

   Press F9.

   NOTE: When you set a breakpoint, the Call Stack window shows what was called before the breakpoint.

   NOTE: You can use the Run to Cursor option to test the lines of code between a breakpoint and your cursor (indicated by the yellow arrow in the SQL Editor).

3. To check your variables, do the following:

   1) In the SQL Editor, click a variable in your script and drag it to the Watch window.

   2) In the Watch window, change the value of the watch variable and then click Go to run your script and see the results of the new value.

4. To check record in stored objects, do the following:

   1) Drag the record to the Watch window.

   2) In the Watch window, change the value of the record, then click Go to run your script and see the results of the new value.

5. To check the dependencies, do the following:

   1) In the Dependency Tree window double-click the target dependent object to extract the code into a new SQL Editor.

   2) Step through the script while monitoring the Dependency Tree window.

6. When you finish debugging the script, click Close.

Rapid SQL closes the PL/SQL Debugger SQL Editor.

NOTE: When you exit a debug session and reenter it, the Embarcadero SQL Debugger for Oracle retains any watch variables or breakpoints you have set.
DEBUGGING A SAMPLE SCRIPT
The Rapid SQL installation includes a sample script intended to walk you through basic debuging functionality. The sample script creates a package that includes functions and procedures that you debug.

NOTE: To create the sample package, you must have CREATE privileges.

Overview
Debugging a Sample Script is divided into three sections that will familiarize you with basic debugging features and functionality. These sections are:

• Getting Started, which guides you through creating the package you will use in Debugging Sample Script 1 and Debugging Sample Script 2.

• Debugging Sample Script 1, which guides you through debugging functionality and demonstrates the Embarcadero SQL Debugger for Oracle interface features.

• Debugging Sample Script 2, which guides you through debugging functionality and error correction.

NOTE: For the purposes of this walk-through we have created this package under the user name DEMO_SPENCE.

GETTING STARTED
The Rapid SQL installation includes a sample script that you execute to create a package containing functions and procedures. These functions and procedures demonstrate basic debugging features available in the Embarcadero SQL Debugger for Oracle.

NOTE: To create the sample package, you must have CREATE privileges.

If you create the package included with the Rapid SQL installation, you can delete it and its objects from your system when you finish working with them. The objects to delete are as follows:

• The package COUNT_TIME_INTERVAL

• The package function WEEKEND_DAYS_( )

• The package function WORKING_DAYS_( )

• The package function YEARS_ELAPSED_BETWEEN_( )

• The procedure YEARS_ELAPSED

• The procedure YEARS_ELAPSED_Y2K

Overview
The Getting Started section guides you through:
Getting Started

1. Start Rapid SQL.
2. On the File menu, click Open. Rapid SQL opens the Open File(s) dialog box.
   
   **NOTE:** The sample file used in this example, DEBUGGER_DEMO.sql, is stored in the configured user SQL scripts folder. For details, see Directories Options.

3. In the Open File(s) dialog box, navigate to the user SQL scripts folder and open the DEBUGGER_DEMO.sql file.
   
   Rapid SQL opens the What type of file dialog box.

4. On the What type of file dialog box, click The file includes the DDL to create a database object, and then click OK.
   
   Rapid SQL opens the target script in an SQL Editor.

5. On the SQL Editor toolbar, click Execute to execute the script and create the package.
   
   Rapid SQL executes the target script and opens the SQL Editor Results Tab, displaying the results of the script execution. If you were not able to create the package, check the error messages to determine the problem.

6. On the Explorer Tab list, click Organize by Owner.
   
   Rapid SQL displays a list of owners in the Database Explorer.

7. On the Explorer Tab, double-click your owner name.
   
   Rapid SQL displays a list of your schema objects.

8. Under your owner node, double-click the Packages node.
   
   Rapid SQL displays COUNT_TIME_INTERVAL, confirming the package’s creation. You are now ready to begin debugging Sample Script 1 and Sample Script 2.

Debugging Sample Script 1

Sample Script 1 demonstrates Embarcadero SQL Debugger for Oracle’s basic features and functionality with the function WORKING_DAYS(), which counts the number of business days between two dates.
Overview
Debugging Sample Script 1 is divided into five parts:

- Starting the Debug Session
- Entering Input Parameters
- Inserting Breakpoints
- Stepping Into
- Viewing Debug Session Results

SAMPLE SCRIPT 1 - STARTING THE DEBUG SESSION
After you open and execute DEBUGGER_DEMO.sql, you can begin debugging Sample Script 1. To begin debugging the function WORKING_DAYS(), you must start a debug session.

Starting the Debug Session
To start the debug session, do the following:

1. On the Explorer Tab, under the Packages node, double-click the COUNT_TIME_INTERVAL node.
   Rapid SQL opens the COUNT_TIME_INTERVAL node and displays the following items:

2. Under the COUNT_TIME_INTERVAL node, double-click Functions.
   Rapid SQL opens the Functions node and displays the following items:

3. Under the Functions node, right-click WORKING_DAYS(), and then click Debug to start the debug session.
   Rapid SQL opens the Function Execution dialog box with the current date in the boxes. You are now ready to begin working with input parameters.

SAMPLE SCRIPT 1 - ENTERING INPUT PARAMETERS
After you start a debugging session, you can enter input parameters. You cannot debug a script that requires input parameters until you input those parameters in the Function Execution dialog box.

Input Parameters
To input parameters, do the following:

4. At the end of the P_START_DATE DATE row, click the drop-down arrow.
   Rapid SQL opens a calendar.

5. On the calendar, click left arrow to set the month to November 1999.
6 Click 1.
   Rapid SQL displays 11/01/1999 in the Value column of P_START_DATE.
7 Click the P_END_DATE DATE box, and then click the drop-down arrow.
   Rapid SQL opens a new calendar.
8 On the calendar, click left arrow to set the month to November 1999.
9 Click 8.
   Rapid SQL displays 11/08/1999 in the Value column of P_END_DATE.
10 Click Continue.
   Rapid SQL closes the Function Execution dialog box, and then opens the following five Embarcadero SQL Debugger for Oracle interface windows:
   - SQL Editor, which displays the SQL code for the function.
   - Watch window.
   - Variables window.
   - Call Stack window.
   - Dependency Tree window, which displays the dependent objects.
You are now ready to begin inserting breakpoints.

**SAMPLE SCRIPT 1- INSERTING BREAKPOINTS**

After you input parameters in the Input Parameters dialog box, you can begin inserting breakpoints. In this example, the breakpoints must be inserted in the extracted dependent object code. After you extract this code, you must locate the target breakpoint lines by searching for the text DBMS_OUTPUT.

**Breakpoints**

To insert breakpoints, do the following:

1 In the Dependency Tree window, double-click the COUNT_TIME_INTERVAL package body.
   Rapid SQL displays the SQL code for the package body in the SQL Editor window.
2 On the Edit toolbar, click Find.
   Rapid SQL opens the Find dialog box.
3 On the Find dialog box, in the Find What box, type DBMS_OUTPUT.
4 Click Find Next.
   In the SQL Editor, Rapid SQL highlights the first occurrence of DBMS_OUTPUT, on line 22.
On the SQL Editor toolbar, click Breakpoint.
Rapid SQL inserts a breakpoint next to the target line number.

6 On the Find dialog box, click Find Next.
Rapid SQL highlights the next occurrence of DBMS_OUTPUT.

7 Click Find Next a third time.
Rapid SQL highlights the next occurrence of DBMS_OUTPUT, on line 35.

8 On the Find dialog box, click Cancel.
Rapid SQL closes the Find dialog box.

9 On the SQL Editor toolbar, click Breakpoint to insert a second breakpoint.
You should now have breakpoints set at lines 22 and 35. You are now ready to begin stepping into the code.

SAMPLE SCRIPT 1 - STEPPING INTO
After you insert breakpoints, you can step into the function code.

Step Into
To Step Into the code, do the following:

1 On the SQL Editor toolbar, click Go.
Embarcadero SQL Debugger for Oracle begins debugging and runs to the first breakpoint, placing the yellow arrow on line 22.

2 On the SQL Editor toolbar, click Step Into.
Embarcadero SQL Debugger for Oracle moves the yellow arrow to the next line of the code.

3 Click Step Into again to enter the LOOP block.
Embarcadero SQL Debugger for Oracle displays the value of the variables in the Variables window.

4 Click Step Into again to start moving through the LOOP block.
In the Variables window, Embarcadero SQL Debugger for Oracle updates the value of variable v_curdate from 01-NOV-1999 to 02-NOV-1999.
5 Click Step Into two more times.

In the Variables window, Embarcadero SQL Debugger for Oracle updates the value of v_theday from NULL to Tuesday.

**NOTE:** If you continued stepping through the LOOP block, the Embarcadero SQL Debugger for Oracle would continue to update v_curdate and v_theday until v_curdate is greater than p_end_date.

6 On the SQL Editor toolbar, click Go.

Embarcadero SQL Debugger for Oracle runs to the next breakpoint.

7 On the SQL Editor toolbar, click Go once more.

Rapid SQL PL/SQL concludes the debug session and displays the **Debug Session Results** box.

**SAMPLE SCRIPT 1 - VIEWING DEBUG SESSION RESULTS**

After **Stepping Into** and running to the end of the code, Embarcadero SQL Debugger for Oracle displays a Debug Session Results box containing the following information:

- Variable output
- DBMS_OUTPUT

**NOTE:** In this example, the Embarcadero SQL Debugger for Oracle displays a Debug Session Results box because the sample program includes DBMS_OUTPUT.

**Debug Session Results**

1 Click OK.

Rapid SQL closes the **Debug Session Results** box and terminates your debug session.

**DEBUGGING SAMPLE SCRIPT 2**

Sample Script 2 demonstrates Embarcadero SQL Debugger for Oracle’s functionality when used on a function containing a bug which prevents it from executing successfully. The buggy function, WEEKEND_DAYS(), requires input parameters and counts the number of weekend days between two dates. In this section you must use Embarcadero SQL Debugger for Oracle to identify the bug, and then correct the script so that it can execute successfully.

**Overview**

Debugging Sample Script 2 is divided into six parts:

- **Executing the Function**
- **Starting the Debug Session**
SAMPLE SCRIPT 2 - EXECUTING THE FUNCTION
After you open and execute DEBUGGER_DEMO.sql, you can begin debugging Sample Script 2. To begin debugging the function WEEKEND_DAYS ( ), you must first execute the function to discover the type of error it returns when it fails to execute.

Executing the Function
To execute the function, do the following:

1. On the Explorer Tab, under the Packages node, double-click the COUNT_TIME_INTERVAL node.
   
   Rapid SQL opens the COUNT_TIME_INTERVAL node and displays the following items:

2. Double-click the Functions node.

   Rapid SQL opens the Functions node and displays the following items:

3. Click WEEKEND_DAYS ( ), then right-click it and click Execute.

   Rapid SQL opens the Function Execution dialog box.

4. In the Value column of the P_START_DATE row, type 11/01/1999.

5. In the Value column of the P_END_DATE row, type 11/30/1999.

6. Click Execute.

   Rapid SQL attempts to execute the function but returns an error indicating that the character string buffer is too small.

   You are now ready to start the debug session.

SAMPLE SCRIPT 2 - STARTING THE DEBUG SESSION
After you unsuccessfully execute the function WEEKEND_DAYS( ) and Rapid SQL displays the nature of its execution error, you can start a debugging session to determine the actual cause of the error.
Starting the Debugging Session

To start the debugging session, do the following:

1. On the Explorer Tab, under the COUNT_TIME_INTERVAL node, under the Functions node, right-click WEEKEND_DAYS ( ), and then click Debug to start the debug session.

   Rapid SQL opens the Function Execution dialog box.

   You are now ready to begin entering input parameters.

SAMPLE SCRIPT 2 - ENTERING INPUT PARAMETERS

After you start the debug session, you can enter input parameters in the Function Execution dialog box.

Entering Input Parameters

To enter the input parameters, do the following:

1. At the end of the P_START_DATE row, click the drop-down arrow.
   Rapid SQL opens a calendar.

2. On the calendar, click left arrow to set the month to November 1999.

3. Click 1.
   Rapid SQL displays 11/01/1999 in the Value column of the P_START_DATE row.

4. At the end of the P_END_DATE row, click the drop-down arrow.
   Rapid SQL opens a new calendar.

5. On the calendar, click left arrow to set the month to November 1999.

6. Click 30.
   Rapid SQL displays 11/08/1999 in the Value column of the P_END_DATE row.

7. Click Continue.
   Rapid SQL closes the Function Execution dialog box, and then opens the following five Embarcadero SQL Debugger for Oracle interface windows:

   • SQL Editor, which displays the SQL code for the function.
   • Watch window.
   • Variables window.
   • Call Stack window.
   • Dependency Tree window, which displays the dependent objects.

   You are now ready to begin inserting breakpoints.
SAMPLE SCRIPT 2- INSERTING BREAKPOINTS
After you enter input parameters, you can begin inserting breakpoints. In this example, the breakpoints must be inserted in the extracted dependent object code. After you extract this code, you must locate the target breakpoint lines by searching for a particular line of code.

**Breakpoints**
To insert breakpoints, do the following:

1. In the **Dependency Tree window**, double-click the **COUNT_TIME_INTERVAL** package body.
   - Rapid SQL displays the SQL code for the package body in the SQL Editor window.

2. On the **Edit** toolbar, click **Find**.
   - Rapid SQL opens the **Find** dialog box.

3. On the Find dialog box, in the **Find What** box, type **Function weekend_days**, and then click **Find Next**.
   - Embarcadero SQL Debugger for Oracle highlights the first occurrence of Function weekend_days.

4. On the Find dialog box, click **Cancel**.
   - Rapid SQL closes the Find dialog box.

5. Click line 60, the first line of executable code:

6. On the **SQL Editor** toolbar, click **Breakpoint**.
   - Rapid SQL inserts a breakpoint next to the line number.

7. Click **Go** to start debugging and run to the breakpoint.
   - Embarcadero SQL Debugger for Oracle places the yellow arrow on line 60 and populates the Variables window with the first set of variables in the function code.
   - Embarcadero SQL Debugger for Oracle also populates the Call Stack window with everything called before the breakpoint.

You are now ready to begin **stepping into** the function.

SAMPLE SCRIPT 2- STEPPING INTO
After you set and run to the breakpoint, you can step into the function to locate the cause of the error. To locate the cause of the error, you must monitor the Variables window. As you step through the code, the Variables window updates with the value of the variables.
**Step Into**

To step into the function, do the following:

1. On the SQL Editor toolbar, click Step Into.
   
   Rapid SQL moves the yellow arrow to the next line of the code, line 64.

2. On the SQL Editor toolbar, click Step Into.
   
   Embarcadero SQL Debugger for Oracle’s Variables window updates the value of v_curdate to 02-NOV-1999.

3. On the SQL Editor toolbar, click Step Into.
   
   Rapid SQL moves the yellow arrow to the next line of the code, line 66.

4. On the SQL Editor toolbar, click Step Into.
   
   Rapid SQL moves the yellow arrow to the next line of the code, line 67, and, in the Variables window, updates the value of v_theday to Tuesday.

5. On the SQL Editor toolbar, click Step Into.
   
   Rapid SQL moves the yellow arrow back to line 64 to repeat the loop.

6. On the SQL Editor toolbar, click Step Into.
   
   Embarcadero SQL Debugger for Oracle’s Variables window updates the value of v_curdate to 03-NOV-1999.

7. On the SQL Editor toolbar, click Step Into.
   
   Rapid SQL moves the yellow arrow to the next line of the code, line 66.

8. On the SQL Editor toolbar, click Step Into.
   
   The Embarcadero SQL Debugger for Oracle locates the error. The application terminates the debug session, returns an error indicating that the numeric or value character string buffer is too small, extracts the COUNT_TIME_INTERVAL package code into an SQL Editor, and returns an error indicating the line on which the code failed. You are now ready to correct the script.

**SAMPLE SCRIPT 2 - CORRECTING THE SCRIPT**

After you step through the SQL code and locate the error, you can correct the bug in Sample Script 2. When Embarcadero SQL Debugger for Oracle locates an error, it extracts the target package body into an SQL Editor. To correct this script, you must do the following:

- Scroll to the incorrect line in the script
- Analyze the code
- Correct the error
- Execute the corrected SQL script
• Execute the WEEKEND_DAYS () function

The code in Sample Script 2 fails on line 66, returning an error when the variable v_theday increments from the value Tuesday to the value Wednesday. The cause of this error is found in the declarations section of the function script, where the width of the VARCHAR2 variable v_theday is set to 8. Because “Wednesday” includes nine characters, the value of the variable v_theday fails when it attempts to place a nine-character value in an eight-character variable. To correct this error, you must increase the width of the variable v_theday to accommodate nine characters.

Correcting the Script
To correct the script, do the following:

1. On the Explorer Tab, under the Packages node, under the COUNT_TIME_INTERVAL. node, right-click Package Body, and then click Extract.
   
   Rapid SQL extracts the package body into an SQL Editor.

2. In the SQL Editor, scroll to line 57, the line defining the variable v_theday.

3. On line 57, change the value of the width from 8 to 9.

4. On the SQL Editor toolbar, click Execute to execute the script.
   
   Rapid SQL successfully executes the script.

5. On the Explorer Tab, under the COUNT_TIME_INTERVAL package node, under the Functions node, click WEEKEND_DAYS ( ).

6. Right-click WEEKEND_DAYS ( ), and then click Execute.
   
   Rapid SQL opens the Function Execution dialog box.

7. In the Value column of the P_START_DATE row, type 11/01/1999.

8. In the Value column of the P_END_DATE row, type 11/30/1999.

9. Click Execute.
   
   Rapid SQL successfully executes the corrected function.

Embarcadero SQL Debugger for Sybase ASE
Embarcadero SQL Debugger for Sybase is a programming tool that lets you debug Sybase objects in the following Sybase versions:

• 12

• 12.0 (special version)

• 12.5
Objects
Using Embarcadero SQL Debugger for Sybase, you can debug the following objects:

- Procedures
- Triggers

You can only debug triggers by debugging the procedures that call them.

**NOTE:** Availability of this feature depends on your Rapid SQL licensing. For more information, see [Licensing](#).

**TIP:** The [Code Analyst](#) is a tool to identify time-consuming lines of code. Code Analyst lets you perform detailed response time analysis on the execution of Procedures and Functions.

The table below describes the sections of this chapter:

<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Features</strong></td>
<td>This section describes how Embarcadero SQL Debugger for Sybase ASE helps you identify problems within your code.</td>
</tr>
<tr>
<td><strong>Interface</strong></td>
<td>This section describes Embarcadero SQL Debugger for Sybase ASE's graphical interface, which includes an editor window and four debug view windows.</td>
</tr>
<tr>
<td><strong>Functionality</strong></td>
<td>This section describes the way in which Embarcadero SQL Debugger for Sybase ASE functions.</td>
</tr>
<tr>
<td>Using Embarcadero SQL Debugger for Sybase ASE</td>
<td>This section describes how to run a debug session.</td>
</tr>
</tbody>
</table>

EMBARCADERO SQL DEBUGGER FOR SYBASE ASE FEATURES
Embarcadero SQL Debugger for Sybase ASE is designed to help identify problems within your code. Embarcadero SQL Debugger for Sybase ASE lets you:

- Interactively step through the flow of script execution.
- Examine the value of variables.
- Solve logical problems with your script design.

Embarcadero SQL Debugger for Sybase ASE offers fundamental debugging features and several options to help fine tune debugging, as listed in the table below:

<table>
<thead>
<tr>
<th>Debugging Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Step Into</strong></td>
<td>Lets you execute each instruction step-by-step and step inside a stored object.</td>
</tr>
</tbody>
</table>
EMBARCADERO SQL DEBUGGER FOR SYBASE ASE OPTIONS

You can specify Debugger options from the Debug Tab of Rapid SQL's Options editor. The Debug Tab of the Options Editor lets you set the duration of your debug initialization and debug session, enable DBMS output, and refresh dependencies.

Setting Debugger Options
To set debugger options, do the following:

1. On the File menu, click Options.

   OR

   On the Main toolbar, click Options.

   Rapid SQL opens the Options Editor.

2. On the Debug Tab, specify debugger options. The table below describes the options available:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Initialization Timeout (seconds)</td>
<td>Specifies the number of seconds Rapid SQL tries to initialize the debugger. If it cannot initialize the debugger in the specified time, a message displays in the Debug Output window.</td>
<td>60</td>
</tr>
<tr>
<td>Debug Session Timeout (seconds)</td>
<td>Specifies, in seconds, the length of your debug session.</td>
<td>7200</td>
</tr>
<tr>
<td>Enable DBMS Output</td>
<td>Toggles the print output. Enable this option if you use dbms_output.put_line calls in your procedures and you want these lines displayed.</td>
<td>Selected</td>
</tr>
<tr>
<td>Refresh Dependencies for each run</td>
<td>Refreshes dependencies for each run. This potentially time-consuming process is useful if the target procedure has rapidly varying dependencies that can require updating during the debugging process.</td>
<td>Cleared</td>
</tr>
</tbody>
</table>
Click Close. Rapid SQL closes the Options Editor.

EMBARCADERO SQL DEBUGGER FOR SYBASE ASE INTERFACE

Embarcadero SQL Debugger for Sybase ASE has a graphical interface that includes an editor window and four debug view windows. When you open a debug session, Rapid SQL extracts the code for the object into a DDL Editor and opens four debug view windows at the bottom of the screen.

TIP: All Embarcadero debuggers display Performance Metrics that let you measure the execution time of each statement in the debug session.

The four debug view windows are optional, dockable windows designed to help debug your script. Embarcadero SQL Debugger for Sybase ASE’s five windows are:

- DDL Editor window
- Watch window
- Variables window
- Call Stack window
- Dependency Tree window

Working with Debugger Windows

Rapid SQL lets you resize, move, dock and float the following Debugger windows:

- Watch
- Variables
- Call Stack
- Dependency Tree

To work with the above windows, do the following:

1. To resize the target window, click its frame and drag it.
   Rapid SQL resizes the window.

2. To move and dock the target window, click its grab bar and drag it.
   Rapid SQL moves the window to its new location and docks it with surrounding windows.

3. To float the target window, press Shift, then click its grab bar and drag it.
   Rapid SQL frames the window in its own floating frame and moves the window to its new location.
DDL EDITOR WINDOW
Embarcadero SQL Debugger for Sybase ASE provides a DDL Editor window that displays your code in read-only format. When you start debugging, Embarcadero SQL Debugger for Sybase ASE extracts your code into a DDL Editor window, making it editable. The DDL Editor uses the default Rapid SQL syntax coloring.

WATCH WINDOW
Embarcadero SQL Debugger for Sybase ASE provides a Watch window that displays the watch variables for the database object you are debugging and lets you specify variables you want to evaluate or modify while debugging your program. For example, to check what happens when a variable (x) has a value of 100, you can double-click that variable in the DDL Editor and drag it into the Watch window. In the Watch window, change the value to 100. When you execute the script, the debugger uses the value x=100. This window is only visible when Embarcadero SQL Debugger for Sybase ASE is active.

NOTE: You can type a fully qualified record variable into the Watch window.

NOTE: When you exit a debug session and reenter it, Embarcadero SQL Debugger for Sybase ASE retains any watch variables or breakpoints you have set.

Opening and Closing the Watch Window
To open and close the Watch Window, do the following:
1. On the Debug Menu, on the Debug Views sub-menu, select or clear Watch.
   OR
   Press ALT+3.

Setting a Watch Variable
To set a Watch Variable, do the following:
1. In the DDL Editor, double-click the target variable and drag it to the Watch window.
2. In the Watch window, in the Value column, change the value of the variable.
3. On the DDL Editor toolbar, click Go to execute the script using the new value of the variable.
   Rapid SQL executes the script using the new value of the variable.
Removing a Watch Variable
To remove a Watch Variable, do the following:

1. In the Watch window, delete the variable.

VARIABLES WINDOW
Embarcadero SQL Debugger for Sybase ASE provides a Variables window that displays the local variables and their current values during script execution. You cannot edit variables in the Variables window. This window is only visible when the Debugger is active. If the DDL Editor displays an external database object, and that object is a dependent of the object you are debugging, then the Variables window automatically refreshes and displays the variables for that external object.

Embarcadero SQL Debugger for Sybase ASE also lets you monitor the value of your variables while debugging.

Opening and Closing the Variables Window
To open and close the Variables Window, do the following:

1. On the Debug Menu, on the Debug Views sub-menu, select or clear Variable.
   OR
   Press ALT+4.

Monitoring Variables
To monitor the values of your variables while debugging, do the following:

1. In the DDL Editor, hold the pointer over the target variable.
   Rapid SQL opens a ScreenTip displaying the current value of that variable.

CALL STACK WINDOW
Embarcadero SQL Debugger for Sybase ASE provides a Call Stack window that displays the stack of currently active calls. The Call Stack window is only visible when the Debugger is active.

Opening and Closing the Call Stack Window
To open and close the Call Stack Window, do the following:

1. On the Debug Menu, on the Debug Views sub-menu, select or clear Call Stack.
   OR
   Press ALT+5.
Using the Call Stack Window
To display a line of code that references the call in the DDL Editor, do the following:

1. In the Call Stack window, double-click the target line.

   In the DDL Editor, Rapid SQL displays a green arrow on the line of the referenced call.

Dependency Tree Window
Embarcadero SQL Debugger for Sybase ASE provides a Dependency Tree window that displays any external database objects accessed by the script. Rapid SQL displays these database objects in a hierarchical tree, with the child objects as database objects accessed by the parent objects. You can use this window to display the code for a dependent database object in the DDL Editor window. This window is only visible when the Debugger is active.

Opening and Closing the Dependency Tree Window
To open and close the Dependency Tree Window, do the following:

1. On the Debug Menu, on the Debug Views sub-menu, select or clear Dependencies.

   OR

   Press ALT+6.

Displaying Dependencies
To display the code for a dependent database object in the DDL Editor window, do the following:

1. In the Dependency Tree window, double-click the target object.

   Rapid SQL displays the SQL of the target object in the DDL Editor window.

Embarcadero SQL Debugger for Sybase ASE Functionality
Embarcadero SQL Debugger for Sybase ASE offers you the following functionality:

- Input parameters
- Step Into
- Step Out
- Step Over
- Run to Cursor
- Insert or Remove Breakpoint
- Toggle Breakpoint
To make use of the above functionality, you must first open a debugging session.

**INPUT PARAMETERS**

Input parameters are set when you first create an object. If the object you want to debug requires input parameters, Rapid SQL opens a Procedure Execution dialog box and prompts you for the input parameters when you open a debugging session.

This dialog box also lets you:

- Save input parameters as *.prm files to preserve specific input parameter configurations.
- Open *.prm files to save the effort of reentering specific input parameters.
- Reset parameters to their default setting.

The table below describes the options and functionality on Procedure Execution dialog box:

<table>
<thead>
<tr>
<th>Dialog box component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Owner drop-down list</td>
<td>Displays the current procedure's owner</td>
</tr>
<tr>
<td>Procedure drop-down list</td>
<td>Displays the name of the current procedure.</td>
</tr>
<tr>
<td>Parameter window</td>
<td>Specify the required input parameters in this window. If input parameters are not required for the execution of the target procedure, a message appears in this window, stating that the procedure “has no input parameters. Press execute to run it.”</td>
</tr>
<tr>
<td>Open button</td>
<td>Click to open an Open dialog box, from which you can open an existing *.prm file. The saved parameters immediately populate the dialog box upon opening.</td>
</tr>
<tr>
<td>Save button</td>
<td>Click to save the values of your input parameters as a *.prm file. You can reopen a saved *.prm file from this dialog box at any time.</td>
</tr>
<tr>
<td>Reset button</td>
<td>Click to reset the parameters in the Parameter window to their default values.</td>
</tr>
<tr>
<td>Execute button</td>
<td>Click to execute the procedure once you have entered values for all required parameters in the Parameter window.</td>
</tr>
</tbody>
</table>
NOTE: You cannot debug a script that requires input parameters until you provide input parameters.

**STEP INTO**

After you open a debugging session, Step Into lets you execute the current instruction. If the current instruction makes a call to a stored Sybase ASE object, Embarcadero SQL Debugger for Sybase ASE steps inside the nested child object.

**Step Into**

To use the Step Into facility, do the following:

1. On the Debug menu, click Step Into.
   
   OR
   
   On the DDL Editor toolbar, click Step Into.
   
   OR
   
   In the DDL Editor window, right-click and then click Step Into.
   
   OR
   
   Press F11.

   Embarcadero SQL Debugger for Sybase ASE moves the arrow to execute the current instruction.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Owner</td>
<td>Displays the current procedure's owner.</td>
</tr>
<tr>
<td>Procedure</td>
<td>Displays the name of the current procedure.</td>
</tr>
<tr>
<td>Parameter</td>
<td>Specify the required input parameters in this window. If input parameters are not required for the execution of the target procedure, a message displays in this window, stating that the procedure “has no input parameters. Press execute to run it.”</td>
</tr>
<tr>
<td>Open</td>
<td>Click to open an existing *.prm file. The saved parameters immediately populate the dialog box upon opening.</td>
</tr>
<tr>
<td>Save</td>
<td>Click to save the values of your input parameters as a *.prm file. You can reopen a saved *.prm file from this dialog box at any time.</td>
</tr>
<tr>
<td>Reset</td>
<td>Click to reset the parameters in the Parameter window to their default values.</td>
</tr>
<tr>
<td>Continue</td>
<td>Click to execute the procedure once you have entered values for all required parameters in the Parameter window.</td>
</tr>
</tbody>
</table>
STEP OUT
After you open a debugging session, Step Out lets you execute the remainder of the dependent child object and resumes line-by-line, step-debugging in the parent object.

NOTE: Step Out is only active when the pointer indicates a child-dependent instruction.

Step Out
To use the Step Out facility, do the following:
1. On the Debug menu, click Step Out.

OR
On the DDL Editor toolbar, click Step Out.

OR
In the DDL Editor window, right-click and then click Step Out.

OR
Press SHIFT+F11.

Embarcadero SQL Debugger for Sybase ASE stops stepping through the current object and executes the remainder of the script.

STEP OVER
After you open a debugging session, Step Over lets you execute the current instruction without stepping into a nested child object if the instruction makes a call to a dependent object.

Step Over
To use the Step Over facility, do the following:
1. On the Debug menu, click Step Over.

OR
On the DDL Editor toolbar, click Step Over.

OR
In the DDL Editor window, right-click and then click Step Over.

OR
Press F10.

Embarcadero SQL Debugger for Sybase ASE executes the current instruction.
**RUN TO CURSOR**

After you [open a debugging session](#), Run to Cursor lets you execute all instructions between the yellow arrow and your cursor.

**Run to Cursor**

To use the Run to Cursor facility, do the following:

1. Scroll down from the yellow arrow to the target line.
2. Click the target line.
   
   Embarcadero SQL Debugger for Sybase ASE places the cursor on the target line.
3. On the Debug menu, click **Run to Cursor**.
   
   OR
   
   On the **DDL Editor** toolbar, click Run to Cursor.
   
   OR
   
   In the **DDL Editor window**, right-click and then click **Run to Cursor**.
   
   OR
   
   Press CTRL+F10.

   Embarcadero SQL Debugger for Sybase ASE executes all instructions between the yellow arrow and your cursor.

**INSERT OR REMOVE A BREAKPOINT**

A breakpoint is a position in a program where a debugger stops execution. When you start debugging, Embarcadero SQL Debugger for Sybase ASE opens the script in a DDL Editor window. A yellow pointer indicates which line the Debugger executes next. Embarcadero SQL Debugger for Sybase ASE executes all lines of code between the pointer and the first breakpoint. If no breakpoints are present, Embarcadero SQL Debugger for Sybase ASE debugs the entire script.

While debugging, you can set one or more breakpoints in the currently executing object or in any object in the program call stack. Breakpoints can be toggled (temporarily disabled or enabled) without having to remove or reinsert them. Embarcadero SQL Debugger for Sybase ASE displays each enabled breakpoint as a red dot in the left margin of the DDL Editor Window, and each disabled breakpoint as a red circle.

Rapid SQL stores all breakpoints you set so that when you debug the same script on separate occasions, you can reuse the same breakpoints each time.

After you [open a debugging session](#), you can insert a breakpoint on the line where your cursor is located, and you can remove a breakpoint on the line where your cursor is located.

**NOTE:** Script execution stops at the first breakpoint.
Inserting or Removing a Breakpoint
To insert or remove a breakpoint, do the following:

1. In the DDL Editor window, click the target line of SQL.
2. On the Debug menu, click Breakpoint.
   OR
   On the DDL Editor toolbar, click Breakpoint.
   OR
   In the DDL Editor window, right-click and then click Breakpoint.
   OR
   Press F9.

Embarcadero SQL Debugger for Sybase ASE inserts a new breakpoint or removes an existing breakpoint on the target line of code.

TOGGLE BREAKPOINT
After you open a debugging session and insert a breakpoint, Toggle Breakpoint lets you enable or disable that breakpoint. Embarcadero SQL Debugger for Sybase ASE displays each enabled breakpoint as a red dot in the left margin of the DDL Editor Window, and each disabled breakpoint as a red circle. You can toggle any breakpoint in the DDL Editor window. When you exit a debugging session and reenter it, the Embarcadero SQL Debugger for Sybase ASE retains any breakpoints you set.

Toggling a Breakpoint
To toggle a breakpoint, do the following:

1. In the DDL Editor window, click the line of the target breakpoint.
   OR
   On the DDL Editor toolbar, click Enable/Disable Breakpoint.
   OR
   In the DDL Editor window, right-click and then click Enable/Disable Breakpoint.
   OR
   Press CTRL+F9.

Embarcadero SQL Debugger for Sybase ASE toggles the breakpoint indicated by the pointer.
Go
After you open a debugging session, Go lets you execute all instructions, stopping only when it encounters a breakpoint or when the program is complete.

Go
To use the Go facility, do the following:

1. On the Debug menu, click Go.

   OR

   On the DDL Editor toolbar, click Go.

   OR

   In the DDL Editor window, right-click and then click Go.

   OR

   Press F5.

   Embarcadero SQL Debugger for Sybase ASE executes all instructions.

Stop
After you open a debugging session, Stop lets you halt the script execution and terminate the session.

Stop
To stop the debugger, do the following:

1. On the Debug menu, click Stop Debugging.

   OR

   On the DDL Editor toolbar, click Stop Debugging.

   OR

   In the DDL Editor window, right-click and then click Stop Debugging.

   OR

   Press SHIFT+F5.

   Embarcadero SQL Debugger for Sybase ASE stops the script execution and terminates the session.
RESTART
After you open a debugging session, Restart lets you terminate the current debug session and open a new one. When the new session opens, Rapid SQL prompts you for new input parameters.

Restart
To restart the debugger, do the following:

1. On the Debug menu, click Restart.
   OR
   On the DDL Editor toolbar, click Restart.
   OR
   In the DDL Editor window, right-click and then click Restart.
   OR
   Press CTRL+SHIFT+F5.

Embarcadero SQL Debugger for Sybase ASE restarts the debug session.

BREAK
After you open a debugging session, Break lets you pause the debug session.

Break
To pause the debugger, do the following:

1. On the Debug menu, click Break.
   OR
   On the DDL Editor toolbar, click Break.
   OR
   In the DDL Editor window, right-click and then click Break.

Embarcadero SQL Debugger for Sybase ASE suspends the debug session.

CLOSE
After you open a debugging session, Close lets you close the DDL Editor and Embarcadero SQL Debugger for Sybase ASE.
Close
To close the DDL Editor and debugger, do the following:

1. On the DDL Editor toolbar, click Close.
   - OR
   - In the upper right corner of the window, click Close.
   - OR
   - In the DDL Editor window, right-click and then click Close.

Embarcadero SQL Debugger for Sybase ASE closes the debug session.

Using Embarcadero SQL Debugger for Sybase ASE
This section offers a general overview of how to use Embarcadero SQL Debugger for Sybase ASE’s full range of debugging functionality. After you open a debugging session for any Sybase ASE procedure or trigger, you can begin debugging.

Opening a Debugging Session
When you open a debugging session, Rapid SQL opens the five windows of the Embarcadero SQL Debugger for Sybase ASE interface. If the target script requires input parameters, Rapid SQL opens a Procedure Execution dialog box and prompts you for the necessary input parameters before displaying the target code in the DDL Editor window. When Rapid SQL displays the target script in the DDL Editor window, you can begin debugging.

**NOTE:** Embarcadero SQL Debugger for Sybase ASE only lets you debug the SQL script of triggers and procedures.

Opening a Debugging Session
To debug a trigger or procedure, do the following:

1. On the Explorer Tab, click the node of the target procedure.
   - Rapid SQL opens the node and displays two items: Code and Privileges.
2. Under the target object node, double-click Code.
   - Rapid SQL opens an DDL Editor displaying the code of the target object.
3. On the Debug menu, click Start Debugging.

   OR

   On the DDL Editor toolbar, click Debug.

   OR

   In the DDL Editor window, right-click and then click Debug.

   OR

   Press CTRL+F5.

   If the script requests input parameters, Rapid SQL opens a Procedure Execution dialog box. If the script does not require input parameters, Rapid SQL displays the script in the DDL Editor window for you to begin debugging.

   NOTE: You cannot use Embarcadero SQL Debugger for Sybase ASE until it has fully initialized.

4. In the Procedure Execution dialog box, type the parameters, and then click OK.

   Rapid SQL displays the script in the DDL Editor window for you to begin debugging.

   NOTE: If the script requires Sybase ASE types (tables, records, or Booleans) as input parameters, Embarcadero SQL Debugger for Sybase ASE generates an anonymous block.

DEBUGGING AN SQL SCRIPT

After you open a debugging session and enter any required input parameters, you can begin working with your script in Embarcadero SQL Debugger for Sybase ASE.

Debugging an SQL Script

To debug a SQL script, do the following:

1. On the Debug menu, click an Embarcadero SQL Debugger for Sybase ASE option (Step Into, Step Over, and so forth) or click Go.

   OR

   On the DDL Editor toolbar, click an Embarcadero SQL Debugger for Sybase ASE option (Step Into, Step Over, and so on) or click Go.

   NOTE: You can monitor the progress of your debug session in the Variables window.
2 On the Debug menu, click Breakpoint.

OR

On the DDL Editor toolbar, click Breakpoint.

NOTE: When you set a breakpoint, the Call Stack window shows what was called before the breakpoint.

NOTE: You can use the Run to Cursor option to test the lines of code between a breakpoint and your cursor (indicated by the yellow arrow in the DDL Editor).

3 To check your variables, do the following:

1) In the DDL Editor, click a variable in your script and drag it to the Watch window.

2) In the Watch window, change the value of the watch variable and then click Go to run your script and see the results of the new value.

4 To check record in stored objects, do the following:

1) Drag the record to the Watch window.

2) In the Watch window, change the value of the record, then click Go to run your script and see the results of the new value.

5 To check the dependencies, do the following:

1) In the Dependency Tree window double-click the target dependent object to extract the code into a new DDL Editor.

2) Step through the script while monitoring the Dependency Tree window.

6 When you finish debugging the script, click Close.

Rapid SQL closes an Embarcadero SQL Debugger for Sybase ASE’s DDL Editor.

NOTE: When you exit a debug session and reenter it, Embarcadero SQL Debugger for Sybase ASE retains any watch variables or breakpoints you have set.

Rapid SQL PL/SQL Profiler

The Rapid SQL PL/SQL Profiler module lets you capture metrics of various PL/SQL programmable objects as they are executed in the database. Developers can use data collected in profile sessions to improve performance of PL/SQL code execution. Rapid SQL PL/SQL Profiler collects and stores data in database tables and helps identify and isolate performance problems, and provide code coverage information. The Rapid SQL PL/SQL Profiler lets you:

- Graphically browse PL/SQL profiling data within the Explorer Tab
- View profiling data in the right pane of the application, which is populated as you navigate the Explorer Tab
- Start and stop PL/SQL profiling sessions with a single click
- Graphically analyze time spent in each programmable object (unit)
• Graphically analyze time spent in each source code line of a unit

The table below describes the sections of this chapter:

<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Setting Up the Profiler</td>
<td>This section describes the process of setting up Rapid SQL PL/SQL Profiler.</td>
</tr>
<tr>
<td>Profiler Functionality</td>
<td>This section describes the functionality of Rapid SQL PL/SQL Profiler.</td>
</tr>
<tr>
<td>Using the Profiler</td>
<td>This section describes how to run a profile session.</td>
</tr>
</tbody>
</table>

**NOTE:** Availability of this feature depends on your Rapid SQL licensing. For more information, see Licensing.

For more information, see:

• Setting Up Rapid SQL PL/SQL Profiler
• Rapid SQL PL/SQL Profiler Explorer
• Rapid SQL PL/SQL Profiler Functionality
• Using Rapid SQL PL/SQL Profiler

**SETTING UP RAPID SQL PL/SQL PROFILER**

The profiling tables must be on the server before using the Rapid SQL PL/SQL Profiler. The first time you open the PL/SQL Profiler, Rapid SQL checks the server for the profiling tables. If the profiling tables are not on the server, Rapid SQL automatically installs profiling tables on the server.

**RAPID SQL PL/SQL PROFILER EXPLORER**

The Rapid SQL PL/SQL Profiler displays profiling data in the right pane of the application, which is populated as you navigate the Explorer Tab.

The table below describes the nodes of the Rapid SQL PL/SQL Profiler Explorer and the corresponding information in the right pane of the application:

<table>
<thead>
<tr>
<th>Node</th>
<th>Right pane information</th>
</tr>
</thead>
<tbody>
<tr>
<td>PL/SQL Code Profiling</td>
<td>Contain all Comment, Run ID and Run Date\time data that is current stored in the Profiling tables.</td>
</tr>
<tr>
<td>Label\Comment level</td>
<td>Contains all Run ID and Run Date\time data for the specific Label\Comment.</td>
</tr>
</tbody>
</table>
RAPID SQL PL/SQL PROFILER FUNCTIONALITY

Rapid SQL PL/SQL Profiler offers you the following functionality:

- **Start**
- **Flush**
- **Run Summary**
- **Run Detail**
- **Unit Summary**
- **Unit Detail**
- **Clear Profile Table**
- **Stop**

**START**

Rapid SQL PL/SQL Profiler lets you begin a new profiling session or open a previous profiling session with the Start command.

**Starting a New Profile Session**

To start a new Profiler session, do the following:

1. On the Tools menu, click PL/SQL Profiler and then click Start.

   OR

   On the PL/SQL Profiler toolbar, click Execute.

   OR

   On the Explorer Tab, right-click the PL/SQL Code Profiling node, and then click Start.

   Rapid SQL opens the PL/SQL Profiler - Start dialog box.

2. In the Profile Label box, type the name of the new profile.
   
   **NOTE:** Each user can own one or more Profiles.

3. Click OK to begin profiling.
Starting an Existing Profile Session

To start an existing Profiler session, do the following:

1. On the Explorer Tab, expand the PL/SQL Code Profiling node. Rapid SQL displays the list of existing Profiles.

2. On the Tools menu, click PL/SQL Profiler, and then click Start.
   OR
   On the PL/SQL Profiler toolbar, click Execute.
   OR
   On the Explorer Tab, right-click the PL/SQL Profiler node, and then click Start.
   OR
   On the Explorer Tab, right-click the target Profile, and then click Start.
   Rapid SQL opens the PL/SQL Profiler - Start dialog box.

3. Click the Profile Label list and then click the existing profile.

4. Click OK to begin profiling.

FLUSH

Rapid SQL PL/SQL Profiler lets you move the data from the dynamic tables into Analysis tables with the Flush command.

Flushing a Profile

To flush a Profile, do the following:

1. On the Tools menu, click PL/SQL Profiler and then click Flush.
   OR
   On the PL/SQL Profiler toolbar click Flush.
   OR
   On the Explorer Tab, right-click the PL/SQL Code Profiling node, and then click Flush.
   Rapid SQL opens the PL/SQL Profiler - Flush dialog box.

2. In the PL/SQL Profiler - Flush dialog box:
   • Click Flush to delete the data in a running profile.
   • Click Flush & Analyze to open the PL/SQL Profiler Run Detail window.
   • Click Cancel to abort the flush and continue the profiling session.
   
   NOTE: You can only Flush a running Profile.
**RUN SUMMARY**
The Rapid SQL PL/SQL Profiler Run Summary window lets you view the following information for each of your profiles:

- Run ID
- Run Date
- Total Time

**Opening the Run Summary Window**
To open the Run Summary Window, do the following:

1. On the Explorer Tab, expand the PL/SQL Code Profiling node.
   Rapid SQL displays the list of existing Profiles.
2. On the Tools menu, click PL/SQL Profiler, and then click Run Summary.
   On the PL/SQL Profiler toolbar click Run Summary.
   On the Explorer Tab, right-click the PL/SQL Profiler node, and then click Run Summary.
   On the Explorer Tab, right-click the target *Profile*, and then click Run Summary.
3. Rapid SQL opens the PL/SQL Profiler - Run Summary window.
4. Click the *Profile Label* list, and then click the target profile.

**RUN DETAIL**
The Rapid SQL PL/SQL Profiler Run Detail window lets you view the following information for each of your profiles:

- Run Number
- Run Date
- Run Time

The Rapid SQL PL/SQL Profiler lets you view the information for all runs or you can view profile information based on the unit type or unit owner.

The Rapid SQL PL/SQL Profiler Run Detail window lets you view results in milliseconds, seconds and minutes. The Run Detail window also contains graphical displays of the profiling data that you can go to the specific unit within the summary portion of the window.
Opening the Run Detail Window
To open the Run Detail Window, do the following:

1. On the Explorer Tab, expand the PL/SQL Code Profiling node. Rapid SQL displays the list of existing Profiles.
2. On the Tools menu, click PL/SQL Profiler and then click Run Detail.
   OR
   On the PL/SQL Profiler toolbar click Run Detail.
   OR
   On the Explorer Tab, right-click the PL/SQL Code Profiling node and then click Run Detail.
   OR
   Right-click the target run and then click Run Detail.
   OR
   In a PL/SQL Profiler - Run Summary window right-click and then click Detail.
   OR
   In a PL/SQL Profiler - Unit Summary window right-click and then click Detail.
Rapid SQL opens the PL/SQL Profiler - Run Detail window.

3. In the PL/SQL Profiler - Run Detail window:
   • Click the Label list box and then click the target profile.
   • Click the Run list and then click the target run.
   • Click the Unit Type list and then click the target unit type(s).
   • Click the Unit Owner list and then click the target unit owner(s) to populate the table.

UNIT SUMMARY
The Rapid SQL PL/SQL Profiler Unit Summary window lets you view the following information for each of your profiles:

• Run ID
• Run Date
• Run Time
• Unit Time
• Percentage of Run Time
The Rapid SQL PL/SQL Profiler Unit Summary window lets you view results in milliseconds, seconds and minutes. The Unit Summary window also displays graphs of execution statistics for the top N runs and associated units. You can use the graphical displays to go to the specific run within summary portion of the window.

Opening the Unit Summary Window
To open the Unit Summary Window, do the following:

1. On the Tools menu, click PL/SQL Profiler, and then click Unit Summary.

OR

On the PL/SQL Profiler toolbar click Unit Summary.

OR

On the Explorer Tab, right-click the PL/SQL Code Profiling node, and then click Unit Summary.

Rapid SQL opens the PL/SQL Profiler - Unit Summary window.

2. In the PL/SQL Profiler - Unit Summary window:
   - Click the Unit Owner list and then click the target unit owner.
   - Click the Unit Name list and then click the target unit name to populate the table.

CLEAR PROFILE TABLE
Rapid SQL PL/SQL Profiler lets you delete data from the user’s profile tables with the command Clear Profile Table.

Clearing a Profile Table
To clear a profile table, do the following:

1. On the Tools menu, click PL/SQL Profiler, and then click Clear Profile Table.

OR

On the PL/SQL Profiler toolbar, click Clear Profile Table.

OR

On the Explorer Tab, right-click the PL/SQL Code Profiling node, and then click Clear Profile Table.

Rapid SQL clears the profile table.

2. In the dialog box, if you are sure that you want to clear out the profiler tables, click Yes.
UNIT DETAIL
The Rapid SQL PL/SQL Profiler Unit Detail window lets you view the following information for each of your profiles:

- Average Time
- Source
- PL/SQL Script

The Rapid SQL PL/SQL Profiler Unit Detail window lets you view results in milliseconds, seconds and minutes. The Unit Detail window also provides two calculation options for viewing unit execution time as a percentage of total execution time (total run vs unit run). The Rapid SQL PL/SQL Profiler Unit Detail window also displays graphs of execution statistics for the top N run. You can use the graphical displays to go to the specific line within source code portion of the window. The graphical display portion of the window contains options for viewing advanced statistics.

The Advanced View of the Rapid SQL PL/SQL Profiler Unit Detail window, lets you view the following information for each of your profiles:

- Hit Lines
- Missed Lines
- Line Number
- Calls
- Total Time
- Percentage of the Total Time
- Average Time
- Minimum Time
- Maximum Time

Opening the Unit Detail Window
To open the Unit Detail Window, do the following:

1. On the Explorer Tab, expand the PL/SQL Code Profiling node.
   Rapid SQL displays the list of existing Profiles.
2 On the Tools menu, click PL/SQL Profiler and then click Unit Detail. OR
   On the PL/SQL Profiler toolbar click Unit Detail. OR
   On the Explorer Tab, right-click the PL/SQL Code Profiling node and then click Unit Detail. OR
   Right-click the target run and then click Unit Detail. OR
   In a PL/SQL Profiler - Run Summary window right-click and then click Unit Detail. OR
   In a PL/SQL Profiler - Unit Summary window right-click and then click Unit Detail.
   Rapid SQL opens the PL/SQL Profiler - Unit Detail window.

3 In the PL/SQL Profiler - Unit Detail window, do any of the following:
   • Click the Label list and then click the target profile.
   • Click the Run list and then click the target run.
   • Click the Unit list and then click the target unit to populate the table.
   • Right-click and then click Show Only Hit Lines to populate the table with the Average Time and Source for hit lines.
   • Right-click and then click Show Only Missed Lines to populate the table with the Average Time and Source for missed lines.

Opening the Unit Detail Window Advanced View
To open the Unit Detail Window Advanced View, do the following:

1 In the Unit Detail table, right-click and then click Advanced View to populate the table with advanced view information.

STOP
Rapid SQL PL/SQL Profiler command Stop pauses the data gathering operation. Stop & Analyze populates the summary tables so you can view the Unit Detail and Run Summary windows.
Stopping a Profiling Session
To stop a Profiling session, do the following:
1. On the Tools menu, click PL/SQL Profiler and then click Stop.
   OR
   On the PL/SQL Profiler toolbar click Stop.
   OR
   On the Explorer Tab, right-click the PL/SQL Code Profiling node, and then click Stop.
   Rapid SQL opens the PL/SQL Profiler - Stop dialog box.
2. In the PL/SQL Profiler - Stop dialog box:
   • Click Stop to stop the profiling session.
   • Click Stop & Analyze to open the PL/SQL Profiler Run Detail window.
   • Click Cancel to continue the profiling session.

USING RAPID SQL PL/SQL PROFILER
The steps below provide a high level overview of running a profiling session:
• Starting the Session
• Executing the Sample Script
• Stopping and Analyzing the Session
For more information, see Sample Profiling Session.

Using the Rapid SQL PL/SQL Profiler

NOTE: The first execution of a PL/SQL unit can take more time to execute because the code is loading into memory; subsequent runs take less time.

To use the Profiler, do the following:
1. On the Tools menu, click PL/SQL Profiler and then click Start.
   OR
   On the PL/SQL Profiler toolbar, click Start.
   Rapid SQL opens the PL/SQL Profiler - Start dialog box.
2. In the Profile Label box, enter the name of the new profile.
   NOTE: Each user can own one or more Profiles.
3 Click OK.
   Rapid SQL begins profiling.

4 In the Explorer Tab, execute one of the following PL/SQL database objects:
   • Procedure
   • Function
   • Package Procedure
   • Package Function
   Profiler displays profiling data in the right pane of the application.

5 On the Tools menu, click PL/SQL Profiler and then click Stop.
   Rapid SQL opens the PL/SQL Profiler - Stop dialog box.

6 In the PL/SQL Profiler - Stop dialog box, do any of the following:
   • Click Stop to stop the profiling session.
   • Click Stop & Analyze to open the PL/SQL Profiler Run Detail window.
   • Click Cancel to continue the profiling session.

7 If you clicked Stop & Analyze do the following:
   • Click the Label list and then click the target profile.
   • Click the Run list and then click the target run.
   • Click the Unit Type list and then click the target unit type(s).
   • Click the Unit Owner list and then click the target unit owner(s) to populate the table.

8 Use the Tools menu to open any of the following PL/SQL Profiler windows:
   • PL/SQL Profiler Run Summary
   • PL/SQL Profiler Unit Summary
   • PL/SQL Profiler Unit Detail

SAMPLE PROFILING SESSION
The Rapid SQL installation includes two scripts for the sample profiling session:
   • PROFILER_BUILD_DEMO.SQL
   • PROFILER_DEMO.SQL

The PROFILER_BUILD_DEMO.SQL creates the objects that you will profile in the walk-through, and the PROFILER_DEMO.SQL is what you will profile during the walk-through.

   NOTE: To create the objects in the PROFILER_BUILD_DEMO.SQL script, you must have CREATE privileges.
The sample script demonstrates the following features of the Rapid SQL PL/SQL Profiler:

- Unit Detail
- Run Detail
- Show Only Hit Lines
- Advanced View

During the installation, Rapid SQL places the scripts in the configured, default user SQL scripts folder. For details, see Directories Options.

Overview

Sample Profiling Session is divided into six parts:

- Getting Started
- Starting the Session
- Executing the Sample Script
- Stopping the Session
- Rerunning & Reexecuting the Session
- Stopping & Analyzing

SAMPLE PROFILING SESSION - GETTING STARTED

In this step of Sample Profiling Session, you create the objects that you will profile in the walkthrough.

Overview

The Getting Started section guides you through:

- Opening PROFILER_BUILD_DEMO.SQL
- Changing the Explorer tab Display
- Confirming the Creation of the Package

Getting Started

1. Start Rapid SQL.
2. On the File menu, click Open. Rapid SQL opens the Open Files dialog box.

**NOTE:** The sample file used in this example, PROFILER_BUILD_DEMO.SQL, is stored in the configured user SQL scripts folder. For details, see Directories Options.
3 In the Open File(s) dialog box, navigate to the user SQL scripts folder and open the PROFILER_BUILD_DEMO.SQL file.

Rapid SQL opens the PROFILER_BUILD_DEMO.SQL script in an SQL Editor window.

4 On the SQL Editor window, click Execute.

Rapid SQL executes the script and creates the package.

5 On the Explorer Tab list, click Organize by Owner.

6 On the Explorer Tab, click the node of your owner name.

Rapid SQL displays your schema objects.

7 Double-click the Packages node to display PF_COUNT_TIME_INTERVAL and confirm its creation.

**NOTE:** If you were not able to create the package, check the error messages to determine the problem.

**SAMPLE PROFILING SESSION - STARTING THE SESSION**

In this step of Sample Profiling Session, you start the profiling session.

**Sample Profiling Session - Starting the Session**

To start the session, do the following:

1 On the File Menu, click Open to open the Open Files dialog box.

2 In the Open Files dialog box, type the path to the UsrScrpt directory, press ENTER and then double-click PROFILER_DEMO.SQL to open the script in an SQL Editor.

Rapid SQL opens the PROFILER_DEMO.SQL script in an SQL Editor.

3 On the Tools menu, click PL/SQL Profiler and then click Start.

Rapid SQL opens the PL/SQL Profiler - Start dialog box.

4 In the Profile Label list, type DemoProfile.

5 Click OK to begin the profiling session.

Rapid SQL begins the profiling session.

If this is the first time you start the Rapid SQL PL/SQL Profiler, Rapid SQL displays a message that user profiling tables need to be installed.

6 Click Yes.

Rapid SQL opens SQL*Plus to create the tables. You will need to start the profiling session again (see Step 3).
SAMPLE PROFILING SESSION - EXECUTING THE SAMPLE SCRIPT
In this step of Sample Profiling Session, you execute the DEMO script.

Sample Profiling Session - Executing the Sample Script
To execute the sample script, do the following:
1. On the SQL Editor window toolbar, click Execute.
   Rapid SQL executes the script and opens a Results Tab.

SAMPLE PROFILING SESSION - STOPPING THE SESSION
In this step of Sample Profiling Session, you stop the profiling run.

Sample Profiling Session - Stopping the Session
To stop the session, do the following:
1. On the Tools menu, click PL/SQL Profiler and then click Stop.
   Rapid SQL opens the PL/SQL Profiler - Stop dialog box.
2. Click Stop.

SAMPLE PROFILING SESSION - RERUNNING & REEXECUTING THE SESSION
In this step of Sample Profiling Session, you run the same profile session and execute the DEMO script again.

Sample Profiling Session - Rerunning & Reexecuting the Session
To rerun and reexecute the session, do the following:
1. In the SQL Editor, click the Query Tab.
2. On the Tools menu, click PL/SQL Profiler and then click Start.
   Rapid SQL opens the PL/SQL Profiler - Start dialog box again.
3. Click the down arrow on the Profile Comment list and then click DemoProfile.
4. Click OK to begin the profiling session.
5. On the SQL Editor toolbar, click Execute.
   Rapid SQL executes the script again and opens the Results Tab.

SAMPLE PROFILING SESSION - STOPPING & ANALYZING
In this step of Sample Profiling Session, you stop profiling and analyze the runs.
Sample Profiling Session - Stopping & Analyzing

To stop and analyze, do the following:

1. On the Tools menu, click PL/SQL Profiler and then click Stop.
   
   Rapid SQL opens the PL/SQL Profiler - Stop dialog box again.

2. Click Stop & Analyze.
   
   Rapid SQL opens the PL/SQL Profiler - Run Detail window.

3. Click the Run list and then click Run#x.

   NOTE: Rapid SQL assigns a number to each profiling session. These numbers increase incrementally each time you run a profiling session. x= the number that was assigned to your first run.

   Rapid SQL PL/SQL Profiler populates the grid with information on the procedure, package body, and package specification.

   NOTE: For the purposes of this walk-through we have created this package under the account SCOTT.

4. Click the Run list again and then click the Run# for your second run.

   Notice this time there is no information on the package specification. It was created in the first run.

5. Right-click and then click Detail.

   Rapid SQL PL/SQL Profiler opens the PL/SQL Profiler - Unit Detail window and populates the grid with the average time to execute each unit and the source code. Notice the time to execute SELECT object_name, in the example is 126 ms.

6. In the PL/SQL Profiler - Unit Detail window, click the Run list and then click Run#x for your first run.

7. Click the Unit list and then click user name.PL_COUNT_SYSTEM_OBJECTS.

   Notice the time to execute SELECT object_name is considerably greater: in the example it is 24476 ms.

8. Right-click and then click Show Only Hit Lines.

   THE RAPID SQL PL/SQL PROFILER SHOWS ONLY THE LINES OF CODE THAT EXECUTED.

9. Right-click and then click Advanced View.

   The Rapid SQL PL/SQL Profiler opens the Advanced View window.

10. Continue clicking the Run and Unit lists to compare the performance of each run and each session.

This concludes the Sample Profiling Session. You can now delete the objects created during the Sample Profiling Session. They are:

- Check Constraints, PLSQL_PROFILER_UNITS, PLSQL_PROFILER_DATA
• Foreign Keys, PLSQL_PROFILER_UNITS, PLSQL_PROFILER_DATA

• Package, PF_COUNT_TIME_INTERVAL

• Package functions, WEEKEND_DAYS_(), WORKING_DAYS_(), YEAR

• S_ELAPSED_BETWEEN_()

• PL/SQL code Profiles, DemoProfile

• Primary Keys, PLSQL_PROFILER_RUNS, PLSQL_PROFILER_UNITS, PLSQL_PROFILER_DATA

• Procedure, PF_COUNT_SYSTEM_OBJECTS

• Sequence, PLSQL_PROFILER_RUNNUMBER

• Tables, PLSQL_PROFILER_RUNS, PLSQL_PROFILER_UNITS, PLSQL_PROFILER_DATA
CODE ANALYST

The Code Analyst is a tool to identify time-consuming lines of code. Code Analyst lets you:

- Perform detailed response time analysis on the execution of Procedures and External Functions.
- Benchmark the execution of one or more procedures or functions to determine exactly what code objects and lines of code are taking the longest to run.
- Save response time metrics and perform intelligent compares against current execution times so you can determine deviations from previous acceptable response times.

**TIP:** You can set Code Analyst options in the Code Analyst Options.

**NOTE:** Availability of this feature depends on your Rapid SQL licensing. For more information, see Licensing.

Important Notes

- For DB2, before profiling with Code Analyst, Compile all procedures with the debugging option selected.
- For Oracle, when using the Oracle Debugger, Compile all procedures with the debugging option selected before profiling with Code Analyst.

Common Tasks

- [Creating a Code Analyst Session](#)
- [Identifying and Fixing Bottlenecks Using Code Analyst](#)
- [Comparing Code Analyst Sessions](#)
- [Cloning a Code Analyst Session](#)
- [Deleting a Code Analyst Session](#)
- [Stopping a Code Analyst Session Execution](#)
- [Executing a Code Analyst Session](#)
- [Scheduling a Code Analyst Session](#)
- [Unscheduling a Code Analyst Session](#)
- [Refreshing a Code Analyst Session](#)
- [Saving Results in Code Analyst](#)
- [Printing Results in Code Analyst](#)
- [Viewing Run Details in Code Analyst](#)
- [Viewing Unit Summary Information in Code Analyst](#)
**CODE ANALYST DBMS NOTES**

Code Analyst is available for:

- Microsoft SQL Server
- Oracle 7
- IBM DB2 LUW
- Sybase ASE 12.0.0.3 or later

Rapid SQL utilizes debugger technology to capture the data for each line of executed code. For Oracle, you can use the debugger or using Oracle’s supplied DBMS_Profiler package.

**TIP:** For Oracle, you can specify to use the debugger or the DBMS_Profiler package on the Code Analyst Options.

The Code Analyst will step through each line of code, stopping to record data for those lines of code onto which a breakpoint can be issued. Some debuggers cannot capture time metrics for all lines of a stored procedure or function.

Procedures and functions that contain looping constructs will require more time to run. The additional amount of time needed to run is proportional to the number of iterations in the loop.

For more information, see:

- IBM DB2 LUW Data Captured by Code Analyst
- Microsoft SQL Server Data Captured by Code Analyst
- Oracle Data Captured by Code Analyst
- Sybase ASE Data Captured by Code Analyst

**IBM DB2 LUW DATA CAPTURED BY CODE ANALYST**

Code Analyst utilizes the IBM Debugger when capturing time data.

The debugger is verified to run on IBM DB2 LUW version 7.2 and up. There is a known issue running version 7.2 with Fixpack 9.

DB2 has documented limitations on lines of code that can be profiled.
The following are SQL statements that are NOT valid break point lines:

BEGIN
BEGIN
BEGIN NOT ATOMIC
BEGIN ATOMIC
CLOSE CURSOR
DECLARE cursor WITH RETURN FOR <sql statement>
DECLARE , var without default
DECLARE CONDITION (CONDITION) FOR SQLSTATE (VALUE) "..."
DECLARE CONTINUE HANDLER
DECLARE CURSOR
DECLARE EXIT HANDLER
DECLARE RESULT_SET_LOCATOR [VARYING]
DECLARE SQLSTATE
DECLARE SQLCODE (unless there is a default)
DECLARE UNDO HANDLER (unless they are entered)
DO
ELSE
END
END CASE
END IF
END FOR
END REPEAT
END WHILE
ITERATE
LEAVE
LOOP
OPEN CURSOR
REPEAT (as a keyword alone)
RESIGNAL
SIGNAL

THEN

labels, e.g. P1:

**NOTE:** Code containing these statements will not have times associated with them.

For more information, see [Code Analyst DBMS Notes](#).

**MICROSOFT SQL SERVER DATA CAPTURED BY CODE ANALYST**

In order to execute a Code Analyst session against a Microsoft SQL Server database, the SQL Server debugger must be installed and functioning properly. Please refer to [Embarcadero SQL Debugger for Microsoft SQL Server](#) for details concerning set up.

**Related Information**

[Code Analyst DBMS Notes](#)

**ORACLE DATA CAPTURED BY CODE ANALYST**

When using the PL/SQL Profiler, Oracle has documented an issue regarding extremely large times being returned by the profiler. The times are sometimes hundred times larger than the actual run time of the stored procedure or function. Oracle documents that this is a vendor/os problem rather than an Oracle problem, because the RDTSC instruction is reporting wrong time stamp counter. They indicate that they have seen this problem on some INTEL Pentium processors.

**Related Information**

[Code Analyst DBMS Notes](#)

**SYBASE ASE DATA CAPTURED BY CODE ANALYST**

Sybase has documented a problem with their debugger API. The problem involves reporting the wrong line number through the debugger. Because of this bug, Code Analyst may report back data for blank lines or lines that contain comments. Sybase has fixed this problem release 12.5.2 of the database. All procedures affected must be dropped and recreated in order to correct the problem.

**Related Information**

[Code Analyst DBMS Notes](#)
CODE ANALYST REQUIREMENTS

Debuggers
The Code Analyst uses fully configured Embarcadero SQL Debuggers to profile, and therefore availability of this feature depends on your Rapid SQL licensing. For more information, see the following topics:

- Licensing
- Rapid SQL Add-On Tools

Using Code Analyst with the Oracle Profiler
Oracle users have the option of either using the Oracle Debugger or the Oracle Profiler with Code Analyst to capture statistics. To use Code Analyst with the profiler option, Oracle’s profiler package must be installed. The install is user specific, so it must be installed by each user wishing to use Code Analyst. To install the package, users can invoke the Rapid SQL PL/SQL Profiler.

**TIP:** You can set profiler options in the Code Analyst Options. You can specify that Code Analyst display the actual run time on the database, and does not include the time it takes to get to the server.

Privileges
For Oracle, SYS privileges are required to install the Code Analyst tables. If you do not have SYS privileges, ask your Server Administrator to log into the Oracle datasource as SYSDBA, and then open Code Analyst to install the tables.

During install, the following privileges are set for the Code Analyst tables.

- DB2 – Permissions are granted to the Public Group
- Oracle – Permissions are granted to the Public group.
- Microsoft SQL Server – Permissions are granted to the Public role.
- Sybase ASE – Permissions are granted to the Public group.

All users can use the Code Analyst but each user will only see their own run ids. Users need to belong to the public group.

**TIP:** You can check this/modify privileges in the Users Editor.

INSTALLING CODE ANALYST
To install Code Analyst, do the following:

2. In Select the database you would like to install the tables on, select a database.
3 For IBM DB2 LUW for Open Systems, in select the tablespace you would like to install the tables on, select a tablespace.

4 For IBM DB2 LUW for Open Systems, in select the schema you would like to install the tables on, select a schema. The default is EMBTCA schema.

5 In Select the filegroup you would like to install the tables to, select a filegroup.

Code Analyst installs the following repository tables in the repository:

- EMBT_CODE_ANA_RUNS - Holds all the code analyst sessions created by users.
- EMBT_CODE_ANA_UNITS - Holds all the objects to be run for all.
- EMBT_CODE_ANA_PARAMS - Contains all the parameters for the objects that were run.
- EMBT_CODE_ANA_DATA - Contains the run data and is used to populate all the charts and statistics.
- EMBT_CODE_ANA_VERSION - Contains the version number of code analyst.

Code Analyst opens to the Run Summary tab.

6 Create a session using the Creating a Code Analyst Session.

**UNINSTALLING CODE ANALYST**

The Uninstall functionality lets you uninstall Code Analyst from the server.

NOTE: To uninstall a repository table, you need create table and grant privileges. Generally, you need sysadmin privileges.

1 On the Tools menu, select Code Analyst.

2 Select a session or object, and then select Uninstall.

Code Analyst removes the repository tables in the repository:

- EMBT_CODE_ANA_RUNS - Holds all the code analyst sessions created by users.
- EMBT_CODE_ANA_UNITS - Holds all the objects to be run for all.
- EMBT_CODE_ANA_PARAMS - Contains all the parameters for the objects that were run.
- EMBT_CODE_ANA_DATA - Contains the run data and is used to populate all the charts and statistics.
- EMBT_CODE_ANA_VERSION - Contains the version number of code analyst.
CODE ANALYST PRODUCT DESIGN

Code Analyst performs detailed response time analysis. Code Analyst steps through each line of code and profiles those lines of code that the debugger or profiler can capture time metrics for.

**NOTE:** Some debuggers do not capture time metrics for all lines of a procedure or function. For more information, see Code Analyst DBMS Notes.

After capturing the time metrics, Code Analyst displays the data in an easy-to-read format on the tabs.

The Code Analyst is comprised of the following tabs:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Run Summary</td>
<td>Session</td>
<td>Lets you select the run session(s).</td>
</tr>
<tr>
<td></td>
<td>Session</td>
<td>Displays the name of the session as created by the user.</td>
</tr>
<tr>
<td></td>
<td>Run ID</td>
<td>Displays the run ID for the run(s). This number is system generated.</td>
</tr>
<tr>
<td></td>
<td>Run Date</td>
<td>Displays the time and date of the session.</td>
</tr>
<tr>
<td></td>
<td>Total Profile Time (ms)</td>
<td>Displays the total time taken for the profiled code to execute. This time is limited to the lines of code that are profiled. Overhead is not included in this calculation.</td>
</tr>
<tr>
<td></td>
<td>Total Analysis Time</td>
<td>Displays the total time taken for the session to complete, including all overhead time needed to analyze the procedure or function.</td>
</tr>
<tr>
<td></td>
<td>Scheduler</td>
<td>Displays the scheduler used to schedule the session. This information displays until the scheduled job has been run.</td>
</tr>
<tr>
<td>Run Detail</td>
<td>Session</td>
<td>Lets you select the object execution session.</td>
</tr>
<tr>
<td></td>
<td>Run</td>
<td>Lets you select the object execution.</td>
</tr>
<tr>
<td></td>
<td>Unit Type</td>
<td>Lets you select the object type for the object execution.</td>
</tr>
<tr>
<td></td>
<td>Unit Owner</td>
<td>Lets you select the object owner for the object execution.</td>
</tr>
<tr>
<td></td>
<td>Unit Database</td>
<td>Lets you select the object database for the object execution.</td>
</tr>
<tr>
<td></td>
<td>Time Unit</td>
<td>Lets you specify the time unit for the Unit Execution graph.</td>
</tr>
<tr>
<td></td>
<td>Unit Owner</td>
<td>Displays the owner of the procedure or function.</td>
</tr>
<tr>
<td></td>
<td>Unit Name</td>
<td>Displays the name of the procedure or function.</td>
</tr>
<tr>
<td></td>
<td>Unit Type</td>
<td>Displays the types of captured objects, including Anonymous Block, Function, Package Body, and Procedure for Oracle databases. Also displays SQL Statement and Procedure for the other platforms.</td>
</tr>
<tr>
<td></td>
<td>Unit Database</td>
<td>Displays the database on which the object is stored.</td>
</tr>
<tr>
<td></td>
<td>Total Profiled Time</td>
<td>Displays the total time taken for the profiled code to execute.</td>
</tr>
<tr>
<td></td>
<td>% of Profiled Time</td>
<td>Displays the percentage of the Total Profiled Time for the run that this unit accounts for.</td>
</tr>
<tr>
<td>Comparison</td>
<td>Base Run</td>
<td>Lets you select the earlier object execution.</td>
</tr>
<tr>
<td>Tab</td>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>-----------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>New Run</td>
<td></td>
<td>Lets you select the later object execution.</td>
</tr>
<tr>
<td>Unit Owner</td>
<td></td>
<td>Displays the owner of the procedure or function.</td>
</tr>
<tr>
<td>Unit Name</td>
<td></td>
<td>Displays the name of the procedure or function.</td>
</tr>
<tr>
<td>Unit Type</td>
<td></td>
<td>Displays the types of captured objects, including Anonymous Block, Function, Package Body, and Procedure for Oracle databases. Also displays SQL Statement and Procedure for the other platforms.</td>
</tr>
<tr>
<td>Unit Database</td>
<td></td>
<td>Displays the object database for the object execution.</td>
</tr>
<tr>
<td>Time Diff</td>
<td></td>
<td>Displays the time difference in milliseconds between the base run and the new run.</td>
</tr>
<tr>
<td>New Profiled Time</td>
<td></td>
<td>Displays the profiled time of the new run.</td>
</tr>
<tr>
<td>Base Profiled Time</td>
<td></td>
<td>Displays the profiled time of the base run.</td>
</tr>
<tr>
<td>Unit Summary</td>
<td>Unit Owner</td>
<td>Lets you select the object owner for the session(s).</td>
</tr>
<tr>
<td></td>
<td>Unit Name</td>
<td>Lets you select the object name for the session(s).</td>
</tr>
<tr>
<td></td>
<td>Unit Database</td>
<td>Lets you select the object database for the session(s).</td>
</tr>
<tr>
<td></td>
<td>Number of Top Runs</td>
<td>Lets you specify the number of top object executions to display in the Top 5 Runs graph and select the unit of time for the Unit Time graph.</td>
</tr>
<tr>
<td></td>
<td>Session</td>
<td>Displays the name of the session as created by the user.</td>
</tr>
<tr>
<td></td>
<td>Run ID</td>
<td>Displays the unique id for the Run. This number is system generated.</td>
</tr>
<tr>
<td></td>
<td>Run Date</td>
<td>Displays the time and date of the session.</td>
</tr>
<tr>
<td></td>
<td>Total Analysis Time</td>
<td>Displays the total time taken for the session to complete, including all overhead time needed to analyze the procedure or function.</td>
</tr>
<tr>
<td></td>
<td>Total Profiled Time</td>
<td>Displays the total time taken for the profiled code to execute.</td>
</tr>
<tr>
<td></td>
<td>Unit Profiled Time</td>
<td>Displays the unit time for the session(s).</td>
</tr>
<tr>
<td></td>
<td>% of Profiled Time</td>
<td>Displays the percentage of the Total Profiled Time for the run that this unit accounts for.</td>
</tr>
<tr>
<td></td>
<td>% of Run Time</td>
<td>Displays the percentage of object execution time for the session(s).</td>
</tr>
<tr>
<td>Unit Detail</td>
<td>Session</td>
<td>Lets you select the session.</td>
</tr>
<tr>
<td></td>
<td>Run</td>
<td>Lets you select the object execution.</td>
</tr>
<tr>
<td></td>
<td>Unit Name</td>
<td>Lets you select the object name for the session.</td>
</tr>
<tr>
<td></td>
<td>Number of Top Lines</td>
<td>Lets you specify the number of top lines in the Top 5 Lines Execution Time graph and select the total time units.</td>
</tr>
<tr>
<td></td>
<td>Percentage Calculation</td>
<td>Lets you specify total object execution time or object run time.</td>
</tr>
<tr>
<td></td>
<td>Calls</td>
<td>Displays the number of times the line was executed.</td>
</tr>
<tr>
<td></td>
<td>Total Time</td>
<td>Displays the total time the line was executed.</td>
</tr>
<tr>
<td></td>
<td>% of Total Profiled</td>
<td>Displays the percentage of the Total Profiled Time that this line of code was responsible for.</td>
</tr>
</tbody>
</table>
CODE ANALYST

Common Tasks

Creating a Code Analyst Session
Identifying and Fixing Bottlenecks Using Code Analyst
Comparing Code Analyst Sessions
Cloning a Code Analyst Session
Deleting a Code Analyst Session
Stopping a Code Analyst Session Execution
Executing a Code Analyst Session
Scheduling a Code Analyst Session
Unscheduling a Code Analyst Session
Refreshing a Code Analyst Session
Saving Results in Code Analyst
Printing Results in Code Analyst
Viewing Run Details in Code Analyst
Viewing Unit Summary Information in Code Analyst
Viewing Unit Details in Code Analyst
Setting View Options for the Unit Detail Tab in Code Analyst
Extracting SQL Text in Code Analyst
Executing SQL in Code Analyst

CODE ANALYST TUTORIAL

The following tutorial guides you through the process of using the Code Analyst.

<table>
<thead>
<tr>
<th>Tab</th>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Avg Time</td>
<td>Displays the average profiled time for this line.</td>
</tr>
<tr>
<td></td>
<td>Min Time</td>
<td>Displays the minimum recorded time for execution of this line.</td>
</tr>
<tr>
<td></td>
<td>Max Time</td>
<td>Displays the maximum recorded time for execution of this line.</td>
</tr>
<tr>
<td></td>
<td>Dependency</td>
<td>Displays the UNIT_NUMBER of the dependency object that was called by that line. Lets you right-click and quickly go to that UNIT_NUMBER to see its Unit detail information.</td>
</tr>
<tr>
<td></td>
<td>Source</td>
<td>Displays the object's SQL source code.</td>
</tr>
</tbody>
</table>
Creating a Code Analyst Session

   
   Initially, Code Analyst installs the repository tables. For more information, see Installing Code Analyst. Then Rapid SQL opens the Code Analyst to the Run Summary tab.

2. On the Code Analyst Tools toolbar, click the Create New Collection button.
   
   Rapid SQL opens the first panel of the Code Analyst Wizard.

3. Select the individual object or group of objects to analyze. In this example, an individual stored procedure (CREATE_ADMISSION2) is selected.
   
   **TIP:** Code Analyst does not let you select objects that do not have stored procedures.

4. Click Next.
   
   If the object(s) selected to be analyzed requires parameters, the second panel of the wizard prompts you to enter the parameters.

5. Double-click the object to set the parameters.

6. For IBM DB2 LUW for Open Systems and Oracle, the Compile button opens the Confirm Compile dialog box that lets you compile the objects to ensure that the Code Analyst can capture the time metrics.

7. Click Finish.
   
   Code Analyst displays a message that the Code Analyst will run longer than the actual code. Then Code Analyst analyzes the objects, using the Embarcadero SQL Debugger to profile and then opens the Run Detail tab.

   **TIP:** You can select the "Please do not show me this dialog again" option in the dialog box or set the option on the Code Analyst Options.
Identifying and Fixing Bottlenecks Using Code Analyst

The Run Detail tab displays the total time for the objects being analyzed. The tab information may be enough to identify the potential bottleneck.

1. To view more detailed information, double-click the Unit Name.
   Code Analyst opens to the Unit Detail tab.
The Unit Detail Tab displays the object code and other information related to the individual lines of code. You can determine which line of code is taking too long and why. The Unit Detail Tab is where you troubleshoot, and then resolve the problem in the Modifying objects using editors.

2 In Rapid SQL, open the object editor, and then modify the code on the Definition tab.

3 Click Alter.

4 In Code Analyst, on the Unit Detail Tab, click Execute.
Comparing Code Analyst Sessions

1. Click the Comparison tab.

Code Analyst has a Comparison facility to allow quick compares of two object executions, showing the base time and the new time, as well as the time differences. The Comparison tab lets you compare which of the two procedures or functions ran faster.

2. Examine the Time Diff which indicates improvement to code.

3. If necessary, continue to modify the code on the Definition tab of the object editor, and then press Alter.

4. In Code Analyst, on the Unit Detail Tab, click Execute.

5. Examine the Time Diff until the bottleneck is solved.

Common Tasks

- Creating a Code Analyst Session
- Identifying and Fixing Bottlenecks Using Code Analyst
- Comparing Code Analyst Sessions
- Cloning a Code Analyst Session
Deleting a Code Analyst Session
Stopping a Code Analyst Session Execution
Executing a Code Analyst Session
Scheduling a Code Analyst Session
Unscheduling a Code Analyst Session
Refreshing a Code Analyst Session
Saving Results in Code Analyst
Printing Results in Code Analyst
Viewing Run Details in Code Analyst
Viewing Unit Summary Information in Code Analyst
Viewing Unit Details in Code Analyst
Setting View Options for the Unit Detail Tab in Code Analyst
Extracting SQL Text in Code Analyst
Executing SQL in Code Analyst

USING THE CODE ANALYST

When working with database code stored in database objects, it is sometimes difficult to pinpoint bottlenecks within the code. When situations like this arise, Code Analyst can assist in identifying the trouble spots. Code Analyst can be used to analyze one object or a group of objects. You select one or multiple objects, execute them, view the results, and save those results for later viewing or comparing.

Common Tasks
Creating a Code Analyst Session
Identifying and Fixing Bottlenecks Using Code Analyst
Comparing Code Analyst Sessions
Cloning a Code Analyst Session
Deleting a Code Analyst Session
Stopping a Code Analyst Session Execution
Executing a Code Analyst Session
Scheduling a Code Analyst Session
Unscheduling a Code Analyst Session
Creating a Code Analyst Session

The Code Analyst Wizard creates a new Code Analysis session that creates data for the Code Analyst tabs:

   Rapid SQL opens the first panel of the Code Analyst Wizard.
3. Select the individual object or group of objects to analyze.
4. Click Next.
   If the object(s) selected to be analyzed requires parameters, the second panel of the wizard prompts you to enter the parameters.
5. Double-click the object to set the parameters.
6. For IBM DB2 LUW for Open Systems and Oracle, the Compile button opens the Confirm Compile dialog box that lets you compile the objects to ensure that the Code Analyst can capture the time metrics.
7. Click Finish.
   Code Analyst displays a message that the Code Analyst will run longer than the actual code. Then Code Analyst analyzes the objects, using the Embarcadero SQL Debugger to profile and then opens the Run Detail tab.

   **Tip:** You can also select the “Please do not show me this dialog again” option in the dialog box or set the option on the Code Analyst Options.

For more information, see [Code Analyst Wizard](#).
CODE ANALYST WIZARD

The table below describes the options and functionality of the Code Analyst Wizard:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Session Name</td>
<td>Lets you type a name.</td>
</tr>
<tr>
<td>Select by Owner</td>
<td>Code Analyst Wizard queries the database to get the list of procedures and functions and lets you select objects to retrieve Codes for. Select to display available objects by owner, and then select the database(s).</td>
</tr>
<tr>
<td>Select by Object</td>
<td>Code Analyst Wizard queries the database to get the list of procedures and functions and lets you select objects to retrieve Codes for. Select to display available objects by object, and then select the object(s).</td>
</tr>
<tr>
<td>Object Name</td>
<td>Double-click each object to specify the input parameters. Specify which object executes first by clicking the Up and Down buttons.</td>
</tr>
<tr>
<td>Compile</td>
<td>IBM DB2 LUW FOR OPEN SYSTEMS AND ORACLE ONLY: Opens the Confirm Compile dialog box that lets you compile the objects to ensure that the Code Analyst can capture the time metrics.</td>
</tr>
<tr>
<td>Schedule</td>
<td>Opens the Select Scheduler dialog box or opens scheduling application.</td>
</tr>
<tr>
<td>Finish</td>
<td>Code Analyst analyzes the code.</td>
</tr>
</tbody>
</table>

For more information, see: [Creating a Code Analyst Session](#).

IDENTIFYING AND FIXING BOTTLENECKS USING CODE ANALYST

The Unit Detail Tab displays the object code and other information related to the individual lines of code. You can identify time-consuming lines of code in the Unit Detail Tab. The Unit Detail Tab is where you troubleshoot, and then resolve the problem in the [Modifying objects using editors](#).

2. Click the Unit Detail Tab.
   - Percent of Run Time displays the percentage of object execution time for the session(s).
3. Identify an object that contains time-consuming code.
4. In Rapid SQL, open the object editor, and then modify the code on the Definition tab.
5. Click Alter.
6. In Code Analyst, on the Unit Detail Tab, click Execute.
7. Click the Comparison tab.
The Comparison Tab lets you compare times of the objects in two different object executions to determine which run was more efficient. The Comparison Tab displays the base time and the new time, as well as the time differences. The Comparison tab lets you compare which of the two procedures or functions ran faster.

8. Examine the Time Diff which indicates improvement to code.

9. If necessary, continue to modify the code on the Definition tab of the object editor, and then press Alter.

10. Create new Code Analyst sessions and examine the Time Diff until the bottleneck is solved.

For more information, see:

- Code Analyst Product Design
- Using the Code Analyst

### COMPARING CODE ANALYST SESSIONS

The Comparison Tab lets you compare times of the objects in two different object executions to determine which run was more efficient. The Comparison Tab displays the base time and the new time, as well as the time differences. The Comparison tab lets you compare which of the two procedures or functions ran faster.


2. On the Run Summary tab, right-click the sessions, and then select Compare.

3. Examine the Time Diff which indicates improvement to code.

For more information, see:

- Code Analyst Product Design
- Using the Code Analyst

### CLONING A CODE ANALYST SESSION

The Clone Collection functionality lets you clone an existing Code Analyst session using the Code Analyst Wizard. Clone lets you reset the parameters or the order of the objects in the session without creating a new session.


2. On the Run Summary tab, select the session to clone.


   Rapid SQL opens the first panel of the Code Analyst Wizard.

For more information, see:
DELETING A CODE ANALYST SESSION
The Delete Collection functionality lets you delete the selected Code Analyst session.
2. On the Run Summary tab, select the session to delete.
   Code Analyst deletes the session.
For more information, see:
   Code Analyst Product Design
   Using the Code Analyst

STOPPING A CODE ANALYST SESSION EXECUTION
The Stop Execution kills the execution of the selected collection.
2. On the Run Summary tab, select the session to kill.
   Code Analyst kills the execution.
For more information, see:
   Code Analyst Product Design
   Using the Code Analyst

EXECUTING A CODE ANALYST SESSION
The Execute Collection functionality extracts the SQL text and then executes the code.
2. On the Run Summary tab, select the session to execute.
   Code analyst extracts and executes the SQL.
For more information, see:
SCHEDULING A CODE ANALYST SESSION
The Schedule Session functionality lets you schedule the session for a future run.

1 On the Tools menu, select Code Analyst.
2 On the Run Summary tab, select the session to schedule.
   Code Analyst opens the default scheduler.

For more information, see:
Scheduled
Code Analyst Product Design
Using the Code Analyst

UNSCHEDULING A CODE ANALYST SESSION
The Delete Session functionality lets you remove the session from a schedule.

1 On the Tools menu, select Code Analyst.
2 On the Run Summary tab, select the session to unschedule.
3 On the Code Analyst Tools toolbar, click Delete Session.

For more information, see:
Scheduled
Code Analyst Product Design
Using the Code Analyst

REFRESHING A CODE ANALYST SESSION
The Refresh Data functionality refreshes the data.

1 On the Tools menu, select Code Analyst.
2 On the tab, on the Code Analyst Tools toolbar, click Refresh Data.

For more information, see:
Code Analyst Product Design
USING THE CODE ANALYST

SAVING RESULTS IN CODE ANALYST
The Save functionality lets you save results for later viewing or comparing.

2. On the tab, right-click the session or unit, and then select Save.

   Code Analyst opens the Save Results dialog box.

For more information, see:
- Code Analyst Product Design
- Using the Code Analyst

PRINTING RESULTS IN CODE ANALYST
The Print functionality lets you print results for later viewing or comparing.

2. On the tab, right-click the session or unit, and then select Print.

   Code Analyst opens the Print Results dialog box.

For more information, see:
- Code Analyst Product Design
- Using the Code Analyst

VIEWING RUN DETAILS IN CODE ANALYST
The Run Detail tab displays the total time for the objects being analyzed. The tab information may be enough to identify the potential bottleneck.

To open the Run Details Tab in Code Analyst, do the following:

2. On the Run Summary tab, right-click the session, and then select Run Detail.
   OR
3. On the Unit Summary tab, right-click the session, and then select Run Detail.

For more information, see:
- Code Analyst Product Design
Using the Code Analyst

VIEWING UNIT SUMMARY INFORMATION IN CODE ANALYST

The Unit Summary Tab in Code Analyst displays the individual runs for a session.

To open the Unit Summary Tab in Code Analyst, do the following:

2. On the Comparison tab, right-click the session, and then select Unit Summary.

For more information, see:

Code Analyst Product Design
Using the Code Analyst

VIEWING UNIT DETAILS IN CODE ANALYST

The Unit Detail Tab displays the object code and other information related to the individual lines of code. You can identify time-consuming lines of code in the Unit Detail Tab. The Unit Detail Tab is where you troubleshoot, and then resolve the problem in the Modifying objects using editors.

To open the Unit Details tab in Code Analyst, do the following:

2. On the Unit Summary tab, right-click the session, and then select Unit Detail.

For more information, see:

Code Analyst Product Design
Using the Code Analyst

SETTING VIEW OPTIONS FOR THE UNIT DETAIL TAB IN CODE ANALYST

The table below describes the options on the shortcut menu for the Unit Details Tab in Code Analyst:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dependency Details</td>
<td>Displays dependency details.</td>
</tr>
<tr>
<td>Show Only Hit Lines</td>
<td>Displays only those lines with time metrics.</td>
</tr>
<tr>
<td>Show Only Missed Lines</td>
<td>Displays only those lines without time metrics.</td>
</tr>
<tr>
<td>Show All Lines</td>
<td>Resets the view to show all lines.</td>
</tr>
</tbody>
</table>
EXTRACTING SQL TEXT IN CODE ANALYST
The Extract SQL Text functionality extracts SQL text to an ISQL window.

2. On the Unit Detail tab, right-click the session, and then select Extract SQL Text.
   Code analyst extracts the SQL text to an ISQL window.

For more information, see:
Extract
Code Analyst Product Design
Using the Code Analyst

EXECUTING SQL IN CODE ANALYST
The Execute SQL functionality extracts SQL text to an ISQL window, and then executes the code.

2. On the Unit Detail tab, right-click the session, and then select Execute SQL.
   Code analyst extracts the SQL text to an ISQL window and executes the code.

For more information, see:
Execute
Code Analyst Product Design
Using the Code Analyst
Index

Symbols
/mdf/.ndf/.ldf files 503
@@thresh_hysteresis 564
#define 705
#include 705
default file location 101
Numerics
3D Rounded Docking Tabs. 46
A
ACCENT_SENSITIVITY 334
account, user 553
accounting, logins 562
accounts/accounting
setting lock time 540
activating roles 681
active
transactions, rollback segments 542
ACTIVE FOR BEGIN_DIALOG option 327
Add Cluster Column 370
Add Database Object Files(s) to Project Wizard
Panel 1 801
Panel 2 802
Panel 3 802
Panel 4 for All Objects 803
Panel 4 for Selected Objects 803
Panel 5 804
Panel 6 804
add/modify login trigger object action 581
Additional resources 11
admin_move_table 646
AES... algorithms 404
AFTER trigger timing 516
AFTER triggers
options 413
specifying 412
AFTER UPDATE OF options 413
aggregate, MySQL functions 362
alarms/thresholds
code analyst 93
algorithms
encryption, Oracle columns 404
aliases
creation shortcut 605
creating, DB2 LUW 252
creating, Sybase 420
editor, DB2 LUW 452
editor, DB2 Z/OS 471
editor, Sybase 556
see also objects, database support for 181
Alignment index partition setting 531, 538, 552, 561
ALL views 105
allocate extent object action 582
Allow Bit Data setting 468
Allow Duplicate Rows index setting 561
allow nulls
domains 308
allow nulls setting
by default, databases 422
Oracle columns 403
tables 482
user datatype 569
allow parallel option 463
Allow Parallel setting 257, 454
Allow Reverse Scans index setting 456
ALLOW_NULLS_BY_DEFAULT 764
ALLPAGES 566
ALTER
trigger event 413
ALTER SYSTEM SET "_recyclebin"= 628
ALTER_REBUILD 590
alter, rename style 105
ANALYZE
trigger event 413
Analyze Code 709
analyze tables object action 585
ANSI null default 328, 503
ANSI nulls 328, 503
ANSI padding 328, 503
ANSI warnings 328, 503
ANSINULL option 764
Append Data setting 464
Append, materialized query tables 457
applications
bind to database 557
archive databases 421
arithabort 503
array dimension, domains 308
AS DEFAULT 334
as locator 455
As Locator function setting 474
As Locator option 463
Asc Sort, indexes 530
Ascending option
indexes, InterBase 313
ASSOCIATE_STATISTICS
trigger event 413
asymmetric keys
creating, SQL Server 325
editor, SQL Server 501
SQL Server logins 339
AT SHUTDOWN durability option 422
AT(COMMIT) clause 692
attach database object action 585
AUDIT
trigger event 413
Audit table setting 482
authentication
OS-based for datasource 141
authorization
owner, full-text catalogs 334
auto close 328, 503
Auto Commit Status 710
auto create statistics 328, 503
auto format options, ISQL 114
auto format, DDL extract options 98
auto identity 422
Auto Replace feature
enabling/configuring 902
auto shrink 328, 503
auto update statistics 328, 503
autoconnect
restricting 127
auto-increment, MySQL tables 364
auto-reload
files, ISQL Editor 112
auto-reload, options 111–112
Auto-Save
ISQL editor 112
auto-save, files 111–112
Average Size package setting 476
B
backup certificate object action 586
backup devices
see also objects, database
batch delimiter 763
batch files
Java drop/load 97
Batch Mode execution 94
BEFORE triggers
options 413
specifying 412
BEFORE UPDATE OF options 413
Begin Transaction ON/OFF 710
BerkeleyDB storage engine 364
bind options 590
bind package object action 587
bind size 121
Bind Time package setting 476
bind to temporary database action 589
bind variables 711
Binder package setting 458
binding
application/login to database 557
default/rule 519
user datatype
default binding 569
binding logins to 589
bit data, user datatypes 468
bitmap index type 530
blob filters
creating using wizard 306
editing 488
support for 182
body
function 473
packages 536
type bodies 550
Boomerangs 44, 745
Clearing 746
Goto 745
Moving 745
bookmarks, Explorer 160
boundary values, partition functions 341
broken job 378
Browser
Options 92
browser
column filtering 38
object type appearance 103
Browsers
Copying 38
Displaying Dependencies 40
Extracting DDL 39
Main Menu 39
Object Types 34
Opening 33
Printing 37
Refreshing 40
Searching 38
Shortcut Menu 39
Sorting 38
Toolbar 33, 39
buffer pools
tablespace specification 298
Buffered Inset package setting 458
bufferpools
indexes 475, 485
primary key setting 479
see also objects, database
tablespace default 466
build procedure object action 590
Building a Query
Statements
UPDATE 865
BY PASSWORD 349
C
C
method type, DB2 LUW 463
cache
clusters 526
flushing, packages 637
materialized view logs option 534–535
property, tables 545
sequence setting 460, 543
calendar syntax 379, 398
called on NULL input option 463
Called on Null Input setting 257
CANCEL, ADMIN_MOVE TABLE 646
carriage return 112
CASCADE
delete rule 529
update/delete rule 506
cascade
set integrity options 686
shrink option 690
unique key setting 551
CASCADE delete rule 454
CASCADE, MySQL foreign key 361
Cascading Permissions 785
case
object identifiers 104
CAST FROM 463
catalog, datasource 130
specifying storage method 96
categories
dropping outlines by 622
stored outlines 536
categories, datasource
assigning 144
customizing 170
introduced 168
user interface element treatment 96
categories, reassigning 654
categories, stored outline 591
CCSID
database setting 472
table setting 464
user datatype setting 486
certificate
SQL Server logins 339
Certificate setting
Asymetric Key setting 518
certificates
backing up 586
creating, SQL Server 327
editing 501
editor, SQL Server 501
chains
support summary 183, 222
change category object action 591
change status action
DDL triggers 593
full-text indexes 594
triggers 593
change status object action 592
changed option, check tables 597
CHANGEGE TRACKING, full-text indexes 335
CHAR
unicode support, Data editor 892
unicode support, Results editor 784
character set
MySQL 360
character set, client 89
character strings. See strings
character type
unicode support, Data editor 892
unicode support, Results editor 784
check constraints
creating for IBM DB2 580
creating for IBM DB2 for OS/390 and z/OS 580
creating for Microsoft SQL Server 580
creating for Oracle 580
creating for Sybase ASE 580
database, DB2 LUW 452
database, DB2 Z/OS 471
database, Oracle 526
database, SQL Server 502
database, Sybase 556
hiding source text 640
modifying for IBM DB2 580
see also objects, database
support for 184
table, DB2 LUW 465, 497
Check Flag table setting 482
check pending states 686
check policy/expiration 339
check tables object action 597
Checking Syntax 709
checkpoint 598
checksum tables object action 598
CHECKTABLE DBCC option 613
CLEANUP, ADMIN.Move TABLE 646
clients
trouble-shooting 155
clipboard, line end options 112
CLOB
unicode support, Data editor 892
unicode support, Results editor 784
xmltype display 107
close
dropping, table 622
exchanging data 631
Close index setting 475, 485
Close primary key setting 479
Cluster Factor setting 456, 459, 468, 475, 479, 486, 531, 552
Cluster Factor, primary keys 538
Cluster Ration setting 456, 459, 468, 475, 479, 486
CLUSTER, ADMIN.Move TABLE 646
clustered indexes, SQL Server 508
clustered setting 569
indexes 456
primary keys 511, 517
clusters 527
allocating extents to 582
and materialized views 534
creating, Oracle 368
deallocating unused space 616
database, Oracle 526
see also objects, database
support for 185
truncating 694
coalescing tablespaces 599
conditions
  check constraint  556
check constraints, SQL Server  502
check contraints, DB2 LUW  452
check contraints, Oracle  526
configuration parameters, DB2 LUW  453
confirmation dialogs
data editor options  95
Connect Navigator  150
connect string, database links  528
connect time  540
Connect, Embarcadero
  Connect Navigator usage  150
datasource operations  150
  feature lockdown  127
  introduced  148
  logging in  149
connections
  options/preferences  89
  packages  477
connections, troubleshooting  155
constraints
table, DB2 LUW  465
  ,  497
tables, Sybase  567
consumers  701
containers
  managing for tablespace  466
  rebalancing  655
containers, tablespace, reducing  644
CONTAINS SQL function setting  459
CONVERSION_ERROR  764
convert tables object action  603
copy end of line options  112
Copy index setting  475, 485
copy operations
  object names  604
  objects, based on existing  607
  schema  604
Copy primary key setting  479
COPY_USE_LOAD, ADMIN_MOVE TABLE  646
COPY_WITH_INDEXES, ADMIN_MOVE TABLE  646
COPY, ADMIN_MOVE TABLE  646
CPU
  per call profile setting  540
  per session profile setting  540
CREATE
  trigger event  413
create alias object action  605
CREATE FUNCTION  425
Create Like  607
CREATE OR REPLACE TRIGGER  412
CREATE SYMMETRIC KEY  347
CREATE_JOB AUTO_DROP attribute  379
CREATE_NEW  326
Created setting
  packages  537
Creating INSERT Statements  899
Creating Objects  247
CREATION_DISPOSITION  326, 348
CURRENT_TIMESTAMP pseudocolumn  404
CurrentData package setting  476
Cursor Blocking package setting  458
cursor close on commit  328, 503
cycle numbers, IBM LUW sequences  460
cycle numbers, sequences  460
Cycle When Reach Max/Min setting  460, 543
D
DASD storage  482
data
  extracting as xml  634
  selecting all from a table  683
Data Blks/Key
  indexes  531
  primary keys  538
  unique keys  552
data block storage
  clusters  526–527
  materialized view logs  535
  materialized views  534
  unique keys  552
data cache
  see also objects, database
DATA CAPTURE NONE/CHANGES  482
data capture option  457
Data Dictionary
  role usage  105
data dictionary
  viewing usage permission  104
Data Editor
  Calendar  893
  Data Editor Filter  891
  Date Functions  893
  Date/Time Format Builder  893
  Edit Window  889
  Editing Date and Time Functions  893
  Editing Date/Time  893
  Modifying Criteria  891
  SQL Window  890
  Time Functions  893
  Toolbar  890
Data editor
  execution mode  94
  options/preferences  87
  type support  891
data editor
  default column value handling  897
Data Editor Filter  891
data files
  attaching  585
  detaching  617
Data Pages setting  508, 511, 518, 561, 563, 569
database devices
  default path, datasources  142
  moving transaction logs  645
  see also objects, database
  specifying in segments  433
INDEX

database links
  creating, Oracle 371
  editor, Oracle 528
  see also objects, database
  support for 186
Database partition Group table setting 464
Database Search
  Results 838
Database Search Wizard 837
  Panel 1 837
  Panel 2 838
database triggers
  creating, SQL Server 329
  editing, SQL Server 504
  enabling 504
  enabling/disabling 593
  FOR/AFTER argument 330
  support summary 186
  supported events 330
databasemanager configuration file parameters 453
databases
  archive 421
  associated triggers 412
  checkpoint 598
  creating, DB2 LUW 252
  creating, DB2 z/OS 280
  creating, MySQL 359
  creating, SQL Server 328
  creating, Sybase 420
detaching 617
database manager
  configuration file parameters 453
datasource Organizer 30
datasource
  auto-discovering 144
  basic viewing/organization options 163
catalog option 130
categories 168
  connecting (explicit) 153
  connecting to 155
discovering automatically 145
dropping storage paths 621
  editing 131
  export/import 146
  filtering objects/nodes view 170
groups 164
  indexing 115
  options/preferences 87
  registering like an existing 131
  registering manually 131
  repository preferences 88
  specifying catalog storage 96
troubleshooting catalog storage 155
  unregistering 153
  viewing properties 152
datatypes
  domain 307
  function parameters 474
  methods, DB2 LUW 463
  procedure parameters 480
  sequence 460, 543
  user-defined DB2 LUW 468
date formats
  data editor 94
date/time format setting
  results, ISQL 124
db chaining 328, 503
  DB Protocol package setting 476
  DB2
    version/connectivity support 14
  DB2 for Linux, Unix, and Windows
    troubleshooting connectivity 157
  DB2 for z/OS
    troubleshooting connectivity 157
db2....exe locations 97
  DB2GENERAL parameter style 463
  DBA views 105
  DBAs
    data dictionary view permission 104
  DBD table setting 482
  DBINFO option 463
  DBInfo parameter 454, 459
  DBINFO setting 257
dbms platforms, restricting 127
  DBMS_JAVA 97
  DBMS_JAVA package 97
  DBMS_JOB.BROKEN 378
DBMS_JOB.SUBMIT 378
DBMS_SCHEDULER.CREATE_JOB 379
DBMS_SCHEDULER.CREATE_PROGRAM 394
DBMS_SCHEDULER.CREATE_SCHEDULE 397
DBMS_SCHEDULER.DEFINE_PROGRAM_ARGUMENT 394
DBMS_SCHEDULER.ENABLE/DISABLE 626
DBMS_SCHEDULER.RUN_JOB 682
DBMS_SCHEDULER.SET_ATTRIBUTE 379
DBMS_SCHEDULER.STOP_JOB 692
dbo use only 328, 422, 503
DBRM see also objects, database
DBSpaces support summary 189
DDL creating temporary objects 199, 221
  extraction options 98
  object extraction 633
DDL Editors 722
  Opening 722
ddl in tran 422
DDL triggers database 329
deactivating roles 681
deallocate unused space 616
debugger, SQL
  options/preferences 87
Dec31 package setting 476
Decimal Point package setting 476
decryption
  certificate 327
  symmetric keys 349
DECRIPTION BY... 348
DEFAULT row format 364
default binding 519
default location, proxy databases 421
default to local cursor 328, 503
Default Value setting 482
defaults creating, SQL Server 330
creating, Sybase 422
data editor handling 897
editor, SQL Server 504
editor, Sybase 558
full-text catalog 334
hiding source text 640
Oracle columns 404
package schema 458
see also objects, database
segment 569
segment name 566
support for 190
tablespace 684
Defer Prepare package setting 476
DEFER(PREPARE) 589
Deferrable primary key setting 537
Deferrable/Deferred unique key setting 551
Deferred primary key setting 537
define directive 705
Definer package setting 458
degree of parallelism 337, 343, 355
Degree package setting 458, 476
degree, bind packages 588
degree, binding packages 589
Degrees setting 534–535
delete rule 506, 529
delete rule CASCADE delete rule 473
delete rule, update rule 454, 491
DELETE statements
  triggers, Oracle 413
delete statistics object operation 617
DELETEs
  trigger firing on 516
delimited identifiers 89
Density setting 456, 459, 468, 475, 479, 486
DES... algorithms 404
Descending option
  indexes, InterBase 313
DESTROY 590
detach database object action 617
deterministic option 463
Deterministic setting 257, 454, 459
DEV category 168
Developer Network 18
device
  container type
    files container type 466
device fragments 557
Dialog Box
  Grant Privileges To 786
  Revoke Privileges From 787
Dialog Boxes 42
dimensions, columns 464
directories
  creating, Oracle 372
  editor, Oracle 528
  ETSQLX files 101
  Oracle utilities 121
  oracle utilities 95
  see also objects, database support for 191
disable
  SQL Server indexes 618
DISABLE clause 412
disable job object action 619
disable keys object action 619
DISABLE TRIGGER 593
Disable Triggers 620
DISABLE_RI_CHECK 764
disabled environments 589
DISASSOCIATE_STATISTICS trigger event 413
Discover Datasources setting up for 144
Discussion Groups 11
INDEX

Display
  Customizing
    Output Window 31
Distinct Keys setting 531, 552
  indexes 456, 459, 475
  primary keys 479, 486
  unique keys 468
distinct values, column 482
distribution key columns 464
distribution statistics 699
DIVIDE_BY_ZERO_ERROR 764
docking tab colors 46
Documentation 11
domains
  access, SQL Server users 141
    creation wizard 307
    editing 489
    SQL Server logins 339
    support for 191–192
drivers
  native, support 14
DROP
  trigger event 413
drop by category object action 622
drop clone, object action 622
drop java object action
    configuring 97
    using 623
drop login trigger object action 624
DROP PENDING state 655
DROP statements
  extract/migrate defaults 98
DROP STORAGE clause 696
drop unused columns object action 625
drop Unused object action 625
drop, Java 97
drop, object action 620
dump utility, MySQL 120
duplicate keys 508
durability, Sybase databases 422

DYNAMIC
  row format 364
Dynamic Rules package setting 476
Dynamic setting 532
Dynamic Setting 542
dynamic SQL, flushing 637
E
EARLY_PREDICATE_EXECUTION 764
Editing Result Sets 773
  Adding a Column 777
  Adding a Row 776
  Columns 775
  Copying 774
  Cutting 773
  Deleting a Column 778
  Deleting a Row 777
  Formatting Result Sets 779
  Inserting a Column 777
  Inserting a Row 776
  Pasting 774
  Resizing Columns 778
  Resizing Rows 778
  Rows 774
  Sorting Data 779
Editing SQL Scripts 736
  Changing Case 742
  Commenting Code 741
  Copying and Pasting a Column 743
  Copying and Pasting Text 743
  Cutting and Pasting a Column 744
  Cutting and Pasting Text 743
  Pasting SQL Statements 738
  Pasting SQL Syntax 736
  Selecting a Block of Text 740
  Selecting Text 740
  Setting Bookmarks 745
Uncommenting Code 742
editor, IBM DB2 LUW 467
Editors

aliases, DB@ LUW 452
aliases, DB2 Z/OS 471
aliases, Sybase 556
asymmetric keys, SQL Server 501
blob filters 488
certificates, SQL Server 501
check constraints, DB2 LUW 452
check constraints, DB2 Z/OS 471
check constraints, Oracle 526
check constraints, SQL Server 502
check constraints, Sybase 556
clusters, Oracle 526
database links, Oracle 528
databases, DB2 LUW 453
databases, IBM DB2 Z/OS 472
databases, MySQL 521
databases, Sybase 503
databases, Sybase 557
defaults, SQL Server 504
defaults, Sybase 558
directories, Oracle 528
domains 489
encryption keys 489
exceptions 490–491
extended procedures, Sybase 558
foreign key, Sybase 559
foreign keys, DB2 LUW 454
foreign keys, IBM DB2 Z/OS 472
foreign keys, InterBase 491
foreign keys, MySQL 522
foreign keys, Oracle 529
foreign keys, SQL Server 505
functions, DB2 LUW 454
functions, DB2 Z/OS 473
functions, Oracle 529
functions, SQL Server 507
functions, Sybase 560
generators 492
groups, Sybase 560
indexes, DB2 Z/OS 474
indexes, IBM LUW 455
indexes, InterBase 493
indexes, MySQL 522–523
indexes, Oracle 530
indexes, SQL Server 507
indexes, Sybase 493, 561
job queues, Oracle 532
libraries, Oracle 533
logins, Sybase 508, 562
materialized query tables 457
materialized view logs, Oracle 535
options/preferences 111–112
outline, Oracle 536
packages, IBM DB2 Z/OS 476
packages, IBM LUW 458
packages, Oracle 536
plans, IBM DB2 Z/OS 477
primary keys, IBM LUW 458
primary keys, MySQL 522–523
primary keys, Oracle 537
primary keys, SQL Server 510
primary keys, Sybase 562
primary keys, z/OS 478
procedures, IBM DB2 Z/OS 479
procedures, IBM LUW 459, 494
procedures, Oracle 539
procedures, SQL Server 512
procedures, Sybase 563
profiles, Oracle 539, 541
roles, SQL Server 495
rollbacksegments, Oracle 542
rules, SQL Server 513
segments, Sybase 564
sequences, IBM LUW 460
sequences, Oracle 543
shadowss, InterBase 496
stogroups, IBM DB2 Z/OS 480
structured types, IBM LUW 461
syonyms, DB2 Z/OS 481
syonyms, Oracle 544
tables, DB2 LUW 463
tables, DB2 Z/OS 481
tables, InterBase 496, 498
tables, MySQL 523
tables, Sybase 565
tablespaces, DB2 LUW 466
tablespaces, DB2 Z/OS 483
tablespaces, Oracle 547
triggers, DB2 Z/OS 484
triggers, IBM DB2 LUW 467
triggers, Oracle 549
triggers, SQL Server 516
triggers, Sybase 568
type bodies, Oracle 550
types, Oracle 551
unique keys, DB2 z/OS 485
unique keys, IBM DB2 LUW 467
unique keys, InterBase 498
unique keys, MySQL 522–523
unique keys, Oracle 551
unique keys, SQL Server 517
unique keys, Sybase 568
user datatypes, DB2 LUW 468
user datatypes, IBM DB2 Z/OS 486
user datatypes, SQL Server 519
user messages, SQL Server 519
users, DB2 Z/OS 486
users, IBM DB2 LUW 469
users, MySQL 524
users, SQL Server 518
users, Sybase 571
views, DB2 LUW 469
views, DB2 Z/OS 487
views, Oracle 554
views, SQL Server 520
views, Sybase 571
EditProcedure table setting 482
email. See also SMTP
Embarcadero Connect. See also Connect, Embarcadero
Embarcadero SQL Debugger for IBM DB2 UDB 929
Embarcadero SQL Debugger for IBM DB2 UDB for
Windows/Unix
Basics
　　Interface 933
　　DDL Editor 934
　　Features 933
　　Functionality 937, 939
　　Break 945
　　Breakpoints 942–943
　　Close 945
　　Go 943
　　Input Parameters 938
　　Restart 944
　　Run to Cursor 941
　　Step Into 939
　　Step Out 940
　　Step Over 940
　　Stop 944
　　Call Stack Window 936
　　Dependency Tree Window 937
　　Variables Window 935
　　Watch Window 934
　　Options 932
　　Requirements 930
　　Using 946
　　Debugging an SQL Script 947
　　Opening a Debugging Session 946
Embarcadero SQL Debugger for Microsoft 948
Basics
　　Requirements
　　Client 953
　　Server 950
　　Break 966
　　Call Stack Window 958
　　DDL Editor 957
　　Debugging an SQL Script 968
　　Dependency Tree Window 959
　　Features 949
　　Functionality 959
　　Breakpoints 963–964
　　Close 966
　　Go 965
　　Input Parameters 960
　　Run to Cursor 963
　　Step Out 962
　　Step Over 962
　　Call Stack Window 956
　　Variables Window 958
　　Opening a Debugging Session 967
　　Options 955
　　Requirements 950
　　Restart 966
　　Step Into 961
　　Stop 965
　　Using 967
　　Debugging a Sample Script 969
　　Watch Window 957
Embarcadero SQL Debugger for Oracle 979
Breakpoints
　　Insert 990
　　Debugging a Sample Script 996
　　Getting Started 996
　　Sample Script 1 997
　　Sample Script 2 1001
　　Debugging a SQL Script 994
　　Debugging Sample Script 2 1001
　　Exclusion List 980
　　Features 980
　　Functionality 985
　　Breakpoint 990
　　Breakpoints
　　Remove 990
　　Restart 992
Toggle 990
Close 993
Go 991
Input Parameters 986
Pause 992
Run to Cursor 989
Step Into 987
Step Out 988
Step Over 988
Stop 991
Interface 982
Call Stack Window 984
Dependency Tree Window 985
Watch Window 983
Objects 979
Options 981
SQL Editor Window 983
Using 993
Opening a Debugging Session 994
Variables Window 984
Embarcadero SQL Debugger for Sybase 1006
Features 1007
Functionality 1012
Breakpoint 1016
Breakpoints
Insert 1016
Remove 1016
Restart 1019
Toggle 1017
Close 1019
Go 1018
Input Parameters 1013
Pause 1019
Run to Cursor 1016
Step Into 1014
Step Out 1015
Step Over 1015
Stop 1018
Interface 1009
Call Stack Window 1011
DDL Editor Window 1010
Dependency Tree Window 1012
Variables Window 1011
Watch Window 1010
Objects 1007
Options 1008
Using 1020
Debugging an SQL Script 1021
Opening a Debugging Session 1020
enable job object action 627
enable keys object action 628
Enable Query Rewrite materialized view setting 533
ENABLE TRIGGER 593
Enable Triggers 620
Enable/Disable object action
   jobs
      enabling/disabling 626
   enable environments 589
   Enabled primary key setting 537
   Enabled setting 516
   EnableQueryOptimization setting 470
   enabling/disabling
      check constraints 502
      materialized query tables 457
      unique keys 551
   encoding
      bind packages 589
   Encoding package setting 476
   Encoding Scheme database setting 472
   encoding, Java 97
   Encrypted setting 516
   encryption
      certificate 327
      database DDL triggers 330
      Oracle columns 404
      rules 513
   encryption algorithm 404
   ENCRYPTION BY PASSWORD 326
   ENCRYPTION BY... 348
   encryption keys
      editing 489
      support for 192
   END_DATE attribute 398
   end-of-line options 112
   enforced foreign key 454
   Enforcing Index settings 537
   ENGINE= option 603
   entry point, blob filters 307
   entry points
      external functions 310
   environments
      adding to packages 587
   environments, disabled/enabled 589
   environments, packages 476
   environments, plans 478
   ER/Studio Portal
      options/preferences 88
   Erase primary key setting 479
   error messages
      SQL Server 356
   Error Size setting 529, 539
   packages 537
   ERROR, check tables results 597
   ERROR, repair tables results 679
   errors
      maximum before abort, ISQL 106
   Errors materialized view setting 533
   estimate size, object action 630
   ETSQLX files, directory 101
   ETStart/ETEnd tags 199, 221
   event monitors
      see also objects, database
   events
      database triggers 330
      Sybase IQ support description 192
      trigger 467, 485
Excel 2000 772
Excel Spreadsheets
  Importing 899

exceptions
  creation wizard 308–309
  editing 490–491
  support for 193
exchange data, object action 631
Executing Procedures 710
Executing Scripts 746
  Cancelling a Query 749
  Compilation Error Tab 749
  Executing from Command History 749
  Executing Partial Scripts 747
  Plan Facility 752
  Script Execution Facility 747
  Step Execution Facility 750
  Token Matching Capability 766

EXISTING KEYS option 327
Expected Row Size setting 566
expired password 418
expiry date
  certificate 327

Explain Level/Snapshot/Mode setting 458
Explain package setting 476
explain plans
  bind packages 589
  table creation 108
Explicit Bind Time package setting 503
Explicit Permissions 785
Explorer
  basic viewing/organization options 163
  Favorites tab 162
  filtering tree view 170
  groups options 164
  Project/Version Control tabs 162
export
  datasources 146
  default directory 95
  utility directory 121
expression
  check constraint 556
expressions
  check constraint 471
  check constraints, SQL Server 502
extended option, check tables 597–598
extended option, repair tables action 679
extended procedures
  creating, SQL Server 331
  creating, Sybase 423
  editor, Sybase 558
  hiding source text 640
  library name 559
  see also objects, database
  support for 194
EXTENDED _JOIN_SYNTAX 764
extending a container 466
Extends setting 542
Extent Size tablespace setting 464

extents 527
  allocating 582
  allocating to tables/indexes/clusters
  allocating extents 582
  assigned to clusters 526
  clusters 527
  free/save on truncate 695
  LOB column usage 546
  materialized view logs 535
  materialized views 534
  primary key settings 538
  unique keys 552
external action option 463
External Action setting 257, 454, 459
external applications 46
external functions
  creation wizard 310
  support for 194
External Name setting 454, 459
Externally setting 541
extract, object action 633
extraction
  DDL options 98
F
failed login attempts 540
FAILED RUNS attribute 379
FAQs 11
  fast option, check tables 597
  Favorites tab 162
  feature lockdown 127
  fenced option 463
  Fenced setting 257, 454, 459
  File Factor setting 511, 517
  File Group setting 508, 511, 517
  File Growth Rate setting 503
filegroups
  full-text catalogs 334
  full-text indexes 335
  next used 647
  partitions, SQL Server 342, 351
files
  auto-saving 111–112
  data editor types 94
  datasource storage 96
  mdf, ndf, ldf 503
  SQL logging options 119
  tracking 111–112
  tracking, ISQL Editor 112
Fill Factor setting 508, 563
filtering
  character-based, on-the-fly 171
  introduced 170
Final Cal setting 257
final call option 463
Final Call setting 454
Fire On Delete/Update/Insert setting, rule 513
Fire On Insert/UpdateDelete 516
First Key index setting 456, 459, 475
First Key primary key setting 479, 486
First n Keys setting 468
FIXED
   row format 364
flag, binding packages 589
flashback recycle bin entry action 635
flashback table object action 636
flush cache object action 637
flush tables object action 638
fonts
   data editor options 94
   editor options 113
   Query Builder options 122
FOR clause 413
For Data setting 482
For Data table setting 486
FOR EACH ROW 412
FOR LOAD 421
FOR PROXY_UPDATE 421, 681
FOR UPDATE OF options 413
FOR VALUES arguments 341
FOR/AFTER argument, database ddl triggers 330
FORCE attribute 692
FORCE GENERATED set integrity option 686
FORCE, ADMIN_MOVE TABLE 646
force, start database option 691
foreign keys
   and set integrity 686
creating, DB2 LUW 254
creating, DB2 z/OS 281
creating, MySQL 360
creating, Oracle 373
creating, SQL Server 332
creating, Sybase 424
editor 559
editor, DB2 LUW 454
editor, IBM DB2 z/OS 472
editor, InterBase 491
editor, MySQL 522
editor, Oracle 529
editor, SQL Server 505
MySQL tables 365
see also objects, database support for 195
table, DB2 LUW 465, 497
Format 710
formatting
   ISQL 114
Formatting Code 709
Formatting Result Sets 779
   Changing Display Properties 782
   Display Properties 781
   Setting Alignment Properties 780
   Setting Border Properties 781
   Setting Colors 783
   Setting Fonts 782
Forums 11
fragments 557
free packages object action 638
Free Page primary key setting 479
free space threshold, segments 433
freelists
   cluster 526
   clusters 527
   in indexes 530, 546
   in unique keys 552
   primary key settings 538
FROM ASSEMBLY/EXECUTABLE FILE/FILE 327
FROM FILE/ASSEMBLY/ASSEMBLY/PROVIDER 326
FROM PROVIDER 348
FULL ACCESS set integrity option 685
FULL durability option 422
Full Keys
   index setting 456, 459, 475
   primary key setting 479, 486
   unique keys setting 468
Full Screen Mode 52
   Activating 52
   Dismissing 52
   Toolbar 52
full-text catalogs
   associated indexes 335
   basic properties 334
   editing 506
   rebuilding 656
   reorganizing 667
   support summary 196–197
full-text indexes
   basic properties 335
   column specification 335
   creating 334
   editing 506
   enabling/disabling 594
   population status 650
fully qualified names
   synonyms, SQL Server 350
function path 133, 135
Function Path package setting 458
Function-Based index setting 530
<table>
<thead>
<tr>
<th>Category</th>
<th>Pages</th>
</tr>
</thead>
<tbody>
<tr>
<td>functions</td>
<td>alarms/thresholds, time consumption 94</td>
</tr>
<tr>
<td></td>
<td>creating synonyms to 609</td>
</tr>
<tr>
<td></td>
<td>creating, DB2 LUW 256</td>
</tr>
<tr>
<td></td>
<td>creating, DB2 z/OS 282</td>
</tr>
<tr>
<td></td>
<td>creating, MySQL 361</td>
</tr>
<tr>
<td></td>
<td>creating, Oracle 374</td>
</tr>
<tr>
<td></td>
<td>creating, SQL Server 335</td>
</tr>
<tr>
<td>editor</td>
<td>DB2 LUW 454</td>
</tr>
<tr>
<td></td>
<td>DB2 Z/OS 473</td>
</tr>
<tr>
<td></td>
<td>Oracle 529</td>
</tr>
<tr>
<td></td>
<td>SQL Server 507</td>
</tr>
<tr>
<td></td>
<td>Sybase 560</td>
</tr>
<tr>
<td>extract options</td>
<td>199, 221</td>
</tr>
<tr>
<td>hiding source text</td>
<td>640</td>
</tr>
<tr>
<td>password verification</td>
<td>540</td>
</tr>
<tr>
<td>see also objects, database support for</td>
<td>197</td>
</tr>
<tr>
<td>triggers, path 467, 485</td>
<td></td>
</tr>
<tr>
<td>wizard, Sybase 425</td>
<td></td>
</tr>
<tr>
<td>GBP Cache</td>
<td>primary key setting 479</td>
</tr>
<tr>
<td>GENERATE NEW KEYS</td>
<td>option 327</td>
</tr>
<tr>
<td>Generate Numbers in Order setting</td>
<td>460, 543</td>
</tr>
<tr>
<td>Generate Package</td>
<td>639</td>
</tr>
<tr>
<td>Generate Procedure</td>
<td>639</td>
</tr>
<tr>
<td>Generate Select Statement</td>
<td>639</td>
</tr>
<tr>
<td>Generate Statements</td>
<td>639</td>
</tr>
<tr>
<td>GENERATED ALWAYS... options</td>
<td>270, 295</td>
</tr>
<tr>
<td>generated column, set integrity</td>
<td>686</td>
</tr>
<tr>
<td>generators</td>
<td>creation wizard 312</td>
</tr>
<tr>
<td></td>
<td>editing 492</td>
</tr>
<tr>
<td></td>
<td>support for 199</td>
</tr>
<tr>
<td>Gets setting</td>
<td>542</td>
</tr>
<tr>
<td>Globally setting</td>
<td>541</td>
</tr>
<tr>
<td>grace period, password</td>
<td>540</td>
</tr>
<tr>
<td>GRANT</td>
<td>trigger event 413</td>
</tr>
<tr>
<td></td>
<td>grid properties, results window 105</td>
</tr>
<tr>
<td></td>
<td>Group Member database setting 472</td>
</tr>
<tr>
<td></td>
<td>Group Member package setting 476</td>
</tr>
<tr>
<td>groups</td>
<td>assigning users 571</td>
</tr>
<tr>
<td></td>
<td>assigning users to 571</td>
</tr>
<tr>
<td></td>
<td>creating, Sybase 425</td>
</tr>
<tr>
<td>editor</td>
<td>Sybase 560</td>
</tr>
<tr>
<td>quiescing database to</td>
<td>653</td>
</tr>
<tr>
<td>quiescing instance to</td>
<td>653</td>
</tr>
<tr>
<td>see also objects, database support for</td>
<td>200</td>
</tr>
<tr>
<td>groups, datasource</td>
<td>adding/deleting/renameing 166</td>
</tr>
<tr>
<td></td>
<td>changing the hierarchy 167</td>
</tr>
<tr>
<td></td>
<td>introduced 164</td>
</tr>
<tr>
<td></td>
<td>moving datasources 165</td>
</tr>
<tr>
<td>grow by parameters, segments</td>
<td>433</td>
</tr>
<tr>
<td>H</td>
<td>hash</td>
</tr>
<tr>
<td></td>
<td>cluster type 526</td>
</tr>
<tr>
<td></td>
<td>partitions, Sybase tables 567</td>
</tr>
<tr>
<td></td>
<td>hash composite 561</td>
</tr>
<tr>
<td></td>
<td>header</td>
</tr>
<tr>
<td></td>
<td>type bodies 550</td>
</tr>
<tr>
<td></td>
<td>headers</td>
</tr>
<tr>
<td></td>
<td>packages 536</td>
</tr>
<tr>
<td>heap size</td>
<td>JDBC option 118</td>
</tr>
<tr>
<td></td>
<td>heap size, initial/max 118</td>
</tr>
<tr>
<td></td>
<td>heap size, JDBC 118</td>
</tr>
<tr>
<td></td>
<td>HEAP storage engine 364</td>
</tr>
<tr>
<td></td>
<td>hide text object operation 640</td>
</tr>
<tr>
<td></td>
<td>high water mark</td>
</tr>
<tr>
<td></td>
<td>lowering 644</td>
</tr>
<tr>
<td></td>
<td>high watermarks</td>
</tr>
<tr>
<td></td>
<td>rollback segment setting 542</td>
</tr>
<tr>
<td></td>
<td>highlighting. See style</td>
</tr>
<tr>
<td></td>
<td>histogram steps 701</td>
</tr>
<tr>
<td></td>
<td>history table 272</td>
</tr>
<tr>
<td>host</td>
<td>MySQL users 367</td>
</tr>
<tr>
<td>HTML</td>
<td>reports, default directories 100</td>
</tr>
<tr>
<td></td>
<td>template directory 101</td>
</tr>
<tr>
<td></td>
<td>hyperlinks, object action feature</td>
</tr>
<tr>
<td></td>
<td>and Code Assist features</td>
</tr>
<tr>
<td></td>
<td>enabling/configuring 117</td>
</tr>
<tr>
<td></td>
<td>introduced 718</td>
</tr>
<tr>
<td></td>
<td>hysteresis</td>
</tr>
<tr>
<td></td>
<td>segments 564</td>
</tr>
<tr>
<td>I</td>
<td>I/O</td>
</tr>
<tr>
<td></td>
<td>tablespace settings 466</td>
</tr>
<tr>
<td>IDENTIFIED BY</td>
<td>clause 404</td>
</tr>
<tr>
<td>identity</td>
<td>user datatype 569</td>
</tr>
<tr>
<td></td>
<td>Identity Column setting 482</td>
</tr>
<tr>
<td></td>
<td>Identity Gap setting 566</td>
</tr>
<tr>
<td></td>
<td>identity in nonunique index 422</td>
</tr>
<tr>
<td></td>
<td>IDENTIFY_VALUE 348</td>
</tr>
<tr>
<td></td>
<td>idle time 540</td>
</tr>
<tr>
<td>IGNORE DELETE TRIGGERS clause</td>
<td>696</td>
</tr>
<tr>
<td>Ignore Duplicate Key setting</td>
<td>508, 511, 517</td>
</tr>
<tr>
<td>Ignore Duplicate Rows index setting</td>
<td>427, 561</td>
</tr>
<tr>
<td>immediate offline mode</td>
<td>596</td>
</tr>
<tr>
<td>IMMEDIATE CHECKED set integrity option</td>
<td>685</td>
</tr>
<tr>
<td>IMMEDIATE clause</td>
<td>696</td>
</tr>
<tr>
<td>import</td>
<td>datasources 146</td>
</tr>
<tr>
<td></td>
<td>default directory 95</td>
</tr>
<tr>
<td></td>
<td>utility directory 121</td>
</tr>
<tr>
<td></td>
<td>utility, MySQL 120</td>
</tr>
<tr>
<td>Import Data Wizard</td>
<td>899</td>
</tr>
<tr>
<td>IN PATH</td>
<td>334</td>
</tr>
<tr>
<td>include columns</td>
<td>456</td>
</tr>
</tbody>
</table>
include directive 705
Include Longvar Columns setting 457
incremental refresh 661
index
  - cluster type 526
Index Buffer Pool database setting 472
Index Level setting 456, 459, 468, 475, 479, 486, 531, 552
Index Level, primary keys 538
Index Page Ratio setting 561, 563, 569
Index Tablespace setting 457
Index Type index setting 456
INDEX_ADVISOR... options 764
index, datasource 115
Indexes 200
  - Partitions 204
  - Rebuilding 657
indexes
  - allocating extents to 582
  - compressing 260
  - creating, DB2 LUW 259
  - creating, DB2 z/OS 284
  - creating, InterBase 312
  - creating, MySQL 362
  - creating, Oracle 375
  - creating, SQL Server 336
  - creating, Sybase 426
  - deallocating unused space 616
  - default segment warning 126
  - disabling, SQL Server 618
  - editor, DB2 z/OS 474
  - editor, IBM LUW 455
  - editor, MySQL 522–523
  - editor, Oracle 530
  - editor, SQL Server 507
  - editor, Sybase 493, 561
  - estimating size 630
MySQL tables 365
  - purging, recycle bin 652
  - rebuilding, InterBase 659
  - rebuilding, SQL Server 659
  - recreating, missing 628
  - reorganizing, SQL Server 665
  - same tablespace indexes warning 126
see also objects, database
  - segment placing 649
  - set statistics action 687
  - shrinking 690
  - table, DB2 LUW 464, 497
  - tables, Sybase 566
  - updating statistics 697
INFER_SUBQUERY_PREDICATES 764
INFO, check tables results 597
INFO, repair tables results 679
Inherit Special Registers setting 257, 454, 459
INIT, ADMIN_MOVE TABLE 646
initial extent
  - clusters setting 527
  - index setting 530
  - materialized view log setting 535
  - materialized view setting 534
  - primary key settings 538
  - rollback segment setting 542
  - table setting 546
  - unique key setting 552
initial heap size 118
initial heap size, JDBC option 118
Initial Transactions
  - cluster setting 527
  - index setting 530
  - materialized view log setting 535
  - materialized view setting 534
  - primary key settings 538
  - table setting 546
  - unique key setting 552
INMEMORY
  - database specification 421
InnoDB storage engine 364
input parameters 480
INSERT statements
  - triggers, Oracle 413
INSERT statements
  - generating from table data 606
INSERTs
  - trigger firing on 516
INSTANCE_STICKINESS attribute 379
instances
  - materialized view log setting 534–535
  - quiescing 653
  - support for 205
  - unquiescing 697
INSTEAD OF trigger timing 516
Interbase
  - version/connectivity support 14
Intra-partition package setting 458
invisible
  - indexes, Oracle 375
IP addresses
  - Performance Center 121
ISAM storage engine 364
isolation level 108
Isolation Level package setting 458
isolation, bind packages 588
ISQL editor
  - results options 123
ISQL Window
  - Code Templates 903
ISQL window
  - setting query options 753
ISQL Window Status Bar 710
isValid index setting 530
J
JAVA
  - method type, DB2 LUW 463
INDEX

Java
  load/drop options 97
  options/preferences 87
  virtual machine options 118
Java Classes 206
java classes
  dropping 623
java load object action
  using 642
Java Resources 206
Java Sources 206
jConnect 118
JDBC
  options/preferences 88, 118
JDBC support 14
job config files directory 101
Job Queues 208
job queues
  creating 378
  disabling 619
  editing 532
  editor, Oracle 532
  enabling 627
  procedure associated 378
  running jobs 683
  schedule 378
  see also objects, database
JOB_ACTION attribute 380
JOB_PRIORITY attribute 379
JOB_WEIGHT attribute 379
jobs
  creating 379
  editing 532
  support summary 207
join indexes
  support summary 208
JOIN_OPTIMIZATION 764
joins
  type/index Query Builder restrictions 122
JVM options 118
K
Katakana Charset package setting 476
Keep Dynamic package setting 476
KEEP_ADMIN_MOVE TABLE 646
Kerberos authentication 141
key columns, cluster 526
KEY_INDEX 335
key size, clusters 526
KEY_SOURCE 348
Keyboard Commands 49
Keyboard Emulation Mode 710
keyboard preferences 46
keys
  disabling 619
  enabling 628
Knowledge Base 11
L
Label table setting 482
language
  package setting 476
  user messages 519
  user messages, Sybase 440
Language Level package setting 458
LARGE.DOUBLES_ACCUMULATOR 764
Last Bind Time package setting 458
Last Modified setting 529
  packages 537
Last Runstats setting 482
layout, query plans 107
LDAP
  registering DB2 datasources from 133
  registering Oracle datasources from 135
  server/authentication configuration 119
Leaf Blks/Key setting 531, 552
Leaf Blks/Key, primary keys 538
Leaf Blocks setting 531, 552
Leaf Blocks, primary keys 538
Leaf Pages setting 456, 459, 468, 475, 479, 486
LEFT, partition function range 341
libraries
  creating, Oracle 380
  dynamic/status settings 533
  editor, Oracle 533
  extended procedure 558
  modify path/file name 533
  see also objects, database
  support for 209
library
  MySQL functions 362
library name, extended procedures 559
licensing 18
  offline/online, concurrent 20
  selecting at startup 20
lifetime, password 540
Lightweight Directory Access Protocol. See also LDAP
line feed 112
line numbers 113
link options 590
linked servers
  see also objects, database
list composite 561
list partitions 567
literals
  parameterized 711
Live Mode execution 94
load data
  default directory 95
Load Java 97
load java object action
  configuring 97
LOAD_MSGPATH, ADMIN_MOVE TABLE 646
range- 298
locale 123
localhost, MySQL users 367
Locality index partition setting 531, 538, 552, 561
locator, as 455
lock connections
default settings 107
Lock Isolation package setting 476
Lock Scheme setting 566
Lock Size setting 464
lock table object action 643
lock time, account 540
lockdown, feature 127
locking
rows/pages 338, 508
Locksize, materialized query tables 457
log files
attaching 585
detaching 617
logfile
materialized view logs 535
Logged Initially setting 457
logging
database files 503
index setting 530
materialized query table options 457
materialized view logs 534–535
primary key index constraints 537
table setting 545
unique keys 551
logging
SQL options 119
logging, SQL
options/preferences 88
logical reads 540
login triggers
adding/modifying 581
configured for login 562
dropping 624
LogIndexBuild setting 464
Logins 209
logins
accounting details 562
activating/deactivating roles 681
adding to server roles 340
adding user accounts to database 340
adding/modifying login triggers 581
associating with users 571
bind to database 557
binding to temporary databases 589
changing password 591
copying from existing 607
creating, SQL Server 338
creating, Sybase 427
dropping login triggers 624
editing, SQL Server 508
editor, Sybase 508, 562
extracting with user 98
login trigger configured 562
profile assignment 541
profile limits 540
see also objects, database
unbinding from temporary databases 696
LOGON
trigger event 413
LOGSEGMENT 569
logsegment 649
LONG
unicode support, Data editor 892
unicode support, Results editor 784
Long Tablespace setting 457
longvarchar types 784, 892
lower high water mark operation 644
M
Mailing Result Sets 770
Make Unique setting 456, 459, 468, 475, 479, 486
MAPI
file format (emailed files) 103
mapping
foreign keys, Sybase 559
MySQL foreign keys 361
master database
object creation warning 126
Master View materialized view setting 533
Match Full setting 559
Materialized Query Tables 211
materialized query tables
alias creation shortcut 605
and set integrity 686
copying from existing 607
creating, DB2 LUW 260
editor 457
reloading/refreshing 661
see also objects, database
materialized query tableless
creating synonyms to 609
Materialized View Logs 212
creating, Oracle 386
no chkpt on recovery 422
no free space acctg 422
NO RECOVERY durability option 422
No Sort index setting 530
No Sort unique key setting 551
NO SQL function setting 459
NO_STATS, ADMIN_MOVE TABLE 646
NO_TARGET_LOCKSIZE, ADMIN_MOVE TABLE 646
NOAUDIT
trigger event 413
NODEFER(PREPARE) 589
nodegroups
creating, DB2 LUW 263
see also objects, database
tablespace default 466
nodes
filtering 170
NOEXEC 764
NON_ANSI_NULL_VARCHAR 764
NON_CLUSTER, ADMIN_MOVE TABLE 646
non-clustered index, same segment warning 126
NONE update/delete rule 506
nonunique 456
nonunique index type 530
nonunique indexes
stopping updates 619
Norely primary key setting 537
normal offline mode 596
NOT ENFORCED option 454
Not For Replication setting 506
NoValidate index constraint status 537
ntext
unicode support, Data editor 892
unicode support, Results editor 784
num_freqvalues 699
num_quantiles 699
Number of Extents unique key setting 552
number, user message 440
numeric roundabout 328, 503
NVARCHAR
unicode support, Data editor 892
unicode support, Results editor 784
nvarchar
unicode support, Data editor 892
unicode support, Results editor 784
nvarchar(max)
unicode support, Data editor 892
unicode support, Results editor 784
NVARCHAR2
unicode support, Data editor 892
unicode support, Results editor 784

O
OAM Page Ratio setting 561, 563, 569
OBID table setting 482
object editors
max per open operation 104
object operations
invoking from SQL editor 718
object properties action 648
Object Status trigger setting 467, 485
object types
creating, Oracle 414
objects, database
associated with users 571
copying names 604
creating 247
dropping 620
editors 451
extracting DDL 633
filtering from tree view 170
included in datasource index 117
owning user, DB2 Z/OS 487
segments, associated 564
tablespace-associated 467
transferring ownership 693
user dependencies 469
viewing/organization options 163
ODBC support 14
offline
database setting 328, 503
license usage 20
tablespace status 596
offline, setting databases 687
OLE methods 463
ON DATABASE argument 329
ON DELETE
MySQL foreign key 361
ON FILEGROUP 334
ON UPDATE
MySQL foreign key 361
ON_CHARSET_CONVERSION_FAILURE 764
OneNote style tabs 46
online
setting databases 687
tablespace status 596
Op, check tables results 597
Op, repair tables results 679
OPEN SYMMETRIC KEY 349
open the key object action 349
OPEN_EXISTING 326
Operative package setting 476
Optimal Size setting 542
Optimization Hint package setting 476
optimization hints, bind packages 589
optimization, view queries 469
optimize tables object action 648
Options
Browser 92
Version Control 125
options
code analyst 93
options (application) 87
partitions
  editing in DB2 Z/OS tables 482
  for materialized query tables 457
indexes
  SQL Server 338, 352
  indexes, Oracle 531
  primary keys, Oracle 538
  tables, DB2 LUW 464
  tables, Sybase 567
tablespace 298
  truncate operation 695
unique keys, Oracle 552
password
  Oracle columns 404
password, Developer Network 18
passwords
  changing 591
  database links, associated 528
  expired 418
  profile limits 540
  user, Oracle 553
password, end of line options 112
path, database device default 142
paths
  full-text catalogs 334
  Oracle directory object 528
  trigger functions 467, 485
PDS Name package setting 476
Percent Free primary key setting 479
Percent Free setting 530, 546, 552
  percent free, extents 527, 534
  Percent Free/Used setting 535
  Percent Increase setting 530, 535, 546, 552
  percent increase, extents 527
  percent increase, materialized views extents 534
  percent used, extents 527, 534
  Performance Center
    client option 121
    connectivity options 121
    identifiers 121
    options/preferences 88, 121
  PERIOD... clauses 272
permanent generation size 118
Permissions
  Cascading 785
  Explicit 785
  Using Roles to Grant 786
  Using Roles to Revoke 786
permissions
  DBA/data dictionary 104
  Permissions Management 785
  PH1 589
  Piece Size index setting 475, 485
  Piece Size primary key setting 479
PL/SQL Profiler 1022
  Functionality 1024
    Clear Profile Table 1028
    Flush 1025
    Run Detail 1026
    Run Summary 1026
    Start 1024
    Stop 1030
    Unit Detail 1029
      Advanced View 1030
    Unit Summary 1027
  Requirements 1023–1024
  Using 1031
    Sample Session 1032
placement, databases 557
plans
  editor, IBM DB2 Z/OS 477
  rebinding 656
  see also objects, database
platforms
  restricting 127
population status object action 650
port numbers
  Performance Center 121
precision
  function parameters 474
  parameters, DB2 functions 455
  precision, function parameters 474
  Precompile Timestamp package setting 476
  precomplie options 590
preferences
  code analyst 93
  preferences (application) 87
  Prefetch Size setting 466
  Prefetch Strategy setting 427, 561, 566
  prelink options 590
prepare batch query option 755–758, 760, 763, 765
prepared statements 711
primary keys
  creating, DB2 z/OS 289
  creating, InterBase 314
  creating, MySQL 362
  creating, Oracle 389
  creating, Sybase 429
deallocating unused space 616
  editor, IBM LUW 458
  editor, InterBase 493
  editor, MySQL 522–523
  editor, Oracle 537
  editor, SQL Server 510
  editor, Sybase 562
  editor, z/OS 478
  see also objects, database
  support for 271
  table, DB2 LUW 465, 497
Primary Space Allocation 479
primary keys
  creating, DB2 LUW 263
private key, certificate 327
private SGA

Privileges

Deny Privileges From 788
Grant Privileges 786
Revoke Privileges To 787

Procedures 219

procedures
alarms/thresholds, time consumption 94
building 590
creating for Oracle 391
creating synonyms to 609
creating, DB2 LUW 264
creating, DB2 z/OS 291
creating, InterBase 315
creating, Oracle 391
creating, SQL Server 343
creating, Sybase 430
editor, IBM DB2 z/OS 479
editor, IBM LUW 459, 494
editor, Oracle 539
editor, SQL Server 512
editor, Sybase 563
extract options 199, 221
hiding source text 640
job queue 378
see also objects, database

PROD category 168

Product Design 30

Profiler
Setting Up 1023

profiles
creating, Oracle 392
editor, Oracle 539, 541
see also objects, database
support for 221
user-associated 553

profiling level, code analyst 93

programs
creating 394
display/style options 122
enabling/disabling 626
project management
Explorer tab 162

Projects
Adding Database Objects 801
Adding Files 805
Build Order 800
Closing 799
Creating 790
Creating From a Database 791
Creating From a Version Control Project 796
Creating From Existing Files 795
Creating Without Initialization 797
Executing Files 804
File Properties 809
Management 789
New Project 790
Opening a File 806
Opening a Recent Project 798
Opening an Existing Project 798
Project Management 789
Properties 808
Setting the Build Order 800
Subproject Properties 810
Subprojects 806
Creating 806
Deleting 807
Renaming 808
Sorting 808
Working with 797

PROVIDER_KEY_NAME 326, 348
proxy tables
creating 421
resynchronizing 681
PRUNE set integrity option 685
published 328, 503
purge recycle bin action 650
purge recycle bin entry action 652
purging, recycle bin 652

Q

QA category 168
Qualifier package setting 476

queries
building options 122
optimization for views 470
optimization, DB2 LUW views 469
optimization, MQTs 457
options, introduced 753
options, setting 754
options, when sent 754

query
optimization, table refresh 661

Query Builder
Auto Join options 122
code generation options 122
display/style options 122
exclusion options 122
syntax check options 122
Query Builder
- Adding a Join 875
- Auto Join Properties 854
- Auto Joins 877
- Auto Layout 877
- Building a CREATE VIEW Statement 867
- Building a DELETE Statement 866
- Building a Query 862
- Building a SELECT Statement 863
- Building an INSERT Statement 864
- Building an UPDATE Statement 865
- Column Properties 856
- Creating a Clause 878
- Creating a GROUP BY Clause 882
- Creating a HAVING Clause 883
- Creating a WHERE Clause 878
- Creating an AND Clause 879
- Creating an ORDER BY Clause 881
- Design 849
- Display Options 854
- DML Tab 850
- Editing Joins 875
- Execution Properties 854
- Explorer 849
- General Properties 854
- Getting Started 859
- Inserting an AND or OR Clause 880
- Joins 873
  - Editing 875
  - Inner 873
  - Left Outer 874
  - Properties 857
  - Self 874
- Keyboard Commands 852
- Moving Additional Tables to the SQL Diagram Pane 870
- Moving Columns in the SQL Statement Tree 885
- Moving Tables 869
- Moving Tables and Columns in the SQL Statement Tree 885
- Moving Tables and Views 870
- Moving Tables in the SQL Statement Tree 885
- Opening Queries 887
- options/preferences 88
- Removing a Join 875
- Results Tab 851
- Saving Queries 887
- Saving Queries as XML 887
- Schema Change Detection 887
- Selecting a Statement 860
- Selecting ALL Columns 872
- Selecting an Instance or Database 859
- Selecting Columns 861
- Selecting Columns in the SQL Diagram Pane 861
- Selecting Columns in the SQL Statement Tree 861
- Selecting DISTINCT Columns 872
- Selecting Tables 869
- Setting Column Properties 856
- setting options/preferences 122

SQL Diagram Pane 850
SQL Statement Pane 850
SQL Tab 851
Statement Properties 853
Subqueries 885
Syntax Checker 886
Table Properties 855
Table Shortcut Menus 852
Tables in the SQL Diagram Pane 869
Tables/Views Tab 850
Toolbar 851
Using 858
Using Data Editor with Query Builder 888
View Properties 855
Working with Tables in the SQL Diagram Pane 869
Workspace Window Options 849

Query Optimization package setting 458
Query Plan Facility 752
query plans
  - default display type 107
  - default layout 107
query rewrite, materialized views 533
QUERY_PLAN... options 765
QUERY_ROWS_RETURNED_LIMIT 765
QUERY_TEMP_SPACE_LIMIT 765
QUERY_TIMING 765
quick option, check tables 597
quick option, checksum tables 599
quick option, repair tables action 679
quiesce database action 653
quiesce instance action 653
quotas, user 548
quoted identifier 328, 503
quoted identifiers 89
QUOTED_IDENTIFIER 764
R
  - range
    - partition functions 341
  - range partitions 567
  - range-hash/list composite 561
read access
  - materialized query tables 661
read only 328, 422, 503
reads
  - logical 540
READS SQL DATA function setting 459
reassign by category object action 659
rebalance object action 655
REBIND 590
rebind package 655
rebind plans 656
REBUILD 590
rebuild
  - InterBase indexes 659
  - SQL Server objects 659
  - rebuild full-text catalogs action 656
  - rebuild outlines object action 660
  - recompile object action 661
recompute statistics 508
records
maximum length 482
recover tables operation 635
Recovery Status setting 466
recursive triggers 328, 503
recycle bin
displaying contents 222
enabling/disabling 628
flashback (recover) tables 635
object support summary 222
pugging tables/indexes 652
purge options 650
purging entire 650
status of 628
redo log groups
see also objects, database
Reduce option, tablespaces 644
reducing a container 466
REF CURSOR
Display in ISQL Window 703
Refresh Method materialized view setting 533
refresh table object action 661
refresh, materialized query tables 457
registration code 18
registration, product 18
registry
datasource storage 96
feature lockdown 127
regular expressions
browser filtering 38
introduced 729
Release Bound package setting 476
Rely primary key setting 537
Rely unique key setting 551
remote servers
see also objects, database
RENAME
trigger event 413
rename action style 105
Reoptvar package setting 476
reordering parameters 455
REORG, ADMIN_MOVE TABLE 646
reorganize
SQL Server objects 665
reorganize full-text catalogs action 667
Reorganize Tablespace 672
repair tables object action 679
REPEAT_INTERVAL attribute 398
Replacement Strategy setting 546
REPLAY, ADMIN_MOVE TABLE 646
replication
check constraints 502
materialized view logs 535
Reserve Page Gap setting 427, 561, 563, 566
Reserved Psges setting 508, 511, 561, 563, 569
Resize 778
resizing a container 466
Resource Release package setting 476
restart sequence 681
RESTARTABLE attribute 379
restore point 636
RESTRICT delete/update rule 454
RESTRICT WHEN DELETE TRIGGERS clause 696
RESTRICT, MySQL foreign key 361
RESTRICT delete rule 473
RestrictDrop setting 464
RestrictDrop table setting 482
Result Sets
Closing 772
Editing 773
Formatting 779
Mailing 770
Saving 772
Saving as XML 772
results (ISQL) options 123
Results Editor 767
Closing a Result Set 772
Closing a Result Window 771
Configuring 767
Editing Result Sets 773
Exporting Data 770
Mailing a Result Set 771
Multiple Result Sets 768
One Attached Tab Window 768
One Separate Unattached Window 769
Opening Result Files 727
Read-only Mode 770
Renaming a Result Window 771
Saving Results 772
Separate Unattached Windows 768
Single Result Sets 769
Status Bar 770
Results editor
type support 784
results window
grid options 105
options/preferences 88
results, SQL
format options 124
window/file/set options 123
resynchronize object action 681
return values
MySQL functions 362
returns
column, DB2 functions 455
scalar, DB2 functions 455
returns, functions 473
reuse max, password 540
REUSE STORAGE clause 696
reuse time, password 540
Reverse index setting 530
Reverse primary key setting 537
reverse scans, indexes 456
Reverse unique key setting 551
REVOKE
trigger event 413
Right Outer Joins 874
INDEX

RIGHT, partition function range 341
Roles 223
roles
activating/deactivating 681
assigned to logins 508, 562
assigning to users 518
creating, Oracle 395
creating, SQL Server 345
Data Dictionary usage 105
editor, SQL Server 495
see also objects, database
rollback segments
creating, Oracle 396
editor, Oracle 542
see also objects, database
shrinking 689
rollbacks, materialized views 533
roundrobin partitions 567
row
length, average 482
Row Compression setting 464
row count 763
Row Movement property
and shrink operation 690
Row Movement setting 545
Row Organization setting 545
ROWPAGES 566
rows
locking 338, 508
total in table 482
trigger type 412
RSA_212/1024/2048 326
rule binding 519, 569
Rules 224
rules
creating, SQL Server 345
creating, Sybase 431
editor, SQL Server 513
hiding source text 640
see also objects, database
Run Job object action
jobs
running 682
run job object action 683
run script with batch execution 763
runstats
last 482
S
SALT, Oracle columns 404
save point function setting 459
scalar, return 455
scale
function parameter 474
parameters, DB2 functions 455
parameters, IBM LUW procedures 459, 495
Scale setting 482
schedule
job queues 378
scheduler (Oracle)
chains 183
jobs 207
programs 222
schedules
creating 397
editing 543
support summary 225
Scheduling
ISQL Window Scripts 843
Microsoft Task Scheduler 843
schema
associated triggers 412
copying 604
see also objects, database
schema object operation 683
Schema Path package setting 476
SCN 636
scratch database 421
Scratchpad Length setting 257
scratchpad option 463
Scratchpad setting 257
Scratchpad settings 454
screen tips 46
Script Execution Facility
Using 840
Script Files 723
Inserting Files 725
scripts
query options 753
Secondary Space Allocation 479
Security Policy setting 464
Segment Name setting 427, 561, 563, 566
Segment setting 569
segmented tablespaces 298
segments
creating, Sybase 432
editor, Sybase 564
extending 433
LOB column usage 546
object creation warnings 126
placing indexes/tables 649
see also objects, database
support for 226
Select * From operation 683
select into/bulkcopy/pllsort 328, 422, 503
semantic validation
options/preferences 116
sequences
alias creation shortcut 605
creating synonyms to 609
creating, Oracle 398
editor, IBM LUW 460
editor, Oracle 543
restarting 681
see also objects, database
support for 227
Sequential Pages setting 456, 459, 468, 475, 479, 486
serial number 18
SQL Server
  trouble-shooting connectivity 157
SQL Warn/Math Warn package setting 458
SQL Windows 710
  Find and Replace 727
  Replacing 729
  Searching 727
SQL_FLAGGER_ERROR_LEVEL 764
SQL_FLAGGER_WARNING_LEVEL 764
SQL. See also results, SQL
staging tables 686
Start Database operation 691
start date
certificate 327
START_DATE attribute 398
statement triggers 412
statistics
  updating 697
Statistics Recompute setting 508, 511, 517
statistics computing, SQL Server indexes 508
status
  functions 529
  libraries 533
  packages 537
  procedures 539
  table spaces 596
  triggers 550, 592
status bar
  ISQL default 112
Status package setting 458
STATUS, check tables results 597
STATUS, repair tables results 679
Stay Resident procedure setting 480
Step Execution Facility 751
step values 701
stogroups
  creating, DB2 z/OS 293
editor, IBM DB2 Z/OS 480
  see also objects, database
  specified in table space 298
Stop database operation 692
Stop Job object action
  jobs
    stopping 692
STOP_ON_WINDOW_CLOSE attribute 379
STOPLIST 335
storage engine 603
Storage Group database setting 472
Storage Group primary key setting 479
stored outlines
  changing categories 591
  dropping by category 622
  dropping unused 625
  rebuilding 660
stored procedures
  java, loading 642
storage paths, dropping 621
String Delimiter package setting 476
STRING_RTRUNCATION 764
Structured Types 228
structured types
  adding/editing methods 462
editor, IBM LUW 461
  see also objects, database
style
  auto-indent 114
  editor 113
  ISQL window 114
  syntax highlighting options 113
  tabs to spaces 114
subject, certificate 327
Subpartition type index setting 531, 538, 552, 561
subscribed 328, 503
subtypes, blob filters 307
SUSPEND
  trigger event 413
SWAP, ADMIN_MOVE TABLE 646
switch online object operation 693
Sybase ASE
  trouble-shooting connectivity 156
  version/connectivity support 14
Sybase IQ
  Transact-SQL compatibility 763
symmetric keys
  creating, SQL Server 347
  opening/decrypting 349
synonyms
  creating 609
  creating, DB2 z/OS 294
  creating, Oracle 400
  creating, SQL Server 350
  editing, SQL Server 514
  editor, DB2 z/OS 481
  editor, Oracle 544
  see also objects, database
  support for 229
syntax
  calendaring 379, 398
  checking during execute, ISQL 107
  checking, Query Builder 122
Syntax Check 709–710
SYSDATE pseudocolumn 404
SysEntries package setting 476
SYSTEM
  table space, default 684
system
  segment 569
  segment name 566
system change number 636
system indexes
  support summary 230
System Required setting 456, 459, 468, 475, 479, 486
system tables
  support summary 231
SYSTEM table space
  object/user creation warning 126
system triggers
  support summary 231
T
Tab Menu 46
Table Status setting 482
Table Tablespace setting 457
Table Type setting 482
Tables
  Moving Tables in the SQL Diagram Pane 869

tables 652
  alias creation shortcut 605
  allocating extents to 582
  analyzing 585
  associated triggers 412
  check for errors 597
  checksum 598
  column summary 683
  copying from existing 607
  creating synonyms to 609
  creating views from 609
  creating, DB2 LUW 269
  creating, DB2 z/OS 294
  creating, InterBase 318
  creating, Oracle 401
  creating, SQL Server 351
  creating, Sybase 434
  deallocating unused space 616
  default segment warning 126
  deleting statistics 617
  disabling keys 619
  dropping clone 622
  dropping unused columns 625
  editor, DB2 LUW 463
  editor, DB2 Z/OS 481
  editor, InterBase 496, 498
  editor, MySQL 523
  editor, Sybase 565
  enabling keys 628
  estimating size 630
  exchange data, clone 631
  extracting data as XML 634
  flashback 636
  flushing 638
  hiding source text 640
  locking 643
  moving between tablespaces 646
  optimizing 648
  partitioning for Oracle 406
  recompiling 661
  recover from recycle bin 635
  repairing 679
  see also objects, database
  segment placing 649
  selecting all data from 683
  shrinking 690
  storage engine 603
  support for 232
  temporal 272
  truncating 694
  updating statistics 697
Tablespace Buffer Pool database setting 472
tablespaces
  and dropping storage paths 621
  and materialized views 534
changing status 596
coalescing 599
creating, DB2 LUW 273
creating, DB2 z/OS 297
creating, Oracle 408
database placement 453
default, setting 684
database editor, DB2 LUW 466
database editor, DB2 z/OS 483
database editor, Oracle 547
extent details 549
for materialized query tables 457
in indexes 530, 546
index creation warning 126
in unique keys 552
lowering high water mark 644
materialized view logs 535
moving tables between 646
object creation warnings 126
primary key settings 538
purge recycle bin options 650
rebalancing 655
see also objects, database
segment management 549
set undo action 688
support for 235
switching online 693
user default/temporary 553
user quotas 548
tabs
to spaces 114
Task Scheduler 843
Technical Requirements 12
  Hardware 12
  Operating System 12
technical requirements
database 14
templates
code. See Code Template feature
temporal tables 272
temporary databases 589, 696
temporary databases, Sybase 421
temporary offline mode 596
temporary tables
  automatic creation/deletion, extract 199, 221
TEXT
  unicode support, Data editor 892
  unicode support, Results editor 784
Text Files
  Importing 899
The 591
Threadsafe function setting 454, 459
Threadsafe setting 257
thresholds
  free space, segments 433
  segment hysteresis 564
  segments 564
thresholds/alarms
code analyst 93
time formats
data editor 94
time-based settings
  profile limits 540
timeouts
  server connection/query 89
Timestamp package setting 476
timing, trigger 516
timing, triggers 550
timing, triggers 467
Toggle 704
Token Matching Capability 766
toolbars
  hiding/displaying 46
  ISQL default 112
  options/preferences 111-112
  preferences 46
Tools
  Data Editor 889
  Database Search 837
  Embarcadero Products 902
  File Execution Facility 839
  Find in Files 836
  Query Builder 848
  Scheduling 843
  Script Execution Facility 839
  Visual Difference 844
torn page detection 328, 503
Total Keys setting 456, 459, 468, 475, 479, 486
Total Pages Modified setting 508, 511, 518
Total Rows Modified Since Last setting 518
Total Sections package setting 458
transaction log files 503
  attaching 585
detaching 617
Transact-SQL compatibility 763
transfer ownership 693
Transfer Rate setting 466
transparent data encryption 404
INDEX

triggers
  adding login 581
  alarms/thresholds, time consumption 94
  changing status 592
  columns firing, Oracle 413
  creating, DB2 LUW 274
  creating, DB2 z/OS 299
  creating, InterBase 320, 323
  creating, Oracle 412
  creating, SQL Server 353
  dropping login 624
  editor, DB2 Z/OS 484
  editor, IBM DB2 LUW 467
  editor, Oracle 549
  editor, SQL Server 516
  editor, Sybase 568
  enabling/disabling 593
  events 467, 485
  firing events, Oracle 413
  function path 467, 485
  hiding source text 640
  login 562
  see also objects, database
  support for 236
  support for, summary 236
  timing 467, 485
  type 467, 485
  trouble-shooting, connections 155
trunc log on chkpt 328, 422, 503
TRUNCATE
  trigger event 413
truncate object operation 694
TSQ_VARIABLES 764
type
  columns, DB2 z/OS 482
  Oracle columns 403
  user datatype 569
Type Bodies 238
  type bodies
    editor, Oracle 550
types
  alarms/thresholds, time consumption 94
  editor, Oracle 551
  parameters, DB2 functions 455
  parameters, IBM LUW procedures 459, 495
  sequences, IBM LUW 460
  triggers 550
U
UI
  Setting Appearance 46
  Setting Classic Microsoft Office 97 style 46
  Setting Microsoft Office 2003 style 46
  Setting Microsoft Office XP style 46
UID pseudocolumn 404
unbind from temporary database action 696
unbinding logins from 696
UNCHECKED set integrity option 685
UNICHAR
  unicode support, Data editor 892
  unicode support, Results editor 784
Unicode support
  Data editor 891
  Results editor 784
unique 456
  indexes, InterBase 313
  unique auto_identity index setting 422
  unique index type 530
  unique keys 467
  creating, DB2 z/OS 300
  creating, InterBase 316, 321
  creating, MySQL 362
  creating, Oracle 414
  creating, SQL Server 355
  creating, Sybase 437
  deallocating unused space 616
  editor, InterBase 498
  editor, MySQL 522–523
  editor, Oracle 551
  editor, SQL Server 517
  editor, Sybase 568
  editor, z/OS 485
  see also objects, database
  support for 239
  table, DB2 LUW 465, 497
unique setting
  indexes 456
UNIQUETEXT
  unicode support, Data editor 892
  unicode support, Results editor 784
UNIVARCHAR
  unicode support, Data editor 892
  unicode support, Results editor 784
range- 298
Unlimited Max Size setting 503
unload data
  default directory 95
  unnamed variables 711
unquiesce object operation 697
unregistering datasources 153
unused space, deallocating 616
update rule 506
UPDATE statements
  triggers, Oracle 413
UPDATE STATISTICS 617
update statistics object action 697
UPDATES
  trigger firing on 516
UPDATEUSAGE DBCC option 613
URLs
  ER/Studio Portal 88
usage
  user datatypes 569
  use FRM file option, repair tables action 679
USE statements
  DDL extract options 98
  USE_CURRENT_SESSION attribute 682
Used Pages setting 508, 511, 518, 561, 563, 569
User Datatypes 240
user datatypes
creating, DB2 LUW 276
creating, DB2 z/OS 303
creating, SQL Server 357
creating, Sybase 438
database, DB2 LUW 468
database, IBM DB2 Z/OS 486
database, SQL Server 519
see also objects, database
user ID, Developer Network 18
User interface preferences 46
user messages
creating, SQL Server 356
creating, Sybase 439
database, SQL Server 519
see also objects, database
support for 241
USER pseudocolumn 404
USER views 105
users
alias definition 556
assigned to logins 508, 562
assigning to groups 560, 571
assigning to profiles 539
changing password 591
copying from existing 607
creating, DB2 LUW 277, 304
creating, MySQL 366
creating, Oracle 417
creating, SQL Server 357
creating, Sybase 441
database links, associated 528
database, DB2 Z/OS 486
database, IBM DB2 LUW 469
database, MySQL 524
database, Oracle, editors
tablespace, Oracle 553
database, SQL Server 518
database, Sybase 571
extracting logins with 98
hiding source text 640
profile assignment 541
purge recycle bin options 650
quiescing database to 653
quiescing instance to 653
role assignment 495–496
see also objects, database
support for 242
tablespace quotas 548
utility, start database option 691
V
Valid package setting 476
Validate index constraint status 537
Validate package setting 476
Validate unique key setting 551
validation, bind packages 588
ValidProc table setting 482
VARCHAR
unicode support, Data editor 892
unicode support, Results editor 784
varchar
unicode support, Data editor 892
unicode support, Results editor 784
VARCHAR2
unicode support, Data editor 892
unicode support, Results editor 784
variables
bind 711
VC Files Tab
Closing 822
Opening 822
VC Files Tab Functionality 820
VCAT 298
VCAT Catalog primary key setting 479
verify function, password 540
VERIFY, ADMIN.Move TABLE 646
Version Control 813
Adding Files to Version Control 817
Basics 818
Checking In Projects or Files 826
Checking Out Projects or Files 824
Collapse All 833
Delete 822
Expand All 832
Getting Latest Version 823
Integrating with Merant/Intersolv PVCS Version
Manager 814
Integrating with Microsoft Visual SourceSafe 814
Integrating with MKS Source Integrity 815
MKS Source Integrity 815
Open 822
Properties 832
Refresh 833
Removing a Project or File 831
Removing a Project or File from Version Control 831
Sort 822
Undoing a Check Out 827
VC Files Tab 819
Viewing File Differences 829
Viewing History 829
Visual SourceSafe 814
Working with Files 817
version control
Explorer tab 162
options/preferences 125
view
creating, Sybase 442
views
  alias creation shortcut 605
  associated triggers 412
  column summary 683
  creating from a table 609
  creating synonyms to 609
  creating, DB2 LUW 277
  creating, DB2 z/OS 304
  creating, Oracle 418
  creating, SQL Server 358
  editor, DB2 LUW 469
  editor, DB2 Z/OS 487
  editor, Oracle 554
  editor, SQL Server 520
  editor, Sybase 571
  hiding source text 640
  query optimization 470
  see also objects, database support for 244
  update statistics, DB2 LUW 699
  updating statistics 697
virtual columns 403
virtual machine options, Java 118
Visual Difference
  Comparing Files 844
  Navigating 846
  Opening 844
  Options 847
  Printing 846
  Searching 847
visual style 46
Volatile setting 464
Volatile table setting 482
Volatile, materialized query tables 457
W
  Waits setting 542
  WARNING, check tables results 597
  WARNING, repair tables results 679
Warnings
  options/preferences 88
  warnings
    options/preferences 126
    Query Builder options 122
    WHAT argument, job queue 378
Windows
  SQL Server logins 339
  Windows authentication 141
  WITH ALGORITHM 326
  WITH DEFAULT_LOCATION clause 421
  WITH DURABILITY= parameter 422
  WITH OVERRIDE 421
  WITH PASSWORD 348–349
  WITH PRIVATE KEY 327
  WITH PRIVATE KEY clause 586
  WITH SCRATCH_DATABASE 421
  WITH SUBJECT 327
  Without Login setting 518
wizards
  blob filters 306
  domains 307
  exceptions 308–309
  external functions 310
  functions, Sybase 425
  generators 312
  wizards, default directories 100
  WORKFILE database type 298
  Wraps setting 542
  write access
    materialized query tables 661
  Writes setting 542
  X
XML 772
  type support, Data editor 891
  type support, Results editor 784
xmltype
  viewing as CLOB 107